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PARTE 1

Princípios básicos do 
Dreamweaver

Aprenda a utilizar a documentação e outros recursos do Macromedia 
Dreamweaver 8, bem como a configurar a área de trabalho do programa de 
acordo com suas preferências de trabalho. Planeje e configure um site e 
comece a criar páginas.

Esta seção contém os seguintes capítulos:
Introdução  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Capítulo 1: Explorar a área de trabalho. . . . . . . . . . . . . . . . . . . . . . . .43

Capítulo 2: Configurar um site do Dreamweaver. . . . . . . . . . . . . . . 87

Capítulo 3: Criar e abrir documentos . . . . . . . . . . . . . . . . . . . . . . . . 101
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Introdução
O Dreamweaver MX2004 da Macromedia é um editor de HTML profissional para desenhar, 
codificar e desenvolver sites, páginas e aplicativos para a Web. Para aqueles que gostam do 
controle da codificação manual HTML ou para os que preferem trabalhar em um ambiente de 
edição visual, o Dreamweaver fornece ferramentas úteis para aprimorar a sua experiência de 
criação para Web. 

Os recursos de edição visual do Dreamweaver permitem criar páginas, de modo rápido, sem 
que seja necessário escrever uma única linha de código. É possível visualizar todos os 
elementos ou propriedades do site e arrastá-los de um painel fácil de usar diretamente para um 
documento. Dinamize o fluxo de trabalho de desenvolvimento de sites criando e editando as 
imagens no Fireworks da Macromedia ou em outro aplicativo gráfico e, posteriormente, 
importando-as diretamente para o Dreamweaver ou incluindo objetos do Flash da 
Macromedia.

O Dreamweaver também fornece um ambiente de codificação completo que inclui 
ferramentas de edição de códigos (como codificação por cores e preenchimento de tags) e 
material de referência de linguagens sobre Cascading Style Sheets (Folha de estilo em cascata) 
(CSS), JavaScript e ColdFusion Markup Language (CFML), entre outros. A tecnologia 
HTML do Macromedia Roundtrip permite importar documentos HTML codificados 
manualmente sem reformatar o código; em seguida, você pode optar por reformatar o código, 
aplicando o seu estilo de formatação preferido.

O Dreamweaver também permite criar aplicativos dinâmicos e com suporte de banco de 
dados para a Web, utilizando tecnologia de servidor como CFML, ASP.NET, ASP, JSP e PHP.

O Dreamweaver é inteiramente personalizável. Crie os seus próprios objetos e comandos, 
modifique os atalhos de teclado e adicione códigos JavaScript para ampliar ainda mais os 
recursos do Dreamweaver com novos comportamentos, Property inspectors (Inspetores de 
propriedades) e relatórios de site.
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Este capítulo contém as seguintes seções:
Novidades do Dreamweaver 8  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Onde iniciar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Fluxo de trabalho do Dreamweaver para criar sites da Web  . . . . . . . . . . . . . . . . . . . 28

Utilizar o Dreamweaver com outros aplicativos. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Dreamweaver e acessibilidade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Guia para a mídia de treinamento do Dreamweaver. . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Convenções tipográficas  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Recursos de tecnologias da Web e HTML. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Novidades do Dreamweaver 8
O Dreamweaver 8 inclui vários recursos novos que melhoram a utilização e ajudam a criar 
páginas nos ambientes de criação e de codificação. 

O Dreamweaver 8 oferece suporte às melhores práticas e padrões da indústria, incluindo 
suporte à utilização avançada do CSS, leitores RSS e XML, e requisitos de acessibilidade.

Trabalhar com as melhores práticas

Autoria visual com dados 
XML

Ganhe velocidade com XML utilizando ferramentas visuais 
poderosas para integrar leitores ao trabalho e acabe com o 
mistério da conversão de XML para HTML. Integrate dados 
baseados em XML, como leitores RSS, a páginas da Web 
utilizando um simples fluxo de trabalho de arrastar e soltar. 
Passe para a visualização de código a fim de personalizar a 
transformação, utilizando referências de código aprimoradas 
para XML e XSLT. Para obter mais informações, consulte 
Capítulo 36, “Exibir dados XML em páginas da Web”, na 
página 813.

Painel do CSS novo e 
unificado

O painel do CSS, novo e unificado, é um local central para 
estudar, compreender e trabalhar com os estilos CSS aplicados 
às páginas de um modo visual. Toda a funcionalidade do CSS é 
consolidada em um único painel, que foi definido e aprimorado 
para facilitar o trabalho com os estilos CSS e torná-lo mais 
produtivo. A nova interface facilita a visualização da cascata de 
estilos aplicados a um elemento específico, de modo que você 
pode facilmente identificar onde os atributos estão definidos. 
Uma grade de propriedades permite fazer edições rápidas. 
Para obter mais informações, consulte “Utilizar o painel CSS 
Styles (Estilos CSS)” na página 433.
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Visualização do layout CSS Aplique auxílios visuais na fase de projeto para fazer o contorno 
de bordas de layout CSS ou colorir layouts CSS. A aplicação 
de auxílios visuais revela esquemas complexos de aninhamento 
e melhora a seleção. Clique no layout do CSS para obter dicas 
de ferramentas valiosas que vão ajudá-lo a compreender os 
elementos que controlam o projeto. Consulte Capítulo 7, “Criar 
layouts de páginas com CSS”, na página 219.

Barra de ferramentas Style 
Rendering (Processamento 
de estilo)

Visualize o conteúdo do mesmo modo que os usuários, não 
importando o mecanismo de entrega, com o novo suporte para 
tipos de mídia CSS. Utilize a barra de ferramentas Style 
Rendering para alternar para a visualização do projeto e ver 
como ele ficará ao ser impresso ou ao ser apresentado em um 
dispositivo portátil ou na tela. Consulte “A barra de ferramentas 
Style Rendering” na página 54.

Aprimoramentos no 
processamento de CSS

Veja como os layouts de CSS complexos serão processados 
na maioria dos navegadores, com aprimoramentos 
substanciais na precisão da visualização do projeto. Agora o 
Dreamweaver oferece suporte total a técnicas avançadas de 
CSS, como estouro, pseudo-elementos e elementos de 
formulário.

Acessibilidade: Suporte 
para pontos de verificação 
de prioridade 2 da WCAG/
W3C

Além da ferramenta integrada de avaliação da acessibilidade 
referente à Seção 508 e os pontos de verificação de prioridade 
1 da WCAG, agora o Dreamweaver suporta o CSS e a 
acessibilidade utilizando uma ferramenta de avaliação 
atualizada que inclui pontos de verificação de prioridade 2 da 
WCAG.

WebDAV aprimorado Agora no Dreamweaver 8, o WebDAV suporta autenticação 
resumida e SSL para transferência segura de arquivos, e 
oferece conectividade aprimorada com um conjunto maior de 
servidores. Consulte “Utilizar o protocolo WebDAV para 
devolver e retirar arquivos” na página 151.

Trabalhar com as melhores práticas
Novidades do Dreamweaver 8 21



         
Obtenha mais resultados em menos tempo com fluxos de trabalho de usuário aprimorados 
que reduzem o tempo necessário para completar tarefas comuns. O Dreamweaver 8 simplifica 
os pequenos detalhes para que você possa gastar mais tempo desenhando e desenvolvendo sites 
da Web e aplicativos que sejam interessantes.

Obtenha mais resultados

Transferência de arquivos 
em segundo plano

Continue trabalhando enquanto o Dreamweaver 8 faz o upload 
de arquivos para o servidor. Para obter mais informações, 
consulte “Gerenciar transferências de arquivos” na página 160.

Zoom Tenha um controle maior sobre o seu desenho com o zoom. 
Amplie uma imagem e inspecione-a ou trabalhe com um layout 
complexo de tabela aninhada. Reduza o zoom para visualizar a 
aparência que uma página terá. Para obter mais informações, 
consulte “Aplicar zoom” na página 389.

Guias Compare o layout de página a esboços de páginas com a 
precisão de pixels perfeitos, utilizando guias para medir layouts 
de página. A visualização das alterações ajuda a medir 
distâncias com precisão e suporta encaixes inteligentes. Para 
obter mais informações, consulte “Utilizar guias” na página 251.

Barra de ferramentas 
Coding (Codificação)

A nova barra de ferramentas Coding fornece botões para 
recursos comuns de codificação em uma barra da medianiz ao 
longo da lateral da visualização de código. Para obter mais 
informações, consulte “Inserir código rapidamente com a barra 
de ferramentas Coding (Codificação)” na página 617.

Redução de código Concentre-se apenas no código que você deseja ver, ocultando 
e expandindo blocos de código. Para obter mais informações, 
consulte “Reduzir e expandir fragmentos de código” na 
página 623.

Layouts da área de trabalho Personalize e salve configurações da área de trabalho. O 
Dreamweaver 8 é fornecido com quatro configurações 
diferentes, feitas sob medida para as necessidades de 
designers e codificadores. Também é possível criar uma área 
de trabalho personalizada. Para obter mais informações, 
consulte “Salvar layouts personalizados da área de trabalho” na 
página 80.

Documentos com guias 
para Macintosh

Novas guias de documentos no Mac ajudam a simplificar a 
interface do usuário e facilitam a seleção de documentos. Para 
obter mais informações, consulte “Exibir documentos com 
guias (Macintosh)” na página 79.

Novas páginas do iniciante Novos layouts e desenhos permitem criar sites rapidamente.
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Sincronia do site e sistema 
de devoluções/retiradas 
aprimorados

Gerencie sites com mais confiabilidade. Os recursos de 
sincronização aprimorada de sites ajudam a garantir que o 
arquivo que está em uso é a versão mais recente. Evite 
substituições acidentais do trabalho de outras pessoas 
utilizando uma funcionalidade aprimorada de devoluções e 
retiradas. Para obter mais informações, consulte “Sincronizar 
os arquivos nos sites local e remoto” na página 161.

Comparar arquivos Compare arquivos rapidamente para identificar quais foram as 
alterações. Você pode comparar dois arquivos locais, um 
arquivo do computador local e um do computador remoto ou 
dois arquivos do computador remoto. Utilize sua ferramenta 
favorita de comparação de arquivos com o Dreamweaver, nas 
plataformas Macintosh e Windows. Para obter mais 
informações, consulte “Comparar arquivos para conhecer as 
diferenças” na página 126.

Paste Special (Colar 
especial)

Com as novas opções de colagem do Dreamweaver, você pode 
reter toda a formatação de origem criada no Microsoft Word ou 
apenas colar o texto. Para obter mais informações, consulte 
“Adicionar texto a um documento” na página 418.

Referências relativas a sites Trabalhe de forma totalmente integrada com inclusões do 
servidor na fase de projeto e execução, certificando-se de que 
as referências são relativas a sites e não a arquivos locais. Para 
obter mais informações, consulte “Definir o caminho relativo de 
novos links” na página 473.

Aprimoramentos na edição 
de códigos

Tenha um maior controle sobre como o Dreamweaver fornece 
referências de código e tags completas que se ajustam ao seu 
estilo de código. 

Obtenha mais resultados
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O Dreamweaver 8 suporta esforços para assimilar e tirar proveito de novas tecnologias, 
incluindo PHP 5, Flash Video, ColdFusion MX 7 e o Macromedia Web Publishing System.

Onde iniciar
A documentação do Dreamweaver inclui informações para leitores de vários níveis. Para tirar 
o melhor proveito desta documentação, inicie lendo as partes mais adequadas ao seu nível 
de experiência. 

Para obter informações sobre recursos do Dreamweaver, consulte “Guia para a mídia de 
treinamento do Dreamweaver” na página 36.

Novidades do projeto da Web
Se você estiver começando a criar desenhos da Web, esta seção indicará as seções da 
documentação do Dreamweaver mais apropriadas para o seu nível de experiência.

Integrado às tecnologias e aos padrões mais recentes

Suporte ao ColdFusion MX 
7

O suporte atualizado ao ColdFusion MX 7 inclui novos 
comportamentos de servidor e referências de código. Para 
estabelecer a correspondência das referências de código e da 
depuração com a versão correta do ColdFusion, o 
Dreamweaver detecta automaticamente a versão do servidor 
na primeira conexão com o site. A estreita integração do 
Dreamweaver com o ColdFusion permite adicionar e remover 
bancos de dados diretamente no painel Databases (Bancos de 
dados) e visualizar apenas os componentes ColdFusion 
definidos no site atual. Para obter mais informações, consulte 
“Ativar os aprimoramentos do ColdFusion” na página 916.

Suporte ao PHP 5 Tire proveito do suporte atualizado ao PHP 5, incluindo 
comportamentos de servidor e referências de código.

Flash Video Insira um arquivo Flash Video com rapidez e facilidade em uma 
página da Web. Para obter mais informações, consulte “Inserir 
conteúdo do Flash Video” na página 530.

Macromedia Web 
Publishing System: 
notificação e registro de 
eventos

Controle tudo que ocorre no seu site. Os eventos do 
Dreamweaver são notificados ao servidor do Macromedia Web 
Publishing System, de modo que são registradas todas as 
alterações de um site da Web no sistema WPS.

Material de referência 
atualizado de O'Reilly

Consulte novo conteúdo de referência para XML, XSLT e 
XPath, e conteúdo atualizado para ASP e JSP.
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Para iniciantes em desenho da Web:

1. Inicie pela leitura dos tutoriais no Getting Started in Dreamweaver.

2. Em Usando o Dreamweaver (Help [Ajuda]> Using Dreamweaver [Usando o 
Dreamweaver]), leia Capítulo 1, “Explorar a área de trabalho”, na página 43, Capítulo 2, 
“Configurar um site do Dreamweaver”, na página 87, Capítulo 4, “Gerenciar arquivos”, na 
página 113 e Capítulo 3, “Criar e abrir documentos”, na página 101.

3. Aprenda sobre layouts de páginas no Capítulo 9, “Criação de páginas no modo Layout”, 
na página 283.

4. Para saber como formatar texto e incluir imagens nas páginas, consulte o Capítulo 13, 
“Inserir e formatar texto”, na página 405 e o Capítulo 14, “Inserir imagens”, na 
página 445.

Isso é tudo de você precisa para começar a produzir sites da Web de alta qualidade. Quando 
estiver pronto para aprender a utilizar ferramentas mais avançadas, poderá continuar lendo os 
capítulos restantes sobre páginas estáticas, em Usando o Dreamweaver. Talvez seja mais 
conveniente adiar a leitura dos capítulos sobre páginas dinâmicas para quando estiver criando 
páginas da Web.

Designers da Web experientes
Se você for um designer experiente da Web, esta seção indicará as seções da documentação do 
Dreamweaver mais adequadas ao seu nível de experiência. Existem dois métodos diferentes: 
um para designers iniciantes do Dreamweaver e outro para designers experientes do 
Dreamweaver que gostariam de aprender mais sobre a criação de páginas dinâmicas.

Para os designers experientes da Web que ainda não trabalharam com o 
Dreamweaver:

1. Inicie pela leitura dos tutoriais no Getting Started in Dreamweaver.

2. Em Usando o Dreamweaver, leia Capítulo 1, “Explorar a área de trabalho”, na página 43 
para aprender mais sobre a interface de usuário do Dreamweaver.

3. Embora provavelmente você esteja familiarizado com grande parte do conteúdo em 
Capítulo 2, “Configurar um site do Dreamweaver”, na página 87 e Capítulo 4, “Gerenciar 
arquivos”, na página 113, examine esses capítulos para saber como os conceitos já 
conhecidos são implementados no Dreamweaver. Dê atenção especial às seções que tratam 
da configuração de um site do Dreamweaver.

4. Para obter informações úteis sobre os detalhes da utilização do Dreamweaver na criação de 
páginas HTML básicas, consulte Capítulo 13, “Inserir e formatar texto”, na página 405 e 
Capítulo 14, “Inserir imagens”, na página 445.
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5. Para obter informações sobre a codificação no Dreamweaver, consulte “Configurar o 
ambiente de codificação” na página 583, “Codificar no Dreamweaver” na página 603, 
“Otimizar e depurar o código” na página 633 e “Editar o código na Design View 
(Visualização do projeto)” na página 643.

6. Consulte a visão geral, no início de cada um dos outros capítulos em Usando o Dreamweaver 
para verificar se os tópicos são de seu interesse.

Para os designers experientes da Web, que já estão familiarizados com o 
Dreamweaver, e desejam aprender a criar páginas dinâmicas:

1. Inicie pela leitura de Appendix A, “Understanding Web Applications” e “Tutorial: 
Developing a Web Application” no Getting Started with Dreamweaver.

2. Em Usando o Dreamweaver, leia o Capítulo 1, “Explorar a área de trabalho”, na página 43 
para aprender sobre os novos aspectos da interface de usuário do Dreamweaver e depois leia 
“Otimizar a área de trabalho para desenvolvimento visual” na página 721.

3. Familiarize-se com o fluxo de trabalho do Dreamweaver para páginas dinâmicas lendo 
“Fluxo de trabalho para projetos de páginas dinâmicas” na página 735.

4. Configure um servidor da Web e um servidor de aplicativos. Consulte Capítulo 23, 
“Configurar um aplicativo para a Web”, na página 657.

5. Conecte-se a um banco de dados. Consulte “Efetuar a conexão com um banco de dados” 
na página 668.

6. Leia a visão geral, no início de cada um dos outros capítulos em Usando o Dreamweaver, 
para verificar se os tópicos são de seu interesse.

7. Se estiver interessado em personalizar manualmente o Dreamweaver, leia “Customizing 
Dreamweaver“ (Personalização do Dreamweaver)  no Centro de Suporte da Macromedia, 
em www.macromedia.com/go/customizing_dreamweaver. Se desejar criar extensões para o 
Dreamweaver, leia Extending Dreamweaver (Extensão dos recursos do Dreamweaver).

Codificadores manuais experientes
Se você for um codificador manual experiente, esta seção indicará as seções da documentação 
do Dreamweaver mais adequadas ao seu nível de experiência.

Para os codificadores manuais experientes:

1. Em Usando o Dreamweaver, leia Capítulo 1, “Explorar a área de trabalho”, na página 43 
para aprender mais sobre a interface de usuário do Dreamweaver.
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2. Embora você esteja provavelmente familiarizado com grande parte do conteúdo em 
Capítulo 2, “Configurar um site do Dreamweaver”, na página 87 e Capítulo 4, “Gerenciar 
arquivos”, na página 113, examine esses capítulos para saber como os conceitos já 
conhecidos são implementados no Dreamweaver. Dê atenção especial às seções que tratam 
da configuração de um site do Dreamweaver.

3. Para mais detalhes sobre codificação com o Dreamweaver, consulte o Capítulo 19, 
“Configurar o ambiente de codificação”, na página 583, Capítulo 20, “Codificar no 
Dreamweaver”, na página 603, Capítulo 21, “Otimizar e depurar o código”, na página 633 
e Capítulo 22, “Editar o código na Design View (Visualização do projeto)”, na página 643.

4. Leia a visão geral, no início de cada um dos outros capítulos em Usando o Dreamweaver, 
para verificar se os tópicos são de seu interesse.

Desenvolvedores de aplicativos para a Web
Se você for um desenvolvedor de aplicativos para a Web, esta seção indicará as seções da 
documentação do Dreamweaver mais apropriadas ao seu nível de experiência. Há dois 
métodos diferentes: um para quem já utilizou o Dreamweaver anteriormente e outro para 
aqueles que ainda não o utilizaram.

Para os desenvolvedores de aplicativos para a Web que ainda não utilizaram o 
Dreamweaver: 

1. Inicie pela leitura rápida de Getting Started with Dreamweaver para familiarizar-se com os 
conceitos básicos sobre a utilização do Dreamweaver.

2. Em Usando o Dreamweaver, leia Capítulo 1, “Explorar a área de trabalho”, na página 43 
para aprender mais sobre a interface de usuário do Dreamweaver.

3. Embora você esteja provavelmente familiarizado com grande parte do conteúdo em 
Capítulo 2, “Configurar um site do Dreamweaver”, na página 87 e Capítulo 4, “Gerenciar 
arquivos”, na página 113, examine esses capítulos para saber como os conceitos já 
conhecidos são implementados no Dreamweaver. Dê atenção especial às seções que tratam 
da configuração de um site do Dreamweaver.

4. Configurar um servidor da Web e um servidor de aplicativos utilizando o Dreamweaver. 
Consulte Capítulo 23, “Configurar um aplicativo para a Web”, na página 657.

5. Conecte-se a um banco de dados. Consulte “Efetuar a conexão com um banco de dados” 
na página 668.

6. Leia a visão geral, no início de cada um dos outros capítulos em Usando o Dreamweaver, 
para verificar se os tópicos são de seu interesse.
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Para os desenvolvedores experientes de aplicativos para a Web que já 
utilizaram o Dreamweaver:

1. Comece pela leitura de “Novidades do Dreamweaver 8” na página 20.

2. Em Usando o Dreamweaver, leia o Capítulo 1, “Explorar a área de trabalho”, na página 43 
para aprender sobre os novos aspectos da interface de usuário do Dreamweaver.

3. Se estiver interessado em personalizar manualmente o Dreamweaver, leia “Customizing 
Dreamweaver“ (Personalização do Dreamweaver)  no Centro de Suporte da Macromedia, 
em www.macromedia.com/go/customizing_dreamweaver. Se desejar criar extensões para o 
Dreamweaver, leia Extending Dreamweaver.

Fluxo de trabalho do Dreamweaver para 
criar sites da Web
Há diversos métodos possíveis para se criar um site da Web. O fluxo de trabalho apresentado 
nesta documentação inicia-se pela definição da estratégia ou dos objetivos de um site. Se você 
estiver desenvolvendo um aplicativo para a Web, será preciso configurar os servidores e bancos 
de dados de acordo com a necessidade. Em seguida, o usuário projetará a aparência do site. 
Quando o projeto estiver completo, serão criados o site e as páginas de código, adicionando o 
conteúdo e a interatividade. Em seguida, as páginas serão vinculadas e a funcionalidade do site 
será testada para verificar se atende aos objetivos definidos. É possível incluir também páginas 
dinâmicas no site. No final do ciclo, o site é publicado em um servidor. Muitos programadores 
efetuam ainda uma manutenção periódica para assegurar que o site permaneça atualizado e 
funcional.

Planejar o site
O cuidado no planejamento e na organização do site desde o início pode economizar tempo 
posteriormente. A organização do site não consiste apenas em determinar onde os arquivos 
serão armazenados, mas também examinar os requisitos e objetivos do site, bem como o perfil 
do público-alvo. Além disso, é necessário considerar certos requisitos técnicos, como o acesso 
dos usuários e também as restrições do navegador, dos plug-ins e de download. 

Quando as informações estiverem organizadas e a estrutura tiver sido determinada, é possível 
iniciar a criação do seu site.
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■ Utilize o painel Files (Arquivos) do Dreamweaver para configurar a estrutura 
organizacional do site. No painel Files, é possível adicionar, excluir e renomear arquivos e 
pastas com facilidade para alterar a organização de acordo com as suas necessidades. 
(Consulte Capítulo 2, “Configurar um site do Dreamweaver”, na página 87 e Capítulo 4, 
“Gerenciar arquivos”, na página 113).

■ Inicie criando páginas simples que poderão se tornar mais complexas posteriormente. Crie 
novas páginas em branco ou páginas baseadas em projetos de página predefinidos. 
Consulte Capítulo 3, “Criar e abrir documentos”, na página 101.

Caso você faça parte de uma equipe de desenvolvimento para a Web, os tópicos a seguir 
poderão ser do seu interesse:

■ Configure um sistema para evitar que os membros da equipe substituam os arquivos. 
Consulte “Devolver e retirar arquivos” na página 148.

■ Utilize as Design Notes (Notas de design) para se comunicar com os membros da equipe 
da Web. Consulte “Armazenar informações sobre arquivos nas Design Notes” na 
página 167.

Gerenciar arquivos de sites
Os painéis Files e Assets (Propriedades) do Dreamweaver facilitam o gerenciamento de 
arquivos de site.

■ No painel Files do Dreamweaver, você obterá várias ferramentas para ajudar a gerenciar o 
site, transferir arquivos de/para um servidor remoto, configurar um processo de 
devolução/retirada, para evitar que os arquivos sejam substituídos, e sincronizar os 
arquivos nos seus sites local e remoto. Consulte “Gerenciar arquivos” na página 113.

■ O painel Assets permite organizar facilmente as propriedades em um site. A maioria das 
propriedades pode ser arrastada diretamente do painel Assets para um documento do 
Dreamweaver. Consulte Capítulo 5, “Gerenciar bibliotecas e propriedades de sites”, na 
página 177.

■ Você pode utilizar o Dreamweaver para gerenciar aspectos dos sites do Contribute. 
Consulte Capítulo 6, “Gerenciar sites do Contribute com o Dreamweaver”, na 
página 201.

Criar o layout de páginas da Web
O Dreamweaver oferece a flexibilidade necessária durante os processos de teste e criação de 
um layout final para as páginas. Escolha sua técnica de layout preferida ou utilize as opções de 
layout do Dreamweaver juntas para criar uma aparência para o seu site.
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■ Você pode utilizar os estilos de posicionamento CSS ou as camadas do Dreamweaver para 
criar um layout. Consulte Capítulo 7, “Criar layouts de páginas com CSS”, na 
página 219.

■ As ferramentas de tabelas e a visualização de layout no Dreamweaver permitem projetar 
rapidamente as páginas da Web, através do desenho e da reorganização da estrutura da 
página. (Consulte Capítulo 8, “Apresentar conteúdo com tabelas”, na página 257 e 
Capítulo 9, “Criação de páginas no modo Layout”, na página 283).

■ Para exibir vários documentos simultaneamente em um navegador da Web, é possível criar 
documentos utilizando quadros. Consulte Capítulo 10, “Utilização de quadros”, na 
página 303.

■ Os modelos do Dreamweaver permitem aplicar facilmente projetos de páginas e conteúdo 
reutilizáveis ao site. Novas páginas podem ser criadas com base em um modelo do 
Dreamweaver e, em seguida, seu layout poderá ser atualizado automaticamente quando o 
modelo for alterado. Consulte Capítulo 11, “Gerenciar modelos”, na página 325.

Adicionar conteúdo a páginas
Com o Dreamweaver, é possível adicionar facilmente diversos tipos de conteúdo às páginas da 
Web. Adicione propriedades e elementos de projeto, como texto, imagens, cores, filmes, som e 
outras formas de mídia. 

■ Os recursos de criação de páginas do Dreamweaver permitem especificar propriedades de 
páginas da Web, como títulos, imagens de fundo e cores. Além disso, o Dreamweaver 
fornece ferramentas para ajudar a maximizar o desempenho do site da Web e testar as 
páginas para garantir a compatibilidade com diversos navegadores da Web. Consulte 
Capítulo 12, “Trabalhar com páginas”, na página 375.

■ Digite diretamente em um documento do Dreamweaver ou importe o texto de outros 
documentos e, em seguida, formate o texto utilizando o Property inspector (Inspetor de 
propriedades) do Dreamweaver. É possível criar facilmente as suas próprias folhas de 
estilos em cascata (CSS). Consulte Capítulo 13, “Inserir e formatar texto”, na página 405.

■ Insira imagens, incluindo imagens cambiáveis, mapas de imagens e imagens cortadas do 
Fireworks, e utilize as ferramentas de alinhamento para posicionar as imagens em uma 
página. Também é possível redimensionar imagens diretamente no Dreamweaver. 
(Consulte Capítulo 14, “Inserir imagens”, na página 445 e Capítulo 16, “Trabalhar com 
outros aplicativos”, na página 497).

■ Com o Dreamweaver, é possível criar links HTML padrão, incluindo links âncora e de 
correio eletrônico ou configurar facilmente sistemas de navegação gráfica, como menus de 
salto e barras de navegação. Consulte Capítulo 15, “Links e navegação”, na página 461.
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■ Insira outros tipos de mídia numa página da Web, como filmes Flash, Shockwave e 
QuickTime, som e miniaplicativos. Consulte Capítulo 17, “Adicionar áudio, vídeo e 
elementos interativos”, na página 515.

■ Utilize os comportamentos para realizar tarefas em resposta a determinados eventos, como 
o realce de um botão quando o visitante passar o ponteiro sobre ele, a validação de um 
formulário quando o visitante clicar no botão Submit (Enviar) ou a abertura de uma 
segunda janela do navegador quando a página principal terminar de ser carregada. 
Consulte Capítulo 18, “Utilizar comportamentos JavaScript”, na página 541.

Codificação manual
A codificação manual de páginas é outro método de criação de páginas. O Dreamweaver 
fornece ferramentas de edição visual fáceis de usar, além de um sofisticado ambiente de 
codificação. Você pode utilizar um dos métodos, ou ambos, para criar e editar suas páginas.

■ É possível trabalhar em um ambiente de codificação sem utilizar as ferramentas visuais. 
Essas ferramentas ajudam a criar e editar o código, formatá-lo e verificar sua 
compatibilidade com os padrões. Consulte Capítulo 19, “Configurar o ambiente de 
codificação”, na página 583, Capítulo 20, “Codificar no Dreamweaver”, na página 603 e 
Capítulo 21, “Otimizar e depurar o código”, na página 633.

■ É possível também utilizar as ferramentas de codificação no modo de visualização do 
projeto, que é o ambiente de criação visual do Dreamweaver. Consulte Capítulo 22, 
“Editar o código na Design View (Visualização do projeto)”, na página 643.

Configurar um aplicativo para a Web
Vários sites da Web contêm páginas dinâmicas que permitem aos visitantes exibir as 
informações armazenadas em bancos de dados. Além disso, alguns visitantes podem adicionar 
informações aos bancos de dados e editá-las. Para criar essas páginas, é necessário executar 
várias etapas preparatórias.

■ Configurar um servidor da Web e um servidor de aplicativos, em seguida, criar ou 
modificar um site do Dreamweaver. Consulte Capítulo 23, “Configurar um aplicativo 
para a Web”, na página 657.

■ Conecte-se a um banco de dados. Consulte “Efetuar a conexão com um banco de dados” 
na página 668.
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Criar páginas dinâmicas
No Dreamweaver, é possível definir várias origens de conteúdo dinâmico, inclusive recordsets 
extraídos de bancos de dados, parâmetros de formulário e componentes de software 
reutilizáveis para Java. Para adicionar o conteúdo dinâmico a uma página, basta arrastá-lo até a 
página. 

A página pode ser definida para exibir um ou muitos registros de uma só vez, mais de uma 
página de registros, adicionar links especiais para que se possa passar de uma página de 
registros à próxima (e retornar) e criar contadores de registros, para ajudar os usuários a 
controlar os registros.

■ Se você não estiver familiarizado com a criação de aplicativos para a Web no 
Dreamweaver, aprenda a utilizar o Dreamweaver para criar páginas dinâmicas. (Consulte 
Capítulo 30, “Otimizar a área de trabalho para desenvolvimento visual”, na página 721 e 
Capítulo 31, “Fluxo de trabalho para projetos de páginas dinâmicas”, na página 735).

■ Defina e exiba o conteúdo dinâmico nas suas páginas. Consulte Capítulo 32, “Obter 
dados para a página”, na página 745, Capítulo 33, “Definir as fontes de 
conteúdo dinâmico”, na página 759, Capítulo 34, “Adicionar conteúdo dinâmico a 
páginas da Web”, na página 781 e Capítulo 35, “Exibir registros de bancos de dados”, na 
página 793.

■ Encapsule aplicativos ou lógica empresarial utilizando tecnologias avançadas, como os 
serviços da Web e os componentes do Macromedia ColdFusion. (Consulte “Utilizar 
componentes ColdFusion” na página 978 e Capítulo 37, “Usar os serviços da Web”, na 
página 847).

■ Se necessitar de mais flexibilidade, crie os seus próprios comportamentos de servidor e 
formulários interativos. (Consulte Capítulo 38, “Adicionar comportamentos de servidor 
personalizados”, na página 861 e Capítulo 39, “Criar formulários”, na página 885).

Desenvolvimento rápido de aplicativos
O Dreamweaver oferece várias ferramentas de desenvolvimento rápido de aplicativos (RAD, 
Rapid Application Development), incluindo comportamentos de servidor e objetos de 
aplicativo, que ajudam a criar aplicativos para a Web sofisticados, sem a necessidade de gerar 
um código do servidor.

■ Crie rapidamente páginas que efetuam buscas e modificam bancos de dados, além de 
exibir os resultados da pesquisa. Ofereça segurança restringindo o acesso às páginas. 
Consulte “Criar aplicativos ColdFusion rapidamente” na página 909, “Criar aplicativos 
ASP.NET rapidamente” na página 987, “Criar aplicativos ASP e JSP rapidamente” na 
página 1033 e “Criar aplicativos PHP rapidamente” na página 1057.
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Utilizar o Dreamweaver com outros 
aplicativos
O Dreamweaver adapta o seu desenho da Web e o processo de desenvolvimento, facilitando, 
assim, o trabalho com outros aplicativos. Para obter informações sobre o trabalho com outros 
aplicativos, como navegadores, editores de HTML e de imagens, e ferramentas de animação, 
consulte os seguintes tópicos: 

■ Para obter informações sobre a utilização do Dreamweaver com outros editores de 
HTML, como HomeSite ou BBEdit, consulte “Utilizar um editor de HTML externo com 
o Dreamweaver” na página 599. 

■ É possível especificar os navegadores preferidos para visualizar o site. Consulte “Visualizar 
e testar páginas em navegadores” na página 399.

■ É possível iniciar um editor de imagens externo, como o Macromedia Fireworks ou o 
Adobe Photoshop, no Dreamweaver. Consulte “Usar um editor de imagens externo” na 
página 458.

■ É possível configurar o Dreamweaver para iniciar um editor diferente de acordo com o 
tipo de arquivo. Consulte “Iniciar um editor de arquivos de mídia externo” na página 521.

■ Para obter informações sobre como adicionar interatividade no seu site utilizando o 
Macromedia Flash, consulte “Inserir e modificar um objeto de botão Flash” na 
página 523,“Inserir um objeto de texto do Flash” na página 526 ou “Fazer o download e 
instalar os elementos Flash” na página 527.

■ Para obter informações sobre como utilizar o ColdFusion, consulte Using ColdFusion 
(Usando o ColdFusion) (Help> Using ColdFusion).

Dreamweaver e acessibilidade
A acessibilidade refere-se a projetar sites e produtos da Web úteis para portadores de 
deficiência auditiva, visual, motora e outras. Os exemplos de recursos de acessibilidade para 
produtos de software e sites da Web incluem suporte à leitora de tela, equivalentes de texto 
para gráfico, atalhos de teclado, alteração de cores para alto contraste, etc.

O Dreamweaver fornece ferramentas que tornam o produto acessível e ajudam a criar 
conteúdo acessível. 

N
O

T
A

Para obter mais informações sobre duas iniciativas de acessibilidade importantes, 
consulte World Wide Web Consortium Web Accessibility Initiative (www.w3.org/wai) e 
a seção 508 da Lei Federal sobre Reabilitação dos Estados Unidos 
(www.section508,gov).
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Utilização de recursos de acessibilidade do Dreamweaver  Para os designers da Web do 
Dreamweaver que precisam utilizar recursos de acessibilidade, o Dreamweaver oferece suporte 
para leitoras de tela, navegação por teclado e acessibilidade do sistema operacional.

Para obter mais informações, consulte “Utilizar os recursos de acessibilidade do Dreamweaver” 
na página 70.

Autoria para acessibilidade  Para os designers da Web do Dreamweaver que precisam criar 
conteúdo acessível, o Dreamweaver ajuda a produzir páginas acessíveis com conteúdo útil para 
leitoras de tela que seguem as diretrizes do governo. 

O Dreamweaver oferece caixas de diálogo onde você deve fornecer atributos de acessibilidade 
ao inserir elementos de página (consulte “Otimizar a área de trabalho para o projeto de página 
acessível” na página 76). Por exemplo, a caixa de diálogo de acessibilidade para imagens lembra 
que você deve adicionar equivalentes em texto aos diagramas. Em seguida, quando a imagem 
aparece na página para um usuário com deficiência visual, a leitora de tela lê a descrição.

O Dreamweaver também fornece exemplos de páginas da Web projetadas para oferecer 
acessibilidade (consulte “Criar um documento com base em um arquivo de projeto do 
Dreamweaver” na página 103) e um relatório de acessibilidade que você pode executar para 
testar sua página ou site em relação às diretrizes de acessibilidade contidas na seção 508 
(consulte “Testar o site” na página 171).

N
O

T
A

Lembre-se de que nenhuma ferramenta de autoria pode automatizar o processo de 
desenvolvimento. O projeto de sites da Web acessíveis exige que você compreenda os 
requisitos de acessibilidade e tome várias decisões subjetivas sobre a forma como os 
usuários com deficiências interagem com páginas da Web. A melhor maneira de garantir 
que um site da Web está acessível é por meio de planejamento deliberado, 
desenvolvimento, teste e avaliação.
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O recurso de validação de acessibilidade do 
Dreamweaver 
O recurso de validação de acessibilidade do Dreamweaver utiliza a tecnologia da UsableNet. A 
UsableNet é líder no desenvolvimento de software fácil de utilizar para automatizar a 
utilização e o processo de correção e teste de acessibilidade. Para obter auxílio adicional com o 
teste de acessibilidade, use o UsableNet LIFT for Macromedia Dreamweaver, uma solução 
completa para desenvolvimento de sites da Web úteis e acessíveis. O UsableNet Lift for 
Macromedia Dreamweaver inclui assistentes de correção para tabelas complexas, formulários e 
imagens, um editor ALT global, relatórios personalizáveis e um novo modo de 
monitoramento ativo que garante a acessibilidade do conteúdo durante a criação das páginas. 
Solicite uma demonstração do Lift for Macromedia Dreamweaver em www.usablenet.com.
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Guia para a mídia de treinamento do 
Dreamweaver 
O Dreamweaver inclui várias mídias para ajudá-lo rapidamente a programar e a tornar-se um 
autor experiente de páginas e sites da Web. O sistema de Ajuda do Dreamweaver inclui vários 
documentos para ajudá-lo a conhecer o Dreamweaver, Dreamweaver Extensibility e 
ColdFusion. Há também diversos recursos online adicionais que você poderá consultar 
quando souber criar páginas da Web.

Acessar a documentação do Dreamweaver
A tabela a seguir resume a documentação incluída no sistema de Ajuda do Dreamweaver.

É possível adquirir as versões impressas dos títulos selecionados. Para obter mais informações, 
consulte www.macromedia.com/go/buy_books.

Título Descrição/
Público

Onde encontrar

Getting Started 
with 
Dreamweaver 
(Guia de 
introdução ao 
Dreamweaver)

Fornece uma 
introdução básica 
aos conceitos e à 
interface do 
Dreamweaver, 
com tutoriais 
detalhados para 
iniciantes. 
Destina-se a 
usuários 
iniciantes, bem 
como a usuários 
intermediários e 
avançados que 
tenham interesse 
em conhecer 
novos recursos.

• Visualize no Dreamweaver: 
Selecione Help > Getting Started 
with Dreamweaver

• Visualize online: http://
livedocs.macromedia.com/go/
livedocs_dreamweaver/

• Obtenha o PDF: 
www.macromedia.com/go/
dw_documentation
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Usando o 
Dreamweaver

Informações 
completas sobre 
todos os recursos 
do Dreamweaver. 
Destina-se a 
todos os usuários 
do Dreamweaver.

• Visualize no Dreamweaver: 
Selecione Help > Dreamweaver 
Help (Ajuda do Dreamweaver) ou 
Help > Using Dreamweaver

• Visualize online: http://
livedocs.macromedia.com/go/
livedocs_dreamweaver/

• Obtenha o PDF: 
www.macromedia.com/go/
dw_documentation

Extending 
Dreamweaver

Descreve a 
estrutura e a API 
(interface de 
programação de 
aplicativos) do 
Dreamweaver. 
Destina-se a 
usuários 
avançados que 
desejem criar 
extensões e 
personalizar a 
interface do 
Dreamweaver.

• Visualize no Dreamweaver: 
Selecione Help > Extending 
Dreamweaver

• Visualize online: http://
livedocs.macromedia.com/go/
livedocs_dreamweaver/

• Obtenha o PDF: 
www.macromedia.com/go/
dw_documentation

Dreamweaver 
API Reference 
(Manual de 
Referência da API 
do Dreamweaver)

Descreve a API 
do utilitário e a 
API JavaScript, 
sendo que ambas 
permitem 
executar várias 
tarefas de suporte 
ao desenvolver 
extensões do 
Dreamweaver. 
Destina-se a 
usuários 
avançados que 
desejem criar 
extensões e 
personalizar a 
interface do 
Dreamweaver.

• Visualize no Dreamweaver: 
Selecione Help > Dreamweaver 
API Reference

• Visualize online: http://
livedocs.macromedia.com/go/
livedocs_dreamweaver/

• Obtenha o PDF: 
www.macromedia.com/go/
dw_documentation

Título Descrição/
Público

Onde encontrar
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Using ColdFusion 
(Usando o 
ColdFusion)

Inclui uma 
seleção dos 
manuais mais 
importantes do 
conjunto de 
documentos do 
ColdFusion. (O 
conjunto 
completo 
encontra-se 
disponível no 
LiveDocs.) 
Destina-se a 
qualquer pessoa 
que tenha 
interesse no 
ColdFusion, 
desde iniciantes 
até 
desenvolvedores 
avançados.

• Visualize no Dreamweaver: 
Selecione Help > Using 
ColdFusion

• Visualize online: http://
livedocs.macromedia.com/go/
livedocs_coldfusion/

• Obtenha o PDF: 
www.macromedia.com/go/
cf_documentation

Reference 
(Referência)

Inclui vários tipos 
de manuais de 
referência sobre 
HTML, modelos 
de servidor e 
outros tópicos, 
principalmente 
aqueles que 
foram publicados 
pela editora 
O’Reilly. Destina-
se a qualquer 
pessoa que 
necessite de mais 
informações 
sobre sintaxe de 
códigos, 
conceitos, etc.

• Visualize no Dreamweaver: 
Selecione Help > Reference. Para 
obter uma lista de completa dos 
manuais, clique no menu pop-up 
Book (Manual) no painel 
Reference.

Título Descrição/
Público

Onde encontrar
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Acessar os recursos online adicionais do 
Dreamweaver

A tabela a seguir resume os recursos online adicionais para conhecer o Dreamweaver.

Recurso Descrição/
Público

Onde encontrar

Centro de suporte 
do Dreamweaver

TechNotes, 
suporte e 
informações para 
resolução de 
problemas para 
os usuários do 
Dreamweaver.

www.macromedia.com/go/
dreamweaver_support

Centro de 
desenvolvedores 
Dreamweaver

Artigos e tutoriais 
para ajudar-lhe a 
aprimorar suas 
habilidades e a 
adquirir novas.

www.macromedia.com/go/
dreamweaver_devcenter

Centro de 
recursos de 
documentação do 
Dreamweaver

Manuais do 
produto no 
formato PDF, 
erratas, tutoriais e 
notas de versão.

www.macromedia.com/go/
dw_documentation

Fóruns online 
Macromedia

Discussões e 
informações 
sobre resoluções 
de problemas 
com a 
participação de 
usuários do 
Dreamweaver, 
representantes do 
suporte técnico e 
a equipe de 
desenvolvimento 
do Dreamweaver.

www.macromedia.com/go/
dreamweaver_newsgroup

Treinamento da 
Macromedia

Os cursos 
englobam tarefas 
práticas e 
cenários reais.

www.macromedia.com/go/
dreamweaver_training
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Para aproveitar ao máximo os recursos do Dreamweaver, consulte “Onde iniciar” na 
página 24.

Convenções tipográficas
As seguintes convenções tipográficas são utilizadas neste guia:

■ Os itens de menu são mostrados neste formato: nome do menu > nome do item de menu. 
Os itens nos submenus são mostrados neste formato: nome do menu > nome do submenu 
> nome do item de menu.

■ Fonte de código indica os nomes de tags e atributos HTML, bem como o texto literal 
usado nos exemplos.

■ Fonte de código em itálico indica os itens substituíveis (às vezes denominados 
metassímbolos) no código. 

■ Texto romano em negrito indica o texto a ser digitado exatamente conforme a indicação.

Para obter uma lista completa de recursos do Dreamweaver, consulte “Guia para a mídia de 
treinamento do Dreamweaver” na página 36.

Recursos de tecnologias da Web e 
HTML
A seguir, estão alguns recursos úteis, disponíveis na Web:

A especificação de nível 1 para estilos CSS (CSS1) (www.w3.org/TR/REC-CSS1) e a 

especificação de nível 2 (CSS2) (www.w3.org/TR/REC-CSS2/) são as especificações 
oficiais para folhas de estilo do World Wide Web Consortium.

A especificação HTML 4.01 (www.w3.org/TR/REC-html40/) é a especificação oficial para 
HTML do World Wide Web Consortium.

Índice DOT HTML (www.blooberry.com/indexdot/html/) é uma lista completa de tags, 
atributos e valores HTML, bem como de sua compatibilidade com os diversos navegadores.

Especificação XHTML 1.0  ((www.w3.org/TR/xhtml1/ ) é a especificação oficial para a 
Extensible Markup HyperText Language.

O site O’Reilly XML.com (www.xml.com/) fornece informações, tutoriais e dicas sobre a 
Extensible Markup Language (XML), bem como outras tecnologias da Web.

N
O

T
A

Para obter uma lista de recursos do Dreamweaver, consulte “Guia para a mídia de 
treinamento do Dreamweaver” na página 36.
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O site xFront (www.xfront.com/rescuing-xslt.html) fornece uma introdução a transformações 
XSL para novos usuários.

As páginas de descrição geral sobre ASP (http://msdn.microsoft.com/library/en-us/
dnasp/html/ASPover.asp) fornecem informações sobre Active Server Pages (ASP).

A página Microsoft ASP.NET (http://msdn.microsoft.com/asp.net/) fornece informações 
sobre ASP.NET.

A página Sun JSP (http://java.sun.com/products/jsp/) fornece informações sobre JavaServer 
Pages (JSP).

O site PHP na Web (www.php.net/) fornece informações sobre PHP.

O site MySQL (www.mysql.com/) fornece informações sobre MySQL.

A tabela de entidades (www.bbsinc.com/iso8859.html) apresenta uma lista de nome de 
entidades utilizadas pelo padrão ISO 8859-1 (Latin-1).

A página do produto Macromedia ColdFusion (www.macromedia.com/go/coldfusion/) 
fornece informações sobre o ColdFusion.

A página do produto Macromedia JRun Server (www.macromedia.com/go/jrun/) fornece 
informações sobre o servidor de aplicativos JRun Java.

Web Services Demystified  (www.sitepoint.com/article/692) explica o que são os serviços da 
Web e como eles funcionam.

A JavaScript Bible, de autoria de Danny Goodman (IDG Books), oferece uma abordagem 
abrangente da linguagem JavaScript 1.2.

JavaScript: O Definitive Guide, de autoria de David Flanagan (O’Reilly & Associates), 
fornece informações de referência para cada função, objeto, método, propriedade e 
manipulador de evento JavaScript.

O índice de recursos CGI (www.cgi-resources.com/) contém um conjunto de todas as 
questões relativas a CGI, incluindo scripts prontos, documentação, livros e até mesmo 
programadores que oferecem seus serviços.

O site Common Gateway Interface (http://hoohoo.ncsa.uiuc.edu/cgi/) inclui uma 
introdução à CGI.
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CAPÍTULO 1

Explorar a área de trabalho
Para obter o máximo de aproveitamento do Macromedia Dreamweaver 8, você deverá 
compreender os conceitos básicos inerentes à área de trabalho do Dreamweaver e saber como 
selecionar opções, utilizar os inspetores e os painéis e definir as preferências mais adequadas ao 
seu estilo de trabalho.

Este capítulo contém as seguintes seções:
Sobre a área de trabalho do Dreamweaver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

Trabalhar na janela do documento . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

Utilizar barras de ferramentas, inspetores e menus contextuais . . . . . . . . . . . . . . . . 59

Utilizar painéis e grupos de painéis  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

Utilizar os recursos de acessibilidade do Dreamweaver . . . . . . . . . . . . . . . . . . . . . . . 70

Otimizar a área de trabalho para o projeto de página acessível. . . . . . . . . . . . . . . . . 76

Utilizar guias visuais no Dreamweaver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Dreamweaver conceitos básicos de personalização . . . . . . . . . . . . . . . . . . . . . . . . . . 78

Tópicos relacionados
■ “Otimizar a área de trabalho para desenvolvimento visual” na página 721

Sobre a área de trabalho do 
Dreamweaver 
A área de trabalho do Dreamweaver permite exibir documentos e propriedades de objetos. Ela 
inclui várias operações comuns em barras de ferramentas para que você possa fazer alterações 
em documentos com rapidez.
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O layout da área de trabalho
No Windows, o Dreamweaver fornece um layout -integrado- em uma única janela.  Na área 
de trabalho integrada, todos os painéis e janelas são integrados em uma única janela, que é a 
maior do aplicativo.

N
O

T
A

A área de trabalho do Windows também possui uma opção Coder (Codificador), que, 
por padrão, encaixa os grupos de painéis no lado esquerdo e exibe a janela do 
documento no modo de visualização do código. Para obter mais informações, consulte 
“Utilizar a área de trabalho orientada a codificador (apenas no Windows)” na 
página 585. Para utilizar essa opção, consulte “Escolher o layout de área de trabalho 
(no Windows)” na página 78.

Files (Arquivos), painelProperty inspector (Inspetor de propriedades)Seletor de tags

barra de ferramentas do documento

barra Insert (Inserir)

janela do documento grupos de painéis
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No Macintosh, o Dreamweaver pode exibir vários documentos em uma única janela, com 
guias identificando cada documento. O Dreamweaver também pode exibir uma área de 
trabalho flutuante, na qual cada documento aparece em uma janela individual. Os grupos de 
painéis são inicialmente encaixados juntos, mas podem ser separados e colocados em suas 
próprias janelas. As janelas “encaixam-se” automaticamente umas nas outras, nas laterais da 
tela e na janela do documento, à medida que são arrastadas ou redimensionadas.

Você pode alternar entre layouts diferentes no Windows e no Macintosh. Para obter mais 
informações, consulte “Escolher o layout de área de trabalho (no Windows)” na página 78 e 
“Exibir documentos com guias (Macintosh)” na página 79.

Tópicos relacionados
■ “Elementos da área de trabalho do Dreamweaver” na página 46
■ “Utilizar barras de ferramentas, inspetores e menus contextuais” na página 59 
■ “Utilizar painéis e grupos de painéis” na página 67.

barra Insert

barra de ferramentas do documento

Property inspector

janela do documento

Seletor de tags

grupos de painéis

Files, painel
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Elementos da área de trabalho do Dreamweaver
Esta seção descreve resumidamente alguns elementos da área de trabalho do Dreamweaver.

A página inicial permite que você abra um documento recente ou crie um novo documento. 
Na página inicial, você pode aprender mais sobre o Dreamweaver realizando um tour do 
produto ou um tutorial.

A barra Insert  contém botões para inserir vários tipos de “objetos”, como imagens, tabelas e 
camadas, em um documento. Cada objeto é uma parte do código HTML, que permite definir 
vários atributos à medida que são inseridos. Por exemplo, você pode inserir uma tabela 
clicando no botão Table (Tabela), na barra Insert. Se preferir, inclua os objetos utilizando o 
menu Insert em vez da barra Insert.

A barra de ferramentas do documento contém botões que oferecem opções para diferentes 
visualizações da janela do documento (como visualização do projeto e do código), várias 
opções de exibição e algumas operações comuns, como a visualização em um navegador.

A barra de ferramentas padrão (que não é exibida no layout padrão da área de trabalho) 
contém botões para executar operações comuns dos menus File (Arquivo) e Edit (Editar): 
New (Novo), Open (Abrir), Save (Salvar), Save All (Salvar tudo), Cut (Recortar), Copy 
(Copiar), Paste (Colar), Undo (Desfazer) e Redo (Refazer). Para exibir a barra de ferramentas 
padrão, selecione View (Exibir) > Toolbars (Barras de ferramentas) > Standard (Padrão).

A barra de ferramentas Coding (exibida apenas na visualização de código) contém botões 
que permitem executar várias operações de codificação padrão.

A barra de ferramentas Style Rendering (Processamento de estilo) (oculta por padrão) 
contém botões que possibilitam ver como ficaria o projeto com tipos de mídia diferentes se 
fossem utilizadas folhas de estilo dependentes de mídia. Ela também contém um botão que 
permite ativar ou desativar estilos CSS.

A janela do documento exibe o documento que está sendo criado e editado.

O Property inspector permite que você exiba e altere várias propriedades do objeto ou texto 
selecionado. Cada tipo de objeto apresenta diferentes propriedades. Por padrão, o Property 
inspector não é expandido no layout da área de trabalho Coder.

O seletor de tags, localizado na barra de status situada na parte inferior da janela do 
documento, mostra a hierarquia das tags que fazem parte da seleção atual. Clique em qualquer 
tag na hierarquia para selecioná-la e exibir todo o seu conteúdo. 

N
O

T
A

O Dreamweaver apresenta vários outros painéis, inspetores e janelas. Para abrir os 
painéis, inspetores e janelas do Dreamweaver, utilize o menu Window (Janela). Se não 
conseguir localizar um painel, inspetor ou janela marcado como aberto, selecione 
Window > Arrange Panels (Organizar painéis) para posicionar adequadamente todos os 
painéis abertos.
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Os grupos de painéis são conjuntos de painéis relacionados, agrupados sob um cabeçalho. 
Para expandir um grupo de painéis, clique na seta de expansão à esquerda do nome do grupo. 
Para desencaixar um grupo de painéis, arraste a pinça na extremidade esquerda da barra de 
título do grupo.

O painel Files permite gerenciar arquivos e pastas que façam parte de um site do 
Dreamweaver ou que estejam localizados em um servidor remoto. O painel Files também 
permite acessar todos os arquivos contidos no disco local, de forma semelhante ao Windows 
Explorer (Windows) ou ao Finder (Macintosh). 

Tópicos relacionados
■ “Trabalhar na janela do documento” na página 56
■ “Utilizar barras de ferramentas, inspetores e menus contextuais” na página 59
■ “Utilizar painéis e grupos de painéis” na página 67
■ “Gerenciar arquivos e pastas no painel Files (Arquivos)” na página 132

A janela do documento
A janela do documento mostra o documento que está aberto. É possível selecionar uma das 
seguintes visualizações:

A visualização do projeto é um ambiente de projeto que você utiliza para criar o layout visual 
da página, executar a edição visual e desenvolver rapidamente os aplicativos. Nessa 
visualização, o Dreamweaver exibe uma representação inteiramente editável do documento, 
semelhante à visualização de uma página em um navegador. É possível configurar a 
visualização do projeto para que exiba o conteúdo dinâmico durante o trabalho com o 
documento (consulte “Exibir o Live Data na visualização do projeto” na página 725).

A visualização do código é um ambiente de codificação manual para gravar e editar código 
HTML, JavaScript, de linguagem de servidor — como PHP ou ColdFusion Markup 
Language (CFML) — e qualquer outro tipo de código. Para obter mais informações, consulte 
Capítulo 20, “Codificar no Dreamweaver”, na página 603.

As visualizações do código e do projeto permitem ver o documento nessas duas 
visualizações em uma única janela.

Quando a janela do documento contiver uma barra de título, esta exibirá o título da página e, 
entre parênteses, o nome e o caminho do arquivo. Após o nome do arquivo, o Dreamweaver 
exibirá um asterisco, se você tiver feito alterações ainda não salvas.

No Windows, quando a janela do documento é maximizada no layout de área de trabalho 
integrada, ela não contém a barra de título. Nesse caso, o título da página, e o nome e 
caminho do arquivo aparecerão na barra de título da janela principal da área de trabalho.
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Quando a janela do documento está maximizada, as guias aparecem na parte inferior da área 
da janela do documento, mostrando os nomes de arquivo de todos os documentos que 
estiverem abertos. Para alternar para um documento, clique na sua respectiva guia.

Tópicos relacionados
■ “Trabalhar na janela do documento” na página 56

A barra de ferramentas do documento 
A barra de ferramentas do documento contém botões que permitem alternar rapidamente 
diferentes visualizações do documento: A visualização do código, do projeto e uma 
visualização dividida (que mostra as visualizações do código e do projeto). 

A barra de ferramentas também contém alguns comandos e opções comuns relacionados à 
visualização do documento e à sua transferência entre os sites local e remoto.

As seguintes opções são mostradas na barra de ferramentas do documento:

Show Code View exibe apenas a visualização de código na janela do documento.

Show Code and Design Views exibe a visualização de código em uma parte da janela do 
documento e a visualização do projeto na outra parte. Quando essa visualização combinada é 
selecionada, a opção Design View on Top (Visualização do projeto no alto) torna-se 
disponível no menu View Options. Utilize essa opção para especificar qual visualização 
aparecerá na parte superior da janela do documento.

Show Design View exibe apenas a visualização do projeto na janela do documento.

Server Debug exibe um relatório para ajudar na depuração da página atual do ColdFusion. O 
relatório inclui erros da página, se houver.

Show Code View (Mostrar visualização do código)

Show Design View (Mostrar 
visualização do projeto)

Título do documento

Refresh Design View 
(Atualizar a visualização 
do projeto)

No Browser/Check Errors 
(Sem navegador/Verificar erros)

View Options 
(Opções de exibição)

Show Code and Design Views (Mostrar 
visualizações do código e do projeto)

Preview/Debug in Browser (Visualizar/depurar no navegador)

File Management 
(Gerenciamento de arquivos)

Server Debug 
Visual Aids 
(Auxílios visuais)

Validate Markup (Validar o markup)
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Document Title permite que você digite um título para o documento, que será exibido na 
barra de título do navegador. Se já existir, o título do documento aparecerá nesse campo.

No Browser/Check Errors permite verificar a compatibilidade entre diferentes navegadores.

Validate Markup permite validar o documento atual ou uma tag selecionada.

File Management  exibe o menu pop-up File Management.

Preview/Debug in Browser permite visualizar ou depurar o documento em um navegador. 
Selecione um navegador no menu pop-up.

Refresh Design View atualiza a visualização do projeto do documento após as alterações 
feitas na visualização de código. As alterações feitas na visualização de código não são exibidas 
automaticamente na visualização do projeto até que sejam executadas determinadas ações, por 
exemplo: salvar o arquivo ou clicar neste botão.

View Options permite definir as opções das visualizações de código e do projeto, inclusive 
qual visualização deve aparecer em primeiro plano. As opções do menu são relacionadas à 
exibição atual: a visualização do projeto, a visualização do código ou ambas. Para obter 
informações sobre as opções da visualização do código, consulte “Definir preferências de 
codificação” na página 585. Para obter informações sobre as opções da visualização do projeto, 
consulte “Selecionar elementos na janela do documento” na página 386, “Exibir e editar o 
conteúdo do cabeçalho” na página 654 e “Utilizar guias visuais no Dreamweaver” na 
página 77.

Visual Aidspermite utilizar auxílios visuais diferentes para projetar as páginas.

Tópicos relacionados
■ “Exibir barras de ferramentas” na página 60

A barra de ferramentas padrão
A barra de ferramentas padrão contém botões para executar operações comuns dos menus File 
e Edit : New, Open, Save, Save All, Cut, Copy, Paste, Undo e Redo. Utilize esses botões da 
mesma forma que os comandos equivalentes nos menus.

Para obter mais informações sobre operações, como Open e Save, consulte o Capítulo 3, 
“Criar e abrir documentos”, na página 101.

Tópicos relacionados
■ “Exibir barras de ferramentas” na página 60
Sobre a área de trabalho do Dreamweaver 49



         
A barra de status
A barra de status, situada na parte inferior da janela do documento, fornece informações 
adicionais sobre o documento que está sendo criado.

O seletor de tags mostra a hierarquia das tags que fazem parte da seleção atual. Clique em 
qualquer tag na hierarquia para selecioná-la e exibir todo o seu conteúdo. Clique na tag 
<body> para selecionar o corpo inteiro do documento. Para definir os atributos class ou id 
de uma tag, no seletor de tags, clique com o botão direito do mouse (no Windows) ou 
pressione Ctrl e clique na tag (no Macintosh) e selecione uma classe ou identificação no menu 
contextual.

A ferramenta Hand permite que você clique no documento e arraste-o na janela do 
documento. Clique na ferramenta Select para desativar a ferramenta Hand.

A ferramenta Zoom e o menu pop-up Set Magnification (Definir ampliação) permitem que 
você defina um nível de ampliação para o documento. Para obter mais informações, consulte 
“Aplicar zoom” na página 389.

O menu pop-up Window Size (visível apenas na visualização do projeto) permite 
redimensionar a janela do documento para um tamanho predeterminado ou personalizado. 
Para obter mais informações, consulte “Redimensionar a janela do documento” na página 58.

À direita do menu pop-up Window Size são mostradas as estimativas de tamanho do 
documento e de tempo de download da página, incluindo todos os arquivos dependentes, 
como os arquivos de imagens e de outras mídias. Para obter mais informações, consulte 
“Definir preferências de tamanho e tempo de download” na página 402.

Tópicos relacionados
■ “Definir as preferências da barra de status” na página 59

Tamanho do documento e tempo 
estimado para download

Seletor de tags
Menu pop-up Window Size 
(Tamanho da janela)

Ampliação definida
Ferramenta Zoom

Ferramenta Hand (Mão)
Ferramenta Select (Selecionar)
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A barra Insert
A barra Insert contém botões para você criar e inserir objetos, como tabelas, camadas e 
imagens. Quando você passa o mouse sobre um botão, é exibida uma dica de ferramenta com 
o nome desse botão.

Os botões são organizados em diversas categorias, que podem ser alternadas no lado esquerdo 
da barra Insert. Categorias adicionais são exibidas quando o documento atual contém código 
do servidor, como documentos ASP ou CFML. Quando o Dreamweaver é inicializado, a 
última categoria com a qual você trabalhou é  aberta. 

Algumas categorias possuem botões com menus pop-up. Quando você seleciona uma opção 
em um menu pop-up, ela se torna a ação padrão do botão. Por exemplo, se você selecionar 
Image Placeholder (Alocador de espaço de imagem) no menu pop-up Image (Imagem), o 
Dreamweaver inserirá um alocador de espaço de imagem na próxima vez que o botão Image 
for clicado. Sempre que você selecionar uma nova opção no menu pop-up, a ação padrão do 
botão será alterada.

A barra Insert está organizada nas seguintes categorias:

A categoria Common (Comuns) permite criar e inserir os objetos mais utilizados, como 
imagens e tabelas. 

A categoria Layout permite inserir tabelas, tags div, camadas e quadros. Você também pode 
escolher entre três visualizações de tabelas: Standard (Padrão), Expanded Tables (Tabelas 
expandidas) e Layout. Quando o modo Layout for selecionado, poderão ser utilizadas as 
ferramentas de layout do Dreamweaver : Draw Layout Cell (Desenhar a célula de layout) e 
Draw Layout Table (Desenhar a tabela de layout). 

A categoria Forms (Formulários) contém botões para criar formulários e inserir elementos 
de formulário. 

A categoria Text (Texto) permite inserir uma variedade de tags de formatação de texto e de 
lista, como b, em, p, h1 e ul. 

A categoria HTML permite inserir tags HTML para réguas horizontais, conteúdo do 
cabeçalho, tabelas, quadros e scripts. 

N
O

T
A

Se preferir exibir as categorias como guias na parte superior da barra Insert, altere o 
layout da barra Insert (consulte “Definir as preferências de fontes para a exibição do 
Dreamweaver” na página 82).
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As categorias de código do servidor estão disponíveis apenas para as páginas que utilizam 
determinada linguagem de servidor, como ASP, ASP.NET, CFML Basic, CFML Flow, CFML 
Advanced, JSP e PHP. Cada uma dessas categorias fornece objetos de código do servidor que 
podem ser inseridos na visualização do código. 

A categoria Application (Aplicativo) permite inserir elementos dinâmicos, como conjuntos 
de registros, regiões repetidas e formulários de inserção e de atualização de registros.

A categoria Flash elements (Elementos Flash) permite inserir elementos Macromedia 
Flash.

A categoria Favorites (Favoritos) permite agrupar e organizar em um único local os botões 
da barra Insert mais utilizados. 

É possível modificar qualquer objeto na barra Insert ou criar seus próprios objetos. Consulte 
“Customizing Dreamweaver” (Personalização do Dreamweaver) no Centro de Suporte da 
Macromedia, em www.macromedia.com/go/customizing_dreamweaver.

Tópicos relacionados
■ “Utilizar a barra Insert” na página 61
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A barra de ferramentas Coding
A barra de ferramentas Coding contém botões que permitem executar várias operações de 
codificação padrão, como reduzir e expandir seleções de códigos, realçar código incorreto, 
aplicar e remover comentários, recuar código e inserir trechos de código recentemente 
utilizados. A barra de ferramentas Coding fica visível apenas na visualização de código e 
aparece verticalmente do lado esquerdo da janela do documento.

Não é possível desencaixar nem mover a barra de ferramentas Coding, mas você pode ocultá-
la. Para obter mais informações, consulte “Exibir barras de ferramentas” na página 60.

Você também pode editar a barra de ferramentas Coding para exibir mais botões (como Word 
Wrap [Quebra de linha], Show Hidden Characters [Mostrar caracteres ocultos] e Auto Indent 
[Recuo automático]) ou ocultar botões que não deseja utilizar. Para isso, você deve editar o 
arquivo XML que gera a barra de ferramentas. Para obter mais informações, consulte 
Extending Dreamweaver (Extensão dos recursos do Dreamweaver).

Tópicos relacionados
■ “Inserir código rapidamente com a barra de ferramentas Coding (Codificação)” na 

página 617
■ “Exibir barras de ferramentas” na página 60
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A barra de ferramentas Style Rendering
A barra de ferramentas Style Rendering (oculta por padrão) contém botões que possibilitam 
ver como ficaria o projeto com tipos de mídia diferentes, se você usasse folhas de estilo 
dependentes de mídia. Ela também contém um botão que permite ativar ou desativar estilos 
CSS. Para exibir a barra de ferramentas padrão, selecione View  >  Toolbars > Style Rendering.

Esta barra de ferramentas só funciona se os documentos utilizarem folhas de estilo 
dependentes de mídia. Por exemplo, sua folha de estilo poderia especificar uma regra body 
para impressão e uma regra body diferente para dispositivos portáteis. Para obter mais 
informações sobre a criação de folhas de estilo dependentes de mídia, consulte o site do World 
Wide Web Consortium em www.w3.org/TR/CSS21/media.html.

Por padrão, o Dreamweaver exibe seu projeto para o tipo de mídia de tela (que mostra como 
uma página é apresentada em uma tela de computador). Você pode visualizar as apresentações 
de tipo de mídia a seguir, clicando nos respectivos botões na barra de ferramentas Style 
Rendering.

Render Screen Media Type (Apresentar tipo de mídia de tela) mostra a aparência da 
página em uma tela de computador.

Render Print Media Type (Apresentar tipo de mídia de impressão) mostra a aparência da 
página impressa em uma folha de papel.

Render Handheld Media Type (Apresentar tipo de mídia portátil) mostra a aparência da 
página em um dispositivo portátil, como um telefone celular ou um dispositivo BlackBerry.

Render Projection Media Type (Apresentar tipo de mídia de projeção)mostra a aparência 
da página em um dispositivo de projeção.

Render TTY Media Type (Apresentar tipo de mídia TTY) mostra a aparência da página em 
uma máquina teletipo.

Render TV Media Type (Apresentar tipo de mídia TV) mostra a aparência da página em 
uma tela de televisão.

Toggle Displaying of CSS Styles (Alternar exibição de estilos CSS) permite ativar ou 
desativar estilos CSS. O funcionamento deste botão não depende de outros botões de mídia.

Tópicos relacionados
■ “Exibir barras de ferramentas” na página 60
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Relatórios no Dreamweaver
Você pode executar relatórios no Dreamweaver para localizar ou testar o conteúdo, ou para 
solucionar problemas. Você pode gerar os seguintes tipos de relatório:

Search (Busca) permite procurar tags, atributos e texto específico em tags. Para procurar seu 
código, consulte “Procurar e substituir tags e atributos” na página 628.

Validation (Validação) permite verificar erros de código ou sintaxe. Para validar seu código, 
consulte “Validar tags” na página 639.

Target Browser Check (Verificação de navegador de destino) permite testar o HTML nos 
documentos para ver se as tags ou os atributos não são suportados pelos navegadores de 
destino. Para executar uma verificação de navegador de destino, consulte “Verificar a 
compatibilidade com navegadores” na página 635.

Link Checker (Verificador de links) permite localizar e corrigir links rompidos, externos e 
órfãos. Para executar o verificador de links, consulte “Verificar links rompidos, externos e 
órfãos” na página 491.

Site Reports (Relatórios de site) permite melhorar o fluxo de trabalho e testar os atributos 
HTML no site. Os relatórios de fluxo de trabalho incluem Checked Out By (Retirado por), 
Recently Modified (Modificado recentemente) e Design Notes. Os relatórios HTML incluem 
Combinable Nested Font Tags (Tags combináveis de fontes aninhadas), Accessibility 
(Acessibilidade), Missing Alt Text (Texto alternativo ausente), Redundant Nested Tags (Tags 
aninhadas redundantes), Removable Empty Tags (Tags vazias removíveis) e Untitled 
Documents (Documentos sem título). Para executar relatórios de site, consulte “Testar o site” 
na página 171.

FTP Log (Registro de FTP) permite exibir todas as atividades de transferência de arquivos 
por FTP. Para exibir o registro de FTP, consulte “Obter arquivos de um servidor remoto” na 
página 156 ou “Colocar arquivos em um servidor remoto” na página 157.

Server Debug permite exibir informações para depurar um aplicativo ColdFusion. Para 
exibir informações de depuração, consulte “Usar o depurador ColdFusion (somente no 
Windows)” na página 641.

Sobre a personalização do Dreamweaver em 
sistemas multiusuário
Você pode personalizar o Dreamweaver para adequá-lo às suas necessidades até mesmo em um 
sistema operacional multiusuário, como o Windows XP ou o Mac OS X. 
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O Dreamweaver impede que a configuração personalizada de um usuário afete a configuração 
personalizada de outros usuários. Para que isso ocorra, na primeira execução do Dreamweaver 
em um sistema operacional multiusuário que o reconheça, o aplicativo criará cópias de vários 
arquivos de configuração para você. Estes arquivos de configuração do usuário são 
armazenados em uma pasta. 

No Windows XP, por exemplo, eles são armazenados em C:\Documents and 
Settings\username\Application Data\Macromedia\Dreamweaver 8\Configuration (que pode 
estar dentro de uma pasta oculta).

No Mac OS X, eles são armazenados na pasta principal, especificamente em Users/username/
Library/Application Support/Macromedia/Dreamweaver 8/Configuration.

Se o Dreamweaver for reinstalado ou atualizado, o Dreamweaver fará automaticamente cópias 
de segurança dos arquivos de configuração do usuário existentes de modo que, se eles tiverem 
sido personalizados manualmente, o usuário ainda tenha acesso às alterações efetuadas.

Tópicos relacionados
■ “Dreamweaver conceitos básicos de personalização”

Trabalhar na janela do documento
A janela do documento mostra o documento que está aberto. Você pode exibir um 
documento na visualização do projeto, na visualização do código ou em ambas. A barra de 
status da janela do documento apresenta informações sobre o documento atual. 

Tópicos relacionados
■ “A janela do documento” na página 47
■ “A barra de status” na página 50

Alternar entre visualizações na janela do documento
Você pode exibir um documento da janela do documento na visualização do código, na 
visualização do projeto ou nas visualizações do código e do projeto.

Para alternar entre as visualizações na janela do documento, execute um dos 
seguintes procedimentos:

■ Utilize o menu View:
■ Selecione View > Code (Código).
■ Selecione View > Design (Projeto).
■ Selecione View > Code and Design (Código e projeto).
56 Explorar a área de trabalho



         
■ Utilize a barra de ferramentas do documento:
■ Clique no botão Show Code View.

■ Clique no botão Show Code and Design Views.

■ Clique no botão Show Design View.

Para alternar entre a visualização do código e a visualização do projeto:

■ Pressione Control+til (~), no Windows, ou Command+aspa simples (‘), no Macintosh. 

Tópicos relacionados
■ “A janela do documento” na página 47

Dispor janelas de documentos em cascata ou lado a 
lado
Se tiver vários documentos abertos simultaneamente, você poderá mostrá-los em cascata ou 
lado a lado.

Para dispor janelas de documentos em cascata, siga o procedimento abaixo:

■ Selecione Window > Cascade.

Para dispor janelas de documentos lado a lado, siga um dos procedimentos 
abaixo:

■ No Windows, selecione Window > Tile Horizontally (Lado a lado horizontalmente) ou 
Window > Tile Vertically (Lado a lado verticalmente).

■ No Macintosh, selecione Window > Tile.

Tópicos relacionados
■ “Escolher o layout de área de trabalho (no Windows)” na página 78
■ “Exibir documentos com guias (Macintosh)” na página 79
■ “Salvar layouts personalizados da área de trabalho” na página 80
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Se as duas visualizações forem exibidas na janela do documento, esse atalho de 
teclado mudará o foco do teclado de uma visualização para a outra.
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Redimensionar a janela do documento 
A barra de status exibe as dimensões atuais da janela do documento (em pixels). Para criar 
uma página cuja aparência seja melhor em determinado tamanho, você poderá ajustar a janela 
do documento para qualquer um dos tamanhos predeterminados, editá-los ou criar novos 
tamanhos.

Para redimensionar a janela do documento de acordo com um tamanho 
predeterminado:

■ Selecione um dos tamanhos no menu pop-up Window Size situado na parte inferior da 
janela do documento. 

O tamanho da janela mostrado reflete as dimensões internas da janela do navegador, sem 
incluir as bordas. O tamanho do monitor é exibido entre parênteses. Por exemplo: seria 
recomendável utilizar o tamanho “536 x 196 (640 x 480, padrão)” se os visitantes do site 
estiverem utilizando o Microsoft Internet Explorer ou o Netscape Navigator com 
configurações padrão em um monitor de 640 x 480 pixels.

Para alterar os valores na lista do menu pop-up Window Size:

1. No menu pop-up Window Size, selecione Edit Sizes. 

2. Clique em qualquer dos valores de largura ou altura na lista Window Sizes e digite um novo 
valor.

Para que a janela do documento se ajuste apenas a uma largura específica (mantendo a 
altura inalterada), selecione um valor de altura e exclua-o. 

3. Clique na caixa de texto Description (Descrição), para digitar um texto descritivo sobre 
determinado tamanho.
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No Windows, você pode maximizar uma janela de documento para que ela preencha 
totalmente a área do documento da janela integrada. Você não pode redimensionar 
uma janela do documento quando ela está maximizada.

D
IC

A
Para redimensionar manualmente, utilize os métodos padrão do sistema operacional de 
ajuste de janelas, como, por exemplo, arrastar o canto inferior direito da janela. 
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4. Clique em OK para salvar a alteração e retornar à janela do documento.

Para adicionar um novo tamanho ao menu pop-up Window Size: 

1. No menu pop-up Window Size, selecione Edit Sizes. 

2. Clique no espaço em branco abaixo do último valor na coluna Width (Largura).

3. Digite os valores de Width e Height (Altura).

Para definir apenas os valores de largura ou de altura, basta deixar um desses campos vazio.
4. Clique no campo Description, para inserir um texto descritivo sobre o tamanho 

adicionado.

5. Clique em OK para salvar a alteração e retornar à janela do documento.

Por exemplo, digite SVGA ou PC comum ao lado da entrada referente a um monitor de 
800 x 600 pixels, e Mac de 17 pol. ao lado da entrada referente a um monitor de 832 x 
624 pixels. A maioria dos monitores permite ajustes para várias dimensões em pixels.

Definir as preferências da barra de status
Defina as preferências da barra de status utilizando a caixa de diálogo Preferences 
(Preferências).

Para definir as preferências da barra de status:

1. Selecione Edit  > Preferences (Windows) ou Dreamweaver  > Preferences (Macintosh).

A caixa de diálogo Preferences será exibida.
2. Selecione Status Bar (Barra de status) na lista Category (Categoria) à esquerda.

3. Defina as opções de preferências. 

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

Tópicos relacionados
■ “A barra de status” na página 50

Utilizar barras de ferramentas, inspetores 
e menus contextuais
O Dreamweaver contém várias ferramentas que permitem fazer alterações rapidamente 
durante a criação ou a edição de um documento. 
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As barras de ferramentas padrão, do documento e Coding servem para editar o documento 
atual e trabalhar nele. A barra Insert contém botões para criar e inserir objetos, como tabelas, 
camadas e imagens. E o Property inspector permite editar as propriedades desses objetos.

Como alternativa para a barra Insert e o Property inspector, utilize os menus contextuais para 
criar e editar objetos. 

Exibir barras de ferramentas
Utilize as barras de ferramentas padrão e do documento para executar operações de edição 
padrão e relacionadas ao documento. Utilize a barra de ferramentas Coding para inserir 
código rapidamente e a barra de ferramentas Style Rendering para exibir a página da forma 
como ela seria apresentada em diferentes tipos de mídia. Você pode optar por exibir ou ocultar 
as barras de ferramentas conforme necessário.

Para mostrar ou ocultar uma barra de ferramentas, execute um dos seguintes 
procedimentos:

■ Selecione View  > Toolbars e, em seguida, selecione a barra de ferramentas.
■ Clique com o botão direito do mouse (no Windows) ou clique com a tecla Control 

pressionada (Macintosh) em uma das barras de ferramentas e, em seguida, selecione a 
barra de ferramentas no menu contextual.

Tópicos relacionados
■ “A barra de ferramentas do documento” na página 48
■ “A barra de ferramentas padrão” na página 49
■ “A barra de ferramentas Coding” na página 53
■ “A barra de ferramentas Style Rendering” na página 54
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É possível também utilizar o Tag inspector (Inspetor de tags) para exibir e editar 
propriedades (consulte “Alterar atributos com o Tag inspector (Inspetor de tags)” na 
página 644). O Tag inspector permite exibir e editar todos os atributos associados a 
uma determinada tag, enquanto o Property inspector mostra apenas os atributos mais 
comuns.

N
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Para exibir ou ocultar a barra de ferramentas Coding no Code inspector (Inspetor de 
código, Window > Code Inspector), selecione Coding Toolbar (Barra de Ferramentas 
Coding) no menu pop-up View Options localizado na parte superior do inspetor.
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Utilizar a barra Insert
A barra Insert contém botões para criar e inserir objetos, como tabelas e imagens. Os botões 
estão organizados em categorias. Quando você passa o mouse sobre um botão, é exibida uma 
dica de ferramenta com o nome desse botão.

Tópicos relacionados
■ “A barra Insert” na página 51

Exibir a barra Insert e respectivas categorias e menus
Você pode ocultar, mostrar, reduzir ou expandir a barra Insert de acordo com a sua 
necessidade. Você também pode exibir as categorias diferentes da barra Insert. Algumas 
categorias dessa barra têm botões que contêm menus com comandos comuns.

Se preferir exibir as categorias como guias na parte superior da barra Insert, altere o layout da 
barra Insert.

Para ocultar ou mostrar a barra Insert, execute um dos seguintes 
procedimentos:

■ Selecione Window > Insert.
■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 

pressionada (no Macintosh) na barra Insert da barra de ferramentas do documento, da 
barra de ferramentas padrão ou da barra de ferramentas Coding e selecione Insert Bar 
(Barra Insert).

Para mostrar os botões em uma determinada categoria:

■ Clique na seta ao lado do nome da categoria (no lado esquerdo da barra Insert) e selecione 
outra categoria no menu pop-up.
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Para exibir o menu pop-up de um botão:

■ Clique na seta para baixo ao lado do ícone do botão.

Para mostrar as categorias da barra Insert como guias:

■ Clique na seta ao lado do nome da categoria (no lado esquerdo da barra Insert) e selecione 
Show as Tabs (Mostrar como guias).

As categorias são exibidas como guias na parte superior da barra Insert.

Para mostrar as categorias da barra Insert como um menu:

■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) na barra Insert e selecione Show as Menus (Mostrar 
como menus).

A barra Insert exibe as categorias em um menu, em vez de em guias.

Tópicos relacionados
■ “Personalizar e usar a categoria Favorites (Favoritos) da barra Insert” na página 64

Utilizar a barra Insert para inserir objetos
A barra Insert é um método conveniente para criar e inserir objetos. 

Para inserir um objeto:

1. No lado esquerdo da barra Insert, selecione a categoria adequada.

2. Siga um dos procedimentos abaixo:

■ Clique em um objeto de botão ou arraste o ícone de botão para a janela do 
documento.

■ Clique na seta em um botão e selecione uma opção no menu.

N
O
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Talvez seja necessário clicar na barra de título da barra Insert para reabri-la.
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Dependendo do objeto, poderá ser exibida uma caixa de diálogo de inserção de objeto 
correspondente que solicita a busca um arquivo ou de parâmetros específicos de um objeto. 
Como alternativa, o Dreamweaver poderá inserir o código no documento, ou abrir um editor 
de tags (consulte “Editar tags utilizando Tag editors (Editores de tags)” na página 621) ou um 
painel para que você especifique informações antes da inserção do código. 

Se um objeto for inserido na visualização do projeto, nenhuma caixa de diálogo será exibida; 
no entanto, se o objeto for inserido na visualização de código, o editor de tags será exibido. No 
caso de alguns objetos, sua inserção na visualização do projeto fará com que o Dreamweaver 
alterne para a visualização do código antes de inserir o objeto. 

Para ignorar a caixa de diálogo de inserção de objetos e inserir um objeto 
alocador de espaço vazio: 

■ Pressione Control (no Windows) ou Option (no Macintosh) e clique no botão 
correspondente ao objeto.
Por exemplo, para inserir um alocador de espaço de uma imagem sem especificar um 
arquivo de imagem, pressione Control ou Option, e clique no botão Image.

Para modificar as preferências da barra Insert:

1. Selecione Edit  > Preferences (Windows) ou Dreamweaver  > Preferences (Macintosh).

A caixa de diálogo Preferences exibe a categoria de preferências General (Geral).
2. Desmarque Show Dialog When Inserting Objects (Mostrar a caixa de diálogo quando 

inserir objetos) para suprimir caixas de diálogo quando inserir objetos, como imagens, 
tabelas, scripts e elementos head, ou pressione a tecla Control (Windows) ou Option 
(Macintosh) durante a criação do objeto. 

N
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Alguns objetos, como as âncoras com nome, não são visíveis quando a página é exibida 
na janela do navegador. Na visualização do projeto, para exibir os ícones que marcam a 
localização desses objetos invisíveis, consulte “Mostrar e ocultar elementos invisíveis” 
na página 388.

N
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Esse procedimento não ignora todas as caixas de diálogo de inserção de objeto. 
Muitos objetos, inclusive as barras de navegação, camadas, botões Flash e 
conjuntos de quadros (framesets), não inserem alocadores de espaço ou objetos 
com valor padrão.

D
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Quando o objeto é inserido com essa opção desativada, são conferidos valores de 
atributos padrão ao objeto. Utilize o Property inspector para alterar as propriedades 
do objeto após a inserção. 
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3. Clique em OK.

Tópicos relacionados
■ “Exibir a barra Insert e respectivas categorias e menus” na página 61

Personalizar e usar a categoria Favorites (Favoritos) da barra 
Insert 
A categoria Favorites da barra Insert permite agrupar e organizar os botões mais utilizados 
nessa barra. Você pode adicionar, gerenciar e excluir botões da categoria Favorites.

Para adicionar, excluir ou gerenciar itens na categoria Favorites:

1. Selecione qualquer categoria na barra Insert.

2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) na área em que os botões aparecem (não clique com o botão 
direito no nome da categoria); em seguida, selecione Customize Objects (Personalizar 
objetos).

Será exibida a caixa de diálogo Customize Favorite Objects (Personalizar objetos 
favoritos).

3. Faça as alterações necessárias.

Para obter mais informações, clique no botão Help da caixa de diálogo.
4. Clique em OK.

A categoria Favorites mostrará as alterações efetuadas.

Para inserir objetos utilizando botões da categoria Favorites:

■ No lado esquerdo da barra Insert, selecione a categoria Favorites e, em seguida, clique no 
botão de qualquer objeto da categoria Favorites que tenha sido adicionado. 

Tópicos relacionados
■ “Exibir a barra Insert e respectivas categorias e menus” na página 61
■ “Utilizar a barra Insert para inserir objetos” na página 62

D
IC

A

Se você não estiver nessa categoria, selecione-a para ver as alterações.

N
O

T
A

A categoria Favorites não conterá botão algum até que você a personalize para 
adicionar objetos.
64 Explorar a área de trabalho



         
Utilizar o Property inspector 
O Property inspector permite examinar e editar as propriedades mais comuns do elemento da 
página que estiver selecionado, como um texto ou objeto inserido. O conteúdo do Property 
inspector varia de acordo com o elemento selecionado.

Para mostrar ou ocultar o Property inspector:

■ Selecione Window > Properties (Propriedades). 

Para expandir ou reduzir o Property inspector:

■ Clique na seta de expansão no canto inferior direito do Property inspector. 

Para exibir as propriedades de um elemento de página:

■ Na janela do documento, selecione o elemento de página. 

Para alterar as propriedades de um elemento de página:

1. Selecione o elemento de página na janela do documento. 

2. Altere as propriedades no Property inspector.

Em sua maioria, as alterações que você fizer nas propriedades serão imediatamente 
aplicadas à janela do documento. 

N
O

T
A

Utilize o Tag inspector para exibir e editar todos os atributos associados às propriedades 
de determinada tag (consulte “Alterar atributos com o Tag inspector (Inspetor de tags)” 
na página 644). 

D
IC

A

Por padrão, o Property inspector fica localizado na parte inferior da área de trabalho, 
mas você poderá encaixá-lo na parte superior da área de trabalho, se quiser. Você 
também pode torná-lo um painel flutuante na área de trabalho. Para obter mais 
informações sobre como mover o Property inspector, consulte “Encaixar e desencaixar 
painéis e grupos de painéis” na página 68.

N
O

T
A

Talvez seja necessário expandir o Property inspector para exibir todas as 
propriedades do elemento selecionado.

N
O

T
A

Para obter informações sobre propriedades específicas, selecione um elemento na 
janela do documento e, em seguida, clique no ícone Help no canto superior direito 
do Property inspector.
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3. Se as alterações não forem aplicadas imediatamente, siga um destes procedimentos:

■ Clique fora dos campos de texto de edição de propriedades.
■ Pressione a tecla Enter (no Windows) ou Return (no Macintosh).
■ Pressione a tecla Tab para alternar para outra propriedade.

Utilizar menus contextuais 
O Dreamweaver utiliza amplamente os menus contextuais, que oferecem acesso conveniente 
aos comandos mais úteis e às propriedades relacionadas ao objeto ou à janela com a qual você 
está trabalhando. Os menus contextuais apresentam apenas os comandos pertinentes à seleção 
atual.

Para utilizar um menu contextual:

1. Clique com o botão direito do mouse (no Windows) ou pressione Ctrl e clique (no 
Macintosh) no objeto ou na janela.

Será exibido o menu contextual correspondente ao objeto ou à janela selecionada.
2. Selecione um comando no menu contextual.
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Utilizar painéis e grupos de painéis  
No Dreamweaver, os painéis são reunidos em grupos de painéis. O painel selecionado em um 
grupo de painéis aparece como uma guia. Cada grupo pode ser expandido ou minimizado e 
encaixado ou separado de outros grupos de painéis. 

Os grupos de painéis também podem ser encaixados na janela integrada do aplicativo (apenas 
no Windows). Esse recurso facilita o acesso aos painéis necessários sem desorganizar a área de 
trabalho. 

Exibir painéis e grupos de painéis
Na área de trabalho, você pode exibir ou ocultar painéis ou grupos de painéis conforme 
necessário. 

Para expandir ou minimizar um grupo de painéis, siga um destes 
procedimentos:

■ Clique na seta de expansão no lado esquerdo da barra de título do grupo de painéis.
■ Clique no título do grupo de painéis.

Para fechar um grupo de painéis de modo que ele não seja visível na tela:

■ No menu Options (Opções) da barra de título do grupo de painéis, selecione Close Panel 
Group (Fechar o grupo de painéis).
O grupo de painéis desaparecerá da tela.

Para abrir um painel ou um grupo de painéis que não esteja visível na tela:

■ Selecione o menu Window e, em seguida, selecione um nome de painel no menu.
Uma marca de seleção ao lado de um item, no menu Window, indica que ele está aberto 
(embora possa estar oculto atrás de outras janelas). 

Para selecionar um painel dentro de um grupo expandido de painéis:

■ Clique no nome do painel.

N
O

T
A

Quando um grupo de painéis é flutuante (separado), é exibida uma barra vazia estreita 
na parte superior do grupo de painéis. Nesta documentação, o termo “barra de título do 
grupo de painéis” se refere à área na qual o nome do grupo de painéis é mostrado, e não 
à barra vazia estreita.

D
IC

A

Se você não conseguir localizar um painel, inspetor ou janela marcado como aberto, 
selecione Window > Arrange Panels (Organizar painéis) para posicionar 
adequadamente todos os painéis abertos.
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Para ver o menu Options de um grupo de painéis, caso ele não esteja sendo 
exibido:

■ Para expandir o grupo de painéis, clique em seu nome ou na seta de expansão.
O menu Options ficará visível quando o grupo de painéis for expandido.

Encaixar e desencaixar painéis e grupos de painéis
Você pode mover painéis e grupos de painéis como necessário, e pode organizá-los para que 
flutuem ou sejam encaixados na área de trabalho.

A maioria dos painéis pode ser encaixada apenas à esquerda ou à direita da janela do 
documento na área de trabalho integrada, enquanto os outros, como o Property inspector e a 
barra Insert, podem ser encaixados somente nas partes superior e inferior da janela integrada. 

Para separar um grupo de painéis:

■ Arraste o grupo de painéis utilizando a pinça (no lado esquerdo da barra de título do 
grupo de painéis) até que o contorno indique que ele não está mais encaixado.

Para encaixar um grupo de painéis em outros grupos de painéis (área flutuante 
de trabalho) ou na janela integrada, apenas no Windows:

■ Arraste o grupo de painéis utilizando a pinça, até que o seu contorno indique que ele não 
está mais acoplado.

Para desanexar um painel de um grupo de painéis:

■ No menu Options da barra de título do grupo de painéis, selecione Group With (Agrupar 
a) > New Panel Group (Novo grupo de painéis). O nome do comando Group With é 
alterado de acordo com o nome do painel ativo.
O painel será exibido em um novo grupo de painéis individual.

Para encaixar um painel em um grupo de painéis:

■ Selecione o nome de um grupo de painéis no submenu Group With do menu Options do 
grupo de painéis. O nome do comando Group With é alterado de acordo com o nome do 
painel ativo.

D
IC

A

Algumas opções estão disponíveis no menu contextual do grupo de painéis mesmo 
quando o grupo está reduzido. Clique com o botão direito do mouse (no Windows) 
ou pressione Control e clique (no Macintosh) na barra de título do grupo de painéis 
para exibir o menu contextual.
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Para arrastar um grupo de painéis flutuantes (separados) sem encaixá-lo:

■ Arraste o grupo de painéis pela barra situada acima da barra de título. O grupo de painéis 
não será encaixado caso não seja arrastado pela respectiva pinça.

Redimensionar e renomear grupos de painéis
Você pode alterar o tamanho e o nome dos grupos de painéis de acordo com as suas 
necessidades.

Para alterar o tamanho dos grupos de painéis:

■ No caso de painéis flutuantes, arraste o conjunto de grupos de painéis utilizando o mesmo 
procedimento para redimensionar qualquer janela no seu sistema operacional.
Por exemplo, você pode arrastar a área de redimensionamento no canto inferior direito do 
conjunto de grupos de painéis.

■ No caso de painéis encaixados, arraste a barra de divisão entre os painéis e a janela do 
documento.

Para maximizar um grupo de painéis, siga um destes procedimentos:

■ No menu Options, na barra de título do grupo de painéis, escolha Maximize Panel Group 
(Maximizar o grupo de painéis).

■ Clique duas vezes em qualquer parte da barra de título do grupo de painéis.
O grupo de painéis será verticalmente expandido de modo a preencher todo o espaço 
vertical disponível.

Para renomear um grupo de painéis: 

1. No menu Options da barra de título do grupo de painéis, selecione Rename Panel 
Group (Renomear grupo de painéis).

2. Digite um novo nome e, em seguida, clique em OK.
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Salvar grupos de painéis
O Dreamweaver permite que você salve e restaure diferentes grupos de painéis, para que possa 
personalizar sua área de trabalho em relação a diferentes atividades. Quando você salva um 
layout de área de trabalho, o Dreamweaver memoriza os painéis no layout especificado, bem 
como outros atributos como as posições e os tamanhos dos painéis, seu estado expandido ou 
minimizado, a posição e o tamanho da janela do aplicativo, e a posição e o tamanho da janela 
do documento.

Para obter mais informações, consulte “Salvar layouts personalizados da área de trabalho” na 
página 80.

Definir as preferências de painéis
Você pode definir preferências para especificar quais painéis e inspetores sempre aparecerão 
em primeiro plano na janela do documento e quais serão ocultos por essa janela. 

Para definir preferências de painéis:

1. Selecione Edit  > Preferences (Windows) ou Dreamweaver  > Preferences (Macintosh).

A caixa de diálogo Preferences será exibida.
2. Selecione Panels na lista Category à esquerda.

3. Selecione opções. 

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

Utilizar os recursos de acessibilidade do 
Dreamweaver 
O Dreamweaver fornece recursos que o tornam acessível aos usuários com deficiências. 
Especificamente, o Dreamweaver oferece suporte a leitoras de tela, recursos de acessibilidade 
do sistema operacional e navegação por teclado.

Tópicos relacionados
■ “Dreamweaver e acessibilidade” na página 33 
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Utilizar as leitoras de tela com o Dreamweaver
Uma leitora de tela relaciona o texto exibido na tela do computador. Ela também lê as 
informações não textuais, tais como identificadores de botão ou descrições de imagem no 
aplicativo, fornecidas nas guias de acessibilidade ou atributos durante a autoria.

Como usuário do Dreamweaver, é possível utilizar uma leitora de tela para auxiliá-lo na 
criação de páginas da Web. A leitora de tela inicia a leitura no canto superior esquerdo da 
janela do documento.

O Dreamweaver suporta as leitoras de tela JAWS for Windows da Freedom Scientific 
(www.freedomscientific.com) e Window-Eyes da GW Micro (www.gwmicro.com).

Tópicos relacionados
■ “Utilização do teclado para navegar Dreamweaver” na página 72

Suporte para recursos de acessibilidade do sistema 
operacional
O Dreamweaver suporta recursos de acessibilidade nos sistemas operacionais Windows e 
Macintosh. Por exemplo, no Macintosh, você define as preferências visuais na caixa de diálogo 
Universal Access Preferences (Preferências de acesso universal) (Apple > System Preferences 
[Preferências de sistema]). Suas definições são refletidas na área de trabalho do Dreamweaver.

O Dreamweaver também suporta a definição de alto contraste do sistema operacional 
Windows. O usuário ativa esta opção por meio do Painel de Controle do Windows. Quando 
o alto contraste está ativado, ele afeta o Dreamweaver da seguinte maneira:

■ As caixas de diálogo e os painéis utilizam as definições de cor do sistema.
Por exemplo: se você definir a cor como branco ou preto, todas as caixas de diálogo e 
painéis do Dreamweaver serão exibidos com uma cor de primeiro plano branca e de 
segundo plano preta.

■ A sinalização da sintaxe por cores da visualização do código está desativada. 
A visualização do código utiliza a janela do sistema e a cor do texto da janela, e ignora as 
definições de cor em Preferences. Por exemplo, se você definir a cor do sistema como 
branco sobre preto e alterar as cores do texto em Preferences > Code Coloring 
(Codificação por cores), o Dreamweaver ignorará a definição de cores em Preferences e 
exibirá o texto do código com uma cor branca em primeiro plano e preta em segundo 
plano.
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■ A visualização do projeto utiliza as cores de segundo plano e de texto definidas em Modify 
(Modificar) > Page Properties (Propriedades de página) para que o projeto das páginas 
processe as cores como um navegador.

Tópicos relacionados
■ “Utilizar as leitoras de tela com o Dreamweaver” na página 71

Utilização do teclado para navegar Dreamweaver
É possível utilizar o teclado para navegar por painéis, inspetores, caixas de diálogo, quadros e 
tabelas do Dreamweaver em vez de usar o mouse. 

Tópicos relacionados
■ “Utilizar as leitoras de tela com o Dreamweaver” na página 71
■ “Suporte para recursos de acessibilidade do sistema operacional” na página 71

Painéis de navegação
É possível utilizar o teclado para navegar nos painéis

Para navegar nos painéis:

1. Na janela do documento, pressione Control+Alt+Tab para mudar o foco para um painel. 

Um contorno branco em torno da barra de títulos do painel indica que o foco está nesse 
painel. A leitora de tela lê a barra de títulos do painel que está no foco.

2. Pressione Control+Alt+Tab novamente para mudar o foco para o próximo painel. 

Continue até ter o foco no painel com o qual deseja trabalhar.
3. Pressione Control+Alt+ Shift+Tab para mudar o foco para o painel anterior, se necessário. 

4. Se o painel desejado não estiver aberto, utilize os atalhos de teclado listados no menu 
Windows (Janelas) para exibir o painel apropriado e pressione Control+Alt+Tab para 
mudar o foco para esse painel. 

Se o painel desejado estiver aberto, mas não expandido, coloque o foco na barra de título 
do painel e pressione a barra de espaço. Pressione a barra de espaço novamente para 
reduzir o painel. 

5. Pressione a tecla Tab para percorrer as opções no painel.

Um contorno pontilhado em torno da opção indica que o foco está nessa opção.

N
O

T
A

A utilização de tabulação e teclas de setas é suportada somente pelo Windows.
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6. Utilize as teclas de seta quando apropriado.

■ Se uma opção contiver outras opções, utilize as teclas de seta para percorrer as opções e 
pressione a barra de espaço para fazer uma seleção.

■ Se houver guias no grupo de painel para abrir outros painéis, coloque o foco na guia 
aberta e utilize a tecla de seta para a esquerda ou para a direita para abrir outras guias. 
Ao abrir uma nova guia, pressione a tecla Tab para percorrer as opções nesse painel.

Tópicos relacionados
■ “Navegar em caixas de diálogo” na página 74
■ “Navegar em quadros” na página 74
■ “Navegar nas tabelas” na página 75

Navegar no Property inspector 
É possível utilizar o teclado para navegar no Property inspector e fazer alterações no 
documento.

Para navegar no Property inspector:

1. Pressione Control+F3 (no Windows) ou Command+F3 (no Macintosh) para exibir o 
Property inspector, se ele ainda não estiver visível. 

2. (Windows) Pressione Control+Alt+Tab até mudar o foco para o Property inspector.

3. Pressione a tecla Tab para percorrer as opções do Property inspector. 

4. (Windows) Utilize as teclas de seta conforme apropriado para percorrer as opções.

5. Pressione Control+Tab (no Windows) ou Option+Tab (no Macintosh) para abrir e fechar 
a seção expandida do Property inspector quando necessário. Ou, com o foco na seta de 
expansão na parte inferior direita, pressione a barra de espaço.

Tópicos relacionados
■ “Painéis de navegação” na página 72
■ “Navegar em quadros” na página 74
■ “Navegar nas tabelas” na página 75

N
O

T
A

A utilização das teclas de setas é suportada somente pelo Windows.
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Navegar em caixas de diálogo
É possível utilizar o teclado para navegar nas caixas de diálogo.

Para navegar em uma caixa de diálogo:

1. Pressione a tecla Tab para percorrer as opções em uma caixa de diálogo.

2. (Windows) Utilize as teclas de setas para percorrer as opções de uma opção.

Por exemplo, se uma opção tem um menu pop-up, mova o foco para essa opção e utilize a 
seta para baixo para percorrer as opções. 

3. Se a caixa de diálogo tem uma lista de categorias, pressione Control+Tab (no Windows) ou 
Option+Tab (no Macintosh) para mudar o foco para a lista de categorias e utilize as teclas 
de seta para mover-se para cima ou para baixo na lista.

4. Pressione Control+Tab (no Windows) ou Option+Tab (no Macintosh) novamente para 
mudar as opções de uma categoria.

5. Pressione Enter (no Windows) ou Return (no Macintosh) para sair da caixa de diálogo.

Tópicos relacionados
■ “Painéis de navegação” na página 72
■ “Navegar no Property inspector” na página 73
■ “Navegar nas tabelas” na página 75

Navegar em quadros
Se o documento contém quadros, é possível utilizar as teclas de seta para mudar o foco para 
um quadro.

Para selecionar um quadro:

1. Coloque o ponto de inserção na janela do documento.

2. Pressione Alt+Seta para Cima, para selecionar o quadro que atualmente está no foco. 

Uma linha pontilhada indica o quadro que está no foco. 
3. Continue pressionando Alt+Seta para Cima para mudar o foco para o conjunto de quadros 

e, em seguida, conjuntos de quadros pai, se houver conjuntos de quadros aninhados.

N
O

T
A

A utilização das teclas de setas é suportada somente pelo Windows.

N
O

T
A

A utilização das teclas de setas é suportada somente pelo Windows.
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4. Pressione Alt+Seta para Baixo, para mudar o foco para um conjunto de quadros filho ou 
um único quadro no conjunto de quadros.

5. Com o foco em um único quadro, pressione Alt+Seta para a Esquerda ou para a Direita 
para percorrer os quadros.

6. Pressione Alt+Seta para a Direita para colocar o ponto de inserção na janela do documento.

Tópicos relacionados
■ “Painéis de navegação” na página 72
■ “Navegar no Property inspector” na página 73
■ “Navegar em caixas de diálogo” na página 74

Navegar nas tabelas
Após selecionar uma tabela, é possível utilizar o teclado para navegar nela.

Para navegar em uma tabela:

1. Utilize as teclas de setas ou pressione Tab para percorrer as outras células da tabela quando 
necessário. 

2. Para selecionar uma célula, pressione Control+A (no Windows) ou Command+A 
(Macintosh) enquanto o ponto de inserção está na célula.

3. Para selecionar uma tabela, pressione Control+A (no Windows) ou Command+A 
(Macintosh) duas vezes se o ponto de inserção estiver em uma célula, ou uma vez se uma 
célula estiver selecionada.

4. Para sair da tabela, pressione Control+A (no Windows) ou Command+A (no Macintosh) 
três vezes se o ponto de inserção estiver em uma célula, duas vezes se a célula estiver 
selecionada ou uma vez se a tabela estiver selecionada, e depois pressione a tecla de seta para 
cima, para a esquerda, para a direita ou para baixo.

Tópicos relacionados
■ “Painéis de navegação” na página 72
■ “Navegar no Property inspector” na página 73
■ “Navegar em caixas de diálogo” na página 74
■ “Navegar em quadros” na página 74

D
IC

A

Quando a tecla de tabulação for pressionada na célula mais à direita, será adicionada 
automaticamente outra linha à tabela.
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Otimizar a área de trabalho para o projeto 
de página acessível
Ao criar páginas acessíveis, é necessário associar informações, tais como identificadores e 
descrições, aos objetos da página para tornar o conteúdo acessível a todos os usuários. 

Para fazer isso, ative a caixa de diálogo Accessibility para cada objeto, de modo que o 
Dreamweaver solicite informações sobre acessibilidade quando você inserir objetos. É possível 
ativar a caixa de diálogo para cada um dos objetos na categoria Accessibility em Preferences 
(Preferências). 

Para ativar as caixas de diálogo Accessibility:

1. Selecione Edit  > Preferences (Windows) ou Dreamweaver  > Preferences (Macintosh).

A caixa de diálogo Preferences será exibida.
2. Na lista Category (Categoria), à esquerda, selecione Accessibility.

A caixa de diálogo Preferences exibe as opções de acessibilidade.

3. Selecione os objetos para os quais você deseja ativar caixas de diálogo Accessibility.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

N
O

T
A

Os atributos de acessibilidade aparecem automaticamente na caixa de diálogo 
Insert Table (Inserir tabela) quando você insere uma nova tabela.
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4. Clique em OK.

Para cada objeto selecionado, uma caixa de diálogo Accessibility solicita a digitação de 
atributos e tags de acessibilidade quando você insere o objeto em um documento. 

Tópicos relacionados
■ “Dreamweaver e acessibilidade” na página 33
■ “Inserir uma imagem” na página 448
■ “Validar dados de formulário HTML” na página 902
■ “Criar quadros e conjuntos de quadros” na página 309
■ “Inserir e editar um objeto de mídia” na página 518
■ “Inserir uma tabela e adicionar conteúdo” na página 260

Utilizar guias visuais no Dreamweaver
O Dreamweaver fornece diversos tipos de guias visuais para auxiliá-lo a projetar os 
documentos e prever (aproximadamente) a aparência que eles terão nos navegadores. É 
possível executar qualquer um destes procedimentos: 

■ Ajustar instantaneamente a janela do documento ao tamanho desejado para ver como os 
elementos se ajustam à página. Consulte “Redimensionar a janela do documento” na 
página 58.

■ Utilizar uma imagem de rastreamento como o fundo da página para ajudar a duplicar um 
projeto criado em um aplicativo de edição de imagens ou ilustrações, como o Macromedia 
Fireworks. Consulte “Utilizar uma imagem de rastreamento” na página 254.

■ Utilizar as réguas e guias para que sirvam como um guia visual ao posicionar e 
redimensionar com precisão elementos de página. Consulte “Utilizar réguas, guias e grades 
para definir o layout de páginas” na página 250.

■ Utilizar a grade para posicionar e redimensionar as camadas com precisão. Consulte 
“Utilizar a grade” na página 253.
As marcas da grade exibidas na página ajudam a alinhar as camadas e, quando o encaixe 
for ativado, as camadas serão encaixadas automaticamente no ponto de grade mais 
próximo ao serem redimensionadas ou movidas (outros objetos, como imagens e 
parágrafos, não se encaixam na grade). O encaixe funcionará independentemente da 
visibilidade da grade. 
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Dreamweaver conceitos básicos de 
personalização
Existem algumas técnicas básicas que podem ser utilizadas para personalizar o Dreamweaver, 
de modo a adequá-lo às suas necessidades, sem precisar conhecer códigos complexos ou saber 
como editar arquivos de texto. Por exemplo, você pode alterar o layout da área de trabalho, 
ocultar ou exibir a página inicial, definir preferências, criar seus próprios atalhos de teclado e 
adicionar extensões ao Dreamweaver.

Para obter informações sobre como personalizar o layout dos painéis na área de trabalho, 
consulte “Utilizar painéis e grupos de painéis” na página 67.

Esta seção descreve somente as opções mais comuns das preferências. Para obter informações 
sobre uma opção específica das preferências não incluída aqui, consulte o tópico 
correspondente em Usando o Dreamweaver.

Tópicos relacionados
■ “Sobre a personalização do Dreamweaver em sistemas multiusuário”
■ Extending Dreamweaver

Escolher o layout de área de trabalho (no Windows)
No Windows, é possível escolher entre os layouts Designer e Coder da área de trabalho. 
Quando você inicia o Dreamweaver pela primeira vez, é possível escolher um layout para a 
área de trabalho em uma caixa de diálogo. É possível alternar para uma outra área de trabalho 
a qualquer momento.

Para escolher um layout da área de trabalho na primeira vez que você iniciar o 
Dreamweaver:

1. Selecione um dos seguintes layouts:

Designer é uma área de trabalho integrada que utiliza a interface de múltiplos 
documentos (MDI), na qual todas as janelas de documento e painéis estão integrados em 
uma janela de aplicativo maior, com os grupos de painéis encaixados à direita. 

N
O

T
A

Para obter informações sobre como personalizar arquivos de configuração 
manualmente, consulte “Customizing Dreamweaver” no centro de suporte da 
Macromedia em www.macromedia.com/go/customizing_dreamweaver. 
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Coder consiste na mesma área de trabalho integrada. No entanto, os grupos de painéis 
estão encaixados à esquerda – apresentando um layout semelhante ao utilizado pelo 
Macromedia HomeSite e pelo Macromedia ColdFusion Studio – e a janela do documento 
mostra a visualização do código como padrão.

2. Clique em OK.

Para alternar para uma área de trabalho diferente da que foi escolhida:

■ Selecione Window > Workspace Layout (Layout da área de trabalho) e selecione seu 
layout preferido para a área de trabalho.

Além de selecionar Coder e Designer, é possível selecionar Dual Screen Right (Monitor 
secundário à direita) ou Dual Screen Left (Monitor secundário à esquerda). Se você tiver um 
monitor secundário à direita do monitor principal, a opção Dual Screen Right fará com que 
todos os painéis sejam exibidos no monitor da direita e manterá a janela do documento no 
monitor principal. Se você tiver um monitor secundário à esquerda do monitor principal, a 
opção Dual Screen Left fará com que todos os painéis sejam exibidos no monitor da esquerda 
e manterá a janela do documento no monitor principal.

Tópicos relacionados
■ “O layout da área de trabalho” na página 44
■ “Salvar layouts personalizados da área de trabalho” na página 80
■ “Dispor janelas de documentos em cascata ou lado a lado” na página 57

Exibir documentos com guias (Macintosh)
No Macintosh, o Dreamweaver pode exibir vários documentos em uma única janela de 
documento, utilizando guias para identificar cada documento. O Dreamweaver também pode 
exibi-los como parte de uma área de trabalho flutuante, na qual cada documento aparece na 
sua própria janela.

Para abrir um documento com guias em uma janela separada:

■ Clique com o botão direito do mouse (no Windows) ou clique com a tecla Control 
pressionada (no Macintosh) e, em seguida, selecione New Window (Nova janela) no 
menu contextual.

Para combinar documentos separados em janelas com guias:

■ Selecione Window (Janela) > Combine as Tabs (Combinar como guias).

N
O

T
A

É possível encaixar grupos de painéis em qualquer lados da área de trabalho em 
qualquer dos layouts.
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Para alterar a definição padrão de documento com guias:

1. Selecione Dreamweaver > Preferences (Preferências) e depois selecione a categoria General 
(Geral).

2. Marque ou desmarque Open Documents in Tabs (Abrir documentos em guias) e clique em 
OK.

Tópicos relacionados
■ “O layout da área de trabalho” na página 44
■ “Dispor janelas de documentos em cascata ou lado a lado” na página 57

Salvar layouts personalizados da área de trabalho
O Dreamweaver permite salvar e restaurar conjuntos de painéis diferentes, de modo que você 
possa personalizar sua área de trabalho para diferentes atividades. Quando você salva um 
layout de área de trabalho, o Dreamweaver memoriza os painéis no layout especificado, bem 
como outros atributos como as posições e os tamanhos dos painéis, seu estado expandido ou 
minimizado, a posição e o tamanho da janela do aplicativo.

Para salvar um layout personalizado da área de trabalho:

1. Organize os painéis como desejar.

2. Selecione Window (Janela) > Workspace Layout (Layout da área de trabalho) > Save 
Current (Salvar atual).

3. Digite um nome para o layout e clique em OK.

Para alternar para um outro layout personalizado da área de trabalho:

■ Selecione Window > Workspace Layout e selecione seu layout personalizado.

Para renomear ou excluir um layout personalizado da área de trabalho:

1. Selecione Window > Workspace Layout > Manage (Gerenciar).

2. Selecione um layout e siga um dos procedimentos abaixo:

■ Para renomear um layout, clique no botão Rename (Renomear), digite um novo nome 
de layout e clique em OK.

■ Para excluir um layout, clique no botão Delete (Excluir).

N
O

T
A

O Dreamweaver não altera a exibição dos documentos que estão abertos quando 
você altera as preferências. No entanto, os documentos que forem abertos depois 
que você selecionar uma nova preferência serão exibidos de acordo com a 
preferência selecionada.
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3. Clique em OK.

Tópicos relacionados
■ “Utilizar painéis e grupos de painéis” na página 67
■ “Escolher o layout de área de trabalho (no Windows)” na página 78
■ “Exibir documentos com guias (Macintosh)” na página 79

Ocultar e exibir a página inicial
A página inicial do Dreamweaver aparece quando você inicia o Dreamweaver e quando não há 
documentos abertos. Você pode optar por ocultar a página inicial e, mais tarde, exibi-la 
novamente. Quando a página inicial estiver oculta e não houver documentos abertos, a janela 
do documento estará em branco.

Para ocultar a página inicial:

■ Marque a caixa de seleção Don’t Show Again (Não mostrar novamente) na página inicial.

A página inicial não será exibida quando você iniciar o Dreamweaver ou depois que você abrir 
e fechar um documento.

Para exibir a página inicial:

1. Selecione Edit  > Preferences (Windows) ou Dreamweaver  > Preferences (Macintosh).

A caixa de diálogo Preferences será exibida com a categoria de preferências General 
(Geral).

2. Marque a caixa de seleção Show Start Page (Mostrar página inicial).

A página inicial será exibida quando você iniciar o Dreamweaver ou depois que abrir e fechar 
um documento.

Definir as preferências gerais para o Dreamweaver
As preferências gerais controlam a aparência do Dreamweaver como um todo.

Para alterar as preferências gerais:

1. Selecione Edit  > Preferences (Windows) ou Dreamweaver  > Preferences (Macintosh).

A caixa de diálogo Preferences será exibida com a categoria de preferências General 
(Geral).

N
O

T
A

Você pode definir o Dreamweaver para abrir o último documento em que estava 
trabalhando toda vez que for iniciado. Para obter mais informações, consulte “Definir as 
preferências gerais para o Dreamweaver” na página 81.
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2. Defina as opções de preferências. 

Para obter mais informações, clique em Help.
3. Clique em OK.

Definir as preferências de fontes para a exibição do 
Dreamweaver
A codificação do documento determina como ele será exibido em um navegador. As 
preferências de fontes do Dreamweaver permitem mostrar determinada codificação utilizando 
a fonte e o tamanho preferidos, sem afetar a aparência do documento quando visualizado por 
outras pessoas em um navegador. 

Para definir as fontes a serem utilizadas no Dreamweaver para cada tipo de 
codificação:

1. Selecione Edit  > Preferences (Windows) ou Dreamweaver  > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.
2. Na lista Category (Categoria), à esquerda, selecione Fonts (Fontes).

3. Selecione o tipo de codificação, como Western (Latin1) (Ocidental [Latim1]) ou Japanese 
(Japonês), na lista Font Settings (Definições de fontes). Em seguida, nos menus pop-up de 
fontes situados abaixo da lista Font Settings, escolha as fontes a serem utilizadas no 
Dreamweaver para essa codificação. 

Para obter mais informações, clique em Help.

4. Clique em OK.

Tópicos relacionados
■ “Codificação de documentos” na página 379

N
O

T
A

As fontes selecionadas não afetam a aparência do documento no navegador de um 
visitante.
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Personalização de atalhos de teclado
Utilize o Keyboard Shortcut Editor (Editor de atalhos de teclado) para criar suas próprias 
teclas de atalho, incluindo atalhos de teclado para trechos de código. Você pode também 
remover atalhos, editar atalhos já existentes e selecionar um conjunto predeterminado de 
atalhos no Keyboard Shortcut Editor.

Para personalizar os atalhos de teclado: 

1. Selecione Edit > Keyboard Shortcuts (Atalhos de teclado, no Windows) ou Dreamweaver 
> Keyboard Shortcuts (no Macintosh).

Será exibida a caixa de diálogo Keyboard Shortcuts. 

2. Adicionar, excluir ou editar atalhos de teclado.

Para obter mais informações, clique em Help.
3. Clique em OK.

N
O

T
A

Um diagrama com todos os atalhos de teclado da configuração padrão do 
Dreamweaver está disponível como guia de referência rápida no site da Macromedia na 
Web, em www.macromedia.com/go/dw_documentation.

Duplicate Set (Conjunto duplicado), botão

Rename Set (Renomear conjunto), botão

Delete Set (Excluir conjunto), botão

Export Set as HTML (Exportar conjunto 
como HTML), botão
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Adicionar extensões ao Dreamweaver
As extensões são novos recursos que podem ser facilmente adicionados ao Dreamweaver. É 
possível utilizar muitos tipos de extensões, por exemplo: há extensões que permitem 
reformatar tabelas, efetuar conexões a bancos de dados auxiliares ou que podem ajudá-lo a 
escrever scripts para navegadores.

Para localizar as extensões mais recentes para o Dreamweaver, visite o site do Macromedia 
Exchange na Web, em www.macromedia.com/go/dreamweaver_exchange/. Neste site, é 
possível efetuar o login e o download das extensões (muitas das quais são gratuitas), participar 
de grupos de discussão, visualizar as avaliações e críticas dos usuários, além de instalar e 
utilizar o Extension Manager. É necessário instalar o Extension Manager antes de instalar as 
extensões.

O Extension Manager é um aplicativo independente que permite instalar e gerenciar as 
extensões nos aplicativos da Macromedia. Inicie o Extension Manager no Dreamweaver 
escolhendo Commands (Comandos) > Manage Extensions (Gerenciar extensões). 

Para instalar e gerenciar as extensões:

1. No site do Macromedia Exchange na Web, clique no link de download de uma extensão.

O seu navegador talvez permita optar por abri-la e instalá-la diretamente no site ou salvá-
la em disco.
■ Se a extensão for aberta diretamente no site, o Extension Manager executará a 

instalação automaticamente.
■ Se a extensão for salva no disco, um bom local para salvar o arquivo do pacote de 

extensão (.mxp) é a pasta Downloaded Extensions, na pasta do aplicativo 
Dreamweaver do computador.

N
O

T
A

Para instalar extensões às quais todos os usuários tenham acesso em um sistema 
operacional multiusuário, é necessário ter efetuado login como Administrador (no 
Windows) ou raiz (no Mac OS X). Para obter mais informações sobre os sistemas 
multiusuário, consulte “Sobre a personalização do Dreamweaver em sistemas 
multiusuário” na página 55.
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2. Clique duas vezes no arquivo do pacote de extensão ou abra o Extension Manager e 
selecione File > Install Extension (Instalar a extensão).

A extensão será instalada no Dreamweaver. Algumas extensões não estarão acessíveis 
enquanto o Dreamweaver não for reiniciado. É possível que você seja solicitado a sair do 
aplicativo e reiniciá-lo.

N
O

T
A

Utilize o Extension Manager para remover extensões ou ver mais informações sobre 
uma determinada extensão.
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2

CAPÍTULO 2

Configurar um site do 
Dreamweaver  
Um site da Web é um conjunto de documentos vinculados com atributos compartilhados, 
como tópicos relacionados, um projeto semelhante ou uma finalidade compartilhada. O 
Macromedia Dreamweaver 8 é uma ferramenta de criação e gerenciamento de sites que você 
pode utilizar para criar sites da Web completos, além de documentos. 

A primeira etapa da criação de um site da Web é o planejamento. Para obter os melhores 
resultados, projete e planeje a estrutura do site da Web antes de criar as páginas contidas nele.

A próxima etapa é configurar o Dreamweaver para que você possa trabalhar na estrutura 
básica do site. Se você já tiver um site em um servidor da Web, poderá utilizar o Dreamweaver 
para editá-lo.

Este capítulo contém as seguintes seções:
Sobre sites do Dreamweaver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Configurar um novo site do Dreamweaver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

Utilizar as definições avançadas para configurar um site do Dreamweaver . . . . . . 91

Editar definições de um site do Dreamweaver. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Editar sites da Web já existentes no Dreamweaver . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Sobre sites do Dreamweaver  
Um site do Dreamweaver fornece uma maneira de organizar todos os documentos associados 
a um site da Web. A organização dos arquivos em um site permite utilizar o Dreamweaver 
para efetuar o upload do site no servidor da Web, controlar e manter automaticamente os 
links e gerenciar e compartilhar os arquivos. Para aproveitar todas as vantagens dos recursos do 
Dreamweaver, defina um site.

D
IC

A

À medida que você desenvolver o conteúdo do site, tente utilizar modelos do 
Dreamweaver como base para as páginas. Consulte “Sobre modelos do Dreamweaver” 
na página 326 e “Criar um modelo no Dreamweaver” na página 340.
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Um site do Dreamweaver consiste em até três partes, ou pastas, dependendo do ambiente de 
desenvolvimento e do tipo de site da Web a ser criado:

A pasta local é o diretório de trabalho. O Dreamweaver refere-se a essa pasta como “site 
local”. Essa pasta pode estar no computador local ou em um servidor da rede. Esse é o local 
onde você armazena os arquivos de um site do Dreamweaver nos quais está trabalhando. 

Para definir um site do Dreamweaver, basta configurar a pasta local. Para transferir arquivos 
para um servidor da Web ou desenvolver aplicativos para a Web, você também precisa 
adicionar informações relativas a um site remoto e um servidor de teste.

A pasta remota é onde são armazenados os arquivos, dependendo do ambiente de 
desenvolvimento: teste, produção, colaboração e assim por diante. O Dreamweaver refere-se a 
essa pasta como “site remoto” no painel Files (Arquivos). Normalmente, a pasta remota está 
situada no computador onde estiver em execução o servidor da Web.

As pastas local e remota permitem transferir arquivos entre o disco local e o servidor da Web, 
o que facilita o gerenciamento de arquivos dos sites do Dreamweaver.

A pasta de servidor de teste é a pasta onde o Dreamweaver processa páginas dinâmicas. Para 
obter mais informações, consulte “Especificar onde as páginas dinâmicas podem ser 
processadas” na página 667.

Tópicos relacionados
■ “Configurar um novo site do Dreamweaver” na página 90

Estrutura das pastas local e remota
Quando configurar o acesso à pasta remota para o site do Dreamweaver (consulte “Configurar 
uma pasta remota” na página 94), determine o diretório do host dessa pasta. O diretório do 
host especificado deverá corresponder à pasta raiz da pasta local. O diagrama a seguir mostra 
um exemplo de pasta local, à esquerda, e um exemplo de pasta remota, à direita.

site local
(pasta-raiz)

Propriedades

HTML

não

sim

não

diretório de login
(Não deve ser o Diretório
Host nesse caso)

public_html
(deve ser o
Diretório Host)

Propriedades
(Não deve ser o
Diretório Host)

HTML
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Se a estrutura da pasta remota não coincidir com a da pasta local, o Dreamweaver efetuará o 
upload dos arquivos para o local incorreto e eles não estarão visíveis para os visitantes do site. 
Os caminhos para as imagens e os links também serão rompidos.

É necessário que o diretório raiz remoto exista para que o Dreamweaver possa se conectar a 
ele. Se não houver um diretório raiz para a pasta remota, solicite ao administrador do servidor 
que crie um ou crie-o você mesmo.

Mesmo se pretender editar apenas uma parte do site remoto, duplique localmente toda a 
estrutura da ramificação do site remoto, desde a raiz do mesmo até os arquivos a serem 
editados. 

Por exemplo: se a pasta raiz do site remoto (denominada public_html) contiver duas pastas 
(Projeto1 e Projeto2) e você desejar trabalhar apenas com os arquivos HTML no Projeto1, 
não haverá necessidade de efetuar o download dos arquivos do Projeto2, porém será necessário 
mapear a pasta raiz local para public_html, em vez de Projeto1.

Tópicos relacionados
■ “Sobre sites do Dreamweaver” na página 87
■ “Configurar uma pasta remota” na página 94

SITE REMOTO SITE LOCAL

public_html

Projeto 1

Propriedades

HTML

Projeto 2

Propriedades

HTML

Pasta-raiz local
(mapeie esta pasta em public_html, 
não em Projeto1 ou Projeto1/HTML)

Projeto 1
(deve estar presente no site local; 
corresponde a Projeto1 no site remoto)

HTML
(deve estar presente no site local; 
corresponde a Projeto1/HTML no 
site remoto)
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Configurar um novo site do Dreamweaver 
Depois de planejar a estrutura do site, ou se já houver um site, defina um novo site no 
Dreamweaver antes de iniciar o desenvolvimento. A configuração de um site do Dreamweaver 
é uma maneira de organizar todos os documentos associados a um site da Web. Para obter 
mais informações, consulte “Sobre sites do Dreamweaver” na página 87.

Após configurar um site do Dreamweaver, é recomendável exportar o site para que você tenha 
uma cópia de backup local. Para obter mais informações, consulte “Importar e exportar sites” 
na página 147.

Para configurar um site do Dreamweaver:

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.

2. Clique no botão New (Novo).

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Siga um dos procedimentos abaixo:

■ Clique na guia Basic (Básica) para utilizar o Site Definition Wizard (Assistente de 
definição do site), que o orienta durante o processo de configuração.

■ Clique na guia Advanced (Avançado) para utilizar as definições avançadas, que 
permitem configurar individualmente pastas locais, remotas e de teste como 
necessário.

N
O

T
A

Você também pode editar arquivos sem configurar um site do Dreamweaver. Para obter 
mais informações, consulte “Acessar sites, um servidor e unidades locais” na página 118.

N
O

T
A

Se não houver um site do Dreamweaver definido, a caixa de diálogo Site Definition 
(Definição do site) aparecerá e você poderá passar para a próxima etapa.

N
O

T
A

Recomenda-se aos usuários que ainda não conhecem o Dreamweaver que 
utilizem o Site Definition Wizard; os usuários mais experientes do Dreamweaver 
poderão utilizar as definições avançadas.

N
O

T
A

Para iniciar o procedimento, configure na íntegra um site do Dreamweaver ou 
inicie apenas a primeira etapa, configurando a pasta local. 
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4. Conclua o processo de configuração do site do Dreamweaver:

■ Para o Site Definition Wizard, responda às perguntas de cada tela e, em seguida, clique 
em Next (Avançar) para continuar o processo de configuração ou clique em Back 
(Voltar) para retornar à tela anterior.

■ Para as definições avançadas, preencha as categorias Local Info (Informações locais), 
Remote Info (Informações remotas) e Testing Server (Servidor de teste), conforme 
necessário (consulte “Utilizar as definições avançadas para configurar um site do 
Dreamweaver” na página 91).

Se você estiver configurando um site do Dreamweaver para um aplicativo para a Web, 
consulte Capítulo 23, “Configurar um aplicativo para a Web”, na página 657.

Utilizar as definições avançadas para 
configurar um site do Dreamweaver 
Você pode utilizar as definições avançadas da caixa de diálogo Site Definition (Definição do 
site) para configurar um site do Dreamweaver. As definições avançadas permitem configurar 
pastas locais, remotas e de teste separadamente, para o processamento de páginas dinâmicas, 
como necessário. Esse método é recomendado aos usuários experientes do Dreamweaver.

Se você não tiver experiência com o Dreamweaver, poderá utilizar o Site Definition Wizard 
(Assistente de definição do site), em vez das definições avançadas, para orientá-lo durante o 
processo de configuração. Consulte “Configurar um novo site do Dreamweaver” na 
página 90.

D
IC

A

Após configurar um site do Dreamweaver, é recomendável exportar o site para 
que você tenha uma cópia de backup local. Para obter mais informações, 
consulte “Importar e exportar sites” na página 147.

N
O

T
A

Para começar rapidamente, você pode ir para a primeira etapa da configuração de um 
site do Dreamweaver, que configura a pasta local. Em seguida, você pode adicionar 
informações remotas e de teste. É necessário configurar pelo menos uma pasta local 
antes de começar a utilizar o Dreamweaver.
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Se você estiver configurando um site do Dreamweaver para um aplicativo para a Web, ignore 
esta seção e consulte Capítulo 23, “Configurar um aplicativo para a Web”, na página 657.

Tópicos relacionados
■ “Sobre sites do Dreamweaver” na página 87
■ “Especificar onde as páginas dinâmicas podem ser processadas” na página 667

Configurar uma pasta local
A pasta local é o diretório de trabalho do site do Dreamweaver.  Essa pasta pode estar no 
computador local ou em um servidor da rede. 

Para configurar uma pasta local:

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.

2. Clique em New (Novo).

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Clique no botão Advanced (Avançado) se as definições avançadas não estiverem sendo 

exibidas.

D
IC

A

Após configurar um site do Dreamweaver, é recomendável exportar o site para que você 
tenha uma cópia de backup local. Para obter mais informações, consulte “Importar e 
exportar sites” na página 147.

N
O

T
A

Se não houver um site do Dreamweaver definido, a caixa de diálogo Site Definition 
(Definição do site) aparecerá e você poderá passar para a próxima etapa.
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A guia Advanced da caixa de diálogo Site Definition exibirá as opções da categoria Local 
Info (Informações locais).

4. Digite as opções de informações locais.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
5. (Opcional) Se você estiver pronto para configurar o servidor remoto agora, pule as etapas 

restantes; selecione a categoria Remote Info (Informações remotas) à esquerda e, em 
seguida, preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
6. Clique em OK.

O Dreamweaver criará o cache inicial do site, e o novo site do Dreamweaver aparecerá no 
painel Files (Arquivos). 
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Depois de configurar uma pasta local, você poderá adicionar pastas remotas ou de teste 
(consulte “Configurar uma pasta remota” na página 94 e “Especificar onde as páginas 
dinâmicas podem ser processadas” na página 667).

Tópicos relacionados
■ “Sobre sites do Dreamweaver” na página 87
■ “Gerenciar arquivos” na página 113

Configurar uma pasta remota 
Depois que você tiver configurado uma pasta local de um site do Dreamweaver (consulte 
“Configurar uma pasta local” na página 92), configure uma pasta remota. Dependendo do 
ambiente de desenvolvimento, a pasta remota é o local onde você armazena arquivos para 
teste, colaboração, produção, disposição ou outros tipos de atividade. 

Determine como você acessará a pasta remota e anote as informações de conexão. Esta seção 
descreve como configurar uma pasta remota e conectar-se a ela.

Para configurar uma pasta remota:

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.
2. Selecione um site do Dreamweaver já existente. 

Se não houver sites do Dreamweaver definidos, crie uma pasta local antes de continuar 
(consulte  “Configurar uma pasta local” na página 92). 

3. Clique em Edit (Editar).

A caixa de diálogo Site Definition (Definição do site) é exibida.
4. Clique no botão Advanced (Avançado) se as definições avançadas não estiverem sendo 

exibidas.

5. Selecione Remote Info na lista Category (Categoria) à esquerda.

6. Selecione uma opção de acesso.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

N
O

T
A

Não será necessário especificar uma pasta remota se a pasta especificada como local 
for a mesma pasta criada para os arquivos do site no sistema que estiver executando o 
servidor da Web. Isso indica que o servidor da Web está em execução no computador 
local. 
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7. Clique em OK.

O Dreamweaver criará uma conexão para a pasta remota. Se você estiver desenvolvendo 
um site dinâmico, precisará adicionar uma pasta Testing Server (Servidor de teste) para 
processar as páginas dinâmicas (consulte “Especificar onde as páginas dinâmicas podem 
ser processadas” na página 667).

Para se conectar a uma pasta remota com o acesso de FTP:

■ No painel Files (Arquivos), clique no botão Connects to Remote Host (Conectar ao host 
remoto) na barra de ferramentas. 

Para se desconectar de uma pasta remota com o acesso de FTP:

■ No painel Files, clique no botão Disconnect (Desconectar) na barra de ferramentas.

Para se conectar ou desconectar de uma pasta remota com acesso à rede:

■ Você não precisa se conectar à pasta remota; você está sempre conectado. Clique no botão 
Refresh (Atualizar) para ver os arquivos remotos.

Tópicos relacionados
■ “Sobre sites do Dreamweaver” na página 87
■ “Estrutura das pastas local e remota” na página 88
■ “Solucionar problemas de configuração da pasta remota” na página 95

Solucionar problemas de configuração da pasta 
remota 
Um servidor da Web pode ser configurado de várias maneiras. A lista a seguir contém 
informações sobre alguns problemas comuns que podem ocorrer durante a configuração de 
uma pasta remota (consulte “Configurar uma pasta remota” na página 94) e como solucioná-
los:

■ É possível que a implementação de FTP do Dreamweaver não funcione corretamente em 
determinados servidores proxy, firewalls em muitos níveis e outras formas de acesso 
indireto ao servidor. 
Caso você tenha problemas com o acesso de FTP, peça ajuda ao administrador de sistemas 
local.
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■ Para efetuar a implementação de FTP do Dreamweaver, é necessário estabelecer conexão 
com a pasta raiz do sistema remoto. Em muitos aplicativos, é possível conectar-se a 
qualquer diretório remoto e, em seguida, navegar pelo sistema de arquivos remotos, para 
localizar o diretório desejado. 
Certifique-se de indicar a pasta raiz do sistema remoto como diretório do host.
Se estiverem ocorrendo problemas na conexão e o diretório do host tiver sido especificado 
com uma barra inclinada simples (/), é possível que você precise especificar um caminho 
relativo do diretório ao qual estiver se conectando, assim como a pasta raiz remota.
Por exemplo: se a pasta raiz remota for um diretório de nível mais elevado, é possível que 
você precise especificar ../../ correspondente ao diretório do host. 

■ Os nomes de pastas e arquivos que contêm espaços e caracteres especiais geralmente 
causam problemas quando são transferidos para um site remoto. 
Utilize sinais de sublinhado em vez de espaços e evite os caracteres especiais nos nomes de 
arquivos e pastas, sempre que possível. Em particular, dois pontos, barras inclinadas, 
pontos e apóstrofes nos nomes de arquivos ou pastas podem causar problemas. 
Ocasionalmente, os caracteres especiais em nomes de pastas ou arquivos também podem 
impedir que o Dreamweaver crie um mapa do site.

■ Se ocorrerem problemas com nomes longos de arquivos, renomeie-os com designações 
mais curtas. No Macintosh, os nomes de arquivos não podem exceder 31 caracteres. 

■ Observe que muitos servidores podem utilizar links simbólicos (no UNIX), atalhos (no 
Windows) ou apelidos (no Macintosh), para conectar uma pasta em uma parte do disco 
do servidor a uma outra que esteja em uma localização diferente.
Por exemplo: o subdiretório public_html do seu diretório principal no servidor pode ser, 
na verdade, um link para outra parte do servidor. Na maioria dos casos, esses apelidos não 
têm efeito sobre a possibilidade de conexão à pasta ou diretório adequado, mas, se for 
possível conectar-se a uma parte do servidor mas não a outras, talvez exista uma 
discrepância de apelidos.

■ Caso apareça uma mensagem de erro como: “cannot put file (não é possível colocar o 
arquivo)”, é possível que não haja espaço na pasta remota. Para obter informações mais 
detalhadas, consulte o registro do FTP.

N
O

T
A

Em geral, se você tiver um problema em uma transferência por FTP, examine o 
registro do FTP selecionando Window (Janela) > Results (Resultados) (no Windows) 
ou Site > FTP Log (Registro do FTP) (no Macintosh), e clicando na tag FTP Log.
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Editar definições de um site do 
Dreamweaver 
Utilize as definições avançadas de Site Definition (Definição do site) para editar os sites do 
Dreamweaver.

Para editar as definições de um site do Dreamweaver, siga um dos seguintes 
procedimentos: 

■ Selecione Site > Manage Sites (Gerenciar sites), selecione um site na caixa de diálogo 
Manage Sites e, em seguida, clique em Edit (Editar).

■ No painel Files (Arquivos), selecione Manage Sites no menu pop-up em que o site atual, o 
servidor ou a unidade aparece; selecione um site na caixa de diálogo Manage Sites e, em 
seguida, clique em Edit.

Tópicos relacionados
■ “Configurar um novo site do Dreamweaver” na página 90

Editar sites da Web já existentes no 
Dreamweaver
Você pode utilizar o Dreamweaver para editar sites existentes, mesmo se o site original não 
tiver sido criado no Dreamweaver. É possível editar sites existentes no sistema local ou em um 
sistema remoto.

Editar um site local da Web já existente no 
Dreamweaver
Você poderá utilizar o Dreamweaver para editar um site da Web já existente no disco local, 
mesmo se o site original não tiver sido criado no Dreamweaver.

Para editar um site da Web local existente:

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.

N
O

T
A

Esta seção configura um site do Dreamweaver para editar um site local da Web já 
existente. Você também pode editar o site existente sem criar um site do Dreamweaver. 
Para obter mais informações, consulte “Acessar sites, um servidor e unidades locais” na 
página 118.
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2. Clique em New (Novo).

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Clique no botão Advanced (Avançado) se as definições avançadas não estiverem sendo 

exibidas.

A guia Advanced da caixa de diálogo Site Definition exibirá as opções da categoria Local 
Info (Informações locais).

4. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
5. Clique em OK.

Editar um site remoto da Web já existente no 
Dreamweaver
Você pode utilizar o Dreamweaver para copiar um site remoto já existente (ou uma 
ramificação desse site) para o disco local e editá-lo, mesmo se o site original não tiver sido 
criado no Dreamweaver.

Para editar um site remoto já existente: 

1. Crie uma pasta local que abrigará o site já existente e defina-a como a pasta local do site 
(consulte “Configurar uma pasta local” na página 92).

2. Configure uma pasta remota (consulte “Configurar uma pasta remota” na página 94) 
utilizando as informações sobre o site já existente. 

Escolha a pasta raiz correta para o site remoto.
3. Para exibir o site remoto, no painel Files (Arquivos), em Window (Janela) > Files, clique 

no botão Connects to Remote Host (Conectar ao host remoto), para acesso ao FTP; ou 
clique no botão Refresh (Atualizar), para acesso à rede, na barra de tarefas.

N
O

T
A

Esta seção configura um site do Dreamweaver para editar um site remoto da Web já 
existente. Você também pode editar o site existente sem criar um site do Dreamweaver. 
Para obter mais informações, consulte “Acessar sites, um servidor e unidades locais” na 
página 118.

N
O

T
A

Duplique localmente a estrutura inteira da ramificação em questão do site remoto 
existente. Para obter mais informações, consulte “Estrutura das pastas local e 
remota” na página 88.
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4. Dependendo de quanto deseje editar no site remoto, siga um destes procedimentos:

■ Para trabalhar com todo o site, selecione a pasta raiz do site remoto no painel Files e, 
em seguida, clique em Get (Obter), na barra de tarefas, para efetuar o download de 
todo o site para o disco local.

■ Se desejar trabalhar apenas com um dos arquivos ou uma das pastas do site, localize o 
item na visualização remota do painel Files e clique em Get para efetuar o seu 
download para o disco local.

O Dreamweaver duplicará automaticamente a parte necessária da estrutura do site remoto 
para posicionar o arquivo do qual você efetuou o download no local adequado da 
hierarquia do site. Ao editar apenas uma parte de um site, opte preferencialmente por 
incluir os arquivos dependentes.

5. Utilize o Dreamweaver para trabalhar no site.

Tópicos relacionados
■ “Editar um site local da Web já existente no Dreamweaver” na página 97
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CAPÍTULO 3

Criar e abrir documentos
O Macromedia Dreamweaver 8 oferece um ambiente flexível para trabalhar com vários 
documentos de desenvolvimento e criação na Web. Além de documentos HTML, você pode 
criar e abrir diversos documentos baseados em texto, inclusive CFML, ASP, JavaScript e CSS. 
O Dreamweaver também oferece suporte a arquivos de código-fonte, como Visual Basic, 
.NET, C# e Java.

O Dreamweaver fornece várias opções para a criação de um novo documento. Você pode criar 
qualquer um dos seguintes documentos:

■ Um novo modelo ou documento em branco
■ Um documento baseado em um dos layouts de página predefinidos incluídos no 

Dreamweaver
■ Um documento baseado em um dos seus modelos

Outras opções de documentos também estão disponíveis. Por exemplo, se você geralmente 
trabalha com um tipo de documento, poderá defini-lo como o tipo de documento padrão 
para as novas páginas que criar. 

No Dreamweaver, é possível definir com facilidade as propriedades de um documento, tais 
como tags meta, título de documentos e cores de fundo, além de várias outras propriedades de 
página na visualização do projeto ou na visualização do código. 

Este capítulo contém as seguintes seções:
Criar novos documentos. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Salvar um novo documento . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Definir um novo tipo de documento padrão . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

Definir a extensão de arquivo padrão de novos documentos HTML . . . . . . . . . . . 106

Abrir documentos existentes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107

Limpar arquivos HTML do Microsoft Word . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
101



         
Criar novos documentos
O Dreamweaver fornece várias opções de seleção de um novo documento de trabalho. É 
possível criar um novo documento das seguintes maneiras:

■ Começar com um documento em branco (consulte “Criar um novo documento em 
branco” na página 102).

■ Criar um documento ou um modelo em branco com base em um arquivo de projeto do 
Dreamweaver (consulte “Criar um documento com base em um arquivo de projeto do 
Dreamweaver” na página 103).

■ Utilizar um modelo que defina a aparência de um documento e determine quais partes de 
um documento poderão ser editadas (consulte “Criar um documento a partir de um 
modelo existente” na página 104).

Criar um novo documento em branco
Você pode selecionar o tipo de documento em branco a ser criado.

Para criar um novo documento em branco:

1. Selecione File (Arquivo)> New (Novo).

A caixa de diálogo New Document (Novo documento) é exibida. A guia General (Geral) 
já está selecionada.

2. Na lista Category (Categoria), selecione Basic Page (Página básica), Dynamic Page (Página 
dinâmica), Template Page (Página de modelo), Other (Outros) ou Framesets (Conjuntos 
de quadros). Em seguida, na lista à direita, selecione o tipo de documento a ser criado. 

Por exemplo, selecione Basic Page para criar um documento HTML, ou Dynamic Page 
para criar um documento ColdFusion ou ASP e assim por diante.
Para obter mais informações sobre as opções dessa caixa de diálogo, clique no botão Help 
(Ajuda) na caixa de diálogo. 

D
IC

A

Se, geralmente, você trabalha com um tipo de documento específico, poderá definir 
um documento padrão e automaticamente abrir um novo documento com base no 
documento padrão por ele definido. Para obter informações, veja “Definir um novo 
tipo de documento padrão” na página 106.
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3. Clique no botão Create (Criar).

O novo documento é aberto na janela do documento.
4. Salve o documento (consulte “Salvar um novo documento” na página 105).

Tópicos relacionados
■ “Criar um documento a partir de um modelo existente” na página 104

Criar um documento com base em um arquivo de 
projeto do Dreamweaver
O Dreamweaver vem com diversos arquivos de elementos de design e de layout de página com 
aparência profissional. É possível utilizar esses arquivos de projeto como pontos de partida para 
criar páginas do seu próprio site. Quando você cria um documento com base em um arquivo 
de projeto, o Dreamweaver gera uma cópia do arquivo.

Para criar um novo documento a partir de um arquivo de projeto do 
Dreamweaver: 

1. Selecione File (Arquivo)> New (Novo).

A caixa de diálogo New Document (Novo documento) é exibida. A guia General (Geral) 
já está selecionada.

2. Na lista Category (Categoria), selecione CSS Style Sheets (Folhas de estilo CSS), Table 
Based Layouts (Layouts baseados em tabelas), Page Designs (CSS) (Projetos de página 
[CSS]) Page Designs (Projetos de página) ou Page Designs (Accessible) (Projetos de páginas 
[acessíveis]). Em seguida, selecione um arquivo de projeto na lista à direita.

Você pode visualizar um arquivo de projeto e ler uma breve descrição dos elementos de 
projeto de um documento.
Para obter mais informações sobre as opções dessa caixa de diálogo, clique no botão Help 
(Ajuda) na caixa de diálogo. 

3. Clique no botão Create (Criar).

O novo documento é aberto na janela do documento. Se você tiver selecionado uma folha 
de estilos CSS, o documento CSS aparecerá na janela do documento e a folha de estilos 
CSS será aberta na visualização do código.

N
O

T
A

Se você criar um documento com base em um conjunto de quadros predefinido, apenas 
a estrutura do conjunto de quadros será copiada, e não o conteúdo do quadro. Além 
disso, será necessário salvar cada arquivo de quadro separadamente. Para obter 
informações sobre como salvar quadros, consulte “Salvar arquivos de quadros e de 
conjuntos de quadros” na página 316.
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4. Salve o documento (consulte “Salvar um novo documento” na página 105).

Se o arquivo contiver links para os arquivos de propriedades, a caixa de diálogo Copy 
Dependent Files (Copiar os arquivos dependentes) será aberta para você salvar uma cópia 
dos arquivos dependentes.

5. Se a caixa de diálogo Copy Dependent Files aparecer, defina as opções e, em seguida, clique 
em Copy (Copiar) para copiar as propriedades na pasta selecionada. 

Você pode escolher sua própria localização para os arquivos dependentes ou utilizar a 
localização da pasta padrão gerada pelo Dreamweaver (com base no nome de origem do 
arquivo de projeto).

Tópicos relacionados
■ “Criar um novo documento em branco” na página 102

Criar um documento a partir de um modelo existente
Você pode selecionar, visualizar e criar um novo documento a partir de um modelo existente. 
É possível utilizar a caixa de diálogo New Document (Novo documento) para selecionar um 
modelo de qualquer um dos seus sites definidos pelo Dreamweaver ou utilizar o painel Assets 
(Propriedades) para criar um novo documento a partir de um modelo.

Para obter informações sobre como criar modelos, consulte “Criar um modelo no 
Dreamweaver” na página 340.

Para criar um novo documento a partir de um modelo: 

1. Selecione File (Arquivo)> New (Novo).

A caixa de diálogo New Document é exibida. 
2. Clique na guia Templates (Modelos).

3. Na lista Templates For (Modelos para), selecione o site do Dreamweaver que contém o 
modelo a ser utilizado e, em seguida, selecione um modelo na lista à direita.

Para obter mais informações sobre as opções dessa caixa de diálogo, clique no botão Help 
(Ajuda) na caixa de diálogo. 

4. Clique em Create (Criar). 

O novo documento é aberto na janela do documento.

D
IC

A

Se o seu site não contiver modelos, você poderá salvar um documento em uma das 
categorias do arquivo de projetos da caixa de diálogo New Document. Em seguida, crie 
páginas baseadas nesse modelo. Para obter informações sobre como salvar um arquivo 
de projeto como um modelo, consulte “Criar um documento com base em um arquivo de 
projeto do Dreamweaver” na página 103.
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5. Salve o documento (consulte “Salvar um novo documento” na página 105).

Para criar um novo documento de um modelo no painel Assets: 

1. Abra o painel Assets, em Window (Janela) > Assets, se ele ainda não estiver aberto.

2. No painel Assets, clique no ícone Templates à esquerda para exibir a lista de modelos no 
seu site atual.

3. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) no modelo a ser aplicado e, em seguida, selecione New From 
Template (Novo a partir de modelo).

O documento é aberto na janela do documento.

Tópicos relacionados
■ “Criar um novo documento em branco” na página 102
■ “Criar um documento com base em um arquivo de projeto do Dreamweaver” na 

página 103

Salvar um novo documento
Quando você cria um novo documento, é preciso salvá-lo.

Para salvar um novo documento:

1. Selecione File (Arquivo) > Save (Salvar).

2. Na caixa de diálogo exibida, navegue até a pasta onde deseja salvar o arquivo.

3. Na caixa de texto File Name (Nome do arquivo), digite um nome para o arquivo.

Evite utilizar espaços e caracteres especiais em nomes de arquivos e de pastas e não inicie 
um nome de arquivo com um número. Particularmente, não utilize caracteres especiais 
(como é, ç ou ¥) ou pontuação (como dois pontos, barras inclinadas ou pontos) nos 
nomes dos arquivos que serão colocados em um servidor remoto. Muitos servidores 
alteram esses caracteres durante o upload, o que causa o rompimento dos links para 
os arquivos. 

4. Clique em Save (Salvar).

D
IC

A

Se você acabou de criar o modelo que deseja aplicar, talvez seja preciso clicar no 
botão Refresh (Atualizar) para visualizá-lo.

D
IC

A

É aconselhável salvar seu arquivo em um site do Dreamweaver. Para obter mais 
informações, consulte “Configurar um novo site do Dreamweaver” na página 90.
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Definir um novo tipo de documento 
padrão
Você pode definir o tipo de documento que o Dreamweaver utiliza como o documento 
padrão de um site. 

Por exemplo, se a maioria das páginas de um site tiver um tipo de arquivo específico (como 
documentos ColdFusion, HTML ou ASP), você poderá definir as preferências de documento 
que criam automaticamente novos documentos do tipo de arquivo especificado.

Para definir um novo tipo de documento padrão e suas preferências:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.

2. Clique em New Document na lista de categorias à esquerda.

3. Defina ou altere as preferências como necessário.

Para obter mais informações sobre as opções dessa caixa de diálogo, clique no botão Help 
(Ajuda).

4. Clique em OK.

O Dreamweaver salva as preferências.

Definir a extensão de arquivo padrão de 
novos documentos HTML
É possível definir a extensão de arquivo padrão de documentos HTML criados no 
Dreamweaver. Por exemplo, é possível indicar que o Dreamweaver utilize uma extensão .htm 
ou .html para todos os novos documentos HTML.

Para definir a extensão de arquivo padrão de novos documentos HTML:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.

D
IC

A

Você também pode clicar no botão Preferences na caixa de diálogo New Document 
(Novo documento) para definir as preferências quando criar um novo documento 
(consulte “Criar um novo documento em branco” na página 102).

D
IC

A

Você também pode clicar no botão Preferences na caixa de diálogo New Document 
(Novo documento) para definir as preferências quando criar um novo documento 
(consulte “Criar um novo documento em branco” na página 102).
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2. Clique em New Document na lista de categorias à esquerda.

3. Em Default Document Type (Tipo de documento padrão), selecione a opção HTML.

4. Na caixa de texto Default Extension (Extensão padrão), especifique a extensão de arquivo 
que deseja para os novos documentos HTML criados no Dreamweaver.

Para Windows, é possível especificar as seguintes extensões: .html, .htm, .shtml, .shtm, 
.stm, .tpl, .lasso, .xhtml.
Para Macintosh, é possível especificar as seguintes extensões: .html, .htm, .shtml, .shtm, 
.tpl, .lasso, .xhtml, .ssi. 

Abrir documentos existentes 
No Dreamweaver, você pode abrir uma página da Web existente ou um documento baseado 
em texto, mesmo que ele não tenha sido criado no Dreamweaver. É possível abrir o 
documento e utilizar o Dreamweaver para editá-lo na visualização do projeto ou do código.

Se o documento aberto for um arquivo do Microsoft Word salvo como HTML, você poderá 
utilizar o comando Cleanup Word HTML (Limpar o HTML do Word) para remover as tags 
de markup irrelevantes que o Word insere em arquivos HTML. Para obter mais informações, 
consulte “Limpar arquivos HTML do Microsoft Word” na página 108.

Para limpar o HTML ou XHTML que não foi gerado pelo Microsoft Word, consulte 
“Limpar o código” na página 633.

Também é possível abrir arquivos de texto diferentes de HTML, tais como arquivos 
JavaScript, arquivos XML, folhas de estilos CSS ou arquivos de texto salvos por processadores 
ou editores de texto. 

Para abrir um arquivo existente:

1. Selecione File (Arquivo) > Open (Abrir).

A caixa de diálogo Open é exibida.

2. Navegue e selecione o arquivo a ser aberto.

D
IC

A

Também é possível utilizar o painel Files (Arquivos) para abrir arquivos. Para obter 
mais informações, consulte “Trabalhar com arquivos no painel Files (Arquivos)” na 
página 134.

N
O

T
A

Se ainda não tiver selecionado o arquivo, é recomendável organizar os arquivos que 
planeja abrir e editar em um site do Dreamweaver, e não em outro local. Para obter 
informações sobre como configurar um site do Dreamweaver, consulte “Configurar 
um novo site do Dreamweaver” na página 90.
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3. Clique em Open.

O documento é aberto na janela do documento. 
Por padrão, documentos JavaScript, de texto e de Folhas de estilos CSS são abertos na 
visualização do código. É possível atualizar o documento enquanto se trabalha no 
Dreamweaver e, depois, salvar as alterações feitas no arquivo. Para obter informações sobre 
como definir um editor de texto externo para exibir esses tipos de arquivos, consulte 
“Iniciar um editor de arquivos de mídia externo” na página 521.

Limpar arquivos HTML do Microsoft 
Word
No Dreamweaver, é possível abrir documentos salvos pelo Microsoft Word como arquivos 
HTML e, então, utilizar o comando Clean Up Word HTML (Limpar o HTML do Word) 
para remover o código HTML irrelevante gerado pelo Word. O comando Clean Up Word 
HTML está disponível para documentos salvos como arquivos HTML no Word 97 ou em 
versões posteriores.

O código que o Dreamweaver remove é utilizado pelo Word basicamente para formatar e 
exibir os documentos no Word, não sendo necessário à exibição do arquivo HTML. É 
recomendável guardar uma cópia de segurança do arquivo original do Word (.doc), porque 
talvez não seja possível reabrir o documento HTML no Word após a aplicação do recurso 
Clean Up Word HTML. 

Para limpar o HTML ou XHTML que não foi gerado pelo Microsoft Word, consulte 
“Limpar o código” na página 633.

Para abrir e limpar um arquivo HTML do Microsoft Word: 

1. No Microsoft Word, salve o documento como um arquivo HTML, se ainda não tiver feito 
isso.

2. Abra o arquivo HTML no Dreamweaver.

Para exibir o código HTML gerado pelo Word, alterne para a visualização do código 
(View [Exibir] > Code [Código].

N
O

T
A

No Windows, feche o arquivo no Word para evitar uma violação de 
compartilhamento.
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3. Selecione Commands (Comandos) > Clean Up Word HTML (Limpar o HTML do 
Word).

A caixa de diálogo Clean Up Word HTML é exibida.
Poderá ocorrer um pequeno atraso enquanto o Dreamweaver tenta detectar a versão do 
Word utilizada para salvar o arquivo. Se o Dreamweaver não conseguir detectá-la, 
selecione a versão correta no menu pop-up. 

4. Desmarque as opções da caixa de diálogo, se desejar.

Para obter mais informações sobre as opções dessa caixa de diálogo, clique no botão Help 
(Ajuda).

5. Clique em OK.

O Dreamweaver aplica as configurações de limpeza ao documento HTML, e um registro 
das alterações é exibido (a menos que você desmarque essa opção na caixa de diálogo).

Tópicos relacionados
■ “Importar documentos do Microsoft Office (apenas noWindows)” na página 420
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PARTE 2

Trabalhar com sites do 
Dreamweaver
Aprenda a gerenciar os sites do Macromedia Dreamweaver 8 e as 
propriedades específicas do site.

Esta seção contém os seguintes capítulos:
Capítulo 4: Gerenciar arquivos  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

Capítulo 5: Gerenciar bibliotecas e propriedades de sites  . . . . . 177

Capítulo 6: Gerenciar sites do Contribute com o Dreamweaver 201
111
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CAPÍTULO 4

Gerenciar arquivos
O Macromedia Dreamweaver 8 ajuda a organizar e gerenciar arquivos.

O Dreamweaver inclui vários recursos para gerenciar arquivos e transferir arquivos entre o seu 
computador e um servidor remoto. Quando os arquivos são transferidos entre os sites locais e 
remotos, o Dreamweaver mantém paralelas as estruturas de pastas e arquivos entre estes sites. 
Ao transferir arquivos entre os sites, o Dreamweaver automaticamente criará as pastas 
necessárias, se ainda não existirem em um dos sites. Você também pode sincronizar os 
arquivos entre os sites locais e remotos. Quando apropriado, o Dreamweaver copia arquivos 
nas duas direções e remove os arquivos inúteis.

O Dreamweaver contém recursos para facilitar o trabalho de colaboração em sites da Web. É 
possível retirar e devolver os arquivos a um servidor remoto, de maneira que os outros 
membros de uma equipe da Web possam saber quem está trabalhando em um determinado 
arquivo. É possível adicionar Design Notes aos arquivos, para compartilhar informações com 
os membros da equipe sobre o status e prioridade de um arquivo, e assim por diante. Também 
é possível utilizar o recurso Workflow Reports (Relatórios de fluxo de trabalho), para executar 
relatórios relativos ao site, exibir informações sobre o status das retiradas e devoluções de 
arquivos e procurar as Design Notes anexadas aos arquivos.

Este capítulo contém as seguintes seções:
Sobre o gerenciamento de sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .114

Acessar sites, um servidor e unidades locais . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .118

Exibir arquivos e pastas. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122

Comparar arquivos para conhecer as diferenças . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126

Reverter arquivos (usuários do Contribute)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132

Gerenciar arquivos e pastas no painel Files (Arquivos) . . . . . . . . . . . . . . . . . . . . . . . 132

Trabalhar com um mapa visual do site. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137

Importar e exportar sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147

Remover um site do Dreamweaver da lista de sites . . . . . . . . . . . . . . . . . . . . . . . . . . 148

Devolver e retirar arquivos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148

Obter e colocar arquivos no servidor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155
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Sincronizar os arquivos nos sites local e remoto. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .161

Identificar e excluir arquivos não-utilizados . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162

Mascarar as pastas e os arquivos do site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163

Armazenar informações sobre arquivos nas Design Notes  . . . . . . . . . . . . . . . . . . . 167

Testar o site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171

Sobre o gerenciamento de sites
O Dreamweaver inclui diversos recursos para gerenciar um site e transferir arquivos entre o 
seu computador e um servidor remoto. O Dreamweaver também contém recursos para 
facilitar o trabalho em equipe em um site da Web, como o Check In/Check Out (Devolver/
retirar) e as Design Notes.

Sobre o sistema de devoluções e retiradas
Em um ambiente com vários usuários, utilize o sistema de devoluções e retiradas de arquivos 
dos servidores local e remoto. 

A retirada de um arquivo equivale a declarar: “Estou trabalhando com este arquivo — não o 
toque!”. Quando um arquivo for retirado, o Dreamweaver exibirá, no painel Files (Arquivos), 
o nome da pessoa que o retirou, juntamente com uma marca de seleção vermelha (se um 
membro da equipe o tiver retirado) ou verde (se você for essa pessoa) ao lado do ícone do 
arquivo.

A devolução de um arquivo possibilitará aos outros membros da equipe retirá-lo e editá-lo. 
Quando você devolver um arquivo depois de editá-lo, a sua versão local se tornará somente 
leitura e aparecerá um símbolo de cadeado ao lado dela no painel Files para evitar 
modificações. 

No servidor remoto, o Dreamweaver não modifica o status dos arquivos retirados para 
somente leitura. Caso os arquivos sejam transferidos com um aplicativo diferente do 
Dreamweaver, você poderá sobrescrever os arquivos retirados. No entanto, em aplicativos 
diferentes do Dreamweaver, o arquivo LCK estará visível ao lado do arquivo retirado na 
hierarquia de arquivos para evitar acidentes desse tipo.

Para obter mais informações sobre os arquivos LCK e o funcionamento do sistema de 
devoluções e retiradas, consulte TechNote 15447 no site da Macromedia na Web em 
www.macromedia.com/go/15447.

N
O

T
A

É possível utilizar os recursos Get (Obter) e Put (Colocar) com um servidor de teste, mas 
não os recursos Check In/Check Out. Para obter mais informações sobre como usar os 
recursos Get e Put, consulte “Obter e colocar arquivos no servidor” na página 155.
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Tópicos relacionados
■ “Configurar o sistema Check In/Check Out (Devolver/retirar)” na página 149
■ “Devolver e retirar os arquivos de um servidor remoto” na página 153

Sobre as transferências de arquivos em segundo 
plano
O Dreamweaver permite a execução de outras atividades não relacionadas com o servidor 
enquanto você está obtendo ou colocando arquivos. A transferência de arquivos em segundo 
plano funciona para todos os protocolos de transferência suportados pelo Dreamweaver: FTP, 
SFTP, LAN, WebDAV, Microsoft Visual SourceSafe e RDS.

As atividades não relacionadas com o servidor incluem operações comuns como digitação, 
edição de folhas de estilos%% externas, geração de relatórios de todo o site e criação de novos 
sites. 

As atividades relacionadas com o servidor e que o Dreamweaver não pode executar durante as 
transferências de arquivos incluem as seguintes:

■ Obter/colocar/devolver/retirar arquivos.
■ Desfazer a retirada.
■ Criar uma conexão de banco de dados.
■ Ligar dados dinâmicos.
■ Visualizar Live Data.
■ Inserir um serviço da Web.
■ Excluir arquivos ou pastas remotas.
■ Visualizar no navegador em um servidor de teste.
■ Salvar um arquivo em um servidor remoto.
■ Inserir uma imagem de um servidor remoto.
■ Abrir um arquivo de servidor remoto.
■ Colocar arquivos em salvamento automático.
■ Arrastar arquivos para o site remoto.
■ Recortar, copiar ou colar arquivos no site remoto.
■ Atualizar a visualização remota.

Tópicos relacionados
■ “Gerenciar transferências de arquivos” na página 160
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Sobre o mascaramento de sites
O mascaramento de sites permite excluir pastas e tipos de arquivo de operações como 
obtenção e colocação. É possível mascarar pastas individuais, mas não arquivos individuais. 
Para mascarar arquivos, selecione um tipo de arquivo. O Dreamweaver irá mascarar todos os 
arquivos desse tipo. Além disso, o Dreamweaver memorizará as definições de cada site, de 
modo que você não tenha que fazer seleções sempre que trabalhar no site.

Por exemplo, se estiver trabalhando em um site grande e não desejar efetuar o upload diário 
dos arquivos de multimídia, utilize o mascaramento do site para esconder a pasta de 
multimídia. O sistema excluirá os arquivos dessa pasta das operações que afetarem o site.

É possível mascarar pastas e tipos de arquivos do site remoto ou local. O mascaramento exclui 
as pastas e os arquivos mascarados nas seguintes operações:

■ Executar as operações Put (Colocar), Get (Obter), Check In (Devolver) e Check Out 
(Retirar)

■ Geração de relatórios 
■ Localização de arquivos locais e remotos mais recentes
■ Execução de operações no site inteiro, como a verificação e a alteração de links
■ Sincronização
■ Trabalho com o conteúdo do painel Assets (Propriedades)
■ Atualização de modelos e bibliotecas

Tópicos relacionados
■ “Mascarar as pastas e os arquivos do site” na página 163

Sobre o Design Notes
As Design Notes são notas que acompanham um arquivo. Elas estão associadas ao arquivo que 
descrevem, mas são armazenadas em outro arquivo. Você pode ver quais arquivos apresentam 
Design Notes anexadas no painel Files (Arquivos) expandido: o ícone Design Notes aparece 
na coluna Notes (Notas).

N
O
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A

O Dreamweaver  exclui modelos e itens de biblioteca mascarados apenas das 
operações de obtenção (Get) e colocação (Put), mas não das operações em lote, 
pois isso pode fazer com que fiquem fora de sintonia com suas respectivas 
instâncias.
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Utilize as Design Notes para controlar as informações adicionais relativas aos documentos, 
como nomes de arquivos de origem de imagens e comentários sobre o status de arquivos. Por 
exemplo: se um documento for copiado de um site para outro, é possível adicionar Design 
Notes a esse documento, informando que seu original está na pasta do outro site. 

Você também pode utilizar as Design Notes para controlar as informações confidenciais que 
não pode colocar em um documento por motivos de segurança, como notas sobre como uma 
configuração ou preço específico foi escolhido, ou quais os fatores de marketing que 
influenciaram uma decisão de projeto. 

Se você abrir um arquivo no Macromedia Fireworks ou no Macromedia Flash e exportá-lo 
para outro formato, esses programas salvarão automaticamente o nome do arquivo de origem 
inicial em um arquivo de Design Notes. Por exemplo, se você abrir o arquivo minha_casa.png 
no Fireworks e exportá-lo para minha_casa.gif, o Fireworks criará um arquivo de Design 
Notes denominado minha_casa.gif.mno com o nome do arquivo original, como uma URL de 
arquivo: absoluto.   Assim, as Design Notes correspondentes ao arquivo minha_casa.gif 
poderão conter a seguinte linha:
fw_source="file:///Mydisk/sites/assets/orig/myhouse.png"

Uma Design Note semelhante do Flash poderia conter a seguinte linha:
fl_source="file:///Mydisk/sites/assets/orig/myhouse.fla"

Quando a imagem for importada para o Dreamweaver, o arquivo de Design Notes será 
automaticamente copiado para o site, juntamente com a imagem. Quando você seleciona 
a imagem no Dreamweaver e decide editá-la no Fireworks (consulte “Iniciar um editor de 
arquivos de mídia externo” na página 521), o Fireworks abre o arquivo original para edição.

Tópicos relacionados
■ “Ativar e desativar as Design Notes de um site” na página 168
■ “Associar Design Notes a arquivos” na página 169

Sobre os arquivos dependentes
Quando você transfere um documento entre uma pasta local e uma remota no painel Files 
(Arquivos), o Dreamweaver oferece a opção de transferir os arquivos dependentes do 
documento. Os arquivos dependentes são imagens, folhas de estilos externas e outros arquivos 
referenciados no seu documento e que o navegador carrega junto com o documento.

N
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Para compartilhar as Design Notes, os usuários deverão definir o mesmo caminho para 
a raiz do site (por exemplo, sites/propriedades/orig).
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O Dreamweaver também trata os itens de biblioteca como arquivos dependentes. Para obter 
mais informações, consulte “Sobre itens de biblioteca” na página 177.

Alguns servidores apresentarão erros na colocação de itens de biblioteca. Entretanto, é possível 
mascarar esses arquivos para impedir que sejam transferidos. Para obter instruções, consulte 
“Mascarar as pastas e os arquivos do site” na página 163. 

Tópicos relacionados
■ “Obter arquivos de um servidor remoto” na página 156
■ “Colocar arquivos em um servidor remoto” na página 157

Acessar sites, um servidor e unidades 
locais
Você pode acessar, modificar e salvar arquivos e pastas de sites do Dreamweaver, bem como 
arquivos e pastas que não fazem parte de um site do Dreamweaver. Além dos sites do 
Dreamweaver, você pode acessar um servidor, uma unidade local ou a área de trabalho. 

Antes de acessar um servidor remoto, configure o Dreamweaver para trabalhar com esse 
servidor (consulte  “Configurar o Dreamweaver para trabalhar sem definir um site” na 
página 120).

Para abrir um site já existente do Dreamweaver:

■ No painel Files (Arquivos), em Window (Janela) > Files, selecione um site no menu pop-
up (em que o site atual, o servidor ou a unidade aparece).

N
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A melhor maneira de gerenciar os arquivos consiste em criar um site do Dreamweaver 
(consulte “Configurar um novo site do Dreamweaver” na página 90). 
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Para obter informações sobre como alterar a visualização do site, por exemplo, para exibir a 
pasta remota, consulte “Exibir arquivos e pastas” na página 122. Para obter informações sobre 
como abrir arquivos no site, consulte “Trabalhar com arquivos no painel Files (Arquivos)” na 
página 134.

Para abrir uma pasta em um servidor FTP ou RDS remoto:

1. No painel Files (Window > Files), selecione um nome de servidor no menu pop-up (em 
que aparece o site, o servidor ou a unidade atual).

2. Navegue para os arquivos e edite-os normalmente.

Para obter mais informações, consulte “Trabalhar com arquivos no painel Files 
(Arquivos)” na página 134.

Para acessar uma unidade local ou a sua área de trabalho:

1. No painel Files (Window > Files), selecione Desktop (Área de trabalho), Local Disk (Disco 
local) ou CD Drive (Unidade de CD) no menu pop-up (em que o site atual, o servidor ou 
a unidade aparece).

N
O

T
A

Nomes de servidores aparecem para os servidores com os quais o Dreamweaver foi 
configurado para trabalhar. Se você ainda não configurou um servidor, consulte 
“Configurar o Dreamweaver para trabalhar sem definir um site” na página 120.
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2. Navegue para um arquivo e siga um destes procedimentos:

■ Abra arquivos no Dreamweaver ou em outro aplicativo
■ Renomeie arquivos
■ Copie arquivos
■ Exclua arquivos
■ Arraste arquivos

Quando você arrastar um arquivo de um site do Dreamweaver para outro ou para uma 
pasta que não esteja associada a um site do Dreamweaver, o Dreamweaver copiará o 
arquivo para o local em que for solto. Se você arrastar um arquivo dentro do mesmo 
site do Dreamweaver, o Dreamweaver moverá o arquivo para o local em que for solto. 
Se arrastar um arquivo que não esteja associado a um site do Dreamweaver para uma 
pasta que não faça parte de um site do Dreamweaver, o Dreamweaver moverá o 
arquivo para o local em que for solto.

Tópicos relacionados
■ “Gerenciar arquivos e pastas no painel Files (Arquivos)” na página 132

Configurar o Dreamweaver para trabalhar sem definir 
um site
O Dreamweaver permite estabelecer uma conexão com um servidor FTP ou RDS para 
trabalhar nos seus documentos sem criar um site do Dreamweaver. 

Para configurar o Dreamweaver para trabalhar com um servidor na janela do 
documento:

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.
2. Clique em New (Novo) e, em seguida, selecione FTP & RDS Servers (Servidores FTP e 

RDS). 

A caixa de diálogo Configure Server (Configurar servidor) é exibida.

N
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Para mover um arquivo que o Dreamweaver copia como padrão, mantenha 
pressionada a tecla Shift enquanto arrasta o arquivo. Para copiar um arquivo que 
o Dreamweaver move como padrão, mantenha pressionada a tecla Control 
enquanto arrasta o arquivo.

N
O

T
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Se você trabalhar em arquivos sem criar um site do Dreamweaver, não poderá executar 
operações no site, como verificação de links. Para configurar um site do Dreamweaver, 
consulte “Configurar um novo site do Dreamweaver” na página 90.
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3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

4. Clique em OK.

O painel Files (Arquivos) exibe o conteúdo da pasta do servidor remoto ao qual você se 
conectou, e o nome do servidor aparece no menu pop-up na parte superior do painel.

Para configurar o Dreamweaver para trabalhar com um servidor utilizando o 
painel Files:

1. No painel Files (Window > Files), selecione Desktop (Área de trabalho) no menu pop-up 
(em que aparece o site, o servidor ou a unidade atual).

2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) no nó FTP and RDS Servers, no painel Files. Em seguida, 
selecione Add FTP Server (Adicionar servidor FTP) ou Add RDS Server (Adicionar 
servidor RDS).
 

A caixa de diálogo Configure Server (Configurar servidor) é exibida.

N
O

T
A

Você só precisará preencher essa caixa de diálogo uma vez para cada servidor ao 
qual deseja se conectar.
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3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

4. Clique em OK.

O painel Files (Arquivos) exibe o conteúdo da pasta do servidor remoto ao qual você se 
conectou, e o nome do servidor aparece no menu pop-up na parte superior do painel.

Tópicos relacionados
■ “Acessar sites, um servidor e unidades locais” na página 118

Exibir arquivos e pastas
Você pode exibir arquivos e pastas no painel Files (Arquivos), estejam eles associados a um site 
do Dreamweaver ou não. Quando você exibir sites, arquivos ou pastas no painel Files, poderá 
alterar o tamanho da área de visualização e, para os sites do Dreamweaver, poderá expandir ou 
reduzir esse painel.

Para sites do Dreamweaver, você pode também personalizar o painel Files alterando a 
visualização — do site local ou remoto — que aparece, por padrão, no painel reduzido. Poderá 
também alternar as visualizações do conteúdo no painel Files expandido usando a opção 
Always Show (Mostrar sempre) (consulte “Definir as preferências do painel Files (Arquivos)” 
na página 133.) 

Para abrir ou fechar o painel Files:

■ Selecione Window (Janela) > Files.

Para alterar o tamanho da área de visualização no painel Files expandido:

■ Em Window > Files, no painel Files expandido, siga um destes procedimentos:
■ Arraste a barra divisória que separa as duas visualizações para aumentar ou diminuir a 

área de exibição do painel direito ou esquerdo.
■ Utilize as barras de rolagem na parte inferior do painel Files para rolar pelo conteúdo 

das visualizações.
■ No mapa do site, arraste a seta acima de um arquivo para alterar o espaço entre os 

arquivos.

N
O

T
A

Você só precisará preencher essa caixa de diálogo uma vez para cada servidor ao 
qual deseja se conectar.

N
O

T
A

No caso de pastas grandes, pode levar alguns minutos para que o painel Files exiba 
a pasta.
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Para expandir ou reduzir o painel Files (somente sites do Dreamweaver):

■ No painel Files (Window > Files), clique no botão Expand/Collapse (Expandir/Reduzir) 
na barra de ferramentas.

Quando o painel Files estiver reduzido, ele exibirá o conteúdo dos sites local e remoto ou do 
servidor de teste como uma lista de arquivos. Quando expandido, ele exibirá o site local, além 
do site remoto ou do servidor de teste. O painel Files também pode exibir um mapa visual do 
site local. 

Para alterar a visualização do site no painel Files, siga um destes 
procedimentos (somente sites do Dreamweaver):

■ No painel Files reduzido (Window > Files), selecione Local View (Visualização local), 
Remote View (Visualização remota), Testing Server (Servidor de teste) ou Map View 
(Visualização do mapa) no menu pop-up Site View (Visualização do site).

■ No painel Files expandido (Window > Files), clique no botão Site Files (Arquivos do site) 
do site remoto, Testing Server ou Site Map (Mapa do site) na barra de ferramentas.

N
O

T
A

Se você clicar no botão Expand/Collapse para expandir o painel enquanto este 
estiver encaixado, ele será maximizado, de modo a impossibilitar o trabalho na janela 
do documento. Para retornar à janela do documento, clique novamente no botão 
Expand/Collapse, para reduzir o painel. Se você clicar no botão Expand/Collapse 
para expandir o painel enquanto ele estiver encaixado, ainda poderá trabalhar na 
janela do documento. É necessário reduzir o painel antes de encaixá-lo novamente.

N
O

T
A

Como padrão, Local View aparecerá nesse menu pop-up.

Site Files (Arquivos do site)

Testing Server (Servidor de teste)

Site Map (Mapa do site)
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Ao clicar no botão Site Map, você poderá optar pela visualização do mapa do site com ou 
sem os respectivos arquivos. Para obter mais informações, consulte “Exibir um mapa de 
site” na página 138.

Tópicos relacionados
■ “Acessar sites, um servidor e unidades locais” na página 118
■ “Gerenciar arquivos e pastas no painel Files (Arquivos)” na página 132

Personalizar detalhes de arquivos e pastas exibidos 
no painel Files (Arquivos) expandido
Quando você visualiza um site do Dreamweaver no painel Files expandido (consulte “Exibir 
arquivos e pastas” na página 122), o Dreamweaver exibe informações sobre os arquivos e as 
pastas em colunas. Por exemplo, você pode ver o tipo de arquivo ou a data em que um arquivo 
foi modificado.

Pode personalizar as colunas seguindo qualquer destes procedimentos (algumas operações 
estão disponíveis apenas para as colunas adicionadas, e não as colunas padrão):

■ Reordenar ou realinhar colunas 
■ Adicionar novas colunas (dez, no máximo)
■ Ocultar colunas (exceto a coluna do nome do arquivo)
■ Designar colunas a serem compartilhadas com todos os usuários que estiverem conectados 

a um site
■ Excluir colunas (somente colunas personalizadas)
■ Renomear colunas (somente colunas personalizadas)
■ Associar com uma Design Note (somente colunas personalizadas)

Para ordenar por qualquer coluna de detalhes do painel Files (Arquivos):

■ Clique no cabeçalho da coluna a ser ordenada.

N
O

T
A

Para poder exibir um site remoto ou um servidor de teste, é necessário configurá-lo 
(consulte “Configurar uma pasta remota” na página 94 ou “Especificar onde as 
páginas dinâmicas podem ser processadas” na página 667). Para poder exibir o 
mapa de um site, é necessário configurar uma home page (consulte “Exibir um mapa 
de site” na página 138).

D
IC

A

Clique no cabeçalho novamente para inverter a ordem (ascendente ou descendente) 
de acordo com a qual o Dreamweaver ordenará a coluna.
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Para adicionar, excluir ou alterar as colunas de detalhes:

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.
2. Selecione um site e, em seguida, clique em Edit (Editar). 

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Selecione File View Columns (Colunas de visualização de arquivos) na lista de categorias à 

esquerda.

A caixa de diálogo Site Definition exibirá as opções das colunas de visualização de 
arquivos.

4. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
5. Clique em OK.
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Comparar arquivos para conhecer as 
diferenças
O Dreamweaver pode trabalhar com ferramentas de comparação de arquivos (também 
conhecidas como “ferramentas diff ”) para comparar o código de versões locais e remotas do 
mesmo arquivo, dois arquivos remotos diferentes ou dois arquivos locais diferentes. A 
comparação de versões locais e remotas é útil quando você está trabalhando em um arquivo 
localmente e suspeita que a cópia desse arquivo no servidor foi modificada por outra pessoa. 
Sem sair do Dreamweaver, você pode visualizar e mesclar as alterações remotas na sua versão 
local antes de colocar o arquivo no servidor. 

A comparação de dois arquivos locais ou dois arquivos remotos também é útil quando você 
mantém versões anteriores renomeadas dos seus arquivos. Caso você tenha se esquecido das 
alterações feitas em um arquivo de uma versão anterior, uma comparação rápida fará com que 
você se lembre.

Antes de começar, é preciso instalar no sistema uma ferramenta de comparação de arquivos de 
terceiros. Para obter mais informações sobre ferramentas de comparação de arquivos, consulte 
o site da Macromedia na Web em www.macromedia.com/go/dw8_compare_util. Você 
também deve especificar a ferramenta no Dreamweaver após sua instalação, conforme descrito 
mais adiante nesta seção.

Esta seção contém os tópicos a seguir:

■ “Comparar antes de colocar arquivos” na página 129
■ “Comparar durante a sincronização de arquivos” na página 130
■ “Especificar uma ferramenta de comparação no Dreamweaver” na página 130

Comparar dois arquivos
Após instalar uma ferramenta de comparação de arquivos no sistema e especificá-la no 
Dreamweaver, você poderá executar qualquer uma das seguintes tarefas no Dreamweaver:

■ “Comparar dois arquivos locais” na página 127 
■ “Comparar dois arquivos remotos” na página 127 
■ “Comparar um arquivo local com um arquivo remoto” na página 128
■ “Comparar um arquivo remoto com um arquivo local” na página 128
■ “Comparar um arquivo aberto com um arquivo remoto” na página 129
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Tópicos relacionados
■ “Comparar antes de colocar arquivos” na página 129
■ “Comparar durante a sincronização de arquivos” na página 130

Comparar dois arquivos locais
Você pode comparar dois arquivos localizados em qualquer parte do seu computador.

Para comparar dois arquivos locais:

1. No painel Files (Arquivos), pressione a tecla Control (no Windows) ou a tecla Command 
(no Macintosh) e clique nos dois arquivos para selecioná-los.

2. Clique com o botão direito do mouse nos arquivos selecionados e selecione Compare Local 
Files (Comparar arquivos locais) no menu contextual.

A ferramenta de comparação de arquivos é iniciada, e a comparação dos dois arquivos 
começa.

Comparar dois arquivos remotos
Você pode comparar dois arquivos localizados no servidor remoto. É preciso definir um site 
do Dreamweaver com definições remotas antes de realizar essa tarefa. Para obter mais 
informações, consulte “Configurar um novo site do Dreamweaver” na página 90.

Para comparar dois arquivos remotos:

1. No painel Files (Arquivos), exiba os arquivos do servidor remoto selecionando Remote 
View (Visualização remota) no menu pop-up à direita.

2. Pressione a tecla Control (no Windows) ou a tecla Command (no Macintosh) e clique nos 
dois arquivos para selecioná-los.

D
IC

A

Para selecionar arquivos fora do site definido, selecione seu disco local no menu 
pop-up localizado à esquerda no painel Files e selecione-os.

N
O

T
A

Caso o seu mouse só tenha um botão, pressione a tecla Control e clique em um dos 
arquivos selecionados. 
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3. Clique com o botão direito do mouse em um dos arquivos selecionados e selecione 
Compare Remote Files (Comparar arquivos remotos) no menu contextual.

A ferramenta de comparação de arquivos é iniciada, e a comparação dos dois arquivos 
começa.

Comparar um arquivo local com um arquivo remoto
Você pode comparar um arquivo local com um arquivo localizado no servidor remoto. Para 
fazer isto, é necessário primeiro definir um site do Dreamweaver com definições remotas. Para 
obter mais informações, consulte “Configurar um novo site do Dreamweaver” na página 90.

Para comparar um arquivo local com um arquivo remoto:

■ No painel Files (Arquivos), clique com o botão direito do mouse em um arquivo local e 
selecione Compare with Remote (Comparar com remoto) no menu contextual.

A ferramenta de comparação de arquivos é iniciada, e a comparação dos dois arquivos 
começa.

Comparar um arquivo remoto com um arquivo local
É possível comparar um arquivo remoto com um arquivo local. É preciso definir um site do 
Dreamweaver com definições remotas antes de realizar essa tarefa. Para obter mais 
informações, consulte “Configurar um novo site do Dreamweaver” na página 90.

Para comparar um arquivo remoto com um arquivo local:

1. No painel Files (Arquivos), exiba os arquivos do servidor remoto selecionando Remote 
View (Visualização remota) no menu pop-up à direita.

■ Clique com o botão direito do mouse em um arquivo do painel e selecione Compare with 
Local (Comparar com local) no menu contextual.

N
O

T
A

Caso o seu mouse só tenha um botão, pressione a tecla Control e clique em um dos 
arquivos selecionados.

N
O

T
A

Caso o seu mouse só tenha um botão, pressione a tecla Control e clique no arquivo 
local.

N
O

T
A

Caso o seu mouse só tenha um botão, pressione a tecla Control e clique no arquivo.
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Comparar um arquivo aberto com um arquivo remoto
É possível comparar um arquivo aberto no Dreamweaver com seu correspondente no servidor 
remoto.

Para comparar um arquivo aberto no Dreamweaver com sua cópia remota:

■ Na janela Document (Documento), selecione File (Arquivo) > Compare with Remote. 
A ferramenta de comparação de arquivos é iniciada, e a comparação dos dois arquivos 
começa.

Comparar antes de colocar arquivos
Se você editar um arquivo localmente e depois tentar carregá-lo para o servidor remoto, o 
Dreamweaver enviará uma notificação se a versão remota do arquivo tiver sido alterada. O 
Dreamweaver permite que você compare os dois arquivos antes de carregar o arquivo e 
sobrescrever a versão remota. 

Antes de começar, é preciso instalar no sistema uma ferramenta de comparação de arquivos e 
especificá-la no Dreamweaver. Para obter mais informações, consulte “Especificar uma 
ferramenta de comparação no Dreamweaver” na página 130.

Para comparar arquivos ao colocar um arquivo:

1. Após editar um arquivo em um site do Dreamweaver, coloque-o (Site > Put (Colocar)) no 
site remoto. 

Se a versão remota do arquivo tiver sido modificada, o Dreamweaver enviará uma 
notificação e permitirá que você veja as diferenças.

2. Para visualizar as diferenças, clique no botão Compare (Comparar).

A ferramenta de comparação de arquivos é iniciada, e a comparação dos dois arquivos 
começa.
Se você não especificou nenhuma ferramenta de comparação de arquivos, o Dreamweaver 
solicitará que você especifique uma.

3. Após analisar ou mesclar as alterações na ferramenta, você poderá prosseguir com a 
operação Put (Colocar) ou cancelá-la.

Tópicos relacionados
■ “Comparar dois arquivos” na página 126

D
IC

A

Também é possível clicar com o botão direito do mouse na guia do documento, na 
parte superior da janela Document (Documento), e selecionar Compare with 
Remote no menu contextual.
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Comparar durante a sincronização de arquivos
É possível comparar as versões locais dos arquivos com as versões remotas ao sincronizar os 
arquivos do site com o Dreamweaver.

Antes de começar, é preciso instalar no sistema uma ferramenta de comparação de arquivos e 
especificá-la no Dreamweaver. Para obter mais informações, consulte “Especificar uma 
ferramenta de comparação no Dreamweaver” na página 130.

Para comparar arquivos durante uma sincronização:

1. Clique com o botão direito do mouse em qualquer parte do painel Files (Arquivos) e 
selecione Synchronize (Sincronizar) no menu contextual. 

A caixa de diálogo Synchronize Files (Sincronizar os arquivos) é exibida.
2. Preencha a caixa de diálogo Synchronize Files (Sincronizar os arquivos) e clique em Preview 

(Visualizar). 

Para obter mais informações, consulte “Sincronizar os arquivos nos sites local e remoto” na 
página 161.
Depois que você clicar em Preview, o Dreamweaver listará os arquivos selecionados e as 
ações que executará durante a sincronização. 

3. Na lista, selecione cada arquivo que você deseja comparar e clique no botão Compare (o 
ícone com duas pequenas páginas).

O Dreamweaver inicia a ferramenta de comparação, que compara a versão local com a 
versão remota de cada arquivo selecionado.

Tópicos relacionados
■ “Comparar dois arquivos” na página 126
■ “Comparar antes de colocar arquivos” na página 129

Especificar uma ferramenta de comparação no 
Dreamweaver
É preciso instalar no sistema uma ferramenta de comparação de arquivos de terceiros para 
comparar arquivos no Dreamweaver. Para obter mais informações sobre ferramentas de 
comparação de arquivos, consulte o site da Macromedia na Web em www.macromedia.com/
go/dw8_compare_util. 

N
O

T
A

O arquivo deve ser baseado em texto, como os arquivos HTML ou ColdFusion.
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Após a instalação de uma ferramenta de comparação de arquivos, é preciso especificá-la no 
Dreamweaver, conforme descrito nesta seção.

Para especificar uma ferramenta de comparação de arquivos:

1. Instale a ferramenta de comparação de arquivos no mesmo sistema do Dreamweaver. 

2. No Dreamweaver, abra a caixa de diálogo Preferences (Preferências) selecionando Edit 
(Editar) > Preferences (no Windows) ou Dreamweaver > Preferences (no Macintosh), e 
depois selecione a categoria File Compare (Comparação de arquivos).

3. No Windows, clique no botão Browse (Procurar) e selecione o aplicativo que compara 
arquivos.

4. No Macintosh, clique no botão Browse e selecione a ferramenta ou script que inicia a 
ferramenta de comparação de arquivos na linha de comando, e não na ferramenta de 
comparação de arquivos propriamente dita.

No Macintosh, as ferramentas ou scripts de iniciação geralmente estão localizados na pasta 
usr/bin. Por exemplo, se você desejar utilizar o FileMerge, procure usr/bin e selecione 
opendiff, que é a ferramenta que inicia o FileMerge.
A tabela a seguir lista ferramentas comuns de comparação de arquivos para Macintosh e a 
localização de suas respectivas ferramentas ou scripts de iniciação no disco rígido:

Tópicos relacionados
■ “Comparar dois arquivos” na página 126
■ “Comparar antes de colocar arquivos” na página 129
■ “Comparar durante a sincronização de arquivos” na página 130

Se você usar Selecione o seguinte arquivo

FileMerge usr/bin/opendiff

BBEdit usr/bin/bbdiff

TextWrangler usr/bin/twdiff

N
O

T
A

Geralmente, a pasta usr fica oculta no Finder. No entanto, você pode acessá-la com 
o botão Browse no Dreamweaver.
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Reverter arquivos (usuários do 
Contribute)
O Dreamweaver salva automaticamente várias versões de um documento quando você ativa a 
compatibilidade do Contribute. Para ativar a compatibilidade do Contribute, consulte 
“Preparar um site para utilizar com o Contribute” na página 207.

A reversão de arquivos deve estar ativada nas definições administrativas do Contribute. Para 
obter mais informações, consulte Administering Contribute.

Para reverter um arquivo para uma versão anterior:

1. No Windows, clique com o botão direito do mouse ou, no Macintosh, pressione Control 
e clique em um arquivo no painel Files (Arquivos).

2. Selecione Roll Back Page (Reverter página).

Se houver alguma versão anterior da página para reverter, a caixa de diálogo Rollback 
(Reverter) será exibida.

3. Selecione a versão da página para a qual você deseja reverter e clique em Roll Back 
(Reverter).

Tópicos relacionados
■ “Excluir, mover ou renomear um arquivo remoto em um site do Contribute” na 

página 211

Gerenciar arquivos e pastas no painel 
Files (Arquivos)
Você pode organizar e gerenciar os arquivos de um site estejam eles associados a um site do 
Dreamweaver ou localizados em um servidor ao qual você está conectado, na unidade local ou 
na área de trabalho.

N
O

T
A

O Contribute e o Dreamweaver devem estar instalados na mesma máquina.

N
O

T
A

Na versão anterior do Dreamweaver, o painel Files era chamado painel Site.
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Tópicos relacionados
■ “Acessar sites, um servidor e unidades locais” na página 118
■ “Exibir arquivos e pastas” na página 122

Definir as preferências do painel Files (Arquivos)
Selecione as preferências para controlar os recursos de transferência de arquivos no painel 
Files.

Para editar as preferências do painel Files (Arquivos):

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.
2. Selecione Site, na lista de categorias à esquerda.

Aparecerão as opções de preferência do site.

3. Altere as opções conforme a necessidade.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
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4. Clique em OK.

Trabalhar com arquivos no painel Files (Arquivos)
Você pode abrir, renomear, adicionar, mover ou excluir arquivos ou atualizar o painel Files 
depois de fazer alterações.

Para os sites do Dreamweaver, você também pode determinar quais arquivos (do site local ou 
remoto) foram atualizados desde a última vez em que foram transferidos. Para obter mais 
informações sobre a sincronização do site local com o remoto, consulte “Sincronizar os 
arquivos nos sites local e remoto” na página 161.

Para abrir um arquivo:

1. No painel Files (Arquivos), em Window (Janela) > Files, selecione um site, um servidor ou 
uma unidade no menu pop-up (em que o site atual, o servidor ou a unidade aparece).

2. Navegue até o arquivo a ser aberto.

3. Siga um dos procedimentos abaixo:

■ Clique duas vezes no ícone do arquivo.
■ No Windows, clique com o botão direito do mouse ou, no Macintosh, pressione 

Control e clique no ícone do arquivo. Em seguida, selecione Open (Abrir).

O Dreamweaver abre o arquivo na janela do documento.

Para criar um novo arquivo ou uma nova pasta:

1. No painel Files (Window > Files), selecione um arquivo ou uma pasta.

O Dreamweaver criará o novo arquivo ou pasta dentro da pasta que estiver selecionada, ou 
na pasta do arquivo selecionado no momento.

2. No Windows, clique com o botão direito do mouse ou, no Macintosh, pressione Control 
e, em seguida, selecione New File (Novo arquivo) ou New Folder (Nova pasta).

3. Digite um nome para o novo arquivo ou pasta.

4. Pressione a tecla Enter (no Windows) ou Return (no Macintosh).

D
IC

A

Para definir se os tipos de arquivo serão transferidos no formato ASCII (texto) ou 
binário, personalize o arquivo FTPExtensionMap.txt na pasta Dreamweaver/
Configuration (no Macintosh, FTPExtensionMapMac.txt). Para obter mais 
informações, consulte Extending Dreamweaver.
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Para excluir um arquivo ou uma pasta:

1. No painel Files (Window > Files), selecione a pasta ou o arquivo a ser excluído.

2. No Windows, clique com o botão direito do mouse ou, no Macintosh, pressione Control 
e, em seguida, selecione Delete (Excluir).

Para renomear um arquivo ou uma pasta:

1. No painel Files (Window > Files), selecione a pasta ou o arquivo a ser renomeado.

2. Siga um dos procedimentos abaixo, para ativar o nome do arquivo ou da pasta:

■ Clique no nome do arquivo, faça uma pausa e, em seguida, clique novamente.
■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 

pressionada (no Macintosh) no ícone do arquivo e, em seguida, selecione Rename 
(Renomear).

3. Digite o novo nome sobre o nome existente.

4. Pressione a tecla Enter (no Windows) ou Return (no Macintosh).

Para mover um arquivo ou uma pasta:

1. No painel Files (Window > Files) selecione a pasta ou o arquivo a ser movido.

2. Siga um dos procedimentos abaixo:

■ Copie o arquivo ou a pasta e cole em um novo local.
■ Arraste o arquivo ou a pasta para um novo local.

3. Atualize o painel Files para ver o arquivo ou a pasta em seu novo local.

Para atualizar o painel Files, siga um destes procedimentos:

■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) em qualquer arquivo ou pasta e, em seguida, selecione 
Refresh (Atualizar).

■ (Apenas para os sites do Dreamweaver) Clique no botão Refresh na barra de ferramentas 
do painel Files. Essa opção atualiza os dois painéis.

Tópicos relacionados
■ “Exibir arquivos e pastas” na página 122
■ “Acessar sites, um servidor e unidades locais” na página 118
■ “Definir as preferências do painel Files (Arquivos)” na página 133

N
O

T
A

O Dreamweaver atualiza automaticamente o painel Files quando você faz alterações 
em outro aplicativo e retorna ao Dreamweaver.
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Localizar arquivos no site do Dreamweaver 
O Dreamweaver  facilita a localização de arquivos selecionados, abertos, retirados ou 
modificados recentemente em um site. Você também pode localizar arquivos mais recentes no 
site local ou remoto.

Para localizar um arquivo aberto no site:

1. Abra o arquivo na janela do documento.

2. Selecione Site > Locate in Site (Localizar no site). 

O Dreamweaver seleciona o arquivo no painel Files.

Para localizar e selecionar arquivos retirados em um site do Dreamweaver:

■ No painel Files reduzido, em Window (Janela) > Files, clique no menu Options (Opções) 
no canto superior direito desse painel e, em seguida, selecione Edit (Editar) > Select 
Checked Out Files (Selecionar os arquivos retirados).

O Dreamweaver seleciona os arquivos no painel Files.

Para localizar um arquivo selecionado no site local ou remoto:

1. Selecione o arquivo na visualização local ou remota do painel Files (Window > Files).

2. No Windows, clique com o botão direito do mouse ou, no Macintosh, pressione Control 
e, em seguida, selecione Locate in Local Site (Localizar no site local) ou Locate in Remote 
Site (Localizar no site remoto), dependendo do local em que você selecionou o arquivo.

O Dreamweaver seleciona o arquivo no painel Files.

Para localizar e selecionar arquivos que sejam mais recentes no site local do 
que no remoto:

■ No painel Files reduzido (Window > Files), clique no menu Options no canto superior 
direito desse painel e selecione Edit > Select Newer Local (Selecionar um local mais novo).

O Dreamweaver seleciona os arquivos no painel Files.

N
O

T
A

Se o arquivo aberto na janela do documento não estiver associado ao site atual no painel 
Files, o Dreamweaver tentará determinar a qual dos seus sites do Dreamweaver esse 
arquivo pertence. Se o arquivo atual pertencer apenas a um site local, o Dreamweaver 
abrirá esse site no painel Files e o realçará.
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Para localizar e selecionar os arquivos que forem mais recentes no site remoto 
do que no local:

■ No painel Files reduzido (Window > Files), clique no menu Options no canto superior 
direito desse painel e selecione Edit > Select Newer Remote (Selecionar um remoto mais 
novo).

O Dreamweaver seleciona os arquivos no painel Files.

Para localizar arquivos modificados recentemente no site:

1. No painel Files reduzido (Window > Files), clique no menu Options no canto superior 
direito desse painel e selecione Edit > Select Recently Modified (Selecionar modificados 
recentemente).

A caixa de diálogo Select Recently Modified é exibida.
2. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK para salvar as definições.

O Dreamweaver realça os arquivos modificados no intervalo de tempo selecionado no 
painel Files.

Tópicos relacionados
■ “Acessar sites, um servidor e unidades locais” na página 118
■ “Exibir arquivos e pastas” na página 122
■ “Trabalhar com arquivos no painel Files (Arquivos)” na página 134

Trabalhar com um mapa visual do site
Você pode exibir uma pasta local de um site do Dreamweaver como um mapa visual de ícones 
vinculados, denominado mapa do site. Utilize o mapa do site para adicionar novos arquivos a 
um site do Dreamweaver, ou para adicionar, modificar ou remover links. 

O mapa do site mostra a estrutura do site em dois níveis a partir da home page. Ele mostra as 
páginas como ícones e exibe os links na ordem em que são encontrados no código-fonte. 
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A visualização do mapa do site é ideal para criar o layout da estrutura do site. Você pode 
configurar rapidamente a estrutura inteira do site e, em seguida, criar uma imagem gráfica do 
mapa do site.

Tópicos relacionados
■ “Criar links para documentos usando o mapa do site” na página 471

Exibir um mapa de site
É necessário definir uma home page correspondente ao site antes de exibir o mapa do mesmo. 
A home page pode ser qualquer página do site. Não precisa ser a página principal. Nesse caso, 
a home page é apenas o ponto de partida do mapa. 

Para definir a home page do site: 

1. No painel Files (Arquivos), em Window (Janela) > Files, selecione um site no menu pop-
up (em que o site atual, o servidor ou a unidade aparece).

2. No Windows, clique com o botão direito do mouse ou, no Macintosh, pressione Control 
e clique no arquivo a ser designado como a home page. Em seguida, selecione Set as Home 
Page (Definir como home page).

Para exibir o mapa de um site: 

1. Para exibir o mapa do site, no painel Files (Window > Files), siga um destes procedimentos:

■ No painel Files reduzido, selecione Map View (Visualização do mapa) no menu pop-
up Site View (Visualização do site).

N
O

T
A

O mapa do site se aplica apenas aos sites locais. Para criar o mapa de um site remoto, 
copie o conteúdo desse site para uma pasta na unidade local e utilize o comando 
Manage Sites (Gerenciar sites) para definir o site como local (consulte “Configurar uma 
pasta local” na página 92).

N
O

T
A

Você também pode definir a home page nas opções de Site Map Layout (Layout do 
mapa do site) na caixa de diálogo Site Definition (Definição do site) (consulte 
“Modificar o layout do mapa do site” na página 140).
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■ No painel Files expandido, clique no botão Site Map (Mapa do site) na barra de 
ferramentas e, em seguida, selecione Map Only (Apenas o mapa) ou Map and Files 
(Mapa e arquivos).

Selecione Map Only, para exibir o mapa do site sem a estrutura de arquivos locais, ou 
Site and Map (Site e mapa), para exibir o mapa do site com a estrutura de arquivos 
locais.

O painel Files exibe um mapa do site que mostra os dois níveis da estrutura do site.

2. Clique no sinal de adição (+) ou subtração (–) ao lado do nome de um arquivo para mostrar 
ou ocultar as páginas vinculadas abaixo do segundo nível. 

3. Observe as cores do mapa do site:

■ O texto em vermelho indica um link rompido.
■ O texto em azul e marcado com um ícone representando um globo indica um arquivo 

em um outro site ou um link especial (como um link de correio eletrônico ou de 
script).

■ Uma marca de seleção verde indica um arquivo retirado por você.
■ Uma marca de seleção vermelha indica um arquivo retirado por outro usuário.

N
O

T
A

Se você não tiver definido uma home page, ou se o Dreamweaver não conseguir 
localizar uma página index.html ou index.htm no site atual para utilizar como 
home page, o Dreamweaver solicitará a seleção de uma home page.

N
O

T
A

Como padrão, o mapa do site não exibe arquivos ocultos ou dependentes. Para 
obter mais informações, consulte “Mostrar e ocultar os arquivos do mapa do site” na 
página 144.
Trabalhar com um mapa visual do site 139



         
■ Um ícone com um cadeado indica um arquivo somente leitura.

Tópicos relacionados
■ “Trabalhar com as páginas no mapa do site” na página 141
■ “Mostrar e ocultar os arquivos do mapa do site” na página 144
■ “Exibir o site a partir de uma ramificação” na página 145

Modificar o layout do mapa do site
Utilize as opções de Site Map Layout (Layout do mapa do site) para personalizar a aparência 
do mapa do site. Você poderá alterar a home page e o número de colunas exibidas, bem como 
definir se os identificadores de ícones exibirão o nome do arquivo ou o título da página, e se os 
arquivos ocultos e dependentes serão mostrados.

Para modificar o layout do mapa do site:

1. Siga um dos procedimentos abaixo, para abrir a caixa de diálogo Site Definition (Definição 
do site):

■ Selecione Site > Manage Sites (Gerenciar Sites).
■ No painel Files (Arquivos), selecione Manage Sites no menu pop-up em que o site 

atual, o servidor ou a unidade aparece.
A caixa de diálogo Manage Sites é exibida.

2. Clique em Edit (Editar). 

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Na lista de categorias à esquerda, selecione Site Map Layout.
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A caixa de diálogo Site Definition exibe as opções de Site Map Layout.

4. Faça as alterações necessárias.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
5. Clique em OK para fechar a caixa de diálogo Site Definition.

6. Clique em Done (Concluído) para fechar a caixa de diálogo Manage Sites, se ela estiver 
aberta.

Tópicos relacionados
■ “Exibir um mapa de site” na página 138
■ “Mostrar e ocultar os arquivos do mapa do site” na página 144
■ “Salvar o mapa do site” na página 146

Trabalhar com as páginas no mapa do site
Durante o trabalho no mapa do site, é possível selecionar páginas, abrir uma página para 
edição, adicionar novas páginas ao site, criar links entre arquivos e alterar os títulos das 
páginas. 
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Para selecionar várias páginas no mapa do site, siga um dos procedimentos 
abaixo:

■ Pressione a tecla Shift e clique, para selecionar uma faixa de páginas adjacentes. 
■ Inicie em uma parte em branco da visualização e arraste um grupo de arquivos 

para selecioná-los. 
■ Pressione a tecla Control e dê um clique, para selecionar páginas não-contíguas.

Para abrir uma página do mapa do site para edição, siga um dos 
procedimentos abaixo:

■ Clique duas vezes no arquivo.
■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 

pressionada (no Macintosh) no arquivo e, em seguida, selecione Open (Abrir). 

Para adicionar um arquivo já existente ao site, siga um dos procedimentos 
abaixo:

■ Arraste um arquivo do Windows Explorer ou do Macintosh Finder e solte-o em um 
arquivo do mapa do site. A página será adicionada ao site e um link será criado entre ela e 
o arquivo no qual for solta. 

■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) no arquivo no mapa do site, selecione Link to Existing File 
(Link a um arquivo existente) e procure o arquivo. 

Para criar um novo arquivo e adicionar um link no mapa do site:

1. Selecione um arquivo no mapa do site. 

2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) e, em seguida, selecione Link to New File (Link a um novo 
arquivo).

A caixa de diálogo Link to New File é exibida.

3. Digite um nome, título e o texto do link.

4. Clique em OK. 

O Dreamweaver salvará o arquivo na mesma pasta que o arquivo selecionado. Se for 
adicionado um novo arquivo a uma ramificação oculta, o novo arquivo também estará 
oculto (consulte “Mostrar e ocultar os arquivos do mapa do site” na página 144).
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Para modificar o título de uma página no mapa do site:

1. Certifique-se de que os títulos das páginas estejam sendo exibidos clicando no menu 
Options (Opções), no canto superior direito do painel Files (Arquivos) reduzido e, em 
seguida, selecionando File (Arquivo) > Rename View (Renomear visualização) > Show Page 
Titles (Mostrar títulos das páginas).

2. No mapa do site, selecione um arquivo e siga um dos seguintes procedimentos:

■ Clique no título. Quando ele se tornar editável, digite um novo título.
■ No canto superior direito, clique no menu Options e, em seguida, selecione File > 

Rename (Renomear).
3. Depois de digitar o novo nome, pressione Enter.

Para alterar a home page no mapa do site, siga um dos procedimentos abaixo:

■ Na visualização local do painel Files, selecione um arquivo; clique com o botão direito do 
mouse (no Windows) ou mantenha a tecla Control (no Macintosh) pressionada e 
selecione Set as Home Page (Definir como home page).

■ No painel Files, selecione Manage Sites (Gerenciar sites) no menu pop-up em que o site 
atual, o servidor ou a unidade aparece. Em seguida, clique em Edit (Editar). Selecione Site 
Map Layout (Layout do mapa do site) na lista de categorias da caixa de diálogo Site 
Definition (Definição do site). Procure uma nova home page e, em seguida, clique em 
OK.

Para atualizar a visualização do mapa do site depois de ter concluído as 
alterações:

1. Clique em qualquer ponto do mapa do site, para cancelar a seleção dos arquivos.

2. Clique no botão Refresh (Atualizar) na barra de ferramentas do painel Files.

Tópicos relacionados
■ “Exibir um mapa de site” na página 138
■ “Modificar o layout do mapa do site” na página 140
■ “Salvar o mapa do site” na página 146

N
O

T
A

Quando você trabalha no painel Files, o Dreamweaver atualiza automaticamente 
todos os links para os arquivos cujos nomes foram alterados.
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Mostrar e ocultar os arquivos do mapa do site
É possível modificar o layout do mapa do site, para mostrar ou não os arquivos ocultos e 
dependentes. Esse procedimento é útil para enfatizar tópicos ou conteúdo importante e retirar 
a ênfase de materiais menos relevantes.

Para ocultar um arquivo utilizando o mapa do site, é necessário marcar o arquivo como 
oculto. Quando um arquivo for ocultado, os links a ele também se tornarão ocultos. Quando 
um arquivo marcado como oculto for exibido, o ícone e os links a ele estarão visíveis no mapa 
do site, porém os nomes aparecerão em itálico.

Para marcar os arquivos como ocultos no mapa do site:

1. No mapa do site, selecione um ou mais arquivos.

2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) e, em seguida, selecione Show/Hide Link (Mostrar/ocultar o 
link).

Para desmarcar os arquivos marcados como ocultos no mapa do site:

1. No mapa do site, selecione um ou mais arquivos.

2. Siga um dos procedimentos abaixo:

■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) no mapa do site e, em seguida, selecione Show/Hide Link 
(Mostrar/ocultar o link).

■ No painel Files (Arquivos) reduzido, em Window (Janela) > Files, clique no menu 
Options (Opções) no canto superior direito e selecione View (Exibir) > Show Files 
Marked as Hidden (Mostrar os arquivos marcados como ocultos).

■ No painel Files reduzido, em Window > Files, clique no menu Options no canto 
superior direito e selecione View > Show/Hide Link.

Para mostrar ou ocultar arquivos marcados como ocultos no mapa do site:

1. No painel Files reduzido (Window > Files), clique no menu Options no canto superior 
direito.

N
O

T
A

Como padrão, os arquivos dependentes já estão ocultos.
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2. Siga um dos procedimentos abaixo:

■ Selecione View > Show Files Marked as Hidden.
■ Selecione View > Layout para abrir a caixa de diálogo Site Definition (Definição do 

site) e marque a opção Display Files Marked as Hidden (Exibir os arquivos marcados 
como ocultos).

Para mostrar arquivos dependentes no mapa do site:

1. No painel Files reduzido (Window > Files), clique no menu Options no canto superior 
direito.

2. Siga um dos procedimentos abaixo:

■ Selecione View (Exibir) > Show Dependent Files (Mostrar os arquivos dependentes).
■ Selecione View > Layout para abrir a caixa de diálogo Site Definition e, em seguida, 

selecione a opção Display Dependent Files (Exibir os arquivos dependentes).

Tópicos relacionados
■ “Exibir um mapa de site” na página 138
■ “Modificar o layout do mapa do site” na página 140
■ “Trabalhar com as páginas no mapa do site” na página 141
■ “Salvar o mapa do site” na página 146

Exibir o site a partir de uma ramificação
É possível exibir os detalhes de uma determinada seção de um site, tomando como ponto de 
referência uma das ramificações do mapa do site.

Para exibir uma outra ramificação no mapa do site:

1. Selecione a página a ser exibida.

2. Siga um dos procedimentos abaixo:

■ No Windows, clique com o botão direito do mouse ou, no Macintosh, pressione 
Control e clique no mapa do site. Em seguida, selecione View as Root (Exibir como 
raiz).

■ No painel Files (Arquivos) reduzido, em Window (Janela) > Files, clique no menu 
Options (Opções) no canto superior direito e selecione View (Exibir) > View as Root.
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O mapa do site será redesenhado na janela como se a página especificada estivesse na raiz do 
site. A caixa de texto Site Navigation (Navegação no site), situada acima do mapa do site, 
exibe o caminho da home page até a página especificada. Selecione qualquer item nesse 
caminho para exibir o mapa do site a partir desse nível, clicando uma vez.

Para expandir ou contrair as ramificações do mapa do site:

■ Clique no sinal de adição (+) ou subtração (–) de uma ramificação.

Tópicos relacionados
■ “Exibir um mapa de site” na página 138
■ “Modificar o layout do mapa do site” na página 140
■ “Trabalhar com as páginas no mapa do site” na página 141

Salvar o mapa do site 
Você pode salvar o mapa do site como uma imagem e, em seguida, exibi-la (ou imprimi-la) em 
um editor de imagens.

Para criar um arquivo de imagem do mapa do site atual:

1. No painel Files (Arquivos) reduzido, em Window (Janela) > Files, clique no menu Options 
(Opções) no canto superior direito e selecione File (Arquivo) > Save Site Map (Salvar o 
mapa do site).

A caixa de diálogo Save Site Map é exibida.
2. Digite um nome na caixa de texto File Name (Nome do arquivo). 

3. No menu pop-up File Type, selecione .bmp ou .png. 

4. Selecione o local onde deseja salvar o arquivo e digite o nome da imagem.

5. Clique em Save (Salvar).

Tópicos relacionados
■ “Exibir um mapa de site” na página 138
■ “Modificar o layout do mapa do site” na página 140
■ “Trabalhar com as páginas no mapa do site” na página 141
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Importar e exportar sites
Você pode exportar um site como um arquivo XML que contém as definições do site e mais 
tarde importar o site para o Dreamweaver. Esse recurso permite transferir sites de um 
computador para outro e entre diferentes versões do produto, ou compartilhá-los com 
outros usuários.

Para exportar seus sites:

1. Selecione Site > Manage Sites.

A caixa de diálogo Manage Sites é exibida.
2. Selecione um ou mais sites a serem exportados e depois clique no botão Export (Exportar).

Para selecionar mais de um site, clique em cada site pressionando simultaneamente a tecla 
Control (no Windows) ou Command (no Macintosh). Para selecionar uma faixa de sites, 
clique no primeiro e no último sites da lista, mantendo pressionada a tecla Shift.

3. Para cada site que você desejar exportar, procure a localização onde deseja salvá-lo e clique 
em Save (Salvar).

Caso deseje exportar um site que especifique um nome de usuário e senha para um 
servidor remoto, o Dreamweaver perguntará se você deseja fazer uma cópia de segurança 
das suas definições ou se deseja compartilhar as definições com outros usuários. Se você 
desejar compartilhar suas definições com outros usuários, selecione a segunda opção e 
clique em OK. O Dreamweaver não salvará as informações que não serviriam para outros 
usuários, como suas informações de login no servidor remoto e caminhos locais.
O Dreamweaver salvará cada site como um arquivo XML com a extensão .ste no 
local especificado.

4. Clique em Done (Concluído) para fechar a caixa de diálogo Manage Sites.

Para importar sites:

1. Selecione Site > Manage Sites.

A caixa de diálogo Manage Sites é exibida.
2. Clique no botão Import (Importar).

A caixa de diálogo Import Site (Importar o site) é exibida.

D
IC

A

É aconselhável exportar os sites regularmente para manter uma cópia de backup de 
tudo o que acontece no site.
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3. Procure e selecione um ou mais sites (definidos nos arquivos com a extensão de arquivo .ste) 
para importação.

Para selecionar mais de um site, clique em cada arquivo .ste pressionando 
simultaneamente a tecla Control (no Windows) ou Command (no Macintosh). Para 
selecionar uma faixa de sites, clique no primeiro e no último arquivos da lista, mantendo 
pressionada a tecla Shift.

4. Clique em Open (Abrir) para iniciar a importação dos sites.

Depois de o Dreamweaver importar os sites, os nomes aparecem na caixa de diálogo 
Manage Sites em seguida.

5. Clique em Done (Concluído) para fechar a caixa de diálogo Manage Sites.

Remover um site do Dreamweaver da 
lista de sites
Se não desejar mais trabalhar com um site no Dreamweaver, remova-o da lista de sites. Os 
arquivos do site não serão removidos.

Para remover um site da lista de sites:

1. Selecione Site  > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.
2. Selecione o nome do site.

3. Clique em Remove (Remover).

Aparecerá uma caixa de diálogo, solicitando a confirmação da remoção.
4. Clique em Yes, para remover o site da lista, ou em No, para manter o seu nome.

Se você clicar em Yes, o nome do site desaparecerá da lista.
5. Clique em Done (Concluído) para fechar a caixa de diálogo Manage Sites.

Devolver e retirar arquivos
Se estiver trabalhando em um ambiente com vários usuários, você poderá utilizar o sistema 
Check In/Check Out (Devolver/retirar) para devolver e retirar arquivos dos servidores local e 
remoto. 

N
O

T
A

Quando um site for removido da lista, todas as informações de configuração sobre o site 
serão perdidas em caráter permanente.
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Se apenas você estiver trabalhando no servidor remoto, poderá utilizar os comandos Put 
(Colocar) e Get (Obter) sem devolver ou retirar os arquivos (consulte “Obter e colocar 
arquivos no servidor” na página 155).

Esta seção contém os tópicos a seguir:

■ “Configurar o sistema Check In/Check Out (Devolver/retirar)” na página 149
■ “Utilizar o protocolo WebDAV para devolver e retirar arquivos” na página 151
■ “Devolver e retirar os arquivos de um servidor remoto” na página 153
■ “Desfazer a retirada de um arquivo” na página 155

Tópicos relacionados
■ “Sobre o sistema de devoluções e retiradas” na página 114

Configurar o sistema Check In/Check Out (Devolver/
retirar)
Para poder utilizar o sistema Check In/Check Out, é necessário associar o site local a um 
servidor remoto (consulte “Configurar uma pasta remota” na página 94).

Para configurar o sistema de devoluções e retiradas:

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.
2. Selecione um site e, em seguida, clique em Edit (Editar).

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Selecione Remote Info (Informações remotas) na lista de categorias à esquerda.

A caixa de diálogo Site Definition exibirá as opções de Remote Info. A seção Check In/
Out (Devolver/retirar) aparecerá na parte inferior da caixa de diálogo.

4. Selecione a opção Enable File Check In and Check Out (Ativar a devolução e retirada de 
arquivos).
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Serão mostradas opções adicionais.

5. Preencha a seção Check In/Out.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
6. Clique em OK.

Tópicos relacionados
■ “Sobre o sistema de devoluções e retiradas” na página 114
■ “Devolver e retirar os arquivos de um servidor remoto” na página 153
■ “Desfazer a retirada de um arquivo” na página 155

N
O

T
A

Se as opções de Check In/Out não forem exibidas, significa que o servidor remoto 
não foi configurado (consulte “Configurar uma pasta remota” na página 94).
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Utilizar o protocolo WebDAV para devolver e retirar 
arquivos
O Dreamweaver pode se conectar a um servidor que utilize o protocolo WebDAV (Web-based 
Distributed Authoring and Versioning), que é um conjunto de extensões para o protocolo 
HTTP que possibilita que os usuários de uma equipe editem e gerenciem arquivos em 
servidores Web remotos. Para obter mais informações, consulte www.webdav.org. 

Para configurar o acesso de WebDAV no Dreamweaver:

1. Caso ainda não o tenha feito, defina um site do Dreamweaver que especifique a pasta local 
que você utiliza para armazenar seus arquivos de projeto.

Para obter mais informações, consulte “Configurar uma pasta local” na página 92.
2. Selecione Site > Manage Sites (Gerenciar sites) e depois clique duas vezes no seu site na lista.

A caixa de diálogo Site Definition (Definição do site) é exibida. 
3. Se a guia Basic (Básica) estiver selecionada, clique na guia Advanced (Avançado).
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4. Clique na categoria Remote Info (Informações remotas) e selecione WebDAV no menu 
pop-up Access (Acesso).

5. Especifique como o Dreamweaver deve se conectar ao servidor WebDAV.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
6. Selecione a opção Enable File Check in and Check Out (Ativar a devolução e retirada de 

arquivos) e digite as seguintes informações:

■ Na caixa de texto Check Out Name (Nome de retirada), digite um nome que 
identifique você para os demais membros da equipe.

■ Na caixa de texto Email Address (Endereço do correio eletrônico), digite o seu 
endereço do correio eletrônico.

O nome e o endereço do correio eletrônico são usados para identificar a propriedade do 
servidor WebDAV e aparecem no painel Files (Arquivos) para fins de contato.

7. Clique em OK.

O Dreamweaver configura o site para o acesso de WebDAV. 
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Para devolver e retirar arquivos utilizando o WebDAV:

■ Utilize os métodos padrão de devolução e retirada descritos na seção a seguir.
Quando você utiliza o comando Check In (Devolver) ou Check Out (Retirar) para 
qualquer arquivo do site, o Dreamweaver transfere o arquivo usando WebDAV.

Devolver e retirar os arquivos de um servidor remoto
Depois de configurar o sistema Check In/Check Out (Devolver/retirar) (consulte “Configurar 
o sistema Check In/Check Out (Devolver/retirar)” na página 149), você poderá devolver e 
retirar arquivos em um servidor remoto utilizando o painel Files (Arquivos) ou na janela do 
documento.

Para retirar arquivos utilizando o painel Files (Arquivos):

1. No painel Files, em Window (Janela) > Files, selecione os arquivos a serem retirados do 
servidor remoto.

Uma marca de seleção vermelha indica que outro membro da equipe retirou o arquivo, e 
um símbolo de cadeado indica que o arquivo é somente leitura (no Windows) ou está 
bloqueado (Macintosh).

2. Siga um dos procedimentos abaixo, para retirar o(s) arquivo(s):

■ Clique no botão Check Out (Retirar) na barra de ferramentas do painel Files.
■ No Windows, clique com o botão direito do mouse ou, no Macintosh, pressione 

Control e clique em Check Out no menu contextual.
A caixa de diálogo Dependent Files (Arquivos dependentes) será exibida.

3. Clique em Yes para efetuar o download dos arquivos dependentes, juntamente com os 
arquivos selecionados, ou em No para não efetuar o download desses arquivos.

Uma marca de seleção verde aparecerá ao lado do ícone do arquivo local indicando que ele 
foi retirado.

N
O

T
A

Você pode selecionar arquivos na visualização local ou remota, mas não na 
visualização do servidor de teste.

N
O

T
A

É recomendável efetuar o download dos arquivos dependentes na retirada de um 
novo arquivo. Mas, se a versão mais recente dos arquivos dependentes já estiver no 
disco local, não haverá necessidade de efetuar o download novamente.
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Para devolver arquivos utilizando o painel Files (Arquivos):

1. No painel Files (Window > Files), selecione os arquivos novos ou retirados.

2. Siga um destes procedimentos para devolver o(s) arquivo(s):

■ Clique no botão Check In (Devolver) na barra de ferramentas do painel Files. 
■ No Windows, clique com o botão direito do mouse ou, no Macintosh, pressione 

Control e clique em Check In no menu contextual.
A caixa de diálogo Dependent Files (Arquivos dependentes) será exibida.

3. Clique em Yes para efetuar o download dos arquivos dependentes, juntamente com os 
arquivos selecionados, ou em No para não efetuar o download desses arquivos.

Um símbolo de cadeado é exibido ao lado do ícone do arquivo local indicando que esse 
arquivo agora é somente de leitura.

Para devolver ou retirar um arquivo aberto na janela do documento:

1. Certifique-se de que o arquivo a ser devolvido ou retirado esteja ativo na janela do 
documento.

2. Siga um dos procedimentos abaixo:

■ Selecione Site > Check In ou Site > Check Out.
■ Clique no ícone de File Management (Gerenciamento de arquivos) na barra de 

ferramentas da janela do documento e, em seguida, selecione Check In ou Check Out 
no menu pop-up.

N
O

T
A

Você pode selecionar arquivos na visualização local ou remota, mas não na 
visualização do servidor de teste.

N
O

T
A

É recomendável efetuar o upload dos arquivos dependentes na devolução de um 
novo arquivo. Mas, se a versão mais recente dos arquivos dependentes já estiver no 
servidor remoto, não haverá necessidade de efetuar o upload novamente.

N
O

T
A

Você só pode devolver um arquivo aberto por vez.

N
O

T
A

Se o arquivo ativo não estiver associado ao site atual no painel Files, o 
Dreamweaver tentará determinar a qual site definido localmente esse arquivo 
pertence. Se o arquivo pertencer a apenas um site local, o Dreamweaver abrirá 
esse site e, em seguida, efetuará a operação de devolução ou retirada.
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Se o arquivo ativo for retirado, a versão aberta deste será substituída pela nova versão retirada. 
Se o arquivo ativo for devolvido, ele poderá ser salvo automaticamente antes da devolução, 
dependendo das opções de preferência definidas (consulte “Definir as preferências do painel 
Files (Arquivos)” na página 133). 

Tópicos relacionados
■ “Sobre o sistema de devoluções e retiradas” na página 114
■ “Configurar o sistema Check In/Check Out (Devolver/retirar)” na página 149

Desfazer a retirada de um arquivo
Se você retirar um arquivo e depois optar por não editá-lo (ou decidir descartar as alterações 
feitas), poderá desfazer a operação de retirada para que o arquivo volte ao seu estado original.

Para desfazer a retirada de um arquivo, siga um destes procedimentos:

■ Abra o arquivo na janela Document (Documento) e, em seguida, selecione Site > Undo 
Check Out (Desfazer a retirada).

■ No painel Files (Arquivos), em Window (Janela) > Files, clique com o botão direito do 
mouse (no Windows) ou pressione a tecla Control (no Macintosh) e, em seguida, 
selecione Undo Check Out.
A cópia local do arquivo se tornará somente de leitura e quaisquer alterações feitas serão 
perdidas.

Tópicos relacionados
■ “Sobre o sistema de devoluções e retiradas” na página 114
■ “Configurar o sistema Check In/Check Out (Devolver/retirar)” na página 149
■ “Devolver e retirar os arquivos de um servidor remoto” na página 153

Obter e colocar arquivos no servidor
Se você estiver trabalhando em um ambiente com vários usuários, utilize o sistema Check In/
Check Out (Devolver/retirar) para transferir os arquivos entre os sites local e remoto (consulte 
“Devolver e retirar arquivos” na página 148). Contudo, se for a única pessoa trabalhando no 
site remoto, utilize os comandos Get (Obter) e Put (Colocar), para transferir os arquivos sem 
devolver ou retirá-los.
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Obter arquivos de um servidor remoto
Utilize o comando Get (Obter) para copiar arquivos do site remoto para seu site local. Você 
pode utilizar o painel Files (Arquivos) ou a janela do documento para obter arquivos. 

O Dreamweaver cria um log da atividade dos arquivos durante a transferência. Para exibir ou 
salvar este log, consulte “Gerenciar transferências de arquivos” na página 160.

O Dreamweaver também registra todas as atividades de transferência de arquivos através de 
FTP. Se ocorrer um erro durante a transferência de um arquivo com o FTP, o Registro de FTP 
do site poderá auxiliá-lo a determinar o problema. 

Para obter arquivos de um servidor remoto utilizando o painel Files (Arquivos):

1. No painel Files, em Window (Janela) > Files, selecione os arquivos desejados para 
download. 

Em geral, esses arquivos são selecionados na visualização remota, mas é possível selecionar 
os arquivos correspondentes na visualização local, se for apropriado. Se a visualização 
remota estiver ativa, o Dreamweaver copiará os arquivos selecionados para o site local. Se a 
visualização local estiver ativa, o Dreamweaver copiará as versões remotas dos arquivos 
locais selecionados para o site local.

2. Siga um dos procedimentos abaixo, para obter o arquivo:

■ Clique no botão Get (Obter) na barra de ferramentas do painel Files.
■ No Windows, clique com o botão direito do mouse ou, no Macintosh, pressione 

Control e clique no arquivo no painel Files. Em seguida, selecione Get no menu 
contextual.

A caixa de diálogo Dependent files (Arquivos dependentes) será exibida.
3. Para efetuar o download dos arquivos dependentes, clique em Yes. Para ignorá-los, clique 

em No.

O Dreamweaver efetua o download dos arquivos selecionados, do seguinte modo:
■ Se estiver utilizando o sistema de devoluções e retiradas, a obtenção de um arquivo 

resultará em uma cópia local somente de leitura do arquivo. O arquivo continuará 
disponível no site remoto ou no servidor de teste para a retirada por outros membros 
da equipe (consulte “Devolver e retirar arquivos” na página 148). 

N
O

T
A

Para obter apenas os arquivos cuja versão remota for mais recente do que a local, 
utilize o comando Synchronize (Sincronizar) (consulte “Sincronizar os arquivos nos 
sites local e remoto” na página 161).

N
O

T
A

Se já houver cópias locais dos arquivos dependentes, clique em No.
156 Capítulo 4:  Gerenciar arquivos



         
■ Se você estiver utilizando o sistema de devoluções e retiradas, a obtenção de um 
arquivo resultará na transferência de uma cópia com privilégios de leitura e gravação.

Para interromper a transferência de arquivos a qualquer momento, clique no botão Cancel 
(Cancelar) na caixa de diálogo Status. É possível que a transferência não pare imediatamente.

Para obter um arquivo de um servidor remoto utilizando a janela do 
documento:

1. Certifique-se de que o documento esteja ativo na janela do documento.

2. Siga um dos procedimentos abaixo, para obter o arquivo:

■ Selecione Site > Get (Obter).
■ Clique no ícone de File Management (Gerenciamento de arquivos) na barra de 

ferramentas da janela do documento e selecione Get no menu pop-up.

Para exibir o registro de FTP:

■ Clique no menu Options (Opções) no canto superior direito do painel Files (Arquivos) e 
selecione View (Exibir) > Site FTP Log (Registro de site do FTP).

Tópicos relacionados
■ “Sobre o sistema de devoluções e retiradas” na página 114
■ “Sobre as transferências de arquivos em segundo plano” na página 115

Colocar arquivos em um servidor remoto 
Você pode colocar arquivos do site local no site remoto geralmente sem alterar o status de 
retirada do arquivo. 

Há duas situações comuns nas quais é possível utilizar o comando Put (Colocar) em vez de 
Check In (Devolver):

N
O

T
A

Se você estiver trabalhando em um ambiente com vários usuários, isto é, se 
outras pessoas estiverem utilizando os mesmos arquivos, não desative a opção 
Enable File Check In and Check Out (Ativar a devolução e retirada de arquivos). 
Se as outras pessoas estiverem utilizando o sistema de devoluções e retiradas 
no site, você também deverá utilizar o mesmo sistema.

N
O

T
A

Se o arquivo ativo não estiver associado ao site atual no painel Files, o 
Dreamweaver tentará determinar a qual site definido localmente esse arquivo 
pertence. Se o arquivo atual pertencer a apenas um site local, o Dreamweaver 
abrirá esse site e, em seguida, efetuará a operação Get.
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■ Você não está em um ambiente com muitos usuários e não está utilizando o sistema de 
devoluções e retiradas de arquivos.

■ Você deseja colocar a versão atual do arquivo no servidor e continuar a editá-lo.

Você pode utilizar o painel Files (Arquivos) ou a janela do documento para colocar arquivos. 
O Dreamweaver cria um log da atividade dos arquivos durante a transferência. Para exibir ou 
salvar este log, consulte “Gerenciar transferências de arquivos” na página 160.

O Dreamweaver também registra todas as atividades de transferência de arquivos através de 
FTP. Se ocorrer um erro durante a transferência de um arquivo com o FTP, o Registro de FTP 
do site poderá auxiliá-lo a determinar o problema. 

Para colocar arquivos em um servidor remoto ou de teste utilizando o painel 
Files:

1. No painel Files, em Window (Janela) > Files, selecione os arquivos desejados para upload.

Normalmente, você os seleciona na visualização local, embora também possa selecionar os 
arquivos correspondentes na visualização remota, se preferir.

2. Siga um dos procedimentos abaixo, para colocar o arquivo:

■ Clique no botão Put (Colocar) na barra de ferramentas do painel Files.
■ No Windows, clique com o botão direito do mouse ou, no Macintosh, pressione 

Control e clique no arquivo no painel Files. Em seguida, selecione Put no menu 
contextual.

Se o arquivo não tiver sido salvo, é possível que apareça uma caixa de diálogo, dependendo 
da definição de preferências na categoria Site da caixa de diálogo Preferences 
(Preferências), que permita salvar o arquivo antes de colocá-lo no servidor remoto. 

3. Se uma caixa de diálogo for exibida, clique em Yes para salvar o arquivo ou clique em No 
para colocar a versão salva anteriormente no servidor remoto. 

A caixa de diálogo Dependent Files (Arquivos dependentes) será exibida.

N
O

T
A

Caso você coloque um arquivo que ainda não exista no site remoto e esteja 
utilizando o sistema de devoluções e retiradas, o arquivo será copiado para o site 
remoto e, em seguida, retirado para que você possa continuar a editá-lo.

N
O

T
A

Para colocar apenas os arquivos cuja versão local for mais recente do que a remota, 
consulte “Sincronizar os arquivos nos sites local e remoto” na página 161.

N
O

T
A

Se você não salvar o arquivo, as alterações feitas desde o último salvamento não 
serão colocadas no servidor remoto. Contudo, o arquivo continuará aberto para que 
ainda seja possível salvá-lo depois de colocá-lo no servidor.
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4. Para efetuar o upload dos arquivos dependentes, clique em Yes. Para ignorá-los, clique em 
No.

Para interromper a transferência de arquivos, clique no botão Cancel (Cancelar) na caixa de 
diálogo Status. É possível que a transferência não pare imediatamente.

Para colocar arquivos em um servidor remoto utilizando a janela do 
documento:

1. Certifique-se de que o documento esteja ativo na janela do documento.

2. Siga um dos procedimentos abaixo, para colocar o arquivo:

■ Selecione Site > Put (Colocar).
■ Clique no ícone de File Management (Gerenciamento de arquivos) na barra de 

ferramentas da janela do documento e selecione Put no menu pop-up.

Para exibir o registro de FTP:

■ Clique no menu Options (Opções) no canto superior direito do painel Files (Arquivos) e 
selecione View (Exibir) > Site FTP Log (Registro de site do FTP).

Tópicos relacionados
■ “Sobre o sistema de devoluções e retiradas” na página 114
■ “Obter arquivos de um servidor remoto” na página 156
■ “Sobre as transferências de arquivos em segundo plano” na página 115

N
O

T
A

Se o site remoto já contiver cópias dos arquivos dependentes, clique em No. 

N
O

T
A

Se o arquivo ativo não estiver associado ao site atual no painel Files, o 
Dreamweaver tentará determinar a qual site definido localmente esse arquivo 
pertence. Se o arquivo atual pertencer a apenas um site local, o Dreamweaver 
abrirá esse site e, em seguida, efetuará a operação Put.
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Gerenciar transferências de arquivos
É possível exibir o status das operações de transferências de arquivos, bem como uma lista de 
arquivos transferidos e seus respectivos resultados (transferência bem-sucedida, ignorada ou 
falha na transferência). Também é possível salvar um log da atividade dos arquivos.

Para cancelar uma transferência de arquivo:

■ Clique no botão Cancel (Cancelar) ou feche a caixa de diálogo Background File Activity 
(Atividade de arquivos em segundo plano).

Para ocultar a caixa de diálogo Background File Activity durante as 
transferências:

■ Clique no botão Hide (Ocultar) na caixa de diálogo Background File Activity.

Para exibir os detalhes da última transferência de arquivo:

1. Clique no botão Log (Registro) na parte inferior do painel Files (Arquivos) para abrir a 
caixa de diálogo Background File Activity.

2. Clique na seta de expansão Details (Detalhes).

Para salvar um log da última transferência de arquivo:

1. Clique no botão Log (Registro) na parte inferior do painel Files (Arquivos) para abrir a 
caixa de diálogo Background File Activity.

2. Clique no botão Save Log (Salvar o registro) e salve as informações como um arquivo de 
texto.

É possível analisar a atividade dos arquivos ao abrir o arquivo de log no Dreamweaver ou em 
qualquer editor de texto.

Tópicos relacionados
■ “Obter e colocar arquivos no servidor” na página 155

N
O

T
A

O Dreamweaver permite a execução de outras atividades não relacionadas com o 
servidor enquanto você está transferindo arquivos de/para um servidor. Para obter mais 
informações, consulte “Sobre as transferências de arquivos em segundo plano” na 
página 115.
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Sincronizar os arquivos nos sites local e 
remoto
Depois que os arquivos forem criados nos sites local e remoto, é possível sincronizá-los.

Antes de sincronizar os sites, você poderá verificar quais arquivos deseja colocar, obter, excluir 
ou ignorar. O Dreamweaver confirma quais arquivos foram atualizados após o término da 
sincronização.

Para verificar quais arquivos são mais recentes no site local ou no site remoto, 
sem sincronização, siga um dos procedimentos abaixo:

■ No canto superior direito do painel Files (Arquivos), clique no menu Options (Opções) e 
depois selecione Edit (Editar) > Select Newer Local (Selecionar um local mais novo) ou 
Select (Selecionar) > Select Newer Remote (Selecionar um remoto mais novo). 

■ No painel Files, clique com o botão direito do mouse (no Windows) ou mantenha a tecla 
Control pressionada (no Macintosh) e, em seguida, selecione Select > Newer Local (Local 
mais novo) ou Select > Newer Remote (Remoto mais novo).

Para sincronizar os arquivos:

1. No painel Files (Arquivos), em Window (Janela) > Files, selecione um site no menu pop-
up (em que o site atual, o servidor ou a unidade aparece).

2. (Opcional) Selecione pastas ou arquivos específicos. 

Se desejar sincronizar o site inteiro, ignore essa etapa.
3. Clique no menu Options no canto superior direito do painel Files e selecione Site > 

Synchronize (Sincronizar).

A caixa de diálogo Synchronize Files (Sincronizar os arquivos) é exibida.

N
O

T
A

Caso o site remoto seja um servidor de FTP (em vez de um servidor de rede), a 
sincronização dos arquivos utilizará o FTP.
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4. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
5. Clique no botão Preview (Visualizar).

O Dreamweaver exibe os arquivos que serão sincronizados e permite que você altere as 
ações (colocar, obter, excluir e ignorar) para esses arquivos antes de executar a 
sincronização. Se todos os seus arquivos já estiverem sincronizados, o Dreamweaver o 
informará que a sincronização não é necessária.
Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Tópicos relacionados
■ “Devolver e retirar os arquivos de um servidor remoto” na página 153
■ “Obter arquivos de um servidor remoto” na página 156
■ “Colocar arquivos em um servidor remoto” na página 157
■ “Comparar arquivos para conhecer as diferenças” na página 126

Identificar e excluir arquivos não-
utilizados
É possível identificar e excluir arquivos que não mais são usados por outros arquivos do site.

Para identificar e excluir arquivos não-utilizados:

1. Escolha Site > Check Links Sitewide (Verificar os links no site inteiro).

O Dreamweaver verifica todos os links do site e exibe os links rompidos no painel Results 
(Resultados).

2. Selecione Orphaned Files (Arquivos Órfãos) no menu pop-up do painel Link Checker 
(Verificador de links).

O Dreamweaver exibe todos os arquivos que não apresentam links de entrada. Isto 
significa que nenhum arquivo do seu site possui links apontando para esses arquivos.

3. Selecione os arquivos que você deseja excluir e pressione a tecla Delete (no Windows) ou 
Command+Delete (no Macintosh). 

C
U

ID
A

D
O

Apesar de nenhum outro arquivo do site possuir links apontando para esses 
arquivos, alguns dos arquivos listados podem ter links apontando para outros 
arquivos. Tenha cuidado com a exclusão de arquivos.
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Tópicos relacionados
■ “Verificar links rompidos, externos e órfãos” na página 491

Mascarar as pastas e os arquivos do site
O mascaramento de sites permite excluir pastas e tipos arquivos em um site de operações no 
site inteiro, como Get (Obter) ou Put (Colocar).

Tópicos relacionados
■ “Sobre o mascaramento de sites” na página 116
■ “Identificar e excluir arquivos não-utilizados” na página 162

Ativar e desativar o mascaramento de sites
O mascaramento de sites está ativo como padrão. É possível desativar o mascaramento em 
caráter permanente ou temporário, para realizar uma operação que afete todos os arquivos, 
inclusive os que estiverem mascarados. Quando o mascaramento de sites for desativado, todos 
os arquivos que estiverem mascarados serão revelados. Quando ele for reativado, todos os 
arquivos que estavam anteriormente mascarados retornarão a esse estado. 

Para ativar ou desativar o mascaramento de sites:

1. No painel Files (Arquivos), em Window (Janela) > Files, selecione um site no menu pop-
up em que o site atual, o servidor ou a unidade aparece.

2. Selecione um arquivo ou uma pasta. 

3. Clique com o botão direito do mouse (no (Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) e, em seguida, siga um destes procedimentos:

■ Selecione Enable/Disable Cloaking (Ativar/Desativar o mascaramento).
■ Selecione Settings (Definições) e, em seguida, na guia Advanced (Avançado) da caixa 

de diálogo Site Definition (Definição do site), escolha Mascaramento (Cloaking) na 
lista de categorias à esquerda. Selecione Enable Cloaking (Ativar o mascaramento) ou 
cancele sua seleção e, em seguida, clique em OK.

O mascaramento deste site estará ativado ou desativado.

N
O

T
A

Também é possível utilizar a opção Uncloak All (Revelar tudo) para revelar todos os 
arquivos, mas ela não desativará o mascaramento. Não há uma maneira de mascarar 
novamente todas as pastas e os arquivos que estavam anteriormente mascarados, 
exceto redefinindo o mascaramento de cada pasta e tipo de arquivo.
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Tópicos relacionados
■ “Sobre o mascaramento de sites” na página 116
■ “Mascarar e revelar determinados tipos de arquivos” na página 164
■ “Revelar todas as pastas e arquivos” na página 167

Mascarar e revelar as pastas do site
É possível mascarar determinadas pastas, mas não todas as pastas ou um site inteiro. É possível 
mascarar diversas pastas simultaneamente.

Para mascarar ou revelar determinadas pastas de um site:

1. No painel Files (Arquivos), em Window (Janela) > Files, selecione um site cujo 
mascaramento esteja ativado no menu pop-up em que o site atual, o servidor ou a unidade 
aparece.

2. Selecione a(s) pasta(s) que deseja mascarar ou revelar.

3. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada enquanto clica (no Macintosh). Em seguida, selecione Cloaking 
(Mascaramento)> Cloak (Mascarar) ou  Cloaking > Uncloak (Revelar) no menu 
contextual. 

Uma linha vermelha atravessando o ícone correspondente à pasta aparecerá ou desaparecerá, 
indicando se a pasta está mascarada ou não.

Tópicos relacionados
■ “Sobre o mascaramento de sites” na página 116
■ “Ativar e desativar o mascaramento de sites” na página 163
■ “Revelar todas as pastas e arquivos” na página 167

Mascarar e revelar determinados tipos de arquivos
É possível indicar determinados tipos de arquivos a serem mascarados, de modo que o 
Dreamweaver mascare todos os arquivos que terminarem com um padrão especificado. Por 
exemplo: mascare todos os arquivos que terminarem com a extensão .txt. Os tipos de arquivos 
digitados não precisam ser extensões, pois podem obedecer a qualquer padrão no final dos 
nomes de arquivo.

N
O

T
A

Para realizar uma operação em determinada pasta mascarada, basta selecionar o item 
no painel Files. A realização direta de uma operação em um arquivo ou uma pasta anula 
o mascaramento.
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Para mascarar determinados tipos de arquivos em um site:

1. No painel Files (Arquivos), em Window (Janela) > Files, selecione um site cujo 
mascaramento esteja ativado no menu pop-up em que o site atual, o servidor ou a unidade 
aparece.

2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) e, em seguida, selecione Settings (Definições).

A caixa de diálogo Site Definition (Definição do site) exibe as opções de Cloaking 
(Mascaramento).

3. Marque a caixa de seleção Cloak Files Ending With (Mascarar os arquivos terminados 
com).

4. Na caixa de texto, digite os tipos de arquivos a serem mascarados.

Por exemplo: .jpg, para mascarar todos os arquivos do site que terminarem com .jpg.

5. Clique em OK.

N
O

T
A

Separe os diversos tipos de arquivos com um espaço. Não utilize vírgulas ou sinais 
de dois pontos.
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Aparecerá uma linha vermelha atravessando os arquivos afetados, indicando o seu 
mascaramento.

Para revelar determinados tipos de arquivos em um site:

1. No painel Files (Arquivos), em Window (Janela) > Files, selecione um site cujo 
mascaramento esteja ativado no menu pop-up em que o site atual, o servidor ou a unidade 
aparece.

2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) e, em seguida, selecione Cloaking > Settings.

A guia Advanced (Avançado) da caixa de diálogo Site Definition (Definição do site) é 
exibida.

3. Siga um dos procedimentos abaixo:

■ Desmarque a caixa de seleção Cloak Files Ending With para revelar todos os tipos de 
arquivos listados na caixa de texto.

■ Exclua determinados tipos de arquivos da caixa de texto, para revelá-los.
4. Clique em OK.

As linhas vermelhas que atravessavam os arquivos afetados desaparecerão, indicando que 
eles foram revelados.

Tópicos relacionados
■ “Sobre o mascaramento de sites” na página 116
■ “Ativar e desativar o mascaramento de sites” na página 163
■ “Mascarar e revelar as pastas do site” na página 164

D
IC

A

Alguns programas criam arquivos de cópia de segurança com um determinado sufixo, 
como .bak. Esses arquivos podem ser mascarados.

N
O

T
A

Para realizar uma operação em determinada pasta mascarada, basta selecionar o item 
no painel Files. A realização direta de uma operação em um arquivo ou uma pasta anula 
o mascaramento.
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Revelar todas as pastas e arquivos
É possível revelar todas as pastas e arquivos de um site simultaneamente. Essa ação não pode 
ser desfeita. Não há como encobrir novamente todos os itens que estavam encobertos 
anteriormente. Será necessário mascará-los individualmente.

Para revelar todas as pastas e arquivos de um site:

1. No painel Files (Arquivos), em Window (Janela) > Files, selecione um site cujo 
mascaramento esteja ativado no menu pop-up em que o site atual, o servidor ou a unidade 
aparece.

2. Selecione qualquer arquivo ou pasta do site.

3. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) e, em seguida, selecione Cloaking (Mascaramento) > Uncloack 
All (Revelar tudo). 

As linhas vermelhas que atravessavam os ícones dos arquivos e das pastas desaparecerão, 
indicando que eles foram revelados.

Tópicos relacionados
■ “Sobre o mascaramento de sites” na página 116
■ “Ativar e desativar o mascaramento de sites” na página 163
■ “Mascarar e revelar as pastas do site” na página 164
■ “Mascarar e revelar determinados tipos de arquivos” na página 164

Armazenar informações sobre arquivos 
nas Design Notes
As Design Notes são notas associadas a um arquivo, mas armazenadas em um arquivo 
separado. Utilize as Design Notes para controlar as informações adicionais relativas aos 
documentos, como nomes de arquivos de origem de imagens e comentários sobre o status de 
arquivos.

D
IC

A

Se desejar revelar temporariamente todas as pastas e arquivos e mascará-los 
novamente, desative o mascaramento de sites (consulte “Ativar e desativar o 
mascaramento de sites” na página 163).

N
O

T
A

Essa etapa também desmarca a caixa Cloak Files Ending With (Mascarar os 
arquivos terminados com) em Site  >  Cloaking > Settings (Definições).
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Tópicos relacionados
■ “Sobre o Design Notes” na página 116

Ativar e desativar as Design Notes de um site
Ative ou desative as Design Notes de um site na categoria Design Notes da caixa de diálogo 
Site Definition (Definição do site). Ao ativar as Design Notes, é possível optar por utilizá-las 
apenas localmente, se desejar.

Para ativar e desativar as Design Notes do site ou para utilizá-las localmente:

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.
2. Selecione um site e, em seguida, clique em Edit (Editar).

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Selecione as Design Notes na lista Category (Categoria) à esquerda.

A caixa de diálogo Site Definition exibe as opções das Design Notes.

4. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
5. Clique em OK.
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Tópicos relacionados
■ “Sobre o Design Notes” na página 116
■ “Trabalhar com Design Notes” na página 170

Associar Design Notes a arquivos
É possível criar um arquivo de Design Notes para cada documento ou modelo do site. Você 
pode também criar Design Notes referentes a miniaplicativos, controles ActiveX, imagens, 
conteúdo Flash, objetos Shockwave e campos de imagem nos documentos.

Para adicionar Design Notes a um documento:

1. Siga um dos procedimentos abaixo:

■ Abra o arquivo na janela do documento e, em seguida, selecione File (Arquivo) > 
Design Notes.

■ No painel Files, clique com o botão direito do mouse (Windows) ou clique com a tecla 
Control pressionada (Macintosh) e clique no arquivo. Em seguida, selecione 
Design Notes. 

Aparecerá a caixa de diálogo Design Notes.

2. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

N
O

T
A

Se forem adicionadas Design Notes a um arquivo de modelo, elas não serão herdadas 
pelos documentos criados com esse modelo.

N
O

T
A

Se o arquivo residir em um site remoto, retire ou obtenha o arquivo e, em seguida 
selecione-o na pasta local (consulte “Devolver e retirar os arquivos de um 
servidor remoto” na página 153 ou “Obter e colocar arquivos no servidor” na 
página 155).
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3. Clique em OK, para salvar as notas.

O Dreamweaver salvará as notas em uma pasta denominada _notes, no mesmo local que o 
arquivo. O nome do arquivo será o mesmo do arquivo do documento, além da extensão 
.mno. 
Por exemplo: se o nome do arquivo for índice.html, o arquivo de Design Notes a ele 
associado será denominado índice.html.mno.

Tópicos relacionados
■ “Sobre o Design Notes” na página 116
■ “Ativar e desativar as Design Notes de um site” na página 168

Trabalhar com Design Notes
Depois de associar uma Design Note a um arquivo (consulte “Associar Design Notes a 
arquivos” na página 169), você poderá abri-la, alterar seu status ou excluí-la. 

Para abrir as Design Notes associadas a um arquivo, siga um destes 
procedimentos:

■ Abra o arquivo na janela do documento e, em seguida, selecione File (Arquivo) > 
Design Notes.

■ No painel Files, clique com o botão direito do mouse (Windows) ou clique com a tecla 
Control pressionada (Macintosh) e clique no arquivo. Em seguida, selecione 
Design Notes. 

■ Na coluna Notes (Notas) do painel Files, clique duas vezes no ícone amarelo das Design 
Notes.

Para atribuir um status personalizado às Design Notes:

1. Abra as Design Notes correspondentes a um arquivo ou objeto (consulte o procedimento 
anterior).

2. Clique na guia All Info (Todas as informações).

3. Clique no botão com o sinal de adição (+).

4. No campo Name (Nome), digite a palavra status.

5. No campo Value (Valor), digite o status.

Se já existir um valor de status, ele será substituído pelo novo valor.
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6. Clique na guia Basic Info e observe que o novo valor de status é mostrado no menu pop-
up Status.

Para excluir do site as Design Notes sem associação:

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.
2. Selecione o site e clique em Edit (Editar).

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Selecione Design Notes na lista de categorias à esquerda.

4. Clique no botão Clean Up (Limpar). 

O Dreamweaver solicitará que verifique se as Design Notes que não estão mais associadas 
a um arquivo do site deverão ser excluídas. 
Se você utilizar o Dreamweaver para excluir um arquivo ao qual está associado um arquivo 
de Design Notes, ele excluirá também o arquivo de Design Notes. Por esse motivo, 
geralmente os arquivos órfãos de Design Notes ocorrerão apenas quando um arquivo for 
excluído ou renomeado fora do Dreamweaver.

Tópicos relacionados
■ “Sobre o Design Notes” na página 116
■ “Ativar e desativar as Design Notes de um site” na página 168

Testar o site 
O Dreamweaver fornece diversos recursos para ajudá-lo a testar um site, inclusive a 
visualização de páginas e a verificação de compatibilidade de navegadores. Você também pode 
executar vários relatórios, como um relatório de links rompidos.

N
O

T
A

É possível constar apenas um valor personalizado no menu de status de cada vez. 
Se esse procedimento for realizado novamente, o Dreamweaver substituirá o valor 
de status inserido na primeira vez pelo novo valor.

N
O

T
A

Se a opção Maintain Design Notes (Manter as Design Notes) for desmarcada antes 
de clicar em Clean Up, o Dreamweaver excluirá todos os arquivos de Design Notes 
associados ao site.
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Diretrizes de teste de site
Antes de carregar o site em um servidor e prepará-lo para a exibição, é recomendável testá-lo 
localmente (recomenda-se testar e verificar se há problemas no site com freqüência durante a 
sua construção. Desta forma, é possível descobrir problemas logo e evitar que se repitam). 

Certifique-se de que a aparência e o funcionamento das páginas nos navegadores de destino 
estejam de acordo com o esperado, que não haja links rompidos e que o download das páginas 
não demore demais. Também é possível testar e solucionar problemas em seu site como um 
todo executando um relatório de local.

As diretrizes a seguir o auxiliarão a criar uma experiência agradável para os visitantes 
do seu site:

■ Certifique-se de que as páginas estejam funcionando conforme o esperado nos 
navegadores de destino e de que não apresentem problemas ou "falhas" em outros 
navegadores. 
As páginas devem ser legíveis e funcionais nos navegadores que não oferecerem suporte aos 
estilos, camadas, plug-ins ao JavaScript (consulte “Verificar a compatibilidade com 
navegadores” na página 635). No caso das páginas que não funcionam adequadamente em 
navegadores de versões anteriores, há a possibilidade de utilizar o comportamento Check 
Browser (Verificar o navegador) para redirecionar os visitantes automaticamente a outra 
página (consulte “Check Browser (Verificar o navegador)” na página 551).

■ Visualize as páginas no maior número possível de navegadores e plataformas diferentes.
Este procedimento possibilita a exibição de diferenças no layout, cores, tamanhos de fonte 
e tamanho padrão de janelas do navegador, que não podem ser previstos em uma 
verificação de navegador de destino (consulte “Visualizar e testar páginas em navegadores” 
na página 399).

■ Verifique se há links rompidos no site e ajuste-os. 
Uma vez que os outros sites também sofrem reformas e reorganizações, a página à qual está 
vinculando o seu site pode ter sido transferida ou excluída. É possível executar um 
relatório de verificação de links para testá-los (consulte “Verificar links rompidos, externos 
e órfãos” na página 491 e “Corrigir links rompidos” na página 493).    
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■ Monitore o tamanho das páginas e o tempo de download (consulte “Definir preferências 
de tamanho e tempo de download” na página 402). 
Lembre-se de que, se uma página consistir em uma grande tabela, em alguns navegadores, 
os visitantes não verão nada até que a tabela inteira seja carregada. Considere também a 
possibilidade de desmembrar tabelas grandes; se isto não for possível, coloque um 
conteúdo pequeno, como uma mensagem de boas-vindas ou uma faixa de propaganda, 
fora da tabela no alto da página, de modo que os visitantes possam visualizar esse material 
enquanto for feito o download da tabela.

■ Execute alguns relatórios de site para testar e solucionar problemas no site como um todo. 
É possível verificar o seu site inteiro quanto a problemas como, por exemplo, documentos 
sem títulos, tags vazias e tags redundantes aninhadas (consulte “Testar o site” na 
página 171).

■ Valide o código para localizar erros de tag ou sintaxe (consulte “Validar tags” na 
página 639).

■ Depois que porção maior do site tiver sido publicada, prossiga com sua atualização e 
manutenção. 
A publicação do site, ou seja, colocá-lo "no ar", pode ser efetuada de várias maneiras e é 
um processo contínuo. A definição e implementação de um sistema de controle de versão 
é uma parte importante do processo, tanto com as ferramentas do Dreamweaver, quanto 
com um aplicativo externo de controle de versão.

■ Utilize os fóruns de discussão do Dreamweaver no site da Macromedia na Web, em 
www.macromedia.com/go/dreamweaver_newsgroup.
Os fóruns podem fornecer informações importantes sobre navegadores, plataformas e 
assim por diante. Também é possível discutir assuntos técnicos e compartilhar sugestões 
úteis com outros usuários do Dreamweaver .

Utilizar relatórios para testar um site
Você pode executar relatórios de site sobre o fluxo de trabalho ou sobre atributos HTML, 
inclusive acessibilidade, para o documento atual, os arquivos selecionados ou o site inteiro.
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Os relatórios de fluxo de trabalho podem melhorar a colaboração entre membros de uma 
equipe da Web. Você pode executar relatórios de fluxo de trabalho que exibem quem retirou 
um arquivo, quais arquivos estão associados a Design Notes e quais arquivos foram 
modificados recentemente. É possível refinar ainda mais os relatórios das Design Notes, 
especificando os parâmetros nome/valor. 

Os relatórios HTML permitem compilar e gerar relatórios de vários atributos HTML. Você 
pode verificar as tags de fontes aninhadas combináveis, a acessibilidade, a ausência de texto 
alternativo, as tags aninhadas redundantes, as tags vazias removíveis e os documentos sem 
título. 

Após executar um relatório, você poderá salvá-lo em um arquivo XML, importá-lo para uma 
instância de modelo, um banco de dados ou uma planilha eletrônica e imprimi-lo ou exibi-lo 
em um site da Web. 

Para utilizar o comando Reports (Relatórios) para verificar os links de um site, consulte 
“Verificar links rompidos, externos e órfãos” na página 491.

Para executar relatórios de teste de um site: 

1. Selecione Site > Reports (Relatórios). 

N
O

T
A

É necessário contar com uma conexão a um site remoto definida para executar os 
relatórios de fluxo de trabalho. Para definir um site remoto, consulte “Configurar uma 
pasta remota” na página 94.

N
O

T
A

É possível adicionar também diversos tipos de relatórios ao Dreamweaver através do 
site de intercâmbio Macromedia Dreamweaver Exchange. (Consulte “Adicionar 
extensões ao Dreamweaver” na página 84).

D
IC

A
Para executar apenas um relatório de acessibilidade do site, você poderá selecionar 
File (Arquivo) > Check Page (Verificar página) > Check Accessibility (Verificar 
acessibilidade) e o relatório aparecerá no painel Site Reports (Relatórios de site) do 
grupo de painéis Results (Resultados).
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A caixa de diálogo Reports (Relatórios) é exibida.

2. Selecione uma categoria para criar um relatório e um tipo de relatório para executar.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em Run (Executar) para criar o relatório.

Dependendo do tipo de relatório a ser executado, talvez você seja solicitado a salvar o 
arquivo, definir o site ou selecionar uma pasta (se ainda não tiver feito isso).
Uma lista de resultados aparece no painel Site Reports no grupo de painéis Results.

Para utilizar e salvar um relatório:

1. Execute um relatório (consulte o procedimento anterior).

2. No painel Site Reports, siga um destes procedimentos para exibir o relatório:

■ Clique no cabeçalho da coluna de acordo com a qual deseja ordenar os resultados. 
É possível ordenar por nome de arquivo, número da linha ou descrição. Também é 
possível executar vários relatórios diferentes e mantê-los abertos.

■ Selecione qualquer linha do relatório e clique no botão More Info (Mais informações), 
no lado esquerdo do painel Site Reports, para obter uma descrição do problema.
As informações aparecerão no painel Reference (Referência).

■ Clique duas vezes em qualquer linha do relatório para exibir o código correspondente 
na janela do documento.

N
O

T
A

Na visualização do projeto, o Dreamweaver altera a exibição para visualização 
dividida para mostrar o problema relatado em código.
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3. Clique em Save Report (Salvar o relatório) para salvar o relatório.

Quando o relatório for salvo, ele poderá ser importado para um arquivo existente de 
modelo. Em seguida, é possível importar o arquivo para um banco de dados ou planilha e 
imprimir ou exibi-lo em um site da Web.

Tópicos relacionados
■ “Relatórios no Dreamweaver” na página 55

D
IC

A

Após executar os relatórios HTML, utilize o comando Clean Up HTML (Limpar o 
HTML) para corrigir quaisquer erros de HTML que tiverem sido listados pelos 
relatórios (consulte “Limpar o código” na página 633).
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CAPÍTULO 5

Gerenciar bibliotecas 
e propriedades de sites
Ao desenvolver sites da Web, você pode acumular um número cada vez maior de 
propriedades. Em alguns casos, é possível utilizar as mesmas propriedades para vários sites ou 
definir um conjunto de propriedades preferidas que podem ser utilizadas para todos os seus 
sites. Você pode utilizar o Macromedia Dreamweaver 8 para gerenciar as propriedades do site. 
É possível localizar e visualizar facilmente diversos tipos de propriedades armazenadas no site, 
como imagens, filmes, cores, scripts e links. Você também pode arrastar facilmente uma 
propriedade diretamente para o documento atual a fim de inseri-la em uma página.

O Dreamweaver permite acesso a dois tipos especiais de recursos: bibliotecas e modelos. Os 
itens da biblioteca e modelos são propriedades vinculadas: edição de um item de biblioteca ou 
modelo atualiza todos os documentos nos quais as propriedades foram aplicadas. Os itens de 
biblioteca são reservados para uso com elementos de projeto específicos, como as informações 
de direitos autorais de um site ou um logotipo. Os modelos permitem controlar uma área de 
projeto maior. Para obter mais informações, consulte Capítulo 11, “Gerenciar modelos”, na 
página 325. 

Os seguintes tópicos são discutidos neste capítulo: 
Sobre itens de biblioteca  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177

Trabalhar com propriedades . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179

Criar e gerenciar uma lista de propriedades favoritas  . . . . . . . . . . . . . . . . . . . . . . . . 188

Trabalhar com itens de biblioteca. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .191

Sobre itens de biblioteca
Uma biblioteca é um arquivo especial do Dreamweaver que contém uma coleção de 
propriedades específicas ou cópias de propriedades criadas por você para serem inseridas nas 
páginas da Web. Essas propriedades contidas em uma biblioteca são chamadas de itens de 
biblioteca. Você pode atualizar todas as páginas que utilizam um item de biblioteca sempre 
que alterar o conteúdo do item. É possível armazenar todos os tipos de elementos de página, 
como imagens, tabelas, sons e arquivos Flash em uma biblioteca.
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A seguir um exemplo de utilização de um item de biblioteca: suponha que esteja criando um 
site grande para uma empresa. O slogan da empresa deve aparecer em todas as páginas do site, 
mas o departamento de marketing ainda não se decidiu quanto aos detalhes do conteúdo do 
slogan. Se um item de biblioteca for criado para conter o slogan para ser utilizado em todas as 
páginas, quando o departamento de marketing fornecer o slogan final, você poderá alterar o 
item de biblioteca e automaticamente atualizar todas as páginas que o utilizarem.

O Dreamweaver armazena os itens de biblioteca na pasta Library (Biblioteca) localizada na 
pasta raiz local de cada site. Cada site tem sua própria biblioteca. 

Quando você utiliza um item de biblioteca, o Dreamweaver não insere esse item na página da 
Web; em vez disso, ele insere um link para o item. Isto é, o Dreamweaver insere uma cópia do 
código-fonte HTML desse item no documento e adiciona um comentário de HTML com 
uma referência para o item original e externo. 

A referência ao item externo da biblioteca possibilita a atualização simultânea do conteúdo 
inteiro de um site por meio da alteração do item e, em seguida, da utilização dos comandos de 
atualização do submenu Modify (Modificar) > Library. Em seguida, se você precisar alterar 
parte do texto, por exemplo, ou uma imagem, a atualização automática do item de biblioteca 
atualizará a instância da biblioteca em todas as páginas nas quais o item foi inserido. 

Quando você criar um item de biblioteca que contenha um elemento com um anexo de 
comportamento, o Dreamweaver copiará, para o arquivo do item de biblioteca, o elemento e 
o seu manipulador de evento (o atributo que especifica o evento que iniciará a ação, como 
onClick, onLoad ou onMouseOver, e qual ação deverá ser chamada quando ocorrer o evento). 
O programa não copiará para o item de biblioteca as funções JavaScript associadas. Em vez 
disso, quando você inserir o item de biblioteca no documento, o Dreamweaver inserirá 
automaticamente as funções JavaScript apropriadas na seção head do documento (caso ainda 
não estejam na seção).

N
O

T
A

Se o item de biblioteca contiver links, os links poderão não funcionar no novo site. Além 
disso, as imagens de um item de biblioteca não serão copiadas para o novo site.

N
O

T
A

Se codificar manualmente o JavaScript (ou seja, se for criado sem utilizar os 
comportamentos do Dreamweaver), você poderá integrá-lo a um item de biblioteca se o 
comportamento Call JavaScript (Chamar o JavaScript) for utilizado para executar o 
código. Se você não utilizar um comportamento do Dreamweaver para executar o 
código, este não será mantido como parte do item de biblioteca.
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Existem requisitos especiais para editar os comportamentos em itens de biblioteca (consulte 
“Editar um comportamento em um item de biblioteca” na página 199). Os itens de biblioteca 
não podem conter folhas de estilos, porque o código correspondente a esses elementos integra 
a seção head.

Tópicos relacionados
■ “Trabalhar com itens de biblioteca” na página 191

Trabalhar com propriedades
As propriedades envolvem vários elementos que você pode armazenar em um site, como um 
arquivo de imagem ou de filme. 

É possível obter propriedades de várias fontes. Por exemplo, você pode criar propriedades em 
um aplicativo, como o Macromedia Fireworks ou Macromedia Flash, recebê-las de um colega 
de trabalho ou copiá-las de um CD de clip-art ou de um site gráfico da Web.

Tópicos relacionados
■ “Criar e gerenciar uma lista de propriedades favoritas” na página 188
■ “Trabalhar com itens de biblioteca” na página 191

Exibir propriedades no painel Assets (Propriedades)
Você pode exibir e gerenciar as propriedades do site atual no painel Assets. O painel Assets 
exibe as propriedades do site associadas ao documento ativo na janela do documento. 

O painel Assets fornece duas visualizações: 

A lista Site mostra todas as propriedades do site, inclusive as cores e as URLs utilizadas em 
qualquer documento desse site.

A lista Favorites (Favoritos) mostra apenas as propriedades escolhidas explicitamente.

N
O

T
A

É preciso definir um site local antes de visualizar as propriedades no painel Assets. Para 
obter mais informações sobre como configurar um site, consulte “Configurar um novo 
site do Dreamweaver” na página 90.
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Nas duas listas, as propriedades são divididas em categorias (no lado esquerdo do painel 
Assets). As listas Site e Favorites estão disponíveis para todas as categorias de propriedades, 
exceto para modelos e itens de biblioteca. 

Como padrão, as propriedades em uma determinada categoria são listadas por nomes em 
ordem alfabética. Você também pode listar as propriedades por vários outros critérios ou 
alterar o tamanho das colunas. É possível visualizar as propriedades de uma categoria e alterar 
o tamanho da área de visualização.

Para abrir o painel Assets: 

■ Selecione Window (Janela) > Assets. 
O painel Assets é exibido. A categoria Images (Imagens) é selecionada por padrão. 

Para exibir a lista Site:

■ No painel Assets, em Window > Assets, selecione a opção Site na parte superior do painel.

N
O

T
A

A maioria das operações do painel Assets funciona do mesmo modo que as listas Site e 
Favorites. Contudo, há algumas tarefas que podem ser executadas apenas na lista 
Favorites (consulte “Criar e gerenciar uma lista de propriedades favoritas” na 
página 188).

N
O

T
A

Nas categorias Templates (Modelos) e Library, localizadas no lado esquerdo do 
painel Assets, as opções Site e Favorites não estarão disponíveis.
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Para exibir a lista Favorites:

■ No painel Assets, em Window > Assets, selecione a opção Favorites na partes superior do 
painel.
A lista Favorites permanecerá vazia até que você adicione propriedades a ela.

Para exibir as propriedades de uma determinada categoria:

■ Clique no ícone apropriado no lado esquerdo do painel Assets, em Window > Assets. 

Para listar as propriedades em uma ordem diferente:

■ Clique em um dos cabeçalhos de colunas.
Por exemplo: para classificar a lista de imagens por tipo, de modo que todas as imagens 
GIF, JPEG etc. sejam agrupadas, clique no cabeçalho de coluna Type (Tipo).

Para alterar a largura de uma coluna:

■ Arraste a linha que separa os dois cabeçalhos das colunas.

Para visualizar uma propriedade:

■ Selecione a propriedade no painel Assets.
A área de visualização, no alto do painel, mostra a pré-visualização da propriedade. 
Por exemplo: ao selecionar uma propriedade de filme, a área de visualização exibe um 
ícone. Para exibir o filme, clique no botão Play (Executar), o triângulo verde no canto 
superior direito da área de visualização.

Para alterar o tamanho da área de visualização:

■ Arraste para cima ou para baixo a barra de divisão (entre a área de visualização e a lista de 
propriedades).

Tópicos relacionados
■ “Adicionar uma propriedade a um documento” na página 182
■ “Selecionar e editar as propriedades” na página 184

Atualizar o painel Assets 
O painel Assets  pode demorar alguns segundos até criar a lista Site, pois é necessário ler o 
cache do site para criar essa lista.

N
O

T
A

Nas categorias Templates e Library, localizadas no lado esquerdo do painel Assets, 
as opções Site e Favorites não estarão disponíveis.
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Algumas alterações não aparecerão imediatamente no painel Assets:

■ Quando você adicionar ou remover uma propriedade do site, as alterações não aparecerão 
no painel Assets até que a lista Site seja atualizada, clicando no botão Refresh Site List 
(Atualizar a lista Site). Se uma propriedade for adicionada ou removida fora do 
Dreamweaver, utilizando o Windows Explorer, por exemplo, recrie o cache do site para 
atualizar o painel Assets.

■ Quando você remover a única instância de determinada cor ou URL no site,, ou salvar um 
novo arquivo contendo uma cor ou URL ainda não utilizado no site, as alterações não 
aparecerão no painel Assets até que, a lista Site seja atualizada.

Para atualizar manualmente a lista Site: 

1. No painel Assets, em Window > Assets, selecione a opção Site na parte superior do painel 
para ver a lista Site.

2. Clique no botão Refresh Site List na parte inferior do painel Assets.

O Dreamweaver cria o cache do site ou o atualiza, conforme necessário, e o painel Assets é 
atualizado para exibir as propriedades do site.

Para recriar o cache do site manualmente e atualizar a lista Site:

■ No painel Assets (Window > Assets), clique com o botão direito do mouse (no Windows) 
ou pressione a tecla Command (no Macintosh) na lista Assets e selecione Refresh Site List.

Tópicos relacionados
■ “Selecionar e editar as propriedades” na página 184
■ “Reutilizar propriedades em outro site” na página 186

Adicionar uma propriedade a um documento 
A maior parte dos tipos de propriedades pode ser inserida em um documento arrastando-as 
para a visualização do projeto ou visualização do código da janela do documento ou utilizando 
o botão Insert (Inserir). É possível inserir cores e URLs ou aplicá-las no texto selecionado, na 
visualização do projeto (as URLs também podem ser aplicadas a outros elementos, como as 
imagens, na visualização do projeto). 

Para inserir uma propriedade em um documento:

1. Coloque o ponto de inserção na visualização do projeto onde a propriedade deverá 
aparecer.
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2. No painel Assets, em Window > Assets, selecione, no lado esquerdo do painel, a categoria 
relativa ao tipo de propriedade a ser inserida.

3. Selecione Site ou Favorites na parte superior do painel e, em seguida, escolha a propriedade 
a ser inserida.

Não há listas Site ou Favorites para os itens de biblioteca. Ignore essa etapa ao inserir um 
item de biblioteca.

4. Siga um dos procedimentos abaixo:

■ Arraste a propriedade do painel para o documento. 
Você pode arrastar os scripts até a área de conteúdo do cabeçalho na janela do 
documento. Se essa área não estiver visível, selecione View (Exibir) > Head Content 
(Conteúdo do cabeçalho).

■ Selecione a propriedade no painel e clique em Insert na parte inferior do painel.
A propriedade é inserida no documento. Se a propriedade for uma cor, ela será aplicada a 
partir do ponto de inserção, ou seja, a digitação subseqüente será exibida nesta cor.

Tópicos relacionados
■ “Aplicar uma URL a uma imagem ou um texto utilizando o painel Assets” na página 184
■ “Selecionar e editar as propriedades” na página 184
■ “Reutilizar propriedades em outro site” na página 186

Aplicar uma cor ao texto utilizando o painel Assets
As cores no painel Assets representam as cores que você aplicou a vários elementos do site, 
como texto, borda da tabela, cor de fundo e assim por diante. É possível utilizar amostras de 
cores na categoria Color (Cores) para aplicar as opções de cores a objetos em uma página de 
maneira uniforme. 

Para obter mais informações sobre como adicionar uma cor à categoria Color, consulte 
“Adicionar e remover propriedades da lista Favorites” na página 188.

N
O

T
A

Selecione qualquer categoria, exceto Templates. Um modelo pode ser aplicado 
apenas a um documento inteiro e não pode ser inserido em um documento. Para 
obter mais informações sobre os modelos, consulte Capítulo 11, “Gerenciar 
modelos”, na página 325.
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Para alterar a cor do texto selecionado em um documento: 

1. Selecione o texto no documento.

2. No painel Assets (Window > Assets) selecione a categoria Colors no lado esquerdo do 
painel.

3. Selecione a cor desejada.

4. Na parte inferior do painel, clique no botão Apply (Aplicar).

Tópicos relacionados
■ “Adicionar uma propriedade a um documento” na página 182
■ “Selecionar e editar as propriedades” na página 184
■ “Reutilizar propriedades em outro site” na página 186

Aplicar uma URL a uma imagem ou um texto 
utilizando o painel Assets
Você pode utilizar o painel Assets para transformar o texto ou a imagem selecionada em um 
link ativo.

Para adicionar um link à seleção atual em um documento: 

1. Selecione o texto ou imagem em que deseja aplicar a URL.

2. No painel Assets, em Window > Assets, selecione a categoria URLs no lado esquerdo do 
painel.

3. Selecione a URL desejada.

4. Siga um dos procedimentos abaixo:

■ Arraste a URL do painel para a seleção na visualização do projeto.
■ Selecione a URL e, em seguida, clique no botão Insert.

Tópicos relacionados
■ “Adicionar uma propriedade a um documento” na página 182
■ “Aplicar uma cor ao texto utilizando o painel Assets” na página 183
■ “Reutilizar propriedades em outro site” na página 186

Selecionar e editar as propriedades
O painel Assets permite selecionar várias propriedades simultaneamente. Este painel também 
fornece um modo rápido de iniciar a edição das propriedades.
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Para selecionar várias propriedades: 

1. No painel Assets, em Window > Assets, selecione uma das propriedades.

2. Selecione as outras propriedades de uma das seguintes maneiras:

■ Pressione a tecla Shift e clique para selecionar uma série consecutiva de propriedades.
■ Pressione a tecla Control (no Windows) ou a tecla Command (no Macintosh) e clique 

para adicionar uma propriedade individual à seleção (seja ela adjacente ou não à 
seleção existente). Pressione a tecla Control ou Command e clique em uma 
propriedade escolhida para cancelar a sua seleção.

Para editar uma propriedade: 

1. No painel Assets (Window > Assets), selecione uma das propriedades.

■ Clique duas vezes na propriedade.
■ Selecione a propriedade e, em seguida, clique no botão Edit (Editar) na parte inferior 

do painel.
No caso de alguns tipos de propriedades (imagens, por exemplo), a edição da propriedade 
será iniciada em um aplicativo de edição externo. Quanto às cores e URLs, a edição da 
propriedade permite alterar o valor desta apenas na lista Favorites. As cores e URLs não 
podem ser editadas na lista Site. No caso dos modelos e itens de biblioteca, a edição da 
propriedade permite alterá-la no Dreamweaver.

2. Altere a propriedade conforme desejar.

3. Ao concluir a edição da propriedade, siga um dos procedimentos abaixo:

■ Se a propriedade estiver na forma de um arquivo (qualquer uma diferente de cor ou 
URL), salve-a (utilizando qualquer editor empregado para editá-la) e feche a 
propriedade. 

■ Se a propriedade for uma URL, clique em OK ao terminar a edição na caixa de diálogo 
Edit URL (Editar URL).

■ Se a propriedade for uma cor, o seletor de cores do Dreamweaver se fechará 
automaticamente quando uma cor for escolhida. 

N
O

T
A

Se não for aberto um editor externo para uma propriedade que deveria utilizá-lo, 
selecione Edit > Preferences (Preferências) (no Windows) ou Dreamweaver > 
Preferences (no Macintosh), selecione a categoria File Types/Editors (Tipos de 
arquivos/editores) e certifique-se de que haja um editor externo definido para o tipo 
de arquivo da propriedade. Consulte “Iniciar um editor de arquivos de mídia externo” 
na página 521.

N
O

T
A

Para desativar o seletor de cores sem escolher uma cor, pressione a tecla Esc.
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Tópicos relacionados
■ “Exibir propriedades no painel Assets (Propriedades)” na página 179
■ “Atualizar o painel Assets” na página 181

Reutilizar propriedades em outro site
O painel Assets mostra todas as propriedades (dos tipos reconhecidos) no site atual. Para 
utilizar uma propriedade do site atual em outro site, copie-a no outro site. É possível copiar 
uma propriedade individual, um conjunto de propriedades ou uma pasta Favorites inteira de 
uma só vez. 

Talvez você precise localizar o arquivo no painel Files (Arquivos) que corresponde a uma 
propriedade no painel Assets antes de transferir a propriedade de ou para o site remoto.

Para localizar um arquivo de propriedade no painel Files:

1. No painel Assets, em Window > Assets, selecione, no lado esquerdo do painel, a categoria 
relativa ao tipo de propriedade a ser localizada.

2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) e clique no nome da propriedade ou no ícone correspondente 
no painel Assets. Em seguida, selecione Locate in Site (Localizar no site) no menu 
contextual.

O painel Files é exibido com o arquivo de propriedade selecionado. O comando Locate in 
Site localiza o arquivo correspondente à propriedade, e não um arquivo que a utiliza.

N
O

T
A

O painel Files pode exibir um site diferente daquele mostrado no painel Assets. Isso 
ocorre porque o painel Assets está associado ao documento ativo. 

N
O

T
A

A opção Locate in Site não está disponível para cores e URLs que não 
correspondam a arquivos no site,
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Para copiar as propriedades da lista Site ou Favorites do painel Assets para 
outro site:

1. No painel Assets (Window > Assets), selecione, no lado esquerdo do painel, a categoria 
relativa ao tipo de propriedade a ser copiada.

2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh), clique nas propriedades a serem copiadas e selecione Copy to 
Site (Copiar para o site). Em seguida, selecione o site de destino no submenu. O submenu 
listará todos os sites que o usuário tiver definido.

As propriedades são copiadas para o site especificado, para posições correspondentes às 
posições no site atual. O Dreamweaver cria novas pastas na hierarquia do site de destino 
como necessário. As propriedades também são adicionadas à lista Favorites do site 
especificado.

Quando um documento for aberto no site de destino, o painel Assets alternará para esse site e 
exibirá a propriedade copiada.

Tópicos relacionados
■ “Exibir propriedades no painel Assets (Propriedades)” na página 179
■ “Atualizar o painel Assets” na página 181
■ “Selecionar e editar as propriedades” na página 184

N
O

T
A

Na lista Favorites, é possível copiar uma pasta Favorites, bem como propriedades 
específicas. Para obter informações sobre as pastas Favorites, consulte “Agrupar as 
propriedades na pasta Favorites” na página 191.

N
O

T
A

Se a propriedade copiada for uma cor ou uma URL, ela aparecerá na lista Favorites, e 
não na lista Site do outro site. Isso ocorre porque não há qualquer arquivo 
correspondente à cor ou à URL. Portanto, nenhum arquivo poderá ser copiado no outro 
site.
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Criar e gerenciar uma lista de 
propriedades favoritas
Uma vez que a lista Site do painel Assets mostra todas as propriedades reconhecidas no site, 
essa lista torna-se muito longa no caso de alguns sites grandes. Você pode adicionar as 
propriedades utilizadas com freqüência à lista Favorites, agrupar as propriedades relacionadas, 
fornecer apelidos a elas que lembrem sua função e localizá-las facilmente no painel Assets.

A maioria das operações do painel Assets é a mesma nas listas Site e Favorites. Contudo, há 
várias tarefas que podem ser executadas apenas na lista Favorites. 

Adicionar e remover propriedades da lista Favorites
Há várias maneiras de adicionar propriedades à lista Favorites no painel Assets. 

A adição de uma cor ou uma URL à lista Favorites requer uma etapa extra. Observe que você 
não pode adicionar cores ou URLs novas à lista Site, que contém apenas as propriedades que 
já estão em uso no site. 

Para adicionar propriedades à lista Favorites, siga um destes procedimentos:

■ Selecione uma ou mais propriedades na lista Site do painel Assets e clique no botão Add to 
Favorites (Adicionar à pasta Favoritos) na parte inferior do painel.

■ Selecione uma ou mais propriedades na lista Site do painel Assets, clique com o botão 
direito do mouse (no Windows) ou mantenha a tecla Control pressionada (no Macintosh) 
e, em seguida, selecione Add to Favorites.

■ Selecione um ou mais arquivos no painel Files, clique com o botão direito do mouse (no 
Windows) ou mantenha a tecla Control pressionada (no Macintosh) e, em seguida, 
selecione Add to Favorites. 
O Dreamweaver ignora os arquivos que não se enquadram em uma categoria no painel 
Assets.

N
O

T
A

As propriedades favoritas não são armazenadas como arquivos separados no disco 
rígido. Na verdade, são referências de propriedades existentes na lista Site. O 
Dreamweaver controla quais propriedades da lista Site serão exibidas na lista Favorites.

N
O

T
A

Não há listas Favorites para os modelos e os itens de biblioteca.
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■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control (no 
Macintosh) pressionada e clique em um elemento na visualização do projeto da janela do 
documento. Em seguida, selecione o comando no menu contextual para adicionar o 
elemento à categoria Favorites apropriada. 
Observe que o menu contextual correspondente ao texto conterá Add to Color Favorites 
(Adicionar à pasta de cores favoritas) ou Add to URL Favorites (Adicionar à pasta de 
URLs favoritas), dependendo do fato de haver ou não um link associado ao texto. Observe 
também que apenas os elementos que se enquadrarem em uma das categorias do painel 
Assets poderão ser adicionados à lista Favorites.

Para adicionar uma nova cor ou URL à lista Favorites:

1. No painel Assets, em Window > Assets, selecione a categoria Colors ou URLs no lado 
esquerdo do painel.

2. Selecione a opção Favorites na parte superior do painel para exibir a lista Favorites.

3. Na parte inferior do painel, clique no botão New Color (Nova cor) ou New URL (Nova 
URL).

4. Siga um dos procedimentos abaixo

■ Selecione uma cor utilizando o seletor de cores e, em seguida, dê um apelido à cor, se 
desejar (consulte “Criar um apelido para uma propriedade favorita” na página 190). 
Para sair do seletor de cores sem selecionar uma cor, pressione a tecla Esc ou clique na 
barra cinza, na parte superior do seletor. Para obter mais informações sobre o uso do 
seletor de cores, consulte “Trabalhar com cores” na página 384.

■ Digite uma URL e um apelido na caixa de diálogo Add New URL (Adicionar nova 
URL) e, em seguida, clique em OK.

Para remover propriedades da lista Favorites :

1. No painel Assets, em Window > Assets, selecione a opção Favorites na partes superior do 
painel.

2. Selecione uma ou mais propriedades (ou uma pasta) na lista Favorites.

3. Clique no botão Remove From Favorites (Remover da pasta Favoritos) na parte inferior do 
painel.

As propriedades serão removidas da lista Favorites, mas ainda aparecerão na lista Site. Se 
uma pasta Favorites for removida, essa pasta e todas as propriedades nela contidas serão 
excluídas da lista Favorites.
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Tópicos relacionados
■ “Exibir propriedades no painel Assets (Propriedades)” na página 179
■ “Criar um apelido para uma propriedade favorita” na página 190

Criar um apelido para uma propriedade favorita
Você pode fornecer apelidos para as propriedades da lista Favorites. O apelido é exibido no 
lugar do nome do arquivo ou do valor da propriedade. Por exemplo: se uma cor for chamada 
de #999900, deverá ser utilizado um apelido mais descritivo, cor_de_fundo_da_página ou 
cor_de_texto_importante.

Você pode fornecer apelidos para as propriedades da lista Favorites do painel Assets. Na lista 
Site, as propriedades são listadas pelos seus nomes de arquivos reais (ou seus valores, no caso 
das cores e URLs).

Para dar nomes às propriedades favoritas:

1. No painel Assets, em Window > Assets, selecione a categoria no lado esquerdo do painel 
que contém a propriedade.

2. Selecione a opção Favorites na parte superior do painel para exibir a lista Favorites.

3. Siga um dos procedimentos abaixo:

■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh), e clique no nome da propriedade ou no ícone no painel 
Assets. Em seguida, escolha Edit Nickname (Editar o apelido).

■ Clique uma vez no nome da propriedade, faça uma pausa e clique nele novamente.
4. Digite um apelido para a propriedade, em seguida, pressione a tecla Enter (no Windows) 

ou Return (no Macintosh).

O apelido aparecerá na coluna Nickname (Apelido).

Tópicos relacionados
■ “Exibir propriedades no painel Assets (Propriedades)” na página 179
■ “Adicionar e remover propriedades da lista Favorites” na página 188
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Agrupar as propriedades na pasta Favorites
Você pode agrupar as propriedades da lista Favorites em pastas no painel Assets. Por exemplo: 
se houver um conjunto de imagens utilizadas em várias páginas de catálogos em um site de 
comércio eletrônico, elas poderão ser agrupadas em uma pasta chamada 
Imagens_de_catálogo. 

Para criar uma pasta Favorites:

1. No painel Assets, em Window > Assets, selecione a opção Favorites na parte superior do 
painel.

2. Clique no botão New Favorites Folder (Nova pasta Favoritos) na parte inferior do painel.

3. Digite um nome para a pasta e, em seguida, pressione a tecla Enter (no Windows) ou 
Return (no Macintosh).

4. Arraste as propriedades para a pasta.

Tópicos relacionados
■ “Exibir propriedades no painel Assets (Propriedades)” na página 179
■ “Adicionar e remover propriedades da lista Favorites” na página 188
■ “Criar um apelido para uma propriedade favorita” na página 190

Trabalhar com itens de biblioteca
As bibliotecas constituem uma maneira de armazenar elementos de páginas como, por 
exemplo, imagens, texto e outros objetos, que são reutilizados ou atualizados com freqüência 
em todo o site da Web. Estes elementos são denominados itens de biblioteca.

Tópicos relacionados
■ “Sobre itens de biblioteca” na página 177

Criar um item de biblioteca
É possível criar um item de biblioteca a partir de qualquer elemento da seção body de um 
documento, incluindo texto, tabelas, formulários, applets Java, plug-ins, elementos ActiveX, 
barras de navegação e imagens.

N
O

T
A

A inserção de uma propriedade em uma pasta de favoritos não altera a localização do 
arquivo da propriedade no disco rígido.
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No caso de itens vinculados, como as imagens, a biblioteca armazenará somente uma 
referência ao item. O arquivo original deverá permanecer no local especificado para que o 
item de biblioteca funcione corretamente. 

Mesmo assim, poderá ser útil armazenar uma imagem em um item de biblioteca, por 
exemplo: você pode armazenar uma tag img completa em um item de biblioteca, que 
permitiria alterar facilmente o texto alt da imagem, ou o seu atributo src no site inteiro. No 
entanto, não utilize esta técnica para alterar os atributos de width e height de uma imagem, a 
não ser que utilize também um editor de imagens para alterar o tamanho real da imagem.

Para criar um item de biblioteca baseado em uma seleção:

1. Na janela do documento, selecione uma parte de um documento para salvá-la como um 
item de biblioteca.

2. Siga um dos procedimentos abaixo:

■ Arraste a seleção até a categoria Library do painel Assets, em Window > Assets.
■ Na parte inferior da categoria Library do painel Assets (Window > Assets), clique no 

botão New Library Item (Novo item de biblioteca).
■ Selecione Modify (Modificar) > Library > Add Object to Library (Adicionar objeto à 

biblioteca).
3. Digite um nome para o novo item de biblioteca e, em seguida, pressione a tecla Enter (no 

Windows) ou Return (no Macintosh).

O Dreamweaver salva cada item de biblioteca como um arquivo separado (com a extensão 
.lbi) na pasta Library da pasta raiz local do site.

Para criar um item de biblioteca vazio:

1. Certifique-se de que não haja qualquer elemento selecionado na janela do documento. 

Se algum item for selecionado, a seleção será colocada no novo item de biblioteca.
2. No painel Assets (Window > Assets), selecione a categoria Library no lado esquerdo do 

painel.

3. Na parte inferior do painel Assets, clique no botão New Library Item (Novo item de 
biblioteca).

Um novo item sem título é adicionado à lista de itens do painel. 
4. Enquanto o item estiver selecionado, digite um nome para ele e, em seguida, pressione 

Enter (no Windows) ou Return (no Macintosh).

Tópicos relacionados
■ “Editar um item de biblioteca” na página 194
■ “Definir as preferências de realce da biblioteca” na página 197
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Inserir um item de biblioteca em um documento
Quando um item de biblioteca for adicionado a uma página, o conteúdo atual será inserido 
no documento juntamente com uma referência ao item de biblioteca.

Para inserir um item de biblioteca em um documento:

1. Coloque o ponto de inserção na janela do documento.

2. No painel Assets, em Window > Assets, selecione a categoria Library no lado esquerdo do 
painel.

3. Siga um dos procedimentos abaixo:

■ Arraste um item de biblioteca do painel Assets para a janela do documento.

■ Selecione um item de biblioteca e clique no botão Insert na parte inferior do painel.

D
IC

A

Para inserir o conteúdo de um item de biblioteca sem incluir no documento uma 
referência a esse item, pressione a tecla Control (no Windows) ou Option (no 
Macintosh) enquanto arrasta um item para fora do painel Assets. Se inserir um 
item dessa forma, você poderá editá-lo no documento, mas o documento não 
será atualizado quando você atualizar as páginas que utilizam esse item de 
biblioteca.
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Tópicos relacionados
■ “Criar um item de biblioteca” na página 191
■ “Editar as propriedades de um item de biblioteca” na página 198
■ “Tornar editáveis os itens de biblioteca de um documento” na página 198

Editar um item de biblioteca
Quando editar um item de biblioteca, você poderá atualizar todos os documentos que o 
utilizam. Se você optar por não fazer uma atualização, os documentos continuarão associados 
ao item de biblioteca e você poderá atualizá-los posteriormente.

Outros tipos de alterações em itens de biblioteca incluem a sua renomeação, para romper a 
conexão com os documentos ou modelos, a sua exclusão da biblioteca do site e a recriação de 
um item de biblioteca perdido.

Para editar um item de biblioteca:

1. No painel Assets, em Window > Assets, selecione a categoria Library no lado esquerdo do 
painel.

2. Selecione um item de biblioteca.

A visualização do item de biblioteca é exibida na parte superior do painel Assets. Não é 
possível editar os elementos da visualização.

3. Siga um dos procedimentos abaixo:

■ Na parte inferior do painel, clique no botão Edit (Editar).
■ Clique duas vezes no item de biblioteca.
O Dreamweaver abrirá uma nova janela para a edição do item de biblioteca. Essa janela é 
semelhante a uma janela de documento, mas a sua visualização do projeto tem um fundo 
cinza, indicando a edição de um item de biblioteca, e não de um documento.

4. Edite o item de biblioteca e, em seguida, salve as alterações.

N
O

T
A

O painel CSS Styles (Estilos CSS) não estará disponível quando você estiver editando 
um item de biblioteca, uma vez que esses itens podem conter apenas elementos body e 
o código de folhas de estilos CSS é inserido na seção head de um documento. A caixa 
de diálogo Page Properties (Propriedades da página) também não estará disponível, 
pois um item de biblioteca não pode incluir uma tag  body ou seus atributos.
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5. Na caixa de diálogo exibida, selecione se deseja atualizar os documentos do site local que 
utiliza o item de biblioteca editado:

■ Selecione Update (Atualizar) para atualizar todos os documentos do site local com o 
item de biblioteca editado.

■ Selecione Don’t Update (Não atualizar) para evitar que os documentos sejam alterados 
até que você utilize Modify > Library >Update Current Page (Atualizar a página atual) 
ou Update Pages (Atualizar páginas).

Para atualizar o documento atual de forma a utilizar a versão mais recente de 
todos os itens de biblioteca:

■ Selecione Modify > Library > Update Current Page. 

Para atualizar o site inteiro ou todos os documentos que utilizarem um item de 
biblioteca específico:

1. Selecione Modify > Biblioteca > Update Pages.

A caixa de diálogo Update Pages é exibida.
2. No menu pop-up Look In (Procurar em), siga um dos procedimentos abaixo:

■ Selecione Entire Site (Site inteiro) e, em seguida, escolha o nome do site no menu 
pop-up adjacente. 
Este procedimento atualizará todas as páginas no site selecionado, para que utilizem a 
versão atual de todos os itens de biblioteca.

■ Selecione Files That Use (Arquivos que usam) e, em seguida, selecione um item de 
biblioteca no menu pop-up adjacente. 
Esse procedimento atualizará todas as páginas no site atual que utilizarem o item de 
biblioteca selecionado.

3. Verifique se a opção Library Items (Itens de biblioteca) está selecionada na opção Update. 

4. Clique em Start (Iniciar).

O Dreamweaver atualizará os arquivos conforme indicado. Se a opção Show Log (Mostrar 
registro) for selecionada, o Dreamweaver fornecerá informações sobre os arquivos que 
tentar atualizar, incluindo informações sobre o êxito em sua atualização.

D
IC

A

Para atualizar os modelos simultaneamente, verifique se a opção Templates 
também está selecionada. Para obter mais informações, consulte “Abrir um modelo 
para edição” na página 359.
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Para renomear um item de biblioteca:

1. No painel Assets (Window > Assets), selecione a categoria Library no lado esquerdo do 
painel.

2. Selecione o item de biblioteca a ser renomeado, faça uma pausa e, em seguida, clique nele 
novamente.

3. Quando o nome se tornar editável, digite um novo nome.

4. Clique em outro local ou pressione a tecla Enter (no Windows) ou Return (no Macintosh).

5. O Dreamweaver perguntará se você deseja atualizar os documentos que utilizam este item: 

■ Para atualizar todos os documentos do site que utilizam esse item, clique em Update.
■ Para evitar a atualização de qualquer documento que utilize esse item, clique em Don’t 

Update.

Para excluir um item de uma biblioteca:

1. No painel Assets (Window > Assets), selecione a categoria Library no lado esquerdo do 
painel.

2. Selecione o item de biblioteca a ser excluído.

3. Siga um dos procedimentos abaixo:

■ Clique no botão Delete (Excluir) na parte inferior do painel e confirme que deseja 
excluir o item. 

■ Pressione a tecla Delete e confirme que deseja excluir o item. 

O Dreamweaver remove o item de biblioteca, mas não altera o conteúdo dos documentos 
que utilizam esse item.

Para recriar um item de biblioteca ausente ou excluído:

1. Selecione uma instância do item em um documento.

2. Clique no botão Recreate (Recriar) do Property inspector (Inspetor de propriedades), em 
Window > Properties (Propriedades).

N
O

T
A

Este método funciona da mesma forma que a renomeação de um arquivo no 
Windows Explorer (no Windows) ou Finder (no Macintosh). Do mesmo modo que no 
Windows Explorer ou Finder, certifique-se de fazer uma pequena pausa entre os 
cliques. Não clique duas vezes no nome, pois o item de biblioteca será aberto 
para edição.

C
U

ID
A

D
O

Tenha cuidado ao excluir um item de biblioteca, pois não será possível utilizar o 
comando Undo (Refazer) para recuperá-lo. No entanto, talvez você possa recriá-lo, 
como descrito no próximo procedimento.
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Tópicos relacionados
■ “Criar um item de biblioteca” na página 191
■ “Tornar editáveis os itens de biblioteca de um documento” na página 198
■ “Editar um comportamento em um item de biblioteca” na página 199

Definir as preferências de realce da biblioteca
A cor de realce dos itens de biblioteca pode ser personalizada, exibida ou ocultada, de acordo 
com a definição nas preferências de realce. 

Para alterar a cor de realce de itens de biblioteca:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.
2. Selecione a categoria Highlight (Realce) na lista à esquerda.

3. Clique na caixa de cor dos itens de biblioteca e selecione a cor de realce utilizando o seletor 
de cores ou digite o valor hexadecimal correspondente à cor de realce na caixa de texto. 

Para obter informações sobre como utilizar o seletor de cores, consulte “Trabalhar com 
cores” na página 384.

4. Selecione Show (Mostrar) para exibir a cor da biblioteca realçada na janela do documento.

5. Clique em OK. 

Para exibir cores de realce na janela do documento:

■ Selecione View (Exibir) > Visual Aids (Auxílios visuais) > Invisible Elements (Elementos 
invisíveis).
As cores de realce aparecerão na janela do documento apenas quando a opção View  > 
Visual Aids> Invisible Elements for ativada e as opções apropriadas estiverem ativas nas 
preferências de realce.

Tópicos relacionados
■ “Criar um item de biblioteca” na página 191
■ “Editar um item de biblioteca” na página 194
■ “Editar as propriedades de um item de biblioteca” na página 198
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Editar as propriedades de um item de biblioteca
Você pode utilizar o Property inspector de um item de biblioteca para abrir esse item e editá-
lo, desanexar um item de biblioteca selecionado do arquivo de origem, ou sobregravar um 
item com o item de biblioteca selecionado no momento.

Para editar as propriedades de um item de biblioteca:

1. Selecione um item de biblioteca em um documento.

2. Clique em um dos botões do Property Inspector, em Window > Properties, dependendo 
do que você deseja fazer.

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.

Tópicos relacionados
■ “Criar um item de biblioteca” na página 191
■ “Inserir um item de biblioteca em um documento” na página 193
■ “Definir as preferências de realce da biblioteca” na página 197

Tornar editáveis os itens de biblioteca de um 
documento 
Se tiver adicionado um item de biblioteca ao documento e desejar editá-lo especificamente em 
uma página, será necessário romper o link entre o item do documento e a biblioteca. Quando 
a instância do item de biblioteca tornar-se editável, essa instância não poderá ser atualizada 
quando o item de biblioteca tiver sido modificado.

Para tornar editável um item de biblioteca:

1. Selecione um item de biblioteca no documento atual.

2. No Property Inspector, em Window > Properties, clique em Detach from Original 
(Desanexar do original).

A instância selecionada do item de biblioteca perderá a cor de realce (se esta estiver visível) 
e não poderá mais ser atualizada quando o item de biblioteca original for alterado.

Tópicos relacionados
■ “Criar um item de biblioteca” na página 191
■ “Inserir um item de biblioteca em um documento” na página 193
■ “Editar um item de biblioteca” na página 194
■ “Editar as propriedades de um item de biblioteca” na página 198
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Editar um comportamento em um item de biblioteca
Para editar o comportamento de um item de biblioteca, você deve primeiramente inseri-lo em 
um documento e, em seguida, tornar o item editável no documento. Depois de fazer as 
alterações desejadas, é possível recriar o item de biblioteca substituindo o item na biblioteca 
pelo item editado do documento.

Para obter mais informações sobre os comportamentos, consulte “Utilizar comportamentos 
JavaScript” na página 541.

Para editar um comportamento em um item de biblioteca:

1. Abra um documento que contenha o item de biblioteca.

Anote o nome do item, bem como as tags que ele contém. Você precisará dessas 
informações mais tarde.

2. Selecione o item de biblioteca e, em seguida, clique em Detach from Original no 
Property inspector, em Window > Properties.

3. Selecione o elemento que contém o comportamento anexado.

4. No painel Behaviors (Comportamentos) (Window> Behaviors), clique duas vezes na ação 
que deseja alterar.

5. Na caixa de diálogo que aparecer, faça as alterações necessárias e clique em OK.

6. No painel Assets (Window > Assets), selecione a categoria Library no lado esquerdo do 
painel.

7. Registre o nome exato do item de biblioteca original; selecione o item de biblioteca original 
e, em seguida, clique no botão Delete (Excluir), na parte inferior do painel.

8. Na janela do documento, selecione todos os elementos que compõem o item de biblioteca.

Selecione exatamente os mesmos elementos contidos no item de biblioteca original.
9. No painel Assets, clique no botão New Library Item (Novo item de biblioteca) e atribua ao 

novo item o mesmo nome do item que foi excluído. 

Certifique-se de utilizar exatamente a mesma grafia e caixa alta ou baixa.
10. Para atualizar o item de biblioteca nos outros documentos do site, selecione Modify 

>Library > Update Pages.

11. Na caixa de diálogo Update Pages, no menu pop-up Look In, selecione Files That Use.

12. No menu pop-up adjacente, selecione o nome do item de biblioteca que acaba de criar.
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13. Na opção Update, certifique-se de que os itens de Library estejam selecionados e, em 
seguida, clique em Start (Iniciar).

14. Quando tiver concluído as atualizações, clique em Close (Fechar) para sair da caixa de 
diálogo Update Pages.

Tópicos relacionados
■ “Criar um item de biblioteca” na página 191
■ “Inserir um item de biblioteca em um documento” na página 193
■ “Editar um item de biblioteca” na página 194
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CAPÍTULO 6

Gerenciar sites do Contribute 
com o Dreamweaver
O Macromedia Contribute combina um navegador e um editor de páginas da Web básico. Ele 
permite que seus colegas ou clientes naveguem em uma página de um site que você criou, e 
editem ou atualizem a página se tiverem permissão para isso. Os usuários do Contribute 
podem adicionar e atualizar conteúdo básico da Web, incluindo texto formatado, imagens, 
tabelas e links. Os administradores do site do Contribute podem limitar o que os usuários 
comuns (não-administradores) têm permissão para fazer em um site. 

Como administrador do site, você concede àqueles que não são administradores a capacidade 
de editar páginas ao criar uma chave de conexão e enviando-a para eles. (Para obter mais 
informações, consulte Using Contribute.) Você também pode configurar uma conexão com 
um site do Contribute utilizando o Macromedia Dreamweaver 8, que permite que você ou 
outro usuário modifique os arquivos do site como faria em qualquer outro site do 
Dreamweaver. Isto pode ser útil para as pessoas que desejam se conectar ao seu site do 
Contribute, mas que desejam fazê-lo utilizando o Dreamweaver e não o Contribute. Por 
exemplo, seu designer de sites gostaria de se conectar ao site do Contribute, mas tendo todos 
os recursos de edição disponíveis no Dreamweaver.

O Contribute adiciona funcionalidade ao seu site da Web com o CPS (Servidor de publicação 
do Contribute, Contribute Publishing Server), um conjunto de aplicativos de publicação e 
ferramentas de gerenciamento de usuários que permite integrar o Contribute ao serviço de 
diretório de usuários da sua empresa — por exemplo, o protocolo LDAP (Lightweight 
Directory Access Protocol) ou o Active Directory. Quando você ativar o site do Dreamweaver 
como um site do Contribute, o Dreamweaver lerá as configurações administrativas do 
Contribute sempre que você se conectar ao site remoto. Se o Dreamweaver detectar que o CPS 
está ativo, ele se comunicará diretamente com o CPS. Isso permite que o Dreamweaver herde 
algumas das funcionalidades do CPS, como reversão de arquivos e registro de eventos.

N
O

T
A

Este capítulo pressupõe que você é um administrador do Contribute.
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Este capítulo contém as seguintes seções:
Sobre o gerenciamento de sites do Contribute . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202

Preparar um site para utilizar com o Contribute. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .207

Administrar um site do Contribute utilizando o Dreamweaver . . . . . . . . . . . . . . . . 208

Gerenciar arquivos do Contribute utilizando o Dreamweaver  . . . . . . . . . . . . . . . . . 210

Solucionar problemas de um site do Contribute . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214

Sobre o gerenciamento de sites do 
Contribute  
Você pode se conectar a um site do Dreamweaver por meio do Contribute e modificar os 
arquivos do site como faria em qualquer site do Dreamweaver. A maioria das funcionalidades 
do Dreamweaver funciona tão bem em um site do Contribute quanto em qualquer outro site. 
Existem apenas alguns aspectos do trabalho com arquivos em um site do Contribute 
diferentes do trabalho com arquivos em outros sites. 

Estrutura de site e projeto de página de um site do 
Contribute 
Para preparar seu site da Web para ser editado pelos usuários do Contribute, organize o site 
adequadamente. 

Crie as pastas que os usuários do Contribute deverão utilizar em suas páginas, crie páginas de 
índice para essas pastas e acrescente navegação básica às páginas. Talvez seja preciso criar pastas 
específicas para que os usuários possam praticar. Você também pode criar folhas de estilo CSS 
que definam os estilos para cada página ou pasta. É possível executar algumas dessas tarefas de 
configuração no Contribute, mas é mais fácil configurar um site utilizando o Dreamweaver.

Além disso, é possível criar modelos que os usuários do Contribute podem utilizar para criar 
novas páginas (consulte “Criar modelos para um site do Contribute” na página 344).

As sugestões a seguir podem ajudar a criar um site com o qual os usuários do Contribute 
poderão contribuir facilmente:

■ Mantenha a estrutura do site simples.
Não aninhe pastas demasiadamente. Agrupe itens relacionados em uma pasta.

■ Configure adequadamente as permissões de leitura e gravação das pastas no servidor. 
Para obter mais informações, consulte “Permitir aos usuários do Contribute o acesso a 
modelos sem acessar a pasta raiz” na página 212.
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■ À medida que criar uma estrutura de pastas, adicione páginas de índice às pastas para 
incentivar os usuários do Contribute a inserir as novas páginas nas pastas corretas.
Por exemplo: se os usuários do Contribute fornecerem páginas contendo atas de reunião, é 
possível criar uma pasta na pasta raiz do site denominada atas_reuniao e criar uma página 
de índice naquela pasta. Em seguida, você pode fornecer um link da página principal de 
seu site para a página de índice para as atas de reunião. O usuário do Contribute poderá 
então navegar naquela página de índice e criar uma página nova de atas para uma reunião 
específica vinculadas àquela página; a nova página é criada automaticamente dentro da 
pasta atas_reuniao.

■ Na página de índice de cada pasta, forneça uma lista de links às páginas de conteúdo 
individuais e documentos naquela pasta.

■ Mantenha o design da página o mais simples possível, evitando qualquer formatação mais 
complexa.

■ Nomeie os estilos CSS corretamente. 
Se os usuários do Contribute que estiverem trabalhando em seu site utilizarem um 
conjunto de estilos padrão do Microsoft Word, nomeie os estilos CSS com os mesmos 
nomes que os estilos do Word correspondentes, de forma que o Contribute possa mapear 
os estilos quando um usuário copiar informações de um documento do Word e colá-lo em 
uma página do Contribute.

■ Para evitar que um estilo CSS fique disponível para os usuários do Contribute, altere o 
nome do estilo de modo que o nome inicie com mmhide_ . 
Por exemplo, se você utilizar um estilo denominado JustificadoDireita em uma página, 
mas não desejar que os usuários do Contribute tenham acesso a esse estilo, renomeie o 
estilo para mmhide_JustificadoDireita.

■ Utilize CSS em vez de tags HTML. 
O Contribute reconhece os estilos CSS e permite que eles sejam aplicados pelos usuários. 

■ Use o menor número possível de estilos CSS, para manter o design de páginas simples e 
organizado.

■ Se você utilizar inclusões de servidor para elementos de página HTML, como cabeçalhos 
ou rodapés, crie uma página HTML simples e desvinculada que contenha links para os 
arquivos de inclusão. 
Os usuários do Contribute poderão então marcar essa página e utilizá-la para navegar até 
os arquivos de inclusão e editá-los.

N
O

T
A

Você precisa adicionar mmhide_ ao nome do estilo na visualização do código; não é 
possível adicioná-lo no painel CSS.
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Tópicos relacionados
■ Capítulo 2, “Configurar um site do Dreamweaver”, na página 87
■ “Criar novos documentos” na página 102
■ “Utilizar a opção Cascading Style Sheets (Folha de estilo em cascata) para formatar texto” 

na página 433
■ “Trabalhar com inclusões do servidor” na página 652

Conexão de site para compatibilidade com o 
Contribute 
No Dreamweaver, você pode se conectar a um site do Contribute existente e modificar os 
arquivos nesse site como faria em qualquer site do Dreamweaver (“Configurar um novo site 
do Dreamweaver” na página 90). Quando você se conectar a um site configurado como um 
site do Contribute, que já tenha um administrador, o Dreamweaver solicitará a ativação da 
compatibilidade do Contribute. 

Se você estiver preparando um site existente do Dreamweaver para os usuários do Contribute, 
precisará ativar explicitamente a compatibilidade do Contribute para usar recursos 
relacionados ao Contribute; o Dreamweaver não solicitará a ativação. Para obter mais 
informações, consulte “Preparar um site para utilizar com o Contribute” na página 207.

O Dreamweaver permite a conexão a um site remoto (inclusive a um site do Contribute) de 
diversas formas, mas nem todos os tipos de conexão suportam a compatibilidade do 
Contribute. Em especial, as restrições a seguir são aplicáveis aos tipos de conexão:

■ Se você estiver se conectando a um site remoto por meio do WebDAV ou SourceSafe, não 
poderá ativar a compatibilidade do Contribute, uma vez que os sistemas de controle de 
origem não são compatíveis com as Design Notes e os sistemas de devolução/retirada que 
o Dreamweaver utiliza para sites do Contribute.

■ Se você utilizar o RDS para conectar-se ao site remoto, é possível ativar a compatibilidade 
do Contribute, mas é necessário personalizar sua conexão antes de compartilhá-la com 
usuários do Contribute.

■ Se seu servidor da Web for um computador local, você precisará configurar o site 
utilizando uma conexão FTP ou de rede com o seu computador (em vez de um caminho 
de pasta local apenas) para poder compartilhar sua conexão com os usuários do 
Contribute.
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Transferência de arquivos de e para um site do 
Contribute 
O Contribute utiliza um sistema semelhante ao sistema Check In/Check Out (Devolver/
retirar) do Dreamweaver para assegurar que somente um usuário por vez possa editar 
determinada página da Web. Quando você ativar a compatibilidade do Contribute no 
Dreamweaver, o sistema Check In/Check Out do Dreamweaver será ativado 
automaticamente.

Para transferir arquivos de e para um site do Contribute por meio do Dreamweaver, utilize 
sempre os comandos Check In (Devolver) e Check Out (Retirar). Se os comandos Put 
(Colocar) e Get (Obter) forem utilizados para transferir arquivos, é possível sobregravar a 
modificação que o usuário do Contribute acabou de fazer em um arquivo.

A retirada de um arquivo de um site Contribute funciona da mesma maneira que em qualquer 
outro site.

Ao devolver um arquivo a um site Contribute, o Dreamweaver efetua uma cópia de backup 
automático da versão do arquivo devolvido anteriormente na pasta _baks e adiciona o nome 
do usuário e um registro temporal a um arquivo do Design Notes, de modo que outros 
usuários possam visualizar quem retornou o arquivo e quando. Para obter mais informações 
sobre cópias de backup, consulte “Permitir aos usuários do Contribute o acesso a modelos sem 
acessar a pasta raiz” na página 212.

Tópicos relacionados
■ “Devolver e retirar arquivos” na página 148
■ “Preparar um site para utilizar com o Contribute” na página 207

Permissões de arquivos e pastas do Contribute no 
servidor
O Contribute oferece uma maneira de gerenciar permissões de arquivo e pasta para cada 
função de usuário definida. Para obter mais informações, consulte Administering Contribute. 
Os usuários do Dreamweaver não são afetados por essas permissões, mas o Contribute 
executará as permissões para os usuários do Contribute.

N
O

T
A

Se o comando Put for utilizado em um site do Contribute, o Dreamweaver verificará o 
arquivo automaticamente e retirará esse arquivo novamente, para evitar que as 
alterações entrem em conflito com as de outros usuários.
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No entanto, o Contribute não oferece uma maneira de gerenciar as permissões de leitura e 
gravação atribuídas a arquivos e pastas pelo servidor. É possível gerenciar essas permissões 
diretamente no servidor. 

É possível imaginar as funções de usuário do Contribute como uma camada das permissões de 
leitura e gravação do servidor. Por exemplo, se um usuário não tiver permissão de gravação em 
uma pasta no servidor, ele não poderá salvar nada nessa pasta, mesmo que seja membro de 
uma função com autorização para gravar na pasta (de acordo com as permissões do 
Contribute).

Se um usuário do Contribute não tiver acesso de leitura no servidor a um arquivo dependente, 
como uma imagem exibida em uma página, o conteúdo do arquivo dependente não aparecerá 
na janela do Contribute. Por exemplo, se um usuário não tiver acesso de leitura a uma pasta de 
imagens, as imagens dessa pasta aparecerão como ícones de imagens rompidos no Contribute. 
Do mesmo modo, os modelos do Dreamweaver são armazenados em uma subpasta da pasta 
raiz do site. Por isso, se um usuário do Contribute não tiver acesso de leitura à pasta raiz, não 
poderá utilizar os modelos desse site, a menos que você copie os modelos para uma pasta 
apropriada.

Ao criar um site, você deve oferecer acesso de leitura a usuários no servidor para a pasta /_mm 
(a subpasta _mm na pasta raiz), pasta /Templates (Modelos) e todas as pastas contendo 
propriedades que os usuários podem necessitar.

Se, por algum motivo, não for possível conceder aos usuários o acesso de leitura à pasta /
Templates, consulte “Permitir aos usuários do Contribute o acesso a modelos sem acessar a 
pasta raiz” na página 212 para fornecer modelos aos usuários.

Arquivos especiais do Contribute 
O Contribute utiliza vários arquivos especiais que não devem ser visualizados pelos visitantes 
do site. Esses arquivos também possibilitam as seguintes ações:

■ O arquivo de configuração compartilhado, que possui um nome ofuscado com uma 
extensão CSI, aparece em uma pasta denominada _mm na pasta raiz do site, e contém 
informações que o Contribute utiliza para gerenciar o site

■ Versões antigas dos arquivos, em pastas denominadas _baks (consulte “Permitir aos 
usuários do Contribute o acesso a modelos sem acessar a pasta raiz” na página 212)

■ Versões temporárias de páginas, de modo que os usuários podem visualizar as alterações
■ Arquivos temporariamente bloqueados, indicando que uma determinada página está 

sendo editada ou visualizada
■ Arquivo de Design Notes contendo metadados sobre as páginas do site
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Em geral, você não deve editar esses arquivos especiais do Contribute utilizando o 
Dreamweaver; o Dreamweaver gerencia-os automaticamente. 

Para que esses arquivos especiais do Contribute não apareçam no servidor acessível ao público, 
você pode configurar um servidor temporário em que os usuários do Contribute possam 
trabalhar com as páginas. Em seguida, é possível copiar periodicamente essas páginas da Web 
do servidor temporário a um servidor de produção na Web. Se este método de servidor 
temporário for utilizado, copie somente as páginas da Web ao servidor de produção, mas não 
os arquivos especiais do Contribute relacionados acima. Em especial, não copiar as pastas 
_mm e _baks ao servidor de produção.

Em alguns casos, pode ser necessário excluir manualmente arquivos especiais do Contribute. 
Por exemplo: pode haver casos em que o Contribute não conseguirá excluir páginas de 
visualização temporárias quando o usuário terminar de visualizar as páginas. Nesse caso, será 
necessário excluir manualmente essas páginas temporárias. As páginas de visualização 
temporárias têm nomes de arquivo que iniciam com TMP.

Do mesmo modo, em alguns casos, um arquivo de bloqueio desatualizado poderá ser mantido 
acidentalmente no servidor. Se isto ocorrer, é preciso excluir manualmente o arquivo de 
bloqueio para permitir que outros usuários possam editar a página. Para obter mais 
informações sobre como excluir arquivos bloqueados, consulte “Desbloquear um arquivo em 
um site do Contribute” na página 213.

Preparar um site para utilizar com o  
Contribute
Antes de utilizar o Dreamweaver para administrar um site do Contribute , ative a 
compatibilidade do Contribute. Dependendo do site ao qual está se conectando, você poderá 
ser automaticamente solicitado a ativar a compatibilidade do Contribute .

N
O

T
A

Para obter informações sobre como configurar um servidor para evitar que os visitantes 
vejam arquivos nas pastas que começam com sublinhado, consulte “Segurança do site” 
em Using Contribute.

N
O

T
A

Quando você ativa a compatibilidade do Contribute, o Dreamweaver ativa 
automaticamente as Design Notes, incluindo a opção Upload Design Notes for Sharing 
(Carregar as Design Notes para compartilhamento), e o sistema de Check In/Check Out 
(Devolver/retirar).
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Para ativar os recursos de compatibilidade do Contribute para um site definido 
do Dreamweaver:

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.
2. Selecione um site e, em seguida, clique em Edit (Editar).

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Clique na guia Advanced (Avançado).

4. Selecione a categoria do Contribute na lista Category (Categoria) à esquerda.

5. Selecione a opção Enable Contribute Compatibility (Ativar compatibilidade do 
Contribute) e preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda).
6. Clique em OK para fechar a caixa de diálogo Site Definition.

7. Clique em Done (Concluído) para fechar a caixa de diálogo Manage Sites.

Tópicos relacionados
■ “Conexão de site para compatibilidade com o Contribute” na página 204

Administrar um site do Contribute 
utilizando o Dreamweaver
Após ativar a compatibilidade do Contribute (consulte “Preparar um site para utilizar com o 
Contribute” na página 207), você poderá utilizar o Dreamweaver para iniciar o Contribute e 
executar tarefas de administração do site.

Como administrador de um site do Contribute, você pode executar qualquer uma destas 
tarefas:

■ Alterar as configurações administrativas do site inteiro.
As configurações administrativas do Contribute são uma coleção de configurações que se 
aplicam a todos os usuários do site da Web. Essas configurações permitem que você faça o 
ajuste fino do Contribute a fim de fornecer uma melhor experiência ao usuário. 

■ Alterar as permissões concedidas às funções de usuário do Contribute.

N
O

T
A

O Contribute e o Dreamweaver devem estar instalados na mesma máquina.
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■ Configurar os usuários do Contribute. 
Os usuários do Contribute precisam de certas informações sobre o site para poder se 
conectar a ele: É possível agrupar todas essas informações em um arquivo chamado chave 
de conexão para enviar para os usuários do Contribute.

Para administrar um site do Contribute na Web no Dreamweaver:

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.
2. Selecione um site e, em seguida, clique em Edit (Editar).

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Clique na guia Advanced (Avançado).

4. Selecione uma categoria do Contribute na lista de categorias à esquerda.

5. Clique no botão Administer Site in Contribute (Administrar site no Contribute).

6. Se solicitado, digite a senha de administrador e clique em OK.

A caixa de diálogo Administer Website (Administrar site da Web) é exibida.
7. Siga qualquer um dos procedimentos abaixo:

■ Para alterar as configurações administrativas, selecione uma categoria na lista à 
esquerda e depois altere as configurações conforme a necessidade.

■ Para alterar as configurações de função, na categoria Users and Roles (Usuários e 
funções), clique no botão Edit Role Settings (Editar configurações de função) e depois 
faça alterações segundo a necessidade.

N
O

T
A

Uma chave de conexão não é o mesmo que um arquivo do site do Dreamweaver 
exportado. Para exportar informações sobre um site para utilizar com o 
Dreamweaver, consulte“Importar e exportar sites” na página 147.

D
IC

A

Antes de fornecer aos usuários do Contribute as informações de conexão 
necessárias para editar páginas, utilize o Dreamweaver para criar a hierarquia de 
pastas básicas para o site (consulte “Estrutura de site e projeto de página de um site 
do Contribute” na página 202) e para criar todas as folhas de estilos CSS e os 
modelos necessários para o site (consulte “Criar modelos para um site do 
Contribute” na página 344).

N
O

T
A

Esse botão não será exibido se você não tiver ativado a compatibilidade do 
Contribute. Para obter informações sobre como ativar esta opção, consulte 
“Preparar um site para utilizar com o Contribute” na página 207.
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■ Para enviar uma chave de conexão para configurar usuários, na categoria Users and 
Roles, clique no botão Send Connection Key (Enviar chave de conexão) e preencha o 
Connection Wizard (Assistente de conexão). 

8. Clique em Close (Fechar) para fechar a caixa de diálogo Administer Website.

9. Clique em OK para fechar a caixa de diálogo Site Definition.

10. Clique em Done (Concluído) para fechar a caixa de diálogo Edit Sites (Editar sites).

Tópicos relacionados
■ “Gerenciar arquivos do Contribute utilizando o Dreamweaver” na página 210

Gerenciar arquivos do Contribute 
utilizando o Dreamweaver
A maioria das funcionalidades do Dreamweaver funciona tão bem em um site do Contribute 
quanto em qualquer outro site. No entanto, ao utilizar o Dreamweaver com um site do 
Contribute, o Dreamweaver realiza automaticamente determinadas operações de 
gerenciamento de arquivos, como salvar múltiplas revisões de um documento e registrar certos 
eventos no console do CPS. 

Esta seção descreve os aspectos do trabalho com arquivos em um site do Contribute que 
diferem em relação a outros sites.

Para obter informações sobre a transferência de arquivos de e para um site do Contribute, 
consulte “Transferência de arquivos de e para um site do Contribute” na página 205. Para 
obter informações sobre arquivos especiais do Contribute, consulte “Arquivos especiais do 
Contribute” na página 206.

D
IC

A

Para obter mais informações sobre as configurações administrativas, 
gerenciamento de funções de usuário e criação de uma chave de conexão, 
consulte Using Contribute.

N
O

T
A

Um administrador do Contribute pode designar usuários a funções  e pode especificar 
quais ações os membros de cada função podem executar. Ao utilizar o Dreamweaver 
para gerenciar arquivos em um site do Contribute, as restrições baseadas em funções 
não são aplicáveis no seu caso; as únicas restrições aplicáveis são as permissões de 
leitura e gravação no servidor. Para obter mais informações sobre os diferentes tipos de 
permissões, consulte “Permissões de arquivos e pastas do Contribute no servidor” na 
página 205.
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Excluir, mover ou renomear um arquivo remoto em 
um site do Contribute
Excluir um arquivo do servidor remoto que está hospedando um site Contribute é quase o 
mesmo que excluir um arquivo do servidor em qualquer site Dreamweaver. No entanto, ao 
excluir um arquivo de um site Contribute, o Dreamweaver perguntará se você deseja excluir 
todas as versões anteriores do arquivo. Se você desejar manter as versões anteriores, o 
Dreamweaver salvará também uma cópia da versão atual, para que seja possível recuperá-la 
mais tarde.

Renomear um arquivo ou movê-lo de uma pasta para outra em um site Contribute funciona 
da mesma maneira como em qualquer site Dreamweaver. Em um site do Contribute, o 
Dreamweaver também renomeia ou move as versões anteriores do arquivo correspondentes 
salvas na pasta _baks.

Para excluir um arquivo remoto:

1. Selecione o arquivo na janela remota do painel Files (Arquivos), em Window (Janela) > 
Files, e pressione Backspace (Windows) ou Delete (Macintosh).

Será exibida uma caixa de diálogo perguntando se você deseja excluir o arquivo.
2. Se a opção Delete Rollback Versions (Excluir versões anteriores) aparecer na caixa de 

diálogo de confirmação, siga um destes procedimentos:

■ Para excluir todas as versões anteriores do arquivo, bem como da versão atual, 
selecione a opção Delete Rollback Versions.

■ Para manter as versões anteriores do servidor, desmarque a opção Delete Rollback 
Versions.

3. Clique em Yes (Sim) para excluir o arquivo.

O arquivo será excluído. Se você optar por excluir as versões anteriores, elas também serão 
excluídas. Se você preferir não excluir as versões anteriores, uma cópia da versão atual será 
salva na pasta _baks como uma nova revisão do arquivo.

Tópicos relacionados
■ “Permitir aos usuários do Contribute o acesso a modelos sem acessar a pasta raiz” na 

página 212
■ “Desbloquear um arquivo em um site do Contribute” na página 213
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Permitir aos usuários do Contribute o acesso a 
modelos sem acessar a pasta raiz
Em um site do Contribute, você gerencia permissões de arquivo e pasta subjacentes 
diretamente no servidor. Para obter mais informações, consulte “Permissões de arquivos e 
pastas do Contribute no servidor” na página 205.

Ao configurar um site, seria adequado oferecer acesso de leitura a usuários no servidor para a 
pasta /_mm (a subpasta _mm na pasta raiz), pasta /Templates (Modelos) e todas as pastas 
contendo propriedades de que os usuários podem necessitar. Também é aconselhável dar aos 
usuários acesso de leitura no servidor para a pasta /Templates.

Mesmo se, por algum motivo, não for possível conceder aos usuários o acesso de leitura à pasta 
/Templates, você poderá tornar os modelos disponíveis para eles.

Para permitir que os usuários do Contribute utilizem modelos sem acesso de 
leitura à pasta raiz do site principal:

1. Configure o site do Contribute de modo que a pasta raiz seja a pasta a ser visualizada pelos 
usuários como raiz.

2. Copie manualmente a pasta de modelos da pasta raiz do site principal para a pasta raiz do 
site do Contribute utilizando o painel Files (Arquivos).

3. Após atualizar os modelos do site principal, copie novamente os modelos modificados em 
subpastas apropriadas, conforme necessário. 

Se este método for utilizado, não utilize os links relativos ao site raiz nas subpastas. Os links 
relativos à raiz do site são relativos à pasta raiz principal do servidor, não à pasta raiz definida 
no Dreamweaver. Os usuários do Contribute não podem criar links relativos à raiz do site. 
Para obter mais informações sobre links relativos à raiz do site, consulte “Localizações e 
caminhos dos documentos” na página 462.

Se os links em uma página do Contribute parecerem rompidos, é possível que haja um 
problema com as permissões da pasta, especialmente se os links levarem a páginas que 
estiverem fora da pasta raiz do usuário do Contribute. Verifique as permissões de leitura e 
gravação das pastas no servidor.
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Desbloquear um arquivo em um site do Contribute
Às vezes, um arquivo remoto em um site do Contribute parece ter sido retirado, mas, na 
verdade, ele está bloqueado no computador do usuário. Quando isso ocorrer, desbloqueie o 
arquivo para que os usuários possam editá-lo.

Para desbloquear a retirada de um arquivo:

1. Siga um dos procedimentos abaixo:

■ Abra o arquivo na janela Document (Documento) e, em seguida, selecione Site > 
Undo Check Out (Desfazer a retirada).

■ No painel Files (Arquivos), em Window (Janela) > Files, clique com o botão direito do 
mouse (no Windows) ou pressione a tecla Control (no Macintosh) e, em seguida, 
selecione Undo Check Out.

Uma caixa de diálogo pode ser exibida indicando quem retirou o arquivo e solicitando que 
você confirme se deseja desbloqueá-lo.

2. Se a caixa de diálogo for exibida, clique em Yes (Sim) para confirmar.

O arquivo será desbloqueado no servidor.

Registrar eventos
Se o CPS (Servidor de publicação do Contribute, Contribute Publishing Server) estiver 
ativado no site remoto ao qual você está se conectando, o Dreamweaver enviará uma 
notificação ao CPS sempre que você disparar uma operação de rede como devolução, reversão 
ou publicação de um arquivo. O CPS registrará esses eventos, e você poderá visualizar o 
registro no console de administração do CPS.

Para iniciar o registro de eventos:

■ Ative os recursos de compatibilidade do Contribute no Dreamweaver.
Para obter mais informações, consulte “Preparar um site para utilizar com o Contribute” 
na página 207.

N
O

T
A

Para seguir esse procedimento, certifique-se de que o arquivo tenha sido realmente 
retirado. Se um arquivo for desbloqueado enquanto um usuário do Contribute o estiver 
editando, diversos usuários poderão editar o arquivo ao mesmo tempo.

N
O

T
A

O CPS é ativado com o Contribute. Para obter mais informações, consulte 
Administering Contribute.
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Para exibir o registro de eventos:

■ Alterne para o console de administração do CPS. 
Para obter mais informações, consulte Administering Contribute. 

Para interromper o registro de eventos:

■ Desative os recursos de compatibilidade do Contribute.

Solucionar problemas de um site do 
Contribute 
Se você encontrar um problema em um site doContribute, consulte os tópicos específicos a 
seguir para obter informações sobre como solucionar o problema:

■ Para problemas relacionados a um site do Contribute, consulte “Solução de problemas de 
conexão em um site do Contribute” na página 214.

■ Para problemas de uso das ferramentas de administração, consulte “Solução de problemas 
de ferramentas administrativas do Contribute” na página 215.

Para obter mais informações sobre solução de problemas, consulte a seção de solução de 
problemas em Administrar o Contribute.

Solução de problemas de conexão em um site do 
Contribute
Quando você clica em qualquer botão relacionado à administração do site do Contribute, o 
Dreamweaver verifica se é possível conectar-se ao site remoto e se a opção Site Root URL 
(URL raiz do site) fornecida para o site é válida. Se o Dreamweaver não puder se conectar ou 
se a URL não for válida, será exibida uma mensagem de erro.

Para verificar uma conexão ao Contribute:

1. Verifique a opção Site Root URL na categoria Contribute da caixa de diálogo Site 
Definition (Definição de site) abrindo essa URL em um navegador para certificar-se de que 
a página correta seja aberta.

2. Utilize o botão Test (Testar) na categoria Remote Info (Informações remotas) da caixa de 
diálogo Site Definition para se certificar de que é possível estabelecer conexão com o site.

3. Se a URL estiver correta mas o botão Test resultar em uma mensagem de erro, peça ajuda 
ao administrador do sistema.
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Solução de problemas de ferramentas 
administrativas do Contribute
Se as ferramentas administrativas não estiverem funcionando corretamente, talvez haja um 
problema na pasta _mm.

Para verificar a pasta _mm:

1. No servidor, assegure-se de que existe permissão de leitura e gravação, além de permissões 
executáveis, se necessário, para a pasta _mm

2. Verifique se a pasta _mm contém um arquivo de configurações compartilhadas com uma 
extensão CSI.

3. Se não contiver, utilize o Connection Wizard (Assistente de conexão) (no Windows) ou 
Connection Assistant (Assistente de conexão) (no Macintosh) para criar uma conexão ao 
site e tornar-se um administrador do site. 

O arquivo de configuração compartilhado é criado automaticamente ao se tornar um 
administrador. Para obter mais informações sobre como tornar-se um administrador para 
um site do Contribute já existente, consulte Administering Contribute.

Tópicos relacionados
■ “Solução de problemas de conexão em um site do Contribute” na página 214
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PARTE 3

Criar layouts de página
Utilize as ferramentas de projeto visual do Macromedia Dreamweaver 8 
para criar layouts de página sofisticados.

Esta seção contém os seguintes capítulos:
Capítulo 7: Criar layouts de páginas com CSS  . . . . . . . . . . . . . . . 219

Capítulo 8: Apresentar conteúdo com tabelas. . . . . . . . . . . . . . . 257

Capítulo 9: Criação de páginas no modo Layout  . . . . . . . . . . . . 283

Capítulo 10: Utilização de quadros . . . . . . . . . . . . . . . . . . . . . . . . . 303

Capítulo 11: Gerenciar modelos . . . . . . . . . . . . . . . . . . . . . . . . . . . . 325
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CAPÍTULO 7

Criar layouts de páginas com 
CSS
No Macromedia Dreamweaver 8, você pode utilizar estilos CSS para definir o layout das 
páginas. Você pode inserir tags div manualmente e aplicar os estilos de posicionamento CSS a 
elas, ou utilizar as camadas do Dreamweaver para criar um layout. No Dreamweaver, uma 
camada é um elemento da página HTML — especificamente uma tag div ou qualquer outra 
tag — à qual foi atribuída uma posição absoluta.

Independentemente da utilização de CSS, tabelas ou quadros para definir o layout das 
páginas, o Dreamweaver contém réguas e grades para a orientação visual no layout. O 
Dreamweaver também contém um recurso de imagem de rastreamento, que você pode utilizar 
para recriar um projeto de página criado em um aplicativo gráfico.

Este capítulo contém as seguintes seções:
Sobre camadas no Dreamweaver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 220

Inserir uma camada  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .222

Definir propriedades e preferências de camadas . . . . . . . . . . . . . . . . . . . . . . . . . . . .225

Gerenciar camadas  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .227

Manipular camadas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230

Converter camadas em tabelas. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .233

N
O

T
A

O Dreamweaver trata como camadas todas as tags div com posição absoluta, mesmo 
que você não tenha criado essas tags div utilizando a ferramenta de desenho Layer.

D
IC

A

Você pode utilizar um arquivo de projetos do Dreamweaver como um ponto de partida 
para o layout CSS. Na categoria Page Designs (CSS) (Projetos de página [CSS]) da 
caixa de diálogo New Document (Novo documento), selecione um arquivo (consulte 
“Criar um documento com base em um arquivo de projeto do Dreamweaver” na 
página 103).

N
O

T
A

Se você não estiver familiarizado com o uso de camadas e com as folhas de estilo em 
cascata (CSS), mas estiver familiarizado com o uso de tabelas, experimente utilizar 
tabelas ou o modo Layout para o layout da página (consulte “Apresentar conteúdo 
com tabelas” na página 257 e “Criação de páginas no modo Layout” na página 283).
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Animar camadas. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .235

Inserir tags div no layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 244

Trabalhar com tags div no layout  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .246

Alterar a cor de realce de tags div. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .247

Trabalhar com visualização de layout CSS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .248

Utilizar réguas, guias e grades para definir o layout de páginas. . . . . . . . . . . . . . . 250

Utilizar uma imagem de rastreamento . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 254

Sobre camadas no  Dreamweaver
Uma camada é um elemento da página HTML — especificamente uma tag div ou qualquer 
outra tag — à qual foi atribuída uma posição absoluta. Elas podem conter texto, imagens ou 
qualquer outro conteúdo que possa ser inserido no corpo de um documento HTML.

Camadas
Com o Dreamweaver, você pode utilizar camadas para definir o layout da página. Você pode 
colocar as camadas na frente ou atrás de outras, ocultá-las enquanto outras são exibidas e 
movê-las na tela. Coloque uma imagem de fundo em uma camada e, em seguida, uma 
segunda camada contendo texto com um fundo transparente na frente da primeira camada.

As camadas oferecem bastante flexibilidade para inserir conteúdo. Contudo, os visitantes do 
site que tiverem navegadores da Web muito antigos poderiam ter problemas para visualizar as 
camadas. Para garantir que todos possam visualizar a sua página da Web, conceba o layout da 
página com camadas e, em seguida, converta-as em tabelas. Para obter mais informações, 
consulte “Converter camadas em tabelas” na página 233. Contudo, se for provável que o seu 
público esteja utilizando um navegador recente, crie layouts apenas com as camadas, sem 
convertê-las em tabelas.

Tópicos relacionados
■ “Gerenciar camadas” na página 227

N
O

T
A

As camadas, conforme descrito neste capítulo, referem-se ao conceito de layout do 
Dreamweaver, não à tag layer.
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Código HTML das camadas
Quando se coloca uma camada em um documento, o Dreamweaver insere a tag HTML 
correspondente à camada no código. Como padrão, o Dreamweaver cria as camadas 
utilizando a tag div.

Quando você desenha uma camada utilizando a ferramenta Draw Layer (Desenhar camada), o 
Dreamweaver insere uma tag div no documento e atribui à camada um valor de identificação 
(por padrão, Layer1 (Camada1) para a primeira camada desenhada, Layer2 (Camada2) para a 
segunda camada desenhada e assim por diante). Mais tarde, você poderá renomear a camada 
com o nome desejado utilizando o painel Layers (Camadas) ou o Property inspector (Inspetor 
de propriedades). O Dreamweaver também utiliza CSS incorporado na seção head do 
documento para posicionar a camada e determinar as dimensões exatas da camada.

A seguir, apresentamos um exemplo de código HTML para uma camada:
<head>
<meta http-equiv="Content-Type" content="text/html; charset=iso-8859-1" />
<title>Sample Layers Page</title>
<style type="text/css">
<!--
#Layer1 {

position:absolute;
left:62px;
top:67px;
width:421px;
height:188px;
z-index:1;

}
-->
</style>
</head>

<body>
<div id="Layer1"></div>
</body>
</html>

Você pode definir as propriedades das camadas na página, inclusive as coordenadas x e y, o 
índice z (ou ordem de empilhamento), além da visibilidade. Para obter mais informações, 
consulte “Definir propriedades e preferências de camadas” na página 225.

N
O

T
A

Existem duas outras tags que podem ser utilizadas na criação de camadas: layer e 
ilayer. Contudo, essas tags são aceitas apenas no Netscape Navigator 4; o Internet 
Explorer não oferece suporte a essas tags e o Netscape deixou de oferecê-lo nas 
versões posteriores. O Dreamweaver reconhece as tags layer e ilayer, mas não cria 
camadas utilizando-as.
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Tópicos relacionados
■ “Camadas” na página 220

Inserir uma camada 
O Dreamweaver permite criar, com facilidade, camadas na página e posicioná-las com 
precisão. Ele também permite criar camadas aninhadas. Para obter mais informações, consulte 
“Camadas aninhadas” na página 223.

Quando você insere uma camada, o Dreamweaver exibe a borda da camada, por padrão, e 
realça o bloco quando se passa o ponteiro sobre ele. Você pode ativar bordas de camadas 
desativando as opções Layer Outlines (Contornos de camadas) e CSS Layout Outlines 
(Contornos de layout CSS) no menu View (Exibir) > Visual Aids (Auxílios visuais). Você 
também pode ativar níveis e o modelo de caixa para as camadas como auxílios visuais 
enquanto está projetando. Para obter mais informações, consulte “Trabalhar com visualização 
de layout CSS” na página 248.

Para alterar a cor de realce de uma camada ou desativar o realce, consulte “Alterar a cor de 
realce de tags div” na página 247.

Depois de criar uma camada, para adicionar conteúdo a ela, coloque o ponto de inserção na 
camada e adicione o conteúdo como faria em uma página.

Para desenhar uma única camada ou várias camadas consecutivamente:

1. Na categoria Layout da barra Insert, clique no botão Expanded Tables Mode (Modo de 
tabelas expandidas).

2. Na visualização do projeto da janela do documento, siga um destes procedimentos:

■ Arraste para desenhar uma única camada.
■ Mantenha a tecla Control (no Windows) ou Command (no Macintosh) pressionada e 

arraste para desenhar várias camadas consecutivamente.
Você pode continuar a desenhar novas camadas, contanto que não solte a tecla Control 
ou Command.

N
O

T
A

Você pode utilizar um arquivo de projetos do Dreamweaver como um ponto de partida 
para o layout CSS. Na categoria Page Designs (CSS) da caixa de diálogo New 
Document, selecione um arquivo (consulte “Criar um documento com base em um 
arquivo de projeto do Dreamweaver” na página 103).
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Para inserir uma camada em um local específico do documento:

■ Coloque o ponto de inserção na janela do documento e selecione Insert> Layout Objects 
(Objetos de Layout) > Layer.

Para colocar o ponto de inserção em uma camada:

■ Clique em qualquer ponto dentro das bordas da camada.

As bordas da camada serão realçadas e a alça de seleção aparecerá, mas a camada não estará 
selecionada. Para obter informações sobre como selecionar as camadas, consulte “Selecionar 
camadas” na página 227.

Para exibir as bordas das camadas:

■ Selecione View> Visual Aids e, em seguida, selecione Layer Outlines ou CSS Layout 
Outlines.

Para ocultar bordas de camadas:

■ Selecione View > Visual Aids e depois desmarque Layer Outlines e CSS Layout Outlines.

Tópicos relacionados
■ “Definir propriedades e preferências de camadas” na página 225
■ “Gerenciar camadas” na página 227
■ “Manipular camadas” na página 230

Camadas aninhadas
A camada aninhada é aquela cujo código está contido em uma outra camada. O aninhamento 
é utilizado regularmente para agrupar as camadas. Uma camada aninhada se move com a sua 
camada-mãe e pode ser definida para herdar a visibilidade da mãe. 

N
O

T
A

Esse procedimento coloca a tag da camada onde você clicou na janela do 
documento. Portanto, o processamento visual da camada pode afetar outros 
elementos da página (como texto) que a circundam.

N
O

T
A

A seleção simultânea das duas opções terá o mesmo efeito.
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Você pode ativar a opção Nesting (Aninhamento) para aninhar automaticamente quando 
desenhar uma camada que comece dentro de outra camada.

Para desenhar uma camada aninhada:

1. Na categoria Layout da barra Insert, clique no botão Expanded Tables Mode. 

2. Na visualização do projeto na janela do documento, arraste para desenhar uma camada 
dentro de uma camada existente:

Se a opção Nesting estiver desativada nas preferências de camadas, mantenha pressionada a 
tecla Alt (no Windows) ou Option (no Macintosh) e arraste para aninhar uma camada 
dentro de outra já existente.

Para inserir uma camada aninhada:

■ Coloque o ponto de inserção dentro de uma camada existente na visualização do projeto 
na janela do documento e selecione Insert > Layer.

Para aninhar uma camada existente dentro de uma outra camada utilizando o 
painel Layers:

1. Selecione Window (Janela) > Layers para abrir o painel Layers.

2. Selecione uma camada no painel Layers, pressione a tecla Control (no Windows) ou 
Command (no Macintosh) e arraste-a até a camada de destino no painel Layers. 

3. Solte o botão do mouse quando o nome da camada de destino for realçado.

Para aninhar camadas automaticamente ao desenhar uma camada que 
comece dentro de outra:

■ Selecione a opção Nesting (Aninhamento) nas preferências de camadas.
Para obter mais informações, consulte “Definir preferências de camadas” na página 225.

D
IC

A

Você pode que as camadas aninhadas sejam exibidas de maneira diferente nos 
diversos navegadores. Ao criar camadas aninhadas, verifique com freqüência a sua 
aparência em diversos navegadores durante o processo de criação.
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Tópicos relacionados
■ “Inserir uma camada” na página 222
■ “Gerenciar camadas” na página 227
■ “Manipular camadas” na página 230

Definir propriedades e preferências de 
camadas 
Você pode especificar definições padrão para camadas. Você pode também exibir e definir 
vários atributos de uma ou mais camadas utilizando o Property inspector.

Definir preferências de camadas
Utilize a categoria Layers na caixa de diálogo Preferences (Preferências) para especificar as 
definições padrão das novas camadas criadas.

Para exibir ou definir as preferências de camadas:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences será exibida.
2. Na lista Category (Categoria) à esquerda, selecione Layers.

3. Faça as alterações necessárias.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

Tópicos relacionados
■ “Exibir e definir as propriedades de diversas camadas” na página 226

Exibir e definir propriedades de uma única camada
Quando você seleciona uma camada, o Property inspector exibe as propriedades dessa 
camada.

Para exibir e definir propriedades de camadas:

1. Selecione uma camada (consulte “Selecionar camadas” na página 227).
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2. No Property inspector, em Window > Properties (Propriedades), clique na seta de 
expansão, no lado inferior direito, se ela ainda não estiver expandida, para ver todas as 
propriedades. 

3. Altere os atributos da camada definindo as propriedades como necessário.

Para obter mais informações, clique no botão Help do Property inspector.

Tópicos relacionados
■ “Definir preferências de camadas” na página 225
■ “Gerenciar camadas” na página 227

Exibir e definir as propriedades de diversas camadas
Quando você selecionar duas ou mais camadas, o Property inspector das camadas exibirá as 
propriedades de texto e um subconjunto de todas as propriedades das camadas, o que permite 
modificar várias camadas simultaneamente.

Para selecionar diversas camadas: 

■ Mantenha pressionada a tecla Shift enquanto seleciona as camadas (consulte “Selecionar 
camadas” na página 227).

Para exibir e definir propriedades para diversas camadas:

1. Selecione diversas camadas.

2. No Property inspector, em Window > Properties, clique na seta de expansão, no lado 
inferior direito, se ela ainda não estiver expandida, para ver todas as propriedades. 

3. Altere os atributos das camadas, definindo as propriedades.

Para obter mais informações, clique no botão Help do Property inspector.

Tópicos relacionados
■ “Definir preferências de camadas” na página 225
■ “Exibir e definir propriedades de uma única camada” na página 225
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Gerenciar camadas
Você pode selecionar camadas para trabalhar com elas. Você também pode alterar a ordem de 
empilhamento e a visibilidade das camadas. O painel Layers fornece uma maneira 
conveniente de gerenciar camadas.

Utilizar o painel Layers 
O painel Layers é um meio de gerenciar as camadas dos documentos. Utilize o painel Layers 
para evitar sobreposições, alterar a visibilidade das camadas, aninhar ou empilhar camadas e 
selecionar uma ou mais camadas.

Para abrir o painel Layers:

■ Selecione Window  > Layers.

As camadas são exibidas como uma lista de nomes organizada de acordo com o índice z. Por 
padrão, a primeira camada criada (com um índice z igual a 1) é mostrada na parte inferior da 
lista, enquanto que a camada criada mais recentemente (com um índice z superior a 1) é 
mostrada no alto da lista. No entanto, você pode alterar o índice z de uma camada para alterar 
seu lugar na ordem de empilhamento. Por exemplo, se você tiver criado oito camadas e quiser 
que a quarta camada passe a ser a camada “superior” da ordem de empilhamento, será possível 
atribuir-lhe um índice z superior ao das demais camadas.

Para obter mais informações sobre como utilizar o painel Layers, consulte os seguintes tópicos:

■ “Inserir uma camada” na página 222
■ “Selecionar camadas” na página 227
■ “Alterar a ordem de empilhamento de camadas” na página 228
■ “Alterar a visibilidade das camadas” na página 229
■ “Evitar sobreposições de camadas” na página 233

Selecionar camadas
Selecione uma ou mais camadas para manipulá-las ou alterar as suas propriedades.

Para selecionar uma camada no painel Layers:

■ No painel Layers, em Window > Layers, clique no nome da camada.

Para selecionar uma camada na janela do documento, siga um destes 
procedimentos:

■ Clique na alça de seleção da camada. 
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Se a alça de seleção não estiver visível, clique em qualquer ponto dentro da camada para 
tornar a alça visível. 

■ Clique na borda de uma camada. 
■ Mantenha pressionadas as teclas Control-Shift (no Windows) ou Command-Shift (no 

Macintosh) e clique dentro de uma camada.
■ Clique dentro de uma camada e pressione Control+A (Windows) ou Command+A 

(Macintosh) para selecionar o conteúdo da camada. Pressione Control+A ou 
Command+A novamente para selecionar a camada.

■ Clique dentro de uma camada e selecione a tag no seletor de tags.

Para selecionar camadas múltiplas, siga um dos procedimentos abaixo:

■ No painel Layers (Window > Layers), pressione a tecla Shift e clique em dois ou mais 
nomes de camadas.

■ Na janela do documento, pressione a tecla Shift e clique dentro ou sobre a borda de duas 
ou mais camadas.

Tópicos relacionados
■ “Inserir uma camada” na página 222
■ “Definir propriedades e preferências de camadas” na página 225
■ “Gerenciar camadas” na página 227
■ “Manipular camadas” na página 230

Alterar a ordem de empilhamento de camadas
Utilize o Property inspector ou o painel Layers para alterar a ordem de empilhamento das 
camadas. A camada na parte superior do painel Layers está situada no alto da ordem de 
empilhamento e aparecerá na frente das outras camadas.

No código HTML, a ordem de empilhamento das camadas, ou índice z, determina a ordem 
segundo a qual elas serão desenhadas em um navegador. Quanto maior for o índice z de uma 
camada, mais alta será a posição da camada na ordem de empilhamento. O índice z de cada 
camada pode ser alterado no Property inspector ou no painel Layers.
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Para alterar a ordem de empilhamento das camadas no painel Layers:

1. Selecione Window > Layers para abrir o painel Layers.

2. Arraste uma camada para cima ou para baixo, de acordo com a ordem de empilhamento 
desejada.

À medida que a camada for movida, aparecerá uma linha que indica o local onde será 
colocada a camada. Solte o botão do mouse quando a linha de colocação aparecer no 
ponto desejado da ordem de empilhamento.

Para alterar a ordem de empilhamento das camadas com o Property 
inspector:

1. Selecione Window  > Layers para abrir o painel Layers e ver a ordem de 
empilhamento atual.

2. Selecione uma camada no painel ou na janela do documento.

3. No Property inspector da camada, em Window > Properties, digite um número na caixa 
de texto Z-index (Índice Z). 

■ Digite um número mais alto, para mover a camada até uma posição superior na ordem 
de empilhamento.

■ Digite um número mais baixo, para mover a camada até uma posição inferior na 
ordem de empilhamento.

Tópicos relacionados
■ “Utilizar o painel Layers” na página 227
■ “Selecionar camadas” na página 227

Alterar a visibilidade das camadas
Ao trabalhar em um documento, você poderá mostrar ou ocultar as camadas manualmente 
com o painel Layers, para examinar a aparência da página em diversas condições. 

Para alterar a visibilidade de uma camada:

1. Selecione Window  > Layers para abrir o painel Layers.

2. Clique na coluna do ícone representando um olho para alterar a sua visibilidade.

■ Um olho aberto significa que a camada está visível. 
■ Um olho fechado significa que a camada está invisível. 

N
O

T
A

A camada selecionada ficará sempre visível e aparecerá na frente das outras camadas 
enquanto estiver selecionada.
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■ Se não houver um ícone representando um olho, lembre-se de que a camada costuma 
herdar as definições de visibilidade da camada-mãe. Quando as camadas não estiverem 
aninhadas, a camada-mãe será o corpo do documento, que está sempre visível. 
O ícone representando um olho estará ausente quando não for especificada uma 
visibilidade, que aparecerá no Property inspector como visibilidade padrão. 

Para alterar a visibilidade de todas as camadas simultaneamente: 

■ No painel Layers (Window > Layers), clique no ícone do olho do cabeçalho, na parte 
superior da coluna.

Tópicos relacionados
■ “Utilizar o painel Layers” na página 227
■ “Alterar a ordem de empilhamento de camadas” na página 228

Manipular camadas
As camadas podem ser selecionadas, movidas, redimensionadas ou alinhadas durante o 
trabalho no layout da página. É necessário selecionar uma camada, para poder mover, 
redimensionar ou alinhá-la.

Para evitar que as camadas se sobreponham quando forem movidas ou redimensionadas, 
utilize a opção Prevent Overlap (Evitar sobreposições). Consulte “Evitar sobreposições de 
camadas” na página 233.

Redimensionar camadas
Você pode redimensionar uma única camada ou várias camadas simultaneamente para torná-
las iguais às suas larguras e alturas.

N
O

T
A

Esse procedimento poderá tornar todas as camadas visíveis ou ocultas, mas estas 
não poderão herdar a visibilidade da mãe.
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Se a opção Prevent Overlaps estiver ativada, você não poderá redimensionar uma camada para 
que esta se sobreponha a outra. Consulte “Evitar sobreposições de camadas” na página 233.

Para redimensionar uma camada:

1. Na visualização do projeto, selecione uma camada (consulte “Selecionar camadas” na 
página 227). 

2. Siga um deste procedimentos para redimensionar a camada:

■ Para redimensionar arrastando o cursor, arraste qualquer uma das alças de 
redimensionamento da camada.

■ Para redimensionar um pixel por vez, pressione a tecla Control (no Windows) ou 
Option (no Macintosh) e uma das teclas de seta.
As teclas de seta moverão a borda direita e inferior da camada. Essa técnica não 
permite redimensionar a camada utilizando as bordas superior e esquerda.

■ Para redimensionar de acordo com o incremento de encaixe na grade, mantenha 
pressionadas as teclas Shift-Control (no Windows) ou Shift-Option (no Macintosh) e 
uma das teclas de seta. 
Para obter informações sobre a definição de incrementos de encaixe na grade, consulte 
“Utilizar uma imagem de rastreamento” na página 254.

■ No Property inspector, em Window > Properties, digite os valores da largura (W - 
Width) e altura (H - Height).

O redimensionamento de uma camada irá alterar a sua largura e altura. Ele não definirá a 
extensão do conteúdo da camada que estará visível. Para definir a região visível de uma 
camada, consulte “Definir propriedades e preferências de camadas” na página 225.

Para redimensionar diversas camadas simultaneamente:

1. Na visualização do projeto, selecione duas ou mais camadas (consulte “Selecionar camadas” 
na página 227). 

2. Siga um dos procedimentos abaixo:

■ Selecione Modify (Modificar) > Align (Alinhar) > Make Same Width (Tornar as 
larguras iguais) ou Modify  > Align > Make Same Height (Tornar as alturas iguais). 
As primeiras camadas selecionadas assumirão a largura ou altura da última camada 
selecionada.

■ No Property inspector, em Window > Properties, em Multiple Layers (Camadas 
múltiplas), digite os valores da largura e altura. 

Os valores serão aplicados a todas as camadas selecionadas.
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Tópicos relacionados
■ “Alinhar camadas” na página 232
■ “Utilizar uma imagem de rastreamento” na página 254

Mover camadas
Você pode mover as camadas na visualização do projeto da mesma maneira que os objetos são 
deslocados na maioria dos aplicativos gráficos básicos.

Se a opção Prevent Overlaps estiver ativa, você não poderá mover uma camada de modo que 
ela se sobreponha a outra. Consulte “Evitar sobreposições de camadas” na página 233.

Para mover uma ou mais camadas selecionadas:

1. Na visualização do projeto, selecione uma camada ou várias camadas (consulte “Selecionar 
camadas” na página 227). 

2. Siga um destes procedimentos:

■ Para mover arrastando, arraste a alça de seleção da última camada selecionada (realçada 
em preto).

■ Para mover um pixel de cada vez, utilize as teclas de seta. 
Mantenha pressionada a tecla Shift e utilize uma das teclas de seta para mover a 
camada de acordo com o incremento de encaixe na grade. Para obter informações 
sobre a definição de incrementos de encaixe na grade, consulte “Utilizar uma imagem 
de rastreamento” na página 254.

Tópicos relacionados
■ “Redimensionar camadas” na página 230
■ “Utilizar uma imagem de rastreamento” na página 254

Alinhar camadas
Utilize os comandos de alinhamento de camadas para alinhar uma ou mais camadas com uma 
borda da última camada selecionada.

Durante o alinhamento de camadas, quando uma camada-mãe for selecionada e movida, 
talvez as camadas secundárias que não tenham sido selecionadas se movam. Para evitar esse 
tipo de problema, não utilize camadas aninhadas.

Para alinhar duas ou mais camadas:

1. Na visualização do projeto, selecione uma camada (consulte “Selecionar camadas” na 
página 227). 
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2. Selecione Modify  > Arrange (Organizar) e escolha uma opção de alinhamento. 

Por exemplo, se você selecionar Top (No alto), todas as camadas se moverão, de maneira 
que as suas bordas superiores assumirão a mesma posição vertical que a borda superior da 
última camada selecionada (realçada em preto).

Tópicos relacionados
■ “Redimensionar camadas” na página 230
■ “Mover camadas” na página 232
■ “Utilizar uma imagem de rastreamento” na página 254

Converter camadas em tabelas
Em vez de utilizar tabelas ou o modo Layout para criar o layout, alguns designers da Web 
preferem trabalhar com camadas. O Dreamweaver permite criar o layout utilizando camadas 
e, se desejar, convertê-las em tabelas. Por exemplo, talvez seja necessário converter suas 
camadas em tabelas, se você precisar de suporte a navegadores anteriores à versão 4.0.

Você pode ajustar o layout e otimizar o desenho da página movimentando-se entre as diversas 
camadas e tabelas. Você não pode converter uma tabela ou uma camada específica de uma 
página; é necessário converter camadas em tabelas e tabelas em camadas de uma página 
inteira. 

Evitar sobreposições de camadas
Uma vez que as células de tabelas não podem se sobrepor, o Dreamweaver não poderá criar 
uma tabela a partir de camadas sobrepostas. Se estiver planejando converter as camadas de um 
documento em tabelas, utilize a opção Prevent Overlap, que restringirá o movimento e o 
posicionamento das camadas de maneira que não haja sobreposição. 

N
O

T
A

As camadas não podem ser convertidas em tabelas ou vice-versa em um modelo de 
documento ou em um documento ao qual tiver sido aplicado um modelo. Em vez disso, 
crie o layout em um documento que não seja um modelo e converta-o antes de salvá-lo 
como um modelo. 

N
O

T
A

A conversão de camadas em tabelas poderá resultar em tabelas com um grande número 
de células vazias.
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Quando esta opção estiver ativada, uma camada não poderá ser criada na frente de uma 
camada existente, nem movida, redimensionada ou aninhada dentro de uma camada 
existente. Caso ative esta opção após criar camadas sobrepostas, arraste cada camada 
sobreposta para afastá-la das outras camadas. O Dreamweaver não corrigirá automaticamente 
as camadas sobrepostas na página quando a opção Prevent Layer Overlaps estiver ativada.

Quando essa opção e o encaixe estiverem ativados, a camada não se encaixará na grade se 
isso acarretar a sobreposição de duas camadas. Em vez disso, ela se encaixará na margem da 
camada mais próxima. 

NOTA Certas ações permitem que as camadas se sobreponham, mesmo quando a 
opção Prevent Overlaps está at ivada. Se você inserir uma camada uti l izando o menu 
Inserir,  digitar números no Property inspector ou reposicionar as camadas editando 
o código-fonte HTML, poderá provocar a sobreposição ou o aninhamento de 
camadas enquanto essa opção estiver ativada. Se as sobreposições ocorrerem, 
arraste as camadas sobrepostas até a visual ização do projeto, a f im de separá-las. 

Para evitar as sobreposições de camadas, siga um dos procedimentos abaixo:

■ No painel Layers, em Window > Layers, selecione a opção Prevent Overlaps.
■ Na janela do documento, selecione Modify  > Arrange > Prevent Layer Overlaps.

Converter entre camadas e tabelas
Você pode criar o layout utilizando camadas e, em seguida, convertê-las em tabelas, para que o 
layout possa ser visualizado nos navegadores mais antigos. 

Antes de converter camadas em tabelas, certifique de que as camadas não estejam sobrepostas 
(consulte “Evitar sobreposições de camadas” na página 233).

Para converter camadas em uma tabela:

1. Selecione Modify  > Convert (Converter) > Layers to Table (Camadas em tabela). 

A caixa de diálogo Convert Layers to Tables é exibida.
2. Selecione as opções desejadas.

Para obter mais informações, clique no botão Help da caixa de diálogo.
3. Clique em OK.

As camadas serão convertidas em uma tabela.

N
O

T
A

Esta é uma nova tabela Note (Nota). Encontra-se anexada a uma tag de parágrafo 
Table_anchor. Para criar uma, copie e cole da página de referência.
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Para converter tabelas em camadas:

1. Selecione Modify  > Convert  > Tables to Layers (Tabelas em camadas).

A caixa de diálogo Convert Tables to Layers (Converter tabelas em camadas) aparece.
2. Selecione as opções desejadas.

Para obter mais informações, clique no botão Help da caixa de diálogo.
3. Clique em OK. 

As tabelas serão convertidas em camadas. As células vazias não serão convertidas em 
camadas, a não ser que elas tenham cores de fundo.

Animar camadas
O termo HTML dinâmico, ou DHTML, refere-se à combinação de HTML com uma 
linguagem de scripts que permite alterar as propriedades de posicionamento ou estilo dos 
elementos HTML. As linhas de tempo do Dreamweaver utilizam HTML dinâmico para 
alterar as propriedades de camadas e imagens ao longo do tempo. Utilize as linhas de tempo 
para criar animações que não requerem nenhum controle ActiveX, plug-ins nem applets Java 
(mas que requerem JavaScript). 

As linhas de tempo permitem alterar a posição, tamanho, visibilidade e ordem de 
empilhamento de uma camada. (As funções de camada das linhas de tempo funcionam apenas 
em navegadores 4.0 ou posteriores.) As linhas de tempo também são úteis para outras ações 
que você deseja que ocorram após a página ser carregada. Por exemplo, as linhas de tempo 
podem alterar o arquivo de origem de uma tag de imagem, de modo que imagens diferentes 
apareçam na página ao longo do tempo.

Para ver o código JavaScript gerado por uma linha de tempo, abra a visualização do código da 
janela do documento. O código da linha de tempo está na função MM_initTimelines, dentro 
de uma tag de script na seção head do documento.

Ao editar o HTML de um documento que contém linhas de tempo, certifique-se de não 
mover, renomear nem excluir nenhum item que seja referenciado por uma linha de tempo. 

N
O

T
A

Os elementos de página que estavam fora das tabelas também serão colocados em 
camadas.

N
O

T
A

A palavra 'dinâmico' pode ter vários significados em diferentes contextos relativos à 
Web. Não confunda HTML dinâmico com a idéia de uma página da Web dinâmica, que 
é uma página da Web gerada dinamicamente por um código do lado do servidor antes 
de ser apresentada a um visitante.
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Utilizar o painel Timelines (Linhas de tempo)
O painel Timelines mostra como as propriedades de camadas e imagens mudam ao longo do 
tempo. Selecione Window > Timelines para abrir o painel Timelines.
 

O menu pop-up Timeline especifica qual das linhas de tempo do documento está sendo 
exibida no painel Timelines.

A cabeça de execuçãomostra qual quadro da linha de tempo está sendo exibido na janela do 
documento.

O número do quadroindica a numeração seqüencial dos quadros. O número do quadro atual 
está entre os botões Back (Voltar) e Play (Executar). Você pode controlar a duração da 
animação ao definir o total de quadros e o número de quadros por segundo (qps). A definição 
padrão de 15 quadros por segundo é uma boa taxa média para usar na maioria dos 
navegadores que estão sendo executados em sistemas comuns Windows e Macintosh.

O menu contextual contém vários comandos relativos à linha de tempo.

O canal Behaviorsé o canal de comportamentos que devem ser executados em um 
determinado quadro da linha de tempo.

As barras Animation mostram a duração da animação de cada objeto. Uma única linha pode 
incluir várias barras que representam objetos diferentes. Barras diferentes não podem controlar 
o mesmo objeto no mesmo quadro.

N
O

T
A

É possível que taxas mais velozes não melhorem o desempenho. Os navegadores 
sempre executam todos os quadros da animação, mesmo que não consigam obter a 
taxa de quadros especificada. A taxa de quadros será ignorada se for superior à que o 
navegador pode suportar.

quadros-chave

canal Behaviors 
(Comportamentos)

menu pop-up Timeline (Linha de tempo)

canal Animation (Animação)

barra Animation (Animação)

cabeça de execução

número do quadro
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Os quadros-chavesão quadros de uma barra, onde você especificou propriedades (como 
posição) para o objeto. O Dreamweaver calcula valores intermediários para os quadros que 
estão entre os quadros-chave. Os quadros-chave são indicados por pequenos círculos.

Os canais Animation exibem barras para camadas e imagens com animações.

Opções de execução
A seguir, são apresentadas as opções de execução para visualizar a animação.

Rewind (Rebobinar)move a cabeça de execução para o primeiro quadro na linha de tempo.

Back move a cabeça de execução um quadro para a esquerda. Clique em Back e mantenha 
pressionado o botão do mouse para executar a linha de tempo para trás.

Play move a cabeça de execução um quadro para a direita. Clique em Play e mantenha 
pressionado o botão do mouse para executar a linha de tempo para frente. 

Autoplay (Execução automática) faz com que a linha de tempo comece a execução 
automaticamente quando a página atual for carregada em um navegador. A opção Autoplay 
anexa um comportamento à tag body da página que executa a ação Play Timeline (Executar 
linha de tempo) quando a página é carregada. 

Loop faz com que a linha de tempo atual fique em loop indefinidamente enquanto a página 
estiver aberta em um navegador. A opção Loop insere o comportamento Go to Timeline 
Frame (Ir para quadro da linha de tempo) no canal Behaviors após o último quadro da 
animação. Clique duas vezes no marcador do comportamento no canal Behaviors para editar 
os parâmetros desse comportamento e alterar o número de loops. 

Mover uma camada utilizando uma animação da linha 
de tempo
O tipo mais comum de animação da linha de tempo envolve a movimentação de uma camada 
ao longo de um caminho. As linhas de tempo só podem mover camadas. Para fazer com que 
imagens ou texto se movam, crie uma camada usando o botão Draw Layer (Desenhar camada) 
na barra Insert e, em seguida, insira na camada imagens, texto ou qualquer outro tipo de 
conteúdo (consulte “Inserir uma camada” na página 222).

As linhas de tempo também podem alterar outros atributos de camadas e imagens. Para obter 
mais informações, consulte “Alterar propriedades de imagens e camadas com linhas de tempo” 
na página 240.
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Para animar uma camada utilizando uma linha de tempo: 

1. Mova a camada para onde deve estar quando a animação começar.

2. Selecione Window  > Timelines. 

3. Selecione a camada que você deseja animar. 

Certifique-se de que selecionou o elemento desejado. Clique no marcador da camada ou 
na alça de seleção da camada, ou utilize o painel Layers para selecionar uma camada. Para 
obter mais informações, consulte “Manipular camadas” na página 230. Quando uma 
camada é selecionada, são exibidas alças ao seu redor, conforme mostrado na ilustração a 
seguir.

Quando você clica na camada, é colocado um ponto de inserção piscante dentro dela, mas 
a camada não é selecionada.

4. Selecione Modify > Timeline > Add Object to Timeline ou simplesmente arraste a camada 
selecionada até o painel Timelines.

É exibida uma barra no primeiro canal da linha de tempo. O nome da camada é 
mostrado na barra.

5. Clique no marcador de quadro-chave mostrado no final da barra.

6. Mova a camada dentro da página para onde ela deverá ir no final da animação. 

É exibida uma linha indicando o caminho da animação na janela do documento.
7. Caso você queira que a camada se mova em curva, selecione a barra de animação e pressione 

a tecla Control (no Windows) ou a tecla Command (no Macintosh) e clique em um quadro 
no meio da barra para adicionar um quadro-chave ao quadro em que você clicou, ou clique 
em um quadro no meio da barra de animação e selecione Add Keyframe (Adicionar 
quadro-chave) no menu contextual.

Repita esta etapa para definir quadros-chave adicionais.

Clique na alça de seleção da camada 
para selecionar a camada

Camada selecionada 
com imagem dentro
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8. Mantenha pressionado o botão Play para visualizar a animação na página. 

Repita o procedimento para adicionar mais camadas e imagens à linha de tempo e criar 
uma animação mais complexa. 

Criar uma linha de tempo arrastando um caminho
Se você quiser criar uma animação com um caminho complexo, talvez seja mais eficiente 
gravar o caminho enquanto arrasta a camada, em vez de criar quadros-chave individuais.

Para criar uma linha de tempo arrastando um caminho:

1. Selecione uma camada.

2. Mova a camada para onde deve estar quando a animação começar.

Certifique-se de ter selecionado a camada; se o ponto de inserção está na camada, isto 
significa que ela não está selecionada. Para selecionar uma camada, clique no marcador da 
camada ou na alça de seleção da camada, ou utilize o painel Layers. Para obter mais 
informações, consulte “Manipular camadas” na página 230.

3. Selecione Modify > Timeline > Record Path of Layer (Gravar caminho da camada).

4. Arraste a camada pela página para criar um caminho.

5. Solte a camada no ponto onde a animação deve parar.

O Dreamweaver adiciona uma barra de animação à linha de tempo, contendo o número 
apropriado de quadros-chave.

6. No painel Timelines, clique no botão Rewind (Rebobinar); depois, mantenha pressionado 
o botão Play para visualizar a animação.

Modificar linhas de tempo
Após definir os componentes básicos de uma linha de tempo, você poderá fazer alterações 
como adição e remoção de quadros, alteração da hora de início da animação, etc.

Para modificar uma linha de tempo, siga um destes procedimentos:

■ Para fazer com que a animação seja executada por mais tempo, arraste para a direita o 
marcador do quadro final. Todos os quadros-chave da animação são deslocados, de modo 
que suas posições relativas permaneçam constantes. Para evitar que os outros quadros-
chave sejam movidos, pressione a tecla Control e arraste o marcador do quadro final.

■ Para fazer com que a camada alcance a posição de um quadro-chave mais cedo ou mais 
tarde, mova o marcador do quadro-chave na barra para a esquerda ou direita. 
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■ Para alterar a hora de início de uma animação, selecione uma ou mais barras associadas à 
animação (pressione Shift para selecionar mais de uma barra simultaneamente) e arraste-
a(s) para a esquerda ou direita.

■ Para mudar a localização do caminho de uma animação inteira, selecione a barra inteira e 
depois arraste o objeto na página. O Dreamweaver ajustará a posição de todos os quadros-
chave. Se for feito qualquer tipo de alteração com uma barra inteira selecionada, todos os 
quadros-chave serão alterados.

■ Para adicionar ou remover quadros da linha de tempo, selecione Modify > Timeline > 
Add Frame ou Modify > Timeline > Remove Frame.

■ Para fazer com que a linha de tempo seja executada automaticamente quando a página for 
aberta em um navegador, clique em Autoplay (Execução automática). A opção Autoplay 
anexa à página um comportamento que executa a ação Play Timeline quando a página 
é carregada.

■ Para fazer com que a linha de tempo fique em loop contínuo, clique em Loop. A opção 
Loop insere a ação Go To Timeline Frame (Ir para quadro da linha de tempo) no canal 
Behaviors (Comportamentos) após o último quadro da animação. Você pode editar os 
parâmetros desse comportamento para definir o número de loops.

Alterar propriedades de imagens e camadas com 
linhas de tempo
Além de mover camadas com linhas de tempo, você pode alterar a visibilidade, tamanho e 
ordem de empilhamento de uma camada. Você também pode alterar o arquivo de origem de 
uma imagem.

Para alterar as propriedades de imagens e camadas com uma linha de tempo:

1. No painel Timelines, siga um destes procedimentos:

■ Selecione um quadro-chave existente na barra que controla o objeto que você deseja 
alterar. (Os quadros inicial e final são sempre quadros-chave.) 

■ Crie um novo quadro-chave, clicando em um quadro no meio da barra de animação e 
selecionando Modify > Timeline > Add Keyframe. Você também pode criar um novo 
quadro-chave pressionando a tecla Control (no Windows) ou a tecla Command (no 
Macintosh) e clicando em um quadro da barra de animação.

2. Defina novas propriedades para o objeto, seguindo um dos procedimentos abaixo:

■ Para alterar o arquivo de origem de uma imagem, clique no ícone de pasta junto à 
caixa de texto Src (Orig.) no Property inspector; depois procure uma nova imagem e 
selecione-a.
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■ Para alterar a visibilidade de uma camada, selecione inherit (herdar), visible (visível) ou 
hidden (oculta) no menu pop-up da caixa de texto Vis do Property inspector. Uma 
alternativa é usar os ícones que representam um olho, no painel Layers. Consulte 
“Alterar a visibilidade das camadas” na página 229.

■ Para alterar o tamanho de uma camada, arraste as alças de redimensionamento da 
camada ou digite novos valores nas caixas de texto Width (Largura) e Height (Altura) 
no Property inspector. Nem todos os navegadores podem alterar o tamanho de uma 
camada de forma dinâmica.

■ Para alterar a ordem de empilhamento de uma camada, digite um novo valor na caixa 
de texto Z-Index (Índice Z) ou utilize o painel Layers para alterar a ordem de 
empilhamento da camada atual (consulte “Alterar a ordem de empilhamento de 
camadas” na página 228).

3. Mantenha pressionado o botão Play para ver a animação.

Utilizar várias linhas de tempo
Em vez de tentar controlar todas as ações de uma página com uma linha de tempo, é mais fácil 
trabalhar com linhas de tempo separadas que controlem partes diferentes da página. Por 
exemplo, uma página pode incluir elementos interativos, sendo que cada um deles aciona uma 
linha de tempo diferente.

Para gerenciar várias linhas de tempo, siga um destes procedimentos:

■ Para criar uma nova linha de tempo, selecione Modify > Timeline > Add Timeline 
(Adicionar linha de tempo).

■ Para remover a linha de tempo selecionada, selecione Modify > Timeline > 
Remove Timeline. Assim, todas as animações da linha de tempo selecionada serão 
removidas permanentemente.

■ Para renomear a linha de tempo selecionada, selecione Modify > Timeline > 
Rename Timeline (Renomear linha de tempo) ou digite um novo nome no menu pop-up 
Timeline no painel Timelines .

■ Para exibir outra linha de tempo no painel Timelines, selecione uma nova linha de tempo 
no menu pop-up Timeline, no painel Timelines.
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Copiar e colar animações
Quando gostar de uma seqüência de animações , você poderá copiá-la e colá-la em uma outra 
área da linha de tempo atual, em outra linha de tempo do mesmo documento ou em uma 
linha de tempo de outro documento. Você também pode copiar e colar várias seqüências de 
uma só vez.

Para recortar ou copiar e colar seqüências de animações:

1. Clique em uma barra de animação para selecionar uma seqüência. Para selecionar várias 
seqüências, pressione a tecla Shift e clique em várias barras de animação; para selecionar 
todas as seqüências, pressione Control+A (no Windows) ou Command+A (no Macintosh).

2. Copie ou recorte a seleção.

3. Siga um dos procedimentos abaixo:

■ Mova a cabeça de execução para um outro ponto da linha de tempo atual.
■ Selecione uma outra linha de tempo no menu pop-up Timeline.
■ Abra um outro documento, ou crie um novo, e depois clique no painel Timelines.

4. Cole a seleção na linha de tempo.

As barras de animação de um mesmo objeto não podem se sobrepor porque uma camada 
não pode estar em dois lugares ao mesmo tempo (nem tampouco uma imagem pode ter 
duas fontes diferentes ao mesmo tempo). Se a barra de animação que você estiver colando 
for se sobrepor a uma outra barra de animação do mesmo objeto, o Dreamweaver 
deslocará automaticamente o primeiro quadro que não se sobrepõe.

Há dois princípios a serem seguidos ao colar seqüências de animações em um outro 
documento:

■ Se você copiar uma seqüência de animações para uma camada, e o novo documento tiver 
uma camada com o mesmo nome, o Dreamweaver aplicará as propriedades de animação à 
camada existente no novo documento.

■ Se você copiar uma seqüência de animações para uma camada, e o novo documento não 
tiver uma camada com o mesmo nome, o Dreamweaver colará a camada (e seu conteúdo) 
do documento original juntamente com a seqüência de animações. Para aplicar em uma 
outra camada do novo documento a seqüência de animações colada, selecione Change 
Object (Alterar objeto) no menu contextual e depois selecione o nome da segunda camada 
no menu pop-up. Se desejar, exclua a camada que foi colada. 
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Aplicar uma seqüência de animações a um objeto 
diferente
Para economizar tempo, você pode criar uma seqüência de animações e aplicá-la a cada uma 
das camadas restantes no documento.

Para aplicar uma seqüência de animações existente a outros objetos:

1. No painel Timelines, selecione a seqüência de animações e copie-a.

2. Clique em qualquer quadro do painel Timelines e cole a seqüência nesse quadro.

3. Clique com o botão direito do mouse (no Windows) ou clique com a tecla Control 
pressionada (Macintosh) na seqüência de animações que foi colada e selecione Change 
Object (Alterar objeto) no menu contextual.

4. Na caixa de diálogo apresentada, selecione um outro objeto no menu pop-up e clique em 
OK.

5. Repita as etapas de 2 a 4 para os demais objetos que devam seguir a mesma seqüência de 
animações.

Após a criação de uma seqüência de animações, você também pode mudar de idéia quanto à 
camada que deve ser animada ; simplesmente siga as etapas 3 e 4 acima (não é necessário 
copiar nem colar).

Renomear linhas de tempo
Você pode renomear uma linha de tempo.

Para renomear uma linha de tempo que está sendo exibida no painel 
Timelines:

1. Selecione Modify > Timeline > Rename Timeline.

2. Na caixa de diálogo Rename Timeline, digite um novo nome.

Se o documento contiver a ação de comportamento Play Timeline (por exemplo, se ele 
contiver um botão no qual o visitante deve clicar para iniciar a linha de tempo), você precisará 
editar o comportamento para que ele reflita o novo nome da linha de tempo.

Dicas de animação para linhas de tempo
As sugestões apresentadas a seguir podem melhorar o desempenho das suas animações e 
facilitar a criação de animações:
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■ Mostre e oculte camadas em vez de alterar o arquivo de origem nas animações que têm 
várias imagens. A alternância de arquivos de origem de uma imagem poderá tornar a 
animação mais lenta porque será necessário fazer o download da nova imagem. Não haverá 
pausas perceptíveis nem imagens ausentes se for feito o download, de uma só vez, de todas 
as imagens em camadas ocultas, antes da execução da animação.

■ Estenda as barras de animação para criar um movimento mais suave. Se a animação 
parecer instável , e as imagens ficarem trocando de posição, arraste o quadro final da barra 
de animação da camada, a fim de estender o movimento por mais quadros. O aumento da 
barra de animação cria mais pontos de dados entre os pontos inicial e final do movimento 
e também faz com que o objeto se mova mais lentamente. Tente aumentar o número de 
quadros por segundo (qps) para melhorar a velocidade, mas saiba que a maioria dos 
navegadores executados nos sistemas mais comuns não conseguem animar muito mais 
rápido do que 15 qps. Teste a animação em sistemas diferentes e com navegadores 
diferentes para estabelecer as melhores definições.

■ Não anime grandes mapas de bits. A animação de imagens grandes resulta em animações 
lentas. Em vez disso, crie composições e mova pequenas partes da imagem. Por exemplo, 
mostre um carro em movimento animando apenas as rodas.

■ Crie animações simples. Não crie animações que exijam mais recursos do que os 
navegadores atuais podem proporcionar. Os navegadores sempre executam todos os 
quadros em uma animação de linha de tempo, mesmo quando há uma queda no 
desempenho do sistema ou da Internet.

Inserir tags div no layout
Você pode utilizar tags div para criar blocos de layout CSS e posicioná-los no documento. 
Essas tags são especialmente úteis quando você tem uma folha de estilos CSS com estilos de 
posicionamento anexada ao documento. O Dreamweaver permite inserir rapidamente uma 
tag div e aplicar os estilos existentes a ela.

Para inserir uma tag div:

1. Na janela do documento, coloque o ponto de inserção no local onde a tag div deverá 
aparecer.

N
O

T
A

Você pode utilizar um arquivo de projetos do Dreamweaver como um ponto de partida 
para o layout CSS. Na categoria Page Designs (CSS) da caixa de diálogo New 
Document, selecione um arquivo (consulte “Criar um documento com base em um 
arquivo de projeto do Dreamweaver” na página 103).
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2. Siga um dos procedimentos abaixo:

■ Selecione Insert (Inserir) > Layout Objects (Objetos de layout) > Div Tag (Tag div).
■ Na categoria Layout da barra Insert, clique no botão Expanded Tables Mode (Modo 

de tabelas expandidas).
A caixa de diálogo Insert Div Tag (Inserir tag div) é exibida.

3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help da caixa de diálogo.
4. Clique em OK.

A tag div aparece como uma caixa no documento com o texto do alocador de espaço. 
Quando você move o mouse sobre a margem da caixa, o Dreamweaver a realça.

Se a tag div estiver em uma posição absoluta, ela agirá como uma camada do Dreamweaver. 
Para obter informações sobre como trabalhar com camadas, consulte “Definir propriedades e 
preferências de camadas” na página 225, “Gerenciar camadas” na página 227 ou “Manipular 
camadas” na página 230. 

Para obter informações sobre como trabalhar com tags div que não estejam absolutamente 
posicionadas, consulte “Trabalhar com tags div no layout” na página 246.

Tópicos relacionados
■ “Alterar a cor de realce de tags div” na página 247
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Trabalhar com tags div no layout
Depois de inserir uma tag div (consulte “Inserir tags div no layout” na página 244), você 
poderá manipulá-la ou adicionar conteúdo a ela.

As bordas das tags div são visíveis quando você as atribui ou quando a opção CSS Layout 
Outlines está selecionada. (Por padrão, a opção CSS Layout Outlines permanec selecionada 
no menu View > Visual Aids.) Quando você move o ponteiro sobre uma tag div, o 
Dreamweaver a realça. Para alterar a cor de realce ou para desativá-lo, consulte “Alterar a cor 
de realce de tags div” na página 247.

Ao selecionar uma tag div, você pode visualizar e editar regras para ela no painel CSS Styles 
(Estilos CSS). Você também pode adicionar conteúdo à tag div posicionando o ponto de 
inserção dentro da tag div e, em seguida, adicionando conteúdo da mesma forma que em 
uma página.

Para exibir e editar as regras aplicadas a uma tag div:

1. Siga um destes procedimentos para selecionar a tag div:

■ Clique na borda da tag div.

■ Clique dentro da tag div e pressione Control+A (no Windows) ou Command+A (no 
Macintosh) duas vezes.

■ Clique dentro da tag div e selecione-a no seletor de tags, na parte inferior da janela do 
documento.

2. Selecione Window > CSS Styles para abrir o painel CSS Styles, se já não estiver aberto.

As regras aplicadas à tag div aparecem no painel.
3. Edite conforme a necessidade.

Para colocar o ponto de inserção em uma tag div para adicionar conteúdo:

■ Clique em qualquer ponto dentro das bordas da tag.

N
O

T
A

As tags div que têm uma posição absoluta são camadas do Dreamweaver. Para obter 
informações sobre como trabalhar com essas tags div, pule esta seção e consulte 
“Definir propriedades e preferências de camadas” na página 225, “Gerenciar camadas” 
na página 227 ou “Manipular camadas” na página 230.

D
IC

A

Procure o realce para ver a borda.
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Para alterar o texto do alocador de espaço em uma tag div:

■ Selecione o texto e digite sobre ele ou pressione a tecla Delete.

Tópicos relacionados
■ “Inserir tags div no layout” na página 244
■ “Utilizar o painel CSS Styles (Estilos CSS)” na página 433

Alterar a cor de realce de tags div
Quando você move o ponteiro sobre a margem de uma tag div na visualização do projeto, o 
Dreamweaver realça as bordas da tag. Você pode ativar ou desativar o realce se necessário, ou 
alterar a cor de realce na caixa de diálogo Preferences (Preferências).

Para alterar as preferências de realce das tags div:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.
2. Selecione Highlighting (Realce) na lista de categorias à esquerda.

3. Faça uma dessas alterações:

■ Para alterar a cor do realce para as tags div, clique na caixa de cor Mouse-Over 
(Seleção do mouse) e selecione a cor de realce utilizando o seletor de cores (ou digite o 
valor hexadecimal relativo à cor do realce na caixa de texto). 
Para obter informações sobre como utilizar o seletor de cores, consulte “Trabalhar com 
cores” na página 384.

■ Para ativar ou desativar o realce para as tags div, marque ou desmarque a caixa de 
seleção Show (Mostrar) para Mouse-Over.

4. Clique em OK.

N
O

T
A

Você pode adicionar conteúdo à tag div exatamente como faria em uma página.

N
O

T
A

Essas opções afetam todos os objetos, como tabelas, que o Dreamweaver 
realça quando você move o mouse sobre eles. 
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Trabalhar com visualização de layout 
CSS
O Dreamweaver inclui vários recursos de visualização que permitem exibir elementos do 
layout CSS na visualização do projeto. Por exemplo, você pode exibir os contornos das tags 
div que não têm bordas atribuídas a elas, ou pode exibir cores de fundo temporárias para tags 
div, a fim de ver sua localização na página.

Esta seção contém os tópicos a seguir:

■ “Sobre a visualização de layout CSS” na página 248
■ “Exibir blocos de layout CSS” na página 249
■ “Utilizar folhas de estilo Design-time (Fase de projeto) com blocos de layout CSS” na 

página 249

Sobre a visualização de layout CSS
O Dreamweaver permite visualizar os blocos de layout CSS enquanto você trabalha na 
visualização do projeto. Os blocos de layout CSS são elementos de página HTML que podem 
ser posicionados em qualquer ponto da página. Mais especificamente, um bloco de layout 
CSS é uma tag div sem display:inline ou qualquer outro elemento de página que inclua as 
declarações CSS display:block, position:absolute ou position:relative. A seguir, 
são apresentados alguns exemplos de elementos que são considerados blocos de layout CSS no 
Dreamweaver:

■ Uma tag div
■ Uma imagem com posição absoluta ou relativa a ela atribuída
■ Uma tag a com o estilo display:block atribuído a ela
■ Um parágrafo com posição absoluta ou relativa a ele atribuída

O Dreamweaver fornece vários auxílios visuais para visualizar os blocos de layout CSS. Por 
exemplo, você pode ativar contornos, fundos e o modelo de caixa para blocos de layout CSS 
enquanto você está projetando. Você também pode visualizar dicas de ferramenta que exibem 
propriedades de um bloco de layout CSS selecionado ao passar o ponteiro do mouse sobre o 
bloco de layout.

A lista de auxílios visuais de blocos de layout CSS a seguir descreve o que o Dreamweaver 
apresenta como visível para cada um destes itens:

N
O

T
A

Para fins de processamento visual, os blocos de layout CSS não incluem elementos 
em linha (isto é, elementos cujo código se encontra em uma linha de texto) nem 
elementos de bloco simples como parágrafos.
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CSS Layout Outlines mostra os contornos de todos os blocos de layout CSS da página.

CSS Layout Backgrounds (Fundos de layout CSS) mostra as cores de fundo 
temporariamente atribuídas a blocos de layout CSS individuais e oculta as demais cores de 
fundo ou imagens que normalmente são mostradas na página.

Sempre que você ativar o auxílio visual para visualizar fundos de blocos de layout CSS, o 
Dreamweaver atribuirá automaticamente a cada bloco de layout CSS uma cor de fundo 
distinta. (O Dreamweaver seleciona as cores utilizando um processo algorítmico — não existe 
uma forma de você atribuir as cores pessoalmente.) As cores atribuídas são visualmente 
identificáveis, e seu uso foi projetado para ajudar a distinguir os blocos de layout CSS. 

CSS Layout Box Model (Modelo de caixa de layout CSS) mostra o modelo de caixa (isto é, 
preenchimento e margens) do bloco de layout CSS selecionado.

Exibir blocos de layout CSS
Você pode ativar ou desativar os auxílios visuais de blocos de layout CSS, se necessário. Para 
obter uma explicação sobre o que cada auxílio visual processa, consulte “Sobre a visualização 
de layout CSS” na página 248.

Para exibir contornos de blocos de layout CSS:

■ Selecione View > Visual Aids > CSS Layout Outlines.

Para exibir os fundos de blocos de layout CSS:

■ Selecione View > Visual Aids > CSS Layout Backgrounds.

Para exibir os modelos de caixa de blocos de layout CSS:

■ Selecione View > Visual Aids > CSS Layout Outlines (Modelos de caixa de layout CSS).

Você também pode acessar as opções de auxílios visuais de blocos de layout CSS ao clicar no 
botão Visual Aids na barra de ferramentas Document (Documento).

Utilizar folhas de estilo Design-time (Fase de projeto) 
com blocos de layout CSS
Você pode utilizar uma folha de estilos Design-time para exibir os fundos, bordas ou modelo 
de caixa para elementos que geralmente não são considerados blocos de layout CSS. Para isso, 
é necessário primeiro criar uma folha de estilos Design-time que associe o atributo 
display:block ao elemento de página apropriado.
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Para utilizar auxílios visuais de blocos de layout CSS com elementos de bloco 
de layout diferentes de CSS:

1. Para criar uma folha de estilos CSS externa, selecione File (Arquivo) > New (Novo), 
selecione Basic Page (Página básica) na coluna Category, selecione CSS na coluna Basic 
Page e clique em Create (Criar).

2. Na nova folha de estilos, crie regras que associem o atributo display:block aos elementos 
de página que você deseja exibir como blocos de layout CSS.

Por exemplo, se você quisesse exibir uma cor de fundo para os itens de lista e parágrafos, 
poderia criar uma folha de estilos com as seguintes regras:
p{

display:block;
}
li{

display:block;
}

3. Salve o arquivo.

4. Na visualização do projeto, abra a página à qual deseja anexar os novos estilos.

5. Selecione Text > CSS Styles > Design-time.

6. Na caixa de diálogo Design-time Style Sheets (Folhas de estilo da fase de projeto), clique 
no botão com o sinal de adição (+) acima da caixa de texto Show Only at Design Time 
(Mostrar apenas na fase de projeto), selecione a folha de estilos que você acaba de criar e 
clique em OK.

7. Clique em OK para fechar a caixa de diálogo Design-time Style Sheets.

A folha de estilos é anexada ao seu documento. Se você criar uma folha de estilos 
utilizando o exemplo anterior, todos os itens de lista e parágrafos serão formatados com o 
atributo display:block, possibilitando, assim, que você ative ou desative os auxílios 
visuais de blocos de layout CSS para itens de lista e parágrafos.

Tópicos relacionados
■ “Utilizar folhas de estilo Design-Time” na página 442

Utilizar réguas, guias e grades para definir 
o layout de páginas
Utilize réguas, guias e grades como auxílios visuais para posicionar, medir ou redimensionar 
elementos na visualização do projeto da janela do documento.
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Utilizar réguas
As réguas ajudam a medir, organizar e planejar seu layout. Elas podem aparecer nas bordas 
superior e esquerda da página, marcadas em pixels, polegadas ou centímetros.

Para alterar as definições de régua, siga um destes procedimentos:

■ Para mostrar ou ocultar as réguas, selecione View > Rulers > Show. 
■ Para alterar a origem, arraste o ícone de origem da régua (no canto superior esquerdo da 

visualização do projeto da janela do documento) em qualquer lugar da página. 
Para redefinir a origem para a posição padrão, selecione View > Rulers > Reset Origin 
(Redefinir a origem).

■ Para alterar a unidade de medida, selecione Pixels, Inches ou Centimeters no submenu 
View > Rulers .

Utilizar guias
As guias são linhas que você arrasta das réguas para o documento. Elas ajudam a colocar e 
alinhar objetos com maior precisão. Você também pode usar guias para medir o tamanho dos 
elementos de página ou emular as dobras (áreas visíveis) de navegadores da Web.

Para ajudar a alinhar elementos, o Dreamweaver permite encaixar os elementos nas guias e 
vice-versa. (Os elementos devem ter uma posição absoluta para que o recurso de encaixe 
funcione.) Você também pode bloquear as guias para impedir que sejam acidentalmente 
movidas por um outro usuário.

Para criar uma guia horizontal ou vertical:

1. Arraste o ponteiro do mouse a partir da régua correspondente.

2. Posicione a guia na janela do documento e libere o botão do mouse. 

Você pode reposicionar a guia arrastando-a novamente.

Para mostrar ou ocultar guias:

■ Selecione View> Guides> Show Guides (Mostrar guias).

N
O

T
A

Por padrão, as guias são gravadas como medidas absolutas em pixels, a partir da 
parte superior ou do lado esquerdo do documento, e são mostradas em relação à 
origem da régua. Para gravar a guia como um percentual, pressione a tecla Shift 
enquanto cria ou move a guia.
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Para encaixar os elementos nas guias:

■ Selecione View > Guides > Snap to Guides (Encaixar nas guias).

Para encaixar as guias nos elementos:

■ Selecione View > Guides > Guides Snap to Elements (Guias se encaixam nos elementos).

Para bloquear ou desbloquear todas as guias:

■ Selecione View > Guides > Lock Guides (Bloquear guias).

Para mover uma guia para uma posição específica:

1. Clique duas vezes na guia.

2. Insira nova posição na caixa de diálogo Move Guide (Mover guia) e clique em OK.

Para exibir a posição de uma guia:

■ Mantenha o ponteiro do mouse posicionado em cima da guia.

Para exibir a distância entre as guias:

■ Pressione a tecla Control (no Windows) ou a tecla Command (no Macintosh) e mantenha 
o ponteiro do mouse em qualquer posição entre as duas guias.

Para alterar a cor da guia:

1. Selecione View > Guides > Edit Guides (Editar guias).

2. Selecione a nova cor da guia no menu pop-up Guide Color (Cor da guia) e clique em OK.

Para alterar a cor que indica a distância entre as guias:

1. Selecione View > Guides > Edit Guides. 

2. Selecione a cor no menu pop-up Distance Color (Cor para distância) e clique em OK.

Para emular a dobra (área visível) de um navegador da Web:

■ Selecione View > Guides e selecione um tamanho predefinido de janela de navegador no 
menu.

Para remover uma guia:

■ Arraste a guia para fora do documento.

N
O

T
A

Quando você redimensiona elementos, como camadas, tabelas e imagens, os 
elementos redimensionados se encaixam nas guias.

N
O

T
A

A unidade de medida é a mesma usada para as réguas.
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Para limpar todas as guias:

■ Selecione View > Guides > Clear Guides (Limpar guias).

Utilizar guias com modelos
Quando se adicionam guias a um modelo do Dreamweaver, todas as instâncias do modelo 
herdam essas guias. Nas instâncias de modelos, entretanto, as guias são tratadas como regiões 
editáveis, de modo que os usuários possam modificá-las. As guias modificadas nas instâncias 
de modelos são restauradas na sua localização original sempre que a instância é atualizada com 
o modelo-mestre.

Você também pode adicionar suas próprias guias às instâncias de um modelo. As guias 
adicionadas desse modo não são substituídas quando a instância do modelo é atualizada com 
o modelo-mestre.

Tópicos relacionados
■ “Redimensionar camadas” na página 230
■ “Mover camadas” na página 232
■ “Alinhar camadas” na página 232

Utilizar a grade
A grade exibe um sistema de linhas horizontais e verticais na janela do documento. É útil para 
posicionar objetos com precisão. À medida que os elementos da página que têm posição 
absoluta forem movidos, você poderá encaixá-los automaticamente na grade e alterá-la ou 
controlar o comportamento de encaixe especificando as definições da grade. O encaixe 
funcionará independentemente da visibilidade da grade. 

Para mostrar ou ocultar a grade:

■ Selecione View > Grid (Grade) > Show Grid (Mostrar grade).

Para ativar ou desativar o encaixe:

■ Selecione View > Grid > Snap to Grid (Encaixar na grade).

Para alterar as definições da grade:

1. Selecione View> Grid > Grid Settings (Definições da grade).
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A caixa de diálogo Grid Settings é exibida.

2. Defina as opções conforme desejado.

Para obter mais informações, clique no botão Help da caixa de diálogo.
3. Clique em OK.

Tópicos relacionados
■ “Redimensionar camadas” na página 230
■ “Mover camadas” na página 232
■ “Alinhar camadas” na página 232

Utilizar uma imagem de rastreamento
Você pode utilizar uma imagem de rastreamento como um guia para recriar uma página criada 
em um aplicativo gráfico, como o Macromedia Freehand ou Fireworks. 

As imagens de rastreamento são imagens JPEG, GIF ou PNG que são colocadas no fundo da 
janela do documento. Você pode ocultar a imagem, definir a sua opacidade e alterar a sua 
posição.   

Para colocar uma imagem de rastreamento na janela do documento:

1. Siga um destes procedimentos:

■ Selecione View > Tracing Image (Imagem de rastreamento) > Load (Carregar).
■ Selecione Modify> Page Properties (Propriedades da página) e, em seguida, clique no 

botão Browse (Procurar) ao lado da caixa de texto Tracing Image.
2. Na caixa de diálogo que é exibida, selecione um arquivo de imagem e clique em Select 

(Selecionar), no Windows, ou em Choose (Escolher), no Macintosh.

Será exibida a caixa de diálogo Page Properties. 
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3. Especifique a transparência da imagem arrastando o botão deslizante Image Transparency 
(Transparência da imagem) e clique em OK.

Para alternar para outra imagem de rastreamento ou alterar a transparência da imagem de 
rastreamento atual a qualquer momento, selecione Modify > Page Properties.

Para mostrar ou ocultar a imagem de rastreamento: 

■ Selecione View > Tracing Image > Show. 

A imagem de rastreamento fica visível apenas no Dreamweaver. Ela nunca fica visível quando 
a página é exibida em um navegador. Quando a imagem de rastreamento fica visível, a 
imagem e a cor de fundo reais da página não podem ser visualizadas na janela do documento; 
contudo, elas aparecem quando a página é exibida em um navegador. 

Para alterar a posição de uma imagem de rastreamento: 

1. Selecione View > Tracing Image > Adjust Position. 

2. Siga um destes procedimentos:

■ Para especificar com precisão a posição da imagem de rastreamento, digite valores de 
coordenadas nas caixas de texto X e Y.

■ Para mover a imagem um pixel de cada vez, utilize as teclas de seta.
■ Para mover a imagem cinco pixels de cada vez, pressione a tecla Shift e uma tecla de 

seta.

Para redefinir a posição da imagem de rastreamento:

■ Selecione View > Tracing Image > Reset Position. 
A imagem de rastreamento retorna ao canto superior esquerdo da janela do documento 
(coordenadas 0,0).

Para alinhar a imagem de rastreamento a um elemento selecionado: 

1. Selecionar um elemento na janela do documento. 

2. Selecione View > Tracing Image > Align with Selection. 

O canto superior esquerdo da imagem de rastreamento é alinhado com o canto superior 
esquerdo do elemento selecionado. 
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8

CAPÍTULO 8

Apresentar conteúdo 
com tabelas
As tabelas são ferramentas poderosas para a apresentação de dados tabulares e para a definição 
do layout de textos e gráficos em uma página.

Muitos designers usam tabelas para definir o layout de páginas da Web. O Macromedia 
Dreamweaver 8 fornece dois modos de visualização e manipulação de tabelas: O modo 
Standard (Padrão), no qual as tabelas são apresentadas como grades de linhas e colunas, e o 
modo Layout (Layout), que permite desenhar, redimensionar e mover caixas na página 
enquanto estiver usando tabelas para a estrutura subjacente (consulte o Capítulo 9, “Criação 
de páginas no modo Layout”, na página 283). 

Este capítulo contém as seguintes seções:
Sobre as tabelas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .258

Inserir uma tabela e adicionar conteúdo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260

Importar e exportar dados tabulares  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261

Selecionar os elementos da tabela. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .262

Usar o modo Expanded Tables (Tabelas expandidas) para facilitar a edição da 
tabela. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .266

Formatar tabelas e células . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .267

Redimensionar tabelas, colunas e linhas  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .270

Adicionar e remover linhas e colunas. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .275

Dividir e mesclar células . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .276

Copiar, colar e excluir células. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .278

Aninhar tabelas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 281

Ordenar tabelas  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 281

N
O
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A

É possível também definir o layout das páginas utilizando o posicionamento de CSS 
(consulte o Capítulo 7, “Criar layouts de páginas com CSS”, na página 219).
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Sobre as tabelas
As tabelas são ferramentas poderosas para a apresentação de dados tabulares e para a definição 
do layout de textos e gráficos em uma página HTML. Uma tabela consiste em uma ou mais 
linhas, sendo que cada linha é formada por uma ou mais células. Embora normalmente as 
colunas não sejam especificadas de forma explícita no código HTML, o Dreamweaver permite 
manipulá-las, bem como linhas e células.

 O Dreamweaver exibe a largura da tabela e da coluna para cada coluna da tabela quando a 
tabela é selecionada ou quando o ponto de inserção está na tabela. Ao lado das larguras, estão 
as setas relativas ao menu do cabeçalho da tabela e aos menus do cabeçalho da coluna. Use os 
menus para ter acesso rápido a alguns comandos relacionados a tabelas. Você pode ativar ou 
desativar as larguras e os menus, conforme a necessidade (consulte o  “Exibir larguras e menus 
de tabelas e colunas” na página 274).

Se você não vir uma largura para a tabela ou para a coluna, isso significa que a tabela ou 
coluna não possuem uma largura específica no código HTML. Se aparecerem dois números, a 
largura visual que aparece no modo Design não coincide com o que foi especificado no código 
HTML. Isto poderá ocorrer quando a tabela é redimensionada arrastando seu canto inferior 
direito ou quando o conteúdo adicionado a uma célula é maior do que a largura definida para 
essa célula.

Por exemplo, se a largura de uma coluna for definida como 200 pixels, ao adicionar conteúdo 
que aumente a largura para 250 pixels, dois números aparecerão para essa coluna: 200 (a 
largura especificada no código) e (250) entre parênteses (a largura visual da coluna, na forma 
como ele é processada na sua tela). 

Para compatibilizar as duas larguras de coluna, veja “Tornar as larguras das colunas 
consistentes com as larguras visuais” na página 273.

Tópicos relacionados
■ “Inserir uma tabela e adicionar conteúdo” na página 260

Ordem de precedência para a formatação de tabelas 
em HTML
Ao formatar tabelas na visualização do projeto, é possível definir propriedades para toda a 
tabela ou para linhas, colunas ou células selecionadas da tabela. Quando uma propriedade, 
como cor de fundo ou alinhamento, é definida com um valor para toda a tabela e outro valor 
para células individuais, a formatação da célula tem precedência sobre a formatação da linha, 
que, por sua vez, tem precedência sobre a formação da tabela. 
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A ordem de precedência para formatação da tabela é esta:

1. Células

2. Linhas

3. Tabela

Por exemplo: se você definir a cor de fundo azul para uma única célula e definir a cor de fundo 
amarelo para toda a tabela, a célula azul não mudará para a cor amarela, uma vez que a 
formatação das células tem precedência sobre a formatação da tabela.

Tópicos relacionados
■ “Formatar tabelas e células” na página 267

Sobre a divisão e a mesclagem de células da tabela
É possível mesclar qualquer número de células adjacentes (contanto que a seleção inteira seja 
uma linha ou um retângulo de células) para produzir uma única célula abrangendo diversas 
colunas ou linhas. É possível dividir uma célula em várias linhas ou colunas, 
independentemente de ela já ter sido mesclada. O Dreamweaver reestrutura automaticamente 
a tabela (adicionando quaisquer atributos colspan ou rowspan necessários) para criar o 
formato especificado. 

Na ilustração a seguir, as células no meio das duas primeiras linhas foram mescladas em uma 
única célula, de forma a abrangerem duas linhas.

Tópicos relacionados
■ “Dividir e mesclar células” na página 276

N
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Quando se definem propriedades em uma coluna, o Dreamweaver modifica os atributos 
da tag td correspondente a cada célula da coluna.
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Inserir uma tabela e adicionar conteúdo
Utilize a barra Insert (Inserir) ou o menu Insert (Inserir) para criar uma nova tabela. É possível 
adicionar textos e imagens às células da tabela do mesmo modo que se adicionam textos e 
imagens fora de uma tabela (consulte o Capítulo 13, “Inserir e formatar texto”, na página 405 
e o Capítulo 14, “Inserir imagens”, na página 445).

Para inserir uma tabela:

1. Na visualização do projeto da janela do documento, coloque o ponto de inserção no local 
onde deseja que a tabela seja exibida.

2. Siga um dos procedimentos abaixo:

■ Selecione Insert (Inserir)  > Table (Tabela).
■ Na categoria Common (Comuns) da barra Insert, clique no botão Table.
A caixa de diálogo Insert Table (Inserir tabela) é exibida.

3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

A tabela será exibida no documento.

Tópicos relacionados
■ “Exibir e configurar as propriedades de tabelas, células, linhas e colunas” na página 267
■ “Editar atributos de acessibilidade para uma tabela” na página 268
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Se o documento estiver em branco, o único local para colocar o ponto de inserção 
será o início do documento.
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Importar e exportar dados tabulares
Os dados tabulares criados com outro aplicativo (como o Microsoft Excel) e salvos em um 
formato de texto delimitado (com itens separados por tabulações, vírgulas, dois-pontos, 
ponto-e-vírgula ou outros delimitadores) podem ser importados para o Dreamweaver e 
formatados como uma tabela.

Também é possível exportar dados da tabela, a partir do Dreamweaver, para um arquivo de 
texto com o conteúdo das células adjacentes separado por um delimitador. É possível utilizar 
vírgulas, dois-pontos, ponto-e-vírgulas ou espaços como delimitadores. Quando uma tabela é 
exportada, toda ela é exportada; é impossível selecionar partes de uma tabela para exportação.

Para importar dados da tabela: 

1. Siga um dos procedimentos abaixo:

■ Selecione File (Arquivo) > Import (Importar) > Tabular Data (Dados tabulares).
■ Selecione Insert (Inserir) > Table Objects (Objetos de tabela) > Import Tabular Data 

(Importar dados tabulares).
A caixa de diálogo Import Tabular Data (Importar dados tabulares) é exibida.

2. Na caixa de diálogo, forneça as informações sobre o arquivo que contém os dados. 

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

D
IC

A

Se desejar exportar somente alguns dados de uma tabela, por exemplo, as seis 
primeiras linhas ou as seis primeiras colunas, copie as células que contêm os dados, 
colá-las fora da tabela (para criar uma nova tabela) e exportar a nova tabela.
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Para exportar uma tabela:

1. Coloque o ponto de inserção em qualquer célula da tabela.

2. Selecione File (Arquivo) > Export (Exportar) > Table (Tabela).

A caixa de diálogo Export Table (Exportar tabela) é exibida.

3. Na caixa de diálogo Export Table, especifique as opções para exportar a tabela.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em Export.

A caixa de diálogo Export Table As (Exportar tabela como) é exibida.
5. Digite um nome para o arquivo.

6. Clique em Save (Salvar).

Selecionar os elementos da tabela 
É possível selecionar uma tabela, uma linha ou uma coluna inteira ao mesmo tempo. Também 
é possível selecionar uma ou mais células individuais.

Quando você move o ponteiro sobre uma tabela, linha, coluna ou célula, o Dreamweaver 
realça todas as células dessa seção de modo que você saiba exatamente quais células serão 
selecionadas se você clicar na seleção. Esse procedimento pode ser útil quando houver tabelas 
sem bordas, células que abrangem múltiplas colunas ou linhas ou, ainda, tabelas aninhadas. É 
possível destacar a cor de realce na caixa de diálogo Preferences (Preferências). 

Para alterar a cor de realce para elementos selecionados da tabela:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.
2. Selecione Highlighting (Realce) na lista de categorias à esquerda.

D
IC

A

Se o ponteiro do mouse for posicionado sobre a borda de uma tabela e a tecla Control 
(no Windows) ou Command (no Macintosh) for pressionada, toda a estrutura da tabela — 
isto é, todas as células da tabela — será realçada. Esse procedimento pode ser útil 
quando houver tabelas aninhadas e você desejar ver a estrutura de uma das tabelas.
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3. Faça uma dessas alterações:

■ Para alterar a cor do realce para os elementos da tabela, clique na caixa de cor Mouse-
over (Seleção do mouse) utilizando o seletor de cores (ou digite o valor hexadecimal 
relativo à cor do realce na caixa de texto). 
Para obter informações sobre como utilizar o seletor de cores, consulte “Trabalhar com 
cores” na página 384.

■ Para ativar ou desativar o realce para elementos da tabela, marque ou desmarque a 
caixa de seleção Show (Mostrar) de Mouse-over.

4. Clique em OK.

Tópicos relacionados
■ “Formatar tabelas e células” na página 267
■ “Redimensionar tabelas, colunas e linhas” na página 270
■ “Copiar, colar e excluir células” na página 278

Selecionar uma tabela
Há várias maneiras de selecionar a tabela inteira de uma só vez.

Para selecionar uma tabela inteira, siga um dos procedimentos abaixo:

■ Clique no canto superior esquerdo da tabela, em qualquer área na margem superior ou 
inferior da tabela ou ainda na borda de uma linha ou coluna.

■ Clique em uma célula da tabela e, em seguida, selecione a tag <table> no seletor de tags, 
no canto inferior esquerdo da janela do documento.

■ Clique em uma célula da tabela e selecione Modify (Modificar) > Table (Tabela) > Select 
Table (Selecionar tabela).

N
O

T
A

Essas opções afetam todos os objetos, como camadas e tabelas e células de 
visualização do modo Layout que o Dreamweaver realça quando você move o 
ponteiro sobre eles. 

N
O

T
A

O ponteiro passa para o ícone de grade de tabela quando a tabela é selecionada (a 
menos que você clique na borda de uma linha ou coluna).
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■ Clique em uma célula da tabela, clique no menu de cabeçalho da tabela e, em seguida, 
selecione Select Table (Selecionar tabela). 
Alças de seleção são exibidas na borda inferior e direita da tabela selecionada. 

Tópicos relacionados
■ “Selecionar células” na página 265

Selecionar linhas ou colunas
É possível selecionar uma linha ou coluna individual ou selecionar múltiplas linhas ou 
colunas.

Para selecionar linhas ou colunas individuais ou múltiplas:

1. Posicione o ponteiro de forma que aponte para a margem esquerda de uma linha ou para a 
margem superior de uma coluna.

2. Quando o ponteiro se transformar em uma seta de seleção, clique para selecionar uma linha 
ou coluna ou arrastar para selecionar várias linhas ou colunas.

Para selecionar uma única coluna:

1. Clique na coluna.

2. Clique no menu de cabeçalho da coluna e selecione Select Column (Selecionar coluna).

Tópicos relacionados
■ “Selecionar uma tabela” na página 263
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Selecionar células
É possível selecionar uma única célula, uma linha ou bloco de células ou, ainda, células não-
adjacentes. Para selecionar linhas ou colunas inteiras, consulte “Selecionar linhas ou colunas” 
na página 264.

Para selecionar uma única célula, siga um dos procedimentos abaixo:

■ Clique na célula e, em seguida, selecione a tag <td> no seletor de tags, no canto inferior 
esquerdo da janela do documento.

■ Pressione a tecla Control (no Windows) ou Command (no Macintosh) na célula.
■ Clique na célula e selecione Edit (Editar) > Select All (Selecionar tudo).

Para selecionar uma linha ou um bloco retangular de células, siga um dos 
procedimentos abaixo:

■ Arraste de uma célula a outra.
■ Clique em uma célula, pressione a tecla Control (no Windows) ou a tecla Command (no 

Macintosh) na mesma célula para selecioná-la e, em seguida, pressione a tecla Shift em 
outra célula.
Todas as células dentro da região linear ou retangular definida pelas duas células são 
selecionadas. 

Para selecionar células não-adjacentes:

■ Mantenha a tecla Control (no Windows) ou a tecla Command (no Macintosh) 
pressionada e clique nas células, linhas ou colunas que deseja selecionar.
Se as células, linhas ou colunas nas quais clicar ainda não estiverem selecionadas, elas serão 
adicionadas à seleção. Se já tiverem sido selecionadas, serão removidas da seleção.

Tópicos relacionados
■ “Selecionar uma tabela” na página 263
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Escolha Edit (Editar) > Select All (Selecionar tudo) novamente quando a célula 
estiver selecionada a fim de selecionar a tabela inteira.
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Usar o modo Expanded Tables (Tabelas 
expandidas) para facilitar a edição da 
tabela
O modo Expanded Tables (Tabelas expandidas) adiciona, temporariamente, o preenchimento 
e espaçamento das células a todas as tabelas de um documento e aumenta as bordas das tabelas 
para facilitar a edição. Esse modo permite selecionar itens em tabelas ou posicionar com 
precisão o ponto de inserção. 

Por exemplo, talvez seja preciso expandir uma tabela para posicionar o ponto de inserção à 
esquerda ou à direita de uma imagem, sem selecionar acidentalmente a imagem ou a célula da 
tabela. 

Para passar ao modo Expanded Tables:

1. Se você estiver no modo de exibição Code, selecione View (Exibir) > Design ou View > 
Code and Design (Código e design).

Não é possível passar para o modo Expanded Tables na visualização de código.
2. Siga um dos procedimentos abaixo:

■ Selecione View (Exibir) > Table Mode (Modo da tabela) > Expanded Tables Mode 
(Modo de tabelas expandidas).

■ Na categoria Layout da barra Insert (Inserir), clique no botão Expanded Tables Mode.

Uma barra denominada Expanded Tables Mode aparece na parte superior da janela do 
documento. O Dreamweaver adiciona preenchimento e espaçamento de célula a todas as 
tabelas da página e aumenta as bordas das tabelas.

N
O

T
A

Após fazer a seleção ou posicionar o ponto de inserção, retorne ao modo Standard 
(Padrão) da visualização do projeto para fazer a edição necessária. Algumas operações 
visuais, como redimensionamento, não terão os resultados esperados no modo 
Expanded Tables.
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Para sair do modo Expanded Tables, siga um destes procedimentos:

■ Na barra Expanded Tables Mode, na parte superior da janela do documento, clique em 
Exit (Sair).

■ Selecione View (Exibir) > Table Mode (Modo da tabela) > Layout Mode (Modo Layout).
■ Na categoria Layout da barra Insert, clique no botão Modo Standard.

O Dreamweaver volta para o modo Standard.

Formatar tabelas e células 
É possível alterar a aparência das tabelas definindo-se as propriedades da tabela e das células ou 
aplicando-se um estilo predefinido à tabela. Antes de alterar as propriedades de tabelas e 
células, é recomendável saber que propriedades têm precedência sobre as outras (consulte 
“Ordem de precedência para a formatação de tabelas em HTML” na página 258).

Tópicos relacionados
■ “Redimensionar tabelas, colunas e linhas” na página 270

Exibir e configurar as propriedades de tabelas, 
células, linhas e colunas 
Quando uma tabela ou célula é selecionada, o Property inspector (Inspetor de propriedades) 
permite exibir e alterar suas propriedades.

Para visualizar e definir propriedades da tabela ou de elementos da tabela:

1. Selecione uma tabela, célula, linha ou coluna (consulte “Selecionar os elementos da tabela” 
na página 262).

2. Clique na seta de expansão, no canto inferior direito do Property inspector, aberto a partir 
da seleção de Window (Janela)  > Properties (Propriedades), para examinar todas as 
propriedades.

D
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Para formatar o texto de uma célula da tabela, utilize os mesmos procedimentos que 
usaria para formatar texto fora de uma tabela. Para obter mais informações, consulte 
Capítulo 13, “Inserir e formatar texto”, na página 405.
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Antes de alterar as propriedades de elementos da tabela, é recomendável saber que 
propriedades têm precedência sobre outras (consulte “Ordem de precedência para a 
formatação de tabelas em HTML” na página 258).
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3. Altere as propriedades conforme a necessidade.

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.

Editar atributos de acessibilidade para uma tabela
Caso não tenham sido adicionados atributos de acessibilidade à sua tabela ao inseri-la 
(consulte “Inserir uma tabela e adicionar conteúdo” na página 260) e for preciso adicioná-los 
posteriormente, ou se for preciso editar atributos de acessibilidade, é possível realizar essas 
tarefas na visualização do código ou na visualização do projeto.

Para adicionar ou editar valores de acessibilidade para uma tabela na 
visualização de código:

■ Edite os atributos apropriados no código. 

Para adicionar ou editar valores de acessibilidade para uma tabela na 
visualização do projeto, siga um destes procedimentos:

■ Para editar a legenda da tabela, realce a legenda e, em seguida, digite uma nova legenda. 
■ Para editar o alinhamento da legenda, coloque o ponto de inserção na legenda da tabela, 

clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) e, em seguida, selecione Edit Tag Code (Editar código da tag).

■ Para editar o resumo da tabela, selecione a tabela, clique com o botão direito do mouse (no 
Windows) ou mantenha a tecla Control pressionada (no Macintosh) e, em seguida, 
selecione Edit Tag Code.

Tópicos relacionados
■ “Exibir e configurar as propriedades de tabelas, células, linhas e colunas” na página 267

N
O

T
A

Quando se definem propriedades em uma coluna, o Dreamweaver modifica os 
atributos da tag td correspondente a cada célula da coluna. Ao definir certas 
propriedades para uma linha, no entanto, o Dreamweaver altera os atributos da tag 
tr em vez de alterar os atributos de cada tag td da linha. Ao aplicar o mesmo formato 
a todas as células de uma linha, a aplicação do formato à tag tr produz um código 
HTML mais conciso e limpo.

D
IC

A

Para localizar rapidamente as tags no código, clique na tabela e, em seguida, 
selecione <table> no seletor de tags, na parte inferior da janela do documento. 
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Usar um esquema de desenho para formatar uma 
tabela
Utilizar o comando Format Table (Formatar tabela) para aplicar rapidamente um estilo 
predefinido a uma tabela. Em seguida, as opções podem ser selecionadas para personalizar o 
estilo ainda mais.

Para utilizar um estilo de tabela predefinido:

1. Selecione uma tabela (consulte “Selecionar uma tabela” na página 263).

2. Select Commands (Comandos) > Format Table (Formatar tabela). 

A caixa de diálogo Format Table é exibida.

3. Personalizar as opções, conforme desejado. 

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em Apply (Aplicar) ou em OK para formatar a tabela com o estilo selecionado.

N
O

T
A

Somente as tabelas mais simples podem ser formatadas usando estilos predefinidos. 
Não é possível usar esses estilos para formatar tabelas que contêm células mescladas 
(colspan ou rowspan) ou grupos de colunas ou, ainda, para formatar qualquer outra 
tabela que não consista em uma grade retangular simples de células.
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Redimensionar tabelas, colunas e linhas
É possível redimensionar uma tabela inteira ou determinadas linhas e colunas da tabela. Se 
houver dificuldade para redimensionar a largura das colunas ou altura das linhas, voltar e 
começar novamente. 

Algumas vezes, as larguras das colunas definidas no código HTML não correspondem às suas 
larguras aparentes na tela. Quando isso acontecer, você pode tornar as larguras iguais. As 
larguras das tabelas e das colunas e os menus dos cabeçalhos aparecem no Dreamweaver para 
ajudar a definir o layout das tabelas. É possível ativar ou desativar as larguras e os menus, 
conforme a necessidade.

Redimensionar uma tabela
É possível redimensionar uma tabela arrastando uma de suas alças de seleção. O Dreamweaver 
exibe a largura da tabela, juntamente com um menu dos cabeçalhos da tabela, na parte 
superior ou inferior da tabela, quando a tabela é selecionada ou quando o ponto de inserção 
está na tabela. 

Quando uma tabela inteira é redimensionada, o tamanho de todas as células da tabela é 
alterado na mesma proporção. Se as células de uma tabela tiverem larguras ou alturas 
especificadas explicitamente, o redimensionamento da tabela alterará o tamanho visual das 
células na janela do documento, mas não modificará as larguras e alturas especificadas das 
células. Para limpar larguras ou alturas definidas, consulte “Limpar larguras e alturas 
definidas” na página 273.

Para redimensionar uma tabela:

1. Selecione a tabela (consulte “Selecionar uma tabela” na página 263).

São exibidas alças de seleção na tabela.

N
O

T
A

A largura da tabela e o menu de cabeçalhos da tabela podem ser desativados, se 
necessário (consulte “Exibir larguras e menus de tabelas e colunas” na página 274).
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2. Siga um dos procedimentos abaixo:

■ Para redimensionar a tabela horizontalmente, arraste a alça de seleção à direita.
■ Para redimensionar a tabela verticalmente, arraste a alça de seleção da parte inferior.
■ Para redimensionar a tabela em ambas as dimensões, arraste a alça de seleção no canto 

inferior direito.

Redimensionar colunas e linhas
É possível alterar a largura de uma coluna ou a altura de uma linha no Property inspector 
(Inspetor de propriedades) ou arrastando as bordas da coluna ou linha. Se houver dificuldade 
no redimensionamento, é possível limpar as larguras das colunas ou as alturas das linhas e 
começar novamente (consulte “Limpar larguras e alturas definidas” na página 273).

O Dreamweaver exibe as larguras das colunas, juntamente com os menus de cabeçalhos das 
colunas, na parte superior ou inferior das colunas quando a tabela é selecionada ou quando 
um ponto de inserção está na tabela. Para obter mais informações, consulte “Sobre as tabelas” 
na página 258. 

Para alterar a largura de uma coluna e manter a largura geral da tabela:

■ Arraste a borda direita da coluna a ser alterada.
A largura da coluna adjacente também é alterada; na verdade, duas colunas são 
redimensionadas. A visualização das alterações efetuadas mostra de que forma as colunas 
serão alteradas; a largura geral da tabela não é alterada.

N
O

T
A

Também é possível alterar a largura e a altura da célula diretamente no código HTML 
utilizando a visualização do código. Para obter mais informações, consulte “Codificar no 
Dreamweaver” na página 603.

N
O

T
A

Se necessário, é possível desativar as larguras das colunas e os menus de cabeçalhos 
(consulte “Exibir larguras e menus de tabelas e colunas” na página 274).

N
O

T
A

Em tabelas com larguras baseadas em porcentagem (e não em pixels), se a borda 
direita da coluna mais à direita for arrastada, a largura da tabela inteira é alterada e 
todas as colunas terão a largura aumentada ou reduzida proporcionalmente.
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Para alterar a largura de uma coluna e manter o tamanho das outras colunas:

■ Mantenha a tecla Shift pressionada e arraste a borda da coluna.
A largura da coluna é alterada. A visualização das alterações efetuada mostra de que forma 
a largura das colunas será ajustada; a largura geral da tabela é alterada para acomodar a 
coluna que está sendo redimensionada. 

Para alterar visualmente a altura de uma linha:

■ Arraste a borda inferior da linha. 

Para definir a largura de uma coluna ou a altura de uma linha utilizando o 
Property inspector:

1. Selecione a coluna ou linha (consulte “Selecionar linhas ou colunas” na página 264).

2. No Property inspector, aberto a partir da seleção de Window (Janela)  > Properties 
(Propriedades), digite um valor no campo de texto W (L) para a largura da coluna ou no 
campo de texto H (A) para a altura da linha.

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.

3. Pressione a tecla Tab ou Enter (no Windows) ou Return (no Macintosh) para aplicar o 
valor.

Tópicos relacionados
■ “Redimensionar uma tabela” na página 270
■ “Limpar larguras e alturas definidas” na página 273
■ “Exibir larguras e menus de tabelas e colunas” na página 274

D
IC

A

É possível especificar larguras e alturas como pixels ou porcentagens e também 
converter de pixels para porcentagens e vice-versa.
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Tornar as larguras das colunas consistentes com as 
larguras visuais
Se você vir dois números para a largura de uma coluna, isso significa que a largura de coluna 
definida no código HTML não reflete a largura aparente da coluna na tela. É possível tornar a 
largura especificada no código consistente com a largura visual. Para obter mais informações, 
consulte “Sobre as tabelas” na página 258.

Para tornar as larguras consistentes:

1. Clique em uma célula.

2. Clique no menu do cabeçalho da tabela e selecione Make All Widths Consistent (Tornar 
consistentes todas as larguras).

O Dreamweaver redefine a largura especificada no código para que ela corresponda à 
largura visual.

Tópicos relacionados
■ “Redimensionar uma tabela” na página 270
■ “Redimensionar colunas e linhas” na página 271

Limpar larguras e alturas definidas
Talvez seja preciso limpar as larguras e alturas definidas antes de redimensionar uma tabela ou 
caso haja problemas no redimensionamento de uma tabela ou de colunas ou linhas individuais 
e você deseje reiniciar o processo.

Para limpar todas as larguras ou alturas definidas em uma tabela:

1. Selecione a tabela (consulte “Selecionar uma tabela” na página 263).

N
O

T
A

Ao redimensionar uma tabela arrastando uma de suas alças de seleção, o tamanho 
visual das células da tabela é alterado, mas não é alterada nenhuma das larguras ou 
alturas especificadas das células. É recomendável limpar larguras e alturas definidas 
antes do redimensionamento.
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2. Siga um dos procedimentos abaixo:

■ Selecione Modify (Modificar)  > Table (Tabela)  > Clear Cell Widths (Limpar larguras 
das células) ou Modify > Table > Clear Cell Heights (Limpar alturas das células).

■ No Property inspector (Inspetor de propriedades), aberto a partir da seleção de 
Window (Janela) > Properties (Propriedades), clique no botão Clear Row Heights 
(Limpar as alturas das linhas) ou no botão Clear Column Widths (Limpar as larguras 
das colunas). 

■ Clique no menu do cabeçalho da tabela e selecione Clear All Heights (Limpar todas as 
alturas) ou Clear All Widths (Limpar todas as larguras).

Para limpar a largura definida de uma coluna:

1. Clique na coluna.

2. Clique no menu de cabeçalho da coluna e selecione Clear Column Width.

Tópicos relacionados
■ “Redimensionar uma tabela” na página 270
■ “Redimensionar colunas e linhas” na página 271
■ “Tornar as larguras das colunas consistentes com as larguras visuais” na página 273

Exibir larguras e menus de tabelas e colunas
O Dreamweaver exibe larguras de tabelas e colunas, juntamente com setas para acesso ao 
menu de cabeçalhos de tabelas e ao menu de cabeçalhos de colunas, quando uma tabela é 
selecionada ou quando o ponto de inserção está na tabela. Para obter mais informações, 
consulte “Sobre as tabelas” na página 258. Você pode ativar ou desativar as larguras e os 
menus, conforme a necessidade.

Para ativar ou desativar as larguras e os menus de tabelas e colunas, siga um 
destes procedimentos:

■ Selecione View (Exibir) > Visual Aids (Auxílios visuais) > Table Widths (Larguras da 
tabela). 
274 Capítulo 8:  Apresentar conteúdo com tabelas



         
■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) na tabela e, em seguida, selecione Table (Tabela) > Table 
Widths.

Tópicos relacionados
■ “Redimensionar uma tabela” na página 270
■ “Redimensionar colunas e linhas” na página 271

Adicionar e remover linhas e colunas  
Para adicionar e remover linhas e colunas, utilize o comando Modify (Modificar) > Table 
(Tabela) ou o menus dos cabeçalhos das colunas.

Para adicionar uma única linha ou coluna:

1. Clique em uma célula.

2. Siga um dos procedimentos abaixo:

■ Selecione Modify (Modificar) > Table (Tabela) > Insert Row (Inserir linha) ou Modify 
(Modificar) > Table (Tabela) > Insert Column (Inserir coluna).
Uma linha é exibida acima do ponto de inserção ou uma coluna é exibida à esquerda 
do ponto de inserção.

■ Clique no menu do cabeçalho da coluna e selecione Insert Column Left (Inserir 
coluna à esquerda) ou Insert Column Right (Inserir coluna à direita).

Uma coluna é exibida à esquerda ou à direita do ponto de inserção.

Para adicionar múltiplas linhas ou colunas:

1. Clique em uma célula.

2. Selecione Modify (Modificar) > Table (Tabela) > Insert Rows or Columns (Inserir linhas 
ou colunas).

Será exibida a caixa de diálogo Insert Rows or Columns.

D
IC

A

Quando você pressiona Tab na última célula de uma tabela, outra linha é adicionada 
automaticamente à tabela.
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3. Selecione Rows (Linhas) ou Columns (Colunas) e, em seguida, preencha a caixa de diálogo. 

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

As linhas ou colunas são exibidas na tabela.

Para excluir uma linha ou coluna, siga um dos procedimentos abaixo:

■ Clique em uma célula da linha ou coluna que deseja excluir e selecione Modify 
(Modificar) > Table (Tabela) > Delete Row (Excluir linha)  ou Modify (Modificar) > Table 
(Tabela) > Delete Column (Excluir coluna).

■ Selecione a linha ou coluna inteira (consulte“Selecionar linhas ou colunas” na página 264) 
e selecione Edit (Editar) > Clear (Limpar) ou pressione a tecla Delete.

A linha ou coluna inteira desaparece da tabela.

Para adicionar ou excluir linhas ou colunas utilizando o Property inspector 
(Inspetor de propriedades):

1. Selecione a tabela (consulte “Selecionar uma tabela” na página 263).

2. No Property inspector, aberto a partir da seleção de Window (Janela) > Properties 
(Propriedades), siga um dos procedimentos abaixo:

■ Aumente ou diminua o valor de Rows (Linhas) para adicionar ou excluir linhas.
O Dreamweaver permite adicionar e remover linhas na parte inferior da tabela.

■ Aumente ou diminua o valor de Cols (Colunas) para adicionar ou excluir colunas.
O Dreamweaver adiciona e remove colunas à direita da tabela.

Tópicos relacionados
■ “Inserir uma tabela repetitiva” na página 351
■ “Exibir vários resultados de recordsets” na página 806

Dividir e mesclar células 
Utilize o Property inspector (Inspetor de propriedades) ou os comandos do submenu Modify 
(Modificar)  > Table (Tabela) para dividir ou mesclar células. Para obter mais informações, 
consulte “Sobre a divisão e a mesclagem de células da tabela” na página 259.

N
O

T
A

O Dreamweaver não avisa quando as linhas ou colunas que contêm dados estão 
sendo excluídas.
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Como método alternativo para mesclar e dividir células, o Dreamweaver também fornece 
ferramentas para aumentar e diminuir o número de linhas ou colunas estendidas por uma 
célula.

Para mesclar duas ou mais células de uma tabela: 

1. Selecione as células em uma linha contígua, usando o formato retangular. 

Na ilustração a seguir, a seleção é um retângulo de células, por isso elas podem ser 
mescladas. 

Na ilustração a seguir, a seleção não é retangular, por isso as células não podem ser 
mescladas.

2. Siga um dos procedimentos abaixo:

■ Select Modify (Modificar) > Table (Tabela) > Merge Cells (Mesclar células).
■ No Property inspector expandido, aberto a partir da seleção de Window (Janela) > 

Properties (Propriedades), clique no botão Merge Cells (Mesclar células).

O conteúdo das células individuais é colocado na célula mesclada resultante. As 
propriedades da primeira célula selecionada são aplicadas à célula mesclada.

Para dividir uma célula:

1. Clique na célula.

2. Siga um dos procedimentos abaixo:

■ Selecione Modify (Modificar) > Table (Tabela) > Split Cells (Dividir células). 

N
O

T
A

Se você não vir o botão, clique na seta localizada no canto inferior direito do 
Property inspector para ver todas as opções.
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■ No Property inspector, aberto a partir da seleção de Window > Properties, clique no 
botão Split Cells.

3. Na caixa de diálogo Split Cell (Dividir célula), especifique o modo como a célula deve ser 
dividida.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Para aumentar ou diminuir o número de linhas ou colunas estendidas por uma 
célula:

1. Selecione uma célula.

2. Siga um dos procedimentos abaixo:

■ Selecione Modify (Modificar) > Table (Tabela) > Increase Row Span (Aumentar a 
extensão da linha) ou Modify  > Table  > Increase Column Span (Aumentar a extensão 
da coluna).

■ Selecione Modify  > Table  > Decrease Row Span (Diminuir a extensão da linha) ou 
Modify  > Table  > Decrease Column Span (Diminuir a extensão da coluna).

Copiar, colar e excluir células
É possível copiar, colar ou excluir uma única célula da tabela ou múltiplas células de uma só 
vez. conservando sua formatação.

As células podem ser coladas no ponto de inserção ou no lugar de uma seleção feita em uma 
tabela existente. Na colagem de várias células de tabela, o conteúdo da área de transferência 
deve ser compatível com a estrutura da tabela ou da parte selecionada na tabela em que 
as células serão coladas.

N
O

T
A

Se você não vir o botão, clique na seta localizada no canto inferior direito do 
Property inspector para ver todas as opções.
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Para recortar ou copiar células da tabela:

1. Selecione uma ou múltiplas células em uma linha contígua, usando o formato retangular. 

Na ilustração a seguir, a seleção é um retângulo de células, por isso as células podem ser 
recortadas ou copiadas. 

Na ilustração a seguir, a seleção não é um retângulo, por isso as células não podem ser 
recortadas ou copiadas. 

2. Selecione Edit (Editar) > Cut (Recortar) ou Edit  > Copy (Copiar). 

Para colar as células da tabela:

1. Selecione onde deseja colar as células:

■ Para substituir as células existentes pelas células que estão sendo coladas, selecione um 
conjunto de células existentes com o mesmo layout das células que estão na área de 
transferência. 
Por exemplo: se um bloco de células 3 x 2 for copiado ou recortado, é possível 
selecionar outro bloco de células 3 x 2 para substituir aquele por colagem.

■ Para colar uma linha inteira de células acima de uma determinada célula, clique nesta 
célula.

N
O

T
A

Se uma linha ou coluna inteira tiver sido selecionada e a opção Edit  > Cut tiver sido 
escolhida, a linha ou coluna inteira será removida da tabela (não apenas o conteúdo 
das células).
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■ Para colar uma coluna inteira de células à esquerda de uma determinada célula, clique 
nesta célula.

■ Para criar uma nova tabela com as células coladas, coloque o ponto de inserção fora da 
tabela.

2. Selecione Edit (Editar) > Paste (Colar). 

Se forem coladas linhas ou colunas inteiras em uma tabela existente, elas serão adicionadas 
à tabela. Se estiver colando um célula separada, o conteúdo da célula selecionada será 
substituído. Se a colagem tiver que ser feita fora de uma tabela, as linhas, colunas ou 
células serão utilizadas para definir uma nova tabela.

Para remover o conteúdo das células e mantê-las intactas:

1. Selecione uma ou mais células. 

2. Selecione Edit (Editar) > Clear (Limpar) ou pressione a tecla Delete. 

Para excluir linhas ou colunas que contêm células mescladas:

1. Selecione a linha ou coluna.

2. Selecione Modify (Modificar) > Table (Tabela) > Delete Row (Excluir linha) ou Modify  > 
Table  > Delete Column (Excluir coluna).

N
O

T
A

Se houver menos de uma linha ou coluna inteira de células na área de 
transferência e o usuário clicar em uma célula e colar as células da área de 
transferência, a célula clicada e as células vizinhas poderão ser substituídas 
pelas células que estão sendo coladas (dependendo de sua posição na tabela).

N
O

T
A

A seleção não pode ser composta inteiramente de linhas ou colunas completas.

N
O

T
A

Se forem selecionadas somente linhas ou colunas completas ao escolher Edit  > 
Clear ou ao pressionar a tecla Delete, as linhas ou colunas inteiras serão removidas 
da tabela (não somente seu conteúdo).
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Aninhar tabelas
Uma tabela aninhada é uma tabela dentro de uma célula de outra tabela. É possível formatar 
uma tabela aninhada como qualquer outra tabela, contudo, sua largura está limitada pela 
largura da célula na qual é exibida.

Para aninhar uma tabela na célula de uma tabela:

1. Clique em uma célula da tabela existente.

2. Selecione Insert (Inserir)  >  Table (Tabela).

A caixa de diálogo Insert Table (Inserir tabela) é exibida.
3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

A tabela é exibida na tabela existente.

Ordenar tabelas
É possível ordenar as linhas de uma tabela com base no conteúdo de uma única coluna. 
Também é possível fazer uma ordenação mais complexa da tabela com base no conteúdo de 
duas colunas.

Não é possível ordenar tabelas que contenham os atributos colspan ou rowspan — isto é, 
aquelas que comportam células mescladas. Para obter mais informações, consulte “Dividir e 
mesclar células” na página 276.

Para ordenar uma tabela:

1. Selecione a tabela (consulte “Selecionar uma tabela” na página 263) ou clique em uma 
célula qualquer.
Ordenar tabelas 281



         
2. Selecione Commands (Comandos) > Sort Table (Ordenar tabela).

A caixa de diálogo Sort Table é exibida.
3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.
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CAPÍTULO 9

Criação de páginas no 
modo Layout
Um método comum de se criar um layout de página consiste na utilização de tabelas HTML 
para posicionar os elementos. No entanto, pode ser difícil utilizar tabelas para layouts, pois 
elas foram criadas originalmente para exibir dados tabulares e não para definir o layout de 
páginas da Web. Para dinamizar o processo de utilização de tabelas para o layout de página, o 
Macromedia Dreamweaver 8 fornece o modo Layout. 

No modo Layout, é possível criar uma página utilizando tabelas como a estrutura básica, ao 
mesmo tempo em que se evitam alguns dos problemas que ocorrem com freqüência na criação 
de projetos baseados em tabelas através dos meios convencionais. 

Este capítulo contém as seções a seguir:
Sobre o modo Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .284

Alternar do modo Standard (Padrão) para o modo Layout  . . . . . . . . . . . . . . . . . . .288

Desenhar no modo Layout. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .289

Adicionar conteúdo a uma célula de layout  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .293

Limpar automaticamente as alturas das células . . . . . . . . . . . . . . . . . . . . . . . . . . . . 295

Redimensionar e mover células e tabelas de layout . . . . . . . . . . . . . . . . . . . . . . . . . 295

Formatar células e tabelas de layout  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .297

Definir a largura da coluna . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .298

Definir preferência para o modo Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302

N
O

T
A

Para mais informações sobre o trabalho com tabelas no modo Standard, veja Capítulo 8, 
“Apresentar conteúdo com tabelas”, na página 257. Ou, como alternativa ao uso de 
tabelas nos modos Standard ou Layout, você pode usar o posicionamento CSS para 
criar o layout das páginas (veja “Inserir tags div no layout” na página 244).
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Sobre o modo Layout
No modo Layout, você usa células e tabelas de layout para  criar o layout da página antes de 
incluir conteúdo. Por exemplo, seria possível desenhar uma célula na parte superior da página 
para conter um gráfico de cabeçalho, outra célula no lado esquerdo da página para conter uma 
barra de navegação e uma terceira célula, à direita, para o conteúdo. Ao adicionar conteúdo, 
você pode mover as células o quanto for necessário para ajustar o seu layout.

As tabelas de layout aparecem com uma borda verde na página; as células de layout aparecem 
com uma borda azul na página. (Para modificar as cores de borda padrão, veja “Definir 
preferência para o modo Layout” na página 302.) Quando você move o ponteiro sobre uma 
célula da tabela, o Dreamweaver realça essa célula. (Para ativar ou desativar o realce ou para 
alterar a cor de realce, consulte “Desenhar células e tabelas de layout” na página 289.) 

É possível definir o layout de uma página utilizando várias células de layout dentro de uma 
tabela de layout - que é o método mais comum para a definição do layout de uma página na 
Web - ou utilizar diversas tabelas de layout separadas para layouts mais complexos. O uso de 
diversas tabelas de layout isola seções do layout, de modo que não possam ser afetadas por 
alterações feitas em outras seções.

D
IC

A

Para maior flexibilidade, você pode desenhar cada célula apenas quando tiver acabado 
de adicionar conteúdo nela. Isso permite que você disponha de mais espaço na tabela 
de layout por mais tempo, de modo que possa mover ou redimensionar células com mais 
facilidade.
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Também é possível aninhar tabelas de layout ao inserir uma nova tabela de layout dentro de 
uma tabela existente (veja “Desenhar uma tabela de layout aninhada” na página 292). Esta 
estrutura permite simplificar a estrutura da tabela quando as linhas ou coluna em uma parte 
do layout não estiveram alinhadas com as linhas ou colunas em outra parte do layout. Por 
exemplo, ao utilizar tabelas de layout aninhadas seria possível criar facilmente um layout com 
duas colunas e quatro linhas na coluna esquerda e três linhas na coluna direita. 

Tópicos relacionados
■ “Alternar do modo Standard (Padrão) para o modo Layout” na página 288
■ “Desenhar no modo Layout” na página 289

Como ver tabelas e células no modo Layout
As larguras de tabelas e células de layout (em pixels ou em um percentual da largura da página) 
aparecem na parte superior ou inferior da tabela quando ela é selecionada ou quando o ponto 
de inserção se encontra na tabela. Ao lado das larguras, encontram-se setas que indicam o 
menu de cabeçalho da tabela e os menus de cabeçalho de colunas. Use os menus para ter 
acesso rápido a alguns dos comandos mais comuns.

Eventualmente, a largura pode não aparecer para uma coluna; você provavelmente verá o 
seguinte:

■ Sem largura. Se você não vir uma largura para a tabela ou para a coluna, isso significa que 
a tabela ou coluna não possuem uma largura específica no código HTML. Para especificar 
uma largura fixa, veja “Criando uma coluna com alongamento automático ou com largura 
fixa” na página 299.

■ Dois números. Se aparecerem dois números, a largura visual que aparece no modo Design 
não coincide com o que foi especificado no código HTML. Isto poderá ocorrer quando a 
tabela é redimensionada arrastando seu canto inferior direito ou quando o conteúdo 
adicionado a uma célula é maior do que a largura definida para essa célula.

N
O

T
A

Para desativar larguras de colunas, guias de tabela e menus de cabeçalho, é preciso 
desativar todos os recursos visuais [View (Visualizar) > Visual Aids (Recursos visuais) > 
Hide All (Ocultar todos)].
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Por exemplo, se a largura da coluna for definida como 200 pixels, ao adicionar conteúdo 
que aumente a largura para 250 pixels, dois números aparecerão na parte superior dessa 
coluna: 200 (a largura especificada no código) e (250) entre parênteses (a largura visual da 
coluna, na forma como ele é processada na sua tela). 
Para compatibilizar as duas larguras de coluna, veja “Tornar as larguras das colunas 
consistentes com as larguras visuais” na página 301.

■ Linha ondulada. Uma linha ondulada aparece para as colunas que estão configuradas com 
alongamento automático. Para obter informações sobre a definição do alongamento 
automático de uma coluna, veja “Criando uma coluna com alongamento automático ou 
com largura fixa” na página 299.

■ Barras duplas. Colunas que contêm imagens espacejadoras possuem barras duplas em volta 
da largura da coluna. Para obter informações sobre as imagens, veja “Utilizar imagens 
espaçadoras” na página 300.

Tópicos relacionados
■ “Definir a largura da coluna” na página 298

Linhas de grade de tabelas e células de layout
Quando você desenha uma célula de layout em uma tabela de layout, uma grade de linhas 
sutil aparece, indo das bordas de uma célula de layout qualquer até as bordas da tabela de 
layout que a contém. Estas linhas ajudam a alinhar as novas células às células antigas e 
visualizar a estrutura da tabela HTML oculta. 

No Dreamweaver, as extremidades das novas células são alinhadas automaticamente com as 
extremidades das células existentes. As células de layout não podem ser sobrepostas. As 
extremidades da célula também se encaixam automaticamente às extremidades da tabela de 
layout que contém a célula se uma célula for desenhada próxima à extremidade de uma tabela. 

Você também pode usar a grade do Dreamweaver, que é pré-configurada e que não se 
modifica em função do posicionamento das células, para criar o layout da sua página (veja 
“Utilizar uma imagem de rastreamento” na página 254).

Tópicos relacionados
■ “Sobre o modo Layout” na página 284
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Largura das colunas com tamanho fixo e colunas 
com alongamento automático
Uma coluna da tabela no modo Layout pode ter uma largura fixa ou uma largura que se 
expande automaticamente para preencher o máximo possível a janela do navegador  
(alongamento automático). 

Colunas de largura fixa possuem uma largura numérica específica, como 300 pixels. O 
Dreamweaver exibe a largura de cada coluna com largura fixa na parte superior ou inferior da 
coluna. 

Colunas com alongamento automático se modificam automaticamente dependendo da 
largura da janela do navegador. Se o layout incluir uma coluna com alongamento automático, 
ele sempre preencherá a largura inteira da janela do navegador do visitante. É possível fazer 
com que somente uma coluna de uma determinada tabela de layout seja alongada 
automaticamente. Uma coluna com alongamento automático exibe uma linha ondulada na 
área de largura da coluna. 

Um método de layout comum consiste em provocar o alongamento automático da coluna que 
comporta o conteúdo principal da página, o que define automaticamente todas as outras 
colunas para uma largura fixa. Por exemplo: suponha que o layout tenha uma imagem grande 
à esquerda da página e uma coluna de texto à direita. É possível definir a coluna da esquerda 
com uma largura fixa e provocar o alongamento automático da área da barra lateral.

Ao provocar o alongamento automático de uma coluna, o Dreamweaver insere imagens 
espaçadoras nas colunas com largura fixa para assegurar que essas colunas tenham a largura 
apropriada, a menos que seja especificado que nenhuma imagem espaçadora deva ser 
utilizada. Uma imagem espaçadora é uma imagem transparente utilizada para controlar o 
espaçamento, mas não fica visível na janela do navegador. 

Tópicos relacionados
■ “Criando uma coluna com alongamento automático ou com largura fixa” na página 299

Imagens espaçadoras
Uma imagem espaçadora (também conhecida como GIF de espaçamento) é uma imagem 
transparente utilizada para controlar o espaçamento em tabelas com alongamento automático. 
Uma imagem espaçadora consiste em uma imagem GIF transparente de um único pixel 
alongada para ter um número específico de pixels. O navegador não pode desenhar uma 
coluna da tabela mais estreita do que a imagem mais larga contida em uma célula daquela 
coluna. Por isso, a inserção de uma imagem espaçadora em uma coluna da tabela exigirá que 
os navegadores mantenham a coluna ao menos com a mesma largura da imagem.
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O Dreamweaver adiciona automaticamente imagens espaçadoras ao definir uma coluna para 
alongamento automático, a menos que seja determinado que nenhuma imagem espaçadora 
deva ser utilizada. É possível inserir e remover imagens espaçadoras manualmente em cada 
coluna, se preferir. As colunas que contêm imagens espaçadoras têm uma barra dupla na área 
da largura da coluna.

É possível inserir e remover manualmente as imagens espaçadoras de colunas específicas ou 
remover todas as imagens espaçadoras da página.

Tópicos relacionados
■ “Utilizar imagens espaçadoras” na página 300

Alternar do modo Standard (Padrão) 
para o modo Layout
Para poder desenhar tabelas de layout ou células de layout, é necessário alternar do modo 
Standard (Padrão) para o modo Layout. É mais fácil criar tabelas para layout no modo Layout 
do que no modo Standard, mas é recomendável retornar ao modo Standard antes de adicionar 
conteúdo ou editar as tabelas.

Para passar modo Layout:

1. Se você estiver no modo de exibição Code, selecione View (Exibir) > Design ou View > 
Code and Design (Código e design).

Não é possível mudar para o modo Layout no modo de exibição Code.
2. Siga um dos procedimentos abaixo:

■ Selecione View (Exibir) > Table Mode (Modo da tabela) > Layout Mode (Modo 
Layout).

■ Na categoria Layout da barra Insert, clique no botão Modo Layout.

Uma barra com o nome Layout Mode (Modo Layout) aparece ao longo da parte superior da 
janela Document (Documento). Se houver tabelas nesta página, serão exibidas como tabelas 
de layout.

N
O

T
A

Se o usuário criar uma tabela no modo Standard e depois alternar para o modo 
Layout,, a tabela de layout resultante poderá conter células de layout vazias. Talvez seja 
preciso excluir essas células de layout vazias para poder criar novas células de layout ou 
mover as célula de layout pela tabela. 
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A fim de mudar para o modo Layout, faça o seguinte:

■ Clique em Exit (Sair) na barra com o nome Layout Mode na parte superior da janela 
Document.

■ Selecione View (Exibir) > Table Mode (Modo da tabela) > Layout Mode (Modo Layout).
■ Na categoria Layout da barra Insert, clique no botão Modo Standard.

O Dreamweaver volta para o modo Standard.

Desenhar no modo Layout
O modo Layout permite desenhar células e tabelas, incluindo tabelas aninhadas em outras 
tabelas. A grade de encaixe o ajudará a alinhar as células (veja “Utilizar uma imagem de 
rastreamento” na página 254).

Desenhar células e tabelas de layout
É possível desenhar células e tabelas de layout na página enquanto se está no modo Layout. Ao 
desenhar uma célula de layout fora de uma tabela de layout, o Dreamweaver cria 
automaticamente uma tabela de layout como um recipiente para a célula. Uma célula de 
layout não pode existir fora de uma tabela de layout.

Quando o Dreamweaver cria uma tabela de layout de modo automático, a tabela é exibida 
inicialmente para preencher toda a visualização do projeto, mesmo que o tamanho da janela 
do documento seja alterado. Esta tabela de layout padrão que ocupa todo o espaço da janela 
permite desenhar células de layout em qualquer local na visualização do projeto. É possível 
definir um tamanho específico para a tabela clicando na borda da tabela e arrastando suas alças 
de redimensionamento.

Quando você passa o cursor sobre uma célula de layout, o Dreamweaver aplica realce a ela. 
Você pode ativar ou desativar o realce ou alterar a cor de realce na caixa de diálogo Preferences 
(Preferências).

Para desenhar uma célula de layout:

1. Verifique se está no modo Layout (veja “Alternar do modo Standard (Padrão) para o modo 
Layout” na página 288).

N
O

T
A

No modo Layout, é impossível utilizar as ferramentas Insert Table (Inserir tabela) e Draw 
Layer (Desenhar camada) como no modo Standard (Padrão). Para utilizar estas 
ferramentas, é necessário primeiro alternar para o modo Standard (Padrão).
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2. Na categoria Layout da barra Insert, clique no botão Draw Layout Cell (Desenhar célula 
de layout).

O ponteiro é convertido em uma cruz (+).
3. Posicione o ponteiro onde deseja iniciar a célula na página e arraste-o para criar a célula de 

layout. 

Se você desenhar a célula próximo à borda da tabela de layout, as bordas da célula 
automaticamente se alinham à tabela de layout em que estão contidas. Para desativar 
temporariamente o encaixe, mantenha pressionada a tecla Alt (no Windows) ou a tecla 
Option (no Macintosh) ao desenhar a célula.

A célula será exibida contornada em azul na página. Para alterar a cor de contorno, veja 
“Definir preferência para o modo Layout” na página 302.

Para desenhar uma tabela de layout:

1. Verifique se está no modo Layout (veja “Alternar do modo Standard (Padrão) para o modo 
Layout” na página 288). 

2. Na categoria Layout da barra Insert, clique no botão Draw Layout Table (Desenhar tabela 
de layout).

O ponteiro é convertido em uma cruz (+).
3. Posicione o ponteiro do mouse na página e arraste-o para criar a tabela de layout. 

D
IC

A

Para desenhar mais de uma célula de layout sem ter que selecionar repetidamente 
Draw Layout Cell (Desenhar célula de layout), mantenha a tecla Control (no 
Windows) ou Command (no Macintosh) pressionada enquanto arrasta o mouse para 
desenhar a célula de layout. É possível continuar a desenhar células de layout uma 
após a outra, contanto que não solte a tecla Control ou Command.

D
IC

A
Para desenhar mais de uma tabela de layout sem ter que selecionar repetidamente 
Draw Layout Table (Desenhar tabela de layout), mantenha a tecla Control (no 
Windows) ou Command (no Macintosh) pressionada enquanto arrasta o mouse para 
desenhar a tabela de layout. É possível continuar a desenhar tabelas de layout uma 
após a outra, contanto que não solte a tecla Control ou Command.
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É possível criar uma tabela de layout em uma área vazia do layout da página, ao redor de 
células e tabelas de layout existentes ou mesmo aninhada em uma tabela de layout 
existente. Se a página possui conteúdo e você desejar adicionar uma tabela de layout, é 
possível desenhar uma nova tabela de layout somente abaixo da parte inferior do conteúdo 
existente. 

A tabela de layout é exibida com um contorno verde na página. Para alterar a cor de contorno, 
veja “Definir preferência para o modo Layout” na página 302.

Para alterar as preferências de realce de células de layout:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.
2. Selecione Highlighting (Realce) na lista de categorias à esquerda.

3. Faça uma dessas alterações:

■ Para alterar a cor de realce, clique na caixa de cores e, em seguida, selecione a cor de 
realce utilizando o seletor de cores (ou digite o valor hexadecimal correspondente à cor 
de realce na caixa de texto). 
Para obter informações sobre como utilizar o seletor de cores, consulte “Trabalhar com 
cores” na página 384.

■ Para ativar ou desativar o realce, marque ou desmarque a caixa de seleção Show 
(Exibir) de Mouse-Over (Mouse sobre).

4. Clique em OK.

D
IC

A

Se tentar desenhar uma tabela de layout sob um conteúdo existente e o ponteiro não 
disponível surgir, tente redimensionar a janela do documento para aumentar o 
espaço em branco entre a parte inferior do conteúdo existente e a parte inferior da 
janela.

N
O

T
A

As tabelas não podem se sobrepor umas às outras, mas uma tabela pode ser 
totalmente inserida em outra tabela. Para obter mais informações, consulte 
“Desenhar uma tabela de layout aninhada” na página 292.

N
O

T
A

Essas opções afetam todos os objetos, como tabelas e camadas, que o 
Dreamweaver realça quando você passa o cursor do mouse sobre elas. 
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Desenhar uma tabela de layout aninhada
É possível desenhar uma tabela de layout dentro de outra tabela de layout para criar uma 
tabela aninhada. As células internas de uma tabela aninhada não podem ser modificadas em 
relação à tabela externa, por exemplo: ao modificar o tamanho de uma linha ou coluna na 
tabela externa, o tamanho das células da tabela interna não é modificado.

É possível inserir diversos níveis de tabelas aninhadas. Uma tabela de layout aninhada não 
pode ser maior do que a tabela que a contém.

Para desenhar uma tabela de layout aninhada:

1. Verifique se está no modo Layout (veja “Alternar do modo Standard (Padrão) para o modo 
Layout” na página 288).

2. Na categoria Layout da barra Insert, clique no botão Draw Layout Table (Desenhar tabela 
de layout).

O ponteiro é convertido em uma cruz (+).
3. Aponte para qualquer área vazia (cinza) em uma tabela de layout existente e, em seguida, 

arraste para criar a tabela de layout aninhada.

N
O

T
A

Se uma tabela de layout for desenhada no centro da página antes de uma célula de 
layout ser desenhada, a tabela desenhada será aninhada automaticamente dentro de 
uma tabela maior.

N
O

T
A

É impossível criar uma tabela de layout dentro de uma célula de layout. Só é possível 
criar uma tabela de layout aninhada em uma área vazia de uma tabela de layout 
existente ou ao redor de células existentes.
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Para desenhar uma tabela de layout ao redor de células ou tabelas de layout já 
existentes:

1. Verifique se está no modo Layout (veja “Alternar do modo Standard (Padrão) para o modo 
Layout” na página 288).

2. Na categoria Layout da barra Insert, clique no botão Draw Layout Table (Desenhar tabela 
de layout).

O ponteiro é convertido em uma cruz (+).
3. Arraste o ponteiro para desenhar um retângulo ao redor de um conjunto de células ou 

tabelas de layout existentes.

É exibida uma tabela de layout aninhada, incluindo as células ou tabelas existentes.

Adicionar conteúdo a uma célula de 
layout
É possível adicionar texto, imagens e outros tipos de conteúdo às células de layout no modo 
Layout, do mesmo modo que o conteúdo é adicionado às células da tabela no modo Standard 
(Padrão). Clique na célula onde deverá ser adicionado o conteúdo e, em seguida, digite o texto 
ou inserir outro conteúdo.

É possível inserir conteúdo apenas em uma célula de layout, mas não em uma área vazia 
(cinza) de uma tabela de layout. Desse modo, para poder adicionar conteúdo, é necessário 
primeiro criar as células de layout (veja “Desenhar no modo Layout” na página 289).

Para adicionar texto a uma célula de layout:

1. Coloque o ponto de inserção na célula de layout em que deseja adicionar texto.

2. Siga um dos procedimentos abaixo:

■ Digite o texto na célula. 
A célula se expande automaticamente à medida que um texto é digitado, se necessário.

■ Cole o texto copiado de outro documento. 
Para obter mais informações, consulte “Inserir texto” na página 418.

D
IC

A

Para encaixar perfeitamente uma célula de layout em uma das bordas da nova tabela 
aninhada, comece a arrastá-la próximo à borda da célula. A borda da nova tabela se 
encaixará à borda da célula. É impossível arrastar do centro de uma célula de layout, 
pois não se pode criar uma tabela de layout inteiramente no interior de uma célula de 
layout.
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Ao adicionar conteúdo maior do que a célula, a célula de layout se expandirá 
automaticamente. À medida que a célula se expande, a coluna onde a célula está localizada 
também se expande, o que pode alterar o tamanho da células circunvizinhas. A largura dessa 
coluna modifica-se para mostrar a largura que aparece no código, seguida da largura visual da 
coluna (a largura como aparece na tela do usuário) entre parênteses. Para obter mais 
informações sobre larguras de colunas, veja “Definir a largura da coluna” na página 298.

Para adicionar uma imagem a uma célula de layout:

1. Coloque o ponto de inserção na célula de layout em que deseja adicionar a imagem.

2. Siga um dos procedimentos abaixo:

■ Selecione Insert (Inserir) > Image (Imagem).
■ Na categoria Common (Comuns) da barra Insert, clique na seta suspensa do botão 

Images (Imagens) e selecione Images.

A caixa de diálogo Select Image Source (Selecionar origem da imagem) é exibida.
3. Selecione um arquivo de imagem.

Para obter mais informações, consulte “Inserir uma imagem” na página 448.
4. Clique em OK.

A imagem é exibida na célula de layout.

D
IC

A

Se o botão Image estiver exibido (como no exemplo a seguir) na barra Insert, 
você pode clicar no botão em vez de usar o menu pop-up.
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Limpar automaticamente as alturas das 
células
Ao criar uma célula de layout, o Dreamweaver especifica automaticamente uma altura para a 
célula, de modo que ela seja exibida com a altura selecionada mesmo que estiver vazia. Após 
inserir conteúdo na célula, talvez não seja mais preciso especificar a altura; por isso é possível 
remover da tabela as alturas da célula.

Para limpar as alturas da célula, siga um dos procedimentos abaixo:

■ Clique no menu de cabeçalho da tabela e selecione Clear All Heights (Redefinir todas as 
alturas).

■ Selecione uma tabela de layout, clicando na guia exibida na parte superior da tabela e 
clique no botão Clear Row Heights (Limpar as alturas das colunas) do inspetor Property 
(Propriedades), aberto a partir da seleção de Window (Janela) > Properties (Propriedades). 

O Dreamweaver limpa todas as alturas especificadas na tabela. Algumas células da tabela 
podem encolher verticalmente.

Redimensionar e mover células e tabelas 
de layout
Para ajustar o layout da página, é possível mover e redimensionar células de layout e tabelas de 
layout aninhadas (a parte externa da tabela só pode ser redimensionada).

Redimensionar e mover células de layout
É possível redimensionar ou mover células de layout, mas elas não podem ser sobrepostas. É 
impossível mover ou redimensionar uma célula para que ela ultrapasse os limites da tabela de 
layout que a contém. Uma célula de layout não pode ser reduzida a um tamanho menor do 
que seu conteúdo.
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Para utilizar a grade do Dreamweaver como guia ao mover ou redimensionar as células e 
tabelas, veja “Utilizar uma imagem de rastreamento” na página 254.
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Para obter informações sobre como redimensionar e mover células de layout, veja 
“Redimensionar e mover tabelas de layout” na página 296.

Para redimensionar uma célula de layout:

1. Selecione uma célula clicando em uma extremidade desta ou mantendo a tecla Control 
pressionada (no Windows) ou a tecla Command (no Macintosh) e clique em qualquer local 
da célula.

São exibidas alças de seleção ao redor da célula.
2. Arraste uma alça de seleção para redimensionar a célula.

As extremidades da célula encaixam-se automaticamente para se alinhar com as 
extremidades de outras células.

Para mover uma célula de layout:

1. Selecione uma célula clicando em uma extremidade desta ou mantendo a tecla Control 
pressionada (no Windows) ou a tecla Command (no Macintosh) e clique em qualquer local 
da célula.

São exibidas alças de seleção ao redor da célula.
2. Siga um dos procedimentos abaixo:

■ Arraste a célula para outro local dentro da tabela de layout.
■ Pressione as teclas de seta para mover a célula 1 pixel por vez. 

Redimensionar e mover tabelas de layout
Uma tabela de layout não pode ser redimensionada a um tamanho menor do que o menor 
retângulo que contém todas as suas células. Uma tabela de layout também não pode ser 
redimensionada de modo que sobreponha outras tabelas ou células.

Para redimensionar e mover células de layout, veja “Redimensionar e mover células de layout” 
na página 295.
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Mantenha pressionada a tecla Shift ao utilizar as teclas de seta para mover a 
célula 10 pixels de cada vez.
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Para redimensionar uma tabela de layout:

1. Selecione uma tabela clicando na guia, na parte superior da tabela.

São exibidas alças de seleção ao redor da tabela.
2. Arraste as alças de seleção para redimensionar a tabela.

As extremidades da tabela encaixam-se automaticamente para se alinhar com as 
extremidades de outras células e tabelas.

Para mover uma tabela de layout:

1. Selecione uma tabela clicando na guia, na parte superior da tabela.

São exibidas alças de seleção ao redor da tabela.

2. Siga um dos procedimentos abaixo:

■ Arraste a tabela para outro local na página.
■ Pressione as teclas de seta para mover a tabela 1 pixel por vez. 

Formatar células e tabelas de layout
É possível alterar a aparência de qualquer célula ou tabela de layout utilizando o inspetor de 
propriedades. 

Formatar células de layout
É possível definir vários atributos de uma célula de layout no inspetor Property 
(Propriedades), incluindo largura e altura, cor de fundo e alinhamento do conteúdo da célula.

Para formatar uma célula de layout no inspetor Property (Propriedades):

1. Selecione uma célula clicando em uma extremidade desta ou mantendo a tecla Control 
pressionada (no Windows) ou a tecla Command (no Macintosh) e clique em qualquer local 
da célula.
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É possível mover uma tabela de layout somente se ela estiver aninhada no interior de 
outra tabela de layout.
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Mantenha pressionada a tecla Shift ao utilizar as teclas de seta para mover a 
tabela 10 pixels de cada vez.
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2. Abra o inspetor Property (Propriedades), a partir da seleção de Window (Janela) > 
Properties (Propriedades), se ele ainda não estiver aberto.

3. Modifique a formatação da célula definindo as propriedades. 

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.

Formatar tabelas de layout
É possível definir vários atributos de uma tabela de layout no inspetor Property, como largura, 
altura, preenchimento e espaçamento. 

Para formatar uma tabela de layout:

1. Selecione uma tabela clicando na guia, na parte superior da tabela. 

2. Abra o inspetor Property (Propriedades), a partir da seleção de Window (Janela) > 
Properties (Propriedades), se ele ainda não estiver aberto.

3. Altere a formatação da tabela definindo as propriedades. 

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.

Definir a largura da coluna
É possível definir uma largura específica para uma coluna ou expandi-la para que ocupe o 
espaço máximo possível de uma janela do navegador. Também é possível especificar uma 
largura mínima para uma coluna usando uma imagem espaçadora. 

Algumas vezes, as larguras das colunas da tabela definidas no código HTML não 
correspondem às suas larguras aparentes na tela. Quando isso acontecer, você pode tornar as 
larguras iguais. 
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Criando uma coluna com alongamento automático ou 
com largura fixa
Uma coluna em uma tabela pode ter largura fixa ou alongamento automático. Para obter mais 
informações, consulte “Largura das colunas com tamanho fixo e colunas com alongamento 
automático” na página 287.

Provocar o alongamento automático de uma coluna antes de o layout estar completo pode 
causar efeitos inesperados no layout da tabela. Para evitar que as colunas se tornem mais largas 
ou estreitas além do esperado, finalize o layout e utilizar imagens espaçadoras antes de 
provocar o alongamento automático de uma coluna. No entanto, se cada coluna comporta 
outro conteúdo que mantém a coluna com a largura desejada, não é necessário utilizar 
imagens espaçadoras.

Para provocar o alongamento automático da coluna:

1. Siga um dos procedimentos abaixo:

■ Clique no menu de cabeçalho da coluna e selecione Make Column Autostretch (Criar 
coluna com alongamento automático).

■ Selecione uma célula na coluna clicando em uma extremidade da célula e, em seguida, 
clique em Autostretch (Alongamento automático) no inspetor Property 
(Propriedades).

Se você não definiu uma imagem espacejadora para esse site, aparece a caixa de diálogo 
Choose Spacer Image (Escolher imagem espacejadora).

2. Se a caixa de diálogo Choose Spacer Image (Escolher imagem epacejadora) aparecer, 
selecione uma opção e, em seguida, clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Uma linha ondulada aparece na parte superior ou inferior da coluna com alongamento 
automático. Barras duplas aparecem na parte superior ou inferior de colunas que contêm 
imagens espacejadoras.
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É possível alongar automaticamente apenas uma coluna de uma determinada 
tabela.
Definir a largura da coluna 299



         
Para definir uma largura fixa para a coluna, siga um dos procedimentos 
abaixo:

■ Clique no menu de cabeçalho da coluna e depois selecione Make Column Fixed Width 
(Criar coluna de largura fixa). 
A opção Make Column Fixed Width (Criar coluna de largura fixa) especifica uma largura 
para a coluna (no código) que corresponde à largura visual da coluna.

■ Selecione uma célula na coluna clicando em uma extremidade da célula, clique em Fixed 
(Fixa) e digite um valor numérico no inspetor Property (Propriedades).
Se o usuário inserir um valor numérico menor que a largura do conteúdo da coluna, o 
Dreamweaver definirá automaticamente a largura para corresponder à largura do 
conteúdo.

A largura de uma coluna aparece na parte superior ou inferior da coluna.

Tópicos relacionados
■ “Tornar as larguras das colunas consistentes com as larguras visuais” na página 301

Utilizar imagens espaçadoras
Para fazer uma coluna ter uma determinada largura mínima, é possível inserir uma imagem 
espaçadora nessa coluna. Para obter mais informações, consulte “Imagens espaçadoras” na 
página 287. Você pode remover imagens espacejadoras a partir de uma coluna ou de uma 
tabela inteira.

Na primeira vez que insere uma imagem espacejadora, você define uma imagem espacejadora 
para o site. Você pode definir preferências para imagens espacejadoras (veja “Definir 
preferência para o modo Layout” na página 302).

Para inserir uma imagem espaçadora em uma coluna:

1. Clique no menu do cabeçalho da coluna e, em seguida, selecione Add Spacer Image 
(Adicionar imagem espacejadora).

Se você não definiu uma imagem espacejadora para esse site, aparece a caixa de diálogo 
Choose Spacer Image (Escolher imagem espacejadora).

2. Se a caixa de diálogo Choose Spacer Image (Escolher imagem epacejadora) aparecer, 
selecione uma opção e, em seguida, clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
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O Dreamweaver insere a imagem espacejadora na coluna. A imagem não fica visível, mas a 
coluna pode se deslocar ligeiramente e apresentar uma barra dupla na parte superior ou 
inferior, para indicar que a coluna contém uma imagem espaçadora.

Para remover uma imagem espaçadora de uma coluna:

■ Clique no menu do cabeçalho da coluna e, em seguida, selecione Remove Spacer Image 
(Remover imagem espacejadora).

O Dreamweaver remove a imagem espacejadora. A coluna pode sofrer um deslocamento. 

Para remover todas as imagens espaçadoras de uma tabela, siga um dos 
procedimentos abaixo:

■ Clique no menu de cabeçalho da tabela e, em seguida, selecione Remove All Spacer Images 
(Remover todas as imagens espacejadoras).

■ Selecione a tabela e clique no botão Remove All Spacers (Remover todos os espaçadores) 
do inspetor Property (Propriedades), aberto a partir da seleção de Window (Janela)  > 
Properties (Propriedades).

O layout de toda a tabela pode ser modificado. Se algumas colunas não comportarem 
conteúdo, elas poderão desaparecer completamente da visualização do projeto.

Tornar as larguras das colunas consistentes com as 
larguras visuais
Se você vir dois números para a largura de uma coluna, isso significa que a largura de coluna 
definida no código HTML não reflete a largura aparente da coluna na tela. É possível tornar a 
largura especificada no código consistente com a largura visual. Para obter mais informações, 
consulte “Como ver tabelas e células no modo Layout” na página 285.

Para tornar as larguras consistentes:

1. Clique em uma célula.

2. Siga um dos procedimentos abaixo:

■ Clique no menu do cabeçalho da tabela e depois selecione Make All Widths 
Consistent (Tornar consistentes todas as larguras).
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■ Selecione a tabela e clique no botão Remove All Spacers (Remover todos os 
espaçadores) do inspetor Property (Propriedades), aberto a partir da seleção de 
Window (Janela) > Properties (Propriedades).

O Dreamweaver redefine a largura especificada no código para que ela corresponda à 
largura visual.

Tópicos relacionados
■ “Criando uma coluna com alongamento automático ou com largura fixa” na página 299
■ “Utilizar imagens espaçadoras” na página 300

Definir preferência para o modo Layout
Você pode especificar preferências para arquivos de imagem espacejadora e para as cores que o 
Dreamweaver usa ao desenhar tabelas de layout e células de layout.

Para definir as preferências do modo Layout:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.
2. Selecione Layout View (Visualização de layout), na lista de categorias, à esquerda.

3. Faça as alterações necessárias.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.
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CAPÍTULO 10

Utilização de quadros
Os quadros possibilitam dividir uma janela do navegador em várias regiões, podendo cada 
uma exibir um documento HTML diferente. Na utilização mais comum dos quadros, um 
quadro exibe um documento que contém controles de navegação, enquanto o outro exibe um 
documento com conteúdo.

Este capítulo contém as seguintes seções:
Sobre quadros e conjuntos de quadros. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 303

Trabalhar com conjuntos de quadros na janela do documento . . . . . . . . . . . . . . . 309

Criar quadros e conjuntos de quadros . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 309

Selecionar quadros e conjuntos de quadros  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313

Abrir um documento em um quadro. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 316

Salvar arquivos de quadros e de conjuntos de quadros  . . . . . . . . . . . . . . . . . . . . . . 316

Visualização e definição de propriedades e atributos de quadros. . . . . . . . . . . . . . 318

Exibir e definir propriedades de conjuntos de quadros  . . . . . . . . . . . . . . . . . . . . . . 320

Controlar o conteúdo de quadros com links. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 321

Lidar com um navegador que não pode exibir quadros. . . . . . . . . . . . . . . . . . . . . . .323

Utilizar comportamentos JavaScript com quadros  . . . . . . . . . . . . . . . . . . . . . . . . . .323

Sobre quadros e conjuntos de quadros 
Um quadro é uma região de uma janela do navegador que pode exibir um documento HTML 
independentemente do que está sendo exibido no restante da janela do navegador.
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Uma discussão detalhada sobre todas as maneiras de projetar e utilizar quadros, bem 
como o código necessário para codificação manual, está além do escopo deste capítulo. 
Se forem necessárias informações detalhadas sobre o código utilizado em layouts de 
quadro avançados, consulte um documento sobre quadros e conjuntos de quadros.
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Um conjunto de quadros é um arquivo HTML que define o layout e as propriedades de uma 
série de quadros, inclusive o número de quadros, seu tamanho e posicionamento, bem como a 
URL da página a ser inicialmente exibida em cada quadro. O arquivo do conjunto de quadros 
em si não contém código HTML a ser exibido em um navegador, exceto na seção noframes 
(consulte “Lidar com um navegador que não pode exibir quadros” na página 323). O arquivo 
do conjunto de quadros apenas fornece informações para o navegador sobre a aparência que 
um conjunto de quadros deve ter e que documentos devem ser exibidos nele.

Tópicos relacionados
■ “Trabalhar com conjuntos de quadros na janela do documento” na página 309
■ “Criar quadros e conjuntos de quadros” na página 309

Quadros e conjuntos de quadros 
Um quadro é uma região de uma janela do navegador que pode exibir um documento HTML 
independentemente do que está sendo exibido no restante da janela do navegador. Um 
conjunto de quadros é um arquivo HTML que define o layout e as propriedades de uma série 
de quadros. 

Para exibir um conjunto de quadros em um navegador, digite a URL do arquivo do conjunto 
de quadros. O navegador abrirá os documentos relevantes para exibição nos quadros. O 
arquivo do conjunto de quadros de um site é geralmente denominado index.html, para que 
ele seja exibido como padrão se um visitante não especificar um nome de arquivo.
304 Capítulo 10:  Utilização de quadros



         
O exemplo a seguir mostra um layout de quadro que consiste em três quadros: um quadro 
estreito lateral que contém uma barra de navegação, outra na parte superior com o logotipo e 
o nome do site da Web, e um quadro grande que ocupa o restante da página e acomoda o 
conteúdo principal. Cada um desses quadros exibe um documento HTML distinto.

Neste exemplo: o documento exibido no quadro superior nunca se altera à medida que o 
visitante navega pelo site. A barra de navegação do quadro lateral contém links. Clique em um 
desses links para alterar o conteúdo do quadro principal de conteúdo, mas o conteúdo do 
próprio quadro lateral permanece inalterado. O quadro principal de conteúdo à direita exibe o 
documento adequado para qualquer link em que o visitante clique à esquerda.

Observe que um quadro não é um arquivo. Pode-se considerar o documento atualmente 
exibido em um quadro como uma parte integrante do quadro, mas na realidade o documento 
não faz parte dele. O quadro é um recipiente que armazena o documento; qualquer quadro 
pode exibir qualquer documento.

Um site que é exibido em um navegador como uma página única compreendendo três 
quadros consiste, na verdade, de pelo menos quatro documentos HTML distintos: o arquivo 
do conjunto de quadros e os três documentos que comportam o conteúdo que é exibido 
inicialmente dentro dos quadros. Quando uma página for projetada utilizando conjuntos de 
quadros no Dreamweaver, esses quatro arquivos deverão ser salvos, para que a página funcione 
corretamente no navegador.
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A palavra página pode ser utilizada livremente em referência a um único documento 
HTML ou a todo o conteúdo de uma janela do navegador em determinado momento, 
mesmo que vários documentos HTML estejam sendo exibidos simultaneamente.  A 
frase “uma página que utiliza quadros”, por exemplo, normalmente refere-se a um 
conjunto de quadros e aos documentos que são exibidos inicialmente nesses quadros.
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Tópicos relacionados
■ “Conjuntos de quadros aninhados” na página 307

Decidir se um quadro será utilizado
A utilização mais comum de quadros é para navegação. Um conjunto de quadros geralmente 
inclui um quadro contendo uma barra de navegação e outro quadro para exibir as páginas 
principais de conteúdo. 

Entretanto, projetar com quadros pode ser confuso e, em muitos casos, é possível criar uma 
página da Web sem quadros, atingindo muitos dos mesmos objetivos de um conjunto de 
quadros. Por exemplo: se você desejar que a barra de navegação seja exibida no lado esquerdo 
da página, substitua a página por um conjunto de quadros ou apenas inclua a barra de 
navegação em cada página do site (O Dreamweaver ajuda a criar várias páginas que utilizam o 
mesmo layout (veja “Sobre modelos do Dreamweaver” na página 326). A imagem a seguir 
mostra um projeto de página com um layout semelhante a quadro, mas que não 
utiliza quadros.

Muitos designers da Web profissionais preferem não utilizar quadros, e muitas pessoas que 
navegam na Web não as apreciam. Na maioria dos casos, isso é devido à existência de sites que 
utilizam mal ou desnecessariamente os quadros (como um conjunto de quadros que recarrega 
o conteúdo dos quadros de navegação todas as vezes em que um visitante clica em um botão 
de navegação). Se os quadros forem bem utilizados (quando são utilizados para manter os 
controles de navegação estáticos em um quadro enquanto permitem que o conteúdo de outro 
quadro se altere), eles podem ser muito úteis para alguns sites.
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Nem todos os navegadores fornecem um bom suporte a quadros e podem ser difíceis de 
navegar para visitantes portadores de deficiências. Portanto, se usar quadros, sempre inclua 
uma seção noframes no conjunto de quadros para os visitantes que não podem vê-los 
(consulte “Lidar com um navegador que não pode exibir quadros” na página 323). Ofereça 
também um link explícito para uma versão sem quadros do site, para visitantes com 
navegadores que ofereçam suporte a quadros mas que não gostem de usá-los.

As vantagens de utilizar quadros são as seguintes:

■ O navegador de um visitante não precisa recarregar imagens relacionadas à navegação para 
cada página. 

■ Cada quadro tem sua própria barra de rolagem (se o conteúdo for muito grande para caber 
em uma janela) para que um visitante possa rolar os quadros independentemente. 
Por exemplo: se um visitante usar a barra de rolagem para ir para a parte inferior de uma 
longa página de conteúdo em um quadro, não precisará voltar para a parte superior para 
usar a barra de navegação, se ela estiver em outro quadro.

As desvantagens de se utilizar quadros incluem:

■ O alinhamento gráfico preciso dos elementos em diversos quadros pode ser difícil.
■ O teste de navegação pode consumir muito tempo.
■ As URLs das páginas individuais com quadros não são exibidas no navegador; portanto, 

pode ser difícil para um visitante incluir um marcador em uma página específica (exceto se 
for fornecido o código do servidor que permite ao visitante carregar uma versão com 
quadros de determinada página).

Tópicos relacionados
■ “Quadros e conjuntos de quadros” na página 304
■ “Lidar com um navegador que não pode exibir quadros” na página 323

Conjuntos de quadros aninhados 
Um conjunto de quadros que estiver dentro de outro é denominado um conjunto aninhado 
de quadros. Um único arquivo do conjunto de quadros pode conter vários conjuntos de 
quadros aninhados. A maioria das páginas da Web que utilizam quadros contém quadros 
aninhados e muitos dos conjuntos de quadros predefinidos no Dreamweaver também utilizam 
o aninhamento. Qualquer conjunto de quadros em que houver números diferentes de quadros 
em linhas ou colunas distintas requer um conjunto de quadros aninhado.
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Por exemplo: o layout de quadros mais comum tem um quadro na linha da parte superior 
(onde é exibido o logotipo da empresa) e dois quadros na linha da parte inferior (um quadro 
de navegação e um quadro de conteúdo). Esse layout requer um conjunto de quadros 
aninhado: um conjunto de quadros de duas linhas, com um conjunto de quadros de duas 
colunas aninhado na segunda linha 

O Dreamweaver se encarrega do aninhamento de conjuntos de quadros, se necessário. Se 
forem utilizadas ferramentas para divisão de quadros no Dreamweaver, não é necessário se 
preocupar com os detalhes de quais quadros são aninhados ou não. Para obter mais 
informações sobre essas ferramentas, consulte “Criar um conjunto de quadros” na página 312.

Há duas maneiras de aninhar conjuntos de quadros em HTML: o conjunto de quadros 
interno pode ser definido no mesmo arquivo que o do conjunto de quadros externo ou em um 
arquivo próprio distinto. Cada conjunto de quadros predefinido no Dreamweaver define 
todos os seus conjuntos de quadros no mesmo arquivo.

Os dois tipos de aninhamento produzem os mesmos resultados visuais. Não é fácil diferenciar, 
sem examinar o código, o tipo de aninhamento que está sendo utilizado. A situação mais 
provável na qual um arquivo de conjunto de quadros externo seria utilizado no Dreamweaver 
seria quando o comando Abrir no quadro é utilizado para abrir um arquivo do conjunto de 
quadros dentro de um quadro. Isto poderia resultar em problemas ao definir destinos para os 
links. Em geral é mais simples manter todos os conjuntos de quadros definidos em um único 
arquivo.

Tópicos relacionados
■ “Quadros e conjuntos de quadros” na página 304
■ “Decidir se um quadro será utilizado” na página 306

Conjunto de quadros principal

Os quadros do menu e do 
conteúdo estão aninhados dentro 
do conjunto de quadros principal
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Trabalhar com conjuntos de quadros na 
janela do documento
O Dreamweaver permite exibir e editar todos os documentos associados a um conjunto de 
quadros em uma única janela do documento. Essa abordagem permite exibir 
aproximadamente como as páginas com quadros são exibidas em um navegador, à medida que 
são editadas. Entretanto, alguns aspectos dessa abordagem podem ser confusos, até que se 
tornem familiares.

Lembre-se, especialmente, que cada quadro exibe um documento HTML distinto. Mesmo 
que os documentos estejam vazios, é necessário salvá-los antes de poder visualizá-los (porque o 
conjunto de quadros pode ser visualizado com precisão apenas se ele contiver a URL de um 
documento a ser exibido em cada quadro).

Para garantir que seu conjunto de quadros será corretamente exibido em 
navegadores: 

1. Crie seu conjunto de quadros e especifique um documento para ser exibido em cada quadro 
(consulte “Criar quadros e conjuntos de quadros” na página 309).

2. Salve todos os arquivos que aparecerão em um quadro (consulte “Salvar arquivos de 
quadros e de conjuntos de quadros” na página 316). 

Lembre-se de que cada quadro exibe um documento HTML específico e você deve salvar 
cada documento junto com o arquivo do conjunto de quadros.

3. Defina as propriedades de cada quadro e do conjunto de quadros (consulte “Visualização e 
definição de propriedades e atributos de quadros” na página 318 e “Exibir e definir 
propriedades de conjuntos de quadros” na página 320).

Isso inclui o nome de cada quadro e a definição de opções fixas e de rolagem, entre outros 
4. Certifique-se de que foi definida a propriedade Target (Destino) no Property inspector 

(Inspetor de propriedades) para todos os seus links, de forma que o conteúdo com links seja 
exibido na área correta (veja “Controlar o conteúdo de quadros com links” na página 321).

Criar quadros e conjuntos de quadros
Há duas maneiras de criar um conjunto de quadros no Dreamweaver: você pode selecioná-lo 
entre vários conjuntos de quadros predefinidos ou criar um novo. 

A seleção de um conjunto de quadros predefinido configura automaticamente todos os 
conjuntos de quadros e os quadros necessários à criação do layout, e é a maneira mais fácil de 
criar rapidamente um layout com base em quadros. Só é possível inserir um conjunto de 
quadros predefinido na visualização do projeto da janela do documento.
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Utilizar um conjunto de quadros predefinido
Os conjuntos de quadros predefinidos permitem selecionar facilmente o tipo de conjunto de 
quadros que você deseja criar. Se preferir criar o seu próprio conjunto de quadros, consulte 
“Criar um conjunto de quadros” na página 312.

Há duas maneiras de criar um conjunto predefinido de quadros: 

■ A barra Insert (Inserir) permite criar um conjunto de quadros e exibir o documento atual 
em um dos novos quadros criados.

■ A caixa de diálogo New Document (Novo documento) cria um novo conjunto de quadros 
vazio.

Para criar um conjunto de quadros predefinido e exibir um documento 
existente em um quadro:

1. Coloque o ponto de inserção em um documento. 

2. Siga um dos procedimentos abaixo:

■ Selecione um conjunto de quadros predefinido no submenu Insert (Inserir)>  HTML 
> Frames (Quadros).

■ Na categoria Layout da barra Insert (Inserir), clique na seta drop-down do botão 
Frames (Quadros) e selecione um conjunto de quadros predefinido.
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Os ícones dos conjuntos de quadros fornecem uma representação visual de cada conjunto 
de quadros conforme aplicado ao documento atual. A área azul de um ícone de conjunto 
de quadros representa o documento atual e as áreas brancas representam quadros que 
exibem outros documentos.

A caixa de diálogo Frame Tag Accessibility Attributes (Atributos de acessibilidade de tags 
de quadros) aparecerá se você tiver configurado o Dreamweaver para solicitar-lhe atributos 
de acessibilidade de quadro (consulte “Otimizar a área de trabalho para o projeto de 
página acessível” na página 76).

3. Se a caixa de diálogo Frame Tag Accessibility Attributes (Atributos de acessibilidade de tags 
de quadros) for exibida, preencha-a para cada quadro e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Para editar atributos de acessibilidade da tag de quadros, consulte “Visualização e 
definição de propriedades e atributos de quadros” na página 318.

Para criar um novo conjunto de quadros predefinido vazio:

1. Selecione File (Arquivo) > New (Novo).

2. Na caixa de diálogo New Document (Novo documento), selecione a categoria Framesets 
(Conjuntos de quadros).

N
O

T
A

Ao aplicar um conjunto de quadros, o Dreamweaver automaticamente configura o 
conjunto de quadros para exibir o documento atual (o documento no qual o ponto de 
inserção está localizado) em um dos quadros. 

N
O

T
A

Caso clique em Cancel (Cancelar), o conjunto de quadros será exibido no 
documento, mas o Dreamweaver não associará tags ou atributos de acessibilidade a 
ele.
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3. Selecione um conjunto de quadros na lista Framesets (Conjuntos de quadros).

4. Clique em Create (Criar).

O conjunto de quadros é exibido no seu documento e a caixa de diálogo Frame Tag 
Accessibility Attributes (Atributos de acessibilidade da tag de quadros) é exibida, se ela 
tiver sido ativada em Preferences (Preferências) (consulte “Otimizar a área de trabalho para 
o projeto de página acessível” na página 76).

5. Se a caixa de diálogo Frame Tag Accessibility Attributes (Atributos de acessibilidade da tag 
de quadros) for exibida, preencha-a para cada quadro e, em seguida, clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Para editar atributos de acessibilidade da tag de quadros, consulte “Visualização e 
definição de propriedades e atributos de quadros” na página 318.

Criar um conjunto de quadros 
É possível criar o seu próprio conjunto de quadros no Dreamweaver adicionando “divisores” à 
janela. Se preferir utilizar um conjunto de quadros predefinido, consulte “Utilizar um 
conjunto de quadros predefinido” na página 310.

Para criar um conjunto de quadros:

■ Selecione Modify (Modificar) > Frameset (Conjunto de quadros) e, em seguida, selecione 
um item de divisão, como Split Frame Left (Dividir o quadro para a esquerda) ou Split 
Frame Right (Dividir o quadro para a direita), no submenu.
O Dreamweaver divide a janela em quadros. Se houver um documento aberto, ele será 
exibido em um dos quadros.

Para dividir um quadro em quadros menores, siga um dos procedimentos 
abaixo:

■ Para dividir o quadro onde está posicionado o ponto de inserção, selecione um item de 
divisão no submenu Modify (Modificar) > Frameset (Conjunto de quadros).

■ Para dividir um quadro ou conjunto de quadros vertical ou horizontalmente, arraste uma 
borda do quadro da margem da visualização do projeto para o meio da visualização do 
projeto.

N
O

T
A

Caso pressione Cancel (Cancelar), o conjunto de quadros é exibido no documento, 
mas o Dreamweaver não associa tags de acessibilidade a ele.

D
IC

A

Antes de criar um conjunto de quadros ou de trabalhar com quadros, torne as bordas 
dos quadros visíveis na visualização do projeto da janela do documento, selecionando 
View (Exibir) > Visual Aids (Auxílios visuais) > Frame Borders (Bordas do quadro).
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■ Para dividir um quadro utilizando uma borda de quadro que não está na margem da 
visualização do projeto, mantenha pressionada a tecla Alt (no Windows) e arraste a borda 
do quadro.

■ Para dividir um quadro em quatro quadros, arraste uma borda do quadro de uma das 
margens da visualização do projeto para o meio de um quadro. 

Para excluir um quadro:

■ Arraste a borda do quadro para fora da página ou até a borda do quadro principal.
Se houver conteúdo não salvo de um documento localizado em um quadro que esteja 
sendo removido, o Dreamweaver solicitará que o documento seja salvo.

Para redimensionar um quadro, faça o seguinte:

■ Para definir tamanhos aproximados de quadros, arraste as bordas do quadro na 
visualização do projeto da janela do documento.

■ Use o Property Inspetor (Inspetor de propriedades) para especificar os tamanhos exatos e o 
espaço que o navegador alocará para uma linha ou coluna de quadros quando o tamanho 
da janela do navegador não permitir que os quadros sejam exibidos no tamanho máxim 
(consulte “Exibir e definir propriedades de conjuntos de quadros” na página 320).

Selecionar quadros e conjuntos de 
quadros 
Para fazer alterações nas propriedades de um quadro ou de um conjunto de quadros, comece 
selecionando o quadro ou o conjunto de quadros que deseja modificar. É possível selecionar 
um quadro ou um conjunto de quadros na janela do documento ou utilizar o painel Frames 
(Quadros).

D
IC

A

Para criar três quadros, inicie com dois quadros e depois divida um deles. Não é fácil 
mesclar dois quadros adjacentes sem editar o código do conjunto de quadros, 
portanto, transformar quatro quadros em três é mais difícil do que transformar dois 
quadros em três.

N
O

T
A

É impossível remover um conjunto de quadros inteiro arrastando as bordas. Para 
remover um conjunto de quadros, feche a janela do documento que o exibe. Se o 
arquivo do conjunto de quadros tiver sido salvo, exclua o arquivo.
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Selecionar quadros e conjuntos de quadros no painel 
Frames (Quadros) 
O painel Frames (Quadros) fornece uma representação visual dos quadros em um conjunto de 
quadros. Ele mostra a hierarquia da estrutura do conjunto de quadros de uma forma que pode 
não ser visível na janela do documento. Nesse painel, uma borda tridimensional muito espessa 
envolve cada conjunto de quadros. Cada quadro é contornado por uma linha fina cinza e é 
identificado por um nome de quadro.

Para exibir o painel Frames (Quadros):

■ Selecione Window (Janela) > Frames (Quadros).

Para selecionar um quadro no painel Frames (Quadros):

■ Clique no quadro, no painel Frames (Quadros).
Um contorno da seleção é exibido ao redor do quadro, tanto no painel Frames (Quadros) 
quanto na visualização do projeto na janela do documento.

Para selecionar um conjunto de quadros no painel Frames (Quadros):

■ Clique na borda que circunda os quadros, no painel Frames (Quadros).
Um contorno da seleção é exibido ao redor do conjunto de quadros, tanto no painel 
Frames (Quadros) quanto na visualização do projeto na janela do documento.

Tópicos relacionados
■ “Visualização e definição de propriedades e atributos de quadros” na página 318
■ “Exibir e definir propriedades de conjuntos de quadros” na página 320
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Selecionar quadros e conjuntos de quadros na janela 
do documento
Na visualização do projeto da janela do documento, quando um quadro é selecionado, suas 
bordas são marcadas com uma linha pontilhada. Quando um conjunto de quadros é 
selecionado, todas as bordas dos quadros nesse conjunto são marcadas com uma linha 
pontilhada leve.

Para selecionar um quadro na janela do documento:

■ Pressione a tecla Alt (no Windows), ou as teclas Shift-Option (no Macintosh), e clique 
dentro de um quadro na visualização do projeto.
Um contorno da seleção é exibido ao redor do quadro.

Para selecionar um conjunto de quadros na janela do documento:

■ Clique em uma das bordas do quadro interna do conjunto de quadros na visualização do 
projeto. As bordas do quadro devem estar visíveis para que isso seja possível. Selecione 
View (Exibir) >Visual Aids (Auxílios visuais)> Frame Borders (Bordas do quadro) para 
tornar as bordas do quadro visíveis, caso não estejam.
Um contorno da seleção é exibido ao redor do conjunto de quadros.

Para selecionar outro quadro ou conjunto de quadros, siga um dos 
procedimentos abaixo:

■ Para selecionar o quadro ou conjunto de quadros anterior ou seguinte no mesmo nível 
hierárquico que a seleção atual, pressione Alt e seta para a esquerda ou Alt e seta para a 
direita (Windows) ou Command e seta para a esquerda ou Command e seta para a direita 
(Macintosh). Ao utilizar essas teclas, é possível alternar os quadros e conjuntos de quadros 
na ordem na qual eles são definidos no arquivo do conjunto de quadros.

■ Para selecionar o conjunto-mãe de quadros (o conjunto de quadros que contém a seleção 
atual), pressione Alt+Seta para Cima (Windows) ou Command+Seta para Cima 
(Macintosh).

N
O

T
A

Colocar o ponto de inserção em um documento que é exibido em um quadro não é o 
mesmo que selecionar um quadro. Há várias operações (como definir propriedades do 
quadro) nas quais é preciso selecionar um quadro.

N
O

T
A

Em geral é mais fácil selecionar conjuntos de quadros no painel Frames (Quadros) 
do que na janela do documento. Para obter mais informações, consulte “Selecionar 
quadros e conjuntos de quadros no painel Frames (Quadros)” na página 314.
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■ Para selecionar o primeiro quadro filho ou conjunto de quadros do conjunto de quadros 
atualmente selecionado (isto é, o primeiro na ordem em que estão definidos no arquivo do 
conjunto de quadros), pressione Alt+Seta para Baixo (Windows) ou Command+Seta para 
Baixo (Macintosh).

Tópicos relacionados
■ “Selecionar quadros e conjuntos de quadros no painel Frames (Quadros)” na página 314
■ “Visualização e definição de propriedades e atributos de quadros” na página 318
■ “Exibir e definir propriedades de conjuntos de quadros” na página 320

Abrir um documento em um quadro
Pode-se especificar o conteúdo inicial de um quadro inserindo o novo conteúdo em um 
documento vazio em um quadro ou abrindo um documento existente em um quadro.

Para abrir um documento existente em um quadro:

1. Coloque o ponto de inserção em um quadro.

2. Selecione File (File) > Open in Frame (Abrir no quadro).

3. Selecione um documento a ser aberto no quadro e clique em OK (Windows) ou em Choose 
(Escolher) (Macintosh).

O documento será exibido no quadro.
4. (Opcional) Para tornar esse o documento padrão a ser exibido no quadro quando o 

conjunto de quadros for aberto em um navegador, salve o conjunto de quadros. 

Salvar arquivos de quadros e de 
conjuntos de quadros
Para visualizar um conjunto de quadros em um navegador, você deve salvar o arquivo do 
conjunto de quadros e todos os documentos que serão exibidos nos quadros. É possível salvar 
cada arquivo do conjunto de quadros e o documento com quadro individualmente ou salvar o 
arquivo do conjunto de quadros e todos os documentos exibidos em quadros de uma só vez.

N
O

T
A

Ao utilizar ferramentas visuais no Dreamweaver para criar um conjunto de quadros, cada 
novo documento que é exibido em um quadro recebe um nome de arquivo padrão. Por 
exemplo: o primeiro arquivo do conjunto de quadros é denominado UntitledFrameset-1, 
enquanto o primeiro documento em um quadro é denominado UntitledFrame-1.
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Para salvar um arquivo de conjunto de quadros:

1. Selecione o conjunto de quadros no painel Frames (Quadros) ou na janela do documento 
(consulte “Selecionar quadros e conjuntos de quadros” na página 313).

2. Siga um dos procedimentos abaixo:

■ Para salvar o arquivo do conjunto de quadros, selecione File (Arquivo) > Frameset 
(Salvar conjunto de quadros).

■ Para salvar um novo arquivo de conjunto de quadros, selecione File (Arquivo) > Save 
Frameset As (Salvar conjunto de quadros como).

Caso o arquivo do conjunto de quadros não tenha sido salvo anteriormente, os dois 
comandos serão equivalentes.

Para salvar um documento que é exibido em um quadro:

■ Clique no quadro e selecione File (Arquivo) >  Save Frame (Salvar quadro) ou File > 
Save Frame As (Salvar quadro como).

Para salvar todos os arquivos associados a um conjunto de quadros:

■ Selecione File (Arquivo) > Save All Frames (Salvar todos os quadros).
Salvar arquivos de quadros e de conjuntos de quadros 317



         
Isso salvará todos os documentos abertos no conjunto de quadros, incluindo o arquivo do 
conjunto de quadros e todos os documentos com quadro. Se o arquivo do conjunto de 
quadros ainda não tiver sido salvo, uma borda mais espessa será exibida ao redor do 
conjunto de quadros na visualização do projeto e uma caixa de diálogo permitirá escolher 
um nome de arquivo. Para cada quadro que ainda não tiver sido salvo, será exibida uma 
borda mais espessa ao redor do quadro e uma caixa de diálogo permitirá escolher um 
nome de arquivo.

Visualização e definição de propriedades 
e atributos de quadros
Utilize o Property inspector (Inspetor de propriedades) para exibir e definir a maioria das 
propriedades do quadro.

Você também pode definir alguns atributos de quadros, como o atributo de título (que é 
diferente do atributo de nome), para aumentar a acessibilidade. Você pode ativar a opção de 
autoria de acessibilidade de quadros para definir atributos ao criar quadros (consulte 
“Otimizar a área de trabalho para o projeto de página acessível” na página 76) ou pode definir 
atributos após inserir um quadro. Para editar atributos de acessibilidade de um quadro, você 
pode usar o Tag inspector (Inspetor de tags) para editar o código HTML diretamente. 

Para definir propriedades para um conjunto de quadros, consulte “Exibir e definir 
propriedades de conjuntos de quadros” na página 320.

N
O

T
A

Se File (Arquivo) > Open in Frame (Abrir no quadro) tiver sido utilizado para abrir um 
documento em um quadro, ao salvar o conjunto de quadros, o documento aberto no 
quadro se tornará o documento padrão a ser exibido naquele quadro. Se não desejar 
que o documento seja o padrão, não salve o arquivo do conjunto de quadros.
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Para exibir ou definir as propriedades do quadro:

1. Selecione um quadro seguindo um dos procedimentos abaixo:

■ Mantenha pressionada a tecla Alt (no Windows), ou as teclas Shift-Option (no 
Macintosh), e clique em um quadro na visualização do projeto da janela do 
documento.

■ Clique em um quadro no painel Frames (Quadros)  (Window (Janela) > Frames 
(Quadros)).

2. No Property inspector (Inspetor de propriedades) (Window (Janela) > Properties 
(Propriedades)), clique na seta de expansão no canto inferior direito para exibir todas as 
propriedades do quadro. 

3. Faça as alterações necessárias.

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.

Para definir os valores de acessibilidade de um quadro:

1. No painel Frames (Quadros) (Window (Janela) > Frames (Quadros)), selecione um quadro 
posicionando o ponto de inserção em um dos quadros.

2. Selecione Modify (Modificar) > Edit Tag (Editar tag).

O Tag Editor (Editor de tags) será aberto.
3. Na lista de categorias à esquerda, selecione Style Sheet/Accessibility (Folha de estilos/

Acessibilidade).

4. Digite os valores desejados.

5. Clique em OK.

Para editar os valores de acessibilidade de um quadro:

1. Use as visualizações Code (Código) ou Code and Design (Código e design) do documento, 
caso esteja na visualização Design (Design).

2. No painel Frames (Quadros) (Window (Janela) > Frames (Quadros)), selecione um quadro 
posicionando o ponto de inserção em um dos quadros.

O Dreamweaver realça a tag do quadro no código.

D
IC

A

Para alterar a cor de fundo de um quadro, defina a cor de fundo do documento no 
quadro, nas propriedades de página.
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3. Clique com o botão direito (Windows) ou clique e mantenha pressionada a tecla Control 
(Macintosh) no código e selecione Edit Tag (Editar tag).

O Tag Editor (Editor de tags) será aberto.
4. Faça as alterações necessárias.

5. Clique em OK.

Para alterar a cor de fundo de um documento em um quadro:

1. Coloque o ponto de inserção no quadro.

2. Selecione Modify (Modificar) > Page Properties (Propriedades da página).

Será exibida a caixa de diálogo Page Properties.
3. Clique no menu pop-up Background (Fundo) e selecione uma cor.

4. Clique em OK.

Tópicos relacionados
■ “Criar quadros e conjuntos de quadros” na página 309

Exibir e definir propriedades de conjuntos 
de quadros
Utilize o Property inspector (Inspetor de propriedades) para exibir e definir a maioria das 
propriedades dos conjuntos de quadros. Para definir propriedades para um quadro, consulte 
“Visualização e definição de propriedades e atributos de quadros” na página 318.

Para exibir ou definir as propriedades de conjuntos de quadros:

1. Selecione um conjunto de quadros, seguindo um dos procedimentos abaixo:

■ Clique em uma borda entre dois quadros no conjunto de quadros da visualização do 
projeto da janela do documento.

■ Clique na borda que circunda um conjunto de quadros no painel Frames (Window > 
Frames). 
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2. No Property inspector (Inspetor de propriedades), em Window > Properties 
(Propriedades), clique na seta de expansão no canto inferior direito para exibir todas as 
propriedades do conjunto de quadros. 

3. Faça as alterações necessárias.

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.

Para definir um título para um documento do conjunto de quadros:

1. Selecione um conjunto de quadros, seguindo um dos procedimentos abaixo:

■ Clique em uma borda entre dois quadros no conjunto de quadros da visualização do 
projeto da janela do documento.

■ Clique na borda que circunda um conjunto de quadros no painel Frames (Window > 
Frames). 

2. No campo Title (Título) da barra de ferramentas Document (Documento), digite um 
nome para o documento do conjunto de quadros.

Quando um visitante exibe o conjunto de quadros em um navegador, o título é exibido na 
barra de títulos do navegador.

Tópicos relacionados
■ “Criar quadros e conjuntos de quadros” na página 309

Controlar o conteúdo de quadros com 
links
Para utilizar um link de um quadro para abrir um documento em outro quadro, é necessário 
definir um destino para o link. O atributo target de um link especifica a quadro ou janela na 
qual o conteúdo com link será aberto.
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Por exemplo: se a barra de navegação estiver no quadro esquerda e se desejar que o material 
com link seja exibido no quadro principal de conteúdo à direita, será necessário especificar o 
nome do quadro principal de conteúdo como destino para cada um dos links da barra de 
navegação. Quando um visitante clica em um link de navegação, o conteúdo especificado é 
aberto no quadro principal.

Para designar um quadro:

1. Na visualização do projeto, selecione um texto ou um objeto.

2. No campo Link do Property inspector (Inspetor de propriedades) (Window (Janela) > 
Properties (Proopriedades)), siga um destes procedimentos:

■ Clique no ícone da pasta e selecione o arquivo a ser vinculado.
■ Arraste o ícone Point to File (Apontar para arquivo) para o painel Files (Arquivos) para 

selecionar o arquivo ao qual se vincular. 
3. No menu pop-up Target (Destino) no Property inspector (Inspetor de propriedades), 

selecione o quadro ou janela no qual o documento vinculado deve aparecer:

■ _blank abre o documento vinculado em uma nova janela do navegador e deixa a 
janela atual inalterada. 

■ _parent abre o documento com link no conjunto-pai de quadros do quadro na qual o 
link será exibido, substituindo o conjunto de quadros inteiro.

■ _self abre o link no quadro atual, substituindo o conteúdo desse quadro. 
■ _top abre o documento vinculado na janela atual do navegador, substituindo todos os 

quadros.
Nomes de quadros também aparecem neste menu. Selecione um quadro com nome para 
abrir o documento vinculado nesse quadro.

N
O

T
A

Os nomes de quadro serão exibidos apenas ao editar um documento em um 
conjunto de quadros. Quando você edita um documento em sua janela Document 
(Documento), os nomes dos quadros não são exibidos no menu pop-up Target 
(Destino). Se estiver editando um documento fora do conjunto de quadros, você 
pode digitar o nome do quadro de destino na caixa de texto Target (Destino).

D
IC

A

Se estiver vinculando a uma página fora do seu site, utilizar sempre target="_top" 
ou target="_blank" para garantir que a página não pareça fazer parte do seu site.
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Lidar com um navegador que não pode 
exibir quadros
O Dreamweaver permite especificar o conteúdo a ser exibido em navegadores com base em 
texto e em navegadores gráficos mais antigos e sem suporte a quadros. Esse conteúdo é 
armazenado no arquivo do conjunto de quadros, contido em uma tag noframes. Quando um 
navegador sem suporte a quadros carrega o arquivo do conjunto de quadros, o navegador 
exibe apenas o conteúdo delimitado pela tag noframes.

Para definir o conteúdo para navegadores sem suporte a quadros:

1. Selecione Modify (Modificar) > Frameset (Conjunto de quadros) > Edit NoFrames 
Content (Editar conteúdo NoFrames).

O Dreamweaver limpará a visualização do projeto e a mensagem “NoFrames Content” 
(Conteúdo NoFrames) será exibida na parte superior da visualização do projeto.

2. Para criar o conteúdo NoFrames, siga um dos procedimentos abaixo:

■ Na janela do documento, digite ou insira o conteúdo do mesmo modo que seria feito 
em um documento normal.

■ Selecione Window (Janela) > Code Inspector (Inspetor de código), posicione o ponto 
de inserção entre as tags body que são exibidas dentro das tags noframes e digite o 
código HTML do conteúdo.

3. Selecione novamente Modify (Modificar) > Frameset (Conjunto de quadros)> Edit 
NoFrames Content (Editar conteúdo NoFrames) para retornar à exibição normal do 
documento com o conjunto de quadros.

Utilizar comportamentos JavaScript com 
quadros
Há vários comportamentos JavaScript e comandos relacionados à navegação que são 
particularmente apropriados para utilização com quadros.

N
O

T
A

O conteúdo na área noframes deve ser maior do que apenas uma observação que diz: 
“É necessário fazer upgrade para um navegador que pode lidar com quadros.” Algumas 
pessoas têm boas razões para utilizar um sistema que não permite a exibição de 
quadros. Tentar tornar o conteúdo o mais acessível possível para tais visitantes.
Utilizar comportamentos JavaScript com quadros 323



         
A ação Set Text of Frame (Definir o texto do quadro) substitui o conteúdo e a formatação 
de determinado quadro pelo conteúdo especificado. O conteúdo pode incluir qualquer 
HTML válido. Utilize esta ação para exibir informações dinamicamente em um quadro. 
Consulte “Set Text of Frame (Definir o texto do quadro)” na página 566.

A ação Go to URL (Ir para a URL) abre uma nova página na janela atual ou no quadro 
especificado. Esta ação é especialmente útil para alterar o conteúdo de dois ou mais quadros 
com um único clique. Consulte “Go to URL (Ir para a URL)” na página 559.

O comando Insert Navigation Bar (Inserir barra de navegação) adiciona uma barra de 
navegação a uma página; após inserir uma barra de navegação, é possível anexar 
comportamentos as suas imagens e definir qual imagem será exibida com base nas ações de um 
visitante. Por exemplo: uma imagem de botão pode ser mostrada no estado para cima ou para 
baixo, para permitir que o visitante saiba qual página de um site está sendo exibida. Consulte 
“Inserir uma barra de navegação” na página 486.

O comando Insert Jump Menu (Inserir menu de salto) configura uma lista de menu de links 
que abrem arquivos em uma janela do navegador quando clicados. Você também pode 
designar uma janela ou quadro em que o documento é aberto. Consulte “Inserir menus de 
salto” na página 483.
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CAPÍTULO 11

Gerenciar modelos
Um modelo do Dreamweaver 8 consiste em um tipo especial de documento que você pode 
usar para projetar um layout de página “fixo”; você pode criar documentos com base no 
modelo que herdar o layout de página do modelo. Ao projetar um modelo, você especifica 
quais áreas de documentos baseados no modelo podem ser editadas pelos usuários. 

Este capítulo contém as seguintes seções: 
Sobre modelos do Dreamweaver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .326

Criar um modelo no Dreamweaver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 340

Criar modelos para um site do Contribute. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 344

Criar regiões editáveis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .346

Criar regiões repetitivas  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 350

Usar regiões opcionais  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .353

Definir atributos de tag editáveis. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .356

Criar um modelo aninhado . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .357

Editar e atualizar modelos  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 359

Gerenciar modelos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .363

Exportar e importar o conteúdo XML de um modelo . . . . . . . . . . . . . . . . . . . . . . . . .364

Exportar um site sem markup de modelo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .365

Aplicar ou remover um modelo de um documento existente . . . . . . . . . . . . . . . . . .366

Editar conteúdo em um documento baseado em modelo. . . . . . . . . . . . . . . . . . . . .368

N
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Os modelos permitem controlar uma área de design maior e reutilizar layouts inteiros. Se 
quiser reutilizar elementos de design, como informações de direitos autorais ou um 
logotipo, você pode criar itens de biblioteca. Para obter mais informações, consulte 
Capítulo 5, “Gerenciar bibliotecas e propriedades de sites”, na página 177. 
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Sobre modelos do Dreamweaver 
O autor de um modelo projeta um layout de página “fixo” em um modelo. O autor cria então 
regiões em um modelo que podem ser editadas em documentos baseados nesse modelo; se o 
autor não definir uma região como editável, os usuários do modelo não poderão editar 
conteúdo nessa área. Os modelos permitem aos autores controlar os elementos da página que 
podem ser editados pelos usuários — redatores, artistas gráficos ou outros desenvolvedores de 
Web. Há vários tipos de regiões de modelo que o autor pode incluir em um documento.

Uma das principais e mais poderosas características dos modelos é sua capacidade de atualizar 
diversas páginas simultaneamente. Um documento criado a partir de um modelo permanece 
conectado a esse modelo (a menos que o documento seja posteriormente desanexado). Você 
pode modificar um modelo e atualizar imediatamente o design em todos os documentos 
baseados nele.

Tópicos relacionados
■ “Criar um modelo no Dreamweaver” na página 340

Tipos de regiões de modelo
O Dreamweaver bloqueia automaticamente a maioria das regiões de um documento ao salvar 
o documento como modelo. Como autor do modelo, você pode especificar as regiões de um 
documento baseado em modelo que podem ser editadas, inserindo regiões ou parâmetros 
editáveis no modelo. 

Enquanto o arquivo de modelo estiver sendo criado, é possível alterar regiões editáveis e 
regiões bloqueadas. Em um documento baseado em modelo, no entanto, um usuário do 
modelo pode efetuar alterações somente nas regiões editáveis. As regiões bloqueadas não 
podem ser modificadas.

Há quatro tipos de regiões de modelo: 

Região editável: é uma região desbloqueada de um documento baseado em modelo, ou seja, 
uma seção editável pelo usuário do modelo. O autor do modelo pode definir qualquer área de 
um modelo como editável. Para que um modelo seja efetivo, ele deve conter uma região 
editável pelo menos, caso contrário, as páginas baseadas no modelo não poderão ser editadas. 
Para obter informações sobre como inserir uma região editável, consulte “Inserir uma região 
editável” na página 347.
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Região repetitiva: é uma seção do layout definida em um documento para ser repetida várias 
vezes. Por exemplo, você pode definir que a linha de uma tabela deve ser repetida. 
Geralmente, as seções repetitivas são editáveis, de modo que o usuário do modelo pode editar 
o conteúdo do elemento repetitivo, embora o design em si seja controlado pelo autor do 
modelo. O usuário do modelo utiliza as opções de controle da região repetitiva para adicionar 
ou excluir cópias de regiões repetitivas em um documento baseado no modelo, caso 
necessário. 

Existem dois tipos de regiões repetitivas que você pode inserir em um modelo: região 
repetitiva e tabela repetitiva. Para obter mais informações sobre como inserir uma região 
repetitiva em um modelo, consulte “Criar uma região repetitiva em um modelo” na 
página 350. Para obter informações sobre como criar uma tabela repetitiva, consulte “Inserir 
uma tabela repetitiva” na página 351. Para obter informações sobre como trabalhar com uma 
região repetitiva em uma página baseada em modelo, consulte “Adicionar, excluir e modificar 
a ordem de uma entrada de região repetitiva” na página 370.

Região opcional é uma seção de um modelo que você define como opcional, para armazenar 
conteúdo (como texto opcional ou uma imagem) que pode ou não aparecer no documento 
baseado no modelo. Em uma página baseada em modelo, o usuário do modelo normalmente 
controla se o conteúdo será exibido. Para obter mais informações sobre como definir regiões 
opcionais em um modelo, consulte “Inserir uma região opcional” na página 353. Para obter 
informações sobre como definir regiões opcionais em uma página baseada em modelo, 
consulte “Modificar propriedades de modelos” na página 368.

Atributo de tag editável: permite desbloquear um atributo de tag em um modelo, de modo 
que o atributo possa ser editado em uma página baseada em modelo. Por exemplo, você pode 
“bloquear” a imagem que aparece no documento, mas permitir que o usuário do modelo 
defina o alinhamento à esquerda, à direita ou centralizado. Para obter mais informações sobre 
como definir atributos de tags editáveis, consulte “Definir atributos de tag editáveis em um 
modelo” na página 356. Para obter informações sobre como editar as tags em uma página 
baseada em modelo, consulte “Modificar propriedades de modelos” na página 368.

Tópicos relacionados
■ “Criar regiões editáveis” na página 346
■ “Criar regiões repetitivas” na página 350
■ “Usar regiões opcionais” na página 353
■ “Definir atributos de tag editáveis” na página 356
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Modelos e documentos baseados em modelo nas 
visualizações do projeto e do código
É possível exibir, nas visualizações do projeto e do código, modelos e documentos baseados em 
modelo.

Exibir modelos na visualização do projeto 
Nos modelos, as regiões editáveis aparecem na visualização do projeto da janela do 
documento, entre contornos retangulares na cor de realce predefinida. Uma pequena guia 
aparece no canto superior esquerdo de cada região, exibindo o nome de cada região. 

É possível identificar um arquivo de modelo olhando para a barra de título na janela do 
documento. A barra de título de um arquivo de modelo exibe a palavra <<Template>> e a 
extensão de nome de arquivo .dwt.

Tópicos relacionados
■ “Exibir documentos baseados em modelo na visualização do projeto” na página 330
■ “Exibir documentos baseados em modelo na visualização de código” na página 330

N
O
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Para obter informações sobre como definir preferências de cor de realce, consulte 
“Definir preferências de realce para regiões de modelo” na página 342. 
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Exibir modelos na visualização do código
Na visualização do código é possível efetuar alterações tanto no código-fonte editável como no 
código HTML bloqueado em um modelo. 

As regiões de conteúdo editável são marcadas em HTML com os seguintes comentários: 

<!-- TemplateBeginEditable> e <!-- TemplateEndEditable -->

Qualquer item entre esses comentários é editável em documentos baseados no modelo. O 
código-fonte HTML de uma região editável pode ter a seguinte aparência:
<table width="75%"  border="1"  cellspacing="0" cellpadding="0">
  <tr bgcolor="#333366"> 
    <td>Name</td>
    <td><font color="#FFFFFF">Address</font></td>
    <td><font color="#FFFFFF">Telephone Number</font></td>
  </tr>
  <!-- TemplateBeginEditable name="LocationList" --> 
  <tr> 
    <td>Enter name</td>
    <td>Enter Address</td>
    <td>Enter Telephone</td>
  </tr>
  <!-- TemplateEndEditable --> 
</table> 

Tópicos relacionados
■ “Exibir modelos na visualização do projeto” na página 328
■ “Exibir documentos baseados em modelo na visualização de código” na página 330

D
IC
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Você pode usar preferências de cores de código para definir seu esquema de cores, de 
modo a poder distinguir facilmente as regiões do modelo ao exibir um documento na 
visualização de código (consulte “Personalizar preferências de cores de código para um 
modelo” na página 342).

N
O
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Ao editar código e modelo na visualização de código, tome cuidado para não alterar 
nenhuma das tags de comentários relacionados ao modelo de que o Dreamweaver 
necessita.
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Exibir documentos baseados em modelo na visualização do 
projeto
Em um documento baseado em um modelo, as regiões editáveis aparecem na visualização do 
projeto na janela do documento circundadas por contornos retangulares em uma cor de realce 
predefinida. Uma pequena guia aparece no canto superior esquerdo de cada região, exibindo o 
nome de cada região. 

Além dos contornos de regiões editáveis, a página inteira é circundada por um contorno de 
cor diferente, com uma guia no canto superior direito mostrando o nome do modelo no qual 
o documento se baseia. Este retângulo realçado está presente para lembrar que o documento 
está baseado em um modelo e que nada poderá ser modificado fora das regiões editáveis.

Tópicos relacionados
■ “Exibir modelos na visualização do projeto” na página 328
■ “Exibir modelos na visualização do código” na página 329

Exibir documentos baseados em modelo na visualização de 
código
Na visualização de código, as regiões editáveis em um documento baseado em um modelo 
aparecem em uma cor diferente do código nas regiões não-editáveis. Você pode alterar códigos 
apenas nas regiões editáveis ou em parâmetros editáveis; o Dreamweaver não permite que 
você digite em regiões bloqueadas.
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Para obter informações sobre como definir preferências de cor de realce, consulte 
“Definir preferências de realce para regiões de modelo” na página 342. 
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O conteúdo editável é marcado em HTML com os seguintes comentários do Dreamweaver:

<!-- InstanceBeginEditable> e <!-- InstanceEndEditable -->

Tudo o que estiver entre esses comentários é editável em um modelo baseado em documento. 
O código-fonte HTML de uma região editável pode ter a seguinte aparência:
<body bgcolor="#FFFFFF" leftmargin="0">
<table width="75%"  border="1"  cellspacing="0" cellpadding="0">
  <tr bgcolor="#333366"> 
    <td>Name</td>
    <td><font color="#FFFFFF">Address</font></td>
    <td><font color="#FFFFFF">Telephone Number</font></td>
  </tr>
  <!-- InstanceBeginEditable name="LocationList" --> 
  <tr> 
    <td>Enter name</td>
    <td>Enter Address</td>
    <td>Enter Telephone</td>
  </tr>
  <!-- InstanceEndEditable --> 
</table> 
</body>

A cor padrão para textos não-editáveis é cinza. É possível selecionar outra cor para as regiões 
editáveis e não-editáveis na caixa de diálogo Preferences (Preferências). Para obter mais 
informações, consulte “Personalizar preferências de cores de código para um modelo” na 
página 342.

Tópicos relacionados
■ “Exibir modelos na visualização do projeto” na página 328
■ “Exibir modelos na visualização do código” na página 329
■ “Exibir documentos baseados em modelo na visualização do projeto” na página 330

Sintaxe de tags de modelo
Esta seção descreve as regras gerais de sintaxe e lista as tags de comentários HTML usadas pelo 
Dreamweaver para especificar regiões em modelos e em documentos baseados em modelos. O 
Dreamweaver insere automaticamente tags de modelos no código quando você insere um 
objeto de modelo. 

N
O
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O Dreamweaver usa tags de comentários HTML para definir regiões de modelos, para 
que os documentos baseados em modelos sejam arquivos HTML válidos.
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Regras gerais de sintaxe
A seguir são descritas as regras gerais de sintaxe:

■ É possível substituir qualquer quantidade de espaço em branco (espaços, tabulações, 
quebras de linha), independentemente de onde ele apareça. O espaço em branco é 
obrigatório, menos no começo ou final de um comentário.

■ Os atributos podem estar em qualquer ordem. Por exemplo, em TemplateParam, é 
possível especificar o tipo antes do nome.

■ Os comentários e nomes de atributos reconhecem maiúsculas e minúsculas.
■ Todos os atributos devem estar entre aspas. Podem ser utilizadas aspas simples ou duplas.

Para obter informações sobre como verificar a sintaxe, consulte “Verificar a sintaxe de 
modelos” na página 362.

Tópicos relacionados
■ “Tags de instância” na página 333

Tags de modelo
O Dreamweaver usa as seguintes tags de modelo:
<!-- TemplateBeginEditable name="..." --> 
<!-- TemplateEndEditable -->

<!-- TemplateParam name="..." type="..." value="..." -->

<!-- TemplateBeginRepeat name="..." --> 
<!-- TemplateEndRepeat -->

<!-- TemplateBeginIf cond="..." -->
<!-- TemplateEndIf -->

<!-- TemplateBeginPassthroughIf cond="..." -->
<!-- TemplateEndPassthroughIf -->

<!-- TemplateBeginMultipleIf -->
<!-- TemplateEndMultipleIf -->

<!-- TemplateBeginPassthroughMultipleIf -->
<!-- TemplateEndPassthroughMultipleIf -->

<!-- TemplateBeginIfClause cond="..." -->
<!-- TemplateEndIfClause -->

<!-- TemplateBeginPassthroughIfClause cond="..." -->
<!-- TemplateEndPassthroughIfClause -->
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<!-- TemplateExpr expr="..." --> (equivalent to @@...@@)

<!-- TemplatePassthroughExpr expr="..." -->

<!-- TemplateInfo codeOutsideHTMLIsLocked="..." -->

Tópicos relacionados
■ “Regras gerais de sintaxe” na página 332

Tags de instância
O Dreamweaver usa as seguintes tags de modelo:
<!-- InstanceBegin template="..." codeOutsideHTMLIsLocked="..." -->
<!-- InstanceEnd -->
<!-- InstanceBeginEditable name="..." -->
<!-- InstanceEndEditable -->
<!-- InstanceParam name="..." type="..." value="..." passthrough="..." -->
<!-- InstanceBeginRepeat name="..." -->
<!-- InstanceEndRepeat -->
<!-- InstanceBeginRepeatEntry -->
<!-- InstanceEndRepeatEntry -->

Tópicos relacionados
■ “Regras gerais de sintaxe” na página 332
■ “Tags de modelo” na página 332

Links em modelos
Para criar um link em um arquivo de modelo, utilize o ícone de pasta ou o ícone indicador de 
arquivo) no Inspetor de propriedades. Não digite o nome do arquivo a ser vinculado. Se você 
digitar o nome, o link não funcionará como esperado. Esta seção explica como o 
Dreamweaver trata links em modelos. 

Ao criar um arquivo de modelo a partir de uma página existente, salve a página como modelo. 
O Dreamweaver atualizará os links de modo que apontem para os mesmos arquivos que antes. 
Como os modelos são salvos na pasta Templates (Modelos), o caminho para o link relativo ao 
documento é modificado ao salvar a página como um modelo. No Dreamweaver, ao criar um 
novo documento baseado nesse modelo e salvar o novo documento, todos os links relativos ao 
documento são atualizados de modo que continuem apontando para os arquivos corretos.
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Entretanto, ao adicionar um link relativo ao documento em um arquivo de modelo, se o 
caminho for digitado na caixa de texto do link no Inspetor de propriedades, é possível digitar 
um caminho incorreto por engano. O caminho correto é o caminho da pasta Templates 
(Modelos) para o documento vinculado, e não o caminho da pasta do documento baseado em 
modelo para o documento vinculado.

Para obter mais informações sobre como vincular usando o ícone indicador de arquivo, 
consulte “Vincular arquivos e documentos” na página 468.

Modelos aninhados
Um modelo aninhado é um modelo cujo projeto e regiões editáveis são baseados em outro 
modelo. Para criar um modelo aninhado, salve o modelo original ou básico primeiro e, em 
seguida, crie um novo documento baseado no modelo e salve o documento como modelo. No 
novo modelo, é possível definir posteriormente regiões editáveis em áreas originalmente 
definidas como editáveis do modelo básico.

Os modelos aninhados são utilizados para controlar o conteúdo em páginas de um site que 
compartilham muitos elementos de design, mas possuem poucas variações entre as páginas. 
Por exemplo, um modelo básico pode conter áreas de projeto maiores e ser utilizável por 
diversos fornecedores de conteúdo de um site, enquanto um modelo aninhado pode definir as 
regiões editáveis de páginas em uma seção específica do site. 

As regiões editáveis em um modelo básico são repassadas ao modelo aninhado e permanecem 
editáveis em páginas criadas a partir de um modelo aninhado, a menos que novas regiões de 
modelo sejam inseridas nessas regiões. 

As modificações feitas em um modelo básico são automaticamente atualizadas nos modelos 
baseados no modelo básico, e em todos os documentos baseados em modelo que estão 
baseados no modelo principal e nos modelos aninhados. 

N
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Em alguns casos (como, por exemplo, caminhos de arquivo em manipuladores de 
eventos em modelos) não será possível utilizar o ícone de pasta ou o ícone indicador de 
arquivo. Nesses casos, digite o caminho correto manualmente.
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No exemplo a seguir, o modelo contém três regiões editáveis, denominadas  Body, Nav Bar e 
Footer:

Para criar um modelo aninhado, criamos um novo documento baseado no modelo e salvamos 
o documento como modelo com o nome TrioNested. Em seguida, adicionamos ao modelo 
aninhado duas regiões editáveis, com conteúdo, na região editável Body. 
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Ao adicionar uma nova região editável a uma região editável repassada ao modelo aninhado, a 
cor de realce da região editável muda para laranja. O conteúdo adicionado por você a uma 
região editável, como a imagem em editableColumn, não será mais editável em documentos 
baseados no modelo aninhado. As áreas editáveis realçadas em azul, adicionadas ao modelo 
aninhado ou repassadas do modelo básico, permanecem editáveis nos documentos baseados 
no modelo aninhado. As regiões de modelo às quais não são inseridas regiões editáveis são 
repassas aos documentos baseados no modelo como regiões editáveis. 

Tópicos relacionados
■ “Criar um modelo aninhado” na página 357

Scripts do servidor em modelos e em documentos 
baseados em modelo
Alguns scripts do servidor são inseridos bem no início ou no final do documento (antes da tag 
<html> ou após a tag </html>). Esses scripts requerem tratamento especial em modelos e 
documentos baseados em modelo. Normalmente, se você fizer alterações no código do script 
antes da tag <html> ou após a tag </html> em um modelo, as alterações não serão copiadas 
para os documentos baseados nesse modelo. Isso pode causar erros de servidor se outros scripts 
de servidor, dentro do corpo principal do modelo, dependerem dos scripts que não foram 
copiados. Como resultado, o Dreamweaver o alertará se uma alteração for feita nos scripts 
antes da tag <html> ou após a tag </html> em um modelo.

Para evitar este problema, insira o código a seguir na seção head do modelo:
<!-- TemplateInfo codeOutsideHTMLIsLocked="true" -->

Quando esse código estiver presente em um modelo, as alterações feitas nos scripts antes da 
tag <html> ou após a tag </html> serão copiadas para os documentos baseados nesse modelo. 
No entanto, não será mais possível editar esses scripts em documentos baseados no modelo. 
Assim, você pode escolher entre editar os scripts no modelo ou em documentos baseados no 
modelo, mas não em ambos.

Parâmetros de modelo
Os parâmetros de modelo especificam valores para controlar o conteúdo em documentos 
baseados em um modelo. É possível usar parâmetros de modelo com regiões opcionais ou 
atributos de tags editáveis, ou definir os valores que deseja repassar para um documento 
anexado. Para cada parâmetro, você seleciona um nome, um tipo de dados e um valor padrão. 
Cada parâmetro deve ter um nome exclusivo, com distinção de maiúsculas e de minúsculas. 
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Os parâmetros do modelo são repassados para um documento como parâmetros de instância. 
Na maioria dos casos, o usuário de um modelo pode editar o valor padrão do parâmetro para 
personalizar o que aparece em um documento baseado em modelo. Em outros casos, o autor 
do modelo pode determinar o que aparece no documento com base no valor de uma expressão 
de modelo. 

Tópicos relacionados
■ “Usar regiões opcionais” na página 353
■ “Definir atributos de tag editáveis” na página 356

Expressões de modelo  
As expressões de modelo são instruções utilizadas para computar ou avaliar um valor. 

Você poderá utilizar uma expressão para armazenar um valor e exibi-lo em um documento. 
Por exemplo, uma expressão pode ser simples como o valor de um parâmetro, como 
@@(Param)@@, ou complexa o bastante para calcular valores que alternam a cor de fundo de 
uma linha da tabela, como @@((_index&1) ? red : blue)@@. 

Também é possível definir expressões para as condições if e if múltipla (para um exemplo, 
consulte “Condição If múltipla em códigos de modelo” na página 339). Quando uma 
expressão é usada em uma instrução condicional, o Dreamweaver a avalia como sendo true 
(verdadeira) ou false (falsa). Se a condição for verdadeira, a região opcional aparecerá no 
documento baseado em um modelo; se for falsa, não aparecerá. 

Você pode definir expressões na visualização de código ou na caixa de diálogo Optional 
Region (Região opcional) ao inserir uma região opcional. Para obter mais informações sobre 
como criar expressões de modelos, consulte “A linguagem de expressão do modelo” na 
página 337. 

Na visualização de código, há duas maneiras de definir expressões de modelos: usando o 
comentário <!-- TemplateExpr expr=“your expresson”--> ou @@(your 
expression)@@. Quando você insere uma expressão no código do modelo, um marcador de 
expressão aparece na visualização do projeto. Ao aplicar no modelo, o Dreamweaver avalia a 
expressão e exibe o valor no documento baseado no modelo.

A linguagem de expressão do modelo
A linguagem da expressão do modelo é um pequeno subconjunto do JavaScript e utiliza 
sintaxe e regras de precedência do JavaScript. É possível utilizar operadores do JavaScript para 
escrever uma expressão do seguinte modo: 
@@(firstName+lastName)@@ 
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Os seguintes recursos e operadores são suportados:

■ literais numéricos, literais de seqüência de caracteres (somente sintaxe entre aspas duplas), 
literais booleanos (true ou false)

■ referência variável (consulte a lista de variáveis definidas mais adiante nesta seção)
■ referência de campo (operador “dot”)
■ operadores unários: +, -, ~, !
■ operadores binários: +, -, *, /, %, &, |, ^, &&, ||, <, <=, >, >=, ==, !=, <<, >>
■ operador condicional: ?:
■ parênteses: ()

Os seguintes tipos de dados são usados: booleano, ponto flutuante IEEE de 64 bits, seqüência 
de caracteres e objeto. Os modelos do Dreamweaver não suportam o uso dos tipos “nulo” ou 
“indefinido” do JavaScript. Não permitem também tipos escalares para serem convertidos 
implicitamente em um objeto. Assim, a expressão "abc".length resultaria em erro, em vez de 
produzir o valor 3.

Os únicos objetos disponíveis são aqueles definidos pelo modelo de objeto de expressão. As 
variáveis a seguir são definidas:

_document 

Contém os dados do modelo no nível do documento com um campo para cada parâmetro do 
modelo.

_repeat

Definido apenas para expressões que aparecem dentro de uma região repetitiva. Fornece 
informações incorporadas sobre a região:

_index  Índice numérico (a partir de 0) da entrada atual

_numRows  Número total de entradas nesta região repetitiva

_isFirst  Verdadeiro se a entrada atual for a primeira entrada na região repetitiva

_isLast Verdadeiro se a entrada atual for a última entrada na região repetitiva

_prevRecord  O objeto _repeat da entrada anterior. É um erro acessar esta propriedade 
para a primeira entrada da região.

 _nextRecord O objeto _repeat da entrada seguinte. É um erro acessar esta propriedade 
para a última entrada da região. 

 _parent Em uma região repetitiva aninhada, fornece o objeto _repeat para a região 
repetitiva final (externa). É um erro acessar esta propriedade fora de uma região repetitiva 
aninhada.
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Durante a avaliação da expressão, todos os campos dos objetos _document e _repeat estão 
implicitamente disponíveis. Por exemplo, é possível digitar title em vez de 
_document.title para acessar o parâmetro de título do documento.

Em casos em que não há um conflito de campos, os campos do objeto _repeat têm 
precedência sobre os campos do objeto _document. Portanto, não será necessário fazer 
referência explícita a  _document ou _repeat, a menos que _document seja necessário dentro 
de uma região repetitiva para fazer referência a parâmetros de documento que estejam 
ocultados por parâmetros de regiões repetitivas.

Quando as regiões repetitivas aninhadas forem utilizadas, somente os campos das regiões 
repetitivas internas estarão implicitamente disponíveis. As regiões externas devem ser 
explicitamente indicadas por meio de _parent.

Condição If múltipla em códigos de modelo
É possível definir expressões de modelo para condições if e if múltipla (consulte “Expressões 
de modelo” na página 337). Este exemplo demonstra a definição de um parâmetro 
denominado “Dept”, definindo um valor inicial e definindo uma condição if múltipla que 
determina o logotipo a ser exibido. 

O exemplo a seguir mostra um código que você pode digitar na seção de cabeçalho do 
modelo:
<!-- TemplateParam name="Dept" type="number" value="1" -->

A instrução de condição a seguir verifica o valor atribuído ao parâmetro Dept. Quando a 
condição for verdadeira (true) ou correspondente, a imagem apropriada será exibida.
<!-- TemplateBeginMultipleIf -->
<!-- checks value of Dept and shows appropriate image-->

<!-- TemplateBeginClause cond="Dept == 1" --> <img src=".../sales.gif"> 
<!-- TemplateEndIfClause -->

<!-- TemplateBeginIfClause cond="Dept == 2" --> <img src=".../
support.gif"> <!-- TemplateEndIfClause-->

<!-- TemplateBeginIfClause cond="Dept == 3" --> <img src=".../hr.gif"> 
<!-- TemplateEndIfClause -->

<!-- TemplateBeginIfClause cond="Dept != 3" --> <img src=".../
spacer.gif"> <!-- TemplateEndIfClause -->

<!-- TemplateEndMultipleIf -->

Quando você cria um documento baseado em um modelo, os parâmetros do modelo são 
automaticamente repassados para ele. O usuário do modelo determina a imagem a ser exibida 
(consulte “Modificar propriedades de modelos” na página 368). 
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Criar um modelo no Dreamweaver
É possível criar um modelo a partir de um documento existente (como um documento 
HTML, Macromedia ColdFusion ou Microsoft Active Server Pages) ou a partir de um 
documento novo, vazio.

Após criar um modelo, você pode inserir regiões de modelos (consulte “Tipos de regiões de 
modelo” na página 326). Você também pode definir preferências de modelo para cores de 
código e cores de realce para regiões de modelos (consulte “Personalizar preferências de cores 
de código para um modelo” na página 342 e “Definir preferências de realce para regiões de 
modelo” na página 342).

Para criar um modelo:

1. Abra o documento que deseja salvar como modelo:

■ Para abrir um documento, selecione File (Arquivo) > Open (Abrir) e, em seguida, 
selecione o documento.

■ Para abrir um documento novo e em branco, escolha File (Arquivo) > New (Novo). 
Na caixa de diálogo exibida, selecione Basic Page (Página básica) ou Dynamic Page 
(Página dinâmica), selecione o tipo de página desejada e, em seguida, clique em Create 
(Criar). 

2. Com o documento aberto, siga um destes procedimentos:

■ Selecione File (Arquivo) > Save as Template (Salvar como modelo).
■ Na categoria Common (Comuns) da barra Insert (Inserir), clique na seta do botão 

Templates (Modelos) e selecione Make Template (Criar modelo).

D
IC

A

Você pode armazenar informações adicionais sobre um modelo (como nome do criador, 
data da última alteração, ou porque tomou determinadas decisões sobre o layout) em 
um arquivo do Design Notes para o modelo (consulte “Associar Design Notes a 
arquivos” na página 169). Os documentos baseados em um modelo não herdarão as 
Design Notes. 

N
O

T
A

Para obter informações sobre como criar um novo documento, consulte “Criar 
um novo documento em branco” na página 102.

N
O

T
A

A menos que a opção Don’t Show This Dialog Again (Não notificar novamente) 
esteja selecionada, será exibido um aviso informando que o documento sendo 
salvo não possui regiões editáveis. Clique em OK para salvar o documento como 
modelo ou clique em Cancel (Cancelar) para sair dessa caixa de diálogo sem 
criar um modelo.
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A caixa de diálogo Save as Template (Salvar como modelo) é exibida.

3. Selecione um site para salvar o modelo no meu pop-up Site e, em seguida, digite um nome 
para o modelo na caixa de texto Save As (Salvar como).

4. Clique em Save (Salvar).

O Dreamweaver salva o modelo na pasta Templates (Modelos) do site, na pasta raiz local 
do site, com a extensão de arquivo .dwt. Se a pasta Templates (Modelos) ainda não existir 
no site, o Dreamweaver criará a pasta quando você salvar um novo modelo.

Para utilizar o painel Assets (Propriedades) para criar um novo modelo:

1. No painel Assets [Window > Assets], selecione a categoria Templates (Modelos) no lado 
esquerdo do painel.

A categoria Templates é exibida no painel Assets.
2. Clique no botão New Template (Novo modelo) na parte inferior do painel Assets. 

Um novo modelo vazio e sem título é adicionado à lista de modelos no painel Assets.
3. Com o modelo ainda selecionado, digite um nome para ele e, em seguida, pressione Enter 

(Windows) ou Return (Macintosh).

Dreamweaver cria um modelo novo e vazio no painel Assets da pasta Templates.

Tópicos relacionados
■ “Definir preferências de realce para regiões de modelo” na página 342
■ “Criar modelos para um site do Contribute” na página 344
■ “Inserir uma região editável” na página 347

N
O

T
A

Não remova os modelos da pasta Templates (Modelos) e não coloque arquivos que 
não sejam modelos nesta pasta. Além disso, não mova a pasta Templates (Modelos) 
da pasta raiz local. Ao fazer isto, você estará provocando erros nos caminhos dos 
modelos.
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Personalizar preferências de cores de código para 
um modelo 
As preferências de cores do código controlam texto, cor de fundo e atributos de estilo do texto 
exibidos na visualização do código. Defina o seu esquema de cores, de modo a distinguir 
facilmente regiões do modelo ao exibir um documento na visualização de código.

Para definir um esquema de cores para modelos na visualização do código:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.
2. Selecione Code Coloring (Codificação por cores) na lista de categorias à esquerda.

3. Selecione HTML na lista Document Type (Tipo de documento) e clique no botão Edit 
Coloring Scheme (Editar esquema de cores).

A caixa de diálogo Edit Code Coloring Scheme (Editar esquema de codificação por cores) 
é exibida.

4. Na lista Styles For (Estilo para), selecione Template Tags (Tags de modelo).

5. Defina cor, cor de fundo e atributos de estilo para o texto na visualização do código 
efetuando um dos procedimentos a seguir:

■ Para alterar a cor do texto, digite na caixa de texto Text Color (Cor do texto) o valor 
hexadecimal da cor a ser aplicada ao texto selecionado, ou utilize o seletor de cores para 
selecionar uma cor a ser aplicada ao texto. Repita o procedimento no campo 
Background (Cor de fundo) para adicionar ou modificar uma cor de fundo existente 
para o texto selecionado.

■ Se desejar adicionar um atributo de estilo ao código selecionado, clique nos botões B 
(N) (negrito), I (I) (itálico) ou U (S) (sublinhado) para definir o estilo desejado.

6. Clique em OK.

Definir preferências de realce para regiões de modelo
É possível utilizar as preferências de realce do Dreamweaver para personalizar as cores de realce 
dos contornos das regiões editáveis e bloqueadas de um modelo na visualização do projeto. 
A cor de região editável aparece no modelo, bem como em documentos baseados no modelo.

Para mais informações sobre a exibição de modelos e de documentos baseados em modelos na 
visualização de projeto, consulte “Exibir modelos na visualização do projeto” na página 328 e 
“Exibir documentos baseados em modelo na visualização do projeto” na página 330.
342 Capítulo 11:  Gerenciar modelos



         
Para alterar as cores de realce do modelo:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.
2. Selecione Highlighting (Realce) na lista de categorias à esquerda.

3. Clique na caixa de cor Editable Regions, Nested Regions, or Locked Regions (Regiões 
editáveis, regiões aninhadas, regiões bloqueadas) e, em seguida, selecione a cor de realce 
com o seletor de cores (ou digite o valor hexadecimal correspondente à cor de realce na caixa 
de texto). 

Para obter informações sobre como utilizar o seletor de cores, consulte “Trabalhar com 
cores” na página 384.

4. (Opcional) Repita este processo para outros tipos de regiões de modelo, se necessário. 

5. Clique na opção Show (Mostrar) para ativar ou desativar a exibição das cores na janela do 
documento.

6. Clique em OK.

Para exibir cores de realce na janela do documento:

■ Selecione View (Exibir) > Visual Aids (Auxílios visuais) > Invisible Elements (Elementos 
invisíveis).
As cores de realce aparecerão na janela do documento apenas quando a opção View > 
Visual Aids > Invisible Elements for ativada e as opções apropriadas estiverem ativas nas 
preferências de realce.

Tópicos relacionados
■ “Personalizar preferências de cores de código para um modelo” na página 342

N
O

T
A

A caixa de cor Nested Region (Região aninhada) não possui uma opção Show 
(Mostrar). Sua exibição é controlada pela opção Editable Region (Região editável).

N
O

T
A

Se os elementos invisíveis forem exibidos, mas as cores de realce não, selecione 
Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh) e, em 
seguida, selecione a categoria Highlight (Realce). Certifique-se de que a opção 
Show (Exibir) ao lado da cor de realce apropriada esteja selecionada. Assegure-se 
também de que a cor desejada esteja visível em relação à cor de fundo da página
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Criar modelos para um site do Contribute
Com o Dreamweaver, você pode criar modelos para ajudar os usuários do Macromedia 
Contribute na criação de novas páginas, para assegurar um aspecto consistente ao seu site, e 
para que possa atualizar o layout de várias páginas ao mesmo tempo.

Ao criar um modelo e transferi-lo para o servidor, o modelo fica disponível para todos os 
usuários do Contribute que se conectam ao seu site, a menos sejam estabelecidas restrições ao 
uso do modelo para determinadas funções do Contribute. Caso tenha definido restrições de 
uso para o modelo, talvez precise adicionar cada novo modelo a uma lista de modelos que 
podem ser usados pelo usuário do Contribute (consulte Administering Contribute).

Além de modelos do Dreamweaver, é possível criar “modelos não-Dreamweaver” usando as 
ferramentas administrativas do  Contribute. Um modelo não-Dreamweaver é uma página 
existente que os usuários do Contribute podem utilizar para criar novas páginas. Ele é similar 
a um modelo do Dreamweaver, exceto que as páginas baseadas nesse modelo não são 
atualizadas quando o modelo é alterado. Além disso, os modelos não-Dreamweaver não 
podem conter elementos de modelos do Dreamweaver, como regiões editáveis, bloqueadas, 
repetitivas e opcionais.

N
O

T
A

Verifique se a pasta raiz do site especificada em cada definição do site do usuário do 
Contribute é a mesma que a pasta raiz do site especificada na definição do seu site no 
Dreamweaver. Se a pasta raiz do site de um usuário não corresponder à sua pasta, 
aquele usuário não poderá utilizar os modelos.
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Quando um usuário do Contribute cria um novo documento em um site contendo modelos 
do Dreamweaver, o Contribute lista os modelos disponíveis (tanto modelos Dreamweaver 
como não-Dreamweaver) na caixa de diálogo New Page (Nova página). 

Para incluir em seu site páginas que utilizem outro tipo de codificação que não Latin-1, talvez 
você precise criar modelos (modelos Dreamweaver ou não-Dreamweaver). O Contribute pode 
editar páginas que utilizam qualquer codificação, mas quando um usuário do Contribute cria 
uma nova página em branco, a codificação Latin-1 é utilizada. Para criar uma página com uma 
codificação diferente, o usuário do Contribute pode criar uma cópia de uma página existente 
com uma outra codificação, ou utilizar um modelo com uma codificação diferente. No 
entanto, se não houver nenhuma página ou modelo no site com outras codificações, será 
preciso criar primeiro uma página ou modelo no Dreamweaver com outra codificação.

Para obter mais informações sobre como criar, editar e atualizar modelos do Dreamweaver, 
consulte “Sobre modelos do Dreamweaver” na página 326.
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Para criar um modelo não-Dreamweaver :

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Manage Sites é exibida.
2. Selecione um site e, em seguida, clique em Edit (Editar).

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Clique na guia Advanced (Avançado).

4. Selecione uma categoria do Contribute na lista de categorias à esquerda.

5. Caso ainda não o tenha feito, você deverá ativar agora a compatibilidade do Contribute.

Selecione a opção Enable Contribute Compatibility (Ativar compatibilidade) e, em 
seguida, digite um URL de site raiz.
Para obter mais informações, clique no botão Help (Ajuda).

6. Clique no botão Administer Site in Contribute.

7. Se solicitada, insira a senha de administrador e depois clique em OK.

A caixa de diálogo Administer Website (Administrar site da Web) é exibida.
8. Na categoria Users and Roles (Usuários e funções), selecione uma função e depois clique 

no botão Edit Role Settings (Editar configurações de função).

9. Selecione a categoria New Pages (Novas páginas) e adicione páginas existentes à lista em 
Create a New Page by Copying a Page from This List (Criar nova página copiando uma 
página desta lista). 

Para obter mais informações, consulte Administering Contribute.
10. Clique em OK para fechar a caixa de diálogo Edit Settings (Editar configurações).

11. Clique em Close (Fechar) para fechar a caixa de diálogo Administer Website.

Tópicos relacionados
■ “Criar um modelo no Dreamweaver” na página 340

Criar regiões editáveis
As regiões de modelo editáveis controlam as áreas de uma página baseada em modelo que 
podem ser editadas. 

Tópicos relacionados
■ “Tipos de regiões de modelo” na página 326
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Inserir uma região editável
Antes de inserir uma região editável, salve o documento atual como modelo (consulte “Criar 
um modelo no Dreamweaver” na página 340). 

Você pode inserir uma região editável em qualquer parte da página, mas observe o seguinte ao 
criar uma tabela ou camada editável:

■ É possível marcar como editável uma tabela inteira ou uma célula de tabela. No entanto, 
não é possível marcar várias células da tabela como uma única região editável. Se uma tag 
<td> for selecionada, a região editável incluirá a região ao redor da célula; caso contrário, a 
região editável afetará apenas o conteúdo dentro da célula.

■ As camadas e seu conteúdo são elementos distintos. Ao tornar editável uma camada, sua 
posição e seu conteúdo podem ser alterados. Mas ao tornar editável o conteúdo da 
camada, somente o conteúdo da camada (e não sua posição) poderá ser alterado.

Para inserir uma região de modelo editável:

1. Na janela do documento, siga um dos procedimentos abaixo para selecionar a região:

■ Selecione o texto ou conteúdo a ser definido como uma região editável.
■ Coloque o ponto de inserção onde deseja inserir uma região editável.

2. Siga um dos procedimentos abaixo para inserir uma região editável:

■ Selecione Insert (Inserir) > Template Objects (Objetos de modelo) > Editable Region 
(Região editável).

■ Clique com o botão direito (Windows) ou clique mantendo pressionada a tecla 
Control (Macintosh) e, em seguida, selecione Templates (Modelos) > New Editable 
Region (Nova região editável).

■ Na categoria Common da barra Insert, clique na seta do botão Templates e selecione 
Make Template (Criar modelo).

A caixa de diálogo Editable Region (Região editável) é exibida.

N
O

T
A

Se você inserir uma região editável em um documento em vez de fazer isso em um 
arquivo de modelo, o Dreamweaver o advertirá que o documento será salvo 
automaticamente como um modelo.
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3. Na caixa de texto Name (Nome), digite um nome exclusivo para a região. Em um 
determinado modelo, não é possível utilizar o mesmo nome para mais de uma região 
editável.

4. Clique em OK.

A região editável é delimitada por um contorno retangular realçado no modelo com a cor 
de realce definida em preferências. Uma guia no canto superior esquerdo da região mostra 
o nome da região. Se uma região editável vazia for inserida no documento, o nome da 
região também aparecerá dentro da região.

Tópicos relacionados
■ “Remover uma região editável” na página 349
■ “Alterar o nome de uma região editável” na página 349

Selecionar regiões editáveis
É possível identificar e selecionar facilmente regiões de modelo no documento de modelo e 
em documentos baseados em modelos.

Para selecionar uma região editável na janela do documento:

■ Clique na guia no canto superior esquerdo de uma região editável.

Para localizar uma região editável e selecioná-la no documento:

■ Selecione Modify (Modificar) > Templates (Modelos) e, em seguida, escolha o nome da 
região na lista localizada na parte inferior do submenu. 

A região editável é selecionada no documento.

N
O

T
A

Não é permitido o uso de caracteres especiais na caixa de texto Name. 

N
O

T
A

Para obter informações sobre como definir opções de realce de modelos, consulte 
“Definir preferências de realce para regiões de modelo” na página 342. 

N
O

T
A

As regiões editáveis dentro de uma região repetitiva não aparecem no menu. É 
necessário localizar estas regiões procurando pelas bordas com guia na janela do 
documento.
348 Capítulo 11:  Gerenciar modelos



         
Tópicos relacionados
■ “Definir preferências de realce para regiões de modelo” na página 342
■ “Inserir uma região editável” na página 347
■ “Alterar o nome de uma região editável” na página 349

Remover uma região editável
Se tiver marcado uma região do arquivo de modelo como editável e quiser bloqueá-la (torná-la 
não-editável nos documentos baseados no modelo) novamente, use o comando Remove 
Template Markup (Remover markup do modelo). 

Para remover uma região editável:

1. Clique na guia no canto superior esquerdo da região editável para selecioná-la.

2. Siga um dos procedimentos abaixo:

■ Selecione Modify (Modificar) > Templates (Modelos) > Remove Template Markup 
(Remover markup do modelo).

■ Clique com o botão direito (Windows) ou mantendo pressionada a tecla Control 
(Macintosh) e, em seguida, selecione Templates > Remove Template Markup.

A região não será mais editável.

Tópicos relacionados
■ “Inserir uma região editável” na página 347

Alterar o nome de uma região editável
Após inserir uma região editável, você pode alterar o seu nome. 

Para alterar o nome de uma região editável:

1. Clique na guia no canto superior esquerdo da região editável para selecioná-la.

2. No Inspetor de propriedades [Window > Properties], insira um novo nome.

3. Pressione a tecla Enter (no Windows) ou Return (no Macintosh).

Dreamweaver aplica o novo nome à região editável.

Tópicos relacionados
■ “Inserir uma região editável” na página 347
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Criar regiões repetitivas
Uma região repetitiva é uma seção de um modelo que pode ser duplicada o número de vezes 
desejado em uma página baseada em modelo. As regiões repetitivas são normalmente usadas 
em tabelas, embora também seja possível definir uma região repetitiva para outros elementos 
da página. 

As regiões repetitivas permitem que você controle o layout da sua página repetindo 
determinados itens, como um item de catálogo e um layout de descrição, ou uma linha de 
dados como, por exemplo, uma lista de itens. 

Há dois objetos de modelo de região repetitiva que podem ser utilizados: região repetitiva e 
tabela repetitiva.

Tópicos relacionados
■ “Tipos de regiões de modelo” na página 326

Criar uma região repetitiva em um modelo
Regiões repetitivas permitem aos usuários do modelo duplicar uma região especificada no 
modelo tantas vezes quanto forem necessárias. Uma região repetitiva não é uma região 
editável. 

Para tornar editável o conteúdo de uma região repetitiva (por exemplo, para permitir a um 
usuário inserir texto em uma célula de tabela em um documento baseado em modelo), insira 
uma região editável na região repetitiva (consulte “Inserir uma região editável” na 
página 347). 

Para obter informações sobre como criar uma tabela repetitiva, consulte “Inserir uma tabela 
repetitiva” na página 351.

Para inserir uma região repetitiva em um modelo:

1. Na janela do documento, siga um dos procedimentos abaixo:

■ Selecione o texto ou conteúdo a ser definido como uma região repetitiva.
■ Coloque o ponto de inserção onde deseja inserir a região repetitiva no documento.

2. Siga um dos procedimentos abaixo para criar uma região repetitiva:

■ Selecione Insert (Inserir) > Template Objects (Objetos de modelo) > Repeating Region 
(Região repetitiva).

■ Clique com o botão direito (Windows) ou clique mantendo pressionada a tecla 
Control (Macintosh) e, em seguida, selecione Templates > New Editable Region.
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■ Na categoria Common da barra Insert, clique na seta do botão Templates e selecione 
Repeating Region.

A caixa de diálogo New Repeating Region (Nova região repetitiva) é exibida.
3. Na caixa de texto Name (Nome), digite um nome exclusivo para a região de modelo (não 

é possível utilizar o mesmo nome para mais de uma região repetitiva em um modelo).

4. Clique em OK.

A região repetitiva será inserida no documento.

Inserir uma tabela repetitiva
Você pode usar uma tabela repetitiva para criar uma região editável (em formato de tabela) 
com linhas repetitivas. É possível definir atributos de tabela e, em seguida, quais células serão 
editáveis.

Para inserir uma tabela repetitiva:

1. Na janela do documento, coloque o ponto de inserção onde deseja inserir a tabela repetitiva 
no documento.

2. Siga um dos procedimentos abaixo:

■ Selecione Insert (Inserir) > Template Objects (Objetos de modelo) > Repeating Table 
(Tabela repetitiva).

■ Na categoria Common da barra Insert, clique na seta do botão Templates e selecione 
Repeating Table.

N
O

T
A

Não utilize caracteres especiais ao nomear uma região. 

N
O

T
A

Uma região repetitiva não é editável no documento baseado em modelo, a menos 
que ela contenha uma região editável. Para obter informações sobre como inserir 
uma região editável, consulte “Inserir uma região editável” na página 347.
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A caixa de diálogo Insert Repeating Table (Inserir tabela repetitiva) é exibida.

3. Digite novos valores conforme desejado.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

A tabela repetitiva aparece no modelo.

Definir cores de fundo diferentes em uma região 
repetitiva
Após inserir uma tabela repetitiva em um modelo (consulte “Inserir uma tabela repetitiva” na 
página 351), você pode personalizá-la alternando a cor de fundo das linhas da tabela. 

Para definir cores de fundo alternativas para linhas da tabela:

1. Na janela do documento, selecione uma linha na tabela repetitiva.

2. Clique no botão Show Code view (Mostrar visualização do código) ou no botão Show 
Code and Design view (Mostrar visualização do código e do projeto), na barra de 
ferramentas do documento, para acessar o código para a linha da tabela selecionada.

3. Na visualização do código, edite a tag <tr> para incluir o código a seguir:
<tr bgcolor="@@( _index & 1 ? '#FFFFFF' : '#CCCCCC' )@@">

Substitua os valores hexadecimais #FFFFFF e #CCCCCC por outras cores de sua escolha.
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4. Salve o modelo.

O exemplo de código a seguir é usado para uma tabela que inclui cores de fundo alternativas 
para as linhas da tabela:
<table width="75%"  border="1"  cellspacing="0" cellpadding="0">
<tr><th>Name</th><th>Phone Number</th><th>Email Address</th></tr>

<!-- TemplateBeginRepeat name="contacts" --> 
<tr bgcolor="@@(_index & 1 ? '#FFFFFF' : '#CCCCCC')@@"> 
<td> <!-- TemplateBeginEditable name="name" --> name <!-- 

TemplateEndEditable --> 
</td>
<td> <!-- TemplateBeginEditable name="phone" --> phone <!-- 

TemplateEndEditable --> 
</td>
<td> <!-- TemplateBeginEditable name="email" --> email <!-- 

TemplateEndEditable --> 
</td>
</tr>
  <!-- TemplateEndRepeat --> 

</table>

Usar regiões opcionais
Uma região opcional é uma região em um modelo que os usuários podem configurar para ser 
exibida ou ocultada em um documento baseado em modelo. Use uma região opcional quando 
você desejar definir as condições de exibição do conteúdo em um documento. 

Ao inserir uma região opcional, você pode definir valores específicos para um parâmetro de 
modelo ou definir instruções condicionais em um modelo. Se necessário, você poderá 
modificar a região opcional posteriormente. Com base nas condições definidas por você, os 
usuários do modelo podem editar os parâmetros em documentos criados por eles e controlar 
se a região opcional deve ou não ser exibida.“Modificar propriedades de modelos” na 
página 368

Tópicos relacionados
■ “Tipos de regiões de modelo” na página 326

Inserir uma região opcional
Use a região opcional para controlar o conteúdo que pode ou não ser exibido em um 
documento baseado em modelo. Há dois objetos de região opcional: 
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■ Uma região opcional permite aos usuários do modelo exibir ou ocultar regiões com marcas 
especiais sem precisar editar seu conteúdo. 
A guia Templates (Modelos) de uma região opcional é precedida pela palavra if. Com base 
na condição definida no modelo, os usuários do modelo podem definir se a região é visível 
nas páginas que criarem. 

■ Uma região opcional editável permite aos usuários do modelo especificar se a região será 
ou não exibida, sendo que eles podem editar o conteúdo da região.
Por exemplo, se a região opcional incluir uma imagem ou texto, o usuário do modelo pode 
definir se o conteúdo será exibido, bem como editar o conteúdo, se desejado. Uma região 
editável é controlada por uma instrução condicional. 

Para inserir uma região opcional:

1. Na janela do documento, selecione o elemento que deseja definir como região opcional.

2. Siga um dos procedimentos abaixo:

■ Selecione Insert (Inserir) > Template Objects (Objetos de modelo) > Optional Region 
(Região opcional).

■ Clique com o botão direito (Windows) ou clique mantendo pressionada a tecla 
Control (Macintosh) no conteúdo selecionado e, em seguida, selecione Templates > 
New Optional Region.

■ Na categoria Common da barra Insert, clique na seta do botão Templates e selecione 
Optional Region.

A caixa de diálogo Optional Region (Região opcional) é exibida.
3. Especifique as opções para a região opcional. 

Para obter mais informações sobre como definir a região opcional, clique no botão Help 
(Ajuda) da caixa de diálogo.

4. Clique em OK. 

Para inserir uma região opcional editável:

1. Na janela do documento, coloque o ponto de inserção onde deseja inserir a região opcional.

N
O

T
A

Para configurar regiões opcionais para serem exibidas ou ocultadas em documentos 
baseados em modelos, consulte “Modificar propriedades de modelos” na 
página 368.

D
IC

A

Não é possível marcar uma seleção para criar uma região editável opcional. Insira a 
região e, em seguida, insira o conteúdo na região.
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2. Siga um dos procedimentos abaixo para abrir a caixa de diálogo Optional Region (Região 
opcional):

■ Selecione Insert (Inserir) > Template Objects (Objetos de modelo) > Editable 
Optional Region (Região opcional editável).

■ Na categoria Common da barra Insert, clique na seta do botão Templates e selecione 
Editable Optional Region.

A caixa de diálogo Optional Region (Região opcional) é exibida.
3. Digite o nome da região opcional e, em seguida, clique na guia Advanced (Avançado) se 

quiser definir outras opções.

Para obter mais informações sobre como definir a região opcional, clique no botão Help 
(Ajuda) da caixa de diálogo.

4. Clique em OK. 

Modificar uma região opcional
É possível editar as configurações da região opcional após inserir a região em um modelo. Por 
exemplo, você pode definir se o padrão do conteúdo deve ser exibido ou não, vincular um 
parâmetro a uma região opcional existente ou modificar uma expressão de modelo.

Para reabrir a caixa de diálogo Optional Region (Região opcional):

1. Na janela do documento, siga um dos procedimentos abaixo:

■ Na visualização do projeto, clique na guia do modelo da região opcional a ser 
modificada.

■ Na visualização do projeto, posicione o ponto de inserção na  região do modelo; em 
seguida, no seletor de tags na parte inferior da janela do documento, selecione a tag do 
modelo, <mmtemplate:if>.

■ Na visualização do código, clique na tag de comentário da região de modelo a ser 
modificada.

2. No Inspetor de propriedades (Window > Properties), clique em Edit.

A caixa de diálogo Optional Region (Região opcional) é exibida.

N
O

T
A

Para configurar regiões opcionais para serem exibidas ou ocultadas em documentos 
baseados em modelos, consulte “Modificar propriedades de modelos” na página 368.
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3. Faça as alterações necessárias.

Para obter informações sobre opções da caixa de diálogo, clique no botão Help (Ajuda) da 
caixa de diálogo.

4. Clique em OK.

Definir atributos de tag editáveis
Você pode permitir que o usuário de um modelo modifique atributos de tag especificados em 
um documento baseado  em um modelo.  

Por exemplo, você pode definir uma cor de fundo no documento de modelo, mas permitir 
que os usuários definam outra cor de fundo para as páginas criadas por eles.  Os usuários 
podem atualizar somente os atributos que você especificar como editáveis. 

Tópicos relacionados
■ “Tipos de regiões de modelo” na página 326

Definir atributos de tag editáveis em um modelo
Você pode definir vários atributos editáveis em uma página, de modo que os usuários do 
modelo possam modificar esses atributos em documentos baseados em modelos.  Os tipos de 
dados a seguir são suportados: texto, booleanos (true/false), cores e URL.  

Para definir um atributo de tag editável:

1. Na janela do documento, selecione um item para o qual deseja definir um atributo de tag 
editável.

2. Selecione Modify (Modificar) > Templates (Modelos) > Make Attribute Editable (Tornar 
editável o atributo).

A caixa de diálogo Editable Tag Attributes (Atributos de tag editáveis) é exibida.
3. Preencha a caixa de diálogo para cada atributo que deseja tornar editável.

Para obter informações sobre como preencher a caixa de diálogo, clique no botão Help 
(Ajuda) da caixa de diálogo.

N
O

T
A

Para modificar atributos de tags editáveis em documentos baseados em modelos, 
consulte “Modificar propriedades de modelos” na página 368.
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4. Clique em OK.

Crie um atributo de tag editável para inserir um parâmetro de modelo no código. Um 
valor inicial para o atributo é definido no documento de modelo. Quando um documento 
baseado em modelo for criado, o parâmetro será atribuído automaticamente ao 
documento. Um usuário do modelo pode então editar o parâmetro no documento 
baseado em modelo (consulte “Modificar propriedades de modelos” na página 368).

Tornar não-editável um atributo de tag editável
Uma tag marcada como editável pode ser marcada como não-editável. 

Para redefinir um atributo de tag editável:

1. No documento de modelo, clique no elemento associado ao atributo editável, ou use o 
seletor de tags para selecionar a tag.

2. Selecione Modify (Modificar) > Templates (Modelos) > Make Attribute Editable (Tornar 
editável o atributo). 

A caixa de diálogo Editable Tag Attributes (Atributos de tag editáveis) é exibida.
3. No menu pop-up Attributes (Atributos), selecione o atributo a ser modificado.

4. Desmarque a caixa de seleção Make Attribute Editable (Tornar editável o atributo).

5. Clique em OK.

6. Atualize os documentos baseados no modelo.

Tópicos relacionados
■ “Definir atributos de tag editáveis em um modelo” na página 356

Criar um modelo aninhado
Os modelos aninhados permitem criar variações de um modelo básico. Você pode criar um 
modelo aninhado salvando um documento baseado em um modelo e, em seguida, salvando o 
documento como um novo modelo. É possível aninhar diversos modelos para definir layouts 
cada vez mais específicos. Para obter mais informações, consulte “Modelos aninhados” na 
página 334.

Por padrão, todas as regiões de modelo editáveis do modelo básico são repassadas do modelo 
aninhado para o documento baseado no modelo aninhado. Isto significa que, se você criar 
uma região editável em um modelo de base e, em seguida, criar um modelo aninhado, a região 
editável aparecerá nos documentos baseados no modelo aninhado (se nenhuma nova região de 
modelo tiver sido inserida naquela região no modelo aninhado).
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Em modelos aninhados, as regiões editáveis repassadas possuem uma borda azul . Você pode 
inserir um markup de modelo em uma região editável, de modo que ela não apareça como 
região editável em documentos baseados no modelo aninhado. Essas regiões têm uma borda 
cor de laranja em vez de azul.

Para criar um modelo aninhado: 

1. Crie um documento a partir do modelo no qual pretende basear o modelo aninhado:

■ Na categoria Templates do painel Assets, clique com o botão direito (Windows) ou 
clique e mantenha pressionada a tecla Control (Macintosh) sobre o modelo a partir do 
qual deseja criar o documento e, em seguida, selecione New From Template (Novo a 
partir de modelo) no menu de contexto.

■ Selecione File (Arquivo)> New (Novo). Na caixa de diálogo New Document (Novo 
documento), clique na guia Templates (Modelos) e selecione o site que contém o 
modelo desejado; na lista de documentos, clique duas vezes no modelo para criar um 
novo documento.

Um novo documento é exibido na janela do documento.
2. Siga um destes procedimentos para salvar o novo documento como um modelo aninhado:

■ Selecione File (Arquivo) > Save as Template (Salvar como modelo).
■ Na categoria Common da barra Insert, clique na seta do botão Templates e selecione 

Make Nested Template (Criar modelo aninhado).

A caixa de diálogo Save as Template (Salvar como modelo) é exibida.
3. Insira um nome na caixa de texto Save As e, em seguida, clique em OK.

Em documentos baseados no modelo aninhado, é possível adicionar ou modificar conteúdo 
em regiões editáveis repassadas a partir do modelo básico, bem como em regiões editáveis 
criadas no modelo novo.

Para impedir que uma região editável seja repassada a um modelo aninhado:

1. Na visualização de código, localize a região editável que não quer que fique acessível.

As regiões editáveis são definidas por tags de comentários de modelos. 
2. Delimite a região editável (incluindo as tags de comentários) com os seguintes marcadores:

@@(" ")@@

Para obter mais informações, consulte TechNote 16416 no site da Macromedia na Web 
em www.macromedia.com/go/16416.
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Editar e atualizar modelos
Quando você altera e salva um modelo, o Dreamweaver atualiza automaticamente todos os 
documentos anexados ao modelo. Você também pode atualizar manualmente documentos 
baseados em um modelo, se necessário. 

O Dreamweaver verifica a sintaxe do modelo automaticamente ao salvar um modelo. Você 
pode também verificar a sintaxe enquanto edita um modelo.

Abrir um modelo para edição
Você pode abrir um arquivo de modelo diretamente para edição ou então, pode abrir um 
documento baseado no modelo e abrir o modelo anexado para edição.

Quando uma alteração for feita em um modelo, o Dreamweaver solicitará a atualização das 
páginas que o utilizarem. 

Para abrir e editar um arquivo de modelo:

1. No painel Assets [Window > Assets], selecione a categoria Templates no lado esquerdo 
do painel.

O painel Assets lista as propriedades de todos os modelos disponíveis para seu site e exibe 
uma visualização do modelo selecionado.

2. Na lista de modelos disponíveis, siga um destes procedimentos:

■ Clique duas vezes no nome do modelo que deseja editar.
■ Selecione o modelo a ser editado e, em seguida, clique no botão Edit na parte inferior 

do painel Assets. 
O modelo é aberto na janela do documento.

N
O

T
A

Para editar um modelo para um site do Contribute, você deve usar o Dreamweaver. Não 
é possível editar modelos no Contribute. 

N
O

T
A

Para obter informações sobre como editar documentos baseados em modelos, consulte 
“Editar conteúdo em um documento baseado em modelo” na página 368.

N
O

T
A

Se necessário, você também pode atualizar manualmente os documentos para refletir 
as alterações no modelo (consulte “Atualizar manualmente documentos baseados em 
modelo” na página 361).
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3. Modifique o conteúdo do modelo como desejar. 

4. Salve o modelo. 

O Dreamweaver solicita que você atualize as páginas baseadas no modelo.
5. Clique em Update (Atualizar) para atualizar todos os documentos baseados no modelo 

modificado ou clique em Don’t Update (Não atualizar), se não quiser atualizar esses 
documentos.

O Dreamweaver exibe um logotipo indicando os arquivos atualizados. 

Para abrir e modificar o modelo anexado ao documento atual:

1. Abra o documento baseado no modelo na janela do documento.

2. Siga um dos procedimentos abaixo:

■ Selecione Modify (Modificar) > Templates (Modelos) > Open Attached Template 
(Abrir modelo anexado). 

■ Clique com o botão direito (Windows) ou mantendo pressionada a tecla Control 
(Macintosh) e, em seguida, selecione Templates >Open Attached Template.

3. Modifique o conteúdo do modelo como desejar. 

4. Salve o modelo. 

O Dreamweaver solicita que você atualize as páginas baseadas no modelo.
5. Clique em Update (Atualizar) para atualizar todos os documentos baseados no modelo 

modificado ou clique em Don’t Update (Não atualizar), se não quiser atualizar esses 
documentos.

O Dreamweaver exibe um logotipo indicando os arquivos atualizados. 

Tópicos relacionados
■ “Atualizar modelos em um site do Contribute” na página 361
■ “Verificar a sintaxe de modelos” na página 362

D
IC

A

Para modificar as propriedades de página do modelo, selecione Modify (Modificar) > 
Page Properties (Propriedades da página) Os documentos baseados em um modelo 
herdam as propriedades de página do modelo. 

D
IC

A

Para modificar as propriedades de página do modelo, selecione Modify (Modificar) > 
Page Properties (Propriedades da página) Os documentos baseados em um modelo 
herdam as propriedades de página do modelo. 
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Atualizar manualmente documentos baseados em 
modelo
Quando você altera um modelo, o Dreamweaver solicita que você atualize os documentos 
baseados no modelo, mas você pode atualizar o documento atual manualmente ou o site 
inteiro, se necessário. A atualização manual de documentos baseados em modelos é como 
reaplicar um modelo.

Para aplicar as alterações do modelo ao documento atual baseado no modelo:

1. Abra o documento na janela do documento. 

2. Selecione Modify (Modificar) > Templates (Modelos) > Update Current Page (Atualizar 
página atual). 

O Dreamweaver atualiza o documento para refletir quaisquer alterações no modelo.

Para atualizar o site inteiro ou todos os documentos baseados em um modelo 
especificado:

1. Selecione Modify (Modificar) > Templates (Modelos) > Update Pages (Atualizar páginas). 

A caixa de diálogo Update Pages (Atualizar páginas) é exibida.
2. Preencha a caixa de diálogo e clique em Start (Iniciar).

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo. 
O Dreamweaver atualiza os arquivos conforme indicado. Se a opção Show Log (Mostrar 
registro) for selecionada, o Dreamweaver fornecerá informações sobre os arquivos que 
tentar atualizar, incluindo informações sobre o êxito em sua atualização.

3. Clique em Close para fechar a caixa de diálogo.

Tópicos relacionados
■ “Abrir um modelo para edição” na página 359
■ “Verificar a sintaxe de modelos” na página 362

Atualizar modelos em um site do Contribute
Os usuários do Contribute não podem efetuar alterações em um modelo do Dreamweaver. 
Entretanto, é possível utilizar o Dreamweaver para alterar um modelo para um site do 
Contribute.
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Os fatores a seguir são importantes e devem ser levados em consideração ao atualizar modelos 
em um site do Contribute :

■ O Contribute recuperará modelos novos e modificados do site somente quando o 
Contribute for inicializado e quando o usuário do Contribute modificar suas informações 
de conexão. Se forem feitas alterações em um modelo enquanto um usuário do Contribute 
estiver editando um arquivo baseado nesse modelo, o usuário não verá as alterações feitas 
no modelo até que o Contribute seja reinicializado.

■ Se uma região editável for removida de um modelo, o usuário do Contribute que estiver 
editando uma página baseada nesse modelo poderá ter dúvidas sobre o que fazer com o 
conteúdo presente nessa região editável.

Para editar um modelo em um site do Contribute:

1. Edite o modelo usando o Dreamweaver. 

Para obter mais informações, consulte “Abrir um modelo para edição” na página 359.
2. Informe a todos os usuários do Contribute que estejam trabalhando no site para saírem do 

Contribute e reiniciá-lo.

Verificar a sintaxe de modelos
O Dreamweaver verifica automaticamente a sintaxe do modelo quando você o salva, mas você 
pode verificá-la manualmente antes de salvar o modelo. Por exemplo, caso adicione um 
parâmetro de modelo ou expressão na visualização de código, você poderá verificar se o código 
obedece a sintaxe correta.

Para verificar a sintaxe de modelo válida:

1. Abra o documento que deseja verificar na janela do documento.

2. Selecione Modify (Modificar) > Templates (Modelos) > Check Template Syntax (Verificar 
sintaxe do modelo). 

Uma mensagem de erro será exibida se a sintaxe for digitada incorretamente. A mensagem de 
erro descreve o erro e indica a linha específica no código onde o erro ocorreu.

Tópicos relacionados
■ “Sintaxe de tags de modelo” na página 331
■ “Expressões de modelo” na página 337
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Gerenciar modelos
Use a categoria Templates do painel Assets para gerenciar modelos existentes, como para 
renomear e excluir arquivos de modelo. 

Para renomear um modelo no painel Assets (Propriedades):

1. No painel Assets [Window > Assets], selecione a categoria Templates no lado esquerdo 
do painel.

2. Clique no nome do modelo para selecioná-lo.

3. Clique no nome novamente para tornar o texto selecionável e digite um novo nome.

Este método funciona da mesma forma que o usado para renomear um arquivo no 
Windows Explorer (no Windows) ou Finder (no Macintosh). Do mesmo modo que no 
Windows Explorer, faça uma pequena pausa entre os cliques. Não clique duas vezes no 
nome, pois essa ação abre o modelo para edição.

4. Clique em outra área do painel Assets ou pressione a tecla Enter (no Windows) ou Return 
(no Macintosh) para que a alteração tenha efeito.

O Dreamweaver perguntará se você deseja atualizar os documentos basedos neste modelo.
5. Para atualizar todos os documentos no site baseados neste modelo, clique em Update. Para 

evitar a atualização de todos os documentos baseados nesse modelo, clique em Don’t 
Update (Não atualizar).

Para excluir um arquivo de modelo:

1. No painel Assets [Window > Assets], selecione a categoria Templates no lado esquerdo 
do painel.

2. Clique no nome do modelo para selecioná-lo.

3. Clique no botão Delete (Excluir) na parte inferior do painel e confirme que deseja excluir 
o modelo.

N
O

T
A

Você também pode usar o painel Assets para aplicar um modelo a um documento 
(consulte“Editar e atualizar modelos” na página 359) ou editar um modelo (consulte 
“Abrir um modelo para edição” na página 359).

C
U

ID
A

D
O

Após excluir um arquivo de modelo, não será possível recuperá-lo. O arquivo de 
modelo será excluído do site. 
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Os documentos baseados no modelo excluído não são desanexados do modelo; eles 
preservam a estrutura e as regiões editáveis que o arquivo de modelo possuía antes de ser 
excluído. Para converter esse documento em um arquivo HTML normal sem regiões 
editáveis ou bloqueadas, consulte “Desanexar um documento de um modelo” na 
página 367.

Tópicos relacionados
■ “Criar um modelo no Dreamweaver” na página 340
■ “Aplicar ou remover um modelo de um documento existente” na página 366
■ “Editar e atualizar modelos” na página 359

Exportar e importar o conteúdo XML de 
um modelo
Um documento baseado em um modelo contém dados representados por pares nome/valor. 
Cada par consiste em um nome de região editável e no respectivo conteúdo da região. 

O Dreamweaver permite exportar os pares nome/valor para um arquivo XML, de modo que 
seja possível trabalhar com os dados do documento fora do Dreamweaver (em um editor 
XML ou editor de texto, por exemplo, ou mesmo aplicativos de banco de dados). Por outro 
lado, é possível importar os dados de um documento XML que esteja estruturado 
adequadamente para um documento baseado em um modelo do Dreamweaver. 

Para exportar as regiões editáveis do documento como XML:

1. Abra um documento baseado em modelo que contenha regiões editáveis.

2. Selecione File (Arquivo) > Export (Exportar) > Template Data as XML (Dados do modelo 
como XML). 

A caixa de diálogo Export Template Data as XML (Exportar dados do modelo como 
XML) é exibida.

3. Selecione uma das opções de Notation (Notação): 

■ Se o modelo contiver regiões repetitivas ou parâmetros de modelo, selecione Use 
Standard Dreamweaver XML Tag (Utilizar tag XML padrão do Dreamweaver). 

■ Se o modelo não contiver regiões repetitivas ou parâmetros de modelo, selecione Use 
Editable Region Names as XML Tags (Utilizar nomes de regiões editáveis como tags 
XML). 

4. Clique em OK. 

Uma caixa de diálogo é exibida, onde você pode salvar o arquivo XML.
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5. Selecione uma pasta, insira um nome para o arquivo XML e clique em Save (Salvar).

O Dreamweaver irá gerar um arquivo XML contendo o material dos parâmetros e regiões 
editáveis do documento, incluindo regiões editáveis dentro das regiões repetitivas ou 
regiões opcionais. O arquivo XML inclui o nome do modelo original, bem como o nome 
e o conteúdo de cada região do modelo.

Para importar um conteúdo XML:

1. Selecione File (Arquivo) > Import (Importar) > Import XML into Template (Importar 
XML para o modelo).

A caixa de diálogo Import XML (Importar XML) é exibida.
2. Selecione o arquivo XML e, em seguida, clique em Open (Abrir).

O Dreamweaver criará um novo documento baseado no modelo especificado no arquivo 
XML. O programa preencherá o conteúdo de cada região editável do documento utilizando 
os dados do arquivo XML. O documento resultante será aberto na janela do documento. 

Exportar um site sem markup de modelo
Se você não desejar incluir markup de modelo nos documentos baseados em modelo e que são 
exportados para outro site, utilize o comando Export Site Without Template Markup 
(Exportar site sem markup de modelo).

Para exportar um site sem markup de modelo:

1. Selecione Modify (Modificar) > Templates (Modelos) > Export Without Markup 
(Exportar sem markup).

A caixa de diálogo Export Site Without Template Markup (Exportar site sem markup de 
modelo) é exibida.

N
O

T
A

O conteúdo nas regiões bloqueadas não será exportado para o arquivo XML.

D
IC

A

Se o arquivo XML não estiver definido exatamente como o Dreamweaver espera, talvez 
não seja possível importar os dados. Uma solução para este problema é exportar um 
arquivo XML fictício do Dreamweaver, para que exista um arquivo XML com a estrutura 
correta. Em seguida, copie os dados do arquivo original XML para o arquivo XML 
exportado. O resultado é um arquivo XML com a estrutura correta que contém os dados 
apropriados, todos prontos para serem importados.
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2. Selecione uma pasta para a qual exportar o site e, em seguida, selecione opções de 
exportação adicionais conforme desejar.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo. 
3. Clique em OK.

Aplicar ou remover um modelo de um 
documento existente
Quando você aplica um modelo a um documento existente, o Dreamweaver faz a 
correspondência entre o conteúdo e as regiões do modelo ou pergunta como deve resolver os 
erros de correspondência. É possível remove o modelo posteriormente, se for necessário fazer 
alterações em regiões bloqueadas.

Aplicar um modelo a um documento existente
Ao aplicar um modelo a um documento com conteúdo existente, o Dreamweaver tentará 
corresponder o conteúdo existente com uma região do modelo. Se você estiver aplicando uma 
versão revisada de um dos seus modelos existentes, é provável que os nomes sejam 
correspondentes.

Se você aplica um modelo a um documento que não possui um modelo aplicado, não existem 
regiões editáveis para comparar e ocorre um erro de correspondência. O Dreamweaver 
controla esses erros de forma que você possa selecionar a região ou regiões para onde o 
conteúdo da página atual deve ser movido, ou excluir o conteúdo com erro de 
correspondência.

Para aplicar um modelo a um documento existente, utilize o painel Assets ou a janela do 
documento. Você pode cancelar a aplicação de um modelo, caso necessário.

Para aplicar um modelo a um documento usando o painel Assets:

1. Abra o documento ao qual deseja aplicar o modelo.

2. No painel Assets [Window > Assets], selecione a categoria Templates no lado esquerdo 
do painel.

N
O

T
A

É necessário selecionar uma pasta fora do site atual.
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3. Siga um dos procedimentos abaixo:

■ Arraste o modelo a ser aplicado do painel Assets para a janela do documento.
■ Selecione o modelo que deseja aplicar e, em seguida, clique no botão Apply (Aplicar) 

na parte inferior do painel Assets.
Se houver conteúdo no documento que não pode ser atribuído automaticamente a uma 
região de modelo, a caixa de diálogo Inconsistent Region Names será exibida.

4. Se houver conteúdo em aberto, selecione um destino para o conteúdo e, em seguida, clique 
em OK.

Para obter informações sobre como mover o conteúdo existente para regiões editáveis do 
documento, consulte Corrigir nomes de região inconsistentes em Using Dreamweaver. 

Para aplicar um modelo a um documento existente na janela do documento:

1. Abra o documento ao qual deseja aplicar o modelo.

2. Selecione Modify (Modificar) > Templates  (Modelos) > Apply Template to Page (Aplicar 
modelo à página). 

A caixa de diálogo Select Template (Selecionar modelo) é exibida.
3. Escolha um modelo na lista e clique em Select. 

Se houver conteúdo no documento que não pode ser atribuído automaticamente a uma 
região de modelo, a caixa de diálogo Inconsistent Region Names será exibida.

4. Se houver conteúdo em aberto, selecione um destino para o conteúdo e, em seguida, clique 
em OK.

Para obter informações sobre como mover o conteúdo existente para regiões editáveis do 
documento, consulte Corrigir nomes de região inconsistentes em Using Dreamweaver. 

Para desfazer as alterações feitas no modelo:

■ Selecione Edit (Editar) > Undo Apply Template (Desfazer Aplicar modelo).

O documento volta para o estado anterior à aplicação do modelo.

Desanexar um documento de um modelo
Para fazer alterações nas regiões bloqueadas de um documento baseado em um modelo, você 
deve desanexar o documento do modelo. Quando o documento é desanexado, o documento 
inteiro passa a ser editável.
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Para desanexar um documento de um modelo:

1. Abra o documento baseado em modelo a ser desanexado.

2. Selecione Modify (Modificar) > Templates (Modelos) > Detach from Template 
(Desanexar do modelo).

O documento é desanexado do modelo e todos os códigos do modelo são removidos.

Tópicos relacionados
■ “Aplicar um modelo a um documento existente” na página 366

Editar conteúdo em um documento 
baseado em modelo
Os modelos do Dreamweaver especificam as regiões bloqueadas (não editáveis) e as regiões 
editáveis para documentos baseados em modelo (consulte “Sobre modelos do Dreamweaver” 
na página 326). 

Em páginas baseadas em modelos (consulte “Criar um documento a partir de um modelo 
existente” na página 104), os usuários do modelo podem editar somente o conteúdo de 
regiões editáveis. É fácil identificar e selecionar regiões editáveis para editar conteúdo (consulte 
“Selecionar regiões editáveis” na página 348). Os usuários do modelo não podem editar 
conteúdo em regiões bloqueadas.

Os usuários do modelo podem também modificar propriedades e editar entradas para uma 
região repetitiva em documentos baseados em modelos.

Modificar propriedades de modelos
Quando os autores de um modelo criam parâmetros em um modelo (consulte “Parâmetros de 
modelo” na página 336), os documentos baseados no modelo automaticamente herdam os 
parâmetros e as definições iniciais dos valores. O usuário de um modelo pode atualizar 
atributos de tags editáveis e outros parâmetros do modelo (como definições de região 
opcionais). 

N
O

T
A

Se você tentar editar uma região bloqueada em um documento baseado em modelo 
quando o realce estiver desativado, o ponteiro do mouse será alterado para indicar que 
não é possível clicar na região bloqueada. 
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Para modificar um atributo de tag editável:

1. Abra o documento baseado em modelos.

2. Selecione Modify (Modificar) > Template Properties (Propriedades do modelo).

A caixa de diálogo Template Properties é aberta, exibindo uma lista de propriedades 
disponíveis. A caixa de diálogo exibe regiões opcionais e atributos de tags editáveis.

3. Na lista Name, selecione a propriedade. 

A área de fundo da caixa de diálogo é atualizada para exibir o identificador da propriedade 
selecionada e seu valor atribuído.

4. No campo à direita do identificador da propriedade, edite o valor para modificar a 
propriedade no documento.

5. Marque a caixa de seleção Allow Nested Templates to Control This (Permitir que modelos 
aninhados controlem isso), se quiser repassar a propriedade editável aos documentos 
baseados no modelo aninhado.  

Para modificar parâmetros de modelo de regiões opcionais: 

1. Abra o documento baseado em modelos.

2. Selecione Modify (Modificar) > Template Properties (Propriedades do modelo).

A caixa de diálogo Template Properties é aberta, exibindo uma lista de propriedades 
disponíveis. A caixa de diálogo exibe regiões opcionais e atributos de tags editáveis.

3. Na lista Name (Nome), selecione uma propriedade.

A caixa de diálogo é atualizada para exibir o identificador da propriedade selecionada e seu 
valor atribuído. 

4. Marque a caixa de seleção Show (Mostrar) para exibir a região opcional no documento ou 
desmarque a caixa de seleção para ocultá-la. 

5. Marque a caixa de seleção Allow Nested Templates to Control This (Permitir que modelos 
aninhados controlem isso), se quiser repassar a propriedade editável aos documentos 
baseados no modelo aninhado.  

N
O

T
A

O nome do campo e os valores atualizáveis são definidos no modelo. Os atributos 
que não aparecem na lista Name não podem ser atualizados no documento baseado 
em modelo.

N
O

T
A

O nome do campo e os valores padrão são definidos no modelo.
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Tópicos relacionados
■ “Definir atributos de tag editáveis” na página 356
■ “Usar regiões opcionais” na página 353

Adicionar, excluir e modificar a ordem de uma 
entrada de região repetitiva 
Use a região repetitiva para controlar, excluir ou modificar a ordem das entradas em 
documentos baseados em modelos. Quando uma entrada de região repetitiva é adicionada, 
uma cópia de toda a região repetitiva é adicionada. Para atualizar o conteúdo das regiões 
repetitivas, o modelo original deve incluir uma região editável na região repetitiva.  

Para adicionar, excluir ou modificar a ordem de uma região repetitiva: 

1. Posicione o ponto de inserção na região repetitiva para selecioná-la.

2. Siga um dos procedimentos abaixo:

■ Clique no botão de adição (+) para adicionar uma entrada de região repetitiva abaixo 
da entrada selecionada no momento.

■ Clique no botão de subtração (–) para excluir a entrada de região repetitiva 
selecionada.

■ Clique no botão de seta para abaixo para mover a entrada selecionada uma posição 
para baixo.

■ Clique no botão de seta para cima para mover a entrada selecionada uma posição 
acima.

N
O

T
A

Você pode também selecionar Modify > Template e, em seguida, selecionar uma 
das opções de entradas repetitivas próximas à parte inferior do menu de 
contexto. Use este menu para inserir uma nova entrada repetitiva ou mover a 
posição da entrada selecionada.
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Para recortar, copiar e excluir entradas:

1. Posicione o ponto de inserção na região repetitiva para selecioná-la.

2. Siga um dos procedimentos abaixo:

■ Para recortar uma entrada repetitiva, selecione Edit (Editar) > Repeating Entries 
(Entradas repetitivas) > Cut Repeating Entries (Recortar entradas repetitivas).

■ Para copiar uma entrada repetitiva, selecione Edit > Repeating Entries > Copy 
Repeating Entries.

■ Para remover uma entrada repetitiva, selecione Edit > Repeating Entries > Delete 
Repeating Entries.

■ Para colar uma entrada repetitiva, selecione Edit > Paste.

Tópicos relacionados
■ “Criar regiões repetitivas” na página 350
<!-- TemplateParam name="departmentImage" type="boolean" value="true" -->

<!-- TemplateBeginIf cond="departmentImage" --> 
<p><img src="/images/airfare_on.gif" width="85" height="22"> </p>
<!-- TemplateEndIf --> 

N
O

T
A

A opção colar insere uma nova entrada, mas não substitui uma entrada existente.
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PARTE 4

Adicionar conteúdo às 
páginas

Use as ferramentas visuais do Macromedia Dreamweaver 8 para adicionar 
uma variedade de conteúdo às páginas da Web. Com elas você pode 
adicionar e formatar elementos como texto, imagens, cores, filmes, som e 
outras formas de mídia. Você pode tornar o conteúdo de suas páginas 
acessível a visitantes com deficiência física.

Esta seção contém os seguintes capítulos:
Capítulo 12: Trabalhar com páginas . . . . . . . . . . . . . . . . . . . . . . . . 375

Capítulo 13: Inserir e formatar texto . . . . . . . . . . . . . . . . . . . . . . . . 405

Capítulo 14: Inserir imagens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 445

Capítulo 15: Links e navegação. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 461

Capítulo 16: Trabalhar com outros aplicativos . . . . . . . . . . . . . . . 497

Capítulo 17: Adicionar áudio, vídeo e elementos interativos . . . . 515

Capítulo 18: Utilizar comportamentos JavaScript . . . . . . . . . . . . . 541
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CAPÍTULO 12

Trabalhar com páginas
O Macromedia Dreamweaver 8 fornece muitos recursos para ajudá-lo a criar novas páginas da 
Web. Esses recursos para a criação de páginas ajudam a facilitar a especificação das 
propriedades das páginas, como títulos, imagens e cores de fundo e cores do texto e de links. 
Além disso, o Dreamweaver fornece ferramentas para ajudar a maximizar o desempenho do 
site da Web e para criar e testar as páginas para garantir a compatibilidade com diversos 
navegadores da Web.

Este capítulo contém as seguintes seções:
Sobre o trabalho com páginas. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .375

Salvar páginas da Web . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 380

Especificar HTML em vez de CSS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381

Definir propriedades de página . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381

Trabalhar com cores  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .384

Selecionar elementos na janela do documento. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .386

Aplicar zoom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .389

Utilizar o painel History (Histórico) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 390

Automatizar tarefas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 391

Utilizar comportamentos JavaScript para detectar navegadores e plug-ins  . . . .398

Visualizar e testar páginas em navegadores  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399

Definir preferências de tamanho e tempo de download  . . . . . . . . . . . . . . . . . . . . . 402

Sobre o trabalho com páginas
Ao criar uma página da Web, leve em consideração os navegadores e sistemas operacionais que 
os usuários usarão para exibir suas páginas da Web e os conjuntos de idioma que planeja 
suportar. As próximas seções irão ajudá-lo a entender como selecionar cores para exibição 
correta em diferentes navegadores da Web, como codificar caracteres (formatos de letra) para 
os diferentes idiomas e como verificar se um navegador da Web é compatível com seu site.
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Sobre a configuração de propriedades de página
Para cada página criada no Dreamweaver, você pode especificar propriedades de layout e 
formatação na caixa de diálogo Page Properties (Propriedades de página) aberta a partir de 
Modify > Page Properties. Essa caixa de diálogo permite especificar a família e o tamanho da 
fonte padrão, a cor de fundo, margens, estilos de links e muitos outros aspectos do design de 
uma página. Você pode atribuir novas propriedades de página para cada nova página criada e 
modificar aquelas de páginas existentes.

Por padrão, o Dreamweaver formata o texto usando folhas de estilo CSS (Cascading Style 
Sheet, Folha de estilo em cascata). Para alterar as preferências de formatação de página para 
HTML, use a caixa de diálogo Preferences (Preferências), acessada a partir de Edit > 
Preferences. Ao usar propriedades de página CSS, o Dreamweaver utiliza tags CSS para todas 
as propriedades definidas nas categorias Appearance (Aparência), Links e Headings 
(Cabeçalhos) da caixa de diálogo Page Properties (Propriedades da página). As tags de CSS 
que definem esses atributos são incorporadas na seção de cabeçalho da página. 

Propriedades de página CSS versus HTML
Por padrão, o Dreamweaver utiliza CSS para atribuir propriedades de página. Se ao invés 
disso, quiser usar tags HTML, você deve especificar na caixa de diálogo Preferences (consulte 
“Especificar HTML em vez de CSS” na página 381 para mais informações).

N
O

T
A

As propriedades de página definidas por você são aplicadas somente ao documento 
ativo. Se uma página utilizar uma folha de estilo CSS externa, o Dreamweaver não 
substituirá o conjunto de tags definidas na folha de estilo, pois isso afetará todas as 
outras páginas que utilizarem essa folha de estilo. 
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Mesmo que decida usar HTML em vez de CSS, o Inspetor de propriedades ainda exibirá o 
menu pop-up Style (Estilo). Entretanto, os controles de fonte, tamanho, cor e alinhamento 
mostrarão apenas as propriedades definidas usando tags HTML. Os valores de propriedades 
de CSS aplicados à seleção atual não serão mais visíveis e o menu pop-up Size (Tamanho) será 
desativado.

Tópicos relacionados
■ “Especificar HTML em vez de CSS” na página 381
■ “Definir propriedades de página” na página 381

Sobre o painel History (Histórico)
O painel History (Histórico) exibe uma lista das etapas realizadas no documento ativo desde 
que você o criou ou o abriu, até um número especificado de etapas. Esse painel não mostra as 
etapas realizadas em outros quadros, janelas do documento ou no painel Site. Ele permite 
desfazer uma ou mais etapas, executá-las novamente e criar novos comandos para automatizar 
tarefas repetitivas.

O botão deslizante (polegar) do painel History (Histórico) indica inicialmente a última etapa 
efetuada.

Tópicos relacionados
■ “Utilizar o painel History (Histórico)” na página 390

Replay 

Botão Copy Steps 

Botão Save As Command 

Controle 

Etapas
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Sobre as cores aceitas pela Web
Em HTML, as cores são expressas como valores hexadecimais (por exemplo, #FF0000) ou 
como nomes de cores (vermelho). Uma cor aceita pela Web é aquela que tem a mesma 
aparência no Netscape Navigator e no Microsoft Internet Explorer, tanto nos sietemas 
Windows e Macintosh, quando estão em execução no modo de 256 cores. Na prática, diz-se 
que há 216 cores comuns e que qualquer valor hexadecimal que combine os pares 00, 33, 66, 
99, CC ou FF (valores RGB 0, 51, 102, 153, 204 e 255, respectivamente) representa uma cor 
aceita pela Web.

No entanto, testes revelam que existem somente 212 cores aceitas pela Web em vez de 216, 
pois o Internet Explorer, quando executado no Windows, não interpreta corretamente as cores 
#0033FF (0,51,255), #3300FF (51,0,255), #00FF33 (0,255,51) e #33FF00 (51,255,0).

Quando os navegadores da Web surgiram, a maioria dos computadores exibia apenas 256 
cores (8 bits). Como a maioria dos computadores atuais exibe milhares ou milhões de cores 
(16 e 32 bits), há pouca justificativa para usar a paleta de cores seguras para a Web ao 
desenvolver seu site para usuários com sistemas de computador atuais. 

Uma razão para utilizar a paleta de cores segura para a Web é se planeja desenvolver para 
dispositivos de Web alternativos, como telas de PDAs e de telefones celulares. Muitos desses 
dispositivos oferecem apenas telas em preto e branco (1 bit) ou 256 cores (8 bits). 

No Dreamweaver, as paletas Color Cubes (Cubos de cor) (padrão) e Continuous Tone (Tom 
contínuo) utilizam a paleta de 216 cores aceita pela Web; a seleção de uma cor em uma dessas 
paletas exibirá o valor hexadecimal da cor.

Para escolher uma cor fora da faixa de cores aceitas pela Web, abra o seletor de cores do 
sistema, clicando no botão Color Wheel (Círculo de cores) localizado no canto superior 
direito do seletor de cores do Dreamweaver. O seletor de cores do sistema não se limita às 
cores aceitas pela Web.

As versões para UNIX do Netscape Navigator utilizam uma paleta de cores diferente daquela 
usada nas versões para Windows e Macintosh. Se a programação for exclusiva para 
navegadores UNIX (ou se o público-alvo for composto por usuários do Windows ou 
Macintosh com monitores de 24 bits e por usuários do UNIX com monitores de 8 bits), deve-
se considerar a possibilidade de utilizar valores hexadecimais que combinem os pares 00, 40, 
80, BF ou FF, que produzem cores aceitas pela Web para o SunOS.

Tópicos relacionados
■ “Trabalhar com cores” na página 384
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Codificação de documentos
A opção Document encoding (Codificação do documento) especifica a codificação de 
caracteres utilizada no documento. A codificação do documento é especificada em uma tag 
meta no cabeçalho do documento; ela informa ao navegador e ao Dreamweaver como o 
documento deverá ser decodificado e quais fontes deverão ser usadas para exibir o texto 
decodificado.

Por exemplo, se for especificado Western (Latin1) (Ocidental [Latin1]), a seguinte tag meta 
será inserida: <meta http-equiv="Content-Type" content="text/html; charset=iso-
8859-1">. O Dreamweaver exibirá o documento com as fontes especificadas em Fonts 
Preferences para a codificação Western (Latin1); um navegador exibirá o documento com as 
fontes especificadas pelo usuário do navegador para a codificação Western (Latin1).

Se for especificado japonês (Shift JIS), a seguinte tag meta será inserida: <meta http-
equiv="Content-Type" content="text/html; charset=Shift_JIS">. O Dreamweaver 
exibirá o documento utilizando as fontes especificadas para as codificações do idioma japonês. 
O navegador exibirá o documento utilizando as fontes especificadas pelo usuário do 
navegador para a codificação do idioma japonês.

Para alterar a codificação do documento para uma página, consulte “Definir propriedades de 
página” na página 381. Para alterar a codificação padrão que o Dreamweaver utiliza para criar 
novos documentos, consulte “Definir um novo tipo de documento padrão” na página 106. 
Para alterar as fontes que o Dreamweaver utiliza para exibir cada codificação, consulte 
“Definir as preferências de fontes para a exibição do Dreamweaver” na página 82. 

Utilizar comandos salvos versus repetir etapas
O Dreamweaver permite gravar um comando temporário para uso por um período curto ou 
executar etapas anteriores a partir do painel History. 

Quando você grava um comando temporário:

■ As etapas são gravadas à medida que são executadas, dispensando a necessidade de 
selecioná-las no painel History (Histórico) antes de executá-las novamente.

■ Durante a gravação, o Dreamweaver impede que sejam efetuados movimentos do mouse 
que não possam ser gravados (como clicar para selecionar um elemento de uma janela ou 
arrastar um elemento da página para um novo local).

■ Se você alternar para um outro documento durante a gravação, o Dreamweaver não 
gravará as alterações feitas no outro documento. Para determinar se a gravação está sendo 
processada ou não, observe o ponteiro do mouse.
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Tópicos relacionados
■ “Automatizar tarefas” na página 391
■ “Repetir etapas” na página 392
■ “Gravar comandos” na página 397

Salvar páginas da Web
É possível salvar um documento usando seu nome e local atual ou salvar uma cópia de um 
documento usando um nome e local diferentes.

Ao atribuir nomes a arquivos, evite usar espaços e caracteres especiais em nomes de arquivo e 
de pasta. Particularmente, não utilize caracteres especiais (como é, ç ou ¥) ou pontuação 
(como dois pontos, barras inclinadas ou pontos) nos nomes dos arquivos que serão colocados 
em um servidor remoto. Muitos servidores alteram esses caracteres durante o upload, o que 
causa o rompimento dos links para os arquivos. Além disso, não coloque um número no 
início de um nome de arquivo.

Para salvar um documento:

1. Siga um dos procedimentos abaixo:

■ Para substituir a versão atual no disco e salvar quaisquer alterações feitas, selecione File 
(Arquivo) > Save (Salvar).

■ Para salvar o arquivo em uma pasta diferente ou usando um nome diferente, selecione 
File (Arquivo) > Save As (Salvar como).

2. Na caixa de diálogo Save As (Salvar como), navegue até a pasta onde deseja salvar o arquivo.

3. Na caixa de texto File Name (Nome do arquivo), digite um nome para o arquivo.

4. Clique em Save (Salvar) para salvar o arquivo.

Para salvar todos os documentos abertos:

1. Selecione File (Arquivo) > Save All (Salvar tudo). 

2. Se existirem documentos não salvos abertos, a caixa de diálogo Save As (Salvar como) será 
exibida para cada um desses documentos. 

Na caixa de diálogo exibida, navegue até a pasta onde deseja salvar o arquivo.
3. Na caixa de texto File Name (Nome do arquivo), digite um nome para o arquivo.

4. Clique em Save (Salvar) para salvar o arquivo.
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Para reverter para a última versão salva do documento:

1. Selecione File (Arquivo) > Revert (Reverter).

Será exibida uma caixa de diálogo perguntando se você deseja descartar as alterações e 
reverter para a versão salva anteriormente. 

2. Clique em Yes (Sim) para reverter para a versão anterior; clique em Não (Não) para manter 
as suas alterações.

Tópicos relacionados
■ “Criar novos documentos” na página 102
■ “Salvar um novo documento” na página 105

Especificar HTML em vez de CSS
Por padrão, o Dreamweaver utiliza tags CSS para atribuir propriedades de página. Se preferir 
usar tags HTML, você deverá desmarcar a opção Use CSS Instead of HTML Tags (Usar tags 
CSS em vez de tags HTML) na categoria General da caixa de diálogo Preferences.

Para especificar tags HTML em vez de tags CSS para as propriedades de 
página:

1. Selecione Edit (Editar) > Preferences (Preferências).

A caixa de diálogo Preferences é exibida.
2. Na categoria General da caixa de diálogo Page Properties, desmarque a caixa de seleção Use 

CSS Instead of HTML Tags (Utilizar tags CSS em vez de HMTL). 

Essa caixa de seleção está localizada na seção Editing Options (Opções de edição) do 
painel General Preferences (Preferências gerais).

3. Clique em OK.

Tópicos relacionados
■ “Sobre a configuração de propriedades de página” na página 376

Definir propriedades de página
Os títulos, as cores e imagens de fundo, as cores do texto e dos links e as margens da página 
são propriedades básicas de todo documento da Web. É possível definir ou alterar 
propriedades de página utilizando a caixa de diálogo Page Properties (Propriedades da página).

N
O

T
A

Se você salvar um documento e, em seguida, sair do Dreamweaver, não poderá 
reverter para a versão anterior do documento ao reiniciar o Dreamweaver.
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Para definir propriedades do documento:

1. Selecione Modify (Modificar) > Page Properties (Propriedades da página), ou clique no 
botão Page Properties no Inspetor de propriedades do texto.

A caixa de diálogo Page Properties (Propriedades da página) é exibida.
2. Faça as alterações das propriedades, conforme desejado.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

Tópicos relacionados
■ “Sobre a configuração de propriedades de página” na página 376
■ “Definir estilos de sublinhado para links CSS” na página 383
■ “Definir uma imagem de fundo ou uma cor de fundo para a página” na página 383

Alterar o título do documento
O título de uma página HTML ajuda os visitantes do site a controlar o que estão exibindo 
enquanto navegam e também identifica a página nas listas de histórico e marcadores do 
visitante. Se uma página não tiver um título, ela será exibida na janela do navegador e nessas 
listas como um Untitled Document (Documento sem título). 

Para localizar todos os documentos sem título existentes no seu site, utilize o comando Site > 
Reports (Relatórios do site). Consulte “Testar o site” na página 171.

Para alterar o título de uma página:

1. Com o documento aberto, siga um dos procedimentos abaixo:

■ Selecione Modify (Modificar) > Page Properties (Propriedades da página).
■ Selecione View (Exibir) > Toolbar (Barra de ferramentas) >Document (Documento) 

(se ainda não estiver selecionado).
■ Clique com o botão direito do mouse (no Windows), ou mantenha a tecla Control 

pressionada e clique (no Macintosh), em uma área vazia do documento e, em seguida, 
selecione Page Properties (Propriedades da página).

2. Na caixa de texto Title (Título), digite o título da página e pressione Enter (Windows) ou 
Return (Macintosh).

N
O

T
A

Observe que atribuir um nome de arquivo a um documento (salvando-o) não é o mesmo 
que atribuir um título a uma página. 
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3. Se estiver editando o título na caixa de diálogo Page Properties (Propriedades da página), 
clique em OK.

O título é exibido na barra de título da janela do documento (e na barra de ferramentas do 
documento, se ela for exibida). O nome de arquivo da página e a pasta na qual o arquivo 
foi salvo são exibidos entre parênteses ao lado do título na barra de título. Um asterisco 
indica que o documento contém alterações que ainda não foram salvas.

Tópicos relacionados
■ “Sobre a configuração de propriedades de página” na página 376

Definir estilos de sublinhado para links CSS
Se você estiver usando a caixa de diálogo CSS Page Properties (Propriedades de páginas CSS) 
padrão, o Dreamweaver facilitará a tarefa de especificar estilos especiais para links CSS. Ao 
usar as opções para links CSS, é possível escolher entre nunca sublinhar links, sublinhar links 
somente quando o mouse passar sobre eles ou desativar links quando o mouse passar sobre 
eles.

Para selecionar um estilo para um link CSS:

1. Selecione Modify (Modificar) > Page Properties (Propriedades da página), ou selecione 
Page Properties (Propriedades da página) no menu contextual, na visualização do projeto 
na janela do documento.

2. Selecione a categoria Links na caixa de diálogo CSS Page Properties (Propriedades de 
páginas CSS).

3. No menu pop-up Underline Style (Estilo de sublinhado), selecione o estilo de sublinhado 
que deseja usar como padrão para a sua página.

4. Clique em OK.

Tópicos relacionados
■ “Sobre a configuração de propriedades de página” na página 376
■ Capítulo 15, “Links e navegação”, na página 461

Definir uma imagem de fundo ou uma cor de fundo 
para a página
Para definir uma imagem ou cor de fundo da página, utilize a caixa de diálogo Page Properties 
(Propriedades da página). 
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Se utilizar tanto uma imagem de fundo quanto uma cor de fundo, a cor aparecerá durante o 
download da imagem, que por sua vez cobrirá a cor. Se a imagem de fundo contiver algum 
pixel transparente, a cor de fundo ficará visível. 

Para definir uma imagem ou cor de fundo:

1. Selecione Modify (Modificar) > Page Properties (Propriedades da página), ou selecione 
Page Properties (Propriedades da página) no menu contextual, na visualização do projeto 
na janela do documento.

2. Selecione a categoria Appearance (Aparência) na caixa de diálogo Page Properties 
(Propriedades da página).

3. Para definir uma imagem de fundo, clique no botão Browse (Procurar) e, em seguida, 
procure a imagem para selecioná-la. Uma alternativa é digitar o caminho da imagem de 
fundo na caixa Background Image (Imagem de fundo). 

O Dreamweaver irá dispor lado a lado (repetirá) a imagem de fundo se esta não preencher 
toda a janela, exatamente como fazem os navegadores. Para não dispor a imagem de fundo 
lado a lado, use a opção Cascading Style Sheets (Folhas de estilo em cascata) para desativar 
a repetição de imagens. Consulte “Definir propriedades de fundo do estilo CSS” em 
Usando o Dreamweaver.)

4. Para definir uma cor de fundo, clique na caixa Background Color (Cor de fundo) e 
selecione uma cor no seletor de cores.

Tópicos relacionados:
■ “Sobre a configuração de propriedades de página” na página 376

Trabalhar com cores
No Dreamweaver, muitas das caixas de diálogo, assim como o Inspetor de propriedades para 
muitos dos elementos da página, contêm uma caixa de cores que abre um seletor de cores. 
Utilize o seletor de cores para selecionar uma cor para um elemento da página.

Para selecionar uma cor no Dreamweaver:

1. Clique em uma caixa de cores de qualquer caixa de diálogo ou do Inspetor de propriedades. 
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O seletor de cores é exibido.

2. Siga um dos procedimentos abaixo:

■ Utilize o conta-gotas para selecionar uma amostra de cor na paleta. Todas as cores 
exibidas nas paletas Color Cubes (Cubos de cor), o padrão, e Continuous Tone (Tom 
contínuo) são aceitas pela Web, mas as cores de outras paletas não. Para obter mais 
informações, consulte “Sobre as cores aceitas pela Web” na página 378.

■ Utilize o conta-gotas para selecionar uma cor de qualquer lugar da tela, inclusive fora 
das janelas do Dreamweaver. Para escolher uma cor da área de trabalho ou de outro 
aplicativo, mantenha pressionado o botão do mouse para manter o foco do conta-
gotas e selecione uma cor fora do Dreamweaver. Caso clique na área de trabalho ou em 
outro aplicativo, o Dreamweaver obterá a cor de onde você clicou. Entretanto, se 
alternar para outro aplicativo, talvez você precise clicar em uma janela do 
Dreamweaver para continuar trabalhando no Dreamweaver.

■ Para aumentar a seleção de cores, utilize o menu pop-up localizado no canto superior 
direito do seletor de cores. É possível selecionar Color Cubes (Cubos de cor), 
Continuous Tone (Tom contínuo), Windows OS (Windows), Mac OS (Mac), 
Grayscale (Escala de cinza) e Snap to Web Safe (Ajustar à cor aceita pela Web). 

Para limpar a cor atual sem precisar escolher outra cor, clique no botão Default Color.
Para abrir o seletor de cores do sistema, clique no botão Color Wheel (Círculo de 
cores). Para obter mais informações, consulte “Sobre as cores aceitas pela Web” na 
página 378. 

N
O

T
A

As paletas Color Cubes (Cubos de cor) e Continuous Tone (Tom contínuo) são 
seguras para a Web, mas as paletas Windows OS, Mac OS e Grayscale (Escala 
de cinza) não são. Se você estiver utilizando uma paleta que é aceita pela Web e, 
em seguida, selecionar Snap to Web Safe (Ajustar à cor aceita pela Web), o 
Dreamweaver substituirá a cor selecionada pela cor mais próxima aceita pela 
Web. Em outras palavras, é possível que a cor não corresponda àquela que 
for visualizada.
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Definir cores padrão para o texto
Defina cores padrão para texto comum, links, links visitados e links ativos na caixa de diálogo 
Page Properties (Propriedades da página), ou escolha um esquema de cores predefinido para 
definir as cores do texto e do fundo da página. Consulte “Trabalhar com cores” na página 384. 

Para definir as cores padrão do texto, siga um dos procedimentos abaixo:

■ Selecione Modify (Modificar) > Page Properties (Propriedades da página) e, em seguida, 
selecione as cores para as opções Text Color (Cor do texto), Link Color (Cor do link), 
Visited Links (Links visitados) e Active Links (Links ativos).

■ Selecione Commands (Comandos) > Set Color Scheme (Definir esquema de cores) e, em 
seguida, selecione uma cor de fundo e um conjunto de cores para o texto e os links.
A caixa de exemplo exibe a aparência do esquema de cores no navegador.

Tópicos relacionados
■ “Sobre a configuração de propriedades de página” na página 376

Selecionar elementos na janela 
do documento
Para selecionar um elemento na visualização do projeto da janela do documento, clique no 
elemento. Se um elemento estiver invisível, você deverá torná-lo visível para que 
possa selecioná-lo. Para obter mais informações sobre elementos invisíveis, consulte “Mostrar 
e ocultar elementos invisíveis” na página 388.

Para selecionar elementos, utilize as seguintes técnicas:

■ Para selecionar um elemento visível na janela do documento, clique nele ou arraste o 
mouse sobre o elemento.

■ Para escolher um elemento invisível, selecione View (Exibir) > Visual Aids (Auxílios 
visuais) > Invisible Elements (Elementos invisíveis), se esse item de menu já não estiver 
selecionado. Em seguida, clique no marcador do elemento na janela do documento.

N
O

T
A

A cor dos links ativos é a cor assumida por um link quando se clica nele. Alguns 
navegadores da Web podem não utilizar a cor que você especificar.

N
O

T
A

Caso defina essas configurações na caixa de diálogo Page Properties (Propriedades 
da página) usando as tags CSS padrão, o comando Color Scheme (Cor do 
esquema) não afetará a aparência da sua página. Isso ocorre porque as tags CSS 
têm precedência sobre as tags HTML.
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Alguns objetos são exibidos na página em um lugar diferente de onde foi inserido o código 
correspondente. Por exemplo, uma camada pode estar em qualquer posição na página, 
mas o código que a define estará em uma posição fixa. Quando elementos invisíveis são 
exibidos, o Dreamweaver mostra marcadores na janela do documento para indicar a 
localização do código para tais elementos. A seleção de um marcador seleciona o elemento 
inteiro. Por exemplo, a seleção do marcador de uma camada seleciona toda a camada. 
Consulte “Mostrar e ocultar elementos invisíveis” na página 388.

■ Para selecionar uma tag completa (inclusive o seu conteúdo, se houver), clique em uma tag 
do seletor de tags, localizado na parte inferior esquerda da janela do documento (o seletor 
de tags é exibido tanto na visualização do projeto como na visualização do código). O 
seletor sempre mostra as tags que contêm a seleção atual ou o ponto de inserção. A tag 
mais à esquerda é a tag mais externa que contém a seleção atual ou o ponto de inserção. A 
tag seguinte está contida na tag mais externa e assim por diante. A tag mais à direita é a tag 
mais interna, que contém a seleção atual ou o ponto de inserção. 
No exemplo a seguir, o ponto de inserção está em uma tag de parágrafo, <p>. Para 
selecionar a tabela contendo o parágrafo desejado, selecione a tag <table> à esquerda da 
tag <p>. 

Para ver o código HTML associado ao texto ou objeto selecionado, siga um 
dos procedimentos abaixo: 

■ Na barra de ferramentas do documento, clique no botão Show Code view (Mostrar 
visualização do código).

■ Selecione View (Exibir) > Code (Código).
■ Na barra de ferramentas do documento, clique no botão Show Code and Design View 

(Mostrar visualização do código e do projeto).
■ Selecione View > Code and Design (Código e projeto).
■ Selecione Window (Janela)> Code Inspector (Inspetor de código). 

Para obter mais informações sobre a visualização de código, consulte “Exibir o código” na 
página 583.

Ao selecionar um elemento em um dos editores de código, seja na visualização do código ou 
no inspetor Code (Código), ele geralmente também é selecionado na janela do documento. 
Talvez seja preciso sincronizar as duas visualizações para que a seleção seja exibida (consulte 
“Exibir o código” na página 583).
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Mostrar e ocultar elementos invisíveis
Alguns códigos HTML não possuem uma representação visível em um navegador. Por 
exemplo, as tags comment não são exibidas nos navegadores. Entretanto, durante a criação de 
uma página, será útil poder selecionar esses elementos invisíveis, editá-los, movê-los e excluí-
los. 

O Dreamweaver permite especificar se ícones devem ser exibidos marcando a localização de 
elementos invisíveis na visualização do projeto da janela do documento. Para indicar os 
marcadores de elementos que serão exibidos ao selecionar a opção View (Exibir) > Visual Aids 
(Auxílios visuais) > Invisible Elements (Elementos invisíveis), defina opções nas preferências 
de Invisible Elements (Elementos invisíveis). Por exemplo, você pode especificar que as 
âncoras com nome sejam visíveis, mas não as quebras de linha.

É possível criar determinados elementos invisíveis (tais como comentários e âncoras com 
nome) utilizando botões da categoria Common (Comuns) da barra Insert (Inserir) (consulte 
“Utilizar a barra Insert” na página 61). Em seguida, você pode modificar esses elementos 
usando o Inspetor de propriedades.

Para mostrar ou ocultar ícones de marcadores para elementos invisíveis:

■ Selecione View (Exibir) > Visual Aids (Auxílios visuais) > Invisible Elements (Elementos 
invisíveis). 

Para alterar as preferências em Invisible Elements (Elementos invisíveis):

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh) e 
clique em Invisible Elements.

2. Selecione os elementos que deverão se tornar visíveis. 

A marca de seleção ao lado do nome do elemento, na caixa de diálogo, significa que ele 
estará visível quando a opção View (Exibir) > Visual Aids (Auxílios visuais)> Invisible 
Elements (Elementos invisíveis) for selecionada.
Para obter uma explicação sobre cada uma das preferências de Invisible Elements 
(Elementos invisíveis), consulte “Mostrar e ocultar elementos invisíveis” em Usando o 
Dreamweaver.

3. Clique em OK.

N
O

T
A

A exibição de elementos invisíveis pode alterar ligeiramente o layout da página, 
movendo outros elementos alguns pixels. Portanto, para obter um layout preciso, 
oculte os elementos invisíveis.
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Aplicar zoom
O Dreamweaver permite ampliar ou reduzir um documento, de modo que você possa verificar 
a precisão de pixels das figuras, selecionar itens pequenos mais facilmente, criar páginas com 
texto pequeno, criar páginas grandes, etc.

Para ampliar uma página:

1. Selecione a ferramenta Zoom (ícone da lente de aumento) no canto inferior direito da 
janela do documento.

2. Siga um dos procedimentos abaixo:

■ Clique na parte da página que você deseja ampliar até obter a ampliação desejada.
■ Arraste uma caixa pela área da página que você deseja ampliar e solte o botão do mouse.
■ Selecione um nível de ampliação predefinido no menu pop-up Zoom.
■ Digite um nível de ampliação na caixa de texto Zoom.

Para reduzir uma página:

1. Selecione a ferramenta Zoom.

2. Pressione a tecla Alt (no Windows) ou Option (no Macintosh) e clique na página.

Para editar uma página após aplicar o zoom:

■ Selecione a ferramenta Pointer (Ponteiro) (ícone do ponteiro) no canto inferior direito da 
janela do documento e clique na página.

Para ver uma panorâmica da página após aplicar o zoom:

1. Selecione a ferramenta Hand (Mão) (ícone da mão) no canto inferior direito da janela do 
documento.

2. Arraste a página.

Para preencher a janela do documento com uma seleção:

1. Selecione um elemento da página.

2. Selecione View (Exibir)> Fit Selection (Ajustar a seleção).

N
O

T
A

As ferramentas de zoom estarão disponíveis apenas na visualização do projeto.

D
IC

A

Também é possível ampliar uma página sem utilizar a ferramenta Zoom, 
pressionando Control+= (Windows) ou Command+= (Macintosh).

D
IC

A

Também é possível reduzir uma página sem utilizar a ferramenta Zoom, 
pressionando Control+- (Windows) ou Command+- (Macintosh).
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Para preencher a janela do documento com uma página inteira:

■ Selecione View > Fit All (Ajustar tudo).

Para preencher a janela do documento com a largura inteira de uma página:

■ Selecione View > Fit Width (Ajustar a largura).

Tópicos relacionados
■ “A barra de status” na página 50

Utilizar o painel History (Histórico)
O painel History (Histórico) controla cada etapa do seu trabalho no Dreamweaver. Utilize 
este painel para desfazer diversas etapas simultaneamente.

Se desejar desfazer a última operação realizada em um documento, selecione Edit (Editar) > 
Undo (Desfazer), como em qualquer outro aplicativo. O nome do comando Undo (Desfazer) 
no menu Edit (Editar) será alterado, refletindo a última operação efetuada.

O painel History também permite executar novamente etapas já realizadas e automatizar 
tarefas, através da criação de novos comandos. Para obter mais informações, consulte 
“Automatizar tarefas” na página 391.

Para abrir o painel History:

■ Selecione Window> History.

Para desfazer a última etapa:

■ Arraste o controle deslizante do painel History para a etapa anterior na lista. Esta ação 
provoca o mesmo efeito que a seleção de Edit (Editar)  > Undo (Desfazer).
A etapa desfeita aparecerá acinzentada.

Para desfazer várias etapas simultaneamente, siga um dos procedimentos 
abaixo:

■ Arraste o controle deslizante até que indique uma etapa.
■ Clique à esquerda de uma etapa,ao longo do caminho do controle deslizante para rolar 

automaticamente até a etapa, desfazendo as etapas durante a rolagem.

N
O

T
A

Para rolar automaticamente até uma determinada etapa, clique à esquerda da 
mesma. Clique em uma etapa para selecioná-la. A ação de selecionar uma etapa é 
diferente de retornar a essa etapa no histórico de cancelamento.
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Da mesma maneira que uma única etapa não pode ser refeita, se várias etapas forem desfeitas, 
não será mais possível refazê-las depois de efetuar uma nova ação no documento, pois elas 
desaparecerão do painel History.

Para definir o número de etapas que o painel History manterá e mostrará:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

2. Selecione General (Geral) na lista de categorias, à esquerda.

3. Digite o Maximum Number of History Steps (Número máximo de etapas do painel 
History [Histórico]).

O valor padrão deve ser suficiente para a maioria dos usuários. Quanto mais alto for o 
número, maiores serão os requisitos de memória do painel History (Histórico). Isso 
poderá afetar o desempenho e diminuir significativamente a velocidade do computador. 
Quando o painel History (Histórico) atingir o número máximo de etapas, as primeiras 
etapas serão descartadas.

Para apagar a lista de histórico do documento atual:

■ No menu contextual do painel History (Histórico), selecione Clear History (Limpar 
histórico).
Este comando também limpará todas as informações relacionadas ao cancelamento de 
ações para o documento atual. Após selecionar Clear History, não será mais possível 
desfazer as etapas que tiverem sido limpas. Observe que o comando Clear History não 
refaz as etapas, ele simplesmente remove o registro das etapas da memória do 
Dreamweaver.

Tópicos relacionados
■ “Sobre o painel History (Histórico)” na página 377

Automatizar tarefas
Ao criar documentos, é provável que você executa uma mesma tarefa várias vezes. 

Para repetir uma série de etapas uma ou duas vezes, deve-se executá-las diretamente no painel 
History (Histórico), que registra as etapas executadas pelo usuário enquanto ele trabalha em 
um documento. Para informações básicas sobre o painel History (Histórico), consulte “Sobre 
o painel History (Histórico)” na página 377. Para automatizar uma tarefa realizada com 
freqüência, deve-se criar um novo comando que execute essa tarefa automaticamente.

N
O

T
A

Não é possível reordenar as etapas no painel History. Não se deve imaginar o painel 
History como uma coleção arbitrária de comandos. Considere-o como uma maneira 
de visualizar as etapas já realizadas, na ordem em que foram executadas.
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Alguns movimentos do mouse, como o ato de clicar ou arrastar para selecionar um elemento 
na janela do documento, não poderão ser executados ou salvos como parte de comandos 
salvos. Ao realizar um destes movimentos, uma linha preta é exibida no painel History 
(Histórico) (embora a linha não estará óbvia enquanto uma outra ação não for efetuada). Para 
evitar movimentos que não podem ser executados novamente, utilize as teclas de seta em vez 
do mouse para mover o ponto de inserção na janela do documento. Para efetuar ou estender 
uma seleção, mantenha pressionada a tecla Shift ao pressionar uma tecla de seta.

Algumas outras etapas específicas também não podem ser repetidas, como arrastar um 
elemento de página para outro local na página. Ao efetuar uma destas etapas, um ícone de 
comando de menu com um pequeno X vermelho é exibido no painel History (Histórico).

Tópicos relacionados
■ “Aplicar etapas a um outro objeto” na página 394
■ “Aplicar etapas a vários objetos” na página 394
■ “Copiar e colar etapas entre documentos” na página 395
■ “Criar novos comandos a partir de etapas do histórico” na página 396
■ “Gravar comandos” na página 397

Repetir etapas
É possível utilizar o painel History para repetir a última etapa realizada, repetir uma série de 
etapas adjacentes ou uma série de etapas não-adjacentes. Para informações básicas sobre o 
painel History (Histórico), consulte “Sobre o painel History (Histórico)” na página 377.

Para repetir uma única etapa, siga um dos procedimentos abaixo:

■ Selecione Edit (Editar) > Redo (Refazer).
O nome desse comando do menu Edit (Editar) é alterado para refletir a última etapa 
realizada. Por exemplo, se a última etapa tiver sido a digitação de um texto, o nome do 
comando será Redo Typing (Refazer digitação). 

■ No painel History (Histórico), selecione a etapa e clique no botão Replay (Executar 
novamente). 
A etapa será executada novamente e uma cópia dessa etapa será exibida no painel History 
(Histórico). 

D
IC

A

Se uma linha preta de indicação do movimento do mouse aparecer enquanto você 
estiver executando uma tarefa que deseja repetir mais tarde, é possível desfazer até 
antes desta etapa e tentar novamente, talvez utilizando as teclas de seta. 
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Para repetir uma série de etapas adjacentes:

1. Selecione as etapas no painel History (Histórico), seguindo um dos procedimentos abaixo:

■ Arraste de uma etapa para outra (não arraste o controle deslizante; arraste apenas do 
identificador de texto de uma etapa até o identificador de texto de uma outra etapa).

■ Selecione a primeira etapa e, em seguida, mantenha a tecla Shift pressionada e clique 
na última etapa ou selecione a última etapa e mantenha a tecla Shift pressionada e 
clique na primeira etapa.

As etapas executadas são as etapas que estão selecionadas (realçadas), e não 
necessariamente a etapa que o botão deslizante aponta no momento.

2. Clique em Replay (Executar novamente).

As etapas serão executadas novamente em ordem, e uma nova etapa, denominada Replay 
Steps (Executar etapas novamente), será exibida no painel History (Histórico).

Para repetir etapas não-adjacentes:

1. Selecione uma etapa, mantenha a tecla Control (Windows) ou Command (Macintosh) 
pressionada e clique nas outras etapas.

Também é possível manter a tecla Control (no Windows) ou Command (no Macintosh) 
pressionada e clicar para desmarcar uma etapa selecionada.

2. Clique em Replay (Executar novamente).

As etapas selecionadas serão executadas novamente na ordem e uma nova etapa, 
denominada Replay Steps (Executar etapas novamente), será exibida no painel History 
(Histórico).

Tópicos relacionados
■ “Aplicar etapas a vários objetos” na página 394

N
O

T
A

Embora seja possível selecionar uma série de etapas que inclui uma linha preta de 
indicação do movimento do mouse, esse movimento do mouse é ignorado quando 
as etapas são executadas novamente.
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Aplicar etapas a um outro objeto
É possível aplicar um conjunto de etapas do painel History a qualquer objeto na janela 
do documento.

Para aplicar as etapas do painel History a um novo objeto:

1. Selecione o objeto.

2. Selecione as etapas relevantes no painel History e, em seguida, clique em Replay (Executar 
novamente).

Aplicar etapas a vários objetos
Se vários objetos forem selecionados em um documento e, em seguida, forem aplicadas etapas 
a eles a partir do painel History, os objetos serão tratados como uma única seleção e o 
Dreamweaver tentará aplicar as etapas em todos eles. 

Por exemplo, é impossível selecionar cinco imagens e aplicar a mesma alteração de tamanho a 
cada uma delas ao mesmo tempo. Uma alteração de tamanho é uma operação que deve ser 
aplicada a cada imagem individualmente e não a um conjunto de imagens.

Para aplicar uma série de etapas a cada objeto existente em um conjunto de objetos, é 
necessário que a última etapa da série selecione o próximo objeto do conjunto. O 
procedimento a seguir demonstra este princípio em uma determinada situação: definição do 
espaçamento vertical e horizontal de uma série de imagens.

Para definir o espaçamento vertical e horizontal de uma série de imagens:

1. Inicie com um documento no qual cada linha consiste em uma pequena imagem (como 
um marcador gráfico ou um ícone) seguida de texto. O objetivo é manter as imagens 
afastadas do texto e de outras imagens acima e abaixo delas. 

2. Abra o Property inspector, em Window (Janela) > Properties (Propriedades), caso não 
esteja aberto.

3. Selecione a primeira imagem.

4. No Inspetor de propriedades, digite números nas caixas de texto V Space (Espaço V) e H 
Space (Espaço H) para definir o espaçamento entre as imagens.

5. Clique na imagem novamente para tornar a janela do documento ativa sem mover o ponto 
de inserção.
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6. Pressione a tecla de seta à esquerda para mover o ponto de inserção para a esquerda da 
imagem. Em seguida, pressione a tecla de seta para baixo a fim de mover o ponto de 
inserção uma linha abaixo, deixando-o à esquerda da segunda imagem da série. Pressione 
as teclas Shift+seta para a direita para selecionar a segunda imagem.

7. Selecione as etapas do painel History (Histórico) que correspondem à alteração do 
espaçamento da imagem e à seleção da próxima imagem. Clique no botão Replay para 
repetir essas etapas.

O espaçamento da imagem atual é alterado, e a próxima imagem é selecionada.

8. Continue clicando em Replay (Executar novamente) até que todas as imagens sejam 
espaçadas da forma correta.

Para aplicar etapas a um objeto de um outro documento, utilize o botão Copy Steps (Copiar 
etapas). 

Copiar e colar etapas entre documentos
Cada documento aberto tem seu próprio histórico de etapas. É possível copiar as etapas de um 
documento e colá-las em outro.

O fechamento de um documento limpará o seu histórico. Se tiver certeza de que desejará 
utilizar etapas de um documento após tê-lo fechado, copie as etapas usando Copy Steps 
(Copiar etapas), ou salve-as como um comando (consulte “Criar novos comandos a partir de 
etapas do histórico” na página 396) antes de fechar o documento.

N
O

T
A

Não selecionar a imagem clicando nela, pois desse modo não será possível executar 
todas as etapas novamente.
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Para reutilizar as etapas de um documento em outro documento:

1. Comece a tarefa com o documento que contém as etapas a serem reutilizadas.

2. Selecione as etapas no painel History (Histórico).

3. No painel History, clique no botão Copy Steps (Copiar etapas) para copiar essas etapas.

As etapas que incluem um comando Copy (Copiar) ou Paste (Colar) devem ser copiadas 
com cuidado:
■ Não utilizar Copy (Copiar) as etapas se uma das etapas for um comando Copy, pois 

talvez não seja possível colar estas etapas da maneira desejada.
■ Se as etapas incluírem um comando Paste (Colar), será impossível colá-las, a não ser 

que também incluam um comando Copy (Copiar) antes do comando Paste.
4. Abra o outro documento.

5. Coloque o ponto de inserção no local desejado ou selecione um objeto ao qual deseja aplicar 
as etapas.

6. Selecione Edit (Editar) > Paste (Colar) para colar as etapas.

As etapas serão executadas novamente à medida que forem coladas no painel History do 
documento. O painel History mostra as etapas como uma única etapa, denominada Paste 
Steps (Colar etapas).
Se as etapas forem coladas em um editor de texto, na visualização do código ou no 
Inspetor de código, elas serão exibidas como código JavaScript. Este procedimento poderá 
ser útil para aprender como gravar os seus próprios scripts. Para obter mais informações 
sobre como utilizar o JavaScript no Dreamweaver, consulte “Escrever e editar o código” na 
página 613.

Criar novos comandos a partir de etapas do histórico
É possível salvar um conjunto de etapas do histórico como um comando com nome, que se 
tornará disponível no menu Commands (Comandos).

Crie e salve um novo comando caso planeje usar novamente determinado conjunto de etapas 
no futuro, principalmente se quiser usá-las sempre que iniciar o Dreamweaver. Os comandos 
salvos são mantidos permanentemente (a menos que você os exclua), ao passo que os 
comandos gravados são perdidos quando você sai do Dreamweaver. As seqüências copiadas de 
etapas são perdidas quando outro elemento é copiado.

N
O

T
A

O comando Copy Steps (um botão exibido no painel History) é diferente da opção 
Copy do menu Edit. Não é possível utilizar Edit (Editar) > Copy (Copiar) para copiar 
etapas, embora elas sejam coladas com o comando Edit (Editar) > Paste (Colar).
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É possível editar ou excluir os nomes de comandos inseridos no menu Commands 
(Comandos). É mais complicado editar e excluir os comandos incluídos no menu Commands 
(Comandos), ou seja, os comandos que não foram adicionados voluntariamente.

Para criar um comando:

1. Selecione uma etapa ou conjunto de etapas no painel History (Histórico).

2. Clique no botão Save As Command (Salvar como comando) ou selecione Save As 
Command (Salvar como comando) no menu contextual do painel History (Histórico).

3. Digite um nome para o comando e clique em OK.

O comando é exibido no menu Commands (Comandos).

Para utilizar um comando salvo:

1. Selecione um objeto ao qual se deseja aplicar o comando ou coloque o ponto de inserção 
no local desejado.

2. Selecione o comando no menu Commands (Comandos).

Para editar os nomes de comandos no menu Commands:

1. Selecione Commands > Edit Command List.

2. Selecione o comando a ser renomeado e digite um novo nome para ele.

3. Clique em Close (Fechar).

Para excluir um nome do menu Commands:

1. Selecione Commands > Edit Command List.

2. Selecione um comando.

3. Clique em Delete (Excluir) e em Close (Fechar).

Gravar comandos
É possível gravar um comando temporário para uso por um período curto. O Dreamweaver 
retém apenas um único comando gravado de cada vez; assim que começa a gravação de um 
novo comando, o comando antigo é perdido.

N
O

T
A

O comando é salvo como um arquivo JavaScript (ou, às vezes, como um arquivo 
HTML) na pasta /Configuration/Commands (/Configuração/Comandos) do 
Dreamweaver. Se estiver usando o Dreamweaver em um sistema operacional 
multiusuário, o arquivo será salvo na pasta de comandos do usuário específico.
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Para salvar um novo comando sem perder um comando já gravado, salve o comando no painel 
History. Para obter mais informações ao usar comandos gravados para executar etapas 
anteriores a partir do painel History, consulte “Utilizar o painel History (Histórico)” na 
página 390 .

Para gravar temporariamente uma série de etapas utilizadas com freqüência:

1. Selecione Commands (Comandos)  > Start Recording (Iniciar gravação), ou pressione 
Control+Shift+X (no Windows) ou Command+Shift+X (no Macintosh).

O ponteiro se altera, indicando que um comando está sendo gravado.
2. Ao terminar a gravação, selecione Commands (Comandos)  >Stop Recording (Parar 

gravação), ou pressione Control+Shift+X (no Windows) ou Command+Shift+X (no 
Macintosh).

Para reexecutar um comando gravado:

■ Selecione Commands (Comandos) > Play Recorded Command (Executar comando 
gravado), ou pressione Control+Shift+R (no Windows) ou Command+Shift+R (no 
Macintosh).

Para salvar um comando gravado:

1. Selecione Commands (Comandos) > Play Recorded Command (Executar comando 
gravado) para executar o comando novamente.

Uma etapa denominada Run Command (Executar comando) é exibida na lista de etapas 
do painel History (Histórico).

2. Selecione a etapa Run Command (Executar comando) e clique no botão Save As 
Command (Salvar como comando).

3. Digite um nome para o comando e clique em OK.

O comando é exibido no menu Commands (Comandos).

Utilizar comportamentos JavaScript para 
detectar navegadores e plug-ins
Os comportamentos podem ser utilizados para determinar qual navegador os visitantes do site 
estão utilizando e se possuem um plug-in instalado. Para obter mais informações sobre os 
comportamentos, consulte Capítulo 18, “Utilizar comportamentos JavaScript”, na 
página 541.
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Check Browser (Verificar navegador): envia os visitantes a outras páginas, dependendo do 
tipo e versão do navegador (consulte “Check Browser (Verificar o navegador)” na página 551). 
Por exemplo, você pode querer enviar os usuários para uma página se eles estiverem usando a 
versão 4.0 ou mais avançada do Netscape Navigator, para outra página se usarem a versão 4.0 
ou mais avançada do Microsoft Internet Explorer, ou mantê-los na mesma página caso estejam 
usando outro navegador.

Check Plug-in  envia os visitantes a páginas diferentes, dependendo se o plug-in especificado 
estiver ou não instalado (consulte “Check Plugin (Verificar o plug-in)” na página 552). Por 
exemplo, é possível enviar os usuários que tenham o Macromedia Shockwave instalado para 
uma página, e os que não o tenham para outra página. 

Visualizar e testar páginas em 
navegadores
É possível visualizar documentos em um navegador a qualquer momento. Não é necessário 
salvar o documento primeiro, nem fazer upload para um servidor da Web 

Esta seção contém os tópicos a seguir:

■ “Visualizar em um navegador” na página 399
■ “Definir preferências de visualização” na página 400
■ “Visualizar conteúdo ativo no Internet Explorer (Windows)” na página 401

Visualizar em um navegador
Você pode utilizar o Dreamweaver para visualizar e testar o seu documento em um navegador.

Para visualizar e testar o seu documento em um navegador:

1. Siga um dos procedimentos abaixo para visualizar a página:

■ Selecione File (Arquivo) > Preview in Browser (Visualizar no navegador) e, em seguida, 
selecione um dos navegadores listados.

■ Pressione as teclas F12 (no Windows) ou Option+F12 (no Macintosh) para exibir o 
documento atual no navegador primário.

N
O
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Se você ainda não tiver selecionado um navegador, selecione Edit > Preferences 
(no Windows) ou Dreamweaver > Preferences (no Macintosh) e, em seguida, 
selecione a categoria Preview in Browser (Visualizar no navegador) à esquerda 
para selecionar um navegador.
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■ Pressione as teclas Control+F12 (no Windows), ou Command+F12 (no Macintosh), 
para exibir o documento no navegador secundário.

2. Clique em links e teste o conteúdo da sua página.

Na maioria dos casos, todas as funções relacionadas aos navegadores devem funcionar, 
inclusive os comportamentos JavaScript, links relativos a documentos e absolutos, 
controles ActiveX e plug-ins do Netscape Navigator, contanto que os plug-ins ou controles 
ActiveX necessários estejam instalados. 
Se você usa o Internet Explorer em um computador que tem instalado o Windows XP 
com Pacote de Serviço 2, é possível que o navegador exiba uma mensagem indicando que 
ele proibiu o arquivo de mostrar conteúdo ativo. Você pode resolver o problema incluindo 
o código Mark of the Web no arquivo. Para obter mais informações, consulte “Visualizar 
conteúdo ativo no Internet Explorer (Windows)” na página 401.

3. Feche a página no navegador após concluir o teste.

Definir preferências de visualização
Você pode definir até 20 navegadores para a visualização. Os seguintes navegadores são 
recomendados para visualização: Internet Explorer 6.0, Netscape Navigator 7.0 e Safari 
(apenas Macintosh). Além desses navegadores gráficos mais populares, é possível testar suas 
páginas  utilizando um navegador somente de texto como o Lynx.

Para configurar ou alterar as preferências dos navegadores primário e 
secundário:

1. Siga um dos procedimentos abaixo para abrir as opções Preview in Browser (Visualizar no 
navegador):

■ Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh) e 
selecione Preview in Browser (Visualizar no navegador) na lista de categorias à 
esquerda.

N
O
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O conteúdo vinculado a um caminho relativo à raiz não aparece quando os 
documentos são visualizados em um navegador local, a menos que você especifique 
um servidor de teste ou selecione a opção Preview Using Temporary File (Visualizar 
utilizando arquivo temporário) em Edit (Editar)> Preferences (Preferências)> Preview 
in Browser (Visualizador no navegador). Isso se deve ao fato de que os navegadores 
não reconhecem a raiz do site, como os servidores reconhecem.
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Para visualizar o conteúdo vinculado a caminhos relativos à raiz, coloque o arquivo 
em um servidor remoto e, em seguida, selecione File (Arquivo) > Preview in Browser 
(Visualizar no navegador) para visualizá-lo (consulte “Caminhos relativos à raiz do 
site” na página 464).
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■ Selecione File (Arquivo) > Preview in Browser (Visualizar no navegador) > Edit 
Browser List (Editar lista de navegadores).

A caixa de diálogo Preferences (Preferências) é exibida as opções de visualização no 
navegador.

2. Faça as alterações necessárias.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

Visualizar conteúdo ativo no Internet Explorer 
(Windows)
Se você visualizar um documento que tem conteúdo ativo no Internet Explorer após a 
instalação da atualização do Pacote de Serviço 2 do Windows XP, é possível que o navegador 
não exiba o documento corretamente. O navegador exibirá uma mensagem indicando que ele 
proibiu o arquivo de mostrar conteúdo ativo. Você pode resolver o problema inserindo o 
código Mark of the Web no documento. 
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O Internet Explorer bloqueia o conteúdo ativo e os scripts que tentam ser executados na zona 
Máquina Local. Como os invasores tentam tirar proveito da zona Máquina Local, a Microsoft 
aumentou as restrições aos programas que, por padrão, podem ser executados nesta zona. O 
código Mark of the Web instrui o navegador a executar o conteúdo ativo em uma outra zona, 
neste caso, a zona Internet.

Para visualizar conteúdo ativo no Internet Explorer, no Windows XP SP2:

■ Com o documento aberto no Dreamweaver, selecione Commands (Comandos) > Insert 
Mark of the Web (Inserir Mark of the Web).
O Dreamweaver inserirá a seguinte linha no código: 
<!-- saved from url=(0014)about:internet -->

Essa linha instrui o navegador a ignorar a zona Máquina Local e executar o conteúdo ativo 
na zona Internet.

Você também pode remover o código Mark of the Web antes de enviar arquivos. 

Para remover o código Mark of the Web:

1. No Dreamweaver, abra o documento que contém o código Mark of the Web.

2. Selecione Commands > Remove Mark of the Web (Remover Mark of the Web).

Para obter mais informações, consulte a seção TechNote 19578 no site da Macromedia, em 
www.macromedia.com/go/19578.

Definir preferências de tamanho e tempo 
de download
O Dreamweaver calcula o tamanho com base no conteúdo total da página, incluindo todos os 
objetos vinculados, como imagens e plug-ins. O Dreamweaver estima o tempo de download 
com base na velocidade de conexão inserida nas preferências de Status Bar (Barra de status). O 
tempo do download é variável e depende das condições gerais da Internet.

Para definir as preferências de tempo e tamanho do download:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.
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Uma boa diretriz a ser seguida na verificação dos períodos de download de uma 
determinada página da Web é a regra de oito segundos. Ou seja, a maioria dos usuários 
não esperará mais do que oito segundos para que a página seja carregada 
completamente.
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2. Selecione Status Bar (Barra de status) na lista Category (Categoria) à esquerda.

As opções de preferências para Status Bar (Barra de status) são exibidas.

3. Selecione uma velocidade de conexão com a qual deseja calcular o tempo de download.

A velocidade média de conexão nos EUA é 28,8 kbps. Se o seu projeto destinar-se a uma 
intranet, é possível que você queira selecionar 1.500 (velocidade T1).
Para obter mais informações sobre as preferências da barra de status, consulte “Definir as 
preferências da barra de status” na página 59.

4. Clique em OK.
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13

CAPÍTULO 13

Inserir e formatar texto
O Macromedia Dreamweaver 8 oferece várias maneiras de adicionar e formatar texto em um 
documento. Você pode inserir texto, definir atributos de tipo de fonte, tamanho, cor e 
alinhamento, assim como criar e aplicar seus estilos personalizados usando Cascading Style 
Sheets (Folhas de estilo em cascata) (CSS).

Este capítulo aborda os tópicos a seguir:
Formatar texto no Dreamweaver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 405

Inserir texto  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 418

Formatar parágrafos e estruturas de documento . . . . . . . . . . . . . . . . . . . . . . . . . . . .422

Formatação do texto . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .427

Utilizar a opção Cascading Style Sheets (Folha de estilo em cascata) 
para formatar texto. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .433

Verificar a ortografia  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 443

Procurar e substituir texto. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 444

Formatar texto no Dreamweaver
O Dreamweaver oferece várias ferramentas e comandos que permitem formatar texto usando 
CSS ou HTML.

Esta seção contém os seguintes tópicos:

■ “Inserir texto” na página 406
■ “Formatar texto” na página 406
■ “CSS (Cascading Style Sheets)” na página 408
■ “Regras CSS conflitantes” na página 410
■ “Propriedades abreviadas de CSS” na página 410
■ “O Property inspector (Inspetor de propriedades) e a formatação de texto” na página 412
■ “Utilizar o painel CSS Styles” na página 414
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Inserir texto 
O Dreamweaver permite que você inclua texto em páginas da Web digitando texto 
diretamente na página, copiando e colando texto de outro documento ou mesmo arrastando 
texto de outro aplicativo. Entre os tipos de documento mais comuns que os profissionais da 
Web recebem com conteúdo que deve ser incorporado a páginas da web, incluem-se arquivos 
de texto ASCII, arquivos em formato rich text e documento do Microsoft Office. O 
Dreamweaver permite que você incorpore qualquer um desses tipos de documento a uma 
página da Web.

Tópicos relacionados
■ “Inserir texto” na página 418
■ “Adicionar texto a um documento” na página 418
■ “Importar documentos de dados tabulares” na página 419
■ “Importar documentos do Microsoft Office (apenas noWindows)” na página 420

Formatar texto
A formatação no Dreamweaver é semelhante à utilização de um processador de texto padrão. 
Você pode definir os estilos de formatação padrão (Parágrafo, Título 1, Título 2 e assim por 
diante) para um bloco de texto, alterar a fonte, o tamanho, a cor e o alinhamento do texto 
selecionado ou ainda aplicar estilos de texto, como, por exemplo, negrito, itálico, código 
(monoespaçado) e sublinhado.

Por padrão, o Dreamweaver formata texto usando CSS (Cascading Style Sheets). Os CSS dão 
aos designers da Web e aos desenvolvedores maior controle sobre o design de páginas da Web, 
oferecendo ao mesmo tempo recursos avançados de acessibilidade, além de arquivos menores. 
Quando você formata e alinha texto usando comandos do Dreamweaver, as regras CSS são 
incorporadas ao documento atual. Isso permite reutilizar os estilos existentes com maior 
facilidade, bem como nomear os estilos que você criar. As CSS estão se transformando no 
método preferido de formatar texto e criar páginas da Web.

Se preferir, você pode usar tags de HTML para formatar e alinhar texto em suas páginas da 
Web. Caso precise usar tags HTML em vez de CSS, você deverá alterar as preferências padrão 
de formatação de texto do Dreamweaver. Para obter mais informações, consulte “Especificar 
HTML em vez de CSS” na página 381.
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Usar CSS é uma maneira de controlar o estilo de uma página da Web sem comprometer sua 
estrutura.  Ao separar os elementos visuais do design (fontes, cores, margens, etc.) da lógica 
estrutural da página da Web, o CSS oferece aos Web designers controle visual e tipográfico, 
sem sacrificar a integridade do conteúdo. Além disso, definir design tipográfico e layout de 
página a partir de um determinado bloco de código — sem a necessidade de recorrer a image 
maps, fontes tags, tabelas e GIFs de espacejamento — permite downloads mais rápidos, 
manutenção de sites mais racional e um ponto central de controle dos atributos de design em 
diversas páginas da Web. 

O CSS define a formatação para o texto inteiro em uma determinada classe ou redefine a 
formatação para uma tag HTML específica (como h1, h2, p ou li).

Os estilos criados com CSS podem ser armazenados diretamente no documento (padrão 
quando você formata texto utilizando o Property inspector [Inspetor de propriedades]) ou, 
para se obter mais capacidade e flexibilidade, em uma folha de estilos externa.. Se uma folha 
de estilos externa for anexada a várias páginas da Web, todas as páginas refletirão 
automaticamente quaisquer alterações feitas na folha de estilos. Para acessar todas as regras 
CSS de uma página, utilize o painel CSS Styles (Estilos CSS) (Window [Janela]> CSS Styles).

Para obter mais informações sobre como usar o Property inspector de texto para aplicar 
HTML ou CSS, consulte Definir opções de propriedades de texto. Para obter mais 
informações sobre como usar o painel CSS para aplicar CSS, consulte Utilizar o painel CSS 
Styles (Estilos CSS).

Tópicos relacionados
■ “Inserir texto” na página 418
■ “Formatação do texto” na página 427

N
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É possível combinar CSS e formatação HTML 3.2 na mesma página. A formatação é 
aplicada de maneira hierárquica: A formatação em HTML 3.2 é sobreposta à 
formatação aplicada por outras folhas de estilos CSS, e o CSS incorporado a um 
documento é sobreposto a um CSS externo. Para obter mais informações, consulte 
“Utilizar a opção Cascading Style Sheets (Folha de estilo em cascata) para formatar 
texto” na página 433.
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CSS (Cascading Style Sheets)
Os estilos CSS (folhas de estilo em cascata) são um conjunto de regras de formatação que 
controlam a aparência do conteúdo em uma página da Web. Ao utilizar CSS para formatar 
uma página, você separa da apresentação o conteúdo. O conteúdo da página — o código 
HTML — reside no próprio arquivo HTML, embora as regras CSS que definam a 
apresentação do código residam em um outro arquivo (uma folha de estilo externa) ou em 
uma outra parte do documento HTML (geralmente, na seção head). Com CSS, você tem 
grande flexibilidade e controle sobre a aparência da página, desde o posicionamento preciso do 
layout até fontes e estilos específicos.

Com CSS, você pode controlar várias propriedades que o HTML sozinho não pode controlar. 
Por exemplo: é possível especificar diferentes tamanhos de fontes e unidades (pixels, pontos, 
etc.) para o texto selecionado. Também é possível garantir um tratamento mais consistente do 
layout e da aparência da página em vários navegadores, utilizando CSS para definir tamanhos 
de fontes em pixels.

Além da formatação do texto, é possível utilizar CSS para controlar o formato e o 
posicionamento de elementos em nível de bloco em uma página da Web. É possível definir, 
por exemplo, margens e bordas para elementos em nível de bloco, texto flutuante em torno de 
outro texto, e assim por diante.

Uma regra de formatação CSS consiste em duas partes: o seletor e a declaração. O seletor é um 
termo (como P, H1,  um nome de classe ou uma id) que identifica o elemento formatado, e a 
declaração define os elementos de estilo. No exemplo a seguir, H1 é o seletor, e tudo que está 
entre chaves ({}) é a declaração:
H1 { 

font-size: 16 pixels;
font-family: Helvetica;
font-weight:bold;

}

A declaração consiste em duas partes: a propriedade (como font-family) e o valor (como 
Helvetica). Na regra CSS anterior, foi criado um estilo específico particular para tags H1: o 
texto de todas as tags H1 vinculadas a esse estilo terá 16 pixels, fonte Helvetica e negrito.

O termo em cascata refere-se à capacidade de aplicar vários estilos ao mesmo elemento. Por 
exemplo: é possível criar uma regra CSS para aplicar cor e outra para aplicar margens, e aplicá-
las ao mesmo texto em uma página. Os estilos definidos formam uma “cascata” decrescente 
com os elementos da página Web, criando, finalmente, o desenho desejado.

Uma grande vantagem do CSS é que ele oferece a capacidade de fácil atualização. Quando 
uma regra CSS é atualizada em um local, a formatação de todos os documentos que utilizam o 
estilo definido é atualizada automaticamente para o novo estilo.
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Você pode definir os seguintes tipos de estilos no Dreamweaver:

■ Regras CSS personalizadas, também chamadas estilos de classe, permitem aplicar atributos 
de estilo a qualquer faixa ou bloco de texto. Consulte “Aplicar um estilo de classe” na 
página 437.

■ Os estilos de tags HTML redefinem a formatação de uma tag específica, como  h1. 
Quando for criado ou alterado um estilo CSS para a tag h1, todos os textos formatados 
com a tag h1 serão imediatamente atualizados.

■ Os estilos do seletor CSS (estilos avançados) redefinem a formatação de uma determinada 
combinação de elementos ou de outras formas de seletor permitidas pelo CSS (por 
exemplo, o seletor td h2 é aplicado sempre que aparece um cabeçalho h2 dentro de uma 
célula da tabela.) Os estilos avançados também podem redefinir a formatação de tags que 
contêm um atributo id específico (por exemplo, os estilos definidos por #myStyle se 
aplicam a todas as tags que contêm o par de valor do atributo id="myStyle").

As regras CSS podem residir nos seguintes locais:

Folhas de estilo CSS externas são coleções de regras CSS armazenados em um arquivo CSS 
externo separado, com a extensão .css (e não um arquivo de HTML).  Este arquivo é 
vinculado a uma ou mais páginas em um site da Web através de um link na seção head do 
documento. 

Folhas de estilo CSS internas (ou incorporadas) são coleções de regras CSS incluídas em 
uma tag style na seção head de um documento HTML.

Estilos em linha são definidos dentro de instâncias específicas de tag por todo o documento 
HTML.

O Dreamweaver reconhece os estilos definidos em documentos existentes, contanto que eles 
estejam em conformidade com as instruções CSS.

A formatação HTML manual pode anular a formatação aplicada com CSS. Para que as regras 
CSS controlem a formatação de um parágrafo, remova toda a formatação HTML manual.

O Dreamweaver processa a maioria dos atributos de estilos aplicados diretamente na janela do 
documento. Também é possível visualizar o documento em uma janela do navegador para ver 
os estilos aplicados. Alguns atributos de estilo CSS têm uma aparência diferente no Microsoft 
Internet Explorer, no Netscape, no Opera e no Apple Safari, sendo que alguns não são 
suportados por nenhum navegador atual.
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Para exibir o guia de referência de CSS da O’Reilly incluído no Dreamweaver, selecione 
Help > Reference e selecione O’Reilly CSS Reference no menu pop-up do painel 
Reference.
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Regras CSS conflitantes
Quando duas ou mais regras CSS forem aplicadas ao mesmo texto, estas poderão se tornar 
conflitantes e produzir resultados inesperados. Os navegadores aplicam regras CSS da seguinte 
maneira:

■ Se duas regras forem aplicadas ao mesmo texto, o navegador exibirá todos os atributos de 
ambas as regras, a menos que os atributos específicos sejam conflitantes. Por exemplo: uma 
regra pode especificar azul para a cor do texto, e outra, definir vermelho.

■ Se os atributos de duas regras aplicadas ao mesmo texto forem conflitantes, o navegador 
exibirá o atributo da regra mais próxima (àquela do texto). Por isso, se uma folha de estilo 
externa e um estilo inline forem aplicados a um determinado elemento de texto, o estilo 
inline prevalecerá.

■ Se houver um conflito direto, os atributos das regras CSS personalizadas (aplicadas com o 
atributo class) anularão aqueles dos estilos de tags HTML.

No exemplo a seguir, o estilo definido para h1 deve especificar a fonte, o tamanho e a cor para 
todos os parágrafos h1, mas a regra CSS personalizada .Blue aplicada a esse parágrafo anula a 
definição de cor no estilo h1. A segunda regra CSS personalizada .Red anula o .Blue porque 
ela está contida no estilo .Blue.
<h1><span class="Blue">This paragraph is controlled by the .Blue custom 

style and h1
HTML tag style.<span class="Red">Except this sentence is controlled by the 

.Red style.</span>
Now we're back to the .Blue style.</span></h1>

Propriedades abreviadas de CSS
A especificação de CSS permite criar estilos utilizando uma sintaxe abreviada conhecida como 
CSS abreviada. A CSS abreviada permite especificar os valores de várias propriedades usando 
uma única tag de propriedade.  Por exemplo, a propriedade font permite configurar as 
propriedades font-style, font-variant, font-weight, font-size, line-height e font-
family dentro de uma única linha de sintaxe.

Uma questão chave a ser observada ao usar CSS abreviada é que valores omitidos em uma 
propriedade CSS abreviada assumem seu valor padrão.  Isso pode fazer com que algumas 
páginas sejam exibidas incorretamente quando duas ou mais regras CSS forem atribuídas à 
mesma tag. 
410 Capítulo 13:  Inserir e formatar texto



         
Por exemplo, o tag  H1 mostrado abaixo utiliza sintaxe CSS longa.  Observe que foram 
atribuídos os valores padrão às propriedades font-variant, font-stretch, font-size-
adjust e font-style .
H1 { 

font-weight: bold; 
font-size: 16pt;
line-height: 18pt; 
font-family: Arial; 
font-variant: normal;
font-style: normal;
font-stretch: normal;
font-size-adjust: none

}

Se fosse reescrita como uma única propriedade abreviada, a mesma tag teria o seguinte 
aspecto:
H1 { font: bold 16pt/18pt Arial }

Quando essa notação abreviada é usada, são usados automaticamente valores padrão para os 
valores omitidos.  Portanto, o exemplo abreviado anterior omite as tags font-variant, font-
stretch, font-size-adjust e font-style.

Caso tenha estilos definidos em mais de um local (por exemplo, incorporados em uma página 
HTML e importados de uma folha de estilo externa) com ambas as formas de sintaxe de CSS, 
abreviada e longa, observe que as propriedades omitidas podem anular (ou se propagar em 
cascata) as propriedades configuradas explicitamente no outro local.

Por isso, o Dreamweaver utiliza como padrão a forma longa de notação de CSS.  Isso evita 
possíveis problemas causados por uma regra abreviada que anule uma regra longa. Se abrir 
uma página da Web que foi codificada com notação abreviada de CSS no Dreamweaver, 
observe que o Dreamweaver criará qualquer nova regra CSS usando a forma longa. Para 
especificar como o Dreamweaver cria e edita regras CSS, altere as preferências de edição CSS 
na categoria CSS Styles da caixa de diálogo Preferences (Edit  > Preferences no Windows ou 
Dreamweaver > Preferences no Macintosh).

Tópicos relacionados
■ “Regras CSS conflitantes” na página 410
■ “Utilizar o painel CSS Styles” na página 414

N
O

T
A

O painel CSS Styles (Estilos CSS) cria regras usando apenas notação longa. Se você 
criar uma página ou folha de estilo CSS usando o painel CSS Styles, observe que a 
codificação manual de regras CSS abreviadas pode fazer com que as propriedades 
abreviadas anulem aquelas criadas na forma longa. Por isso, utilize sempre notação 
longa ao criar seus estilos.
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O Property inspector (Inspetor de propriedades) e a 
formatação de texto
O Property inspector permite que você formate um segmento de texto selecionado. À medida 
que você formata o texto usando o Property inspector, o Dreamweaver registra as propriedades 
de formatação que atribui a cada elemento de texto, atribuindo a cada um uma identificação 
usando a seguinte convenção de nomenclatura: Style1 (Estilo1), Style2 (Estilo2), Style3 
(Estilo3), Stylen (Estilo n). Se você atribuir os mesmos atributos de formatação a dois ou mais 
elementos de texto, Dreamweaver aplica rótulos a esses elementos com o mesmo título, 
eliminando nomes de estilos redundantes. O rótulo aplicado pelo Dreamweaver a um 
determinado corpo de texto pode ser aplicado usando o menu pop-up Style, o que permite 
criar uma biblioteca de estilos dentro de uma página. Dessa forma, pode-se aplicar esses 
mesmos estilos selecionando o elemento de texto na página e selecionando um estilo no menu 
pop-up Styles. É possível renomear estilos com tags mais significativas, como Cabeçalho1, 
Cabeçalho2, Corpo e Tabela.
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O menu pop-up Style (Estilo) exibe tanto  os nomes dos estilos na sua página, como uma 
visualização das propriedades do estilo. As propriedades mostradas na visualização são família 
de fontes, espessura da fonte, peso de fonte, cor de texto e cor de fundo. 

Tópicos relacionados
■ “Formatar parágrafos” na página 423
■ “Definir e alterar fontes e estilos” na página 427
■ “Renomear um estilo” na página 428
■ “Utilizar a opção Cascading Style Sheets (Folha de estilo em cascata) para formatar texto” 

na página 433
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Utilizar o painel CSS Styles
O painel CSS Styles (Estilos CSS) permite acompanhar as regras CSS e propriedades que 
afetam um elemento selecionado da página (modo Current [Atual]) ou as regras e as 
propriedades que afetam um documento inteiro (modo All [Tudo]). Um botão de alternância 
na parte superior do painel CSS Styles permite alternar entre os dois modos. O painel CSS 
Styles também permite modificar as propriedades CSS nos modos All e Current.

Painel CSS Styles no modo Current
No modo Current (Atual), o painel CSS Styles (Estilos CSS) exibe três painéis: o painel 
Summary for Selection (Resumo para seleção) que exibe as propriedades CSS da seleção atual 
no documento, o painel Rules (Regras) que exibe a localização das propriedades selecionadas 
(ou uma cascata de regras para a tag selecionada, dependendo da seleção) e o painel Properties 
(Propriedades) permite editar propriedades CSS para a regra que define a seleção.

É possível redimensionar qualquer um dos painéis arrastando as bordas existentes entre eles.
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O painel Summary for Selection exibe um resumo das propriedades CSS do item atualmente 
selecionado no documento ativo. O resumo mostra as propriedades para todas as regras que se 
aplicam diretamente à seleção. São mostradas apenas as propriedades definidas.

Por exemplo, as regras a seguir criam um estilo de classe e um estilo de tag (nesse caso, 
parágrafo):
.foo{

color: green;
font-family: ‘Arial’;

}

P{
font-family: ‘serif’;
font-size: 12px;

}

Quando você seleciona um texto de parágrafo com estilo de classe .foo na janela do 
documento, o painel Summary for Selection exibe as propriedades relevantes das duas regras 
porque as duas regras se aplicam à seleção. Nesse caso, o painel Summary for Selection listaria 
as seguintes propriedades:
font-size: 12px
font-family: ‘Arial’
color: green

O painel Summary for Selection organiza as propriedades por ordem crescente de 
especificidade. No exemplo acima, o estilo da tag define o tamanho da fonte, e o estilo da 
classe define a família de fontes e a cor. (A família de fontes definida pelo estilo da classe anula 
a família de fontes definida pelo estilo da tag porque os seletores de classe têm especificidade 
superior aos seletores de tags. Para obter mais informações sobre especificidade CSS, consulte 
www.w3.org/TR/CSS2/cascade.html.)

O painel Rules exibe duas visualizações diferentes — visualização About (Sobre) e visualização 
Rules — dependendo da seleção feita. Na visualização About (padrão), o painel exibe o nome 
da regra que define a propriedade CSS selecionada e o nome do arquivo que contém a regra. 
Na visualização Rules, o painel exibe uma cascata, ou hierarquia, de todas as regras que se 
aplicam direta ou indiretamente à seleção atual. (A tag à qual a regra se aplica diretamente 
aparece na coluna da direita.) É possível alternar entre as duas visualizações clicando nos 
botões Show Information (Mostrar informações) e Show Cascade (Mostrar cascata) no canto 
superior direito do painel Rules.
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Quando você seleciona uma propriedade no painel Summary for Selection, todas as 
propriedades da regra de definição aparecem no painel Properties. (A regra de definição 
também será selecionada no painel Rules, se a visualização Rules for selecionada.) Por 
exemplo, se você tiver uma regra denominada .maintext que defina uma família de fontes, 
tamanho e cor da fonte, ao selecionar qualquer uma dessas propriedades no painel Summary 
for Selection, serão exibidas todas as propriedades definidas pela regra .maintext no painel 
Properties, bem como a regra .maintext selecionada no painel Rules. (Além disso, ao 
selecionar qualquer regra no painel Rules, serão exibidas as propriedades dessa regra no painel 
Properties.) É possível utilizar o painel Properties para modificar rapidamente o CSS, esteja ele 
incorporado no documento atual ou vinculado apenas por meio de uma folha de estilo 
anexada. Por padrão, o painel Properties mostra apenas as propriedades que foram 
anteriormente definidas e as organiza por ordem alfabética. 

Você pode optar por exibir o painel Properties em duas outras visualizações. A visualização 
Category (Por categorias) exibe propriedades agrupadas em categorias, como Font (Fonte), 
Background (Fundo), Block (Bloco), Border (Borda), etc., com as propriedades definidas na 
parte superior de cada categoria, exibidas em azul. A visualização List (Por lista) exibe uma 
lista alfabética de todas as propriedades disponíveis e, do mesmo modo, classifica as 
propriedades definidas na parte superior, exibindo-as em azul. Para alternar entre as 
visualizações, clique no botão Show Category View (Mostrar visualização de categoria) ou 
Show List View (Mostrar visualização de lista) ou Show Only Set Properties (Mostrar apenas 
as propriedades definidas), localizado no canto inferior esquerdo do painel Properties.

Em todas as visualizações, as propriedades definidas são exibidas em azul; propriedades 
irrelevantes para uma seleção são exibidas em vermelho e riscadas. Se você passar o cursor 
sobre uma regra irrelevante, será exibida uma mensagem explicando por que a propriedade é 
irrelevante. Normalmente, uma propriedade é irrelevante porque foi sobrescrita ou por não ter 
sido herdada.

Todas as alterações feitas no painel Properties são aplicadas instantaneamente, permitindo que 
você visualize o que está fazendo à medida que trabalha.

Tópicos relacionados
■ “Painel CSS Styles (Estilos CSS) no modo All (Tudo)” na página 417
■ “Utilizar o painel CSS Styles (Estilos CSS)” na página 433
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Painel CSS Styles (Estilos CSS) no modo All (Tudo)
No modo All, o painel CSS Styles exibe dois painéis: o painel All Rules (Todas as regras) (na 
parte superior) e o painel Properties (Propriedades) (na parte inferior). O painel All Rules 
exibe uma lista com as regras definidas no documento atual, bem como todas as regras 
definidas nas folhas de estilos anexadas ao documento atual. O painel Properties permite 
editar propriedades CSS para qualquer regra selecionada no painel All Rules.

É possível redimensionar qualquer um dos painéis arrastando a borda entre os painéis.

Quando você seleciona uma regra no painel All Rules, todas as propriedades definidas nessa 
regra aparecem no painel Properties. É possível utilizar o painel Properties para modificar 
rapidamente o CSS, esteja ele incorporado no documento atual ou vinculado apenas por meio 
de uma folha de estilo anexada. Por padrão, o painel Properties mostra apenas as propriedades 
que foram anteriormente definidas e as organiza por ordem alfabética.

Você pode optar por exibir as propriedades em duas outras visualizações. A visualização 
Category (Por categorias) exibe propriedades agrupadas em categorias, como Font (Fonte), 
Background (Fundo), Block (Bloco), Border (Borda), etc., com as propriedades definidas na 
parte superior de cada categoria. A visualização List (Por lista) exibe uma lista alfabética de 
todas as propriedades disponíveis e, desse modo, classifica as propriedades definidas na parte 
superior. Para alternar entre as visualizações, clique no botão Show Category View (Mostrar 
visualização de categoria) ou Show List View (Mostrar visualização de lista) ou Show Only Set 
Properties (Mostrar apenas as propriedades definidas), localizado no canto inferior esquerdo 
do painel Properties. Em todas as visualizações, as propriedades definidas são exibidas em azul.
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Todas as alterações feitas no painel Properties são aplicadas instantaneamente, permitindo que 
você visualize o que está fazendo à medida que trabalha.

Tópicos relacionados
■ “Painel CSS Styles no modo Current” na página 414
■ “Utilizar o painel CSS Styles (Estilos CSS)” na página 433

Inserir texto 
O Dreamweaver permite que você insira texto facilmente em um documento digitando, 
copiando e colando ou importando. Você também pode inserir espaço extra entre caracteres e 
linhas no texto.

Adicionar texto a um documento
Para adicionar texto a um documento do Dreamweaver, você pode digitar diretamente na 
janela de documento do Dreamweaver ou recortar e colar. Você também pode importar texto 
de outros documentos (consulte  “Importar documentos de dados tabulares” na página 419 e 
“Importar documentos do Microsoft Office (apenas noWindows)” na página 420).

Ao colar texto em um documento do Dreamweaver, você pode usar o comando Paste (Colar) 
ou Paste Special (Colar especial). O comando Paste Special permite especificar o formato do 
texto colado de maneiras diferentes. Por exemplo, se você quisesse colar o texto de um 
documento formatado do Microsoft Word no documento do Dreamweaver, mas quisesse 
remover toda a formatação, a fim de poder aplicar sua própria folha de estilos CSS ao texto 
colado, seria possível selecionar o texto no Word, copiá-lo para a área de transferência e usar o 
comando Paste Special para selecionar a opção que permite colar apenas texto.

Além disso, ao utilizar o comando Paste para colar texto de outros aplicativos , você pode 
definir as preferências de colagem como opções padrão. Para obter mais informações, consulte 
“Definir preferências de cópia/colagem” na página 419.

Para adicionar texto a um documento, siga um dos procedimentos abaixo:

■ Digite o texto diretamente na janela do documento.
■ Copie o texto de outro aplicativo, alterne para o Dreamweaver, posicione o ponto de 

inserção na visualização do projeto da janela do documento e escolha Edit (Editar) > Paste 
(Coalr) ou Edit > Paste Special (Colar especial).
Quando você seleciona Edit > Paste Special, uma caixa de diálogo apresenta várias opções 
de formatação de colagem. Para obter mais informações, clique no botão Help (Ajuda) da 
caixa de diálogo.
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Também é possível colar texto utilizando os seguintes atalhos de teclado:

Definir preferências de cópia/colagem
Você pode definir preferências especiais de colagem como opções padrão ao utilizar Edit 
(Editar) > Paste (Colar) para colar texto de outros aplicativos. Por exemplo, se você deseja 
colar texto apenas como texto ou texto com formatação básica, poderá definir a opção padrão 
na caixa de diálogo Copy/Paste Preferences (Preferências de cópia/colagem).

Para definir as opções padrão para cópia e colagem:

1. Selecione Edit > Preferences (Preferências) (no Windows) ou Dreamweaver Preferences 
(Preferências do Dreamweaver) (no Macintosh).

2. Clique na categoria Copy/Paste (Copiar/colar).

3. Preencha a caixa de diálogo e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda).

Importar documentos de dados tabulares
É possível importar dados tabulares para um documento através do salvamento inicial dos 
arquivos (como arquivos do Microsoft Excel ou de um banco de dados) como arquivos de 
texto delimitados. 

Para mais informações sobre importação e formatação de dados de tabelas, veja “Importar e 
exportar dados tabulares” na página 261. Para mais informações sobre importação de texto de 
documentos em HTML do Microsoft Word, consulte “Abrir documentos existentes” na 
página 107.

Opção de colagem Atalho de teclado

Paste (Colar) Control+V (Windows)
Command+V (Macintosh)

Paste Special (Colar especial) Control+Shift+V (Windows)
Command+Shift+V (Macintosh)

N
O

T
A

Os atalhos Control+V (Windows) e Command+V (Macintosh) sempre colam apenas 
o texto (sem formatação) na visualização de código.

N
O

T
A

As preferências definidas na caixa de diálogo Copy/Paste Preferences se aplicam 
apenas ao material colado na visualização do projeto.
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Você também pode adicionar texto de documentos do Microsoft Excel a um documento do 
Dreamweaver importando o conteúdo de um arquivo do Excel em uma página da Web 
(consulte “Importar documentos do Microsoft Office (apenas noWindows)” na página 420).

Para importar dados tabulares: 

1. Selecione File (Arquivo) > Import (Importar) > Import Tabular Data (Importar dados 
tabulados) ou Insert (Inserir) > Table Objects (Objetos de tabela) > Import Tabular Data 
(Importar dados tabulados).

A caixa de diálogo Import Table (Importar os dados da tabela) é exibida.
2. Procure o arquivo desejado ou digite o seu nome na caixa de texto.

3. Selecione o delimitador utilizado quando o arquivo foi salvo como texto delimitado. As 
opções disponíveis são Tab (Tabulação), Comma (Vírgula), Semicolon (Ponto-e-vírgula), 
Colon (Dois-pontos), e Other (Outro).

Se for selecionado Other (Outro), aparecerá um campo em branco ao lado da opção. 
Digite o caractere que foi utilizado como um delimitador.

4. Utilize as demais opções para formatar ou definir a tabela para a qual os dados 
serão importados.

5. Clique em OK.

Importar documentos do Microsoft Office (apenas 
noWindows)
É possível inserir todo o conteúdo de um documento do Microsoft Word ou do Excel em uma 
página da Web nova ou existente. Quando você importa um documento do Word ou Excel, o 
Dreamweaver recebe o HTML convertido e insere-o na página da Web. O tamanho do 
arquivo, depois de o Dreamweaver receber o HTML convertido, deve ser menor que 300K.

D
IC

A

Em vez de importar todo o conteúdo de um arquivo, você também pode colar partes de 
um documento do Word e preservar a formatação. Para obter mais informações, 
consulte “Adicionar texto a um documento” na página 418.

N
O

T
A

Se você usar o Microsoft Office 97, não será possível importar o conteúdo a um 
documento do Word ou do Excel; você deverá inserir um link para documento. Para 
obter informações, veja “Inserir um link para um documento do Word ou do Excel” na 
página 422.
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Para inserir um documento do Word ou do Excel em uma página da Web nova 
ou preexistente:

1. Abra a página da Web na qual você deseja inserir o documento do Word ou do Excel.

2. Certifique-se de estar no modo de visualização do projeto. Se não estiver, clique no botão 
Design View (Visualização do projeto).

3. Siga um dos procedimentos abaixo, para colocar o arquivo:

■ Arraste o arquivo da sua posição atual para a página onde deseja que o conteúdo 
apareça. Quando a caixa de diálogo Insert Document (Inserir documento) for exibida, 
defina as opções e clique em OK. Para obter mais informações, clique no botão Help 
(Ajuda) da caixa de diálogo.

■ Selecione File (Arquivo) > Import (Importar) > Word Document (Documento do 
Word) ou File (Arquivo) > Import (Importar) > Excel Document (Documento do 
Excel). Na caixa de diálogo Import Document (Importar documento), procure o 
arquivo que você deseja adicionar, selecione as opções de formatação na parte inferior 
da caixa de diálogo e clique em Open (Abrir).
As opções de formatação são:
Text Only (Somente texto) permite inserir texto não formatado. Se o texto original 
estiver formatado, toda a formatação será removida.
Text with Structure (Texto com estrutura) permite inserir texto que retém a 
estrutura, mas não retém a formatação básica. Por exemplo, você pode colar o texto e 
reter a estrutura de parágrafos, listas e tabelas, sem reter negrito, itálico e outras 
formatações.
Text with Structure Plus Basic Formatting (Texto com estrutura mais formatação 

básica) permite inserir texto estruturado e texto com formatação HTML simples (por 
exemplo, parágrafos e tabelas, bem como texto formatado com as tags b, i, u, strong, 
em, hr, abbr ou acronym).
Text with Structure Plus Full Formatting (Texto com estrutura mais formatação 

total) permite inserir texto que retém toda a estrutura, formatação HTML e estilos 
CSS.
Clean Up Word Paragraph Spacing (Limpar espaçamento entre parágrafos) 
permite eliminar o espaço extra entre parágrafos ao colar o texto, se você tiver 
selecionado Text with Structure (Texto com estrutura) ou Basic Formatting 
(Formatação básica).

O conteúdo do documento do Word ou do Excel aparece na sua página.
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Inserir um link para um documento do Word ou do 
Excel
É possível inserir um link para um documento do Microsoft Word ou do Microsoft Excel em 
uma página existente.

Para criar um link para um documento do Word ou do Excel:

1. Abra a página onde você quer que o link apareça.

2. Arraste o arquivo da sua posição atual para a página do Dreamweaver, posicionando o link 
onde você desejar. 

A caixa de diálogo Insert Document (Inserir documento) é exibida.
3. Selecione Create a Link (Criar um link) e, em seguida, clique em OK.

4. Se o documento para o qual você está criando um link se localiza fora do site ou na pasta-
raiz do site, o Dreamweaver solicita que você copie o documento para a raiz do site.

Ao copiar o documento para a pasta-raiz do site, você garante que o documento estará 
disponível quando você publicar o site.

5. Ao fazer o upload da sua página para o servidor da Web, certifique-se de também fazer o 
upload do arquivo Word ou Excel.

Agora sua página contém um link para o documento do Word ou Excel. O texto do link é o 
nome do arquivo vinculado; para alterar o texto do link, consulte “Gerenciar links” na 
página 479.

Formatar parágrafos e estruturas de 
documento
Dreamweaver suporta todos os padrões da Web usados na formatação de páginas e objetos. 
Esta seção descreve como formatar parágrafos e como inserir réguas horizontais e datas.

Tópicos relacionados
■ “Definir propriedades de página” na página 381
■ “Alinhar texto” na página 423
■ “Recuo de texto” na página 424
■ “Adicionar espaços entre parágrafos” na página 424
■ “Utilizar réguas horizontais” na página 425
■ “Inserir datas” na página 431
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Formatar parágrafos
Utilize o menu pop-up Format do Property inspector (Inspetor de propriedades), ou o 
submenu Text (Texto) > Paragraph Format (Formato do parágrafo) para aplicar as tags de 
cabeçalho e parágrafo padrão. 

Para aplicar uma tag de cabeçalho ou parágrafo: 

1. Coloque o ponto de inserção no parágrafo ou selecione uma parte do texto no parágrafo.

2. No submenu Text (Texto) > Paragraph Format (Formato do parágrafo) ou no menu pop-
up Format (Formato) do Property inspector, escolha uma opção:

■ Selecione um formato de parágrafo [por exemplo: Heading 1 (Cabeçalho 1), Heading 
2  (Cabeçalho 2), Preformatted Text (Texto pré-formatado), etc.]. A tag HTML 
associada ao estilo selecionado (por exemplo: h1 para Cabeçalho 1, h2 para Cabeçalho 
2, pre para Texto pré-formatado, etc.) será aplicada ao parágrafo inteiro.

■ Escolha None (Nenhum), para remover um formato de parágrafo.

Quando uma tag de cabeçalho é aplicada a um parágrafo, o Dreamweaver adiciona 
automaticamente a próxima linha de texto como um parágrafo padrão. Para alterar essa 
definição, escolha Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh) 
e, em seguida, na categoria General em Editing Options, certifique-se de que a opção Switch 
to Plain Paragraph after Heading (Alternar para parágrafo simples depois do cabeçalho) esteja 
desmarcada.

Alinhar texto
Para alinhar o texto na página, use o Property inspector ou o submenu Text > Align. É possível 
centralizar qualquer elemento em uma página utilizando o comando Texto > Alinhar > 
Centro.

Para alinhar o texto:

1. Selecione o texto a ser alinhado ou simplesmente insira o indicador no início do texto.

2. Clique em uma opção de alinhamento - Left, Right ou Center (À esquerda, À direita, 
Centro) - no inspetor Properties ou escolha Text  >  Align e selecione um comando de 
alinhamento.

Para centralizar os elementos:

1. Selecione o elemento (imagem, plug-in, tabela ou outro elemento da página) 
a ser centralizado.
Formatar parágrafos e estruturas de documento 423



         
2. Selecione Text (Texto) > Align (Alinhar) > Center (Centro).

Recuo de texto 
O uso do comando Indent (Recuo) aplica a tag de HTML blockquote a um parágrafo de 
texto, recuando o texto nos dois lados da página.

Para recuar o texto e remover o recuo:

1. Coloque o ponto de inserção no parágrafo a ser recuado.

2. Clique no botão Indent (Recuo) ou Outdent (Remover o recuo) no Property inspector 
(Inspetor de propriedades), escolha Text > Indent ou Outdent, ou selecione List > Indent 
ou Outdent no menu contextual.

Adicionar espaços entre parágrafos
O Dreamweaver funciona de forma semelhante a vários aplicativos de processamento de texto: 
o usuário pressiona Enter (no Windows) ou Return (no Macintosh) para criar um novo 
parágrafo. Navegadores da Web inserem automaticamente um espaço de linha em branco 
entre os parágrafos. É possível adicionar um espaço de uma única linha entre parágrafos 
inserindo uma quebra de linha.

Para adicionar um retorno de parágrafo:

■ Pressione a tecla Enter (no Windows) ou Return (no Macintosh). 

Para adicionar uma quebra de linha, siga um dos procedimentos abaixo:

■ Pressione Shift+Enter (no Windows) ou Shift+Return (no Macintosh).
■ Na categoria Text (Texto) da barra Insert (Inserir), selecione Character (Caractere) e clique 

no ícone Line Break (Quebra de linha).
■ Escolha Insert (Inserir) > HTML > Special Characters (Caracteres especiais) > Line Break 

(Quebra de linha).

N
O

T
A

É possível alinhar e centralizar blocos inteiros de texto, mas é impossível alinhar ou 
centralizar parte de um cabeçalho ou de um parágrafo.

N
O

T
A

É possível aplicar vários recuos a um parágrafo. Cada vez que este comando é 
escolhido, o texto recua mais nos dois lados do documento.
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Utilizar réguas horizontais
As réguas horizontais (linhas) são úteis para organizar informações. Em uma página, o texto e 
os objetos podem ser separados visualmente por meio de uma ou mais réguas.

Para criar uma régua horizontal:

1. Na janela do documento, coloque o ponto de inserção onde será inserida uma régua 
horizontal.

2. Siga um dos procedimentos abaixo:

■ Selecione Insert (Inserir) > HTML > Horizontal Rule (Régua horizontal).
■ Na categoria HTML da barra Insert, clique no botão Horizontal Rule. 

Para modificar uma régua horizontal:

1. Na janela do documento, selecione uma régua horizontal.

2. Escolha Window > Properties para abrir o Property inspector e modifique as propriedades 
desejadas. 

W e H especificam a largura e a altura da régua em pixels ou como uma percentagem do 
tamanho da página.
Align (Alinhar) especifica o alinhamento da régua [Default (Padrão), Left (À esquerda), 
Center (Centro), ou Right (À direita)]. Esta definição será aplicada apenas quando a 
largura da régua for menor do que a da janela do navegador.
Shading (Sombreado) especifica se a régua será desenhada com sombreado. Desmarque 
esta opção para desenhar a régua com uma cor sólida.

Criar listas com marcadores e listas numeradas
À medida que digita na janela do documento, podem ser criadas listas numeradas (ordenadas), 
listas com marcadores (não-ordenadas) e listas de definições com base em um texto existente 
ou em um novo texto. 

As listas de definições não utilizam caracteres à esquerda, como marcadores ou números, 
porém estes são utilizados freqüentemente em glossários ou descrições. As listas também 
podem ser aninhadas. Listas aninhadas são listas que contêm outras listas. Por exemplo: o 
usuário poderá querer aninhar uma lista ordenada ou com marcadores em uma outra lista 
numerada ou ordenada.
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Para obter informações sobre a definição de um tipo de lista específico e outras opções de lista 
para uma lista inteira ou um item de lista específico (por exemplo: redefinir a numeração, 
utilizar numerais romanos em uma lista ordenada ou definir marcadores quadrados), veja a 
caixa de diálogo Setting List Properties (Definir propriedades da lista) na Ajuda de Usando o 
Dreamweaver.

Para criar uma nova lista: 

1. No documento do Dreamweaver, coloque o ponto de inserção onde será adicionada uma 
lista e, em seguida, siga um dos procedimentos abaixo:

■ Clique no botão Bulleted (Lista com marcadores) ou Numbered List (Lista numerada) 
no Property inspector (Inspetor de propriedades)

■ Escolha Text (Texto) > List (Lista) e selecione o tipo de lista desejado — Unordered 
(bulleted) List [Lista não-ordenada (com marcadores)], Ordered (numbered) List 
[Lista ordenada (numerada)] ou Definition List (Lista de definições).

O caractere à esquerda do item de lista especificado é exibido na janela do documento.
2. Digite o texto do item de lista e, em seguida, pressione Enter (no Windows) ou Return (no 

Macintosh) para criar um outro item de lista.

3. Para concluir a lista, pressione duas vezes Enter (no Windows) ou Return (no Macintosh).

Para criar uma lista usando texto já existente:

1. Selecione uma série de parágrafos para transformá-los em uma lista.

2. Clique nos botões Bulleted (Lista com marcadores) ou Numbered List (Lista numerada) no 
Property inspector (Inspetor de propriedades) ou escolha Text (Texto) > List (Lista) e 
selecione o tipo de lista desejado: Unordered List (Lista não-ordenada), Ordered List (Lista 
ordenada) ou Definition List (Lista de definições).

Para criar uma lista aninhada:

1. Selecione os itens da lista a serem aninhados.

2. Clique no botão Indent (Recuo) no Property inspector, ou escolha Text (Texto) > Indent 
(Recuo).

O Dreamweaver recuará o texto e criará uma lista separada com os atributos HTML da 
lista original.

3. Aplique um novo estilo ou tipo de lista ao texto recuado seguindo o mesmo procedimento 
utilizado acima.
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Formatação do texto 
Você pode aplicar formatação de texto a um caractere ou a um conjunto de parágrafos e a 
blocos de texto.

Tópicos relacionados
■ “Modificar combinações de fontes” na página 429
■ “Alterar a cor do texto” na página 430
■ “Inserir datas” na página 431
■ “Inserir caracteres especiais” na página 431
■ “Adicionar espaço entre os caracteres” na página 432
■ “Criar uma nova regra CSS” na página 436

Definir e alterar fontes e estilos
Utilize opções do Property inspector ou do menu Text (Texto) para definir ou alterar 
características da fonte de um texto selecionado. É possível definir o tipo de fonte, o estilo 
(como negrito ou itálico) e o tamanho.

Para definir ou alterar as características da fonte:

1. Selecione o texto. Se nenhum texto for selecionado, a alteração será aplicada ao texto 
subseqüente que for digitado.

2. Selecione uma dentre as seguintes opções:

■ Para alterar a fonte, escolha uma combinação de fontes no Property inspector 
(Inspetor de propriedades) ou no submenu Text (Texto)  > Font (Fonte).
Escolha Default (Padrão) para remover as fontes aplicadas anteriormente; Padrão 
aplica a fonte padrão ao texto selecionado (a fonte padrão do navegador ou aquela 
designada para essa tag na folha de estilo CSS).

■ Para alterar o estilo da fonte, clique em Bold (Negrito) ou Italic (Itálico), no Property 
inspector, ou escolha um estilo de fonte (negrito, itálico, sublinhado etc.) no submenu 
Text (Texto) > Style (Estilo).

N
O

T
A

Quando é utilizado o Property inspector para aplicar o estilo negrito ou itálico, o 
Dreamweaver aplica a tag <strong> ou <em>, respectivamente, de modo 
automático. Se estiverem sendo criadas páginas para visitantes que possuem 
navegadores versão 3.0 ou mais antigas, alterar essa preferência na categoria 
General (Geral) da caixa de diálogo Preferences (Preferências) [Edit (Editar) > 
Preferences (Preferências)].
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■ Para alterar o tamanho da fonte, escolha um tamanho (1 a 7) no Property inspector ou 
no submenu Text > Size.
Os tamanhos de fontes HTML são pontos de tamanho relativo e não específico. Os 
usuários definem o tamanho do ponto da fonte padrão para os seus navegadores. O 
tamanho da fonte será visto quando for selecionado Default (Padrão) ou 3, no 
Property inspector ou no submenu Text (Texto) > Size (Tamanho). Os tamanhos 1 e 2 
aparecerão menores do que o tamanho padrão de fonte; os tamanhos 4 a 7 aparecerão 
maiores. Além disso, as fontes costumam parecer maiores no Windows do que no 
Macintosh, apesar de o Internet Explorer 5 no Macintosh utilizar o mesmo tamanho 
de fonte padrão que o Windows.

■ Para aumentar ou diminuir o tamanho do texto selecionado, escolha um tamanho 
relativo (+1 a + 4 ou –1 a –3) no Property inspector ou no submenu Text (Texto) > 
Size Change (Alterar o tamanho).

Renomear um estilo
À medida em que você formata texto, o Dreamweaver acompanha todos os estilos criados por 
você em cada página, e gera uma biblioteca de estilos que pode ser reutilizada. Isso simplifica 
consideravelmente a aplicação de uma mesma formatação a um bloco de texto, assim como 
permite que você crie um layout mais consistente para as suas páginas. 

Para renomear um estilo:

1. Selecione Rename Style (Renomear estilo) no menu pop-up Style do Property inspector de 
texto. 

A caixa de diálogo Rename Style é exibida.
2. Selecione o estilo que você deseja renomear no menu pop-up Rename Style.

D
IC

A

Um modo de garantir a consistência com o tamanho da fonte é utilizar os estilos 
CSS com o tamanho da sua fonte definido em pixels. Para obter mais 
informações sobre as CSS, consulte “Utilizar a opção Cascading Style Sheets 
(Folha de estilo em cascata) para formatar texto” na página 433.

N
O

T
A

Esses números indicam uma diferença relativa do tamanho da fonte básica. O 
valor da fonte básica padrão é 3. Portanto, um valor +4 resulta em um tamanho 
de fonte de 3 + 4 ou seja, 7. A soma máxima de valores de tamanho de fonte é 7. 
Caso tente definir um valor superior, ele será exibido como 7. O Dreamweaver 
não exibe a tag basefont (que aparece na seção head), embora o tamanho da 
fonte deva ser exibido corretamente em um navegador.  Para testar esse 
procedimento, compare textos definidos para 3 e +3.
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3. Digite um novo nome no campo de texto New Name (Novo nome).

4. Clique em OK.

Modificar combinações de fontes
Utilize o comando Edit Font List (Editar lista de fontes) para definir as combinações de fontes 
que aparecem no Property inspector e no submenu Text (Texto) > Font (Fonte). 

As combinações de fontes determinam como um navegador exibe o texto na sua página da 
Web. O navegador utiliza a primeira fonte na combinação que estiver instalada no sistema do 
usuário. Se nenhuma das fontes na combinação estiver instalada, ele exibirá o texto conforme 
a especificação das preferências do navegador do usuário.

Para modificar as combinações de fontes:

1. Escolha Text (Texto) > Font (Fonte) > Edit Font List (Editar lista de fontes).

2. Selecione a combinação de fontes na lista situada no alto da caixa de diálogo.

As fontes na combinação selecionada estão relacionadas na lista Chosen Fonts (Fontes 
escolhidas), no canto inferior esquerdo da caixa de diálogo. À direita, há uma lista com 
todas as fontes disponíveis, instaladas no seu sistema.

3. Siga um dos procedimentos abaixo:

■ Para adicionar ou remover fontes de uma combinação de fontes, clique no botão de 
seta (<< ou >>) entre as listas Chosen Fonts (Fontes escolhidas) e Available Fonts 
(Fontes disponíveis).

■ Para adicionar ou remover uma combinação de fontes, clique nos botões com sinal de 
adição (+) e de subtração (–), no alto da caixa de diálogo.

■ Para adicionar uma fonte não instalada no sistema, digite o nome da fonte no campo 
de texto abaixo da lista Available Fonts e clique no botão << para adicioná-
la à combinação. A adição de uma fonte não instalada no sistema é útil, por exemplo, 
para designar uma fonte específica do Windows quando o usuário está desenvolvendo 
páginas em um Macintosh.

■ Para mover a combinação de fontes para cima ou para baixo na lista, clique nos botões 
de seta, na parte superior da caixa de diálogo.

Para adicionar uma nova combinação a uma lista de fontes:

1. Escolha Text (Texto) > Font (Fonte) > Edit Font List (Editar lista de fontes).

2. Selecione uma fonte na lista de fontes disponíveis e clique no botão << para mover a fonte 
para a lista Chosen Fonts (Fontes escolhidas).
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3. Repita a etapa 2 para cada fonte subseqüente na combinação.

Para adicionar uma fonte não instalada no sistema, digite o nome da fonte no campo de 
texto abaixo da lista Fontes disponíveis e clique no botão << para adicioná-la à 
combinação. A adição de uma fonte não instalada no sistema é útil, por exemplo, para 
designar uma fonte específica do Windows quando o usuário está desenvolvendo páginas 
em um Macintosh.

4. Ao terminar a seleção das fontes específicas, selecione uma família de fontes genérica no 
menu Available Fonts (Fontes disponíveis) e clique no botão <<, para mover a família 
genérica para a lista Chosen Fonts (Fontes escolhidas).

As famílias de fontes genéricas incluem cursivas, fantasia, monoespaçadas, e com e sem 
serifas. Se nenhuma das fontes na lista Chosen Fonts (Fontes escolhidas) estiver disponível 
no sistema do usuário, o texto aparecerá na fonte padrão associada à família de fontes 
genérica. Por exemplo: a fonte monoespaçada padrão na maioria dos sistemas é Courier.

Alterar a cor do texto
É possível alterar a cor do texto selecionado, para que a nova cor anule a cor do texto definida 
em Page Properties (Propriedades da página) (se nenhuma cor tiver sido definida em Page 
Properties, a cor de texto padrão será preto).

Para alterar a cor do texto:

1. Selecione o texto.

2. Siga um dos procedimentos abaixo:

■ Para escolher uma cor na paleta de cores, clique no seletor de cores no Property 
inspector.

■ Selecione Text (Texto) > Color (Cor). A caixa de diálogo System Color Picker (Seletor 
de cores do sistema) é exibida. Selecione uma cor e clique em OK.

■ Digite o nome da cor ou um número hexadecimal diretamente no campo do Property 
inspector.

■ Para definir a cor padrão do texto, utilize o comando Modify (Modificar) > Page 
Properties (Propriedades da página). Veja “Definir cores padrão para o texto” na 
página 386.

Para retornar o texto à cor padrão:

1. No Property inspector, clique na caixa de cores para abrir a paleta de cores aceitas pela Web.

2. Clique no botão Strike-through (Riscado) (o botão quadrado branco com uma linha 
vermelha cortando-o, situado no canto superior direito).
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Inserir datas
O Dreamweaver fornece um objeto Date (Data) conveniente, que insere a data atual em 
qualquer formato preferido (com ou sem a hora) e dá ao usuário a opção de atualizar a data 
sempre que o arquivo for salvo. 

Para inserir a data atual em um documento:

1. Na janela do documento, coloque o ponto de inserção onde deseja inserir a data.

2. Siga um dos procedimentos abaixo:

■ Selecione Insert (Inserir) > Date (Data).
■ Na categoria Common da barra Insert, clique no ícone Date.

3. Na caixa de diálogo que aparecer, selecione os formatos para o nome do dia da semana, a 
data e a hora.

4. Para que a hora inserida seja atualizada sempre que o documento for salvo, selecione 
Update Automatically on Save (Atualizar automaticamente ao salvar). Para transformar a 
data em texto simples, quando for inserida, e nunca atualizá-la automaticamente, 
desmarque esta opção.

5. Clique em OK para inserir a data.

Inserir caracteres especiais
Alguns caracteres especiais são representados em HTML por um nome ou número, 
referenciado como uma entidade. O HTML inclui nomes de entidades para caracteres como 
símbolo de copyright (&copy;), o "e" comercial (&amp;) e o símbolo de marca registrada 
(&reg;). Cada entidade contém um nome (por exemplo: &mdash;) e um equivalente 
numérico (por exemplo: &#151;).

N
O

T
A

As datas e horas mostradas na caixa de diálogo Inserir data não representam a data 
atual nem refletem as datas/horas vistas por um visitante quando ele exibe o seu site. 
Estes são apenas exemplos da maneira de mostrar essas informações.

D
IC

A

Se for escolhida a opção Update Automatically on Save (Atualizar automaticamente 
ao salvar), é possível editar o formato da data após ter sido inserida no documento, 
através do clique no texto formatado e da seleção de Edit Date Format (Editar 
formato da data), no Property inspector.

D
IC

A

O HTML utiliza chaves <> no seu código, mas talvez seja necessário expressar os 
caracteres especiais correspondentes a maior ou menor do que, sem que o 
Dreamweaver os interprete como código. Nesse caso, utilizar &gt; para maior do que (>) 
e &it; para menor do que (<).
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Infelizmente, muitos navegadores (especialmente, os mais antigos e aqueles diferentes do 
Navigator e Internet Explorer) não exibem corretamente muitas das entidades denominadas.

Para inserir um caractere especial em um documento:

1. Na janela do documento, coloque o ponto de inserção onde o caractere especial deverá ser 
inserido.

2. Siga um dos procedimentos abaixo:

■ Escolha o nome do caractere no submenu Insert > HTML > Special Characters.
■ Na categoria Text da barra Insert, clique no botão Characters e selecione o 

caractere desejado.

Adicionar espaço entre os caracteres
O HTML só permite um espaço entre caracteres. Para adicionar espaço adicional em um 
documento, é necessário inserir um espaço não-separável. É possível definir uma preferência 
para adicionar automaticamente espaços não-separáveis em um documento. 

Para inserir um espaço não-separável, siga um dos procedimentos abaixo:

■ Na categoria HTML da barra Insert, clique no botão Characters e selecione Insert 
Non-breaking Space (Inserir espaço não-separável).

■ Escolha Insert > HTML > Special Characters >Non-Breaking Space.
■ Pressione Control+Shift+Barra de espaço (Windows) ou Option+Barra de espaço 

(Macintosh).

Para definir uma preferência para adicionar espaços não-separáveis:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

2. Na categoria General, certifique-se de que Allow Multiple Consecutive Spaces (Permitir 
espaços consecutivos múltiplos) está selecionada. 

D
IC

A

Há muitos outros caracteres especiais disponíveis; para selecionar um deles, 
selecione Insert > HTML > Special Characters > Other ou selecione a categoria 
HTML na barra Insert, clique no menu Characters  e selecione Other Characters. 
Selecione um caractere na caixa de diálogo Insert Other Character (Inserir outro 
caractere) e clique em OK. 
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Utilizar a opção Cascading Style Sheets 
(Folha de estilo em cascata) para 
formatar texto
Por padrão, o Dreamweaver utiliza CSS ao formatar texto. Os estilos que você aplica a texto 
usando o Property inspector ou comandos de menu criam regras CSS que são incorporadas ao 
cabeçalho do documento atual. Os estilos CSS fornecem maior flexibilidade e controle sobre a 
aparência da página, desde o posicionamento preciso do layout até fontes específicas e estilos 
de texto.

Também é possível utilizar o painel CSS Styles (Estilos CSS) para criar e editar regras CSS e 
propriedades. O painel CSS Styles é um editor muito mais avançado do que o Property 
inspector (Inspetor de propriedades) e exibe todas as regras CSS definidas para o documento 
atual, estando essas regras incorporadas na seção head do documento ou em uma folha de 
estilos externa. A Macromedia recomenda a utilização do painel CSS Styles (em vez do 
Property inspector) como ferramenta principal para criar e editar o CSS.  Como 
conseqüência, seu código será mais limpo e mais fácil de manter.

Além dos estilos e das folhas de estilos criadas, é possível utilizar folhas de estilo que 
acompanham o Dreamweaver para aplicar estilos aos documentos. Consulte “Criar um 
documento com base em um arquivo de projeto do Dreamweaver” na página 103.

Utilizar o painel CSS Styles (Estilos CSS)
Você pode utilizar o painel CSS Styles para visualizar, criar, editar e remover estilos CSS, assim 
como para anexar folhas de estilo externas a documentos. (Para obter uma visão geral deste 
painel, consulte “Utilizar o painel CSS Styles” na página 414.)

Para abrir o painel CSS Styles

■ Siga um dos procedimentos abaixo:
■ Selecione Window (Janela) > CSS Styles (Estilos CSS).
■ Pressione Shift+F11.
■ Clique no botão CSS no Property inspector (Inspetor de propriedades).

Para editar uma regra no painel CSS Styles (modo Current [Atual]):

1. Clique no botão Current na parte superior do painel CSS Styles.

2. Selecione um elemento de texto na página atual para que suas propriedades sejam exibidas.
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3. Siga um dos procedimentos abaixo:

■ Clique duas vezes em uma propriedade no painel Summary for Selection (Resumo para 
seleção) para exibir a caixa de diálogo CSS Rule Definition (Definição de regra CSS) e 
depois faça as alterações.

■ Selecione uma propriedade no painel Summary for Selection e edite a propriedade no 
painel (Propriedades) que se encontra abaixo.

■ Selecione uma regra no painel Rules (Regras) e depois edite as propriedades da regra no 
painel Properties apresentado abaixo.

Para editar uma regra no painel CSS Styles (modo All):

1. Clique no botão All (Tudo) na parte superior do painel CSS Styles.

2. Siga um dos procedimentos abaixo:

■ Clique duas vezes em uma regra no painel All Rules (Todas as regras) para exibir a caixa de 
diálogo CSS Rule Definition e depois faça as alterações.

■ Selecione uma regra no painel All Rules e depois edite as propriedades da regra no painel 
Properties apresentado abaixo.

■ Selecione uma regra no painel All Rules e clique no botão Edit Style (Editar estilo), 
localizado no canto inferior direito do painel CSS Styles.

Para adicionar uma propriedade a uma regra:

1. Selecione uma regra no painel All Rules (modo All) ou selecione uma propriedade no painel 
Summary for Selection (Resumo para seleção) (modo Current).

2. Siga um dos procedimentos abaixo:

■ Se a visualização Show Only Set Properties (Mostrar apenas as propriedades definidas) 
estiver selecionada no painel Properties, clique no link Add Properties (Adicionar 
propriedades) e adicione uma propriedade.

N
O

T
A

É possível alterar o comportamento de duplo clique para editar CSS, bem como 
outros comportamentos, alterando as preferências do Dreamweaver. Para obter 
mais informações, consulte Definir as preferências de estilos CSS.

N
O

T
A

É possível alterar o comportamento de duplo clique para editar CSS, bem como 
outros comportamentos, alterando as preferências do Dreamweaver. Para obter 
mais informações, consulte Definir as preferências de estilos CSS. 

N
O

T
A
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■ Se a visualização Category (Por categorias) ou a visualização List (Por lista) estiver 
selecionada no painel Properties, preencha um valor para a propriedade que você deseja 
adicionar.

Nos modos All e Current, o painel CSS Styles contém três botões que permitem alterar a 
visualização no painel Properties (painel inferior):

A visualização Category (Por categorias) divide as propriedades CSS suportadas pelo 
Dreamweaver em oito categorias: font (fonte), background (fundo), block (bloco), border 
(borda), box (caixa), list (lista), positioning (posicionamento) e extensions (extensões).  As 
propriedades de cada categoria encontram-se em uma lista que pode ser aberta ou fechada 
clicando-se no botão com o sinal de adição (+) próximo ao nome da categoria. As 
propriedades definidas são mostradas (em azul) na parte superior da lista.

A visualização List (Por lista) exibe todas as propriedades CSS suportadas pelo Dreamweaver 
em ordem alfabética. As propriedades definidas são mostradas (em azul) na parte superior da 
lista.

A visualização Set Properties (Propriedades definidas) exibe apenas as propriedades que 
foram definidas. A visualização Set Properties é o padrão.

Nos modos All e Current, o painel CSS Styles também contém os seguintes botões:

O botão Attach Style Sheet (Anexar a folha de estilo) abre a caixa de diálogo Link External 
Style Sheet (Vincular a folha de estilo externa). Selecione uma folha de estilo externa para 
vincular ou importar para o documento atual. Para obter informações sobre como anexar uma 
folha de estilo externa, veja “Vincular ou importar uma folha de estilo CSS externa” na 
página 439.

O botão New CSS Rule (Nova regra CSS) abre uma caixa de diálogo na qual é possível 
selecionar o tipo de estilo que está sendo criado, por exemplo, para criar um estilo de classe, 
redefinir uma tag de HTML ou definir um seletor CSS. Para obter mais informações, consulte 
“Criar uma nova regra CSS” na página 436.

Visualização 
Category

Visualização Set Properties

Visualização List

New CSS Rule

Attach Style 
Sheet

Edit Style

Delete CSS Rule
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O botão Edit Style (Editar estilo) abre uma caixa de diálogo na qual é possível editar os 
estilos do documento atual ou de uma folha de estilos externa. Para obter informações sobre 
como atualizar uma folha de estilo, consulte “Editar uma regra CSS” na página 441.

O botão Delete CSS Rule (Excluir a regra CSS) remove a regra ou propriedade selecionada 
do painel CSS Styles e remove a formatação de qualquer elemento ao qual o estilo tenha sido 
aplicado. (No entanto, ele não remove as referências a esse estilo). 

Tópicos relacionados
■ “Aplicar um estilo de classe” na página 437
■ “Vincular ou importar uma folha de estilo CSS externa” na página 439
■ “Editar uma folha de estilo CSS” na página 441

Criar uma nova regra CSS
É possível criar uma regra CSS para automatizar a formatação das tags HTML ou uma faixa 
de texto identificada por um atributo class.

Para criar uma nova regra CSS: 

1. Coloque o ponto de inserção no documento e siga um dos procedimentos abaixo para abrir 
a caixa de diálogo New CSS Rule (Nova regra CSS):

■ No painel CSS Styles (Window [Janela] > CSS Styles [Estilos CSS]), clique no botão 
New CSS Rule (+), localizado no lado inferior direito do painel. 

■ Escolha Text (Texto) > CSS Styles (Estilos CSS) > New CSS Rule (Nova regra CSS).
2. Defina o tipo de estilo CSS que deseja criar:

■ Para criar um estilo personalizado que possa ser aplicado como um atributo class a 
uma faixa ou bloco de texto, selecione a opção Class (Classe) e digite um nome para o 
estilo na caixa de texto Name (Nome). 

■ Para redefinir a formatação padrão de uma HTML específica, selecione a opção Tag e 
depois digite uma tag HTML na caixa de texto Tag ou selecione uma no 
menu pop-up. 

D
IC

A

Clique com o botão direito (Windows) ou clique mantendo a tecla Control pressionada 
(Macintosh) no painel CSS Styles para abrir um menu contextual de opções para 
trabalhar com comandos de folhas de estilos CSS.

N
O

T
A

Os nomes de classe devem ser precedidos de um ponto, podendo conter 
qualquer combinação de letras e números (por exemplo, .myhead1). Caso o 
ponto não seja inserido, o Dreamweaver o digitará automaticamente.
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■ Para definir a formatação de determinada combinação de tags ou de todas as tags que 
contenham um atributo Id específico, selecione a opção Advanced (Avançado) e 
depois digite uma ou mais tags na caixa de texto Selector (Seletor) ou selecione uma no 
menu pop-up. Os seletores disponíveis no menu pop-up são a:active, a:hover, 
a:link e a:visited. 

3. Selecione o local onde o estilo será definido: 

■ Para criar uma folha de estilo externa, escolha New Style Sheet File (Novo arquivo de 
folha de estilo).

■ Para incorporar o estilo no documento atual, escolha This Document Only.
4. Clique em OK. 

A caixa de diálogo Style Definition (Definição do estilo) é exibida. 
5. Escolha as opções de estilo a serem definidas para a nova regra CSS. 

6. Ao concluir a definição de atributos de estilo, clique em OK. 

Para obter informações sobre definições de estilo CSS específicas, consulte os seguintes tópicos 
em Usando o Dreamweaver:

■ Definir propriedades do tipo CSS
■ Definir propriedades de fundo do estilo CSS
■ Definir propriedades de bloco do estilo CSS
■ Definir propriedades de caixa do estilo CSS
■ Definir propriedades de borda do estilo CSS
■ Definir propriedades de lista do estilo CSS
■ Definir propriedades de posicionamento do estilo CSS 
■ Definir propriedades de extensões do estilo CSS

Tópicos relacionados
■ “Utilizar o painel CSS Styles (Estilos CSS)” na página 433
■ “Aplicar um estilo de classe” na página 437
■ “Editar uma regra CSS” na página 441

Aplicar um estilo de classe
Os estilos de classe são o único tipo de estilo CSS que pode ser aplicado a qualquer texto em 
um documento, sem levar em consideração as tags que o controlam. Todos estilos de classe 
associados ao documento atual são exibidos no painel CSS Styles (Estilos CSS) (com um 
ponto antes do nome), e no menu pop-up Style do Property inspector de texto.
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A maioria dos estilos atualizados é exibida de imediato, mas é necessário visualizar a página em 
um navegador para verificar se um estilo foi aplicado conforme esperado. Se dois ou mais 
estilos forem aplicados ao mesmo texto, poderá ocorrer conflito e os resultados poderão ser 
inesperados.  Para obter mais informações, consulte “Regras CSS conflitantes” na página 410.

Para aplicar um estilo CSS personalizado:

1. No documento, selecione o texto ao qual será aplicado um estilo CSS.

Coloque o ponto de inserção em um parágrafo, para aplicar o estilo ao parágrafo inteiro.
Se for selecionada uma faixa de texto em um único parágrafo, o estilo CSS afetará apenas a 
faixa selecionada.
Para especificar a tag exata à qual o estilo CSS deve ser aplicado, selecione a tag no seletor 
de tags, localizado na parte inferior esquerda da janela do documento. 

2. Para aplicar um estilo de classe, siga um dos procedimentos abaixo:

■ No painel CSS Styles (Window [Janela] > CSS Styles), selecione o modo All (Tudo), 
clique com o botão direito no nome do estilo que deseja aplicar e selecione Apply 
(Aplicar) no menu de contexto.

■ No Property inspector de texto, selecione o estilo de classe que deseja aplicar no menu 
pop-up Style. 

■ Na janela do documento, clique com o botão direito (Windows) ou clique mantendo 
pressionada a tecla Control (Macintosh) sobre o texto selecionado e, no menu 
contextual, escolha CSS Styles e selecione o estilo desejado. 

■ Selecione Text > CSS Styles e selecione o estilo desejado no submenu.

Para remover um estilo personalizado de uma seleção: 

1. Selecione o objeto ou texto do qual você deseja remover o estilo.

2. No Property inspector de texto (Window > Properties [Propriedades]), selecione None 
(Nenhum) no menu pop-up Style. 

Tópicos relacionados

■ “CSS (Cascading Style Sheets)” na página 408
■ “Utilizar o painel CSS Styles” na página 414
■ “Editar uma regra CSS” na página 441

D
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Ao visualizar estilos definidos em uma folha de estilo CSS externa, certifique-se de 
salvar a folha de estilo para assegurar que suas alterações sejam refletidas quando 
visualizar a página em um navegador.
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Exportar estilos para criar uma folha de estilo CSS
Os estilos de um documento podem ser exportados para criar uma nova folha de estilo CSS. 
Em seguida, ela pode ser vinculada a outros documentos, para que os estilos sejam aplicados.

Para exportar os estilos CSS de um documento e criar uma folha de estilo 
CSS:

1. Selecione File > Export > CSS Styles ou Text > CSS Styles > Export. 

A caixa de diálogo Export Styles as CSS File (Exportar os estilos como um arquivo CSS) é 
exibida. 

2. Digite um nome para a folha de estilo e clique em Save (Salvar).

O estilo será salvo como uma folha de estilo CSS.

Tópicos relacionados
■ “Utilizar o painel CSS Styles (Estilos CSS)” na página 433
■ “Editar uma folha de estilo CSS” na página 441
■ “Utilizar folhas de estilo Design-Time” na página 442

Vincular ou importar uma folha de estilo CSS externa
Quando uma folha de estilo CSS externa for editada, todos os documentos a ela vinculados 
serão atualizados com essas alterações. É possível exportar os estilos CSS de um documento 
para criar uma nova folha de estilo CSS e, em seguida, anexar ou vincular a uma folha de estilo 
externa, a fim de aplicar os estilos nela contidos.

Você pode, obviamente, anexar às suas páginas qualquer estilos qualquer folha de estilo criada 
ou copiada para o seu site. Além disso, o Dreamweaver dispõe de folhas de estilo predefinidas, 
que podem ser automaticamente movidas para o seu site e anexadas às suas páginas.  Para 
obter informações sobre como usar as folhas de estilos de projeto incluídas no Dreamweaver, 
consulte “Criar um documento com base em um arquivo de projeto do Dreamweaver” na 
página 103.

Para obter informações sobre como aplicar um estilo, consulte “Aplicar um estilo de classe” na 
página 437.

Para vincular ou importar uma folha de estilo CSS externa: 

1. Abra o painel CSS Styles (Estilos CSS) seguindo um dos procedimentos abaixo:

■ Selecione Window (Janela) > CSS Styles (Estilos CSS).
■ Pressione Shift + F11.
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2. No painel CSS Styles (Estilos CSS), clique no botão Attach Style Sheet (Anexar folha de 
estilo). (Ele está no canto inferior direito do painel.)

3. Preencha a caixa de diálogo e clique em OK.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.

Tópicos relacionados
■ “Utilizar o painel CSS Styles (Estilos CSS)” na página 433
■ “Exportar estilos para criar uma folha de estilo CSS” na página 439
■ “Editar uma folha de estilo CSS” na página 441

Usar as folhas de estilo de amostra do Dreamweaver
O Dreamweaver fornece folhas de estilo de amostra que você pode aplicar às suas páginas ou 
usar como pontos de partida para desenvolver seus próprios estilos.

Para aplicar folhas de estilo do Dreamweaver:

1. Abra o painel CSS Styles (Estilos CSS) seguindo um dos procedimentos abaixo:

■ Selecione Window (Janela) > CSS Styles (Estilos CSS).
■ Pressione Shift+F11.

2. No painel CSS Styles (Estilos CSS), clique no botão Attach External Style Sheet (Anexar 
folha de estilo externa). (Ele está no canto inferior direito do painel.)

3. Na caixa de diálogo Attach External Style Sheet, clique em Sample Style Sheets (Amostras 
de folhas de estilo).

4. Na caixa de diálogo Sample Style Sheets, selecione uma folha de estilo na caixa de lista.

Quando você seleciona folhas de estilo na caixa de lista, o painel Preview (Visualizar) exibe 
a formatação de texto e de cores da folha de estilo selecionada.

5. Clique no botão Preview (Visualizar) para aplicar a folha de estilo e verificar se ela emprega 
os estilos desejados na página atual.

Se não estiver satisfeito com os estilos aplicados, selecione outra folha de estilo na lista e 
clique em Preview (Visualizar) para ver esses estilos.

6. Por padrão, o Dreamweaver salva a folhas de estilo em uma pasta chamada CSS, logo 
abaixo da raiz do site que você definiu na sua página. Se essa pasta não existir, ela será criada 
pelo Dreamweaver.  Para salvar o arquivo em outro local, clique em Browse (Procurar) e 
localize a pasta desejada. 

7. Quando encontrar uma folha de estilo cujas regras de formatação atendam aos seus critérios 
de design, clique em OK.
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Editar uma regra CSS
É possível editar facilmente as regras internas e externas aplicadas a um documento. 

Quando uma folha de estilo CSS que controla o texto no documento for editada, o texto 
inteiro controlado por essa folha de estilo CSS será reformatado instantaneamente. As edições 
em uma folha de estilo externa afetam todos os documentos vinculados a ela.

É possível definir um editor externo para editar folhas de estilo. Para obter informações sobre 
como configurar um editor externo, consulte “Iniciar um editor de arquivos de mídia externo” 
na página 521. 

Para editar uma regra CSS:

1. Abra o painel CSS Styles (Estilos CSS) selecionando Window (Janela) > CSS Styles.

2. Posicione o cursor no texto cuja regra CSS deseja editar. 

3. Utilize o painel CSS Styles para editar a regra. Para obter instruções, consulte “Utilizar o 
painel CSS Styles (Estilos CSS)” na página 433.

As alterações que você fizer serão automaticamente aplicadas ao documento atual, 
permitindo que você visualize suas alterações à medida que elas são feitas. Se estiver 
editando regras armazenadas em uma folha de estilo externa, certifique-se de salvar suas 
alterações para ver suas atualizações aplicadas.
Se modificar regras CSS que se encontram em uma folha de estilo usada por mais de um 
documento, as modificações serão refletidas também nessas páginas.

Tópicos relacionados
■ “Utilizar folhas de estilo Design-Time” na página 442

Editar uma folha de estilo CSS
Uma folha de estilo CSS costuma incluir um ou mais regras. Você pode editar uma regra 
individual em uma folha de estilo CSS utilizando o painel CSS Styles (Estilos CSS) (consulte 
“Editar uma regra CSS” na página 441) ou, caso prefira, trabalhando diretamente na folha de 
estilo CSS.

Para editar uma folha de estilo CSS: 

1. No painel CSS Styles (Window [Janela]> CSS Styles), selecione o modo All (Tudo).

2. No painel All Rules (Todas as regras), clique duas vezes no nome da folha de estilo que 
deseja editar.

3. Na janela do documento, modifique a folha de estilo como desejar e depois salve-a.
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Tópicos relacionados
■ “Utilizar o painel CSS Styles (Estilos CSS)” na página 433
■ “Editar uma regra CSS” na página 441

Atualizar folhas de estilo CSS em um site do 
Contribute
Os usuários do Macromedia Contribute não podem efetuar alterações em uma folha de estilo 
CSS Para modificar uma folha de estilo para um site do Contribute, use o Dreamweaver.

Os fatores a seguir são importantes e devem ser levados em consideração ao atualizar folhas de 
estilo para um site do Contribute :

■ Se forem feitas alterações em uma folha de estilo enquanto um usuário do Contribute 
estiver editando uma folha de estilo, o usuário não poderá visualizar as alterações feitas na 
folha de estilo até que sejam publicadas na página.

■ Se um estilo for excluído de uma folha de estilo, o nome do estilo não será excluído da 
página que utiliza aquela folha de estilo, mas uma vez que o estilo não existe mais, não será 
exibido da forma que o usuário do Contribute esperava. Portanto, se nada acontecer ao ser 
aplicado um estilo em especial, o problema pode ser o estilo que não foi excluído da folha 
de estilo.

Para editar uma folha de estilo CSS em um site do Contribute:

1. Edite a folha de estilo utilizando as ferramentas de edição de folha de estilo do 
Dreamweaver. Para obter mais informações, consulte “Utilizar a opção Cascading Style 
Sheets (Folha de estilo em cascata) para formatar texto” na página 433.

2. Informe a todos os usuários do Contribute que estão trabalhando no site para publicar as 
páginas que utilizam aquela folha de estilo, e editar novamente as páginas para visualizar a 
nova folha de estilo.

Utilizar folhas de estilo Design-Time
As folhas de estilos Design-Time (Tempo de design) permitem mostrar ou ocultar o design 
aplicado por uma folha de estilo CSS, à medida que você trabalha em um documento do 
Dreamweaver. Por exemplo: você pode usar essa opção para incluir ou excluir o efeito de uma 
folha de estilo apenas do Macintosh ou apenas do Windows, durante a criação da página. 

Essas folhas de estilos são válidas apenas ao trabalhar no documento do Dreamweaver. 
Quando a página é exibida em uma janela do navegador, apenas os estilos anexados ou 
incorporados no documento são exibidos.  
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Para mostrar ou ocultar uma folha de estilo CSS para tempo de projeto: 

1. Siga um destes procedimentos para abrir a caixa de diálogo Design-Time Style Definition 
(Definição de estilo de tempo de projeto):

■ Clique com o botão direito do mouse no painel CSS Styles e selecione Design-time no 
menu de contexto. 

■ Selecione Text > CSS Styles > Design-time.
2. Na caixa de diálogo, defina as opções para mostrar ou ocultar uma folha de estilo 

selecionada. 

■ Para exibir uma folha de estilo CSS em tempo de projeto, clique no botão de adição 
(+) acima de Show Only at Design Time (Mostrar apenas em tempo de projeto) e, em 
seguida, na caixa de diálogo Select a Style Sheet (Selecionar uma folha de estilo), 
localize a folha de estilo CSS desejada.

■ Para exibir uma folha de estilo CSS em tempo de projeto, clique no botão de adição 
(+) acima de Hide at Design Time (Ocultar em tempo de projeto) e, em seguida, 
localize a folha de estilo CSS desejada na caixa de diálogo Select a Style Sheet.

■ Para remover uma folha de estilo de uma das listas, clique na folha de estilo a ser 
removida e, em seguida, clique no botão de subtração (–) apropriado.

3. Clique em OK para fechar a caixa de diálogo.

O painel CSS Styles (Estilos CSS) é atualizado com o nome da folha de estilo selecionada 
junto com um indicador, “oculto” ou “design”, para refletir o status da folha de estilo. 

Tópicos relacionados
■ “Utilizar o painel CSS Styles (Estilos CSS)” na página 433
■ “Exportar estilos para criar uma folha de estilo CSS” na página 439
■ “Vincular ou importar uma folha de estilo CSS externa” na página 439
■ “Editar uma folha de estilo CSS” na página 441

Verificar a ortografia
Utilize o comando Check Spelling (Verificar ortografia) no menu Text para verificar a 
ortografia do documento atual. Esse comando ignora as tags HTML e valores de atributos. 
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Como padrão, a verificação ortográfica utiliza o dicionário ortográfico de inglês dos EUA. 
Para alterar o dicionário, selecione Edit > Preferences > General (Windows) ou Dreamweaver 
> Preferences > General  (Macintosh) e, em seguida, no menu pop-up Spelling Dictionary 
(Dicionário ortográfico), selecione o dicionário desejado. Para fazer download de dicionários 
para idiomas adicionais, visite o Centro de Suporte do Dreamweaver, em 
www.macromedia.com/support/dreamweaver.

Para verificar e corrigir a ortografia:

1. Escolha Text (Texto) > Check Spelling (Verificar ortografia) ou pressione Shift+F7.

Quando o Dreamweaver encontra uma palavra não reconhecida, a caixa de diálogo Check 
Spelling (Verificar ortografia) é exibida.

2. Selecione a opção adequada com base em como você deseja lidar com essa discrepância.

Procurar e substituir texto
Você pode usar o comando Find and Replace (Localizar e substituir) para procurar por texto e 
tags HTML e atributos em um documento ou em um conjunto de documentos.

Para procurar texto e/ou HTML nos documentos: 

1. Abra o documento no qual deseja fazer a busca, ou selecione documentos ou uma pasta no 
painel Files (Arquivos).

2. Selecione Edit > Find e Replace. 

A caixa de diálogo Find and Replace é exibida. 
3. Especifique os arquivos nos quais deseja fazer a busca e, em seguida, especifique o tipo de 

busca a ser executada, bem como o texto e as tags a serem procurados. Como alternativa, 
especifique também o texto de substituição. Em seguida, clique em um dos botões Find 
(Localizar) ou Replace (Substituir).

Para obter mais informações, clique no botão Help (Ajuda).
4. Ao terminar, clique no botão Close (Fechar) para fechar a caixa de diálogo.

Para fazer uma nova busca sem exibir a caixa de diálogo Find and Replace:

■ Pressione F3 (no Windows) ou Command+G (no Macintosh).

N
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Para procurar por arquivos em um site, usam-se comandos distintos: Locate in Local 
Site (Procurar no site local) and Locate in Remote Site (Procurar no site remoto).
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CAPÍTULO 14

Inserir imagens
No Macromedia Dreamweaver 8, é possível trabalhar na visualização de projeto ou de código 
para inserir imagens em um documento.  Ao adicionar imagens em um documento do 
Dreamweaver, é possível definir ou modificar propriedades da imagem e exibir as alterações 
diretamente na janela do documento.

Para mais eficiência no fluxo de trabalho de criação da Web, você pode selecionar uma 
preferência de editor de imagens para iniciá-lo automaticamente para editar imagens ao 
trabalhar no Dreamweaver. 

Este capítulo contém as seguintes seções:
Sobre as imagens. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 445

Inserir uma imagem . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .448

Redimensionar uma imagem . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .453

Cortar uma imagem . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 454

Usar o Fireworks para otimizar uma imagem. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 455

Ajustar o brilho e o contraste de uma imagem. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .456

Definir a nitidez de uma imagem. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .456

Criar uma imagem cambiável. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .457

Usar um editor de imagens externo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .458

Aplicar comportamentos a imagens. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 459

Sobre as imagens
Existem muitos tipos diferentes de formatos de arquivos gráficos, mas três formatos são 
geralmente utilizados nas páginas da Web: GIF, JPEG e PNG. Atualmente, os formatos de 
arquivo GIF e JPEG são os que apresentam melhor suporte e podem ser exibidos na maioria 
dos navegadores. 
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Os arquivos PNG adaptam-se melhor a quase todos os tipos de imagens gráficas da Web 
devido a sua flexibilidade e pequeno tamanho de arquivo, entretanto, a exibição de imagens 
PNG conta com suporte parcial apenas no Microsoft Internet Explorer (navegadores 4.0 e 
posteriores) e no Netscape Navigator (navegadores 4.04 e posteriores). Portanto, a menos que 
seu projeto se destine a um público-alvo específico que utiliza um navegador com suporte para 
o formato PNG, utilize os formatos GIF ou JPEG para atingir um público maior.

Os arquivos GIF (Graphic Interchange Format) utilizam um máximo de 256 cores e são 
mais apropriados para exibir imagens em tons descontínuos ou aquelas que contêm grandes 
superfícies de cores sólidas, como barras de navegação, botões, ícones, logotipos ou outras 
imagens com matizes e cores uniformes, por exemplo). 

O formato de arquivo JPEG (Joint Photographic Experts Group) é a opção mais avançada 
para imagens fotográficas ou de tons contínuos, porque os arquivos JPEG podem conter 
milhões de cores. À medida que a qualidade do arquivo JPEG aumenta, também aumentam o 
tamanho do arquivo e o tempo de download. Geralmente é possível equilibrar a qualidade da 
imagem e o tamanho do arquivo, compactando um arquivo JPEG. 

O formato de arquivo PNG (Portable Network Group) é um substituto do GIF, não 
patenteado, que inclui suporte para imagens com cores indexadas, escala de cinza e True 
Color, além de suporte ao canal alfa para transparência. O PNG é o formato de arquivo nativo 
do Macromedia Fireworks. Os arquivos PNG reúnem todas as informações originais sobre 
camadas, vetores, cores e efeitos (como sombreamento), e todos os elementos são inteiramente 
editáveis todas as vezes. Os arquivos devem ter extensão .png para serem reconhecidos como 
arquivos PNG pelo Macromedia Dreamweaver MX.

Editar imagens no Dreamweaver
O Dreamweaver fornece recursos básicos de edição de imagens que permitem modificar 
imagens sem utilizar um aplicativo externo de edição de imagens, como o Macromedia 
Fireworks.  As ferramentas de edição de imagens do Dreamweaver foram elaboradas para 
facilitar a tarefa dos designers de conteúdo responsáveis pela criação de arquivos de imagem 
para uso nos sites da Web. 

O Dreamweaver possui os seguintes recursos de edição de imagem:

N
O

T
A

Não é preciso ter o Macromedia Fireworks instalado no seu computador para usar os 
recursos de edição de imagem do Dreamweaver.
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Image resampling (Reamostragem de imagens) adiciona ou subtrai pixels de arquivos de 
imagem JPEG e GIF redimensionados, de modo a refletir o melhor possível a imagem 
original. A reamostragem de uma imagem reduz o tamanho do arquivo de imagem, 
resultando em um melhor desempenho de download.

Ao redimensionar uma imagem no Dreamweaver, você pode fazer uma reamostragem da 
imagem para refletir suas novas dimensões. Ao fazer uma reamostragem de um objeto de 
bitmap, pixels são adicionados ou removidos da imagem para torná-la maior ou menor. A 
reamostragem de uma imagem para uma resolução maior geralmente gera uma pequena perda 
de qualidade.  Entretanto, a reamostragem para uma resolução menor sempre gera perda de 
dados e geralmente queda na qualidade.

Cropping (Corte) permite editar imagens reduzindo a área da imagem. Geralmente, você 
desejará cortar uma imagem para enfatizar o assunto da imagem e remover aspectos 
indesejáveis próximos ao centro de interesse na imagem.  

Brightness/Contrast (Brilho/Contraste): modifica o brilho ou contraste de pixels em uma 
imagem. Esse recurso afeta os realces, sombreamentos e meios-tons de uma imagem. 
Normalmente, os recursos de brilho/contraste são utilizados na correção de imagens que estão 
muito escuras ou muito claras.

Sharpening (Nitidez) ajusta o foco de uma imagem para aumentar o contraste das bordas 
localizadas dentro da imagem. Ao digitalizar uma imagem ou tirar uma foto digital, a ação 
padrão em muitos softwares de captura de imagem é suavizar as bordas dos objetos na 
imagem.  Isso evita que detalhes mais delicados se percam nos pixels que compõem as imagens 
digitais. Entretanto, para realçar os detalhes em arquivos de imagens digitais, em geral é 
necessário melhorar a nitidez da imagem, aumentando o contraste da borda e tornando a 
imagem mais nítida. 

Tópicos relacionados
■ “Redimensionar uma imagem” na página 453
■ “Cortar uma imagem” na página 454
■ “Ajustar o brilho e o contraste de uma imagem” na página 456
■ “Definir a nitidez de uma imagem” na página 456

N
O

T
A

Os recursos de edição de imagem do Dreamweaver se aplicam somente aos formatos 
de arquivo de imagem JPEG e GIF.  Outros formatos de arquivo de imagem de bitmap 
não podem ser editados com esses recursos de edição de imagem.
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Inserir uma imagem
Ao inserir uma imagem em um documento do Dreamweaver, o programa gerará 
automaticamente uma referência a esse arquivo de imagem no código-fonte HTML. Para 
garantir que essa referência esteja correta, o arquivo de imagem deverá estar no site. Caso não 
esteja no site atual, o Dreamweaver perguntará se o arquivo deve ser copiado para o site.

É possível inserir imagens dinamicamente. As imagens dinâmicas são aquelas que se alteram 
com freqüência. Por exemplo, sistemas de rotação de propagandas precisam selecionar 
aleatoriamente uma única propaganda a partir de uma lista de propagandas potenciais e, em 
seguida, exibir dinamicamente a imagem da propaganda quando uma página é solicitada. Para 
obter mais informações, consulte “Tornar dinâmicas as imagens” na página 785.

Para inserir uma imagem:

1. Posicione o ponto de inserção onde a imagem deverá ser exibida na janela do documento e 
siga um dos procedimentos abaixo:

■ Na categoria Common (Comuns) da barra Insert (Inserir), clique no ícone Image 
(Imagem).

■ Na categoria Common (Comuns) da barra Insert (Inserir), arraste o ícone Image 
(Imagem) para a janela do documento (ou para a janela de visualização do código se 
estiver trabalhando no código). 

■ Selecione Insert (Inserir) > Image (Imagem). 
■ Arraste uma imagem do painel Assets (Propriedades), aberto a partir da seleção de 

Window (Janela) > Assets (Propriedades), até a localização desejada na janela do 
documento e prossiga para a etapa 3.

■ Arraste uma imagem do painel Site até o local desejado na janela do documento e 
vá para a etapa 3.

■ Arraste uma imagem da área de trabalho até o local desejado na janela do documento e 
vá para a etapa 3.  

2. Na caixa de diálogo exibida, siga um dos procedimentos abaixo:

■ Selecione File System (Sistema de arquivos) para escolher um arquivo gráfico.
■ Selecione Data Source (Fonte de dados) para escolher uma fonte de imagem dinâmica.

3. Procure a imagem ou origem do conteúdo a ser inserido.

Se você estiver trabalhando em um documento que não foi salvo, o Dreamweaver irá gerar 
uma referência file:// para esse arquivo de imagem. Quando você salva o documento em 
um local qualquer do site, o Dreamweaver converte a referência em um caminho relativo 
ao documento. Clique no botão Help (Ajuda) na caixa de diálogo para aprender sobre as 
opções da caixa de diálogo.
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4. Clique em OK.

A caixa de diálogo Image Tag Accessibility Attributes (Atributos de acessibilidade da tag de 
imagem) é exibida se a caixa de diálogo tiver sido ativada em Preferences (Preferências) 
(consulte “Otimizar a área de trabalho para o projeto de página acessível” na página 76).

5. Digite valores nas caixas de texto Alternate text (Texto alternativo) e Long Description 
(Descrição longa) e clique em OK. 

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
A imagem é exibida no documento. 

6. No Property inspector (Window > Properties), defina as propriedades da imagem. 

Para obter mais informações, consulte “Definir propriedades da imagem” na Usando o 
Dreamweaver. 
Para editar atributos de acessibilidade para a imagem, consulte “Editar atributos de 
acessibilidade para uma imagem” na página 449.

Tópicos relacionados
■ “Definir uma imagem de fundo ou uma cor de fundo para a página” na página 383
■ “Utilizar imagens espaçadoras” na página 300

Editar atributos de acessibilidade para uma imagem
Se você tiver inserido atributos de acessibilidade para uma imagem (consulte “Inserir uma 
imagem” na página 448), é possível editar esses valores no código HTML.

Para editar valores de acessibilidade de uma imagem:

1. Na janela do documento, selecione a imagem.

N
O

T
A

É possível inserir informações uma ou em ambas as caixas de texto, conforme a 
necessidade.

N
O

T
A

Ao clicar em Cancel (Cancelar), a imagem é exibida no documento, mas o 
Dreamweaver não associa tags de acessibilidade a ele.
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2. Siga um dos procedimentos abaixo:

■ Edite os atributos de imagem apropriados na visualização do código: 
■ Clique com o botão direito do mouse (no Windows), ou mantenha a tecla Control 

pressionada e clique (no Macintosh), e selecione Edit Tag Code (Editar código da tag). 
■ Edite o valor Alt no Property inspector.

Inserir alocador de espaço de imagem
Um alocador de espaço de imagem é um gráfico utilizado até que a arte-final esteja pronta 
para ser adicionada a uma página da Web. 

Para inserir um alocador de espaço de imagem:

1. Na janela do documento, coloque o ponto de inserção onde deseja inserir o gráfico do 
alocador de espaço.

2. Siga um dos procedimentos abaixo:

■ Na barra Common Insert (Inserir comuns), clique no ícone Image Placeholder 
(Alocador de espaço de imagem).

■ Selecione Insert (Inserir) > Image Placeholder (Alocador de espaço de imagem).
A caixa de diálogo Image Placeholder (Alocador de espaço de imagem) é exibida.

3. Na caixa de diálogo, selecione as opções para o alocador de espaço de imagem. 

Você também pode definir o tamanho e a cor do alocador de espaço, bem como atribuir-
lhe um identificador de texto. Para obter mais informações, clique no botão Help na caixa 
de diálogo.

4. Clique em OK.

Os atributos de tamanho e cor do alocador de espaço, assim como seu identificador, são 
exibidos da seguinte maneira:

Quando exibidos em uma janela do navegador, o identificador e o tamanho do texto não são 
mostrados. 

Tópicos relacionados
■ “Redimensionar uma imagem” na página 453
■ “Utilizar o Fireworks para modificar alocadores de espaço de imagem do Dreamweaver” 

na página 502.
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Substituir um alocador de espaço de imagem
Um alocador de espaço de imagem não é uma imagem gráfica exibida em um navegador. 
Antes da publicação no seu site, é necessário substituir quaisquer alocadores de espaços de 
imagens que tiver adicionado com arquivos gráficos amigáveis para Web, como GIFs ou 
JPEGs. 

Com o Fireworks, será possível criar uma nova imagem no alocador de espaço de imagem do 
Dreamweaver. A nova imagem está definida para o mesmo tamanho que a imagem do 
alocador de espaço. É possível editar a imagem e depois recolocá-la no Dreamweaver. Para 
obter informações sobre a criação de uma imagem de substituição em Fireworks MX, veja 
“Utilizar o Fireworks para modificar alocadores de espaço de imagem do Dreamweaver” na 
página 502.

Para atualizar a origem da imagem:

1. Na janela do documento, siga um dos procedimentos abaixo:

■ Clique duas vezes no alocador de espaço de imagem.
■ Clique no alocador de espaço de imagem para selecioná-lo e, no Property inspector 

(Window > Properties), clique no ícone de pasta junto à caixa de texto Src (Orig).
A caixa de diálogo Image Source (Origem da imagem) é exibida.

2. Na caixa de diálogo, navegue até a imagem que substituirá o alocador de espaço de imagem. 

3. Clique em OK.

A imagem selecionada é exibida no documento. 
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Alinhar uma imagem
É possível alinhar uma imagem a um texto, a outra imagem, a um plug-in ou a outros 
elementos na mesma linha. Também é possível definir o alinhamento horizontal de uma 
imagem.

Para alinhar uma imagem:

1. Selecione a imagem na visualização do projeto.

2. Defina os atributos de alinhamento da imagem no Property inspector.

É possível definir o alinhamento em relação a outros elementos do mesmo parágrafo ou linha. 

A seguir são listadas as opções de alinhamento:

A opção Default geralmente especifica um alinhamento da linha de base. O padrão pode ser 
diferente, dependendo do navegador do visitante do site. 

Baseline (Linha de base) e Bottom (Inferior): alinham a parte inferior do objeto selecionado 
à linha de base do texto (ou de outro elemento do mesmo parágrafo). 

Top (Superior): alinha a parte superior de uma imagem com a parte superior do item mais 
alto (imagem ou texto) na linha atual. 

Middle (Centro): alinha a parte central da imagem com a linha de base da linha atual. 

Text Top (Parte superior do texto): alinha a parte superior da imagem com a parte superior 
do caractere mais alto da linha de texto. 

Absolute Middle (No meio absoluto): alinha a parte central da imagem com a parte central 
do texto na linha atual. 

Absolute Bottom (O mais abaixo): alinha a parte inferior da imagem com a parte inferior da 
linha de texto (o que inclui descendentes, como na letra g). 

N
O

T
A

O código HTML não fornece um modo de dispor o texto ao redor dos limites de uma 
imagem, como é possível fazer em alguns processadores de texto.
452 Capítulo 14:  Inserir imagens



         
Left (À esquerda): coloca a imagem selecionada na margem esquerda, quebrando 
automaticamente as linhas do texto em volta dele à direita. Se o texto alinhado à esquerda 
preceder o objeto na linha, ele geralmente forçará os objetos alinhados à esquerda a passarem 
para a próxima linha. 

Right (À direita): coloca o objeto na margem direita, quebrando automaticamente as linhas 
do texto em volta dele à esquerda. Se o texto alinhado à direita preceder o objeto na linha, ele 
geralmente forçará os objetos alinhados à direita a passarem para a próxima linha. 

Redimensionar uma imagem
É possível redimensionar visualmente elementos como imagens, plug-ins, filmes do 
Macromedia Shockwave ou Flash, applets e controles ActiveX no Dreamweaver. 

Redimensionar visualmente uma imagem no Dreamweaver o ajuda a visualizar como a 
imagem afeta o layout em diferentes dimensões. A escala do arquivo da imagem não é alterada 
para as proporções especificadas por você.  Se você redimensionar visualmente uma imagem 
no Dreamweaver, mas não usar um aplicativo de edição de imagens (como o Macromedia 
Fireworks) para alterar o arquivo de imagem para o tamanho desejado, o navegador do usuário 
poderá redimensionar a imagem quando a página for carregada.  Isso pode causar retardo no 
tempo de download da página e exibição inadequada da imagem no navegador do usuário.  
Para reduzir o tempo de download e garantir que todas as instâncias de uma imagem sejam 
exibidas com o mesmo tamanho, utilize um aplicativo de edição de imagens para 
redimensioná-las.

Para redimensionar visualmente um elemento:

1. Selecione o elemento (por exemplo, uma imagem ou filme Shockwave) na janela do 
documento.

As alças de redimensionamento são exibidas na parte inferior, no lado direito do elemento 
e no canto inferior direito. Se as alças de redimensionamento não forem exibidas, clique 
fora do elemento a ser redimensionado e, em seguida, na tag apropriada no seletor de tags 
para selecionar o elemento.

2. Redimensione o elemento, seguindo um dos procedimentos abaixo:

■ Para ajustar a largura do elemento, arraste a alça de seleção no lado direito.
■ Para ajustar a altura do elemento, arraste a alça de seleção da parte inferior.
■ Para ajustar a largura e a altura do elemento simultaneamente, arraste a alça de seleção 

do canto.
■ Pressione a tecla Shift e arraste a alça de seleção, localizada no canto do elemento, para 

preservar suas proporções (largura e altura) ao ajustar suas dimensões.
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Os elementos podem ser redimensionados visualmente até um mínimo de 8 pixels por 8. Para 
ajustar a largura e a altura de um elemento a um tamanho menor (por exemplo, 1 pixel por 1), 
utilize o Property inspector para digitar um valor numérico.

Para retornar um elemento redimensionado às suas dimensões originais, exclua os valores nos 
campos W (largura) e H (altura) no Property inspector, ou clique no botão Reset Size 
(Redefinir tamanho).  

Para reverter uma imagem para seu tamanho original:

■ Clique no botão Reset size (Redefinir tamanho) no Property inspector da imagem. 

Para fazer reamostragem de uma imagem redimensionada:

1. Redimensione a imagem como descrito acima. 

2. Clique no botão Resample (Fazer reamostragem) no Property inspector da imagem.

Tópicos relacionados
■ “Editar imagens no Dreamweaver” na página 446

Cortar uma imagem
O Dreamweaver permite cortar (ou aparar) arquivos de imagem de bitmap. 

Para cortar um arquivo de imagem:

1. Abra a página contendo a imagem que deseja cortar, selecione a imagem e siga um 
destes procedimentos:

■ Clique no ícone Crop Tool (ferramenta Cortar) no Property inspector da imagem.
■ Selecione Modify (Modificar) > Image (Imagem)> Crop (Cortar).
São mostradas alças ao redor da imagem selecionada.

2. Mova essas alças até que a caixa delimitadora esteja ao redor da área da imagem que deseja 
manter.

N
O

T
A

Você não pode fazer reamostragem de alocadores de espaço de imagem ou 
elementos que não sejam imagens de bitmap. 

N
O

T
A

Quando você corta uma imagem utilizando o Dreamweaver, o arquivo de origem da 
imagem é alterado no disco. Por isso, é recomendável manter uma cópia de backup do 
arquivo de imagem, caso precise reverter à imagem original. 
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3. Clique duas vezes no interior da caixa delimitadora ou pressione a tecla Enter para ajustar 
a seleção.

Uma caixa de diálogo informa que o arquivo de imagem que você está modificando será 
alterado em disco. Clique em OK. 
Cada pixel do bitmap selecionado que esteja fora da caixa delimitadora é removido, mas os 
outros objetos da imagem são mantidos. 

4. Visualize a imagem para garantir que ela atende as suas expectativas. 

Para desfazer os efeitos do comando cortar:

■ Selecione Edit (Editar) > Undo Crop (Desfazer cortar) para reverter à imagem original.
Você pode desfazer o comando Crop (Cortar) (e reverter para o arquivo original de 
imagem) somente antes de fechar o Dreamweaver, ou ao editar o arquivo em um 
aplicativo externo de edição de imagem. 

Tópicos relacionados
■ “Editar imagens no Dreamweaver” na página 446
■ “Ajustar o brilho e o contraste de uma imagem” na página 456
■ “Definir a nitidez de uma imagem” na página 456

Usar o Fireworks para otimizar uma 
imagem
É possível otimizar imagens em suas páginas da Web dentro do Dreamweaver.  

Para otimizar uma imagem:

1. Abra a página contendo a imagem que deseja otimizar, selecione a imagem e siga um destes 
procedimentos:

■ Clique no botão Optimize in Fireworks (Otimizar no Fireworks) no Property 
inspector da imagem.

■ Selecione Modify > Image > Optimize Image in Fireworks.
A caixa de diálogo Fireworks Optimize Image (Imagem otimizada do Fireworks) é exibida.

2. Clique em OK.
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Tópicos relacionados
■ “Editar imagens no Dreamweaver” na página 446
■ “Inserir uma imagem” na página 448
■ “Cortar uma imagem” na página 454
■ “Definir a nitidez de uma imagem” na página 456

Ajustar o brilho e o contraste de uma 
imagem
Brightness/Contrast (Brilho/Contraste) modifica o brilho ou o contraste de pixels em uma 
imagem. Esse recurso afeta os realces, sombreamentos e meios-tons de uma imagem. 
Normalmente, os recursos de Brightness/Contrast são usados para corrigir imagens muito 
escuras ou muito claras.

Para ajustar o brilho e o contraste de uma imagem:

1. Abra a página contendo a imagem que deseja ajustar, selecione a imagem e siga um 
destes procedimentos:

■ Clique no botão Brightness/Contrast no Property inspector da imagem.
■ Selecione Modify > Image > Brightness/Contrast.
A caixa de diálogo Brightness/Contrast é exibida.

2. Arraste os controles deslizantes Brightness (Brilho) and Contrast (Contraste) para ajustar 
as configurações.

Os valores variam de -100 a 100. 
3. Clique em OK.

Tópicos relacionados
■ “Editar imagens no Dreamweaver” na página 446
■ “Inserir uma imagem” na página 448
■ “Cortar uma imagem” na página 454
■ “Definir a nitidez de uma imagem” na página 456

Definir a nitidez de uma imagem
O recurso Sharpening (Nitidez) aumenta o contraste de pixels em torno das extremidades dos 
objetos para aumentar a definição ou nitidez da imagem. 
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Para definir a nitidez de uma imagem:

1. Abra a página contendo a imagem cuja nitidez deseja definir, selecione a imagem e siga um 
destes procedimentos:

■ Clique no botão Sharpen (Nitidez) no Property inspector da imagem.
■ Selecione Modify > Image > Sharpen.
A caixa de diálogo Sharpen (Nitidez) é exibida.

2. Para especificar o grau de nitidez a ser aplicado pelo Dreamweaver à imagem, arraste o 
controle deslizante ou insira um valor entre 0 e 10 na caixa de texto. 

À medida que ajusta a nitidez da imagem na caixa de diálogo Sharpness (Nitidez), você 
pode visualizar a alteração na imagem.

3. Clique em OK.

4. Para salvar as alterações, selecione File (Arquivo)  >  Save (Salvar), ou reverta a ação 
selecionando Edit (Editar) > Undo Sharpen More (Desfazer mais nitidez).

Para desfazer os efeitos do comando Sharpen:

■ Selecione Edit (Editar) > Undo Sharpen (Desfazer nitidez) para reverter à imagem 
original.
É possível desfazer o efeito do comando Sharpen (Nitidez) (e reverter para o arquivo de 
imagem original) somente antes de salvar a página contendo a imagem. Após salvar a 
página, as alterações feitas na imagem serão permanentemente salvas.

Tópicos relacionados
■ “Editar imagens no Dreamweaver” na página 446
■ “Cortar uma imagem” na página 454
■ “Ajustar o brilho e o contraste de uma imagem” na página 456

Criar uma imagem cambiável
É possível inserir imagens cambiáveis na sua página. Uma imagem cambiável é aquela que, 
exibida em um navegador, é alterada quando o ponteiro do mouse é movido sobre ela. 

Antes de iniciar, obtenha um ou mais pares de imagens cambiáveis. Para criar uma imagem 
cambiável com dois arquivos de imagem: a imagem primária (exibida quando a página for 
carregada pela primeira vez) e a imagem secundária (que será exibida quando o cursor for 
deslizado sobre a imagem primária). Ambas as imagens em uma imagem cambiável devem ter 
o mesmo tamanho. Caso contrário, o Dreamweaver redimensionará automaticamente a 
segunda imagem para que corresponda às propriedades da primeira imagem.
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As imagens cambiáveis são automaticamente definidas para responder ao evento 
onMouseOver.  Para obter informações sobre a definição de uma imagem que responda a um 
evento diferente (um clique do mouse, por exemplo) ou sobre a edição de uma imagem 
cambiável para que exiba uma imagem diferente, veja “Swap Image (Trocar imagem)” na 
página 577.

Para criar uma imagem cambiável:

1. Na janela do documento, coloque o ponto de inserção no local onde deverá ser exibida a 
imagem cambiável.

2. Insira a imagem cambiável por meio de um destes métodos:

■ Na barra Insert, selecione Common e clique no ícone de  imagem cambiável.
■ Na barra Insert, selecione Common e arraste o ícone de  imagem cambiável até o local 

desejado na janela do documento.
■ Selecione Insert (Inserir) > Interactive Images (Imagens interativas) > Rollover Image 

(Imagem cambiável).
A caixa de diálogo Insert Rollover Image (Inserir imagem cambiável) é exibida.

3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

5. Selecione File (Arquivo) > Preview in Browser (Visualizar no navegador) ou pressione a 
tecla F12.

Não é possível ver o efeito de uma imagem cambiável na visualização do projeto. 
6. No navegador, passe o cursor sobre a imagem original. 

A exibição pode alternar para a imagem cambiável.

Tópicos relacionados
■ “Inserir uma barra de navegação” na página 486

Usar um editor de imagens externo
No Dreamweaver, é possível abrir uma imagem selecionada em um editor de imagens externo. 
Ao retornar para o Dreamweaver, após salvar o arquivo de imagem editado, as alterações feitas 
na imagem estarão visíveis na janela do documento.

É possível configurar o Fireworks como o seu editor externo primário. Para obter mais 
informações, consulte “Trabalhar com o Fireworks” na página 499.
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Para iniciar o editor de imagens externo, siga um destes procedimentos: 

■ Clique duas vezes nas imagens a serem editadas.
■ Na imagem a ser editada, clique com o botão direito (no Windows), ou mantenha a tecla 

Control pressionada e clique (no Macintosh). Em seguida, selecione Edit With (Editar 
com) >Browse (Procurar).

■ Selecione a imagem a ser editada e clique em Edit no Property inspector.
■ No painel Site, clique duas vezes no arquivo de imagem para iniciar o editor de imagens 

primário. Se nenhum editor de imagens tiver sido especificado, o Dreamweaver iniciará o  
editor padrão para esse tipo de arquivo.

Caso a imagem não apareça atualizada após retornar à janela do Dreamweaver, selecione a 
imagem e, em seguida, clique no botão Refresh (Atualizar) no Property inspector.

Tópicos relacionados
■ “Especificar o editor a iniciar usando o Dreamweaver” na página 522

Aplicar comportamentos a imagens
É possível aplicar qualquer comportamento disponível a uma imagem ou ponto ativo de 
imagem. Quando um comportamento for aplicado a um ponto ativo, Dreamweaver inserirá o 
código-fonte HTML na tag area. Três comportamentos se aplicam especificamente às 
imagens: Preload Images (Carregar imagens previamente), Swap Image (Trocar imagem) e 
Swap Image Restore (Restaurar troca de imagem). 
Preload Images (Carregar imagens previamente): carrega imagens que não são exibidas na 
página imediatamente (como as que serão permutadas com comportamentos, camadas ou 
JavaScript) no cache do navegador. Esse processo evita os atrasos causados pelo download 
quando as imagens tiverem de ser exibidas. Consulte “Preload Images (Pré-carregar as 
imagens)” na página 564.

Swap Image (Trocar imagem): alterna de uma imagem para outra, modificando o atributo 
SRC da tag img. Utilize esta ação para criar botões cambiáveis e outros efeitos em imagens 
(inclusive a troca simultânea de mais de uma imagem). Consulte “Swap Image (Trocar 
imagem)” na página 577.
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Quando uma imagem for aberta no painel Site (Site), os recursos de integração do 
Fireworks descritos acima não estarão em vigor e o Fireworks não abrirá o arquivo 
PNG original. Para utilizar os recursos de integração do Fireworks, abra imagens na 
janela do documento.
Aplicar comportamentos a imagens 459



         
Swap Image Restore (Restaurar troca de imagem): restaura o último conjunto de imagens 
permutadas para seus arquivos de origem anteriores. Por padrão, essa ação será adicionada 
automaticamente, sempre que for anexada a ação Swap Image (Trocar imagem) a um objeto. 
Não será necessário selecioná-la manualmente. Consulte “Swap Image Restore (Restaurar 
troca de imagem)” na página 578.

Também é possível utilizar comportamentos para criar sistemas de navegação mais 
sofisticados, como uma barra de navegação ou um menu de salto (veja “Usar as barras de 
navegação” na página 486 e “Inserir menus de salto” na página 483).
460 Capítulo 14:  Inserir imagens



         

15

CAPÍTULO 15

Links e navegação
Após criar um site do Macromedia Dreamweaver 8 para armazenar documentos do seu site e 
criar as páginas HTML, você poderá definir conexões entre seus documentos e 
outros documentos.

O Dreamweaver oferece diversas formas de criar links de hipertexto para documentos, 
imagens, arquivos de multimídia ou softwares de download. É possível criar links para 
qualquer texto ou imagem, em qualquer parte de um documento, mesmo texto ou imagens 
localizados em um título, lista, tabela, camada ou quadro.

Para obter uma representação visual de como os arquivos são vinculados, utilize o mapa do 
site. Nesse mapa, é possível adicionar novos documentos ao seu site, criar e remover links de 
documento e verificar links para arquivos dependentes. Para obter mais informações, consulte 
“Exibir um mapa de site” na página 138.

Há várias maneiras diferentes de criar e gerenciar os links. Alguns designers da Web preferem 
criar links para páginas ou arquivos que ainda não existam à medida que trabalham. Outros 
acham mais conveniente criar primeiro todos os arquivos e páginas e então adicionar os links. 
Outra maneira de gerenciar os links é criando páginas "alocadoras de espaço", que 
representam o arquivo final e permitem adicionar e verificar links rapidamente, antes das 
páginas serem realmente concluídas. Para obter informações sobre como verificar links, 
consulte“Verificar links rompidos, externos e órfãos” na página 491.

Este capítulo contém as seguintes seções:
Localizações e caminhos dos documentos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .462

Menus de salto  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .465

Barras de navegação. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .466

Sobre mapas de imagens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .467

Criar links . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .467

Gerenciar links. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .479

Inserir menus de salto . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .483

Usar as barras de navegação. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .486

Usar mapas de imagens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .488
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Anexar comportamentos JavaScript aos links  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 491

Verificar links rompidos, externos e órfãos. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 491

Corrigir links rompidos  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 493

Abrir documentos vinculados no Dreamweaver . . . . . . . . . . . . . . . . . . . . . . . . . . . . 495

Localizações e caminhos dos 
documentos
Ao criar links, é essencial compreender o caminho de arquivo entre o documento do qual 
parte o link e o que está sendo vinculado.

Cada página da Web tem um endereço único chamado URL - Uniform Resource Locator 
(Localizador de recursos uniforme). Para mais informações sobre URLs, consulte o site da 
World Wide Web Consortium na Web sobre atribuição de nomes e endereços, www.w3.org/
Addressing/.

Contudo, quando é criado um link local (entre dois documentos no mesmo site), 
normalmente, a URL inteira do documento que está sendo vinculado não é especificada; em 
vez disso, é indicado um caminho relativo ao documento atual ou à pasta raiz do site. 

Existem três tipos de caminhos de links:

■ Caminhos absolutos (por exemplo: http://www.macromedia.com/support/dreamweaver/
contents.html).  Para obter mais informações, consulte “Caminhos absolutos” na 
página 462.

■ Caminhos relativos a documento (por exemplo: dreamweaver/contents.html).  Para obter 
mais informações, consulte “Caminhos relativos a documentos” na página 463.

■ Caminhos relativos à raiz do site (por exemplo: /support/dreamweaver/contents.html).  
Para obter mais informações, consulte “Caminhos relativos à raiz do site” na página 464.

Com o Dreamweaver, é possível selecionar facilmente o tipo de caminho do documento para 
os links (consulte “Vincular arquivos e documentos” na página 468).

Caminhos absolutos
Caminhos absolutos fornecem o URL completo do documento vinculado, inclusive 
o protocolo a ser utilizado (normalmente http:// para as páginas da Web). Por exemplo: http:/
/www.macromedia.com/support/dreamweaver/contents.html é um caminho absoluto. 

N
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É melhor utilizar o tipo de link de sua preferência e que estiver mais acostumado, tanto 
relativo ao documento quanto ao site. A busca de links, ao contrário da digitação de 
caminhos, garante que o caminho inserido estará sempre correto.
462 Capítulo 15:  Links e navegação

http://www.w3.org/Addressing/
http://www.w3.org/Addressing/


         
Utilize um caminho absoluto ao criar um link para um documento em outro servidor. Os 
links de caminho absoluto também podem ser utilizados para os links locais (a documentos no 
mesmo site), mas essa abordagem não é recomendada; se o site for deslocado para outro 
domínio, todos os seus links de caminho absoluto irão se partir. Além disso, a utilização de 
caminhos relativos para os links locais possibilita maior flexibilidade quando for necessário 
mover os arquivos no site.

Caminhos relativos a documentos
Caminhos relativos a documentos são os mais apropriados para os links locais na maioria dos 
sites da Web. Eles são particularmente úteis quando o documento atual e o vinculado 
estiverem na mesma pasta, e possivelmente permanecerão juntos. O caminho relativo também 
pode ser usado para criar um link para um documento em outra pasta. Para isso, especifique o 
caminho através de toda a hierarquia de pastas, desde o documento atual até o vinculado. 

Na especificação desse caminho, não consta a parte da URL absoluta, que é a mesma para 
ambos os documentos. É fornecido apenas o segmento do caminho que é diferente. 

Por exemplo, suponha que o site tenha esta estrutura:
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Ao inserir imagens (mas não links): se for utilizado um caminho absoluto a uma imagem 
que resida em um servidor remoto e que não esteja disponível no disco rígido local, não 
será possível exibi-la na janela do documento. Em vez disso, o documento deve ser 
visualizado em um navegador. Se for possível, utilize os caminhos relativos a documento 
ou à raiz do site para as imagens. Para obter mais informações, consulte “Inserir uma 
imagem” na página 448.
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Você pode criar links de contents.html para outros arquivos da seguinte forma:

■ Ao criar um link de contents.html para hours.html (ambos os arquivos estão na mesma 
pasta), o caminho relativo é o nome do arquivo: hours.html.

■ Para vincular a tips.html (na subpasta chamada resources), utilize o caminho relativo 
resources/tips.html.
Cada barra inclinada (/) representa mover um nível abaixo na hierarquia de pastas.

■ Para vincular a index.html (na pasta pai, um nível acima de contents.html), utilize o 
caminho relativo ../index.html.
Cada ../ representa mover um nível acima na hierarquia de pastas.

■ Para vincular a catalog.html (em uma subpasta da pasta pai), utilize o caminho relativo ../
products/catalog.html.
A ../ move um nível acima em direção à pasta pai; products/ move um nível para baixo na 
subpasta products.

Quando um grupo de arquivos for movido em conjunto — por exemplo: quando uma pasta 
for transferida inteira, de maneira que os arquivos dentro dela mantenham os mesmos 
caminhos relativos entre si — os links relativos a documento não precisarão ser atualizados 
entre esses arquivos. Contudo, quando um arquivo individual que contém links relativos a 
documento ou que está vinculado por esse mesmo tipo de ligação for movido, torna-se 
absolutamente necessário atualizar esses links. (Se os arquivos forem movidos ou renomeados 
usando o painel Files, o Dreamweaver atualizará automaticamente todos os links relevantes).

Tópicos relacionados
■ “Definir o caminho relativo de novos links” na página 473

Caminhos relativos à raiz do site
Caminhos relativos à raiz do site fornecem o caminho completo desde a pasta raiz do site até 
um documento. Pode ser conveniente utilizar esses tipos de caminhos ao trabalhar em um site 
grande da Web, que use vários servidores, ou um servidor que hospede diversos sites 
diferentes. Contudo, se você não estiver familiarizado com esse tipo de caminho, é 
recomendável continuar utilizando os caminhos relativos a documento.

Um caminho relativo à raiz do site inicia com uma barra inclinada para a direita, que 
representa a pasta raiz do site. Por exemplo: /support/tips.html é um caminho relativo à raiz 
do site para um arquivo (tips.html) na subpasta support, dentro da pasta raiz do site.
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Um caminho relativo à raiz do site é, normalmente, o melhor modo de especificar links em 
um site da Web, no qual os arquivos HTML precisam ser movidos com freqüência de uma 
pasta para outra. Quando um documento que contém links relativos à raiz for movido, não é 
necessário alterá-los, por exemplo: quando os arquivos HTML utilizam links relativos à raiz 
para os arquivos dependentes (como as imagens), se um arquivo HTML for movido, os seus 
links dos arquivos dependentes ainda serão válidos.

Contudo, quando os links dos documentos forem relativos à raiz e estes forem movidos ou 
renomeados, é absolutamente necessário atualizar esses links, mesmo que os caminhos dos 
documentos relativos entre si não tenham sido alterados. Por exemplo: se uma pasta for 
movida, todos os links relativos à raiz para os arquivos nessa pasta devem ser atualizados. (Se 
os arquivos forem movidos ou renomeados usando o painel Files, o Dreamweaver atualizará 
automaticamente todos os links relevantes).

Tópicos relacionados
■ “Definir o caminho relativo de novos links” na página 473

Menus de salto
Um menu de salto é um menu pop-up em um documento, visível aos usuários do site, que 
lista as opções para criar links em documentos e arquivos. Podem ser criados links a 
documentos no seu site da Web, a documentos em outros sites da Web, links de correio 
eletrônico, links a imagens ou a qualquer tipo de arquivo que possa ser aberto em um 
navegador.

Um menu de salto contém três componentes básicos:

■ (Opcional) Um aviso de seleção no menu, como instruções ou uma descrição da categoria 
dos itens do menu. Por exemplo: “Escolha uma opção”.

■ (Obrigatório) Uma lista de itens de menu vinculados: um usuário seleciona uma opção e o 
documento ou arquivo vinculado a ela é aberto.

■ (Opcional) Um botão Go (Ir).

Tópicos relacionados
■ “Inserir menus de salto” na página 483
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Barras de navegação
Uma barra de navegação é composta por uma imagem (ou um conjunto de imagens), que se 
altera de acordo nas ações do usuário. As barras de navegação são, com freqüência, um modo 
fácil de se mover entre as páginas e arquivos de um site.

Um elemento da barra de navegação pode apresentar quatro estados:

■ Up (Ativa): a imagem que aparece quando o usuário ainda não clicou ou interagiu com o 
elemento. 
Por exemplo: o elemento nesse estado parece que não foi clicado.

■ Over (Sobreposta): a imagem que aparecerá quando o cursor for movido sobre uma 
imagem ativa. A aparência do elemento é alterada (por exemplo: poderá ficar mais clara) 
para informar aos usuários que eles não podem interagir com o elemento.

■ Down (Inativa): a imagem que aparece após o clique no elemento. 
Por exemplo: quando um usuário clica em um elemento, uma nova página é carregada e a 
barra de navegação ainda estará em exibição, mas o elemento clicado estará escurecido 
para mostrar que foi selecionado.

■ Over While Down (Imagem sobreposta enquanto inativa): a imagem que aparecerá 
quando o cursor for deslizado sobre a imagem inativa, após o clique do usuário. 
Por exemplo: o elemento aparece esmaecido ou cinza. Esse estado pode ser utilizado como 
uma informação visual aos usuários de que esse elemento não pode ser clicado novamente 
enquanto estiverem nesta parte do site.

Não é necessário incluir imagens na barra de navegação para todos os quatro estados; por 
exemplo: podem ser necessários apenas os estados Up (Ativa) e Down (Inativa).

Tópicos relacionados
■ “Usar as barras de navegação” na página 486
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Sobre mapas de imagens
Um mapa de imagens é uma imagem que foi dividida em áreas, ou pontos ativos. Quando se 
clica em um ponto ativo, ocorre uma ação (um novo arquivo é aberto, por exemplo). 

Os mapas de imagens no lado do cliente armazenam as informações sobre o link de hipertexto 
no documento HTML e não em um arquivo de mapa separado, como fazem os mapas de 
imagens do servidor. Quando um visitante do site clica em um ponto ativo na imagem, a URL 
a ele associada é enviada diretamente ao servidor. Isso torna os mapas de imagens do lado do 
cliente mais rápidos que os do servidor, porque o servidor não precisará interpretar onde o 
usuário clicou. Os mapas de imagens no lado do cliente são compatíveis com o Netscape 
Navigator 2.0 e posteriores, NCSA Mosaic 2.1 e 3.0 e com todas as versões do Microsoft 
Internet Explorer.

O Dreamweaver não altera as referências de mapas de imagens do servidor nos documentos 
existentes; é possível utilizar mapas de imagens de clientes e do servidor em um mesmo 
documento. Contudo, os navegadores que oferecem suporte a ambos os tipos de mapas de 
imagens priorizam os do lado do cliente. Para incluir um mapa de imagens do lado do 
servidor em um documento, é necessário gravar o código HTML adequado.

Tópicos relacionados
■ “Usar mapas de imagens” na página 488

Criar links
Podem ser criados diversos tipos de links em um documento.

■ Um link a outro documento ou arquivo, como um arquivo de imagem, filme, PDF ou 
de som.  Consulte “Vincular arquivos e documentos” na página 468.

■ Um link de âncora com nome, que salta para uma localização específica em um 
documento.  Consulte “Criar um link para um local específico de um documento” na 
página 475.

■ Um link de correio eletrônico, que cria uma nova mensagem com o endereço do 
destinatário já preenchido. Consulte “Criar um link de correio eletrônico” na página 476.

■ Os links nulos e de script, que permitem anexar comportamentos a um objeto ou criar um 
link que execute código JavaScript.  Consulte “Criar links nulos e de script” na 
página 477.
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Antes de criar os links, você deve compreender como funcionam os caminhos 
relativos ao documento, os caminhos relativos à raiz do site e os caminhos 
absolutos. Consulte “Localizações e caminhos dos documentos” na página 462.
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Vincular arquivos e documentos
Utilize o Property inspector e o ícone do indicador de arquivos para criar links de uma 
imagem, objeto ou texto a outro documento ou arquivo. Para obter mais informações sobre 
como usar o mapa do site para criar links, consulte “Modificar links no mapa do site” na 
página 481.

O Dreamweaver cria links com outras páginas do site usando caminhos relativos a 
documentos. Também é possível instruir o Dreamweaver a criar novos links utilizando 
caminhos relativos à raiz do site.

Esta seção contém os tópicos a seguir:

■ “Vincular documentos usando o Property inspector (Inspetor de propriedades)” na 
página 468

■ “Vincular documentos usando o ícone Point-to-File (Indicador de arquivos)” na 
página 470

■ “Criar links para documentos usando o mapa do site” na página 471
■ “Utilizar o comando Hyperlink” na página 472
■ “Definir o caminho relativo de novos links” na página 473

Tópicos relacionados
■ “Localizações e caminhos dos documentos” na página 462

Vincular documentos usando o Property inspector (Inspetor 
de propriedades)
É possível usar o ícone de pasta do Property inspector ou a caixa de texto Link para criar links 
de uma imagem, um objeto ou texto para outro documento ou arquivo. 

Para vincular documentos utilizando o ícone de pasta do Property inspector ou 
a caixa de texto Link:

1. Selecione o texto ou uma imagem na visualização do projeto, na janela do documento.
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Salve sempre um novo arquivo antes de criar um caminho relativo a documento, já que 
esse caminho não será válido sem um ponto de partida definido. Se você criar um 
caminho relativo a documento antes de salvar o arquivo, o Dreamweaver utilizará 
temporariamente um caminho absoluto iniciado por file://, até que o arquivo seja salvo e, 
em seguida, o programa converterá o caminho file:// em um caminho relativo.
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2. Abra o Property inspector (Window > Properties) e siga um destes procedimentos:

■ Clique no ícone pasta, à direita da caixa de texto Link, para procurar e selecionar um 
arquivo.
O caminho para o documento vinculado é exibido na caixa de texto URL. Utilize o 
menu pop-up Relative To (Relativo a), na caixa de diálogo Select HTML File 
(Selecionar arquivo HTML), para decidir se o caminho será relativo ao documento ou 
à raiz e, em seguida, clique em Select (Selecionar). O tipo de caminho selecionado se 
aplica apenas ao link atual. Para obter mais informações, consulte “Localizações e 
caminhos dos documentos” na página 462.
É possível alterar a definição padrão da caixa de texto Relative To para o site. Para 
obter mais informações, consulte “Definir o caminho relativo de novos links” na 
página 473.

■ Digite o caminho e nome do arquivo do documento no campo Link.
Para criar um link a um documento no site, digite um caminho relativo a documento 
ou à raiz do site. Para criar um link para um documento fora do site, digite um 
caminho absoluto que inclua o protocolo (por exemplo: http://). Esse procedimento 
pode ser utilizado para digitar um link a um arquivo que ainda não foi criado.

Em caminhos relativos, omita a parte do URL, que é o mesmo para ambos os 
documentos, o documento atual e aquele para o qual está criando o link. Se o arquivo para 
o qual você está criando um link estiver contido na mesma pasta que o documento atual, 
digite o nome do arquivo; se estiver em uma subpasta, digite o nome da subpasta seguido 
de uma barra inclinada (/) e do nome do arquivo; se estiver na pasta pai, preceda o nome 
do arquivo com ../ (onde “..” significa “um nível acima na hierarquia de pastas”).

3. No menu pop-up Target (Destino), selecione um local para abrir o documento.

Para que o documento vinculado apareça em um local diferente da janela ou quadro atual, 
selecione uma opção no menu pop-up Target (Destino) no Property inspector.
■ _blank carrega o documento vinculado em uma janela nova e sem nome do 

navegador.
■ _parent carrega o documento vinculado na janela pai ou janela principal do quadro 

que contém o link. Se o quadro onde está o link não estiver aninhado, o documento 
vinculado será carregado na janela inteira do navegador.

■ _self carrega o documento vinculado no mesmo quadro ou janela que o link. Esse 
destino é o padrão, portanto geralmente não é necessário especificá-lo.
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■ _top carrega o documento vinculado na janela inteira do navegador, removendo, 
portanto, todos os quadros.

Vincular documentos usando o ícone Point-to-File (Indicador 
de arquivos)
O ícone Point-to-File permite criar links a partir de imagens, objetos ou texto para outro 
documento ou arquivo. 

Para vincular documentos usando o ícone Point-to-File:

1. Selecione o texto ou uma imagem na visualização do projeto, na janela do documento.

2. Arraste o ícone do indicador de arquivos, à direita da caixa de texto Link no Property 
inspector para outro documento aberto, para uma âncora visível em um documento aberto 
ou para um documento no painel Files (Arquivos).

O campo Link será atualizado para mostrar o link.

3. Solte o botão do mouse.

Para criar um link a partir de uma seleção em um documento aberto:

1. Selecione o texto na janela do documento.

2. Mantenha a tecla Shift pressionada e arraste a partir da seleção.

O ícone do indicador de arquivos aparecerá à medida que o cursor for arrastado.
3. Aponte para outro documento aberto, uma âncora visível de um documento aberto ou um 

documento no painel Files.

4. Solte o botão do mouse.

D
IC

A

Se todos os links da página forem definidos para o mesmo destino, você poderá 
especificar esse destino uma única vez selecionando Insert (Inserir) > Head Tag 
(Tag de cabeçalho) > Base e selecionando as informações do destino. Para obter 
informações sobre como designar quadros, consulte “Controlar o conteúdo de 
quadros com links” na página 321.

N
O

T
A

Pode ser estabelecido um vínculo a um documento aberto apenas quando os seus 
documentos não estiverem maximizados na janela do documento. Quando se indica 
um documento, ele é movido para o primeiro plano da tela durante a seleção.

N
O

T
A

Pode ser estabelecido um vínculo a um documento aberto apenas quando os seus 
documentos não estiverem maximizados na janela do documento. Quando se indica 
um documento, ele é movido para o primeiro plano da tela durante a seleção.
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Tópicos relacionados
■ “Definir o caminho relativo de novos links” na página 473

Criar links para documentos usando o mapa do site
É possível criar links usando o mapa do site. Os links criados serão colocados no final dos 
arquivos HTML selecionados, o que possibilitará a rápida criação de links em todo o site.

Para criar um link a documentos usando o mapa do site e o ícone do indicador 
de arquivos:

1. Expanda o painel Files e, em seguida, exiba as visualizações Site Files (Arquivos do site) e 
Site Map (Mapa do site). Para isso,  pressione o ícone de mapa do site enquanto seleciona 
Map and Files (Mapa e arquivos).

2. Selecione um arquivo HTML no mapa do site.

O ícone do indicador de arquivos aparecerá ao lado do arquivo.
3. Arraste o ícone do indicador de arquivos e indique outro arquivo no mapa do site ou um 

arquivo local na visualização dos arquivos do site.

4. Solte o botão do mouse.

Um link de hipertexto com o nome do arquivo vinculado será colocado na parte inferior 
do arquivo HTML selecionado. Esse método funciona bem quando um site está sendo 
construído e se deseja criar links no site inteiro rapidamente. 

Para criar links entre documentos no mapa do site, siga um destes 
procedimentos:

■ Arraste uma página do Windows Explorer ou do Macintosh Finder e solte-a em uma 
página do mapa do site.

■ No mapa do site, marque uma página HTML e depois selecione Site > Link to Existing 
File (Vincular a um arquivo existente) (Windows), ou Site > Site Map View (Visualização 
do mapa do site) > Link to Existing File (Macintosh) ou ainda, selecione Link to Existing 
File no menu contextual.

■ No mapa do site, marque uma página HTML e depois selecione Site > Link to New File 
(Link a um novo arquivo) (no Windows), ou Site > Site Map View (Visualização do mapa 
do site) > Link to New File (Link a um novo arquivo) (no Macintosh), ou escolha Link to 
New File (Link a um novo arquivo) no menu contextual.

N
O

T
A

Certifique-se de que o painel Files (Arquivos) esteja encaixado e, em seguida, clique 
na seta Expand (Expandir). Mantenha pressionado o botão Site Map (Mapa do site) 
e, em seguida, selecione Files and Map (Arquivos e mapa).
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Tópicos relacionados
■ “Definir o caminho relativo de novos links” na página 473

Utilizar o comando Hyperlink
O comando Hyperlink permite criar um link a partir de um texto para uma imagem, um 
objeto ou para outro documento ou arquivo.

Para adicionar um hiperlink utilizando o comando Hyperlink:

1. Coloque o ponto de inserção onde o hiperlink deve ser inserido no documento.

2. Siga um destes procedimentos para exibir a caixa de diálogo Insert Hyperlink:

■ Selecione Insert (Inserir) > Hyperlink.
■ Na categoria Common (Comuns) da barra Insert (Inserir), clique no botão Hyperlink.
Aparecerá a caixa de diálogo Hyperlink.

3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

Tópicos relacionados
■ “Modificar links no mapa do site” na página 481
■ “Criar um link para um local específico de um documento” na página 475
■ “Criar um link de correio eletrônico” na página 476
■ “Criar links nulos e de script” na página 477
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Definir o caminho relativo de novos links
Por padrão, o Dreamweaver cria links para outras páginas do site utilizando caminhos 
relativos a documentos. Mas também é possível instruir o Dreamweaver a criar links para 
caminhos relativos à raiz do site. Para obter mais informações sobre caminhos relativos, 
consulte “Localizações e caminhos dos documentos” na página 462.

Para utilizar os caminhos relativos à raiz do site, primeiro é preciso definir um site local no 
Dreamweaver escolhendo uma pasta raiz local que seja equivalente à raiz do documento em 
um servidor (consulte “Configurar um novo site do Dreamweaver” na página 90). O 
Dreamweaver utiliza essa pasta para determinar os caminhos relativos à raiz do site para os 
arquivos.

Você define o caminho relativo de novos links na caixa de diálogo Site Definition (Definição 
do site).

Para definir o caminho relativo de novos links:

1. Selecione Site > Manage Sites (Gerenciar Sites). 

A caixa de diálogo Manage Sites é exibida.
2. Clique duas vezes no site na lista. 

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Clique na guia Advanced (Avançado) se as definições avançadas não estiverem sendo 

exibidas. 

A guia Advanced da caixa de diálogo Site Definition exibirá as opções da categoria Local 
Info (Informações locais).

4. Defina o caminho relativo de novos links selecionando a opção Document or Site Root 
(Documento ou raiz do site).
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A alteração desta definição não converterá o caminho dos links existentes quando você 
clicar em OK. Essa definição só será aplicada aos novos links que você criar com o 
Dreamweaver.

5. Para caminhos relativos à raiz do site, digite a URL a ser utilizada pelo site da Web 
finalizado na caixa de texto HTTP Address (Endereço HTTP).

O Dreamweaver utiliza esse endereço para assegurar que os links relativos à raiz funcionem 
no servidor remoto, que pode ter uma raiz do site diferente. Por exemplo, se você estiver 
criando um vínculo para um arquivo de imagem localizado na pasta C:\Vendas\imagens\ 
do seu disco rígido (onde Vendas é sua pasta raiz local), e a URL do site finalizado for 
http://www.meusite.com/AplVendas/ (onde AplVendas é sua pasta raiz remota), ao digitar 
a URL na caixa de texto HTTP Address ficará assegurado que o caminho para o arquivo 
vinculado no servidor remoto será /AplVendas/imagens/.

6. Clique em OK.

A nova definição de caminho se aplica apenas ao site atual.

Tópicos relacionados
■ “Localizações e caminhos dos documentos” na página 462
■ “Utilizar as definições avançadas para configurar um site do Dreamweaver” na página 91

N
O

T
A

O conteúdo vinculado a um caminho relativo à raiz não aparece quando os 
documentos são visualizados em um navegador local, a menos que você especifique 
um servidor de teste ou selecione a opção Preview Using Temporary File (Visualizar 
utilizando arquivo temporário) em Edit (Editar)> Preferences (Preferências)> Preview 
in Browser (Visualizador no navegador). Isso se deve ao fato de que os navegadores 
não reconhecem a raiz do site, como os servidores reconhecem. (Consulte 
“Visualizar e testar páginas em navegadores” na página 399.)

D
IC

A

Para visualizar o conteúdo vinculado a caminhos relativos à raiz, coloque o arquivo 
em um servidor remoto e, em seguida, selecione File (Arquivo) > Preview in Browser 
(Visualizar no navegador) para visualizá-lo (consulte “Caminhos relativos à raiz do 
site” na página 464).

N
O

T
A

Em versões anteriores, o Dreamweaver falhava ao anexar a pasta raiz remota 
correta, fazendo com que as páginas falhassem na execução.
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Criar um link para um local específico de um 
documento 
O Property inspector pode ser usado para criar um link para uma determinada seção de um 
documento. Para isso, crie primeiro âncoras com nome. Estas permitem definir marcadores 
em um documento e são colocadas, com freqüência, em um tópico específico ou no alto do 
documento. Podem ser criados links para essas âncoras com nome, que levam rapidamente o 
visitante até a posição especificada.

A criação de um link a uma âncora com nome é um processo em duas etapas. Primeiro, crie 
uma âncora com nome e, em seguida, estabeleça um link para essa âncora.

Para criar uma âncora com nome:

1. Na visualização do projeto, na janela do documento, posicione o ponto de inserção no local 
onde deseja inserir a âncora com nome.

2. Siga um dos procedimentos abaixo:

■ Selecione Insert (Inserir) > Named Anchor (Âncora com nome).
■ Pressione as teclas Control, Alt e A (no Windows), ou Command, Option e A (no 

Macintosh).
■ Na categoria Common da barra Insert, clique no botão Named Anchor.
Será exibida a caixa de diálogo Named Anchor (Âncora com nome).

3. Na caixa de texto Anchor Name, digite um nome para a âncora, e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
O marcador da âncora aparecerá no ponto de inserção.

Para criar um link para uma âncora com nome:

1. Na visualização do projeto, na janela do documento, selecione um texto ou uma imagem 
da qual será criado um link.

N
O

T
A

Se o marcador da âncora não estiver visível, selecione View (Exibir) > Visual Aids 
(Auxílios Visuais) > Invisible Elements (Elementos invisíveis).
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2. No campo Link, no Property inspector, digite o caractere # e o nome da âncora. Por 
exemplo:

■ Para criar um link para uma âncora que possua o nome “alto” no documento atual, 
digite #alto.

■ Para criar um link para uma âncora que possua o nome “alto” em outro documento na 
mesma pasta, digite nomedoarquivo.html#alto.

Para criar um link para uma âncora usando o método de indicação de 
arquivos:

1. Abra o documento que contém a âncora com nome escolhida.

2. Na visualização do projeto, na janela do documento, selecione um texto ou uma imagem 
da qual será criado um link. Se este for outro documento aberto, alterne para ele.

3. Siga um dos procedimentos abaixo:

■ Clique no ícone do indicador de arquivos, à direita do campo Link, no Property 
inspector, e arraste-o até a âncora que será vinculada: uma âncora no mesmo 
documento ou em outro documento aberto.

■ Pressione a tecla Shift e arraste o cursor na janela do documento, a partir do texto ou 
imagem selecionada até a âncora a ser vinculada a: uma âncora no mesmo documento 
ou em outro documento aberto.

Tópicos relacionados
■ “Vincular arquivos e documentos” na página 468
■ “Criar links nulos e de script” na página 477

Criar um link de correio eletrônico
Um link de correio eletrônico abrirá uma nova janela de mensagem (utilizando o programa de 
correio eletrônico associado ao navegador do usuário) sempre que for clicado. Na janela de 
mensagem de correio eletrônico, o campo de texto To (Para) é atualizado automaticamente 
com o endereço especificado no link de correio eletrônico.

N
O

T
A

Os nomes de âncora fazem distinção entre maiúsculas e minúsculas.

N
O

T
A

Se a âncora não estiver visível, selecione View (Exibir) > Visual Aids (Auxílios visuais) 
> Invisible Elements (Elementos invisíveis).
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Para criar um link de correio eletrônico com o comando Insert E-mail Link:

1. Na visualização do projeto, na janela do documento, coloque o ponto de inserção onde 
deverá aparecer o link de correio eletrônico, ou selecione o texto ou a imagem a ser 
mostrada neste lugar. 

2. Siga um dos procedimentos abaixo para inserir o link:

■ Selecione Insert > E-Mail Link (Inserir link de correio eletrônico).
■ Na categoria Common da barra Insert, clique no botão Insert E-mail Link.
A caixa de diálogo E-mail Link (Link de correio eletrônico) é exibida.

3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

Para criar um link de correio eletrônico usando o Property inspector:

1. Selecione o texto ou uma imagem na visualização do projeto, na janela do documento.

2. Na caixa de texto Link do Property inspector, digite mailto: seguido de um endereço de 
correio eletrônico.

Não digite espaços entre os dois pontos e o endereço eletrônico. Por exemplo: digite 
mailto:jlydon@macromedia.com.

Tópicos relacionados
■ “Criar um link para um local específico de um documento” na página 475
■ “Criar um link para um local específico de um documento” na página 475

Criar links nulos e de script
Os tipos mais comuns de links ocorrem entre documentos e âncoras com nome (consulte 
“Vincular arquivos e documentos” na página 468 e “Criar um link para um local específico de 
um documento” na página 475), embora também existam outros tipos de links.
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Um link nulo é aquele não designado. Utilize esse tipo de link para anexar comportamentos a 
objetos ou texto em uma página. Após a criação de um link nulo, a ele poderá ser anexado a 
um comportamento para permutar uma imagem ou exibir uma camada, quando o cursor for 
movido sobre o link. Para obter informações sobre como anexar comportamentos a objetos, 
consulte “Aplicação de um comportamento” na página 544.

Links de scripts executam código JavaScript ou chamam uma função JavaScript, sendo úteis 
para fornecer informações adicionais ao usuário sobre um item, sem sair da página atual da 
Web. Os links de scripts também podem ser utilizados para cálculos, validações de formulários 
e outras tarefas de processamento, quando um usuário clicar em um determinado item.

Para criar um link nulo:

1. Selecione o texto, uma imagem ou um objeto na visualização do projeto, na janela do 
documento.

2. No Property inspector, digite javascript:; (a palavra javascript, seguida de dois pontos e de 
um ponto-e-vírgula) na caixa de texto Link.

Para criar um link de script:

1. Selecione o texto, uma imagem ou um objeto na visualização do projeto, na janela do 
documento.

2. Na caixa de texto Link, no Property inspector, digite javascript: seguido de código 
JavaScript ou de uma chamada de função.

Por exemplo, digitar javascript:alert('This link leads to the index') na caixa de texto Link 
cria um link que, ao ser clicado, exibe uma caixa de alerta de JavaScript com a mensagem 
“This link leads to the index”.

Tópicos relacionados
■ “Criar um link para um local específico de um documento” na página 475
■ “Criar um link de correio eletrônico” na página 476

N
O

T
A

Como o código JavaScript aparece entre aspas duplas no HTML (assim como o 
valor do atributo href ), é necessário utilizar aspas simples no código do script ou 
preceder as aspas duplas por barras invertidas (por exemplo: \"Este link conduz 
ao índice\").
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Gerenciar links
Para evitar o surgimento de links rompidos em seu site, é possível ativar o gerenciamento de 
links, de forma que o Dreamweaver realize automaticamente as atualizações dos links sempre 
que você fizer uma alteração. Também é possível usar uma representação visual do seu site 
para modificar os links e atualizar todos os links direcionados a um arquivo específico com 
uma única alteração.

Atualizar links automaticamente
O Dreamweaver pode atualizar os links de e para um documento, sempre que este for movido 
ou renomeado em um site local. Esse recurso funciona melhor quando o site inteiro for 
armazenado (ou uma seção inteira deste) no disco local. O Dreamweaver não altera os 
arquivos na pasta remota até que os arquivos locais sejam colocados ou devolvidos ao servidor 
remoto. 

Para tornar mais rápido o processo de atualização, o Dreamweaver pode criar um arquivo de 
cache, no qual ele armazenará informações sobre todos os links da pasta local. O arquivo de 
cache atualiza-se de forma invisível, à medida que você adiciona, altera ou elimina links dos 
arquivos de seu site local.

Para ativar o gerenciamento de links no Dreamweaver:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

A caixa de diálogo Preferences (Preferências) será exibida.
2. Selecione General (Geral) na lista de categorias, à esquerda.

Serão exibidas as opções de General Preferences (Preferências gerais).
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3. Na seção Document Options (Opções do documento), selecione Always (Sempre) ou 
Prompt (Solicitar), no menu pop-up Update Links when Moving Files (Atualizar os links 
ao mover os arquivos).

Se for escolhida a opção Always (Sempre), o Dreamweaver atualizará automaticamente 
todos os links para e de um documento selecionado, sempre que este for movido ou 
renomeado. (Para obter instruções específicas sobre o que fazer quando um arquivo for 
excluído, consulte “Alterar um link no site inteiro” na página 482.) 
Quando for escolhida a opção Prompt (Solicitar), o Dreamweaver exibirá primeiramente 
uma caixa de diálogo contendo uma lista de todos os arquivos afetados pela alteração. 
Clique em Update (Atualizar) para atualizar os links nesses arquivos ou em Don't Update 
(Não atualizar) para deixá-los inalterados.

4. Clique em OK.

Para criar um arquivo de cache do site:

1. Selecione Site > Manage Sites (Gerenciar Sites).

A caixa de diálogo Edit Sites (Editar os sites) é exibida.
2. Selecione um site e, em seguida, clique em Edit (Editar).

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Clique na guia Advanced para exibir a categoria Advanced da caixa de diálogo Site 

Definition (Definição de site).

4. Selecione Local Info (Informações locais), na lista de categorias, à esquerda.

A caixa de diálogo Site Definition (Definição do site) exibirá as opções de Local Info 
(Informações locais).

5. Na categoria Local Info (Informações locais), marque a caixa de seleção Enable Cache 
(Ativar o cache).

Na primeira vez que você alterar ou excluir os links de arquivo na pasta local após inicializar o 
Dreamweaver, o Dreamweaver perguntará se você deseja carregar o cache. Se você clicar em 
Yes (Sim), o cache será carregado e o Dreamweaver atualizará todos os links associados ao 
arquivo alterado. Se escolher No (Não), as alterações poderão ser observadas no cache, porém 
este não será carregado e o Dreamweaver não atualizará os links.

É possível que o cache demore alguns minutos para ser carregado nos sites maiores; a maior 
parte deste período é gasta na comparação entre os horários dos arquivos no site local e aqueles 
registrados no cache, a fim de verificar se este está desatualizado. Se nenhum arquivo tiver sido 
alterado fora do Dreamweaver, não haverá problemas em clicar em Stop (Parar), quando o 
botão for exibido.
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Para criar novamente o cache do seu site:

■ No painel Files (Arquivos), selecione Site > Advanced (Avançado) > Recreate Site Cache 
(Recriar cache do site).

Modificar links no mapa do site 
A estrutura do site pode ser modificada no mapa do site através da inclusão, alteração 
e remoção dos links. O Dreamweaver atualiza automaticamente o mapa do site para exibir as 
alterações feitas no site.

Para alterar um link:

1. No mapa do site, selecione uma página da qual será alterado o link (para que o documento 
vinculado a esta página indique outra) e siga um dos procedimentos abaixo:

■ Escolha Site > Change Link (Alterar o link) (no Windows), ou Site > Site Map View 
(Visualização do mapa do site) > Change Link (Alterar o link) (no Macintosh). 

■ Clique com o botão direito do mouse (no Windows) ou clique com a tecla Control 
pressionada (Macintosh) e, em seguida, escolha Change Link (Alterar o link), no 
menu contextual.

2. Vá até o arquivo que o link irá indicar ou digite uma URL.

3. Clique em OK.

Para remover um link:

1. Selecione a página no mapa de sites.

2. Siga um dos procedimentos abaixo:

■ Selecione Site > Remove Link (Windows) ou Site > Site Map View > Remove Link 
(Macintosh).

■ Clique com o botão direito do mouse (Windows) ou com a tecla Control pressionada 
(Macintosh) e, em seguida, selecione Remove Link (Remover link) no menu 
de contexto. 

A remoção de um link não exclui o arquivo, mas remove o link da origem de HTML na 
página que está indicando o link.

N
O

T
A

Use o menu Site do painel Files (Arquivos).

N
O

T
A

Use o menu Site do painel Files (Arquivos).
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Para abrir a origem de um link:

1. Selecione um arquivo no mapa do site.

2. Siga um dos procedimentos abaixo:

■ Selecione Site > Open Source of Link (Abrir a origem do link) (no Windows) ou Site > 
Site Map View (Visualização do mapa do site) > Open Source of Link (Abrir a origem 
do link) (no Macintosh).

■ Clique com o botão direito do mouse (no Windows) ou clique com a tecla Control 
pressionada (Macintosh) e, em seguida, escolha Open Source of Link (Abrir a origem 
do link), no menu de contexto.

O Property inspector e o arquivo de origem que contém o link serão abertos na janela do 
documento, com o link realçado.

Tópicos relacionados
■ “Vincular arquivos e documentos” na página 468
■ “Trabalhar com um mapa visual do site” na página 137

Alterar um link no site inteiro 
Além de o Dreamweaver atualizar os links de modo automático sempre que um arquivo for 
movido ou renomeado, também é possível alterar manualmente todos os links (inclusive os de 
correio eletrônico, FTP, nulos e de scripts) para que estes indiquem outras localizações. 

Esta opção pode ser utilizada a qualquer momento (por exemplo: as palavras “os filmes deste 
mês” podem ser vinculadas a /movies/julho.html no site inteiro e, em primeiro de agosto, esses 
links devem ser alterados para indicar /movies/agosto.html), mas é particularmente útil 
quando for necessário excluir um arquivo vinculado a outros arquivos.

Para alterar um link no site inteiro:

1. Selecione um arquivo na visualização local do painel Files (Arquivos).

2. Selecione Site > Change Link Sitewide (Alterar o link no site inteiro).

N
O

T
A

Se a alteração for efetuada em um link de correio eletrônico, FTP ou script, não é 
necessário selecionar um arquivo. 
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Será exibida a caixa de diálogo Change Link Sitewide (Alterar o link no site inteiro).

3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

O Dreamweaver atualizará todos os documentos que possuam links associados ao arquivo 
selecionado, de maneira que indiquem o novo arquivo, utilizando o formato de caminho 
utilizado no documento (por exemplo: se o caminho antigo for relativo ao documento, o 
novo caminho também será deste tipo). O tipo de link, relativo ao documento ou à raiz, 
não é problema. O Dreamweaver atualizará automaticamente o link. 

Após a alteração de um link no site inteiro, o arquivo selecionado se tornará órfão (ou seja, 
nenhum arquivo na unidade local o indicará). A exclusão do mesmo não causará problemas, 
pois não romperá quaisquer links existentes no site local do Dreamweaver.

Inserir menus de salto
Os menus de salto permitem associar URLs a opções de uma lista de menu pop-up. Ao 
escolher um elemento da lista, o usuário será redirecionado (ou “saltará”) para a URL definida. 
Menus de salto são inseridos com o objeto de formulário Jump Menu (Menu de salto).

Para inserir um menu de salto: 

1. Abra um documento, em seguida coloque o ponto de inserção na janela do documento.

2. Siga um dos procedimentos abaixo:

■ Selecione Insert (Inserir) > Form (formulário) > Jump Menu (Menu de salto).
■ Na categoria Form da barra Insert, clique no botão Jump Menu.

N
O

T
A

Como todas as alterações estão ocorrendo localmente, será necessário excluir 
manualmente o arquivo órfão correspondente no site remoto e colocar ou devolver 
quaisquer arquivos nos quais tiverem ocorrido alterações nos links para que os visitantes 
do seu site possam visualizá-las.
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A caixa de diálogo Insert Jump Menu (Inserir menu de salto) é exibida.

3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

O menu de salto será exibido no documento.

Tópicos relacionados
■ “Menus de salto” na página 465
■ “Solucionar problemas nos menus de salto” na página 485

Editar itens do menu de salto
Ao editar os itens de um menu de salto, é possível alterar a ordem da lista ou o arquivo ao qual 
um item está vinculado. Também é possível adicionar, excluir ou renomear um item.

Para alterar o local em que um arquivo vinculado é aberto, para adicionar ou alterar um aviso 
de seleção no menu, deve ser utilizado o painel Behaviors (Comportamentos) (consulte “Jump 
Menu (Menu de salto)” na página 560).

Para editar um item do menu de salto com o Property inspector:

1. Caso o Property inspector esteja fechado, escolha Window (Janela) > Properties 
(Propriedades).

2. Na visualização do projeto da janela do documento, clique no objeto menu de salto para 
selecioná-lo.

Aparecerá o ícone List/Menu (lista/menu), no Property inspector.
3. No Property inspector, clique no botão List Values (Valores da lista).
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A caixa de diálogo List Values (Valores da lista) será exibida.

4. Altere os itens do menu e, em seguida, clique em OK.

Tópicos relacionados
■ “Menus de salto” na página 465
■ “Inserir menus de salto” na página 483

Solucionar problemas nos menus de salto
Depois que o usuário seleciona um item do menu de saltos, não há forma de voltar a 
selecioná-lo caso o usuário navegue de volta para aquela página, ou se a caixa de texto Open 
URL In (Abrir a URL em) especificar um quadro como destino. Há duas maneiras de 
contornar esse problema:

■ Utilize um aviso de seleção no menu, como uma categoria ou instrução do usuário, 
por exemplo: “Escolha uma opção”. O aviso de seleção no menu é escolhido de novo, 
automaticamente, após cada seleção no menu.

■ Utilize um botão Go (Ir), que permite ao usuário visitar de novo o link selecionado.

Tópicos relacionados
■ “Menus de salto” na página 465
■ “Inserir menus de salto” na página 483
■ “Editar itens do menu de salto” na página 484

N
O

T
A

Selecione apenas uma dessas opções para cada menu de salto na caixa de diálogo 
Insert Jump Menu, pois elas aplicam-se a um menu de salto inteiro. 
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Usar as barras de navegação
Uma barra de navegação é composta por uma imagem (ou um conjunto de imagens), que se 
altera de acordo nas ações do usuário. 

Antes de usar o comando Insert Navigation Bar (Inserir barra de navegação), você deve criar 
um conjunto de imagens para exibir os estados de cada elemento de navegação. Pode ser mais 
fácil imaginar um elemento da barra de navegação como um botão porque, quando clicado, 
ele conduzirá o usuário a outra página.

Após criar uma barra de navegação para um documento, você pode adicionar ou remover 
imagens da barra de navegação com o comando Modify Navigation Bar (Modificar barra de 
navegação). Use esse comando para alterar uma imagem ou um conjunto de imagens, alterar o 
arquivo a ser aberto quando um elemento for clicado, selecionar outra janela ou quadro para 
abrir um arquivo e reordenar as imagens.

Tópicos relacionados
■ “Barras de navegação” na página 466 

Inserir uma barra de navegação
Ao inserir uma barra de navegação, você pode escolher nomes para os elementos dessa barra e 
imagens a serem usadas para representá-los.

Para criar uma barra de navegação:

1. Siga um dos procedimentos abaixo:

■ Selecione Insert (Inserir) > Image Objects (Objetos de imagem) > Navigation Bar 
(Barra de navegação).

■ Na categoria Common da barra Insert, clique no menu Images e selecione o botão 
Insert Navigation Bar (Inserir barra de navegação).

D
IC

A

Você pode criar uma barra de navegação, copiá-la para outra páginas do seu site, 
utilizá-la com quadros e editar os comportamentos da página, para mostrar os 
diferentes estados à medida que as páginas são acessadas.
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Aparecerá a caixa de diálogo Insert Navigation Bar (Inserir barra de navegação).

2. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

Tópicos relacionados
■ “Barras de navegação” na página 466

Modificar uma barra de navegação 
Quando for criada uma barra de navegação para um documento, as suas imagens poderão ser 
adicionadas ou removidas através do comando Modify Navigation Bar (Modificar a barra de 
navegação). 

Para modificar uma barra de navegação:

1. Selecione a barra de navegação na página ativa.

2. Selecione Modify (Modificar) > Navigation Bar (Barra de navegação).
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Aparecerá a caixa de diálogo Modify Navigation Bar (Modificar a barra de navegação).

3. Na lista Nav Bar Elements (Elementos da barra de navegação), selecione o elemento a ser 
editado.

4. Faça as alterações necessárias.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
5. Clique em OK.

Tópicos relacionados
■ “Barras de navegação” na página 466
■ “Inserir uma barra de navegação” na página 486

Usar mapas de imagens
Um mapa de imagens é uma imagem que foi dividida em regiões, ou pontos ativos; quando 
um ponto ativo for clicado, ocorrerá uma ação (um novo arquivo será aberto, por exemplo). 

Tópicos relacionados
■ “Sobre mapas de imagens” na página 467
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Inserir mapas de imagens no lado do cliente
Quando você inserir um mapa de imagens no lado do cliente, crie uma área de ponto ativo e, 
em seguida, defina o link que será aberto quando o usuário clicar nessa área. 

Para criar um mapa de imagens no lado do cliente: 

1. Na janela do documento, selecione a imagem.

2. Clique na seta de expansão, no canto inferior direito do Property inspector, para examinar 
todas as propriedades.

3. Na caixa de texto Map Name (Nome do mapa), digite um nome exclusivo para o mapa de 
imagens. 

4. Para definir as áreas do mapa de imagens, siga um dos procedimentos abaixo:

■ Selecione a ferramenta de círculo e arraste o cursor sobre a imagem para criar um 
ponto ativo circular. 

■ Selecione a ferramenta de retângulo e arraste o cursor sobre a imagem para criar um 
ponto ativo retangular.

■ Selecione a ferramenta de polígono e defina um ponto ativo com forma irregular, 
clicando uma vez em cada canto. Clique na ferramenta de seta para fechar o formato.

Após a criação do ponto ativo, será exibido o Property inspector de ponto ativo. 
5. Preencha o Property inspector de ponto ativo.

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.
6. No final do mapeamento da imagem, clique em uma área em branco do documento para 

alterar o Property inspector. 

Tópicos relacionados
■ “Sobre mapas de imagens” na página 467

N
O

T
A

Podem ser criadas várias áreas de pontos ativos, mas elas fazem parte do mesmo mapa 
de imagens.

N
O

T
A

Caso sejam utilizados vários mapas de imagens no mesmo documento, verifique se 
cada mapa tem um nome exclusivo. 
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Modificar um mapa de imagens
Os pontos ativos criados em um mapa de imagens podem ser facilmente editados. É possível 
mover uma área de ponto ativo, redimensionar pontos ativos e movê-los para frente ou para 
trás em uma camada. 

É possível copiar uma imagem com pontos ativos de um documento para outro, ou copiar um 
ou mais pontos ativos de uma imagem e colá-los em outra; os pontos ativos associados a uma 
imagem também serão copiados no novo documento. 

Para selecionar vários pontos ativos em um mapa de imagens:

1. Utilize a ferramenta de indicador de ponto ativo para selecionar um ponto ativo.

2. Siga um dos procedimentos abaixo:

■ Pressione a tecla Shift e clique nos outros pontos ativos a serem selecionados
■ Pressione as teclas Control e A (no Windows), ou Command e A (no Macintosh), para 

selecionar todos os pontos ativos.

Para mover um ponto ativo:

1. Utilize a ferramenta de indicador de ponto ativo, para selecionar o ponto ativo a ser 
movido.

2. Siga um dos procedimentos abaixo:

■ Arraste o ponto ativo para uma nova área.
■ Utilize a tecla Shift e as teclas de seta para mover o ponto ativo 10 pixels na direção 

selecionada.
■ Utilize as teclas de seta para mover um ponto ativo um pixel na direção selecionada.

Para redimensionar um ponto ativo:

1. Utilize a ferramenta de indicador de ponto ativo para selecionar o ponto ativo a ser 
redimensionado.

2. Arraste uma alça do seletor de pontos ativos para alterar o tamanho ou a forma do ponto 
ativo.

Tópicos relacionados
■ “Sobre mapas de imagens” na página 467
■ “Inserir mapas de imagens no lado do cliente” na página 489
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Anexar comportamentos JavaScript aos 
links
Um comportamento pode ser anexado a qualquer link em um documento (consulte 
“Aplicação de um comportamento” na página 544). Considere a possibilidade de utilizar os 
seguintes comportamentos ao inserir elementos vinculados em seus documentos:

Set Text of Status Bar (Definir texto da barra de status) determina o texto da mensagem 
exibida na barra de status na parte inferior esquerda da janela do navegador. Por exemplo: é 
possível utilizar esta ação para descrever o destino de um link na barra de status, em vez de 
mostrar a URL a ele associada. Consulte “Set Text of Status Bar (Definir a mensagem de 
status)” na página 568.

Open Browser Window (Abrir a janela do navegador) abre um URL em uma nova janela. É 
possível especificar as propriedades da nova janela, inclusive o seu tamanho, nome e atributos 
(se ela será redimensionável, possuirá uma barra de menus etc.). Consulte “Open Browser 
Window (Abrir a janela do navegador)” na página 561.

Jump Menu (Menu de salto) edita um menu de salto. É possível alterar a lista de menus, 
especificar um arquivo vinculado diferente ou modificar o local do navegador no qual os 
documentos vinculados serão abertos. Consulte “Jump Menu (Menu de salto)” na 
página 560.

Set Nav Bar Image (Definir imagem da barra de navegação)  permite alterar o 
comportamento da barra de navegação. Utilize esse comportamento para personalizar a 
maneira como as imagens serão exibidas na barra de navegação. Por exemplo: quando o cursor 
estiver sobre uma parte da barra de navegação, a exibição das outras imagens na barra ou no 
documento será alterada. Consulte “Set Nav Bar Image (Definir imagem da barra de 
navegação)” na página 565.

Verificar links rompidos, externos e 
órfãos
Use o recurso Check Links (Verificar links) para procurar links rompidos e arquivos sem 
referências — também conhecidos como órfãos — (arquivos que ainda existem no site apesar 
de nenhum outro referir-se a ele) em um arquivo aberto, uma parte de um site local ou em 
todo o site local. 

O Dreamweaver verificará apenas os links aos documentos dentro do site e compilará uma 
lista de links externos que aparecem no documento ou documentos selecionados, porém não 
os verificará.
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Também é possível identificar e excluir arquivos que não mais são usados por outros arquivos 
do site. Para obter mais informações, consulte “Identificar e excluir arquivos não-utilizados” 
na página 162.

Para verificar os links no documento:

1. Salve o arquivo em um local no site Dreamweaver local.

2. Selecione File (Arquivo) > Check Page (Verificar a página) > Check Links (Verificar os 
links).

O relatório Broken Links (Links rompidos) será exibido no painel Link Checker 
(Verificador de links), dentro do grupo de painéis Results (Resultados).

3. No painel Link Checker (Verificador de links), selecione External Links (Links externos) 
no menu pop-up Show (Mostrar) para exibir outro relatório. 

O relatório External Links (Links externos) é exibido no painel Link Checker (Verificador 
de links) dentro do grupo de painéis (Resultados).

4. Para salvar o relatório, clique no botão Save Report (Salvar o relatório) no painel Link 
Checker (Verificador de links).

Para verificar os links em uma parte de um site local:

1. No painel Files (Arquivos), selecione um site no menu pop-up Current Sites (Sites atuais).

2. Em Local view (Visualização local), selecione os arquivos ou pastas a serem verificados.

3. Inicie a verificação seguindo um dos procedimentos abaixo:

■ Clique com o botão direito do mouse ou clique mantendo a tecla Control pressionada 
(no Macintosh) em um dos arquivos selecionados e, no menu contextual, selecione 
Check Links (Verificar os links) > Selected Files/Folders (Arquivos/pastas 
selecionadas).

■ Selecione File (Arquivo) > Check Page (Verificar a página) > Check Links (Verificar os 
links).

O relatório Broken Links (Links rompidos) será exibido no painel Link Checker 
(Verificador de links), dentro do grupo de painéis Results (Resultados).

D
IC

A

É possível verificar arquivos órfãos ao verificar os links em todo o site.

N
O

T
A

O relatório do navegador de destino é um arquivo temporário e será perdido se não 
for salvo.
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4. No painel Link Checker (Verificador de links), selecione External Links (Links externos) 
no menu pop-up Show (Mostrar) para exibir outro relatório. 

O relatório External Links (Links externos) é exibido no painel Link Checker (Verificador 
de links) dentro do grupo de painéis (Resultados).

5. Para salvar o relatório, clique no botão Save Report (Salvar relatório) no painel Link 
Checker (Verificador de links).

Para verificar os links no site inteiro:

1. No painel Files (Arquivos), selecione um site no menu pop-up Current Sites (Sites atuais).

2. Escolha Site > Check Links Sitewide (Verificar os links no site inteiro).

O relatório Broken Links (Links rompidos) será exibido no painel Link Checker 
(Verificador de links), dentro do grupo de painéis Results (Resultados).

3. No painel Link Checker (Verificador de links), selecione External Links (Links externos) 
ou Orphaned Files (Arquivos órfãos) no menu pop-up Show (Mostrar) para exibir outro 
relatório. 

Uma lista de arquivos correspondentes ao tipo de relatório selecionado aparecerá no painel 
Link Checker (Verificador de links).

4. Para salvar o relatório, clique no botão Save Report (Salvar relatório) no painel Link 
Checker (Verificador de links).

Corrigir links rompidos 
Após obter um relatório de links será possível corrigir diretamente no painel Link Checker 
(Verificador de links) links e referências a imagens rompidos. Também é possível abrir os 
arquivos da lista e ajustar os links no Property inspector.

Para corrigir os links no painel Link Checker (Verificador de links):

1. Execute um relatório de verificação de links (consulte “Verificar links rompidos, externos 
e órfãos” na página 491).

D
IC

A

É possível verificar arquivos órfãos ao verificar os links em todo o site (consulte o 
procedimento a seguir).

N
O

T
A

Se Orphaned Files for selecionado como tipo de relatório, será possível excluí-
los diretamente na caixa de diálogo Link Checker selecionando um arquivo na lista e 
pressionando a tecla Delete. 
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2. Na coluna Broken Links (e não na coluna Files) do painel Link Checker (no grupo de 
painel Results), selecione o link rompido. 

Será exibido o ícone com uma pasta ao lado do link rompido.
3. Clique no ícone correspondente à pasta para localizar o arquivo correto ou digite o caminho 

correto e o nome do arquivo para associar o link.

4. Clique na tecla Tab (Windows) ou Return (Macintosh).

Se houver outras referências rompidas a este mesmo arquivo, aparecerá uma caixa de 
diálogo que o solicitará a ajustar as referências também nos outros arquivos. Clique em Yes 
para que o Dreamweaver atualize todos os documentos da lista que fizerem referência a 
esse arquivo. Clique em No para que o Dreamweaver atualize apenas a referência atual.

Para corrigir links no Property inspector: 

1. Execute um relatório de verificação de links (consulte “Verificar links rompidos, externos 
e órfãos” na página 491).

2. Clique no painel Link Checker (Verificador de links) no grupo de painéis Results 
(Resultados) e clique duas vezes em uma entrada na coluna File (Arquivo).

O Dreamweaver abrirá o documento, selecionará a imagem ou link com problema e 
realçará o caminho e o nome do arquivo no Property inspector. Caso o Property inspector 
não esteja visível, escolha Window (Janela)  > Properties (Propriedades), para abri-lo.

3. Clique no ícone correspondente à pasta para localizar o arquivo correto ou sobrescreva o 
texto realçado para definir um novo caminho e nome de arquivo no Property inspector.

Se estiver atualizando a referência de uma imagem e a nova imagem aparecer com o 
tamanho incorreto, clique nos identificadores W (L) e H (A) no Property inspector, ou 
clique no botão Refresh (Atualizar) para redefinir os valores relativos à altura e largura. Os 
identificadores W (L) e H (A) passarão de negrito para o tipo normal.

4. Salve o arquivo.

À medida que os links forem sendo corrigidos, suas entradas desaparecerão da lista do Link 
Checker (Verificador de links). Se uma entrada for mostrada na lista após digitar o novo 
caminho e nome de arquivo no Link Checker (ou após salvar as alterações feitas no Property 
inspector), isso indica que o Dreamweaver não conseguiu localizar o novo arquivo e o link não 
pôde ser corrigido.

N
O

T
A

Se a opção Enable File Check In and Check Out (Ativar a devolução e retirada de 
arquivos) estiver ativada neste site, o Dreamweaver tentará retirar os arquivos que 
precisarem ser alterados. Se não conseguir retirar um arquivo, o Dreamweaver 
exibirá uma caixa de diálogo de aviso e manterá inalteradas as referências rompidas. 
Consulte “Devolver e retirar arquivos” na página 148.
494 Capítulo 15:  Links e navegação



         
Abrir documentos vinculados no 
Dreamweaver 
Os links não estão ativos no Dreamweaver, ou seja, não é possível abrir um documento 
vinculado clicando no link na janela do documento.

Para abrir documentos vinculados no Dreamweaver, siga um dos 
procedimentos abaixo:

■ Selecione o link e escolha Modify (Modificar) > Open Linked Page (Abrir página 
vinculada).

■ Pressione a tecla Control (no Windows) ou Command (no Macintosh) e clique duas vezes 
no link.

Tópicos relacionados
■ “Visualizar e testar páginas em navegadores” na página 399
■ “Verificar links rompidos, externos e órfãos” na página 491
■ “Corrigir links rompidos” na página 493

N
O

T
A

O documento vinculado deve estar localizado no disco local.
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CAPÍTULO 16

Trabalhar com 
outros aplicativos
Macromedia Fireworks 8 e Macromedia Flash 8 são poderosas ferramentas de 
desenvolvimento para a Web projetadas para criar gráficos e arquivos SWF para visualização 
de páginas da Web. Você pode integrar totalmente essas ferramentas ao Macromedia 
Dreamweaver 8 para simplificar o fluxo de trabalho de design de sites da Web.

É possível inserir facilmente imagens ou tabelas do Fireworks e conteúdo Flash (arquivos 
SWF) em um documento do Dreamweaver. Também é possível aproveitar os recursos de 
integração entre o Dreamweaver e o Fireworks e o Flash para fazer alterações em uma imagem 
ou filme após sua inserção em um documento Dreamweaver.

Este capítulo contém as seguintes seções:
Sobre a integração com o Fireworks e com o Flash  . . . . . . . . . . . . . . . . . . . . . . . . .497

Otimizar o ambiente de trabalho para Fireworks e Flash  . . . . . . . . . . . . . . . . . . . . 498

Trabalhar com o Fireworks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 499

Trabalhar com o Flash. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 512

Sobre a integração com o Fireworks e 
com o Flash
A edição Roundtrip e as Design Notes ativam o Dreamweaver para operações de integração 
com o Fireworks e com o Flash. A edição Roundtrip garante que as atualizações de código 
sejam corretamente transferidas entre o Dreamweaver e estes outros aplicativos (por exemplo, 
para preservar os comportamentos cambiáveis e os links para outros arquivos).

N
O

T
A

Para usar o Dreamweaver junto com o Fireworks e o Flash, os três aplicativos devem 
estar instalados no seu computador.
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Design Notes (Anotações de projeto) são pequenos arquivos que permitem que o 
Dreamweaver localize o documento de origem adequado para uma imagem ou um arquivo de 
filme exportado. Ao exportar os arquivos do Fireworks ou Flash diretamente para um site 
Dreamweaver definido, as Design Notes que contêm as referências ao arquivo de autoria PNG 
ou Flash (FLA) são automaticamente exportadas para o site junto com o arquivo pronto para 
Web (GIF, JPEG ou SWF). Para obter informações, veja “Sobre o Design Notes” na 
página 116.

Além das informações de localização, as Design Notes contêm outras informações pertinentes 
sobre os arquivos exportados. Por exemplo: ao exportar uma tabela do Fireworks, o Fireworks 
escreve uma Design Note para cada arquivo de imagem exportado na tabela. Se o arquivo 
exportado contém pontos ativos ou cambiáveis, o JavaScript dos pontos ativos ou cambiáveis 
está contido no documento HTML que o Fireworks exporta.

Otimizar o ambiente de trabalho para 
Fireworks e Flash
A chave para desenvolver um fluxo de trabalho que se integre suavemente com Fireworks ou 
com Flash é a otimização do ambiente de trabalho. 

Para otimizar seu ambiente de trabalho para Fireworks e Flash:

1. Assegure-se de que as Design Notes estejam ativadas em seu site Dreamweaver. 

As Design Notes ativam-se automaticamente, a menos que você tenha alterado as 
definições padrão do seu site. Para obter mais informações sobre a ativação das Design 
Notes, veja “Ativar e desativar as Design Notes de um site” na página 168. Para obter 
informações sobre a função das Design Notes, consulte “Sobre a integração com o 
Fireworks e com o Flash” na página 497. 

2. Para iniciar facilmente o Fireworks do Dreamweaver, defina o Fireworks como o editor de 
imagens externo primário do Dreamweaver. 

Defina o Fireworks como editor primário para os arquivos gráficos do tipo: GIF, PNG e 
JPEG. Para obter mais informações, consulte “Usar um editor de imagens externo” na 
página 458 em Using Dreamweaver. 

3. Salve os arquivos-fonte e os arquivos prontos para Web do Fireworks e Flash na pasta 
definida do site do Dreamweaver. 

Esse procedimento garante que qualquer usuário que compartilhe o site poderá localizar o 
documento de origem ao editar uma imagem ou tabela do Fireworks, ou ao editar um 
filme SWF enquanto trabalha no Dreamweaver. 
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4. Ao exportar seus arquivos de imagens do Fireworks, exporte-os para a pasta do site do 
Dreamweaver. 

Ao exportar uma imagem gráfica GIF ou JPEG do Fireworks para uma pasta do site do 
Dreamweaver, o Fireworks cria uma pasta named _notes na mesma pasta. Esta pasta 
contém as Design Notes que o Dreamweaver precisa para trabalhar com o Fireworks. 

Trabalhar com o Fireworks
O Dreamweaver e o Fireworks reconhecem e compartilham muitos procedimentos de edição 
de arquivos, incluindo alterações em links, mapas de imagens, cortes de tabela, etc. Juntos, os 
dois aplicativos fornecem um fluxo de trabalho contínuo para edição, otimização e colocação 
dos arquivos gráficos da Web em páginas HTML.

Inserir imagens do Fireworks
As imagens gráficas do Fireworks podem ser colocadas em um documento Dreamweaver de 
várias maneiras. É possível colocar uma imagem gráfica exportada do Fireworks diretamente 
em um documento Dreamweaver, utilizando o comando Insert Image (Inserir imagem), ou 
criar uma nova imagem gráfica do Fireworks a partir de um alocador de espaço para imagem 
do Dreamweaver (consulte “Utilizar o Fireworks para modificar alocadores de espaço de 
imagem do Dreamweaver” na página 502). 

Para inserir um caractere especial em um documento: 

1. No documento Dreamweaver, coloque o ponto de inserção onde deseja que a imagem seja 
exibida e, depois, siga um dos procedimentos abaixo: 

■ Selecione Insert (Inserir) > Image (Imagem).
■ Na categoria Common (Comuns) da barra Insert (Inserir), clique no botão Image 

(Imagem) ou arraste-o para o documento. 
2. Navegue para o arquivo exportado do Fireworks desejado e clique em OK (no Windows) 

ou Open (no Macintosh).

N
O

T
A

Se o arquivo do Fireworks não estiver no site do Dreamweaver atual, será exibida 
uma mensagem perguntando se o usuário deseja copiar o arquivo para a pasta raiz. 
Clique em Sim.
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Edição de uma imagem ou tabela do Fireworks no 
Dreamweaver
É possível acionar o Fireworks do Dreamweaver para editar as imagens inseridas em um 
documento do Dreamweaver. Quando você abre e edita uma imagem ou um corte da imagem 
que faz parte de uma tabela do Fireworks, o Dreamweaver inicia o Fireworks, que abre o 
arquivo PNG do qual a imagem ou a tabela foi exportada.

Quando a imagem faz parte de uma tabela do Fireworks, é possível abrir a tabela inteira do 
Fireworks para edição, enquanto houver o comentário <!--fw table--> no código HTML. Se o 
PNG de origem foi exportado do Fireworks para um site do Dreamweaver utilizando o 
HTML do estilo Dreamweaver e a definição de imagens, o comentário da tabela do Fireworks 
é automaticamente inserido no código HTML.

Para iniciar e editar uma imagem do Fireworks colocada no Dreamweaver:

1. No Dreamweaver, selecione Window > Properties para abrir o Property inspector, caso 
ainda não esteja aberto.

2. Clique na imagem ou corte de imagem para selecioná-la.

Ao selecionar uma imagem exportada do Fireworks, o Property inspector (Inspetor de 
propriedades) identifica a seleção como uma imagem ou tabela do Fireworks e exibe o 
nome do arquivo PNG.

3. Para iniciar o Fireworks para edição, siga um dos procedimentos abaixo:

■ No Property inspector, clique em Edit (Editar).
■ Pressione a tecla Control (no Windows) ou Command (no Macintosh) e clique duas 

vezes na imagem selecionada.
■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 

pressionada e clique (no Macintosh) na imagem selecionada e escolha Edit With 
Fireworks (Editar com Fireworks) no menu contextual. 

O Fireworks é iniciado e abre o PNG associado para edição .

4. No Fireworks, edite o PNG de origem.

N
O

T
A

Se o Fireworks não puder localizar o arquivo de origem, ele solicitará a localização 
do arquivo de origem PNG. Ao trabalhar com o arquivo de origem do Fireworks, as 
alterações são salvas para o arquivo de origem e para o arquivo exportado; caso 
contrário, somente o arquivo exportado é atualizado. 
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5. Ao terminar a edição, clique em Done (Concluído).

O Fireworks salva as alterações no arquivo PNG, exporta a imagem atualizada (ou HTML 
e imagens) e volta o foco ao Dreamweaver. No Dreamweaver, a imagem ou tabela 
atualizada é exibida.

Otimização de uma imagem do Fireworks no 
Dreamweaver
É possível iniciar o Fireworks do Dreamweaver para fazer alterações de exportação rápidas, 
como redimensionamento de uma imagem ou alteração do tipo de arquivo, para imagens e 
animações do Fireworks incluídas. O Fireworks permite as alterações nas definições de 
otimização, nas definições de animação, no tamanho e na área da imagem exportada.

Para alterar as definições de otimização de uma imagem do Fireworks 
colocada no Dreamweaver:

1. No Dreamweaver, selecione a imagem desejada e escolha Commands (Comandos) > 
Optimize Image in Fireworks (Otimizar imagem no Fireworks). 

2. Se solicitado, especifique se um arquivo de origem do Fireworks deve ser iniciado para a 
imagem incluída.

3. No Fireworks, faça as alterações desejadas na caixa de diálogo Optimization (Otimização):

■ Para editar as definições de otimização, clique na guia Options (Opções). Para obter 
mais informações, consulte  Using Fireworks (Usando o Fireworks). 

■ Para editar o tamanho e a área da imagem exportada, clique na guia Arquivo.
4. Ao terminar a edição da imagem, clique em Atualizar. 

Ao clicar em Atualizar, a imagem é exportada utilizando as novas definições de otimização, 
o GIF ou JPEG posicionado no Dreamweaver é atualizado, e o arquivo de origem PNG é 
salvo, se um arquivo de origem foi selecionado. 
Se o usuário alterou o formato da imagem, o verificador do link do Dreamweaver avisa 
sobre a atualização das referências à imagem. Por exemplo, se o usuário alterou o formato 
de uma imagem chamada my_image de GIF para JPEG, clicando em OK neste prompt 
muda todas as referências a my_image.gif no site para my_image.jpg.
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Utilizar o Fireworks para modificar alocadores de 
espaço de imagem do Dreamweaver
É possível criar uma imagem de alocação de espaço em um documento do Dreamweaver e 
iniciar o Fireworks para projetar uma imagem gráfica ou tabela do Fireworks para substituí-la. 
Para obter informações sobre a inserção de um alocador de espaço de imagem, veja “Inserir 
alocador de espaço de imagem” na página 450.

Para criar uma nova imagem de um alocador de espaço de imagem, o usuário deve ter o 
Dreamweaver e o Fireworks instalados no sistema. 

Para editar uma imagem do alocador de espaço do Dreamweaver no 
Fireworks:

1. Certifique-se de que o Fireworks já esteja definido como editor de imagens para os arquivos 
.png. Para obter mais informações, consulte “Usar um editor de imagens externo” na 
página 458 em Using Dreamweaver. 

2. Na janela do documento, clique no alocador de espaço de imagem para selecioná-la.

3. Siga um dos procedimentos abaixo para iniciar o Fireworks para edição:

■ No Property inspector, clique em Create (Criar). 
■ Pressione a tecla Control (no Windows) ou Command (no Macintosh) e clique duas 

vezes no alocador de espaço de imagem.
■ Clique com botão direito (Windows) ou clique e mantenha pressionada a tecla 

Control (Macintosh) sobre o alocador de espaço de imagem e selecione Create Image 
in Fireworks (Criar imagem no Fireworks).

O Fireworks será iniciado no modo Editing from Dreamweaver (Edição do 
Dreamweaver).
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4. Utilize as opções do Fireworks para projetar a imagem. 

O Fireworks reconhece as definições a seguir do alocador de espaço de imagem, que 
podem ter sido definidas ao trabalhar com o alocador de espaço de imagem no 
Dreamweaver: tamanho da imagem (que diz respeito ao tamanho da tela do Fireworks), 
ID da imagem (que o Fireworks usa como nome de documento padrão do arquivo de 
origem e do arquivo de exportação criado), alinhamento de texto e comportamentos 
reconhecidos pelo Fireworks (como imagem de troca, menu pop-up, barra de navegação e 
texto definido). O Fireworks também reconhece os links anexados ao alocador de espaço 
de imagem enquanto trabalha no Dreamweaver.

As seguintes definições do alocador de espaço de imagem estão desativadas no Property 
inspector do alocador de espaço de imagem, já que elas não são reconhecidas pelo 
Fireworks: alinhamento de imagem, cor, Vspace e Hspace e mapas.

5. Ao finalizar, clique em Done (Concluído).

A caixa de diálogo Save as (Salvar como) será exibida. O Fireworks avisa o usuário para 
salvar o arquivo PNG. 

6. Na caixa de texto Save In (Salvar em), escolha a pasta definida como pasta do site local do 
Dreamweaver.

Se você tiver atribuído um nome ao alocador de espaço de imagem ao inseri-lo no 
documento do Dreamweaver, o Fireworks preencherá a caixa de texto File Name (Nome 
do arquivo) com esse nome. É possível alterar esse nome, se desejar.

7. Clique em Save (Salvar) para salvar o arquivo PNG.

A caixa de diálogo Export (Exportar) será exibida. Use esta caixa de diálogo para exportar a 
imagem como GIF, JPEG ou, no caso de imagens cortadas, como HTML e imagens.

8. Na caixa de diálogo Export (Exportar), selecione a pasta do site local do Dreamweaver.

9. A caixa de texto Name (Nome) será atualizada automaticamente com o mesmo nome usado 
para o arquivo PNG. Digite o texto para alterar o nome, se desejar.

10. Para Save As Type (Salvar como tipo), selecione os tipos de arquivo que deseja exportar, 
como Images only (Somente imagens) ou HTML and Images (HTML e Imagens). 

N
O

T
A

Apesar de os links adicionados a um alocador de espaço de imagem não poderem 
ser vistos no Fireworks, eles são preservados. Se você desenhar um ponto ativo e 
adicionar um link no Fireworks, ele não excluirá o link adicionado ao alocador de 
espaço de imagem no Dreamweaver; no entanto, se você remover um corte do 
Fireworks da nova imagem, ele excluirá o link do documento do Dreamweaver 
quando você substituir o alocador de espaço da imagem.
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11. Clique em Save (Salvar) para salvar o arquivo exportado.

O arquivo será salvo e o foco retornará ao Dreamweaver. No documento Dreamweaver, o 
arquivo exportado ou a tabela do Fireworks substitui o alocador de espaço de imagens.

Editar menus pop-up do Fireworks no Dreamweaver
É possível criar um menu pop-up no Fireworks 8 ou posterior e depois editá-lo com o 
Dreamweaver ou com o Fireworks (usando a edição Roundtrip), mas não com ambos. Se você 
editar os menus no Dreamweaver e depois editá-los no Fireworks, perderá todas as suas 
edições anteriores, com exceção do conteúdo de texto.

Caso você prefira editar os menus com o Dreamweaver, é possível usar o Fireworks para criar o 
menu pop-up e depois usar o Dreamweaver exclusivamente para ajustar e personalizar o 
menu.

Caso você prefira editar os menus no Fireworks, é possível usar o recurso de edição Roundtrip 
no Dreamweaver, mas os menus não devem ser editados diretamente no Dreamweaver.

Para utilizar a edição Roundtrip para editar um menu pop-up do Fireworks:

1. No Dreamweaver, selecione a tabela do Fireworks que contém o menu pop-up e depois 
clique em Edit (Editar) no Property inspector (Inspetor de propriedades).

O arquivo de origem PNG é aberto no Fireworks.
2. No Fireworks, edite o menu com o Pop-up Menu Editor (Editor de menus pop-up) e 

depois clique em Done (Concluído) na barra de ferramentas do Fireworks.

O Fireworks devolverá o menu pop-up editado ao Dreamweaver.
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Se você criou um menu pop-up no Fireworks MX 2004 ou anterior, será possível editá-lo no 
Dreamweaver com a caixa de diálogo Show Pop-Up Menu (Mostrar o menu pop-up). 

Para editar um menu pop-up criado no Fireworks MX 2004 ou anterior:

1. No Dreamweaver, selecione o ponto ativo ou a imagem que aciona o menu pop-up.

2. No painel Behaviors (Comportamentos) (Shift+F3), clique duas vezes em Show Pop-Up 
Menu na lista Actions (Ações). 

A caixa de diálogo Show Pop-Up Menu é exibida. O comportamento da opção Show Pop-
Up menu (Mostrar menu pop-up) permite a edição ou atualização do conteúdo de um 
menu pop-up baseado em HTML do Fireworks. É possível adicionar, excluir ou alterar os 
itens de menu, reorganizá-los e definir onde um menu está posicionado em uma página. 
Para obter informações sobre a definição ou modificação das opções do menu pop-up, 
consulte “Show Pop-Up Menu (Mostrar o menu pop-up)” na página 572. 

3. Faça as alterações que desejar no menu pop-up e clique em OK.

Especificar as preferências de acionamento e edição 
para os arquivos de origem do Fireworks
As imagens que serão colocadas em suas páginas da Web serão exportadas pelo Fireworks 
normalmente de um arquivo de origem PNG, quando usar o Fireworks para editá-las. 
Quando abrir (“acionar”) um arquivo de imagem no Dreamweaver para editá-lo, o Fireworks 
automaticamente abrirá o arquivo de origem PNG e solicitará a localização do arquivo PNG, 
caso ele não possa ser encontrado. Se desejar, você pode definir preferências no Fireworks para 
que o Dreamweaver abra a imagem inserida ou lhe dê a opção de usar o arquivo de imagem 
inserido ou o arquivo de origem do Fireworks sempre que você abrir uma imagem no 
Dreamweaver.

Para especificar as preferências de acionamento e edição do Fireworks:

1. No Fireworks, selecione Edit (Editar) > Preferences (Preferências) ou Fireworks > 
Preferences, no Macintosh, e clique na guia Launch and Edit (Acionar e editar), no 
Windows, ou selecione Launch and Edit no menu pop-up, no Macintosh.

N
O

T
A

O Dreamweaver reconhece as preferências de acionamento e edição do Fireworks 
somente em alguns casos. Especificamente, você deve abrir e otimizar uma imagem que 
não faça parte de uma tabela do Fireworks e não contenha um caminho correto das 
Design Notes (Notas de design) para um arquivo PNG de origem.
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2. Especifique as opções de preferência que serão utilizadas ao editar ou otimizar as imagens 
do Fireworks colocadas em um aplicativo externo:

A opção Always Use Source PNG (Usar sempre o PNG de origem) abre 
automaticamente o arquivo PNG do Fireworks que será definido na Design Note (Nota 
de design) como origem da imagem posicionada. As atualizações são feitas tanto no PNG 
de origem quanto na imagem posicionada correspondente.
A opção Never Use Source PNG (Nunca usar o PNG de origem) abre automaticamente 
a imagem posicionada do Fireworks, quer exista ou não um arquivo PNG de origem. As 
atualizações são feitas somente na imagem posicionada.
A opção Ask When Launching (Perguntar ao acionar) permite especificar a cada vez se 
você deseja acionar ou não o arquivo PNG de origem. Ao editar ou otimizar uma imagem 
posicionada, o Fireworks exibe uma mensagem solicitando que ele tome uma decisão de 
acionamento e edição. Também é possível especificar as preferências globais de 
acionamento e edição dessa mensagem. 

Inserir código HTML do Fireworks em um documento 
Dreamweaver
O comando Export (Exportar) no Fireworks permite exportar e gravar imagens otimizadas e 
arquivos HTML na pasta desejada do site do Dreamweaver. É possível inserir o arquivo no 
Dreamweaver. Para obter informações sobre exportação de arquivos do Fireworks em formato 
HTML, consulte  Using Fireworks (Usando o Fireworks). 

O Dreamweaver permite a inserção de um código HTML gerado pelo Fireworks, preenchido 
com imagens associadas, cortes e JavaScript, em um documento. Esse recurso de inserção 
facilita a criação de elementos de design no Fireworks e a incorporação deles a um 
documento Dreamweaver existente.

Para inserir HTML proveniente do Fireworks em um documento 
Dreamweaver:

1. No Dreamweaver, coloque o ponto de inserção onde deseja que comece o código HTML 
do Fireworks.

2. Siga um dos procedimentos abaixo:

■ Selecione Insert (Inserir) > Interactive Images (Imagens interativas) > Fireworks 
HTML (HTML do Fireworks).

■ Na categoria Common (Comuns) da barra Insert (Inserção), clique no botão Insert 
Fireworks HTML (Inserir HTML do Fireworks).
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3. Na caixa de diálogo que for exibida, clique em Browse (Procurar) para escolher o arquivo 
HTML desejado do Fireworks.

4. Selecione a opção Delete File After Insertion (Excluir arquivo após inserção) para mover o 
arquivo HTML do Fireworks original para a Lixeira (no Windows) ou Trash (no 
Macintosh) quando a operação estiver concluída. 

Utilize essa opção, se não precisar mais do arquivo HTML do Fireworks após inseri-lo. 
Essa opção não afeta o arquivo PNG de origem associado ao arquivo HTML.

5. Clique em OK para inserir o código HTML, junto com as imagens associadas, cortes e 
JavaScript, no documento Dreamweaver.

Colar o código HTML do Fireworks no Dreamweaver
Uma maneira rápida de transferir as imagens e tabelas geradas pelo Fireworks para o 
Dreamweaver é copiar e colar o código HTML do Fireworks diretamente no documento 
Dreamweaver.

Para copiar e colar o código HTML do Fireworks no Dreamweaver:

1. No Fireworks, escolha Edit (Editar) > Copy HTML Code (Copiar código HTML). 

2. Siga o assistente pelas definições de exportação de HTML e imagens. Quando solicitado, 
especifique a pasta no site do Dreamweaver como destino para as imagens exportadas.

O assistente exporta as imagens para o destino especificado e copia o código HTML para 
a área de transferência.

3. No Dreamweaver, posicione no documento o ponto de inserção onde deseja colar o código 
HTML e selecione Edit (Editar) > Paste (Colar).

Todos os códigos HTML e JavaScript associados aos arquivos Fireworks exportados são 
copiados para o documento Dreamweaver, e todos os links para as imagens são 
atualizados.

Para exportar e colar o código HTML do Fireworks no Dreamweaver:

1. No Fireworks, escolha File (Arquivo) > Export (Exportar).

2. Na caixa de diálogo Exportar, especifique a pasta no site do Dreamweaver como destino 
para as imagens exportadas.

3. No menu pop-up Save As (Salvar como), escolha HTML and Images (HTML e Imagens).

N
O

T
A

Se o arquivo HTML estiver em uma unidade de disco da rede, ele será 
permanentemente excluído — não movido para a Lixeira.
Trabalhar com o Fireworks 507



4. No menu pop-up HTML, escolha Copy to Clipboard (Copiar para Área de transferência) 
e, em seguida, clique em Save (Salvar).

5. No Dreamweaver, posicione no documento o ponto de inserção onde deseja colar o código 
HTML exportado e escolha Edit (Editar) > Paste (Colar).

Todos os códigos HTML e JavaScript associados aos arquivos Fireworks exportados são 
copiados para o documento Dreamweaver, e todos os links para as imagens são 
atualizados.

Atualizar o HTML do Fireworks colocado no 
Dreamweaver
No Fireworks, o comando File (Arquivo) > Update HTML (Atualizar HTML) fornece uma 
alternativa para a técnica acionar e editar de atualização de arquivos do Fireworks colocados 
no Dreamweaver. Com a Update HTML (Atualização de HTML), é possível editar uma 
imagem do PNG de origem no Fireworks e atualizar automaticamente quaisquer códigos 
HTML e arquivos de imagem exportados colocados em um documento Dreamweaver. Este 
comando permite a atualização dos arquivos do Dreamweaver mesmo quando o Dreamweaver 
não está em execução.

Para atualizar o código HTML do Fireworks colocado no Dreamweaver:

1. No Fireworks, abra o PNG de origem e faça as edições desejadas nele.

2. Selecione File (Arquivo) > Save (Salvar).

3. No Fireworks, escolha File (Arquivo) > Update HTML (Atualizar HTML). 

4. Navegue para o arquivo do Dreamweaver que contém o código HTML que deseja atualizar 
e clique em Open (Abrir).

5. Navegue para o pasta de destino em que deseja colocar os arquivos de imagem atualizados 
e clique em Select (Selecionar) (no Windows) ou em Choose (no Macintosh).

O Fireworks atualiza o código HTML e JavaScript no documento Dreamweaver. O 
Fireworks também exporta as imagens atualizadas associadas ao código HTML e coloca as 
imagens na pasta de destino especificada.
Se o Fireworks não puder localizar o código HTML correspondente para atualizar, ele 
fornece a opção de inserir um novo código HTML no documento Dreamweaver. O 
Fireworks coloca a seção JavaScript do novo código no começo do documento e coloca a 
tabela HTML ou o link para a imagem no fim.
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Criação de um álbum de fotografias na Web
É possível gerar automaticamente um site da Web que apresente um álbum fotográfico de 
imagens localizadas em uma determinada pasta. O Dreamweaver usa o Fireworks para criar 
uma imagem em miniatura e uma imagem maior para cada imagem na pasta. O Dreamweaver 
cria uma página da Web com todas as miniaturas, bem como os links para as imagens maiores. 
Para criar um álbum de fotografias na Web, é preciso ter o Dreamweaver e o Fireworks 4 ou 
posterior instalados no sistema.

Antes de começar, coloque todas as imagens do álbum de fotografias em uma única pasta. (A 
pasta não precisa estar em um site.) Além disso, assegure-se de que os nomes dos arquivos de 
imagem tenham uma das seguintes extensões: .gif, .jpg, .jpeg, .png, .psd, .tif ou .tiff. As 
imagens com extensões de arquivo não reconhecidas não são incluídas no álbum de 
fotografias.

Para criar um álbum de fotografias na Web:

1. No Dreamweaver, escolha Commands (Comandos) > Create Web Photo Album (Criar 
álbum de fotografias na Web).

2. Na caixa de texto Photo Album Title (Título do álbum de fotografias), digite um título. O 
título será exibido em um retângulo cinza na parte superior da página que contém as 
miniaturas.

Caso deseje, é possível digitar até duas linhas de texto adicional a serem exibidas 
diretamente abaixo do título, nas caixas de texto Subheading Info (Informações do 
subcabeçalho) e Other info (Outras informações).

3. Selecione a pasta que contém as imagens de origem clicando no botão Browse (Procurar) 
junto à caixa de texto Source Images Folder (Pasta de imagens de origem). Em seguida, 
selecione (ou crie) uma pasta de destino para armazenar todas as imagens e arquivos HTML 
exportados clicando no botão Browse (Procurar) próximo à caixa de texto Destination 
Folder (Pasta de destino).

A pasta de destino não deve conter ainda um álbum de fotografias — se contiver, e se 
alguma imagem nova tiver os mesmos nomes que as imagens utilizadas anteriormente, é 
possível sobregravar a miniatura existente e os arquivos de imagem.

4. Especifique as opções de exibição das imagens miniaturas:

■ Selecione um tamanho para as miniaturas no menu pop-up Thumbnail Size 
(Tamanho da miniatura). As imagens são dimensionadas proporcionalmente para criar 
miniaturas que se ajustem a um quadrado com as dimensões de pixel indicadas.
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■ Para exibir o nome de arquivo de cada imagem original embaixo da miniatura 
correspondente, selecione Show Filenames (Mostrar os nomes dos arquivos).

■ Digite o número de colunas da tabela que exibe as miniaturas.
5. Selecione um formato para as imagens em miniatura no menu pop-up Thumbnail Format 

(Formato da miniatura):

O formato GIF WebSnap 128 cria miniaturas GIF que utilizam uma paleta adaptativa 
para Web de até 128 cores.
O formato GIF WebSnap 256 cria miniaturas GIF que utilizam uma paleta adaptativa 
para Web de até 256 cores.
O formato JPEG—melhor qualidade cria miniaturas JPEG com qualidade relativamente 
mais alta e arquivos maiores.
O formato JPEG—menor arquivo cria miniaturas JPEG com qualidade relativamente 
mais baixa e arquivos menores.

6. Selecione um formato para as imagens grandes do menu pop-up Photo Format (Formato 
da fotografia). Uma imagem grande do formato especificado é criada para cada imagem 
original. É possível especificar um formato das imagens grandes diferente do formato 
especificado para as miniaturas.

7. Selecione um percentual de escala para as imagens grandes.

Ao definir como 100%, o sistema cria imagens grandes com o mesmo tamanho das 
originais. Observe que o percentual da escala é aplicado a todas as imagens; se as imagens 
originais não forem todas do mesmo tamanho, escalá-las com o mesmo percentual talvez 
não produza os resultados desejados.

8. Selecione Create Navigation Pane for Each Photo (Criar página de navegação para cada 
fotografia) para criar uma página da Web individual para cada imagem de origem, 
contendo os links de navegação Voltar, Inicial e Avançar. 

Caso selecione essa opção, as miniaturas são ligadas às páginas de navegação. Se não 
selecionar esta opção, as miniaturas são ligadas diretamente às imagens grandes. 

N
O

T
A

O comando Create Web Photo Album não permite o uso de arquivos de imagem 
originais como imagens grandes, pois formatos de imagem original diferentes de 
GIF e JPEG talvez não sejam exibidos corretamente em todos os navegadores. 
Observe que se as imagens originais são arquivos JPEG, as imagens grandes 
geradas podem ter tamanhos maiores ou qualidade menor que os arquivos originais.
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9. Clique em OK para criar o código HTML e os arquivos de imagem do álbum de fotografias 
na Web.

O Fireworks será iniciado (se ainda não estiver em execução) e criará as imagens em 
miniatura e as imagens grandes. Esse procedimento pode durar vários minutos, se o 
usuário tiver incluído um grande número de arquivos de imagem. Quando o 
processamento é concluído, o Dreamweaver fica ativo novamente e cria a página que 
contém as miniaturas.

10. Quando for exibida uma caixa de diálogo que informa "Album Created" (“Álbum criado”), 
clique em OK. 

Talvez seja preciso aguardar alguns segundos para que a página do álbum de fotografias 
seja exibida. As miniaturas são mostradas em ordem alfabética por nome de arquivo.

N
O

T
A

Clicar no botão Cancel (Cancelar) da caixa de diálogo Dreamweaver, após o início 
do processamento, não interrompe a criação do álbum de fotografias, isso 
simplesmente impede o Dreamweaver de exibir a página principal do álbum de 
fotografias. 
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Trabalhar com o Flash
É possível usar o Dreamweaver para definir opções de execução e de exibição de um arquivo 
do Flash em uma página da Web ou para atualizar links no filme. Se o Flash estiver instalado, 
também é possível selecionar um arquivo SWF em um documento do Dreamweaver e iniciar 
o Flash para editá-lo. 

Edição de conteúdo Flash no Dreamweaver
Se o Flash estiver instalado, também é possível selecionar um arquivo SWF em um 
documento do Dreamweaver e iniciar o Flash para editá-lo. O Flash não edita diretamente o 
arquivo SWF; ele edita o documento de origem (arquivo FLA) e depois re-exporta o arquivo 
SWF.

Para abrir e editar conteúdo Flash inserido no Dreamweaver:

1. No Dreamweaver, selecione Window > Properties para abrir o Property inspector, caso 
ainda não esteja aberto.

2. No documento Dreamweaver, siga um dos procedimentos abaixo:

■ Clique no alocador de espaço do arquivo SWF para selecioná-lo e depois clique em 
Edit (Editar) no Property inspector (Inspetor de propriedades).

■ Pressione a tecla Control (no Windows) ou Command (no Macintosh) e clique duas 
vezes no alocador de espaço do filme que deseja editar.

N
O

T
A

Caso não disponha do Flash, o botão Edit (Editar) ficará desativado.
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■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada e clique (no Macintosh) no filme desejado e escolha Edit With Flash 
(Editar com Flash) no menu contextual.

O Dreamweaver aciona o Flash, que tenta localizar o arquivo de autoria (.FLA) Flash 
correspondente ao arquivo SWF selecionado. Se o Flash não puder localizar o arquivo de 
autoria Flash, o sistema solicitará a sua localização. Você não pode atualizar um arquivo 
SWF diretamente; altere o arquivo de origem e o exporte como um arquivo SWF.

3. No Flash, edite o filme. A janela do documento indica que você está modificando um filme 
no Dreamweaver. 

4. Ao terminar a edição, clique em Done (Concluído). 

O Flash atualiza o documento de autoria do Flash (arquivo FLA), exporta novamente o 
arquivo de filme (arquivo SWF), encerra e devolve o foco para o documento 
Dreamweaver. 

5. Para exibir o SWF atualizado no documento, clique em Play (Executar) no Property 
inspector ou pressione F12 para visualizar a página em uma janela do navegador.

Atualização de links em um arquivo SWF
Você pode usar o Dreamweaver para atualizar um link em um arquivo do Flash (arquivo 
SWF) e depois atualizar as alterações no documento de autoria Flash (arquivo FLA). 

Para atualizar um link de URL em um arquivo SWF:

1. Configure uma página inicial para o site, se ainda não o tiver feito. 

É necessário configurar uma página inicial para criar um mapa do site. Na visualização no 
mapa do site, é necessário exibir os arquivos dependentes para atualizar um link em um 
arquivo SWF. Como padrão, o mapa do site não apresenta arquivos dependentes. Para 
obter informações sobre a exibição de arquivos dependentes, consulte “Mostrar e ocultar 
os arquivos do mapa do site” na página 144. Para obter informações sobre a visualização 
do mapa do site, consulte “Exibir um mapa de site” na página 138. 

2. Abra a visualização Site Map (Mapa do site).

N
O

T
A

Se o arquivo FLA ou SWF estiver bloqueado, o Dreamweaver avisa o usuário para 
verificar o arquivo, cancelar a solicitação ou exibir o arquivo.
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3. Para exibir arquivos dependentes, faça o seguinte:

■ Selecione View (Exibir) > Show Dependent Files (Mostrar os arquivos dependentes).
■ Selecione View > Layout para abrir a caixa de diálogo Site Definition e, em seguida, 

selecione a opção Display Dependent Files (Exibir os arquivos dependentes).
O link é exibido no arquivo SWF.

4. Altere o link seguindo um dos procedimentos abaixo:

■ Para alterar o link no SWF selecionado, clique com o botão direito do mouse 
(Windows) ou mantenha pressionada a tecla Control e clique no link (Macintosh), 
selecione Change Link (Alterar link) e, na caixa de diálogo exibida na caixa de texto 
URL, digite o caminho da nova URL.

■ Para atualizar todas as instâncias do link, selecione Site (Site) > Change Link Sitewide 
(Alterar o link no site inteiro) e, na caixa de diálogo exibida, na caixa de texto Change 
All Links To (Alterar todos os links para), procure ou digite o caminho do link que está 
sendo alterado e, na caixa de texto Into Links To (Em links a), procure ou digite o 
caminho da nova URL.

5. Clique em OK.

Qualquer link atualizado pelo Dreamweaver no arquivo SWF é transmitido para o 
documento de origem FLA quando um acionamento e uma edição são realizados. O 
Dreamweaver registra automaticamente qualquer alteração de link no arquivo SWF nas 
Design Notes, e quando o Flash passa as alterações para o arquivo FLA, ele as remove das 
Design Notes.
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CAPÍTULO 17

Adicionar áudio, vídeo e 
elementos interativos
Macromedia Dreamweaver 8 permite incluir som e filmes nos sites da Web de maneira rápida 
e fácil. É possível anexar Design Notes (Notas de design) a esses objetos, que permitem a 
comunicação com o grupo. Também é possível inserir botões e objetos de texto do 
Macromedia Flash 8 a partir do próprio Dreamweaver.

Este capítulo contém as seguintes seções:
Sobre os arquivos de mídia  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 516

Inserir e editar um objeto de mídia  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 518

Iniciar um editor de arquivos de mídia externo. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 521

Utilizar as Design Notes (Notas de design) com um objeto de mídia . . . . . . . . . . .523

Inserir e modificar um objeto de botão Flash . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .523

Inserir um objeto de texto do Flash. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .526

Inserir conteúdo Flash . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .526

Fazer o download e instalar os elementos Flash. . . . . . . . . . . . . . . . . . . . . . . . . . . . .527

Inserir elementos Flash . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .528

Editar atributos de elementos Flash. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 529

Inserir documento do FlashPaper. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 529

Inserir conteúdo do Flash Video . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 530

Inserir filmes Shockwave  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .534

Adicionar vídeo (não-Flash). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .535

Adicionar som a uma página . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .535

Inserir conteúdo de plug-in para Netscape Navigator . . . . . . . . . . . . . . . . . . . . . . . .537

Inserir um controle ActiveX  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 539

Inserir um applet Java . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 539
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Sobre os arquivos de mídia
É possível incluir arquivos com os seguintes tipos de mídia em suas páginas Dreamweaver: 
filmes Flash e Shockwave, QuickTime, AVI, applets Java, controles Active X e arquivos de 
áudio de vários formatos.

Sobre Flash tipos de arquivos
Alguns objetos Flash acompanham o Dreamweaver e você pode utilizá-los quer tenha ou não 
Flash instalado em seu computador. Caso disponha de Flash no seu sistema, consulte 
“Trabalhar com o Flash” na página 512 para obter mais informações sobre a utilização desses 
aplicativos de maneira integrada.

Antes de utilizar os comandos Flash disponíveis no Dreamweaver, você deve conhecer os 
diferentes tipos de arquivo do Flash:

O arquivo Flash (.fla) é um arquivo fonte de um projeto e é criado no programa Flash. Esse 
tipo de arquivo pode ser aberto apenas em Flash, e não no Dreamweaver nem em navegadores. 
É possível abrir um arquivo Flash no software Flash e, subseqüentemente, exportá-lo como 
um arquivo SWF ou SWT para ser utilizado nos navegadores.

O arquivo Flash SWF (.swf) é uma versão compactada do arquivo Flash (.fla), otimizado 
para visualização na Web. Esse arquivo pode ser executado em navegadores e visualizado no 
Dreamweaver, mas não pode ser editado no Flash. Esse é o tipo de arquivo criado ao utilizar 
os objetos Flash de texto Flash e de botão. Para obter mais informações, veja “Inserir e 
modificar um objeto de botão Flash” na página 523, “Inserir um objeto de texto do Flash” na 
página 526 e “Inserir conteúdo Flash” na página 526.

Os arquivos do modelo Flash (.swt) possibilitam modificar e substituir informações em um 
arquivo Flash SWF. Esses arquivos são utilizados no objeto de botão Flash, o que permite 
modificar o modelo através da inclusão de seus próprios textos e links, para criar um SWF 
personalizado e inseri-lo em seu documento. No Dreamweaver, estes arquivos de modelo 
podem ser encontrados nas pastas Dreamweaver/Configuration (Configuração)/Flash Objects 
(Objetos)/Flash Buttons (Botões) e Flash Text (Texto).

Também é possível fazer download de novos modelos de botão do Macromedia Exchange for 
Dreamweaver no site da Web (www.macromedia.com/go/dreamweaver_exchange) e colocá-
los na sua pasta de botões do Flash. Para obter mais informações sobre a criação de novos 
modelos de botões, consulte o artigo sobre este assunto no endereço www.macromedia.com/
go/flash_buttons.
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O arquivo do elemento Flash (.swc) é um arquivo Flash SWF que permite criar aplicativos 
Rich Internet incorporando-os a uma página da Web. Os elementos Flash têm parâmetros 
personalizáveis que você pode modificar para executar diferentes funções do aplicativo. Para 
obter mais informações, consulte “Inserir elementos Flash” na página 528 e “Editar atributos 
de elementos Flash” na página 529.

O formato de arquivo Flash Video (.flv) é um arquivo de vídeo que contém dados de vídeo e 
áudio codificados para serem apresentados pelo Flash Player. Por exemplo, se tiver um arquivo 
de vídeo QuickTime ou Windows Media, você pode usar um codificador (como Flash 8 
Video Encoder ou Sorensen Squeeze) para converter o arquivo de vídeo em um arquivo FLV. 
Para mais informações, visite o site Flash Video Developer Center no endereço 
www.macromedia.com/go/flv_devcenter.

Sobre formatos de arquivos de áudio
A lista a seguir descreve os formatos de arquivos de áudio mais comuns, junto com algumas 
das vantagens e desvantagens de cada um para os projetos da Web. 

O formato .midi ou .mid (Interface digital de instrumento musical, Musical Instrument 

Digital Interface) destina-se à música instrumental. Arquivos MIDI contam com suporte em 
diversos navegadores e não requerem um plug-in. Apesar de sua qualidade de som ser muito 
boa, ela pode variar dependendo da placa de som de um visitante. Um pequeno arquivo MIDI 
pode fornecer um longo clipe de som. Os arquivos MIDI não podem ser gravados e devem ser 
sintetizados num computador com hardware e software especiais.

Os arquivos no formato .wav (extensão Waveform) têm boa qualidade de som, contam com 
suporte em vários navegadores e não requerem um plug-in. É possível gravar arquivos WAV 
próprios de um CD, fita, microfone e outros dispositivos. No entanto, o grande tamanho dos 
arquivos limita seriamente o comprimento dos clipes de som que podem ser utilizados nas 
páginas da Web.

O formato .aif (ou AIFF - Audio Interchange File Format), assim como o formato WAV, 
possui uma qualidade de som boa, pode ser reproduzido na maioria dos navegadores e não 
necessita de plug-ins; também é possível gravar arquivos AIFF de um CD, fita, microfone, etc. 
No entanto, o grande tamanho dos arquivos limita seriamente o comprimento dos clipes de 
som que podem ser utilizados nas páginas da Web.
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O formato .mp3 (áudio do Motion Picture Experts Group ou Camada-3 de áudio MPEG) 

é um formato compactado que torna os arquivos de som consideravelmente menores. A 
qualidade de som é muito boa: se um arquivo MP3 tiver sido gravado e compactado 
corretamente, a sua qualidade pode competir com a de um CD. Novas tecnologias MP3 
permitem transferir o arquivo gradualmente, para que o visitante não precise esperar pelo 
download do arquivo inteiro até poder ouvi-lo. No entanto, o tamanho do arquivo é maior do 
que o de um arquivo Real Audio; assim, o download de uma música completa através de uma 
conexão via modem de acesso discado (linha telefônica) tradicional ainda pode ser bastante 
demorado. Para executar os arquivos MP3, os visitantes devem efetuar o download e instalar 
um aplicativo auxiliar ou plug-in, como QuickTime, Windows Media Player ou RealPlayer. 

O grau de compactação do formato .ra, .ram, .rpm ou Real Audio é muito alto e os tamanhos 
de arquivos são menores do que os arquivos no formato MP3. É possível efetuar o download 
de arquivos de música completos num período de tempo razoável. Como os arquivos podem 
ser transferidos gradualmente de um servidor da Web normal, os visitantes podem começar a 
ouvir o som antes que o download do arquivo tenha sido concluído. Para poder executar esses 
arquivos, os visitantes deverão efetuar o download e instalar o aplicativo auxiliar RealPlayer ou 
plug-in.

.qt, .qtm, .mov ou QuickTime é um formato de áudio e de vídeo desenvolvido pela Apple 
Computer. O QuickTime é incluído nos sistemas operacionais Apple Macintosh e é usado 
pela maioria dos aplicativos Macintosh que usam áudio, vídeo ou animação. Os PCs também 
podem reproduzir arquivos no formato QuickTime, mas exigem um driver QuickTime 
especial. O QuickTime suporta a maioria dos formatos de codificação, inclusive Cinepak, 
JPEG e MPEG.

Inserir e editar um objeto de mídia
É possível inserir objetos ou arquivos Flash SWF, filmes QuickTime ou Shockwave, applets 
Java, controles ActiveX ou outros objetos de áudio e vídeo em um documento Dreamweaver. 

Para inserir um objeto de mídia em uma página:

1. Coloque o ponto de inserção no local em que deseja inserir o objeto na janela do 
documento.

N
O

T
A

Além dos formatos mais comuns listados acima, há muitos outros formatos de arquivos 
de áudio e vídeo disponíveis para uso na Web. Se você encontrar um formato 
desconhecido de arquivo de mídia, localize o criador desse formato e solicite 
informações sobre o melhor meio para usá-lo e implantá-lo.
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2. Insira o objeto seguindo um dos procedimentos abaixo:

■ Na categoria Common (Comuns) da barra Insert (Inserir), clique no botão Media 
(Mídia) e selecione o botão relativo ao tipo de objeto que você quer inserir.

■ Selecione o objeto apropriado no submenu Insert > Media.
■ Se o objeto que você deseja inserir não for um objeto Flash, Shockwave, Applet ou 

ActiveX, use o botão de plug-in do Netscape Navigator - o ícone de uma peça de 
quebra-cabeças da barra Insert (Inserir) para inseri-lo. Para obter mais informações, 
consulte “Inserir conteúdo de plug-in para Netscape Navigator” na página 537.

Na maioria dos casos, será exibida uma caixa de diálogo que permite escolher um arquivo 
de origem e especificar certos parâmetros do objeto de mídia.

3. Complete a caixa de diálogo Select File (Selecione arquivo) ou Insert Flash (Inserir Flash).

D
IC

A
Para evitar a exibição de certas caixas de diálogo, selecione Edit (Editar) > 
Preferences (Preferências) > General (Geral) (Windows) ou Dreamweaver> 
Preferences > General (Mac OS X) e desmarque a opção Show Dialog When 
Inserting Objects (Mostrar a caixa de diálogo quando inserir objetos). Para anular 
qualquer preferência definida para exibir caixas de diálogo, mantenha pressionada a 
tecla Control (no Windows) enquanto o objeto é inserido (Por exemplo, para inserir 
um alocador de espaço para um filme Shockwave sem especificar o arquivo, 
mantenha pressionada a tecla Control ou Option e clique no botão Shockwave no 
menu pop-up Media da guia Common da barra Insert, ou selecione Insert > Media > 
Shockwave.) 
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4. Clique em OK.

Será exibida a caixa de diálogo Object Tag Accessibility Attributes (Atributos de acesso da 
tag de objeto) se essa caixa estiver ativada em Preferences (consulte “Otimizar a área de 
trabalho para o projeto de página acessível” na página 76).

5. Se a caixa de diálogo Object Tag Accessibility Attributes (Atributos de acesso da tag de 
objeto) aparecer, preencha-a e clique em  OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
O objeto de mídia será exibido no documento. 

Para especificar um arquivo de origem, definir as dimensões e outros parâmetros e 
atributos, utilize o Property inspector (Inspetor de propriedades) para cada objeto. 

Editar atributos de acessibilidade de objetos de mídia
Se você agregou atributos de acessibilidade a um objeto de mídia (consulte “Inserir e editar 
um objeto de mídia” na página 518), é possível editar estes valores no código HTML.

Para editar valores de acessibilidade de um objeto de mídia:

1. Na janela do documento, selecione o objeto.

2. Siga um dos procedimentos abaixo:

■ Edite os atributos apropriados na visualização do código. 
■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 

pressionada (no Macintosh) e selecione Edit Tag Code (Editar código da tag). 

N
O

T
A

Caso pressione Cancel (Cancelar), o alocador de espaço do objeto de mídia será 
exibido no documento, mas o Dreamweaver não associará a ele tags de 
acessibilidade nem atributos.
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Iniciar um editor de arquivos de mídia 
externo
É possível iniciar um editor externo ao Dreamweaver para editar a maioria dos arquivos de 
mídia. Também é possível definir o editor que deseja que o Dreamweaver inicie para editar o 
arquivo.

Iniciar um editor externo ao Dreamweaver
É possível iniciar um editor externo ao Dreamweaver para editar a maioria dos arquivos de 
mídia. 

Para iniciar um editor externo a partir do Dreamweaver:

1. Assegure-se de que o tipo do arquivo de mídia esteja associado a um editor em seu sistema.

Para descobrir qual editor está associado ao tipo de arquivo, selecione Edit (Editar)  > 
Preferences (Preferências) em Dreamweaver e selecione File Types/Editors (Tipos de 
arquivos/Editores) na lista Category (Categoria). Clique na extensão do arquivo na coluna 
Extensions (Extensões) para descobrir os editores associados a ele na coluna Editors 
(Editores). Você pode alterar o editor associado a um tipo de arquivo. Para obter mais 
informações, consulte “Especificar o editor a iniciar usando o Dreamweaver” na 
página 522.

2. Clique duas vezes no arquivo de mídia no painel Site para abri-lo no editor externo.

O editor que é iniciado quando você clica duas vezes no arquivo no painel Site é 
denominado editor primário. Se você clicar duas vezes em um arquivo de imagem, por 
exemplo, o Dreamweaver abrirá o arquivo no editor de imagens externo primário, como o 
Macromedia Fireworks.

3. Se você não deseja utilizar o editor externo primário para editar o arquivo, é possível utilizar 
outro editor de seu sistema, seguindo um dos procedimentos abaixo:

■ No painel Site, clique com o botão direito do mouse (Windows) ou clique com a tecla 
Control pressionada (Macintosh) no nome do arquivo desejado e selecione Open 
With (Abrir com) no menu contextual

■ Na visualização do projeto, clique com o botão direito do mouse (Windows) ou clique 
com a tecla Control pressionada (Macintosh) no elemento de mídia da página atual e 
selecione Edit With (Editar com) no menu contextual.
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Especificar o editor a iniciar usando o Dreamweaver
É possível especificar o editor desejado Dreamweaver para editar um tipo de arquivo e 
adicionar ou excluir tipos de arquivos reconhecidos pelo Dreamweaver.

Para especificar explicitamente quais editores externos devem ser iniciados 
para um tipo de arquivo definido:

1. Selecione Edit (Editar)  > Preferences (Preferências) e selecione File Types/Editors (Tipos 
de arquivos/editores) na lista Category (Categoria).

As extensões dos nomes de arquivos, como .gif, .wav e .mpg, encontram-se listadas à 
esquerda, em Extensions (Extensões). Os editores associados à extensão selecionada 
encontram-se listados à direita, abaixo de Editors (Editores).

2. Selecione a extensão do tipo de arquivo na lista Extensions e siga um dos procedimentos 
abaixo:

■ Para associar um novo editor ao tipo de arquivo, clique no botão com  o sinal de 
adição (+) acima da lista Editors e preencha a caixa de diálogo que será apresentada.
Por exemplo, selecione o ícone do aplicativo Acrobat para associá-lo ao tipo de 
arquivo.

■ Para fazer de um editor o editor primário de um tipo de arquivo (ou seja, o editor que 
é aberto quando você clica duas vezes sobre o tipo de arquivo no painel Site), selecione 
o editor na lista Editors e clique em Make Primary (Tornar primário).

■ Para dissociar um editor de um tipo de arquivo, selecione-o na lista Editors e clique no 
botão com o sinal de subtração (-) acima da lista Editors.

Para incluir um novo tipo de arquivo e um editor associado:

1. Clique no botão com sinal de adição (+) acima da lista Extensions e digite a extensão de 
tipo de arquivo (incluindo o ponto no início da extensão) ou as diversas extensões 
relacionadas, separadas por espaços.

Por exemplo, você pode digitar .xml .xsl se desejar associá-los com um editor XML 
instalado em seu sistema.

2. Selecione um editor para o tipo de arquivo, clicando no botão com sinal de adição (+) acima 
da lista Editors, e preencha a caixa de diálogo que for exibida. 

Para remover um tipo de arquivo:

■ Selecione o tipo de arquivo na lista Extensions (Extensões) e clique no botão com sinal de 
subtração (-) localizado acima dessa lista.

N
O

T
A

É impossível desfazer a ação após remover um tipo de arquivo; portanto é 
necessário ter certeza de que deseja removê-lo.
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Utilizar as Design Notes (Notas de 
design) com um objeto de mídia
Assim como em outros objetos no Dreamweaver, você também pode adicionar Design Notes 
(Notas de design) a um objeto de mídia. Design Notes são anotações associadas a um arquivo 
em particular que são armazenadas em um arquivo separado. Utilize as Design Notes para 
controlar as informações adicionais relativas aos documentos, como nomes de arquivos de 
origem de imagens e comentários sobre o status de arquivos. Para obter mais informações 
sobre como trabalhar com Design Notes, veja “Armazenar informações sobre arquivos nas 
Design Notes” na página 167. 

Para adicionar Design Notes a um objeto de mídia:

1. Clique com o botão direito do mouse (Windows) ou clique com a tecla Control 
pressionada (Macintosh) no objeto da janela do documento.

2. No menu contextual, escolha Design Notes.

3. Digite as informações que deseja na Design Note.

Inserir e modificar um objeto de botão 
Flash 
Enquanto trabalha com o Dreamweaver, é possível criar, inserir e modificar botões Flash em 
seus documentos. Não é necessário dispor do Macromedia Flash. Um objeto de botão Flash é 
um botão atualizável baseado em um modelo Flash. É possível personalizar um objeto de 
botão Flash , adicionando texto, cor de fundo e links para outros arquivos. 

N
O

T
A

É necessário definir o site antes de adicionar Design Notes a qualquer objeto (veja 
“Ativar e desativar as Design Notes de um site” na página 168).

D
IC

A

Também é possível adicionar uma Design Note a um objeto de mídia na painel Site 
ao selecionar o arquivo, exibir o menu contextual e selecionar as Design Notes neste 
menu.
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Criar e inserir um botão Flash
É possível criar e inserir um botão Flash em seus documentos através da visualização do 
projeto ou da visualização de código.

Para inserir um objeto de botão Flash:

1. Na janela do documento, coloque o ponto de inserção onde deseja inserir o botão Flash.

2. Para abrir a caixa de diálogo Insert Flash Object (Inserir objeto Flash), siga um dos 
procedimentos abaixo:

■ Na categoria Common (Comuns) da barra Insert (Inserir), selecione Media (Mídia) e, 
em seguida, clique no ícone Flash Button (Botão Flash).

■ Selecione Insert > Media > Flash Button. 
A caixa de diálogo Insert Flash Button (Inserir botão Flash) será exibida.

3. Preencha a caixa de diálogo Insert Flash Button e clique em Apply (Aplicar) ou em OK para 
inserir o botão Flash na janela do documento.

Modificação de um objeto de botão Flash
É possível modificar as propriedades e o conteúdo de um objeto de botão Flash. 

N
O

T
A

É necessário salvar os documentos antes de inserir um objeto Flash de botão ou de 
texto.

D
IC

A

Para visualizar o botão na visualização de projeto, clique em Apply. A caixa de 
diálogo permanecerá aberta e você poderá visualizar o botão em seu documento.
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Para modificar um objeto de botão Flash:

1. Na janela do documento, clique no objeto de botão Flash para selecioná-lo.

2. Abra o Property inspector (Inspetor de propriedades), se ele ainda não tiver sido aberto. 

O Property inspector exibirá as propriedades do botão Flash. Utilize o Property inspector 
para modificar os atributos HTML do botão, como largura, altura e cor de fundo. 

3. Para alterar o conteúdo, abra a caixa de diálogo Insert Flash Button (Inserir botão Flash) 
utilizando um dos métodos a seguir:

■ Clique duas vezes no objeto de botão Flash.
■ No Property inspector, clique em Edit (Editar).
■ Clique com o botão direito do mouse (Windows) ou clique com a tecla Control 

pressionada (Macintosh) e, em seguida, selecione Edit (Editar) no menu contextual.
4. Na caixa de diálogo Insert Flash Button (Inserir botão Flash), faça as edições desejadas nas 

caixas de texto descritas anteriormente (consulte “Inserir e modificar um objeto de botão 
Flash” na página 523).

Na visualização do projeto, é possível redimensionar o objeto facilmente utilizando as alças 
de redimensionamento. Para redimensionar o objeto ao seu tamanho original, selecione 
Reset Size (Redefinir tamanho), no Property inspector (consulte “Redimensionar uma 
imagem” na página 453).

Execução de um objeto de botão Flash no 
documento
É possível visualizar um botão Flash na janela do documento de Dreamweaver.

Para visualizar a execução do objeto de botão Flash na janela do documento:

1. Na visualização do projeto, selecione um objeto de botão Flash.

2. No Property inspector (Inspetor de propriedades), clique em Play (Executar).

3. Clique em Stop (Parar), para terminar a visualização.

Também é conveniente visualizar o documento no navegador para ver exatamente como 
aparece o  botão Flash.

N
O

T
A

Não é possível editar o objeto de botão Flash enquanto ele estiver em execução. 
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Inserir um objeto de texto do Flash 
O objeto de texto Flash possibilita criar e inserir um arquivo Flash SWF que contenha apenas 
texto. Isso permite criar um pequeno filme com gráficos vetoriais com fontes e texto de sua 
escolha.

Para inserir um objeto de texto Flash: 

1. Na janela do documento, coloque o ponto de inserção onde deseja inserir o texto Flash.

2. Para abrir a caixa de diálogo Insert Flash Text (Inserir texto Flash), siga um dos 
procedimentos abaixo:

■ Na categoria Common (Comuns) da barra Insert (Inserir), selecione Media (Mídia) e, 
em seguida, clique no ícone Flash Text (Texto Flash).

■ Selecione Insert > Media > Flash Text.
A caixa de diálogo Insert Flash Text (Inserir texto Flash) será exibida.

3. Preencha a caixa de diálogo Insert Flash Text e clique em Apply (Aplicar) ou em OK para 
inserir o texto Flash na janela do documento.

Ao clicar em Apply (Aplicar), a caixa de diálogo permanecerá aberta e será possível 
visualizar o texto no documento.

Para modificar ou executar o objeto de texto Flash, utilize o mesmo procedimento adotado 
para o botão Flash (consulte “Modificação de um objeto de botão Flash” na página 524).

Inserir conteúdo Flash
É possível usar o Dreamweaver para inserir conteúdo Flash em suas páginas. 
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Para inserir um arquivo SWF (conteúdo Flash):

1. Na visualização do projeto, na janela do documento, colocar o ponto de inserção onde 
deseja inserir o filme.

■ Na categoria Common (Comuns) da barra Insert (Inserir), selecione Media (Mídia) e, 
em seguida, clique no ícone Insert Flash.

■ Selecione Insert (Inserir) > Media (Mídia) > Flash.
2. Na caixa de diálogo que será exibida, selecione um arquivo Flash (.swf). 

Um alocador de espaço Flash será exibido na janela do documento (diferentemente dos 
objetos de texto e do botão Flash). Para obter informações sobre como definir 
propriedades para um arquivo Flash SWF, selecione o alocador de espaço e clique no botão 
Help (Ajuda) do Property inspector. 

Para visualizar o conteúdo do Flash na janela do documento:

1. Na janela do documento, clique no alocador de espaço do Flash para selecionar o conteúdo 
do Flash que deseja visualizar.

2. No Property inspector, clique no botão Play (Executar). Clique em Stop (Parar), para 
terminar a visualização. Também é possível visualizar o conteúdo do Flash em um 
navegador, pressionando a tecla F12. 

Fazer o download e instalar os elementos 
Flash
Para usar elementos Flash em suas páginas da Web, você deverá, primeiramente, adicionar os 
elementos ao Dreamweaver usando o Extension Manager. O Extension Manager é um 
aplicativo independente que permite instalar e gerenciar as extensões nos aplicativos da 
Macromedia. Inicie o Extension Manager no Dreamweaver escolhendo Commands 
(Comandos) > Manage Extensions (Gerenciar extensões). 

D
IC

A

Para visualizar todo o conteúdo Flash numa página, pressionar simultaneamente as 
teclas Control+Alt+Shift+P (no Windows) ou Shift+Option+Command+P (Macintosh). 
Todos os objetos e arquivos SWF do Flash estão definidos para Play (Executar).
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Para localizar os elementos mais recentes do Flash para o Dreamweaver, utilize o site do 
Macromedia Exchange na Web, em www.macromedia.com/go/dreamweaver_exchange. Neste 
site, é possível efetuar o login e o download de elementos Flash e de outras extensões do 
Dreamweaver (muitas das quais são gratuitas), participar de grupos de discussão, visualizar as 
avaliações e críticas dos usuários, além de instalar e utilizar o Extension Manager. Você deverá 
instalar o Extension Manager antes de instalar os novos elementos Flash ou outras extensões 
do Dreamweaver.

Para obter informações sobre a utilização do Extension Manager para instalar elementos Flash 
(além de outras extensões do Dreamweaver), consulte “Adicionar extensões ao Dreamweaver” 
na página 84. 

Inserir elementos Flash
Usando o Dreamweaver, você pode inserir elementos Flash em seus documentos. Os 
elementos Flash permitem construir, de modo fácil e rápido, aplicativos Rich Internet 
Application usando elementos predefinidos. Para obter mais informações sobre elementos 
Flash e mostrar como eles podem ser usados em suas páginas da Web, consulte “Sobre Flash 
tipos de arquivos” na página 516.

Para inserir um elemento Flash:

1. Na janela do documento, coloque o ponto de inserção onde deseja inserir o elemento Flash 
e siga um dos procedimentos abaixo:

■ Na categoria de elementos Flash da barra Insert (Inserir), clique no ícone do elemento 
Flash que você quer inserir.

■ Selecione Insert > Media > nome do elemento do Flash.
Dreamweaver inclui um elemento Flash denominado Image Viewer (Visualizador de 
imagens).

A caixa de diálogo Save Flash Element (Salvar elemento Flash) será exibida.
2. Digite um nome de arquivo para o elemento Flash e salve-o em um local adequado no seu 

site.

3. Clique em OK.

O alocador de espaço do elemento Flash será exibido no documento. É possível modificar 
as propriedades do elemento Flash usando os inspetores de Tags e de Propriedades. 

4. Selecione File (Arquivo) > Preview in Browser (Visualizar no navegador) para visualizar o 
elemento Flash.
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Editar atributos de elementos Flash
Você edita atributos de elementos Flash usando os inspetores de Tags e de Propriedades.

Para editar atributos de elementos Flash:

1. Siga um destes procedimentos na janela Document (Documento):

■ Na visualização do projeto, selecione o elemento Flash.
■ Na visualização do código, clique em qualquer lugar do nome ou do conteúdo de um 

componente do Flash. 
2. Abra o Tag inspector (Inspetor de tags) (Windows > Tag inspector) se ele ainda não estiver 

sendo exibido.

3. Edite os atributos do elemento Flash usando o Tag inspector e o Property inspector 
(Inspetor de propriedades). 

4. Pressione Enter (no Windows) ou Return (no Macintosh), ou clique em qualquer parte do 
Tag inspector, para atualizar a tag no documento.

Para obter mais informações, clique no botão Help (Ajuda) do Tag inspector.

Inserir documento do FlashPaper
É possível inserir documentos do Macromedia FlashPaper em páginas da Web. Quando o 
usuário abre no navegador uma página que contém um documento FlashPaper, ele pode fazer 
buscas em todas as páginas desse documento sem precisar carregar novas páginas da Web. 
Além disso, ele pode fazer buscas no documento, imprimi-lo e aumentar ou reduzir seu 
tamanho (zoom).

Para obter mais informações sobre FlashPaper, consulte o site da Macromedia na Web, em 
www.macromedia.com/go/flashpaper.

Para inserir um documento FlashPaper em uma página da Web:

1. Na janela do documento, posicione o ponto de inserção no local da página onde deseja 
exibir o documento FlashPaper e, em seguida, selecione Insert > Media > FlashPaper. 

2. Na caixa de diálogo Insert FlashPaper (Inserir FlashPaper), selecione o documento 
FlashPaper desejado. 

3. Se preferir, especifique as dimensões do objeto FlashPaper na página da Web, inserindo a 
largura e a altura em pixels.

FlashPaper ajustará o documento de acordo com a largura definida.
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4. Clique em OK para inserir o documento na página.

Como o documento FlashPaper é um objeto Flash, será exibido um alocador de espaço 
Flash na página.

5. Para visualizar o documento FlashPaper, clique no alocador de espaço e, em seguida, clique 
no botão Play (Executar) no Property inspector. 

Clique em Stop (Parar), para terminar a visualização. Também é possível visualizar o 
documento em um navegador, pressionando a tecla F12. A barra de ferramentas do 
FlashPaper está totalmente ativa no navegador.

6. Se preferir, defina outras propriedades no Property inspector.

Como um objeto Flash, o objeto FlashPaper compartilha o Property inspector do objeto 
Flash. Para obter informações sobre como definir as propriedades, clique no botão Help 
(Ajuda) no Property inspector.

Inserir conteúdo do Flash Video
O Dreamweaver permite inserir facilmente o conteúdo do Flash Video nas páginas da Web 
sem precisar usar a ferramenta de autoria do Flash. O Dreamweaver insere o componente 
Flash Video; quando visualizado em um navegador, esse componente mostra o conteúdo do 
Flash Video que você selecionou, bem como um conjunto de controles de execução.

D
IC

A

Para visualizar todo o conteúdo Flash numa página, pressione simultaneamente as 
teclas Control+Alt+Shift+P (no Windows) ou Shift+Option+Command+P (Macintosh). 
Todos os objetos Flash e arquivos SWF estão definidos como Play (Executar).
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Esta seção contém os tópicos a seguir:

■ “Sobre a inserção do Flash Video” na página 531
■ “Inserir conteúdo do Flash Video” na página 532
■ “Detectar a versão do Flash Player para ver o Flash Video” na página 532
■ “Editar e excluir um componente Flash Video” na página 533

Para obter mais informações sobre o Flash Video, visite o Flash Video Developer Center, em 
www.macromedia.com/go/flv_devcenter.

Sobre a inserção do Flash Video
O Dreamweaver oferece as seguintes opções para apresentar o Flash Video aos visitantes de seu 
site:

Progressive Download Vídeo (Download progressivo de vídeo) faz o download do arquivo 
Flash Video (FLV) para o disco rígido do visitante do site e o executa. Diferentemente dos 
métodos tradicionais de “download e execução” das apresentações de vídeo, o download 
progressivo permite executar o arquivo de vídeo antes de concluir o download.

Streaming Video (Vídeo de transmissão em fluxo contínuo) transmite o conteúdo do Flash 
Video em fluxos e somente o executa na página da Web após mantê-lo por um breve período 
no buffer, o que assegura uma execução estável. Para ativar o recurso de vídeo de transmissão 
em fluxo contínuo nas páginas da Web, é necessário ter acesso ao Macromedia Flash 
Communication Server.

Você precisa ter um arquivo Flash Video (FLV) codificado para poder utilizá-lo no 
Dreamweaver. É possível inserir arquivos de vídeo criados por meio de dois tipos de codecs 
(tecnologias de compactação/descompactação): Sorenson Squeeze e On2.

■ Se você criou o vídeo com a codec Sorenson Squeeze, os visitantes do site precisarão do 
Flash Player 7 ou de uma versão posterior para executar o download progressivo do vídeo; 
no caso do vídeo de transmissão contínua, eles precisarão do Flash Player 6.0.79 ou 
posterior. 

■ Se você criou o vídeo com a codec On2, os visitantes do site precisarão do Flash Player 8 
ou posterior. 

Uma vez inserido um arquivo Flash Video em uma página, você pode inserir código na página 
para detectar se o usuário tem a versão correta do Flash Player para ver o Flash Video. Caso 
não tenham a versão correta, eles serão solicitados a fazer o download da última versão do 
Flash Player. Para obter mais informações, consulte “Detectar a versão do Flash Player para ver 
o Flash Video” na página 532.
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Para obter mais informações sobre o Flash Video, visite o Flash Video Developer Center em 
www.macromedia.com/go/flv_devcenter.

Tópicos relacionados
■ “Detectar a versão do Flash Player para ver o Flash Video” na página 532
■ “Editar e excluir um componente Flash Video” na página 533

Inserir conteúdo do Flash Video
É possível usar o Dreamweaver para inserir conteúdo do Flash Video em suas páginas. Para 
isso, é necessário ter um arquivo Flash Video (FLV). Para obter mais informações, consulte 
“Sobre Flash tipos de arquivos” na página 516.

Para inserir Flash Video em uma página da Web:

1. Selecione Insert (Inserir)> Media (Mídia) > Flash Video.

2. Na caixa de diálogo Insert Flash Video (Inserir Flash Vídeo), selecione Progressive 
Download ou Streaming Video no menu pop-up Video Type (Tipo de vídeo).

Para obter mais informações sobre essas duas opções, consulte “Sobre a inserção do Flash 
Video” na página 531.

3. Complete o restante das opções da caixa de diálogo. 

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
É possível selecionar uma opção que insere o código que detecta a versão Flash Player 
necessária para ver o Flash Vídeo; se o usuário não tiver a versão correta, essa opção o 
instruirá a fazer o download da última versão do Flash Player. Para obter mais 
informações, consulte “Detectar a versão do Flash Player para ver o Flash Video” na 
página 532.

4. Clique em OK.

Tópicos relacionados
■ “Editar e excluir um componente Flash Video” na página 533

Detectar a versão do Flash Player para ver o Flash 
Video
Ao inserir um arquivo Flash Video em sua página, você também pode inserir um código que 
detecta se o usuário possui a versão correta do Flash Player para ver o Flash Video. Caso não 
tenha a versão correta, ele será solicitado a fazer o download da última versão do Flash Player. 
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Dependendo da codec utilizada para criar o vídeo, talvez seja necessária uma versão diferente 
do Flash Player para exibir o Flash Vídeo. Se você criou o vídeo com a codec Sorenson 
Squeeze, os visitantes do site precisarão do Flash Player 7 ou posterior para executar o 
donwload progressivo do vídeo; no caso do vídeo de transmissão em fluxo contínuo, eles 
precisarão do Flash Player 6.0.79 ou posterior. Se o vídeo foi criado com a codec On2, os 
visitantes do site precisarão do Flash Player 8 ou posterior. 

Para inserir o código que detecta a versão do Flash Player:

1. Ao inserir um Flash Video em uma página, selecione a opção Prompt Users to Download 
Flash Player if Necessary (Instruir usuários a fazerem download do Flas Player se necessário) 
na caixa de diálogo Insert Flash Video (Inserir Flash Video).

Se o Flash Video já estiver na sua página, exclua-o e, em seguida, insira-o novamente com 
a opção selecionada.

2. Aceite a mensagem de aviso padrão ou forneça sua própria mensagem.

Se decidir remover o Flash Video de sua página, você não precisará mais do código de 
detecção. Use o Dreamweaver para removê-lo.

Para remover o código que detecta a versão do Flash Player:

■ Selecione Commands (Comandos)> Remove Flash Video Detection (Remover detecção 
de Flash Video).

Tópicos relacionados
■ “Inserir conteúdo do Flash Video” na página 532

Editar e excluir um componente Flash Video
Para alterar as definições do conteúdo Flash Video em sua página da Web, é necessário 
selecionar o alocador de espaço do componente Flash Video na janela Dreamweaver 
Document (Documento do Dreamweaver) e usar o Property inspector; ou, você pode excluir 
o componente Flash Video e inseri-lo novamente, selecionando Insert (Inserir) > Media 
(Mídia) > Flash Video.

N
O

T
A

Se você inserir outro Flash Video que requeira uma versão mais adiantada do Flash 
Player, o código de detecção instruirá o usuário a fazer o download da versão 
apropriada.
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Para editar o componente Flash Video:

1. Selecione o alocador de espaço do componente Flash Video na janela Dreamweaver 
Document, clicando no ícone Flash Video no centro do alocador de espaço.

2. Abra o Property inspector (Inspetor de propriedades), em Window (Janela) > Properties 
(Propriedades).

3. Faça as alterações. 

As opções do Property inspector são semelhantes às da caixa de diálogo Insert Flash Video 
(Inserir Flash Video). Para obter mais informações, clique no botão Help (Ajuda) do 
Property inspector.

Para excluir o componente Flash Video:

■ Selecione a alocador de espaço do componente Flash Video na janela Dreamweaver 
Document e pressione Delete (Excluir).

Tópicos relacionados
■ “Inserir conteúdo do Flash Video”

Inserir filmes Shockwave
É possível utilizar o Dreamweaver para inserir filmes Shockwave em seus documentos. 
Shockwave, o padrão da Macromedia para multimídia interativa na Web, é um formato 
compactado que permite o download rápido dos arquivos de mídia criados em Macromedia 
Director, para que sejam executados pela maior parte dos navegadores mais comuns.

Para inserir um filme Shockwave:

1. Na janela do documento, coloque o ponto de inserção onde deseja inserir um filme 
Shockwave e siga um dos procedimentos abaixo:

■ Na categoria Common (Comuns) da barra Insert (Inserir), clique no botão Media 
(Mídia) e selecione o ícone Shockwave no menu.

■ Selecione Insert > Media > Shockwave. 
2. Na caixa de diálogo que será exibida, selecione um arquivo de filme.

3. No Property inspector, digite a largura e a altura do filme nas caixas W (L) e H (A).

N
O

T
A

Você não pode alterar os tipos de vídeo (por exemplo, de download progressivo para 
fluxo contínuo) no Property inspector. Para fazer isso, é necessário excluir o 
componente Flash Video e, depois, inseri-lo novamente, selecionando Insert > Media 
> Flash Video.
534 Capítulo 17:  Adicionar áudio, vídeo e elementos interativos



         
Adicionar vídeo (não-Flash)
É possível adicionar vídeo à página da Web de diversas maneiras e utilizando vários formatos. 
É possível efetuar o download de vídeo para o usuário ou ele pode ser transferido 
gradualmente para que seja executado durante o download. 

Para incluir um pequeno vídeo clipe em sua página para que o usuário possa 
fazer download:

1. Coloque o clipe na pasta do seu site.

Esses clipes estão geralmente no formato de arquivo AVI ou MPEG.
2. Estabeleça um link para o clipe ou incorpore-o à sua página.

Para estabelecer um link para o clipe, digite um texto que sirva de link, como “Fazer 
download do clipe”, selecione o texto e clique no ícone da pasta do Property inspector 
(Inspetor de propriedades). Procure o arquivo de vídeo e selecione-o.

Para obter informações sobre como incluir um fluxo de vídeo em sua página, consulte “Inserir 
conteúdo de plug-in para Netscape Navigator” na página 537. 

Adicionar som a uma página
É possível adicionar som a uma página da Web. Existem diversos tipos diferentes de arquivos e 
formatos de som como .wav, .midi e .mp3. Para obter mais informações, consulte “Sobre 
formatos de arquivos de áudio” na página 517. Dentre os fatores a serem considerados antes 
de decidir qual formato e método serão utilizados para adicionar o som, estão o objetivo, o 
público, o tamanho do arquivo, a qualidade do som e as diferenças entre os navegadores. 

Vinculação a um arquivo de áudio
A vinculação a um arquivo de áudio é uma maneira simples e efetiva de adicionar som às 
páginas da Web. Esse método de incorporar arquivos de som permite aos visitantes escolher se 
desejam ouvir o arquivo e coloca o arquivo à disposição de um público maior 

N
O

T
A

O usuário deve fazer download de um aplicativo auxiliar para visualizar os formatos de 
fluxos mais comuns, como Real Media, QuickTime e Windows media. 

N
O

T
A

Os arquivos sonoros são tratados de forma diferente e inconsistente pelos diversos 
navegadores. Pode-se desejar adicionar um arquivo de som a um arquivo Flash SWF, 
em seguida, incorporar o arquivo SWF para melhorar a consistência. 
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Para criar um link para um arquivo de áudio:

1. Selecione o texto ou a imagem que deseja utilizar como link ao arquivo de áudio.

2. No Property inspector (Inspetor de propriedades), clique no ícone de pasta, para procurar 
o arquivo de áudio, ou digite o caminho e o nome do arquivo no campo Link.

Incorporação de um arquivo de som
A incorporação de áudio acrescenta o som diretamente na página, mas o som será reproduzido 
apenas se os visitantes do seu site contarem com o plug-in adequado ao arquivo escolhido. 
Incorpore arquivos caso deseje usar o som como música de fundo ou controlar o volume, a 
aparência do reprodutor na página ou os pontos de início e fim do arquivo de som. 

Para incorporar um arquivo de áudio

1. Na visualização do projeto, coloque o ponto de inserção onde deseja incorporar o arquivo 
e siga um dos procedimentos abaixo:

■ Na categoria Common (Comuns) da barra Insert (Inserir), clique no botão Media 
(Mídia) e selecione o  ícone do plug-in.

■ Selecione Insert > Media >  Plugin.
Para obter mais informações sobre o objeto de plug-in, veja “Inserir conteúdo de plug-in 
para Netscape Navigator” na página 537.

2. No Property inspector (Inspetor de propriedades), clique no ícone de pasta, para procurar 
o arquivo de áudio, ou digite o caminho e o nome do arquivo no campo Link.

3. Digite a largura e a altura, inserindo os valores nas caixas de texto apropriadas ou 
redimensionando o alocador de espaço de plug-in na janela do documento.

Esses valores determinam o tamanho com o qual os controles de áudio serão exibidos no 
navegador.

D
IC

A

Ao incorporar arquivos de som às suas páginas da Web, considere cuidadosamente o 
uso apropriado no seu site e o modo como os visitantes desse site usam recursos de 
mídia. Forneça sempre um controle para ativar ou desativar a execução do som, caso os 
visitantes não desejem ouvir o conteúdo sonoro.
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Inserir conteúdo de plug-in para 
Netscape Navigator
É possível criar conteúdo como um filme QuickTime para um plug-in para Netscape 
Navigator e usar o Dreamweaver para inserir este conteúdo em um documento HTML. 
Dentre os plug-ins mais freqüentes estão o RealPlayer e QuickTime, enquanto alguns 
arquivos de conteúdo incluem MP3s e filmes QuickTime.

Inserir conteúdo de plug-in em sua página
Sua página pode abrigar conteúdo que será reproduzido por um plug-in no navegador do 
usuário.

Para inserir conteúdo de plug-in para Netscape Navigator:

1. Na visualização do projeto, na janela do documento, colocar o ponto de inserção onde 
deseja inserir o filme.

■ Na categoria Common (Comuns) da barra Insert (Inserir), selecione Media (Mídia) e, 
em seguida, clique no ícone do plug-in.

■ Selecione Insert > Media >  Plugin.
2. Na caixa de diálogo que será exibida, selecione um arquivo de conteúdo para um plug-in 

para Netscape Navigator.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Executar um plug-in na janela do documento
É possível visualizar filmes e animações baseados em plug-ins para Netscape Navigator 
diretamente na visualização do projeto da janela do documento. Você pode reproduzir todos 
os elementos de plug-in simultaneamente, para verificar a aparência que a página terá para o 
usuário, ou pode reproduzir cada elemento separadamente, para assegurar que o elemento de 
mídia correto tenha sido incorporado.

Para reproduzir filmes na visualização de projeto, é necessário que os plug-ins adequados 
tenham sido instalados no seu computador. 

N
O

T
A

Não é possível visualizar filmes e animações baseados em controles ActiveX.
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Para executar o conteúdo de plug-ins na janela do documento:

1. Para inserir um ou mais elementos de mídia, selecione Insert (Inserir) > Media (Mídia) > 
Shockwave, Insert (Inserir) > Media (Mídia) > Flash ou Insert (Inserir) > Media (Mídia) > 
Plug-in. 

2. Siga um dos procedimentos abaixo:

■ Selecione um dos elementos de mídia inseridos e selecione View (Exibir) > Plug-ins  > 
Play (Executar), ou clique no botão Play, no Property inspector (Inspetor de 
propriedades).

■ Selecione View > Plug-ins > Play All (Executar todos), para executar todos os 
elementos de mídia na página selecionada que dependerem de plug-ins.

Para parar a execução do conteúdo de plug-ins:

■ Escolha um elemento de mídia e selecione View > Plug-ins > Stop (Parar) ou clique no 
botão Stop, no Property inspector (Inspetor de propriedades).
Também é possível selecionar View > Plugins > Stop All (Parar todos) para parar a 
reprodução de todos os conteúdos de plug-in.

Solução de problemas dos plug-ins para Netscape 
Navigator
Se, após ter seguido essas etapas para executar o conteúdo do plug-in na janela do documento, 
algum conteúdo de plug-in não for executado, tente um dos procedimentos abaixo:

■ Certifique-se de que o plug-in associado esteja instalado no computador e de que o 
conteúdo do mesmo seja compatível com a versão do plug-in existente.

■ Abra o arquivo Configuration (Configuração)/Plugins (Plug-ins)/UnsupportedPlugins.txt 
(Plug-ins não suportados.txt) em um editor de texto e procure, na lista, o plug-in com 
problemas. Esse arquivo mantém um registro dos plug-ins que causam problemas no 
Dreamweaver e, por isso, não contam com suporte. (se houver problemas com qualquer 
outro plug-in, adicioná-lo a esse arquivo).

■ Verifique se há memória suficiente. Alguns plug-ins exigem entre 2 MB e 5 MB a mais de 
memória, para que sejam executados.

N
O

T
A

A opção Play All se aplica ao documento atual e não a outros documentos num 
conjunto de quadros, por exemplo.
538 Capítulo 17:  Adicionar áudio, vídeo e elementos interativos



         
Inserir um controle ActiveX
Você pode inserir um controle ActiveX em sua página. Os controles ActiveX (anteriormente 
conhecidos como controles OLE) são componentes reutilizáveis semelhantes a applets que 
podem funcionar como plug-ins dos navegadores. Eles são executados em Internet Explorer 
com Windows, porém não são executados em Macintosh ou em Netscape Navigator. No 
 Dreamweaver, o objeto ActiveX permite que você defina atributos e parâmetros para um 
controle ActiveX no navegador do visitante.

Para inserir o conteúdo de controles ActiveX:

1. Na janela do documento, coloque o ponto de inserção onde deseja inserir o conteúdo e siga 
um dos procedimentos abaixo:

■ Na categoria Common (Comuns) da barra Insert (Inserir), clique na seta para baixo no 
botão Media (Mídia) e selecione o ícone ActiveX.

■ Na categoria Common da barra Insert, clique na seta para baixo no botão Media e 
selecione o ícone ActiveX. Com o ícone ActiveX exibido na barra Insert, é possível 
arrastá-lo para a janela do documento

■ Selecione Insert > Media > ActiveX.
Um ícone marca o local onde o controle ActiveX será exibido na página no 
Internet Explorer.
Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Inserir um applet Java
É possível usar o Dreamweaver para inserir um applet Java em um documento HTML. Java é 
uma linguagem de programação que permite o desenvolvimento de aplicativos pequenos 
(applets) que podem ser incorporados às páginas da Web. 

Para inserir um applet Java:

1. Na janela do documento, coloque o ponto de inserção onde deseja inserir o applet e siga 
um dos procedimentos abaixo:

■ Na categoria Common (Comuns) da barra Insert (Inserir), clique na seta para baixo no 
botão Media (Mídia) e selecione o ícone Applet. 

■ Selecione Insert > Media > Applet. 
2. Na caixa de diálogo que será exibida, selecione um arquivo que contenha o applet Java.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
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Utilizar comportamentos para controlar 
elementos de mídia
É possível adicionar comportamentos à página, para iniciar e interromper diversos objetos de 
mídia.

A opção Control Shockwave ou Flash (Controlar Shocwave ou Flash) permite que você 
reproduza, interrompa, rebobine ou vá para um quadro em um filme do Shockwave ou 
arquivo Flash SWF (consulte “Control Shockwave or Flash (Controlar o Shockwave ou 
Flash)” na página 554).

A opção Play Sound (Executar o som) permite reproduzir um som. Por exemplo, é possível 
reproduzir um efeito sonoro sempre que o usuário mover o ponteiro do mouse sobre um link 
(consulte “Play Sound (Executar o som)” na página 563).

A opção Check Plugin (Verificar o plug-in) permite verificar se os visitantes do seu site já 
possuem o plug-in necessário instalado e, em seguida, os direciona para outras URLs, caso 
tenham o plug-in correto. Isso se aplica somente aos plug-ins do Netscape Navigator, pois o 
comportamento Check Plugin não verifica os controles ActiveX. Para obter mais informações, 
consulte “Check Plugin (Verificar o plug-in)” na página 552.
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CAPÍTULO 18

Utilizar comportamentos 
JavaScript
Os comportamentos do Macromedia Dreamweaver 8 colocam o código JavaScript nos 
documentos para permitir que os visitantes interajam com uma página da Web para alterar a 
página de diversas maneiras ou determinar a execução de certas tarefas. Um comportamento é 
uma combinação entre um evento e uma ação por ele disparada. No painel Behaviors 
(Comportamentos), é possível adicionar um comportamento a uma página especificando uma 
ação e, depois, o evento que irá dispará-la. 

Na realidade, os eventos são mensagens geradas por navegadores, que indicam algum tipo de 
interação do visitante com a sua página. Por exemplo: quando um visitante move o ponteiro 
sobre um link, o navegador gera um evento onMouseOver correspondente ao link; em seguida, 
o navegador verifica se existe algum código JavaScript (especificado na página que está sendo 
exibida) que deve ser chamado quando o evento for gerado para esse link. Diferentes eventos 
são definidos para diferentes elementos de página. Por exemplo, na maior parte dos 
navegadores, onMouseOver e onClick são eventos associados a links, enquanto onLoad é um 
evento associado a imagens e à seção body do documento.

Uma ação consiste no código previamente escrito em JavaScript, que executa uma tarefa 
específica como, por exemplo, a abertura de uma janela do navegador, a exibição ou ocultação 
de uma camada, a execução de um som ou a interrupção de um filme Macromedia 
Shockwave. As ações fornecidas com o Macromedia Dreamweaver são cuidadosamente 
escritas pelos programadores do Dreamweaver, para proporcionar o máximo de 
compatibilidade entre os diferentes navegadores.

N
O

T
A

O código do comportamento é um código JavaScript no lado do cliente, ou seja, ele é 
executado nos navegadores, não nos servidores.
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Depois de anexar um comportamento a um elemento da página, sempre que o evento 
especificado ocorrer para o elemento, o navegador chamará a ação (o código JavaScript) a ele 
associado. (Os eventos que podem ser utilizados para disparar uma determinada ação variam 
de acordo com o navegador utilizado.) Por exemplo: se você anexar a ação Mensagem pop-up 
a um link e especificar que ela será disparada pelo evento onMouseOver, sempre que alguém 
indicar o link com o ponteiro do mouse no navegador, a mensagem será exibida em uma caixa 
de diálogo.

Um único evento pode disparar diversas ações e é possível especificar a ordem na qual estas 
ações ocorrerão.

O Dreamweaver oferece cerca de duas dúzias de ações de comportamentos; é possível ter 
acesso a outras ações no site da Web do Macromedia Exchange, assim como em sites de outros 
desenvolvedores. Consulte “Fazer o download e instalar os comportamentos de 
outros fabricantes” na página 548. Se souber utilizar os recursos JavaScript, você poderá gravar 
as suas próprias ações relacionadas a comportamentos. Para obter mais informações sobre 
como gravar ações de comportamentos, consulte Extending Dreamweaver (Estender o 
Dreamweaver) (Help > Extending Dreamweaver).

Este capítulo contém as seguintes seções:
Utilizar o painel Behaviors (Comportamentos)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .543

Sobre os eventos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .543

Aplicação de um comportamento. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 544

Anexar um comportamento ao texto . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 545

Alterar um comportamento  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .546

Atualizar um comportamento  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .547

Criar novas ações . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .548

Fazer o download e instalar os comportamentos de outros fabricantes . . . . . . . .548

Utilizar as ações de comportamentos enviadas com o Dreamweaver . . . . . . . . . 549

N
O

T
A

Os termos comportamento e ação se relacionam ao Dreamweaver, e não à HTML. Do 
ponto de vista do navegador, uma ação se assemelha a qualquer outro tipo de código 
JavaScript.
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Utilizar o painel Behaviors 
(Comportamentos)
Utilize o painel Behaviors para anexar comportamentos a elementos de página (mais 
especificamente às tags) e para modificar parâmetros de comportamentos anexados 
anteriormente. 

Para abrir o painel Behaviors:

■ Selecione Window (Janela) > Behaviors.

Os comportamentos que já tiverem sido anexados ao elemento selecionado da página 
aparecerão na lista de comportamentos (a área principal do painel), em ordem alfabética, 
conforme o evento. Se houver diversas ações para o mesmo evento, elas serão executadas na 
ordem em que são exibidas na lista. Se não houver qualquer comportamento na lista de 
comportamentos, o elemento selecionado não apresenta qualquer comportamento a ele 
anexado.

Para obter mais informações sobre as opções do painel Behaviors, selecione Help (Ajuda) no 
menu Options (Opções) na barra de título do grupo de painéis.

Sobre os eventos
Cada navegador fornece um conjunto de eventos que podem ser associados às ações listadas 
no menu pop-up Actions (+) [Ações (+)] do painel Behaviors. Quando um visitante de sua 
página da Web interagir com ela — clicando em uma imagem, por exemplo — o navegador 
gerará eventos, que podem ser utilizados para chamar as funções JavaScript responsáveis pela 
ocorrência da ação Os eventos também podem ser gerados sem a interação com o usuário, 
como no caso da definição de atualização automática de uma página a cada 10 segundos. O 
Dreamweaver fornece muita ações comuns que podem ser ativadas utilizando esses eventos.

Para obter os nomes e as descrições dos eventos fornecidos por cada navegador, visite o 
Dreamweaver Support Center (Centro de suporte do Dreamweaver) em 
www.macromedia.com/go/dreamweaver_support.
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Os eventos que aparecerão no menu pop-up Events (Eventos) dependerão do objeto 
selecionado e dos navegadores especificados no submenu Show Events For (Mostrar os 
eventos de). Para determinar quais são os eventos suportados por um determinado navegador 
para um elemento de página específico, insira o elemento de página no documento e anexe 
um comportamento a ele. Em seguida, consulte o menu pop-up Events, no painel Behaviors. 
É possível que alguns eventos estejam desativados (esmaecidos), se os objetos relevantes ainda 
não existirem na página ou se o objeto selecionado não puder receber eventos. Se os eventos 
esperados não aparecerem, certifique-se de que o objeto correto esteja selecionado ou altere os 
navegadores de destino no menu pop-up Show Events For.

Se você estiver anexando um comportamento a uma imagem, alguns eventos (como 
onMouseOver) aparecerão entre parênteses. Estes eventos estarão disponíveis apenas para os 
links. Ao ser escolhido um deles, o Dreamweaver colocará uma tag a ao redor da imagem, para 
definir um link nulo. Na caixa de texto do link no Property inspector, o link nulo é 
representado por javascript:;. É possível alterar o valor do link se desejar torná-lo um link 
real a outra página, porém, se o link JavaScript for excluído e não for substituído por outro 
link, o comportamento será removido.

Para uma verificação detalhada das tags que poderão ser utilizadas com um dado evento em 
um determinado navegador, localize o evento em um dos arquivos da pasta Dreamweaver/
Configuration (Configuração)/Behaviors/Events (Eventos).

Aplicação de um comportamento
É possível anexar comportamentos ao documento inteiro (ou seja, à tag body) ou aos links, 
imagens, elementos de formulários ou qualquer um dos vários elementos HTML.

O navegador de destino que tiver sido selecionado determinará quais eventos associados a um 
determinado elemento contarão com suporte. O Internet Explorer 4.0, por exemplo, dispõe 
de um conjunto muito maior de eventos para cada elemento do que o Navigator 4.0 ou 
qualquer navegador de versão 3.0.

É possível especificar mais de uma ação por evento. As ações ocorrem na ordem em que 
aparecem na lista da coluna Actions (Ações) do painel Behaviors. Para obter mais informações 
sobre como alterar a ordem das ações, veja “Alterar um comportamento” na página 546.

N
O

T
A

Não é possível anexar um comportamento a texto simples. Para obter mais informações, 
consulte “Anexar um comportamento ao texto” na página 545.
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Para anexar um comportamento:

1. Selecione um elemento na página, como uma imagem ou link, por exemplo. 

Para anexar um comportamento à página inteira, clique na tag <body>, no seletor de tags 
situado no canto inferior esquerdo da janela do documento.

2. Escolha Window (Janela)  > Behaviors (Comportamentos), para abrir o painel Behaviors.

3. Clique no botão com o sinal de adição (+) e escolha uma ação no menu pop-up Actions 
(Ações).

As ações que estiverem esmaecidas no menu não poderão ser escolhidas. É possível que elas 
estejam esmaecidas porque o documento não apresenta um objeto necessário. Por 
exemplo, a ação Control Shockwave or Flash (Controlar o Shockwave ou Flash) encontra-
se esmaecida se o documento contém filmes do Shockwave ou do Macromedia Flash. Se 
não houver qualquer evento disponível para o objeto selecionado, todas as ações estarão 
esmaecidas.
Quando você escolhe uma ação, é exibida uma caixa de diálogo que mostra os parâmetros 
e as instruções referentes a ela.

4. Digite os parâmetros relativos à ação e clique em OK.

Todas as ações enviadas com o Dreamweaver funcionam com os navegadores das versões 
4.0 e posteriores. Algumas ações não funcionam nos navegadores mais antigos. Consulte 
“Utilizar as ações de comportamentos enviadas com o Dreamweaver” na página 549.

5. O evento padrão que desencadeia a ação aparecerá na coluna Events (Eventos). Se este não 
for o evento desejado, escolha outro evento no menu pop-up Events. (Para abrir o menu 
pop-up Events, selecione um evento ou ação no painel Behaviors e clique na seta preta para 
baixo que aparecerá entre o nome do evento e o da ação.)

Anexar um comportamento ao texto
Não é possível anexar um comportamento a texto simples. As tags p e span não geram eventos 
nos navegadores, portanto não é possível desencadear uma ação a partir destas tags.

No entanto, é possível anexar um comportamento a um link. Assim, para anexar um 
comportamento a um trecho de texto, a abordagem mais simples consiste em adicionar um 
link nulo (que não indicará qualquer elemento) ao texto e, em seguida, anexar o 
comportamento ao link. Observe que, ao executar este procedimento, o texto aparecerá como 
um link. É possível alterar a cor do texto e remover o seu sublinhado se for preferível que ele 
não se assemelhe a um link; porém, é possível que o visitante do site não perceba que há um 
motivo para clicar no texto.
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Para anexar um comportamento ao texto selecionado:

1. No Property inspector (Inspetor de propriedades), digite javascript:; na caixa de texto 
Link. Assegure-se de ter incluído os sinais de dois-pontos e ponto-e-vírgula.

2. Mantendo o texto selecionado, abra o painel Behaviors (Comportamentos) [Window 
(Janela) > Behaviors].

3. No menu pop-up Actions (Ações), escolha uma ação, digite os parâmetros a ela 
correspondentes e selecione um evento para dispará-la. Para obter informações detalhadas, 
veja “Aplicação de um comportamento” na página 544.

Para alterar a aparência do texto do link de maneira que não se pareça com 
um link:

1. Abra a visualização do código da janela do documento, escolhendo View (Exibir) > Code 
(Código).

2. Localize o link.

3. Na tag a href do link, insira este atributo: style="text-decoration:none; color:black". 

Esta definição de atributo desativa o sublinhado e torna preta a cor do texto. Obviamente, 
se o texto circundante tiver outra cor, utilizá-la em vez da cor preta.
Observe que esse atributo é um estilo CSS em linha. Um estilo em linha aplicado a um 
único link substitui outros estilos CSS aplicáveis a esse link, mas não tem efeito fora desse 
link. Para alterar a aparência de texto com links em toda a página ou em todo o site, utilize 
os estilos CSS para criar um estilo novo para os links. Para obter informações detalhadas, 
veja Capítulo 13, “Inserir e formatar texto”, na página 405.

Alterar um comportamento
Após anexar um comportamento, você poderá alterar o evento que dispara a ação, adicionar 
ou remover ações e alterar os parâmetros relativos às ações.

Para alterar um comportamento:

1. Selecione um objeto que possua um comportamento a ele anexado.

N
O

T
A

Em vez destes, é possível utilizar o sinal # na caixa de texto Link, se preferir. O 
problema em utilizar o sinal numérico é que quando um visitante clica no link, alguns 
navegadores podem saltar para a parte superior da página. O ato de clicar no link 
nulo de JavaScript não provocará qualquer efeito sobre a página, sendo, portanto, 
geralmente preferível.
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2. Escolha Window (Janela) > Behaviors (Comportamentos), para abrir o painel Behaviors.

Os comportamentos aparecerão no painel, em ordem alfabética, segundo o evento. Se 
houver diversas ações para o mesmo evento, elas serão exibidas na ordem em que 
serão executadas.

3. Siga um dos procedimentos abaixo:

■ Para editar os parâmetros de uma ação, clique duas vezes no nome do comportamento 
ou selecioná-lo e pressione a tecla Enter (no Windows), ou Return (no Macintosh). 
Em seguida, modifique os parâmetros na caixa de diálogo e clique em OK.

■ Para alterar a ordem das ações de um determinado evento, selecione uma ação e clique 
no botão de seta acima ou abaixo. Também é possível, dentre uma série de outras 
ações, selecionar a ação e recortar e colá-la no local desejado.

■ Para excluir um comportamento, selecione-o e clique no botão com o sinal de 
subtração (–), ou pressione a tecla Delete.

Atualizar um comportamento
Se as suas páginas contiverem comportamentos criados com o Dreamweaver 1 ou com o 
Dreamweaver 2, esses comportamentos não serão atualizados automaticamente quando as 
páginas forem abertas na versão atual do Dreamweaver. No entanto, quando você atualiza 
uma ocorrência de um comportamento em uma página (seguindo o procedimento descrito 
nesta seção), todas as outras ocorrências desse comportamento nessa página também 
são atualizadas. Os comportamentos criados com o Dreamweaver 3 funcionarão sem 
alterações no Dreamweaver 4.

Para atualizar um comportamento em uma página:

1. Selecione um elemento ao qual tiver sido anexado o comportamento.

2. Abra o painel Behaviors (Comportamentos).

3. Clique duas vezes no comportamento.

4. Clique em OK na caixa de diálogo do comportamento.

Todas as ocorrências desse comportamento na página serão atualizadas.

N
O

T
A

Como afirmado anteriormente, quando você atualiza uma ocorrência de um 
comportamento em uma página, todas as outras ocorrências desse comportamento 
nessa página também são atualizadas. Contudo, é preciso atualizar comportamentos 
para cada página visitada no site. 
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Criar novas ações
As ações consistem em código JavaScript e HTML. Se o usuário estiver bastante familiarizado 
com JavaScript, poderá escrever novas ações e adicioná-las ao menu pop-up Actions (Ações), 
no painel Behaviors (Comportamentos). Para obter mais informações, veja Extending 
Dreamweaver (Extensão dos recursos do Dreamweaver). 

Fazer o download e instalar os 
comportamentos de outros fabricantes
Um dos aspectos mais úteis do Dreamweaver é a possibilidade de estender os seus recursos, ou 
seja, ele oferece aos usuários que já estão familiarizados com JavaScript a oportunidade de 
escrever o código JavaScript que poderá estender os recursos do Dreamweaver. Muitos desses 
usuários optaram por compartilhar suas extensões com outros usuários enviando-as ao site do 
Macromedia Exchange para Dreamweaver na Web (www.macromedia.com/go/
dreamweaver_exchange).

Para efetuar o download e instalar novos comportamentos do site do 
Macromedia Exchange na Web:

1. Abra o painel Behaviors (Comportamentos) e no menu pop-up Actions (+), escolha Get 
More Behaviors (Obter mais comportamentos).

O navegador primário será aberto e o site de intercâmbio aparecerá. (É preciso estar 
conectado à Web para poder efetuar o download de comportamentos).

2. Procure os pacotes.

3. Efetue o download e instale o pacote de extensão desejado.

Para obter informações detalhadas, veja “Adicionar extensões ao Dreamweaver” na 
página 84.
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Utilizar as ações de comportamentos 
enviadas com o Dreamweaver
As ações de comportamento incluídas com o Dreamweaver foram criadas para funcionar com 
todas as versões do Netscape Navigator 4.0 e posteriores e nas versões 4.0 e mais avançadas do 
Internet Explorer. A maioria dessas ações de comportamento também funciona no Netscape 
Navigator nas versões 3.0 e posteriores (Os comportamentos referentes à camada não 
funcionam no Navigator 3.0). A maioria dessas ações de comportamento falha 
silenciosamente na versão 3.0 do Internet Explorer. 

Embora as ações do Dreamweaver tenham sido escritas visando a maximizar a 
compatibilidade entre os diferentes navegadores, algumas ações não funcionam nas versões 
mais antigas de alguns navegadores. Além disso, alguns navegadores não oferecem qualquer 
suporte ao JavaScript, e muitos usuários que consultam a Web mantêm o JavaScript 
desativado em seus navegadores. Para obter os melhores resultados de compatibilidade entre 
diversas plataformas, forneça interfaces alternativas delimitadas por tags noscript, de 
maneira que os usuários que não contarem com o JavaScript possam utilizar o seu site.

Chamar o JavaScript
A ação Call JavaScript (Chamar o JavaScript) permite utilizar o painel Behaviors para 
especificar a execução de uma função ou linha de código personalizada de JavaScript quando 
ocorrer um evento. (É possível escrever o código JavaScript ou utilizar o código 
disponível gratuitamente em diversas bibliotecas de JavaScript na Web.)

Para poder utilizar a ação Call JavaScript:

1. Selecione um objeto e abra o painel Behaviors (Comportamentos).

2. Clique no botão de adição (+) e escolha Call JavaScript no menu pop-up Actions.

3. Digite o JavaScript a ser executado ou o nome de uma função.

Por exemplo, para criar um botão Back (Voltar), digite 
if (history.length > 0){history.back()}. Se tiver encapsulado o código em uma função, 
digite apenas o nome da função (por exemplo, hogback()).

4. Clique em OK.

N
O

T
A

As ações do Dreamweaver foram escritas para que possam ser executadas no maior 
número possível de navegadores. Caso o código de uma ação do Dreamweaver seja 
removido manualmente ou substituído por código de sua própria autoria, é possível que 
a compatibilidade com outros navegadores seja perdida. 
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5. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de).

Change Property (Alterar a propriedade)
Utilize a ação Change Property para alterar o valor de uma das propriedades de um objeto (a 
cor de fundo de uma camada ou a ação relacionada a um formulário, por exemplo). As 
propriedades que podem ser alteradas são determinadas pelo navegador. O Internet Explorer 
4.0 permite alterar um número maior de propriedades (comparado ao Internet Explorer  3.0  
ou às versões 3.0 e 4.0 do Navigator). Por exemplo: você pode definir dinamicamente a cor 
de fundo de uma camada.

Para utilizar a ação Change Property:

1. Selecione um objeto e abra o painel Behaviors (Comportamentos).

2. Clique no botão de adição (+) e escolha Change Property no menu pop-up Actions.

3. No menu pop-up Type of Object (Tipo de objeto), escolha o tipo de objeto cuja 
propriedade deseje alterar.

O menu pop-up Named Object passa a listar todos os objetos nomeados que pertencem 
ao tipo selecionado. 

4. Escolha um objeto no menu pop-up Named Object.

5. Escolha uma propriedade no menu pop-up Property (Propriedade) ou digite o nome da 
propriedade na caixa de texto.

Para poder examinar as propriedades que podem ser alteradas em cada navegador, 
selecione navegadores diferentes ou versões de navegadores diferentes, no menu pop-up de 
navegadores. Se estiver digitando o nome de uma propriedade, certifique-se de utilizar o 
nome correto da propriedade JavaScript (e lembre-se de que as propriedades JavaScript 
reconhecem maiúsculas e minúsculas).

6. Digite o novo valor da propriedade, na caixa de texto New Value (Novo valor) e clique em 
OK.

N
O

T
A

Utilize esta ação apenas se já estiver muito familiarizado com HTML e JavaScript.
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7. Verifique se o evento padrão corresponde ao desejado. Quando o evento ocorrer, a ação será 
executada e a propriedade alterada.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de).

Check Browser (Verificar o navegador)
Utilize a ação Check Browser para enviar os visitantes a outras páginas, dependendo da marca 
e versão do seu navegador. Por exemplo: é possível optar por enviar os usuários para uma 
página se eles estiverem utilizando a versão 4.0 ou mais avançada do Netscape Navigator, para 
outra página se utilizarem a versão 4.0 ou mais avançada do Microsoft Internet Explorer 4.0 
ou mantê-los na mesma página, caso estejam utilizando qualquer outro navegador.

É útil anexar este comportamento à tag body de uma página que seja compatível com 
praticamente qualquer navegador (e que não utilize outro JavaScript); desta maneira, mesmo 
os visitantes que chegarem à página com o JavaScript desativado poderão ver algo.

Uma outra opção seria anexar este comportamento a um link nulo (such as 
<a href="javascript:;">) de forma que a ação determine o destino do link com base na 
marca e na versão do navegador do visitante.

Para poder utilizar a ação Check Browser:

1. Selecione um objeto e abra o painel Behaviors (Comportamentos).

2. Clique no botão com o sinal de adição (+) e escolha Check Browser no menu 
pop-up Actions.

3. Determine como gostaria de separar os visitantes: por marca de navegador, por versão de 
navegador ou por ambas.

Por exemplo: você gostaria que todos os visitantes com um navegador da versão 4.0 vissem 
uma página, enquanto os visitantes com outras versões vissem uma página diferente? Ou 
talvez que os usuários do Netscape Navigator vissem uma página e os usuários do Internet 
Explorer, outra.

4. Especifique uma versão do Netscape Navigator.

5. Nos menus pop-up adjacentes, escolha as opções que indicam as ações a serem tomadas se 
a versão do navegador corresponder ou for mais avançada do que a versão do Netscape 
Navigator especificada e como proceder no caso contrário.

As opções são Go to URL (Ir para a URL), Go to Alt URL (Ir para URL alternativa) e Stay 
on This Page (Continuar nesta página).

6. Especifique uma versão do Internet Explorer.
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7. Nos menus pop-up adjacentes, escolha as opções que indicam as ações a serem tomadas se 
a versão do navegador corresponder ou for mais avançada do que a versão do Internet 
Explorer especificada e como proceder no caso contrário.

As opções são Go to URL (Ir para a URL), Go to Alt URL (Ir para URL alternativa) e Stay 
on This Page (Continuar nesta página).

8. No menu pop-up Other Browsers (Outros navegadores), escolha uma opção para 
especificar as ações que serão tomadas se o navegador não for o Navigator nem o Internet 
Explorer. Por exemplo: é possível que o visitante esteja utilizando um navegador com base 
em texto, como o Lynx.

Continuar nesta página é a melhor opção para os navegadores diferentes do Navigator e IE 
porque a maioria não oferece suporte ao JavaScript. Nesse caso, se não puderem ler este 
comportamento, eles permanecerão na página de qualquer maneira.

9. Digite os caminhos e nomes de arquivos da URL e da URL alternativa nas caixas de texto 
situados na parte inferior da caixa de diálogo. Se você digitar uma URL remota, digite 
também o prefixo http://, além do endereço www.

10. Clique em OK.

11. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de). Lembre-se de que o objetivo desse comportamento é verificar as 
diferentes versões do navegador, portanto, é melhor escolher um evento que funcione nos 
navegadores 3.0 e mais avançados.

Check Plugin (Verificar o plug-in)
Utilize a ação Check Plugin para enviar os visitantes a outras páginas, dependendo da 
ocorrência de um determinado plug-in instalado. Por exemplo: é possível optar por enviar os 
usuários para uma página se eles possuírem o Shockwave, ou para outra página, se não 
contarem com ele.

Para poder utilizar a ação Check Plugin:

1. Selecione um objeto e abra o painel Behaviors (Comportamentos).

N
O

T
A

Não é possível detectar determinados plug-ins no Internet Explorer utilizando o 
JavaScript. Contudo, a seleção de Flash ou Director adicionará o código VBScript 
apropriado à página, para detectar os plug-ins no IE do Windows. A detecção de plug-
ins não é possível no Internet Explorer que estiver sendo executado no Macintosh.
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2. Clique no botão com o sinal de adição (+) e escolha Check Plugin no menu 
pop-up Actions.

3. No menu pop-up Plugin (Plug-in), escolha um plug-in, ou clique na tecla Enter e digite o 
nome exato do plug-in na caixa de texto adjacente.

É necessário o nome exato do plug-in, conforme o especificado em negrito na página 
About Plug-ins (Sobre os plug-ins) no Navigator. No Windows, escolha Navigator’s Help 
(Ajuda do Navigator) > comando About Plug-ins (Sobre os plug-ins); no Macintosh, 
escolha About Plug-ins no menu Apple. 

4. Na caixa de texto If Found (Se for localizado), na caixa de texto Go To URL (Ir para a 
URL), especifique uma URL para os visitantes que contam com o plug-in.

Se você especificar uma URL remota, digite também o prefixo http:// no endereço.
Para que os visitantes com o plug-in permaneçam na mesma página, deixe em branco 
este campo.

5. Na caixa de texto Otherwise, Go To URL (Caso contrário, ir para URL), especifique um 
URL alternativo para os visitantes que não possuem o plug-in.

Para garantir que os visitantes sem o plug-in permanecerão na mesma página, deixe este 
campo em branco.

6. A maioria dos plug-ins não pode ser detectada no Internet Explorer executado no Windows 
e sua detecção é impossível no Macintosh. Como padrão, quando a detecção for impossível, 
o visitante será enviado para a URL listada na caixa de texto Otherwise (Caso contrário). 
Para enviar o visitante para a primeira URL (If Found), selecione a opção Always go to first 
URL if detection is not possible (Ir sempre para a primeira URL se a detecção não for 
possível). A seleção desta opção implicará aceitar que “o visitante dispõe do plug-in, exceto 
se o navegador indicar explicitamente que o plug-in não está presente”.

Em geral, se o conteúdo do plug-in for parte integral da página, deve-se selecionar a opção 
"Always go to first URL if detection is not possible". Os visitantes que não tiverem o plug-
in receberão uma notificação do navegador para que efetuem o download do plug-in. Se o 
conteúdo do plug-in não for essencial para a página, não selecione esta opção.
Esta opção se aplica apenas ao Internet Explorer; o Navigator é sempre capaz de detectar 
os plug-ins.

7. Clique em OK.

8. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de). 
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Control Shockwave or Flash (Controlar o Shockwave 
ou Flash)
Utilize a ação Control Shockwave or Flash para executar, parar, rebobinar ou ir para um 
quadro de um arquivo Macromedia Shockwave or Macromedia Flash SWF. Para utilizar a 
ação Control Shockwave or Flash:

1. Escolha Insert (Inserir) > Media (Mídia) > Shockwave, ou Insert > Media > Flash, para 
inserir um arquivo Shockwave ou Flash SWF, respectivamente.

2. Escolha Window (Janela) > Properties (Propriedades) e digite o nome de um filme, na caixa 
de texto do canto superior esquerdo (ao lado do ícone de Shockwave ou Flash). É necessário 
atribuir um nome ao filme para que se possa controlá-lo com a ação Control Shockwave or 
Flash.

3. Selecione os itens a serem utilizados no controle do arquivo Shockwave ou Flash SWF. Por 
exemplo: se houver uma imagem de um botão Play (Executar) que será utilizada na 
reprodução do filme, selecione-a.

4. Abra o painel Behaviors (Comportamentos) [Window (Janela) > Behaviors].

5. Clique no botão com o sinal de adição (+) e escolha Control Shockwave or Flash (Controlar 
o Shockwave ou Flash) no menu pop-up Actions (Ações).

Uma caixa de diálogo com os parâmetros é exibida.
6. No menu pop-up Movie (Filme), escolha um filme.

O Dreamweaver listará automaticamente os nomes de todos os filmes Shockwave e Flash 
SWF do documento atual. Especificamente, o Dreamweaver apresentará uma lista com os 
filmes cujos nomes de arquivos terminem com .dcr, .dir, .swf ou .spl e que estiverem em 
tags object ou embed.

7. Escolha uma das ações para executar, parar, rebobinar ou ir para um quadro do filme. A 
opção Play (Executar) executa o filme a partir do quadro no qual ocorre a ação.

8. Clique em OK.

9. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no submenu Show Events For 
(Mostrar os eventos de) no menu pop-up Events (Eventos).
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Drag Layer (Arrastar a camada)
A ação Drag Layer permite ao visitante arrastar uma camada. Utilize esta ação para criar 
quebra-cabeças, controles deslizantes e outros elementos móveis de interface. 

É possível especificar, entre outros aspectos, em qual direção o visitante poderá arrastar a 
camada (horizontal, verticalmente ou em qualquer uma das direções), um destino até o qual a 
camada deverá ser arrastada, se a camada se encaixará no destino, se esta estiver distante um 
certo número de pixels, e o que deverá ser feito quando a camada alcançar o destino.

Como a ação Drag Layer deve ser chamada antes que a camada possa ser arrastada pelo 
visitante, certifique-se de que o evento que disparará a ação ocorrerá antes que o visitante tente 
arrastar a camada. É melhor anexar a ação Drag Layer ao objeto body (com o evento onLoad), 
embora ela também possa ser anexada a um link que preencha toda a camada (ao redor de 
uma imagem, por exemplo) e que utilize o evento onMouseOver.

Para poder utilizar a ação Drag Layer:

1. Escolha Insert (Inserir) > Layer (Camada), ou clique no botão Draw Layer (Desenhar 
camada) na barra Insert, e desenhe uma camada na visualização do projeto da janela do 
documento.

2. Selecione a tag body, clicando em <body>, no seletor de tags, situado na parte inferior da 
janela do documento.

3. Abra o painel Behaviors (Comportamentos).

4. Clique no botão de adição (+) e escolha Drag Layer no menu pop-up Actions.

Se a opção Drag Layer não estiver disponível, é provável que já haja uma camada 
selecionada. Como as camadas não aceitam eventos em ambos os navegadores da versão 
4.0, selecione um outro objeto, como a tag body ou um link (a tag) ou, no menu 
pop-up Show Events For (Mostrar os eventos de), altere o navegador de destino para 
Internet Explorer 4.0.

5. No menu pop-up Layer, selecione a camada que deseja tornar arrastável.

6. No menu pop-up Movement (Movimento), escolha Constrained (Restrito) ou 
Unconstrained (Não restrito).

O movimento não restrito é adequado aos quebra-cabeças e outros jogos que envolvem 
arrastar e soltar elementos. No caso dos controles deslizantes e cenários móveis, como 
gavetas de arquivos, cortinas e mini-persianas, opte pelo movimento restrito.
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7. Digite os valores do movimento restrito (em pixels) nas caixas de texto Up (Acima), Down 
(Abaixo), Left (À esquerda) e Right (À direita).

Os valores se relacionam à posição inicial da camada. Para restringir o movimento a uma 
região retangular, digite valores positivos nas quatro caixas de texto. Para permitir apenas o 
movimento vertical, digite valores positivos em Up e Down, e zero em Left e Right. Para 
permitir apenas o movimento horizontal, digite valores positivos em Left e Right, e zero 
em Up e Down.

8. Digite os valores do destino de soltura (em pixels) nas caixas de texto Left e Top.

O destino de soltura é o ponto até o qual você deseja que o visitante arraste a camada. A 
camada terá alcançado o destino de soltura quando as suas coordenadas esquerda e do alto 
coincidirem com os valores digitados nas caixas de texto Left e Top. Os valores se 
relacionam ao canto superior esquerdo da janela do navegador. Clique em Get Current 
Position (Obter a posição atual), para preencher automaticamente as caixas de texto com a 
posição atual da camada.

9. Digite um valor (em pixels) na caixa de texto Snap if Within (Encaixar, se distante) para 
determinar a distância mínima do destino de soltura que o visitante deverá adotar para que 
a camada se encaixe no destino.

Quanto maior o valor, mais fácil será para o visitante detectar o destino de soltura.
10. No caso de quebra-cabeças simples e manipulações de cenários, não há necessidade de 

ultrapassar este ponto. Para definir a alça de arraste da camada, controlar o movimento da 
camada enquanto esta estiver sendo arrastada e ativar uma ação quando a camada for solta, 
clique na guia Advanced.

11. Para especificar se o visitante deverá clicar em uma determinada área da camada para que 
esta seja arrastada, escolha Area Within Layer (Área dentro da camada), no menu pop-up 
Drag Handle (Alça de arraste). Em seguida, digite as coordenadas da esquerda e do alto, 
assim como a largura e altura da alça de arraste.

Esta opção é útil quando a imagem dentro da camada possuir um elemento que sugere o 
arraste, como uma barra de título ou alça de desenho, por exemplo. Não selecione esta 
opção se preferir permitir ao visitante clicar em qualquer ponto da camada para poder 
arrastá-la.

12. Escolha qualquer opção While Dragging (Enquanto arrasta) que desejar utilizar:

■ Selecione Bring Layer to Front (Trazer a camada para frente), se preferir que a camada 
seja transferida para frente da ordem de empilhamento enquanto for arrastada. Se esta 
opção for selecionada, utilize o menu pop-up para optar por deixar a camada na frente 
ou restaurá-la à sua posição original na ordem de empilhamento.
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■ Digite um código JavaScript ou um nome de função (monitorLayer(), por exemplo) 
na caixa de texto Call JavaScript (Chamar o JavaScript), a fim de executar 
repetidamente o código ou a função enquanto a camada estiver sendo arrastada. Por 
exemplo: é possível gravar uma função que monitore as coordenadas da camada e exiba 
indicações, tais como “você está próximo” ou “muito distante do destino de soltura”, 
em uma caixa de texto. Para obter mais informações, consulte “Reunir informações 
sobre a camada arrastável” na página 557.

13. Digite um código JavaScript ou um nome de função (evaluateLayerPos(), por exemplo) na 
segunda caixa de texto Call JavaScript, a fim de executar o código ou função quando a 
camada for solta. Selecione Only if Snapped (Apenas se estiver encaixada), nos casos em 
que o JavaScript for executado apenas se a camada tiver alcançado o destino de soltura.

14. Clique em OK.

15. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de). Lembre-se de que as camadas não contam com o suporte dos 
navegadores da versão 3.0.

Reunir informações sobre a camada arrastável
Ao ser anexada a ação Drag Layer (Arrastar a camada) a um objeto, o Dreamweaver inserirá a 
função MM_dragLayer() na seção head do documento. Além de registrar a camada como 
arrastável, esta função definirá três propriedades de cada camada arrastável —MM_LEFTRIGHT, 
MM_UPDOWN, and MM_SNAPPED— que você poderá utilizar nas suas próprias funções JavaScript 
para determinar as posições relativas horizontal e vertical da camada e se a camada atingiu o 
destino de soltura.

Por exemplo: a função a seguir exibe o valor da propriedadeMM_UPDOWN (a posição vertical da 
camada) em um campo de formulário denominado curPosField. Por serem dinâmicos, os 
campos de formulário são úteis para exibir informações atualizadas continuamente, ou seja, é 
possível alterar o seu conteúdo depois que a página tiver sido carregada, tanto no Netscape 
Navigator quanto no Internet Explorer.

N
O

T
A

É impossível anexar a ação Drag Layer a um objeto associado aos eventos 
onMouseDown ou onClick.   

N
O

T
A

As informações fornecidas aqui se destinam ao uso apenas de programadores 
de JavaScript que já contem com experiência.
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function getPos(layername){

var layerRef = MM_findObj(layername); 
var curVertPos = layerRef.MM_UPDOWN;
document.tracking.curPosField.value = curVertPos;

}

Em vez de exibir os valores de MM_UPDOWN ou MM_LEFTRIGHT em um campo de formulário, é 
possível usar esses valores de diversas outras maneiras. Por exemplo, você pode escrever uma 
função que exibe uma mensagem em um campo de formulário dependendo do quão próximo 
um valor esteja da zona ativa, ou você pode chamar outra função a fim de exibir ou ocultar 
uma camada dependendo do valor.

É recomendável ler a propriedade MM_SNAPPED quando houver várias camadas na mesma 
página. Todas estas camadas deverão alcançar os seus destinos para que o visitante possa 
avançar até a próxima página ou tarefa. Por exemplo: grave uma função que conte quantas 
camadas possuem um valor de MM_SNAPPED correspondente a true e chame-a sempre que 
uma camada for solta. Quando a contagem de camadas encaixadas atingir o número desejado, 
envie o visitante para a próxima página ou exiba uma mensagem parabenizando-o.

Se você tiver utilizado o evento onMouseOver para anexar a ação Drag Layer a links localizados 
em diversas camadas, será necessário efetuar uma pequena alteração à função 
MM_dragLayer(), para evitar que a propriedade MM_SNAPPED de uma camada encaixada seja 
redefinida como false se o ponteiro do mouse for passado sobre a própria. Isto poderá 
ocorrer quando tiver utilizado Drag Layer para criar um quebra-cabeça, já que é provável que 
o visitante passe o ponteiro do mouse sobre as peças já encaixadas enquanto posiciona outras. 
A função MM_dragLayer() não é capaz de evitar este comportamento porque algumas vezes 
ele é preferível (por exemplo, quando se deseja definir diversos destinos de soltura para uma 
única camada).

Para evitar o novo registro de camadas já encaixadas:

1. Faça uma cópia de segurança do documento antes de alterar o código. É possível fazer  isto  
no painel Site do Dreamweaver, no Windows Explorer (Windows) ou no 
Finder (Macintosh).

2. Selecione Edit (Editar) > Find (Localizar).

3. No menu pop-up Find What (Localizar), escolha HTML Source (Origem de HTML).

4. Digite (!curDrag), inclusive os parênteses, na caixa de texto adjacente. 

5. Clique em Find Next (Localizar o próximo).

Se o Dreamweaver perguntar se você deseja continuar a procurar desde o início do 
documento, clique em Yes. O Dreamweaver localiza a seguinte instrução:
if (!curDrag) return false;
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6. Feche a caixa de diálogo Find e modifique a instrução na visualização do código da janela 
do documento ou no inspetor de código, para que ela corresponda a:
if (!curDrag || curDrag.MM_SNAPPED != null) return false;

Os dois pipes (||) significam OU, e curDrag é uma variável que representa a camada que 
está sendo registrada como arrastável. O significado aproximado da instrução é “Se 
curDrag não for um objeto ou se já tiver um valor MM_SNAPPED, não será necessário 
executar o restante da função”.

Go to URL (Ir para a URL)
A ação Go to URL abre uma nova página na janela ou no quadro especificado. Esta ação é 
especialmente útil para alterar o conteúdo de dois ou mais quadros com um único clique.

Para utilizar a ação Go To URL (Ir para a URL):

1. Selecione um objeto e abra o painel Behaviors (Comportamentos).

2. Clique no botão de adição (+) e escolha Go to URL (Ir para URL) no menu 
pop-up Actions.

3. Na lista de seleção Open In (Abrir em), selecione um destino para a URL.

A lista Open In listará automaticamente os nomes de todos os quadros do conjunto de 
quadros, bem como da janela principal. Se não houver quadros, a janela principal será a 
única opção.

4. Clique em Browse (Procurar), para selecionar um documento a ser aberto, ou digite o 
caminho e o nome do documento na caixa de texto URL.

5. Repita as etapas 3 e 4 para abrir outros documentos em outros quadros.

6. Clique em OK.

7. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de).

N
O

T
A

Esta ação poderá provocar resultados inesperados se houver qualquer quadro com 
os nomes top, blank, self ou parent. Algumas vezes, os navegadores confundem 
estes nomes com os dos destinos reservados.
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Jump Menu (Menu de salto)
Quando for criado um menu de salto utilizando Insert (Inserir) > Form Objects (Objetos de 
formulário) > Jump Menu, o Dreamweaver criará um objeto de menu e lhe anexará o 
comportamento Jump Menu ou Jump Menu Go (Ir do menu de salto). Em geral, não é 
necessário anexar manualmente a ação Jump Menu a um objeto. Para obter informações sobre 
os menus de salto e como criá-los, veja “Menus de salto” na página 465.

É possível editar um menu de salto já existente de duas maneiras distintas:

■ É possível editar e reordenar os itens de menu, alterar os arquivos para os quais serão 
efetuados os saltos e alterar a janela na qual os arquivos serão abertos, ao clicar duas vezes 
em uma ação já existente Jump Menu (Menu de salto), no painel Behaviors 
(Comportamentos).

■ É possível editar os itens do menu da mesma maneira que faria em qualquer outro menu, 
ao selecioná-lo e utilizar o botão List Values (Listar os valores) no Property inspector 
(Inspetor de propriedades). Para obter mais informações, consulte “Inserir menus de 
formulário HTML” na página 894.

Para editar um menu de salto utilizando o painel Behaviors 
(Comportamentos):

1. Crie um objeto de menu de salto, se já não houver algum no documento.

2. Selecione o objeto de menu de salto e abra o painel Behaviors.

3. Na coluna Actions (Ações), clique duas vezes em Jump Menu.

4. Faça as alterações desejadas na caixa de diálogo Jump Menu e, em seguida, clique em OK.

Jump Menu Go (Ir do menu de salto)
A ação Jump Menu Go está intimamente associada à ação Jump Menu (Menu de salto); Jump 
Menu Go permite associar um botão Go (Ir) a um menu de salto. Para poder utilizar esta 
ação, é necessária a existência de um menu de salto no documento. A ação de clicar no botão 
Go abrirá o link que estiver selecionado no menu de salto. Normalmente, os menus de salto 
não exigem a ocorrência de um botão Go; em geral, a escolha de um item em um menu de 
salto acarreta a carga de uma URL, sem qualquer intervenção por parte do usuário. Porém, se 
o visitante escolher o mesmo item que já está escolhido no menu de salto, esse salto não 
ocorrerá. Em geral, isso não fará diferença. Porém, se o menu de salto aparecer em um quadro, 
e os itens desse menu estiverem vinculados a páginas de outros quadros, o botão Go poderá ser 
útil, permitindo aos visitantes escolher novamente um item que já tenha sido selecionado no 
menu de salto.
560 Capítulo 18:  Utilizar comportamentos JavaScript



         
Para adicionar uma ação Jump Menu Go: 

1. Selecione um objeto a ser utilizado como botão Go (geralmente uma imagem de botão) e 
abra o painel Behaviors (Comportamentos).

2. Clique no botão de adição (+) e escolha Jump Menu Go no menu pop-up Actions.

3. No menu pop-up Choose Jump Menu (Escolher menu de salto), selecione um menu a ser 
ativado pelo botão Go. 

4. Clique em OK.

Open Browser Window (Abrir a janela do navegador)
Utilize a ação Open Browser Window para abrir uma URL em uma nova janela. É possível 
especificar as propriedades da nova janela, inclusive o seu tamanho, nome e atributos (se ela 
será redimensionável, possuirá uma barra de menus etc.). Por exemplo, você pode utilizar este 
comportamento para abrir uma imagem maior em outra janela quando o visitante clicar em 
uma imagem em miniatura. Com este comportamento, é possível ajustar a janela ao 
tamanho exato da imagem.

Se você não especificar qualquer atributo da janela, ela será aberta no tamanho e com os 
atributos da janela que a tiver iniciado. A especificação de qualquer atributo da janela 
automaticamente desativará todos os outros atributos que não estiverem explicitamente ativos. 
Por exemplo, se você não definir qualquer atributo para a janela, ela poderá ser aberta com 
640 x 480 pixels e possuir uma barra de navegação, barra de ferramentas de localização, barra 
de status e barra de menus. Se você definir a largura explicitamente como sendo 640 e a altura 
como sendo 480 pixels e não definir outros atributos, a janela será aberta com 640 por 480 
pixels e não possuirá barras de navegação, de ferramentas de localização, de status ou de 
menus, qualquer alça de redimensionamento ou barras de rolagem.

Para utilizar a ação Open Browser Window:

1. Selecione um objeto e abra o painel Behaviors (Comportamentos).

2. Clique no botão com o sinal de adição (+) e escolha Open Browser Window (Abrir janela 
do navegador) no menu pop-up Actions.

3. Clique em Browse (Procurar) para selecionar um arquivo ou digite a URL a ser exibida.

4. Defina qualquer uma das opções a seguir:

Window Width (Largura da janela) especifica a largura da janela, em pixels.
Window Height (Altura da janela) especifica a altura da janela, em pixels.
Navigation Toolbar (Barra de ferramentas de navegação) é a linha de botões do 
navegador que inclui Back (Voltar), Forward (Avançar), Home (Página inicial) e 
Reload (Recarregar).
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Location Toolbar (Barra de ferramentas de localização) é a linha de opções do 
navegador que inclui a caixa de texto de localização.
Barra de status é a área situada na parte inferior da janela do navegador, na qual são 
exibidas as mensagens (como o tempo restante de transferência e as URLs associadas aos 
links).
Menu Bar (Barra de menus) é a área da janela do navegador (no Windows), ou da área 
de trabalho (no Macintosh), onde aparecem os menus File (Arquivo), Edit (Editar), View 
(Exibir), Go (Ir) e Help (Ajuda). Defina explicitamente esta opção se desejar que os 
visitantes possam navegar a partir da nova janela. Se você não definir esta opção, o usuário 
poderá apenas fechar ou minimizar a janela (no Windows), ou fechar a janela ou sair do 
aplicativo (no Macintosh) a partir da nova janela.
Scrollbars as Needed (Barras de rolagem, se necessárias) especifica que as barras de 
rolagem aparecerão se o conteúdo ultrapassar a área visível. Se você não definir esta opção 
explicitamente, as barras de rolagem não aparecerão. Se a opção Resize Handles (Alças de 
redimensionamento) também estiver desativada, o visitante não poderá exibir o conteúdo 
que ultrapassar o tamanho original da janela (apesar de poder rolar a janela ao arrastar a 
margem da mesma).
Resize Handles especifica que o usuário poderá redimensionar a janela, arrastando o 
canto inferior direito da mesma ou clicando no botão de maximização (no Windows), ou 
na caixa de dimensionamento (no Macintosh), situada no canto superior direito. Se esta 
opção não estiver definida explicitamente, os controles de redimensionamento não estarão 
disponíveis e o canto inferior direito da janela não poderá ser arrastado.
Window Name (Nome da janela) é o nome da nova janela. Dê um nome à nova janela se 
desejar atribuir links a ela ou controlá-la com o JavaScript. Este nome não pode conter 
espaços ou caracteres especiais.

5. Clique em OK.

6. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de).
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Play Sound (Executar o som)
Utilize a ação Play Sound para executar um som. Por exemplo: é possível executar um efeito 
sonoro sempre que o ponteiro do mouse for passado sobre um link ou executar um clipe de 
música quando a página for carregada.

Para utilizar a ação Play Sound:

1. Selecione um objeto e abra o painel Behaviors (Comportamentos).

2. Clique no botão de adição (+) e escolha Play Sound (Reproduzir som) no menu 
pop-up Actions.

3. Clique em Browse (Procurar) para selecionar um arquivo de som, ou digite o caminho e o 
nome do arquivo na caixa de texto Play Sound.

4. Clique em OK.

5. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de).

Popup Message (Mensagem pop-up)
A ação Popup Message exibe um alerta em JavaScript com a mensagem por você especificada. 
Como os alertas em JavaScript possuem apenas um botão (OK), utilize esta ação para fornecer 
informações ao usuário, em vez de apresentar-lhe uma opção.

É possível incorporar qualquer chamada válida de função JavaScript, propriedade, variável 
global ou outra expressão no texto. Para incorporar uma expressão JavaScript, coloque-a entre 
chaves ({}). Para exibir um sinal de chaves, preceda-o por uma barra invertida (\{).

N
O

T
A

É possível que os navegadores requeiram algum tipo de suporte de áudio adicional 
(como um plug-in de áudio) para que possam reproduzir sons. Por conseguinte, 
diferentes navegadores dotados de diferentes plug-ins muitas vezes executam os sons 
de maneiras diferentes. É difícil prever com exatidão como serão executados os sons 
que você programou aos visitantes do seu site.
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Exemplo:
The URL for this page is {window.location}, and today is {new Date()}.

Para utilizar a ação Popup Message:

1. Selecione um objeto e abra o painel Behaviors (Comportamentos).

2. Clique no botão de adição (+) e escolha Pop-up Message no menu pop-up Actions.

3. Digite a mensagem na caixa de texto Message (Mensagem).

4. Clique em OK.

5. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de).

Preload Images (Pré-carregar as imagens)
A ação Preload Images carrega no cache do navegador as imagens que não aparecem na página 
imediatamente (como aquelas que serão permutadas com as linhas de tempo, 
comportamentos ou JavaScript, por exemplo). Esse processo evita os atrasos causados pelo 
download quando as imagens tiverem de ser exibidas. 

Para poder utilizar a ação Preload Images:

1. Selecione um objeto e abra o painel Behaviors (Comportamentos).

2. Clique no botão de adição (+) e escolha Preload Images (Pré-carregar as imagens) no menu 
pop-up Actions.

3. Clique em Browse (Procurar) para selecionar o arquivo de imagem que será pré-carregado, 
ou digite o caminho e o nome do arquivo de imagem no campo Image Source File (Arquivo 
de origem da imagem).

N
O

T
A

Não é possível controlar a aparência do alerta JavaScript, ela será determinada pelo 
navegador utilizado pelo visitante. Se desejar exercer um controle maior sobre a 
aparência da mensagem, considere a possibilidade de utilizar o comportamento Open 
Browser Window (Abrir a janela do navegador). Para obter informações detalhadas, 
veja “Open Browser Window (Abrir a janela do navegador)” na página 561.

N
O

T
A

Quando a opção Preload Images, na caixa de diálogo Swap Image (Trocar imagem), for 
selecionada, a ação Swap Image pré-carregará automaticamente todas as imagens de 
realce, dispensando a necessidade de adicionar manualmente a opção Preload Images 
quando estiver utilizando Swap Image.
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4. Clique no botão com o sinal de adição (+), situado no alto da caixa de diálogo, para 
adicionar a imagem à lista Preload Images.

5. Repita as etapas 3 e 4 para todas as imagens restantes a serem pré-carregadas na 
página atual.

6. Para remover uma imagem da lista Preload Images (Pré-carregar as imagens), selecione a 
imagem na lista e clique no botão com o sinal de subtração (–).

7. Clique em OK.

8. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de).

Set Nav Bar Image (Definir imagem da barra de 
navegação)
Utilize a ação Set Nav Bar Image para transformar uma imagem em uma imagem de barra de 
navegação ou para alterar a exibição e ações relacionadas às imagens de uma barra de 
navegação. Para obter mais informações, consulte “Inserir uma barra de navegação” na 
página 486.

Utilize a guia Basic (Básico) da caixa de diálogo Set Nav Bar Image, para criar ou atualizar 
uma imagem ou conjunto de imagens da barra de navegação, para alterar a URL exibida 
quando um botão da barra de navegação for clicado e para selecionar uma janela diferente na 
qual deseja exibir a URL.

Utilize a guia Advanced da caixa de diálogo Set Nav Bar Image para alterar o estado de 
outras imagens em um documento com base no estado atual do botão. Por padrão, a ação de 
clicar em um elemento da barra de navegação automaticamente retornará todos os outros 
elementos desta barra ao estado Up (Ativo). Utilize a guia Advanced para definir um outro 
estado para uma imagem quando este for Down (Inativo) ou Over (Sobreposto).

Para editar uma ação Set Nav Bar Image:

1. Selecione a imagem da barra de navegação a ser editada e abra o painel Behaviors.

2. Na coluna Ações do painel Behaviors, clique duas vezes na ação Set Nav Bar Image 
associada ao evento que estiver alterando.

N
O

T
A

Se você não clicar no botão com o sinal de adição antes de digitar a próxima 
imagem, a imagem escolhida na lista será substituída pela próxima 
imagem selecionada.
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3. Na guia Basic (Básico) da caixa de diálogo Set Nav Bar Image, selecione as opções de edição 
de imagens.

Para definir diversas imagens para um botão da barra de navegação: 

1. Selecione a imagem da barra de navegação a ser editada e abra o painel Behaviors.

2. Na coluna Ações do painel Behaviors, clique duas vezes na ação Set Nav Bar Image 
associada ao evento que estiver alterando.

3. Clique na guia Advanced da caixa de diálogo Set Nav Bar Image.

4. No menu pop-up When Element Is Displaying (Quando o elemento estiver sendo 
exibido), escolha um estado para a imagem. 

■ Escolha Down Image (Imagem inativa), se desejar alterar a exibição de uma outra 
imagem depois que um usuário tiver clicado na imagem selecionada.

■ Escolha Over Image (Imagem sobreposta) ou Over While Down Image (Imagem 
sobreposta enquanto inativa), se desejar alterar a exibição de uma outra imagem 
quando o ponteiro estiver sobre a imagem selecionada.

Para obter informações sobre os estados das imagens, veja “Usar as barras de navegação” 
na página 486.

5. Na lista Also Set Image (Definir também a imagem), selecione uma outra imagem a ser 
definida na página.

6. Clique em Browse (Procurar) para selecionar o arquivo de imagem a ser exibido, ou digite 
o caminho e nome do arquivo de imagem na caixa de texto To Image File (Para o arquivo 
de imagem).

7. Se tiver selecionado Over Image ou Over While Down Image na etapa 4, ainda há uma 
opção adicional. No campo de texto If Down, To Image File (Se inativa, o arquivo de 
imagem), clique em Browse para selecionar o arquivo de imagem, ou digite o caminho e 
nome do arquivo de imagem a ser exibido.

Set Text of Frame (Definir o texto do quadro)
A ação Set Text of Frame permite definir dinamicamente o texto de um quadro ao substituir o 
conteúdo e a formatação do quadro pelo conteúdo especificado. O conteúdo pode incluir 
qualquer código HTML válido. Utilize esta ação para exibir informações dinamicamente.

Embora a ação Set Text of Frame (Definir o texto do quadro) substitua a formatação de um 
quadro, é possível selecionar a opção Preserve Background Color para preservar os 
atributos das cores do fundo da página e do texto. 
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É possível incorporar qualquer chamada válida de função JavaScript, propriedade, variável 
global ou outra expressão no texto. Para incorporar uma expressão JavaScript, coloque-a entre 
chaves ({}). Para exibir um sinal de chaves, preceda-o por uma barra invertida (\{).

Exemplo:
The URL for this page is {window.location}, and today is {new Date()}.

Para criar um conjunto de quadros:

■ Escolher Modify (Modificar) > Frameset (Conjunto de quadros) > Split Frame Left, Right, 
Up, or Down (Dividir o quadro para a esquerda, para a direita, para cima ou para baixo).
Para obter mais informações, consulte “Criar quadros e conjuntos de quadros” na 
página 309.

Para utilizar a ação Set Text of Frame:

1. Selecione um objeto e abra o painel Behaviors (Comportamentos).

2. Clique no botão de adição (+) e escolha Set Text > Set Text of Frame no menu 
pop-up Actions.

3. Na caixa de diálogo Set Text of Frame, escolha o quadro de destino no menu 
pop-up Frame.

4. Clique no botão Get Current HTML (Obter o HTML atual), para copiar o conteúdo da 
seção body  do quadro de destino.

5. Digite uma mensagem na caixa de texto New HTML (Novo HTML) e clique em OK.

6. Verifique se o evento padrão corresponde ao desejado. Se não corresponder, escolha um 
outro evento no menu pop-up. 

Se não forem exibidos os eventos desejados, altere o navegador de destino no menu 
pop-up Show Events For (Mostrar os eventos de).

Set Text of Layer (Definir o texto da camada)
A ação Set Text of Layer substitui o conteúdo e a formatação de uma camada já existente em 
uma página pelo conteúdo especificado. O conteúdo pode incluir qualquer código-fonte 
HTML válido. 

A ação Set Text of Layer substitui o conteúdo e a formatação de uma camada, mas mantém os 
atributos da mesma, inclusive a cor. Formate o conteúdo, inclusive as tags HTML na caixa de 
texto New HTML (Novo HTML), na caixa de diálogo Set Text of Layer.

É possível incorporar qualquer chamada válida de função JavaScript, propriedade, variável 
global ou outra expressão no texto. Para incorporar uma expressão JavaScript, coloque-a entre 
chaves ({}). Para exibir um sinal de chaves, preceda-o por uma barra invertida (\{).
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Exemplo:
The URL for this page is {window.location}, and today is {new Date()}.

Para criar uma camada:

1. Selecione Insert (Inserir) > Layer (Camada).

Para obter mais informações, consulte “Inserir uma camada” na página 222.
2. No Property inspector (Inspetor de propriedades), digite um nome para a camada.

Para utilizar a ação Set Text of Layer:

1. Selecione um objeto e abra o painel Behaviors (Comportamentos). 

2. Clique no botão de adição (+) e escolha Set Text > Set Text of Layer no menu 
pop-up Actions.

3. Na caixa de diálogo Set Text of Layer, utilize o menu pop-up Layer, para escolher a camada 
de destino.

4. Digite uma mensagem na caixa de texto New HTML e clique em OK.

5. Verifique se o evento padrão corresponde ao desejado. Se não corresponder, escolha um 
outro evento no menu pop-up. 

Se não forem exibidos os eventos desejados, altere o navegador de destino no menu 
pop-up Show Events For (Mostrar os eventos de).

Set Text of Status Bar (Definir a mensagem de 
status)
A ação Set Text of Status Bar mostra uma mensagem na barra de status, na parte inferior 
esquerda da janela do navegador. Por exemplo: é possível utilizar esta ação para descrever o 
destino de um link na barra de status, em vez de mostrar a URL a ele associada. Para examinar 
um exemplo de mensagem de status, passe o mouse sobre qualquer um dos botões de 
navegação em Using Dreamweaver. Os visitantes geralmente ignoram ou não atentam para as 
mensagens na barra de status (e nem todos os navegadores fornecem suporte total para definir 
o texto da barra de status); se a mensagem for importante, pense na possibilidade de exibi-la 
como uma mensagem pop-up ou texto de uma camada.

É possível incorporar qualquer chamada válida de função JavaScript, propriedade, variável 
global ou outra expressão no texto. Para incorporar uma expressão JavaScript, coloque-a entre 
chaves ({}). Para exibir um sinal de chaves, preceda-o por uma barra invertida (\{).

Exemplo:
The URL for this page is {window.location}, and today is {new Date()}.
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Para utilizar a ação Set Text of Status Bar: 

1. Selecione um objeto e abra o painel Behaviors (Comportamentos).

2. Clique no botão de adição (+) e escolha Set Text > Set Text of Status Bar no menu 
pop-up Actions.

3. Na caixa de diálogo Set Text of Status Bar, digite a mensagem na caixa de texto Message 
(Mensagem).

A mensagem deverá ser concisa. Se a mensagem não couber na barra de status, ela 
aparecerá truncada no navegador.

4. Clique em OK.

5. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de).

Set Text of Text Field (Definir o texto do campo de 
texto)
A ação Set Text of Text Field substitui o conteúdo de um campo de texto de um formulário 
pelo conteúdo especificado.

É possível incorporar qualquer chamada válida de função JavaScript, propriedade, variável 
global ou outra expressão no texto. Para incorporar uma expressão JavaScript, coloque-a entre 
chaves ({}). Para exibir um sinal de chaves, preceda-o por uma barra invertida (\{).

Exemplo:
The URL for this page is {window.location}, and today is {new Date()}.

Para criar um campo de texto com nome:

1. Escolha Insert (Inserir) > Form Objects (Objetos de formulário) > Text Field (Campo de 
texto).

Se o Dreamweaver solicitar a adição de uma tag de formulário, clique em Sim. Para obter 
mais informações, consulte “Criar formulários” na página 885.

2. No Property inspector, digite um nome para o campo de texto. Certifique-se de que o 
nome seja exclusivo à página (não utilize o mesmo nome para diversos elementos na mesma 
página, mesmo se estiverem em formulários diferentes).
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Para utilizar a ação Set Text of Text Field:

1. Selecionar um campo de texto e abrir o painel Behaviors (Comportamentos).

2. Clique no botão com o sinal de adição (+) e escolha Set Text > Set Text of Text Field no 
menu pop-up Actions.

3. Na caixa de diálogo Set Text of Text Field, escolha o campo de texto de destino no menu 
pop-up Text Field.

4. Digite o texto no campo New Text (Novo texto) e, em seguida, clique em OK.

5. Verifique se o evento padrão corresponde ao desejado. Se não corresponder, escolha um 
outro evento no menu pop-up. 

Se não forem exibidos os eventos desejados, altere o navegador de destino no menu 
pop-up Show Events For (Mostrar os eventos de).

Show-Hide Layers (Mostrar/ocultar as camadas)
A ação Show-Hide Layers mostra, oculta ou restaura a visibilidade padrão de uma ou mais 
camadas. Esta ação é útil para mostrar informações à medida que o usuário interage com a 
página. Por exemplo: à medida que o usuário passar o ponteiro do mouse sobre a imagem de 
uma planta, uma camada poderá ser disparada, mostrando detalhes sobre a época e região de 
crescimento da planta, a quantidade de sol necessária, o tamanho que a planta pode atingir e 
assim por diante.

A ação Show-Hide Layers também é útil para criar uma camada de pré-carga, ou seja, uma 
camada grande que obscurece inicialmente o conteúdo da página, desaparecendo em seguida, 
quando todos os componentes da página tiverem sido carregados.

Para poder utilizar a ação Show-Hide Layers:

1. Escolha Insert (Inserir) > Layer (Camada), ou clique no botão Layer, situado na barra 
Insert, e desenhe uma camada na janela do documento.

Repita esta etapa para criar outras camadas.
2. Clique na janela do documento para desmarcar a camada e, em seguida, abra o 

painel Behavior.

3. Clique no botão com o sinal de adição (+) e escolha Show-Hide Layers (Mostrar-Ocultar 
camadas) no menu pop-up Actions.

Se a opção Show-Hide Layers não estiver disponível, é provável que já haja uma camada 
selecionada. Como as camadas não aceitam eventos em ambos os navegadores da versão 
4.0, selecione um outro objeto, como a tag body tag ou um link (a tag) ou, no menu pop-
up Show Events For (Mostrar os eventos de), altere o navegador de destino para Internet 
Explorer 4.0.
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4. No menu pop-up Named Layers, selecione a camada cuja visibilidade deseja alterar.

5. Clique em Show (Mostrar) para mostrar a camada, Hide (Ocultar) para ocultá-la ou 
Default (Padrão) para restaurar sua visibilidade padrão.

6. Repita as etapas 4 e 5 para todas as camadas cuja visibilidade ainda deseja alterar. É possível 
alterar a visibilidade de diversas camadas com um único comportamento.

7. Clique em OK.

8. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de).

Quando forem exibidas em uma janela do Netscape Navigator, é possível que as camadas 
sejam reduzidas para acomodar todo o conteúdo. Para evitar que isso ocorra, adicione texto ou 
imagens às camadas ou definir valores de corte das mesmas.

Para criar uma camada de pré-carga:

1. Clique no botão Draw Layer (Desenhar a camada), na categoria Common (Comuns) da 
barra Insert, e desenhe uma camada grande na visualização do projeto da janela do 
documento.

Certifique-se de que a camada cubra todo o conteúdo da página.
2. No painel Layers, arraste o nome da camada até o alto da lista de camadas, para especificar 

que esta camada deverá aparecer na frente da ordem de empilhamento.

3. Selecione a camada, se ela ainda não estiver selecionada, e denomine-a loading, 
(carregando), utilizando a caixa de texto na extremidade esquerda do Property inspector.

4. Mantendo a camada selecionada, defina, no Property inspector, a cor de fundo da camada 
como sendo a mesma cor que o fundo da página.
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5. Clique dentro da camada (que deverá estar obscurecendo o restante do conteúdo da página) 
e, se desejar, digite uma mensagem.

Por exemplo: as mensagens “Please wait while the page loads” (“Aguarde até que a página 
seja carregada”) ou “Loading...” (“Carregando...”) mantêm o visitante informado sobre o 
que está ocorrendo, para que ele não pense que a página não possui um conteúdo.

6. Clique na tag <body> no seletor de tags, situado no canto inferior esquerdo da janela do 
documento.

7. No menu pop-up Actions do painel Behaviors, escolha Show-Hide Layers.

8. Na lista Named Layers, selecione a camada denominada loading

9. Clique em Hide.

10. Clique em OK.

11. Certifique-se de que o evento listado ao lado da ação Show-Hide Layers, na lista de 
comportamentos seja onLoad. Se não for, selecione o evento e clique no triângulo para 
baixo, situado entre o evento e a ação. Na lista de eventos do menu pop-up, escolha onLoad.

Show Pop-Up Menu (Mostrar o menu pop-up)
Utilize o comportamento de Show Pop-Up Menu para criar ou editar um menu pop-up do 
Dreamweaver ou para abrir e modificar um menu pop-up Fireworks inserido em um 
documento do Dreamweaver. 

Defina as opções na caixa de diálogo Show Pop-Up Menu para criar um menu 
pop-up horizontal ou vertical. É possível utilizar esta caixa de diálogo para definir ou 
modificar a cor, o texto e a posição de um menu pop-up.

Para ver um menu pop-up em um documento, é necessário abrir o documento em uma janela 
do navegador e rolar o ponteiro sobre a imagem ou link acionado.

Para utilizar a ação Show Pop-up Menu:

1. Selecione um objeto ao qual deseja anexar o comportamento e abra o painel Behaviors 
(Comportamentos) (Shift+F4).

2. Clique no botão com o sinal de adição (+) e escolha Show Pop-Up Menu no menu pop-up 
Actions (Ações).

N
O

T
A

É necessário utilizar o botão Edit (Editar), no Property inspector do Dreamweaver, para 
editar imagens em um menu pop-up baseado em imagem. Entretanto, é possível utilizar 
o comando Show Pop-Up Menu para alterar o texto em um menu pop-up baseado em 
imagem. Para obter informações sobre a edição de imagens no Fireworks, consulte 
Capítulo 16, “Trabalhar com outros aplicativos”, na página 497.
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3. Na caixa de diálogo Show Pop-Up Menu que é exibida, utilize as guias a seguir para definir 
as opções do menu pop-up.

A guia Contents (Conteúdo) permite definir o nome, a estrutura, a URL e o destino dos 
itens de menu individuais. 
A guia Appearance (Aparência) permite definir a aparência dos estados Ativo e 
Sobreposto do menu e as opções de fonte para o texto do item de menu. 
A guia Advanced (Avançado) permite definir as propriedades das células de menu. Por 
exemplo: é possível definir a largura e a altura da célula, a cor da célula e a largura da 
borda, o recuo do texto e o tempo de atraso antes de o menu ser exibido após o usuário 
mover o ponteiro sobre o disparador. 
A guia Position (Posição) permite definir onde o menu está posicionado em relação a 
imagem ou link disparado.

Adicionar, remover e alterar a ordem dos itens do menu pop-
up
Utilize a guia Contents (Conteúdo) na caixa de diálogo Show Pop-up Menu para criar itens de 
menu. É possível utilizar essa guia para remover os itens existentes ou alterar a ordem em que 
eles são exibidos em um menu.

Para adicionar itens do menu pop-up:

1. Na guia Contents, crie um item de menu pop-up seguindo um dos procedimentos abaixo:

Na caixa de texto Text (Texto), selecione o texto padrão [New Item (Novo Item)] e digite 
o texto que será exibido no menu pop-up.

2. Definir as opções adicionais desejadas.

Para que o item de menu abra outro arquivo quando clicado, na caixa de texto Link, digite 
o caminho do arquivo ou clique no ícone de pasta e vá até o documento que deseja abrir.
Para definir uma localização onde abrir o documento, por exemplo, em uma nova janela 
ou em um quadro específico, no menu pop-up Target (Destino), escolha a localização 
desejada.

3. Clique no botão de adição (+) para adicionar outras entradas à lista de visualização Show 
Pop-Up Menu. 

Ao finalizar a adição dos itens de menu, clique em OK para aceitar as definições padrão ou 
selecione outra guia de Show Pop-Up Menu para definir as opções adicionais.

N
O

T
A

Se o quadro a ser designado não for exibido no menu pop-up Target, feche a caixa 
de diálogo Show Pop-Up Menu (Mostrar o menu pop-up) e, na janela Document 
(Documento), selecione o nome do quadro. 
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Para criar um item de submenu:

Na lista Show Pop-Up Menu, selecione o item que deseja transformar em um item de 
submenu e siga um dos procedimentos abaixo:

■ Para recuar um item na lista de menus, clique no botão Indent Item (Recuar o item).
■ Para remover um recuo, clique no botão Outdent Item (Remover o recuo) do item.

Para alterar a ordem de um item no menu:

■ Na lista Show Pop-Up Menu, selecione o item que deseja mover para cima ou para baixo, 
clique na seta para cima ou para baixo para mover o item aonde se deseja que ele seja 
exibido.

Para remover um item do menu:

1. Na guia Contents, selecione a entrada de menu que deseja remover na lista Show Pop-Up 
Menu.

2. Clique no botão com o sinal de subtração (-).

Definição da aparência de um menu pop-up
Após criar os itens de menu, deve-se utilizar a guia Appearance (Aparência) de Show Pop-up 
Menu (Mostrar o menu pop-up) para definir a orientação, os atributos de fonte e os atributos 
de estado do botão do menu pop-up.

Para definir a aparência de um menu pop-up.

1. No menu pop-up na parte superior da guia Appearance, escolher Vertical Menu (Menu 
Vertical) ou Horizontal Menu (Menu Horizontal) para definir a orientação do menu. 

2. Definir as opções de formatação de texto desejadas:

No menu pop-up Font (Fonte), selecione a fonte que se deseja aplicar aos itens de menu. 

Defina o tamanho da fonte, os atributos de estilo e as opções de alinhamento ou 
justificação do texto do item de menu.

N
O

T
A

Não é possível transformar o primeiro item do menu na lista em um item de 
submenu.

N
O

T
A

O painel de visualização da guia Appearance fornece um processamento aproximado 
das opções definidas nesta guia.

N
O

T
A

Se a fonte que se deseja aplicar não se encontrar na lista de fontes, utilize a opção 
Edit Font List (Editar lista de fontes), para adicionar a fonte desejada à lista de 
fontes. Para garantir que o menu será exibido conforme se deseja, é necessário 
escolher uma fonte que o visitante do site deve ter.
574 Capítulo 18:  Utilizar comportamentos JavaScript



         
3. Nas caixas Up State (Estado ativo) e Over States (Estado sobre), utilize o seletor de cor para 
definir as cores do texto e da célula dos botões do item de menu.

4. Ao finalizar a definição das opções de aparência, clique em OK ou selecione outra guia de 
Show Pop-Up Menu para definir as opções adicionais.

Definição das opções de aparência avançadas
Utilize as opções na guia Advanced (Avançado) para especificar atributos adicionais das células 
de menu. Por exemplo: é possível definir a largura, a altura, o espaçamento de célula ou o 
preenchimento do botão de menu, recuar o texto e definir os atributos da borda.

Para definir os atributos de formatação avançados de um menu pop-up:

1. Clique na guia Advanced e defina as opções que se deseja aplicar aos itens de menu:

A opção Cell Width (Largura da célula) define uma largura específica, em pixels, para os 
botões de menu. A largura da célula é definida automaticamente com base no maior item; 
para aumentar a largura da célula, deve-se selecionar Pixels no menu pop-up e inserir um 
valor maior que o valor da caixa de texto Cell Width.
A opção Cell Height (Altura da célula) define a altura específica, em pixels, dos botões do 
menu. Para aumentar a altura da célula, selecione Pixels no menu pop-up e insira um valor 
maior que o valor da caixa de texto Cell Height.
A opção Cell Padding (Preenchimento da célula) determina o número de pixels entre o 
conteúdo da célula e as suas bordas.
A opção Cell Spacing (Espaçamento entre as células) determina o número de pixels 
entre células adjacentes.
A opção Text Indent (Recuo de texto) permite especificar, em pixels, o recuo de texto em 
um item de menu na célula.
A opção Menu Delay (Espera do menu) define o tempo entre o movimento do ponteiro 
pelo usuário sobre a imagem ou link disparado e o momento em que o menu é exibido. Os 
valores são em milissegundos para que a definição padrão, 1000, seja igual a 1 segundo. 
Para cada segundo de atraso, adicione 000, por exemplo: para um atraso de 3 segundos, 
digite 3000.
A opção Pop-up Borders (Bordas pop-up) determina se uma borda é exibida em torno 
dos itens no menu. Se desejar que uma borda seja exibida em torno dos itens de menu, 
certifique-se de que a caixa de seleção Show Borders (Exibir bordas) está marcada.
A opção Border Width (Largura da borda) define o tamanho da borda em pixels.
As opções Shadow, Border Color e Highlight (Sombreado, Cor da borda e Realce) 
permitem selecionar uma cor para essas opções de borda. O sombreado e o realce não são 
exibidos na visualização.
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2. Ao finalizar a definição das opções avançadas de aparência, clique em OK ou selecione uma 
outra guia Show Pop-Up Menu (Mostrar o menu pop-up) para definir opções adicionais.

Definição da posição do menu pop-up em um documento
Utilize as opções de posição para definir onde o menu pop-up é exibido em relação à imagem 
ou ao link disparado. É possível também definir se o menu fica oculto ou não quando o 
usuário move o ponteiro para longe do disparador.

Para definir as opções de posição do menu pop-up:

1. Na caixa de diálogo Show Pop-Up Menu, clique na guia Position (Posição).

2. Defina a localização do menu pop-up, seguindo um dos procedimentos abaixo:

■ Escolha uma das opções predefinidas: 
■ Defina as coordenadas da posição personalizada digitando um número na caixa de 

texto X, para definir a coordenada horizontal, e digitando um número na caixa de 
texto Y, para definir uma coordenada vertical. As coordenadas são contadas a partir do 
canto superior esquerdo do menu.

3. Para ocultar o menu pop-up quando o ponteiro não estiver sobre ele, certifique-se de que 
se a opção Hide Menu onMouseOut Event (Ocultar evento onMouseOut) do menu está 
marcada. Para que o menu seja exibido, cancele a seleção dessa opção.

4. Ao finalizar a criação ou modificação do menu pop-up, clique em OK.

Modificação de um menu pop-up 
O comportamento de Show Pop-Up Menu (Mostrar o menu pop-up) permite editar ou 
atualizar o conteúdo de um menu pop-up. É possível adicionar, excluir ou alterar os itens de 
menu, reorganizá-los e definir onde um menu é posicionado em relação à imagem ou link 
disparado.

Para abrir um menu pop-up existente baseado em HTML:

1. No documento do Dreamweaver, selecione o link ou a imagem que aciona o menu pop-up.

2. Abra o painel Behaviors (Comportamentos) (Shift+F4), se ele ainda não estiver aberto, e, 
na lista Actions (Ações), clique duas vezes em Show Pop-Up Menu.

A caixa de diálogo Show Pop-Up Menu é exibida.
3. Faça as alterações que desejar no menu pop-up.

4. Ao finalizar a modificação do menu pop-up, clique em OK.

Para obter informações detalhadas sobre a definição das opções do menu pop-up, veja “Show 
Pop-Up Menu (Mostrar o menu pop-up)” na página 572.
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Swap Image (Trocar imagem)
A ação Swap Image substitui uma imagem por outra ao alterar o atributo src da tag img. 
Utilize esta ação para criar botões cambiáveis e outros efeitos em imagens (inclusive a troca 
simultânea de mais de uma imagem). Quando você insere uma imagem cambiável, é 
adicionado automaticamente um comportamento Swap Image à página.

Para utilizar a ação Swap Image:

1. Escolha Insert (Inserir) > Image (Imagem), ou clique no botão Image, situado na barra 
Insert, para inserir uma imagem.

2. Nomeie a imagem na caixa de texto mais à esquerda, no Property inspector (Inspetor de 
propriedades).

A ação Swap Image funcionará mesmo que você não nomeie as imagens. Esta ação nomeia 
automaticamente as imagens sem nome quando o comportamento for anexado a um 
objeto. Contudo, é mais fácil distinguir as imagens na caixa de diálogo Swap Image se 
todas tiverem sido nomeadas previamente. 

3. Repita as etapas 1 e 2 para inserir outras imagens.

4. Selecione um objeto (geralmente a imagem a ser permutada) e abra o painel Behaviors 
(Comportamentos).

5. Clique no botão de adição (+) e escolha Swap Image (Trocar imagem) no menu 
pop-up Actions.

6. Na lista Images (Imagens), selecione a imagem cuja origem deseja alterar.

7. Clique em Browse (Procurar) para selecionar o arquivo da nova imagem, ou digite o 
caminho e o nome do arquivo da nova imagem na caixa de texto Set Source To (Definir a 
origem como).

8. Repita as etapas 6 e 7 para quaisquer outras imagens a serem alteradas. Utilize a mesma a 
ação de permuta de imagens simultaneamente em todas as imagens a serem modificadas, 
caso contrário, a ação Swap Image Restore (Restaurar troca de imagem) a ela 
correspondente não irá restaurar todas as imagens.

9. Quando a página tiver sido carregada, selecione a opção Preload Images para carregar as 
novas imagens no cache do navegador.

Esse processo evita os atrasos causados pelo download quando as imagens precisarem ser  
exibidas.

N
O

T
A

Uma vez que apenas o atributo src é afetado por essa ação, a nova imagem a ser 
empregada deverá ter as mesmas dimensões (altura e largura) que a original. Caso 
contrário, a nova imagem aparecerá compactada ou expandida, para se ajustar às 
dimensões da imagem original.
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10. Clique em OK.

11. Verifique se o evento padrão corresponde ao desejado.

Se não corresponder, escolha um outro evento no menu pop-up. Se os eventos desejados 
não estiverem listados, altere o navegador de destino no menu pop-up Show Events For 
(Mostrar os eventos de).

Swap Image Restore (Restaurar troca de imagem)
A ação Swap Image Restore restaura o último conjunto de imagens permutadas aos seus 
arquivos de origem anteriores. Esta ação é adicionada automaticamente sempre que a ação 
Swap Image (Trocar imagem) a um objeto for anexada. Não será necessário selecionar a opção 
Swap Image Restore se a opção Restore (Restaurar) tiver sido selecionada.

Validate Form (Validar o formulário)
A ação Validate Form verifica o conteúdo de determinados campos de texto, a fim de garantir 
que o usuário tenha digitado o tipo correto de dados. Anexe esta ação a certos campos de texto 
com o evento onBlur, para validar os campos à medida que o usuário estiver preenchendo o 
formulário, ou você pode anexá-la ao formulário com o evento onSubmit, para avaliar 
diversos campos de texto simultaneamente quando o usuário clicar no botão Submit (Enviar). 
A anexação desta ação a um formulário evita que este seja enviado ao servidor se algum dos 
campos contiver dados incorretos.

Para utilizar a ação Validate Form:

1. Escolha Insert (Inserir) > Form (Formulário), ou clique no botão Form (situado na barra 
Insert) para inserir um formulário.

2. Escolha Insert (Inserir) > Form Objects (Objetos de formulário) > Text Field (Campo de 
texto), ou clique no botão Text Field, situado na barra Insert, para inserir um campo de 
texto.

Repita esta etapa para inserir outros campos de texto.
3. Siga um dos procedimentos abaixo:

■ Para validar determinados campos à medida que o usuário estiver preenchendo o 
formulário, selecione um campo de texto e escolha Window (Janela) > Behaviors 
(Comportamentos).

■ Para validar vários campos quando o usuário enviar o formulário, clique na tag <form> 
no seletor de tags, situado no canto inferior esquerdo da janela do documento, e 
escolha Window > Behaviors.
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4. No menu pop-up Actions (Ações), escolha Validate Form.

5. Siga um dos procedimentos abaixo:

■ Se você estiver validando determinados campos, selecione o mesmo campo que tiver 
selecionado na janela do documento, na lista Named Fields (Campos com nome).

■ Se estiver validando vários campos, selecione um campo de texto na lista 
 Named Fields.

6. Selecione a opção apropriada, se o campo se destinar a receber dados.

7. Escolha uma das opções a seguir em Accept (Aceitar):

Utilize a opção Anything (Qualquer item), se o campo for necessário, sem precisar conter 
qualquer tipo específico de dados.  Esta opção não terá significado (ela equivale à ausência, 
no campo, da ação Validate Form) se a opção Required (Necessário) não estiver 
selecionada.
Utilize a opção E-mail (Endereço eletrônico), para verificar se o campo contém um sinal 
de @.
Utilize a opção Number (Número), para verificar se o campo contém apenas algarismos 
numéricos.
Utilize a opção Number From (Número de), para verificar se o campo contém apenas um 
número em uma faixa específica.

8. Se estiver validando vários campos, repita as etapas 6 e 7 para quaisquer outros campos a 
serem validados.

9. Clique em OK.

Se estiver validando vários campos quando o usuário enviar o formulário, o evento 
onSubmit aparecerá automaticamente no menu pop-up Events (Eventos). 

10. Se estiver validando um determinado campo, certifique-se de que o evento padrão seja 
 onBlur ou onChange.

Se não for, selecione onBlur ou onChange no menu pop-up. Ambos os eventos ativam a 
ação Validate Form, assim que o usuário mover o cursor para fora do campo. A diferença 
entre estes eventos está na ocorrência invariável de onBlur, se o usuário tiver digitado no 
campo ou não, enquanto que onChange ocorrerá apenas se o usuário tiver alterado o 
conteúdo do campo. O evento onBlur é preferível quando você tiver especificado que o 
campo é necessário. 
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PARTE 5

Trabalhar com códigos de 
página

Utilize as ferramentas de codificação avançadas do Dreamweaver 8 para 
criar ou modificar páginas.

Esta seção contém os seguintes capítulos:
Capítulo 19: Configurar o ambiente de codificação  . . . . . . . . . . 583

Capítulo 20: Codificar no Dreamweaver . . . . . . . . . . . . . . . . . . . . 603

Capítulo 21: Otimizar e depurar o código  . . . . . . . . . . . . . . . . . . . 633

Capítulo 22: Editar o código na Design View (Visualização 
do projeto) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 643

N
O

T
A

Para obter ajuda com as referências de linguagem, pressione Shift+F1 
no modo de visualização de código.
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CAPÍTULO 19

Configurar o ambiente de 
codificação
É possível adaptar o ambiente de codificação do Macromedia Dreamweaver 8 à sua maneira 
de trabalho. Por exemplo: é possível alterar a forma de exibir códigos, configurar diferentes 
atalhos de teclado, ou importar e utilizar a biblioteca de tags favorita. 

Este capítulo aborda os tópicos a seguir:
Exibir o código. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .583

Utilizar a área de trabalho orientada a codificador (apenas no Windows). . . . . . .585

Definir preferências de codificação . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .585

Personalizar atalhos de teclado  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .589

Abrir arquivos na visualização do código por padrão. . . . . . . . . . . . . . . . . . . . . . . . .589

Definir preferências do Validator (Validador) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 590

Gerenciar bibliotecas de tags  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 591

Importar tags personalizadas para o Dreamweaver . . . . . . . . . . . . . . . . . . . . . . . . . 596

Utilizar um editor de HTML externo com o Dreamweaver . . . . . . . . . . . . . . . . . . . 599

Exibir o código
É possível exibir o código-fonte do documento atual de várias maneiras: é possível exibi-lo na 
janela do documento ativando a visualização do código, dividir a janela do documento para 
exibir a página e o código associado, ou trabalhar no Code inspector (Inspetor de código), 
uma janela de codificação separada. O Code inspector e a visualização do código funcionam 
da mesma forma. Você pode pensar no Code inspector como uma visualização do código 
destacável para o documento atual.

Esta seção contém instruções para alterar a forma de exibição de código.
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Para exibir o código na janela do documento:

■ Selecione View (Exibir)  > Code (Código). 

Para codificar e editar visualmente uma página na janela do documento ao 
mesmo tempo:

1. Selecione View  > Code and Design (Código e projeto). 

O código é exibido no painel superior e a página, no painel inferior. 
2. Para exibir a página na parte superior, escolha View  > Design View on Top (Visualização 

do projeto no alto).

3. Para ajustar o tamanho dos painéis na janela do documento, arraste a barra de divisão até a 
posição desejada.

A barra de divisão está localizada entre os dois painéis.
A visualização do código é atualizada automaticamente quando são feitas alterações na 
visualização do projeto. No entanto, após fazer alterações na visualização do código, você 
deve atualizar manualmente o documento na visualização do projeto. Para isso, clique 
nessa visualização e pressione F5. 

Para exibir o código em uma janela separada:

■ Selecione Window (Janela) > Code Inspector.
584 Capítulo 19:  Configurar o ambiente de codificação



         
Utilizar a área de trabalho orientada a 
codificador (apenas no Windows)
No Windows, é possível usar uma área de trabalho com aparência similar à área de trabalho do 
Macromedia HomeSite, com os grupos de painéis reunidos no lado esquerdo, e não no lado 
direito, da janela principal. Por padrão, o layout da área de trabalho exibe o Property inspector 
(Inspetor de propriedades) minimizado e a janela do documento é exibida na visualização do 
código. Para obter informações sobre a utilização desta opção, consulte “Escolher o layout de 
área de trabalho (no Windows)” na página 78.

Tópicos relacionados
■ “Abrir arquivos na visualização do código por padrão” na página 589.

Definir preferências de codificação 
Você pode personalizar o ambiente de codificação do Dreamweaver para atender às suas 
necessidades específicas definindo preferências de formatação, reescrita e codificação por cores 
do código entre outras. 

N
O

T
A

Para definir as preferências avançadas, utilize o Tag Library editor (Editor de bibliotecas 
de tags) (consulte “Gerenciar bibliotecas de tags” na página 591).

barra de ferramentas 
do documento

barra Insert 
(Inserir)

Files (Arquivos), 
painel

grupos de painéis

janela do documentoProperty inspector (minimizado)Seletor de tags
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Definir as opções de visualização de código
É possível definir a quebra automática de linha, exibir números de linha para o código, realçar 
um código inválido, codificar a sintaxe por cores para elementos do código e definir o recuo 
no menu View  > Code View Options (Opções de visualização do código).

Para definir opções da visualização do código e do Code inspector:

1. Exiba um documento na visualização do código ou no Code inspector. 

2. Siga um dos procedimentos abaixo:

■ Selecione View > Code View Options
■ Clique no menu View Options (Opções de exibição) na barra de ferramentas na parte 

superior da visualização do código ou do Code inspector. 
3. Para ativar ou desativar qualquer uma das opções a seguir, selecione-as no menu.

Word Wrap (Quebra de linha) quebra automaticamente o código para permitir exibi-lo 
sem rolar horizontalmente. Esta opção não insere quebras de linha, apenas facilita a 
visualização do código.
Line Numbers (Números de linha) exibe números de linha ao lado do código.
Hidden Characters (Caracteres ocultos) exibe caracteres especiais no lugar no espaço 
em branco. Por exemplo, um ponto substitui cada espaço, uma divisa dupla substitui cada 
tabulação, e um marcador de parágrafo substitui cada quebra de linha.

Highlight Invalid Code (Realçar o código incorreto) faz com que o Dreamweaver realce 
em amarelo todos os códigos HTML incorretos. Quando uma tag inválida for 
selecionada, o Property inspector exibirá informações sobre como corrigir o erro.
Syntax Coloring (Cor da sintaxe) ativa ou desativa a cor do código. Para obter 
informações sobre como alterar o esquema de cores, consulte “Definir preferências de 
codificação por cores” na página 589.
Auto Indent (Recuo automático) faz o recuo automático do código quando o usuário 
pressiona a tecla Enter enquanto grava o código. A nova linha do código é recuada para o 
mesmo nível da linha anterior. Para obter informações sobre o espaçamento do recuo, 
consulte a opção Tab Size (Tamanho da tabulação) em “Definir as preferências de 
formatação de código” na página 587.

N
O

T
A

As quebras de linha condicionais utilizadas pelo Dreamweaver não são exibidas com 
um marcador de parágrafo.
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Tópicos relacionados
■ “Exibir o código” na página 583
■ “A barra de ferramentas Coding” na página 53

Definir as preferências de formatação de código
É possível alterar a aparência do código especificando preferências de formatação como recuo, 
tamanho de linha, a caixa da tag e nomes de atributos. 

Observe que todas as preferências, exceto “Override Case Of” (Ignorar a caixa de), afetam 
apenas os novos documentos e as inclusões feitas nos documentos existentes. Ou seja, quando 
um documento HTML criado anteriormente for aberto, essas opções de formatação não serão 
aplicadas a ele. Para reformatar documentos HTML existentes, utilize o comando Apply 
Source Formatting (Aplicar a formatação de origem). Para obter mais informações, consulte 
“Aplicar novas preferências de formatação a documentos existentes” na página 587.

Para definir preferências de formatação de código:

1. Selecione Edit (Editar)  > Preferences (Preferências).

2. Selecione Code Format (Formato do código) na lista Category (Categoria) à esquerda.

As preferências de formato de código são exibidas.
3. Ajuste uma das definições da caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Aplicar novas preferências de formatação a 
documentos existentes
As opções de formatação de código especificadas nas preferências de formato do código só se 
aplicam a documentos novos criados posteriormente com o Dreamweaver. No entanto, você 
pode aplicar novas preferências de formatação a documentos existentes. 

Para aplicar novas preferências de formatação a um documento existente:

1. Abra o documento no Dreamweaver.

2. Selecione Commands (Comandos)  > Apply Source Formatting (Aplicar a formatação de 
origem).
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Definir as preferências de referências de código
As referências de código permitem que você insira rapidamente nomes de tag, atributos e 
valores à medida que digita o código no modo de visualização de código ou no Quick Tag 
Editor. Para obter mais informações, consulte “Utilizar as referências de código” na 
página 613 ou “Usar o menu de referências no Quick Tag Editor” na página 648. 

Para definir preferências de referências de código:

1. Selecione Edit (Editar)  > Preferences (Preferências).

2. Selecione Code Hints (Referências de código) na lista Category (Categoria) à esquerda.

As preferências de referências de código são exibidas.
3. Ajuste uma das definições da caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Tópicos relacionados
■ “Utilizar as referências de código” na página 613

Definir preferências de reescrita de código
Quando você abre um documento, o Dreamweaver corrige (ou reescreve) alguns tipos de 
códigos tecnicamente inválidos, dependendo das preferências de reescrita de código 
especificadas. Essas preferências não provocam qualquer efeito sobre a edição de HTML ou 
scripts na visualização do código. 

Se as opções de reescrita forem desativadas, o Dreamweaver exibirá itens de markup inválidos 
na janela do documento para o HTML que seria reescrito. 

Para definir preferências de reescrita de código:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

2. Selecione Code Rewriting (Reescrita de código) na lista Category (Categoria) à esquerda.

As preferências de reescrita de código são exibidas.
3. Ajuste uma das definições da caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Tópicos relacionados
■ “Limpar arquivos HTML do Microsoft Word” na página 108

D
IC

A

Mesmo se as referências de código estiverem desativadas, você poderá exibir uma 
referência pop-up na visualização do código pressionando a tecla Control e a barra de 
espaço.
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Definir preferências de codificação por cores
Utilize as preferências de codificação por cores para especificar cores para as categorias gerais 
de tags e elementos de código, como tags relacionadas a forma ou os identificadores de 
JavaScript. Para definir preferências de cores para uma tag específica, edite a definição da tag 
no Tag Library editor (Editor de bibliotecas de tags). Para obter mais informações, consulte 
“Editar bibliotecas, tags e atributos” na página 593. 

Para definir preferências de codificação por cores: 

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

2. Selecione Code Coloring (Codificação por cores) na lista Category (Categoria) à esquerda.

As preferências de codificação por cores são exibidas.
3. Ajuste uma das definições da caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Tópicos relacionados
■ “Personalizar preferências de cores de código para um modelo” na página 342

Personalizar atalhos de teclado
É possível utilizar os atalhos de teclado favoritos no Dreamweaver. Se você estiver acostumado 
a utilizar atalhos de teclado – por exemplo, Control+Enter para adicionar uma quebra de 
linha, Control+G para ir até uma posição específica no código ou Shift+F6 para validar um 
arquivo – poderá adicioná-los ao Dreamweaver por meio do Keyboard Shortcut Editor 
(Editor de atalhos de teclado). Para obter mais informações, consulte “Personalização de 
atalhos de teclado” na página 83.

Tópicos relacionados

“Trabalhar com trechos de código” na página 615

Abrir arquivos na visualização do código 
por padrão
Quando o usuário abre um tipo de arquivo que não costuma conter HTMLs (por exemplo, 
um arquivo JavaScript), o arquivo é aberto na visualização do código ou no Code inspector, e 
não na visualização do projeto. Você pode especificar quais tipos de arquivos deverão ser 
abertos na visualização do código. 
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Para definir a visualização padrão de arquivos não-HTML:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

2. Na lista Category (Categoria) à esquerda, selecione File Types/Editors (Tipos de arquivos/
editores).

As preferências de tipos de arquivos/editores são exibidas.
3. Na caixa de texto Open in Code View (Abrir na visualização do código), digite a extensão 

de nome para o tipo de arquivo a ser aberto automaticamente nessa visualização.

Digite um espaço entre as extensões de nomes de arquivos. Você pode adicionar quantas 
extensões desejar. 

Definir preferências do Validator 
(Validador)
Você pode utilizar o Validator do Dreamweaver para localizar rapidamente erros de tag ou de 
sintaxe no código (consulte “Validar tags” na página 639). É possível especificar os idiomas 
baseados em tag nos quais o Validator deve fazer a verificação, os problemas específicos a 
serem verificados pelo Validator e os tipos de erros a serem relatados pelo Validator. 

Para definir preferências para o Validator:

1. Selecione Edit > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh).

2. Selecione Validator na lista Category (Categoria) à esquerda.

As preferências do Validator são exibidas.
3. Selecione as bibliotecas de tags de acordo com as quais deseja validar o código e defina 

opções para essas bibliotecas.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

N
O

T
A

As preferências do Validator são ignoradas quando você valida um documento que 
especifica explicitamente um tipo de documento.
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Gerenciar bibliotecas de tags
Uma biblioteca de tags, no Dreamweaver, é um conjunto de tags de um tipo específico e de 
informações sobre como o Dreamweaver deve formatar essas tags. As bibliotecas de tags 
fornecem informações sobre as tags que o Dreamweaver utiliza para referências de código, as 
verificações de navegador de destino, o Tag Chooser (Seletor de tags) e outros recursos de 
codificação. O Tag Library editor (Editor de bibliotecas de tags) permite adicionar e excluir 
bibliotecas de tags, tags e atributos, definir propriedades para uma biblioteca de tags, e editar 
tags e atributos. 

Consulte também “Importar tags personalizadas para o Dreamweaver” na página 596.

Abrir e fechar o Tag Library editor (Editor de 
bibliotecas de tags)
Para gerenciar bibliotecas de tags, utilize o Tag Library editor.

Para abrir o Tag Library editor:

■ Selecione Edit (Editar)  > Tag Libraries (Bibliotecas de tags).
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O Tag Library editor é aberto. (O conteúdo desta caixa de diálogo é alterado de acordo com a 
tag selecionada). 

Para fechar o Tag Library editor e salvar as alterações:

■ Clique em OK.

Para fechar o Tag Library editor sem salvar as alterações:

■ Clique em Cancel (Cancelar).

Adicionar bibliotecas, tags e atributos
Você pode utilizar o Tag Library editor (Editor de bibliotecas de tags) para adicionar 
bibliotecas de tags, tags e atributos às bibliotecas de tags do  Dreamweaver.

N
O

T
A

Quando você clicar em Cancel, todas as alterações feitas no Tag Library editor serão 
descartadas. Se você tiver excluído uma tag ou uma biblioteca de tags, ela será 
recuperada.

N
O

T
A

Para importar uma tag, consulte “Importar tags personalizadas para o Dreamweaver” na 
página 596.
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Para adicionar uma biblioteca de tags:

1. No Tag Library editor, em Edit (Editar)  > Tag Libraries (Bibliotecas de tags), clique no 
botão de adição (+) e selecione New Tag Library (Nova biblioteca de tags).

A caixa de diálogo New Tag Library é exibida.
2. Na caixa de texto Library Name (Nome da biblioteca), digite um nome, por exemplo, Tags 

diversas.

3. Clique em OK.

Para adicionar tags a uma biblioteca de tags:

1. No Tag Library editor, em Edit  > Tag Libraries, clique no botão de adição (+) e escolha 
New Tags (Novas tags).

A caixa de diálogo New Tags é exibida.
2. Ajuste uma das definições da caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

Para adicionar um ou mais atributos em uma tag:

1. No Tag Library editor, em Edit  > Tag Libraries, clique no botão de adição (+) e escolha 
New Attributes (Novos atributos).

A caixa de diálogo New Attributes será exibida.
2. Ajuste uma das definições da caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

Tópicos relacionados
■ “Gerenciar bibliotecas de tags” na página 591
■ “Excluir bibliotecas, tags e atributos” na página 595

Editar bibliotecas, tags e atributos
Você pode utilizar o Tag Library editor (Editor de bibliotecas de tags) para definir 
propriedades para uma biblioteca de tags e editar tags e atributos em uma biblioteca, seja para 
os atributos, seus valores ou formato (para facilitar a identificação no código).
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Para definir as propriedades de uma biblioteca de tags:

1. No Tag Library editor (Editor de bibliotecas de tags), em Edit (Editar)  > Tag Libraries 
(Bibliotecas de tags), selecione uma biblioteca de tags, e não uma tag, na lista Tags. 

2. Na lista Used In (Utilizado em), selecione todos os tipos de documentos que devem utilizar 
a biblioteca de tags.

Os tipos selecionados aqui determinam que tipos de documentos fornecem referências de 
código para essa biblioteca específica. Por exemplo, se a opção HTML não for selecionada 
para uma biblioteca de tags específica, as referências de código para essa biblioteca não 
serão exibidas em arquivos HTML.

3. Se as tags da biblioteca de tags precisarem de um prefixo, digite o prefixo na caixa de texto 
Tag Prefix (Prefixo da tag).

4. Ao concluir as alterações no Tag Library editor (Editor de bibliotecas de tags), clique em 
OK.

Para editar uma tag em uma biblioteca de tags:

1. No Tag Library editor, em Edit (Editar) > Tag Libraries, abra uma biblioteca de tags na 
lista Tags e selecione uma tag.

2. Defina qualquer uma destas opções de formato de tag:

Line Breaks (Quebras de linha) especifica onde o Dreamweaver insere quebras de linha 
para uma tag. 
Contents (Conteúdo) especifica como o Dreamweaver insere o conteúdo de uma tag, ou 
seja, se ele aplica quebra de linha, e regras de formatação e recuo ao conteúdo. 
Case (Caixa) especifica a caixa para determinada tag. Selecione Default (Padrão), 
Lowercase (Minúsculas), Uppercase (Maiúsculas) ou Mixed Case (Maiúsculas e 
minúsculas). Se você selecionar Mixed Case, a caixa de diálogo Tag Name Mixed Case 
(Nome da tag em maiúsc./minúsc.) será exibida. Digite a tag em maiúsculas ou 
minúsculas, determine como o Dreamweaver deverá utilizá-la quando inseri-la (por 
exemplo, getProperty) e clique em OK.

N
O

T
A

As propriedades das bibliotecas de tags serão exibidas somente quando uma 
biblioteca de tags for selecionada. As bibliotecas de tags são representadas pelas 
pastas superiores da lista Tags; por exemplo, a pasta HTML Tags (Tags de HTML) 
representa uma biblioteca de tags, e a pasta abbr dentro da pasta HTML Tags 
representa uma tag.

N
O

T
A

Um prefixo é utilizado para identificar uma tag no código como parte de uma 
biblioteca de tags específica. Algumas bibliotecas de tags não utilizam prefixos.
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Set Default (Definir os padrões) define a caixa padrão para todas as tags. Na caixa de 
diálogo Default Tag Case (Caixa padrão da tag) que é exibida, selecione <UPPERCASE> 
ou <lowercase> e clique em OK. 

Para editar um atributo para uma tag:

1. No Tag Library editor, em Edit  > Tag Libraries, expanda uma biblioteca de tags na caixa 
Tags, expanda uma tag e selecione um atributo de tag.

2. No menu pop-up Attribute Case (Caixa do atributo), selecione Default (Padrão), 
Lowercase, Uppercase ou Mixed Case.

Se você selecionar Mixed Case, a caixa de diálogo Attribute Name Mixed Case (Nome da 
tag em maiúsc./minúsc.) será exibida. Digite o atributo em maiúsculas ou minúsculas 
como o Dreamweaver deverá utilizá-lo quando inseri-lo (por exemplo, onClick) e clique 
em OK.
Clique no link Set Default (Definir padrão) para definir a caixa padrão para todos os 
nomes de atributos. 

3. No menu pop-up Attribute Type (Tipo de atributo), selecione o tipo de atributo.

Se você selecionar Enumerated (Enumerados), digite cada valor permitido para o atributo 
na caixa de texto Values (Valores). Separe os valores por vírgulas, e não espaços. Por 
exemplo, os valores enumerados do atributo showborder da tag cfchart são listados 
como yes,no.

Tópicos relacionados
■ “Gerenciar bibliotecas de tags” na página 591
■ “Adicionar bibliotecas, tags e atributos” na página 592

Excluir bibliotecas, tags e atributos
Você pode utilizar o Tag Library editor (Editor de bibliotecas de tags) para excluir bibliotecas 
de tags, tags e atributos. 

Para excluir uma biblioteca, uma tag ou um atributo:

1. No Tag Library editor, em Edit (Editar)  > Tag Libraries (Bibliotecas de tags), selecione 
uma biblioteca de tags, uma tag ou um atributo na caixa Tags.

2. Clique no botão com o sinal de subtração (-).

D
IC

A

Talvez seja necessário definir a caixa padrão como minúsculas por questões de 
compatibilidade com os padrões XML e XHTML.
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3. Se for solicitada a confirmação da exclusão, clique em OK para excluir o item 
permanentemente.

O item é removido da caixa Tags.
4. Clique em OK para fechar o Tag Library editor e concluir a exclusão.

Tópicos relacionados
■ “Gerenciar bibliotecas de tags” na página 591
■ “Adicionar bibliotecas, tags e atributos” na página 592
■ “Editar bibliotecas, tags e atributos” na página 593

Importar tags personalizadas para o  
Dreamweaver
Você pode importar tags personalizadas para o Dreamweaver de forma que elas se tornem 
parte integral do ambiente de criação. Por exemplo, quando você começa a digitar uma tag 
personalizada importada na visualização do código, um menu de referências de código é 
exibido com uma lista de atributos da tag entre os quais você pode selecionar um. 

Importar tags de arquivos XML
É possível importar tags de um arquivo DTD (Definição de tipo de documento, Document 
Type Definition) XML ou de um esquema. 

Para importar tags de um DTD XML ou de um esquema: 

1. Abra o Tag Library editor (Editor de bibliotecas de tags), em Edit (Editar)  > Tag Libraries 
(Bibliotecas de tags).

2. Clique no botão de adição (+) e selecione DTD Schema (Esquema DTD)  > Import XML 
DTD or Schema File (Importar arquivo XML, DTD ou Schema). 

3. Digite o nome do arquivo ou a URL do arquivo DTD ou esquema.

4. Digite o prefixo a ser utilizado com as tags.

5. Clique em OK.

N
O

T
A

Um prefixo é utilizado para identificar uma tag no código como parte de uma 
biblioteca de tags específica. Algumas bibliotecas de tags não utilizam prefixos.
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Importar tags ASP.NET personalizadas
É possível importar tags ASP.NET personalizadas para o Dreamweaver. 

Antes de iniciar, certifique-se de que a tag personalizada esteja instalada no servidor de teste 
definido na caixa de diálogo Site Definition (Definição de sites). Consulte “Especificar onde 
as páginas dinâmicas podem ser processadas” na página 667. Coloque as tags compiladas 
(arquivos .dll) na pasta /bin da raiz do site. Tags não-compiladas (arquivos .ascx) podem 
residir em qualquer diretório ou subdiretório virtual no servidor. Para obter mais informações, 
consulte a documentação do Microsoft ASP.NET.

Para importar tags personalizadas ASP.NET para o Dreamweaver:

1. Abra uma página ASP.NET no Dreamweaver.

2. Abra o Tag Library editor (Editor de bibliotecas de tags), em Edit (Editar)  > Tag Libraries 
(Bibliotecas de tags).

3. Clique no botão de adição (+) e escolha uma das opções a seguir:

■ Para importar todas as tags personalizadas ASP.NET do servidor de aplicativos, 
selecione ASP.NET > Import All ASP.NET Custom Tags (Importar todas as tags 
ASP.NET personalizadas).

■ Para importar apenas algumas tags personalizadas do servidor de aplicativos, selecione 
ASP.NET  > Import Selected ASP.NET Custom Tags (Importar as tags ASP.NET 
personalizadas selecionadas).

A caixa de diálogo Import Selected ASP.NET Custom Tags é exibida, listando todas as tags 
personalizadas ASP.NET instaladas no servidor de aplicativos. Mantenha pressionada a 
tecla Control (no Windows) ou a tecla Command (no Macintosh) e clique em tags da 
lista. Em seguida, clique em OK. 

Importar tags JSP de um arquivo 
É possível importar uma biblioteca de tags JSP para o Dreamweaver de diversos tipos de 
arquivo. 

Para importar uma biblioteca de tags JSP para o Dreamweaver:

1. Abra uma página JSP no Dreamweaver.

2. Abra o Tag Library editor (Editor de bibliotecas de tags), em Edit (Editar)  > Tag Libraries 
(Bibliotecas de tags).

3. Clique no botão de adição (+) e selecione JSP >  Import From File (Importar do arquivo) 
(*.tld, *.jar, *.zip).
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4. Digite um nome de arquivo, uma URI e um prefixo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
5. Clique em OK.

Importar tags JSP de um servidor (web.xml)
É possível importar uma biblioteca de tags JSP para o Dreamweaver de um arquivo web.xml 
em um servidor JSP. 

Para importar tags JSP de um servidor:

1. Abra uma página JSP no Dreamweaver.

2. Abra o Tag Library editor (Editor de bibliotecas de tags), em Edit (Editar)  > Tag Libraries 
(Bibliotecas de tags).

3. Clique no botão de adição (+) e selecione JSP > Import from Server (Importar do servidor) 
(web.xml). 

A caixa de diálogo Import from Server é exibida.
4. Digite um nome de arquivo e um URI.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
5. Clique em OK.

Importar tags JRun
Se você utilizar o Macromedia JRun, poderá importar tags JRun para o Dreamweaver. 

Para importar tags JRun para o Dreamweaver:

1. Abra uma página JSP no Dreamweaver.

2. Abra o Tag Library editor (Editor de bibliotecas de tags), em Edit (Editar)  > Tag Libraries 
(Bibliotecas de tags).

3. No Tag Library editor (Editor de bibliotecas de tags), clique no botão de adição (+) e 
selecione JSP > Import JRun Server Tags from Folder (Importar as tags do servidor JRUN 
a partir da pasta). 

4. Digite um nome de pasta, um URI e um prefixo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
5. Clique em OK.
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Utilizar um editor de HTML externo com 
o Dreamweaver 
É possível iniciar um editor de texto ou HTML externo no Dreamweaver para editar o 
código-fonte no documento atual e, em seguida, alternar novamente para o Dreamweaver e 
continuar a edição gráfica. O Dreamweaver detecta as alterações salvas no documento 
externamente e solicita que você recarregue o documento quando retornar. 
É possível utilizar os editores de HTML integrados a seguir: Macromedia HomeSite (apenas 
no Windows) ou BBEdit (apenas no Macintosh). Também é possível utilizar outro editor de 
texto, como Notepad (Bloco de Notas), WordPad, TextPad, TextEdit, SimpleText, vi ou 
emacs.

Utilizar um editor de HTML integrado
Quando instalar o Dreamweaver, você poderá instalar o HomeSite no Windows ou uma 
versão de teste do BBEdit no Macintosh. O Dreamweaver é bastante integrado a esses dois 
produtos.

Graças a essa integração, é possível editar um documento no Dreamweaver e no HomeSite/
BBEdit, alternando de um aplicativo para o outro. O documento é mantido em sincronização 
automática nos dois aplicativos. Além disso, os dois aplicativos controlam a seleção atual; por 
exemplo, se o usuário selecionar um texto no Dreamweaver e alternar para o BBEdit, o 
mesmo elemento será selecionado no BBEdit. 

Você pode abrir outros editores externos, além do HomeSite ou do BBEdit, no Dreamweaver, 
mas o documento não é mantido em sincronização nos dois aplicativos, como ocorre com o 
HomeSite ou o BBEdit. Quando terminar de fazer alterações em um editor externo diferente 
do HomeSite ou do BBEdit, você deverá atualizar manualmente o documento no 
Dreamweaver. 

Utilizar o HomeSite (apenas no Windows)
Não é necessário ativar a integração para o HomeSite; ele é integrado automaticamente 
quando os dois aplicativos são instalados. 

Para utilizar o HomeSite:

1. Selecione Edit (Editar)  > Edit with HomeSite (Editar com o HomeSite). 

2. Edite o documento no HomeSite e salve as alterações.

3. Para retornar ao Dreamweaver, clique em Dreamweaver na barra de ferramentas Editor.
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Utilizar o BBEdit (apenas no Macintosh)
Você poderá desativar a integração com o BBEdit se optar por não utilizá-lo. As seleções entre 
o Dreamweaver e o BBEdit não serão controladas se a integração com o BBEdit estiver 
desativada. No entanto, a adição no Dreamweaver poderá ser mais rápida se a integração com 
o BBEditfor desativada.

Para utilizar o BBEdit com o Dreamweaver:

1. Selecione Edit (Editar)  > Edit with BBEdit (Editar com o BBEdit). 

2. Edite o documento no BBEdit.

3. Clique no botão  Dreamweaver, na paleta de ferramentas de HTML, no BBEdit, para 
retornar ao Dreamweaver.

Para desativar a integração com o BBEdit:

1. Selecione Edit > Preferences ou Dreamweaver > Preferences (Mac OS X) e selecione File 
Types/Editors (Tipos de arquivos/editores).

2. Cancele a seleção de Enable BBEdit Integration (Ativar a integração com o BBEdit) e 
clique em OK.

Definir preferências de tipo de arquivo e editor 
externo
Você pode especificar o aplicativo que deverá ser utilizado para editar arquivos com cada uma 
das várias extensões. 

Para selecionar um editor de HTML externo:

1. Selecione Edit (Editar)  > Preferences (Preferências).

2. Na lista Category (Categoria) à esquerda, selecione File Types/Editors (Tipos de arquivos/
editores).

As preferências de tipos de arquivos/editores são exibidas.
3. Ajuste uma das definições da caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.
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Para iniciar um editor de HTML externo:

■ Selecione Edit (Editar) > Edit with [editor name] (Editar com [nome do editor]).

Tópicos relacionados
■ “Abrir arquivos na visualização do código por padrão” na página 589
■ “Iniciar um editor de arquivos de mídia externo” na página 521
■ “Utilizar um editor de HTML integrado” na página 599
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CAPÍTULO 20

Codificar no Dreamweaver
O Macromedia Dreamweaver  8 oferece um ambiente de codificação completo, projetado 
para qualquer tipo de tarefa de desenvolvimento para a Web, desde a elaboração de páginas 
HTML simples até a criação, o teste e a implantação de aplicativos complexos para a Web. 

Este capítulo contém os tópicos a seguir:
Sobre a codificação no Dreamweaver. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 604

Escrever e editar o código . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 613

Procurar e substituir tags e atributos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .628

Fazer alterações rápidas em uma seleção do código  . . . . . . . . . . . . . . . . . . . . . . . 630

Utilizar o material de referência de linguagens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 631

Imprimir o código . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .632

Tópicos relacionados
■ “Configurar o ambiente de codificação” na página 583
■ “Otimizar e depurar o código” na página 633
■ “Editar o código na Design View (Visualização do projeto)” na página 643
■ “Comparar arquivos para conhecer as diferenças” na página 126

N
O

T
A

Para obter informações sobre como migrar do Macromedia HomeSite para o 
Dreamweaver, visite o Dreamweaver Support Center (Centro de suporte do 
Dreamweaver) em www.macromedia.com/go/migrate_from_homesite.
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Sobre a codificação no  Dreamweaver
O ambiente de codificação do Dreamweaver permite escrever, editar e testar o código (em 
várias linguagens) contido nas páginas. O Dreamweaver não altera o código escrito 
manualmente, a menos que você ative opções específicas para reescrever alguns tipos de 
códigos inválidos.

Tópicos relacionados
■ “Exibir o código” na página 583

Suporte de linguagens
Além de recursos de edição de texto, o Dreamweaver fornece outros recursos, como referências 
de código, para ajudar a codificação em algumas linguagens. Entre essas linguagens, estão:

■ HTML
■ XHTML
■ CSS
■ JavaScript
■ ColdFusion Markup Language (CFML)
■ Visual Basic (para ASP e ASP.NET)
■ C# (para ASP.NET)
■ JSP
■ PHP

Os recursos de codificação específicos à linguagem do Dreamweaver não oferecem suporte a 
algumas linguagens, como Perl. É possível criar e editar arquivos Perl utilizando o 
Dreamweaver, mas as referências de código, por exemplo, não se aplicam a essa linguagem.

Tópicos relacionados
■ “Modificação automática de código em Dreamweaver” na página 605
■ “Utilizar as referências de código” na página 613
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Sobre como corrigir markup inválido
Se o documento contiver um código inválido, o Dreamweaver exibirá esse código em Design 
view (Visualização do projeto) e, opcionalmente, o realçará em Code view (Visualização do 
código). Se você selecionar o código em uma dessas visualizações, o Property inspector 
(Inspetor de propriedades) exibirá informações como o motivo pelo qual o código é inválido e 
a maneira de corrigi-lo. 

Você pode especificar preferências no Dreamweaver para reescrever vários tipos de códigos 
inválidos quando abrir um documento.

Tópicos relacionados
■ “Definir preferências de reescrita de código” na página 588

Modificação automática de código em   
Dreamweaver 
Você pode definir opções que orientem o Dreamweaver a limpar automaticamente o código 
escrito manualmente de acordo com os critérios que especificar. No entanto, o Dreamweaver 
nunca reescreverá o código, a menos que as opções de reescrita de código estejam ativadas ou 
que você execute uma ação que altere o código. Por exemplo, o Dreamweaver só alterará os 
espaços em branco ou a caixa dos atributos se você utilizar o comando Apply Source 
Formatting (Aplicar a formatação de origem). 

Algumas dessas opções de reescrita de código são ativadas por padrão. Para obter informações 
sobre como desativá-las, ou ativar outras, consulte “Definir preferências de reescrita de 
código” na página 588.

Os recursos Roundtrip HTML do Dreamweaver permitem movimentar os documentos entre 
um editor de HTML baseado em texto e o Dreamweaver, com pouco ou nenhum impacto 
sobre o conteúdo e a estrutura do código-fonte HTML original do documento. Esses recursos 
também possibilitam as seguintes ações:

■ O Dreamweaver permite iniciar um editor de texto de outros fabricantes para editar o 
documento atual. Para obter mais informações, consulte “Utilizar um editor de HTML 
externo com o Dreamweaver” na página 599.

■ Por padrão, o Dreamweaver não faz alterações em código criado ou editado em outros 
editores de HTML, mesmo que esse código seja inválido, a não ser que você ative as 
opções de reescrita de códigos. 
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■ O Dreamweaver não altera as tags que não reconhece, inclusive as tags XML, porque não 
dispõe de um critério para avaliá-las. Se uma tag não-reconhecida se sobrepuser a outra tag 
(por exemplo, <MyNewTag><em>text</MyNewTag></em>), o Dreamweaver marcará essa 
tag como um erro, mas não reescreverá o código.

■ Como alternativa, você pode definir que o Dreamweaver realce o código inválido na 
visualização do código (em amarelo). Quando é selecionada uma seção realçada, o 
Property inspector exibe informações sobre como corrigir o erro.

Tópicos relacionados
■ “Definir preferências de codificação” na página 585
■ “Sobre o código de comportamento do servidor” na página 613

Sobre o código XHTML gerado pelo  Dreamweaver 
O Dreamweaver gera novo código XHTML e limpa o código XHTML existente de forma a 
atender à maioria dos requisitos de XHTML. O Dreamweaver também fornece as ferramentas 
necessárias para atender aos poucos requisitos de XHTML restantes. 

A tabela a seguir descreve os requisitos de XHTML atendidos automaticamente pelo 
Dreamweaver. 

N
O

T
A

Alguns dos requisitos descritos nesta seção também são exigidos em diversas versões 
da linguagem HTML.

Requisito de XHTML Ações que o Dreamweaver executa 
para atender a esse requisito

O documento deve conter uma declaração 
DOCTYPE antes do elemento raiz, e a 
declaração deve fazer referência a um dos 
três arquivos DTD (Document Type 
Definition, Definição de tipo de documento) 
para XHTML (Strict, Transitional ou 
Frameset).

Adiciona uma declaração XHTML DOCTYPE 
a um documento XHTML:
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 
1.0 Transitional//EN" "http://www.w3.org/
TR/xhtml1/DTD/xhtml1-transitional.dtd">
Ou se o documento XHTML tem um conjunto 
de quadros:
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 
1.0 Frameset//EN" "http://www.w3.org/TR/
xhtml1/DTD/xhtml1-frameset.dtd">

O elemento raiz do documento deve ser html, 
e o elemento html deve designar o espaço 
para nome XHTML.

Adiciona o atributo namespace ao elemento 
html, como mostrado a seguir:
<html xmlns="http://www.w3.org/1999/
xhtml">
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Um documento padrão deve conter os 
elementos estruturais head, title e body. Um 
documento de conjunto de quadros deve 
conter os elementos estruturais head, title e 
frameset. 

Em um documento padrão, inclui os 
elementos head, title e body. Em um 
documento de conjunto de quadros, inclui os 
elementos head, title e frameset.

Todos os elementos do documento devem 
ser aninhados corretamente:
<p>Este é um <i>exemplo com erro.</p></i> 
<p>Este é um <i>bom exemplo.</i></p>

Gera corretamente o código aninhado e, ao 
limpar o XHTML, corrige o aninhamento no 
código que não foi gerado pelo 
Dreamweaver.

Todos os nomes de elementos e atributos 
devem ficar em minúsculas.

Impõe o uso de minúsculas para os nomes de 
elementos e atributos HTML no código 
XHTML que gera e ao limpar o XHTML, 
independentemente das preferências de 
caixa de tags e atributos.

Todos os elementos devem ter uma tag de 
fechamento, a menos que estejam 
declarados no arquivo DTD como EMPTY 
(Vazio).

Insere tags de fechamento no código gerado 
e durante a limpeza do XHTML.

Os elementos vazios devem ter uma tag de 
fechamento ou a tag de abertura deve 
terminar com />. Por exemplo, a tag <br> não 
é válida; a forma correta é <br></br> ou <br/>. 
Em seguida, estão os elementos vazios: area, 
base, basefont, br, col, frame, hr, img, input, 
isindex, link, meta e param.
E para fins de compatibilidade com versões 
anteriores de navegadores que não são 
ativados por código XML deve haver um 
espaço antes de /> (por exemplo: <br /> e 
não <br/>). 

Insere elementos vazios com um espaço 
antes da barra inclinada de fechamento em 
tags vazias no código que gera e ao limpar o 
XHTML.

Não é possível minimizar atributos; por 
exemplo, <td nowrap> não é válido; a forma 
correta é <td nowrap="nowrap">.
Isso afeta os atributos a seguir: checked, 
compact, declare, defer, disabled, ismap, 
multiple, noresize, noshade, nowrap, readonly 
e selected.

Insere pares atributo-valor integrais no código 
que gera e ao limpar o XHTML.
Nota: Se um navegador HTML não oferecer 
suporte a HTML 4, ele poderá interpretar 
incorretamente esses atributos booleanos 
quando exibidos na forma por extenso.

Todos os valores de atributos devem ser 
colocados entre aspas.

Coloca os valores de atributos entre aspas no 
código que gera e ao limpar o XHTML.

Requisito de XHTML Ações que o Dreamweaver executa 
para atender a esse requisito
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Inclusões do servidor
Uma inclusão do servidor é um arquivo que o servidor incorpora em um documento quando 
um navegador solicita esse documento do servidor. 

Quando o navegador de um visitante solicita o documento que contém a instrução de 
inclusão, o servidor processa essa instrução e cria um novo documento no qual a instrução é 
substituída pelo conteúdo do arquivo incluído. Em seguida, o servidor envia esse novo 
documento ao navegador do visitante. Ao abrir um documento local diretamente em um 
navegador, no entanto, não há nenhum servidor para processar as instruções das inclusões no 
documento. Portanto, o navegador abrirá o documento sem processar tais instruções e o 
arquivo que deveria ser incluído não aparecerá no navegador. Portanto, sem utilizar o 
Dreamweaver, talvez seja difícil visualizar os arquivos locais e verificar a aparência que terão 
para os visitantes depois de serem colocados no servidor.

Os seguintes elementos devem conter um 
atributo id e um atributo name: a, applet, form, 
frame, iframe, img e map. Por exemplo, 
<a name="intro">Introduction</a> não é 
válido; a forma correta é 
<a id="intro">Introduction</a> ou  
<a id="section1" name="intro"> 
Introduction</a>.

Define os atributos name e id com o mesmo 
valor, sempre que o atributo name é definido 
por um Property inspector, no código que o 
Dreamweaver gera e ao limpar o XHTML.

Os valores de atributos do tipo enumerado 
devem estar em minúsculas. 
Um valor do tipo enumerado é um valor de 
uma lista especificada de valores permitidos; 
por exemplo, os valores permitidos para o 
atributo align são: center, justify, left e 
right.

Impõe o uso de minúsculas para os valores de 
tipos enumerados no código que gera e ao 
limpar o XHTML.

Todos os elementos style e script devem ter 
um atributo type. 
(O atributo type do elemento script é exigido 
desde o HTML 4, quando o atributo language 
tornou-se obsoleto.)

Define os atributos type e language nos 
elementos script, além do atributo type nos 
elementos style, no código que gera e ao 
limpar o XHTML.

Todos os elementos img e area devem ter um 
atributo alt.

Define esses atributos no código que gera e, 
ao limpar o XHTML, reporta os atributos alt 
ausentes.

Requisito de XHTML Ações que o Dreamweaver executa 
para atender a esse requisito
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Com o Dreamweaver, é possível visualizar os documentos exatamente como eles aparecerão 
no servidor, tanto na Design view quanto na visualização em um navegador.

Uma inclusão de servidor em um documento insere uma referência a um arquivo externo; ela 
não insere o conteúdo do arquivo especificado no documento atual. O Dreamweaver exibe o 
conteúdo do arquivo externo na Design view, facilitando a criação de páginas. 

Não é possível editar o arquivo incluído diretamente em um documento. Para poder editar o 
conteúdo de uma inclusão de servidor, você deverá editar diretamente o arquivo a ser incluído. 
Observe que todas as alterações feitas no arquivo externo serão automaticamente transpostas 
para os documentos que o incluírem.

Há dois tipos de inclusões de servidor: Virtual e File (Arquivo). Selecione a opção adequada ao 
tipo de servidor da Web que você utiliza:

■ No caso de um servidor Web Apache, selecione Virtual. No Apache, a opção Virtual 
funciona em todos os casos, enquanto File funciona em apenas alguns.

■ No caso de um servidor Microsoft Internet Information Server (IIS), selecione File. 
(Virtual funciona com o IIS somente em circunstâncias específicas.)

■ Para outros tipos de servidores, ou caso você desconheça o tipo de servidor que estiver 
utilizando, pergunte ao administrador do sistema qual opção deverá ser utilizada.

Alguns servidores são configurados para examinar todos os arquivos, verificando a ocorrência 
de inclusões de servidor. Outros servidores são configurados para examinar somente os 
arquivos com uma extensão específica como, por exemplo, .shtml, .shtm ou .inc. Se uma 
inclusão de servidor não estiver funcionando, pergunte ao administrador do sistema se é 
necessário utilizar uma extensão especial no nome do arquivo que utiliza a inclusão. Por 
exemplo: se o arquivo se chama canoa.html, talvez não seja possível renomeá-lo como 
canoa.shtml. Se desejar que os seus arquivos permaneçam com as extensões .html ou .htm, 
peça ao administrador do sistema para configurar o servidor para examinar todos os arquivos 
(não apenas os arquivos com uma certa extensão) quanto à ocorrência de inclusões de servidor. 
A análise de um arquivo quanto à ocorrência de inclusões de servidor consome mais tempo. 
Portanto, as páginas que o servidor analisar serão veiculadas um pouco mais lentamente do 
que as outras páginas. Em função disso, alguns administradores de sistema não oferecerão a 
opção de análise de todos os arquivos.

N
O

T
A

Infelizmente, o IIS não permite que se inclua um arquivo numa pasta acima da pasta 
atual na hierarquia de pastas, a não ser que algum software especial tenha sido 
instalado no servidor. Se necessitar incluir um arquivo de uma pasta acima na 
hierarquia de pastas de um servidor IIS, pergunte ao administrador do sistema se o 
software necessário está instalado.
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Tópicos relacionados
■ “Inserir uma inclusão do servidor” na página 652
■ “Editar o conteúdo de uma inclusão do servidor” na página 653

Expressões comuns
As expressões comuns consistem em padrões que descrevem as combinações de caracteres no 
texto. Utilize essas expressões em suas buscas de código como auxílio para descrever conceitos 
como “frases iniciadas com ‘var’” e “valores de atributo que contenham um número”. Para 
obter mais informações sobre busca, consulte “Procurar e substituir tags e atributos” na 
página 628. 

A tabela a seguir lista os caracteres especiais em expressões comuns, seus significados e 
exemplos de uso. Para localizar o texto contendo um dos caracteres especiais da tabela, preceda 
o caractere especial com uma barra invertida. Por exemplo: para localizar o asterisco na frase 
some conditions apply*, o padrão de busca deve ter esta aparência: apply\*. Se não for 
colocada uma barra inclinada antes do asterisco, serão localizadas todas as ocorrências de 
“aplicam” (assim como de “aplic”, “aplica” e “aplicar”), e não apenas aquelas seguidas do sinal 
de asterisco.

Caractere Coincide com Exemplo:

^ Início da entrada ou linha. ^T coincidirá com “T” em 
“Terracota”, mas não em “Cabana 
do Pai Tomás”

$ Final da entrada ou linha. o$ coincidirá com “o” em “número”, 
mas  não  em “números”

* O caractere precedente 0 ou 
mais vezes.

um* coincidirá com ”um” em “rum”, 
“umi” em “luminoso” e “u” em “azul”

+ O caractere precedente 1 ou 
mais vezes.

um+ coincidirá com “um” em “rum” e 
“umi” em “luminoso”, porém não 
coincidirá com qualquer ocorrência 
de “azul”

? O caractere precedente no máximo 
uma vez (isto é, indica que o 
caractere precedente é opcional).

re?ta coincidirá com “rta” em 
“curta”e “reta” em “preta”, porém 
não coincidirá com qualquer 
ocorrência de “caneta” ou “brotar”

. Qualquer caractere único, exceto 
nova linha.

.pr coincidirá com “propriedades” e 
“programa” na frase “propriedades 
do programa”
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x|y x ou y. FF0000|0000FF coincidirá com 
“FF0000” em bgcolor=”#FF0000” e 
“0000FF’” em font 
color=”#0000FF”

{n} Exatamente 'n' ocorrências do 
caractere precedente.

r{2} coincidirá com “rr” em “carro” e 
com os primeiros dois erres em 
“brrrrrr”; porém, não coincidirá com 
qualquer ocorrência de “for”

{n,m} No mínimo 'n' e no máximo 'm' 
ocorrências do 
caractere precedente.

F{2,4} coincidirá com “FF” em 
“#FF0000” e com os primeiros 
quatro Fs em #FFFFFF

[abc] Qualquer um dos caracteres dentro 
dos colchetes. Especifique uma faixa 
de caracteres com um hífen (por 
exemplo, [a-f] equivale a [abcdef]). 

[e-g] coincidirá com “e” em “tabela”, 
“f” em “fraude” e “g" em “Aguarde”

[^abc] Qualquer um dos caracteres que não 
esteja dentro dos colchetes. 
Especifique uma faixa de caracteres 
com um hífen (por exemplo [^a-f] 
equivale a [^abcdef]).

[^aeiou] coincidirá inicialmente com 
“r” em “cravo”, “b” em “biblioteca” e 
“f” em “OFF!”

\b Um limite de palavra (como um 
espaço ou retorno de carro).

\bb coincidirá com “b” em 
“blasfêmia”, porém não coincidirá 
com qualquer ocorrência de “abrir” 
ou “liberdade”

\B Qualquer caractere diferente de um 
limite de palavra.

\Bb coincidirá com “b” em 
“liberdade”, porém não coincidirá 
com “blasfêmia”

\d Qualquer caractere numérico. 
Equivale a [0-9].

\d coincidirá com ”3” em “C3PO” e 
“2” em “apartamento 2G”

\D Qualquer caractere não numérico. 
Equivale a [^0-9].

\D coincidirá com ”S” em “900S” e 
”Q” em “Q45”

\f Avanço de página.

\n Avanço de linha.

\r Retorno de carro.

\s Qualquer caractere contendo um 
espaço em branco, inclusive 
espaços, tabulações, avanços 
de página ou avanços de linha.

\scoluna coincidirá com “coluna” em 
“100 colunas”, porém não coincidirá 
com “colunas”

Caractere Coincide com Exemplo:
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Utilize parênteses para definir agrupamentos na expressão comum à qual será feita referência 
posteriormente. Em seguida, utilize $1, $2, $3 e assim por diante no campo Replace With 
(Substituir por) para fazer referência ao primeiro, segundo, terceiro e último agrupamentos de 
parênteses.

Por exemplo, a busca de (\d+)\/(\d+)\/(\d+) e sua substituição por $2/$1/$3 troca o dia e o 
mês em uma data separada por barras inclinadas (na conversão entre o formato de datas no 
estilo americano e europeu).

\S Qualquer caractere que não 
contenha espaços em branco.

\Scoluna coincidirá com “coluna” em 
“colunas:”, porém não coincidirá 
com “100 colunas”

\t Uma tabulação.

\w Qualquer caractere alfanumérico, 
inclusive o sinal de sublinhado. 
Equivale a [A-Za-z0-9_].

b\w* coincidirá com “Alfabeto” em 
“Alfabeto cirílico” e com “objeto” e 
“abstrato” em “nenhum objeto 
abstrato”

\W Qualquer caractere não 
alfanumérico. Equivale a [^A-Za-z0-
9_].

\W coincidirá com “&” em “Joca & 
Mateus” e com “%” em “100%”

Control+Enter 
ou Shift+Enter 
(no Windows) 
ou 
Control+Return, 
Shift+Return ou 
Command+Ret
urn (no 
Macintosh)

Caractere de retorno. Certifique-se 
de desmarcar a opção Ignore 
Whitespace Differences (Ignorar os 
diferentes espaços em branco) ao 
efetuar essa busca se não forem 
utilizadas expressões comuns. 
Observe que ele coincide com 
determinado caractere, mas não 
com a noção geral de quebra de 
linha; por exemplo, não coincide com 
uma tag <br> ou <p>. Os caracteres 
de retorno são exibidos como 
espaços na Design view, e não como 
quebras de linha.

N
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Na caixa de texto Search For (Procurar), para fazer referência a um agrupamento de 
parênteses anterior na expressão comum, utilize \1, \2, \3 e assim por diante, em vez de 
$1, $2, $3.

Caractere Coincide com Exemplo:
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Tópicos relacionados
■ “Procurar tags, atributos ou texto contidos em tags específicas” na página 628
■ “Salvar padrões de busca” na página 629

Sobre o código de comportamento do servidor
Quando você desenvolve uma página dinâmica e seleciona um comportamento de servidor no 
painel Server Behaviors (Comportamentos de servidor), o Dreamweaver insere um ou mais 
blocos de código na página para ativar esse comportamento.

Se você alterar manualmente o código de um bloco de código, não poderá mais utilizar 
painéis, como Bindings (Ligações) e Server Behaviors, para editar o comportamento do 
servidor. O Dreamweaver procura padrões específicos na página de código para detectar 
comportamentos de servidor e exibi-los no painel Server Behaviors. Se alterar o código de um 
bloco de código, o Dreamweaver, você não poderá mais detectar o comportamento do 
servidor e exibi-lo no painel Server Behaviors. No entanto, o comportamento de servidor 
continuará a existir na página e poderá ser editado no ambiente de codificação do 
Dreamweaver.

Escrever e editar o código
O Dreamweaver oferece diversos recursos que ajudam a escrever e editar o código de modo 
eficiente. 

Utilizar as referências de código
O recurso de referências de código ajuda a inserir e editar o código com rapidez e sem erros. 
Quando você digita caracteres específicos na Code view, como as primeiras letras de uma tag 
ou atributo, ou o nome da propriedade CSS, é exibida uma lista que sugere opções para 
preencher sua entrada. É possível utilizar este recurso para inserir ou editar código ou apenas 
para examinar os atributos disponíveis para uma tag, os parâmetros disponíveis para uma 
função ou os métodos disponíveis para um objeto. 
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As referências de código estão disponíveis para vários tipos de código. Quando você digita um 
caractere específico que indica o início de uma parte do código, é exibida uma lista apropriada 
de itens; por exemplo, para exibir uma lista de referências de código de nomes de tags HTML, 
digite um colchete de abertura (<).

A lista de referências de código desaparece quando você pressiona Backspace (no Windows) ou 
Delete (no Macintosh).

Para exibir um menu de referências de código, caso ele não seja exibido 
automaticamente:

■ Pressione Control+Barra de espaço (Windows) ou Command+Barra de espaço 
(Macintosh).

Para inserir markup ou outro código na Code view utilizando referências de 
código: 

1. Digite o início de uma parte do código. Por exemplo, para inserir uma tag, digite um 
colchete de abertura (<); para inserir um atributo, coloque o ponto de inserção logo após 
um nome de tag e pressione a barra de espaço.

É exibida uma lista de itens (como nomes de tags ou atributos).

2. Role pela lista utilizando as teclas de seta para cima ou para baixo.

3. Para inserir um item da lista, clique duas vezes nele, ou selecione-o e pressione Enter (no 
Windows) ou Return (Macintosh).
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Para obter os resultados ideais, especialmente quando estiver utilizando referências de 
código para funções e objetos, defina a opção Delay (Atraso) da caixa de diálogo de 
preferências Code Hints (Referências de código) para um atraso de 0 segundos. Para 
obter mais informações, consulte “Definir as preferências de referências de código” na 
página 588.
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Para fechar a lista a qualquer momento, pressione Escape.

D
IC
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Se um estilo CSS criado recentemente não aparecer em uma lista de referências de 
código de estilos CSS, selecione Refresh Style List (Atualizar lista de estilos) na lista 
de referências de código. Se a Design view estiver em exibição, alguns códigos 
inválidos poderão aparecer nessa visualização temporariamente depois que você 
selecionar Refresh Style List. Para remover esses códigos inválidos da Design view, 
depois de inserir o estilo, pressione F5 para atualizar a visualização novamente.
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Para inserir uma tag de fechamento:

■ Digite </ (barra inclinada).
Por padrão, o Dreamweaver determina a tag a ser fechada e a fecha para você. É possível 
alterar esse comportamento padrão de modo que o Dreamweaver insira uma tag de 
fechamento após a inclusão do colchete final (>) da tag de abertura ou de modo a não 
inserir qualquer tag de fechamento. Selecione Edit > Preferences > Code Hints e, em 
seguida, selecione uma das opções Close Tags.

Para editar uma tag utilizando referências de código, siga um destes 
procedimentos: 

■ Para substituir um atributo por outro, primeiro exclua o atributo e seu valor. Em seguida, 
adicione um novo atributo e seu valor como descrito no procedimento anterior.

■ Para alterar um valor, primeiro exclua esse valor e, em seguida, adicione um novo valor 
como descrito no procedimento anterior.

Tópicos relacionados
■ “Definir as preferências de referências de código” na página 588

Trabalhar com trechos de código
Os trechos de código permitem armazenar conteúdo para que este possa ser reutilizado 
rapidamente. É possível criar e inserir trechos de HTML, JavaScript, CFML, ASP, JSP e 
outros. O Dreamweaver também contém alguns trechos predefinidos que podem ser usados 
como ponto de partida. 

Esta seção descreve como inserir, criar, editar ou excluir trechos de código. Ela também 
descreve como gerenciar os trechos do código e compartilhá-los com outros membros da 
equipe.

Para inserir um trecho de código: 

1. Coloque o ponto de inserção no local onde deseja inserir o trecho de código, ou selecione 
o código em torno do qual você colocará um trecho.

N
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Com o Dreamweaver 8, os trechos que continham tags <font> e outros elementos e 
atributos obsoletos foram movidos para a pasta Legacy (Legado) no painel Snippets 
(Trechos). 
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2. No painel Snippets (Trechos), em Window (Janela)  > Snippets, clique duas vezes no 
trecho.

Você também pode clicar com o botão direito do mouse (Windows) ou pressionar a tecla 
Control (no Macintosh) e clicar no trecho. Em seguida, selecione Insert (Inserir) no menu 
pop-up.

Para criar um trecho de código: 

1. Na parte inferior do painel Snippets, clique no ícone New Snippet (Novo trecho).

A caixa de diálogo Snippet é exibida.
2. Preencha a caixa de diálogo e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Para editar um trecho de código: 

■ No painel Snippets, selecione um trecho e clique no botão Edit Snippet (Editar trecho) na 
parte inferior do painel. 

Para excluir um trecho de código:

■ No painel Snippets, selecione um trecho e clique no botão Remove (Remover) na parte 
inferior do painel. 

Para criar pastas de trechos de código e gerenciar trechos de código: 

1. Na parte inferior do painel Snippets, clique no ícone New Snippet Folder (Pasta de novos 
trechos). 

2. Arraste trechos para a nova pasta ou para outras pastas, conforme desejado.

Para acrescentar ou editar um atalho de teclado referente ao trecho:

1. No painel Snippets, clique com o botão direito do mouse (Windows) ou pressione a tecla 
Control (Macintosh) e selecione Edit Keyboard Shortcuts (Editar atalhos de teclado).

O Keyboard Shortcuts Editor (Editor de atalhos do teclado) é exibido.
2. No menu pop-up Commands (Comandos), selecione Snippets.

Aparece uma lista de trechos.
3. Selecione um trecho e atribua um atalho de teclado a ele. 

Para obter mais informações, consulte “Personalização de atalhos de teclado” na página 83.

Para compartilhar um trecho com outros membros da equipe:

1. Localize o arquivo correspondente ao trecho a ser compartilhado na pasta 
Configuration\Snippets (Configuração/Snippets) da pasta do aplicativo Dreamweaver.
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2. Copie o arquivo do trecho para uma pasta compartilhada do seu computador ou de um 
computador da rede.

3. Solicite aos outros membros da equipe que copiem o arquivo de trecho para as respectivas 
pastas Configuration\Snippets.

Inserir código rapidamente com a barra de 
ferramentas Coding (Codificação)
É possível utilizar a barra de ferramentas Coding para adicionar códigos a uma página 
rapidamente.

Para inserir códigos rapidamente:

1. Certifique-se de estar no modo de visualização do código (View > Code).

2. Coloque o ponto de inserção no código ou selecione um bloco de código.

3. Clique sobre um botão da barra de ferramentas Coding ou selecione um item no menu 
pop-up dessa barra.

Para descobrir o que cada botão faz, posicione o ponteiro sobre ele até que seja exibida uma 
dica de ferramenta. Os botões a seguir serão exibidos por padrão na barra de ferramentas 
Coding.

Open Documents (Abrir documentos) lista os documentos que estão abertos. Quando você 
seleciona um documento, ele é exibido na janela de documento.

Collapse Full Tag (Reduzir tag completa) reduz o conteúdo entre um conjunto de tags de 
abertura e fechamento (por exemplo, o conteúdo entre <table> e </table>). Você pode 
colocar o ponto de inserção na tag de abertura ou de fechamento e, em seguir, clicar no botão 
Collapse Full Tag para reduzir a tag.
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Também é possível reduzir o código fora de uma tag completa, colocando o ponto de 
inserção sobre uma tag de abertura ou de fechamento e, em seguida, pressionando Alt 
(Windows) ou Option (Macintosh) e clicando no botão Collapse Full Tag. Além disso, o 
uso de Control-clique neste botão desativa a “redução inteligente”, a fim de que o 
Dreamweaver não ajuste o conteúdo reduzido fora das tags completas. Para obter mais 
informações, consulte “Sobre a reduçãodo código” na página 622.
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Collapse Selection (Reduzir seleção) reduz o código selecionado.

Expand All (Expandir tudo) restaura todo o código reduzido.

Select Parent Tag (Selecionar tag-mãe) seleciona o conteúdo e as tags de abertura e 
fechamento da linha sobre a qual você posicionou o ponto de inserção. Se você clicar 
repetidamente neste botão e suas tags estiverem balanceadas, o Dreamweaver selecionará as 
tags html e /html mais externas.

Balance Braces (Ajustar as chaves) seleciona o conteúdo e os parênteses, chaves ou 
colchetes da linha sobre a qual você posicionou o ponto de inserção. Se você clicar 
repetidamente neste botão e os símbolos estiverem balanceados, o Dreamweaver selecionará as 
chaves, os parênteses ou os colchetes mais externos no documento.

Show Line Numbers (Mostrar números de linha) permite ocultar ou mostrar os números no 
início de cada linha de código.

Highlight Invalid Code (Realçar o código incorreto) realça em amarelo o código incorreto.

Apply Comment (Aplicar comentário) permite incluir tags de comentários em torno do 
código selecionado ou abrir novas tags de comentários.

■ Apply HTML Comment (Aplicar comentário HTML) inclui <!-- e --!> no código 
selecionado ou abre uma nova tag caso não haja código selecionado. 

■ Apply // Comment (Aplicar comentário //) insere // no início de cada linha do código 
CSS ou JavaScript selecionado ou insere uma única tag // caso nenhum código seja 
selecionado. 

■ Apply /* */ (Aplicar /* */) inclui /* e */ no código CSS ou JavaScript selecionado. 
■ Apply ' Comment (Aplicar comentário ') destina-se a código Visual Basic. Insere aspas 

simples no início de cada linha de um script Visual Basic script ou insere aspas simples no 
início do ponto de inserção se não houver código selecionado.

■ Quando você estiver trabalhando em um arquivo ASP, ASP.NET, JSP, PHP ou 
Macromedia ColdFusion e selecionar a opção Apply Server Comment (Aplicar 
comentário de servidor), o Dreamweaver detectará automaticamente a tag de comentário 
correta e a aplicará à sua seleção.

D
IC

A

É possível reduzir o código fora de uma seleção pressionando Alt (Windows) ou Option 
(Macintosh) e clicando no botão Collapse Selection. Além disso, o uso de Control-clique 
neste botão desativa a “redução inteligente”, a fim de que você possa reduzir 
exatamente o que selecionou sem que haja qualquer manipulação por parte do 
Dreamweaver. Para obter mais informações, consulte “Sobre a reduçãodo código” na 
página 622.
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Remove Comment (Remover comentário) remove as tags de comentário do código 
selecionado. Se uma seleção contiver comentários aninhados, somente as tags de comentário 
mais externas serão removidas.

Wrap Tag (Colocar tag ao redor) coloca a tag selecionada ao redor do código selecionado no 
Quick Tag Editor.

Recent Snippets (Trechos recentes) permite inserir um código usado recentemente a partir 
do painel Snippets. Para obter mais informações, consulte “Trabalhar com trechos de código” 
na página 615.

Indent Code (Recuar o código) desloca a seleção para a direita.

Outdent Code (Remover recuo do código) desloca a seleção para a esquerda.

Format Source Code (Formatar código-fonte) aplica os formatos de código especificados 
anteriormente ao código selecionado ou à página inteira se um código não for selecionado. 
Você também pode definir rapidamente as preferências de formatação de código, selecionando 
Code Formatting Settings (Definições de formatação de código) no botão Format Source 
Code ou editando as bibliotecas de código por meio de Edit Tag Libraries (Editar bibliotecas 
de tags).

O número de botões disponíveis na barra de ferramentas Coding varia de acordo com o 
tamanho da visualização do código na janela do documento. Para ver todos os botões 
disponíveis, ajuste a janela de visualização do código ou clique na seta de expansão no início 
da barra de ferramentas Coding.

Também é possível editar a barra de ferramentas Coding para exibir mais botões, tais como 
Word Wrap (Quebra de linha), Hidden Characters (Caracteres ocultos) e Auto Indent (Recuo 
automático), bem como para ocultar os botões que não se deseja exibir. No entanto, para fazer 
isto, é necessário editar o arquivo XML que gera a barra de ferramentas. Para obter mais 
informações, veja Extending Dreamweaver (Extensão dos recursos do Dreamweaver).

Tópicos relacionados
■ “A barra de ferramentas Coding” na página 53
■ “Exibir barras de ferramentas” na página 60
■ “Verificar se as tags e as chaves estão ajustadas” na página 634

N
O

T
A

A opção de exibição de caracteres ocultos, que não é um botão padrão na barra de 
ferramentas Coding, está disponível no menu View (Exibir) > Code View Options 
(Opções de visualização do código)> Hidden Characters (Caracteres ocultos).
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Inserir código rapidamente utilizando a barra Insert
É possível utilizar a barra Insert  para adicionar códigos a uma página rapidamente. 

Para inserir códigos rapidamente:

1. Posicione o ponto de inserção no código.

2. Selecione uma categoria adequada na barra Insert.

3. Clique sobre um botão da barra Insert ou selecione um item de um menu pop-up dessa 
barra.

Ao clicar em um ícone, o código poderá ser exibido na página imediatamente ou poderá 
ser exibida uma caixa de diálogo solicitando mais informações para concluir o código.

Para descobrir qual é a função de um botão, utilize o ponteiro do mouse para apontá-lo e 
aguarde a exibição da dica de ferramenta. O número e o tipo de botões disponíveis na barra 
Insert variam de acordo com o tipo de documento atual. Também dependem de o usuário 
estar utilizando Code view ou Design view. 

Embora a barra Insert forneça uma série de tags utilizadas com freqüência, ela não abrange 
todas as tags. Para escolher uma tag em uma seleção mais abrangente, utilize o Tag Chooser 
(Seletor de tags).

Tópicos relacionados
■ “A barra Insert” na página 51

Inserir tags com o Tag Chooser (Seletor de tags)
Você pode utilizar o Tag Chooser para inserir na página qualquer tag das bibliotecas de tags do 
Dreamweaver (que incluem bibliotecas de tags ColdFusion e ASP.NET). Para obter mais 
informações sobre as bibliotecas de tags, consulte “Gerenciar bibliotecas de tags” na 
página 591. 

Para inserir uma tag utilizando o Tag Chooser: 

1. Posicione o ponto de inserção no código, clique com o botão direito do mouse (no 
Windows) ou pressione a tecla Control (no Macintosh) e selecione Insert Tag (Inserir tag). 

O Tag Chooser é exibido. O painel esquerdo contém uma lista de bibliotecas de tags que 
contam com suporte e o painel direito mostra as tags individuais na pasta de biblioteca de 
tags selecionada.

2. Selecione e insira uma tag.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
3. Para fechar o Tag Chooser, clique no botão Close (Fechar).
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Editar tags utilizando Tag editors (Editores de tags)
Os Tag editors permitem exibir, especificar e editar os atributos de uma tag. 

Para editar uma tag com um Tag editor:

1. Clique com o botão direito do mouse (Windows) ou com a tecla Control pressionada 
(Macintosh) em uma tag na Code view ou um objeto em Design view, selecione Edit Tag 
(Editar tag) no menu pop-up.

2. Especifique ou edite os atributos da tag e clique em OK. 

Reduzir código
É possível otimizar a visualização do código para mostrar menos ou mais código de acordo 
com a sua preferência, reduzindo ou expandindo os fragmentos de código selecionados. 
Também é possível cortar, colar ou mover seções reduzidas do código.

Esta seção contém os seguintes tópicos:

■ “Sobre a reduçãodo código” na página 622
■ “Reduzir e expandir fragmentos de código” na página 623
■ “Colar e mover fragmentos de código reduzidos” na página 625

D
IC

A

Para obter mais informações sobre a tag no Tag Editor, clique em Tag Info 
(Informações sobre a tag).
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Sobre a reduçãodo código
O Dreamweaver permite que você reduza e expanda fragmentos de código de modo que possa 
visualizar diferentes seções do documento sem precisar usar a barra de rolagem. Por exemplo, 
para ver todas as regras de CSS na tag head que se aplicam a uma tag div em toda a página, 
você pode reduzir tudo entre a tag head e a tag div, de modo a poder ver ao mesmo tempo 
ambas as seções do código. Embora seja possível escolher fragmentos de código fazendo 
seleções na visualização do projeto ou na visualização do código, você só poderá reduzir o 
código na visualização do código.

Quando você seleciona um código, o Dreamweaver inclui um conjunto de botões de redução 
ao lado da seleção (símbolo de subtração no Windows; triângulos verticais no Macintosh). 
Para reduzir a seleção, clique em um dos botões. Quando o código é reduzido, os botões de 
redução se transformam em um botão de expansão (botão de adição do Windows; triângulo 
horizontal no Macintosh). Para expandir a seleção reduzida, clique no botão de expansão. Para 
obter informações sobre outras maneiras de trabalhar com o código reduzido, consulte 
“Reduzir e expandir fragmentos de código” na página 623.

Às vezes, o Dreamweaver não reduz exatamente o fragmento de código selecionado. O 
Dreamweaver usa a “redução inteligente” para reduzir a seleção mais comum e mais 
visualmente agradável. Por exemplo, se você tiver selecionado uma tag de recuo e, depois, 
selecionou também os espaços de recuo antes da tag, o Dreamweaver não reduzirá os espaços 
de recuo, porque a maioria dos usuários espera que os recuos sejam preservados. Caso desede 
desativar o recurso de redução inteligente e forçar o Dreamweaver a reduzir exatamente o que 
foi selecionado, mantenha pressionada a tecla Control antes de reduzir seu código.

Além disso, o Dreamweaver incluirá um ícone de advertência nos fragmentos de código 
reduzidos se um fragmento contiver erros ou código que não sejam aceitos por determinados 
navegadores.

Tópicos relacionados
■ “Colar e mover fragmentos de código reduzidos” na página 625
■ “Limpar o código” na página 633
■ “Inserir código rapidamente com a barra de ferramentas Coding (Codificação)” na 

página 617

N
O

T
A

Os arquivos criados a partir dos modelos do Dreamweaver exibem todos os códigos 
amplamente expandidos, mesmo que o arquivo de modelo (.dwt) contenha fragmentos 
de código reduzidos.
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Reduzir e expandir fragmentos de código

Para reduzir código:

1. Selecione um fragmento de código.

2. Selecione Edit (Editar)> Code Collapse (Redução de código)> Collapse Selection (Reduzir 
seleção) ou clique em um dos botões de redução ao lado da seleção.

Para reduzir o código fora de uma seleção:

1. Na visualização do código, selecione um fragmento de código.

2. Select Edit > Code Collapse > Collapse Outside Selection (Reduzir seleção externa).

Para reduzir uma tag e todo o conteúdo nela contido:

1. Na visualização do código, coloque o ponto de inserção dentro de uma tag de abertura ou 
de fechamento (por exemplo, dentro da tag <table> ou </table>).

2. Selecione Edit > Code Collapse > Collapse Full Tag.

Para reduzir o código fora de uma tag completa:

1. Siga um dos procedimentos abaixo:

■ Na visualização do código, coloque o ponto de inserção dentro de uma tag de abertura ou 
de fechamento (por exemplo, dentro da tag <table> ou </table>).

■ Na visualização do código, selecione parte de uma tag de abertura ou de fechamento.
2. Selecione Edit > Code Collapse > Collapse Outside Full Tag (Reduzir fora da tag 

completa).

D
IC

A

Você também pode reduzir o código fora de uma seleção pressionando Alt 
(Windows) ou Option (Macintosh) e clicando em um dos botões de redução ou no 
botão Collapse Selection na barra de ferramentas Coding.

D
IC

A

Também é possível reduzir uma tag completa, clicando com o botão direito na tag do 
seletor de tags e, em seguida, selecionando Collapse Full Tag.

D
IC

A

Você também pode reduzir o código fora da tag completa, clicando com o botão 
direito na tag no seletor de tags e selecionando Collapse Outside Full Tag. Uma 
alternativa é colocar o ponto de inserção dentro de uma tag de abertura ou de 
fechamento, pressionar Alt e clicar no botão Collapse Full Tag na barra de 
ferramentas Coding.
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Para selecionar um fragmento de código reduzido:

■ Na visualização do código, clique no fragmento de código reduzido.

Para expandir um fragmento de código:

■ Siga um dos procedimentos abaixo:
■ Na visualização do código, clique duas vezes no fragmento de código.
■ Selecione Edit > Code Collapse > Expand Selection.

Para ver o código em um fragmento de código reduzido sem expandi-lo:

■ Posicione o ponteiro do mouse sobre o fragmento de código reduzido.

Para expandir todos os fragmentos de código reduzidos:

■ Selecione Edit > Code Collapse > Expand All.

Também é possível usar as seguintes teclas de atalho para executar qualquer dos comandos 
anteriores:

Tópicos relacionados
■ “Sobre a reduçãodo código” na página 622
■ “Limpar o código” na página 633
■ “Inserir código rapidamente com a barra de ferramentas Coding (Codificação)” na 

página 617

N
O

T
A

Quando você seleciona um item na visualização do projeto que faça parte de um 
fragmento de código reduzido, o Dreamweaver expande automaticamente o 
fragmento na visualização código. Quando você seleciona um item na visualização 
do projeto que seja um fragmento de código completo, o fragmento permanece 
reduzido na visualização do código.

Comando Windows Macintosh

Collapse Selection Control+Shift+C Command+Shift+C

Collapse Outside Selection Control+Alt+C Command+Alt+C

Expand Selection Control+Shift+E Command+Shift+E

Collapse Full Tag Control+Shift+J Command+Shift+J

Collapse Outside Full Tag Control+Alt+J Command+Alt+J

Expand All Control+Alt+E Command+Alt+E
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Colar e mover fragmentos de código reduzidos

Para copiar e colar um fragmento de código reduzido:

1. Selecione o fragmento de código reduzido.

2. Selecione Edit > Copy (Copiar).

3. Coloque o ponto de inserção no ponto em que deseja colar o código.

4. Selecione Edit > Paste (Colar).

Para arrastar um fragmento de código reduzido:

1. Selecione o fragmento de código reduzido.

2. Arraste a seleção até o novo local.

Tópicos relacionados
■ “Sobre a reduçãodo código” na página 622
■ “Reduzir e expandir fragmentos de código” na página 623
■ “Limpar o código” na página 633
■ “Inserir código rapidamente com a barra de ferramentas Coding (Codificação)” na 

página 617

Recuar blocos de código
Ao escrever e editar um código na Code view ou no Code inspector, você pode alterar o nível 
de recuo de um bloco ou linha selecionada, deslocando-a uma tabulação para a direita ou para 
a esquerda. 

Para recuar o bloco de código selecionado, siga um destes procedimentos:

■ Pressione Tab.
■ Selecione Edit  > Indent Code (Recuar o código).

N
O

T
A

Você pode colar em outros aplicativos, mas o estado “reduzido” do fragmento de 
código não será preservado. 

D
IC

A

Para arrastar uma cópia da seleção, pressione Control (Windows) ou Alt (Macintosh) 
e arraste-a.

N
O

T
A

Não é possível arrastar para outros documentos.
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Para remover o recuo de um bloco de código selecionado, siga um destes 
procedimentos:

■ Pressione Shift+Tab.
■ Selecione Edit  > Outdent Code (Remover o recuo do código).

Tópicos relacionados
■ “Fazer alterações rápidas em uma seleção do código” na página 630

Copiar e colar códigos
É possível copiar e colar o código-fonte de outro aplicativo ou da própria Code view. 

Para copiar e colar o código como texto:

1. Copie o código do Dreamweaver ou de outro aplicativo.

2. Coloque o ponto de inserção diretamente na visualização do código e selecione Edit  > 
Paste.

Tópicos relacionados
■ “Colar e mover fragmentos de código reduzidos” na página 625

Inserir comentários de HTML
Um comentário é um texto descritivo inserido no código HTML para explicá-lo ou fornecer 
outras informações. O texto do comentário aparece somente na visualização do código e não é 
exibido em um navegador. 

Para inserir um comentário no ponto de inserção:

■ Selecione Insert  > Comment (Comentário).
Na Code view, o Dreamweaver inclui uma tag de comentário e coloca o ponto de inserção 
no meio dela. Digite o comentário.
Na Design view, o Dreamweaver exibe a caixa de diálogo Comment. Digite seu 
comentário e clique em OK. 

Para exibir marcadores de comentários na Design view:

■ Selecione View (Exibir)  > Visual Aids (Auxílios visuais)  > Invisible Elements (Elementos 
invisíveis).
Certifique-se de que a opção Comments esteja selecionada nas preferências de Invisible 
Elements; caso contrário, o marcador não será exibido.
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Para editar um comentário existente, siga um destes procedimentos:

■ Na visualização de projeto, selecione o marcador Comment e edite o texto do comentário 
no Property inspector.

■ Na visualização do código, localize o comentário e edite seu texto. 

Saltar para uma função do JavaScript ou do 
VBScript
Tanto no Code View como no Code Inspector, você pode ver uma lista de todas as funções de 
JavaScript ou VBScript em seu código e saltar para qualquer uma delas.

Para saltar para uma função de JavaScript ou VBScript em seu código:

1. Exiba o documento na visualização do código (View > Code) ou no Code inspector 
(Window > Code Inspector).

2. Siga um dos procedimentos abaixo:

■ Se estiver usando a visualização do código, clique com o botão direito (Windows) ou 
pressione Control e clique (Macintosh) em qualquer local da visualização do código e, 
em seguida, selecione o submenu Functions no menu de contexto.

Se o código contiver funções JavaScript ou VBScript, elas serão exibidas no submenu.

■ Se estiver usando o inspetor de código, clique no botão Code Navigation na barra de 
ferramentas. 
O botão consiste em um par de chaves ({ }). 

3. No submenu, selecione um nome de função para saltar para a função de seu código.

N
O

T
A

O submenu Functions não aparece na Design view.

D
IC

A

Para ver a lista de funções em ordem alfabética, clique com o botão direito do 
mouse com a tecla Control pressionada (Windows) ou clique com as teclas 
Option e Control pressionadas (Macintosh) na visualização do código e, então, 
selecione o submenu Functions. 
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Procurar e substituir tags e atributos
Você pode utilizar o Dreamweaver para procurar e substituir tags e atributos no código. 

Tópicos relacionados
■ “Expressões comuns” na página 610
■ “Procurar e substituir texto” na página 444
■ “Comparar arquivos para conhecer as diferenças” na página 126

Procurar tags, atributos ou texto contidos em tags 
específicas
Você pode procurar tags, atributos e valores de atributos específicos. Por exemplo, é possível 
procurar todas as tags img sem um atributo alt. 

Você também pode procurar seqüências específicas de texto dentro ou fora de um conjunto de 
tags de recipientes. Por exemplo, é possível procurar a expressão Untitled (Sem título) 
contida em uma tag title para localizar todas as páginas sem título do site. 

Para procurar tags, atributos ou texto no código:

1. Abra o documento no qual deseja fazer a busca, ou selecione documentos ou uma pasta no 
painel Files (Arquivos).

2. Selecione Edit > Find and Replace. 

A caixa de diálogo Find and Replace é exibida. 
3. Especifique os arquivos nos quais deseja fazer a busca e, em seguida, especifique o tipo de 

busca a ser executada, bem como o texto e as tags a serem procurados. Como alternativa, 
especifique também o texto de substituição. Em seguida, clique em um dos botões Find 
(Localizar) ou Replace (Substituir).

Para obter mais informações, clique no botão Help (Ajuda).
4. Quando terminar, clique no botão Close (Fechar) para desativar a caixa de diálogo.

Para fazer uma nova busca sem exibir a caixa de diálogo Find and Replace:

■ Pressione F3 (no Windows) ou Command+G (no Macintosh).

Tópicos relacionados
■ “Expressões comuns” na página 610
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Salvar padrões de busca
Você pode salvar um padrão de busca e reutilizá-lo posteriormente. 

Para salvar um padrão de busca:

1. Na caixa de diálogo Find and Replace (Localizar e substituir), em Edit  > Find and Replace, 
defina os parâmetros para a busca.

Se estiver executando uma busca de tag ou texto avançado, consulte “Procurar tags, 
atributos ou texto contidos em tags específicas” na página 628 para obter informações 
sobre como definir parâmetros adicionais de busca.

2. Clique no botão Save Query (Salvar a consulta), que exibe o ícone do disco.

3. Na caixa de diálogo exibida, navegue até a pasta onde deseja salvar consultas. Em seguida, 
digite um nome de arquivo para identificar a consulta e clique em Save (Salvar).

Por exemplo, se o padrão de busca envolver tags img sem um atributo alt, você poderá 
chamar a consulta de img_no_alt.dwr.

Para chamar um padrão de busca novamente:

1. Selecione Edit > Find and Replace.

2. Clique no botão Load Query (Carregar a consulta), que exibe o ícone da pasta.

3. Navegue para a pasta onde as consultas são salvas. Em seguida, selecione um arquivo de 
consulta e clique em Open (Abrir).

4. Clique em Find Next (Localizar próximo), Find All (Localizar todos), Replace (Substituir) 
ou Replace All (Substituir tudo) para iniciar a busca.

Tópicos relacionados
■ “Procurar tags, atributos ou texto contidos em tags específicas” na página 628
■ “Expressões comuns” na página 610

N
O

T
A

As consultas salvas têm a extensão de nome de arquivo .dwr. Algumas consultas 
salvas de versões anteriores do Dreamweaver poderão ter a extensão .dwq.
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Fazer alterações rápidas em uma seleção 
do código
Você pode selecionar um código e fazer alterações rápidas nele utilizando um menu 
contextual. 

Para fazer alterações rápidas no código selecionado:

1. Na Code view, selecione um código e clique com o botão direito do mouse (no Windows) 
ou pressione Control (no Macintosh). No menu contextual, selecione o submenu Selection 
(Seleção).

2. Selecione uma das seguintes opções no submenu:

Comment Out Lines (Linhas de comentário) coloca as linhas selecionadas entre tags de 
comentário. Se uma linha for parcialmente selecionada, a linha inteira será inserida no 
comentário. Você pode utilizar essa ferramenta para transformar um código possivelmente 
incorreto em um comentário ao depurar a página.
Uncomment Lines (Linhas fora do comentário) remove as marcas de comentário do 
início e do final das linhas da seleção do comentário. Essa ferramenta só funciona em 
linhas inteiras, e não em comentários contidos em linhas.
Convert Tabs to Spaces (Converter tabulações em espaços) converte cada tabulação 
da seleção em um número de espaços igual ao valor de Tab Size (Tamanho da tabulação) 
nas preferências de Code Format (Formato do código). Para obter mais informações, 
consulte “Definir as preferências de formatação de código” na página 587.
Convert Spaces to Tabs (Converter espaços em tabulações) converte conjuntos de 
espaços da seleção em tabulações. Cada conjunto de espaços com um número de espaços 
igual ao tamanho da tabulação é convertido em uma tabulação.
Indent (Recuar) faz o recuo da seleção, deslocando-a para a direita. Para obter mais 
informações sobre como recuar e remover o recuo, consulte “Recuar blocos de código” na 
página 625. 
Outdent (Remover recuo) desloca a seleção para a esquerda. 
Remove All Tags (Remover todas as tags) remove todas as tags da seleção.
Convert Lines to Table (Converter linhas em tabela) coloca a seleção em uma tag table 
sem atributos.
Add Line Breaks (Adicionar quebras de linha) adiciona uma tag br ao final de cada 
linha da seleção.
Convert to Uppercase (Converter em maiúsculas) converte todas as letras da seleção, 
inclusive os nomes e os valores de tags e atributos, em maiúsculas.
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Convert to Lowercase (Converter em minúsculas) converte todas as letras da seleção, 
inclusive os nomes e os valores de tags e atributos, em minúsculas.
Convert Tags to Uppercase (Converter tags em maiúsculas) converte todos os nomes 
de tags e atributos, bem como os valores dos atributos, da seleção em maiúsculas.
Convert Tags to Lowercase (Converter tags em minúsculas) converte todos os nomes 
de tags e atributos, bem como os valores dos atributos, da seleção em minúsculas.

Utilizar o material de referência de 
linguagens
O painel Reference oferece uma ferramenta de referência rápida para linguagens de markup, 
linguagens de programação e estilos CSS. Ela fornece informações sobre tags específicas, 
objetos e estilos com os quais você esteja trabalhando na visualização do código (ou no 
inspetor de código). O painel Reference também fornece um código de exemplo que você 
pode colar em seus documentos.

Para abrir o painel Reference:

1. Execute uma das seguintes ações na Code view:

■ Clique com o botão direito do mouse (Windows) ou com a tecla Control pressionada 
(Macintosh) em uma tag, atributo ou palavra-chave e, em seguida, selecione Reference 
no menu contextual.

■ Posicione o ponto de inserção sobre uma tag, atributo ou palavra-chave e pressione 
Shift+F1.

É exibido o painel Reference, mostrando informações sobre a tag, o atributo ou a palavra-
chave clicada.

2. Para ajustar o tamanho do texto no painel Reference, selecione Large Font (Fonte grande), 
Medium Font (Fonte média) ou Small Font (Fonte pequena) no menu de opções (a seta 
pequena na parte superior direita do painel).
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Para colar o código de exemplo em seu documento:

1. Clique em qualquer local no código de exemplo no conteúdo de referência.

O Dreamweaver realça o código de exemplo inteiro.
2. Selecione Edit > Copy e, em seguida, cole o código de exemplo no seu documento de 

visualização do código. 

Para procurar o conteúdo da referência:

1. Para exibir as tags, os objetos ou estilos de um outro livro, escolha outro livro no menu 
pop-up Book. 

2. Para ver informações sobre um item específico, selecione o item no menu pop-up Tag, 
Object, Style ou CFML (dependendo do livro selecionado).

3. Para exibir informações sobre um atributo do item selecionado, escolha o atributo no menu 
pop-up ao lado do menu pop-up Tag, Object, Style ou CFML.

Esse menu contém a lista de atributos do item selecionado. A seleção padrão é Description 
(Descrição), que exibe uma descrição da tag escolhida. 

Imprimir o código
É possível imprimir o código para editá-lo off-line, arquivá-lo ou distribuí-lo.

Para imprimir o código:

1. Abra uma página na Code view.

2. Selecione File (Arquivo) > Print Code (Imprimir código).

3. Especifique as opções de impressão e depois clique em OK (Windows) ou Print (Imprimir) 
(Macintosh).
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CAPÍTULO 21

Otimizar e depurar o código
É possível usar o Macromedia Dreamweaver  8 para otimizar e depurar códigos. Por exemplo, 
você pode validar tags, tornar o documento compatível com XHTML ou depurar o código 
Macromedia ColdFusion.

Este capítulo aborda os tópicos a seguir:
Limpar o código . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .633

Verificar se as tags e as chaves estão ajustadas . . . . . . . . . . . . . . . . . . . . . . . . . . . . .634

Verificar a compatibilidade com navegadores. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .635

Validar tags  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .639

Tornar páginas compatíveis com XHTML  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 640

Usar o depurador ColdFusion (somente no Windows) . . . . . . . . . . . . . . . . . . . . . . . 641

Limpar o código
O Dreamweaver pode remover automaticamente as tags vazias, combinar tags font aninhadas 
e aperfeiçoar o código HTML ou XHTML ilegível ou incorreto. 

Para obter informações sobre como limpar um documento HTML gerado em Microsoft 
Word, consulte “Abrir documentos existentes” na página 107.

Para limpar o código:

1. Abra um documento:

■ Se o documento estiver em HTML, selecione Commands (Comandos) > Clean Up 
HTML.

■ Se o documento estiver em XHTML, selecione Commands > Clean Up XHTML 
(Limpar o XHTML).
No caso de um documento XHTML, o comando Clean Up XHTML corrige os erros 
de sintaxe de XHTML, define a caixa dos atributos de tag como minúscula e adiciona 
ou informa os atributos necessários que estão faltando em uma tag, além de executar 
operações de limpeza de HTML.
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2. Na caixa de diálogo exibida, selecione as opções desejadas.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

Dependendo do tamanho do documento e do número de opções selecionadas, a limpeza 
poderá demorar alguns segundos.

Tópicos relacionados
■ “Definir as preferências de formatação de código” na página 587
■ “Definir preferências de codificação por cores” na página 589

Verificar se as tags e as chaves estão 
ajustadas
Você pode verificar se as tags, parênteses (( )), chaves ({ }) e colchetes ([ ]) da página estão 
ajustadas. Ajustado significa que todas as tags, parênteses, chaves ou colchetes de abertura têm 
um elemento de fechamento correspondente e vice-versa. 

Para verificar se as tags estão ajustadas:

1. Abra o documento na Code view (Visualização do código). 

2. Coloque o ponto de inserção no código aninhado a ser verificado.

3. Selecione Edit (Editar) > Select Parent Tag (Selecionar a tag-mãe). 

As tags de fechamento correspondentes e os respectivos conteúdos são selecionados no 
código. Caso continue selecionando Edit > Select Parent Tag e as suas tags estiverem 
ajustadas, o Dreamweaver selecionará as tags html e /html mais externas.

Para verificar o ajuste de parênteses, chaves ou colchetes:

1. Abra o documento na Code view. 

2. Coloque o ponto de inserção no código a ser verificado.

3. Selecione Edit  > Balance Braces (Ajustar as chaves). 

Todo o código contido entre os parênteses, chaves ou colchetes será selecionado. Se você 
escolher Edit  > Balance Braces novamente, todo o código entre parênteses, chaves e 
colchetes da nova seleção será selecionado.
634 Capítulo 21:  Otimizar e depurar o código



         
Verificar a compatibilidade com 
navegadores
O Dreamweaver permite criar páginas da Web com elementos (como imagens e texto) aos 
quais os principais navegadores gráficos oferecem suporte, bem como elementos (como estilos 
CSS) aos quais apenas os navegadores mais recentes oferecem suporte. 

Determine qual será o possível público do site e quais navegadores é provável que ele utilize. 
Se a maioria dos usuários pretende utilizar o Netscape 4 (como ainda ocorre em alguns 
ambientes de intranet acadêmicos, por exemplo), evite utilizar tags às quais esse navegador não 
ofereça suporte.

O recurso Check Target Browsers testa o código contido nos documentos para saber se os 
navegadores de destino oferecem suporte aos atributos, às tags, às propriedades CSS e aos 
valores CSS. A verificação não altera qualquer aspecto do documento.

A verificação dos navegadores de destino fornece informações sobre três níveis de possíveis 
problemas: erros, avisos e mensagens informativas. As descrições a seguir explicam as 
diferenças entre esses níveis:

■ Um erro indica um código que pode causar um sério problema visível em um determinado 
navegador, como provocar o desaparecimento de partes de uma página. (Em alguns casos, 
um código de efeito desconhecido também é classificado como erro.)

■ Um aviso indica que parte de um código não será exibida corretamente em um 
determinado navegador, mas que isso não ocasionará nenhum problema sério de exibição.

■ Uma mensagem informativa indica que um determinado navegador não oferece suporte a 
um código, mas que esse fato não tem efeito visível; por exemplo: o atributo galleryimg 
da tag img não recebe suporte de alguns navegadores, mas tais navegadores ignoram esse 
atributo, e não há nenhum efeito visível.

Por padrão, o Dreamweaver executa automaticamente uma verificação de navegador de 
destino sempre que você abre um documento. Você também pode executar manualmente uma 
verificação do navegador de destino em um documento, em uma pasta ou no site inteiro.

N
O

T
A

A verificação de navegador de destino não é atualizada continuamente. Depois de fazer 
alterações no código, execute a verificação manual do navegador de destino para 
confirmar a eliminação do código que não funciona com os navegadores de destino.
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A verificação de navegador de destino não verifica os scripts do site. Além disso, essa 
verificação não funciona como um validador de sintaxe; ela detecta somente o markup ao qual 
os navegadores de destino não oferecem suporte.

Para selecionar navegadores que o Dreamweaver verificará:

1. Selecione Settings (Definições) no menu Browser Target Check na barra de ferramentas 
Document (Documento). 

A caixa de diálogo Check Target Browsers será exibida.
2. Marque a caixa de seleção junto a cada navegador a ser verificado.

3. Para cada navegador escolhido, selecione uma versão mínima para verificação no menu 
pop-up correspondente.

Por exemplo, para verificar se o Microsoft Internet Explorer versão 3.0 ou posterior e o 
Netscape Navigator versão 4.0 ou posterior oferecem suporte a todo o markup do 
documento, marque as caixas de seleção ao lado dos nomes desses navegadores e, em 
seguida, selecione 3.0 no menu pop-up do Microsoft Internet Explorer e 4.0 no menu 
pop-up do Netscape Navigator.

Para exibir os resultados de uma verificação automática de navegador de 
destino, siga um destes procedimentos:

■ Abra um arquivo e exiba-o em Code view, em View  > Code ou View  > Code and Design 
(Código e projeto).

■ Depois de fazer uma alteração em Code view, clique no botão Refresh (Atualizar) no 
Property inspector (Inspetor de propriedades) ou pressione F5.

Uma linha ondulada vermelha é exibida sob o nome de todos os itens que são considerados 
erros em um dos navegadores de destino. (Avisos e mensagens informativas não são marcados 
na Code view. Para visualizá-los, é preciso visualizar o relatório completo do documento.) Se o 
Dreamweaver não localizar um markup sem suporte, nada será sublinhado, e o ícone do menu 
Target Browser Check, na barra de ferramentas Document, será alterado para indicar que não 
há erros.

N
O

T
A

O recurso Check Target Browsers usa arquivos de texto denominados perfis de 
navegador para determinar a quais tags um dado navegador oferece suporte. Para obter 
informações sobre como alterar os perfis existentes ou criar novos perfis, consulte o 
artigo “Customizing Dreamweaver” em www.macromedia.com/go/
dreamweaver_support.

D
IC

A

Para utilizar com facilidade vários comandos relativos a verificações de navegador de 
destino, selecione um comando no menu contextual, clicando com o botão direito do 
mouse (no Windows), ou pressionando a tecla Control (no Macintosh), e clicando em 
qualquer item sublinhado em vermelho.
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Para ver quais navegadores não oferecem suporte a um item sublinhado em 
vermelho específico:

■ Posicione o ponteiro para indicar o texto sublinhado em vermelho.

É exibida uma dica de ferramenta, que indica os navegadores que não oferecem suporte a esse 
item.

Para exibir o relatório Check Target Browser do documento inteiro:

■ No menu Target Browser Check na barra de ferramentas Document, selecione Show All 
Errors (Mostrar todos os erros).

O grupo de painéis Results é exibido com o painel Target Browser Check selecionado. Os 
erros são marcados com um ícone em forma de ponto de exclamação vermelho; os avisos, com 
um ponto de exclamação amarelo; e as mensagens informativas, com um ícone em forma de 
balão de texto.

Para exibir uma mensagem de erro longa no painel Target Browser Check:

1. Abra o painel Target Browser Check.

2. Selecione uma mensagem de erro que seja muito longa para ser lida no painel.

3. Clique no botão More Info (Mais informações). 

A caixa de diálogo Description (Descrição) é exibida com o texto completo da mensagem de 
erro selecionada.

Para desativar a verificação automática de navegador de destino:

■ Desmarque Auto-Check On Open (Verificação automática ao abrir) no menu Browser 
Target Check na barra de ferramentas Document.

Para passar para o erro anterior ou seguinte do código:

■ Selecione Next Error (Próximo erro) ou Previous Error (Erro anterior) no menu Target 
Browser Check, na barra de ferramentas Document.

Para passar para um erro específico do painel Target Browser Check:

■ Clique duas vezes na mensagem de erro.

O markup sem suporte é selecionado na Code view.

Para executar uma verificação manual de navegador de destino no arquivo 
atual:

■ Selecione File (Arquivo)  > Check Page (Verificar página)  > Check Target Browsers. 

O relatório é exibido no painel Target Browser Check, no grupo de painéis Results. 
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Para executar uma verificação manual de navegador de destino em um site ou 
em um conjunto de arquivos selecionados:

1. Na visualização local do painel Files (Arquivos), selecione um conjunto de arquivos ou a 
pasta que contém o site inteiro.

2. Selecione File  > Check Page  > Check Target Browsers. 

O relatório é exibido no painel Target Browser Check, no grupo de painéis Results. 
3. Para cancelar o relatório durante sua execução, clique no botão Stop (Parar) no 

painel Target Browser Check.

Para alternar entre a visualização do relatório do documento atual e a 
visualização do relatório completo do site:

■ No painel Target Browser Check, selecione Current Document (Documento atual) ou 
Site Report (Relatório do site) no menu pop-up.

Para salvar um relatório de verificação de navegador de destino:

■ Clique no botão Save Report (Salvar relatório) no painel Target Browser Check.

Para exibir um relatório de verificação de navegador de destino em um 
navegador:

■ Clique no botão Browse Report (Procurar o relatório) no painel Target Browser Check.

Para corrigir um erro:

■ Remova o código para o qual não há suporte ou altere-o para um código ao qual os 
navegadores de destino ofereçam suporte.

Para especificar que Dreamweaver deve ignorar um determinado tipo de erro:

■ Com o botão direito do mouse (Windows) ou com a tecla Control pressionada 
(Macintosh), clique no código sublinhado em vermelho e selecione Ignore Error (Ignorar 
erro) no menu de contexto.

Esse tipo de erro é alterado para aviso e Dreamweaver não é mais sublinhado em nenhum 
documento.

N
O

T
A

O relatório de verificação de navegador de destino não é salvo automaticamente. Se 
desejar guardar uma cópia para consulta futura, será preciso salvá-lo.
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Validar tags
Você pode utilizar o Dreamweaver para descobrir se seu código contém erros de tag ou sintaxe. 
O Dreamweaver pode validar documentos em várias linguagens, inclusive em HTML, 
XHTML, ColdFusion Markup Language (CFML), JavaServer Pages (JSP), Wireless Markup 
Language (WML) e XML. 

Você pode validar o documento atual ou uma tag selecionada.

Para validar tags:

1. Siga um dos procedimentos abaixo:

■ Para um arquivo XML (ou XHTML), selecione File > Check Page > Validate as XML 
(Validar como XML). 

■ Caso contrário, selecione File  > Check Page  > Validate Markup (Validar o markup). 
A guia Validation (Validação) do painel Results exibe a mensagem “No errors or warnings” 
(Não foram encontrados erros ou avisos) ou lista os erros de sintaxe encontrados. 

2. Clique duas vezes em uma mensagem de erro para realçar o erro no documento.

3. Para salvar o relatório como um arquivo XML, clique no botão Save Report (Salvar o 
relatório).

4. Para exibir o relatório no navegador principal, que permite a impressão desse relatório, 
clique no botão Browse Report.

Você pode definir preferências para o Validator, como especificar as linguagens baseadas em 
tags a serem verificadas, os problemas específicos a serem verificados e os tipos de erros a serem 
relatados. Para obter mais informações, consulte “Definir preferências do Validator 
(Validador)” na página 590.

Tópicos relacionados
■ “Verificar a compatibilidade com navegadores” na página 635

N
O

T
A

Para validar seu documento em relação à acessibilidade, consulte “Testar o site” na 
página 171.
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Tornar páginas compatíveis com XHTML
Ao criar uma nova página, você pode torná-la compatível com XHTML. Também é possível 
tornar um documento HTML existente compatível com XHTML. 

Para criar um novo documento compatível com XHTML:

1. Selecione File > New (Novo).

A caixa de diálogo New Document (Novo documento) é exibida.
2. Selecione a categoria e o tipo de página a serem criados.

3. Selecione uma das DTDs de XHTML no menu pop-up Document Type (DTD). 

Por exemplo, você pode criar um documento HTML compatível com XHTML, 
selecionando XHTML 1.0 Transitional ou XHTML 1.0 Strict no menu pop-up.

4. Clique em OK.

Para criar documentos compatíveis com XHTML como padrão:

1. Selecione Edit  > Preferences ou Dreamweaver > Preferences (Mac OS X) e escolha a 
categoria New Document.

2. Na categoria New Document, escolha um documento padrão e selecione uma das 
definições de tipo de documento (DTD) XHTML no menu pop-up Default Document 
Type (DTD). 

Por exemplo, você pode criar um documento HTML compatível com XHTML, 
selecionando XHTML 1.0 Transitional ou XHTML 1.0 Strict no menu pop-up.

3. Clique em OK.

Para tornar um documento HTML existente compatível com XHTML: 

■ Abra um documento e siga um destes procedimentos:
■ No caso de um documento sem quadros, selecione File > Convert (Converter) e, em 

seguida, selecione uma das definições de tipo de documento XHTML.
Por exemplo, você pode criar um documento HTML compatível com XHTML, 
selecionando XHTML 1.0 Transitional ou XHTML 1.0 Strict no menu pop-up.

N
O

T
A

Nem todos os tipos de documento podem ser transformados em documentos 
compatíveis com XHTML.
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■ No caso de um documento com quadros, escolha um quadro e selecione File  > 
Convert e, em seguida, selecione uma das definições de tipo de documento XHTML.
Para converter todo o documento, repita esta etapa para cada documento com quadro 
e conjuntos de quadros.

Tópicos relacionados
■ “Sobre o código XHTML gerado pelo Dreamweaver” na página 606

Usar o depurador ColdFusion (somente 
no Windows)
Caso seja for um desenvolvedor de ColdFusion que utilize o Macromedia ColdFusion MX 
como servidor de teste do Dreamweaver, você poderá visualizar informações de depuração do 
ColdFusion sem sair do Dreamweaver. 

Se estiver executando ColdFusion MX 6.1 ou anterior, antes de iniciar o processo de 
depuração, certifique-se de que as definições de depuração estejam ativadas no ColdFusion 
Administrator (Administrador de ColdFusion). Para obter mais informações, consulte a 
documentação do ColdFusion em Using Dreamweaver (Help (Ajuda) > Using ColdFusion 
[Usando o Cold Fusion]). Se você estiver executando o ColdFusion MX 7 ou posterior, o 
Dreamweaver ativará automaticamente a definição.

N
O

T
A

É impossível converter uma instância de um modelo porque ela deve ter sido 
criada na mesma linguagem que o modelo no qual se baseia. Por exemplo, um 
documento baseado em um modelo XHTML estará sempre em XHTML, 
enquanto um documento baseado em um modelo HTML não compatível com 
XHTML estará sempre em HTML e não será possível convertê-lo em XHTML ou 
outra linguagem.

N
O

T
A

Este recurso não conta com suporte no Macintosh. Os programadores de Macintosh 
podem utilizar o comando Preview in Browser (Visualizar no navegador) (F12) para abrir 
uma página ColdFusion em um navegador distinto. Se a página contiver erros, as 
informações sobre as possíveis causas desses erros serão exibidas na parte inferior da 
página.
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Além disso, certifique-se de que o servidor de teste do Dreamweaver esteja executando 
ColdFusion. Para obter mais informações sobre o servidor de teste do Dreamweaver, consulte 
“Especificar onde as páginas dinâmicas podem ser processadas” na página 667.

Para depurar uma página ColdFusion:

1. Abra a página ColdFusion no Dreamweaver.

2. Clique no ícone Server Debug (Depuração de servidor) na barra de ferramentas Document. 

O Dreamweaver solicita a página do servidor ColdFusion e a exibe em uma janela interna 
do Internet Explorer. Se a página contiver erros, as possíveis causas dos erros serão exibidas 
na parte inferior da página. 
Ao mesmo tempo, é exibido um painel Server Debug. O painel fornece diversas 
informações úteis, como todas as páginas processadas pelo servidor para interpretar a 
página, todas as consultas SQL executadas na página e todas as variáveis do servidor e seus 
respectivos valores, se houver. O painel também fornece um resumo das execuções.

3. Se uma categoria Exceptions (Exceções) for exibida no painel Server Debug, clique no 
ícone de adição (+) para expandi-la.

A categoria Exceptions é exibida quando o servidor encontra problemas na página. 
Expanda a categoria para obter mais informações sobre o problema.

4. Na coluna Location (Local) do painel Server Debug, clique na URL da página para abri-la 
na Code view e corrigi-la.

Se o Dreamweaver localizar a página, ela será aberta com as linhas que indicam problemas 
realçadas. Se o Dreamweaver não conseguir localizar a página, ele solicitará a localização.

5. Corrija o erro, salve o arquivo no servidor e clique em Browse (Procurar).

O Dreamweaver processa a página no navegador interno novamente e atualiza o painel 
Server Debug. Se não houver mais nenhum problema na página, a categoria Exceptions 
não reaparecerá no painel.

6. Para sair do modo de depuração, alterne para a Code view, na opção View  > Code) ou para 
Design view (Visualização do projeto), na opção View  > Design.

D
IC

A

Para assegurar que as informações de depuração sejam atualizadas sempre que uma 
página for exibida no navegador interno, certifique-se de que o Internet Explorer verifica 
se há versões mais recentes do arquivo sempre que este é solicitado. No Internet 
Explorer, selecione Tools (Ferramentas) > Internet Options (Opções da Internet), escolha 
a guia General (Geral) e clique no botão Settings na área Temporary Internet Files 
(Arquivos de Internet temporários). Na caixa de diálogo Settings, selecione a opção 
Every Visit to Page (A cada visita à página).
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CAPÍTULO 22

Editar o código na Design 
View (Visualização do projeto)
O Macromedia Dreamweaver  8 permite que você crie e edite visualmente páginas da Web 
sem precisar se preocupar com o código-fonte subjacente. No entanto, em alguns casos, talvez 
seja necessário editar o código para obter um controle maior ou para solucionar problemas na 
página da Web. O Dreamweaver permite que você edite alguns códigos ao trabalhar na 
visualização do projeto. 

Este capítulo foi elaborado para pessoas que preferem trabalhar com a Design view, mas que 
também querem ter acesso rápido ao código.

O capítulo contém os seguinte tópicos:
Editar o código com o Property inspector (Inspetor de propriedades)  . . . . . . . . 644

Alterar atributos com o Tag inspector (Inspetor de tags)  . . . . . . . . . . . . . . . . . . . . 644

Editar o código com o Quick Tag Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .646
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Editar o código com o Property inspector 
(Inspetor de propriedades)
O Property inspector pode ser utilizado para verificar e editar os atributos de texto ou dos 
objetos em uma página. As propriedades mostradas no Property inspector geralmente 
correspondem a atributos de tags. A alteração de uma propriedade nesse inspetor 
normalmente tem o mesmo efeito da alteração do atributo correspondente na Code view 
(Visualização do código). 

Para utilizar o Property inspector:

1. Clique em um texto ou selecione um objeto na página.

O Property inspector do texto ou objeto é exibido abaixo da janela Document 
(Documento). Se o Property inspector não estiver visível, selecione Window (Janela)  > 
Properties (Propriedades).

2. Modifique os atributos no Property inspector.

Tópicos relacionados
■ “Utilizar o Property inspector” na página 65

Alterar atributos com o Tag inspector 
(Inspetor de tags)
Você pode utilizar o Tag inspector para editar tags e objetos em uma folha de propriedades 
semelhante àquelas encontradas em outros IDEs (Integrated Development Environments, 
Ambientes integrados de desenvolvimento). 

N
O

T
A

O Tag inspector (Inspetor de tags) e o Property inspector permitem exibir e editar os 
atributos de uma tag. O Tag inspector permite exibir e editar todos os atributos 
associados a uma tag específica. O Property inspector mostra apenas os atributos mais 
comuns, mas fornece um conjunto de controles mais completo para alterar os valores 
desses atributos e permite editar alguns objetos (como colunas de tabelas) que não 
correspondem a tags específicas. 

N
O

T
A

O Tag inspector e o Property inspector permitem exibir e editar os atributos de uma tag. 
O Tag inspector permite exibir e editar todos os atributos associados a uma tag 
específica. O Property inspector mostra apenas os atributos mais comuns, mas fornece 
um conjunto de controles mais completo para alterar os valores desses atributos e 
permite editar alguns objetos (como colunas de tabelas) que não correspondem a tags 
específicas.
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Para editar os atributos utilizando o Tag inspector:

1. Siga um destes procedimentos na janela Document:

■ Na Code view (ou no Code inspector), clique em qualquer parte do nome de uma tag 
ou no seu conteúdo. 

■ Na Design view, selecione um objeto ou uma tag no Tag Selector.
2. Abra o Tag inspector (Window  > Tag Inspector) e selecione a guia Attributes (Atributos).

Os atributos da seleção, bem como seus valores atuais, aparecem no Tag inspector.
3. Siga um destes procedimentos no Tag inspector:

■ Para exibir os atributos organizados por categoria, clique no botão Show Category 
View (Mostrar visualização de categoria). 

■ Para exibir os atributos em uma lista alfabética, clique no botão Show List View 
(Mostrar visualização de lista). 

■ Para alterar o valor de um atributo, selecione o valor e edite-o (consulte o 
procedimento a seguir).

■ Para adicionar um valor para um atributo sem valor especificado, clique na coluna de 
valor do atributo à direita do atributo e adicione um valor (consulte o procedimento a 
seguir).

■ Para excluir o valor de um atributo, selecione o valor e pressione Backspace (no 
Windows) ou Delete (no Macintosh).

■ Para alterar o nome de um atributo, selecione esse nome e edite-o.

■ Para adicionar um novo atributo ainda não listado, clique no espaço vazio abaixo do 
nome do atributo listado por último e digite um novo nome de atributo.

4. Pressione Enter (no Windows) ou Return (no Macintosh), ou clique em qualquer parte do 
Tag inspector, para atualizar a tag no documento.

Para editar ou adicionar o valor de um atributo, siga um destes procedimentos:

■ Digite um novo valor para o atributo na coluna de valor do atributo, à direita de 
seu respectivo nome.

■ Se o atributo assumir valores predefinidos, selecione um valor no menu pop-up (ou no 
seletor de cores) à direita da coluna de valor do atributo.

■ Se o atributo assumir o valor de um URL, clique o botão Browse (Procurar) ou use o ícone 
Point-to-File (Indicador de arquivos) para selecionar um arquivo ou tipo de URL na caixa 
de texto.

N
O

T
A

Se você alterar o nome de um atributo padrão e, em seguida, adicionar um valor 
para ele, esse atributo e seu novo valor serão movidos para a categoria 
apropriada.
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■ Se o atributo assumir um valor de uma fonte de conteúdo dinâmico (como um banco de 
dados), clique no botão Dynamic Data (Dados dinâmicos) à direita da coluna de valor do 
atributo. Em seguida, selecione uma fonte. 
Para obter informações sobre como definir fontes de conteúdo dinâmico, consulte 
“Definir as fontes de conteúdo dinâmico” na página 759.

Tópicos relacionados
■ “Editar o código com o Property inspector (Inspetor de propriedades)” na página 644
■ “Utilizar comportamentos JavaScript” na página 541
■ “Utilizar a opção Cascading Style Sheets (Folha de estilo em cascata) para formatar texto” 

na página 433

Editar o código com o Quick Tag Editor
É possível utilizar o Quick Tag Editor para inspecionar e editar tags HTML rapidamente sem 
sair da Design view. Para abrir o Quick Tag Editor, pressione Control+T (Windows) ou 
Command+T (Macintosh). Para obter mais informações, consulte Using Dreamweaver. 

Inserir uma tag HTML com o Quick Tag Editor
É possível utilizar o Quick Tag Editor para inserir uma tag HTML no documento. 

Para inserir uma tag HTML com o Quick Tag Editor:

1. No modo de visualização do projeto, clique na posição na página onde deseja 
inserir o código.

2. Pressione Control+T (Windows) ou Command+T (Macintosh). 

O Quick Tag Editor é aberto no modo Insert HTML (Inserir HTML).

3. Digite a tag HTML e, em seguida, pressione Enter. 

A tag é inserida no código, com uma tag de finalização correspondente, se aplicável. 
4. Pressione a tecla Esc para sair sem fazer alterações.

Tópicos relacionados
■ “Aplicar HTML a uma seleção com o Quick Tag Editor” na página 648
■ “Usar o menu de referências no Quick Tag Editor” na página 648
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Editar uma tag HTML com o Quick Tag Editor
Utilize o Quick Tag Editor para editar uma tag HTML no documento. 

Para editar uma tag HTML com o Quick Tag Editor:

1. Selecione um objeto na Design view. 

A tag a ser editada também pode ser selecionada no Tag Selector, na parte inferior da 
janela Document . Para obter mais informações, consulte “Editar código com o seletor de 
tags” na página 649.

2. Pressione Control+T (Windows) ou Command+T (Macintosh). 

O Quick Tag Editor é aberto no modo Edit Tag.
3. Digite novos atributos ou edite atributos já existentes ou o nome da tag.

4. Pressione a tecla Tab para avançar de um atributo ao outro e pressione Shift+Tab para 
voltar. 

Por padrão, as alterações são aplicadas ao documento pressionando-se Tab ou Shift+Tab. 
Para desativar as atualizações automáticas, selecione Edit > Preferences > Quick Tag Editor 
ou Dreamweaver > Preferences > Quick Tag Editor (Mac OS X). A caixa de diálogo Quick 
Tag Editor Preferences (Preferências do Quick Tag Editor) é exibida. Desmarque a opção 
Apply Changes Immediately While Editing (Aplicar as modificações durante a edição) e 
clique em OK.
Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

5. Para fechar o Quick Tag Editor e aplicar todas as alterações, pressione Enter.

6. Para sair sem efetuar nenhuma alteração, pressione a tecla Esc.

Tópicos relacionados
■ “Inserir uma tag HTML com o Quick Tag Editor” na página 646
■ “Usar o menu de referências no Quick Tag Editor” na página 648
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Aplicar HTML a uma seleção com o Quick Tag Editor
Você pode utilizar o Quick Tag Editor para colocar a seleção atual entre as tags HTML de 
abertura e de fechamento. 

Como aplicar HTML a uma seleção com o Quick Tag Editor:

1. Selecione um texto ou objeto não formatado, na Design view. 

2. Pressione as teclas Control e T (no Windows), ou Command e T (no Macintosh), ou clique 
no botão Quick Tag Editor no Property inspector. 

O Quick Tag Editor é aberto no modo Wrap Tag.
3. Digite uma única tag de abertura, como strong, e pressione Enter (no Windows) ou Return 

(no Macintosh). 

A tag é inserida no início da seleção e a tag de finalização correspondente é colocada no 
final. 

4. Para sair sem fazer alterações, em vez de pressionar Enter, pressione Esc.

Usar o menu de referências no Quick Tag Editor
No Quick Tag Editor, é possível acessar um menu de referências de atributos que lista todos os 
atributos válidos da tag que está sendo editada ou inserida. 

É possível desativar o menu de referências ou ajustar o intervalo entre as exibições do menu 
pop-up com o Quick Tag Editor.

Para ver um menu de referências com a lista dos atributos válidos para uma tag, faça uma 
breve pausa ao editar o nome de um atributo no Quick Tag Editor. É exibido um menu de 
referências com a lista de todos os atributos válidos para a tag que está sendo editada.

Da mesma forma, para ver um menu de referências com uma lista de nomes de tags válidas, 
faça uma breve pausa ao digitar ou editar o nome de uma tag no Quick Tag Editor.

N
O

T
A

Se você selecionar um texto ou objeto que contenha uma tag HTML de abertura ou 
finalização, o Quick Tag Editor será aberto no modo Edit Tag, e não no modo Wrap 
Tag (Colocar tag ao redor).

N
O

T
A

As preferências das referências de código do Quick Tag Editor são controladas pelas 
preferências de referências de código normais. Para obter mais informações, consulte 
“Definir as preferências de referências de código” na página 588. 
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Para utilizar um menu de referências:

1. Siga um dos procedimentos abaixo:

■ Comece a digitar o nome de um atributo ou de uma tag. A seleção no menu Code 
Hints (Referências de código) passa para o primeiro item que começa com as letras 
digitadas.

■ Utilize as setas para cima e para baixo para selecionar um item.
■ Utilize a barra de rolagem para localizar um item.

2. Pressione Enter para inserir o item selecionado ou clique duas vezes no item para inseri-lo.

3. Para desativar as referências sem inserir um item, pressione Esc ou continue a digitar.

Para desativar o menu de referências ou alterar o intervalo de exibição:

1. Selecione Edit  > Preferences (Windows) ou Dreamweaver > Preferences (Macintosh) e 
escolha Quick Tag Editor.

A caixa de diálogo Quick Tag Editor Preferences (Preferências do Quick Tag Editor) é 
exibida.

2. Para desativar o menu de referências, desmarque a opção Enable Tag Hints (Ativar a 
referência de tags).

3. Para alterar o intervalo entre as exibições do menu, ajuste o botão deslizante Delay (Atraso).

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

Tópicos relacionados
■ “Editar uma tag HTML com o Quick Tag Editor” na página 647

Editar código com o seletor de tags
Utilize o seletor de tags para selecionar, editar ou remover tags sem sair da Design view . O 
Tag Selector está localizado na barra de status, na parte inferior da janela Document, e mostra 
uma série de tags, da forma descrita a seguir. 

Para editar um tag:

1. Clique no documento.

As tags aplicáveis ao ponto de inserção aparecem no Tag Selector.
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2. Clique com o botão direito do mouse (no Windows) ou com a tecla Control pressionada 
(no Macintosh) em uma tag no Tag Selector. 

O menu pop-up é exibido.
3. Selecione Edit Tag no menu.

O Quick Tag Editor é aberto. Para obter mais informações, consulte “Editar uma tag HTML 
com o Quick Tag Editor” na página 647.

Para remover uma tag:

1. Clique no documento.

As tags aplicáveis ao ponto de inserção aparecem no Tag Selector.
2. Clique com o botão direito do mouse (no Windows) ou com a tecla Control pressionada 

(no Macintosh) em uma tag no Tag Selector. 

O menu pop-up é exibido.
3. Selecione Remove Tag (Remover a tag) no menu.

Para selecionar um objeto que corresponda a uma tag:

1. Clique no documento.

As tags aplicáveis ao ponto de inserção aparecem no Tag Selector.
2. Clique em uma tag no Tag selector.

O objeto representado pela tag é selecionado na página.

Editar scripts
É possível trabalhar com JavaScripts e VBScripts no cliente, tanto na Code view quanto na 
Design view.

Escrever um script do cliente na Design view
É possível escrever um JavaScript ou VBScript na página sem sair da Design view. 

Antes de começar, selecione View (Exibir)  > Visual Aids (Auxílios visuais)  > Invisible 
Elements (Elementos invisíveis) para certificar-se de que os marcadores de script sejam 
exibidos na página. 

D
IC

A

Utilize esta técnica para selecionar linhas de tabelas (tags tr) ou células (tags td) 
separadamente.
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Para inserir um script do cliente na Design view:

1. Posicione o ponto de inserção onde o script deve ser inserido.

2. Selecione Insert (Inserir)  > Script Objects (Objetos de script)  > Script.

A caixa de diálogo Script será exibida.
3. Preencha a caixa de diálogo e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Vincular a um arquivo de script externo
É possível criar um link do documento para um arquivo de script externo sem sair da Design 
view.

Antes de começar, selecione View  > Visual Aids (Auxílios visuais)  > Invisible Elements 
(Elementos invisíveis) para se certificar de que os marcadores de script sejam exibidos na 
página. 

Para vincular a um arquivo de script externo:

1. Posicione o ponto de inserção onde o script deve ser inserido.

2. Selecione Insert  > Script Objects  > Script.

A caixa de diálogo Script será exibida.
3. Clique em OK e deixe em branco a caixa de texto Content (Conteúdo).

4. Selecione o marcador de script na Design view da janela Document. 

5. No Property inspector, clique no ícone de pasta para procurar e selecionar o arquivo de 
script externo ou digite o nome do arquivo na caixa Source (Origem).

Editar um script na Design view
É possível editar um script sem sair da Design view. 

Antes de começar, selecione View  > Visual Aids (Auxílios visuais)  > Invisible Elements 
(Elementos invisíveis) para certificar-se de que os marcadores de script sejam exibidos na 
página. 

Para editar o script na Design view:

1. Selecionar o marcador de script.

2. No Property inspector, clique no botão Edit (Editar). 

O script aparecerá na caixa de diálogo Script Properties (Propriedades do script). 
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Se o script estiver vinculado a um arquivo de script externo, o arquivo será aberto 
automaticamente na Code view, onde você poderá editá-lo. 

3. Edite o script e clique em OK. 

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo. 

Trabalhar com inclusões do servidor 
As inclusões do servidor são instruções dadas ao servidor da Web para adicionar um arquivo 
especificado em uma página da Web antes de enviá-la ao navegador. Para obter mais 
informações, consulte “Inclusões do servidor” na página 608. 

É possível usar o Dreamweaver para inserir inclusões do servidor em páginas, editar as 
inclusões ou visualizar as páginas que contêm inclusões.

Inserir uma inclusão do servidor
Você pode utilizar o Dreamweaver para inserir inclusões do servidor em sua página. 

Para inserir uma inclusão de servidor:

1. Selecione Insert > Server-Side Include (Inserir Inclusão no Servidor).

2. Na caixa de diálogo que aparecer, procure e selecione um arquivo.

Por padrão, o Dreamweaver insere o tipo de arquivo de inclusão. 
3. Para alterar o tipo de inclusão, selecione a inclusão do servidor na janela do documento e 

altere o tipo no Property inspector (Window > Properties), da seguinte maneira:

■ No caso de um servidor Web Apache, selecione Virtual. No Apache, a opção Virtual 
funciona em todos os casos, enquanto File funciona em apenas alguns.

■ No caso de um servidor Microsoft Internet Information Server (IIS), selecione File. 
(Virtual funciona com o IIS somente em circunstâncias específicas.)

N
O

T
A

Se não houver um código entre as tags de script, a caixa de diálogo Script 
Properties será aberta, mesmo se houver também um link para um arquivo de script 
externo.

N
O

T
A

Infelizmente, o IIS não permite que se inclua um arquivo numa pasta acima da 
pasta atual na hierarquia de pastas, a não ser que algum software especial tenha 
sido instalado no servidor. Se necessitar incluir um arquivo de uma pasta acima 
na hierarquia de pastas de um servidor IIS, pergunte ao administrador do sistema 
se o software necessário está instalado.
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■ Para outros tipos de servidores, ou caso você desconheça o tipo de servidor que estiver 
utilizando, pergunte ao administrador do sistema qual opção deverá ser utilizada.

Para alterar o arquivo que será incluído:

1. Selecione a inclusão do servidor na janela Document.

2. Abra o Property inspector, em Window (Janela)  > Properties (Propriedades).

3. Siga um dos procedimentos abaixo:

■ Clique no ícone correspondente à pasta, procure e selecione um novo arquivo para 
incluir.

■ Na caixa de texto, digite o caminho e o nome do novo arquivo a ser incluído.

Tópicos relacionados
■ “Inclusões do servidor” na página 608

Editar o conteúdo de uma inclusão do servidor
Você pode utilizar o Dreamweaver para editar inclusões do servidor. Para editar o conteúdo 
associado a este arquivo incluído, abra o arquivo. 

Para editar uma inclusão do servidor:

1. Selecione a inclusão do servidor na Design view ou na Code view e clique em Edit no 
Property inspector .

O arquivo incluído será aberto na janela Document.
2. Edite o arquivo e salve-o em seguida.

As alterações serão transferidas imediatamente para o documento atual e em qualquer 
documento subseqüente que for aberto e contenha esse arquivo. 

3. Efetue o upload do arquivo de inclusão para o site remoto, caso necessário.

Tópicos relacionados
■ “Inclusões do servidor” na página 608

Utilizar comportamentos JavaScript
A guia Behaviors (Comportamentos) do Tag inspector permite anexar, com facilidade, 
comportamentos JavaScript (do cliente) a elementos de página. Para obter mais informações, 
consulte “Utilizar as ações de comportamentos enviadas com o Dreamweaver” na página 549.
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Exibir e editar o conteúdo do cabeçalho
Você pode exibir os elementos na seção head de um documento utilizando o menu View, a 
Code view da janela Document ou o Code inspector. 

Para exibir os elementos da seção head de um documento:

■ Selecione View  > Head Content (Conteúdo do cabeçalho). Para cada elemento do 
conteúdo do head, é exibido um marcador na parte superior da janela Document na 
Design view.

Para inserir um elemento na seção head de um documento:

1. Siga um dos procedimentos abaixo:

■ Na categoria Head da barra Insert (Inserir), clique no botão de um dos objetos.
■ Selecione um item no submenu Insert  > Head Tags (Tags do cabeçalho).

2. Insira as opções para o elemento na caixa de diálogo exibida ou no Property inspector.

Para editar um elemento na seção head de um documento:

1. Selecione View  > Head Content.

2. Clique em um dos ícones na seção head para selecioná-lo.

3. Defina ou modifique as propriedades do elemento no Property inspector.

Para obter informações sobre as propriedades de elementos head específicos, consulte Using 
Dreamweaver.

N
O

T
A

Se a janela do documento estiver definida somente para a visualização do código, a 
opção View  > Head Content estará desativada.
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PARTE 6

Preparar para a criação de 
sites dinâmicos
Se você estiver construindo um aplicativo dinâmico para a Web, comece 
configurando um servidor de aplicativos e conectando-se a um banco de 
dados.

Esta seção contém os seguintes capítulos:
Capítulo 23: Configurar um aplicativo para a Web . . . . . . . . . . . 657

Capítulo 24: Conexões de banco de dados para 
desenvolvedores ColdFusion  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 669

Capítulo 25: Conexões de banco de dados para 
desenvolvedores de ASP.NET . . . . . . . . . . . . . . . . . . . . . . . . . . . . 673

Capítulo 26: Conexões de banco de dados para 
desenvolvedores de ASP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 681

Capítulo 27: Conexões de banco de dados para 
desenvolvedores JSP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 695

Capítulo 28: Conexões de banco de dados para 
desenvolvedores PHP. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 705

Capítulo 29: Solucionar problemas de conexões de banco 
de dados. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 709
655



         



         

23

CAPÍTULO 23

Configurar um aplicativo para 
a Web
Este capítulo descreve como configurar o sistema para criar aplicativos para a Web no 
Macromedia Dreamweaver 8.

O que é necessário para criar aplicativos 
para a Web
Para criar aplicativos para a Web no Dreamweaver, é necessário o software a seguir: 

■ Um servidor da Web (consulte “Configurar um servidor da Web” na página 658)
■ Um servidor de aplicativos que execute o servidor da Web (consulte “Configurar um 

servidor de aplicativos” na página 659)

Se desejar utilizar um banco de dados com o aplicativo, é necessário o software adicional a 
seguir:

■ Um sistema de banco de dados
■ Um driver de banco de dados que ofereça suporte ao banco de dados

Para obter informações sobre como configurar um banco de dados para o aplicativo para a 
Web, consulte “Efetuar a conexão com um banco de dados” na página 668.

Diversas empresas de hospedagem na Web oferecem planos que permitem utilizar o software 
que elas possuem para testar e implementar aplicativos para a Web. Em algumas situações, é 
possível instalar o software necessário no mesmo computador que o Dreamweaver, para fins 
de desenvolvimento. Também é possível instalar o software em um computador de rede 
(normalmente, um computador com o Windows 2000 ou XP) para que outros 
desenvolvedores da equipe possam trabalhar em um projeto.

N
O

T
A

No contexto de aplicativos para a Web, os termos se referem servidor da Web e 
servidor de aplicativos ao software, e não ao hardware. 
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Configurar um servidor da Web
Para executar aplicativos para a Web, é necessário um servidor da Web. Um servidor da Web é 
um software que fornece arquivos em resposta a solicitações de navegadores da Web. O 
servidor da Web é chamado, algumas vezes, de servidor HTTP. Os servidores da Web mais 
conhecidos são: Microsoft Internet Information Server (IIS), Netscape Enterprise Server, Sun 
ONE Web Server e Apache HTTP Server.

Se não estiver usando um serviço de hospedagem na Web, escolha um servidor da Web e o 
instale no computador local ou em um computador remoto. Os usuários do Windows que 
desejarem desenvolver aplicativos ColdFusion para a Web poderão utilizar o servidor da Web 
incluído na edição do desenvolvedor do servidor de aplicativos ColdFusion MX 7, que pode 
ser instalado e utilizado gratuitamente. Para obter mais informações, consulte “Instalar um 
servidor de aplicativos ColdFusion” na página 660.

Os outros usuários do Windows podem instalar o IIS para executar um servidor da Web no 
computador local. É possível que esse servidor da Web já esteja instalado em seu sistema. 
Verifique a estrutura de pastas para saber se contém uma pasta C:\Inetpub ou D:\Inetpub. O 
IIS cria essa pasta durante a instalação. Para instalar o IIS, consulte “Installing a Web Server” 
em Getting Started with Dreamweaver (Guia de introdução do Dreamweaver).

As páginas ASP.NET funcionam apenas com um único servidor da Web: Microsoft IIS 5 ou 
superior. Como o IIS 5 é um serviço dos sistemas operacionais Windows 2000 e Windows XP 
Professional, você só poderá utilizar essas duas versões do Windows para hospedar aplicativos 
ASP.NET. No entanto, você poderá desenvolver (em vez de hospedar) aplicativos ASP.NET 
em qualquer computador que execute o Dreamweaver, inclusive em computadores 
Macintosh.

Os usuários do Macintosh podem utilizar um serviço de hospedagem na Web ou instalar o 
software necessário em um computador remoto. Você também pode desenvolver sites PHP 
localmente utilizando o servidor da Web Apache e o servidor de aplicativos PHP instalados 
com o sistema operacional. Para obter mais informações, consulte “Instalar um servidor de 
aplicativos PHP” na página 662.

Para obter informações sobre como instalar e configurar outros servidores da Web, consulte a 
documentação do revendedor do servidor ou o administrador do sistema.
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Configurar um servidor de aplicativos
Para executar aplicativos para a Web, é necessário que o servidor da Web trabalhe com um 
servidor de aplicativos. Servidor de aplicativos é um software que ajuda o servidor da Web a 
processar páginas dinâmicas.

Escolher o servidor de aplicativos
A escolha do servidor de aplicativos depende de diversos fatores, como o orçamento, a 
tecnologia de servidor que se deseja utilizar (ColdFusion, ASP.NET, ASP, JSP ou PHP) e o 
servidor da Web escolhido.

Orçamento Alguns fornecedores comercializam servidores de aplicativos de alto 
desempenho, que são dispendiosos em termos de aquisição e de administração. Outros 
fornecedores oferecem soluções mais simples, eficientes e econômicas (os exemplos incluem 
servidores Macromedia ColdFusion e JRun). Alguns servidores de aplicativos são integrados a 
servidores da Web (como o Microsoft IIS); também é possível efetuar o download de outros 
servidores gratuitamente pela Internet (como o Jakarta Tomcat e o PHP).

Tecnologia do servidor Os servidores de aplicativos utilizam tecnologias diferentes. O 
Dreamweaver oferece suporte a cinco tecnologias de servidor: ColdFusion, ASP.NET, ASP, 
JSP e PHP. Para obter mais informações, consulte “Choosing a server technology” em Getting 
Started with Dreamweaver. A tabela abaixo mostra servidores de aplicativos conhecidos 
disponíveis para as cinco tecnologias de servidor que contam com suporte do Dreamweaver: 

Servidor da Web A escolha do servidor de aplicativos também pode depender do servidor 
da Web que deseja utilizar. Certifique-se de que o aplicativo funcione com o servidor da Web. 
Por exemplo, o servidor .NET Framework funciona somente com o IIS 5 ou superior.

Tecnologia de servidor Servidor de aplicativos

ColdFusion Macromedia ColdFusion MX 7

ASP.NET Microsoft IIS 6 com .NET Framework

ASP Microsoft IIS
Sun ONE Active Server Pages 

JSP Macromedia JRun
Sun ONE Application Server
IBM WebSphere
Apache Tomcat
BEA WebLogic

PHP Servidor PHP
Configurar um servidor de aplicativos 659



         
Instalar um servidor de aplicativos ColdFusion
Para executar páginas ColdFusion, é necessário utilizar o servidor de aplicativos ColdFusion. 
Esse servidor está disponível para sistemas Windows, Linux, Solaris e HP-UX.

Os usuários do Windows podem efetuar o download e instalar uma edição do ColdFusion 
MX 7 para desenvolvedores, com funcionalidade integral, no site da Macromedia, em 
www.macromedia.com/go/coldfusion/. Uma cópia do ColdFusion MX 7 Developer Edition 
também está disponível no CD do Dreamweaver (somente na versão para Windows).

Durante a instalação, você pode configurar o ColdFusion para utilizar o servidor da Web 
integrado ao ColdFusion ou outro servidor da Web instalado no sistema. Em geral, o ideal é 
ter o máximo de integração possível entre os ambientes de desenvolvimento e de produção. 
Portanto, se você tiver um servidor da Web, como o Microsoft IIS, no seu computador de 
desenvolvimento, poderá selecioná-lo, em vez do servidor da Web ColdFusion. 

Os usuários do Macintosh podem utilizar um serviço de hospedagem na Web que ofereça um 
plano do ColdFusion ou instalar o ColdFusion em um computador remoto com o Windows, 
Linux, Solaris ou HP-UX executando um servidor da Web. Também é possível instalar o 
ColdFusion em um computador Mac OS X, executando um servidor J2EE, como o JRun ou 
o Tomcat. Para obter mais informações, consulte o site da Macromedia na Web em 
www.macromedia.com/go/cfmx7_mac.

Depois de instalar o servidor de aplicativos, criar uma pasta raiz para o aplicativo para a Web. 
Consulte “Criar uma pasta raiz para o aplicativo” na página 663.

Instalar um servidor de aplicativos ASP.NET
Para desenvolver e executar páginas ASP.NET, é necessário o seguinte software:

■ Um computador com o Windows 2000 ou Windows XP Professional executando o IIS 5 
ou mais avançado

■ O Microsoft .NET Framework 1.1, que pode ser adquirido no site da Microsoft
■ O Microsoft .NET Framework 1.1 e o Software Development Kit (SDK), que podem ser 

adquiridos no site da Microsoft

N
O

T
A

A Developer Edition (Edição para programadores) não se destina ao uso comercial, mas 
sim a desenvolvimento e testes de aplicativos para a Web. Não é licenciada para 
implantação. Ele oferece suporte a solicitações do host local e dois endereços IP 
remotos. Você pode usá-lo para desenvolver e testar seus aplicativos para Web pelo 
tempo que desejar; o software não expira. Para obter mais informações, consulte 
“ColdFusion MX 7 product editions” em Using ColdFusion (Help [Ajuda] > Using 
ColdFusion [Usando o ColdFusion]).
660 Capítulo 23:  Configurar um aplicativo para a Web

http://www.macromedia.com/go/coldfusion/
http://www.macromedia.com/go/cfmx7_mac


         
Certifique-se de que tanto o Framework como o SDK estejam instalados e em funcionamento 
em um sistema Windows 2000 ou Windows XP Professional que execute IIS 5 ou superior

Para instalar o .NET Framework e o SDK:

1. Verifique se o .NET Framework está instalado em seu sistema, revendo a lista de aplicativos 
na caixa de diálogo Adicionar ou Remover Programas (Iniciar > Painel de Controle > 
Adicionar ou Remover Programas).

Se o Microsoft .NET Framework 1.1 estiver na lista, o Framework já está instalado e não 
será preciso instalá-lo novamente. Vá para a etapa 3.

2. Se o .NET Framework não estiver instalado no sistema, faça o download do pacote 
Microsoft .NET Framework 1.1 Redistributable no site da Microsoft, em http://
msdn.microsoft.com/netframework/downloads/framework1_1/, e siga as instruções de 
instalação ali fornecidas.

Você instala o Framework como uma atualização do Windows.
3. Faça o download do Microsoft .NET Framework 1.1 e do Software Development Kit 

(SDK) no mesmo site da Web e siga as instruções de instalação.

Após a instalação do .NET Framework e do SDK, é altamente recomendável instalar também 
o pacote Microsoft Data Access Components (MDAC) 2.7 e do SDK. É possível fazer 
gratuitamente o download e a instalação do MDAC 2.7 no site da Microsoft, em http://
msdn.microsoft.com/data/mdac/downloads/.

Os usuários do Macintosh podem utilizar um serviço de hospedagem na Web que ofereça um 
plano para ASP.NET ou podem instalar o .NET Framework e o SDK em um computador 
remoto Windows 2000 ou Windows XP Professional que execute o IIS 5 ou uma versão 
posterior.

Uma vez instalado o .NET Framework e o SDK, crie uma pasta raiz para seu aplicativo para 
Web. Consulte “Criar uma pasta raiz para o aplicativo” na página 663.

Instalar um servidor de aplicativos ASP
Para executar as páginas ASP, você precisa de um servidor de aplicativos que ofereça suporte ao 
Microsoft Active Server Pages 2.0., como o Microsoft IIS, que está incluído no pacote do 
Windows 2000 e do Windows XP Professional.

Os usuários do Windows podem instalar e executar o IIS nos seus computadores locais. Para 
obter instruções, consulte “Installing a Web Server” em Getting Started with Dreamweaver.

Os usuários do Macintosh podem utilizar um serviço de hospedagem na Web, que ofereça um 
plano para ASP, ou podem instalar o IIS em um computador remoto.
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Uma vez instalado o IIS, crie uma pasta raiz para seu aplicativo para Web. Consulte “Criar 
uma pasta raiz para o aplicativo” na página 663.

Instalar um servidor de aplicativos JSP
Para executar páginas JSP, é necessário um servidor de aplicativos que ofereça suporte a 
JavaServer Pages. Estas são algumas das opções conhecidas: 

■ Macromedia JRun for Windows, Mac OS X, Linux, Solaris, ou UNIX. Você pode efetuar 
o download de uma versão de teste do JRun a partir do site da Macromedia na Web em 
www.macromedia.com/go/jrun/.

■ Tomcat for Windows e UNIX (inclusive para Mac OS X). Você pode efetuar o download 
de uma cópia do Tomcat a partir do site do Projeto Jakarta na Web em http://
jakarta.apache.org/tomcat/. Para obter mais informações sobre a instalação do Tomcat no 
Macintosh, consulte o site da Apple na Web em http://developer.apple.com/internet/java/
tomcat1.html.

Depois de instalar um servidor de aplicativos JSP, crie uma pasta raiz para o aplicativo para a 
Web. Consulte “Criar uma pasta raiz para o aplicativo” na página 663.

Instalar um servidor de aplicativos PHP
Para executar páginas PHP, é necessário o servidor de aplicativos PHP, que é um software de 
código-fonte aberto disponível na Web. Há edições do servidor de aplicativos disponíveis para 
sistemas Windows, Linux, UNIX, HP-UX, Solaris e Mac OS X. O servidor de aplicativos 
funciona com os servidores da Web a seguir: Apache, Microsoft IIS, Netscape e Sun ONE, 
bem como quase todos os servidores da Web que oferecem suporte à interface CGI.

Você pode efetuar o download do servidor de aplicativos PHP a partir do site da PHP na Web 
em www.php.net/downloads.php. No PHP 5, a extensão MySQL que permite ao PHP 
funcionar com um servidor de banco de dados MySQL não estará instalada ou não será 
ativada por padrão pelo Windows Installer. Você precisa instalá-la e ativá-la à parte. Para obter 
instruções, consulte “Installing a PHP application server (Windows)” em Getting Started with 
Dreamweaver. Para obter mais informações sobre a extensão MySQL, consulte o site do PHP 
em www.php.net/manual/en/ref.mysql.php.

Se for usuário do Macintosh, você poderá utilizar o servidor de aplicativos PHP instalado com 
o sistema operacional. Para obter mais informações, visite os seguintes sites da Web:

■ www.macromedia.com/go/php_macintosh/  
■ http://developer.apple.com/internet/opensource/php.html 
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Para obter mais informações sobre o servidor de aplicativos, consulte a documentação do PHP, 
cujo download pode ser efetuado no site da PHP, em www.php.net/download-docs.php.

Depois de instalar o servidor de aplicativos PHP, crie uma pasta raiz para o aplicativo para a 
Web.

Criar uma pasta raiz para o aplicativo
Após contratar uma empresa de hospedagem na Web ou de configurar você próprio o software 
do servidor, crie uma pasta raiz para seu aplicativo da Web no computador que está 
executando o servidor da Web. 

Certifique-se de que a pasta seja publicada pelo servidor da Web — em outras palavras, o 
servidor da Web pode fornecer qualquer arquivo existente nessa pasta ou em qualquer uma 
das suas subpastas em resposta a uma solicitação HTTP feita por um navegador da Web. Por 
exemplo, em um computador que execute o ColdFusion MX 7, qualquer arquivo existente na 
pasta \CFusionMX7\wwwroot ou em uma de suas subpastas poderá ser fornecido para um 
navegador da Web. 

Estas são as pastas raiz padrão de alguns servidores da Web:

Para testar o servidor da Web, coloque uma página HTML de teste na pasta raiz padrão e 
tente abri-la digitando a URL da página no navegador. A URL contém o nome do domínio, 
como www.mysite.com, e o nome do arquivo da página HTML como a seguir:

www.mysite.com/testpage.htm

Servidor da Web Pasta raiz padrão

ColdFusion MX 7 \CFusionMX7\wwwroot

IIS \Inetpub\wwwroot

Apache (Windows) \apache\htdocs

Apache (Macintosh) Users:MyUserName:Sites

Jakarta Tomcat (Windows) \jakarta-tomcat-4.x.x\webapps\ROOT\
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Se o servidor da Web estiver em execução no computador local, você poderá utilizar localhost, 
em vez de um nome de domínio. Utilizando o exemplo anterior, digite a seguinte URL de 
host local, dependendo do seu servidor da Web:

Se a página não abrir como esperado, verifique estes possíveis erros: 

■ O servidor da Web não é iniciado. Consulte a documentação do servidor da Web para 
obter instruções de inicialização.

■ O arquivo não tem uma extensão .htm ou .html.
■ Você digitou o caminho do arquivo da página (por exemplo, 

c:\CFusionMX7\wwwroot\testpage.htm), mas não a sua URL (por exemplo, http://
localhost:8500/testpage.htm), na caixa de texto de endereço do navegador. 

■ A URL contém um erro de digitação. Verifique se há erros e certifique-se de que o nome 
de arquivo não venha acompanhado de uma barra invertida, como http://localhost:8080/
testpage.htm/.

Depois de criar uma pasta raiz para o aplicativo, defina um site do Dreamweaver para 
gerenciar seus arquivos. 

Servidor da Web URL localhost 

ColdFusion MX 7 http://localhost:8500/testpage.htm

IIS http://localhost/testpage.htm

Apache (Windows) http://localhost:80/testpage.htm

Apache (Macintosh) http://localhost/~MyUserName/testpage.htm 
(onde MyUserName corresponde ao seu nome de 
usuário Macintosh)

Jakarta Tomcat (Windows) http://localhost:8080/testpage.htm

N
O

T
A

Por padrão, o servidor da Web do ColdFusion MX 7 é executado na porta 8500, e o 
Jakarta Tomcat é executado na porta 8080.
664 Capítulo 23:  Configurar um aplicativo para a Web



         
Definir um site do Dreamweaver
Após configurar seu sistema para desenvolver aplicativos para Web, defina um site do 
Dreamweaver para gerenciar os arquivos.

Antes de começar, certifique-se de que os requisitos a seguir sejam atendidos:

■ Você tem acesso a um servidor da Web. O servidor da Web pode estar sendo executado no 
computador local, em um computador remoto (como um servidor de desenvolvimento) 
ou em um servidor mantido por uma empresa de hospedagem na Web. Consulte 
“Configurar um servidor da Web” na página 658.

■ Um servidor de aplicativos está instalado e em execução no sistema com o servidor da 
Web. Consulte “Configurar um servidor de aplicativos” na página 659.

■ Foi criada uma pasta raiz para o aplicativo para a Web no sistema onde está sendo 
executado o servidor da Web. Para obter mais informações, consulte “Criar uma pasta raiz 
para o aplicativo” na página 663.

O processo de definição de um site do Dreamweaver para o aplicativo para a Web consiste em 
três etapas:

1. Definir uma pasta do disco rígido como a pasta local que o Dreamweaver utilizará para 
armazenar cópias de trabalho dos arquivos do site (consulte “Definir uma pasta local” na 
página 665).

2. Definir uma pasta do computador que está executando o servidor da Web como a pasta 
remota do Dreamweaver (consulte “Definir uma pasta remota” na página 666).

3. Especificar para onde o Dreamweaver deve enviar páginas dinâmicas a serem processadas 
enquanto o usuário trabalha (consulte  “Especificar onde as páginas dinâmicas podem ser 
processadas” na página 667).

Depois de definir o site do Dreamweaver, é possível começar a criar aplicativos para a Web. 

Definir uma pasta local
É possível definir uma pasta local do Dreamweaver para cada novo aplicativo para a Web que 
for criado. A pasta local é a pasta usada para armazenar cópias de trabalho dos arquivos do site 
no disco rígido. A definição de uma pasta local também permite gerenciar os arquivos e 
transferi-los de/para o servidor da Web com o simples clicar de um botão. 

Para definir uma pasta local do Dreamweaver:

1. Crie uma pasta no disco local para armazenar cópias de trabalho dos arquivos.

Talvez seja conveniente criar subpastas para armazenar os arquivos de imagens e outras 
propriedades.
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2. No Dreamweaver selecione Site > Manage Sites (Gerenciar sites), clique no botão New 
(Novo) na caixa de diálogo Manage sites e selecione Site no menu contextual.

A caixa de diálogo Site Definition (Definição do site) é exibida.
3. Se o assistente for exibido, clique em Advanced (Avançado) e selecione Local Info 

(Informações locais) na lista Category (Categoria) (este  deve ser o padrão).

4. Na caixa Site Name (Nome do site), digite um nome descritivo para o site do 
Dreamweaver.

5. Na caixa Local Root Folder (Pasta raiz local), especifique a pasta criada na Etapa 1.

É possível digitar um caminho ou clicar no ícone da pasta para procurá-la e selecioná-la.
6. Se desejar, preencha as outras opções da categoria Local Info (elas não são necessárias para 

que o site funcione).

Para obter mais informações sobre essas opções, clique no botão Help na caixa de diálogo.

A caixa de diálogo Site Definition deve ficar aberta. Em seguida, especifique uma pasta 
remota. 

Definir uma pasta remota
Após definir uma pasta local, é possível definir uma pasta remota para o site do Dreamweaver. 
A pasta remota é aquela criada para o aplicativo para a Web no servidor da Web (consulte 
“Criar uma pasta raiz para o aplicativo” na página 663).

Não será preciso definir uma pasta remota se a pasta definida em “Definir uma pasta local” na 
página 665 puder funcionar também como a pasta raiz do aplicativo para a Web. Isso indica 
que o servidor da Web está em execução no computador local. 

Para definir uma pasta remota do Dreamweaver:

1. Se a caixa de diálogo Site Definition não estiver aberta, abra-a da seguinte maneria: 
selecione Site > Manage Sites (Gerenciar sites), depois selecione o site na lista que aparece 
na caixa de diálogo Manage Sites e, finalmente, clique em Edit (Editar).

A caixa de diálogo Site Definition é exibida.
2. Se o assistente for exibido, clique em Advanced e selecione Remote Info (Informações 

remotas) na lista Category.

A caixa de diálogo Remote Info é exibida.
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3. No menu pop-up Access (Acesso), selecione uma das seguintes opções: Local/Network 
(Local/Rede), FTP ou RDS.

As opções configuradas dizem ao Dreamweaver como o usuário deseja transferir os 
arquivos entre a pasta local e a pasta remota.

Os arquivos também podem ser enviados para o aplicativo Microsoft Visual SourceSafe. 
Para isso, selecione Microsoft Visual SourceSafe. (O Microsoft Visual SourceSafe é 
utilizado pelos programadores para controlar a versão dos arquivos.) Se você selecionar 
essa opção, precisará definir uma pasta separada. Para obter instruções, consulte 
“Especificar onde as páginas dinâmicas podem ser processadas” na página 667.

4. Após escolher um método de acesso, defina opções de acesso conforme apropriado.

Para obter mais informações sobre essas opções, clique no botão Help na caixa de diálogo.

A caixa de diálogo Site Definition deve ficar aberta. Em seguida, defina uma pasta para 
processar páginas dinâmicas. 

Especificar onde as páginas dinâmicas podem ser 
processadas
Após definir a pasta remota no Dreamweaver, especifique uma pasta onde as páginas 
dinâmicas possam ser processadas. O Dreamweaver usa essa pasta para gerar conteúdo 
dinâmico e para se conectar a bancos de dados enquanto o usuário trabalha.

Geralmente, o usuário especifica a pasta raiz que criou no servidor da Web (consulte “Criar 
uma pasta raiz para o aplicativo” na página 663) porque o servidor provavelmente também 
executa um servidor de aplicativos capaz de tratar de páginas dinâmicas. 

Para especificar onde o Dreamweaver pode processar as páginas dinâmicas:

1. Se a caixa de diálogo Site Definition não estiver aberta, abra-a da seguinte maneira: 
selecione Site > Manage Sites (Gerenciar sites), depois selecione o site na lista que aparece 
na caixa de diálogo Manage Sites e, finalmente, clique em Edit (Editar).

A caixa de diálogo Site Definition é exibida.

N
O

T
A

Para utilizar RDS, a pasta remota deve estar no computador com o ColdFusion.

N
O

T
A

A pasta raiz pode ser local ou remota, dependendo do local onde é executado o servidor 
da Web. 
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2. Se o assistente for exibido, clique em Advanced e selecione Testing Server (Servidor de 
teste) na lista Category (Categoria).

A caixa de diálogo Testing Server é exibida. O Dreamweaver precisa dos serviços de um 
servidor de teste para gerar e exibir o conteúdo dinâmico enquanto o usuário trabalha. O 
servidor de teste pode ser o computador local, um servidor de desenvolvimento, de testes 
ou de produção. Contanto que o servidor possa processar os tipos de páginas dinâmicas a 
serem desenvolvidas, a escolha não fará diferença. 

3. Preencha a caixa de diálogo e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Depois de definir um site do Dreamweaver, você poderá se conectar a um banco de dados.

Efetuar a conexão com um banco de 
dados
Se desejar utilizar um banco de dados com o aplicativo para a Web, será necessário antes se 
conectar a ele. Para ler uma discussão geral sobre conexões de banco de dados, consulte 
“Conexões de bancos de dados” na página 1094.

O Dreamweaver trata as conexões de banco de dados de modo distinto, dependendo da 
tecnologia de servidor escolhida. Consulte os capítulos a seguir:

■ Capítulo 24, “Conexões de banco de dados para desenvolvedores ColdFusion”, na 
página 669

■ Capítulo 25, “Conexões de banco de dados para desenvolvedores de ASP.NET”, na 
página 673

■ Capítulo 26, “Conexões de banco de dados para desenvolvedores de ASP”, na página 681
■ Capítulo 27, “Conexões de banco de dados para desenvolvedores JSP”, na página 695
■ Capítulo 28, “Conexões de banco de dados para desenvolvedores PHP”, na página 705
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CAPÍTULO 24

Conexões de banco de dados para 

desenvolvedores ColdFusion
Você pode conectar-se a bancos de dados enquanto desenvolve aplicativos do Macromedia 
ColdFusion com o Macromedia Dreamweaver 8. 

Este capítulo pressupõe que o aplicativo do ColdFusion para a Web já esteja configurado 
(consulte Capítulo 23, “Configurar um aplicativo para a Web”, na página 657). Também 
pressupõe que um banco de dados esteja configurado no computador local ou em um sistema 
ao qual você tem acesso de rede ou FTP. 

Para se conectar ao banco de dados de exemplo fornecido pelo Dreamweaver, consulte “Setup 
for Sample ColdFusion Site” (Configuração do site de exemplo do ColdFusion) na Ajuda do 
Getting Started with Dreamweaver. Para aprender mais sobre bancos de dados e conexões de 
bancos de dados, consulte Apêndice A, “Guia do iniciante em bancos de dados”, na 
página 1085.

Conectar-se a um banco de dados
Ao desenvolver um aplicativo do ColdFusion para a Web com o Dreamweaver, você se 
conecta um banco de dados, selecionando uma fonte de dados ColdFusion definida no 
Dreamweaver ou no ColdFusion Administrator, que é o console de gerenciamento do 
servidor.

Para se conectar a um banco de dados, certifique-se de que o Dreamweaver saiba onde estão 
localizadas as fontes de dados ColdFusion. Para recuperar as fontes de dados ColdFusion na 
fase de design, o Dreamweaver coloca os scripts em uma pasta no computador em que o 
ColdFusion está sendo executado. É necessário especificar essa pasta na categoria Testing 
Server (Servidor de teste) na caixa de diálogo Site Definition (Definição do site). Para obter 
mais informações, consulte “Especificar onde as páginas dinâmicas podem ser processadas” na 
página 667.

Em seguida, crie uma fonte de dados ColdFusion no Deramweaver ou no ColdFusion 
Administrator (se não existir nenhuma). Para obter mais informações, consulte “Criar ou 
modificar uma fonte de dados ColdFusion” na página 670.
669



         
Após criar uma fonte de dados ColdFusion, é possível utilizá-la no Dreamweaver para efetuar 
uma conexão ao banco de dados. Para obter mais informações, consulte “Conectar-se ao 
banco de dados no Dreamweaver” na página 671.

Criar ou modificar uma fonte de dados ColdFusion
Antes de usar as informações do banco de dados em sua página, é necessário criar uma fonte 
de dados ColdFusion. Se estiver executando o ColdFusion MX 7 ou posterior, você poderá 
criar ou modificar a fonte de dados diretamente no Dreamweaver. Se estiver executando o 
ColdFusion MX, use a console de gerenciamento do servidor, ColdFusion MX Administrator, 
para criar ou modificar a fonte de dados. Nesse caso, você ainda pode usar o Dreamweaver 
para abrir o ColdFusion MX Administrator.

Para criar ou modificar uma fonte de dados ColdFusion com o ColdFusion MX 
7 ou posterior:

1. Certifique-se de definir como servidor de teste de seu site um computador que execute 
ColdFusion MX 7 ou posterior.

Para obter mais informações, consulte “Ativar os aprimoramentos do ColdFusion” na 
página 916.

2. Abra qualquer página ColdFusion no Dreamweaver.

3. Para criar uma nova fonte de dados, clique no botão com o sinal de adição (+) no painel 
Databases (Windows > Databases) e digite os valores de parâmetro específicos ao driver do 
banco de dados na caixa de diálogo exibida.

Para obter mais informações, consulte a documentação do revendedor do driver ou 
consulte o administrador do sistema.

4. Para modificar uma fonte de dados, clique duas vezes na conexão do banco de dados no 
painel Databases e faça as alterações na caixa de diálogo de conexão que será exibida.

Você pode editar qualquer parâmetro, exceto o nome da fonte de dados. Para obter mais 
informações, consulte a documentação do revendedor do driver ou consulte o 
administrador do sistema.

N
O

T
A

O Dreamweaver só exibirá o botão de adição (+) se você estiver executando o 
ColdFusion MX 7 ou posterior.
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Para criar ou modificar uma fonte de dados ColdFusion no ColdFusion MX 6.1 
ou 6.0:

1. Abra qualquer página ColdFusion no Dreamweaver.

2. No painel Databases (Window > Databases) do Dreamweaver, clique no ícone Modify 
Data Sources (Alterar fontes de dados) da barra de ferramentas do painel.

O ColdFusion MX Administrator é exibido no navegador.
3. Efetue o logon no ColdFusion MX Administrator e crie ou modifique a fonte de dados. 

Para obter instruções, consulte Using ColdFusion (Usando o ColdFusion)  
(Ajuda > Using ColdFusion). 
É preciso fornecer determinados valores de parâmetros para criar a fonte de dados 
ColdFusion. Para obter os valores de parâmetro específicos ao driver do banco de dados, 
consulte a documentação do fornecedor do driver ou peça orientação ao administrador do 
sistema.

Uma vez criada a fonte de dados ColdFusion, é possível utilizá-la no Dreamweaver. 

Conectar-se ao banco de dados no Dreamweaver
Depois de criar uma fonte de dados ColdFusion , você poderá utilizá-la para efetuar uma 
conexão com o banco de dados no Dreamweaver.

Abra qualquer página do ColdFusion no Dreamweaver e, em seguida, abra o painel Databases 
(Bancos de dados), em Window (Janela) > Databases. As fontes de dados do ColdFusion são 
exibidas no painel.

Se as fontes de dados não forem exibidas, execute a lista de verificação no painel. Além disso, 
certifique-se de que o Dreamweaver sabe onde encontrar as fontes de dados do ColdFusion. 
Na categoria Testing Server (Servidor de teste) na caixa de diálogo Site Definition (Definição 
do site), especifique a pasta raiz do site no computador que está executando o ColdFusion. 
Para obter mais informações, consulte “Especificar onde as páginas dinâmicas podem ser 
processadas” na página 667.

Tópicos relacionados
■ Capítulo 29, “Solucionar problemas de conexões de banco de dados”, na página 709
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Editar ou excluir uma conexão de banco 
de dados
É possível editar ou excluir fontes de dados do ColdFusion no ColdFusion Administrator. No 
painel Databases (Bancos de dados)  em Window (Janela) > Databases) do Dreamweaver, 
clique no ícone Modify Data Sources (Alterar fontes de dados) da barra de ferramentas do 
painel. O ColdFusion Administrator é exibido no navegador. Efetue o logon e modifique a 
fonte de dados. Para obter instruções, consulte Using ColdFusion. 

Para evitar a ocorrência de erros após excluir ou renomear uma fonte de dados do ColdFusion, 
atualize todos os recordsets que utilizam a fonte de dados antiga no Dreamweaver clicando 
duas vezes no nome do recordset, no painel Bindings (Ligações), e escolhendo uma nova fonte 
de dados.
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CAPÍTULO 25

Conexões de banco de dados para 

desenvolvedores de ASP.NET
Para utilizar um banco de dados com um aplicativo ASP.NET, é necessário criar uma conexão 
de banco de dados no Macromedia Dreamweaver 8. Este capítulo descreve como criar a 
conexão de banco de dados. 

Este capítulo pressupõe que um aplicativo ASP.NET esteja configurado (consulte Capítulo 
23, “Configurar um aplicativo para a Web”, na página 657). Também pressupõe que um 
banco de dados esteja configurado no computador local ou em um sistema ao qual você tem 
acesso de rede ou FTP. 

Para se conectar ao banco de dados de exemplo fornecido pelo Dreamweaver, consulte “Setup 
for Sample ColdFusion Site” (Configuração do site de exemplo do ColdFusion) em Getting 
Started with Dreamweaver. Para aprender mais sobre bancos de dados e conexões de bancos de 
dados, consulte Apêndice A, “Guia do iniciante em bancos de dados”, na página 1085.

Conectar-se a um banco de dados
Esta seção descreve como se conectar a um banco de dados durante o desenvolvimento de um 
aplicativo ASP.NET no Dreamweaver.

Antes de se conectar a um banco de dados, é necessário obter um provedor de bancos de dados 
OLE (Object Linking and Embedding, incorporação e vinculação de objetos) para o banco de 
dados. Caso deseje se conectar a um banco de dados Microsoft SQL Server, é possível utilizar 
o Managed Data Provider (Provedor de dados gerenciados) para SQL Server que é fornecido 
pelo .NET Framework Software Development Kit (SDK). Para obter mais informações, 
consulte “Obter um provedor de bancos de dados OLE para o banco de dados” na 
página 674. 

N
O

T
A

Se estiver desenvolvendo aplicativos com o Microsoft Active Server Pages (ASP), 
consulte Capítulo 26, “Conexões de banco de dados para desenvolvedores de ASP”, na 
página 681.
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Uma vez instalado o provedor de banco de dados, é possível utilizá-lo para efetuar uma 
conexão ao banco de dados. Para obter instruções, consulte as seguintes seções:

■ “Criar uma conexão de banco de dados ASP.NET no Dreamweaver” na página 675
■ “Criar uma conexão utilizando a caixa de diálogo Data Link Properties (Propriedades de 

link de dados)” na página 676

Obter um provedor de bancos de dados OLE para o 
banco de dados
Um aplicativo ASP.NET deve se conectar a um banco de dados por meio de um provedor de 
bancos de dados OLE. O provedor atua como um intérprete e permite que o aplicativo 
ASP.NET se comunique com um banco de dados. Para obter mais informações sobre um 
banco de dados OLE e a função dos provedores de banco de dados, consulte “Comunicar-se 
com o banco de dados” na página 1094. 

Caso deseje se conectar a um banco de dados Microsoft SQL Server, utilize o Managed Data 
Provider para SQL Server fornecido com o .NET Framework 1.1 SDK. Esse provedor, que é 
otimizado para SQL Server e é muito veloz, é instalado durante a instalação do SDK.

Se desejar se conectar a um banco de dados que não seja o SQL Server, certifique-se da 
presença de um provedor de bancos de dados OLE instalado para o banco de dados no 
computador que está executando o .NET Framework. É possível obter um provedor de banco 
de dados OLE para Microsoft Access, efetuando o download e instalando o pacote Microsoft 
Data Access Components (MDAC) 2.7 no site da Microsoft, em http://msdn.microsoft.com/
data/mdac/downloads/.

Você pode efetuar o download dos provedores de banco de dados OLE da Oracle no site da 
Oracle, em www.oracle.com/technology/software/tech/windows/ole_db/index.html. Também 
é possível adquirir provedores de bancos de dados OLE de outros fornecedores.

Uma vez obtido um provedor para o banco de dados, é possível utilizá-lo para criar conexões 
de banco de dados no Dreamweaver. 
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Criar uma conexão de banco de dados ASP.NET no 
Dreamweaver
Depois de obter um provedor de bancos de dados OLE para o banco de dados, é possível 
utilizá-lo para criar uma conexão de banco de dados no Dreamweaver. 

Uma outra opção é utilizar a caixa de diálogo Microsoft Data Link Properties (Propriedades 
de link de dados da Microsoft), que ajuda a criar a conexão. Para obter instruções, consulte 
“Criar uma conexão utilizando a caixa de diálogo Data Link Properties (Propriedades de link 
de dados)” na página 676.

Para criar uma conexão de banco de dados para ASP.NET:

1. Abra uma página ASP.NET no Dreamweaver e, em seguida, abra o painel Databases 
(Window > Databases).

O painel exibe as conexões definidas para o site.
2. Clique no botão de adição (+) do painel e selecione OLE DB Connection (Conexão com 

banco de dados OLE) ou SQL Server Connection (Conexão de servidor SQL) no menu 
pop-up.

A caixa de diálogo OLE DB Connection (Conexão com banco de dados OLE) ou SQL 
Server Connection (Conexão de servidor SQL) é exibida.

3. Preencha a caixa de diálogo e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo. 

A nova conexão é exibida no painel Databases.

Tópicos relacionados
■ Capítulo 29, “Solucionar problemas de conexões de banco de dados”, na página 709

N
O
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Selecione SQL Server Connection somente se desejar se conectar a um banco de 
dados Microsoft SQL Server.
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Criar uma conexão utilizando a caixa de diálogo Data 
Link Properties (Propriedades de link de dados) 
Após obter um provedor de banco de dados OLE para o banco de dados (consulte “Obter um 
provedor de bancos de dados OLE para o banco de dados” na página 674), você pode criar 
uma conexão de banco de dados utilizando a caixa de diálogo Data Link Properties no 
Windows. 

Importante: É possível utilizar este método somente se o provedor de bancos de dados OLE 
que deseja utilizar estiver instalado no mesmo computador com o Windows que o 
Dreamweaver.

Para criar uma conexão de banco de dados utilizando a caixa de diálogo Data 
Link Properties:

1. Abra uma página ASP.NET no Dreamweaver e, em seguida, abra o painel Databases 
(Window > Databases).

O painel exibe as conexões definidas para o site.
2. Clique no botão de adição (+) no painel e selecione OLE DB Connection (Conexão com 

banco de dados OLE) no menu pop-up.

É exibida a caixa de diálogo OLE DB Connection.
3. Clique no botão Build (Construir).

A caixa de diálogo Data Link Properties é exibida. Esta caixa de diálogo do Windows exibe 
os provedores de bancos de dados OLE existentes no computador com o Windows que 
está executando o Dreamweaver.

4. Preencha a caixa de diálogo Data Link Properties e clique em OK.

O Dreamweaver insere uma seqüência de caracteres de conexão na caixa de diálogo OLE 
DB Connection. 

5. Clique em Test (Testar).

O Dreamweaver tentará estabelecer a conexão com o banco de dados. Se a conexão falhar, 
verifique novamente a seqüência de caracteres de conexão. Se a conexão continuar 
falhando, verifique as configurações da pasta que o Dreamweaver usa para processar 
páginas dinâmicas (consulte “Especificar onde as páginas dinâmicas podem ser 
processadas” na página 667).

6. Clique em OK.

A nova conexão é exibida no painel Databases.

Tópicos relacionados
■ Capítulo 29, “Solucionar problemas de conexões de banco de dados”, na página 709
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Parâmetros de conexão com banco de dados OLE 
de exemplo para ASP.NET
Uma seqüência de caracteres de conexão com o banco de dados OLE combina todas as 
informações de que o aplicativo ASP.NET precisa para se conectar a um banco de dados. O 
Dreamweaver insere essa seqüência de caracteres nos scripts de servidor da página para 
posterior processamento pelo servidor de aplicativos.

O Dreamweaver fornece modelos de seqüências de caracteres para criar seqüências de 
caracteres de conexão com o banco de dados OLE para aplicativos ASP.NET (consulte “Criar 
uma conexão de banco de dados ASP.NET no Dreamweaver” na página 675). Para criar uma 
seqüência de caracteres de conexão, substitua os alocadores de espaço do modelo pelos valores 
de parâmetros solicitados. Esta seção exibe parâmetros de exemplo para bancos de dados 
Microsoft Access e SQL Server.

Caso 1: O .NET Framework está instalado no computador local e o usuário deseja se conectar 
a um banco de dados Microsoft Access chamado sdSchool.mdb e localizado nesta pasta do 
disco rígido: c:\Inetpub\wwwroot\SkyDiveSchool\data\sdSchool.mdb. Aqui estão os 
parâmetros necessários para criar esta seqüência de caracteres de conexão:
Provider=Microsoft.Jet.OLEDB.4.0;
Data Source=c:\Inetpub\wwwroot\SkyDiveSchool\data\sdSchool.mdb;

Caso 2: O .NET Framework é utilizado em um servidor de desenvolvimento remoto e o 
usuário deseja se conectar a um banco de dados Microsoft Access chamado mtnSchool.mdb e 
localizado nesta pasta do servidor: 
d:\users\tara\projects\MtnDrivingSchool\data\mtnSchool.mdb. Aqui estão os parâmetros 
necessários para criar a seqüência de caracteres de conexão:
Provider=Microsoft.Jet.OLEDB.4.0;
Data Source=d:\users\tara\projects\MtnDrivingSchool\data\mtnSchool.mdb;

N
O

T
A

Para obter os valores de parâmetros específicos a outros bancos de dados, consulte a 
documentação do revendedor do banco de dados ou consulte o administrador do 
sistema.
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Caso 3: Suponha que você use o .NET Framework em um servidor de desenvolvimento em 
rede chamado Savant e deseje conectar-se a um banco de dados Microsoft SQL Server 
chamado pubs no servidor. Seu nome de usuário do SQL Server é “sa” e não existe uma senha. 
Se for utilizado o Managed Data Provider (Provedor de dados gerenciados) para SQL Server, 
ou seja, se você tiver escolhido a opção SQL Connection (Conexão SQL) no painel Databases 
(Bancos de dados), aqui estão os parâmetros necessários para criar a seqüência de caracteres de 
conexão:
Data Source=Savant;
Initial Catalog=pubs;
User ID=sa;
Password=;

Editar ou excluir uma conexão de banco 
de dados
Quando você cria uma conexão de banco de dados, o Dreamweaver armazena as informações 
de conexão em um arquivo de inclusão na subpasta Connections (Conexões) localizada na 
pasta raiz local do site. Você pode editar ou excluir as informações de conexão do arquivo 
manualmente ou como a seguir. 

Para atualizar uma conexão:

1. Abra uma página ASP.NET no Dreamweaver e, em seguida, abra o painel Databases, em 
Window  >  Databases.

Uma lista de conexões é exibida no painel. 
2. Clique com o botão direito do mouse (no Windows) ou pressione a tecla Control (no 

Macintosh) e clique na conexão desejada. Em seguida, selecione Edit Connection (Editar 
conexão) no menu pop-up. 

A caixa de diálogo utilizada para criar a conexão é exibida.
3. Faça as alterações e clique em OK.

O Dreamweaver atualiza automaticamente o arquivo de inclusão que, por sua vez, atualiza 
automaticamente todas as páginas do site que estiverem utilizando a conexão.

Se você renomear uma conexão, atualize todos os DataSets que utilizam o nome antigo da 
conexão. Para isso, clique duas vezes no recordset no painel Bindings (Ligações) e escolha um 
novo nome de conexão na caixa de diálogo DataSet. 
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Para excluir uma conexão:

1. Abra uma página ASP.NET no Dreamweaver e, em seguida, abra o painel Databases 
(Window > Databases).

Uma lista de conexões é exibida no painel. 
2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 

pressionada (no Macintosh) e clique na conexão desejada. Em seguida, selecione Delete 
Connection (Excluir a conexão) no menu pop-up. 

A caixa de diálogo utilizada para criar a conexão é exibida.
3. Confirme se deseja excluir a conexão.

N
O
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Para evitar a ocorrência de erros após excluir uma conexão, atualize todos os 
DataSets que utilizam a conexão antiga. Para isso, clique duas vezes no nome do 
DataSet no painel Bindings e escolha uma nova conexão na caixa de diálogo 
DataSet. 
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CAPÍTULO 26

Conexões de banco de dados 
para desenvolvedores de ASP
Para utilizar um banco de dados com um aplicativo Active Server Pages (ASP) da Microsoft, é 
necessário criar uma conexão de banco de dados no Macromedia Dreamweaver 8. Este 
capítulo descreve como criar a conexão de banco de dados.

Este capítulo pressupõe que um aplicativo ASP já esteja configurado (consulte Capítulo 23, 
“Configurar um aplicativo para a Web”, na página 657). Também pressupõe que um banco de 
dados esteja configurado no computador local ou em um sistema ao qual você tem acesso de 
rede ou FTP. 

Para se conectar ao banco de dados de exemplo fornecido pelo Dreamweaver, consulte “Setup 
for Sample ASP Site” in Getting Started with Dreamweaver. Para aprender mais sobre bancos 
de dados e conexões de bancos de dados, consulte Apêndice A, “Guia do iniciante em 
bancos de dados”, na página 1085.

Sobre conexões de banco de dados no 
ASP
Um aplicativo ASP deve conectar-se a um banco de dados por meio de um driver ODBC ou 
um provedor de banco de dados OLE. A criação de uma conexão de banco de dados OLE 
pode aumentar a velocidade de conexão.

N
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A

Se estiver desenvolvendo aplicativos ASP.NET, consulte Capítulo 25, “Conexões de 
banco de dados para desenvolvedores de ASP.NET”, na página 673.
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Conexões de banco de dados ASP
Um aplicativo ASP deve se conectar a um banco de dados por meio de um driver ODBC 
(Open Database Connectivity, conectividade aberta de banco de dados,) ou de um provedor 
de banco de dados OLE (Object Linking and Embedding, incorporação e vinculação de 
objetos). O driver ou provedor atua como um intérprete que permite ao aplicativo para a Web 
comunicar-se com o banco de dados. Para obter mais informações sobre a função dos drivers 
de banco de dados, consulte “Comunicar-se com o banco de dados” na página 1094. A tabela 
a seguir mostra alguns drivers que podem ser utilizados com bancos de dados Microsoft 
Access, Microsoft SQL Server e Oracle:

É possível utilizar um DSN (nome de fonte de dados) ou uma seqüência de caracteres de 
conexão para se conectar ao banco de dados. 

DSN é um identificador formado por uma única palavra (por exemplo: Acme), direcionado 
ao banco de dados, que contém todas as informações necessárias para conectar-se a este. O 
DSN é definido no Windows. É possível utilizar um DSN para se conectar por meio de um 
driver ODBC instalado no sistema Windows. Para obter instruções detalhadas, consulte 
“Criar uma conexão DSN” na página 684.

Uma seqüência de caracteres de conexão é uma expressão codificada manualmente que 
identifica o banco de dados e lista as informações necessárias para se conectar a ele. Eis um 
exemplo:
Driver={SQL Server};Server=Socrates;Database=AcmeMktg;
UID=wiley;PWD=roadrunner

É necessário utilizar uma seqüência de caracteres de conexão se estiver se conectando por meio 
de um destes recursos:

■ Um provedor de bancos de dados OLE
■ Um driver ODBC não instalado no sistema Windows

Para obter instruções detalhadas, consulte as seções a seguir:

■ “Criação de uma conexão sem DSN” na página 688

Banco de dados Driver de banco de dados

Microsoft Access Driver (ODBC) do Microsoft Access
Microsoft Jet Provider para Access (de banco de dados OLE)

Microsoft SQL 
Server

Driver (ODBC) do Microsoft SQL Server
Provedor (de banco de dados OLE) do Microsoft SQL Server

Oracle Driver (ODBC) da Microsoft para bancos de dados Oracle
Provedor de bancos de dados OLE da Oracle
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■ “Efetuar a conexão com um banco de dados através de um ISP” na página 689

conexões de banco de dados OLE 
É possível utilizar um provedor de bancos de dados OLE para se comunicar com o banco de 
dados. A criação de uma conexão específica de banco de dados OLE direta pode aumentar a 
velocidade da conexão, uma vez que elimina a camada ODBC entre o aplicativo para a Web e 
o banco de dados.

Se não for especificado um provedor de banco de dados OLE para o banco de dados, o ASP 
utilizará o provedor de banco de dados OLE padrão para drivers ODBC para se comunicar 
com um driver ODBC, que, por sua vez, se comunicará com o banco de dados. 

O banco de dados OLE está disponível somente no Windows NT, 2000 ou XP.

Há outros provedores de bancos de dados OLE para bancos de dados distintos. É possível 
obter provedores de bancos de dados OLE para o Microsoft Access e SQL Server, efetuando o 
download e instalando os pacotes Microsoft Data Access Components (MDAC) 2.5 e 2.7 no 
computador Windows que está executando o IIS. É possível fazer gratuitamente o download 
dos pacotes MDAC no site da Microsoft, em http://msdn.microsoft.com/data/mdac/
downloads/.

Você pode efetuar o download dos provedores de banco de dados OLE da Oracle no site da 
Oracle, em www.oracle.com/technology/software/tech/windows/ole_db/index.html (o 
registro é obrigatório).

No Dreamweaver, é possível criar uma conexão de banco de dados OLE incluindo o 
parâmetro Provider em uma seqüência de caracteres de conexão (consulte “Criação de uma 
conexão sem DSN” na página 688). A seguir, alguns exemplos de parâmetros de provedores 
de bancos de dados OLE conhecidos para bancos de dados Access, SQL Server e Oracle, 
respectivamente:
Provider=Microsoft.Jet.OLEDB.4.0;...
Provider=SQLOLEDB;...
Provider=OraOLEDB;...

N
O

T
A

Também é possível utilizar uma seqüência de caracteres de conexão se estiver se 
conectando por meio de um driver ODBC instalado no sistema Windows, mas a 
utilização de um DSN facilita a conexão.

N
O

T
A

Certifique-se de instalar o MDAC 2.5 antes de instalar o MDAC 2.7.
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Para obter o valor do parâmetro do provedor de bancos de dados OLE, consulte a 
documentação do revendedor do provedor ou consulte o administrador do sistema.

Tópicos relacionados
■ “Criação de uma conexão sem DSN” na página 688

Criar uma conexão DSN 
É possível utilizar um DSN para criar uma conexão ODBC entre o aplicativo para a Web e o 
banco de dados. Um DSN é um nome que contém todos os parâmetros necessários para se 
conectar a um determinado banco de dados utilizando um driver ODBC. Para obter mais 
informações, consulte “Usar um DSN” na página 1099.

É possível definir o DSN em um computador com o Windows local ou remoto. 

Tópicos relacionados
■ “Criação de uma conexão sem DSN” na página 688

Criar uma conexão utilizando um DSN local
É possível utilizar um DSN definido localmente para criar uma conexão com um banco de 
dados no Dreamweaver. Se desejar utilizar um DSN local, o DSN deve ser definido em um 
computador com o Windows no qual o Dreamweaver está em execução.

Para criar uma conexão de banco de dados com um DSN definido localmente:

1. Defina um DSN no computador com o Windows no qual o Dreamweaver está em 
execução.

Para obter instruções, consulte os seguintes artigos no site da Microsoft na Web:
■ Se o sistema operacional sendo usado for o o Windows 2000, consulte o Artigo 

300596 do Microsoft Knowledge Base, em http://support.microsoft.com/
default.aspx?scid=kb;en-us;300596 

■ Se o sistema operacional sendo usado for o o Windows XP, consulte o Artigo 305599 
do Microsoft Knowledge Base, em http://support.microsoft.com/
default.aspx?scid=kb;en-us;305599 

N
O

T
A

Uma vez que se pode especificar somente um driver ODBC em um DSN, é necessário 
utilizar uma seqüência de caracteres de conexão se desejar utilizar um provedor de 
bancos de dados OLE. Para obter mais informações, consulte “conexões de banco de 
dados OLE” na página 683.
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2. Abra uma página ASP no Dreamweaver e, em seguida, abra o painel Databases, em 
Window> Databases.

O Dreamweaver exibe todas as conexões definidas para o site.
3. Clique no botão de adição (+) no painel e selecione Data Source Name (DSN) no 

menu pop-up.

A caixa de diálogo Data Source Name (DSN) é exibida. 

4. Digite um nome para a nova conexão.

5. Selecione a opção Using Local DSN (Utilizando o DSN local) na parte inferior da caixa de 
diálogo.

6. Selecione o DSN desejado no menu pop-up Data Source Name (DSN).

Caso deseje utilizar um DSN local que ainda não foi definido, clique em Define (Definir) 
para abrir o Windows ODBC Data Source Administrator (Administrador de fontes de 
dados ODBC do Windows). Para obter instruções, consulte “Criar uma conexão DSN” 
na página 684.

7. Se necessário, preencha as caixas User Name (Nome do usuário) e Password (Senha).

8. Se desejar, é possível limitar o número de itens de banco de dados que o Dreamweaver 
recupera na fase de design. Para isso, clique em Advanced (Avançado) e digite um nome de 
esquema ou de catálogo.

Para obter mais informações, consulte “Restringir uma informação do banco de dados no 
Dreamweaver” na página 733.

N
O

T
A

Não utilize espaços ou caracteres especiais no nome.

N
O

T
A

Não é possível criar um esquema ou catálogo no Microsoft Access.
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9. Clique em Test (Testar).

O Dreamweaver tentará estabelecer a conexão com o banco de dados. Se a conexão falhar, 
verifique novamente o DSN. Se a conexão continuar falhando, verifique as configurações 
da pasta que o Dreamweaver usa para processar páginas dinâmicas (consulte “Especificar 
onde as páginas dinâmicas podem ser processadas” na página 667).

10. Clique em OK.

A nova conexão é exibida no painel Databases.

Tópicos relacionados
■ “Criação de uma conexão sem DSN” na página 688
■ Capítulo 29, “Solucionar problemas de conexões de banco de dados”, na página 709

Criar uma conexão utilizando um DSN remoto
É possível utilizar um DSN definido em um computador remoto para criar uma conexão com 
um banco de dados no Dreamweaver. Se desejar utilizar um DSN remoto, o DSN deve ser 
definido em um computador com o Windows no qual o servidor de aplicativos está sendo 
executado (provavelmente um servidor IIS).

Para criar uma conexão de banco de dados com um DSN definido 
remotamente:

1. Defina um DSN no sistema remoto que estiver executando o servidor de aplicativos.

Para obter instruções, consulte os seguintes artigos no site da Microsoft na Web:
■ Se o sistema operacional sendo executado no computador remoto for o Windows 

2000, consulte o Artigo 300596 do Microsoft Knowledge Base, em http://
support.microsoft.com/default.aspx?scid=kb;en-us;300596 

■ Se o sistema operacional sendo executado no computador remoto for o Windows XP, 
consulte o Artigo 305599 do Microsoft Knowledge Base, em http://
support.microsoft.com/default.aspx?scid=kb;en-us;305599 

2. Abra uma página ASP no Dreamweaver e, em seguida, abra o painel Databases, em 
Window> Databases.

O Dreamweaver exibe todas as conexões definidas para o site.
3. Clique no botão de adição (+) no painel e selecione Data Source Name (DSN) no 

menu pop-up.

A caixa de diálogo Data Source Name (DSN) é exibida.
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4. Digite um nome para a nova conexão.

5. Selecione a opção Using DSN on Testing Server (Utilizando o DSN no servidor de teste) 
na parte inferior da caixa de diálogo.

Os usuários do Macintosh podem ignorar esta etapa, pois todas as conexões de banco de 
dados utilizam DSNs no servidor de aplicativos.

6. Digite o DSN.

Você pode clicar no botão DSN para se conectar ao servidor e selecionar os DSNs 
definidos nele. 

7. Se necessário, preencha as caixas User Name (Nome do usuário) e Password (Senha).

8. Se desejar, é possível limitar o número de itens de banco de dados a serem recuperados pelo 
Dreamweaver na fase de design. Para isso, clique em Advanced (Avançado) e digite um 
nome de esquema ou catálogo.

Para obter mais informações, consulte “Restringir uma informação do banco de dados no 
Dreamweaver” na página 733.

9. Clique em Test (Testar).

O Dreamweaver tentará estabelecer a conexão com o banco de dados. Se a conexão falhar, 
verifique novamente o DSN. Se a conexão continuar falhando, verifique as configurações 
da pasta que o Dreamweaver usa para processar páginas dinâmicas (consulte “Especificar 
onde as páginas dinâmicas podem ser processadas” na página 667).

10. Clique em OK.

A nova conexão é exibida no painel Databases.

Tópicos relacionados
■ “Criar uma conexão utilizando um DSN local” na página 684
■ Capítulo 29, “Solucionar problemas de conexões de banco de dados”, na página 709

N
O

T
A

Não utilize espaços ou caracteres especiais no nome.

N
O

T
A

Não é possível criar um esquema ou catálogo no Microsoft Access.
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Criação de uma conexão sem DSN 
É possível utilizar uma conexão sem DSN para criar uma conexão de banco de dados ODBC 
ou OLE entre o aplicativo para a Web e o banco de dados. Para criar esse tipo de conexão, usa-
se uma seqüência de caracteres de conexão. Uma seqüência de caracteres de conexão combina 
todas as informações de que o aplicativo da Web precisa para se conectar a um banco de 
dados. 

Para criar uma conexão sem DSN:

1. Abra uma página ASP no Dreamweaver e, em seguida, abra o painel Databases, em 
Window> Databases.

O Dreamweaver exibe todas as conexões definidas para o site, se houver alguma.
2. Clique no botão de adição (+) do painel e selecione Custom Connection String (Seqüência 

personalizada de caracteres) no menu pop-up.

Será exibida a caixa de diálogo Custom connection string. 

3. Preencha a caixa de diálogo e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Tópicos relacionados
■ “conexões de banco de dados OLE” na página 683
■ “Utilizar um caminho virtual para se conectar a um banco de dados” na página 691
■ Capítulo 29, “Solucionar problemas de conexões de banco de dados”, na página 709
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Efetuar a conexão com um banco de 
dados através de um ISP
Se você é um programador ASP e trabalha com um Provedor de serviços de Internet (ISP) 
comercial, é possível que não conheça o caminho físico do upload de seus arquivos, nem 
mesmo para o(s) arquivo(s) de seu banco de dados. Se o provedor Internet não definir um 
DSN para você ou se demorar a fazê-lo, será necessário encontrar uma outra forma de criar as 
conexões com os arquivos de banco de dados. Uma alternativa é criar uma conexão sem DSN 
com um arquivo de banco de dados, mas somente será possível definir esta conexão se o 
usuário souber o caminho físico do arquivo de banco de dados no servidor do ISP.

Esta seção descreve como obter o caminho físico de um arquivo de banco de dados em um 
servidor, utilizando o método MapPath do objeto de servidor ASP. 

Os caminhos físicos e virtuais
Após utilizar o Dreamweaver para efetuar o upload dos arquivos em um servidor remoto, os 
arquivos são armazenados em uma pasta na árvore de diretórios locais do servidor. Por 
exemplo: em um servidor com o Microsoft IIS, o caminho para a página inicial será este:
c:\Inetpub\wwwroot\accounts\users\jsmith\index.htm

Este caminho é conhecido como o caminho físico do arquivo. 

No entanto, a URL utilizada para abrir o arquivo não utiliza o caminho físico. Ela utiliza o 
nome do servidor ou domínio seguido de um caminho virtual, como no exemplo a seguir:
www.plutoserve.com/jsmith/index.htm

O caminho virtual, /jsmith/index.htm, representa o caminho físico, 
c:\Inetpub\wwwroot\accounts\users\jsmith\index.htm.

Tópicos relacionados
■ “Utilizar um caminho virtual para se conectar a um banco de dados” na página 691

N
O

T
A

As técnicas apresentadas neste capítulo só serão aplicáveis se o banco de dados se 
basear em arquivos, como no caso de um banco de dados Microsoft Access no qual os 
dados são armazenados em um arquivo .mdb.
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Localizar o caminho físico de um arquivo com o 
caminho virtual
Se você tiver uma conta em um provedor Internet, é possível que não saiba o caminho físico 
dos arquivos carregados. Os ISPs normalmente fornecem um host FTP, possivelmente um 
diretório do host, bem como um nome e uma senha para efetuar logon. Eles também 
especificam uma URL que permite exibir suas páginas na Internet, como 
www.plutoserve.com/jsmith/.

Se você souber a URL, poderá obter o caminho virtual do arquivo, ou seja, o caminho que 
acompanha o nome do servidor ou domínio em uma URL. Uma vez conhecido o caminho 
virtual, é possível obter o caminho físico do arquivo no servidor por meio do método 
MapPath.

Entre outras coisas, o método MapPath considera o caminho virtual como um argumento e 
retorna o caminho físico do arquivo e seu nome. A seguir, a sintaxe do método:
Server.MapPath("/virtualpath")

Suponha que o caminho virtual de um arquivo seja /jsmith/index.htm. A expressão a seguir 
retornará o caminho físico:
Server.MapPath("/jsmith/index.htm")

É possível tentar utilizar o método MapPath da seguinte maneira: 

1. Abra uma página ASP no Dreamweaver e alterne para a visualização do código em View 
(Exibir) > Code (Código).

2. Digite a expressão a seguir no código HTML da página.
<%Response.Write(stringvariable)%>

3. Use o método MapPath para obter um valor para o argumento stringvariable. 

Por exemplo:
<% Response.Write(Server.MapPath("/jsmith/index.htm")) %>

4. Alterne para a Design view (View > Design) e ative o Live Data (View > Live Data) para 
exibir a página.

A página exibe o caminho físico do arquivo no servidor de aplicativos. Utilizando o 
exemplo desta seção, a página exibe este caminho físico:
c:\Inetpub\wwwroot\accounts\users\jsmith\index.htm

Para obter mais informações sobre o método MapPath, consulte a documentação on-line que 
acompanha o Microsoft IIS. 

Tópicos relacionados
■ “Os caminhos físicos e virtuais” na página 689
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Utilizar um caminho virtual para se conectar a um 
banco de dados
Para gravar uma seqüência de caracteres de conexão sem DSN em um arquivo de banco de 
dados localizado em um servidor remoto, é necessário conhecer o caminho físico do arquivo. 
O exemplo a seguir é uma seqüência de caracteres de conexão sem DSN típica para um banco 
de dados Microsoft Access:
Driver={Microsoft Access Driver (*.mdb)};
DBQ=c:\Inetpub\wwwroot\accounts\users\jsmith\data\statistics.mdb

Se você não souber o caminho físico dos arquivos existentes no servidor remoto, é possível 
obtê-lo utilizando o método MapPath na seqüência de caracteres de conexão.

Para criar uma conexão sem DSN utilizando o método MapPath: 

1. Efetue o upload do arquivo de banco de dados no servidor remoto.

Anote o caminho virtual do arquivo (por exemplo, /jsmith/data/statistics.mdb).
2. Abra uma página ASP no Dreamweaver e, em seguida, abra o painel Databases, em 

Window> Databases.

O Dreamweaver exibe todas as conexões definidas para o site.
3. Clique no botão de adição (+) do painel e selecione Custom Connection String no 

menu pop-up.

4. Digite um nome para a nova conexão. 

5. Digite a seqüência de caracteres de conexão e utilize o método MapPath para fornecer o 
parâmetro DBQ.

Suponha que o caminho virtual do banco de dados Microsoft Access seja /jsmith/data/
statistics.mdb. A seqüência de caracteres de conexão pode ser expressa como a seguir se o 
VBScript for utilizado como linguagem de scripts:
“Driver={Microsoft Access Driver (*.mdb)};DBQ=” & Server.MapPath¬
("/jsmith/data/statistics.mdb")

O ‘E’ comercial (&) é utilizado para concatenar (combinar) duas seqüências de caracteres. 
A primeira seqüência de caracteres está entre aspas, e a segunda é retornada pela expressão 
Server.MapPath. Quando as duas seqüências de caracteres são combinadas, é criada esta 
seqüência de caracteres:
Driver={Microsoft Access Driver (*.mdb)};
DBQ=C:\Inetpub\wwwroot\accounts\users\jsmith\data\statistics.mdb

N
O

T
A

Não utilize espaços ou caracteres especiais no nome.
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Se você utilizar o JavaScript, a expressão será idêntica, exceto pelo uso de um sinal de 
adição (+) no lugar do ‘E’ comercial (&) para concatenar as duas seqüências de caracteres:
“Driver={Microsoft Access Driver (*.mdb)};DBQ=” + Server.MapPath¬
("/jsmith/data/statistics.mdb")

6. Selecione a opção Using Driver On Testing Server (Utilizando o driver no servidor de 
teste).

Os usuários do Macintosh podem ignorar esta etapa, pois todas as conexões de banco de 
dados utilizam o servidor de aplicativos.

7. Clique em Test (Testar).

O Dreamweaver tentará estabelecer a conexão com o banco de dados. Se a conexão falhar, 
verifique novamente a seqüência de caracteres de conexão. 
Se ainda assim a conexão falhar, entre em contato com o ISP para certificar-se de que o 
driver de banco de dados especificado na seqüência de caracteres de conexão foi instalado 
no servidor remoto. Verifique também se o ISP possui a versão mais recente do driver. Por 
exemplo: um banco de dados criado no Microsoft Access 2000 não funcionará com o 
Microsoft Access Driver 3.5. É necessário um Microsoft Access Driver 4.0 ou mais 
avançado.

8. Clique em OK.

A nova conexão é exibida no painel Databases. 
9. Atualize a conexão de banco de dados das páginas dinâmicas existentes e utilize a nova 

conexão com qualquer página nova que for criada. 

Para atualizar a conexão de uma página dinâmica, abra a página no Dreamweaver, clique 
duas vezes no nome do recordset localizado no painel Bindings (Ligações) ou no painel 
Server Behaviors (Comportamentos de servidor) e, no menu pop-up Connection 
(Conexão), selecione a conexão recém-criada. 

Tópicos relacionados
■ “Os caminhos físicos e virtuais” na página 689
■ “Localizar o caminho físico de um arquivo com o caminho virtual” na página 690
■ “Criação de uma conexão sem DSN” na página 688
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Editar ou excluir uma conexão de banco 
de dados
Quando você cria uma conexão de banco de dados, o Dreamweaver armazena as informações 
de conexão em um arquivo de inclusão na subpasta Connections (Conexões) localizada na 
pasta raiz local do site. Você pode editar ou excluir as informações de conexão do arquivo 
manualmente ou como a seguir.

Para atualizar uma conexão:

1. Abra uma página ASP no Dreamweaver e, em seguida, abra o painel Databases, em 
Window> Databases.

Uma lista de conexões é exibida no painel. 
2. Clique com o botão direito do mouse (no Windows) ou pressione a tecla Control (no 

Macintosh) e clique na conexão desejada. Em seguida, selecione Edit Connection (Editar 
conexão) no menu pop-up.

A caixa de diálogo utilizada para criar a conexão é exibida.
3. Faça as alterações e clique em OK.

O Dreamweaver atualiza automaticamente o arquivo da inclusão que, por sua vez, atualiza 
todas as páginas do site que estiverem utilizando a conexão.

Para excluir uma conexão:

1. Abra uma página ASP no Dreamweaver e, em seguida, abra o painel Databases, em 
Window> Databases.

Uma lista de conexões é exibida no painel. 
2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 

pressionada (no Macintosh) e clique na conexão desejada. Em seguida, selecione Delete 
Connection (Excluir a conexão) no menu pop-up. 

A caixa de diálogo utilizada para criar a conexão é exibida.
3. Confirme se deseja excluir a conexão.

N
O

T
A

Para evitar a ocorrência de erros após excluir uma conexão, atualize todos os 
recordsets que utilizam a conexão antiga, clicando duas vezes no nome do recordset 
no painel Bindings (Ligações) escolhendo uma nova conexão. 
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27

CAPÍTULO 27

Conexões de banco de dados 
para desenvolvedores JSP
Para utilizar um banco de dados com aplicativos JavaServer Pages (JSP), é necessário criar uma 
conexão de banco de dados no Macromedia Dreamweaver 8. Este capítulo descreve como 
criar a conexão.

Este capítulo pressupõe que um aplicativo JSP já esteja configurado (consulte Capítulo 23, 
“Configurar um aplicativo para a Web”, na página 657). Também pressupõe que um banco de 
dados tenha sido configurado no computador local ou em um sistema ao qual o usuário tem 
acesso de rede ou FTP. 

Para se conectar ao banco de dados de exemplo fornecido pelo Dreamweaver, consulte “Setup 
for Sample ASP Site” em Getting Started with Dreamweaver. Para aprender mais sobre bancos 
de dados e conexões de bancos de dados, consulte Apêndice A, “Guia do iniciante em 
bancos de dados”, na página 1085.

Sobre conexões de banco de dados no 
JSP
Um aplicativo JSP deve se conectar a um banco de dados por meio de um driver JDBC. O 
driver atua como intérprete e permite que o aplicativo JSP se comunique com um banco de 
dados. 

Conexões JSP
Um aplicativo JSP deve se conectar a um banco de dados por meio de um driver JDBC. Para 
obter mais informações sobre JDBC e a função dos drivers de banco de dados, consulte 
“Comunicar-se com o banco de dados” na página 1094. 

É necessário especificar determinados valores de parâmetros para efetuar uma conexão por 
meio de um driver JDBC. Para obter mais informações, consulte “Parâmetros de conexão 
JDBC” na página 696. Para obter os valores de parâmetros específicos ao driver, consulte a 
documentação do revendedor do driver ou consulte o administrador do sistema.
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Também é possível utilizar um driver ODBC (Open Database Connectivity, Conectividade 
aberta de banco de dados), ou DSN no Windows, se houver um bridge driver JDBC-ODBC. 
Para obter mais informações, consulte “Conectar-se através de um driver ODBC” na 
página 699.

Parâmetros de conexão JDBC 
Ao criar uma conexão de banco de dados JSP no Dreamweaver, geralmente você precisa 
digitar os parâmetros de conexão. Consulte “Criar uma conexão de banco de dados para JSP” 
na página 698. Normalmente, as conexões JDBC são formadas por quatro parâmetros: o 
driver, o nome do usuário, a senha e a URL (que especifica a localização do banco de dados). 
Em geral, os valores do parâmetro do driver e do parâmetro da URL dependem do driver.

Esta seção demonstra como definir parâmetros de conexão no Dreamweaver, utilizando o 
driver Oracle Thin JDBC como exemplo. Para obter os parâmetros de conexão de outros 
drivers, consulte a documentação do revendedor do driver.

O driver Oracle Thin JDBC oferece suporte aos bancos de dados Oracle. Caso deseje utilizar 
esse driver para se conectar ao banco de dados Oracle, clique no botão de adição (+) no painel 
Databases (Bancos de dados) e selecione Oracle Thin Driver (Oracle) no menu pop-up. A 
caixa de diálogo exibida a seguir é mostrada parcialmente completa: 

Digite um nome de conexão e substitua os alocadores de espaço (entre colchetes) por 
parâmetros de conexão válidos. Para o alocador de espaço [hostname], digite o endereço IP 
ou nome atribuído ao servidor de banco de dados pelo administrador do sistema. Para o 
alocador de espaço [sid], digite o identificador do sistema de banco de dados. Se houver mais 
de um banco de dados Oracle em execução no mesmo sistema, utilize o valor de SID para 
diferenciá-los.
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Por exemplo, se o servidor se chamar Aristóteles, a porta do banco de dados for 1521 e o SID 
definido para o banco de dados for patients naquele servidor, você deverá digitar os 
seguintes valores de parâmetro no Dreamweaver: 

Conectar-se a um banco de dados
Esta seção descreve como se conectar a um banco de dados durante o desenvolvimento de um 
aplicativo JSP no Dreamweaver.

Esta seção pressupõe que um aplicativo JSP esteja funcionando em um computador local ou 
remoto. Para obter mais informações, consulte “Configurar um aplicativo para a Web” na 
página 657.

Antes de se conectar a um banco de dados, é necessário obter um driver JDBC para o banco 
de dados. Para obter mais informações, consulte “Obter um driver JDBC para o banco de 
dados” na página 697. 

Após instalar o driver de banco de dados, é possível se conectar ao banco de dados. Para obter 
instruções, consulte “Criar uma conexão de banco de dados para JSP” na página 698.

Obter um driver JDBC para o banco de dados
Certifique-se da presença de um driver JDBC para o banco de dados antes de tentar criar uma 
conexão de banco de dados. Alguns drivers JDBC comuns são o driver Oracle Thin JDBC, 
Oracle Java Driver e os drivers i-net JDBC para Microsoft SQL Server.

Revendedores de sistemas de banco de dados como a Oracle normalmente já incluem os 
drivers em seus sistemas. Também é possível adquirir os drivers de outros revendedores. Por 
exemplo, é possível obter um driver JDBC para o Microsoft SQL Server a partir do software i-
net em www.inetsoftware.de/products/jdbc/.

A Sun também fornece um banco de dados para pesquisar drivers JDBC e seus respectivos 
revendedores no site da Web da empresa, em http://developers.sun.com/product/jdbc/drivers.
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Uma vez instalado o driver JDBC para o banco de dados, é possível criar uma conexão de 
banco de dados. 

Tópicos relacionados
■ “Instalar o bridge driver JDBC-ODBC da Sun” na página 700
■ “Comunicar-se com o banco de dados” na página 1094

Criar uma conexão de banco de dados para JSP
Após instalar o driver JDBC apropriado para o banco de dados no computador com o 
servidor de aplicativos , é possível criar uma conexão de banco de dados no Dreamweaver. 

Para criar uma conexão de banco de dados para JSP:

1. Abra uma página JSP no Dreamweaver e, em seguida, abra o painel Databases em Window 
> Databases.

O Dreamweaver exibe as conexões definidas para o site.
2. Clique no botão de adição (+) e selecione um driver no menu pop-up.

Se o driver não estiver listado, selecione Custom JDBC Connection (Conexão JDBC 
personalizada).
Uma caixa de diálogo de conexão é exibida. 

3. Digite os parâmetros de conexão na caixa de diálogo de conexão.

Para obter mais informações, consulte “Parâmetros de conexão JDBC” na página 696.
4. Especifique a localização do driver JDBC que deseja utilizar.

■ Se o driver JDBC estiver instalado no mesmo computador que o Dreamweaver, 
selecione a opção Using Driver On This Machine (Utilizando o driver nesta máquina). 

■ Se o driver JDBC não estiver instalado no mesmo computador que o Dreamweaver, 
selecione a opção Using Driver On Testing Server (Utilizando o driver no servidor de 
teste).

Os usuários do Macintosh podem ignorar esta etapa, pois todas as conexões de banco de 
dados utilizam o servidor de aplicativos.

5. Clique em Test (Testar).

O Dreamweaver tentará estabelecer a conexão com o banco de dados. Se a conexão falhar, 
verifique os parâmetros de conexão novamente. Se a conexão continuar falhando, 
verifique as configurações da pasta que o Dreamweaver usa para processar páginas 
dinâmicas (consulte “Especificar onde as páginas dinâmicas podem ser processadas” na 
página 667).
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6. Clique em OK.

A nova conexão é exibida no painel Databases.

Tópicos relacionados
■ Capítulo 29, “Solucionar problemas de conexões de banco de dados”, na página 709

Conectar-se através de um driver ODBC
Embora os aplicativos JSP tenham de se comunicar com bancos de dados por meio de drivers 
JDBC, eles podem se comunicar por meio de drivers ODBC se houver um bridge driver 
JDBC-ODBC. O bridge driver funciona como intérprete entre o aplicativo JSP, com 
linguagem JDBC, e o driver ODBC, com linguagem ODBC. Esse canal de comunicação 
permite ao aplicativo JSP conversar com o banco de dados. 

Esse tipo de conexão oferece duas vantagens para os usuários do Windows. Primeiro, é 
possível utilizar drivers ODBC gratuitos da Microsoft. Segundo, é possível utilizar um DSN 
para simplificar a tarefa de criação da conexão.

Os requisitos a seguir devem ser satisfeitos para se efetuar uma conexão por meio de um driver 
ODBC:

■ O servidor de aplicativos JSP deve estar instalado e funcionando em um computador com 
o sistema Windows.

■ Um driver ODBC para o banco de dados deve estar instalado no computador com o 
Windows no qual o servidor de aplicativos está sendo executado. Para obter mais 
informações, consulte “Verificar o driver ODBC” na página 700.

■ Um bridge driver JDBC-ODBC deve estar instalado no computador com o Windows no 
qual o servidor de aplicativos está sendo executado. Para obter mais informações, consulte 
“Instalar o bridge driver JDBC-ODBC da Sun” na página 700.

Se os requisitos forem atendidos, a conexão por meio de um driver ODBC poderá ser feita. 
Para obter instruções, consulte “Criar uma conexão ODBC” na página 700.
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Verificar o driver ODBC
Certifique-se de que o driver ODBC para o banco de dados foi instalado no computador com 
o Windows no qual o servidor de aplicativos JSP está sendo executado. Para saber se o driver 
ODBC está instalado ou não, consulte “Exibir os drivers ODBC instalados em um sistema 
Windows” na página 1097. Se um driver apropriado não estiver instalado, efetue o download 
e instale o pacote de aplicativos Microsoft Data Access Components (MDAC) 2.5 e 2.7 no 
computador com o servidor de aplicativos JSP. É possível fazer gratuitamente o download do 
MDAC no site da Microsoft, em http://msdn.microsoft.com/data/mdac/downloads/. Esses 
pacotes contêm os drivers ODBC mais recentes da Microsoft.

Se houver um driver ODBC para o banco de dados, instalar um driver JDBC-ODBC em 
seguida. 

Instalar o bridge driver JDBC-ODBC da Sun
Para se conectar por meio de um driver ODBC, é necessário instalar o bridge driver JDBC-
ODBC da Sun no computador com o Windows no qual o servidor de aplicativos JSP está em 
execução. Este driver é fornecido com o Sun Java 2 SDK, edição Standard para Windows. 

Para saber se o Java 2 SDK foi fornecido como o driver, verifique se existe um dos seguintes 
diretórios no seu disco rígido: jdk1.2, jdk1.3 ou j2sdk1.4. 

Caso não tenha o SDK, você poderá efetuar download a partir do site da Sun na Web em 
http://java.sun.com/j2se/ e instalá-lo. O driver é instalado automaticamente com o SDK.

Embora seja adequado para uso com sistemas de banco de dados mais comuns com o 
Microsoft Access, o bridge driver JDBC-ODBC da Sun é bastante limitado. Por exemplo: ele 
permite que apenas uma página JSP se conecte ao banco de dados de cada vez (ou seja, não 
suporta o uso simultâneo de vários segmentos). Para obter mais informações sobre as 
limitações do driver, consulte a seção TechNote 17392 no centro de suporte da Macromedia 
em www.macromedia.com/go/17392.

Após instalar o bridge driver, é possível criar a conexão de banco de dados. 

Criar uma conexão ODBC
Antes de se conectar por meio de um driver ODBC, certifique-se de que o driver ODBC 
apropriado e o bridge driver JDBC-ODBC da Sun estejam instalados no computador com o 
Windows no qual o servidor de aplicativos JSP está em execução .

N
O

T
A

Instale primeiro o pacote MDAC 2.5 e, depois, o MDAC 2.7.
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Para se conectar por meio de um driver ODBC em JSP:

1. Defina um DSN no sistema Windows no qual está localizado o servidor de aplicativos.

Para obter instruções, consulte os seguintes artigos no site da Microsoft na Web:
■ Os usuários do Windows 2000 podem consultar o Artigo 300596 do Microsoft 

Knowledge Base em http://support.microsoft.com/default.aspx?scid=kb;en-us;300596
■ Os usuários do Windows XP podem consultar a Microsoft Knowledge Base, Artigo 

305599, em http://support.microsoft.com/default.aspx?scid=kb;en-us;305599
2. Abra uma página JSP no Dreamweaver e, em seguida, abra o painel Databases em Window 

> Databases.

O painel exibe as conexões definidas para esse site.
3. Clique no botão de adição (+) no painel e selecione “Sun JDBC-ODBC Driver (ODBC 

Database)” (Driver JDBC-ODBC da Sun [Banco de dados ODBC]) no menu pop-up.

A caixa de diálogo Sun JDBC-ODBC Driver (ODBC Database) é exibida.
4. Digite um nome para a nova conexão.

5. Substitua o alocador de espaço [odbc dsn] na caixa URL pelo DSN definido na etapa 1.

A caixa URL deverá ter esta aparência:
jdbc:odbc:myDSN

6. Especifique o nome de usuário e a senha de acesso ao banco de dados.

Se o nome de usuário ou a senha não forem necessários, deixe as caixas em branco. Por 
exemplo, se o DSN for denominado Acme e não for necessário um nome de usuário ou 
uma senha para acessar o banco de dados, digite estes valores de parâmetro:
Driver: sun.jdbc.odbc.JdbcOdbcDriver
URL: jdbc:odbc:Acme
Nome de usuário: 
Senha: 

7. Especifique a localização do bridge driver JDBC-ODBC.

■ Se o driver estiver instalado no mesmo computador que o Dreamweaver, selecione a 
opção Using Driver On This Machine (Utilizando o driver nesta máquina).

■ Se o driver não estiver instalado no mesmo computador que o Dreamweaver, selecione 
a opção Using Driver On Testing Server (Utilizando o driver no servidor de teste).

Os usuários do Macintosh podem ignorar esta etapa, pois todas as conexões de banco de 
dados utilizam o servidor de aplicativos.

N
O

T
A

Não utilize espaços ou caracteres especiais no nome.
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8. Clique em Test (Testar).

O Dreamweaver tentará estabelecer a conexão com o banco de dados. Se a conexão falhar, 
verifique novamente o DSN e os demais parâmetros de conexão. Se a conexão continuar 
falhando, verifique as configurações da pasta que o Dreamweaver usa para processar 
páginas dinâmicas (consulte “Especificar onde as páginas dinâmicas podem ser 
processadas” na página 667).

9. Clique em OK.

A nova conexão é exibida no painel Databases.

Tópicos relacionados
■ Capítulo 29, “Solucionar problemas de conexões de banco de dados”, na página 709

Editar ou excluir uma conexão de banco 
de dados
Quando você cria uma conexão de banco de dados, o Dreamweaver armazena as informações 
de conexão em um arquivo de inclusão na subpasta Connections (Conexões) localizada na 
pasta raiz local do site. Você pode editar ou excluir as informações de conexão do arquivo 
manualmente ou como a seguir. 

Para atualizar uma conexão:

1. Abra uma página JSP no Dreamweaver e, em seguida, abra o painel Databases em Window 
> Databases.

Uma lista de conexões é exibida no painel. 
2. Clique com o botão direito do mouse (no Windows) ou pressione a tecla Control (no 

Macintosh) e clique na conexão desejada. Em seguida, selecione Edit Connection (Editar 
conexão) no menu pop-up. 

A caixa de diálogo utilizada para criar a conexão é exibida.
3. Faça as alterações e clique em OK.

O Dreamweaver atualiza automaticamente o arquivo da inclusão que, por sua vez, atualiza 
todas as páginas do site que estiverem utilizando a conexão.

Se você renomear uma conexão, atualize todos os recordsets que utilizam o nome da conexão 
antiga. Para isso, clique duas vezes no recordset no painel Bindings (Ligações) e escolha um 
novo nome de conexão na caixa de diálogo Recordset. 
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Para excluir uma conexão:

1. Abra uma página JSP no Dreamweaver e, em seguida, abra o painel Databases em Window 
> Databases.

Uma lista de conexões é exibida no painel. 
2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 

pressionada (no Macintosh) e clique na conexão desejada. Em seguida, selecione Delete 
Connection (Excluir a conexão) no menu pop-up. 

A caixa de diálogo utilizada para criar a conexão é exibida.
3. Confirme se deseja excluir a conexão.

Para evitar a ocorrência de erros após excluir uma conexão, atualize todos os recordsets que 
utilizam a conexão antiga. Para tanto, clique duas vezes no nome do recordset no painel 
Bindings e escolha uma nova conexão na caixa de diálogo Recordset. 
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CAPÍTULO 28

Conexões de banco de dados 
para desenvolvedores PHP
Para utilizar um banco de dados com um aplicativo PHP, é necessário criar uma conexão de 
banco de dados no Macromedia Dreamweaver 8. Este capítulo descreve como criar a 
conexão de banco de dados.

Para fins de desenvolvimento PHP, o Dreamweaver oferece suporte apenas para o sistema de 
banco de dados MySQL. Outros sistemas de banco de dados, como Microsoft Access ou 
Oracle, não são suportados. O MySQL é um software de código-fonte aberto que pode ser 
copiado gratuitamente pela Internet para uso não-comercial. Para obter mais informações, 
consulte o site MySQL em http://dev.mysql.com/downloads/.

Este capítulo pressupõe que um aplicativo PHP já esteja configurado (consulte Capítulo 23, 
“Configurar um aplicativo para a Web”, na página 657). Também pressupõe que um banco de 
dados MySQL esteja configurado no computador local ou em um sistema ao qual o usuário 
tem acesso de rede ou FTP.

Para se conectar ao banco de dados de exemplo fornecido pelo Dreamweaver, consulte “Setup 
for Sample PHP Site” (Configuração do site de PHP de exemplo) em Getting Started with 
Dreamweaver. Para aprender mais sobre bancos de dados e conexões de bancos de dados, 
consulte Apêndice A, “Guia do iniciante em bancos de dados”, na página 1085.

Conectar-se a um banco de dados
Esta seção descreve como conectar-se a um banco de dados ao desenvolver um aplicativo PHP 
no Dreamweaver. Esta seção pressupõe que você tenha um ou mais bancos de dados MySQL e 
que o servidor MySQL tenha sido iniciado.

Para criar uma conexão de banco de dados com o banco de dados MySQL:

1. Abra uma página PHP no Dreamweaver e, em seguida, abra o painel Databases em 
Window > Databases.

D
IC

A

Para fins de desenvolvimento, efetue o download e instale a versão Windows Essentials 
do servidor de banco de dados MySQL.
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2. Clique no botão de adição (+) no painel e selecione MySQL Connection (Conexão 
MySQL) no menu pop-up.

A caixa de diálogo MySQL Connection é exibida.
3. Preencha a caixa de diálogo e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

A nova conexão é exibida no painel Databases.

Editar ou excluir uma conexão de banco 
de dados
Quando você cria uma conexão de banco de dados, o Dreamweaver armazena as informações 
de conexão em um arquivo de inclusão na subpasta Connections (Conexões) localizada na 
pasta raiz local do site. Você pode editar ou excluir as informações de conexão do arquivo 
manualmente ou como a seguir. 

Para atualizar uma conexão:

1. Abra uma página PHP no Dreamweaver e, em seguida, abra o painel Databases em 
Window > Databases.

Uma lista de conexões é exibida no painel. 
2. Clique com o botão direito do mouse (no Windows) ou pressione a tecla Control (no 

Macintosh) e clique na conexão desejada. Em seguida, selecione Edit Connection (Editar 
conexão) no menu pop-up. 

A caixa de diálogo utilizada para criar a conexão é exibida.
3. Faça as alterações e clique em OK.

O Dreamweaver atualiza automaticamente o arquivo da inclusão que, por sua vez, atualiza 
todas as páginas do site que estiverem utilizando a conexão.

Para excluir uma conexão:

1. Abra uma página PHP no Dreamweaver e, em seguida, abra o painel Databases em 
Window > Databases.

Uma lista de conexões é exibida no painel. 

N
O

T
A

Se você receber a mensagem de erro “Client does not support authentication protocol 
requested. Consider upgrading MySQL client” (O cliente não oferece suporte ao 
protocolo de autenticação solicitado. Considere uma atualização para o cliente MySQL) 
ao testar a conexão de banco de dados PHP com o MySQL 4.1, consulte “Solucionar 
mensagens de erro do MySQL” na página 718.
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2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 
pressionada (no Macintosh) e clique na conexão desejada. Em seguida, selecione Delete 
Connection (Excluir a conexão) no menu pop-up. 

A caixa de diálogo utilizada para criar a conexão é exibida.
3. Confirme se deseja excluir a conexão.

Para evitar a ocorrência de erros após excluir uma conexão, atualize todos os recordsets que 
utilizam a conexão antiga. Para tanto, clique duas vezes no nome do recordset no painel 
Bindings (Ligações) e escolha uma nova conexão na caixa de diálogo Recordset. 
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CAPÍTULO 29

Solucionar problemas de 
conexões de banco de dados
Este capítulo descreve alguns problemas comuns que podem ser encontrados após a criação de 
uma conexão ao banco de dados e descreve como solucioná-los. 

Solucionar problemas de permissões
Uma das causas mais comuns de problemas é a insuficiência de permissões de pastas ou 
arquivos. Se o banco de dados estiver localizado em um computador com o Windows 2000 ou 
o Windows XP, e você receber uma mensagem de erro ao tentar exibir uma página dinâmica 
em um navegador da Web ou no modo Live Data, o erro poderá ter ocorrido devido a um 
problema de permissão. 

A conta do Windows tentando acessar o banco de dados não tem permissões suficientes. Pode 
ser a conta anônima do Windows (por padrão, IUSR_computername) ou uma conta específica 
de usuário se a página for protegida com validação de acesso.

É necessário alterar as permissões para dar à conta IUSR_computername as permissões 
apropriadas, de modo que o servidor Web possa acessar o arquivo de banco de dados. Além 
disso, a pasta contendo o arquivo de banco de dados também deve ter certas permissões para 
gravar naquele banco de dados.

Se a página for acessada anonimamente, conceder à conta IUSR_computername controle total 
para acessar a pasta e o arquivo do banco de dados, conforme descrito no procedimento 
abaixo. 

Além disso, se o caminho ao banco de dados for indicado por UNC (\\Server\Share), 
certifique-se de compartilhar a permissão de acesso total com a conta IUSR_computername 
com Share Permissions. Esse passo é aplicável mesmo se o compartilhamento for feito no 
servidor Web local. 

Se você copiar o banco de dados de outro local, não poderá importar automaticamente as 
permissões de sua pasta de destino. Talvez seja preciso alterar as permissões para o banco de 
dados. 
709



         
Para verificar ou alterar as permissões do arquivo de banco de dados 
(Windows XP):

1. Certifique-se de que possui privilégios de administrador no computador. 

2. No Windows Explorer, localizar o arquivo de banco de dados ou a pasta que contém o 
banco de dados, clicar com o botão direito do mouse o arquivo ou a pasta e selecionar 
Properties.

3. Selecione a guia Security (Segurança).

4. Se a conta IUSR_computername não constar da lista Group (Grupo) ou User Names 
(Nomes de usuários), clique no botão Add (Adicionar) para acrescentá-la.

5. Na caixa de diálogo Select Users (Selecionar usuários) ou Groups (Grupos), clique no botão 
Advanced (Avançado).

A caixa de diálogo se altera para apresentar mais opções.
6. Clique no botão Locations (Locais) e selecione o nome do computador.

7. Clique no botão Find Now (Localizar agora).

Uma lista de nomes de contas associadas ao computador é exibida.
8. Selecione a conta IUSR_computername e clique em OK. Em seguida, clique novamente em 

OKpara limpar a caixa de diálogo.

9. Para atribuir permissões totais à conta IUSR, selecione a caixa de verificação Full Control 
(Controle total) e clique em OK.

Para verificar ou alterar as permissões do arquivo de banco de dados 
(Windows 2000):

1. Certifique-se de que possui privilégios de administrador no computador.

2. No Windows Explorer, localizar o arquivo de banco de dados ou a pasta que contém o 
banco de dados, clicar com o botão direito do mouse o arquivo ou a pasta e selecionar 
Properties.

3. Selecione a guia Security (Segurança).

4. Se a conta IUSR_computername não estiver listada na caixa de diálogo File Permissions 
(Permissões de arquivo) nas contas do Windows, clicar no botão Add para adicioná-la.

N
O

T
A

Este passo é aplicável somente se houver um sistema de arquivos NTFS. Se for um 
sistema de arquivos FAT, a caixa de diálogo não terá a guia Security.

N
O

T
A

Este passo é aplicável somente se houver um sistema de arquivos NTFS. Se for um 
sistema de arquivos FAT, a caixa de diálogo não terá a guia Security.
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5. Na caixa de diálogo Select Users,  Computers (Computadores) ou Groups, selecione o 
nome do computador do menu pop-up Look In (Procurar em).

Uma lista de nomes de contas associadas ao computador é exibida.
6. Selecione a conta IUSR_computername e clique em Add.

7. Para atribuir permissões totais à conta IUSR, selecione Full control no menu pop-up Type 
of access (Tipo de acesso) e clique em OK.

Para maior segurança, as permissões podem ser definidas de modo que Read permission (Ler 
permissão) fique desativado na pasta da Web que contém o banco de dados. Não será 
permitido navegar pela pasta, mas as páginas da Web poderão, mesmo assim, acessar o banco 
de dados. 

Para obter mais informações sobre a conta IUSR e permissões do servidor Web, consulte as 
notas técnicas na página de suporte da Macromedia (TechNotes):

■ Understanding anonymous authentication and the IUSR account (A autenticação 
anônima e a conta IUSR) em www.macromedia.com/go/authentication 

■ Setting IIS web server permissions (Definir permissões de servidores da Web IIS) em 
www.macromedia.com/go/server_permissions 

Solucionar mensagens de erro da 
Microsoft
Esta seção descreve algumas mensagens de erro comuns da Microsoft e como diagnosticá-las. 
Estes erros podem ocorrer se você estiver utilizando o Internet Information Server (IIS) com 
um sistema de banco de dados Microsoft, como Access ou SQL Server. Esses erros 
normalmente acontecem quando você solicita uma página dinâmica do servidor.

Para obter mais informações sobre mensagens de erro 80004005, consulte “INFO: 
Troubleshooting Guide for 80004005 Errors in Active Server Pages and Microsoft Data 
Access Components (Guia de correção de erros 80004005 em Active Server Pages e Microsoft 
Data Access Components) (Q306518)”, no site da Microsoft na Web em http://
support.microsoft.com/default.aspx?scid=kb;en-us;Q306518. 

N
O

T
A

A Macromedia não oferece suporte técnico para software de outros fabricantes, como o 
Windows e IIS. Se esta seção não ajudar a resolver o problema, entre em contato com o 
suporte técnico da Microsoft ou visite o site de suporte da Microsoft na Web em http://
support.microsoft.com/. 
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80004005 — Data source name not found and no 
default driver specified (Não foi localizado o nome da 
fonte de dados e não foi especificado nenhum driver 
padrão)
Esse erro ocorre quando você tenta visualizar uma página dinâmica em um navegador Web ou 
no modo Live Data. Essa mensagem de erro pode variar em função do banco de dados e do 
servidor Web. Há outras variações da mensagem de erro: 

■ 80004005 — Driver's SQLSetConnectAttr failed (Falha de SQLSetConnectAttr do 
driver)

■ 80004005 — General error Unable to open registry key 'DriverId' (Erro geral: não é 
possível abrir a chave de registro 'DriverId')

A seguir possíveis causas e soluções:

■ A página não pode localizar o DSN. Certificar-se de que um DSN foi criado tanto no 
servidor Web como no computador local. Para obter mais informações, consulte “Usar um 
DSN” na página 1099.

■ O DSN deve ser configurado como DSN de usuário, não como um DSN de sistema. 
Remova o DSN de usuário e crie um DSN de sistema para substituí-lo.

■ Se o Microsoft Access for utilizado, o arquivo de banco de dados (.mdb) poderá estar 
bloqueado. O bloqueio pode ocorrer devido a um DSN com nome diferente acessando o 
banco de dados. No Windows Explorer, localize o arquivo bloqueado (.ldb) na pasta que 
contém o arquivo de banco de dados (.mdb) e exclua o arquivo.ldb. Se outro DSN estiver 
indicando o mesmo arquivo de banco de dados, exclua o DSN para evitar erros no futuro. 
Reinicie o computador após efetuar as alterações.

80004005 — Couldn’t use ‘(unknown)’; file already in 
use (Não foi possível utilizar 'desconhecido'; o 
arquivo já está em uso)
Esse erro ocorre quando você utiliza um banco de dados do Microsoft Access e tenta visualizar 
uma página dinâmica em um navegador Web ou no modo Live Data. Outra variação desta 
mensagem é “80004005 — Microsoft Jet database engine cannot open the file (unknown) (O 
mecanismo de banco de dados Microsoft Jet não consegue abrir o arquivo 'desconhecido')”. 

N
O

T
A

Se o DSN de usuário não for excluído, o nome de DSN duplicado produzirá um novo 
erro de ODBC.
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A causa provável é um problema de permissão. Para obter mais informações, consulte 
“Solucionar problemas de permissões” na página 709. A seguir algumas possíveis causas e 
soluções:

■ É provável que a conta utilizada pelo Internet Information Server (normalmente IUSR) 
não tenha as permissões corretas do Windows para um banco de dados baseado em 
arquivos ou para a pasta que contém o arquivo. Verifique as permissões da conta IIS 
(IUSR) no gerenciador de usuários. 

■ É possível que você não tenha permissão para criar ou excluir arquivos temporários. 
Verifique as permissões do arquivo e da pasta. Verifique se você tem permissão para criar 
ou excluir arquivos temporários. Arquivos temporários são normalmente criados na 
mesma pasta do banco de dados, mas o arquivo também pode ser criado em outras pastas, 
como /Winnt. 

■ No Windows 2000, pode ser necessário alterar o valor do tempo-limite para o DSN do 
banco de dados do Access. Para alterar o tempo-limite, selecione Start (Iniciar)  > Settings 
(Configurações) > Control Panel (Painel de controle) > Administrative Tools (Ferramentas 
administrativas)> Data Sources (ODBC) (Fontes de dados [ODBC]). Clique na guia 
System (Sistema), realce o DSN correto e clique no botão Configure (Configurar). Clique 
no botão Options (Opções) e altere o valor Page Timeout (Tempo-limite da página) para 
5000.

Se ainda tiver problemas, consulte os seguintes artigos na Microsoft Knowledge Base (Base de 
dados de conhecimento da Microsoft): 

■ PRB: 80004005 “Couldn't Use ‘(unknown)’; File Already in Use" em http://
support.microsoft.com/default.aspx?scid=kb;en-us;Q174943.

■ PRB: Microsoft Access Database Connectivity Fails in Active Server Pages (Falhas do 
Microsoft Access Database Connectivity em Active Server Pages) em http://
support.microsoft.com/default.aspx?scid=kb;en-us;Q253604.

■ PRB: Error “Cannot Open File Unknown” Using Access (Erro “Não é possível abrir o 
arquivo desconhecido” utilizando o acesso) em http://support.microsoft.com/
default.aspx?scid=kb;en-us;Q166029.

80004005 — Logon Failed() (Falha de logon) 
Esse erro ocorre quando você utiliza o Microsoft SQL Server e tenta visualizar uma página 
dinâmica em um navegador Web ou no modo Live Data. 

Este erro será gerado pelo SQL Server (Servidor SQL) se este não aceitar ou não reconhecer a 
conta de logon ou senha enviada (se você estiver usando segurança padrão) ou se uma conta 
do Windows não for atribuída a uma conta SQL (se você estiver usando segurança integrada).
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Algumas possíveis soluções podem ser vistas a seguir:

■ Se estiver usando segurança padrão, o nome da conta e a senha podem estar incorretos. 
Tente utilizar a conta e senha do Admin do sistema (UID = “sa” e nenhuma senha), que 
devem ser definidas na linha de seqüência da conexão (DSNs não armazenam nomes de 
usuário e senhas). 

■ Ao usar segurança integrada, verifique a conta Windows chamando a página e localize a 
conta SQL atribuída (se houver).

■ O SQL Server não permite sublinhados em nomes de conta SQL. Se alguém atribuir 
manualmente a conta IUSR_machinename do Windows a uma conta SQL com o mesmo 
nome, ocorrerá uma falha. Atribua qualquer conta com sublinhado a um nome de conta 
SQL que não use sublinhados.

80004005 — Operation must use an updateable 
query (A operação deve utilizar uma consulta 
atualizável)
Esse erro ocorre quando um evento está atualizando um recordset ou inserindo dados em um 
recordset.

A seguir possíveis causas e soluções:

■ As permissões definidas na pasta que contém o banco de dados são muito restritivas. Os 
privilégios IUSR devem ser estabelecidos para leitura/gravação. Consulte “Solucionar 
problemas de permissões” na página 709.

■ As permissões no arquivo de banco de dados não têm privilégios totais de leitura/gravação 
válidos. Consulte  “Solucionar problemas de permissões” na página 709.

■ O banco de dados pode estar localizado fora do diretório Inetpub/wwwroot. Embora seja 
possível visualizar e localizar os dados, não será possível atualizá-los, a menos que o banco 
de dados esteja localizado no diretório wwwroot. 

■ O recordset está localizado em uma consulta não atualizável. Funções lógicas são bons 
exemplos de consultas não atualizáveis em um banco de dados. Reestruture as consultas de 
modo que se tornem atualizáveis. 

Para mais informações sobre mensagens de erro, consulte “PRB: ASP ‘Error The Query Is Not 
Updateable’ When You Update Table Record (ASP ‘Error The Query Is Not Updateable’ 
quando você atualiza um registro de tabela) na Microsoft Knowledge Base em http://
support.microsoft.com/default.aspx?scid=kb;en-us;Q174640.
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80040e07 — Data type mismatch in criteria 
expression (Erro de correspondência de tipos de 
dados na expressão dos critérios)
Este erro ocorre quando o servidor tenta processar uma página contendo um comportamento 
do servidor Insert Record (Inserir registro) ou Update Record (Atualizar registro), sendo que o 
comportamento de servidor tenta definir o valor de uma coluna Date/Time (Data/Hora) em 
um banco de dados do Microsoft Access com uma seqüência nula (""). 

O Microsoft Access possui situações distintas para digitação de dados e impõe um conjunto de 
regras rigorosas sobre determinados valores das colunas. O valor de seqüência vazio na 
consulta SQL não pode ser armazenado na coluna Date/Time (Data/hora) do Access. 
Atualmente, a única solução conhecida é evitar inserir ou atualizar as colunas Date/Time no 
Access com seqüências vazias ("") ou com qualquer outro valor que não corresponde ao 
intervalo de valores especificado para o tipo de dados.

80040e10 — Too few parameters (Falta de 
parâmetros)
Este erro ocorre quando uma coluna especificada em uma consulta SQL não existe na tabela 
de banco de dados. Verifique os nomes das colunas na tabela de banco de dados em 
comparação à consulta SQL. A causa deste erro é freqüentemente um erro tipográfico. 

80040e10 — COUNT field incorrect (Campo COUNT 
incorreto)
Este erro ocorre ao tentar visualizar uma página contendo um comportamento de servidor 
Insert Record (Inserir registro) em um navegador da Web e tentar utilizá-lo para inserir um 
registro em um banco de dados do Microsoft Access.  

O usuário pode estar tentando inserir um registro em um campo de banco de dados com um 
ponto de interrogação (?) no nome do campo. O ponto de interrogação é um caractere 
especial para alguns mecanismos de busca de banco de dados, incluindo o Microsoft Access, e 
não deve ser usado para nomes de tabela de banco de dados ou nomes de campos. 

Abra o sistema de banco de dados, remova o ponto de interrogação (?) dos nomes do campo e 
atualize os comportamentos de servidor na página referente ao campo.
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80040e14 — Syntax error in INSERT INTO statement 
(Erro de sintaxe na instrução INSERT INTO)
Este erro ocorre quando o servidor tenta processar uma página que contém um 
comportamento de servidor Insert Record (Inserir registro).

Este erro é normalmente o resultado de um ou mais problemas relacionados ao nome do 
campo, objeto ou variável no banco de dados a seguir:

■ Uso de uma palavra reservada como nome. A maioria dos bancos de dados possui um 
conjunto de palavras reservadas. Por exemplo: “data” é uma palavra reservada e não pode 
ser usada para nomes de coluna em um banco de dados.

■ Uso de caracteres especiais com o nome. Exemplos de caracteres especiais:
. / * : ! # & - ? 

■ Uso de um espaço no nome

Este erro também pode acontecer quando uma máscara de entrada for definida para um 
objeto no banco de dados e os dados inseridos não corresponderem à máscara.

Para solucionar o problema, evite usar palavras reservadas como “data”, “nome”, “selecionar”, 
“onde” e “nível” ao especificar nomes de coluna no banco de dados. Remova também os 
espaços e caracteres especiais.

Consulte as páginas da Web a seguir para obter listas de palavras reservadas para sistemas de 
banco de dados comuns:

■ Microsoft Access em http://support.microsoft.com/default.aspx?scid=kb;en-us;Q209187 
■ SQL Server da Microsoft em http://msdn.microsoft.com/library/default.asp?url=/library/

en-us/tsqlref/ts_ra-rz_9oj7.asp 
■ MySQL em http://dev.mysql.com/doc/mysql/en/reserved-words.html 

80040e21 — ODBC error on Insert or Update (Erro 
ODBC em inserção ou atualização)
Este erro ocorre quando o servidor tenta processar uma página contendo um comportamento 
de servidor Update Record (Atualizar registro) ou Insert Record (Inserir registro). O banco de 
dados não pode efetuar a operação de atualização ou de inserção que o comportamento do 
servidor está tentando executar. 
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A seguir possíveis causas e soluções:

■ O comportamento do servidor está tentando atualizar o campo autonumeração de uma 
tabela do banco de dados ou está tentando inserir um registro em um campo de 
autonumeração. Como os campos de autonumeração são preenchidos automaticamente 
pelo sistema do banco de dados, qualquer tentativa de preenchê-los com um valor externo 
resulta em falha. 

■ Os dados que o comportamento de servidor está atualizando ou inserindo consistem no 
tipo incorreto de dados para o campo do banco de dados, como inserir uma data em um 
campo booleano (sim/não), inserir uma seqüência em um campo numérico ou inserir uma 
seqüência formatada incorretamente no campo Date/Time (Data/Hora). 

800a0bcd — Either BOF or EOF is true (BOF ou EOF 
é verdadeiro)
Esse erro ocorre quando você tenta visualizar uma página dinâmica em um navegador Web ou 
no modo Live Data.

O problema ocorre quando a página tenta exibir os dados de um recordset vazio. Para resolver 
o problema, aplique o comportamento de servidor Show Region (Mostrar região) ao conteúdo 
dinâmico a ser exibido na página, do seguinte modo: 

1. Realce o conteúdo dinâmico na página.

2. No painel Server Behaviors (Comportamentos de servidor), clique no botão de adição (+) 
e selecione Show Region > Show Region If Recordset Is Not Empty (Mostrar região se o 
recordset não estiver vazio).

3. Selecione o recordset que estiver fornecendo o conteúdo dinâmico e clique em OK.

4. Repita as etapas de 1 a 3 para cada elemento de conteúdo dinâmico da página.
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Solucionar mensagens de erro do 
MySQL
Esta seção descreve uma mensagem de erro comum que você poderá receber ao testar uma 
conexão de banco de dados PHP para o MySQL 4.1: “Client does not support authentication 
protocol requested. Consider upgrading MySQL client.”

É possível que você precise recorrer a uma versão anterior do MySQL ou instalar o PHP 5 e 
copiar algumas bibliotecas de vínculo dinâmico (DLLs). Para obter instruções detalhadas, 
consulte “Installing a PHP application server (Windows)” em Getting Started with 
Dreamweaver.

Além disso, consulte os seguintes artigos (TechNotes) no site da Macromedia: 

■ TechNote c45f8a29, em www.macromedia.com/go/c45f8a29. 
■ TechNote 16515, em www.macromedia.com/go/16515.
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PARTE 7

Tornar dinâmicas as páginas
Utilize as ferramentas de desenvolvimento de aplicativos do Macromedia 
Dreamweaver 8 para adicionar conteúdo dinâmico às suas páginas.

Esta seção contém os seguintes capítulos:
Capítulo 30: Otimizar a área de trabalho para 
desenvolvimento visual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 721

Capítulo 31: Fluxo de trabalho para projetos de páginas 
dinâmicas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 735

Capítulo 32: Obter dados para a página . . . . . . . . . . . . . . . . . . . . 745

Capítulo 33: Definir as fontes de conteúdo dinâmico  . . . . . . . . 759

Capítulo 34: Adicionar conteúdo dinâmico a páginas da Web  . 781

Capítulo 35: Exibir registros de bancos de dados. . . . . . . . . . . . 793

Capítulo 36: Exibir dados XML em páginas da Web . . . . . . . . . . 813

Capítulo 37: Usar os serviços da Web. . . . . . . . . . . . . . . . . . . . . . 847

Capítulo 38: Adicionar comportamentos de servidor 
personalizados  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 861

Capítulo 39: Criar formulários . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 885
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CAPÍTULO 30

Otimizar a área de trabalho 
para desenvolvimento visual
É possível otimizar a área de trabalho do Macromedia Dreamweaver 8 para desenvolver 
visualmente aplicativos para a Web. Por exemplo: é possível utilizar painéis para construir 
rapidamente páginas dinâmicas e exibir dados ao vivo nas suas páginas enquanto trabalha.

Este capítulo contém as seguintes seções:
Exibir painéis de desenvolvimento de aplicativos para a Web. . . . . . . . . . . . . . . . . 721

Exibir o banco de dados no Dreamweaver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .724

Exibir o Live Data na visualização do projeto. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .725

Trabalhar na visualização do projeto sem o Live Data. . . . . . . . . . . . . . . . . . . . . . . . 731

Visualizar páginas dinâmicas em um navegador. . . . . . . . . . . . . . . . . . . . . . . . . . . . .732

Restringir uma informação do banco de dados no Dreamweaver  . . . . . . . . . . . . .733

Exibir painéis de desenvolvimento de 
aplicativos para a Web
Clique na guia Application (Aplicativo) na barra Insert (Inserir) para exibir um conjunto de 
botões que permitem adicionar conteúdo dinâmico e comportamentos de servidor à sua 
página da seguinte maneira: 

O número e o tipo dos botões exibidos depende do tipo de documento aberto na janela 
Document (Documento). A barra Insert contém botões para adicionar os seguintes itens à 
página:

■ Recordsets
■ Texto ou tabelas dinâmicas
■ Formulários para inserir ou atualizar registros em um banco de dados
■ Barras de navegação dos registros
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Quando se alterna para a visualização do código (View (Exibir) > Code (Código)), são 
exibidos painéis adicionais em sua própria categoria da barra Insert, permitindo a inserção de 
código na página. Por exemplo: se uma página ColdFusion for exibida no modo de 
visualização do código, será disponibilizado um painel CFML na categoria CFML da barra 
Insert: 

Para descobrir o que cada botão da barra Insert faz, mova o mouse sobre um ícone. Será 
exibida a seguinte dica de ferramenta : 

Se desejar definir origens de conteúdo dinâmico para a sua página e adicionar o conteúdo a 
ela, selecione Window (Janela) > Bindings (Ligações). O painel Bindings é exibido.

Para obter mais informações, selecione Help (Ajuda) no menu pop-up do grupo de painéis.

Se desejar adicionar lógica do servidor às páginas dinâmicas, selecione Window > Server 
Behaviors (Comportamentos de servidor). O painel Server Behaviors é exibido.
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Um comportamento de servidor é o conjunto de instruções inseridas em uma página 
dinâmica na fase de design e executado no servidor em tempo de execução. Para obter mais 
informações, selecione Help (Ajuda) no menu pop-up do grupo de painéis.

Se desejar explorar bancos de dados ou criar conexões de bancos de dados, selecione Window 
> Databases (Bancos de dados). O painel Databases é exibido.

Para obter mais informações, selecione Help (Ajuda) no menu pop-up do grupo de painéis.

Se desejar inspecionar, adicionar ou modificar o código para JavaBeans, componentes 
Macromedia ColdFusion ou serviços da Web, selecione Window > Components 
(Componentes). O painel Components é exibido.

Para obter mais informações, selecione Help (Ajuda) no menu pop-up do grupo de painéis. 

N
O

T
A

O painel Components será ativado apenas se você abrir uma página ColdFusion, JSP 
ou ASP.NET. Além disso, o documento pode não oferecer suporte a determinados 
componentes. Por exemplo, os documentos do ColdFusion não oferecem suporte a 
JavaBeans.
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Exibir o banco de dados no 
Dreamweaver
Após se conectar ao banco de dados, você poderá exibir sua estrutura e dados no 
Dreamweaver. 

Para exibir o banco de dados:

1. Abra o painel Databases (Bancos de dados), em Window (Janela)> Databases.

O Dreamweaver preenche o painel Databases com todos os bancos de dados para os quais 
foram criadas conexões. Se você estiver desenvolvendo um site ColdFusion, o 
Dreamweaver preencherá o painel com todos os bancos de dados para os quais foram 
definidas fontes de dados no ColdFusion Administrator.

Se não forem exibidos bancos de dados no painel, será necessário criar uma conexão de 
banco de dados. Para obter mais informações, consulte “Efetuar a conexão com um banco 
de dados” na página 668.

2. Para exibir as tabelas, os procedimentos armazenados e as visualizações no banco de dados, 
clique no ícone de adição (+) ao lado de uma conexão na lista.

3. Para exibir as colunas da tabela, clique em um nome de tabela. 

Os ícones das colunas refletem o tipo de dados e indicam a chave primária. 
4. Para exibir os dados em uma tabela, clique com o botão direito do mouse (no Windows) 

ou pressione a tecla Control (no Macintosh) e clique no nome da tabela na lista. Em 
seguida, selecione View Data (Exibir dados) no menu pop-up.

O Dreamweaver também identifica a chave primária de cada tabela e os tipos de dados de 
cada coluna.

N
O

T
A

O Dreamweaver procura o servidor ColdFusion definido para o site atual. Consulte 
“Especificar onde as páginas dinâmicas podem ser processadas” na página 667.
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Exibir o Live Data na visualização do 
projeto 
O Dreamweaver pode exibir o conteúdo dinâmico de uma página durante o seu trabalho 
nessa página na visualização do projeto. Para obter mais informações sobre a visualização do 
código, consulte “Alternar entre visualizações na janela do documento” na página 56. 

Para exibir o conteúdo dinâmico na visualização do projeto:

1. Certifique-se de que o Dreamweaver esteja configurado adequadamente para exibir o Live 
Data. 

Para obter mais informações, consulte “Requisitos para exibição do Live Data” na 
página 727.

2. Selecione View (Exibir)> Live Data.

O Dreamweaver exibe a página na visualização do projeto completa com conteúdo 
dinâmico.

Quando o Live Data é ativado na visualização do projeto, é possível fazer o seguinte:

■ Ajustar o layout da página utilizando as ferramentas de design da página
■ Adicionar, editar ou excluir o conteúdo dinâmico
■ Adicionar, editar ou excluir comportamentos de servidor

Quando você fizer na página uma alteração que afete o conteúdo dinâmico, poderá atualizar 
essa página clicando no botão Refresh (Atualizar), que exibe o ícone de seta em círculo. O 
Dreamweaver também pode atualizar automaticamente a página.

N
O

T
A

Os links não funcionam no modo de visualização do projeto. Para testar seus links, 
utilize o recurso Preview in Browser (Visualizar no navegador). Consulte  “Visualizar 
páginas dinâmicas em um navegador” na página 732.
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As ilustrações a seguir mostram uma página dinâmica com Live Data desativado. 

As ilustrações a seguir mostram a mesma página com Live Data ativado:
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Tópicos relacionados
■ “Copiar arquivos dependentes” na página 728
■ “Fornecer os parâmetros esperados para a página” na página 729
■ “Atualizar a página” na página 730
■ “Solução de problemas na visualização do Live Data” na página 730
■ “Trabalhar na visualização do projeto sem o Live Data” na página 731

Requisitos para exibição do Live Data
Para exibir live data na visualização do projeto, você deve fazer o seguinte:

■ Definir uma pasta para processar páginas dinâmicas. Para obter instruções, consulte 
“Especificar onde as páginas dinâmicas podem ser processadas” na página 667. 
Quando você ativa o Live Data, é enviada à pasta uma cópia temporária do documento 
aberto, para processamento. A página resultante será retornada e exibida na visualização do 
projeto, enquanto a cópia temporária que estiver no servidor será excluída. 
Se a página exibir uma mensagem de erro quando você ativar o Live Data, certifique-se de 
que o prefixo da URL na caixa de diálogo Site Definition (Definição do site) esteja 
correto. Para obter mais informações, consulte “Efetuar a conexão com um banco de 
dados” na página 668.

■ Copie os arquivos relacionados (se houver) para a pasta. Para obter mais informações, 
consulte “Copiar arquivos dependentes” na página 728.

■ Crie a página com todos os parâmetros que um usuário normalmente criaria. Para obter 
instruções, consulte “Fornecer os parâmetros esperados para a página” na página 729.

Se tiver dificuldade ao obter a visualização do Live Data para trabalhar, consulte “Solução de 
problemas na visualização do Live Data” na página 730.

Tópicos relacionados
■ “Exibir o Live Data na visualização do projeto” na página 725
■ “Trabalhar na visualização do projeto sem o Live Data” na página 731
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Copiar arquivos dependentes
Algumas páginas dinâmicas dependem de outros arquivos para um funcionamento adequado. 
É necessário carregar todos os arquivos relacionados, inclusive as inclusões do servidor e 
arquivos dependentes, como arquivos de imagem e arquivos de classe JSP, para a pasta definida 
para processamento de páginas dinâmicas (consulte “Especificar onde as páginas dinâmicas 
podem ser processadas” na página 667). Quando você ativa o Live Data no modo de 
visualização do projeto, o Dreamweaver não copia automaticamente para a pasta os arquivos 
dependentes. 

Para copiar os arquivos dependentes para o servidor de aplicativos:

1. Abra o painel Site, em Window (Janela)> Site Files (Arquivos do site), e clique no botão 
Expand (Expandir), que é o último ícone na barra de ferramentas do painel. 

O painel Site se expandirá para o tamanho máximo.
2. Clique no ícone Application Server (Servidor de aplicativos) na barra de ferramentas 

expandida do painel Site (segundo ícone da esquerda para a direita).

A pasta da raiz do servidor de aplicativos será exibida abaixo de Remote Site (Site remoto).
3. Em Local Folder (Pasta local), selecione os arquivos dependentes.

4. Clique na seta azul voltada para cima na barra de ferramentas para copiar os arquivos para 
o servidor de aplicativos ou arraste esses arquivos para a pasta apropriada em Remote Site 
(Site remoto).

Faça isso apenas uma vez para seu site, exceto se adicionar mais arquivos dependentes. Nesse 
caso, será necessário copiá-los para a pasta também.

Tópicos relacionados
■ “Exibir o Live Data na visualização do projeto” na página 725
■ “Requisitos para exibição do Live Data” na página 727
■ “Atualizar a página” na página 730
■ “Solução de problemas na visualização do Live Data” na página 730

N
O

T
A

O Live Data oferece suporte a códigos em inclusões do servidor e arquivos de aplicativo 
como global.asa (ASP) e application.cfm (ColdFusion). Antes de ativar o Live Data, 
certifique-se de carregar estes arquivos para o servidor.
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Fornecer os parâmetros esperados para a página
Para gerar conteúdo dinâmico, algumas páginas requerem parâmetros do usuário, por 
exemplo: uma página precisa do número de identificação de um registro para localizar e exibir 
esse registro. Sem esses dados, o Dreamweaver não pode gerar o conteúdo dinâmico a ser 
exibido na visualização do projeto.

Se uma página espera parâmetros do usuário, é necessário fornecê-los da seguinte maneira.

Para fornecer à página os dados que são esperados do usuário: 

1. Na janela Document (Documento), selecione Live Data Settings (Definições do Live Data) 
no menu View (Exibir).

A caixa de diálogo Live Data Settings é exibida. 

2. Preencha a caixa de diálogo e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Se tiver especificado o método GET na caixa de diálogo Live Data Settings, a barra de 
ferramentas do Design view exibirá uma caixa de texto. Utilize essa caixa de texto para digitar 
outros parâmetros de URL e, em seguida, clique no botão Refresh (Atualizar), que exibe o 
ícone de seta em círculo, para ver como os parâmetros afetam a página. 

Digite cada parâmetro de URL no seguinte formato:
name=value;

Neste formato, name é o nome do parâmetro da URL esperado pela página, e value 
corresponde ao valor assumido por aquele parâmetro. Para obter mais informações, consulte 
“Parâmetros da URL” na página 749.
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Tópicos relacionados
■ “Exibir o Live Data na visualização do projeto” na página 725
■ “Requisitos para exibição do Live Data” na página 727
■ “Copiar arquivos dependentes” na página 728
■ “Solução de problemas na visualização do Live Data” na página 730

Atualizar a página

Para atualizar a página:

■ Com o Live Data ativado, clique no botão Refresh (Atualizar), que exibe o ícone de seta 
em círculo, na barra de ferramentas Document (Documento), para atualizar a página após 
fazer alterações que afetem o conteúdo dinâmico.
Também é possível selecionar a opção Auto Refresh (Atualização automática) na barra de 
ferramentas. Com essa opção ativada, a página é atualizada sempre que fizer uma alteração 
que afeta o conteúdo dinâmico. Se a conexão com o banco de dados for lenta, deixe esta 
opção em branco enquanto estiver trabalhando na janela do Live Data. 

Tópicos relacionados
■ “Exibir o Live Data na visualização do projeto” na página 725
■ “Requisitos para exibição do Live Data” na página 727
■ “Copiar arquivos dependentes” na página 728
■ “Fornecer os parâmetros esperados para a página” na página 729

Solução de problemas na visualização do Live Data
Muitos problemas com a visualização do Live Data têm sua origem em valores ausentes ou 
incorretos na caixa de diálogo Site Definition (Definição do site), em Site > Edit Sites (Editar 
sites).

Verifique a categoria Testing Server (Servidor de teste) da caixa de diálogo Site Definition. A 
caixa de texto Remote Folder (Pasta remota) deve especificar uma pasta capaz de processar 
páginas dinâmicas (consulte “Especificar onde as páginas dinâmicas podem ser processadas” 
na página 667). Veja a seguir um exemplo de uma pasta remota adequada se estiver 
executando IIS ou PWS no disco rígido: 

C:\Inetpub\wwwroot\myapp\ 
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Verifique se a caixa URL Prefix (Prefixo da URL) especifica uma URL que corresponda à pasta 
remota (ou “indique-a”). Por exemplo: se o PWS ou IIS for executado no computador local, as 
seguintes pastas remotas terão os seguintes prefixos URL:

Para obter mais informações, consulte “Efetuar a conexão com um banco de dados” na 
página 668.

Tópicos relacionados
■ “Exibir o Live Data na visualização do projeto” na página 725
■ “Requisitos para exibição do Live Data” na página 727
■ “Copiar arquivos dependentes” na página 728
■ “Fornecer os parâmetros esperados para a página” na página 729
■ “Atualizar a página” na página 730

Trabalhar na visualização do projeto sem 
o Live Data
Se o Live Data estiver desativado ou se for temporariamente desconectado do servidor de 
aplicativos, ainda será possível trabalhar com suas páginas dinâmicas na visualização do 
projeto. O Dreamweaver utiliza alocadores de espaço para representar visualmente o conteúdo 
dinâmico na página. Por exemplo, o alocador de espaço para texto dinâmico extraído de um 
banco de dados utiliza a sintaxe {RecordsetName.ColumnName}, onde Recordset é o nome 
do recordset e ColumnName é o nome da coluna escolhida do recordset.

Às vezes, o comprimento dos alocadores de espaço de texto dinâmico distorce o layout da 
página na visualização do projeto. É possível resolver o problema utilizando as chaves vazias 
como alocadores de espaço.

Para utilizar as chaves vazias como alocadores de espaço para texto 
dinâmico:

1. Selecione Edit (Editar) > Preferences (Preferências) > Invisible Elements (Elementos 
invisíveis) ou Dreamweaver > Preferences > Invisible Elements (Mac OS X).

2. No menu pop-up Show Dynamic Text As (Mostrar texto dinâmico como), selecione {}.

Pasta remota prefixo da URL

C:\Inetpub\wwwroot http://localhost/

C:\Inetpub\wwwroot\myapp\ http://localhost/myapp/

C:\Inetpub\wwwroot\fs\planes http://localhost/fs/planes
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3. Clique em OK.

Tópicos relacionados
■ “Exibir o Live Data na visualização do projeto” na página 725
■ “Requisitos para exibição do Live Data” na página 727

Visualizar páginas dinâmicas em um 
navegador
Os desenvolvedores de aplicativos para a Web geralmente depuram suas páginas verificando-as 
com freqüência em um navegador da Web. O Dreamweaver possibilita esse estilo de trabalho 
com o comando Preview in Browser (Visualizar no navegador) (F12). O comando permite 
exibir rapidamente páginas dinâmicas em um navegador sem que seja preciso carregá-las 
manualmente em um servidor. 

Você pode determinar que o Dreamweaver utilize arquivos temporários, no lugar de arquivos 
originais. Com essa opção, o Dreamweaver executará uma cópia temporária da página no 
servidor da Web antes de exibi-la no navegador. Em seguida, o Dreamweaver exclui o arquivo 
temporário do servidor. Para definir esta opção, selecione Edit (Editar) > Preferences 
(Preferências)> Preview in Browser (Visualizar no navegador).

Para visualizar as páginas dinâmicas, você deve completar a categoria Testing Server (Servidor 
de teste) na caixa de diálogo Site Definition. Para obter mais informações, consulte 
“Especificar onde as páginas dinâmicas podem ser processadas” na página 667.

A opção Preview in Browser (Visualizar no navegador) não carrega as páginas relacionadas, 
como as páginas de resultados ou de detalhes, os arquivos dependentes, como os arquivos de 
imagens, ou as inclusões do servidor. Para carregar um arquivo ausente, selecione Window 
(Janela)> Site para abrir o painel Site. Selecione o arquivo em Local Folder (Pasta local) e 
clique na seta azul voltada para cima da barra de ferramentas para copiar o arquivo para a 
pasta do servidor da Web.

D
IC

A

É possível também utilizar a visualização do projeto para verificar rapidamente suas 
páginas enquanto trabalha nelas. A visualização do projeto exibe uma representação 
visual e totalmente editável da sua página, incluindo Live Data. Para obter mais 
informações, consulte “Exibir o Live Data na visualização do projeto” na página 725. 
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Restringir uma informação do banco de 
dados no Dreamweaver
Os usuários avançados de sistemas de bancos de dados mais complexos, como o Oracle, 
devem restringir o número de itens do banco de dados recuperados e exibidos pelo 
Dreamweaver na fase de design. O banco de dados Oracle pode conter itens que o 
Dreamweaver não conseguirá processar na fase de design. No Oracle, é possível criar um 
esquema e, em seguida, utilizá-lo no Dreamweaver para filtrar itens desnecessários na fase de 
design. 

Outros usuários poderão se beneficiar da restrição da quantidade de informação a ser 
recuperada pelo Dreamweaver na fase de design. Como alguns bancos de dados contêm 
dezenas ou até mesmo centenas de tabelas, é recomendável evitar que o Dreamweaver 
apresente todas as tabelas enquanto você trabalha. Um esquema ou um catálogo pode 
restringir o número de itens de banco de dados que o Dreamweaver obtém na fase de design. 

Você deve criar um esquema ou catálogo no sistema de banco de dados para que possa aplicá-
lo ao Dreamweaver. Consulte a documentação do sistema do banco de dados ou o 
administrador do sistema.

Você não poderá aplicar um esquema ou catálogo no Dreamweaver se estiver desenvolvendo 
um aplicativo ColdFusion.

N
O

T
A

Não é possível criar um esquema ou catálogo no Microsoft Access.
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Para aplicar um esquema ou catálogo no Dreamweaver a um aplicativo 
diferente do ColdFusion:

1. Abra uma página dinâmica no Dreamweaver e, em seguida, abra o painel Databases 
(Bancos de dados), em Window (Janela) > Databases.

Se a conexão ao banco de dados já existir, será exibida uma lista de conexões no painel. 
2. Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 

pressionada (no Macintosh) e clique na conexão. Em seguida, selecione Edit Connection 
(Editar conexão) no menu pop-up. A caixa de diálogo correspondente à conexão é exibida.

Se a conexão não existir, será preciso criá-la clicando no botão de adição (+) na parte 
superior do painel. Para obter mais informações, consulte “Efetuar a conexão com um 
banco de dados” na página 668.

3. Na caixa de diálogo da conexão, clique em Advanced (Avançado).

A caixa de diálogo Restrict (Restringir) é exibida.
4. Especifique o seu esquema ou catálogo.

5. Clique em OK.
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CAPÍTULO 31

Fluxo de trabalho para 
projetos de páginas dinâmicas
Uma das principais vantagens oferecidas pelo Macromedia Dreamweaver 8 é a possibilidade 
de criar sites da web dinâmicos, sem que seja necessário experiência em linguagens de 
programação. As ferramentas visuais do Dreamweaver permitem o desenvolvimento de sites 
da Web dinâmicos, sem a necessidade de codificar manualmente a complexa lógica de 
programação exigida na criação de sites com exibição de conteúdo dinâmico armazenado em 
um banco de dados.  Com o Dreamweaver, é possível criar sites dinâmicos da Web utilizando 
qualquer uma das diversas linguagens de programação para Web e tecnologias de servidor 
conhecidas. Entre elas estão Macromedia ColdFusion, ASP.NET, Microsoft Active Server 
Pages (ASP), JavaServer Pages (JSP) e PHP.

Este capítulo descreve as principais etapas que você deve seguir para projetar e criar com êxito 
um site dinâmico da Web. Ao final de cada seção, são apresentadas referências aos 
procedimentos específicos necessários para desenvolver uma página dinâmica. As cinco 
principais etapas do desenvolvimento de uma página da Web dinâmica são as seguintes:
Projetar a página. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .735

Criar uma fonte de conteúdo dinâmico . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .736

Adicionar conteúdo dinâmico a uma página da Web. . . . . . . . . . . . . . . . . . . . . . . . .738

Aprimorar a funcionalidade de uma página dinâmica. . . . . . . . . . . . . . . . . . . . . . . . .739

Testar e depurar a página . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 741

Projetar a página
Uma das principais etapas da criação de qualquer site da Web, seja estático ou dinâmico, é o 
projeto visual da página. Com a inclusão de elementos dinâmicos em uma página da Web, o 
projeto da página torna-se crucial para seu aproveitamento. Considere com cuidado a forma 
como os usuários vão interagir com as páginas e com o site da Web como um todo.
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Um método conhecido para incorporar conteúdo dinâmico a uma página da Web é criar uma 
tabela para apresentar o conteúdo e importar o conteúdo dinâmico para uma ou mais células 
da tabela. Com esse método, é possível apresentar informações de diversos tipos em um 
formato estruturado. 

Para obter informações sobre como projetar páginas, consulte os capítulos a seguir: 

■ Capítulo 8, “Apresentar conteúdo com tabelas”, na página 257
■ Capítulo 9, “Criação de páginas no modo Layout”, na página 283
■ Capítulo 12, “Trabalhar com páginas”, na página 375
■ Capítulo 13, “Inserir e formatar texto”, na página 405
■ Capítulo 14, “Inserir imagens”, na página 445
■ Capítulo 15, “Links e navegação”, na página 461
■ Capítulo 17, “Adicionar áudio, vídeo e elementos interativos”, na página 515

Criar uma fonte de conteúdo dinâmico
Os sites dinâmicos da Web exigem uma fonte de conteúdo da qual extraem os dados a serem 
exibidos em uma página da Web. No Dreamweaver, essas fontes de dados podem ser bancos 
de dados, variáveis de solicitação, variáveis de servidor, variáveis de formulário ou 
procedimentos armazenados. 

Para poder utilizar essas fontes de conteúdo em uma página da Web, é necessário 
primeiramente:

■ Criar uma conexão com a fonte de conteúdo dinâmico (um banco de dados, por exemplo) 
e com o servidor de aplicativos que está processando a página

■ Especificar as informações contidas no banco de dados que deverão ser exibidas ou as 
variáveis a serem incluídas na página

■ Utilizar a interface do tipo apontar-e-clicar do Dreamweaver para selecionar e inserir 
elementos de conteúdo dinâmico na página selecionada

O Dreamweaver também permite que você se conecte facilmente a um banco de dados e crie 
um recordset do qual será extraído o conteúdo dinâmico. Um recordset é o resultado de uma 
consulta ao banco de dados. Ele extrai as informações específicas solicitadas pelo usuário e 
permite exibir essas informações em uma página específica. O recordset deve ser definido com 
base nas informações contidas no banco de dados e no conteúdo que você deseja exibir.
736 Capítulo 31:  Fluxo de trabalho para projetos de páginas dinâmicas



         
Diferentes fornecedores de tecnologia podem utilizar diferentes terminologias para fazer 
referência a um recordset. Nas tecnologias ASP e ColdFusion, um recordset é definido como 
uma consulta (query). Em JSP, um recordset é denominado conjunto de resultados (resultset). 
ASP.NET refere-se a um recordset como DataSet. Se você estiver utilizando outras fontes de 
dados, como entradas do usuário ou variáveis de servidor, o nome da fonte de dados definido 
no Dreamweaver será igual ao nome da própria fonte de dados.

Para utilizar uma fonte de conteúdo no Dreamweaver, utilize o painel Bindings (Ligações) 
para criar a fonte de dados. O painel Bindings, mostrado a seguir, permite criar fontes de 
dados para bancos de dados e diferentes tipos de variável. Quando se cria uma fonte de dados, 
ela é armazenada no painel Bindings, onde pode ser selecionada e inserida na página atual.

Para criar um recordset no Dreamweaver, é necessário utilizar a caixa de diálogo Recordset 
(Conjunto de registros). É possível iniciar a caixa de diálogo Recordset no painel Server 
(Servidor) da barra Insert (Inserir) ou no painel Bindings. A caixa de diálogo Simple Recordset 
(Conjunto de registros simples) permite selecionar uma conexão de banco de dados existente e 
criar uma consulta de banco de dados selecionando as tabelas cujos dados serão incluídos no 
recordset. É possível até mesmo utilizar a seção Filter (Filtro) da caixa de diálogo para criar 
critérios simples de pesquisa e retorno para a consulta. É possível testar a consulta na caixa de 
diálogo Recordset e fazer quaisquer ajustes necessários antes de adicioná-la ao painel Bindings.
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Uma vez estabelecida a conexão com o banco de dados e após a definição de um recordset, o 
recordset é exibido no painel Bindings. Nesse painel, é possível importar o recordset para 
qualquer página da Web do site definido. A ilustração abaixo mostra o painel Bindings com o 
recordset referente a um banco de dados de funcionários aberto. É possível inserir em uma 
página da Web qualquer um dos valores mostrados, selecionar o item e clicar no botão Insert 
na parte inferior do painel. O item selecionado é inserido no alocador de espaço especificado 
na página.

Para obter informações sobre bancos de dados e os procedimentos necessários para criar uma 
conexão com o banco de dados, consulte os seguintes capítulos:

■ Capítulo 32, “Obter dados para a página”, na página 745
■ “Apêndice A, “Guia do iniciante em bancos de dados”, na página 1085,” 

Adicionar conteúdo dinâmico a uma 
página da Web
Após definir um recordset ou outra fonte de dados e adicioná-lo ao painel Bindings 
(Ligações), você pode inserir o conteúdo dinâmico representado pelo recordset na página. A 
interface baseada em menus do Dreamweaver torna a adição de elementos de conteúdo 
dinâmico tão fácil quanto selecionar uma fonte de conteúdo dinâmico no painel Bindings e 
inseri-la em um objeto de texto, imagem ou formulário apropriado na página atual.

Quando você inclui um elemento de conteúdo dinâmico ou outro comportamento de 
servidor em uma página, o Dreamweaver insere um script de servidor no código-fonte da 
página. Esse script instrui o servidor a recuperar dados da fonte de dados definida e processá-
los na página da Web.

■ Para colocar um conteúdo dinâmico em uma página da Web, você pode seguir um destes 
procedimentos:
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■ Colocar o conteúdo no ponto de inserção na visualização do código ou na visualização do 
projeto

■ Substituir uma seqüência de texto ou outro alocador de espaço.

Inseri-lo em um atributo HTML. Por exemplo, o conteúdo dinâmico pode definir o atributo 
src de uma imagem ou o atributo value de um campo de formulário.

Para conhecer os procedimentos detalhados de adição de conteúdo dinâmico a uma página, 
consulte:

■ Capítulo 33, “Definir as fontes de conteúdo dinâmico”, na página 759
■ Capítulo 39, “Criar formulários”, na página 885

Aprimorar a funcionalidade de uma 
página dinâmica
Além de adicionar conteúdo dinâmico, o Dreamweaver permite incorporar facilmente uma 
lógica complexa de aplicativos às páginas da Web por meio do Server Behaviors 
(Comportamentos de servidor) . Os Server Behaviors são partes predefinidas do código do 
servidor, que adicionam lógica de aplicativos às páginas da Web, proporcionando maior 
interação e funcionalidade. Os comportamentos de servidor do Dreamweaver permitem 
adicionar a lógica de aplicativos a um site da Web sem gravar o código. Os comportamentos 
de servidor fornecidos no Dreamweaver oferecem suporte a tipos de documentos ColdFusion, 
ASP, ASP.NET, JSP e PHP. 

Os comportamentos de servidor são gravados e testados para serem rápidos, seguros e 
confiáveis. Os comportamentos de servidor internos do Dreamweaver foram criados para 
oferecer suporte a páginas da Web em várias plataformas, para todos os navegadores.

Adicionar comportamentos de servidor a uma página
Para adicionar comportamentos de servidor a uma página, selecione-os na categoria 
Application (Aplicativo) da barra Insert (Inserir) ou no painel Server Behavior. Para utilizar o 
painel Server Behaviors (Comportamentos de servidor), selecione Window (Janela) > Server 
Behaviors, clique no botão de adição (+) no painel e escolha um comportamento de servidor 
no menu pop-up. A ilustração a seguir mostra os botões Server Behavior disponíveis na barra 
Insert (Inserir).
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O Dreamweaver oferece uma interface do tipo apontar-e-clicar que faz com que a aplicação de 
conteúdo dinâmico e de comportamentos complexos seja tão simples quanto inserir 
elementos textuais e de design. Os seguintes comportamentos de servidor estão disponíveis:

■ Definir um recordset a partir de um banco de dados existente. O recordset definido é 
armazenado no painel Bindings (Ligações).

■ Exibir vários registros em uma única página. Selecione uma tabela inteira ou células ou 
linhas individuais que tenham conteúdo dinâmico e especifique o número de registros a 
serem exibidos em cada visualização de página.

■ Criar e inserir uma tabela dinâmica em uma página e associar a tabela a um recordset. 
Posteriormente, você pode modificar a aparência das tabelas e a região repetida com o 
Property inspector (Inspetor de propriedades) e o Repeated Region Server Behavior 
(Comportamento de servidor da região repetida), respectivamente.

■ Inserir um objeto de texto dinâmico em uma página. O objeto de texto que você inseriu é 
um item de um recordset predefinido, ao qual é possível aplicar qualquer um dos formatos 
de dados do Dreamweaver.

■ Criar controles de status e de navegação de registro, páginas-mestras/detalhes e 
formulários para atualizar informações contidas em um banco de dados.

■ Exibir mais de um registro de um recordset do banco de dados.
■ Criar links de navegação para recordsets que permitem exibir os registros anterior e 

seguinte de um recordset do banco de dados.
■ Adicionar um contador de registros para ajudar a controlar a quantidade de registros que 

foram retornados e a respectiva localização no resultado.

Você também pode estender os comportamentos de servidor do Dreamweaver criando 
comportamentos próprios ou instalando comportamentos desenvolvidos por outros 
fabricantes.

Para obter mais informações sobre como aprimorar a funcionalidade de páginas da Web 
utilizando comportamentos de servidor, consulte os seguintes capítulos:

■ Capítulo 34, “Adicionar conteúdo dinâmico a páginas da Web”, na página 781
■ Capítulo 35, “Exibir registros de bancos de dados”, na página 793
■ Capítulo 40, “Criar aplicativos ColdFusion rapidamente”, na página 909
■ Capítulo 41, “Criar aplicativos ASP.NET rapidamente”, na página 987
■ Capítulo 42, “Criar aplicativos ASP e JSP rapidamente”, na página 1033
■ Capítulo 43, “Criar aplicativos PHP rapidamente”, na página 1057
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Testar e depurar a página
Antes de tornar uma página dinâmica — ou um site inteiro — disponível na Web, teste sua 
funcionalidade. Para obter diretrizes que o ajudem a testar a capacidade de utilização de um 
site da Web e a compatibilidade entre plataformas, consulte “Diretrizes de teste de site” na 
página 172. Para obter mais informações sobre como projetar sites da Web para portadores de 
deficiência auditiva, visual ou outras deficiências, consulte “Utilizar os recursos de 
acessibilidade do Dreamweaver” na página 70. É necessário familiarizar-se com as questões 
descritas neste capítulo e levar em consideração o modo como a funcionalidade dos aplicativos 
pode interessar aos portadores de deficiência.

Esta seção contém os tópicos a seguir:

■ “Teste do conteúdo dinâmico” na página 741
■ “Editar o conteúdo dinâmico de uma página” na página 742
■ “Excluir o conteúdo dinâmico” na página 743

Teste do conteúdo dinâmico
O Dreamweaver permite visualizar e editar o conteúdo dinâmico por meio da janela do Live 
Data.

Enquanto o conteúdo dinâmico estiver sendo exibido, é possível executar as seguintes tarefas:

■ Ajustar o layout da página utilizando as ferramentas de projeto de página do Dreamweaver
■ Adicionar, editar ou excluir o conteúdo dinâmico
■ Adicionar, editar ou excluir comportamentos de servidor

Para obter este efeito, o Dreamweaver executa a página dinâmica no servidor antes de exibi-la 
na janela do Live Data. Sempre que o usuário alterna para a janela do Live Data, uma cópia 
temporária do documento aberto é enviada para o servidor de aplicativos para fins de 
processamento. A página resultante é retornada e exibida na janela do Live Data e a cópia 
temporária que está no servidor é excluída. 

Para alternar entre as janelas Document (Documento) e Live Data, selecione a opção Live 
Data no menu View (Exibir). Se uma página precisar de dados do usuário, como, por 
exemplo, o número de identificação de um registro selecionado em uma página mestra, o 
próprio usuário poderá fornecer esses dados na caixa de diálogo Live Data Settings (Definições 
do Live Data). 

N
O

T
A

Os links não funcionam na janela Live Data. Para testá-los, utilize o recurso Preview 
(Visualização) no navegador do Dreamweaver. Consulte “Verificar a compatibilidade 
com navegadores” na página 635. 
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Para digitar parâmetros do Live Data:

1. Fazer as alterações necessárias na página.

2. Se a página precisar de parâmetros de URL de um formulário HTML que utilize o método 
GET, digite os pares de nome/valor na caixa de texto exibida na barra de ferramentas e 
clique no botão Refresh (Atualizar) (o ícone em forma de seta circular. 

Digite os dados de teste no seguinte formato:
name=value; 
Neste formato, name é o nome do parâmetro da URL esperado pela página e value 
corresponde ao valor assumido por esse parâmetro.
Também é possível definir os pares nome/valor na caixa de diálogo Live Data Settings, em 
View (Exibir) > Live Data Settings, e salvá-los com a página.

3. Para atualizar a página, clique no botão Refresh.

Tópicos relacionados
■ “Editar o conteúdo dinâmico de uma página” na página 742
■ “Excluir o conteúdo dinâmico” na página 743

Editar o conteúdo dinâmico de uma página
É possível modificar ou remover o conteúdo dinâmico de uma página alterando-se o 
comportamento de servidor que fornece o conteúdo ou excluindo-se o comportamento. Por 
exemplo: é possível editar um comportamento de servidor do recordset para que retorne mais 
registros à página.

O conteúdo dinâmico de uma página é listado no painel Server Behaviors (Comportamentos 
de servidor). Por exemplo, quando um recordset é adicionado à página, o painel Server 
Behaviors lista o recordset da seguinte forma: 
Recordset(myRecordset)

Se você adicionar outro recordset à página, o painel Server Behaviors listará os dois recordsets 
da seguinte forma:
Recordset(mySecondRecordset)
Recordset(myRecordset)

Para editar um comportamento de servidor que fornece conteúdo dinâmico:

1. Abra o painel Server Behaviors (Comportamentos de servidor), a partir da seleção de 
Window (Janela) > Server Behaviors.
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2. Clique no botão de adição (+) para exibir os comportamentos de servidor e, no painel 
Server Behaviors, clique duas vezes no comportamento de servidor desejado. 

É exibida a caixa de diálogo que foi utilizada para definir a fonte de dados original. 
3. Faça as alterações na caixa de diálogo e clique em OK.

Também é possível utilizar o Property inspector (Inspetor de propriedades) para editar os 
recordsets da página. Abra o Property inspector em Window > Properties (Propriedades), e 
selecione o recordset no painel Server Behaviors, em Window > Server Behaviors. 

Tópicos relacionados
■ “Teste do conteúdo dinâmico” na página 741
■ “Excluir o conteúdo dinâmico” na página 743

Excluir o conteúdo dinâmico 
Após adicionar o conteúdo dinâmico a uma página, é possível exclui-lo selecionando-o na 
página e pressionando a tecla Delete. Também é possível excluir o conteúdo dinâmico através 
de sua seleção no painel Server Behaviors (Comportamentos de servidor) e, em seguida, 
clicando no botão de subtração (-).

Tópicos relacionados
■ “Teste do conteúdo dinâmico” na página 741
■ “Editar o conteúdo dinâmico de uma página” na página 742

N
O

T
A

Essa operação remove o script do servidor na página que recupera o conteúdo dinâmico 
do banco de dados. Ela não exclui os dados do banco de dados.
Testar e depurar a página 743
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32

CAPÍTULO 32 

Obter dados para a página
Aplicativos baseados na Web e sites da web dinâmicos requerem uma fonte de conteúdo da 
qual se recuperam dados. Os dados e as fontes de dados podem ter diversos formatos. 
Geralmente, os dados consistem em informações textuais ou numéricas retornadas para uma 
página da Web e exibidas para o usuário em determinado formato. 

Este capítulo contém as seguintes seções:
Utilizar um banco de dados para armazenar conteúdo . . . . . . . . . . . . . . . . . . . . . . .745

Coletar dados enviados por usuários . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 747

Acessar dados armazenados em variáveis de sessão . . . . . . . . . . . . . . . . . . . . . . . .752

Utilizar um banco de dados para 
armazenar conteúdo
O uso de um banco de dados para armazenar conteúdo permite separar o projeto do site da 
Web do conteúdo que você deseja exibir para usuários do site. Em vez de criar arquivos 
HTML individuais para cada página, é necessário apenas escrever uma página (ou modelo) 
para os diferentes tipos de informações a serem apresentadas. Utilizando um banco de dados, é 
possível prover um site da Web com novo conteúdo. Basta carregar o conteúdo no banco de 
dados e, em seguida, o site da Web recupera esse conteúdo de modo dinâmico em resposta à 
solicitação de um usuário. Uma das principais vantagens de armazenar informações de 
conteúdo em um banco de dados é a possibilidade de atualizar essas informações em uma 
única fonte e, em seguida, distribuir essa alteração por todo o site da Web, sem precisar 
pesquisar as páginas que possam conter as informações e editar cada página manualmente.
745



         
Os bancos de dados têm vários formatos, dependendo do volume e da complexidade dos 
dados que devem armazenar. Um banco de dados geralmente instalado em computadores com 
o sistema Windows é o Microsoft Access. Para iniciantes em bancos de dados, o Access oferece 
uma interface fácil de usar que permite trabalhar com tabelas de banco de dados. Embora seja 
possível utilizar o Access como fonte de dados para a maioria dos aplicativos para sites da Web, 
o programa está limitado a arquivos de 2 GB e pode ser utilizado por 255 usuários 
simultâneos, no máximo. Por esse motivo, o Access é uma opção mais adequada para o 
desenvolvimento de sites da Web e grupos de trabalho corporativos. No entanto, se houver 
necessidade de acesso de um grande número de usuários ao site, planeje a utilização de um 
banco de dados projetado para oferecer suporte à base pretendida de usuários do site.

Para os sites da Web que exigem maior grau de flexibilidade na criação de um modelo de 
dados e a capacidade de oferecer suporte a grandes comunidades de usuários simultâneos, os 
bancos de dados relacionais baseados em servidor (normalmente conhecidos como RDBMS) 
são utilizados com freqüência. Dentre os bancos de dados relacionais mais utilizados para 
armazenar o conteúdo de aplicativos baseados na Web e sites dinâmicos destacam-se MySQL, 
Microsoft SQL Server e Oracle.

Independentemente do banco de dados usado no suporte ao site da Web, é possível utilizar o 
Macromedia Dreamweaver 8 para projetar formulários da Web destinados a inserir, atualizar 
ou excluir dados do banco de dados. 

Para aprender mais sobre bancos de dados, consulte Apêndice A, “Guia do iniciante em 
bancos de dados”, na página 1085.

Acessar dados armazenados em um banco de dados
As páginas da Web não podem acessar de forma direta os dados armazenados em um banco de 
dados. Em vez disso, elas interagem com um recordset. Um recordset é um subconjunto das 
informações (ou registros) extraídas do banco de dados. Esse subconjunto de informações é 
extraído utilizando uma consulta ao banco de dados. Uma consulta consiste em uma instrução 
de pesquisa criada para localizar e extrair informações específicas de um banco de dados. O 
Dreamweaver utiliza a SQL (Structured Query Language) para criar as consultas. Embora não 
seja necessário ser conhecedor de SQL para criar consultas simples com o Dreamweaver, 
algum conhecimento básico dessa linguagem fácil de ser aprendida permite criar consultas 
mais avançadas e, desse modo, proporciona maior flexibilidade para desenvolver páginas 
dinâmicas. Para aprender os conceitos básicos de SQL, consulte Apêndice B, “Manual básico 
de SQL”, na página 1101.
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Uma consulta SQL pode produzir um recordset que contenha apenas determinadas colunas, 
apenas determinados registros ou uma combinação de ambos. Um recordset também pode 
conter todos os registros e colunas de uma tabela de banco de dados. No entanto, como os 
aplicativos raramente precisam utilizar todos os dados de um banco de dados, é recomendado 
reduzir ao máximo os recordsets. Como o servidor Web armazena o recordset 
temporariamente na memória, o uso de um recordset menor consome menos memória e pode 
melhorar o desempenho do servidor.

Coletar dados enviados por usuários
É possível utilizar páginas da Web para coletar informações de usuários, armazená-las na 
memória do servidor e usá-las para criar uma resposta dinâmica com base na entrada do 
usuário. As ferramentas mais conhecidas para a coleta de informações são os formulários 
HTML e as seleções de link de hipertexto.

Os formulários HTML permitem coletar informações de usuários e armazená-las na memória 
do servidor. Um formulário HTML pode enviar as informações como parâmetros de 
formulário ou parâmetros da URL. Se o atributo de método do formulário for definido como 
POST, o navegador incluirá os valores do formulário no corpo da mensagem enviada ao 
servidor. Se o atributo de método do formulário for definido como GET, o navegador anexará 
os valores do formulário à URL especificada no atributo de ação e enviará as informações ao 
servidor.

Os links de hipertexto também permitem coletar informações de usuários e armazená-las na 
memória do servidor. Para especificar um valor ou valores a serem enviados quando um 
usuário clicar em um link (uma preferência, por exemplo), é necessário anexar o valor à URL 
especificada na tag de ancoragem. Quando um usuário clica no link, o navegador envia ao 
servidor a URL e o valor anexado.

Esta seção descreve como criar parâmetros de formulário e URL para uso em aplicativos da 
Web.

Parâmetros de formulário
Os parâmetros de formulário são enviados ao servidor por meio de um formulário HTML 
utilizando o método POST ou GET. Se o método POST for utilizado, os parâmetros serão 
enviados com o corpo da mensagem. De outro modo, o método GET anexa os parâmetros à 
URL solicitada. 
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É possível utilizar o Dreamweaver para criar formulários HTML que enviem parâmetros de 
formulário ao servidor de modo rápido. Para obter instruções, consulte Capítulo 39, “Criar 
formulários”, na página 885. Tenha cuidado ao escolher o método utilizado para transmitir 
informações do navegador para o servidor.

Os parâmetros do formulário assumem os nomes dos objetos de formulário correspondentes. 
Por exemplo: se o formulário contém um campo de texto denominado txtLastName, o 
seguinte parâmetro de formulário é enviado ao servidor quando o usuário clica no botão 
Submit (Enviar): 
txtLastName=enteredvalue

Nos casos em que um aplicativo da Web necessitar de um valor de parâmetro preciso (por 
exemplo, quando ele executar uma ação com base em uma dentre várias opções), utilize um 
objeto de formulário de botão de opção, caixa de seleção ou lista/menu para controlar os 
possíveis valores a serem enviados pelo usuário. Isso impede que os usuários digitem as 
informações de forma incorreta e causem um erro de aplicativo. O exemplo a seguir ilustra um 
formulário de menu pop-up com três opções: 

Cada opção de menu corresponde a um valor inserido no código que é enviado ao servidor 
como um parâmetro de formulário. A caixa de diálogo List Values (Valores da lista), mostrada 
a seguir, faz a correspondência entre cada item da lista e um valor, como Add (Adicionar), 
Update (Atualizar) ou Delete (Excluir): 
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Tópicos relacionados
■ “Parâmetros da URL” na página 749
■ “Criar parâmetros de URL utilizando links HTML” na página 751
■ “Recuperar parâmetros de formulário e URL” na página 751

Parâmetros da URL
Um parâmetro da URL é um par nome/valor anexado a uma URL. O parâmetro começa com 
um ponto de interrogação (?) e assume o formato name=value. Quando há mais de um 
parâmetro da URL, cada parâmetro é separado por um 'e' comercial (&). O exemplo a seguir 
mostra um parâmetro de URL com dois pares nome/valor:
http://server/path/document?name1=value1&name2=value2

Os parâmetros de URL permitem passar as informações fornecidas pelo usuário do navegador 
para o servidor. Quando um servidor recebe uma solicitação e os parâmetros são anexados à 
URL da solicitação, o servidor coloca os parâmetros à disposição da página solicitada antes de 
disponibilizar essa página ao navegador. 

Neste exemplo, imagine que o aplicativo é a vitrine de uma loja baseada na Web. Como os 
desenvolvedores do site pretendem atingir o maior público possível, eles projetaram o site para 
oferecer suporte a moedas estrangeiras. Quando os usuários efetuam logon no site, eles podem 
selecionar a moeda em que desejam exibir os preços dos itens disponíveis.

1. O navegador solicita a página report.cfm do servidor. A solicitação inclui o parâmetro de 
URL Currency=“euro”. A variável Currency=“euro” especifica que todas as quantias 
monetárias recuperadas sejam exibidas na moeda euro da União Européia.

2. O servidor armazena temporariamente o parâmetro da URL na memória. 

3. A página report.cfm recupera e usa o parâmetro para recuperar o custo dos itens em euros. 
Essas quantias monetárias podem ser armazenadas em uma tabela de banco de dados de 
moedas diferentes ou convertidas de uma única moeda associada a cada item para qualquer 
moeda aceita pelo aplicativo.
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4. O servidor envia a página report.cfm ao navegador e exibe o valor dos itens na moeda 
solicitada. Quando esse usuário termina a sessão, o servidor destrói o valor do parâmetro 
da URL e libera a memória para armazenar as solicitações dos novos usuários que efetuarem 
logon no site.

Os parâmetros de URL são criados quando o método GET do protocolo HTTP é usado junto 
com um formulário HTML. O método GET especifica que o valor do parâmetro seja anexado 
à solicitação de URL quando o formulário é enviado. 

Os usos mais comuns dos parâmetros da URL incluem a personalização de sites da Web com 
base nas preferências de um usuário. Por exemplo: um parâmetro de URL formado por um 
nome de usuário e uma senha pode ser utilizado para autenticar um usuário, exibindo apenas 
as informações para as quais o usuário se cadastrou. Os exemplos comuns disso incluem os 
sites financeiros que exibem preços de ações individuais com base nos símbolos do mercado de 
ações anteriormente escolhidos pelo usuário. Os programadores de aplicativos para a Web 
geralmente utilizam parâmetros da URL para passar valores às variáveis nos aplicativos. É 
possível, por exemplo, transferir termos de busca para variáveis SQL a um aplicativo da Web 
para que este gere os resultados da pesquisa.

Tópicos relacionados
■ “Criar parâmetros de URL utilizando links HTML” na página 751
■ “Recuperar parâmetros de formulário e URL” na página 751

Currency="¤"

http://www.mysite.com/
report.cfm?Currency="¤"

Navegador da Web

SERVIDOR DA WEB 

<HTML>

</HTML>

report.cfm
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Criar parâmetros de URL utilizando links HTML
Para criar parâmetros de URL em um link HTML, utilize o atributo href da tag de 
ancoragem HTML. É possível inserir os parâmetros de URL diretamente no atributo, 
alternando para a visualização do código (View (Exibir) > Code (Código) ou anexando os 
parâmetros de URL no final da URL de link na caixa de texto Link do Property inspector 
(Inspetor de propriedades).

No exemplo a seguir, três links criam um único parâmetro de URL (action) com três 
possíveis valores (Add, Update e Delete). Dependendo do link em que o usuário clicar, um 
valor de parâmetro diferente será enviado ao servidor, e a ação solicitada será executada:
<a href="http://www.mysite.com/index.cfm?action=Add">Add a record</a>
<a href="http://www.mysite.com/index.cfm?action=Update">Update a record</a>
<a href="http://www.mysite.com/index.cfm?action=Delete">Delete a record</a>

O Property inspector em Window (Janela) > Properties (Propriedades) permite que você crie 
os mesmos parâmetros de URL, seja selecionando o link ou anexando os valores do parâmetro 
da URL no final da URL de link na caixa de texto Link. 

Tópicos relacionados
■ “Coletar dados enviados por usuários” na página 747
■ “Parâmetros da URL” na página 749
■ “Recuperar parâmetros de formulário e URL” na página 751
■ “Parâmetros de URL e de formulários” na página 763
■ “Definir os parâmetros de URL” na página 769
■ “Definir os parâmetros de formulário” na página 771

Recuperar parâmetros de formulário e URL 
Após a criação de um parâmetro de formulário ou URL, o Dreamweaver pode recuperar o 
valor e utilizá-lo em um aplicativo da Web. Para obter mais informações, consulte “Definir os 
parâmetros de URL” na página 769.

Após a definição do parâmetro de formulário ou URL no Dreamweaver, é possível inserir o 
valor do parâmetro em uma página. Para obter mais informações, consulte Capítulo 34, 
“Adicionar conteúdo dinâmico a páginas da Web”, na página 781.
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Tópicos relacionados
■ “Acessar dados armazenados em um banco de dados” na página 746
■ “Parâmetros de formulário” na página 747
■ “Parâmetros da URL” na página 749
■ “Criar parâmetros de URL utilizando links HTML” na página 751

Acessar dados armazenados em 
variáveis de sessão
As variáveis de sessão oferecem um mecanismo por meio do qual as informações do usuário 
podem ser armazenadas e acessadas para uso pelos aplicativos da Web. Normalmente, as 
variáveis de sessão armazenam informações (em geral, parâmetros de formulário ou URL 
enviados por usuários) e tornam essas informações disponíveis para todas as páginas dos 
aplicativos durante a visita do usuário. Por exemplo, quando os usuários efetuam logon em 
um portal da Web que oferece acesso a e-mail, cotações de ações, previsão do tempo e 
noticiário, o aplicativo da Web armazena as informações de logon em uma variável de sessão 
que identifica o usuário em todas as páginas do site. Isso permite que o usuário veja somente 
os tipos de conteúdo que ele selecionou ao navegar pelo site. As variáveis de sessão também 
podem fornecer um mecanismo de segurança na forma de tempo limite, que termina a sessão 
do usuário se a conta permanecer inativa por um longo período de tempo. Isso também libera 
a memória do servidor e os recursos de processamento quando os usuários se esquecem de 
efetuar logoff de um site da Web.

As variáveis de sessão são normalmente utilizadas para armazenar as preferências de exibição 
do usuário, respostas a questionários de várias partes, itens selecionados para compra nos 
aplicativos que funcionam como “carro de compras” e contadores de pontos obtidos em jogos 
on-line.

Variáveis de sessão
Os servidores da Web (ou, mais precisamente, protocolos HTTP) não contêm informações de 
status, ou seja, não mantêm um registro dos navegadores que se conectam a eles, nem das 
solicitações de páginas individuais feitas pelos usuários. Sempre que um servidor da Web 
recebe uma solicitação de uma página da Web e responde a ela disponibilizando a página 
relevante para o navegador do usuário, o servidor Web “se esquece” do navegador que fez a 
solicitação e da página da Web que foi enviada. Posteriormente, quando o mesmo usuário 
solicita uma página relacionada, o servidor Web envia a página sem se lembrar da última 
página que enviou para esse usuário. 
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Apesar de essa natureza do HTTP o tornar um protocolo simples e fácil de implementar, ela 
dificulta as aplicações mais avançadas da Web, como a geração de páginas personalizadas. Por 
exemplo, para personalizar o conteúdo do site de um usuário individual, é necessário primeiro 
identificar o usuário. É por isso que a maioria dos sites da Web utiliza alguma forma de logon 
com nome de usuário e senha.  Se o objetivo for exibir várias páginas personalizadas, será 
necessário utilizar um mecanismo que mantenha um registro dos usuários conectados, pois a 
maioria deles não aceitaria fornecer seu nome de usuário e senha em cada página do site.

Para possibilitar a criação de aplicativos para Web complexos e o armazenamento de dados 
fornecidos pelo usuário em todas as páginas de um site, a maioria das tecnologias de servidores 
de aplicativos inclui suporte a gerenciamento de sessão. O gerenciamento de sessão possibilita 
que os aplicativos da Web mantenham o estado em várias solicitações HTTP, permitindo que 
as solicitações de páginas da Web feitas por um usuário durante determinado período sejam 
exibidas como parte da mesma sessão interativa.

As variáveis de sessão armazenam informações durante a sessão do usuário. A sessão do usuário 
tem início quando ele abre a página pela primeira vez no aplicativo. A sessão termina quando 
o usuário não abre outra página no aplicativo durante um determinado período ou quando 
encerra explicitamente a sessão (normalmente, clicando em um link de “logoff ”). Enquanto 
existe, a sessão é específica de determinado usuário, e cada usuário tem uma sessão separada.

Utilize as variáveis de sessão para armazenar informações que todas as páginas de um 
aplicativo da Web podem acessar. As informações podem ser as mais variadas, como o nome 
do usuário, o tamanho de fonte preferido ou um sinalizador indicando se o usuário conseguiu 
efetuar logon com sucesso ou não. Outro uso comum das variáveis de sessão é manter um 
contador de pontos, como o número de perguntas que o usuário respondeu corretamente em 
um teste de conhecimentos on-line ou os produtos que ele selecionou até aquele momento em 
um catálogo on-line.

Observe que as variáveis de sessão funcionam somente se o navegador do usuário estiver 
configurado para aceitar cookies. O servidor cria um número de identificação da sessão, que 
identifica o usuário de modo exclusivo quando a sessão é iniciada e depois envia um cookie 
contendo esse número para o navegador do usuário. Quando o usuário solicita outra página 
no servidor, o servidor lê o cookie no navegador para identificar o usuário e recuperar as 
variáveis de sessão do usuário armazenadas na memória do servidor. 

Tópicos relacionados
■ “Coletar informações a serem armazenadas em variáveis de sessão” na página 754
■ “Armazenar informações em variáveis de sessão” na página 755
■ “Exemplo de informações armazenadas em variáveis de sessão” na página 756
■ “Recuperar dados de uma variável de sessão” na página 757
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Coletar informações a serem armazenadas em 
variáveis de sessão
Antes de criar uma variável de sessão, é preciso obter as informações a serem armazenadas e 
depois enviá-las ao servidor para que sejam armazenadas. Esta seção descreve como coletar e 
enviar informações ao servidor usando formulários HTML ou links de hipertexto contendo 
parâmetros da URL. Também é possível obter informações nos cookies armazenados no 
computador do usuário, nos cabeçalhos HTTP enviados pelo navegador do usuário junto 
com uma solicitação de página ou em um banco de dados.

Tópicos relacionados
■ “Variáveis de sessão” na página 752
■ “Armazenar informações em variáveis de sessão” na página 755
■ “Exemplo de informações armazenadas em variáveis de sessão” na página 756
■ “Recuperar dados de uma variável de sessão” na página 757

Armazenar parâmetros de URL em variáveis de sessão
Um exemplo comum de armazenamento de parâmetros de URL em variáveis de sessão é um 
catálogo de produtos que use parâmetros inseridos no código da URL. Esses parâmetros são 
criados com o auxílio de um link de hipertexto para enviar informações sobre o produto de 
volta ao servidor, a fim de que sejam armazenadas em uma variável de sessão. Quando um 
usuário clica no link “Add to shopping cart” (Adicionar ao carrinho de compras), a 
identificação do produto é armazenada em uma variável de sessão enquanto o usuário 
continua comprando. Quando o usuário prossegue até a página de conclusão da compra, a 
identificação do produto armazenado na variável de sessão é recuperada. 

Armazenar parâmetros de formulário em uma variável de 
sessão
Uma pesquisa baseada em formulário é um exemplo característico de uma página que 
armazena parâmetros de formulário em variáveis de sessão. O formulário devolve as 
informações selecionadas ao servidor, onde uma página de aplicativo anota os pontos da 
pesquisa e armazena as respostas em uma variável de sessão para que sejam repassadas para um 
aplicativo que calcula as respostas coletadas das pessoas pesquisadas. Ou, então, as 
informações podem ser armazenadas em um banco de dados para uso posterior.
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Armazenar informações em variáveis de sessão
Depois que as informações forem enviadas ao servidor, armazene-as em variáveis de sessão 
adicionando o código apropriado para o modelo do servidor à página especificada pelo 
parâmetro de URL ou formulário. Conhecida como página de destino, essa página é 
especificada no atributo action do formulário HTML ou no atributo href do link de 
hipertexto na página inicial. 

A sintaxe HTML de cada um aparece deste modo:
<form action="destination.html" method="get" name="myform"> </form> 

<param name="href"value="destination.html">

Tanto a tecnologia de servidor utilizada quanto o método usado para obter as informações 
determinam o código empregado para armazenar as informações em uma variável de sessão. A 
sintaxe básica de cada tecnologia de servidor é descrita da seguinte maneira:

ColdFusion
<CFSET session.variable_name = value>

ASP e ASP.NET
<% Session("variable_name") = value %>

A expressão value é geralmente uma expressão do servidor, como 
Request.Form(“lastname”). Por exemplo: se um parâmetro de URL denominado product 
(ou um formulário HTML com o método GET e um campo de texto chamado product) for 
utilizado para coletar informações, as seguintes instruções armazenarão as informações em 
uma variável de sessão denominada prodID:

ColdFusion
<CFSET session.prodID = url.product>

ASP e ASP.NET
<% Session("prodID") = Request.QueryString("product") %>

Se for utilizado um formulário HTML com o método post e um campo de texto 
denominado txtProduct para coletar as informações, as instruções apresentadas a seguir 
armazenarão as informações na variável de sessão:

ColdFusion
<CFSET session.prodID = form.txtProduct>

ASP e ASP.NET
<% Session("prodID") = Request.Form("txtProduct") %>
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Tópicos relacionados
■ “Variáveis de sessão” na página 752
■ “Coletar informações a serem armazenadas em variáveis de sessão” na página 754
■ “Exemplo de informações armazenadas em variáveis de sessão” na página 756
■ “Recuperar dados de uma variável de sessão” na página 757

Exemplo de informações armazenadas em variáveis 
de sessão
Você está trabalhando em um site cujos usuários, em sua maioria, são pessoas idosas. No 
Dreamweaver, é possível adicionar à página inicial dois links que permitam aos usuários 
personalizar o tamanho do texto do site. Para visualizar um texto com letras maiores que 
facilitem a leitura, o usuário clica em um link. Para ler o texto no tamanho usual, clica em 
outro link. 

Cada link tem um parâmetro da URL denominado fontsize que envia as preferências de 
texto do usuário ao servidor, conforme ilustrado neste exemplo do Macromedia ColdFusion:
<a href="resort.cfm?fontsize=large">Larger Text</a><br>
<a href="resort.cfm?fontsize=small">Normal Text</a>

Cabe a você decidir se deve armazenar a preferência de texto do usuário em uma variável de 
sessão e utilizá-la para definir o tamanho da fonte em cada página solicitada pelo usuário.

Próximo do início da página de destino, especifique o código a seguir para criar uma sessão 
denominada font_pref que armazena a preferência do usuário quanto ao tamanho de fonte.

ColdFusion
<CFSET session.font_pref = url.fontsize>
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ASP e ASP.NET
<% Session("font_pref") = Request.QueryString("fontsize") %>

Quando o usuário clica no link de hipertexto, a página envia a preferência de texto do usuário 
em um parâmetro da URL para a página de destino. O código da página de destino armazena 
o parâmetro da URL na variável de sessão font_pref. Durante a sessão do usuário, todas as 
páginas do aplicativo recuperam esse valor e exibem o tamanho de fonte selecionado.

Tópicos relacionados
■ “Variáveis de sessão” na página 752
■ “Coletar informações a serem armazenadas em variáveis de sessão” na página 754
■ “Armazenar informações em variáveis de sessão” na página 755
■ “Recuperar dados de uma variável de sessão” na página 757

Recuperar dados de uma variável de sessão
Depois que um valor é armazenado em uma variável de sessão, é possível utilizar o 
Dreamweaver para recuperar o valor de variáveis de sessão e utilizá-lo em um aplicativo da 
Web. Para obter mais informações, consulte “Definir as variáveis de sessão” na página 772.

Após a definição da variável de sessão no Dreamweaver, é possível inserir o respectivo valor em 
uma página. Para obter mais informações, consulte Capítulo 34, “Adicionar conteúdo 
dinâmico a páginas da Web”, na página 781.

Tópicos relacionados
■ “Variáveis de sessão” na página 752
■ “Coletar informações a serem armazenadas em variáveis de sessão” na página 754
■ “Armazenar informações em variáveis de sessão” na página 755
■ “Exemplo de informações armazenadas em variáveis de sessão” na página 756
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CAPÍTULO 33

Definir as fontes de 
conteúdo dinâmico
Os sites da Web dinâmicos necessitam de uma fonte de dados da qual o conteúdo dinâmico é 
recuperado e exibido. O Macromedia Dreamweaver 8 permite o uso de bancos de dados, 
variáveis de solicitação, variáveis de URL, variáveis de servidor, variáveis de formulários, 
procedimentos armazenados (stored procedures) e outras fontes de conteúdo dinâmico. 
Dependendo da fonte de dados, é possível recuperar um novo conteúdo para atender à 
solicitação ou modificar a página para satisfazer às necessidades dos usuários.

Este capítulo descreve os procedimentos para definir bancos de dados e variáveis como fontes 
de conteúdo dinâmico. Para conhecer melhor as tecnologias apresentadas neste capítulo, 
consulte “Recursos de tecnologias da Web e HTML” na página 40.

Este capítulo contém as seguintes seções:
Sobre fontes de conteúdo dinâmico  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .760

Definir um recordset  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .765

Definir os parâmetros de URL. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .769

Definir os parâmetros de formulário. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 771

Definir as variáveis de sessão . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 772

Definir variáveis de aplicativo ASP e ColdFusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . 773

Utilizar uma variável como fonte de dados para um recordset ColdFusion  . . . . . 774

Definir variáveis de servidor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 775

Armazenar em cache as fontes de conteúdo. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 778

Alterar ou excluir as fontes de conteúdo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 778

Copiar um recordset para outra página . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 779
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Sobre fontes de conteúdo dinâmico
Uma fonte de conteúdo dinâmico é um local de armazenamento de informações do qual é 
possível recuperar e exibir conteúdo dinâmico para ser utilizado em uma página da Web. As 
fontes de conteúdo dinâmico incluem não somente as informações armazenadas em um banco 
de dados, mas também os valores enviados pelos formulários HTML e os contidos nos objetos 
de servidor, os valores das propriedades dos componentes de software reutilizáveis para Java e 
outras fontes de conteúdo.

Qualquer fonte de conteúdo definida no Dreamweaver é adicionada à lista de fontes de 
conteúdo no painel Bindings (Ligações). Depois de criar uma fonte de conteúdo e incluí-la no 
painel Bindings, você poderá inseri-la facilmente na página selecionada.

Tópicos relacionados
■ “Recordsets” na página 760
■ “Parâmetros de URL e de formulários” na página 763
■ “Sobre variáveis de sessão” na página 763
■ “Variáveis de aplicativos ASP e ColdFusion” na página 764
■ “Variáveis de servidor ASP” na página 764
■ “Variáveis de servidor ColdFusion” na página 764

Recordsets
Ao utilizar um banco de dados como fonte de conteúdo para uma página da Web, é necessário 
criar primeiro um recordset no qual os dados recuperados serão armazenados. Os recordsets 
servem como intermediário entre o banco de dados que armazena o conteúdo e o servidor de 
aplicativos que gera a página. Eles consistem nos dados obtidos em uma consulta ao banco de 
dados e são temporariamente armazenados na memória do servidor de aplicativos, para que a 
recuperação seja mais rápida. O servidor descarta o recordset quando deixa de ser necessário.
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O recordset é uma coleção de dados recuperados em determinado banco de dados. Ele pode 
conter uma tabela inteira de banco de dados ou um subconjunto de linhas e colunas da tabela. 
Essas linhas e colunas são recuperadas como resultado de uma consulta ao banco de dados que 
está definida no recordset. As consultas ao banco de dados são escritas em Structured Query 
Language (SQL, linguagem de consulta estruturada), uma linguagem simples que permite 
recuperar, adicionar e excluir dados de/para um banco de dados. O criador de SQL incluído 
no Dreamweaver permite criar consultas simples sem a necessidade de conhecer a SQL. 
Contudo, para criar consultas SQL complexas, é necessário aprender SQL e escrever 
manualmente as instruções SQL a serem inseridas no Dreamweaver.

Para obter mais informações sobre como utilizar bancos de dados e SQL, consulte 
Apêndice A, “Guia do iniciante em bancos de dados”, na página 1085 e Apêndice B, “Manual 
básico de SQL”, na página 1101.

Se você for gravar SQL para utilizar com o ASP.NET, precisará conhecer algumas condições 
específicas do ASP.NET. Para conhecer melhor essas condições, consulte “Gravar SQL para 
ASP.NET” na página 762.

Para definir um recordset a ser utilizado no Dreamweaver, é necessário criar uma conexão a 
um banco de dados e digitar dados no banco de dados, caso ainda não existam. Se você ainda 
não tiver definido uma conexão de banco de dados para o seu site, consulte o capítulo sobre 
este assunto para obter informações sobre a tecnologia de servidor que está sendo desenvolvida 
e siga as instruções para criação de uma conexão de banco de dados.

As conexões de banco de dados para todas as tecnologias de servidor aceitas pelo Dreamweaver 
estão descritas nos seguintes capítulos:

■ Capítulo 24, “Conexões de banco de dados para desenvolvedores ColdFusion”, na 
página 669

■ Capítulo 26, “Conexões de banco de dados para desenvolvedores de ASP”, na página 681
■ Capítulo 25, “Conexões de banco de dados para desenvolvedores de ASP.NET”, na 

página 673
■ Capítulo 27, “Conexões de banco de dados para desenvolvedores JSP”, na página 695
■ Capítulo 28, “Conexões de banco de dados para desenvolvedores PHP”, na página 705

Tópicos relacionados
■ “Definir um recordset” na página 765

N
O

T
A

O Microsoft ASP.NET refere-se a um recordset como DataSet. Se você estiver 
trabalhando com tipos de documento ASP.NET, as caixas de diálogo e opções de menu 
específicas do ASP.NET utilizam a denominação DataSet. A documentação do 
Dreamweaver refere-se a ambos os tipos como recordsets, mas utiliza DataSet ao 
descrever especificamente os recursos do ASP.NET.
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Gravar SQL para ASP.NET
Para gravar as instruções SQL na caixa de diálogo Advanced DataSet (DataSet avançado), é 
necessário conhecer determinadas condições específicas do ASP.NET. Essas condições são 
descritas nas seções a seguir.

Parâmetros
A sintaxe usada para fazer referência a parâmetros varia de acordo com a conexão do banco de 
dados em uso; por exemplo: OLE DB (Banco de dados OLE) ou  Microsoft SQL Server. 

OLE DB

Quando a conexão ao banco de dados for estabelecida utilizando a tecnologia OLE DB, a 
referência aos parâmetros deve conter um ponto de interrogação (?). Por exemplo:
SELECT * FROM Employees WHERE HireDate > ?

Microsoft SQL Server

No estabelecimento da conexão ao Microsoft SQL Server utilizando o Managed Data 
Provider (Provedor de dados gerenciados) para o SQL Server, fornecido com o .NET 
Framework, todos os parâmetros deverão ter um nome. Por exemplo:
SELECT * FROM Employees WHERE HireDate > @hireDate

Inserir código nas instruções SQL
Quando for inserir código nas instruções SQL gravadas para ASP.NET, envolva todas as 
seqüências de caracteres em aspas duplas (" ") e coloque o código entre parênteses ( ).
SELECT * FROM Employees WHERE HireDate > "+ 

(Request.queryString("hireDate"))

Tópicos relacionados:
■ Capítulo 25, “Conexões de banco de dados para desenvolvedores de ASP.NET”, na 

página 673. 
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Parâmetros de URL e de formulários
Os parâmetros de URL armazenam as informações recuperadas, que foram inseridas pelos 
usuários. Para definir um parâmetro da URL, crie um formulário ou link de hipertexto que 
utilize o método GET para enviar dados. As informações são anexadas à URL da página 
solicitada e comunicadas ao servidor. Quando as variáveis de URL são utilizadas, a seqüência 
de caracteres da consulta contém um ou mais pares de nome/valor que estão associados aos 
campos de formulário. Esses pares de nome/valor são anexados à URL.

Os parâmetros de formulário armazenam as informações recuperadas, que são incluídas na 
solicitação de HTTP de uma página da Web. Se for criado um formulário que utilize o 
método POST, os dados enviados pelo formulário serão repassados ao servidor. Antes de iniciar, 
certifique-se de ter repassado um parâmetro de formulário ao servidor. Para obter instruções, 
consulte Capítulo 32, “Obter dados para a página”, na página 745.

Tópicos relacionados
■ “Definir os parâmetros de URL” na página 769
■ “Definir os parâmetros de formulário” na página 771

Sobre variáveis de sessão
As variáveis de sessão permitem armazenar e exibir as informações mantidas durante a visita 
(ou sessão) de um usuário. O servidor cria um objeto de sessão diferente para cada usuário e o 
mantém durante um período de tempo definido ou até que o objeto seja explicitamente 
finalizado. Para obter mais informações, consulte “Acessar dados armazenados em variáveis de 
sessão” na página 752.

As variáveis de sessão são ideais para armazenar as preferências do usuário, porque elas se 
mantêm durante toda a sessão e permanecem inalteradas quando o usuário se move de uma 
página para outra no site da Web. As variáveis de sessão também podem ser utilizadas para 
inserir um valor no código HTML da página, designar o valor de uma variável local ou 
fornecer um valor para avaliar uma expressão condicional.

Antes de definir as variáveis de sessão para uma página, é necessário criá-las no código-fonte. 
Para obter instruções, consulte “Coletar dados enviados por usuários” na página 747 e 
“Acessar dados armazenados em variáveis de sessão” na página 752. 

Depois de criar uma variável de sessão no código-fonte do aplicativo para a Web, é possível 
utilizar o Dreamweaver para recuperar o seu valor e usá-lo na página da Web. 
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Tópicos relacionados
■ “Variáveis de aplicativos ASP e ColdFusion” na página 764
■ “Definir as variáveis de sessão” na página 772

Variáveis de aplicativos ASP e ColdFusion
Em ASP e ColdFusion, você pode utilizar as variáveis de aplicativo para armazenar e exibir as 
informações que são mantidas pelo tempo de utilização do aplicativo e que permanecem 
independentemente do usuário. O tempo de utilização do aplicativo se prolongará desde o 
momento em que o primeiro usuário solicitar uma página no aplicativo até o momento em 
que o servidor da Web for parado. Um aplicativo é definido como todos os arquivos contidos 
em um diretório virtual e seus subdiretórios.

As variáveis de aplicativo são ideais para armazenar as informações que devem existir para 
todos os usuários como, por exemplo, a data e hora atuais, porque elas se mantêm durante o 
tempo de utilização do aplicativo e não são alteradas de usuário para usuário. O valor da 
variável de aplicativo é definido no código do aplicativo.

Para obter mais informações, consulte “Definir variáveis de aplicativo ASP e ColdFusion” na 
página 773 e “Adicionar conteúdo dinâmico a páginas da Web” na página 781.

Variáveis de servidor ASP
As variáveis de servidor ASP podem ser definidas como fontes de conteúdo dinâmico: 
Request.Cookie, Request.QueryString, Request.Form, Request.ServerVariables e 
Request.ClientCertificates. 

Tópicos relacionados
■ “Definir variáveis de servidor ASP” na página 775

Variáveis de servidor ColdFusion
Você pode definir as seguintes variáveis de servidor ColdFusion:

Variáveis de cliente associam os dados a um determinado cliente. Essas variáveis são 
utilizadas para manter o estado do aplicativo à medida que o usuário se move de uma página 
para outra ou de uma sessão para outra. “Manter o estado” significa preservar as informações 
de uma página (ou sessão), de modo que o aplicativo “se lembre” do usuário e de suas opções e 
preferências anteriores.

Variáveis de cookie acessam os cookies repassados para o servidor pelo navegador.
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Variáveis de CGI fornecem informações sobre o servidor que executa o ColdFusion, o 
navegador que solicita a página e outras informações sobre o ambiente de processamento.

Variáveis de servidor podem ser acessadas por todos os clientes e aplicativos no servidor. Elas 
se mantêm até que o servidor seja parado.

Variáveis locais são criadas com a tag CFSET ou CFPARAM, na página ColdFusion. 

Tópicos relacionados
■ “Definir as variáveis de servidor ColdFusion” na página 776
■ “Definir as variáveis de servidor JSP” na página 777
■ “Definir as variáveis de servidor PHP” na página 777

Definir um recordset
Você pode definir um recordset usando a caixa de diálogo Simple Recordset (Recordset 
simples) do Dreamweaver, que lhe permite criar com facilidade instruções SQL simples, ou 
usar a caixa de diálogo Advanced Recordset (Recordset avançado), que permite gravar suas 
próprias instruções SQL, ou, ainda, usar a hierarquia gráfica Database Items (Itens de banco 
de dados) para criar uma instrução SQL.

Se não estiver familiarizado com a gravação de instruções SQL para a recuperação de 
informações de um banco de dados, use a caixa de diálogo Simple Recordset.

Esta seção contém os tópicos a seguir:

■ “Criar um recordset sem gravar SQL” na página 765
■ “Criar um recordset avançado gravando SQL” na página 767
■ “Criar consultas SQL utilizando a hierarquia Database Items (Itens de banco de dados)” 

na página 768

Tópicos relacionados
■ “Definir um recordset em um componente ColdFusion” na página 984

Criar um recordset sem gravar SQL 
Esta seção descreve como definir um recordset utilizando a caixa de diálogo Dreamweaver’s 
Recordset (Recordset do Dreamweaver), que permite criar um recordset sem precisar inserir 
manualmente as instruções SQL. Para definir um recordset por esse método, basta selecionar 
uma conexão e uma tabela de banco de dados nos menus pop-up da caixa de diálogo 
Recordset.
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Se desejar gravar suas próprias instruções SQL, utilize a caixa de diálogo Advanced Recordset 
(Recordset avançado). Consulte  “Criar um recordset avançado gravando SQL” na 
página 767.

Para definir um recordset sem utilizar SQL:

1. Na janela do documento, abra a página que utilizará o recordset.

2. Selecione Window (Janela) > Bindings (Ligações) para exibir o painel Bindings.

3. No painel Bindings, clique no botão com o sinal de adição (+) e escolha Recordset (Query) 
(Recordset [consulta]) no menu pop-up. 

Será exibida a caixa de diálogo Recordset simples. Se você estiver desenvolvendo um site 
do ColdFusion ou do ASP.NET, a caixa de diálogo Recordset será um pouco diferente do 
exemplo mostrado abaixo. (Se, em vez disso, aparecer a caixa de diálogo Advanced 
Recordset, alterne para a caixa de diálogo Simple Recordset, clicando no botão Simple 
(Simples).

4. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) na caixa de diálogo.
5. Clique no botão Test (Testar) para executar a consulta e assegurar que ela recupere as 

informações desejadas.

Se tiver sido definido um filtro que utilize parâmetros inseridos pelo usuário, o botão Test 
exibirá a caixa de diálogo Test Value (Valor de teste). Digite um valor na caixa de texto 
Test Value e clique em OK. Se for criada corretamente uma instância do recordset, será 
exibida uma tabela mostrando os dados extraídos desse recordset.

6. Clique em OK para adicionar o recordset à lista de conteúdos originais disponíveis no 
painel Bindings.
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Criar um recordset avançado gravando SQL
A caixa de diálogo Advanced Recordset (Recordset avançado) permite gravar as suas próprias 
instruções SQL ou utilizar a hierarquia gráfica Database Items (Itens de banco de dados) para 
criar uma instrução SQL.

Se desejar criar uma recordset simples sem gravar manualmente em SQL, consulte “Criar 
consultas SQL utilizando a hierarquia Database Items (Itens de banco de dados)” na 
página 768.

Para definir um recordset gravando SQL:

1. Na janela do documento, abra a página que utilizará o recordset.

2. Selecione Window (Janela) > Bindings (Ligações) para exibir o painel Bindings.

3. No painel Bindings, clique no botão com o sinal de adição (+) e escolha Recordset (Query) 
(Recordset [consulta]) no menu pop-up.

Será exibida a caixa de diálogo Advanced Recordset. Se você estiver desenvolvendo um site 
do ColdFusion ou do ASP.NET, a caixa de diálogo Recordset será um pouco diferente do 
exemplo mostrado abaixo. Se, no lugar dela, aparecer a caixa de diálogo Recordset simples, 
alterne para a caixa de diálogo Recordset avançada, clicando no botão Advanced 
(Avançado).

4. Preencha a caixa de diálogo.

Para obter instruções sobre como preencher a caixa de diálogo Recordset, clique no botão 
Help (Ajuda) da caixa de diálogo Recordset.

N
O

T
A

Se você estiver gravando instruções SQL para tipos de documentos ASP.NET, consulte 
“Criar consultas SQL utilizando a hierarquia Database Items (Itens de banco de dados)” 
na página 768 para obter as regras específicas para ASP.NET.
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5. Clique no botão Test (Testar) para executar a consulta e assegurar que ela recupere as 
informações desejadas.

Se tiver sido definido um filtro que utilize parâmetros inseridos pelo usuário, o botão Test 
exibirá a caixa de diálogo Test Value (Valor de teste). Digite um valor na caixa de texto 
Test Value e clique em OK. Se for criada corretamente uma instância do recordset, será 
exibida uma tabela mostrando os dados extraídos desse recordset.

6. Clique em OK para adicionar o recordset à lista de conteúdos originais disponíveis no 
painel Bindings.

Criar consultas SQL utilizando a hierarquia Database 
Items (Itens de banco de dados)
Em vez de inserir manualmente as instruções SQL na caixa de texto apropriada, é possível 
utilizar a interface do tipo apontar e clicar da hierarquia Database Items (Itens de banco de 
dados) para criar consultas SQL complexas. A hierarquia Database Items permite selecionar 
objetos de banco de dados e vinculá-los usando as cláusulas do SQL SELECT, WHERE e 
ORDER BY. Após criar uma consulta SQL, você poderá definir variáveis utilizando a área 
Variables (Variáveis) da caixa de diálogo.

Os exemplos abaixo descrevem duas instruções SQL e as etapas para criá-las por meio da 
hierarquia Database Items da caixa de diálogo Recordset avançada.

Selecionar uma tabela
Este exemplo seleciona todo o conteúdo da tabela Employees (Empregados). A instrução SQL 
que define a consulta é a seguinte:
SELECT * FROM Employees

Para criar esta consulta:

1. Expanda a ramificação Tables (Tabelas) para exibir todas as tabelas do banco de dados 
selecionado.

2. Selecione a tabela Employees.

3. Clique no botão Select (Selecionar).

4. Clique em OK para adicionar o recordset ao painel Bindings.
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Selecionar linhas específicas em uma tabela e ordenar os 
resultados
O exemplo abaixo seleciona duas linhas da tabela Employees e escolhe o tipo de trabalho, 
utilizando uma variável que você deve definir. Os resultados serão ordenados por nome de 
empregado.
SELECT emplNo, emplName
FROM Employees
WHERE emplJob = 'varJob'
ORDER BY emplName

Para criar esta consulta:

1. Expanda a ramificação Tables para exibir todas as tabelas do banco de dados selecionado e, 
em seguida, expanda a tabela Employees para exibir as linhas da tabela individualmente.

2. Crie a instrução SQL da seguinte forma:

■ Selecione emplNo e clique no botão Select (Selecionar).
■ Selecione emplName e clique no botão Select.
■ Selecione emplJob e clique no botão Where (Onde).
■ Selecione emplName e clique no botão Order By (Classificar por).

3. Coloque o ponto de inserção após WHERE emplJob, na área de texto SQL, e digite 
='varJob' (inclua o sinal de igual).

4. Defina a variável 'varJob' clicando no botão com o sinal de adição (+), na área Variables 
(Variáveis) e inserindo os seguintes valores nas colunas Name (Nome), Default Value 
(Valor padrão) e Run-Time Value (Valor em tempo de execução): varJob, CLERK, 
Request("job").

5. Clique em OK para adicionar o recordset ao painel Bindings.

Definir os parâmetros de URL
Os parâmetros de URL armazenam as informações recuperadas, que foram inseridas pelos 
usuários. Antes de iniciar, certifique-se de ter repassado um formulário ou parâmetro da URL 
ao servidor. Para obter mais informações, consulte “Parâmetros da URL” na página 749 e 
“Parâmetros de URL e de formulários” na página 763.

Para definir um parâmetro da URL:

1. Na janela do documento, abra a página que utilizará a variável.

2. Selecione Window (Janela) > Bindings (Ligações) para exibir o painel Bindings.
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3. No painel Bindings, clique no botão com o sinal de adição (+) e selecione uma das seguintes 
opções no menu pop-up: 

Será exibida a caixa de diálogo URL Variable (Variável de URL).
4. Digite o nome da URL Variable na caixa de texto e clique em OK.

Normalmente, o nome da variável de URL é o mesmo do campo de formulário HTML 
ou do objeto utilizado para obter esse valor.

5. A variável de URL é exibida no painel Bindings. 

Após definir a variável de URL, o seu valor pode ser utilizado na página selecionada. Para 
obter mais informações, consulte Capítulo 34, “Adicionar conteúdo dinâmico a páginas 
da Web”, na página 781.

Tópicos relacionados:
■ “Definir os parâmetros de formulário” na página 771
■ “Definir as variáveis de sessão” na página 772

Tipos de 
documentos

Item de menu no painel Bindings para a variável de URL

ASP Request Variable (Variável de solicitação) > Request.QueryString

ColdFusion URL Variable

JSP Request Variable (Variável de solicitação)

PHP URL Variable
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Definir os parâmetros de formulário
Os parâmetros de formulário armazenam as informações recuperadas, que são incluídas na 
solicitação de HTTP de uma página da Web. Se for criado um formulário que utilize o 
método POST, os dados enviados pelo formulário serão repassados ao servidor. Antes de iniciar, 
certifique-se de ter repassado um parâmetro de formulário ao servidor. Para obter mais 
informações, consulte Capítulo 32, “Obter dados para a página”, na página 745 e  

Para definir um parâmetro de formulário:

1. Na janela do documento, abra a página que utilizará a variável.

2. Selecione Window (Janela) > Bindings (Ligações) para exibir o painel Bindings.

3. No painel Bindings, clique no botão com o sinal de adição (+) e selecione uma das seguintes 
opções no menu pop-up:

Será exibida a caixa de diálogo Form Variable (Variável de formulário). Digite o nome da 
variável de formulário na caixa de diálogo e clique em OK. Normalmente, o nome do 
parâmetro de formulário é o mesmo do campo de formulário HTML ou do objeto 
utilizado para obter esse valor.

4. O parâmetro de formulário é exibido no painel Bindings. 

Tipos de 
documentos

Item de menu no painel Bindings da variável de formulário

ASP Request Variable > Request.Form

ColdFusion Form Variable

JSP Request Variable (Variável de solicitação)

PHP Form Variable
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Após definir o parâmetro de formulário como uma fonte de conteúdo, pode-se utilizar o seu 
valor na página. Para obter mais informações, consulte Capítulo 32, “Obter dados para a 
página”, na página 745.

Tópicos relacionados
■ “Sobre fontes de conteúdo dinâmico” na página 760
■ “Parâmetros de URL e de formulários” na página 763
■ “Definir os parâmetros de URL” na página 769

Definir as variáveis de sessão
É possível utilizar as variáveis de sessão para armazenar e exibir as informações mantidas 
durante a visita (ou sessão) do usuário. O servidor cria um objeto de sessão diferente para cada 
usuário e o mantém durante um período de tempo definido ou até que o objeto seja 
explicitamente finalizado. Para obter mais informações, consulte “Variáveis de sessão” na 
página 752.

Antes de definir as variáveis de sessão para uma página, é necessário criá-las no código-fonte. 
Para obter instruções, consulte os seguintes tópicos:

■ “Coletar dados enviados por usuários” na página 747
■ “Acessar dados armazenados em variáveis de sessão” na página 752
■ “Armazenar informações em variáveis de sessão” na página 755

Depois de criar uma variável de sessão no código-fonte do aplicativo para a Web, é possível 
utilizar o Dreamweaver para recuperar o seu valor e usá-lo na página da Web. 

Para configurar uma variável predefinida de sessão:

1. Crie uma variável de sessão no código-fonte e atribua-lhe um valor.

Por exemplo: este exemplo de ColdFusion produz a instância de uma sessão chamada 
 username e atribui a ela o valorCornelius:
<CFSET session.username = Cornelius>

2. Selecione Window (Janela) > Bindings (Ligações) para exibir o painel Bindings.

3. Clique no botão com o sinal de adição (+) e selecione Session Variable (Variável de sessão) 
no menu pop-up.

4. Digite o nome da variável definida no código-fonte.
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5. Clique em OK.

A variável de sessão é exibida no painel Bindings.

Após definir a variável de sessão, o seu valor pode ser utilizado na página. Para obter mais 
informações, consulte Capítulo 34, “Adicionar conteúdo dinâmico a páginas da Web”, na 
página 781.

Tópicos relacionados
■ “Coletar dados enviados por usuários” na página 747
■ “Acessar dados armazenados em variáveis de sessão” na página 752
■ “Variáveis de sessão” na página 752
■ “Armazenar informações em variáveis de sessão” na página 755

Definir variáveis de aplicativo ASP e 
ColdFusion
Em ASP e ColdFusion, você pode utilizar as variáveis de aplicativo para armazenar e exibir as 
informações que são mantidas pelo tempo de utilização do aplicativo e que permanecem 
constantes de um usuário para outro. 

Para definir a variável de aplicativo para a página:

1. Abra um tipo de documento dinâmico na janela do documento. 

2. Selecione Window (Janela) > Bindings (Ligações) para exibir o painel Bindings.

3. Clique no botão com o sinal de adição (+) e selecione Application Variable (Variável de 
aplicativo) no menu pop-up.

N
O

T
A

Não há objetos de variáveis de aplicativo em JSP ou PHP.
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4. Digite o nome da variável definida no código-fonte do aplicativo.

5. Clique em OK. 

A variável de aplicativo é exibida no painel Bindings, no ícone Application (Aplicativo).

Após definir a variável de aplicativo, o seu valor pode ser utilizado na página. Para obter 
mais informações, consulte Capítulo 34, “Adicionar conteúdo dinâmico a páginas da 
Web”, na página 781.

Tópicos relacionados:
■ “Variáveis de aplicativos ASP e ColdFusion” na página 764

Utilizar uma variável como fonte de 
dados para um recordset ColdFusion
Quando você define um recordset para uma página no painel Bindings (Ligações), o 
Dreamweaver insere o nome da fonte de dados ColdFusion na tag cfquery na página. Para 
obter mais flexibilidade, você pode armazenar o nome de uma fonte de dados em uma variável 
e utilizar essa variável na tag cfquery. O Dreamweaver fornece um método visual de 
especificação desse tipo de variável em recordsets.

Para especificar visualmente uma variável como uma fonte de dados para um 
recordset:

1. Certifique-se de que uma página ColdFusion esteja ativa na janela do documento.

2. No painel Bindings, clique no botão com o sinal de adição (+) e selecione Data Source 
Name Variable (Variável de nome de fonte de dados) no menu pop-up.

A caixa de diálogo Data Source Name Variable é exibida.
3. Defina uma variável e clique em OK.
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4. Quando for definir o recordset, selecione a variável como Data Source (Fonte de dados) 
para o recordset.

Na caixa de diálogo Recordset, a variável aparece no menu pop-up Data Source junto com 
as fontes de dados ColdFusion no servidor.

5. Preencha a caixa de diálogo Recordset e clique em OK.

6. Inicialize a variável.

O Dreamweaver não inicializará a variável para que você possa inicializá-la como e onde 
desejar. Você pode inicializar a variável no código da página (antes da tag cfquery), em 
um arquivo de inclusão ou em algum outro arquivo como uma variável de sessão ou 
aplicativo.

Definir variáveis de servidor
É possível definir as variáveis de servidor como fontes de conteúdo dinâmico para serem 
utilizadas em um aplicativo para a Web. 

As variáveis de servidor variam para cada tipo de documento e incluem variáveis de 
formulário, de URL, de sessão e de aplicativo. Para obter mais informações sobre esses tipos de 
variáveis, consulte as seções abaixo:

■ “Definir os parâmetros de URL” na página 769
■ “Definir os parâmetros de formulário” na página 771
■ “Definir as variáveis de sessão” na página 772
■ “Definir variáveis de aplicativo ASP e ColdFusion” na página 773

Esta sessão discute as variáveis de servidor para diferentes tipos de documentos que você pode 
definir como fontes de conteúdo. Estes são os tipos de documentos e suas correspondentes 
seções:

■ “Definir as variáveis de servidor ColdFusion” na página 776
■ “Definir as variáveis de servidor JSP” na página 777

Definir variáveis de servidor ASP
As variáveis de servidor ASP podem ser definidas como fontes de conteúdo dinâmico: 
Request.Cookie, Request.QueryString, Request.Form, Request.ServerVariables e 
Request.ClientCertificates. 

Para definir uma variável de servidor de uma página ASP:

1. Abra o painel Bindings (Ligações), em Window (Janela) > Bindings.
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2. Clique no botão com o sinal de adição (+) e selecione Request Variable (Variável de 
solicitação) no menu pop-up.

Será exibida a caixa de diálogo Request Variable (Variável de solicitação). Selecione um dos 
conjuntos de solicitações no menu pop-up Type (Tipo).
Por exemplo: se desejar acessar as informações no conjunto Request.ServerVariables, 
selecione Server Variables (Variáveis de servidor). Se desejar acessar as informações no 
conjunto Request.Form, selecione Form (Formulário).
Para obter mais informações sobre as variáveis de servidor ASP, clique no botão Help 
(Ajuda).

3. Especifique a variável no conjunto a ser acessado.

Por exemplo: se desejar acessar as informações na variável 
Request.ServerVariables("HTTP_USER_AGENT"), digite o 
argumentoHTTP_USER_AGENT. Se desejar acessar as informações na variável 
Request.Form("lastname"), digite o argumentolastname.

4. Clique em OK.

A variável de servidor é exibida no painel Bindings. 

Definir as variáveis de servidor ColdFusion
É possível definir as seguintes variáveis de servidor ColdFusion como fontes de conteúdo 
dinâmico: cliente, cookie, CGI, servidor e variáveis locais. Para obter mais informações sobre 
essas variáveis de servidor, consulte “Variáveis de servidor ASP” na página 764.

Para definir uma variável de servidor de uma página ColdFusion:

1. Abra o painel Bindings (Ligações), em Window (Janela) > Bindings.

2. Clique no botão com o sinal de adição (+) e escolha a variável de servidor no menu pop-up.

3. Digite o nome da variável.

Para obter mais informações sobre as possíveis entradas de nomes, clique no botão Help.
4. Clique em OK.

A variável de servidor ColdFusion é exibida no painel Bindings (Ligações).

Tópicos relacionados:
■ “Definir os parâmetros de URL” na página 769
■ “Definir as variáveis de sessão” na página 772
■ “Definir variáveis de aplicativo ASP e ColdFusion” na página 773
■ Capítulo 34, “Adicionar conteúdo dinâmico a páginas da Web”, na página 781
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Definir as variáveis de servidor PHP
Você pode definir uma variável de servidor PHP como fonte do conteúdo dinâmico dos tipos 
de documentos do PHP.

Para definir uma variável de servidor de uma página PHP:

1. Abra o painel Bindings (Ligações), em Window (Janela) > Bindings.

2. Clique no botão com o sinal de adição (+) e escolha a variável no menu pop-up.

3. Digite o nome da variável.

4.  Clique em OK.

A variável de servidor PHP é exibida no painel Bindings.

Tópicos relacionados:
■ Capítulo 33, “Definir os parâmetros de URL”, na página 769
■ Capítulo 34, “Adicionar conteúdo dinâmico a páginas da Web”, na página 781

Definir as variáveis de servidor JSP 
É possível definir uma variável de solicitação como uma fonte de conteúdo dinâmico para as 
páginas JSP.

Para definir uma variável de solicitação de uma página JSP:

1. Abra o painel Bindings (Ligações), em Window (Janela) > Bindings.

2. Clique no botão com o sinal de adição (+) e selecione Request Variable (Variável de 
solicitação) no menu pop-up.

3. Digite o nome da variável.

4.  Clique em OK.

A variável de servidor JSP é exibida no painel Bindings.

Tópicos relacionados:
■ Capítulo 33, “Definir os parâmetros de URL”, na página 769
■ Capítulo 34, “Adicionar conteúdo dinâmico a páginas da Web”, na página 781
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Armazenar em cache as fontes de 
conteúdo
É possível armazenar em cache as fontes de conteúdo dinâmico em uma Design Note. Esse 
recurso permite trabalhar em um site mesmo que o usuário não tenha acesso ao banco de 
dados ou ao servidor de aplicativos que armazena as fontes de conteúdo dinâmico. O 
armazenamento em cache também acelera o desenvolvimento, eliminando o acesso repetitivo 
através de uma rede ao banco de dados e ao servidor de aplicativos.

Para armazenar as fontes de conteúdo:

■ Clique no botão com a seta no canto superior direito do painel Bindings (Ligações) e 
alterne Cache no menu pop-up. 
Se você alterar uma das fontes de conteúdo, poderá atualizar o cache clicando no botão 
Refresh (Atualizar), que exibe o ícone de seta em círculo, no canto superior direito do 
painel Bindings. Se o botão não estiver visível, expanda o painel.

Alterar ou excluir as fontes de conteúdo
É possível alterar ou excluir qualquer fonte de conteúdo dinâmico, ou seja, qualquer fonte de 
conteúdo que estiver indicada no painel Bindings (Ligações). 

A alteração ou exclusão de uma fonte de conteúdo no painel Bindings não altera ou exclui 
qualquer instância desse conteúdo na página. Esse procedimento somente a altera ou exclui 
como uma possível fonte de conteúdo para a página. Para editar ou excluir uma instância do 
conteúdo na página, consulte “Editar conteúdo dinâmico” na página 789 e “Excluir o 
conteúdo dinâmico” na página 789.
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Para alterar uma fonte de conteúdo no painel Bindings: 

1. No painel Bindings (Ligações) (Window > Bindings), clique duas vezes no nome da fonte 
de conteúdo a ser editada.

2. Faça as alterações na caixa de diálogo que será exibida.

3. Se estiver satisfeito com a alteração, clique em OK.

Para excluir uma fonte de conteúdo no painel Bindings: 

1. No painel Bindings (Window > Bindings), selecione a fonte de conteúdo na lista.

2. Clique no botão com o sinal de subtração (-).

Tópicos relacionados
■ “Sobre fontes de conteúdo dinâmico” na página 760

Copiar um recordset para outra página
É possível copiar um recordset de uma página para outra no site.

Para copiar um recordset para outra página:

1. Selecione o recordset no painel Bindings (Ligações) ou no painel Server Behaviors 
(Comportamentos de servidor).

2. Clique com o botão direito do mouse no recordset e selecione Copy from (Copiar de) no 
menu pop-up.

3. Abra a página na qual será copiado o recordset.

4. Clique com o botão direito do mouse no painel Bindings ou na barra de ferramentas Server 
Behaviors e selecione Paste (Colar) no menu pop-up.

Tópicos relacionados:
■ “Sobre fontes de conteúdo dinâmico” na página 760
■ “Alterar ou excluir as fontes de conteúdo” na página 778
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34

CAPÍTULO 34

Adicionar conteúdo dinâmico 
a páginas da Web
Este capítulo descreve as maneiras mais eficientes de tornar dinâmicos vários elementos de 
página. Após definir um ou mais fontes de conteúdo dinâmico, é possível utilizar as fontes 
para adicionar conteúdo dinâmico à página. As fontes de conteúdo podem incluir uma coluna 
em um recordset, um valor enviado por um formulário HTML, o valor contido em um objeto 
de servidor e outros dados. Para obter mais informações, consulte Capítulo 33, “Definir as 
fontes de conteúdo dinâmico”, na página 759. 

No Macromedia Dreamweaver 8, é possível inserir conteúdo dinâmico em praticamente todos 
os locais de uma página da Web ou de seu código-fonte HTML. É possível inserir conteúdo 
dinâmico no local onde está posicionado o ponto de inserção, substituir uma seqüência de 
caracteres de texto ou inserir esse conteúdo como um atributo HTML. Por exemplo: o 
conteúdo dinâmico pode definir o atributo src de uma imagem ou o atributo value de um 
campo de formulário.

Este capítulo contém as seguintes seções:
Sobre a adição de conteúdo dinâmico  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 781

Tornar dinâmico o texto  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .783

Tornar dinâmicas as imagens  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .785

Tornar dinâmicos atributos HTML . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .786

Tornar dinâmicos objetos ActiveX, Flash e outros parâmetros de objetos . . . . . . 788

Editar conteúdo dinâmico. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .789

Excluir o conteúdo dinâmico . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .789

Criar páginas dinâmicas em um site do Contribute. . . . . . . . . . . . . . . . . . . . . . . . . . .790

Sobre a adição de conteúdo dinâmico
É possível adicionar conteúdo dinâmico a uma página selecionando uma fonte de conteúdo 
no painel Bindings (Ligações). O Dreamweaver insere um script do servidor no código da 
página, instruindo o servidor a transferir os dados da fonte de conteúdo para o código HTML 
da página quando esta for solicitada por um navegador.
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Normalmente, há mais de uma maneira de tornar dinâmico determinado elemento de uma 
página. Por exemplo: para tornar dinâmica uma imagem, é possível utilizar o painel Bindings, 
o Property Inspector (Inspetor de propriedades) ou o comando Image (Imagem) no menu 
Insert (Inserir).

Como padrão, uma página HTML pode exibir somente um registro de cada vez. Para exibir 
os outros registros no recordset, você pode adicionar um link para se mover pelos 
registros, um de cada vez (consulte “Criar links de navegação para recordsets” na página 802), 
ou pode criar uma região repetida para exibir mais de um registro em uma única 
página (consulte “Exibir vários resultados de recordsets” na página 806).

Texto dinâmico
O texto dinâmico adotará qualquer formatação de texto aplicada ao texto existente ou 
ao ponto de inserção. Por exemplo: se um estilo CSS (Cascading Style Sheet, Folha em estilo 
em cascata) afetar o texto selecionado, o conteúdo dinâmico que o substituir também será 
afetado pelo estilo. Também é possível adicionar ou alterar o formato de texto do conteúdo 
dinâmico por meio de qualquer ferramenta de formatação de texto do Dreamweaver. 
Consulte “Aplicar elementos tipográficos e de layout de página a dados dinâmicos” na 
página 795.

Também é possível aplicar um formato de dados ao texto dinâmico. Por exemplo: se os dados 
consistirem em datas, é possível especificar um formato de data especial como, por exemplo, 
04/17/00 para os visitantes americanos ou 17/04/00 para os visitantes brasileiros. Consulte 
“Utilizar formatos de dados predefinidos” na página 800. 

É possível substituir um texto comum na página por um texto dinâmico ou adicionar um 
texto dinâmico no ponto de inserção na página.

Alterar o conteúdo dinâmico 
É possível alterar o conteúdo dinâmico na página editando o comportamento do servidor que 
fornece o conteúdo. Por exemplo, é possível editar um comportamento do servidor do 
recordset para que ele forneça mais registros à página.

O conteúdo dinâmico de uma página é listado no painel Server Behaviors (Comportamentos 
de servidor). Por exemplo, quando um recordset é adicionado à página, o painel Server 
Behaviors lista o recordset da seguinte forma: 
Recordset(myRecordset)
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Se você adicionar outro recordset à página, o painel Server Behaviors listará os dois recordsets 
da seguinte forma:
Recordset(mySecondRecordset)
Recordset(myRecordset)

Tópicos relacionados:
■ “Editar conteúdo dinâmico” na página 789
■ “Excluir o conteúdo dinâmico” na página 789

Tornar dinâmico o texto
É possível substituir um texto existente por um texto dinâmico ou colocar um texto dinâmico 
em um ponto de inserção específico na página. 

Para adicionar um texto dinâmico:

1. Abra o painel Bindings (Ligações) selecionando Window (Janela) > Bindings.

2. Verifique se o painel Bindings relaciona a fonte de conteúdo que você deseja utilizar. 

A fonte de conteúdo deve conter texto simples (texto ASCII). O texto simples inclui 
HTML. Se nenhuma fonte de conteúdo aparecer na lista ou se as fontes de conteúdo 
disponíveis não atenderem às suas necessidades, clique no botão de adição (+) para definir 
uma nova fonte de conteúdo. Consulte Capítulo 33, “Definir as fontes de 
conteúdo dinâmico”, na página 759.

3. No modo de visualização do projeto, selecione o texto da página ou clique no local onde 
deseja adicionar o texto dinâmico.
Tornar dinâmico o texto 783



         
4. No painel Bindings, selecione uma fonte de conteúdo da lista. Se um recordset for 
selecionado, especifique a coluna desejada no recordset.

5. Clique em Insert (Inserir) ou arraste a fonte de conteúdo para a página.

O conteúdo dinâmico será exibido na página se você estiver trabalhando na visualização do 
projeto com a opção Live Data (Dados ativos) ativada; selecione essa opção a partir de View 
(Exibir) > Live Data (Dados ativos).

Se Live Data estiver ativo, um alocador de espaço será exibido. (Se você selecionou um texto 
na página, o alocador de espaço substituirá a seleção de texto.) O alocador de espaço do 
conteúdo do recordset utiliza a sintaxe {RecordsetName.ColumnName}, onde Recordset é o 
nome do recordset e ColumnName é o nome da coluna escolhida do recordset. 

Às vezes, o comprimento dos alocadores de espaço de texto dinâmico distorce o layout da 
página na janela do documento. É possível resolver o problema utilizando as chaves vazias 
como alocadores de espaço. 

Para criar alocadores de espaço de texto dinâmico:

1. Selecione Edit (Editar) > Preferences (Preferências) > Invisible Elements (Elementos 
invisíveis) (no Windows) ou Dreamweaver > Preferences > Invisible Elements (no 
Macintosh). 

2. No menu pop-up Show Dynamic Text As (Mostrar texto dinâmico como), selecione {}.

3. Clique em OK.

Tópicos relacionados
■ “Sobre a adição de conteúdo dinâmico” na página 781
■ “Texto dinâmico” na página 782
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Tornar dinâmicas as imagens 
É possível tornar dinâmicas as imagens na página. Por exemplo, suponha que uma página seja 
projetada para exibir os itens para vendas num leilão de caridade. Cada página incluiria um 
texto descritivo e uma fotografia de um item. O layout geral da página permaneceria o mesmo 
para cada item, mas a fotografia e o texto descritivo poderiam mudar.

Para tornar dinâmica uma imagem:

1. Abra a página na visualização do projeto (View > Design) e posicione o ponto de inserção 
no local onde deseja que a imagem apareça na página.

2. Selecione Insert (Insert) > Image (Imagem).

A caixa de diálogo Select Image Source (Selecionar origem da imagem) é exibida.
3. Clique na opção Data Sources (Fontes de dados) (no Windows) ou no botão Data Source 

(Fonte de dados) (no Macintosh).

Uma lista de fontes de conteúdo é exibida.

4. Selecione uma fonte de conteúdo na lista.

A fonte do conteúdo deve ser um recordset que contenha os caminhos de seus arquivos de 
imagens. Dependendo da estrutura de arquivos do seu site, tais caminhos podem ser 
absolutos, relativos ao documento ou relativos à raiz.

Se nenhum recordset for exibido na lista ou, se os que estiverem disponíveis não 
atenderem às suas necessidades, defina um novo recordset. Para obter instruções, consulte 
“Recordsets” na página 760. 

N
O

T
A

O Dreamweaver ainda não oferece suporte a imagens binárias armazenadas em 
bancos de dados.
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5. Clique em OK.

Tornar dinâmicos atributos HTML 
É possível alterar dinamicamente a aparência da página ligando os atributos HTML aos 
dados. Por exemplo, é possível alterar a imagem de fundo de uma tabela ligando o atributo 
background da tabela a um campo de um recordset. 

É possível ligar atributos HTML com o painel Bindings (Ligações) com o Property Inspector 
(Inspetor de propriedades). 

Para tornar dinâmicos atributos HTML com o painel Bindings: 

1. Abra o painel Bindings (Ligações) selecionando Window (Janela) > Bindings.

2. Verifique se o painel Bindings relaciona as fontes de dados que você deseja utilizar.

A fonte de conteúdo deve conter os dados apropriados ao atributo HTML que você deseja 
relacionar. Se nenhuma fonte de conteúdo aparecer na lista, ou se as fontes de conteúdo 
disponíveis não atenderem as suas necessidades, clique no botão de adição (+) para definir 
uma nova fonte de dados. Para obter instruções, consulte Capítulo 33, “Definir as fontes 
de conteúdo dinâmico”, na página 759. 

3. Na visualização do projeto, selecione um objeto HTML.

Por exemplo, para selecionar uma tabela HTML, clique no interior da tabela e, em 
seguida, na tag <table>, no seletor de tags localizado no canto inferior esquerdo da janela 
do documento. 

4. No painel Bindings, selecione uma fonte de conteúdo na lista.

5. Na caixa Bind To (Ligar a), selecione um atributo HTML do menu pop-up.

6. Clique em Bind (Ligar).

Sempre que a página for executada no servidor de aplicativos, o valor da fonte de dados será 
atribuído ao atributo HTML.

Para tornar dinâmicos atributos HTML com o Property Inspector: 

1. Na visualização do projeto, selecione um objeto HTML e abra o Property Inspector 
(Propriedades) a partir da seleção de Window (Janela)  >  Properties (Propriedades).

Por exemplo, para selecionar uma tabela HTML, clique no interior da tabela e, em 
seguida, na tag <table>, no seletor de tags localizado no canto inferior esquerdo da janela 
Document (Documento). 
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2. O modo como você vincula uma fonte de conteúdo dinâmico ao atributo HTML depende 
de sua localização: 

■ Se, junto ao atributo que você deseja vincular, houver um ícone em formato de pasta 
no Property inspector, clique sobre o ícone da pasta para abrir uma caixa de diálogo 
com uma seleção de arquivos. Em seguida, clique na opção Data Sources para exibir 
uma lista de fontes de dados. 

■ Se não houver um ícone de pasta ao lado do atributo que você deseja vincular, clique 
na guia List (a mais baixa das duas guias) no lado esquerdo do inspetor.
Aparecerá a visualização de lista do Property inspector (Inspetor de propriedades). 

■ Se o atributo que você deseja vincular não estiver na lista, clique no botão com o sinal 
de adição (+) e, em seguida, digite o nome do atributo ou clique no botão de seta 
pequena e selecione o atributo no menu pop-up.

3. Para tornar dinâmico o valor do atributo, clique no atributo e, em seguida, clique no ícone 
de raio ou no ícone de pasta no final da linha do atributo.

Se você clicou no ícone de raio, aparecerá uma lista de fontes de dados. 
Por exemplo:

Se você clicar no ícone de pasta aparecerá uma caixa de diálogo de seleção de arquivo. 
Clique na opção Data Sources (Fontes de dados) para exibir uma lista de fontes de 
conteúdo.
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4. Selecione uma fonte de conteúdo na lista de fontes de dados.

A fonte de conteúdo deve conter os dados apropriados ao atributo HTML que você deseja 
ligar. Se nenhuma fonte de conteúdo aparecer na lista ou se as fontes de conteúdo 
disponíveis não atenderem às suas necessidades, defina uma nova fonte de conteúdo. Para 
obter instruções, consulte Capítulo 32, “Obter dados para a página”, na página 745.

5. Clique em OK.

Sempre que a página for executada no servidor de aplicativos, o valor da fonte de dados será 
atribuído ao atributo HTML.

Tornar dinâmicos objetos ActiveX, Flash 
e outros parâmetros de objetos
É possível tornar dinâmicos os parâmetros de miniaplicativos e plug-ins Java, bem como os 
parâmetros de objetos ActiveX, Macromedia Flash, Shockwave, Director e Generator.

Antes de começar, verifique se os campos no recordset contêm dados apropriados para os 
parâmetros dos objetos que deseja ligar.

Para tornar dinâmicos parâmetros de objetos:

1. Na visualização do projeto, selecione um objeto na página e abra o Property Inspector 
(Inspetor de propriedades) a partir da seleção de Window (Janela) > Properties. 

2. Clique no botão Parameters (Parâmetros).

A caixa de diálogo Parameters é exibida.

3. Se o seu parâmetro não aparecer na lista, clique no botão de adição (+) e digite um nome 
de parâmetro na coluna Parameter.

4. Clique na coluna Value (Valor) do parâmetro e, em seguida, clique no ícone de raio para 
especificar um valor dinâmico.

Uma lista de fontes de dados é exibida. 
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5. Selecione uma fonte de dados na lista.

A fonte de dados deve conter os dados apropriados ao parâmetro do objeto que você deseja 
ligar. Se nenhuma fonte de dados aparecer na lista ou se as fontes de dados disponíveis não 
atenderem às suas necessidades, defina uma nova fonte de dados. Para obter instruções, 
consulte Capítulo 33, “Definir as fontes de conteúdo dinâmico”, na página 759.

6. Clique em OK.

Editar conteúdo dinâmico
Para editar um comportamento do servidor que fornece o conteúdo dinâmico, clique duas 
vezes no comportamento do servidor no painel Server Behaviors (Comportamentos de 
servidor). Será exibida a mesma caixa de diálogo que você usou para definir a fonte de 
dados original. Faça as alterações na caixa de diálogo e clique em OK.

Também é possível utilizar o Property Inspector (Inspetor de propriedades) para editar os 
recordsets na página. Abra o Property inspector (Window > Properties) e, em seguida, 
selecione o recordset no painel Server Behaviors (Window > Server Behaviors).

Se um recordset for editado na janela Live Data (Dados ativos) com a opção Auto Refresh 
(Atualização automática) não selecionada, será necessário atualizar a página para visualizar as 
alterações. Para atualizar a página, clique no botão Refresh (Atualizar) e selecione View > 
Refresh Live Data (Atualizar dados ativos).

Tópicos relacionados
■ “Editar conteúdo dinâmico” na página 789

Excluir o conteúdo dinâmico 
Após adicionar o conteúdo dinâmico a uma página, é possível exclui-lo selecionando-o na 
página e pressionando a tecla Delete. Também é possível excluir o conteúdo dinâmico através 
de sua seleção no painel Server Behaviors (Comportamentos de servidor) e, em seguida, 
clicando no botão de subtração (-).

Tópicos relacionados
■ “Editar conteúdo dinâmico” na página 789
■ “Editar conteúdo dinâmico” na página 789

N
O

T
A

Essa operação remove o script do servidor na página que recupera o conteúdo dinâmico 
do banco de dados. Ela não exclui os dados do banco de dados.
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Criar páginas dinâmicas em um site do 
Contribute
Quando um usuário do Contribute estiver editando uma página com conteúdo dinâmico ou 
elementos ocultos (como scripts e comentários), o Contribute exibirá o conteúdo dinâmico e 
elementos ocultos em forma de marcadores amarelos. Por padrão, os usuários do Contribute 
não podem selecionar ou excluir esses marcadores.

Se desejar que os usuários do Contribute possam selecionar e excluir o conteúdo dinâmico e 
outros elementos ocultos de uma página, é possível modificar as configurações do grupo de 
permissões para isso; os usuários do Contribute geralmente não podem editar o conteúdo 
dinâmico, mesmo se forem autorizados a selecioná-lo.

Para permitir a um grupo de usuários do Contribute excluir códigos de 
páginas:

1. Selecione Site > Administer Contribute Site (Administrar site do Contribute).

2. Se determinadas opções exigidas para a compatibilidade do Contribute não estiverem 
ativadas, uma caixa de diálogo será exibida perguntando se você desejar ativar essas opções. 
Clique em OK para ativar essas opções e a compatibilidade do Contribute. Para obter mais 
informações, consulte “Preparar um site para utilizar com o Contribute” na página 207.

3. Se solicitado, digite a senha de administrador e clique em OK.

A caixa de diálogo Administer Website (Administrar site da Web) é exibida.
4. Na categoria Users and Roles (Usuários e funções), selecione uma função e, em seguida, 

clique no botão Edit Role Settings (Editar configurações de função).

5. Selecione a categoria Editing (Edição) e desmarque a opção para proteger scripts e 
formulários.  Para obter mais informações, consulte “Criar modelos para um site do 
Contribute” na página 344 e Administering Macromedia Contribute.

6. Clique em OK para fechar a caixa de diálogo Edit Settings (Editar configurações).

N
O

T
A

Por meio de algumas tecnologias de servidor, é possível exibir o texto estático utilizando 
uma tag ou função do servidor. Para permitir que usuários do Contribute possam editar o 
texto estático em uma página dinâmica com essa tecnologia de servidor, coloque o texto 
estático fora das tags do servidor.
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7. Clique em Close (Fechar) para fechar a caixa de diálogo Administer Website (Administrar 
site da Web).

Tópicos relacionados
■ “Gerenciar sites do Contribute com o Dreamweaver” na página 201
■ “Criar modelos para um site do Contribute” na página 344
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35

CAPÍTULO 35

Exibir registros de bancos de 
dados
A exibição de registros de banco de dados envolve recuperar informações armazenadas em um 
banco de dados ou em outra fonte de conteúdo e submeter essas informações a uma página da 
web. O Macromedia Dreamweaver 8 oferece diversos métodos de exibição de conteúdo 
dinâmico e vários comportamentos de servidor incorporados que possibilitam aprimorar a 
apresentação do conteúdo dinâmico e facilitam a busca de informações e a navegação nas 
informações retornadas de um banco de dados.

Este capítulo contém as seguintes seções:
Sobre a exibição de registros de bancos de dados  . . . . . . . . . . . . . . . . . . . . . . . . . .793

Utilizar formatos de dados predefinidos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 800

Criar links de navegação para recordsets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 802

Mostrar ou ocultar regiões com base em resultados do recordset . . . . . . . . . . . . 806

Exibir vários resultados de recordsets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 806

Criar uma tabela com um comportamento de servidor Repeat Region 
(Repetir região) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .808

Criar um contador de registros  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 809

Sobre a exibição de registros de bancos 
de dados
Os bancos de dados e outras fontes de conteúdo dinâmico fornecem mais capacidade e 
flexibilidade na busca, classificação e visualização de grande volume de informações 
armazenadas. A utilização de um banco de dados para armazenar conteúdo para sites da Web 
faz sentido quando é necessário armazenar um grande volume de informações e recuperar e 
exibir essas informações de uma forma compreensiva. O Dreamweaver fornece diversas 
ferramentas e comportamentos predefinidos para ajudá-lo, de forma eficiente, a recuperar e 
exibir informações armazenadas em um banco de dados. As próximas seções descrevem os 
comportamentos de servidor e os elementos de formatação do Dreamweaver, e como você 
pode utilizá-los para exibir conteúdo dinâmico. 
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Comportamentos de servidor e elementos de 
formatação
O Dreamweaver fornece os comportamentos de servidor e elementos de formatação a seguir 
para aprimorar a exibição de dados dinâmicos:

Formats (Formatos): permite aplicar tipos diferentes de valores numéricos, monetários, data/
hora e percentagem ao texto dinâmico. 

Por exemplo, se o preço de um item em um recordset for de 10,989, é possível exibir o preço 
na página como $ 10,99, selecionando o formato “Currency - 2 Decimal Places” (Moeda - 
Duas casas decimais) do Dreamweaver. Este formato exibe um número com duas casas 
decimais. Se o número tiver mais de duas casas decimais, o formato de dados arredondará o 
número para o decimal mais próximo. Se o número não tiver nenhuma casa decimal, o 
formato de dados adicionará um ponto decimal e dois zeros.

Repeated Region (Região repetitiva): esse comportamento de servidor permite exibir itens 
múltiplos retornados de uma consulta a um banco de dados e especificar o número de 
registros a serem exibidos por página.

Recordset Navigation (Navegação no recordset): esse comportamento de servidor permite 
inserir elementos de navegação de modo que os usuários possam ir para o grupo de registros 
seguinte ou anterior retornado pelo recordset. Por exemplo, se 10 registros forem exibidos por 
página utilizando o objeto de servidor Repeated Region (Região repetitiva) e o recordset 
retornar 40 registros, é possível navegar nos 10 registros de uma só vez.

Recordset Status Bar (Barra de status do recordset): esse comportamento de servidor 
inclui um contador que mostra aos usuários onde sua posição dentro de um recordset em 
relação ao número total de registros retornados.

Show Region (Mostrar região): esses comportamentos de servidor permitem mostrar ou 
ocultar itens na página com base na importância dos registros exibidos no momento. Por 
exemplo, se um usuário navegou até o último registro de um recordset, e´possível omitir o link 
“seguinte” e exibir apenas o link dos registros “anteriores”.
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Aplicar elementos tipográficos e de layout de página 
a dados dinâmicos
Um recurso poderoso do Dreamweaver é a capacidade de apresentar dados dinâmicos em uma 
página estruturada e aplicar formatação tipográfica utilizando HTML e CSS. Para aplicar 
formatos a dados dinâmicos no Dreamweaver, formate as tabelas e alocadores de espaço para 
os dados dinâmicos, utilizando as ferramentas de formatação do Dreamweaver. Quando os 
dados forem inseridos da fonte de dados, o programa adotará automaticamente a formatação 
especificada para fontes, parágrafos e tabelas.

Para obter mais informações sobre os recursos de formatação do Dreamweaver e como aplicá-
los a elementos de dados dinâmicos, consulte Capítulo 8, “Apresentar conteúdo com tabelas”, 
na página 257 e Capítulo 13, “Inserir e formatar texto”, na página 405.

Navegar em resultados de recordsets de bancos de 
dados
Os links de navegação do recordset permitem que os usuários se movam entre os registros ou 
conjuntos de registros. Por exemplo, após criar uma página para exibir cinco registros de cada 
vez, adicione links como “Next” (Próximo) ou “Previous” (Anterior) para que os usuários 
possam visualizar os cinco registros anteriores ou posteriores.

O Dreamweaver permite criar quatro tipos de links de navegação para percorrer um recordset: 
First (Primeiro), Previous, Next  e Last (Último). Uma única página pode conter qualquer 
número destes links, desde que todos eles funcionem em apenas um único recordset. Não é 
possível adicionar links para percorrer um segundo recordset na mesma página.

Os links de navegação dos recordsets requerem os seguintes elementos dinâmicos:

■ Um recordset para navegar
■ Conteúdo dinâmico na página, para exibir o registro ou os registros
■ Texto ou imagens na página, para atuar como uma barra de navegação clicável
■ Um conjunto de comportamentos de servidor ”Move To Record” (Mover para o registro) 

para percorrer o recordset 

N
O

T
A

O Microsoft ASP.NET refere-se a um recordset como DataSet. Se você estiver 
trabalhando com tipos de documento ASP.NET, as caixas de diálogo e opções de menu 
específicas do ASP.NET utilizam a denominação DataSet. A documentação do 
Dreamweaver refere-se a ambos os tipos como recordsets, mas utiliza DataSet ao 
descrever especificamente os recursos do ASP.NET.
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É possível adicionar os dois últimos elementos utilizando o objeto de servidor Recordset 
Navigation Bar (Barra de navegação do recordset) ou adicioná-los separadamente utilizando as 
ferramentas de criação do Dreamweaver e o painel Server Behaviors (Comportamentos de 
servidor). 

Tópicos relacionados
■ “Criar links de navegação para recordsets” na página 802

Criar barras de navegação personalizadas para 
recordsets
Se desejar criar uma barra de navegação para um recordset utilizando estilos de layout e de 
formatação mais complexos do que os oferecidos pela tabela simples criada a partir do objeto 
de servidor Recordset Navigation Bar (Barra de navegação para recordset), poderá preferir 
criar a sua própria barra de navegação. Para isto, é preciso criar primeiro os links de navegação 
necessários (seja em forma de texto ou imagens) inseri-los na página na visualização do projeto 
e atribuir a cada um deles comportamentos de servidor individuais.

É possível atribuir os seguintes comportamentos de servidor individuais a links de navegação:

■ Move to first page (Mover para a primeira página)
■ Move to last page (Mover para a última página)
■ Move to next page (Mover para a próxima página)
■ Move to previous page (Mover para a página anterior)

Se preferir utilizar o objeto de servidor Recordset Navigation Bar incorporado do 
Dreamweaver para criar uma barra de navegação, consulte “Criar uma barra de navegação 
utilizando o comportamento de servidor Recordset Navigation Bar (Barra de navegação para 
recordset)” na página 803.

Tarefas para criação da barra de navegação
Ao criar uma barra de navegação, comece criando sua representação visual, utilizando as 
ferramentas de criação de páginas do Dreamweaver. Não é necessário criar um link para a 
seqüência de caracteres de texto ou imagem, pois o Dreamweaver o criará automaticamente.

A página criada para a barra de navegação deve conter um recordset para navegação. Para 
obter mais informações, consulte “Recordsets” na página 760.

Uma barra de navegação para recordset simples pode parecer com a do exemplo, com botões 
de links criados a partir de imagens ou outros elementos de conteúdo: 
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Após adicionar um recordset a uma página e criar uma barra de navegação, é necessário aplicar 
comportamentos de servidor individuais a cada elemento de navegação. Por exemplo, uma 
barra de navegação para recordset típica contém representações dos links correspondentes ao 
comportamento apropriado:

Tópicos relacionados
■ “Exibir vários resultados de recordsets” na página 798

Mostrar ou ocultar regiões com base em resultados 
de recordsets
O Dreamweaver inclui um conjunto de comportamentos de servidor que permite exibir ou 
ocultar uma região com base nos resultados retornados por um recordset. Por exemplo, em 
uma página utilizando os links de registro “Previous” (Anterior) e “Next” (Próximo) para 
navegar em uma página de resultados, é possível especificar que o link de registro “Previous”  
seja exibido em todas as páginas de resultados, exceto a primeira (que não possui nenhum 
resultado anterior) e que o link de registro “Next” seja mostrado em todas as páginas com 
exceção da última (que não possui nenhum resultado posterior). 

Também é possível especificar que uma região seja exibida ou ocultada com base em um 
recordset vazio ou não. Se um recordset estiver vazio (por exemplo, nenhum registro 
corresponde à consulta), é possível exibir uma mensagem que informa ao usuário que nenhum 
registro foi devolvido. Isto é útil principalmente ao criar páginas de busca que dependem dos 
termos de entrada de busca do usuário para executar consultas. Do mesmo modo, é possível 
exibir uma mensagem de erro se houver algum problema de conexão a um banco de dados ou 
se o nome  e senha de usuário não corresponderem aos reconhecidos pelo servidor.

Link de navegação Comportamento de servidor

Ir para a primeira página Move to first page (Mover para a primeira 
página)

Ir para a página anterior Move to previous page (Mover para a página 
anterior)

Ir para a próxima página Move to next page (Mover para a próxima 
página)

Ir para a última página Move to last page (Mover para a última página)
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Os comportamentos de servidor Show Region (Mostrar região) são os seguintes:

■ Show If Recordset Is Empty (Mostrar se o recordset estiver vazio)
■ Show If Recordset Is Not Empty (Mostrar se o recordset não estiver vazio)
■ Show If First Page (Mostrar se for a primeira página)
■ Show If Not First Page (Mostrar se não for a primeira página)
■ Show If Last Page (Mostrar se for a última página)
■ Show If not Last Page (Mostrar se não for a última página)

Para aprender como aplicar os comportamentos de servidor Show Region, consulte “Mostrar 
ou ocultar regiões com base em resultados do recordset” na página 806.

Exibir vários resultados de recordsets
O comportamento de servidor Repeat Region (Repetir região) permite exibir diversos 
registros de um recordset dentro de uma página. Qualquer seleção de dados dinâmicos pode 
ser transformada em uma região repetitiva. As regiões mais comuns, no entanto, são uma 
tabela, uma linha da tabela ou uma série de linhas da tabela.

O exemplo a seguir ilustra como o comportamento de servidor Repeat Region é aplicado a 
uma linha de uma tabela e especifica que nove registros devem ser exibidos por página. A 
própria linha exibe quatro registros diferentes: city (cidade), state (estado), street address 
(endereço) e zip code (CEP).
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Para criar uma tabela como a do exemplo acima, é necessário criar uma tabela com conteúdo 
dinâmico e aplicar o comportamento de servidor Repeat Region à linha da tabela que contém 
o conteúdo dinâmico. Quando a página é processada pelo servidor de aplicativos, a linha é 
repetida o número de vezes especificado no objeto de servidor Repeat Region, com um 
registro diferente inserido em cada nova linha.

Para aprender como aplicar o comportamento de servidor Repeat Region, consulte “Exibir 
vários resultados de recordsets” na página 806 e “Criar uma tabela com um comportamento 
de servidor Repeat Region (Repetir região)” na página 808.

Record counters (Contadores de registros)
Os contadores de registros oferecem aos usuários um ponto de referência quando estiverem 
navegando por um recordset. Normalmente, os contadores de registros exibem o número total 
de registros retornado e os registros atuais visualizados. Por exemplo, se um recordset retornar 
40 registros individuais e forem exibidos 8 registros por página, o contador de registros 
indicará “Displaying records 1-8 of 40” (Exibindo registros 1-8 de 40) na primeira página.

Para criar um contador de registros para uma página, é necessário criar primeiro um recordset 
para a página, um layout de página apropriado para conter o conteúdo dinâmico e uma barra 
de navegação para o recordset. Para aprender mais sobre como criar esses elementos e 
adicioná-los a uma página, consulte as seções a seguir:

■ “Recordsets” na página 760
■ “Criar links de navegação para recordsets” na página 802
■ “Exibir vários resultados de recordsets” na página 806
■ “Criar uma tabela com um comportamento de servidor Repeat Region (Repetir região)” 

na página 808

Uma vez que os elementos acima estejam na página, é possível criar um contador de registros.

Contador de registro simples
É possível criar um contador de registro simples utilizando o objeto de servidor Recordset 
Navigation Status (Status de navegação do recordset). Este objeto de servidor insere um 
contador de registros completo com o qual é possível aplicar formatação de texto com as 
ferramentas de criação de páginas do Dreamweaver. Para obter mais informações sobre este 
contador de registros, consulte “Criar um contador de registros utilizando o objeto Recordset 
Navigation Status (Status de navegação do recordset)” na página 810.
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Contadores de registros personalizados
É possível utilizar comportamentos de contagem de registros individuais para criar contadores 
de registros personalizados. A criação de um contador de registros personalizado permite criar 
um contador de registros mais completo do que a tabela simples com uma única linha inserida 
pelo objeto de servidor Recordset Navigation Status (Status de navegação do recordset). É 
possível organizar elementos de design de diversas formas criativas e aplicar um 
comportamento de servidor apropriado a cada elemento. 

Os comportamentos de servidor Record Count (Contador de registros) são os seguintes:

■ Display Starting Record Number (Exibir o número do registro inicial)
■ Display Ending Record Number (Exibir o número do registro final)
■ Display Total Records (Exibir total de registros)

A seção “Criar contadores de registros personalizados” na página 811 o guia através das etapas 
necessárias para criar um contador de registros através da aplicação dos comportamentos de 
servidor Record Counter individuais para elementos do projeto de uma página.

Utilizar formatos de dados predefinidos
O Dreamweaver vem com vários formatos de dados predefinidos que podem ser aplicados a 
elementos de dados dinâmicos. Os dados incluem formatos de data e hora, moeda, numéricos 
e de porcentagem.

Para aplicar formatos de dados a texto dinâmico: 

1. Selecione o conteúdo dinâmico na janela Live Data o alocador de espaço na janela 
do documento.

2. Selecione Window (Janela) > Bindings (Ligações) para exibir o painel Bindings.

3. Clique no botão de seta para baixo na coluna Format (Formato). 

Se a seta para baixo não estiver visível, expanda o painel.
4. No menu pop-up Format, selecione a categoria de formato de dados desejada.

Certifique-se de que o formato de dados seja  apropriado para o tipo de dados que está 
sendo formatado. Por exemplo, os formatos Currency (Moeda) funcionam somente se os 
dados dinâmicos forem algarismos. Observe que não é possível aplicar mais de um 
formato aos mesmos dados.
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5. Verifique se o formato foi aplicado corretamente visualizando a página na janela Live Data 
ou em um navegador.

Tópicos relacionados
■ “Criar novos formatos de dados” na página 801

Personalizar os formatos de dados existentes 
É possível personalizar os formatos de dados do Dreamweaver ou criar seus próprios formatos.

Para personalizar um formato de dados:

1. Abra uma página que contém dados dinâmicos na visualização do projeto.

2. Selecione os dados dinâmicos cujo formato deseja personalizar.

3. Selecione Window (Janela) > Bindings (Ligações) para exibir o painel Bindings.

O item de dados ligados cujo texto dinâmico selecionado será realçado. 
4. Clique na seta para baixo na coluna Format (Formato) para expandir o menu pop-up dos 

formatos de dados disponíveis.

Se a seta para baixo não estiver visível, expanda o painel.
5. Selecione Edit Format List (Editar lista de formatos) no menu pop-up.

A caixa de diálogo Edit Format List é exibida. 
6. Preencha a caixa de diálogo e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Tópicos relacionados
■ “Utilizar formatos de dados predefinidos” na página 800
■ “Criar novos formatos de dados” na página 801

Criar novos formatos de dados 
É possível criar novos formatos de dados para adequar-se a quaisquer tipos de dados 
dinâmicos que desejar exibir.

Para criar um novo formato de dados:

1. Abra uma página que contenha dados dinâmicos na visualização do projeto.

2. Selecione os dados dinâmicos para o qual deseja criar um formato personalizado.
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3. Selecione Window (Janela)> Bindings (Ligações) para exibir o painel Bindings e clique no 
botão de seta na coluna Format (Formato).

Se a seta para baixo não estiver visível, expanda o painel.
4. Selecione Edit Format List (Editar lista de formatos) no menu pop-up.

A caixa de diálogo Edit Format List é exibida.
5. Clique no botão de adição (+) e selecione um tipo de formato.

6. Defina o formato e clique em OK.

7. Digite um nome para o novo formato na coluna Name (Nome).

8. Clique em OK para fechar a caixa de diálogo Edit Format List.

Tópicos relacionados
■ “Personalizar os formatos de dados existentes” na página 801
■ “Criar novos formatos de dados” na página 801

Criar links de navegação para recordsets 
Os links de navegação do recordset permitem que os usuários se movam entre os registros ou 
conjuntos de registros. Por exemplo, após criar uma página para exibir cinco registros de cada 
vez, adicione links como "Next” (Próximo) ou “Previous” (Anterior) para que os usuários 
possam visualizar os cinco registros anteriores ou posteriores.

Você pode criar links de navegação para o recordset por meio do comportamento de servidor 
Recordset Navigation Bar (Barra de navegação para recordsets) ou pode criar uma barra de 
navegação de recordset personalizada.

Tópicos relacionados
■ “Navegar em resultados de recordsets de bancos de dados” na página 795
■ “Criar barras de navegação personalizadas para recordsets” na página 796
■ “Criar uma barra de navegação personalizada para um recordset” na página 804
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Criar uma barra de navegação utilizando o 
comportamento de servidor Recordset Navigation 
Bar (Barra de navegação para recordset)
É possível criar uma barra de navegação do recordset em uma única operação, usando o 
comportamento de servidor Recordset Navigation Bar. O objeto de servidor adiciona os 
seguintes blocos de criação à página:

■ Uma tabela HTML com links de texto ou imagem
■ Um conjunto de comportamentos de servidor ”Move to” (Mover para)
■ Um conjunto de comportamentos de servidor ”Show Region” (Mostrar região)

A versão de texto da Recordset Navigation Bar é semelhante ao exemplo a seguir:

A versão gráfica da Recordset Navigation Bar é semelhante ao exemplo a seguir:

Antes de colocar a barra de navegação na página, certifique-se de que a página contenha um 
recordset de navegação e um layout de página para exibir os registros.

Após colocar a barra de navegação na página, você pode usar as ferramentas de desenho do 
Dreamweaver para personalizar a barra a seu gosto. Também é possível editar os 
comportamentos de servidor “Move to” e “Show Region” clicando duas vezes nos 
comportamentos no painel Server Behaviors (Comportamentos de servidor).

Se desejar criar a barra de navegação bloco a bloco utilizando as ferramentas de criação do 
Dreamweaver e o painel Server Behaviors, consulte “Criar uma barra de navegação 
personalizada para um recordset” na página 804.

Para criar a barra de navegação para recordset com o objeto de servidor:

1. Na visualização do projeto, posicione o ponto de inserção no local da página onde deseja 
que a barra de navegação apareça.

2. Abra a caixa de diálogo Recordset Navigation Bar (Insert > Application Objects > 
Recordset Navigation Bar).
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A caixa de diálogo Insert Recordset Navigation Bar (Inserir barra de navegação para 
recordset) é exibida. 

3. Selecione, no menu pop-up Recordset, o recordset no qual deseja navegar.

4. Na seção Display Using (Exibir utilizando), selecione o formato com o qual os links de 
navegação da página serão exibidos. A opção Text (Texto) insere links de texto na página, 
enquanto a opção Images (Imagens) permite utilizar imagens gráficas como links. 

Na versão de imagem da barra de navegação, o Dreamweaver utiliza os próprios arquivos 
de imagem do programa. Após inserir a barra na página, é possível substituir essas imagens 
por seus próprios arquivos de imagem.

5. Clique em OK.

O Dreamweaver cria uma tabela contendo links de texto ou de imagens que permitem ao 
usuário navegar pelo recordset selecionado quando ele é clicado. Quando o primeiro 
registro do recordset for exibido, as imagens ou os links “First” (Primeiro) e “Previous” 
(Anterior) são ocultados. Quando o último registro do recordset for exibido, as imagens 
ou os links “Next” (Próximo) e “Last” (Último) são ocultados.
É possível personalizar o layout da barra de navegação utilizando as ferramentas de criação 
do Dreamweaver.

Tópicos relacionados
■ “Criar uma barra de navegação personalizada para um recordset” na página 804

Criar uma barra de navegação personalizada para um 
recordset
Você pode criar uma barra de navegação personalizada para recordset, que use um layout e 
estilos de formatação mais complexos do que os oferecidos pela tabela simples usada pelo 
objeto de servidor da Recordset Navigation Bar (Barra de navegação para recordset).
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Para criar sua própria barra de navegação para recordset, você deve:

■ Desenhar os links de navegação usando texto ou imagens
■ Colocar os links na página na visualização de projeto
■ Atribuir comportamentos de servidor individuais a cada link de navegação

Para aprender mais sobre como criar uma barra de navegação para um recordset personalizada, 
consulte “Criar barras de navegação personalizadas para recordsets” na página 796. Se preferir 
utilizar o objeto de servidor Recordset Navigation Bar (Barra de navegação para recordset) 
incorporado do Dreamweaver para criar uma barra de navegação, consulte “Criar uma barra 
de navegação utilizando o comportamento de servidor Recordset Navigation Bar (Barra de 
navegação para recordset)” na página 803.

Este procedimento descreve como atribuir comportamentos de servidor individuais aos links 
de navegação. 

Para atribuir comportamentos de servidor a links de navegação de recordsets: 

1. Na visualização do projeto, selecione a seqüência de caracteres de texto ou imagem na 
página que deseja utilizar como link de navegação de registro.

2. Abra o painel Server Behaviors (Comportamentos de servidor) a partir de Window (Janela) 
> Server Behaviors e clique no botão de adição (+).

3. Selecione Recordset Paging (Paginação de recordset) no menu pop-up e, em seguida, 
selecione um comportamento de servidor apropriado para esse link a partir dos 
comportamentos de servidor listados. 

Observe que se o recordset possuir muitos registros, é possível que o comportamento de 
servidor Move to Last Record (Mover para o último registro) demore bastante para ser 
executado quando o usuário clicar neste link.

4. No menu pop-up Recordset, selecione o recordset que contém os registros.

5. Clique em OK.

O comportamento de servidor está atribuído ao link de navegação.

Tópicos relacionados
■ “Navegar em resultados de recordsets de bancos de dados” na página 795
■ “Criar barras de navegação personalizadas para recordsets” na página 796
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Mostrar ou ocultar regiões com base em 
resultados do recordset
O Dreamweaver inclui um conjunto de comportamentos de servidor que permitem exibir ou 
ocultar uma região com base nos resultados retornados por um recordset. Para aprender mais 
sobre os comportamentos de servidor Show Region (Mostrar região) e sobre como eles podem 
ser utilizados para mostrar ou ocultar resultados de recordsets, consulte, “Mostrar ou ocultar 
regiões com base em resultados de recordsets” na página 797.

Para exibir uma região apenas quando for necessário: 

1. Na visualização do projeto, selecione a região da página a ser exibida ou ocultada.

2. No painel Server Behaviors (Comportamentos do servidor) (Window > Server Behaviors) 
clique no botão de adição (+) .

3. Selecione Show Region (Mostrar região) no menu pop-up e, em seguida, escolha um dos 
comportamentos de servidor listados.

4. Clique em OK.

Tópicos relacionados
■ “Sobre a exibição de registros de bancos de dados” na página 793
■ “Criar uma tabela com um comportamento de servidor Repeat Region (Repetir região)” 

na página 808

Exibir vários resultados de recordsets 
O comportamento de servidor Repeat Region (Repetir região) permite exibir diversos 
registros de um recordset dentro de uma página. Qualquer seleção de dados dinâmicos pode 
ser transformada em uma região repetitiva. Todavia, as regiões mais comuns são tabelas, linhas 
de tabelas ou uma série de linhas de tabelas. 

Para aprender mais sobre como utilizar o comportamento de servidor Repeat Region, consulte 
“Exibir vários resultados de recordsets” na página 798 e “Criar uma tabela com um 
comportamento de servidor Repeat Region (Repetir região)” na página 808.
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Para criar uma região repetitiva:

1. Na visualização do projeto, selecione uma região que possua conteúdo dinâmico.

A seleção pode ser qualquer elemento, incluindo uma tabela, uma linha de tabela ou até 
mesmo um parágrafo de texto.
Para selecionar com exatidão uma região na página, utilize o seletor de tags no canto 
esquerdo da janela do documento. Por exemplo, se a região for uma linha de tabela, clique 
dentro da linha na página e, em seguida, clique na tag <tr>  mais à direita no seletor de 
tags para selecionar a linha da tabela.

2. Selecione Window (Janela)> Server Behaviors (Comportamentos de servidor) para exibir o 
painel Server Behaviors. 

3. Clique no botão de sinal de adição (+) e selecione Repeat Region.

A caixa de diálogo Repeat Region é exibida.

4. Selecione, no menu pop-up, o nome do recordset a ser utilizado.

5. Selecione o número de registros a serem exibidos por página.

6. Clique em OK.

Na janela do documento, um contorno cinza e estreito com guia será exibido ao redor da 
região repetitiva. Na janela Live Data (Dados ativos), aberta a partir da seleção de View 
(Exibir) > Live Data, o contorno cinza desaparecerá e a seleção se expandirá para exibir o 
número de registros que você tiver especificado.

Tópicos relacionados
■ “Sobre a exibição de registros de bancos de dados” na página 793
■ “Mostrar ou ocultar regiões com base em resultados do recordset” na página 806
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Criar uma tabela com um comportamento 
de servidor Repeat Region (Repetir 
região)
O objeto de servidor Dynamic Table (Tabela dinâmica) permite criar uma tabela com 
conteúdo dinâmico e aplicar o comportamento Repeat Region (Repetir região) a partir de 
uma única caixa de diálogo. Esse objeto de servidor é bastante útil, pois preenche 
simultaneamente uma tabela com conteúdo dinâmico de um recordset e aplica o 
comportamento de servidor Repeat Region.

Para criar uma tabela dinâmica:

1. Para criar uma tabela dinâmica:

■ Selecione Insert (Inserir) > Application Objects (Objetos de aplicativos) > Dynamic 
Table para exibir a caixa de diálogo Dynamic Table.>

■ Na categoria Application (Aplicativo) da barra Insert, selecione o botão Dynamic 
Table no menu Dynamic Data (Dados dinâmicos).

Será exibida a caixa de diálogo Dynamic Table.

2. Selecione, no menu pop-up Recordset, o recordset que deseja utilizar.

3. Selecione o número de registros a serem exibidos por página.

N
O

T
A

O objeto de servidor Dynamic Table (Tabela dinâmica) não está disponível ao utilizar 
tipos de documento ASP.NET. Para criar uma tabela com conteúdo dinâmico e regiões 
repetitivas, é necessário inserir a tabela manualmente, inserir o conteúdo dinâmico do 
painel Bindings (Ligações) e aplicar um comportamento de servidor de região repetitiva, 
se necessário. Para obter mais informações, consulte “Exibir vários resultados de 
recordsets” na página 806.
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4. Digite valores para a borda da tabela, preenchimento de célula e espaçamento entre as 
células, se desejado.

A caixa de diálogo Dynamic Table retém os valores inseridos para bordas da tabela, 
preenchimento de célula e espaçamento entre as células. Se você estiver trabalhando em 
um projeto que necessita de várias tabelas dinâmicas que requerem a mesma aparência, é 
possível digitar os valores de layout da tabela, uma vez que isto simplifica o 
desenvolvimento da página. Observe que é possível ajustar estes valores após inserir a 
tabela utilizando o Property inspector (Inspetor de propriedades) da tabela.

5. Clique em OK.

A tabela e os alocadores de espaço definidos em seu recordset correspondente para o 
conteúdo dinâmico são inseridos na página.

Neste exemplo, o recordset contém quatro registros: FIRSTNAME (Primeiro nome), 
LASTNAME (Último nome), TITLE (Cargo) e DEPARTMENT (Departamento). A 
linha Heading (Cabeçalho) da tabela é preenchida com os nomes de cada item de registro. 
É possível editar os cabeçalhos utilizando qualquer texto descritivo desejado ou substitui-
los por imagens representativas.

Criar um contador de registros 
Os contadores de registros permitem aos usuários saberem onde eles estão em determinado 
recordset em relação ao número total de registros retornados. Por essa razão, os contadores de 
registros são um comportamento útil que pode aumentar significativamente a usabilidade de 
uma página da Web.

Para saber mais sobre contadores de registros, consulte “Record counters (Contadores de 
registros)” na página 799.
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Criar um contador de registros utilizando o objeto 
Recordset Navigation Status (Status de navegação 
do recordset)
O objeto Recordset Navigation Status cria uma entrada de texto na página para exibir o estado 
de registro atual.

Para utilizar o objeto Recordset Navigation Status:

1. Coloque o cursor no ponto em que deseja inserir o contador de registros.

2. Selecione Insert (Inserir)> Application Objects (Objetos de aplicativos) > Recordset 
Navigation Status.

A caixa de diálogo Insert Recordset Navigation Status (Inserir status de navegação do 
recordset) é exibida.

Selecione, no menu pop-up Recordset, o recordset que deseja utilizar.
3. Clique em OK.

O objeto de servidor Recordset Navigation Status insere um contador de registros de texto 
similar ao exibido abaixo:

Você pode usar as ferramentas de desenho de página do Dreamweaver para personalizar o 
contador de registros.
Quando visualizado na janela Live Data (Dados ativos) ou em um navegador, o contador 
será similar ao mostrado abaixo:
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Criar contadores de registros personalizados
Para criar um contador de registros personalizado para uma página, é necessário criar primeiro 
um recordset para a página, um layout de página apropriado para conter o conteúdo dinâmico 
e uma barra de navegação para o recordset. Para saber mais sobre como criar esses elementos e 
adicioná-los a uma página, consulte “Record counters (Contadores de registros)” na 
página 799. Uma vez que os elementos acima estejam na página, é possível criar um contador 
de registros personalizado.

Este exemplo cria um contador de registros semelhante ao da seção anterior, “Criar um 
contador de registros utilizando o objeto Recordset Navigation Status (Status de navegação do 
recordset)” na página 810. O contador de registros, neste exemplo, terá a aparência:

Exibindo registros de StartRow até EndRow de RecordSet.RecordCount.

Nesse exemplo, o texto com fonte sans-serif representa os alocadores de espaço que serão 
inseridos na página.

Para criar um contador de registros personalizado: 

1. Na visualização do projeto, digite o texto do contador na página. Escolha o nome de sua 
preferência. Por exemplo:
Displaying records thru of .

2. Inclua o ponto de inserção no final da seqüência de caracteres de texto.

3. Abra o painel Server Behaviors (Comportamentos de servidor), a partir da seleção de 
Window (Janela) > Server Behaviors.

4. Clique no botão de adição (+) no canto superior esquerdo e clique em Display Record 
Count (Exibir contagem de registros). Neste submenu, selecione Display Total Records 
(Exibir total de registros). O comportamento Display Total Records é inserido na página e 
um alocador de espaço é inserido no local do ponto de inserção. A seqüência de texto deve 
ser similar à do exemplo:
Displaying records thru of {Recordset1.RecordCount}.

5. Posicione o ponto de inserção após a palavra registros e selecione Display Starting 
Record Count Number (Exibir o número inicial da contagem de registros) a partir do 
painel Server Behaviors > botão de adição (+) > Record Count (Contagem de registros). A 
seqüência de texto deve ser similar à do exemplo:
Displaying records {StartRow_Recordset1} thru of 

{Recordset1.RecordCount}.
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6. Em seguida, posicione o ponto de inserção entre as palavras até e de e selecione Display 
Starting Record Count Number no painel Server Behaviors > botão de adição (+) > Record 
Count. A seqüência de texto deve ser similar à do exemplo:
Displaying records {StartRow_Recordset1} thru {EndRow_Recordset1} of
{Recordset1.RecordCount}.

7. Verifique se o contador funciona corretamente, visualizando a página na janela Live Data 
(View > Live Data); o contador deverá ser semelhante ao do exemplo abaixo:
Displaying records 1 thru 8 of 40.

Se a página de resultados tiver um link de navegação para mover ao próximo recordset, 
clique no link para atualizar a leitura do contador de registros do seguinte modo:
Showing records 9 thru 16 of 40.

Os links não funcionam na janela Live Data. Para testá-los, você pode utilizar o recurso 
Preview in Browser (Visualizar no navegador) do Dreamweaver. Verifique se a opção 
Preview Using Live Data Server (Visualizar utilizando servidor de dados ativos) está 
selecionada na caixa de diálogo  Preferences (Edit > Preferences > Preview in Browser 
(Windows) ou Dreamweaver > Preferences > Preview in Browser (Macintosh)); e selecione 
File > Preview in Browser.
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CAPÍTULO 36

Exibir dados XML em 
páginas da Web
Você pode usar o Macromedia Dreamweaver 8 para criar páginas da Web que exibam dados 
XML. A exibição de dados XML envolve a recuperação de informações armazenadas em um 
arquivo XML local e remoto e o processamento dessas informações na página da Web. O 
Dreamweaver oferece métodos para exibir informações a partir de arquivos XML, bem como 
recursos de projeto e objetos XSLT internos que permitem aperfeiçoar a apresentação de 
dados XML.

Este capítulo contém as seguintes seções:
Sobre como usar XML e XSL com páginas da Web . . . . . . . . . . . . . . . . . . . . . . . . . 814

Sobre transformações de XSL no lado servidor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 816

Sobre transformações de XSL no lado cliente  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 819

Sobre dados XML e elementos repetidos  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .822

Sobre a visualização de dados XML  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .824

Executar transformações de XSL no servidor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .826

Executar transformações de XSL no cliente . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .842

Aplicar estilos a fragmentos XSLT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .844

Solucionar problemas de transformações de XSL . . . . . . . . . . . . . . . . . . . . . . . . . . .845
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Sobre como usar XML e XSL com 
páginas da Web
Extensible Markup Language (XML) é uma linguagem que permite estruturar informações. 
Assim como a HTML, a linguagem XML permite estruturar as informações por meio de tags, 
mas ao contrário das tags HTML, as tags XML não são predefinidas. Em vez disso, a XML 
permite que você crie tags de acordo com a sua estrutura de dados. As tags são aninhadas umas 
nas outras de modo a criar um esquema de tags mães e filhas (principais e secundárias). A 
exemplo da maioria das tags HTML, todas as tags em um esquema XML têm uma tag de 
abertura e de fechamento.

O exemplo a seguir mostra a estrutura básica de um arquivo XML:
<?xml version=“1.0”>
<mybooks>

<book bookid=“1”>
<pubdate>03/01/2004</pubdate>
<title>Displaying XML Data with Macromedia Dreamweaver</title>
<author>Charles Brown</author>

</book>
<book bookid=“2”>

<pubdate>04/08/2004</pubdate>
<title>Understanding XML</title>
<author>John Thompson</author>

</book>
</mybooks>

Neste exemplo, cada tag <book> principal (mãe) contém três tags secundárias (filhas): 
<pubdate>, <title> e <author>. No entanto, cada tag <book> é também uma tag 
secundária da tag <mybooks>, que está localizada um nível acima no esquema. Você pode 
nomear e estruturar as tags XML da maneira que mais lhe agradar, desde que as aninhe de 
forma adequada e atribua a cada tag de abertura a tag de fechamento correspondente.

Os documentos XML não contêm nenhuma formatação — são apenas recipientes 
(containers) das informações estruturadas. Uma vez de posse de um esquema XML, você 
poderá usar a Extensible Stylesheet Language (XSL) para exibir as informações. Da mesma 
maneira que as CSS (Cascading Style Sheets) permitem formatar HTML, a XSL permite 
formatar os dados XML. Você pode definir estilos, elementos de página, layout etc. em um 
arquivo XSL e anexá-lo a um arquivo XML, de modo que, quando um usuário vir os dados 
XML em um navegador, os dados sejam formatados de acordo com o que você definiu no 
arquivo XSL. O conteúdo (os dados XML) e a apresentação (definida pelo arquivo XSL) são 
totalmente separados, possibilitando mais controle sobre a maneira como as informações 
aparecem em uma página da Web. Basicamente, a XSL é uma tecnologia de apresentação da 
XML, onde a saída primária é uma página HTML.
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A XSLT (Extensible Stylesheet Language Transformations) é uma linguagem de subconjunto 
da XSL que na verdade permite exibir os dados XML em uma página da Web e “transformá-
los”, junto com os estilos XSL, em informações legíveis e organizadas no formato HTML. 
Você pode usar o Dreamweaver para criar páginas XSLT que permitam executar 
transformações de XSL por meio de um servidor de aplicativos ou de num navegador. 
Quando você executa uma transformação XSL no lado servidor, este é responsável por 
transformar as linguagens XML e XSL e por exibi-las na página. Quando você executa uma 
transformação no lado cliente, um navegador (como o Internet Explorer) faz o trabalho.

A abordagem que você escolher (transformações no lado servidor versus transformações no 
lado cliente) dependerá do que estiver tentando obter como resultado final, das tecnologias 
disponíveis, do nível de acesso que tenha aos arquivos de origem do XML e de outros fatores. 
Ambas as abordagens têm suas vantagens e limitações. Por exemplo, as transformações no lado 
servidor funcionam em todos os navegadores, ao passo que as transformações no lado cliente 
estão restritas apenas aos navegadores modernos (Internet Explorer 6, Netscape 8, Mozilla 1.8 
e Firefox 1.0.2). As transformações no lado servidor permitem exibir dados XML 
dinamicamente a partir de seu próprio servidor ou de qualquer outro local da Web, enquanto 
as transformações no lado cliente precisam usar os dados XML que estão armazenados 
localmente no seu próprio servidor da Web. Por fim, as transformações no lado servidor 
exigem que você implemente suas páginas em um servidor de aplicativos configurado, 
enquanto as transformações no lado cliente só requerem acesso a um servidor da Web.

Para obter mais informações, consulte “Sobre transformações de XSL no lado servidor” na 
página 816 e “Sobre transformações de XSL no lado cliente” na página 819.
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Sobre transformações de XSL no lado 
servidor
O Dreamweaver oferece métodos para a criação de páginas XSLT que lhe permitem executar 
transformações de XSL no lado servidor. Quando um servidor de aplicativos executa a 
transformação de XSL, o arquivo que contém os dados XML pode residir em seu próprio 
servidor ou em qualquer outro local da Web. Além disso, qualquer navegador pode exibir os 
dados transformados. No entanto, o processo de implantação de páginas para transformação 
no lado servidor é um tanto complexo e exige que você tenha acesso a um servidor de 
aplicativos.

Ao trabalhar com transformações de XSL no lado servidor, você pode usar o Dreamweaver 
para criar páginas XSLT que gerem documentos HTML completos (páginas inteiramente 
XSLT) ou fragmentos de XSLT que gerem uma parte de um documento HTML. Uma página 
XSLT completa é semelhante a uma página HTML regular. Ela contém uma tag <body> e 
uma tag <head>, e permite que você exiba uma combinação de dados HTML e XML na 
página. Um fragmento XSLT consiste em parte de um código, usado por um documento 
separado, que exibe dados XML formatados. Diferentemente de uma página inteiramente 
XSLT, ele é um arquivo independente, que não contêm nenhuma tag <body> ou <head>. 
Caso deseje exibir os dados XML em uma página própria, você pode criar uma página XSLT 
completa e vincular seus dados XML a ela. Por outro lado, se preferir exibir os dados XML em 
uma seção específica de uma página dinâmica existente — por exemplo, uma home page 
dinâmica para uma loja de materiais de esporte, com um placar de resultados de esportes 
vinculado a um leitor de RSS (Real Simple Sindication) exibido em um lado da página — 
você pode criar um fragmento XSLT e inserir uma referência a ele na página dinâmica. 
Geralmente, o cenário mais comum consiste na criação de fragmentos XSLT e no uso destes 
junto com outras páginas dinâmicas para exibir dados XML.
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A primeira etapa para criar esses tipos de páginas consiste em criar o fragmento XSLT: trata-se 
de um arquivo separado que contém o layout, a formatação e os outros itens dos dados XML 
que você quer exibir na página dinâmica. Uma vez criado o fragmento XSLT, você insere uma 
referência a ele em um sua página dinâmica (por exemplo, uma página PHP ou Macromedia 
ColdFusion). A referência inserida no fragmento funciona de forma semelhante a um SSI 
(Server Side Include) — os dados XML formatados (o fragmento) residem em um arquivo 
separado, ao passo que no Design view (Visualização de projeto), é exibido um alocador do 
fragmento na página dinâmica propriamente dita. Quando um navegador solicita a página 
dinâmica que contém a referência ao fragmento, o servidor processa as instruções incluídas e 
cria um novo documento no qual o conteúdo formatado do fragmento é exibido no lugar do 
alocador de espaço.
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Você usa o comportamento de servidor XSL Transformation (Transformação de XSL) para 
inserir a referência a um fragmento XSLT em uma página dinâmica. Quando você insere a 
referência, o Dreamweaver gera uma pasta includes/MM_XSLTransform/ na pasta raiz do site 
que contém um arquivo de biblioteca em tempo de execução. O servidor de aplicativos usa as 
funções definidas nesse arquivo quando faz a transformação dos dados XML especificados. O 
arquivo é responsável por buscar os dados XML e os fragmentos XSLT, executando a 
transformação de XSL e exibindo os resultados na página da Web.

Para que sua página seja exibida corretamente, é necessário que o arquivo que contém o 
fragmento XSLT, o arquivo XML que contém seus dados e arquivo de dados da biblioteca em 
tempo de execução estejam todos no servidor. (Se você selecionar um arquivo XML remoto 
como sua fonte de dados — por exemplo, um dos arquivos do leitor RSS — tal arquivo 
precisará obviamente residir em outro local na Internet.)

Você também pode usar o Dreamweaver para criar páginas totalmente XSLT para serem 
usadas nas transformações no lado servidor. Uma página totalmente XSLT funciona 
exatamente da mesma maneira que um fragmento XSLT, ou seja, você só conseguirá inserir o 
conteúdo completo de uma página HTML quando inserir a referência para a página XSLT 
por meio do comportamento de servidor XSL Transformation. Desse modo, antes de inserir a 
referência, será necessário remover todo o conteúdo HTML da página dinâmica (a página 
.cfm, .php, .asp, ou .net que atua como a página recipiente).

O Dreamweaver oferece suporte a transformações de XSL em páginas ColdFusion, ASP, 
ASP.NET e PHP.

Para saber mais sobre os procedimentos de criação de transformações de XSL no lado servidor, 
consulte “Executar transformações de XSL no servidor” na página 826.

Tópicos relacionados
■ “Sobre a visualização de dados XML” na página 824
■ “Aplicar estilos a fragmentos XSLT” na página 844

N
O

T
A

O seu servidor deverá estar configurado de forma apropriada para executar as 
transformações no lado servidor. Para obter mais informações, entre em contato com o 
administrador do servidor ou visite www.macromedia.com/go/dw_xsl.
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Sobre transformações de XSL no lado 
cliente
Também é possível executar transformações de XSL no cliente sem o uso de um servidor de 
aplicativos. Você pode usar o Dreamweaver para criar uma página inteiramente XSLT que faça 
isso; no entanto, as transformações no lado cliente requerem a manipulação do arquivo XML 
que contém os dados que serão exibidos. Além disso, as transformações no lado cliente só 
funcionarão em navegadores modernos (Internet Explorer 6, Netscape 8, Mozilla 1.8 e Firefox 
1.0.2). Para obter mais informações sobre navegadores que oferecem ou não suporte a 
transformações XSL, consulte www.w3schools.com/xsl/xsl_browsers.asp.

Para começar, crie uma página inteiramente XSLT e anexe a ela uma fonte de dados XML. (O 
Dreamweaver lhe pedirá que anexe a fonte de dados quando você estiver criando a nova 
página.) É possível usar o Dreamweaver para criar uma página XSLT totalmente nova ou para 
converter uma página HTML existente para uma página XSLT. Ao converter uma página 
HTML existente para uma página XSLT, você precisa anexar uma fonte de dados XML, 
utilizando o painel Bindings (Window (Janela) > Bindings [Ligações]).

Uma vez criada a página XSLT, você precisa vinculá-la ao arquivo XML que contém os dados 
XML, inserindo uma referência à página XSLT no arquivo XML propriamente dito (como 
faria para inserir uma referência a uma folha de estilos CSS externa na seção <head> da página 
HTML). Os visitantes de seu site precisam ver o arquivo XML (e não a página XSLT) no 
navegador. Quando eles abrem a página, o navegador executa a transformação de XSL e exibe 
os dados XML, formatados pela página XSLT vinculada.
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A relação entre as páginas XSLT e XML vinculadas segue um conceito parecido, com algumas 
diferenças, do modelo de página HTML/CSS externa. No caso de uma página HTML que 
contenha conteúdo (como texto), você usa uma folha de estilos externa para formatar o 
conteúdo. A página HTML determina o conteúdo; por sua vez, o código da CSS externa (que 
o usuário nunca vê) determina a apresentação. Com a XSLT e a XML, ocorre o inverso. O 
arquivo XML (que o usuário nunca vê no formato simples) determina o conteúdo, ao passo 
que a página XSLT determina a apresentação. A página XSLT contém as mesmas tabelas, 
layout, figuras e outros itens contidos no formato HTML padrão. Quando um usuário vê o 
arquivo XML no navegador, a página XSLT formata o conteúdo.
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Quando você usa o Dreamweaver para vincular uma página XSLT a uma página XML, ele 
insere por você o código apropriado na parte superior da página XML. Se você é o 
proprietário da página XML à qual está vinculando (ou seja, se o arquivo XML reside 
exclusivamente no seu servidor da Web), tudo que precisará fazer é usar o Dreamweaver para 
inserir o código apropriado que vincula as duas páginas. Quando você é o proprietário do 
arquivo XML, as transformações de XSL executadas pelo cliente são totalmente dinâmicas. 
Ou seja, sempre que você atualizar os dados no arquivo XML, as saídas no HTML que utiliza 
a página XSLT vinculada serão automaticamente atualizadas com as novas informações.

Caso não seja o proprietário da página XML à qual esteja vinculando (por exemplo, se quiser 
usar os dados XML do leitor RSS em algum outro lugar da Web), o fluxo de trabalho será um 
pouco mais complicado. Para executar transformações no lado cliente usando dados XML de 
uma fonte externa, é necessário primeiro efetuar o download do arquivo que contém o 
código-fonte XML para o mesmo diretório em que reside a página XSLT. Quando a página 
XML estiver em seu site local, você pode usar o Dreamweaver para adicionar o código 
apropriado que a vincula à página XSLT e postar ambas as páginas (o arquivo XML baixado e 
a página XSLT vinculada) em servidor da Web. Quando o usuário vê a página XML no 
navegador, a página XSLT formata o conteúdo, exatamente como no exemplo anterior. 

A desvantagem de executar transformações de XSL no lado cliente em dados XML 
provenientes de uma fonte externa é que os dados XML são apenas parcialmente “dinâmicos”. 
O arquivo XML no qual você efetua o download e as alterações é meramente um 
“instantâneo” do arquivo que reside em outr lugar da Web. Se o arquivo XML original for 
alterado, é necessário fazer novamente o download dele, vinculá-lo à página XSLT e tornar a 
postá-lo em seu servidor da Web. O navegador transmite apenas os dados que ele recebe do 
arquivo XML em seu servidor da Web, e não os dados contidos no arquivo do código-fonte 
XML original.

Para saber mais sobre os procedimentos de criação de transformações XSL no lado cliente, 
consulte “Executar transformações de XSL no cliente” na página 842.

Tópicos relacionados
■ “Sobre a visualização de dados XML” na página 824
■ “Aplicar estilos a fragmentos XSLT” na página 844

N
O

T
A

Os arquivos XML e XSL que você usa nas transformações no lado cliente precisam 
residir no mesmo diretório. Caso contrário, o navegador lerá o arquivo XML e encontrará 
a página XSLT para a transformação, mas não conseguirá localizar as propriedades 
(folhas de estilos, imagens etc) definidas pelos links relativos na página XSLT.
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Sobre dados XML e elementos repetidos
O objeto XSLT de Repeat Region (Região repetitiva) permite que você exiba elementos 
repetidos a partir de um arquivo XML em uma página. Qualquer região que contenha um 
alocador de espaço de dados XML pode ser transformada em uma região repetida. As regiões 
mais comuns, no entanto, são uma tabela, uma linha da tabela ou uma série de linhas da 
tabela. 

O exemplo a seguir demonstra como o objeto XSLT de Repeat Region é aplicado a uma linha 
de tabela que exibe informações sobre o menu de um restaurante. A linha inicial mostra três 
elementos diferentes do esquema XML: item, descrição e preço. Quando o objeto XSLT de 
Repeat Region for aplicado à linha da tabela e a página for processada por um servidor de 
aplicativos ou navegador, a tabela será repetida com dados exclusivos inseridos em cada nova 
linha da tabela.

Quando você aplica um objeto XSLT de Repeat Region à janela do documento, é exibida uma 
linha fina e acinzentada em volta da região repetida. Quando você visualiza seu trabalho em 
um navegador (File (Arquivo) > Preview in Browser [Visualizar no navegador]), a linha cinza 
desaparece e a seleção se expande para exibir os elementos repetidos especificados no arquivo 
XML, conforme exibido na ilustração anterior.
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Observe também que, quando você adiciona o objeto XSLT de Repeat Region à página, o 
Dreamweaver trunca o comprimento do alocador de espaço dos dados XML na janela do 
documento. Isto acontece porque o Dreamweaver atualiza o XPath para o alocador de espaço 
dos dados XML de modo a torná-lo relativo ao caminho do elemento repetido.

Por exemplo, o código a seguir é para uma tabela que contém dois alocadores de espaço 
dinâmicos, sem o objeto XSLT de Repeat Region aplicado à tabela:
<table width="500" border="1">

<tr>
<td><xsl:value-of select="rss/channel/item/title"/></td>

</tr>
<tr>

<td><xsl:value-of select="rss/channel/item/description"/></td>
</tr>

</table>

O código a seguir destina-se à mesma tabela, com o objeto XSLT de Repeat Region aplicado a 
ele:
<xsl:for-each select="rss/channel/item">

<table width="500" border="1">
<tr>

<td><xsl:value-of select="title"/></td>
</tr>
<tr>

<td><xsl:value-of select="description"/></td>
</tr>

</table>
</xsl:for-each>

No exemplo anterior, o Dreamweaver atualizou o XPath de modo que os itens dentro de 
Repeat Region (title & description) fossem relativos ao XPath nas tags que contivessem 
<xsl:for-each>, em vez de no documento completo.

O Dreamweaver gera expressões XPath relativas ao contexto também em outros casos. Por 
exemplo, se você arrastar o alocador de espaço dos dados XML para uma tabela que já utilize 
um objeto XSLT de Repeat Region aplicado a ela, o Dreamweaver automaticamente exibirá o 
XPath relativo ao XPath existente nas tags que contiverem <xsl:for-each>.

Para aprender como aplicar o objeto XSLT de Repeat Region, consulte “Exibir elementos 
XML repetidos” na página 833.
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Sobre a visualização de dados XML
Quando você usar o recurso Preview in Browser (File > Preview in Browser) para visualizar os 
dados XML que inseriu em um fragmento XSLT ou em uma página XSLT completa, o 
mecanismo que realiza a transformação de XSL diferirá de acordo com a situação. No caso de 
páginas dinâmicas que contêm fragmentos XSLT, o servidor de aplicativos sempre executa as 
transformações. Em outras situações, o Dreamweaver ou o browser pode executar a 
transformação.

A tabela a seguir resume as situações onde é usado o Preview in Browser, bem como os 
mecanismos que executam as respectivas transformações:

Os tópicos a seguir fornecem diretrizes que o ajudarão a determinar os métodos de 
visualização apropriados, de acordo com as suas necessidades:

■ “Visualizar páginas de transformações no lado servidor” na página 825
■ “Visualizar páginas de transformações no lado cliente” na página 825
■ “Visualizar páginas inteiramente XSLT e fragmentos XSLT” na página 826

Tipo de página visualizada no 
navegador

Transformação de dados executada 
por

Página dinâmica que contém o fragmento 
XSLT

Servidor de aplicativos

Fragmento XSLT ou página XSLT completa Dreamweaver

 Arquivo XML com link para a página XSLT 
completa

Navegador
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Visualizar páginas de transformações no lado 
servidor
No caso de transformações no lado servidor, o conteúdo final que o visitante do site vê é 
transformado por seu servidor de aplicativos. Ao criar as páginas dinâmicas e XSLT para serem 
usadas com transformações no lado servidor, é sempre recomendável visualizar a página 
dinâmica que contém o fragmento XSLT, em vez do fragmento XSLT propriamente dito. No 
primeiro cenário, você faz uso do servidor de aplicativos, que assegura que a sua visualização 
esteja consistente com o que os visitantes do site verão quando acessarem a sua página. No 
segundo cenário, o Dreamweaver executa a transformação e pode retornar resultados um 
pouco inconsistentes. É possível usar o Dreamweaver para visualizar o fragmento XSLT no 
momento em que este estiver sendo criado, mas você será capaz de ver resultados mais precisos 
da apresentação dos dados se usar o servidor de aplicativos para visualizar a página dinâmica 
depois de inserir o fragmento XSLT.

Visualizar páginas de transformações no lado cliente
No caso de transformações no lado cliente, o conteúdo final que o visitante do site vê é 
transformado por um navegador. Para conseguir isso, é necessário adicionar um link do 
arquivo XML à página XSLT. Se abrir o arquivo XML no Dreamweaver e visualizá-lo no 
navegador, você obrigará o navegador a carregar o arquivo e executar a transformação. Isto 
permitirá que você tenha a mesma experiência que o visitante de seu site.

Uma desvantagem dessa abordagem é que ela dificulta a depuração da página, já que o 
navegador transforma o XML e gera o código HTML internamente. Se selecionou a opção 
View Source (Exibir código-fonte) no navegador para depurar o código HTML gerado, você 
verá apenas o XML recebido pelo navegador, e não a tag HTML completa (tags, estilos etc) 
responsável pela processamento da página. Para ver o HTML completo ao exibir o código-
fonte, é necessário visualizar a página XSLT em um navegador.
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Visualizar páginas inteiramente XSLT e fragmentos 
XSLT
Ao criar páginas inteiramente XSLT e fragmentos XSLT, você desejará visualizar seu trabalho 
para assegurar que os dados estejam sendo exibidos corretamente. Se você usar a opção 
Preview in Browser (Visualizar no navegador) para exibir a página XSLT completa ou um 
fragmento XSLT, o Dreamweaver usará um mecanismo de transformação interno para 
executar a transformação. Este método oferece resultados rápidos e permite que você crie e 
depure sua página de maneira incremental. Oferece também uma maneira de visualizar o 
HTML completo (tags, estilos etc) por meio da opção View Source do navegador.

Tópicos relacionados
■ “Sobre como usar XML e XSL com páginas da Web” na página 814
■ “Sobre transformações de XSL no lado servidor” na página 816
■ “Sobre transformações de XSL no lado cliente” na página 819
■ “Aplicar estilos a fragmentos XSLT” na página 844

Executar transformações de XSL no 
servidor
É possível usar o Dreamweaver para criar páginas XSLT completas ou fragmentos de XSLT 
para serem usados em páginas da Web dinâmicas. Uma página inteiramente XSLT é uma 
página que, quando transformada, gera uma página HTML completa. Um fragmento XSLT 
consiste em parte de um código, usado por um documento separado, que exibe dados XML.

A Macromedia recomenda que você leia “Sobre transformações de XSL no lado servidor” na 
página 816 antes de prosseguir com um destes procedimentos.

Esta seção contém os seguintes tópicos:

■ “Fluxo de trabalho para executar transformações de XSL no lado servidor” na página 827
■ “Criar páginas XSLT” na página 828
■ “Converter páginas HTML em páginas XSLT” na página 830

N
O

T
A

Você provavelmente usará este método quando começar a criar páginas XSLT, 
independentemente de usar o cliente ou o servidor para transformar os dados.

N
O

T
A

O seu servidor deverá estar configurado de forma apropriada para executar as 
transformações no lado servidor. Para obter mais informações, entre em contato com o 
administrador do servidor ou visite www.macromedia.com/go/dw_xsl.
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■ “Anexar fontes de dados XML” na página 830
■ “Exibir dados XML em páginas XSLT” na página 831
■ “Exibir elementos XML repetidos” na página 833
■ “Editar um objeto XSLT de Repeat Region” na página 836
■ “Inserir fragmentos XSLT em páginas dinâmicas” na página 836
■ “Excluir fragmentos XSLT das páginas dinâmicas” na página 838
■ “Editar comportamentos de servidor XSL Transformation” na página 838
■ “Utilizar parâmetros com transformações de XSL” na página 839
■ “Criar regiões XSLT condicionais” na página 840
■ “Editar um objeto XSLT de Conditional Region” na página 841
■ “Inserir comentários de XSL” na página 841

Fluxo de trabalho para executar transformações de 
XSL no lado servidor
Esta seção fornece uma lista das etapas necessárias para executar as transformações de XSL no 
lado servidor e cita as seções da documentação que analisam cada procedimento.

A Macromedia recomenda a leitura de “Sobre como usar XML e XSL com páginas da Web” 
na página 814, “Sobre transformações de XSL no lado servidor” na página 816 e “Sobre 
transformações de XSL no lado cliente” na página 819 antes de criar as páginas que exibem 
dados XML.

Para executar transformações de XSL no lado servidor, siga estas etapas:

■ Configure um site Dreamweaver. Consulte Capítulo 2, “Configurar um site do 
Dreamweaver”, na página 87.

■ Escolha uma tecnologia de servidor e configure um servidor de aplicativos. Consulte 
“Configurar um servidor de aplicativos” na página 659.

■ Teste o servidor de aplicativos para certificar-se de que ele esteja funcionando 
corretamente. Por exemplo, crie uma página que necessite de processamento e verifique se 
o servidor de aplicativos processa a página. Para obter um tutorial sobre como fazer isso, 
visite www.macromedia.com/go/dw_xsl.

■ Siga um dos procedimentos abaixo:
■ No site Dreamweaver, crie um fragmento XSLT ou uma página inteiramente XSLT. 

Consulte “Criar páginas XSLT” na página 828.
■ Converta uma página HTML existente em uma página inteiramente XSLT. Consulte 

“Converter páginas HTML em páginas XSLT” na página 830.
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■ Anexe uma fonte de dados XML à pagina (se isso ainda não tiver sido feito). Consulte 
“Anexar fontes de dados XML” na página 830.

■ Vincule os dados XML ao fragmento XSLT ou à página XSLT completa. Consulte “Exibir 
dados XML em páginas XSLT” na página 831.

■ Se apropriado, adicione um objeto XSLT de Repeat Region à tabela ou linha da tabela que 
contém os alocadores de espaço dos dados XML. Consulte “Exibir elementos XML 
repetidos” na página 833.

■ Siga um dos procedimentos abaixo:
■ Use o comportamento de servidor de XSL Transformation para inserir a referência ao 

fragmento XSLT em uma página dinâmica. Consulte “Inserir fragmentos XSLT em 
páginas dinâmicas” na página 836.

■ Exclua todo o código HTML de uma página dinâmica e, em seguida, use o 
comportamento de servidor de XSL Transformation para inserir uma referência à 
página XSLT completa na página dinâmica.

■ Poste as duas páginas dinâmicas e o fragmento XSLT (ou a página XSLT completa) em seu 
servidor de aplicativos. Se estiver usando um arquivo XML local, você precisará postá-lo 
também.

■ Visualize a página dinâmica no navegador. Quando você fizer isso, o servidor de 
aplicativos transformará os dados XML e os incluirá na página dinâmica para exibi-los no 
navegador.

Criar páginas XSLT
Você pode criar páginas XSLT que lhe permitam exibir dados XML em páginas da Web. É 
possível criar uma página inteiramente XSLT — uma página XSLT que contenha uma tag 
<body> tag e uma tag <head> — ou criar um fragmento XSLT. Quando você cria um 
fragmento XSLT, cria um arquivo independente, que não contém nenhuma tag body ou head 
— um fragmento simples de código que será posteriormente inserido em uma página 
dinâmica.

Para criar uma página XSLT:

1. Selecione File (Arquivo)> New (Novo)

N
O

T
A

Se estiver começando por uma página XSLT existente e precisar anexar a ela uma fonte 
de dados XML, consulte “Anexar fontes de dados XML” na página 830.
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2. Na guia General (Geral) da caixa de diálogo New Document (Novo documento), selecione 
a página Basic (Básica) na coluna Category (Categoria) e siga um destes procedimentos:

■ Selecione XSLT (Entire page) na coluna da página Basics para criar uma página XSLT 
completa.

■ Selecione XSLT (Fragment) na coluna da página Basics para criar um fragmento XSLT.
3. Clique em Create (Criar).

A caixa de diálogo Locate XML Source (Localizar código-fonte XML) é exibida, 
solicitando a você que anexe uma fonte de dados XML.

4. Siga um dos procedimentos abaixo:

■ Selecione Attach a local file (Anexar um arquivo local), clique no botão Browse 
(Procurar), selecione um arquivo XML local em seu computador e, em seguida, clique 
em OK.

■ Selecione Attach a remote file (Anexar um arquivo remoto), digite a URL de um 
arquivo XML na Internet (como a URL de um leitor RSS) e clique em OK.

O Dreamweaver preenche o painel Bindings (Ligações) com o esquema da fonte de dados 
XML.

N
O

T
A

Clicar no botão Cancel (Cancelar) gerará uma nova página XSLT sem nenhuma 
fonte de dados XML anexada. Para obter informações sobre como anexar fontes 
de dados XML, consulte “Anexar fontes de dados XML” na página 830.
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A tabela a seguir fornece uma explicação sobre os diversos elementos do esquema que 
poderão ser exibidos:

5. Salve sua nova página (File > Save) com a extensão .xsl ou .xslt (o padrão é .xsl).

Converter páginas HTML em páginas XSLT
Também é possível converter as páginas HTML existentes para páginas XSLT. Por exemplo, 
caso deseje adicionar dados XML a uma página pré-projetada, você pode converter a página 
em uma página XSLT, em vez de criar uma página XSLT e projetá-la desde o início.

Para converter uma página HTML existente para uma página XSLT:

1. Abra a página HTML a ser convertida.

2. Selecione File > Convert > XSLT 1.0.

O Dreamweaver abre uma cópia da página na janela do documento. A nova página é uma 
folha de estilos XSL, salva com a extensão .xsl.

Anexar fontes de dados XML
Se estiver começando por uma página XSLT existente ou não anexar uma fonte de dados 
XML ao criar uma nova página XSLT com o Dreamweaver, use o painel Bindings para anexar 
a fonte de dados XML.

Elemento Representa Detalhes

<> Requer um elemento XML 
que não se repita

Um elemento que apareça 
exatamente uma vez dentro 
de seu nó-pai

<>+ Elemento XML repetido Um elemento que aparece 
uma ou mais vezes dentro de 
seu nó-pai

<>? Elemento XML opcional Um elemento que pode não 
aparecer nenhuma vez ou 
aparecer várias vezes dentro 
de seu nó-pai

Nó de elemento em fonte 
negrito

Elemento de contexto atual Normalmente, o elemento 
que se repete quando o 
ponto de inserção está 
dentro de uma região de 
repetição

@ Atributo XML
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Para anexar uma fonte de dados XML:

1. No painel Bindings (Window > Bindings), clique no link XML.

2. Siga um dos procedimentos abaixo:

■ Selecione Attach a Local File, clique no botão Browse, selecione um arquivo XML 
local em seu computador e, em seguida, clique em OK.

■ Selecione Attach a Remote File, digite a URL de um arquivo XML na Internet (como 
a URL de um leitor RSS) e clique em OK.

3. Clique em OK para fechar a caixa de diálogo Locate XML Source.

O Dreamweaver preenche o painel Bindings (Ligações) com o esquema da fonte de dados 
XML. Para obter um guia dos símbolos do esquema, consulte “Criar páginas XSLT” na 
página 828.

Exibir dados XML em páginas XSLT
Uma vez criada uma página XSLT e anexada uma fonte de dados XML, você pode vincular os 
dados à página.

Para exibir dados XML:

1. Abra uma página XSLT com uma fonte de dados XML anexada. Para obter instruções, 
consulte “Criar páginas XSLT” na página 828.

N
O

T
A

Se preferir, clique no link Source (localizado no canto superior direito do painel 
Bindings) para adicionar uma fonte de dados XML.
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2. (Opcional) Selecione Insert (Inserir) > Table (Tabela) para adicionar uma tabela à página. 
A tabela o ajudará a organizar os dados XML. Para obter mais informações, consulte 
Capítulo 8, “Apresentar conteúdo com tabelas”, na página 257.

3. No painel Bindings, selecione um elemento XML e arraste-o até a posição na página onde 
desejar inserir os dados.

Um alocador de espaço de dados XML é exibido na página. O alocador de espaço será 
mostrado em destaque e na forma de colchetes vazios. Ele usa a sintaxe XPath (linguagem 
do caminho XML) para descrever a estrutura hierárquica do esquema XML. Por exemplo, 
se você arrastar o elemento-filho “title” até a página e este elemento tiver os elementos-pai 
“rss,” “channel,” e “item,”, a sintaxe do alocador de conteúdo dinâmico será {rss/channel/
item/title}.

N
O

T
A

Na maioria dos casos, você desejará usar o objeto XSLT de Repeat Region para 
exibir os elementos XML repetitivos em uma página. Se esse for o caso, você pode 
criar uma tabela com uma única linha, com uma ou mais colunas. Para incluir um 
cabeçalho na tabela, crie uma tabela com duas linhas. Para obter mais informações, 
consulte “Exibir elementos XML repetidos” na página 833.
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Se houver um alocador de espaço de dados XML na página, você poderá clicar duas vezes 
nele para abrir o XPath Expression Builder. O XPath Expression Builder permite que você 
formate os dados selecionados ou selecione outros itens do esquema XML. Para obter mais 
informações, clique no botão Help (Ajuda) do XPath Expression Builder.

4. (Opcional) Aplique estilos a seus dados XML, selecionando o alocador de espaço de dados 
XML e aplicando estilos a ele como qualquer outro fragmento de conteúdo por meio do 
Property Inspector ou do painel CSS Styles (Estilos de CSS). Ou, use as folhas de estilo 
Design-time (Fase do projeto) para aplicar estilos aos fragmentos XSLT. Cada um desses 
métodos possui seu próprio conjunto de benefícios e limitações. Para obter mais 
informações, consulte “Aplicar estilos a fragmentos XSLT” na página 844.

5. Visualize seu trabalho em um navegador (File > Preview in Browser)

Exibir elementos XML repetidos

O objeto XSLT de Repeat Region permite exibir os elementos repetidos a partir de uma fonte 
de dados XML em uma página da Web. Por exemplo, se você estiver exibindo títulos e 
descrições de artigos a partir de um leitor de notícias e tal leitor contiver entre 10 e 20 artigos, 
os títulos e as descrições no arquivo XML serão provavelmente elementos filhos de um 
elemento repetido.

Qualquer região na visualização do projeto que contenha um alocador de espaço de dados 
XML poderá ser transformado em uma região repetida. Todavia, as regiões mais comuns são 
tabelas, linhas de tabelas ou uma série de linhas de tabelas.

Para saber mais sobre como o objeto XSLT de Repeat Region funciona com os dados XML, 
consulte “Sobre dados XML e elementos repetidos” na página 822.

Para exibir elementos XML repetidos:

1. Na visualização do projeto, selecione uma região que contenha um ou mais alocadores de 
espaço de dados XML.

N
O

T
A

Quando você visualiza seu trabalho em um navegador usando a opção Preview in 
Browser, o Dreamweaver executa uma transformação de XSL interna sem recorrer 
ao servidor de aplicativos. Para obter mais informações, consulte “Sobre a 
visualização de dados XML” na página 824.
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A seleção pode ser qualquer elemento, incluindo uma tabela, uma linha de tabela ou até 
mesmo um parágrafo de texto.

2. Siga um dos procedimentos abaixo

■ Selecione Insert (Inserir) > XSLT Objects (Objetos XSLT) > Repeat Region (Região 
repetitiva).

■ Na categoria XSLT da barra Insert, clique no botão Repeat Region.

D
IC

A

Para selecionar com exatidão uma região na página, utilize o seletor de tags no 
canto inferior esquerdo da janela do documento. Por exemplo, se a região for uma 
tabela, clique dentro da tabela na página e, em seguida, clique na tag <table> no 
seletor de tags.
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3. No XPath Expression Builder, selecione o elemento que se repete, indicado por um 
pequeno sinal de adição.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK. 

Na janela do documento, um contorno cinza e estreito com guia será exibido ao redor da 
região repetitiva. Quando você visualiza seu trabalho em um navegador (File > Preview in 
Browser, a linha cinza desaparece e a seleção se expande para exibir os elementos repetidos 
especificados no arquivo XML.
Você também notará que, quando adicionar o objeto XSLT de Repeat Region à página, o 
Dreamweaver truncará o comprimento do alocador de espaço de dados XML na janela do 
documento. Isto acontece porque o Dreamweaver atualiza o XPath para o alocador de 
espaço dos dados XML de modo a torná-lo relativo ao caminho do elemento repetido.
Para obter mais informações, consulte “Sobre dados XML e elementos repetidos” na 
página 822.
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Editar um objeto XSLT de Repeat Region
Uma vez adicionado um objeto XSLT de Repeat Region a uma região, você poderá fazer 
alterações nele por meio do Property inspector.

Para editar um objeto XSLT de Repeat Region:

1. Selecione o objeto, clicando na guia cinza em torno da região repetida.

2. No Property inspector (Window > Properties), clique no ícone dinâmico ao lado do campo 
de texto Select (Selecionar).

3. No XPath Expression Builder, faça as alterações e clique em OK.

Inserir fragmentos XSLT em páginas dinâmicas
Uma vez criado um fragmento XSLT, use o comportamento de servidor XSLT Transformation 
para inseri-lo em uma página da Web dinâmica. Quando você adiciona o comportamento de 
servidor à sua página e visualiza a página em um navegador, o servidor de aplicativos executa 
uma transformação que exibe os dados XML a partir do fragmento XSLT selecionado. O 
Dreamweaver oferece suporte a transformações de XSL para páginas ColdFusion, ASP, 
ASP.NET ou PHP. 

Para inserir um fragmento XSLT em uma página da Web:

1. Abra uma página ColdFusion, ASP, ASP.NET ou PHP.

2. No modo de visualização de projeto, coloque o ponto de inserção no local onde deseja 
exibir o fragmento XSLT.

N
O

T
A

Para inserir em uma página dinâmica o conteúdo de uma página inteiramente XSLT, o 
procedimento é um pouco diferente. Antes de usar o comportamento de servidor XSL 
Transformation para a página inteiramente XSLT, exclua todo o código HTML de sua 
página dinâmica. Para obter mais informações, consulte “Sobre transformações de XSL 
no lado servidor” na página 816.

N
O

T
A

Ao inserir fragmentos XSLT, é necessário sempre clicar no botão Show Code and 
Design view (Mostrar visualizações do código e do projeto) após posicionar o ponto 
de inserção na página, de modo a assegurar que ele esteja no local correto. Caso 
contrário, você precisará clicar em outro local da visualização do código para 
posicionar o ponto de inserção no local desejado.
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3. No painel Server Behaviors (Comportamentos de servidor) em Window > Server 
Behaviors, clique no botão com sinal de adição (+) e selecione XSL Transformation.

4. Na caixa de diálogo XSL Transformation, clique no botão Browse e acesse um fragmento 
XSLT ou uma página inteiramente XSLT. Para obter mais informações, consulte “Criar 
páginas XSLT” na página 828.

O Dreamweaver preencherá automaticamente o próximo campo de texto com o caminho 
de arquivo ou URL do arquivo XML que está anexado ao fragmento especificado. Para 
alterá-lo, clique no botão Browse e procure outro arquivo.

5. (Opcional) Clique no botão com o sinal de adição (+) para adicionar um parâmetro XSLT. 
Para obter mais informações, consulte “Utilizar parâmetros com transformações de XSL” 
na página 839.

6. Clique em OK.

O Dreamweaver insere uma referência ao fragmento XSLT na página. O fragmento não é 
editável. Para edita-lo, clique duas vezes no fragmento para abrir seu arquivo de origem.
O Dreamweaver cria uma pasta includes/MM_XSLTransform/ na pasta raiz do site que 
contém um arquivo de biblioteca de tempo de execução. O servidor de aplicativos usa as 
funções definidas nesse arquivo para realizar a transformação. Para obter mais 
informações, consulte “Sobre transformações de XSL no lado servidor” na página 816.
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7. Faça o upload da página dinâmica em seu servidor (Site > Put). Quando o Dreamweaver 
oferecer a opção de incluir arquivos dependentes, clique em Yes. O arquivo que contém o 
fragmento XSLT, o arquivo XML que contém os seus dados e o arquivo da biblioteca de 
tempo de execução deverão estar todos no servidor para que a página seja exibida 
corretamente. (Caso tenha selecionado um arquivo XML remoto como fonte de dados, tal 
arquivo deverá, obviamente, residir em algum outro local da Internet.)

Excluir fragmentos XSLT das páginas dinâmicas
É possível remover um fragmento XSLT de uma página excluindo o comportamento de 
servidor XSL Transformation utilizado para inserir o fragmento. A exclusão do 
comportamento de servidor exclui apenas o fragmento XSLT, mas não exclui os arquivos de 
biblioteca de tempo de execução nem os arquivos XML e XSLT a eles associados.

Para excluir um fragmento XSLT de uma página dinâmica:

1. No painel Server Behaviors (Window > Server Behaviors), selecione o comportamento de 
servidor XSL Transformation a ser excluído.

2. Clique no botão com o sinal de subtração (-).

Editar comportamentos de servidor XSL 
Transformation
Uma vez adicionado um fragmento XSLT a uma página dinâmica, é possível editar a qualquer 
momento o comportamento de servidor XSL Transformation.

Para editar um comportamento de servidor XSL Transformation:

1. No painel Server Behaviors (Window > Server Behaviors), clique duas vezes no 
comportamento de servidor XSL Transformation a ser editado.

2. Faça as alterações e clique em OK.

N
O

T
A

A Macromedia recomenda sempre esse procedimento para a remoção de 
comportamentos de servidor. A exclusão manual do código gerado removerá 
apenas parcialmente o comportamento de servidor, embora ele possa desaparecer 
do painel Server Behaviors.
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Utilizar parâmetros com transformações de XSL
É possível definir parâmetros para a transformação de XSL durante a adição de um 
comportamento de servidor XSL Transformation a uma página da Web. O parâmetro 
controla a maneira como os dados XML são processados e exibidos. Por exemplo, é possível 
usar um parâmetro para identificar e listar um artigo específico em um leitor de notícias. 
Quando a página é carregada no navegador, é exibido apenas o artigo especificado com os 
parâmetros.

Para adicionar um parâmetro XSLT a uma transformação de XSL:

1. Abra a caixa de diálogo XSL Transformation. Para fazer isso, clique duas vezes em um 
comportamento de servidor XSL Transformation no painel Server Behaviors (Window > 
Server Behaviors) ou adicione um novo comportamento de servidor XSL Transformation. 
Para obter instruções, consulte “Inserir fragmentos XSLT em páginas dinâmicas” na 
página 836.

2. Na caixa de diálogo XSL Transformation, clique no botão com o sinal de adição (+) ao lado 
de XSLT Parameters (Parâmetros de XSLT).

3. Na caixa de diálogo Add Parameters (Adicionar parâmetros), digite um nome para o 
parâmetro na caixa de texto Name (Nome). O nome só pode conter caracteres 
alfanuméricos. Não são permitidos espaços.

4. Siga um dos procedimentos abaixo:

■ Para usar um valor estático, digite-o na caixa de texto Value.
■ Para usar um valor dinâmico, clique no ícone dinâmico ao lado da caixa de texto Value, 

complete a caixa de diálogo Dynamic Data (Dados dinâmicos) e clique em OK. Para obter 
mais informações, clique no botão Help da caixa de diálogo Dynamic Data.

5. Na caixa de texto Default Value (Valor padrão), digite o valor a ser usado pelo parâmetro 
se a página não receber nenhum valor de tempo de execução.
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6. Clique em OK.

Para editar um parâmetro XSLT:

1. Abra a caixa de diálogo XSL Transformation. Para fazer isso, clique duas vezes em um 
comportamento de servidor XSL Transformation no painel Server Behaviors (Window > 
Server Behaviors) ou adicione um novo comportamento de servidor XSL Transformation. 
Para obter instruções, consulte “Inserir fragmentos XSLT em páginas dinâmicas” na 
página 836.

2. Selecione um parâmetro na lista de parâmetros de XSLT.

3. Clique no botão Edit (Editar).

4. Faça as alterações e clique em OK.

Para excluir um parâmetro XSLT:

1. Abra a caixa de diálogo XSL Transformation. Para fazer isso, clique duas vezes em um 
comportamento de servidor XSL Transformation no painel Server Behaviors (Window > 
Server Behaviors) ou adicione um novo comportamento de servidor XSL Transformation. 
Para obter instruções, consulte “Inserir fragmentos XSLT em páginas dinâmicas” na 
página 836.

2. Selecione um parâmetro na lista de parâmetros de XSLT.

3. Clique no botão com o sinal de subtração (-).

Criar regiões XSLT condicionais
É possível usar o Dreamweaver para criar regiões condicionais simples ou múltiplas em uma 
página XSLT. Você pode fazer uma seleção no modo de visualização de projeto e aplicar a ela 
uma região condicional ou pode inserir uma região condicional na posição do ponto de 
inserção no documento.

Por exemplo, para exibir a palavra “Unavailable” ao lado do preço de um item quando este não 
estiver disponível, digite a palavra “Unavailable” na página, selecione-a e, em seguida, aplique 
uma região condicional ao texto selecionado. O Dreamweaver incluirá a seleção dentro de tags 
<xsl:if> e só exibirá a palavra na página quando os dados coincidirem com as condições da 
expressão condicional.

Para criar uma região XSLT condicional:

1. Selecione Insert > XSLT Objects > Conditional Region (Região condicional) ou Insert > 
XSLT Objects > Multiple Conditional Region (Região condicional múltipla).
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2. Na caixa de diálogo Conditional Region ou Multiple Conditional Region, insira a 
expressão condicional a ser usada para a região.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

Editar um objeto XSLT de Conditional Region
Uma vez adicionada a região XSLT condicional à página, é possível alterá-la por meio do 
Property inspector.

Para editar um objeto XSLT de Conditional Region:

1. Selecione o objeto, clicando na guia cinza em torno da região condicional.

2. No Property inspector (Window > Properties), edite a expressão condicional na caixa de 
texto Test (Testar).

Inserir comentários de XSL
Você poderá adicionar tags de comentário XSL a um documento ou pode marcar a seleção nas 
tags de comentário XSL.

Para adicionar tags de comentário XSL a um documento:

■ Siga um dos procedimentos abaixo:
■ No modo de visualização de projeto, selecione Insert > XSLT Objects > XSL 

Comment (Comentário de XSL), digite o conteúdo do comentário (ou deixe a caixa 
de texto em branco) e clique em OK.

■ No modo de visualização de código, selecione Insert > XSLT Objects > XSL 
Comment.

Para marcar uma seleção nas tags de comentário XSL:

1. Alterne para o modo visualização do código (View > Code).

2. Selecione o código a ser comentado.

3. Na barra de ferramentas Coding (Codificação), clique no botão Apply Comment e 
selecione Apply <xsl:comment></xsl:comment> Comment.
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Executar transformações de XSL no 
cliente
Também é possível executar transformações de XSL no cliente sem o uso de um servidor de 
aplicativos. Quando você faz isso, o navegador torna-se responsável pelo trabalho de 
transformar os dados de XML, no lugar do servidor de aplicativos. Você pode usar o 
Dreamweaver para criar esse tipo de página; no entanto, as transformações no lado cliente 
requerem a manipulação do arquivo XML que contém os dados a serem exibidos. Além disso, 
as transformações no lado cliente só funcionarão em navegadores modernos.

A Macromedia recomenda que você leia “Sobre transformações de XSL no lado cliente” na 
página 819 antes de prosseguir com um destes procedimentos.

Esta seção contém os seguintes tópicos:

■ “Fluxo de trabalho para execução de transformações de XSL no lado cliente” na 
página 842

■ “Criar páginas inteiramente XSLT” na página 843
■ “Vincular arquivos XSLT e XML” na página 843

Tópicos relacionados
■ “Sobre transformações de XSL no lado servidor” na página 816

Fluxo de trabalho para execução de transformações 
de XSL no lado cliente
Esta seção fornece uma lista das etapas necessárias para executar as transformações de XSL no 
lado cliente e cita as seções da documentação que analisam cada procedimento.

A Macromedia recomenda a leitura de “Sobre como usar XML e XSL com páginas da Web” 
na página 814, “Sobre transformações de XSL no lado servidor” na página 816 e “Sobre 
transformações de XSL no lado cliente” na página 819 antes de criar as páginas que exibem 
dados XML.

Para executar transformações de XSL no lado cliente, siga estas etapas:

■ Configure um site Dreamweaver. Consulte Capítulo 2, “Configurar um site do 
Dreamweaver”, na página 87.

■ Siga um dos procedimentos abaixo:
■ No site Dreamweaver, crie uma página inteiramente XSLT. Consulte “Criar páginas 

inteiramente XSLT” na página 843.
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■ Converta uma página HTML existente para uma página inteiramente XSLT. Consulte 
“Converter páginas HTML em páginas XSLT” na página 830

■ Anexe uma fonte de dados XML à pagina (se isso ainda não tiver sido feito). Consulte 
“Anexar fontes de dados XML” na página 830. O arquivo XML que você anexar deverá 
residir no mesmo diretório da página XSLT.

■ Vincule os dados XML à página XSLT. Consulte “Exibir dados XML em páginas XSLT” 
na página 831.

■ Se apropriado, adicione um objeto XSLT de Repeat Region à tabela ou à linha da tabela 
que contém os alocadores de espaço dos dados XML. Consulte “Exibir elementos XML 
repetidos” na página 833.

■ Anexar a página XSLT à página XML. Consulte “Vincular arquivos XSLT e XML” na 
página 843.

■ Envie para o servidor da Web a página XML e a página XSLT vinculada.
■ Visualize a página XML no navegador. Quando você fizer isso, o navegador transformará 

os dados XML e os formatará na página XSLT; em seguida, ele exibirá a página com os 
estilos.

Criar páginas inteiramente XSLT
É necessário usar uma página inteiramente XSLT para as transformações no lado cliente. (Os 
fragmentos XSLT não funcionam neste tipo de transformação.) Para obter instruções sobre 
como criar e vincular dados XML e sobre como formatar páginas XSLT, consulte os seguintes 
tópicos:

■ “Criar páginas XSLT” na página 828 
■ “Exibir dados XML em páginas XSLT” na página 831
■ “Exibir elementos XML repetidos” na página 833
■ “Aplicar estilos a fragmentos XSLT” na página 844

Vincular arquivos XSLT e XML
Uma vez criada uma página inteiramente XSLT com alocadores de espaço de conteúdo 
dinâmico para seus dados XML, você precisa inserir uma referência à página XSLT na página 
XML.

N
O

T
A

Os arquivos XML e XSL que você usa nas transformações no lado cliente precisam 
residir no mesmo diretório. Caso contrário, o navegador lerá o arquivo XML e encontrará 
a página XSLT para a transformação, mas não conseguirá localizar as propriedades 
(folhas de estilos, imagens etc) definidas pelos links relativos na página XSLT.
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Para vincular uma página XSLT a uma página XML:

1. Abra o arquivo XML a ser vinculado à sua página XSLT.

2. Selecione Commands (Comandos) > Attach an XSLT Stylesheet (Anexar uma folha de 
estilos XSLT).

3. Na caixa de diálogo Attach an XSLT Stylesheet, clique no botão Browse, localize a página 
XSLT à qual deseja vincular e clique em OK.

4. Clique em OK para fechar a caixa de diálogo Attach an XSLT Stylesheet.

O Dreamweaver insere a referência à página XSLT na parte superior do documento XML.

Aplicar estilos a fragmentos XSLT
Ao criar uma página inteiramente XSLT (ou seja, uma página XSLT que contém tags <body> 
e <head>), você pode exibir os dados XML na página e, em seguida, formatá-los como 
qualquer outro fragmento de conteúdo por meio do Property inspector ou do painel CSS 
Styles. No entanto, quando você cria um fragmento XSLT para ser inserido em uma página 
dinâmica (por exemplo, um fragmento para inserção em uma página ASP, PHP ou Cold 
Fusion), a apresentação dos estilos no fragmento e na página dinâmica se torna mais 
complicada. Apesar de você trabalhar em um fragmento XSLT separado da página dinâmica, é 
importante lembrar que o fragmento deve ser usado dentro da página dinâmica e que a saída 
final do fragmento XSLT residirá em algum lugar dentro das tags <body> da página. Com 
base nesse fluxo de trabalho, é importante você assegurar que não sejam incluídos elementos 
<head> (tais como definições de estilo ou links para folhas de estilo externas) nos fragmentos. 
Caso isso ocorra, o servidor de aplicativos posicionará esses elementos na tag <body> da 
página dinâmica, gerando assim uma marcação inválida.
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Por exemplo, suponha que você esteja criando um fragmento XSLT para ser inserido em uma 
página dinâmica e deseje formatar os fragmentos usando a mesma folha de estilos externa 
como página dinâmica. Se você anexar a mesma folha de estilos ao fragmento, a página 
HTML apresentará um link duplicado para ela (um na seção <head> da página dinâmica, e 
outro na seção <body>, onde aparece o conteúdo do fragmento XSLT). Em vez dessa 
abordagem, você deve usar as folhas de estilo Design-time para fazer referência à folha de 
estilos externa.

No caso da formatação do conteúdo dos fragmentos XSLT, a Macromedia recomenda que 
você utilize o seguinte fluxo de trabalho:

■ Primeiramente, anexe uma folha de estilos externa à página dinâmica (esse procedimento 
obedece às melhores práticas de aplicação de folhas de estilos ao conteúdo de qualquer 
página da Web). 

■ Em seguida, anexe a mesma folha de estilos externa ao fragmento XSLT como uma folha 
de estilos Design-time (Fase de projeto). Como o próprio nome sugere, as folhas de estilo 
da fase de projeto só funcionam no modo de projeto do Dreamweaver. Para obter mais 
informações, consulte “Utilizar folhas de estilo Design-Time” na página 442. 

Uma vez concluída as etapas anteriores, você poderá aplicar estilos existentes ou criar novos 
estilos em seu fragmento XSLT utilizando a mesma folha de estilos anexada à sua página 
dinâmica. Você terá uma saída HTML mais limpa, já que a referência à folha de estilos só é 
válida quando se trabalha no Dreamweaver, e o fragmento ainda mostrará os estilos 
apropriados no modo de visualização do projeto. Além disso, todos os seus estilos serão 
aplicados tanto ao segmento quanto à página dinâmica quando você visualizar a página 
dinâmica no modo de visualização do projeto ou em um navegador.

Para obter mais informações sobre o uso de CSS para formatar fragmentos XSLT, consulte 
www.macromedia.com/go/dw_xsl_styles.

Solucionar problemas de transformações 
de XSL
Caso tenha problemas com o funcionamento das transformações de XSL, consulte o guia de 
solução de problemas que oferece respostas às perguntas mais freqüentes, disponível em 
www.macromedia.com/go/dw_xsl_faq.

N
O

T
A

Se você visualizar o fragmento XSLT em um navegador, este não mostrará os estilos. 
Em vez disso, você deve visualizar a página dinâmica em um navegador para ver o 
fragmento XSLT dentro do contexto da página dinâmica.
Solucionar problemas de transformações de XSL 845

http://www.macromedia.com/go/dw_xsl_styles
http://www.macromedia.com/go/dw_xsl_faq


846 Capítulo 36:  Exibir dados XML em páginas da Web



         

37

CAPÍTULO 37

Usar os serviços da Web
Os serviços da Web são uma tecnologia emergente que possibilitam às páginas da Web acessar 
aplicativos distribuídos. Ao oferecer tanto o acesso a informações quanto a funcionalidade de 
um aplicativo como um serviço, os serviços da Web podem ser distribuídos e cobrados como 
pacotes de serviços que permitem acesso simultâneo a partir de qualquer plataforma. A página 
da Web que se conecta ao serviço da Web é normalmente conhecida como consumidor e o 
serviço em si é conhecido como publicador. O Macromedia Dreamweaver 8 permite criar 
páginas e sites que são consumidores de serviços da Web. Atualmente, o Dreamweaver oferece 
suporte à criação de consumidores de serviços da Web que utilizam tipos de documentos 
Macromedia ColdFusion MX, ASP.NET e JSP (Java Server Pages). Especificamente, o 
Dreamweaver permite executar as seguintes tarefas de desenvolvimento de serviços da Web:

■ Selecionar serviços da Web disponíveis na Internet
■ Gerar um proxy de serviço da Web que permita à página da Web se comunicar com o 

publicador de serviços da Web
O proxy (também conhecido como classe de abstração) contém os campos, métodos de 
obtenção de dados e propriedades do serviço da Web e os torna disponíveis para a página 
hospedada localmente. Ao gerar um proxy para sua página, o Dreamweaver permite exibi-
los no painel Components (Componentes)

■ Arrastar métodos e tipos de dados para o código da página

Antes de criar uma página que utiliza um serviço da Web, é necessário familiarizar-se com a 
tecnologia subjacente do servidor do aplicativo que deseja utilizar e a programação cria o que é 
exigido pelo aplicativo.

O Dreamweaver permite criar páginas da Web com acesso aos serviços da Web através das 
funcionalidades que os serviços oferecem. Além disso, é possível criar, desenvolver e  publicar 
serviços da Web para Macromedia ColdFusion MX.
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Este capítulo contém as seguintes seções:
Sobre os serviços da Web . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .848

Sobre os geradores proxy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 851

Adicionar um proxy para serviços da Web utilizando a descrição WSDL. . . . . . .855

Adicionar um serviço da Web a uma página  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .856

Editar a lista de sites de serviços da Web UDDI . . . . . . . . . . . . . . . . . . . . . . . . . . . . .859

Sobre os serviços da Web
Os serviços da e Web permitem que os aplicativos se comuniquem e compartilhem 
informações através da Internet, independentemente do sistema operacional ou linguagem de 
programação utilizados. Exemplos de serviços da Web e as informações e funcionalidades que 
fornecem:

■ Autenticação e autorização do usuário
■ Validação de cartão de crédito
■ Serviços de mercados financeiros que envolvem preços de ações associados a símbolos de 

registradores especificados
■ Aquisição de serviços que permitem aos usuários encomendarem produtos on-line
■ Serviços de informação que fornecem notícias ou outros tipos de informação com base em 

um interesse, local ou outras informações pessoais selecionadas

Ao fornecer funcionalidade como um serviço ao qual a página da Web se conecta e utiliza 
quando necessário, os serviços da Web oferecem aos desenvolvedores e provedores de serviço 
maior flexibilidade ao criar e implantar aplicativos de alta potencialidade.

Os serviços da Web consistem dos componentes básicos a seguir:

■ Publicadores de serviço: fornecem aplicativos hospedados e torna-os disponíveis para 
uso. Os serviços da Web podem ser fornecidos gratuitamente ou com o pagamento de 
uma taxa.

■ Agentes de serviços: mantêm um registro dos publicadores de serviços com descrições de 
ofertas de serviço e links para seus aplicativos.

■ Consumidores do serviço: são as páginas da Web que acessam e usam o serviço da Web 
remoto.
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Fluxo de trabalho de serviços da Web no 
Dreamweaver
Para criar uma página ou site consumidor de um serviço da Web utilizando o Dreamweaver, é 
necessário executar as seguintes tarefas:

1. Instalar e configurar um servidor proxy. 

Os geradores proxy geram um proxy para serviços da Web, um componente de software 
que a página da Web utiliza para comunicar-se com o publicador de serviços da Web. O 
proxy para serviços da Web é gerado a partir da WSDL (Web Service Description 
Language, Linguagem de descrição de serviço da Web), que descreve os serviços da Web. 
Dependendo da tecnologia de servidor para a qual deseja desenvolver consumidores de 
serviço da Web, será preciso instalar e configurar um gerador proxy que suporta essa 
tecnologia.
O Dreamweaver vem pré-configurado com o AXIX, o gerador proxy SOAP (Simple 
Object Access Protocol, Protocolo de acesso a objetos simples) da Apache que suporta o 
desenvolvimento de serviços da Web em JSP. Se você estiver desenvolvendo páginas em 
ColdFusion 6, o gerador proxy para serviços da Web será incluído no servidor 
ColdFusion. O estabelecimento de uma conexão ao servidor ColdFusion fornece acesso ao 
gerador proxy.
Se você estiver desenvolvendo páginas de serviço da Web para uso com ASP.NET, é preciso 
instalar o ASP.NET SDK, que está disponível no site da Microsoft.
Para obter mains informações sobre como instalar e configurar um gerador proxy não 
fornecido com o Dreamweaver, consulte “Sobre os geradores proxy” na página 851.

2. Com um navegador, visualize o registro de serviços da Web.

Há diversas fontes de serviços da Web, variando de sites de registro de serviços da Web até 
listas simples. Os registros utilizam o UDDI (Universal Description, Discovery and 
Integration, Descrição, Descoberta e integração universais), um padrão que permite aos 
provedores e consumidores de serviço se localizarem e efetuarem transações entre si. O 
UDDI permite às empresas localizarem serviços na Web de acordo com suas necessidades. 
Por exemplo, com o UDDI é possível especificar certos critérios, como o menor preço 
para um determinado serviço ou informações específicas. 

3. Após localizar e selecionar um serviço da Web com a funcionalidade que necessita, digite a 
URL do WSDL na caixa de diálogo Adding a Web Service (Adicionar um serviço da Web). 

4. Gerar um proxy para o serviço da Web na descrição WSDL do publicador de serviços. 

Para incorporar um serviço da Web em uma página da Web, é necessário criar um proxy. 
O proxy fornece a página da Web com as informações necessárias para ela comunicar-se 
com o serviço da Web e acessar os métodos que o serviço da Web oferece. 
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Para criar um proxy do arquivo WSDL, utilize um gerador proxy. Após criar o proxy, é 
possível instalá-lo:
■ No computador local em que você está desenvolvendo o consumidor de serviço da 

Web.
■ No computador servidor que está executando o servidor de aplicativos. Para implantar 

a página da Web e fazer com que ela se comunique com o publicador de serviços da 
Web, é necessário instalar o proxy no servidor.

Para obter mais informações, consulte “Sobre os geradores proxy” na página 851.
5. No Dreamweaver, adicione o serviço da Web a uma página e edite os parâmetros e métodos 

necessários para utilizar a funcionalidade do serviço.

Para obter mais informações, consulte “Adicionar um serviço da Web a uma página” na 
página 856.

Localizar publicadores de serviço da Web
Os serviços da Web são disponibilizados por publicadores de serviço. Normalmente, o 
publicador de serviço disponibiliza seu serviço da Web através de um registro baseado na Web 
que mantém um diretório de serviços disponíveis que podem ser acessados. Diversos sites da 
Web fornecem este diretório, incluindo:

■ X Methods em http://www.xmethods.net 
■ IBM Business Registry, em https://uddi.ibm.com/ubr/registry.html 
■ Registros do Microsoft UDDI em http://uddi.microsoft.com/default.aspx 

Estes registros utilizam o serviço UDDI (Universal Description, Discovery and Integration - 
Descrição, Descoberta e integração universais), um registro de serviço de e-commerce aberto 
com um fórum para que as empresas possam descrever os bens ou serviços que fornecem a 
outras empresas. Um grupo de empresas chamado de operadoras efetuam a manutenção dos 
registros. As operadoras comprometeram-se a compartilhar entre si todas as informações 
públicas sobre as empresas registradas e os usuários do serviço, e a manter a interoperabilidade 
entre os múltiplos nós da rede de serviço UDDI. Além de serviços da Web públicos, há 
também registros UDDI privados disponíveis por meio de assinatura.

A especificação UDDI baseia-se em padrões existentes na Internet, assegurando desta forma 
sua neutralidade quanto a plataforma e a implementação.

Tópicos relacionados
■ “Editar a lista de sites de serviços da Web UDDI” na página 859
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Componentes de software para serviços da Web
Para que uma página da Web possa acessar e utilizar um serviço da Web, ela deve comunicar-
se com o serviço e ter uma descrição da funcionalidade que o serviço oferece, dos métodos 
disponíveis que podem ser ativados e dos parâmetros retornados pelo serviço. A linguagem 
WSDL é uma descrição do serviço baseada em XML. Cada serviço da Web fornece uma 
WSDL que descreve como se ligar ao serviço, os métodos disponíveis que a página da Web 
pode chamar e as entradas e saídas de dados. A WSDL pode residir em um arquivo ou ser 
gerada pelo serviço da Web durante sua execução.

A comunicação entre a página da Web que solicita o serviço e o próprio serviço da Web utiliza 
o protocolo SOAP. O SOAP é um protocolo baseado em XML que permite a um cliente da 
Web acessar e chamar métodos e parâmetros do serviço da Web.

Tópicos relacionados
■ “Adicionar um proxy para serviços da Web utilizando a descrição WSDL” na página 855

Referências sobre serviços da Web
Para saber mais sobre serviços da Web e as tecnologias básicas que os tornam possíveis, visite 
os sites da Web a seguir:

■ Especificação WSDL em http://www.w3.org/TR/wsdl
■ Especificação UDDI em http://www.uddi.org/specification.html
■ Especificação XML em http://www.w3.org/TR/REC-xml
■ Especificação SOAP em http://www.w3.org/TR/SOAP/

Sobre os geradores proxy
O Dreamweaver instala o gerador proxy AVIS, que suporta serviços da Web em JSP. O AXIS é 
um gerador proxy com código-fonte aberto distribuído através do projeto SOAP da Apache. 
Além disso, é possível adicionar geradores proxy com suporte para as implementações de 
serviços da Web de outro fornecedor ou novas tecnologias de serviços da Web. Esta seção 
descreve como obter geradores proxy e configurá-los para funcionar com o Dreamweaver. 

Para saber mais sobre o AXIS, consulte o site da Apache AXIS em http://ws.apache.org/axis/
index.html.

Tópicos relacionados
■ “Configurar geradores proxy para utilização com o Dreamweaver” na página 852
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Obter geradores proxy adicionais
Se desejar instalar um gerador proxy não fornecido com o Dreamweaver, é preciso obter de 
outro fornecedor o gerador proxy e quaisquer outros componentes de software relacionados. 
Você deve efetuar o download todos os arquivos necessários a partir do site do fornecedor na 
Web.

Alguns geradores proxy criam proxies que dependem de outras bibliotecas de software, as 
quais devem ser instaladas adequadamente de modo que o gerador proxy tenha acesso a elas. 
Por exemplo, o gerador proxy AXIS cria proxies que dependem da biblioteca SOAP da Apache 
que, por sua vez, depende de outras bibliotecas de software (observe que todo o software 
necessário para uso do AXIS encontra-se normalmente instalado no Dreamweaver). Ao 
selecionar um gerador proxy, consulte a documentação fornecida e certifique-se de ter todos os 
componentes e bibliotecas de software exigidos, de modo que seja possível instalá-los e 
configurá-los corretamente.

Após instalar e configurar corretamente o gerador proxy, é necessário configurá-lo para 
funcionar com o Dreamweaver.

Configurar geradores proxy para 
utilização com o Dreamweaver
Ao instalar um gerador proxy para serviços da Web, é necessário configurá-lo para ele 
funcionar com o Dreamweaver. 

Para aprender mais sobre os geradores proxy, consulte “Sobre os geradores proxy” na 
página 851.

Para configurar um gerador proxy para funcionar com o Dreamweaver:

1. Selecione Window (Janela) > Components (Componentes) para abrir o painel 
Components.

2. No painel Components, selecione Web Services (Serviços da Web) no menu pop-up 
localizado no canto superior esquerdo do painel, clique no sinal de adição (+) e selecione 
Add Using WSDL (Adicionar utilizando WSDL).

N
O

T
A

Atualmente, o desenvolvimento de serviços da Web no Dreamweaver está limitado ao 
ambiente Windows. Para desenvolver páginas que acessam serviços da Web no 
Macintosh, é necessário utilizar um servidor de aplicativos separado que utilize o 
Windows NT/2000/XP ou UNIX no qual será executado o proxy para serviços da Web 
e seu ambiente de aplicativo.
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A caixa de diálogo Add Using WSDL (Adicionar utilizando WSDL) é exibida.

3. Na caixa de diálogo Add Using WSDL, selecione Edit Proxy Generator List (Editar lista de 
geradores proxy) no menu pop-up Proxy Generator (Gerador proxy). 

A caixa de diálogo Proxy Generator é exibida. 

4. Clique em New (Novo), selecione o gerador proxy no menu pop-up e clique em Done 
(Concluído). 

Se o gerador proxy que você deseja utilizar não aparecer na lista, selecione Default Proxy 
Generator (Gerador proxy padrão) para exibir a caixa de diálogo Default Proxy Generator.
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A caixa de diálogo Default Proxy Generator permite configurar o gerador proxy 
selecionado ou configurar um gerador proxy novo. As caixas de texto da caixa de diálogo 
variam, dependendo do gerador proxy selecionado. 

5. Preencha a caixa de diálogo e clique em OK.

Para obter informações sobre como preencher a caixa de diálogo, clique no botão Help 
(Ajuda) da caixa de diálogo.

6. Ao preencher as definições da caixa Default Proxy Generator, clique em OK.

Quando o Dreamweaver lê uma descrição WSDL de um serviço da Web, o Dreamweaver 
executa as ações a seguir correspondentes aos campos do Default Proxy Generator:
■ Efetua a leitura da WSDL como entrada para localizar o serviço da Web.
■ Gera o proxy para serviços da Web com o ambiente de execução especificado.
■ Compila o proxy com o compilador especificado.
■ Retorna o código-fonte do proxy e o proxy compilado na pasta de destino especificada.

Tópicos relacionados
■ “Sobre os geradores proxy” na página 851
■ “Obter geradores proxy adicionais” na página 852

N
O

T
A

O gerador proxy ColdFusion MX proxy não é editável.
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Adicionar um proxy para serviços da Web 
utilizando a descrição WSDL
Após especificar um gerador proxy (consulte “Sobre os geradores proxy” na página 851) e 
configurar os modelos de servidores de serviços da Web que deseja suportar, é necessário 
localizar um serviço da Web que forneça a funcionalidade desejada e gere um proxy para 
aquele serviço. 

Para selecionar um serviço da Web e gerar um proxy a partir de seu arquivo 
WSDL:

1. Abra a página à qual deseja adicionar o serviço da Web.

2. Selecione Window (Janela) > Components (Componentes) para abrir o painel 
Components.

3. No painel Components, selecione Web Services (Serviços da Web) no menu pop-up 
localizado no canto superior esquerdo do painel, clique no sinal de adição (+) e selecione 
Add Using WSDL (Adicionar utilizando WSDL).

A caixa de diálogo Add Using WSDL (Adicionar utilizando WSDL) é exibida.

4. Especifique a URL do arquivo WSDL que deseja utilizar.

Se a URL do arquivo WSDL for conhecida, digite a URL da caixa de texto WSDL.
Se a URL do arquivo WSDL não for conhecida, procure a URL em um diretório de 
serviços da Web. Ao localizar o serviço da Web desejado, copie e cole a URL do serviço da 
Web na caixa de edição WSDL. Para iniciar um navegador da Web, clique no botão 
UDDI Browse (Procurar UDDI) e selecione um dos registros de serviço da Web listados. 
O Dreamweaver iniciará o navegador e abrirá o registro selecionado. Localize o serviço da 
Web que deseja utilizar e copie a URL de seu arquivo WSDL para a área de trabalho do 
Windows. Retorne ao seletor de serviços da Web e cole a URL na caixa de diálogo.
É possível editar a lista de registros de serviços da Web para incluir diretórios de serviço da 
Web adicionais ou provedores de serviço da Web específicos. Para obter mais informações, 
consulte “Editar a lista de sites de serviços da Web UDDI” na página 859.
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5. Selecione um gerador proxy que oferece suporte para o modelo de servidor de serviço da 
Web desejado no menu pop-up Proxy Generator (Geradores proxy).

Certifique-se de que o gerador proxy esteja instalado e configurado em seu sistema. Para 
obter mais informações, consulte “Sobre os geradores proxy” na página 851.

6. Clique em OK.

O gerador proxy cria um proxy para o serviço da Web e inicia uma sondagem. Sondagem 
é o processo em que o gerador proxy examina a estrutura interna do proxy para serviços da 
Web para tornar as interfaces, métodos e propriedades disponíveis através do 
Dreamweaver.

O serviço da Web está agora disponível para uso no site e é exibido no painel Components. 
Você agora pode adicionar o serviço da Web à página. 

Tópicos relacionados
■ “Componentes de software para serviços da Web” na página 851

Adicionar um serviço da Web a uma 
página
Após selecionar um serviço da Web, gerar seu proxy e adicioná-lo ao painel Components 
(Componentes), é possível inseri-lo em uma página. 

A ilustração a seguir mostra o painel Components com o proxy para serviços da Web 
Helloworld adicionado. O proxy Helloworld fornece um método, sayHello, que imprime 
a expressão “Hello World”.

Os exemplos a seguir criam instâncias do serviço da Web HelloWorld utilizando o 
ColdFusion. Para obter mais informações sobre como criar serviços da Web e ver exemplos 
adicionais do .NET e do JSP, visite o Macromedia Support Center (Centro de suporte da 
Macromedia) em: www.macromedia.com/go/creating_web_services.
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Para adicionar um serviço da Web a uma página:

1. Na janela do documento, na visualização do código, arraste o método sayHello para o 
HTML da página.

O Dreamweaver adiciona o método e parâmetros fictícios à página.
2. Edite o código inserido com nomes de instâncias de serviço, tipos de dados e valores de 

parâmetro apropriados, conforme exigido pelo serviço da Web. O serviço da Web deve 
fornecer descrições dos tipos de dados e valores de parâmetro.

No exemplo em ColdFusion a seguir, o serviço da Web inclui as tags <cfinvoke>. Ao 
desenvolver um serviço da Web em ColdFusion, use <cfinvoke>  para criar instâncias do 
serviço da Web e iniciar seus métodos.
<html>
<head>
<title>Web Service</title>
<meta http-equiv="Content-Type" content="text/html; charset=iso-8859-1">
</head>

<cfinvoke 
webservice="http://www.mysite.com:8500:8500/helloworld/

HelloWorld.cfc?wsdl"
method="sayHello"
returnvariable="aString">
</cfinvoke>

</body>
</html>
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3. Se desejar ligar um valor de retorno a um elemento visual, alterne para o modo de 
visualização do projeto e coloque um elemento visual na página que possa aceitar ligações 
de dados. Em seguida, retorne para a visualização do código e digite o código apropriado 
para ligar o valor retornado ao elemento visual. Ao criar serviços da Web, consulte a 
documentação do provedor da tecnologia para obter a sintaxe adequada para criar 
instâncias do serviço e exibir os valores retornados à página.

Neste exemplo, o valor retornado para a variável aString é produzido utilizando a tag 
<cfoutput> no ColdFusion. Este código exibirá a sentença “The web service says: 
Hello world!” na página.
<html>
<head>
<title>Web Service</title>
<meta http-equiv="Content-Type" content="text/html; charset=iso-8859-1">
</head>
<cfinvoke 
webservice="http://www.mysite.com:8500/helloworld/HelloWorld.cfc?wsdl"
method="sayHello"
returnvariable="aString">
</cfinvoke>

The web service says: <cfoutput>#aString#</cfoutput>
</body>
</html>

4. Quando você implanta páginas da Web para um servidor de produção, o Dreamweaver 
copia automaticamente as páginas, o proxy e todas as bibliotecas necessárias ao servidor da 
Web. 

N
O

T
A

Se o aplicativo for desenvolvido com um proxy instalado em um computador 
diferente daquele em que as páginas foram desenvolvidas, ou se você estiver 
utilizando uma ferramenta de gerenciamento de site que não pode copiar todos os 
arquivos relacionados para o servidor, é preciso ter certeza de implantar tanto o 
proxy quanto quaisquer outros arquivos de biblioteca dependentes. Caso contrário, 
as suas páginas não poderão se comunicar com o aplicativo de serviço da Web.
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Editar a lista de sites de serviços da Web 
UDDI
O seletor de serviços da Web fornece uma lista de diretórios de serviços da Web baseados em 
UDDI, a partir da qual é possível selecionar serviços da Web. É possível editar esta lista para 
adicionar ou excluir diretórios de serviços da Web. Para obter mais informações, consulte 
“Localizar publicadores de serviço da Web” na página 850.

Para editar a lista de sites de serviços da Web:

1. No Dreamweaver, selecione Window (Janela)> Components (Componentes) para abrir o 
painel Components.

2. No painel Components, selecione Web Services (Serviços da Web) no menu pop-up 
localizado no canto superior esquerdo do painel e clique no sinal de adição (+) para 
adicionar um serviço da Web.

A caixa de diálogo Add Using WSDL (Adicionar utilizando WSDL) é exibida.
3. No Web Services Chooser (Seletor de serviços da Web), clique no ícone de globo e 

selecione Edit UDDI Site List (Editar lista de sites UDDI) no menu pop-up.

A caixa de diálogo UDDI Sites (Sites UDDI) é exibida.

4. Na caixa de diálogo UDDI Sites é possível adicionar novos sites de serviços da Web, editar 
o nome e a URL de sites existentes e remover sites não desejados. 

■ Para adicionar um site novo ou modificar um site existente, clique no botão New 
(Novo) ou Edit (Editar) e preencha a caixa de diálogo.

■ Para remover uma conexão existente, selecione-a na lista e clique no botão Remove 
(Remover).
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CAPÍTULO 38

Adicionar comportamentos 
de servidor personalizados
O Macromedia Dreamweaver 8 vem acompanhado de um conjunto de comportamentos de 
servidor incorporados que permitem adicionar facilmente recursos dinâmicos a um site. Se 
você desejar estender as funcionalidades do Dreamweaver, poderá criar novos 
comportamentos de servidor para adequar às suas necessidades de desenvolvimento, ou obter 
comportamentos de servidor a partir do site do Macromedia Exchange na Web.

Este capítulo contém as seguintes seções:
Sobre os comportamentos de servidor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 861

Instalar comportamentos de servidor de terceiros . . . . . . . . . . . . . . . . . . . . . . . . . . .873

Usar o Server Behavior Builder (Criador de comportamentos de servidor) . . . . .874

Usar parâmetros em comportamentos de servidor  . . . . . . . . . . . . . . . . . . . . . . . . . . 878

Posicionar blocos de código . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 878

Criar uma caixa de diálogo para um comportamento de servidor 
personalizado  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .880

Editar e modificar comportamentos de servidor . . . . . . . . . . . . . . . . . . . . . . . . . . . . .883

Sobre os comportamentos de servidor
Antes de criar os seus próprios comportamentos de servidor, você deve consultar o site do 
Macromedia Exchange na Web para verificar se alguém já criou um comportamento de 
servidor que forneça a funcionalidade que você desejaria adicionar ao seu site da Web. Muitas 
vezes, um desenvolvedor de terceiros pode já ter criado e testado um comportamento de 
servidor que atenda às suas necessidades.

Os comportamentos de servidor e outras extensões disponíveis no site do Macromedia 
Exchange na Web permitem adicionar facilmente novos recursos ao Dreamweaver. Cada 
comportamento de servidor inclui uma breve descrição, análises de usuário e um grupo de 
discussão no qual é possível formular questões e obter suporte para os comportamentos de 
servidor cujo download foi efetuado. 
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Se você estiver pretendendo criar o seu próprio comportamento de servidor, deverá estar 
familiarizado com a linguagem de programação da Web utilizada pelo seu site. Este capítulo 
fornece instruções específicas para a criação de comportamentos de servidor utilizando o 
Dreamweaver. Ele não o instruirá quanto a linguagens de programação ou ao teste de 
comportamentos de servidor.

Comportamentos de servidor 
Se você for um desenvolvedor experiente em ColdFusion, ASP.NET, JavaScript, VBScript, 
PHP ou Java, é possível escrever os seus próprios comportamentos de servidor. As etapas para 
criar um comportamento de servidor incluem as seguintes tarefas:

■ Escrever um ou mais blocos de código que executam a ação necessária.
Para obter mais informações sobre como criar comportamentos de servidor com o Server 
Behavior Builder (Criador de comportamentos do servidor) do Dreamweaver, consulte 
“Usar o Server Behavior Builder (Criador de comportamentos de servidor)” na 
página 874. Para obter mais informações sobre a sintaxe suportada por comportamentos 
de servidor do Dreamweaver, consulte “Usar parâmetros em comportamentos de servidor” 
na página 878.

■ Especificar onde o bloco de código deve ser inserido no código HTML da página
Para obter mais informações sobre como posicionar blocos de código em uma página, 
consulte “Posicionar blocos de código” na página 878.

■ Se o comportamento do servidor exigir a especificação de um valor para um parâmetro, 
criar uma caixa de diálogo solicitando que o programador da Web que aplica o 
comportamento forneça um valor apropriado.
Para obter mais informações como fornecer valores de parâmetro para um comportamento 
de servidor utilizando uma caixa de diálogo, consulte “Criar uma caixa de diálogo para um 
comportamento de servidor personalizado” na página 880.

■ Testar o comportamento do servidor antes de torná-lo disponível publicamente. 
Para obter instruções sobre como testar comportamentos de servidor, consulte “Testar 
comportamentos de servidor” na página 872.
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Sobre os blocos de código
Os blocos de código criados no Server Behavior Builder (Criador de comportamentos de 
servidor) são encapsulados em um comportamento de servidor, que é exibido no painel Server 
Behaviors (Comportamentos de servidor). O código pode ser qualquer código de tempo de 
execução válido para o modelo de servidor especificado. Por exemplo, se o ColdFusion for 
escolhido como o tipo de documento para o comportamento de servidor personalizado, o 
código escrito deverá ser um código ColdFusion válido executado em um servidor de 
aplicativos ColdFusion. 

Tópicos relacionados
■ “Instruções de codificação” na página 871

Blocos de código
É possível criar os blocos de código diretamente no Server Behavior Builder (Criador de 
comportamentos de servidor) ou copiar e colar o código de outras fontes. Cada bloco de 
código criado no Server Behavior Builder deve consistir em uma única tag ou bloco de script. 
Se for necessário inserir vários blocos de tag, dividi-los em blocos de código separados. 

Para obter mais informações, consulte “Usar o Server Behavior Builder (Criador de 
comportamentos de servidor)” na página 874

Parâmetros de tempo de execução
É possível incluir parâmetros no seu código de tempo de execução e permitir que o designer 
da página forneça os valores dos parâmetros. Para isso, insira marcadores de parâmetro no 
código, da seguinte maneira:
@@parameterName@@

Para obter mais informações, consulte “Usar parâmetros em comportamentos de servidor” na 
página 878.

Condições e elementos repetidos em blocos de código
Para executar o bloco de código, ou de parte dele, somente se determinada condição ou 
condições se aplicarem, utilize a seguinte sintaxe:
<@ if (expression1) @>

code block1
[<@ elseif (expression2) @>

code block2]*
[<@ else @>

code block3]
<@ endif @>
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Os colchetes ([ ]) indicam código opcional, e o asterisco (*) denota zero ou mais instâncias. A 
expressão de condição é qualquer expressão de condição JavaScript válida e pode conter 
parâmetros de comportamento de servidor.

Para repetir o bloco de código, ou parte dele, um determinado número de vezes, utilize a 
seguinte sintaxe:
<@ loop (@@param1@@,@@param2@@) @>

code block
<@ endloop @>

A diretiva 'loop' considera uma lista separada por vírgulas de arrays de parâmetros como 
argumentos. O texto que se repete será duplicado n vezes, em que n é o comprimento dos 
argumentos de arrays de parâmetros. Se mais de um argumento de array de parâmetros for 
especificado, todos os arrays deverão ter o mesmo comprimento. Na enésima avaliação do 
loop, os enésimos elementos dos arrays de parâmetros substituem as instâncias de parâmetro 
associadas no bloco de código. 

Para obter informações genéricas sobre codificação, consulte “Instruções de codificação” na 
página 871.

Tópicos relacionados
■ “Tornar condicionais os blocos de código” na página 866
■ “Repetir blocos de código” na página 868

Posicionar o bloco de código dentro de páginas da Web
Ao criar blocos de código usando o Server Behavior Builder (Criador de comportamentos de 
servidor) (consulte “Usar o Server Behavior Builder (Criador de comportamentos de 
servidor)” para obter mais informações), especifique onde quer inseri-los no código HTML da 
página. Você faz isto usando os menus pop-up Insert Code (Inserir código) e Relative Position 
(Posição relativa) da caixa de diálogo Server Behavior Builder, que permitem que você 
selecione onde inserir o bloco de código no documento e especificando, em seguida, uma 
posição relativa a uma outra tag na página.

Por exemplo, se inserir um bloco de código acima da tag de abertura <html>, você deverá 
depois especificar a posição dos blocos de código relativa a outras tags, scripts e 
comportamentos de servidor nessa seção do código HTML da página. Exemplos típicos 
incluem o posicionamento de um comportamento antes ou depois de quaisquer consultas de 
recordset que possam existir no código da página acima da tag de abertura <html>.
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Quando se seleciona uma opção de posicionamento no menu pop-up Insert (Inserir), as 
opções disponíveis no menu pop-up Relative Position (Posição relativa) se alteram para 
oferecer opções pertinentes para essa parte da página. Se, por exemplo, você selecionar Above 
the <html> Tag (Acima da tag html) no menu pop-up Insert Code (Inserir código), as opções 
de posicionamento disponíveis no menu pop-up Relative Position refletirão as escolhas 
pertinentes para essa parte da página. 

As opções de inserção de bloco de código e as opções de posicionamento relativo disponíveis 
para cada uma delas são mostradas na tabela abaixo.
 

Se deseja especificar uma posição personalizada, atribua um peso ao bloco de código. Use a 
opção Custom Position quando for necessário inserir mais de um bloco de código em uma 
determinada ordem. Por exemplo, se desejar inserir uma série ordenada de três blocos de 
código após os blocos que abrem os recordsets, defina um peso 60 para o primeiro bloco, 65 
para o segundo e 70 para o terceiro.

Por padrão, Dreamweaver atribui o peso 50 a todos os blocos de código de abertura de 
recordsets inseridos acima da tag <html>. Se houver correspondência entre o peso de dois ou 
mais blocos, o Dreamweaver determinará aleatoriamente a ordem dos blocos.

Opções de Insert 
Code

Opções de Relative Position

Above the <html> Tag 
(Acima da tag <html>)

• At the beginning of the file (No início do arquivo)
• Just before the recordsets (Imediatamente antes dos 

recordsets)
• Just after the recordsets (Imediatamente depois dos 

recordsets)
• Just above the <html> tag (Imediatamente acima da tag html)
• Custom position (Posição personalizada)

Below the </html> Tag 
(Abaixo da tag /html)

• Before the end of the file (Antes do fim do arquivo)
• Before the recordset close (Antes do fechamento do recordset)
• After the recordset close (Depois do fechamento do recordset)
• After the </html> tag (Depois da tag /html)
• Custom position (Posição personalizada)

Relative to a Specific Tag 
(Relativo a uma tag 
específica)

Selecione uma tag no menu pop-up Tag e, em seguida, escolha 
uma das opções de posicionamento da tag.

Relative to the Selection 
(Relativo à seleção)

Before the selection (Antes da seleção)
After the selection (Depois da seleção)
Replace the selection (Substituir a seleção)
Wrap the selection (Ajustar a seleção)
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Tópicos relacionados
■ “Sobre os blocos de código” na página 863
■ “Posicionar blocos de código” na página 878

Usar parâmetros em comportamentos de servidor
É possível incluir parâmetros no código de comportamento de um servidor e permitir que o 
designer da página forneça os valores de parâmetro necessários antes da inserção do código de 
comportamento de servidor na página. Para permitir que o designer da página forneça valores 
de parâmetros,insira marcadores de parâmetro no código, conforme mostrado:
@@parameterName@@

O exemplo de comportamento de servidor ASP a seguir contém o parâmetro formParam, que 
requer que a pessoa que esteja inserindo o comportamento forneça o nome de um objeto de 
formulário:
<% Session(“lang_pref”) = Request.Form(“formParam”); %>

Para criar um parâmetro que permita ao usuário fornecer o valor necessário:

1. Delimite a seqüência de caracteres formParam com marcadores de parâmetro:
<% Session(“lang_pref”) = Request.Form(“@@formParam@@”); %>

2. Crie uma caixa de diálogo que solicita ao designer o nome do objeto de formulário. Para 
obter mais informações, consulte “Criar uma caixa de diálogo para um comportamento de 
servidor personalizado” na página 880.

Tornar condicionais os blocos de código
O Dreamweaver permite desenvolver blocos de código que incorporam instruções de controle 
que têm uma execução condicional. O Server Behavior Builder (Criador de comportamentos 
de servidor) usa instruções if, elseif e else e também pode conter parâmetros de 
comportamento de servidor. Isso permite inserir blocos de texto alternativos com base nos 
valores de relacionamentos OR entre parâmetros de comportamento de servidor. As 
instruções if, elseif e else aparecem conforme mostrado a seguir. Observe que os colchetes 
([ ]) denotam código opcional e o asterisco (*) denota zero ou mais instâncias.
<@ if (expression1) @>

conditional text1
[<@ elseif (expression2) @>

conditional text2]*
[<@ else @>

conditional text3]
<@ endif @>
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As expressões de condição são qualquer expressão JavaScript que possa ser avaliada por meio 
da função JavaScript eval() e que inclua um parâmetro de comportamento de servidor 
marcado por @@ (as @@ são necessárias para distinguir o parâmetro das variáveis e palavras-
chave do JavaScript).

É possível aninhar qualquer número de condicionais ou uma diretiva 'loop' (consulte “Repetir 
blocos de código” na página 868) dentro de uma diretiva condicional. Por exemplo, é possível 
especificar que, se uma expressão for verdadeira, um loop deverá ser executado.

Tópicos relacionados
■ “Sobre os blocos de código” na página 863

Usar expressões condicionais de forma eficaz
Ao utilizar diretivas if, else e elseif na tag XML insertText , o texto participante será 
pré-processado para resolver as diretivas if e para determinar qual texto deve ser incluído no 
resultado. As diretivas if e elseif tratam a expressão como um argumento. A expressão de 
condição é idêntica àquelas expressões de condição do JavaScript e também pode conter 
parâmetros de comportamento de servidor. Diretivas como esta permitem escolher entre 
blocos de código alternativos com base nos valores de parâmetros de comportamento de 
servidor ou nos relacionamentos entre eles.

Por exemplo, o código JSP mostrado a seguir vem de um comportamento de servidor do 
Dreamweaver que utiliza o bloco de código condicional:
@@rsName@@.close();
<conditional_code>
@@rsName@@_hasData = @@rsName@@.next();

Se o comportamento de servidor usar um recordset normal, o alocador de espaço 
<conditional_code> será substituído por:
@@rsName@@ = Statement@@rsName@@.executeQuery();

Se o comportamento de servidor utilizar um recordset de um objeto chamável, ele utilizará em 
vez disso o seguinte código:
@@callableName@@.execute();

@@rsName@@ = @@callableName@@.getResultSet();

N
O

T
A

As novas linhas após cada “@>” são ignoradas.
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Se o comportamento de servidor for adicionado para um objeto chamável, o usuário digitará 
um valor para o parâmetro @@callableName@@  na caixa de diálogo Parameter  (Parâmetro) do 
comportamento de servidor. Caso contrário, o parâmetro @@callableName@@ deverá estar vazio. 
Assim, é possível reescrever o texto inserido anteriormente com o uso de @@callableName@@ 

como o argumento if. Nesse exemplo, se o parâmetro @@callableName@@ for fornecido com 
um valor e o primeiro bloco de código condicional (que contém o método getResultSet()) 
for selecionado:
@@rsName@@.close();
<@ if (@@callableName@@ != '') @>
@@callableName@@.execute();
@@rsName@@ = @@callableName@@.getResultSet();@ else @>
@@rsName@@ = Statement@@rsName@@.executeQuery();
<@ endif @>
@@rsName@@_hasData = @@rsName@@.next();

Repetir blocos de código
Ao criar comportamentos de servidor, é possível usar construções de loop para repetir um 
bloco de código um certo número de vezes. A sintaxe do loop é:
<@ loop (@@param1@@,@@param2@@,@@param3@@,@@param_n@@) @>

code block
<@ endloop @>

A diretiva 'loop' aceita uma lista separada por vírgulas de arrays de parâmetros como 
argumentos. Nesse caso, os argumentos de array de parâmetros permitem que um usuário 
forneça vários valores para um único parâmetro. O texto que se repete será duplicado n vezes, 
em que n é o comprimento dos argumentos de arrays de parâmetros. Se mais de um 
argumento de array de parâmetros for especificado, todos os arrays deverão ter o mesmo 
comprimento. Na enésima avaliação do loop, os enésimos elementos dos arrays de parâmetros 
substituem as instâncias de parâmetro associadas no bloco de código. Para obter mais 
informações, consulte “Utilizar as variáveis _length e _index da diretiva 'loop'” na página 870.

Após criar uma caixa de diálogo para o comportamento de servidor (consulte “Criar uma caixa 
de diálogo para um comportamento de servidor personalizado” na página 880), é possível 
adicionar um controle a essa caixa de diálogo que permite ao designer da página criar arrays de 
parâmetros. O Dreamweaver inclui um controle de array simples que pode ser utilizado para 
criar caixas de diálogo. Este controle, chamado Text Field Comma Separated List (Lista de 
campos de texto separada por vírgulas), está disponível no Server Behavior Builder (Criador 
de comportamentos de servidor). Para criar elementos de interface do usuário de maior 
complexidade, consulte a documentação da API para criar uma caixa de diálogo com um 
controle para arrays (por exemplo, um controle de grade).
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As diretivas 'loop' não podem ser aninhadas, mas as diretivas condicionais (veja “Posicionar 
blocos de código” na página 878) podem ser aninhadas em uma diretiva 'loop'.

O exemplo a seguir mostra como esses blocos de código repetitivos podem ser usados para 
criar comportamentos de servidor (o exemplo é um comportamento ColdFusion usado para 
acessar um procedimento armazenado):
<CFSTOREDPROC procedure="AddNewBook"

datasource=#MM_connection_DSN# 
username=#MM_connection_USERNAME# 
password=#MM_connection_PASSWORD#>

<CFPROCPARAM type="IN" dbvarname="@CategoryId" value="#Form.CategoryID#"
cfsqltype="CF_SQL_INTEGER">

<CFPROCPARAM type="IN" dbvarname="@ISBN" value="#Form.ISBN#"
cfsqltype="CF_SQL_VARCHAR">

</CFSTOREDPROC>

Nesse exemplo, a tag CFSTOREDPROC pode incluir zero ou mais tags CFPROCPARAM . 
Entretanto, sem suporte para a diretiva 'loop', não há como incluir as tags CFPROCPARAM 

dentro da tag inserida CFSTOREDPROC . Se essas tags tiverem de ser criadas como um 
comportamento de servidor sem o uso da diretiva 'loop', será preciso dividir este exemplo em 
dois participantes: uma tag principal CFSTOREDPROC  e uma tag CFPROCPARAM cujo tipo 
participante seja múltiplo.

Ao utilizar a diretiva 'loop', o mesmo procedimento pode ser escrito da seguinte maneira:
<CFSTOREDPROC procedure="@@procedure@@"
datasource=#MM_@@conn@@_DSN#
username=#MM_@@conn@@_USERNAME# 
password=#MM_@@conn@@_PASSWORD#>
<@ loop (@@paramName@@,@@value@@,@@type@@) @>

<CFPROCPARAM type="IN" 
dbvarname="@@paramName@@"
value="@@value@@" 
cfsqltype="@@type@@">

<@ endloop @>
</CFSTOREDPROC>

No exemplo anterior e no caso de blocos de código condicionais, as novas linhas após @> serão 
ignoradas.

Se o usuário digitar os valores de parâmetro a seguir na caixa de diálogo Server Behavior 
(Comportamento de servidor):
procedure = "proc1"
conn = "connection1"
paramName = ["@CategoryId", "@Year", "@ISBN"]
value = ["#Form.CategoryId#", "#Form.Year#", "#Form.ISBN#"]
type = ["CF_SQL_INTEGER", "CF_SQL_INTEGER", "CF_SQL_VARCHAR"]
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O comportamento de servidor inserirá o seguinte código de tempo de execução na página:
<CFSTOREDPROC procedure="proc1"
datasource=#MM_connection1_DSN#
username=#MM_connection1_USERNAME# 
password=#MM_connection1_PASSWORD#>

<CFPROCPARAM type="IN" dbvarname="@CategoryId" value="#Form.CategoryId#"
cfsqltype="CF_SQL_INTEGER">

<CFPROCPARAM type="IN" dbvarname="@Year" value="#Form.Year#"
cfsqltype="CF_SQL_INTEGER">

<CFPROCPARAM type="IN" dbvarname="@ISBN" value="#Form.ISBN#"
cfsqltype="CF_SQL_VARCHAR">

</CFSTOREDPROC>

Utilizar as variáveis _length e _index da diretiva 'loop'
A diretiva 'loop' inclui duas variáveis internas que podem ser usadas para condições if 
incorporadas. As variáveis são: _length e _index. A variável _length avalia o comprimento 
dos arrays processados pela diretiva 'loop', enquanto a variável _index avalia o índice atual da 
diretiva 'loop'. Para assegurar que as variáveis sejam reconhecidas apenas como diretivas e não 
como parâmetros reais a serem passados no loop, não as delimite com @@. 

Um exemplo do uso de variáveis internas sua aplicação ao atributo import da diretiva de 
página. O atributo import requer a separação de pacotes por vírgulas. Se a diretiva loop se 
estender para todo o atributo import, você terá apenas a saída do nome do atributo import= 
na primeira iteração do loop — e isto incluiria as aspas duplas de fechamento (") — e não a 
saída de uma vírgula na última iteração do loop. Com a variável interna, é possível expressá-la 
da seguinte maneira:
<@loop (@@Import@@)@>
<@ if(_index == 0)@>import="
<@endif@>@@Import@@<@if (_index == _length-1)@>"<@else@>,
<@ endif @>
<@endloop@>

N
O

T
A

Os arrays de parâmetros não podem ser usados fora de um loop, exceto como parte de 
uma expressão diretiva condicional.
870 Capítulo 38:  Adicionar comportamentos de servidor personalizados



         
Instruções de codificação 
De modo geral, o código do comportamento de servidor deve ser compacto e confiável. Os 
desenvolvedores de aplicativos para a Web são geralmente bastante exigentes quanto ao código 
adicionado a suas páginas. Siga as práticas de codificação geralmente aceitas para a linguagem 
de tipo de documento (ColdFusion, ASP.NET, JavaScript, VBScript, PHP, Visual Basic ou 
Java). Ao gerar comentários, leve em consideração os diferentes públicos técnicos que podem 
precisar compreender o código, como designers da Web e de interação, ou outros 
desenvolvedores de aplicativos para a Web. Inclua comentários que descrevam exatamente o 
objetivo do código e quaisquer instruções especiais para sua inclusão em uma página.

Segue uma lista de diretrizes para codificação que se deve ter em mente na criação de 
comportamentos de servidor:

Verificação de erro: é uma necessidade importante. O código do comportamento de servidor 
deve tratar as ocorrências de erros de forma precisa. Tente prever qualquer eventualidade. E se 
uma solicitação de parâmetro falhar, por exemplo? E se nenhum registro for retornado a partir 
de uma consulta?

Nomes exclusivos: ajudam a garantir que o código seja claramente identificável e evita o 
"conflito" de nomes no código existente. Por exemplo, se a página contiver uma função 
denominada hideLayer() e uma variável global denominada ERROR_STRING e o 
comportamento de servidor inserir código que utilize esses mesmos nomes, o comportamento 
de servidor poderá entrar em conflito com o código existente.

Prefixos de código: permitem identificar as suas próprias variáveis globais e funções de 
tempo de execução em uma página. Uma convenção seria utilizar as iniciais do nome do 
usuário. Nunca utilize o prefixo MM_, pois ele é reservado apenas para uso pela Macromedia. A 
Macromedia precede todas as funções e variáveis globais com o prefixo MM_ para impedir que 
elas entrem em conflito com o código que você escreve. 
var MM_ERROR_STRING = "...";
function MM_hideLayer() {

Evite blocos de código semelhantes: esse procedimento faz com que o código escrito por 
você não se pareça muito com o código existente em outros blocos. Se um bloco de código for 
muito parecido com outro bloco de código na página, o painel Server Behaviors 
(Comportamentos de servidor) poderá identificar incorretamente o primeiro bloco como uma 
instância do segundo bloco (ou vice-versa). Uma solução simples seria adicionar um 
comentário a um bloco de código para torná-lo mais  exclusivo.

Tópicos relacionados
■ “Sobre os comportamentos de servidor” na página 861
■ “Comportamentos de servidor” na página 862
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Testar comportamentos de servidor 
O Macromedia Exchange recomenda que sejam feitos os seguintes testes em cada 
comportamento de servidor criado:

■ Aplique o comportamento a partir do painel Server Behaviors (Comportamentos de 
servidor). Se o comportamento possuir uma caixa de diálogo, digite dados válidos em cada 
campo e clique em OK. Verifique se não ocorrem erros quando o comportamento é 
aplicado. Verifique se o código de tempo de execução para o comportamento de servidor 
foi exibido no Code inspector (Inspetor de código).

■ Aplique novamente o comportamento de servidor e insira dados inválidos em cada campo 
da caixa de diálogo. Experimente deixar o campo em branco, utilizar números grandes ou 
negativos, utilizar caracteres inválidos (por exemplo: /, ?, :, *, etc) e utilizar letras em 
campos numéricos. É possível gravar rotinas para validação de formulários a fim de tratar 
dados inválidos (as rotinas de validação envolvem codificação manual, que está além do 
escopo deste manual).

Após aplicar com êxito o comportamento de servidor à página, verifique:

■ O painel Server Behaviors (Comportamentos de servidor) para certificar-se de que o nome 
do comportamento de servidor é exibido na lista de comportamentos adicionados à 
página.

■ Se for aplicável, verifique se os ícones de scripts de servidor são mostrados na página. Os 
ícones de scripts de servidor genéricos são escudos dourados. Para ver os ícones, ative os 
Invisible Elements (Elementos invisíveis), a partir de View (Exibir) > Visual Aids (Auxílios 
visuais) > Invisible Elements.

■ Na visualização do código, a partir da seleção de View > Code (Código), verifique se 
nenhum código inválido foi gerado.

Além disso, se o comportamento de servidor inserir código no documento que estabeleça uma 
conexão a um banco de dados, crie um banco de dados de teste para testar o código incluído 
no documento. Verifique a conexão definindo consultas que produzem conjuntos de dados 
diferentes e de vários tamanhos.

Por fim, carregue a página no servidor e abra-a em um navegador. Visualize o código-fonte 
HTML da página e verifique se os scripts de servidor não geraram nenhum HTML inválido. 
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Instalar comportamentos de servidor de 
terceiros 
É possível efetuar o download e instalar comportamentos de servidor criados por 
desenvolvedores independentes do site do Macromedia Exchange na Web.

Para acessar o Macromedia Exchange:

1. No Dreamweaver, selecione Help (Ajuda) > Dreamweaver Exchange.

O seu navegador abre a página da Web Macromedia Exchange for Dreamweaver.
2. Efetue logon no Exchange com o seu ID de Macromedia ou, se ainda não tiver criado um 

ID para acessar o Macromedia Exchange, siga as instruções para abrir uma conta na 
Macromedia.

Para instalar um comportamento de servidor ou outra extensão no 
Dreamweaver:

1. Inicie o Extension Manager (Gerenciador de extensões) selecionando Commands 
(Comandos) > Manage Extensions (Gerenciar extensões).

2. Selecione File (Arquivo) > Install Package in the Extension Manager (Instalar pacote no 
Extension Manager). 

Para obter mais informações, consulte Using the Extension Manager.

Tópicos relacionados
■ “Sobre os comportamentos de servidor” na página 861
■ “Comportamentos de servidor” na página 862
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O Macromedia Exchange também pode ser acessado a partir do painel Server 
Behaviors (Comportamentos de servidor), aberto a partir da seleção de Window 
(Janela) > Behaviors (Comportamentos). Nesse painel, clique no botão de adição (+) 
e selecione Get More Server Behaviors (Obter outros comportamentos de servidor).
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Usar o Server Behavior Builder (Criador 
de comportamentos de servidor)
Use o Server Behavior Builder para adicionar um ou mais blocos de código que o 
comportamento insere na página.

Para escrever blocos de código de comportamento de servidor:

1. No painel Server Behaviors (Comportamentos de servidor), aberto a partir da seleção de 
Window (Janela)> Server Behaviors, clique no botão de adição (+) e selecione New Server 
Behavior (Novo comportamento de servidor) no menu pop-up. 

A caixa de diálogo New Server Behavior (Novo comportamento de servidor) é exibida.

2. No menu pop-up Document Type (Tipo de documento), selecione o tipo de documento 
para o qual o comportamento de servidor está sendo desenvolvido.

3. Na caixa de texto Name (Nome), digite o nome do comportamento de servidor.

4. Se deseja copiar um comportamento de servidor existente para adicioná-lo ao 
comportamento que está sendo criado, selecione a caixa de seleção Copy Existing Server 
Behavior (Copiar comportamento de servidor existente).

Quando essa caixa de seleção é selecionada, uma lista de comportamentos de servidor 
disponíveis é exibida no menu pop-up Behavior to Copy (Comportamento a ser copiado).

5. Clique em OK.
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A caixa de diálogo Server Behavior Builder é exibida. 

6. Para adicionar um novo bloco de código, clique no botão de adição (+).

A caixa de diálogo Create a New Code Block (Criar um novo bloco de código) é exibida.
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7. Digite um nome para o bloco de código a ser criado e clique em OK.

O nome que você inseriu na caixa de diálogo aparecerá no Server Behavior Builder, com as 
tags apropriadas de script visíveis na caixa de texto Code block (Bloco de código).

8. Na caixa de texto Code Block, digite o código necessário para implementar o 
comportamento de servidor. 

Ao digitar o código na caixa de texto Code Block:
■ Você só pode digitar uma única tag ou bloco de código para cada bloco de código 

nomeado (por exemplo, myBehavior_block1, myBehavior_block2, 
myBehavior_blockn, etc.). Se precisar inserir múltiplas tags ou blocos de código, crie 
um bloco de código individual para cada um que usar o Server Behavior Builder.

■ Para incluir parâmetros de tempo de execução em um bloco de código:
a. Coloque o ponto de inserção no bloco de código em que deseja inserir o parâmetro.
b. Clique em Insert Parameters (Inserir parâmetros) no botão Code Block.

A caixa de diálogo Insert Parameters in Code Block (Inserir parâmetros no bloco de 
código) é exibida.

c. Digite um valor para o parâmetro na caixa de texto Parameter Name (Nome do 
parâmetro).

d. Clique em OK.
O nome do parâmetro é inserido no bloco de código.

■ Repita as etapas de 6 a 8 para cada bloco de código novo que deseje criar.
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9. Digite um nome para os parâmetros no menu pop-up Parameter Name e clique em OK.

O parâmetro será inserido no bloco de código no local em que você colocou o ponto de 
inserção antes de definir o parâmetro.

10. Selecione uma opção no menu pop-up Insert Code (Inserir código) especificando a 
localização na qual incorporar os blocos de código.

Para obter mais informações, veja “Posicionar blocos de código” na página 878.
11. É possível especificar informações adicionais sobre o servidor que está sendo criado 

utilizando o painel de opções Advanced (Avançado). 

12. Clique no botão Advanced para exibir mais opções. 

13. Se for necessário criar mais blocos de código, repita as etapas de 7 a 13 se necessário.

14. Se o comportamento de servidor exigir o fornecimento de parâmetros, será preciso criar 
uma caixa de diálogo que aceite parâmetros de quem estiver aplicando o comportamento. 

Para criar uma caixa de diálogo que aceite parâmetros de entrada do usuário, veja “Criar 
uma caixa de diálogo para um comportamento de servidor personalizado” na página 880.

15. Após executar as etapas anteriores conforme solicitado pelo comportamento de servidor 
que está sendo criado, clique em OK.

Após a criação de um comportamento de servidor, ele será listado no painel Server 
Behaviors (Comportamentos de servidor). Verifique o comportamento de servidor e 
assegure-se de que ele funcione adequadamente. 

Tópicos relacionados
■ “Posicionar blocos de código” na página 878
■ “Repetir blocos de código” na página 868
■ “Instruções de codificação” na página 871
■ “Posicionar blocos de código” na página 878
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Usar parâmetros em comportamentos de 
servidor
É possível incluir parâmetros no código de um comportamento de servidor (consulte “Usar 
parâmetros em comportamentos de servidor” na página 866 para obter mais informações) e 
permitir que o designer da página forneça os valores de parâmetro necessários antes da 
inserção do código do comportamento de servidor na página. Para permitir que o designer da 
página forneça valores de parâmetros,insira marcadores de parâmetro no código, conforme 
mostrado:
@@parameterName@@

O exemplo de comportamento de servidor ASP a seguir contém o parâmetro formParam, que 
requer que a pessoa que esteja inserindo o comportamento forneça o nome de um objeto de 
formulário:
<% Session(“lang_pref”) = Request.Form(“formParam”); %>

Para criar um parâmetro que permita ao usuário fornecer o valor necessário:

1. Delimite a seqüência de caracteres formParam com marcadores de parâmetro:
<% Session(“lang_pref”) = Request.Form(“@@formParam@@”); %>

2. Crie uma caixa de diálogo que solicita ao designer o nome do objeto de formulário. 

Para obter mais informações, consulte “Criar uma caixa de diálogo para um 
comportamento de servidor personalizado” na página 880.

Posicionar blocos de código 
Ao criar blocos de código usando o Server Behavior Builder (Criador de comportamentos de 
servidor) (consulte “Usar o Server Behavior Builder (Criador de comportamentos de 
servidor)” para obter mais informações), especifique onde quer inseri-los no código HTML da 
página. Os menus pop-up Insert Code (Inserir código) e Relative Position (Posição relativa) 
permitem que você escolha onde inserir o bloco de código no documento e depois especifique 
um posição relativa a outra tag na página.

Para aprender mais sobre as opções de posicionamento do bloco de código e sobre como elas 
afetam o comportamento de seu servidor personalizado, consulte “Posicionar o bloco de 
código dentro de páginas da Web” na página 864.

Para posicionar um bloco de código (instruções gerais):

1. Usando o Server Behavior Builder, escreva um bloco de código de acordo com a seção “Usar 
o Server Behavior Builder (Criador de comportamentos de servidor)” na página 874.
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2. Na caixa de diálogo Server Behavior Builder, selecione a posição em que deseja inserir o 
bloco de código do menu pop-up Insert Code.

3. Na caixa de diálogo Server Behavior Builder, selecione uma posição relativa àquela que você 
selecionou no menu pop-up Insert Code.

4. Se tiver concluído a autoria do bloco de código, clique em OK.

O comportamento de servidor é listado no painel Server Behaviors (Comportamentos de 
servidor) (Window [Janela]> Server Behavior) e pode ser exibido clicando-se no botão de 
adição (+). 

5. Verifique o comportamento de servidor e assegure-se de que ele funcione adequadamente. 

Veja “Testar comportamentos de servidor” na página 872, para obter mais informações.

Para posicionar um bloco de código em relação a outra tag na página:

1. No menu pop-up Insert Code, escolha Relative To a Specific Tag (Relativo a uma 
determinada tag).

2. Na caixa de texto Tag, digite a tag ou selecione uma no menu pop-up.

Se uma tag for inserida, não inclua os sinais de maior e menor (< >).
3. Especifique um local em relação à tag, selecionando uma opção no menu pop-up Relative 

Position (Posição relativa).

O bloco de código pode ser inserido imediatamente antes ou imediatamente após as tags 
de abertura ou fechamento. Também é possível substituir a tag pelo código, inserir o 
código como valor de um atributo da tag (será exibida uma caixa que permite selecionar o 
atributo) ou inserir o código na tag de abertura.

Para posicionar um bloco de código em relação a uma tag selecionada pelo 
designer da página:

1. No menu pop-up Insert Code, escolha Relative To the Selection (Relativo à seleção).

2. Especifique um local relativo à seleção, selecionando uma opção no menu pop-up Relative 
Position (Posição relativa).

O bloco de código pode ser inserido imediatamente antes ou depois da seleção. Também é 
possível substitur a seleção pelo seu bloco de código, ou é possível anexar o bloco de 
código ao redor da seleção. 
Para anexar o bloco de código ao redor de uma seleção, esta deve consistir de tags de 
abertura e de fechamento sem conteúdo, conforme mostrado a seguir.
<CFIF Day=”Monday”></CFIF>
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A parte da tag de abertura do bloco de código será inserida antes da tag de abertura da 
seleção, e a parte da tag de fechamento do bloco de código será inserida após a tag de 
fechamento da seleção.

Tópicos relacionados
■ “Sobre os comportamentos de servidor” na página 861
■ “Posicionar o bloco de código dentro de páginas da Web” na página 864
■ “Usar o Server Behavior Builder (Criador de comportamentos de servidor)” na página 874

Criar uma caixa de diálogo para um 
comportamento de servidor 
personalizado 
Os comportamentos de servidor muitas vezes requerem que o designer da página forneça um 
valor de parâmetro. Esse valor deve ser inserido antes que o código do comportamento de 
servidor seja inserido na página. Para isso, é possível criar uma caixa de diálogo que solicita um 
valor de parâmetro a quem estiver implementando o comportamento de servidor.

Crie a caixa de diálogo definindo os parâmetros fornecidos pelo designer no código. Após 
definir todos os parâmetros, será possível gerar uma caixa de diálogo para o comportamento 
de servidor.

Para criar um parâmetro no código do comportamento de servidor:

■ Digite um marcador de parâmetro em uma posição no código na qual o valor do 
parâmetro fornecido deverá ser inserido. A sintaxe do parâmetro é a seguinte:
@@parameterName@@

Por exemplo, se o comportamento de servidor contiver o seguinte bloco de código:
<% Session(“lang_pref”) = Request.Form(“Form_Object_Name”); %>

Para permitir que o designer da página forneça o valor de Form_Object_Name, delimite a 
seqüência de caracteres com marcadores de parâmetro (@@):
<% Session(“lang_pref”) = Request.Form(“@@Form_Object_Name@@”); %>

N
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Um parâmetro será inserido no bloco de código sem a sua interferência, se for 
especificado que o código deve ser incluído relativo a uma tag específica, escolhida pelo 
designer da página, ou seja, selecionando Relative to a Specific Tag (Relativo a uma 
determinada tag) no menu pop-up Insert Code (Inserir código). O parâmetro adiciona 
um menu de tags à caixa de diálogo do comportamento para permitir ao designer da 
página selecionar uma tag. 
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É possível também realçar a seqüência de caracteres e, em seguida, clicar no botão Insert 
Parameter in Code Block (Inserir parâmetro em bloco de código. Digite um nome de 
parâmetro e clique em OK. O Dreamweaver substitui cada instância da seqüência de 
caracteres realçada pelo nome do parâmetro especificado, delimitado com marcadores de 
parâmetro.

O Dreamweaver usa as seqüências de caracteres delimitadas com marcadores de parâmetro 
para identificar os controles da caixa de diálogo gerados por ele (veja o procedimento a seguir). 
No exemplo anterior, o Dreamweaver cria uma caixa de diálogo com o seguinte identificador:

Para criar uma caixa de diálogo para um comportamento de servidor:

1. No Server Behavior Builder (Criador de comportamentos de servidor), clique em Next 
(Avançar).

Será exibida a caixa de diálogo que lista todos os parâmetros fornecidos pelo 
designer definidos no código. 

N
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Os nomes de parâmetros no código do comportamento de servidor não podem ter 
espaços. Portanto, os identificadores da caixa de diálogo não podem ter espaços. Para 
incluir espaços no identificador, é possível editar o arquivo HTML gerado.
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2. (Opcional) A ordem de exibição dos controles na caixa de diálogo também pode ser alterada 
selecionando-se um parâmetro e clicando-se nas setas para cima e para baixo.

3. (Opcional) Outra alternativa é alterar o controle do parâmetro, selecionando o parâmetro 
e escolhendo outro controle na coluna Display As (Exibir como). 

4. Clique em OK.

O Dreamweaver gera uma caixa de diálogo com um controle identificado para cada 
parâmetro fornecido pelo designer que você tenha definido anteriormente.

Para exibir a caixa de diálogo:

■ Clique no botão de adição (+), no painel Server Behaviors (Comportamentos de servidor) 
(Window [Janela]> Server Behaviors), e selecione o seu comportamento de servidor no 
menu pop-up. 

Para editar a caixa de diálogo de um comportamento de servidor criado:

1. No painel Server Behaviors, aberto a partir da seleção de Window > Server Behaviors, 
clique no botão de adição (+) e selecione Edit Server Behaviors (Editar comportamentos de 
servidor) no menu pop-up.

2. Selecione o comportamento de servidor na lista e clique em Open (Abrir).

O Server Behavior Builder será exibido com o comportamento de servidor.
3. Clique em Next (Avançar).

A caixa de diálogo que lista todos os parâmetros fornecidos pelo designer definidos no 
código é exibida.

4. (Opcional) A ordem de exibição dos controles na caixa de diálogo também pode ser alterada 
selecionando-se um parâmetro e clicando-se nas setas para cima e para baixo.

5. (Opcional) Outra alternativa é alterar o controle do parâmetro, selecionando o parâmetro 
e escolhendo outro controle na coluna Display As (Exibir como). 

6. Clique em OK.
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Editar e modificar comportamentos de 
servidor
É possível editar qualquer comportamento de servidor criado com o Server Behavior Builder 
(Criador de comportamentos de servidor), incluindo comportamentos de servidor obtidos no 
site Macromedia Exchange na Web ou por meio de outros fornecedores.

Se um comportamento de servidor for aplicado a uma página e, em seguida, editado no 
Dreamweaver, as instâncias do comportamento anterior não serão mais exibidas no painel 
Server Behaviors (Comportamentos de servidor). Esse painel procurará na página o código 
correspondente ao código dos comportamentos de servidor conhecidos. Se o código de um 
comportamento de servidor que o painel conheça for alterado, o painel não reconhecerá mais 
as versões anteriores do comportamento nessa página. 

Caso você deseje que as versões antiga e nova do comportamento apareçam 
no painel:

■ Clique no botão de adição (+) no painel Server Behaviors (Window [Janela] > Server 
Behaviors), selecione New Server Behavior (Novo comportamento de servidor) e crie uma 
cópia do comportamento de servidor antigo.

Para editar o código de um comportamento de servidor criado com o Server 
Behavior Builder (Criador de comportamentos de servidor):

1. No painel Server Behaviors, aberto a partir da seleção de Window > Server Behaviors, 
clique no botão de adição (+) e selecione Edit Server Behaviors (Editar comportamentos de 
servidor) no menu pop-up.

A caixa de diálogo Edit Server Behaviors é exibida com todos os comportamentos para a 
tecnologia de servidor atual.
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2. Selecione o comportamento de servidor e clique em Edit (Editar).

A caixa de diálogo Server Behavior Builder é exibida. 

3. Selecione o bloco de código apropriado e modifique o código a ser inserido nas páginas.

4. (Opcional) Altere ou adicione marcadores de parâmetros ao código, se desejado.

Para obter instruções, consulte “Criar uma caixa de diálogo para um comportamento de 
servidor personalizado” na página 880.

5. (Opcional) Altere o local de inserção do bloco de código no código-fonte HTML da 
página, escolhendo outra opção no menu pop-up Insert Code. 

Para obter instruções, consulte “Posicionar blocos de código” na página 878.
6. Se o código modificado não contiver nenhum parâmetro fornecido pelo designer, clique 

em OK.

O Dreamweaver recupera o comportamento de servidor sem uma caixa de diálogo. O 
novo comportamento de servidor será exibido no menu pop-up de adição (+) do painel 
Server Behaviors.

7. Se o código modificado contiver parâmetros fornecidos pelo designer, clique em Next.

O Dreamweaver perguntará se você deseja criar uma nova caixa de diálogo para substituir 
a anterior. Faça as alterações e clique em OK.

O Dreamweaver salva todas as alterações no arquivo EDML do comportamento de servidor. 
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CAPÍTULO 39

Criar formulários
É possível utilizar o Macromedia Dreamweaver 8 para criar formulários com campos de texto, 
campos de senha, botões de opção, caixas de seleção, menus pop-up, botões clicáveis e outros 
objetos de formulário. O Dreamweaver também pode escrever o código que valida as 
informações que o visitante fornece. Por exemplo, é possível verificar se um endereço de 
correio eletrônico (e-mail) contém o símbolo "@" ou se um campo de texto obrigatório foi 
preenchido.

Este capítulo contém as seguintes seções:
Sobre os formulários . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .886

Criar formulários HTML  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 890

Inserir objetos de formulário HTML . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .892

Inserir objetos de formulário HTML dinâmicos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .898

Validar dados de formulário HTML  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 902

Anexar comportamentos JavaScript a objetos de formulário HTML . . . . . . . . . . 903

Anexar scripts personalizados a botões de formulário HTML . . . . . . . . . . . . . . . . 903

Criar formulários HTML acessíveis  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 904

Tópicos relacionados
■ “Criar formulários no ColdFusion MX 7” na página 915 
■ “Criar formulários ASP.NET” na página 987 
885



         
Sobre os formulários
Os formulários permitem obter informações dos visitantes do seu site da Web. Os visitantes 
digitam informações usando objetos de formulário, como campos de texto, caixas de lista, 
caixas de seleção e botões de opção, e, em seguida, clicam em um botão para enviar as 
informações.

A função dos formulários no cliente
Os formulários oferecem suporte no lado do cliente no relacionamento cliente-servidor. 
Quando um visitante insere informações em um formulário exibido em um navegador da 
Web (o cliente) e clica no botão de envio, os dados são enviados para o servidor, onde um 
script ou aplicativo do servidor processa essas informações. Tecnologias comuns de servidor 
usadas para processar dados de formulários incluem o Macromedia ColdFusion, o Microsoft 
Active Server Pages (ASP) e o PHP. O servidor responderá enviando as informações solicitadas 
de volta para o usuário (ou cliente), ou realizando alguma ação com base no conteúdo do 
formulário.

N
O

T
A

Também é possível enviar dados de formulário diretamente para um destinatário de 
correio eletrônico.

O visitante preenche o 
formulário e o envia a um 
servidor Web para 
processamento

O script CF 
processa o 
formulário

Um novo documento HTML é 
criado e enviado ao visitante

<HTML>

 

</HTML>

1

2

3
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Objetos de formulário
No Dreamweaver, os tipos de entrada em formulários são denominados objetos de formulário. 
Os objetos de formulário são mecanismos que permitem aos usuários inserir dados. É possível 
adicionar os seguintes objetos de formulário em um formulário: 

Campos de texto: aceitam qualquer tipo de entrada de texto alfanumérico. O texto pode ser 
exibido como uma linha única, várias linhas e como um campo de senha, no qual o 
texto digitado é substituído por asteriscos ou marcadores para ocultar o texto de espectadores.

Campos ocultos: armazenam as informações digitadas pelo usuário (como nome, endereço 
de correio eletrônico ou preferência de exibição) e, em seguida, utilizam tais informações 
quando o usuário visitar o site novamente. 

Botões: executam ações quando clicados. Normalmente, as ações incluem o envio e a 
redefinição de um formulário. É possível adicionar um nome ou identificador personalizado a 
um botão, ou utilizar um dos identificadores predefinidos: “Submit” (Enviar) ou “Reset” 
(Redefinir).

N
O

T
A

As senhas e outras informações enviadas a um servidor através de um campo de senha 
não são criptografadas. Os dados transferidos podem ser interceptados e lidos como 
texto alfanumérico. Por isso, é necessário criptografar sempre os dados que você deseja 
proteger.
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Caixas de seleção: permitem a obtenção de várias respostas em um único grupo de opções. 
O usuário pode escolher quantas opções forem necessárias. O exemplo abaixo mostra esse 
recurso por meio da seleção de três itens nas caixas de seleção: Surfing (Surfe), Mountain 
Biking e Rafting (Canoagem).

Botões de opção: representam opções exclusivas. A seleção de um dos botões do grupo 
cancela a seleção de todos os outros (um grupo consiste em dois ou mais botões com o mesmo 
nome). No exemplo abaixo, Rafting é a opção escolhida. Se o usuário clicar em Surfing, o botão 
Rafting será automaticamente desativado.

Menus de lista exibem valores de opção em uma lista de rolagem que permite aos usuários 
selecionar várias opções. A opção Menu exibe os valores de opção em um menu que permite 
aos usuários selecionar apenas um item.

Menus de salto: são listas navegáveis ou menus pop-up que permitem inserir um menu no 
qual cada opção está vinculada a um documento ou arquivo.

N
O

T
A

Um menu pop-up em um formulário HTML não é o mesmo que um menu pop-up 
gráfico. Para obter mais informações sobre a criação, edição e exibição de um menu 
pop-up gráfico, consulte “Show Pop-Up Menu (Mostrar o menu pop-up)” na 
página 572.
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Campos de arquivo: permitem que o usuário procure arquivos no computador e efetue o 
upload dos arquivos como dados do formulário. 

Campos de imagem: permitem inserir uma imagem em um formulário. Os campos de 
imagem podem ser utilizados para criar botões com aparência gráfica, como os botões Submit 
(Enviar) e Reset (Redefinir).

Tópicos relacionados
■ “Criar formulários HTML” na página 890
■ “Inserir objetos de formulário HTML” na página 892

Objetos de formulário dinâmicos
Um objeto de formulário dinâmico é um objeto cujo estado inicial é determinado pelo 
servidor quando a página é solicitada, e não pelo designer no momento da criação do 
formulário. Por exemplo, quando um usuário solicita uma página PHP que possui um 
formulário com um menu, um script PHP na página pode preencher automaticamente esse 
menu com valores armazenados em um banco de dados. O servidor envia, em seguida, a 
página preenchida para o navegador do usuário.

A ação de tornar dinâmicos os objetos de formulário pode simplificar a manutenção do site. 
Por exemplo, muitos sites usam menus para apresentar aos usuários um conjunto de opções. 
Se o menu for dinâmico, é possível adicionar, remover ou alterar itens de menu em um único 
local (a tabela do banco de dados na qual os itens estão armazenados) para atualizar todas as 
instâncias do mesmo menu no site.

Um menu não é o único tipo de objeto de formulário dinâmico. Também é possível criar e 
utilizar botões de opção, caixas de seleção, campos de texto e campos de imagem dinâmicos. 

Tópicos relacionados
■ “Inserir objetos de formulário HTML” na página 892
■ “Inserir objetos de formulário HTML dinâmicos” na página 898
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Criar formulários HTML
Esta seção descreve como criar formulários HTML no Dreamweaver.

Também é possível usar o Dreamweaver para criar formulários ASP.NET da Web. Para obter 
mais informações, consulte “Criar formulários ASP.NET” na página 987.

Para criar um formulário HTML:

1. Abra uma página e posicione o ponto de inserção no local onde você deseja que o 
formulário seja exibido.

2. Selecione Insert (Inserir) > Form (Formulário) ou selecione a categoria Forms 
(Formulários) na barra Insert e clique no ícone Form.

O Dreamweaver insere um formulário vazio. Com a página na visualização do projeto, os 
formulários são indicados por um contorno pontilhado em vermelho. Se esse contorno 
não estiver visível, verifique se a opção View (Exibir) > Visual Aids (Auxílios visuais) > 
Invisible Elements (Elementos invisíveis) está selecionada.

3. Especifique a página ou script que irá processar os dados do formulário.

Na janela do documento, clique no contorno do formulário para selecionar o formulário. 
No Property inspector (Inspetor de propriedades), aberto a partir da seleção de Window 
(Janela) > Properties (Propriedades), digite o caminho na caixa de texto Action (Ação) do 
inspetor, ou clique no ícone de pasta para navegar para a página ou script apropriado.
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4. Especifique o método que será utilizado para transmitir os dados do formulário para o 
servidor.

No Property inspector, selecione uma das opções a seguir no menu pop-up Method 
(Método):
Default: utiliza a configuração padrão do navegador para enviar os dados do formulário 
para o servidor. Normalmente, o padrão é o método GET.
GET: anexa o valor à URL que solicita a página.
POST: incorpora os dados do formulário na solicitação HTTP.
Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.

5. Insira objetos de formulário.

Posicione o ponto de inserção no local onde deseja que o objeto seja exibido no formulário 
e, em seguida, selecione o objeto no menu Insert > Form ou na categoria Forms da barra 
Insert.
Para obter mais informações, consulte “Inserir objetos de formulário HTML” na 
página 892 ou “Inserir objetos de formulário HTML dinâmicos” na página 898.
Se desejar, defina as propriedades do objeto de formulário após inseri-lo na página. Para 
obter mais informações, selecione o objeto de formulário e clique no ícone Help do 
Property inspector.

6. Ajuste o layout do formulário conforme desejado.

É possível utilizar quebras de linha, quebras de parágrafo, texto pré-formatado ou tabelas 
para formatar os formulários. Um formulário não pode ser inserido em outro formulário 
(ou seja, as tags não podem ser sobrepostas), embora seja possível incluir mais de um 
formulário em uma página.
Quando estiver criando um formulário, lembre-se de identificar os campos com texto 
descritivo para permitir que o usuário identifique o título da pergunta, por exemplo: 
"Digite o seu nome", para solicitar o nome do usuário.
Utilize as tabelas para fornecer uma estrutura para os objetos de formulário e os 
identificadores dos campos. Ao utilizar as tabelas em formulários, verifique se todas as tags 
table estão delimitadas por tags form.
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Tópicos relacionados
■ “Validar dados de formulário HTML” na página 902
■ “Anexar comportamentos JavaScript a objetos de formulário HTML” na página 903
■ “Anexar scripts personalizados a botões de formulário HTML” na página 903
■ “Criar formulários HTML acessíveis” na página 904

Inserir objetos de formulário HTML
É possível utilizar o Dreamweaver para inserir rapidamente objetos de formulário HTML nos 
formulários.

Se você estiver trabalhando em um aplicativo ASP.NET para a Web, poderá usar o 
Dreamweaver para inserir rapidamente controles de formulário ASP.NET. Para obter mais 
informações, consulte “Adicionar controles de formulário ASP.NET a uma página” na 
página 987.

É possível criar um formulário HTML em branco, em Insert (Inserir) > Form (Formulário) > 
Form, antes de inserir objetos de formulário nele. Para obter mais informações, consulte 
“Criar formulários HTML” na página 890. Se você não criar um formulário em branco e 
tentar inserir um objeto de formulário, o Dreamweaver perguntará se deseja criar um 
formulário.

Inserir campos de texto HTML
É possível criar um campo de texto que consiste em uma ou em várias linhas. Também é 
possível criar um campo de texto de senha que oculte o texto digitado pelo usuário. 

Para inserir um campo de texto: 

1. Posicione o ponto de inserção dentro do contorno do formulário:

2. Selecione Insert (Inserir) > Form (Formulário) > Text Field (Campo de texto).

Um campo de texto é exibido no documento.
3. No Property inspector (Inspetor de propriedades), defina as propriedades do campo de 

texto conforme desejado.

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.
4. Para identificar o campo de texto na página, clique junto do campo de texto e digite o 

identificador.
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Tópicos relacionados
■ “Validar dados de formulário HTML” na página 902
■ “Exibir conteúdo dinâmico em campos de texto HTML” na página 900
■ “Objetos de formulário” na página 887

Inserir caixas de seleção HTML
Use caixas de seleção HTML quando quiser permitir que os usuários selecionem mais de uma 
opção em um conjunto de opções. 

Para inserir uma caixa de seleção:

1. Posicione o ponto de inserção dentro do contorno do formulário:

2. Selecione Insert (Inserir) > Form (Formulário) > Check Box (Caixa de seleção). 

Uma caixa de seleção é exibida no documento.
3. No Property inspector (Inspetor de propriedades), defina as propriedades da caixa de 

seleção conforme desejado.

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.
4. Para identificar a caixa de seleção, clique junto da caixa na página e digite o texto do 

identificador.

Tópicos relacionados
■ “Pré-selecionar dinamicamente caixas de seleção HTML” na página 900

Inserir botões de opção HTML
Use botões de opção HTML quando quiser que os usuários selecionem apenas uma opção em 
um conjunto de opções. Normalmente, os botões de opção são utilizados em grupos. Todos os 
botões de opção de um grupo devem ter o mesmo nome.

N
O

T
A

Use botões de opção quando quiser que os usuários selecionem somente uma única 
opção em um conjunto de opções. Para obter mais informações, consulte “Inserir 
botões de opção HTML” na página 893.

N
O

T
A

Use caixas de seleção quando quiser permitir aos usuários selecionar mais de uma 
opção. Para obter mais informações, consulte “Inserir caixas de seleção HTML” na 
página 893.
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Para inserir um grupo de botões de opção:

1. Posicione o ponto de inserção dentro do contorno do formulário:

2. Selecione Insert (Inserir) > Form (Formulário) > Radio Group (Grupo de botões de opção).

A caixa de diálogo Radio Group é exibida.
3. Preencha a caixa de diálogo Radio Group e clique em OK.

Para obter instruções sobre como preencher a caixa de diálogo Radio Group, clique no 
botão Help (Ajuda) dessa caixa de diálogo.

O Dreamweaver insere o grupo de botões de opção no formulário HTML. Se você ainda não 
tiver inserido um formulário na página, o Dreamweaver irá adicioná-lo. Se desejar, é possível 
alterar o layout do grupo. Os botões de opção também podem ser editados usando o Property 
inspector (Inspetor de propriedades) ou diretamente na visualização do código.

Para inserir um botão de opção de cada vez:

1. Posicione o ponto de inserção dentro do contorno do formulário:

2. Insira um botão de opção selecionando Insert > Form > Radio Button (Botão de opção).

Um botão de opção é exibido no documento.
3. No Property inspector, defina as propriedades para o botão de opção, conforme desejado.

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.
4. Para identificar o botão de opção, clique junto do botão na página e digite o texto do 

identificador.

Tópicos relacionados
■ “Pré-selecionar dinamicamente botões de opção HTML” na página 901

Inserir menus de formulário HTML
Um menu de formulário HTML permite que o visitante selecione um ou mais itens em uma 
lista. Os menus são úteis quando há espaço limitado, mas é necessário exibir vários itens. Eles 
também são úteis quando você quer controlar os valores retornados para o servidor. Ao 
contrário dos campos de texto, onde os usuários podem digitar qualquer coisa que queiram, 
inclusive dados inválidos, você define os valores exatos retornados por um menu.

É possível inserir dois tipos de menu em um formulário: um menu que é aberto quando o 
usuário clica nele ou um menu que exibe uma lista rolável de itens que podem ser 
selecionados. Esse último tipo é chamado menu de lista.
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Para inserir um menu:

1. Posicione o ponto de inserção dentro do contorno do formulário:

2. Selecione Insert (Inserir) > Form (Formulário) > List/Menu (Lista/menu).

Um menu é exibido no documento.
3. No Property inspector (Inspetor de propriedades), defina as propriedades do menu, 

conforme desejado.

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.

Tópicos relacionados
■ “Criar um menu de formulário HTML dinâmico” na página 898
■ “Tornar dinâmicos menus de formulário HTML existentes” na página 899

Inserir botões padrão
Os botões controlam as operações relacionadas aos formulários. Use um botão para enviar ao 
servidor dados do formulário ou para redefinir o formulário. Normalmente, os botões de 
formulário são identificados como Submit (Enviar), Reset (Redefinir) ou Send (Enviar). É 
possível atribuir outras tarefas de processamento definidas em um script. Por exemplo, o botão 
pode calcular o custo total dos itens selecionados com base em valores atribuídos.

Para criar um botão:

1. Posicione o ponto de inserção dentro do contorno do formulário:

2. Selecione Insert (Inserir) > Form (Formulário) > Button (Botão).

Um botão é exibido no formulário.
3. No Property inspector (Inspetor de propriedades), defina as propriedades do botão, 

conforme desejado.

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.

Inserir botões de imagem
É possível usar imagens para representar ícones de botões. A utilização de uma imagem para 
efetuar tarefas diferentes do envio de dados requer a anexação de um comportamento ao 
objeto de formulário. 
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Para criar um botão de imagem:

1. No documento, posicione o ponto de inserção dentro do contorno do formulário:

2. Selecione Insert (Inserir) > Form (Formulário) > Image Field (Campo de imagem).

A caixa de diálogo Image Source (Origem da imagem) é exibida.
3. Selecione a imagem para o botão na caixa de diálogo Image Source e clique em OK.

Um campo de imagem é exibido no formulário.
4. No Property inspector (Inspetor de propriedades), defina as propriedades do campo de 

imagem conforme desejado.

Para criar um botão de envio, digite Submit (Enviar) na caixa de texto Image Field no 
Property inspector.
Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.

5. Para anexar um comportamento JavaScript ao botão, selecione a imagem e escolha o 
comportamento no painel Behaviors (Comportamentos), aberto a partir da seleção de 
Window (Janela) > Behaviors. 

Para obter mais informações, consulte “Anexar comportamentos JavaScript a objetos de 
formulário HTML” na página 903 e “Anexar scripts personalizados a botões de formulário 
HTML” na página 903.

Tópicos relacionados
■ “Inserir botões padrão” na página 895

Inserir campos ocultos
É possível utilizar campos ocultos para armazenar e enviar informações não digitadas pelo 
usuário. As informações são mantidas ocultas do usuário.

Para criar um campo oculto:

1. Na visualização do projeto, posicione o ponto de inserção no interior do contorno do 
formulário.

2. Selecione Insert (Inserir) > Form (Formulário) > Hidden Field (Campo oculto).

Aparecerá um marcador no documento. Se o marcador não estiver visível, selecione View 
(Exibir) > Visual Aids (Auxílios visuais) > Invisible Elements (Elementos invisíveis) para 
ver o marcador.

3. Na caixa de texto HiddenField, no Property inspector (Inspetor de propriedades), digite 
um nome exclusivo para o campo.

4. Na caixa de texto Value (Valor), digite o valor que deseja atribuir ao campo.
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Inserir campos para upload de arquivos
É possível criar um campo para upload de arquivos que permite ao usuário selecionar um 
arquivo em seu computador (como, por exemplo, um documento gerado por um processador 
de texto ou arquivo de imagem gráfica) e efetuar o upload do arquivo para o servidor. Um 
campo de arquivo se parece com outros campos de texto, exceto pela presença de um botão 
Browse (Procurar). O usuário pode digitar manualmente o caminho do arquivo do qual ele 
deseja efetuar o upload ou utilizar o botão Browse para localizar e selecionar o arquivo.

Para poder utilizar campos de upload de arquivos, é necessário um script no lado servidor ou 
uma página capaz de tratar envios de arquivos de envio de arquivos. Consulte a documentação 
da tecnologia do servidor utilizada para processar os dados do formulário. Por exemplo, se 
você usa PHP, consulte “Handling files uploads” no manual da PHP, em http://us2.php.net/
manual/en/features.file-upload.php.

Os campos de arquivo requerem o método POST para transmitir os arquivos do navegador 
para o servidor. O arquivo é enviado para o endereço especificado na caixa de texto Action 
(Ação) do formulário.

Para criar um campo de arquivo em um formulário: 

1. Insira um formulário na página, a partir da seleção de Insert (Inserir) > Form (Formulário).

2. Selecione o formulário para exibir o Property inspector (Inspetor de propriedades) 
correspondente.

3. Defina o método do formulário como POST.

4. No menu pop-up Enctype (Tipo de codif.), selecione multipart/form-data.

5. Na caixa de texto Action (Ação), especifique a página ou script no lado servidor que está 
apto a lidar com o arquivo carregado.

6. Posicione o ponto de inserção dentro do contorno do formulário e selecione Insert 
(Inserir)> Form (Formulário)> File Field (Campo de arquivo).

O campo de arquivos é inserido no formulário.
7. No Property inspector (Inspetor de propriedades), defina as propriedades para o campo de 

arquivo, conforme desejado.

Para obter mais informações, clique no botão Help (Ajuda) do Property inspector.

N
O

T
A

Antes de utilizar o campo de arquivos, confirme com o administrador do servidor se é 
permitido o upload anônimo de arquivos.
Inserir objetos de formulário HTML 897

http://us2.php.net/manual/en/features.file-upload.php
http://us2.php.net/manual/en/features.file-upload.php


         
Inserir objetos de formulário HTML 
dinâmicos
É possível inserir objetos de formulário HTML cujo estado inicial é determinado pelo 
servidor quando a página é solicitada, e não pelo designer durante a criação do formulário. 

Tópicos relacionados
■ “Objetos de formulário dinâmicos” na página 889
■ “Criar formulários ASP.NET” na página 987
■ “Criar formulários no ColdFusion MX 7” na página 915

Criar um menu de formulário HTML dinâmico
É possível preencher dinamicamente um menu de lista ou de formulário HTML com entradas 
de um banco de dados.

Para a maioria das páginas, você pode usar um objeto de menu HTML. Para páginas 
ASP.NET, você deve usar um controle de formulário DropDownList (Lista suspensa) ou 
ListBox (Caixa de lista). Para obter mais informações, consulte “Criar formulários ASP.NET” 
na página 987.

Antes de começar, é necessário inserir um formulário HTML em uma página ColdFusion, 
PHP, ASP ou JSP e definir um recordset ou outra fonte de conteúdo dinâmico para o menu. 
Para obter mais informações, consulte “Definir um recordset” na página 765.

Para inserir um menu de formulário HTML dinâmico:

1. Clique no interior do formulário HTML na página.

2. Selecione Insert (Inserir) > Form (Formulário) > List/Menu (Lista/menu).

O Dreamweaver insere um objeto de formulário List/Menu na página.
3. Selecione o objeto de formulário List/Menu.

O Property inspector (Inspetor de propriedades) exibe as propriedades de List/Menu.
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4. No Property inspector, clique no botão Dynamic (Dinâmico) para exibir a caixa de diálogo 
Dynamic List/Menu (Lista/menu dinâmico). 

5. Preencha a caixa de diálogo e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Tornar dinâmicos menus de formulário HTML 
existentes
É possível tornar dinâmico um menu de lista ou de formulário HTML existente. 

Esta seção apresenta os objetos de formulário HTML. Para objetos de menu ASP.NET, como 
DropDownList (Lista suspensa) ou ListBox (Caixa de lista), consulte “Tornar dinâmico um 
menu ASP.NET existente” na página 989.

Antes de começar, é necessário criar o formulário em uma página ColdFusion, PHP, ASP ou 
JSP e definir um recordset ou outra fonte de conteúdo dinâmico para o menu. Para obter mais 
informações, consulte “Definir um recordset” na página 765.

Para tornar dinâmico um menu de formulário HTML existente: 

1. Na visualização do projeto, selecione o objeto de formulário List/Menu (Lista/menu) para 
torná-lo dinâmico.

2. No Property inspector (Inspetor de propriedades), clique no botão Dynamic (Dinâmico).

Será exibida a caixa de diálogo Dynamic List/Menu (Lista/menu dinâmico). 
3. Preencha a caixa de diálogo e clique em OK.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
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Tópicos relacionados
■ “Criar um menu de formulário HTML dinâmico” na página 898

Exibir conteúdo dinâmico em campos de texto HTML
É possível exibir conteúdo dinâmico em campos de texto HTML.

Para páginas ASP.NET, é necessário usar o controle ASP.NET TextBox (Caixa de texto). Para 
obter mais informações, consulte “Exibir conteúdo dinâmico em um controle ASP.NET 
TextBox (Caixa de texto)” na página 990.

Antes de começar, é necessário criar o formulário em uma página ColdFusion, PHP, ASP ou 
JSP e definir um recordset ou outra fonte de conteúdo dinâmico para o campo de texto. Para 
obter mais informações, consulte “Definir um recordset” na página 765.

Para tornar dinâmicos os campos de texto HTML:

1. Selecione o campo de texto no formulário HTML na página.

2. No Property inspector (Inspetor de propriedades), clique no ícone em forma de raio ao lado 
da caixa de texto Init Val (Valor inicial).

Será exibida a caixa de diálogo Dynamic Data (Dados dinâmicos).
3. Selecione a coluna do recordset que fornecerá um valor para o campo de texto. Em seguida, 

clique em OK.

O campo de texto exibirá o conteúdo dinâmico quando o formulário for visualizado em um 
navegador.

Pré-selecionar dinamicamente caixas de seleção 
HTML
É possível permitir que o servidor decida se deve selecionar uma caixa de seleção quando o 
formulário for exibido em um navegador. 

Para páginas ASP.NET, é necessário usar o controle ASP.NET CheckBox (Caixa de seleção). 
Para obter mais informações, consulte “Pré-selecionar dinamicamente controles ASP.NET 
CheckBox (Caixa de seleção)” na página 990.

Antes de começar, é necessário criar o formulário em uma página ColdFusion, PHP, ASP ou 
JSP e definir um recordset ou outra fonte de conteúdo dinâmico para as caixas de seleção. Para 
obter mais informações, consulte “Definir um recordset” na página 765. O ideal é que a fonte 
de conteúdo possua dados booleanos, como Yes/No (Sim/Não) ou true/false (verdadeiro/
falso).
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Para pré-selecionar dinamicamente uma caixa de seleção HTML: 

1. Selecione, na sua página, o objeto de formulário de caixa de seleção.

2. No Property inspector (Inspetor de propriedades), clique no botão Dynamic (Dinâmico).

Será exibida a caixa de diálogo Dynamic CheckBox (Caixa de seleção dinâmica). 

3. Preencha a caixa de diálogo e clique em OK.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.

A caixa de seleção será exibida selecionada ou não (dependendo dos dados), quando o 
formulário for visualizado em um navegador.

Pré-selecionar dinamicamente botões de opção 
HTML
É possível permitir que o servidor decida se deve selecionar um botão de opção HTML 
quando o formulário for exibido em um navegador. 

Se você quiser pré-selecionar dinamicamente objetos de botão de opção ASP.NET, como os 
controles RadioButton (Botão de opção) ou RadioButtonList (Lista de botões de opção), 
consulte “Pré-selecionar dinamicamente um item em um controle ASP.NET RadioButtonList 
(Lista de botão de opção)” na página 991.

Antes de começar, você deve criar o formulário em uma página ColdFusion, PHP, ASP ou JSP 
e inserir pelo menos um grupo de botões de opção HTML (consulte “Inserir botões de opção 
HTML” na página 893). Também é necessário definir um recordset ou outra fonte de 
conteúdo dinâmico para os botões de opção. Para obter mais informações, consulte “Definir 
um recordset” na página 765. O ideal é que a fonte de conteúdo possua dados booleanos, 
como Yes/No (Sim/Não) ou true/false (verdadeiro/falso).

Para pré-selecionar dinamicamente um botão de opção HTML: 

1. Na visualização do projeto, selecione um botão de opção no grupo.

2. No Property inspector (Inspetor de propriedades), clique no botão Dynamic (Dinâmico).

A caixa de diálogo Dynamic Radio Group (Grupo de botões de opção dinâmicos) é 
exibida.
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3. Preencha a caixa de diálogo e clique em OK.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.

Validar dados de formulário HTML
O Dreamweaver pode adicionar um código JavaScript que verifica o conteúdo de campos de 
texto especificados para garantir que o usuário inseriu o tipo de dados correto. 

Esta seção destina-se aos formulários HTML. Você também pode criar formulários 
ColdFusion no Dreamweaver que validam o conteúdo dos campos especificados. Para obter 
mais informações, consulte “Validar dados de formulário ColdFusion” na página 927. Para 
formulários ASP.NET, você pode inserir controles de validação ASP.NET na visualização do 
código. Para obter mais informações, consulte a documentação do ASP.NET.

Para validar os dados de um formulário HTML:

1. Crie um formulário HTML que contenha pelo menos um campo de texto e um botão 
Submit (Enviar).

Verifique se cada campo de texto que você deseja validar possui um nome exclusivo.
2. Selecione o botão Submit.

3. No painel Behaviors (Comportamentos), aberto a partir da seleção de Window (Janela) > 
Behaviors, clique no botão de adição (+) e selecione o comportamento Validate Form 
(Validar formulário) na lista.

Será exibida a caixa de diálogo Validate Form.

N
O

T
A

O comportamento Validate Form estará disponível somente se um campo de texto 
tiver sido inserido no documento.
902 Capítulo 39:  Criar formulários



         
4. Defina as regras de validação para cada campo de texto e clique em OK.

Por exemplo, você poderia especificar que um campo de texto para a idade de uma pessoa 
aceita somente números. Para obter mais informações, consulte “Validate Form (Validar o 
formulário)” na página 578.

Tópicos relacionados
■ Capítulo 18, “Utilizar comportamentos JavaScript”, na página 541
■ “Validar dados de formulário ColdFusion” na página 927

Anexar comportamentos JavaScript a 
objetos de formulário HTML
É possível anexar comportamentos JavaScript armazenados no Dreamweaver a objetos de 
formulário HTML, como, por exemplo, botões.

Para anexar um comportamento JavaScript a um objeto de formulário HTML:

1. Selecione o objeto de formulário HTML.

2. No painel Behaviors (Comportamentos), aberto a partir da seleção de Window (Janela) > 
Behaviors, clique no botão de adição (+) e selecione um comportamento na lista.

Para obter mais informações, consulte Capítulo 18, “Utilizar comportamentos 
JavaScript”, na página 541.

Anexar scripts personalizados a botões 
de formulário HTML
Alguns formulários utilizam JavaScript ou VBScript para processar os formulários ou alguma 
outra ação no cliente (o que evita a necessidade de enviar os dados do formulário ao servidor 
para processamento). Você pode usar o Dreamweaver para configurar um botão de formulário 
para executar determinado script no cliente quando o usuário clicar no botão. 

N
O

T
A

Este recurso não funciona com controles de formulário ASP.NET porque esses 
controles são processados no servidor.

N
O

T
A

Este recurso não funciona com formulários ASP.NET.
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Para executar um script no cliente:

1. Em um formulário, selecione um botão Submit (Enviar).

2. No painel Behaviors (Comportamentos), aberto a partir da seleção de Window (Janela) > 
Behaviors, clique no botão de adição (+) e selecione Call JavaScript (Chamar Javascript) na 
lista.

Para obter mais informações sobre esse comportamento, consulte “Chamar o JavaScript” 
na página 549.

3. Na caixa de texto Call JavaScript que é exibida, digite o nome da função JavaScript que você 
deseja executar quando o usuário clicar no botão. Em seguida, clique em OK. 

Por exemplo, você pode digitar o nome de uma função que ainda não existe, como 
processMyForm().

4. Se sua função JavaScript ainda não existir na seção head do documento, adicione-a agora. 

Por exemplo, você poderia definir a seguinte função JavaScript na seção head do 
documento para exibir uma mensagem quando o usuário clicar no botão Submit.
function processMyForm(){

alert('Thanks for your order!');
}

Criar formulários HTML acessíveis
Quando você insere um objeto de formulário HTML, com a opção Form Object (Objeto de 
formulário) selecionada nas preferências de Accessibility (Acessibilidade), o Dreamweaver 
solicita a digitação de informações para tornar acessível o objeto de formulário. Também é 
possível alterar atributos de acessibilidade após inserir o objeto.

Para adicionar um objeto de formulário acessível:

1. Na primeira vez que você adicionar objetos de formulário acessíveis, ative a caixa de diálogo 
Accessibility para objetos de formulário (consulte “Otimizar a área de trabalho para o 
projeto de página acessível” na página 76).

Esta é uma etapa única.
2. No documento, posicione o ponto de inserção no local onde deverá ser exibido o objeto de 

formulário.

3. Selecione Insert (Inserir) > Form (Formulário). Em seguida, selecione um objeto de 
formulário a inserir.
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A caixa de diálogo Input Tag Accessibility Attributes (Atributos de acessibilidade da tag de 
entrada) é exibida.

4. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
5. Clique em OK.

6. Se o Dreamweaver solicitar a inserção de uma tag de formulário, clique em Yes (Sim).

O objeto de formulário será exibido no documento.

Para editar valores de acessibilidade para um objeto de formulário:

1. Na janela do documento, selecione o objeto.

2. Siga um dos procedimentos abaixo:

■ Edite os atributos apropriados na visualização do código. 
■ Clique com o botão direito do mouse (no Windows) ou mantenha a tecla Control 

pressionada e clique (no Macintosh). Em seguida, selecione Edit Tag (Editar tag). 
<identificador>
<input type="radio" name="radiobutton" value="radiobutton">
RadioButton1</label>

<input type="radio" name="radiobutton" value="radiobutton" 
id="radiobutton">

<label for="radiobutton">RadioButton2</label>

<input type="radio" name="radiobutton" value="radiobutton">
RadioButton3

N
O

T
A

Se você pressionar Cancel (Cancelar), o objeto de formulário será exibido no 
documento, mas o Dreamweaver não associará tags de acessibilidade a ele.
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PARTE 8

Desenvolver aplicativos 
rapidamente
Os aplicativos para a Web geralmente apresentam páginas que permitem 
aos usuários localizar um banco de dados; páginas que permitem aos 
usuários inserir, atualizar ou excluir dados em um banco de dados; e 
páginas que restringem o acesso a um site da Web. Com o Macromedia 
Dreamweaver 8, é possível criar rapidamente qualquer um desses tipos de 
página.

Esta seção contém os seguintes capítulos:
Capítulo 40: Criar aplicativos ColdFusion rapidamente  . . . . . . 909

Capítulo 41: Criar aplicativos ASP.NET rapidamente. . . . . . . . . 987

Capítulo 42: Criar aplicativos ASP e JSP rapidamente. . . . . . 1033

Capítulo 43: Criar aplicativos PHP rapidamente. . . . . . . . . . . . .1057
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40

CAPÍTULO 40

Criar aplicativos ColdFusion 
rapidamente
As ferramentas do Macromedia Dreamweaver 8 podem ser utilizadas para criar rapidamente 
um aplicativo ColdFusion para a Web, com pouca ou nenhuma codificação.

Sobre o desenvolvimento rápido de 
aplicativos (todos os servidores)
O RAD (Rapid application development, Desenvolvimento rápido de aplicativos) é um 
processo de desenvolvimento de software projetado para tornar a criação de aplicativos mais 
fácil e rápida. As ferramentas RAD geralmente lidam com os detalhes de um projeto de 
software de modo semelhante ao que as ferramentas CAD (Computer-assisted-design, Projeto 
auxiliado por computador) tratam dos detalhes do desenho de paredes ou da inserção de 
janelas em uma planta de construção. 

O Dreamweaver é uma ferramenta RAD para Web designers e para desenvolvedores de 
aplicativos para a Web. Ele pode ser utilizado para criar páginas de busca, inserção, atualização 
ou exclusão de registros em um banco de dados. O Dreamweaver trata dos detalhes da criação 
de páginas e exige do desenvolvedor o uso de pouca ou nenhuma codificação. Além disso, 
fornece um ambiente de codificação completo para desenvolvedores que gostam de inserir 
códigos em todas as páginas ou em parte delas.
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Sobre páginas-mestras/detalhes
Uma página mestra é uma página que discrimina os registros e os links correspondentes a 
estes. Quando o usuário clica em um link, a página de detalhes é aberta exibindo mais 
informações sobre o registro. Como exemplo, veja a seguir uma página mestra de uma 
empresa fictícia.
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Quando o usuário clicar em um dos nomes de local exibidos como link, será aberta uma 
página de detalhes:

Uma página de resultados é um tipo comum de página mestra. No entanto, diferentemente da 
página mestra descrita nesta seção, a lista de registros em uma página de resultados não é 
determinada pelo designer, mas pelo usuário. O usuário determina a lista através de uma busca 
no banco de dados. Para obter mais informações sobre este tipo de página mestra, consulte 
“Sobre as páginas de busca/resultados” na página 911.

Também é possível utilizar uma página de detalhes para atualizar ou excluir o registro exibido.

Tópicos relacionados
■ “Criar páginas-mestras/detalhes (ColdFusion)” na página 928
■ “Criar páginas-mestras/detalhes (ASP.NET)” na página 997
■ “Criar páginas-mestras/detalhes (ASP e JSP)” na página 1033
■ “Criar páginas-mestras/detalhes (PHP)” na página 1057

Sobre as páginas de busca/resultados
Na maioria dos casos, são necessárias pelo menos duas páginas para adicionar este recurso ao 
aplicativo para a Web. A primeira página contém um formulário HTML, no qual os usuários 
digitarão os parâmetros de busca. Embora não efetue nenhuma busca na realidade, a página é 
conhecida como “página de busca”.
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A segunda página necessária é a página de resultados, que executa a maior parte do trabalho. A 
página de resultados executa as seguintes tarefas:

■ Lê os parâmetros de busca enviados pela página de busca
■ Conecta-se ao banco de dados e procura os registros
■ Cria um recordset a partir dos registros localizados
■ Exibe o conteúdo do recordset

Opcionalmente, é possível adicionar uma página de detalhes. Uma página de detalhes fornece 
aos usuários as informações sobre um determinado registro da página de resultados.

Se o ASP.NET for utilizado, as páginas de busca e de resultados poderão ser combinadas em 
uma única página.

Se houver apenas um parâmetro de busca, o Dreamweaver permitirá adicionar o recurso de 
busca ao aplicativo da Web sem o uso de consultas e variáveis SQL. Basta projetar as páginas e 
preencher algumas caixas de diálogo. Se houver mais de um parâmetro de busca, será 
necessário codificar uma instrução SQL e definir diversas variáveis para ela.

O Dreamweaver inserirá uma consulta SQL na página. Quando a página for executada no 
servidor, todos os registros na tabela de banco de dados serão verificados. Se o campo 
especificado em um registro corresponder às condições da consulta SQL, o registro será 
incluído em um recordset. A consulta SQL válida criará um recordset apenas com os 
resultados da busca.

Por exemplo, os funcionários de vendas podem informar quais clientes de uma área específica 
têm renda superior a determinado nível. No formulário de uma página de busca, o 
funcionário de vendas digita uma área geográfica e um valor mínimo de nível de salário. Em 
seguida, clica no botão Submit (Enviar) para enviar os dois valores ao servidor. No servidor, os 
valores serão repassados à instrução SQL da página de resultados, que criará então um 
recordset contendo apenas os clientes na área específica, cujos salários se situam acima do 
nível especificado.

Tópicos relacionados
■ “Criar páginas de busca/resultados (ColdFusion, ASP, JSP, PHP)” na página 937
■ “Criar uma página de busca do banco de dados (ASP.NET)” na página 1004
912 Capítulo 40:  Criar aplicativos ColdFusion rapidamente



         
Sobre objetos avançados de manipulação de banco 
de dados
Além de criar páginas que modificam bancos de dados utilizando comportamentos de 
servidor, também é possível criá-las utilizando objetos de manipulação de banco de dados 
(como procedimentos armazenados, objetos de comando ASP ou instruções preparadas JSP).

Procedimentos armazenados
Um procedimento armazenado é um item de banco de dados reutilizável que executa algumas 
operações no banco de dados. Um procedimento armazenado contém código SQL que pode, 
entre outras coisas, inserir, atualizar ou excluir registros. Os procedimentos armazenados 
podem também alterar a estrutura do próprio banco de dados. Por exemplo: é possível utilizar 
um procedimento armazenado para adicionar uma coluna da tabela ou mesmo excluir uma 
tabela. 

O procedimento armazenado também pode chamar outro procedimento armazenado, bem 
como aceitar parâmetros de entrada e retornar valores múltiplos para o procedimento de 
chamada em formato de parâmetros de saída.

O procedimento armazenado é reutilizável, ou seja, é possível utilizar novamente uma única 
versão compilada do procedimento para executar uma operação de banco de dados várias 
vezes. Se uma tarefa de banco de dados for executada mais de uma vez ou se a mesma tarefa for 
executada por aplicativos diferentes, o uso de um procedimento armazenado para executar esta 
tarefa pode tornar as operações de banco de dados mais eficazes.

Tópicos relacionados
■ “Utilizar os procedimentos armazenados para modificar bancos de dados (ColdFusion)” 

na página 965
■ “Utilizar procedimentos armazenados para modificar bancos de dados (ASP.NET)” na 

página 1030
■ “Utilizar procedimentos armazenados para modificar bancos de dados (ASP e JSP)” na 

página 1049

N
O

T
A

Os bancos de dados MySQL e Microsoft Access não oferecem suporte a 
procedimentos armazenados. 
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Objetos de comando, ASP
Um objeto de comando ASP é um objeto de servidor que executa operações em um banco de 
dados. O objeto pode conter qualquer instrução SQL válida, incluindo uma instrução que 
retorna um recordset ou outra que insere, atualiza ou exclui registros de um banco de dados. 
Um objeto de comando pode alterar a estrutura de um banco de dados se a instrução SQL 
adicionar ou excluir uma coluna de tabela. Você também pode utilizar um objeto de comando 
para executar um procedimento armazenado em um banco de dados. 

Um objeto de comando pode ser reutilizável, ou seja, o servidor de aplicativos pode utilizar 
novamente uma única versão compilada do objeto para executar o comando várias vezes. Para 
tornar um comando reutilizável, defina a propriedade Prepared (Preparado) do objeto de 
comando para true, como na instrução VBScript a seguir:
mycommand.Prepared = true

Se o comando for executado diversas vezes, uma única versão compilada do objeto poderá 
tornar as operações de banco de dados mais eficientes. 

Um objeto de comando é criado por meio scripts em uma página ASP, mas o Dreamweaver 
permite criar objetos de comando sem que seja necessário escrever uma única linha de código 
ASP. Para obter mais informações, consulte “Utilizar comandos ASP para modificar um banco 
de dados” na página 1051.

Instruções preparadas, JSP
Uma instrução JSP preparada é um objeto de servidor reutilizável que contém uma instrução 
SQL. É possível colocar qualquer instrução SQL válida em uma instrução preparada. Por 
exemplo, a instrução preparada pode conter qualquer instrução SQL que retorne um recordset 
ou outra que insira, atualize ou exclua registros de um banco de dados.

Uma instrução preparada é reutilizável, ou seja, o servidor de aplicativos utiliza uma única 
instância do objeto de instrução preparado para consultar o banco de dados diversas vezes. Ao 
contrário do objeto de instrução JSP, não é criada uma nova instância do objeto de instrução 
preparado para cada nova consulta no banco de dados. Se a instrução for executada diversas 
vezes, uma única instância do objeto pode tornar as operações de banco de dados mais 
eficientes e ocupar menos quantidade de memória do servidor. 

N
O

T
A

Nem todos os provedores de banco de dados oferecem suporte a comandos 
preparados. Se o banco de dados não oferecer suporte a comandos desse tipo, uma 
mensagem de erro poderá retornar ao definir esta propriedade para true. Pode até 
mesmo ignorar o pedido para preparar o comando e definir a propriedade Prepared para 
false.
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Um objeto de instrução preparado é criado por um scriptlet Java em uma página JSP. O 
Dreamweaver, no entanto, permite criar instruções preparadas sem que seja preciso escrever 
uma única linha de código Java.

Se você estiver interessado no código, o scriptlet a seguir criará uma instrução preparada: 
String myquery = “SELECT * FROM EMPLOYEES WHERE DEPARTMENT = ?”;
PreparedStatement mystatement = connection.prepareStatement(myquery);

A primeira linha armazena a instrução SQL em uma variável de seqüência de caracteres 
chamada myquery, com um ponto de interrogação que serve como alocador de espaço para o 
valor da variável SQL. A segunda linha cria um objeto de instrução preparado chamado 
mystatement.

Em seguida, atribua um valor à variável SQL, do seguinte modo:
mystatement.setString(1, request.getParameter(“myURLparam”));

O método setString atribui o valor à variável e leva dois argumentos. O primeiro 
argumento especifica a variável afetada por sua posição (no exemplo, a primeira posição na 
instrução SQL). O segundo argumento especifica o valor da variável. Neste exemplo, o valor é 
fornecido por um parâmetro URL repassado à página.

Por último, gere o recordset do seguinte modo:
ResultSet myresults = mystatement.execute();

Para obter mais informações sobre como criar instruções preparadas JSP utilizando 
ferramentas de desenvolvimento rápido de aplicativos (RAD) no Dreamweaver, consulte 
“Utilizar as instruções preparadas JSP para modificar um banco de dados” na página 1053.

Criar formulários no ColdFusion MX 7
O Dreamweaver oferece vários aprimoramentos para os desenvolvedores do ColdFusion que 
utilizam ColdFusion MX 7 ou posterior como seus servidores de desenvolvimento. Tais 
aprimoramentos incluem mais botões na barra Insert (Inserir), itens de menu e Property 
inspectors para que você possa criar e definir rapidamente as propriedades dos formulários 
ColdFusion. Você também pode usar o Dreamweaver para gerar um código que valida as 
informações fornecidas pelos visitantes do site. Por exemplo, você pode verificar se o endereço 
de e-mail fornecido por um usuário contém o símbolo @ ou se o campo de texto obrigatório 
contém um certo tipo de valor.

N
O

T
A

É necessário utilizar métodos diferentes para atribuir valores que não sejam seqüências 
de caracteres a variáveis SQL. Por exemplo: para atribuir um valor interior a uma 
variável, utilize o método mystatement.setInt(). 
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Esses aprimoramentos só estarão disponíveis se você tiver acesso a um computador que 
execute ColdFusion MX 7 ou posterior.

Esta seção contém os tópicos a seguir:

■ “Ativar os aprimoramentos do ColdFusion” na página 916
■ “Criar formulários ColdFusion” na página 917
■ “Inserir controles no formulário ColdFusion.” na página 919
■ “Definir visualmente as propriedades dos controles do formulário ColdFusion” na 

página 927
■ “Validar dados de formulário ColdFusion” na página 927

Ativar os aprimoramentos do ColdFusion
O Dreamweaver oferece diversos aprimoramentos para os desenvolvedores do ColdFusion. 
Alguns desses aprimoramentos exigem que você defina um computador que execute 
ColdFusion MX 7 ou posterior como um servidor de teste para o Dreamweaver. Por exemplo, 
os novos Property inspectors para controles de formulário só estarão disponíveis se você 
especificar o servidor de testes correto.

Você só precisa definir uma vez o servidor de teste. Em seguida, o Dreamweaver detectará 
automaticamente a versão do servidor e fará os aprimoramentos disponíveis se detectar o 
ColdFusion MX 7.

Para ativar os aprimoramentos para os desenvolvedores do ColdFusion:

1. Caso ainda não tenha feito, defina um site Dreamweaver para seu projeto ColdFusion.

Para obter mais informações, consulte Capítulo 2, “Configurar um site do Dreamweaver”, 
na página 87.

2. Abra a caixa de diálogo Advanced Site Definition (Definição avançada de site), 
selecionando Site > Manage Sites (Gerenciar sites), escolhendo seu site na lista e clicando 
em Edit.

Se a caixa de diálogo Basic Site Definition (Definição de site básico) aparecer, clique na 
guia Advanced (Avançado) para alternar para a versão avançada.

3. Selecione a categoria Testing Server (Servidor de teste) e especifique um computador que 
execute ColdFusion MX 7 ou posterior como o servidor de teste de seu site Dreamweaver.

Certifique-se de especificar um prefixo de URL válido.
Para obter mais informações, consulte “Especificar onde as páginas dinâmicas podem ser 
processadas” na página 667. 
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4. Abra qualquer documento ColdFusion.

Você só verá qualquer alteração na área de trabalho do Dreamweaver após abrir um 
documento ColdFusion.

Tópicos relacionados
■ “Criar formulários ColdFusion” na página 917
■ “Proteger uma pasta em em seu aplicativo (ColdFusion)” na página 977
■ “Exibir componentes ColdFusion no Dreamweaver” na página 980
■ “Definir um recordset em um componente ColdFusion” na página 984
■ “Usar um recordset CFC como a origem de um conteúdo dinâmico” na página 985
■ “Criar ou modificar uma fonte de dados ColdFusion” na página 670

Criar formulários ColdFusion
Você pode usar vários botões da barra Insert (Inserir), itens de menu e Property inspectors 
para criar rapidamente formulários ColdFusion e definir suas propriedades no Dreamweaver.

Esses aprimoramentos só estarão disponíveis se você tiver acesso a um computador que 
execute ColdFusion MX 7 ou posterior. Para obter mais informações, consulte “Ativar os 
aprimoramentos do ColdFusion” na página 916.

Para criar um formulário ColdFusion:

1. Abra uma página ColdFusion e posicione o ponto de inserção no local onde você deseja que 
o formulário ColdFusion seja exibido.

2. Selecione Insert > ColdFusion Objects (Objetos ColdFusion) > CFForm > CFForm, ou 
selecione a categoria CFForm na barra Insert e clique no ícone CF Form (Formulário CF).

O Dreamweaver insere um formulário ColdFusion vazio. Na exibição do projeto, o 
formulário estará indicado por um contorno vermelho pontilhado. Se esse contorno não 
estiver visível, certifique-se de que a opção View (Exibir) > Visual Aids (Auxílios visuais) > 
Invisible Elements (Elementos invisíveis) esteja selecionada.

3. Certifique-se de que o formulário ainda esteja selecionado e, em seguida, use o Property 
inspector para especificar a página ou script que fará o processamento dos dados do 
formulário.

No Property inspector, digite o caminho da página ou script na caixa de texto Action 
(Ação) ou clique no ícone de pasta ao lado da caixa de texto e navegue até a página ou 
script. 
Se você não vir a caixa de texto Action no Property inspector, clique no contorno do 
formulário na janela do documento para selecionar o formulário.
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4. No menu pop-up Method (Método), selecione o método a ser usado na transmissão dos 
dados do formulário para o servidor.

Default: utiliza a configuração padrão do navegador para enviar os dados do formulário 
para o servidor. Normalmente, o padrão é o método get.
GET: anexa o valor à URL que solicita a página.
POST: incorpora os dados do formulário na solicitação HTTP.
Para obter mais informações, clique no ícone Help (Ajuda) do Property inspector.

5. Inserir controles no formulário ColdFusion. 

Posicione o ponto de inserção no local onde deseja que o controle do formulário 
ColdFusion apareça no formulário e, em seguida, selecione o controle no menu Insert 
(Insert > ColdFusion Objects > CFForm) ou na categoria CFForm da barra Insert.
Para obter mais informações, consulte “Inserir controles no formulário ColdFusion.” na 
página 919.

6. Se necessário, use o Property inspector para definir as propriedades do controle. 

Certifique-se de que o controle esteja selecionado na visualização do projeto e defina as 
propriedades no Property inspector. Para obter mais informações sobre propriedades, 
clique no ícone Help (Ajuda) no Property inspector.

7. Ajuste o layout do formulário ColdFusion. 

Se estiver criando um formulário baseado em HTML, você pode usar quebras de linha, 
quebras de parágrafo, texto pré-formatado ou tabelas para formatar os formulários. Um 
formulário ColdFusion não pode ser inserido em outro formulário ColdFusion (ou seja, as 
tags não podem ser sobrepostas), embora seja possível incluir mais de um formulário 
ColdFusion em uma página.
Se estiver criando um formulário baseado em Flash, use os estilos CSS para fazer o layout 
de seu formulário. O ColdFusion ignora qualquer HTML no formulário.
Lembre-se de identificar com um texto descritivo os campos do formulário ColdFusion, a 
fim de permitir que os usuários saibam ao que estão respondendo. Por exemplo, crie um 
“Digite seu identificador de nome” para solicitar informações sobre o nome.

Tópicos relacionados
■ “Validar dados de formulário ColdFusion” na página 927
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Inserir controles no formulário ColdFusion.
Use a barra Insert ou o menu Insert para inserir rapidamente os controles do formulário 
ColdFusion no formulário.

Esses aprimoramentos só estarão disponíveis se você tiver acesso a um computador que 
execute ColdFusion MX 7 ou posterior. Para obter mais informações, consulte “Ativar os 
aprimoramentos do ColdFusion” na página 916.

É necessário criar um formulário ColdFusion em branco para poder inserir controles nele. 
Para obter mais informações, consulte “Criar formulários ColdFusion” na página 917. Se você 
não criar um formulário em branco e tentar inserir um controle, o Dreamweaver perguntará se 
deseja criar um formulário.

Esta seção contém os seguintes tópicos:

■ “Inserir campos de texto ColdFusion” na página 919
■ “Inserir campos ocultos ColdFusion” na página 920
■ “Inserir áreas de texto ColdFusion” na página 921
■ “Inserir botões ColdFusion” na página 921
■ “Inserir caixas de seleção HTML” na página 922
■ “Inserir botões de opção ColdFusion” na página 923
■ “Inserir caixas de seleção ColdFusion” na página 923
■ “Inserir campos de imagem ColdFusion” na página 924
■ “Inserir campos de arquivo ColdFusion” na página 925

Inserir campos de texto ColdFusion
Você pode inserir visualmente um campo de senha ou de texto ColdFusion no formulário e, 
em seguida, definir suas propriedades. 

Esse aprimoramento do Dreamweaver só estará disponível se você tiver acesso a um 
computador que execute ColdFusion MX 7 ou posterior. Para obter mais informações, 
consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

Para inserir visualmente um campo de texto ColdFusion:

1. Na visualização do projeto, posicione o ponto de inserção no interior do contorno do 
formulário. 

2. Na categoria CFForm da barra Insert (Inserir), clique no ícone CF Text Field (Campo de 
texto ColdFusion). 

Um campo de texto é exibido no formulário.
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3. No Property inspector (Inspetor de propriedades), defina as propriedades do campo de 
texto. 

Para obter mais informações, clique no ícone Help (Ajuda) do Property inspector.
4. Para identificar o campo de texto na página, clique ao lado dele e insira o texto do 

identificador.

Para inserir visualmente um campo de senha: 

1. Repita as etapas 1 e 2 do procedimento anterior de inserção de campo de texto.

2. Selecione o campo de texto inserido para exibir seu respectivo Property inspector.

3. Selecione o valor de Password no menu pop-up Text Mode (Modo de texto) no Property 
inspector.

Tópicos relacionados
■ “Validar dados de formulário ColdFusion” na página 927
■ “Definir visualmente as propriedades dos controles do formulário ColdFusion” na 

página 927

Inserir campos ocultos ColdFusion
Você pode inserir visualmente um campo oculto ColdFusion em seu formulário e definir suas 
propriedades. Use os campos ocultos para armazenar e enviar as informações que o usuário 
não fornecer. As informações são mantidas ocultas do usuário.

Esse aprimoramento do Dreamweaver só estará disponível se você tiver acesso a um 
computador que execute ColdFusion MX 7 ou posterior. Para obter mais informações, 
consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

Para inserir visualmente um campo oculto ColdFusion:

1. Na visualização do projeto, posicione o ponto de inserção no interior do contorno do 
formulário. 

2. Na categoria CFForm da barra Insert (Inserir), clique no ícone CF Hidden Field (Campo 
oculto ColdFusion).

Um marcador é exibido no formulário ColdFusion. Se o marcador não estiver visível, 
selecione View (Exibir)> Visual Aids (Auxílios Visuais) > Invisible Elements (Elementos 
invisíveis).

3. No Property inspector (Inspetor de propriedades), defina as propriedades do campo oculto. 

Para obter mais informações, clique no ícone Help (Ajuda) do Property inspector.
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Tópicos relacionados
■ “Definir visualmente as propriedades dos controles do formulário ColdFusion” na 

página 927

Inserir áreas de texto ColdFusion
Você pode inserir visualmente uma área de texto ColdFusion em seu formulário e definir suas 
propriedades. Uma área de texto é um elemento de entrada que consiste em várias linhas de 
texto.

Esse aprimoramento do Dreamweaver só estará disponível se você tiver acesso a um 
computador que execute ColdFusion MX 7 ou posterior. Para obter mais informações, 
consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

Para inserir visualmente uma área de texto ColdFusion:

1. Posicione o ponto de inserção dentro do contorno do formulário: 

2. Na categoria CFForm da barra Insert (Inserir), clique no ícone CF Text Area (Área de texto 
ColdFusion).

A área de texto é exibida no formulário ColdFusion.
3. No Property inspector, defina as propriedades da área de texto. 

Para obter mais informações, clique no ícone Help (Ajuda) do Property inspector.
4. Para identificar a área de texto, clique ao lado dela e insira o texto do identificador.

Tópicos relacionados
■ “Validar dados de formulário ColdFusion” na página 927
■ “Definir visualmente as propriedades dos controles do formulário ColdFusion” na 

página 927

Inserir botões ColdFusion
Você pode inserir visualmente um botão ColdFusion em seu formulário e definir suas 
propriedades. Os botões ColdFusion controlam as operações no formulário ColdFusion. Os 
botões podem ser usados para enviar os dados do formulário ColdFusion para o servidor ou 
para redefinir o formulário ColdFusion. Normalmente, os botões ColdFusion padrão são 
identificados como Submit (Enviar), Reset (Redefinir) ou Send (Enviar). É possível atribuir 
outras tarefas de processamento que você tenha definido em um script. Por exemplo, o botão 
pode calcular o custo total dos itens selecionados com base em valores atribuídos.
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Esse aprimoramento do Dreamweaver só estará disponível se você tiver acesso a um 
computador que execute ColdFusion MX 7 ou posterior. Para obter mais informações, 
consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

Para inserir visualmente um botão ColdFusion:

1. Posicione o ponto de inserção dentro do contorno do formulário ColdFusion. 

2. Na categoria CFForm da barra Insert (Inserir), clique no ícone CF Button (Botão 
ColdFusion).

Um botão é exibido no formulário ColdFusion.
3. No Property inspector (Inspetor de propriedades), defina as propriedades do botão. 

Para obter mais informações, clique no ícone Help (Ajuda) do Property inspector.

Tópicos relacionados
■ “Definir visualmente as propriedades dos controles do formulário ColdFusion” na 

página 927

Inserir caixas de seleção HTML
Você pode inserir visualmente uma caixa de seleção ColdFusion em seu formulário e definir 
suas propriedades. Use as caixas de seleção para permitir que os usuários selecionem mais de 
uma opção em um conjunto de opções. 

Esse aprimoramento do Dreamweaver só estará disponível se você tiver acesso a um 
computador que execute ColdFusion MX 7 ou posterior. Para obter mais informações, 
consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

Para inserir visualmente uma caixa de seleção ColdFusion:

1. Posicione o ponto de inserção dentro do contorno do formulário: 

2. Na categoria CFForm da barra Insert (Inserir), clique no ícone CF Checkbox (Caixa de 
seleção ColdFusion).

Uma caixa de seleção é exibida no formulário ColdFusion.
3. No painel Properties, defina as propriedades da caixa de seleção. 

Para obter mais informações, clique no ícone Help (Ajuda) do Property inspector.
4. Para identificar a caixa de seleção, clique junto da caixa na página e digite o texto do 

identificador.

Tópicos relacionados
■ “Definir visualmente as propriedades dos controles do formulário ColdFusion” na 

página 927
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Inserir botões de opção ColdFusion
Você pode inserir visualmente um botão de opção ColdFusion em seu formulário e definir 
suas propriedades. Use botões de opção quando quiser que os usuários selecionem somente 
uma única opção em um conjunto de opções. Normalmente, os botões de opção são 
utilizados em grupos. Todos os botões de opção de um grupo devem ter o mesmo nome.

Esse aprimoramento do Dreamweaver só estará disponível se você tiver acesso a um 
computador que execute ColdFusion MX 7 ou posterior. Para obter mais informações, 
consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

Para inserir visualmente botões de opção ColdFusion:

1. Posicione o ponto de inserção dentro do contorno do formulário: 

2. Na categoria CFForm da barra Insert (Inserir), clique no ícone CF Radio Button (Botão 
de opção ColdFusion). 

Um botão de opção é exibido no formulário ColdFusion.
3. No Property inspector, defina as propriedades para o botão de opção. 

Para obter mais informações, clique no ícone Help (Ajuda) do Property inspector.
4. Para identificar o botão de opção na página, clique ao lado dele e insira o texto do 

identificador.

Tópicos relacionados
■ “Definir visualmente as propriedades dos controles do formulário ColdFusion” na 

página 927

Inserir caixas de seleção ColdFusion
Você pode inserir visualmente uma caixa de seleção ColdFusion em seu formulário e definir 
suas propriedades. A caixa de seleção permite que um visitante selecione um ou mais itens em 
uma lista. As caixas de seleção são úteis quando há espaço limitado, mas é necessário exibir 
vários itens. Eles também são úteis quando você quer controlar os valores retornados para o 
servidor. Ao contrário dos campos de texto, onde os usuários podem digitar qualquer coisa 
que queiram, inclusive dados inválidos, você pode definir os valores exatos retornados por um 
menu.

É possível inserir dois tipos de caixas de seleção em um formulário: um menu que é aberto 
quando o usuário clica nele ou um menu que exibe uma lista rolável de itens que podem ser 
selecionados pelo usuário.
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Esse aprimoramento do Dreamweaver só estará disponível se você tiver acesso a um 
computador que execute ColdFusion MX 7 ou posterior. Para obter mais informações, 
consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

Para inserir visualmente uma caixa de seleção ColdFusion:

1. Posicione o ponto de inserção dentro do contorno do formulário: 

2. Na categoria CFForm da barra Insert (Inserir), clique no ícone CF Select (Caixa de seleção 
ColdFusion).

Uma caixa de seleção é exibida no formulário ColdFusion.
3. No Property inspector (Inspetor de propriedades), defina as propriedades da caixa de 

seleção. 

Para obter mais informações, clique no ícone Help (Ajuda) do Property inspector.

Tópicos relacionados
■ “Definir visualmente as propriedades dos controles do formulário ColdFusion” na 

página 927

Inserir campos de imagem ColdFusion
Você pode inserir visualmente um campo de imagem ColdFusion em seu formulário e definir 
suas propriedades. Use os campos de imagem para criar botões personalizados.

Esse aprimoramento do Dreamweaver só estará disponível se você tiver acesso a um 
computador que execute ColdFusion MX 7 ou posterior. Para obter mais informações, 
consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

Para inserir visualmente um campo de imagem ColdFusion:

1. Na visualização do projeto, posicione o ponto de inserção no interior do contorno do 
formulário. 

2. Na categoria CFForm da barra Insert (Inserir), clique no ícone CF Image Field (Campo de 
imagem ColdFusion).

Uma caixa de diálogo lhe pedirá que localize a imagem desejada. Selecione a imagem a ser 
inserida e clique no botão OK.
Se a imagem estiver fora da pasta raiz do site, o Dreamweaver perguntará se você quer 
copiá-la para a pasta raiz. As imagens fora da pasta raiz nem sempre estarão acessíveis 
quando você publicar o site.
Você também pode digitar o caminho do arquivo de imagem que deseja exibir na caixa de 
texto Src (Orig.) do Property inspector.
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3. No Property inspector (Inspetor de propriedades), defina as propriedades do campo de 
imagem.

Para obter mais informações, clique no ícone Help (Ajuda) do Property inspector.

Tópicos relacionados
■ “Definir visualmente as propriedades dos controles do formulário ColdFusion” na 

página 927

Inserir campos de arquivo ColdFusion
Você pode inserir visualmente um campo de arquivo ColdFusion em seu formulário e definir 
suas propriedades. Use o campo de arquivo para permitir que os usuários selecionem um 
arquivo no computador, como um documento de editor de texto ou um arquivo de figuras, e 
o carreguem (upload) no servidor. Um campo de arquivo ColdFusion se parece com outros 
campos de texto, exceto pela presença de um botão Browse (Procurar). Os usuários podem 
digitar manualmente o caminho do arquivo que desejam carregar ou utilizar o botão Browse 
para localizar e selecionar o arquivo.

Os campos de arquivo requerem o método POST para transmitir os arquivos do navegador 
para o servidor. O arquivo é enviado para o endereço especificado na caixa de texto Action 
(Ação) do formulário. Antes de utilizar o campo de arquivo no formulário, confirme com o 
administrador do servidor se é permitido o upload anônimo de arquivos.

Os campos de arquivos também requerem que a codificação do formulário seja definida como 
multipart/form. O Dreamweaver faz essa definição automaticamente quando você insere um 
controle de campo de arquivo.

Esse aprimoramento do Dreamweaver só estará disponível se você tiver acesso a um 
computador que execute ColdFusion MX 7 ou posterior. Para obter mais informações, 
consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

Para inserir visualmente um campo de arquivo ColdFusion:

1. Na visualização do projeto, selecione o CFForm para exibir seu Property inspector. 

Para selecionar rapidamente o formulário, clique em qualquer parte do contorno do 
formulário e clique na tag <cfform> no seletor de tags, no canto inferior da janela do 
documento.

2. No Property inspector, defina o método do formulário como POST. 

3. No menu pop-up Enctype (Tipo de codif.), selecione multipart/form-data. 

4. Posicione o ponto de inserção dentro do contorno do formulário, no local onde você deseja 
exibir o campo de arquivo.
Criar formulários no ColdFusion MX 7 925



         
5. Na categoria CFForm da barra Insert (Inserir), clique no ícone CF File Field (Campo de 
arquivo ColdFusion).

Um campo de arquivo é exibido no documento.
6. No Property inspector (Inspetor de propriedades), defina as propriedades do campo de 

arquivo. 

Para obter mais informações, clique no ícone Help (Ajuda) do Property inspector.

Tópicos relacionados
■ “Definir visualmente as propriedades dos controles do formulário ColdFusion” na 

página 927

Inserir campos de data ColdFusion
Embora não seja possível inserir visualmente um campo de data ColdFusion no Dreamweaver, 
você pode definir visualmente suas propriedades. O campo de data ColdFusion é um tipo 
especial de campo de texto que permite que os usuários selecionem uma data em um 
calendário pop-up para inseri-la em um campo de texto. 

Esse aprimoramento do Dreamweaver só estará disponível se você tiver acesso a um 
computador que execute ColdFusion MX 7 ou posterior. Para obter mais informações, 
consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

Para inserir um campo de data ColdFusion e definir suas propriedades:

1. Na visualização do projeto, selecione o CFForm para exibir seu Property inspector. 

Para selecionar rapidamente o formulário, clique em qualquer parte do contorno do 
formulário e clique na tag <cfform> no seletor de tags, no canto inferior da janela do 
documento.

2. No Property inspector, defina a propriedade Format (Formato) do formulário como Flash. 

O controle do campo de data somente poderá ser implantado nos formulários ColdFusion 
baseados no Flash.

3. Alterne para a visualização de código (View > Code) e insira a seguinte tag em qualquer 
posição entre as tags CFForm de abertura e de fechamento:
<cfinput name="datefield" type="datefield">

4. No Property inspector (Inspetor de propriedades), defina as propriedades do campo de 
data. 

Para obter mais informações, clique no ícone Help (Ajuda) do Property inspector.
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Definir visualmente as propriedades dos controles do 
formulário ColdFusion
Você pode alterar visualmente as propriedades dos controles do formulário ColdFusion 
mesmo quando estiver trabalhando na visualização de projeto ou na visualização de código.

Esse aprimoramento do Dreamweaver só estará disponível se você tiver acesso a um 
computador que execute ColdFusion MX 7 ou posterior. Para obter mais informações, 
consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

Para alterar visualmente as propriedades de um controle de formulário 
ColdFusion:

1. Na visualização do projeto, selecione o controle do formulário na página; na visualização 
do código, clique em qualquer posição dentro da tag do controle.

O Property inspector (Inspetor de propriedades) exibe as propriedades do controle do 
formulário.

2. Modifique as propriedades do controle no Property inspector.

Para obter mais informações, clique no ícone Help (Ajuda) do Property inspector.
3. Para definir mais propriedades, clique no botão Display Tag Editor (Exibir editor de tags) 

no Property inspector e defina as propriedades no editor de tags que for exibido. 

Validar dados de formulário ColdFusion
Você pode criar formulários ColdFusion no Dreamweaver que verificam o conteúdo dos 
campos especificados para assegurar que o usuário inseriu o tipo de dado correto.

Esse aprimoramento do Dreamweaver só estará disponível se você tiver acesso a um 
computador que execute ColdFusion MX 7 ou posterior. Para obter mais informações, 
consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

Para validar dados de um formulário ColdFusion: 

1. Crie um formulário ColdFusion que contenha pelo menos um campo de texto e um botão 
Submit (Enviar).

Verifique se cada campo ColdFusion que você deseja validar possui um nome exclusivo.
2. Selecione um campo do formulário que você deseje validar.

3. No Property inspector, especifique como deseja validar o campo. 
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A parte inferior de cada Property inspector contém controles que o ajudam a definir a regra de 
validação específica. Por exemplo, você pode querer especificar que um campo de texto 
contenha um número telefônico. Para fazer isso, selecione Telephone (Telefone) no menu 
pop-up Value (Valor) no Property inspector. Também é possível especificar quando deverá ser 
feita a validação, no menu pop-up Validate At (Validar em).

Criar páginas-mestras/detalhes 
(ColdFusion)
Com o Dreamweaver, é possível criar conjuntos de páginas que apresentam informações em 
dois níveis de detalhe: uma página mestra que relaciona registros e uma página de detalhes que 
apresenta mais detalhes sobre cada registro. Esta seção descreve como criar esses tipos de 
página-mestra/detalhes. 

Criar páginas-mestras/detalhes em uma operação 
(ColdFusion, ASP, JSP, PHP)
Ao desenvolver aplicativos para a Web, é possível criar rapidamente páginas-mestras/detalhes 
utilizando o objeto de aplicativo Master/Detail Page Set (Conjunto de páginas-mestras/
detalhes). Com o objeto de aplicativo é possível criar um conjunto completo de páginas 
dinâmicas simplesmente preenchendo uma ou duas caixas de diálogo. 

O método é idêntico ao utilizado para páginas ColdFusion, ASP, JSP e PHP. Para obter 
informações sobre como criar páginas-mestras/detalhes ASP.NET, consulte “Criar páginas-
mestras/detalhes (ASP.NET)” na página 997. 

Para completar o conjunto de páginas-mestras/detalhes com um objeto de 
aplicativo:

1. No Dreamweaver, crie uma página dinâmica em branco escolhendo File (Arquivo) > New 
(Novo) > Dynamic (Dinâmico), selecionando uma página dinâmica e clicando em Create 
(Criar).

Essa página será a página mestra.
2. Defina um recordset para a página.

Você pode definir um recordset na fase de projeto (consulte “Definir um recordset” na 
página 765), ou o usuário pode defini-la durante a execução (consulte “Criar páginas de 
busca/resultados (ColdFusion, ASP, JSP, PHP)” na página 937). 
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Assegure-se de que o recordset contenha não somente todas as colunas de que você 
necessitar na página mestra, mas também todas as colunas de que necessitar na página de 
detalhes. Normalmente, o recordset na página mestra extrai algumas colunas de uma 
tabela de banco de dados, enquanto que o recordset na página detalhes extrai mais colunas 
da mesma tabela para fornecer mais detalhes.

3. Abra a página-mestra na visualização do projeto e selecione Insert (Inserir) > Application 
Objects (Objetos de aplicativo) > Master Detail Page Set (Conjunto de páginas-mestras/
detalhes).

Será exibida a caixa de diálogo Master Detail Page Set.

4. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
5. Clique em OK.

O objeto de aplicativo criará uma página de detalhes, caso ainda não tenha sido criada, e 
adicionará conteúdo dinâmico e comportamentos de servidor tanto à página mestra 
quanto à de detalhes. 
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6. Personalize as páginas-mestras e de detalhes de acordo com suas preferências.

O layout de cada página pode ser totalmente personalizado utilizando as ferramentas de 
projeto de página do Dreamweaver. Também é possível editar os comportamentos de 
servidor clicando duas vezes neles no painel Server Behaviors (Comportamentos de 
servidor).

Após criar as páginas-mestras/detalhes com o objeto de aplicativo, utilize o painel 
Server Behaviors, em Window (Janela) > Server Behaviors, para modificar os vários blocos de 
criação inseridos nas páginas pelo objeto de aplicativo. Para obter mais informações, consulte 
“Editar o conteúdo dinâmico de uma página” na página 742.

Também é possível criar páginas-mestras/detalhes utilizando comportamentos de servidor 
individuais. 

Criar páginas-mestras/detalhes bloco a bloco 
(ColdFusion)
É possível adicionar separadamente os blocos de criação básicos das páginas-mestras/detalhes 
utilizando o painel Server Behaviors (Comportamentos de servidor).

Os blocos de criação também podem ser adicionados simultaneamente utilizando o objeto de 
aplicativo Master/Detail Page Set (Conjunto de páginas-mestras/detalhes). Para obter mais 
informações, consulte “Criar páginas-mestras/detalhes em uma operação (ColdFusion, ASP, 
JSP, PHP)” na página 928.

Esta seção apresenta as etapas de criação de páginas-mestras/detalhes com comportamentos de 
servidor:

■ “Criar a página mestra (ColdFusion)” na página 930
■ “Criar os links para a página de detalhes (ColdFusion)” na página 932
■ “Criar um parâmetro da URL para os links (ColdFusion)” na página 933
■ “Localizar e exibir o registro solicitado na página de detalhes (ColdFusion)” na página 934

Criar a página mestra (ColdFusion)
Esta seção descreve como criar uma página mestra que contenha registros de banco de dados. 
É possível utilizar uma tabela dinâmica para listar os registros em uma página ColdFusion.

Antes de começar, certifique-se de definir uma fonte de dados ColdFusion para o banco de 
dados. Para obter mais informações, consulte Capítulo 24, “Conexões de banco de dados para 
desenvolvedores ColdFusion”, na página 669.
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Para criar uma página mestra:

1. No Dreamweaver, crie uma nova página ColdFusion.

Selecione File (Arquivo) > New (Novo) > Dynamic (Dinâmico), escolha ColdFusion e 
clique em Create (Criar). Será aberta no Dreamweaver uma página ColdFusion em 
branco.

2. Defina um recordset para a página.

No painel Bindings (Ligações), clique no botão com sinal de adição (+), selecione 
Recordset (Query) [Recordset (Consulta)] e preencha a caixa de diálogo Recordset. Para 
obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo. Para codificar a 
sua própria instrução SQL, clique no botão Advanced (Avançado) para abrir a caixa de 
diálogo avançada Recordset.
Certifique-se de que o recordset contenha todas as colunas da tabela necessárias para criar 
a tabela dinâmica. O recordset deve incluir também a coluna da tabela que contém a chave 
exclusiva de cada registro — ou seja, a coluna de identificação do registro. No exemplo a 
seguir, a coluna CODE (CÓDIGO) contém informações que identificam cada registro de 
modo exclusivo.

Normalmente, o recordset na página mestra extrai algumas colunas de uma tabela de 
banco de dados, enquanto que o recordset na página detalhes extrai mais colunas da 
mesma tabela para fornecer mais detalhes. 
O recordset pode ser definido em tempo de execução pelo usuário. Para obter mais 
informações, consulte “Criar páginas de busca/resultados (ColdFusion, ASP, JSP, PHP)” 
na página 937.
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3. Insira uma tabela dinâmica para exibir os registros na página. 

Posicione o ponto de inserção no local em que deseja que a tabela dinâmica seja exibida na 
página e selecione Insert (Inserir) > Application Objects (Objetos de aplicativo) > 
Dynamic Data (Dados dinâmicos) > Dynamic Table (Tabela dinâmica).
Será exibida a caixa de diálogo Dynamic Table.

4. Preencha a caixa de diálogo Dynamic Table e clique em OK.

O Dreamweaver inserirá uma tabela dinâmica na página.
Se precisar de ajuda para preencher a caixa de diálogo, clique no botão Help da caixa de 
diálogo.

5. Se desejar, exclua a coluna da tabela dinâmica que contém as identificações de registro.

Se não desejar que as identificações de registro sejam exibidas aos usuários, exclua a coluna 
da tabela dinâmica. Clique em qualquer ponto da página para mover o foco para a página. 
Mova o cursor próximo à parte superior da coluna na tabela dinâmica até que as células da 
coluna sejam exibidas com um contorno vermelho. Em seguida, clique para selecionar a 
coluna. Pressione a tecla Delete para excluir a coluna da tabela. 

A próxima etapa consiste em criar os links para a página de detalhes. 

Criar os links para a página de detalhes (ColdFusion)
Depois de adicionar a tabela dinâmica à página mestra , será necessário criar links que abram a 
página de detalhes. Esta seção descreve como criar esses links. A seção a seguir descreve como 
modificar o link para que ele também repasse a identificação do registro selecionado pelo 
usuário. A página de detalhes usará essa identificação para localizar o registro solicitado no 
banco de dados e exibi-lo.
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Para criar links para a página de detalhes:

1. Na linha repetida da tabela dinâmica, selecione o texto ou imagem que servirá como um 
link.

No exemplo a seguir, o alocador de espaço {rsLocations.LOCATION_NAME} está 
selecionado. Os links serão aplicados aos nomes de local na coluna.

2. No Property inspector (Inspetor de propriedades), clique no ícone da pasta ao lado a caixa 
de texto Link.

3. Procure e selecione a página de detalhes. 

A página de detalhes é exibida na caixa de texto Link, no Property inspector.
Na tabela dinâmica, o texto selecionado é exibido como um link. Quando a página for 
executada no servidor, o link será aplicado ao texto em cada linha da tabela.

A próxima etapa é criar um parâmetro da URL que repasse a identificação do registro para a 
página de detalhes. 

Criar um parâmetro da URL para os links (ColdFusion)
Além de abrir a página de detalhes, os links da tabela dinâmica  também devem repassar a 
identificação do registro selecionado pelo usuário. A página de detalhes utiliza essa 
identificação para localizar o registro solicitado no banco de dados e exibi-lo.

A identificação de registro é repassada para a página de detalhes em um parâmetro da URL. 
Para obter mais informações, consulte “Parâmetros da URL” na página 749.

Esta seção descreve como criar um parâmetro da URL que repasse uma identificação do 
registro para a página de detalhes.

Para criar o parâmetro da URL:

1. Na página mestra, selecione o link na tabela dinâmica.

Se a visualização do Live Data (Dados ativos) estiver ativada, selecione o link na primeira 
linha. 
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2. Na caixa de texto Link no Property inspector (Inspetor de propriedades), adicione a 
seguinte seqüência de caracteres ao final da URL:
?recordID=#recordsetName.fieldName#

O ponto de interrogação informa o servidor de que a seguir haverá um ou mais 
parâmetros da URL. A palavra recordID é o nome do parâmetro da URL (você pode criar 
qualquer nome de sua preferência). Anote o nome do parâmetro da URL, pois ele será 
utilizado mais tarde na página de detalhes.
A expressão após o sinal de igual é o valor do parâmetro. Nesse caso, o valor é gerado por 
uma expressão ColdFusion que retorna uma identificação do registro existente no 
recordset. É gerada uma identificação diferente para cada linha na tabela dinâmica. Na 
expressão ColdFusion, substitua recordsetName pelo nome do recordset e fieldName pelo 
nome do campo no recordset que identifica cada registro de modo exclusivo. Na maioria 
dos casos, o campo consistirá em um número de identificação de registro. No exemplo a 
seguir, o campo consiste em códigos de local exclusivos.
locationDetail.cfm?recordID=#rsLocations.CODE#

Quando a página for executada, os valores do campo CODE (CÓDIGO) do recordset 
serão inseridos nas linhas correspondentes na tabela dinâmica. Por exemplo, se o local de 
locação Canberra, na Austrália, apresentar o código CBR, será utilizada a seguinte URL na 
linha Canberra da tabela dinâmica: 
locationDetail.cfm?recordID=CBR

3. Salve a página.

A próxima etapa é localizar e exibir o registro solicitado na página de detalhes. 

Localizar e exibir o registro solicitado na página de detalhes 
(ColdFusion)
Depois de preencher a página mestra , alterne para a página de detalhes. É necessário localizar 
o registro solicitado no banco de dados e exibi-lo na página. O procedimento consiste em 
definir um recordset para manter um único registro (o registro solicitado pela página mestra) e 
ligar as colunas do recordset à página.

Para localizar e exibir o registro solicitado na página de detalhes:

1. Alterne para a página de detalhes.

Se ainda não existir uma página de detalhes, crie uma página ColdFusion em branco, em 
File (Arquivo) > New (Novo).
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2. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 
de adição (+) e selecione Recordset (Query) [Recordset (Consulta)] no menu pop-up.

Será exibida a caixa de diálogo Recordset simples. Se em vez dela for exibida a caixa de 
diálogo Recordset avançada, clique em Simple (Simples) para alternar para a caixa de 
diálogo Recordset simples.

3. Atribua um nome ao recordset, selecione uma fonte de dados ColdFusion e a tabela de 
banco de dados que fornecerá dados ao recordset.

4. Na área Columns (Colunas), selecione as colunas da tabela a serem incluídas no recordset.

O recordset pode ser idêntico ou diferente do recordset na página mestra. Normalmente, 
um recordset de uma página de detalhes possui mais colunas para exibir mais detalhes. 
Se os recordsets forem diferentes, certifique-se de que o recordset da página de detalhes 
contenha pelo menos uma coluna em comum com o recordset da página mestra. 
Normalmente, a coluna em comum é a coluna de identificação do registro, mas pode ser 
também o campo de junção das tabelas relacionadas. 
Para incluir apenas algumas colunas da tabela no recordset, clique em Selected 
(Selecionado) e selecione as colunas desejadas na lista mantendo a tecla Control (no 
Windows) ou Command (no Macintosh) pressionada enquanto clica. 

5. Preencha a seção Filter (Filtro) para localizar e exibir o registro especificado no parâmetro 
da URL repassado pela página de resultados, do seguinte modo: 

■ No primeiro menu pop-up da área Filter, selecione a coluna do conjunto de dados que 
contém os valores correspondentes ao valor do parâmetro da URL repassado pela 
página mestra. Por exemplo: se o parâmetro da URL contiver um número de 
identificação de registro, selecione a coluna que contém os números de identificação 
de registro. No exemplo analisado na seção anterior, a coluna do recordset chamada 
CODE (CÓDIGO) contém os valores correspondentes ao valor do parâmetro da 
URL repassado pela página mestra.

■ No menu pop-up ao lado do primeiro menu, selecione o sinal de igual (que já deve ter 
sido selecionado). 

■ No terceiro menu pop-up, selecione URL Parameter (Parâmetro da URL).
A página mestra utiliza um parâmetro da URL para repassar informações para a página 
de detalhes.

■ Na quarta caixa de texto, digite o nome do parâmetro da URL repassado pela página 
mestra. Por exemplo, se a URL utilizada pela página mestra para abrir a página de 
detalhes incluir o sufixo locationDetail.cfm?recordID=CBR, digite recordID.
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A caixa de diálogo Recordset deverá ser semelhante à seguinte: 

6. Clique em OK. 

O recordset é exibido no painel Bindings.
7. Ligue as colunas do recordset à página de detalhes, selecionando-as no painel Bindings 

(Window > Bindings) e arrastando-as até a página.

Para obter mais informações, consulte “Tornar dinâmico o texto” na página 783.

Depois de fazer o upload da página mestra e da página de detalhes para o servidor, a página 
mestra poderá ser aberta em um navegador. Após clicar em um link de detalhes na página 
mestra, a página de detalhes será aberta apresentando mais informações sobre o registro 
selecionado.
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Criar páginas de busca/resultados 
(ColdFusion, ASP, JSP, PHP)
O Dreamweaver pode ser utilizado para criar um conjunto de páginas que permitam que os 
usuários efetuem buscas no banco de dados. O método é idêntico ao utilizado para páginas 
ColdFusion, ASP, JSP e PHP. Para obter informações sobre como criar páginas de busca/
resultados ASP.NET, consulte “Criar uma página de busca do banco de dados (ASP.NET)” na 
página 1004.

Criar a página de busca
Normalmente, as páginas de busca na Web contêm campos de formulário, nos quais o usuário 
digitará os parâmetros de busca. A página de busca deve ter pelo menos um formulário 
HTML com um botão Submit (Enviar).

Para adicionar um formulário HTML a uma página de busca: 

1. Abra a página de busca ou uma nova página e selecione Insert (Inserir) > Form 
(Formulário) > Form.

Um formulário vazio é criado na página. Pode ser necessário ativar Invisible Elements 
(Elementos invisíveis), em View (Exibir) > Visual Aids (Auxílios visuais) > Invisible 
Elements, para exibir os limites do formulário, que são representados por linhas 
finas vermelhas.

2. Adicione objetos de formulário para que os usuários possam inserir os parâmetros de busca 
escolhendo Form no menu Insert.

Os objetos de formulário incluem campos de texto, menus de lista, caixas de seleção e 
botões de opção. É possível adicionar tantos objetos de formulário quantos desejar para 
auxiliar os usuários a aprimorar as suas buscas. Contudo, lembre-se de que quanto mais 
parâmetros de busca na página, mais complexa será a instrução SQL.
Para obter mais informações sobre objetos de formulário, consulte “Inserir objetos de 
formulário HTML” na página 892.

3. Adicione ao formulário um botão Submit, a partir de Insert > Form > Button (Botão).

4. Se desejar, altere o identificador do botão Submit da seguinte forma: selecione o botão, abra 
o Property inspector (Inspetor de propriedades), em Window (Janela) > Properties 
(Propriedades), e digite um novo valor na caixa de texto Label (Identificador).

Em seguida, indique ao formulário para onde devem ser enviados os parâmetros de busca 
quando o usuário clicar no botão Submit.
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5. Selecione o formulário escolhendo a tag <form> no seletor de tags, na parte inferior da 
janela do documento, conforme mostrado a seguir:

6. Na caixa de texto Action (Ação), no Property inspector do formulário, digite o nome do 
arquivo da página de resultados que realizará a busca no banco de dados. 

7. No menu pop-up Method (Método), selecione um dos seguintes métodos para determinar 
como o formulário enviará os dados ao servidor: 

■ GET (OBTER) envia os dados do formulário anexando-os à URL como uma seqüência 
de caracteres de consulta. Como as URLs limitam-se a 8192 caracteres, não utilize o 
método GET com formulários longos.

■ POST (TRANSMITIR) envia os dados de formulário no corpo de uma mensagem.
■ Default (Padrão) utiliza o método padrão do navegador (normalmente GET).

A página de busca está pronta. Em seguida, prepare a página de resultados.

Tópicos relacionados
■ “Sobre as páginas de busca/resultados” na página 911

Criar a página de resultados
Quando o usuário clicar no botão Search (Busca) do formulário, os parâmetros de busca serão 
enviados à página de resultados no servidor. A página de resultados no servidor (e não a página 
de busca do navegador) é responsável pela recuperação dos registros do banco de dados.

Tópicos relacionados
■ “Sobre as páginas de busca/resultados” na página 911
■ “Criar a página de busca” na página 937
■ “Criar uma página de detalhes para uma página de resultados” na página 944
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Fazer uma busca com um único parâmetro de busca
Se a página de busca enviar um único parâmetro de busca ao servidor, é possível criar a página 
de resultados sem consultas e variáveis SQL. Crie um recordset básico com um filtro que 
excluirá os registros que não correspondem ao parâmetro de busca enviado pela página de 
busca.

Para criar o recordset que abrigará os resultados da busca: 

1. Abra a página de resultados na janela do documento.

Se ainda não existir uma página de resultados, crie uma página dinâmica em branco, em 
File (Arquivo) > New (Novo).

2. Crie um novo recordset no painel Bindings (Ligações), em Window (Janela) > Bindings, 
clique no botão com sinal de adição (+) e selecione Recordset no menu pop-up.

3. Certifique-se de que a caixa de diálogo Simple Recordset (Recordset simples) seja exibida.

Se no lugar dela for exibida a caixa de diálogo avançada, alterne para a caixa de diálogo 
simples clicando no botão Simple (Simples).

4. Digite um nome para o recordset e selecione uma conexão.

A conexão deve ocorrer com um banco de dados que contenha os dados a serem 
pesquisados pelo usuário.

N
O

T
A

Se houver mais de uma condição de busca, será necessário utilizar a caixa de diálogo 
Advanced Recordset (Recordset avançado) para definir o recordset (consulte “Fazer 
uma busca com diversos parâmetros de busca” na página 941).
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5. No menu pop-up Table (Tabela), selecione a tabela do banco de dados na qual será 
efetuada a busca.

6. Para incluir apenas algumas das colunas da tabela no recordset, clique em Selected 
(Selecionado) e escolha as colunas desejadas clicando na lista e pressionando 
simultaneamente a tecla Control (no Windows) ou Command (no Macintosh).

Devem ser incluídas somente as colunas que contêm as informações que deseja exibir na 
página de resultados.

Mantenha aberta a caixa de diálogo Recordset, por enquanto. Ela será utilizada a seguir para 
recuperar os parâmetros enviados pela página de busca e criar um filtro do recordset, para 
excluir os registros que não corresponderem aos parâmetros.

Para criar o filtro do recordset:

1. No primeiro menu pop-up da área Filter (Filtro), selecione uma coluna na tabela de banco 
de dados em que deseja buscar uma correspondência.

Por exemplo: se o valor enviado pela página de busca for um nome de cidade, selecione a 
coluna na tabela que contiver nomes de cidades.

2. No menu pop-up ao lado do primeiro menu, selecione o sinal de igual (que deve ser 
o padrão). 

3. No terceiro menu pop-up, selecione Form Variable (Variável de formulário), se o 
formulário na página de busca utilizar o método POST (TRANSMITIR), ou o parâmetro da 
URL, se utilizar o método GET (OBTER).

A página de busca utiliza uma variável de formulário ou um parâmetro de URL para 
repassar informações para a página de resultados. 

4. Na quarta caixa de texto, digite o nome do objeto de formulário que aceitará o parâmetro 
de busca na página de busca.

O nome do objeto também funciona como o nome da variável de formulário ou do 
parâmetro de URL. Para obter o nome, alterne para a página de busca, clique no objeto de 
formulário no formulário para selecioná-lo e marque o nome do objeto no 
Property inspector (Inspetor de propriedades).

N
O

T
A

Numa busca com um único parâmetro, é possível efetuar a busca nos registros com 
apenas uma única tabela. Para efetuar uma busca simultânea em mais de uma 
tabela, é necessário utilizar a caixa de diálogo Advanced Recordset e definir uma 
consulta SQL.
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Por exemplo: suponha que você deseja criar um recordset que inclua somente viagens de 
aventuras para um determinado país. Imagine que há uma coluna na tabela denominada 
TRIPLOCATION. Imagine também que um formulário HTML na página de busca utilize o 
método GET e contenha um objeto de menu, denominado Location (Local), que exibe 
uma lista de países. Esta é a aparência que a seção Filter (Filtro) deverá ter:

5. Se desejar, clique em Test (Testar), digite um valor de teste e clique em OK para se conectar 
ao banco de dados e criar uma instância do recordset.

O valor de teste simula o valor que teria sido retornado da página de busca. Clique em OK 
para fechar o recordset de teste.

6. Se estiver satisfeito com o recordset, clique em OK.

O Dreamweaver insere um script do servidor na página que, quando executado no servidor, 
verificará cada registro na tabela do banco de dados. Se o campo especificado em um registro 
corresponder à condição de filtragem, o registro será incluído em um recordset. O script 
válido criará um recordset apenas com os resultados da busca.

A próxima etapa consiste em exibir o recordset na página de resultados. Para obter mais 
informações, consulte “Exibir os resultados” na página 943. 

Fazer uma busca com diversos parâmetros de busca
Se a página de busca enviar mais de um parâmetro de busca ao servidor, será 
necessário escrever uma consulta SQL para a página de resultados e utilizar os parâmetros de 
busca em variáveis SQL. 

Para efetuar uma busca dos registros de um banco de dados utilizando SQL:

1. Abra a página de resultados no Dreamweaver. Em seguida, crie um novo recordset do 
seguinte modo: abra o painel Bindings (Ligações), em Window (Janela) > Bindings, clique 
no botão com sinal de adição (+) e selecione Recordset no menu pop-up.

2. Verifique se a caixa de diálogo Advanced Recordset (Recordset avançado) é exibida.

Se a caixa de diálogo simples for exibida, alterne para a caixa de diálogo simples clicando 
no botão Advanced (Avançado).

N
O

T
A

Se houver apenas uma condição de busca, a caixa de diálogo Simple Recordset 
(Recordset simples) poderá ser utilizada para definir o recordset (consulte “Fazer uma 
busca com um único parâmetro de busca” na página 939).
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3. Digite um nome para o recordset e selecione uma conexão.

A conexão deve ocorrer com um banco de dados que contenha os dados 
a serem pesquisados pelo usuário.

4. Insira uma instrução Select na área de texto SQL.

Verifique se a instrução contém uma cláusula WHERE com variáveis para abrigar os 
parâmetros de busca. No seguinte exemplo, as variáveis são denominadas varLastName e 
varDept:
SELECT EMPLOYEEID, FIRSTNAME, LASTNAME, DEPARTMENT, EXTENSION ¬
FROM EMPLOYEE WHERE LASTNAME LIKE 'varLastName' AND DEPARTMENT ¬
LIKE 'varDept'

Para reduzir o tempo de digitação, é possível utilizar a hierarquia de itens de banco de 
dados na parte inferior da caixa de diálogo Advanced Recordset (Recordset avançado). 
Para obter instruções, consulte “Criar um recordset avançado gravando SQL” na 
página 767.
Para obter ajuda sobre a sintaxe de SQL, consulte Apêndice B, “Manual básico de SQL”, 
na página 1101.

5. Atribua às variáveis SQL os valores dos parâmetros de busca, clicando no botão com o sinal 
de adição (+) na área Variables e digitando o nome da variável, o valor padrão (valor que a 
variável deve assumir, se nenhum valor em tempo de execução for retornado) e o valor de 
tempo de execução (normalmente um objeto de servidor contendo um valor enviado pelo 
navegador como, por exemplo, uma variável de solicitação).

No exemplo em ASP a seguir, o formulário em HTML da página de busca utiliza o 
método  GET (OBTER) e contém um campo de texto denominado “LastName” 
(Sobrenome) e outro denominado “Departamento” (Departamento).

No ColdFusion, os valores em tempo de execução seriam #LastName# e #Department#. 
No JSP, os valores em tempo de execução seriam request.getParameter("LastName") 
e request.getParameter("Department").

6. Se desejar, clique em Test (Testar) para criar uma instância do recordset utilizando os 
valores padrão das variáveis.

Os valores padrão simulam os valores que seriam retornados da página de busca. Clique 
em OK para fechar o recordset de teste.
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7. Se estiver satisfeito com o recordset, clique em OK.

O Dreamweaver inserirá uma consulta SQL na página.

A próxima etapa consiste em exibir o recordset na página de resultados. 

Exibir os resultados
Depois de criar um recordset para conter os resultados da busca, é necessário exibir as 
informações na página de resultados. Para exibir os registros, basta arrastar as colunas do 
painel Bindings (Ligações) até a página de resultados. É possível adicionar links de navegação, 
para mover para frente e para trás no recordset ou criar uma região repetida para exibir mais de 
um registro na página. Também é possível adicionar links a uma página de detalhes.

Esta seção descreve como exibir os resultados utilizando uma tabela dinâmica.

Para exibir os resultados da busca utilizando uma tabela dinâmica:

1. Posicione o ponto de inserção no local em que deseja que a tabela dinâmica seja exibida na 
página de resultados e selecione Insert (Inserir) > Application Objects (Objetos de 
aplicativo) > Dynamic Data (Dados dinâmicos) > Dynamic Table (Tabela dinâmica).

Será exibida a caixa de diálogo Dynamic Table.

2. Preencha a caixa de diálogo Dynamic Table selecionando o recordset escolhido para conter 
os resultados da busca.

Se precisar de ajuda para preencher a caixa de diálogo Dynamic Table, clique no botão 
Help (Ajuda) na caixa de diálogo.

3. Clique em OK.

O Dreamweaver insere uma tabela dinâmica na qual serão exibidos os resultados da busca.

Para obter mais informações sobre outros métodos de exibição do conteúdo dinâmico em uma 
página, consulte Capítulo 35, “Exibir registros de bancos de dados”, na página 793.
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Criar uma página de detalhes para uma página de 
resultados
O conjunto de páginas de busca/resultados pode conter uma página de detalhes, que exibirá 
mais informações sobre determinados registros da página de resultados. Nessa situação, a 
página de resultados funciona também como a página mestra em um conjunto de páginas-
mestras/detalhes. Para obter mais informações, consulte os seguintes tópicos:

■ “Criar páginas-mestras/detalhes (ColdFusion)” na página 928
■ “Criar páginas-mestras/detalhes (ASP e JSP)” na página 1033
■ “Criar páginas-mestras/detalhes (PHP)” na página 1057

Tópicos relacionados
■ “Criar a página de busca” na página 937
■ “Criar a página de resultados” na página 938

Criar uma página de inserção de registros 
(todos os servidores)
O aplicativo pode conter uma página que permite aos usuários inserir novos registros em um 
banco de dados. Por exemplo, a página a seguir insere um novo registro em um banco de 
dados de funcionários: 
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Uma página de inserção consiste em dois blocos de criação:

■ Um formulário HTML que permite aos usuários inserir dados
■ Um comportamento de servidor Insert Record (Inserir registro) que atualiza o banco de 

dados

Os blocos de criação podem ser inseridos em uma única operação utilizando o objeto de 
aplicativo Record Insertion Form (Formulário de inserção de registros) (consulte “Criar a 
página de inserção em uma operação” na página 945) ou adicionados separadamente com as 
ferramentas de formulário e o painel Server Behaviors (Comportamentos de servidor) do 
Dreamweaver (consulte “Criar uma página de inserção bloco a bloco” na página 946). 

Criar a página de inserção em uma operação
Os blocos de criação básicos de uma página de inserção podem ser adicionados por meio de 
uma única operação com o objeto de aplicativo Record Insertion Form (Formulário de 
inserção de registros). Esse objeto de aplicativo adiciona à página um formulário HTML e um 
comportamento de servidor Insert Record (Inserir registro).

Os blocos de criação também podem ser adicionados separadamente por meio das ferramentas 
de formulário e do painel Server Behaviors (Comportamentos de servidor). Para obter mais 
informações, consulte “Criar uma página de inserção bloco a bloco” na página 946.

Após colocar os blocos de criação na página, utilize as ferramentas de projeto do Dreamweaver 
para personalizar o formulário, ou o painel Server Behaviors para editar o comportamento 
Insert Record.

Para criar a página de inserção com o objeto de aplicativo Record Insertion 
Form:

1. Abra a página na visualização do projeto e selecione Insert (Inserir) > Application Objects 
(Objetos de aplicativo) > Insert Record (Inserir registro) > Record Insertion Form Wizard 
(Assistente Formulário de inserção de registros).

Será exibida a caixa de diálogo Insert Record Insertion Form (Inserir formulário de 
inserção de registros).

2. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

N
O

T
A

A página de inserção pode conter apenas um comportamento de servidor de edição de 
registros de cada vez. Por exemplo, não é possível adicionar um comportamento de 
servidor Update Record (Atualizar registro) ou Delete Record (Excluir registro) na 
página de inserção.
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O Dreamweaver adiciona à página um formulário HTML e um comportamento de servidor 
Insert Record. Os objetos de formulário são dispostos em uma tabela básica, que pode ser 
personalizada utilizando as ferramentas de desenvolvimento de projetos de página do 
Dreamweaver (certifique-se de que todos os objetos de formulário estejam dentro dos limites 
do formulário).

Para editar o comportamento de servidor, abra o painel Server Behaviors (Window > Server 
Behaviors) e clique duas vezes no comportamento Insert Record.

Criar uma página de inserção bloco a bloco
Os blocos de criação básicos de uma página de inserção podem ser adicionados separadamente 
utilizando as ferramentas de formulário e o painel Server Behaviors (Comportamentos de 
servidor).

Também é possível adicioná-los simultaneamente utilizando o objeto de aplicativo Record 
Insertion Form (Formulário de inserção de registros). Para obter mais informações, consulte 
“Criar a página de inserção em uma operação” na página 945.

O procedimento de criação da página de inserção consiste em duas etapas:

■ Adição de um formulário HTML à página para que os usuários possam digitar dados
■ Adição do comportamento de servidor Insert Record (Inserir registro) para inserir registros 

em uma tabela de banco de dados

Para adicionar um formulário HTML a uma página de inserção: 

1. Crie uma nova página dinâmica, em File (Arquivo) > New (Novo), e defina o layout 
utilizando as ferramentas de projeto do Dreamweaver.

2. Adicione um formulário HTML colocando o ponto de inserção no local em que deseja que 
o formulário seja exibido e selecione Insert (Inserir) > Form (Formulário) > Form.

Um formulário vazio é criado na página. Pode ser necessário ativar Invisible Elements 
(Elementos invisíveis), em View (Exibir) > Visual Aids (Auxílios visuais) > Invisible 
Elements, para exibir os limites do formulário, que são representados por linhas finas 
vermelhas.

3. Atribua um nome ao formulário HTML clicando na tag <form> na parte inferior da janela 
do documento para selecionar o formulário. Em seguida, abra o Property inspector 
(Inspetor de propriedades), em Window (Janela) > Properties (Propriedades), e digite um 
nome na caixa de texto Form Name (Nome do formulário).
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Não é necessário especificar um atributo action (ação) ou method (método) para o 
formulário, para informá-lo para onde e como serão enviados os dados do registro quando 
o usuário clicar no botão Submit (Enviar). O comportamento de servidor Insert Record 
(Inserir registro) define esses atributos para o usuário.

4. Adicione um objeto de formulário, como um campo de texto, em Insert > Form > Text 
Field (Campo de texto), para cada coluna da tabela de banco de dados em que você deseja 
inserir registros.

Os objetos de formulário destinam-se à entrada de dados. Os campos de texto servem 
comumente a esse objetivo, mas também é possível usar menus, caixas de seleção e botões 
de opção. 
Para obter mais informações sobre objetos de formulário, consulte “Inserir objetos de 
formulário HTML” na página 892. 

5. Adicione ao formulário um botão Submit, a partir de Insert > Form > Button (Botão).

O identificador do botão Submit pode ser alterado do seguinte modo: selecione o botão, 
abra o Property inspector, em Window > Properties, e digite um novo valor na caixa de 
texto Label (Identificador).

Para adicionar um comportamento de servidor que insira registros em uma 
tabela de banco de dados: 

1. No painel Server Behaviors (Comportamentos de servidor), em Window (Janela) > Server 
Behaviors, clique no botão com sinal de adição (+) e selecione Insert Record no menu pop-
up.

Será exibida a caixa de diálogo Insert Record.
2. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

O Dreamweaver adiciona à página um comportamento de servidor que permite aos usuários 
inserir registros em uma tabela de banco de dados clicando no botão Submit.

Para editar o comportamento de servidor, abra o painel Server Behaviors (Window > Server 
Behaviors) e clique duas vezes no comportamento Insert Record.
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Criar páginas para atualizar um registro 
(ColdFusion)
O aplicativo pode conter um conjunto de páginas em que os usuários poderão atualizar os 
registros existentes em uma tabela de banco de dados. Geralmente as páginas consistem em 
uma página de busca, uma página de resultados e uma página de atualização. A página de 
busca e a página de resultados permitem recuperar o registro e a página de atualização permite 
modificá-lo.

Esta seção descreve as etapas para criar páginas de atualização de um registro:

■ “Procurar o registro a ser atualizado (ColdFusion)” na página 948
■ “Criar links para abrir a página de atualização (ColdFusion)” na página 949
■ “Criar um parâmetro da URL para links de atualização (ColdFusion)” na página 949
■ “Recuperar o registro a ser atualizado (ColdFusion)” na página 950
■ “Preencher a página de atualização em uma operação (ColdFusion)” na página 951
■ “Preencher a página de atualização bloco a bloco (ColdFusion)” na página 953

Tópicos relacionados
■ “Criar páginas-mestras/detalhes (ColdFusion)” na página 928
■ “Criar uma página de inserção de registros (todos os servidores)” na página 944
■ “Criar páginas para excluir um registro (ColdFusion)” na página 955

Procurar o registro a ser atualizado (ColdFusion)
Quando os usuários desejam atualizar um registro, é necessário localizá-lo primeiro no banco 
de dados. Da mesma forma, são necessárias as páginas de busca e de resultados para 
funcionarem com a página de atualização. Os critérios de busca são digitados na página de 
busca e o registro é selecionado na página de resultados. Quando o usuário clica no registro, a 
página de atualização é aberta e exibe o registro em um formulário HTML.

Para obter instruções sobre a criação de páginas de busca do registro a ser atualizado, consulte 
“Criar páginas de busca/resultados (ColdFusion, ASP, JSP, PHP)” na página 937.

Após criar as páginas de busca/resultados, a próxima etapa é criar links na página de resultados 
que, ao serem clicados, abrem a página de atualização. 
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Criar links para abrir a página de atualização 
(ColdFusion)
Após criar as páginas de busca/resultados , é necessário criar links na página de resultados para 
abrir a página de atualização e exibir o registro selecionado em um formulário HTML. Esta 
seção descreve como criar esses links. A seção a seguir descreve como modificar o link de 
modo que ele também repasse a identificação do registro selecionado pelo usuário. A página 
de atualização utilizará essa identificação para localizar o registro solicitado no banco de dados 
e exibi-lo.

Para criar os links para a página de atualização:

1. Na página de resultados, selecione o texto repetido ou o alocador de espaço do conteúdo 
dinâmico que você deseja exibir como link.

No exemplo a seguir, o alocador de espaço {rsLocations.LOCATION_NAME} está 
selecionado. Os links serão aplicados aos nomes de local na coluna.

2. No Property inspector (Inspetor de propriedades), clique no ícone da pasta ao lado a caixa 
de texto Link.

3. Procure e selecione a página de atualização.

O nome de arquivo da página de atualização é exibido na caixa de texto Link.
Na página de resultados, o alocador de espaço do conteúdo dinâmico é exibido como um 
link. Se fizer o upload das páginas no servidor e executar uma busca, você verá que o link é 
aplicado a todos os registros apresentados na página de resultados.

A próxima etapa é criar um parâmetro da URL para repassar a identificação do registro 
selecionado pelo usuário. 

Criar um parâmetro da URL para links de atualização 
(ColdFusion)
Além de abrir a página de atualização, os links da página de resultados  também devem 
repassar a identificação do registro selecionado pelo usuário. A página de atualização utilizará 
essa identificação para localizar o registro solicitado no banco de dados e exibi-lo.
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A identificação do registro é repassada para a página de atualização em um parâmetro da URL. 
Para obter mais informações, consulte “Parâmetros da URL” na página 749.

Esta seção descreve como criar um parâmetro da URL que repasse uma identificação do 
registro para a página de atualização.

Para criar o parâmetro da URL:

1. Selecione o link na página de resultados.

2. Na caixa de texto Link no Property inspector (Inspetor de propriedades), adicione a 
seguinte seqüência de caracteres ao final da URL:
?recordID=#recordsetName.fieldName#

O ponto de interrogação informa o servidor de que a seguir haverá um ou mais 
parâmetros da URL. A palavra recordID é o nome do parâmetro da URL (você pode criar 
qualquer nome de sua preferência). Anote o nome do parâmetro da URL, pois ele será 
utilizado na página de atualização posteriormente. 
A expressão após o sinal de igual é o valor do parâmetro. Nesse caso, o valor é gerado por 
uma expressão ColdFusion que retorna uma identificação do registro existente no 
recordset. É gerada uma identificação diferente para cada linha na tabela dinâmica. Na 
expressão ColdFusion, substitua recordsetName pelo nome do recordset e fieldName 
pelo nome do campo no recordset que identifica cada registro de modo exclusivo. Na 
maioria dos casos, o campo consistirá em um número de identificação de registro. No 
exemplo a seguir, o campo consiste em códigos de local exclusivos. 
locationDetail.cfm?recordID=#rsLocations.CODE#

Quando a página for executada, os valores do campo CODE (CÓDIGO) do recordset 
serão inseridos nas linhas correspondentes na tabela dinâmica. Por exemplo, se o local de 
locação Canberra, na Austrália, apresentar o código CBR, será utilizada a seguinte URL na 
linha Canberra da tabela dinâmica: 
locationDetail.cfm?recordID=CBR

3. Salve a página.

A próxima etapa é modificar a página de atualização para que ela possa localizar o registro 
solicitado no banco de dados e exibi-lo. 

Recuperar o registro a ser atualizado (ColdFusion)
Após a página de resultados repassar para a página de atualização um parâmetro da URL que 
identifica o registro a ser atualizado , a página de atualização deverá ler o parâmetro, recuperar 
o registro a partir da tabela do banco de dados e armazená-lo temporariamente em um 
recordset.
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Para recuperar um registro a ser atualizado: 

1. Crie uma nova página ColdFusion no Dreamweaver e salve-a.

Essa página será a página de atualização.
2. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 

de adição (+) e selecione Recordset.

Se a caixa de diálogo avançada for exibida, clique no botão Simple (Simples) para abrir a 
caixa de diálogo simples.

3. Atribua um nome ao recordset e especifique o local onde estão os dados a serem atualizados 
utilizando os menus pop-up Connection (Conexão) e Table (Tabela).

4. Clique na opção Selected (Selecionado) e escolha uma coluna de chave (em geral, a coluna 
de identificação de registro) e as colunas que contêm os dados a serem atualizados.

5. Configure a área Filter (Filtro) para que o valor da coluna de chave seja igual ao valor do 
parâmetro da URL correspondente repassado pela página de resultados.

Este tipo de filtro cria um recordset que contém apenas o registro especificado pela página 
de resultados. Por exemplo: se a coluna-chave contiver informações de identificação de 
registro e for chamada PRID e se a página de resultados repassar as informações de 
identificação de registro correspondentes no parâmetro da URL id, a área Filter terá a 
seguinte aparência:

6. Clique em OK.

Quando o usuário seleciona um registro na página de resultados, a página de atualização 
produzirá um recordset contendo apenas o registro selecionado. 

Preencher a página de atualização em uma operação 
(ColdFusion)
Uma página de atualização é composta por três blocos de criação:

■ Um recordset filtrado para recuperar o registro a partir de uma tabela de banco de dados 
(consulte “Recuperar o registro a ser atualizado (ColdFusion)” na página 950).

■ Um formulário HTML que permite aos usuários modificar os dados do registro
■ Um comportamento de servidor Update Record (Atualizar registro) para atualizar a tabela 

de banco de dados.
Criar páginas para atualizar um registro (ColdFusion) 951



         
Os dois blocos de criação finais de uma página de atualização podem ser adicionados em uma 
única operação utilizando o objeto de aplicativo Record Update Form (Formulário de 
atualização de registros). O objeto de aplicativo adiciona à página um formulário HTML e 
um comportamento de servidor Update Record. 

Para que o objeto de aplicativo possa ser utilizado, o aplicativo para a Web deve identificar o 
registro a ser atualizado e a página de atualização deve ser capaz de recuperá-lo. Consulte 
“Procurar o registro a ser atualizado (ColdFusion)” na página 948, “Criar links para abrir a 
página de atualização (ColdFusion)” na página 949, “Criar um parâmetro da URL para links 
de atualização (ColdFusion)” na página 949 e “Recuperar o registro a ser atualizado 
(ColdFusion)” na página 950.

Após o objeto de aplicativo colocar os blocos de criação na página, utilize as ferramentas de 
projeto do Dreamweaver para personalizar o formulário de acordo com suas preferências ou o 
painel Server Behaviors para editar o comportamento de servidor Update Record.

Para criar a página de atualização com o objeto de aplicativo Record Update 
Form:

1. Abra a página na visualização do projeto e selecione Insert (Inserir) > Application Objects 
(Objetos de aplicativo) > Update Record (Atualizar registro) > Record Update Form 
Wizard (Assistente Formulário de atualização de registros).

Será exibida a caixa de diálogo Record Update Form (Formulário de atualização de 
registros).

2. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

O objeto de aplicativo adiciona à página um formulário HTML e um comportamento de 
servidor Update Record. Os objetos de formulário são dispostos em uma tabela básica, que 
pode ser personalizada utilizando as ferramentas de desenvolvimento de projetos de página do 
Dreamweaver (certifique-se de que todos os objetos de formulário estejam dentro dos 
limites do formulário).

Para editar o comportamento de servidor, abra o painel Server Behaviors, em Window > 
Server Behaviors, e clique duas vezes no comportamento Update Record.

N
O

T
A

A página de atualização pode conter apenas um comportamento de servidor de edição 
de registros de cada vez. Por exemplo, não é possível adicionar um comportamento de 
servidor Insert Record ou Delete Record à página de atualização.
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Preencher a página de atualização bloco a bloco 
(ColdFusion)
Uma página de atualização é composta por três blocos de criação:

■ Um recordset filtrado para recuperar o registro a partir de uma tabela de banco de dados 
(consulte “Recuperar o registro a ser atualizado (ColdFusion)” na página 950).

■ Um formulário HTML que permite aos usuários modificar os dados do registro
■ Um comportamento de servidor Update Record (Atualizar registro) para atualizar a tabela 

de banco de dados.

Os dois blocos de criação básicos finais de uma página de atualização podem ser adicionados 
separadamente utilizando as ferramentas de formulário e o painel Server Behaviors 
(Comportamentos de servidor).

Antes de adicionar os blocos, o aplicativo da Web deve identificar o registro a ser atualizado e 
a página de atualização deve ser capaz de recuperá-lo. Consulte “Procurar o registro a ser 
atualizado (ColdFusion)” na página 948, “Criar links para abrir a página de atualização 
(ColdFusion)” na página 949, “Criar um parâmetro da URL para links de atualização 
(ColdFusion)” na página 949 e “Recuperar o registro a ser atualizado (ColdFusion)” na 
página 950.

O preenchimento da página de atualização consiste em três etapas:

■ Adicionar um formulário HTML à página para que os usuários possam modificar os 
dados

■ Exibir o registro no formulário ligando os objetos do formulário a colunas da tabela de 
banco de dados

■ Adicionar o comportamento de servidor Update Record para atualizar a tabela de banco 
de dados depois que o usuário modificar o registro

Para adicionar um formulário HTML a uma página de atualização: 

1. Crie uma nova página ColdFusion, em File (Arquivo) > New (Novo).

2. Crie o layout da página com as ferramentas de projeto do Dreamweaver.

3. Adicione um formulário HTML posicionando o ponto de inserção no local em que deseja 
que o formulário seja exibido e selecione Insert (Inserir) > Form (Formulário) > Form.

Um formulário vazio é criado na página. Pode ser necessário ativar Invisible Elements 
(Elementos invisíveis), em View (Exibir) > Visual Aids (Auxílios visuais) > Invisible 
Elements, para exibir os limites do formulário, que são representados por linhas finas 
vermelhas.
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4. Atribua um nome ao formulário HTML clicando na tag <form> na parte inferior da janela 
do documento para selecionar o formulário. Em seguida, abra o Property inspector 
(Inspetor de propriedades), em Window (Janela) > Properties (Propriedades), e digite um 
nome na caixa de texto Form Name (Nome do formulário).

Não é necessário especificar um atributo action (ação) ou method (método) para o 
formulário, para informá-lo para onde e como serão enviados os dados do registro quando 
o usuário clicar no botão Submit (Enviar). O comportamento de servidor Update Record 
define esses atributos para o usuário.

5. Adicione um objeto de formulário, como um campo de texto, em Insert > Form > Text 
Field, para cada coluna que deseja atualizar na tabela de banco de dados.

Os objetos de formulário destinam-se à entrada de dados. Os campos de texto servem 
comumente a esse objetivo, mas também é possível usar menus, caixas de seleção e botões 
de opção. 
A cada objeto de formulário deve corresponder uma coluna no recordset definido 
anteriormente. A única exceção é a coluna de chave exclusiva, à qual não deve 
corresponder nenhum objeto de formulário.
Para obter mais informações sobre objetos de formulário, consulte “Inserir objetos de 
formulário HTML” na página 892.

6. Adicione ao formulário um botão Submit, a partir de Insert > Form > Button (Botão).

O identificador do botão Submit pode ser alterado do seguinte modo: selecione o botão, 
abra o Property inspector, em Window > Properties, e digite um novo valor na caixa de 
texto Label (Identificador).

Para exibir o registro no formulário:

1. Certifique-se de ter definido um recordset para conter o registro que o usuário deseja 
atualizar.

Para obter mais informações, consulte “Recuperar o registro a ser atualizado 
(ColdFusion)” na página 950.

2. Ligue cada objeto do formulário aos dados do recordset, conforme descrito nas seções a 
seguir:

■ “Exibir conteúdo dinâmico em campos de texto HTML” na página 900
■ “Pré-selecionar dinamicamente caixas de seleção HTML” na página 900
■ “Pré-selecionar dinamicamente botões de opção HTML” na página 901
■ “Criar um menu de formulário HTML dinâmico” na página 898
■ “Tornar dinâmicos menus de formulário HTML existentes” na página 899
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Para adicionar um comportamento de servidor a fim de atualizar a tabela do 
banco de dados: 

1. No painel Server Behaviors, em Window > Server Behaviors, clique no botão com sinal de 
adição (+) e selecione Update Record no menu pop-up.

Será exibida a caixa de diálogo Update Record.
2. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

O Dreamweaver adiciona à página um comportamento de servidor que permite aos usuários 
atualizar registros em um banco de dados clicando no botão Submit no formulário.

Para editar o comportamento de servidor, abra o painel Server Behaviors, em Window > 
Server Behaviors, e clique duas vezes no comportamento Update Record.

Tópicos relacionados
■ “Preencher a página de atualização em uma operação (ColdFusion)” na página 951

Criar páginas para excluir um registro 
(ColdFusion)
O aplicativo pode conter um conjunto de páginas que permite que os usuários excluam 
registros de um banco de dados. As páginas normalmente consistem em uma página de busca, 
uma página de resultados e uma página de exclusão. A página de busca e a página de 
resultados permitem recuperar o registro e a página de exclusão permite excluí-lo.

Esta seção descreve as seguintes etapas da criação de páginas ColdFusion para excluir registros:

■ “Procurar o registro a ser excluído (ColdFusion)” na página 956
■ “Criar links para uma página de confirmação (ColdFusion)” na página 956
■ “Criar um parâmetro da URL a ser repassado para a página de confirmação (ColdFusion)” 

na página 958
■ “Exibir o registro na página de confirmação (ColdFusion)” na página 959
■ “Adicionar lógica para excluir o registro (ColdFusion)” na página 963
Criar páginas para excluir um registro (ColdFusion) 955



         
Procurar o registro a ser excluído (ColdFusion)
Quando os usuários planejam excluir um registro, é necessário localizá-lo primeiro no banco 
de dados. Da mesma forma, são necessárias as páginas de busca e de resultados para 
funcionarem com a página de exclusão. Os critérios de busca são digitados na página de busca 
e o registro é selecionado na página de resultados. Quando o usuário clica no registro, a página 
de exclusão é aberta e exibe o registro em um formulário HTML.

Para obter instruções sobre a criação de páginas de busca do registro a ser excluído, consulte 
“Criar páginas de busca/resultados (ColdFusion, ASP, JSP, PHP)” na página 937. 

Após criar as páginas de busca/resultados, a próxima etapa é criar links na página de resultados 
para permitir que os usuários selecionem um registro a ser excluído e exibam uma página de 
confirmação. 

Criar links para uma página de confirmação 
(ColdFusion)
Após criar a página de resultados , é necessário criar links nos quais o usuário possa clicar para 
confirmar a exclusão do registro associado do banco de dados. Esta seção descreve como criar 
esses links. A seção a seguir descreve como modificar o link de modo que ele também repasse a 
identificação do registro que o usuário deseja excluir. A página de confirmação utiliza essa 
identificação para localizar e exibir o registro.

Para criar links para uma página de confirmação:

1. Na página de resultados, crie uma nova coluna na tabela utilizada para exibir registros 
clicando na última coluna da tabela e selecionando Modify (Modificar) > Table (Tabela) > 
Insert Rows or Columns (Inserir linhas ou colunas). 

 Será exibida a caixa de diálogo Insert Rows or Columns.
2. Selecione a opção Columns (Colunas) e After Current Column (Depois da coluna atual). 

Em seguida, clique em OK. 

O Dreamweaver adiciona uma coluna à tabela. 
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3. Na coluna recém-criada da tabela, digite a seqüência de caracteres Delete (Excluir) na 
linha que contém os alocadores de espaço do conteúdo dinâmico. Certifique-se de digitar 
a seqüência de caracteres dentro da região repetida com guias.

Também é possível inserir uma imagem com uma palavra ou símbolo para exclusão.
Se a visualização do Live Data (Dados ativos) estiver ativada, digite a seqüência de 
caracteres na primeira linha de registros e clique no ícone Refresh (Atualizar).

4. Selecione a seqüência de caracteres Delete para aplicar um link a ela.

 Se a visualização do Live Data estiver ativada, selecione a seqüência de caracteres na 
primeira linha de registros. 

5. No Property inspector (Inspetor de propriedades), digite a página de confirmação na caixa 
de texto Link. 

É possível digitar qualquer nome de arquivo desejado.

Depois que você clicar fora da caixa de texto Link, a seqüência de caracteres Delete será 
exibida na tabela como um link. Se a visualização do Live Data for ativada, em View (Exibir) 
> Live Data, você poderá ver que o link foi aplicado ao mesmo texto em todas as linhas da 
tabela. Se a visualização do Live Data já estiver ativada, clique no ícone Refresh para aplicar os 
links a cada linha. 

Após criar os links, a próxima etapa é criar parâmetros da URL para os links. 
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Criar um parâmetro da URL a ser repassado para a 
página de confirmação (ColdFusion)
Além de abrir a página de confirmação, os links da página de resultados também devem 
repassar a identificação do registro a ser excluído. A página de confirmação utilizará essa 
identificação para localizar o registro no banco de dados e exibi-lo.

É necessário repassar a identificação do registro para a página de confirmação com um 
parâmetro da URL. Esta seção descreve como criar um parâmetro da URL para repassar a 
identificação do registro para a página de confirmação.

Para criar o parâmetro da URL:

1. Selecione o link Delete (Excluir) na página de resultados.

Se a visualização do Live Data (Dados ativos) estiver ativada, selecione o link na primeira 
linha.

2. Na caixa de texto Link no Property inspector (Inspetor de propriedades), adicione a 
seguinte seqüência de caracteres ao final da URL:
?recordID=#recordsetName.fieldName#

O ponto de interrogação informa o servidor de que a seguir haverá um ou mais 
parâmetros da URL. A palavra recordID é o nome do parâmetro da URL (você pode criar 
qualquer nome de sua preferência). Anote o nome do parâmetro da URL, pois ele será 
utilizado mais tarde na página de confirmação.
A expressão após o sinal de igual é o valor do parâmetro. Nesse caso, o valor é gerado por 
uma expressão ColdFusion que retorna uma identificação do registro existente no 
recordset. É gerada uma identificação diferente para cada linha na tabela dinâmica. Na 
expressão ColdFusion, substitua recordsetName pelo nome do recordset e fieldName 
pelo nome do campo no recordset que identifica cada registro de modo exclusivo. Na 
maioria dos casos, o campo consistirá em um número de identificação de registro. No 
exemplo a seguir, o campo consiste em códigos de local exclusivos: 
confirmDelete.cfm?recordID=#rsLocations.CODE#

Quando a página for executada, os valores do campo CODE (CÓDIGO) do recordset 
serão inseridos nas linhas correspondentes na tabela dinâmica. Por exemplo, se o local de 
locação Canberra, na Austrália, apresentar o código CBR, será utilizada a seguinte URL na 
linha Canberra da tabela dinâmica: 
confirmDelete.cfm?recordID=CBR

3. Salve a página. 

Após criar um parâmetro dinâmico da URL para os links Delete (Excluir), a próxima etapa é 
exibir o registro na página de confirmação. 
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Exibir o registro na página de confirmação 
(ColdFusion)
Após completar a página que contém os registros , alterne para a página de confirmação. A 
página de confirmação mostra o registro e solicita que o usuário confirme se deseja excluí-lo. 
Quando o usuário confirmar a operação clicando no botão Form (Formulário), o aplicativo 
para a Web excluirá o registro do banco de dados.

Criar essa página consiste em criar um formulário HTML, recuperar o registro a ser exibido 
no formulário, exibir o registro no formulário e adicionar a lógica para exclusão do registro do 
banco de dados. A recuperação e exibição do registro consiste em definir um recordset para 
conter um único registro (aquele a ser excluído) e ligar as colunas do recordset ao formulário. 
As etapas estão descritas a seguir, com mais detalhes.

Para criar um formulário HTML para exibir o registro:

1. Crie uma nova página ColdFusion e salve-a como a página de confirmação especificada na 
seção anterior.

A página de confirmação foi especificada quando você criou o link Delete (Excluir) na 
seção anterior. Utilize este nome ao salvar o arquivo pela primeira vez (por exemplo, 
deleteConfirm.cfm).

2. Insira um formulário HTML na página, em Insert (Inserir) > Form (Formulário) > Form.

3. Adicione ao formulário um campo oculto.

O campo oculto do formulário é necessário para armazenar a identificação do registro 
repassada pelo parâmetro da URL. Para adicionar um campo oculto, posicione o ponto de 
inserção no formulário e selecione Insert > Form > Hidden Field (Campo oculto).

4. Adicione um botão ao formulário.

O usuário deve clicar no botão para confirmar e excluir o registro exibido. Para adicionar 
um botão, posicione o ponto de inserção no formulário e selecione Insert > Form > 
Button (Botão).

5. Aperfeiçoe o projeto da página como desejar e salve-a.

Para recuperar o registro que o usuário deseja excluir:

1. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 
de adição (+) e selecione Recordset (Query) [Recordset (Consulta)] no menu pop-up.

Será exibida a caixa de diálogo Recordset simples. Se em vez dela for exibida a caixa de 
diálogo Recordset avançada, clique em Simple (Simples) para alternar para a caixa de 
diálogo Recordset simples. 
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2. Atribua um nome ao recordset, selecione uma fonte de dados ColdFusion e a tabela de 
banco de dados que contém os registros que os usuários podem excluir.

3. Na área Columns (Colunas), selecione as colunas da tabela (campos de registro) que deseja 
exibir na página.

Para exibir apenas alguns dos campos do registro, clique em Selected (Selecionado), 
escolha os campos desejados pressionando a tecla Control (Windows) ou Command 
(Macintosh) enquanto clica em cada um deles na lista.
Certifique-se de incluir o campo de identificação do registro, mesmo que não pretenda 
exibi-lo.

4. Preencha a seção Filter (Filtro) para localizar e exibir o registro especificado no parâmetro 
da URL, repassado pela página de resultados, do seguinte modo:

■ No primeiro menu pop-up da área Filter, selecione a coluna do conjunto de dados que 
contém os valores correspondentes ao valor do parâmetro da URL repassado pela 
página com os links Delete. Por exemplo: se o parâmetro da URL contiver um número 
de identificação de registro, selecione a coluna que contém os números de 
identificação de registro. No exemplo analisado na seção anterior, a coluna do 
recordset chamada CODE (CÓDIGO) contém os valores correspondentes ao valor do 
parâmetro da URL repassado pela página com os links Delete.

■ No menu pop-up ao lado do primeiro menu, selecione o sinal de igual, se ainda não 
tiver sido selecionado.

■ No terceiro menu pop-up, selecione URL Parameter (Parâmetro da URL). A página 
com os links Delete utiliza um parâmetro da URL para repassar informações à página 
de confirmação.

■ Na quarta caixa de texto, digite o nome do parâmetro da URL repassado pela página 
mestra com os links Delete. 
Por exemplo, se a URL utilizada para abrir a página de confirmação incluir o sufixo 
confirmDelete.cfm?recordID=CBR, digite recordID.
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A caixa de diálogo Recordset deverá ter a seguinte aparência:

5. Clique em OK.

O recordset é exibido no painel Bindings. 

Para exibir o registro que o usuário deseja excluir:

1. Selecione as colunas do recordset no painel Bindings e arraste-as até a página de 
confirmação.

Insira esse conteúdo dinâmico somente de leitura dentro dos limites do formulário. Para 
obter mais informações sobre como inserir conteúdo dinâmico em uma página, consulte 
“Tornar dinâmico o texto” na página 783.
Em seguida, ligue a coluna de identificação do registro ao campo oculto do formulário.

2. Certifique-se de que a opção Invisible Elements (Elementos invisíveis) esteja ativada em 
View (Exibir) > Visual Aids (Auxílios visuais) > Invisible Elements. Em seguida, clique no 
ícone amarelo em forma de escudo (que representa o campo oculto do formulário).

O campo oculto do formulário será selecionado.
3. No Property inspector (Inspetor de propriedades), clique no ícone em forma de raio ao lado 

a caixa de texto Value (Valor).

Será exibida a caixa de diálogo Dynamic Data (Dados dinâmicos).
4. Na caixa de diálogo Dynamic Data, selecione a coluna de identificação do registro no 

recordset.
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 No exemplo a seguir, a coluna de identificação de registro selecionada é CODE.

5. Clique em OK e salve a página.

A página de confirmação preenchida deverá ser semelhante à apresentada a seguir.

Após a exibição do registro na página de confirmação, a próxima etapa consiste em adicionar a 
lógica para exclusão do registro. 
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Adicionar lógica para excluir o registro (ColdFusion)
Após exibir o registro selecionado na página de confirmação ), você deve adicionar lógica à 
página para excluir o registro do banco de dados quando o usuário clicar no botão Confirm 
Deletion (Confirmar exclusão). No Dreamweaver, é possível adicionar esta lógica de modo 
rápido e fácil utilizando o comportamento de servidor Delete Record (Excluir registro).

Para adicionar lógica para exclusão do registro exibido no formulário HTML:

1. Verifique se a página de confirmação está aberta no Dreamweaver.

2. No painel Server Behaviors (Comportamentos de servidor), em Window (Janela) > Server 
Behaviors, clique no botão com sinal de adição (+) e selecione Delete Record.

A caixa de diálogo Delete Record é exibida.

3. Na caixa de texto First Check If Variable Is Defined (Primeiramente, verificar se a variável 
está definida), selecione a opção Primary Key Value (Valor da chave primária). 

Especifique o valor da chave primária posteriormente na caixa de diálogo. 
4. No menu pop-up Connection (Conexão), selecione uma conexão com o banco de dados, 

para que o comportamento de servidor possa conectar-se ao banco de dados em questão.

5. No menu pop-up Table (Tabela), selecione a tabela de banco de dados que contém os 
registros a serem excluídos.

6. No menu pop-up Primary Key Column (Coluna de chave primária), selecione a coluna da 
tabela que contém as identificações do registro.

O comportamento de servidor Delete Record buscará uma correspondência nesta coluna. 
A coluna deve conter os mesmos dados de identificação do registro que a coluna do 
recordset ligada ao campo oculto do formulário na página.
Se a identificação do registro for numérica, selecione a opção Numeric (Numérico).
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7. No menu pop-up Primary Key, selecione a variável da página que contém a identificação 
do registro a ser excluído.

A variável é criada pelo campo oculto do formulário. Ela tem o mesmo nome que o 
atributo name (nome) do campo oculto e pode ser um parâmetro de URL ou de 
formulário, dependendo do atributo method (método) do formulário. Em nosso exemplo, 
a variável em questão é uma variável de formulário chamada hiddenRecID.

8. Na caixa de texto After Deleting, Go To (Após a exclusão, ir para), especifique a página a 
ser aberta depois que o registro for excluído da tabela do banco de dados.

É possível especificar uma página que contenha uma breve mensagem de êxito para o 
usuário ou uma que contenha os registros restantes, para que o usuário possa verificar se o 
registro foi excluído.
A caixa de diálogo Delete Record preenchida deverá ter a aparência a seguir.

9. Clique em OK e salve o trabalho.

Faça o upload das páginas para o servidor da Web, abra um navegador e procure um registro a 
ser excluído. Ao clicar em um link Delete (Excluir) na página de resultados, será exibida a 
página de confirmação. Clique no botão Confirm para excluir o registro do banco de dados. 
Para verificar se o registro foi excluído, abra novamente a página com os links Delete. O 
registro não deverá mais ser exibido na lista.

N
O

T
A

Clique em Refresh (Atualizar) se o registro continuar sendo exibido na página.
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Utilizar os procedimentos armazenados 
para modificar bancos de dados 
(ColdFusion)
É possível utilizar um procedimento armazenado para modificar um banco de dados. Um 
procedimento armazenado é um item de banco de dados reutilizável que executa algumas 
operações no banco de dados. 

Antes de utilizar um procedimento armazenado para modificar um banco de dados, 
certifique-se de que o procedimento armazenado contenha o SQL que modifica o banco de 
dados de algum modo. Para criar e armazenar o SQL em seu banco de dados, consulte a 
documentação do banco de dados e um bom manual sobre Transact-SQL.

Para adicionar um procedimento armazenado a uma página do ColdFusion:

1. No Dreamweaver, abra a página onde o procedimento armazenado será executado.

2. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com o 
sinal de adição (+) e selecione Stored Procedure (Procedimento armazenado).

Será exibida a caixa de diálogo Stored Procedure.

N
O

T
A

Os bancos de dados mySQL e Microsoft Access não oferecem suporte para 
procedimentos armazenados. 
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3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

Após fechar a caixa de diálogo Stored Procedure, o Dreamweaver insere o código ColdFusion 
na página de modo que, ao ser executado no servidor, ele chamará um procedimento 
armazenado no banco de dados. O procedimento armazenado, por sua vez, executa uma 
operação de banco de dados, como inserir um registro.

Se o procedimento armazenado exigir parâmetros, é possível criar uma página para reunir os 
valores de parâmetros e os submeter em seguida à página com o procedimento armazenado. 
Por exemplo: é possível criar uma página que utiliza parâmetros da URL ou formulário 
HTML para coletar valores de parâmetro de usuários.

Tópicos relacionados
■ “Procedimentos armazenados” na página 913

Criar páginas que restrinjam o acesso ao 
site (ColdFusion, ASP, JSP, PHP)
O Dreamweaver pode ser utilizado para criar os seguintes tipos de páginas, que restringem o 
acesso a um site:

■ Páginas que requerem o registro dos usuários ao visitarem o site pela primeira vez (consulte 
“Criar uma página de registro” na página 967)

■ Páginas que permitem aos usuários registrados conectar-se ao site (consulte “Criar uma 
página de acesso (login)” na página 971)

■ Páginas que podem ser visualizadas apenas por usuários autorizados (consulte “Criar uma 
página que apenas os usuários autorizados podem acessar” na página 974)

O método é idêntico ao utilizado para páginas ColdFusion, ASP, JSP e PHP. Ele não possui 
comportamentos de servidor de autenticação para páginas ASP.NET.

Tópicos relacionados
■ “Proteger uma pasta em em seu aplicativo (ColdFusion)” na página 977
966 Capítulo 40:  Criar aplicativos ColdFusion rapidamente



         
Criar uma página de registro
O aplicativo da Web pode conter uma página que solicita o registro dos usuários na primeira 
vez que eles visitam o site.

A página a seguir, por exemplo, solicita o registro dos usuários que visitam o site pela primeira 
vez. 

Uma página de registro é composta dos seguintes blocos de criação:

■ Uma tabela de banco de dados para armazenar as informações de login dos usuários 
(consulte “Armazenar as informações de acesso dos usuários (login)” na página 968)

■ Um formulário HTML em que os usuários podem selecionar um nome de usuário e uma 
senha (consulte “Permitir que os usuários escolham um nome e uma senha” na 
página 968)
O formulário também pode ser utilizado para obter informações pessoais dos usuários.

■ Um comportamento de servidor Insert Record (Inserir registro) para atualizar a tabela de 
banco de dados dos usuários do site (consulte “Atualizar a tabela de usuários no banco de 
dados” na página 969)

■ Um comportamento de servidor Check New Username (Verificar novo nome de usuário) 
para garantir que o nome digitado pelo usuário não seja utilizado por outra pessoa 
(consulte “Assegurar que o nome de usuário escolhido é exclusivo” na página 970)
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Armazenar as informações de acesso dos usuários (login)
Uma página de registro requer uma tabela de banco de dados para armazenar as informações 
de login inseridas pelos usuários. Certifique-se de que a tabela de banco de dados contenha 
uma coluna de nome de usuário e de senha. Se desejar que os usuários que efetuaram login 
tenham diferentes privilégios de acesso, inclua uma coluna de privilégio de acesso (consulte 
“Armazenar os privilégios de acesso no banco de dados de usuários” na página 976).

Se desejar definir uma senha comum para todos os usuários do site, configure o seu aplicativo 
de banco de dados (Microsoft Access, Microsoft SQL Server, Oracle, etc.) para inserir a senha 
em cada novo registro de usuário, como padrão. Na maioria dos aplicativos de banco de 
dados, é possível definir um valor padrão para uma coluna sempre que um novo registro for 
criado. Defina o valor padrão da senha.

A tabela de banco de dados também pode ser utilizada para armazenar outras informações 
úteis sobre o usuário.

A próxima etapa na criação de uma página de registro é adicionar a ela um formulário HTML 
para que os usuários possam escolher um nome de usuário e senha (se aplicável). 

Tópicos relacionados
■ “Criar uma página de registro” na página 967

Permitir que os usuários escolham um nome e uma senha
O formulário HTML é adicionado à página de registro para que os usuários possam selecionar 
um nome de usuário e uma senha (se aplicável).

Para permitir que os usuários escolham um nome de usuário e uma senha: 

1. Crie uma nova página em File (Arquivo) > New (Novo) e defina o layout da página de 
registro utilizando as ferramentas de projeto do Dreamweaver.

2. Adicione um formulário HTML posicionando o ponto de inserção no local em que deseja 
exibir o formulário e selecione Form (Formulário) no menu Insert (Inserir).

Um formulário vazio é criado na página. Pode ser necessário ativar Invisible Elements 
(Elementos invisíveis), em View (Exibir) > Visual Aids (Auxílios visuais) > Invisible 
Elements, para exibir os limites do formulário, que são representados por linhas finas 
vermelhas.

3. Atribua um nome ao formulário HTML clicando na tag <form> na parte inferior da janela 
do documento para selecionar o formulário. Em seguida, abra o Property inspector 
(Inspetor de propriedades), em Window (Janela) > Properties (Propriedades), e digite um 
nome na caixa de texto Form Name (Nome do formulário).
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Não é necessário especificar um atributo action (ação) ou method (método) para o 
formulário, para informá-lo para onde e como serão enviados os dados do registro quando 
o usuário clicar no botão Submit (Enviar). O comportamento de servidor Insert Record 
define esses atributos para o usuário (consulte “Atualizar a tabela de usuários no banco de 
dados” na página 969).

4. Adicione campos de texto em Insert > Form > Text Field (Campo de texto) para que o 
usuário possa digitar um nome de usuário e uma senha.

O formulário pode conter também outros objetos de formulário para registrar outros 
dados pessoais.
Devem ser incluídos identificadores (em forma de texto ou de imagens) ao lado de cada 
objeto de formulário para informar aos usuários o que são. Os objetos de formulário 
também devem ser alinhados, colocando-os em uma tabela HTML. Para obter mais 
informações sobre objetos de formulário, consulte “Inserir objetos de formulário HTML” 
na página 892.

5. Adicione ao formulário um botão Submit, a partir de Insert > Form > Button (Botão).

O identificador do botão Submit pode ser alterado do seguinte modo: selecione o botão, 
abra o Property inspector, em Window > Properties, e digite um novo valor na caixa de 
texto Label (Identificador).

A etapa seguinte na criação de uma página de registro é incluir o comportamento de servidor 
Insert Record (Inserir registro) para adicionar registros a uma tabela de usuários no banco de 
dados.

Tópicos relacionados
■ “Criar uma página de registro” na página 967

Atualizar a tabela de usuários no banco de dados
Você deve adicionar um comportamento de servidor Insert Record (Inserir registro) à página 
de registro para atualizar a tabela de usuários no banco de dados. 

Para atualizar a tabela de usuários no banco de dados:

1. No painel Server Behaviors (Comportamentos de servidor), em Window (Janela) > Server 
Behaviors, clique no botão com sinal de adição (+) e selecione Insert Record no menu pop-
up.

Será exibida a caixa de diálogo Insert Record. 
2. Preencha a caixa de diálogo, especificando a tabela de usuários no banco de dados em que 

os dados do usuário serão inseridos.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
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3. Clique em OK.

A etapa final na criação de uma página de registro é verificar se o nome de usuário não está 
sendo utilizado por outro usuário registrado.

Tópicos relacionados
■ “Criar uma página de registro” na página 967

Assegurar que o nome de usuário escolhido é exclusivo 
Adicione um comportamento de servidor para assegurar que o nome de usuário digitado não 
seja utilizado por outro usuário registrado. 

Para assegurar que o nome de usuário escolhido seja exclusivo:

1. No painel Server Behaviors (Comportamentos de servidor), em Window (Janela) > Server 
Behaviors, clique no botão com sinal de adição (+) e selecione User Authentication 
(Autenticação de usuário) > Check New Username (Verificar o novo nome de usuário) no 
menu pop-up.

Será exibida a caixa de diálogo Check New Username.
2. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

O Dreamweaver adiciona um comportamento de servidor à página de registro, que verifica se 
o nome de usuário enviado por um visitante é exclusivo antes de adicionar as informações 
sobre aquele visitante ao banco de dados de usuários registrados. 

Quando o usuário clica no botão Submit (Enviar) na página de registro, o comportamento de 
servidor compara o nome de usuário digitado com os nomes de usuário armazenados em um 
banco de dados. Se não for encontrado nenhum nome de usuário correspondente na tabela de 
banco de dados, o comportamento de servidor continuará normalmente a operação de 
inserção do registro. Se for encontrado um nome de usuário coincidente, o comportamento 
de servidor cancelará a operação de inserção do registro e abrirá uma nova página (em geral, 
uma página para alertar a pessoa que o nome de usuário já foi utilizado).

Tópicos relacionados
■ “Criar uma página de registro” na página 967
970 Capítulo 40:  Criar aplicativos ColdFusion rapidamente



         
Criar uma página de acesso (login)
O aplicativo da Web pode conter uma página que permite aos usuários registrados efetuar 
login no site. 

A seguinte página, por exemplo, solicita aos usuários registrados que efetuem login: 

Uma página de login é composta dos seguintes blocos de criação:

■ Uma tabela de banco de dados de usuários registrados (consulte “Criar uma tabela de 
banco de dados de usuários registrados” na página 971)

■ Um formulário HTML para que os usuários possam digitar um nome de usuário e uma 
senha (consulte “Permitir que os usuários efetuem login” na página 972).

■ Um comportamento de servidor Log In User (Efetuar login de usuário), para validar o 
nome de usuário e a senha digitados (consulte  “Verificar o nome de usuário e a senha” na 
página 973)

Uma variável de sessão, que consiste no nome de usuário seja criada para o usuário quando ele 
efetuar login com sucesso.

Criar uma tabela de banco de dados de usuários registrados
É necessária uma tabela de banco de dados de usuários registrados para verificar se o nome de 
usuário e a senha digitados na página de login são válidos. Utilize o aplicativo de banco de 
dados e uma página de registro para criar a tabela. Para obter mais informações, consulte 
“Criar uma página de registro” na página 967.

A próxima etapa na criação de uma página de login é adicionar um formulário HTML à 
página para permitir que os usuários façam login.
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Tópicos relacionados
■ “Criar uma página de acesso (login)” na página 971

Permitir que os usuários efetuem login
Adicione um formulário HTML à página para permitir aos usuários efetuar login digitando 
um nome de usuário e uma senha.

Para permitir que os usuários efetuem login: 

1. Crie uma nova página em File (Arquivo) > New (Novo) e defina o layout da página de login 
utilizando as ferramentas de projeto do Dreamweaver.

2. Adicione um formulário HTML posicionando o ponto de inserção no local em que deseja 
exibir o formulário e selecionando Form (Formulário) no menu Insert (Inserir).

Um formulário vazio é criado na página. Pode ser necessário ativar Invisible Elements 
(Elementos invisíveis), em View (Exibir) > Visual Aids (Auxílios visuais) > Invisible 
Elements, para exibir os limites do formulário, que são representados por linhas finas 
vermelhas.

3. Atribua um nome ao formulário HTML clicando na tag <form> na parte inferior da janela 
do documento para selecionar o formulário. Em seguida, abra o Property inspector 
(Inspetor de propriedades), em Window (Janela) > Properties (Propriedades), e digite um 
nome na caixa de texto Form Name (Nome do formulário).

Não é necessário especificar um atributo action (ação) ou method (método) para o 
formulário, para informá-lo para onde e como serão enviados os dados do registro quando 
o usuário clicar no botão Submit (Enviar). O comportamento de servidor Log In User 
(Efetuar login de usuário) define esses atributos para você (consulte “Verificar o nome de 
usuário e a senha” na página 973).

4. Adicione um campo de texto de nome de usuário e de senha em Insert (Inserir) > Form 
(Formulário) > Text Field (Campo de texto) ao formulário.

Adicione identificadores (como texto ou imagens) ao lado de cada campo de texto e alinhe 
os campos colocando-os em uma tabela HTML, e defina 0 para o atributo border da 
tabela.

5. Adicione ao formulário um botão Submit, a partir de Insert > Form > Button (Botão).

O identificador do botão Submit pode ser alterado do seguinte modo: selecione o botão, 
abra o Property inspector, em Window > Properties, e digite um novo valor na caixa de 
texto Label (Identificador).

A próxima etapa na criação de uma página de login é adicionar o comportamento de servidor 
Log In User para validar o nome de usuário e a senha digitados. 
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Tópicos relacionados
■ “Criar uma página de acesso (login)” na página 971

Verificar o nome de usuário e a senha 
Você deve adicionar um comportamento de servidor Log In User (Efetuar login de usuário) à 
página de login para validar o nome do usuário e a senha digitados.

Para verificar o nome de usuário e a senha:

1. No painel Server Behaviors (Comportamentos de servidor), em Window (Janela) > Server 
Behaviors, clique no botão com sinal de adição (+) e selecione User Authentication 
(Autenticação de usuário) > Log In User no menu pop-up.

Será exibida a caixa de diálogo Log In User.
2. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

O Dreamweaver adiciona um comportamento de servidor à página de login que verifica se o 
nome de usuário e a senha digitada pelo visitante são válidos.

Quando um usuário clica no botão Submit (Enviar), na página de login, o comportamento de 
servidor Log In User compara os valores digitados pelo usuário com aqueles dos usuários 
registrados. Se os valores forem coincidentes, o comportamento de servidor abrirá uma página 
(normalmente, a página inicial do site). Se os valores não corresponderem, o comportamento 
de servidor abrirá outra página (em geral, uma página alertando o usuário de a tentativa de 
login falhou).

Tópicos relacionados
■ “Criar uma página de acesso (login)” na página 971
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Criar uma página que apenas os usuários autorizados 
podem acessar
O aplicativo da Web pode conter uma página protegida, na qual apenas os usuários 
autorizados podem ter acesso. 

Por exemplo: se um usuário tentar ignorar a página de login, digitando a URL da página 
protegida em um navegador, ele será redirecionado para outra página. Da mesma forma, se for 
definido o nível de autorização Administrator (Administrador) para uma página, somente os 
usuários com esse privilégio de acesso poderão visualizá-la. Se um usuário que efetuou login 
tentar acessar a página protegida sem os privilégios de acesso adequados, ele será redirecionado 
para outra página.

Os níveis de autorização também podem ser utilizados para rever os usuários recém-
registrados antes de lhes conceder acesso total ao site. Por exemplo: pode ser conveniente 
receber o pagamento antes de permitir um acesso de usuário às páginas componentes do site. 
Para isso, proteja as páginas com um nível de autorização membro (Member) e conceda aos 
usuários recém-registrados apenas os privilégios de visitante (Guest). Após receber o 
pagamento do usuário, é possível atualizar os seus privilégios de acesso para membro (na 
tabela de banco de dados de usuários registrados). 

Se não forem utilizados os níveis de autorização, qualquer página poderá ser protegida no site 
através da inclusão de um comportamento de servidor Restrict Access To Page (Restringir 
acesso à página). O comportamento de servidor redirecionará para outra página qualquer 
usuário que não tenha efetuado login com êxito. Para obter mais informações, consulte 
“Redirecionar os usuários não autorizados para outra página” na página 975.

Se não forem utilizados os níveis de autorização, qualquer página poderá ser protegida no site 
utilizando os seguintes blocos de criação:

■ Um comportamento de servidor Restrict Access To Page para redirecionar os usuários não-
autorizados para outra página (consulte “Redirecionar os usuários não autorizados para 
outra página” na página 975)

■ Uma coluna extra na tabela de banco de dados de usuários para armazenar os privilégios de 
acesso de cada usuário (consulte “Armazenar os privilégios de acesso no banco de dados de 
usuários” na página 976)

Sejam ou não utilizados níveis de autorização, é possível adicionar um link à página protegida 
para permitir que o usuário efetue logout e limpe qualquer variável de sessão. Para obter mais 
informações, consulte “Efetuar logout de usuários” na página 976.

N
O

T
A

O Dreamweaver não possui comportamentos de servidor de autenticação para páginas 
ASP.NET.
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Redirecionar os usuários não autorizados para outra página
Para impedir que usuários não autorizados acessem uma página, adicione um comportamento 
de servidor Restrict Access To Page (Restringir acesso à página). O comportamento de 
servidor redirecionará o usuário à outra página se ele tentar ignorar a página de login, 
digitando a URL de uma página protegida em um navegador ou se o usuário tiver efetuado 
login mas tentar acessar a página protegida sem os privilégios de acesso adequados.

Se desejar definir os mesmos privilégios de acesso a muitas páginas, copie e cole os direitos de 
acesso de uma página para outra.

Para redirecionar os usuários não-autorizados para outra página: 

1. Abra a página a ser protegida.

2. No painel Server Behaviors (Comportamentos de servidor), em Window (Janela) > Server 
Behaviors, clique no botão com sinal de adição (+) e selecione User Authentication 
(Autenticação de usuário) > Restrict Access To Page no menu pop-up.

Será exibida a caixa de diálogo Restrict Access To Page.
3. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

O Dreamweaver adiciona um comportamento de servidor à página que permite apenas aos 
usuários autorizados visualizar a página.

Para copiar e colar os direitos de acesso da página em outra página no site:

1. Abra a página protegida e selecione o comportamento de servidor Restrict Access To Page, 
indicado no painel Server Behaviors – e não aquele no menu pop-up com sinal de adição 
(+).

2. Clique no botão de seta, no canto superior direito do painel, e selecione Copy (Copiar) no 
menu pop-up.

O comportamento de servidor Restrict Access To Page será copiado na área de 
transferência do sistema.

3. Abra outra página a ser protegida utilizando o mesmo procedimento.

4. No painel Server Behaviors (Window > Server Behaviors), clique no botão de seta no canto 
superior direito e selecione Paste (Colar) no menu pop-up.

5. Repita as etapas 3 e 4 para cada página a ser protegida.

N
O

T
A

O comportamento de servidor Restrict Access To Page pode proteger apenas as 
páginas HTML. Este comportamento não protege outros recursos do site (arquivos de 
imagem e de áudio, por exemplo).
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Tópicos relacionados
■ “Armazenar os privilégios de acesso no banco de dados de usuários” na página 976

Armazenar os privilégios de acesso no banco de dados de 
usuários 
Este bloco de criação é requerido apenas quando determinados usuários que efetuaram login 
necessitarem de privilégios de acesso diferentes. Se os usuários tiverem que efetuar apenas 
login, não será preciso armazenar os privilégios de acesso.

Para que determinados usuários tenham diferentes privilégios de acesso, verifique se as tabelas 
de usuários no banco de dados contêm uma coluna que especifica os privilégios de acesso de 
cada usuário (guest, usuário, administrador etc.). Os privilégios de acesso de cada usuário 
devem ser inseridos no banco de dados pelo administrador do site.

Na maioria dos aplicativos de banco de dados, é possível definir um valor padrão para uma 
coluna sempre que um novo registro for criado. Defina o valor padrão para o privilégio de 
acesso mais comum no site – por exemplo, Guest (Visitante); em seguida, altere manualmente 
as exceções – por exemplo: passe de Guest para Administrator (Administrador). O usuário 
poderá agora acessar todas as páginas do administrador.

Verifique se cada usuário no banco de dados tem um privilégio de acesso exclusivo (guest ou 
administrador, por exemplo) e não diversos privilégios (como “usuário, administrador”). Se 
desejar definir vários privilégios de acesso às suas páginas (por exemplo: todos os visitantes e 
administradores podem visualizar esta página), defina-os para cada página, mas não para o 
nível de banco de dados. 

Tópicos relacionados
■ “Redirecionar os usuários não autorizados para outra página” na página 975

Efetuar logout de usuários 
Quando um usuário efetua login com sucesso, é criada uma variável de sessão que consiste no 
nome de usuário. Quando o usuário sair do site, é possível remover a variável de sessão e 
redirecionar o usuário à outra página (normalmente, uma página com mensagem “até logo” 
ou “obrigado”) utilizando o comportamento de servidor Log Out User (Efetuar logout de 
usuário).

O comportamento de servidor Log Out User poderá ser chamado quando o usuário clicar em 
um link ou quando uma página específica for carregada. 
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Para adicionar um link que permite aos usuários efetuar logout: 

1. Selecione um texto ou uma imagem na página para servir de link.

2. No painel Server Behaviors (Comportamentos de servidor), em Window (Janela) > 
Behaviors, clique no botão com sinal de adição (+) e selecione User Authentication 
(Autenticação de usuário) > Log Out User. 

Será exibida a caixa de diálogo Log Out User.
3. Especifique uma página a ser aberta quando o usuário clicar no link.

Normalmente, é uma página de despedida ou de agradecimento.
4. Clique em OK.

Para efetuar logout de um usuário quando uma página específica for 
carregada:

1. Abra a página que será carregada no Dreamweaver.

Normalmente, é uma página de despedida ou de agradecimento.
2. No painel Server Behaviors, clique no botão com sinal de adição (+) e selecione User 

Authentication > Log Out User. 

Será exibida a caixa de diálogo Log Out User.
3. Selecione a opção Log Out When Page Loads (Efetuar logout quando a página for 

carregada).

4. Clique em OK.

Tópicos relacionados
■ “Criar uma página que apenas os usuários autorizados podem acessar” na página 974

Proteger uma pasta em em seu aplicativo 
(ColdFusion)
É possível usar o Dreamweaver para criar uma proteção por senha para uma pasta específica 
em seu aplicativo ColdFusion, incluindo a pasta raiz do aplicativo. Quando um visitante do 
site solicitar uma das páginas dessa pasta, o ColdFusion pedirá a ele que forneça um nome de 
usuário e uma senha. O ColdFusion armazena o nome de usuário e a senha em variáveis de 
sessão, de modo que o visitante não precise inseri-los novamente durante a sessão.

Esse recurso só estará disponível se você tiver acesso a um computador que execute 
ColdFusion MX 7 ou posterior. Para obter mais informações, consulte “Ativar os 
aprimoramentos do ColdFusion” na página 916.
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Para proteger uma pasta ou site no servidor:

1. Com um documento Coldfusion aberto no Dreamweaver, selecione Commands 
(Comandos) > ColdFusion Login Wizard (Assistente de login do ColdFusion).

2. Complete o ColdFusion Login Wizard.

Para obter instruções, clique no botão Help (Ajuda) do assistente.
O assistente criará os arquivos necessários para proteger a pasta. 

3. Faça o upload dos novos arquivos para o site remoto.

Os arquivos estão localizados na pasta do site local.

Tópicos relacionados
■ “Criar páginas que restrinjam o acesso ao site (ColdFusion, ASP, JSP, PHP)” na 

página 966

Utilizar componentes ColdFusion
Os componentes ColdFusion (CFCs) permitem encapsular lógicas de aplicação e de negócios 
em unidades completas e reutilizáveis. Os componentes ColdFusion também oferecem uma 
maneira rápida e fácil de se criar serviços para a Web.

Você pode usar o Dreamweaver para criar e modificar CFCs. Também é possível utilizar o 
Dreamweaver para construir páginas da Web que utilizam CFCs.

Esta seção contém os tópicos a seguir:

■ “Sobre os componentes ColdFusion” na página 979
■ “Criar visualmente um componente no Dreamweaver” na página 980
■ “Exibir componentes ColdFusion no Dreamweaver” na página 980
■ “Editar componentes ColdFusion no Dreamweaver” na página 982
■ “Criar páginas da Web que utilizam componentes ColdFusion” na página 983
■ “Definir um recordset em um componente ColdFusion” na página 984
■ “Usar um recordset CFC como a origem de um conteúdo dinâmico” na página 985

N
O

T
A

Você somente poderá usar os CFCs com o Macromedia ColdFusion MX ou posterior. O 
ColdFusion 5 não oferece suporte aos CFCs.
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Sobre os componentes ColdFusion
Um componente ColdFusion é uma unidade de software reutilizável escrita na linguagem de 
markups ColdFusion (CFML). Os CFCs ajudam a tornar o código reutilizável e fácil de 
manter.

Esta seção descreve as vantagens dos CFCs. As seções posteriores descrevem como o 
Dreamweaver pode ajudar o usuário a trabalhar com CFCs. Para obter informações sobre tags 
e sintaxe dos CFCs, consulte a documentação do ColdFusion no Dreamweaver (Help 
(Ajuda)> Using ColdFusion (Usando o ColdFusion)).

A finalidade dos componentes ColdFusion é assegurar aos desenvolvedores um modo simples, 
mas poderoso de encapsular elementos de seus sites na Web. Esses componentes geralmente 
são utilizados para lógica de aplicação ou de negócios. Use tags personalizadas para elementos 
de apresentação, como saudações, menus dinâmicos e assim por diante.

Da mesma forma que muitos outros tipos de construção, os sites dinâmicos podem 
normalmente beneficiar-se de componentes intercambiáveis. Por exemplo, um site dinâmico 
pode executar a mesma consulta repetidamente ou calcular o preço total de páginas com 
carrinho de compras e recalculá-lo sempre que item for adicionado. Estas tarefas podem ser 
controladas por componentes. É possível ajustar, aperfeiçoar, estender e até mesmo substituir 
um componente com impacto mínimo sobre o restante do aplicativo.

Vamos supor que uma loja on-line calcule as taxas de remessa com base no preço dos pedidos. 
Para pedidos abaixo de R$ 20, a taxa da remessa é R$ 4. Para pedidos entre R$ 20 e R$ 40, a 
taxa da remessa é R$ 6 e assim sucessivamente. É possível inserir a lógica para calcular a taxa 
da remessa tanto na página do carrinho de compras quanto na página de resumo do pedido. 
Mas isso misturaria o código de apresentação HTML e o código de lógica CFML e, 
normalmente, tornaria o código difícil de manter e reutilizar.

Neste caso, recomenda-se criar um componente ColdFusion de denominado Pricing (Cálculo 
de preço), que possui, entre outras coisas, uma função chamada ShippingCharge (Taxa de 
remessa). Esta função toma um preço como argumento e retorna uma taxa de remessa. Por 
exemplo, se o valor do argumento for 32,80, a função retorna o valor 6.

Tanto na página de carrinho de compras como na página de resumo do pedido, é possível 
inserir uma tag especial para chamar a função ShippingCharge. Quando a página é 
solicitada, a função é ativada e uma taxa de remessa retornada para a página.

Em seguida, a loja anuncia uma promoção especial: remessa grátis para todos os pedidos 
acima de R$ 100. A mudança é feita nas taxas de remessa em um único local, na função 
ShippingCharge do componente Pricing, e todas as páginas que utilizam a função obtêm 
automaticamente as taxas de remessa exatas.
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Criar visualmente um componente no Dreamweaver
É possível utilizar o Dreamweaver para definir visualmente um componente ColdFusion e 
suas funções. O Dreamweaver cria um arquivo .cfc e insere as tags CFML necessárias.

Para criar visualmente um componente ColdFusion:

1. Abra uma página ColdFusion no Dreamweaver.

2. No painel Components (Componentes), em Window (Janela) > Components, selecione 
CF Components (Componentes CF) no menu pop-up.

3. No painel Components, clique no botão de adição (+).

A caixa de diálogo Create Component (Criar componente) é exibida. 
4. Preencha a caixa de diálogo e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

O Dreamweaver grava um arquivo .cfc e o salva na pasta especificada. O novo componente 
também aparece no painel Components, após você clicar em Refresh (Atualizar).

Para remover um componente, é necessário excluir manualmente o arquivo .cfc do servidor.

Tópicos relacionados
■ “Sobre os componentes ColdFusion” na página 979
■ “Editar componentes ColdFusion no Dreamweaver” na página 982
■ “Criar páginas da Web que utilizam componentes ColdFusion” na página 983

Exibir componentes ColdFusion no Dreamweaver
De modo geral, o Dreamweaver oferece uma maneira de examinar visualmente os CFCs 
localizados na pasta de seu site ou no servidor. Ele lê os arquivos .cfc localizados no servidor e 
exibe as informações referentes a eles de maneira hierárquica, de fácil navegação, no painel 
Components (Componentes).

O Dreamweaver procura pelos componentes no seu servidor de teste (consulte “Especificar 
onde as páginas dinâmicas podem ser processadas” na página 667). Se você criar novos CFCs 
ou fizer alterações nos CFCs existentes, certifique-se de fazer o upload dos arquivos CFC para 
o servidor de teste, de modo que eles sejam refletidos de maneira precisa no painel 
Components.

N
O

T
A

Dependendo do componente, talvez você tenha de completar algum código 
manualmente.
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Se desejar exibir os componentes localizados em outro servidor, modifique as configurações do 
servidor de teste.

Você pode exibir qualquer uma das seguintes informações sobre seus componentes CF:

■ Listar todos os componentes ColdFusion definidos no servidor.
■ Se estiver executando ColdFusion MX 7 ou posterior, filtrar a lista de modo a mostrar 

apenas os CFCs localizados na sua pasta do site.
■ Explorar as funções e argumentos de cada componente
■ Inspecionar as propriedades de funções que funcionam como serviços da Web

Para exibir os componentes ColdFusion no Dreamweaver:

1. Abra qualquer página ColdFusion no Dreamweaver.

2. No painel Components (Componentes), em Window (Janela) > Components, selecione 
CF Components (Componentes CF) no menu pop-up.

3. Clique no botão Refresh (Atualizar) no painel para recuperar os componentes.

O Dreamweaver exibe os pacotes de componentes no servidor. Um pacote de componentes é 
uma pasta que contém arquivos CFC. 
Se os pacotes de componentes existentes não forem exibidos, clique no botão Refresh 
(Atualizar) na barra de ferramentas do painel.

4. Para exibir apenas os CFCs localizados na sua pasta do site, clique no botão Show Only 
Current Site’s CFCs (Mostrar somente os CCFCs do site atual) na barra de ferramentas do 
painel Components.

Esse recurso somente estará disponível se você definir um computador que execute 
ColdFusion MX 6 ou posterior como servidor de teste do Dreamweaver. Para obter mais 
informações, consulte “Ativar os aprimoramentos do ColdFusion” na página 916.

5. Clique no botão de adição (+) ao lado do nome do pacote para exibir os componentes 
armazenados nesse pacote.

■ Para listar as funções de um componente, clique no botão de adição (+) ao lado do 
nome do componente.

■ Para visualizar os argumentos de uma função, bem como o tipo de argumento e se eles 
são obrigatórios ou opcionais, abra a ramificação da função na árvore hierárquica.
As funções sem argumentos não possuem o ícone de adição (+) ao lado delas.

N
O

T
A

Se o site atual estiver listado em uma pasta virtual no servidor remoto, a filtragem 
não funcionará.
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■ Para exibir rapidamente os detalhes de um argumento, função, componente ou pacote, 
selecione o item na visualização da árvore hierárquica e clique no ícone Get Details 
(Obter detalhes) na barra de ferramentas do painel.
Também é possível clicar com o botão direito do mouse (no Windows), ou manter a 
tecla Control pressionada e clicar (no Macintosh), no item e selecionar Get Details no 
menu pop-up.
O Dreamweaver exibirá os detalhes sobre o item em uma caixa de mensagem.

Tópicos relacionados
■ “Sobre os componentes ColdFusion” na página 979
■ “Criar visualmente um componente no Dreamweaver” na página 980
■ “Criar páginas da Web que utilizam componentes ColdFusion” na página 983

Editar componentes ColdFusion no Dreamweaver
O Dreamweaver oferece uma maneira simples e eficaz de editar o código dos componentes 
ColdFusion definidos para o seu site. Por exemplo, é possível adicionar, alterar ou excluir 
qualquer função de um componente sem sair do Dreamweaver.

Para utilizar este recurso, o ambiente de desenvolvimento deve estar configurado do seguinte 
modo:

■ O ColdFusion deve estar sendo executado localmente.
■ Na caixa de diálogo avançada Site Definition (Definição do site) do Dreamweaver, o tipo 

Access (Acesso), especificado na categoria Testing Server (Servidor de teste) deve estar 
definido como Local/Network (Local/Rede).

■ Na caixa de diálogo avançada Site Definition, o caminho da pasta raiz local deve ser igual 
ao caminho da pasta do servidor de teste (por exemplo: 
c:\Inetpub\wwwroot\cf_projects\myNewApp\). Para verificar e alterar esses caminhos, 
selecione Site > Edit Sites (Editar sites).

■ O componente deve estar armazenado na pasta do site local ou em qualquer subpasta em 
seu disco rígido.

Abra qualquer página do ColdFusion no Dreamweaver e exiba os componentes no painel 
Components. Para exibir os componentes, abra o painel Components (Componentes) a partir 
da seleção de Window (Janela)> Components. Em seguida, selecione CF Components 
(Componentes CF) no menu pop-up e clique no botão Refresh (Atualizar) no painel.

Como o ColdFusion está sendo executado localmente, o Dreamweaver exibe os pacotes de 
componentes em seu disco rígido. Para obter mais informações, consulte “Exibir componentes 
ColdFusion no Dreamweaver” na página 980.
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Para editar um componente: 

1. Abra qualquer página do ColdFusion no Dreamweaver e exiba os componentes no painel 
Components (Window > Components).

2. Selecione CF Components no menu pop-up do painel e clique no botão Refresh no painel.

Como o ColdFusion está sendo executado localmente, o Dreamweaver exibe os pacotes de 
componentes em seu disco rígido. Para obter mais informações, consulte “Exibir 
componentes ColdFusion no Dreamweaver” na página 980.

3. Normalmente, para editar um arquivo de componente, abra o pacote e clique duas vezes 
no nome do componente na árvore hierárquica.

O Dreamweaver abrirá o arquivo do componente na visualização do código.
4. Para editar uma função, propriedade ou argumento específico, clique duas vezes no item 

na árvore hierárquica. 

5. Efetue as alterações manualmente na visualização do código.

6. Salve o arquivo selecionando File (Arquivo) > Save (Salvar).

Para exibir qualquer função nova no painel Components, atualize a exibição clicando no 
botão Refresh na barra de ferramentas do painel.

Criar páginas da Web que utilizam componentes 
ColdFusion
Uma maneira de utilizar uma função de componente em suas páginas da Web é escrever 
código na página que chama a função quando a página é solicitada. É possível utilizar o 
Dreamweaver para ajudá-lo a escrever este código.

Para utilizar componente ColdFusion em uma página da Web:

1. No Dreamweaver, abra a página ColdFusion que utilizará a função do componente.

2. Alterne para a visualização do código, selecionando View (Exibir) > Code (Código).

3. Abra o painel Components a partir da seleção de Window (Janela)> Components 
(Componentes) e selecione CF Components (Componentes CF) no menu pop-up do 
painel.

4. Localize o componente que deseja inserir utilizando um dos métodos a seguir:

■ Arraste uma função da árvore hierárquica para a página. O Dreamweaver insere o 
código na página para chamar a função. 

N
O

T
A

Para conhecer outras maneiras de usar componentes, consulte a documentação do 
ColdFusion no Dreamweaver (Help [Ajuda] > Using ColdFusion [Como utilizar o 
ColdFusion]).
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■ Selecione a função no painel e clique no botão Insert (Inserir) da barra de ferramentas 
do painel (o botão à direita). O Dreamweaver insere o código no ponto de inserção da 
página.

5. Se você inserir uma função com argumentos, complete o código de argumento 
manualmente.

Para obter mais informações, consulte a documentação do ColdFusion no Dreamweaver 
(Help > Using ColdFusion).

6. Salve a página selecionando File (Arquivo)> Save (Salvar).

Definir um recordset em um componente ColdFusion
O Dreamweaver pode ajudá-lo a definir um recordset (também conhecido como consulta 
ColdFusion) em um componente ColdFusion (CFC). Uma vez definido o recordset em um 
CFC, você não precisará defini-lo novamente em cada página que o utilizar. Você define o 
recordset uma vez no CFC e usa o CFC em diferentes páginas.

Esse recurso só estará disponível se você tiver acesso a um computador que execute 
ColdFusion MX 7 ou posterior. Para obter mais informações, consulte “Ativar os 
aprimoramentos do ColdFusion” na página 916.

Para definir um recordset em um componente ColdFusion:

1. Crie ou abra um arquivo CFC no Dreamweaver.

Para obter mais informações, consulte “Criar visualmente um componente no 
Dreamweaver” na página 980.

2. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 
de adição (+) e selecione Recordset (Query) [Recordset (Consulta)] no menu pop-up. 

A caixa de diálogo Recordset é exibida. Você pode trabalhar nas caixas de diálogo 
Recordset simples ou avançadas.

3. Se preferir usar uma função existente no CFC, selecione a função no menu pop-up 
Function e vá para a etapa 6.

O recordset é definido na função.
4. Para definir uma nova função no CFC, clique no botão New Function (Nova função) e, 

na caixa de diálogo exibida, digite um nome para a função e clique em OK.

O nome pode conter apenas letras, números e o caractere de sublinhado (_). Não é 
possível utilizar caracteres especiais e espaços.
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5. Use a caixa de diálogo Recordset para definir um recordset para a função.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
Quando você terminar, o Dreamweaver incluirá uma nova função em seu CFC que define 
o recordset. 
Para editar visualmente o recordset do CFC, clique duas vezes no painel Bindings 
(Ligações).

Usar um recordset CFC como a origem de um 
conteúdo dinâmico
É possível usar um componente ColdFusion (CFC) como fonte de dados de um conteúdo 
dinâmico de suas páginas se o componente contiver uma função que define um recordset. Para 
obter mais informações sobre a criação desse tipo de CFC, consulte “Definir um recordset em 
um componente ColdFusion” na página 984.

Esse recurso só estará disponível se você tiver acesso a um computador que execute 
ColdFusion MX 7 ou posterior. Para obter mais informações, consulte “Ativar os 
aprimoramentos do ColdFusion” na página 916.

Para usar um recordset CFC como fonte de dados de um conteúdo dinâmico:

1. Abra uma página ColdFusion no Dreamweaver. 

2. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 
de adição (+) e selecione Recordset (Query) [Recordset (Consulta)] no menu pop-up.

A caixa de diálogo Recordset é exibida. Você pode trabalhar na caixa de diálogo Recordset 
simples ou avançada.

3. Clique no botão CFC Query (Consulta CFC).

A caixa de diálogo CFC Query é exibida.
4. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
5. Clique em OK para fechar a caixa de diálogo CFC Query e, em seguida, clique novamente 

em OK para adicionar o recordset CFC à lista de fontes de conteúdo disponíveis no painel 
Bindings. 
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6. Use o painel Bindings para ligar o recordset aos diversos elementos de página. 

Para obter mais informações, consulte Capítulo 34, “Adicionar conteúdo dinâmico a 
páginas da Web”, na página 781.

Tópicos relacionados
■ “Definir um recordset em um componente ColdFusion” na página 984
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CAPÍTULO 41

Criar aplicativos ASP.NET 
rapidamente
As ferramentas do Macromedia Dreamweaver 8 podem ser utilizadas para criar rapidamente 
um aplicativo ASP.NET para a Web, com pouca ou nenhuma codificação.

Tópicos relacionados
■ “Sobre o desenvolvimento rápido de aplicativos (todos os servidores)” na página 909

Criar formulários ASP.NET
É possível criar formulários ASP.NET no ambiente de criação do Dreamweaver e, em seguida, 
modificar as propriedades dos controles do formulário sem ter de alterar o código 
manualmente.

Tópicos relacionados
■ “Criar formulários” na página 885
■ “Inserir objetos de formulário HTML dinâmicos” na página 898

Adicionar controles de formulário ASP.NET a uma 
página
Você pode usar o ambiente de design visual do Dreamweaver para adicionar controles de 
formulário ASP.NET à sua página. 

Para adicionar um controle de formulário ASP.NET à sua página:

1. Abra uma página ASP.NET na visualização do projeto, a partir da seleção de View (Exibir) 
> Design (Projeto).

2. Posicione o ponto de inserção no local onde deseja exibir o controle de formulário na 
página.
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Os controles de formulário devem ser inseridos em um formulário que tenha um atributo 
runat='server' na tag. Se a página não tiver um formulário, o Dreamweaver criará 
automaticamente um formulário com um atributo runat='server' quando você inserir 
o primeiro controle de formulário ASP.NET. Se a página tiver um formulário HTML, o 
Dreamweaver adicionará automaticamente o atributo runat='server' à tag de 
formulário existente quando você inserir o primeiro controle de formulário.

3. Na categoria ASP.NET da barra Insert (Inserir), selecione o ícone do controle de 
formulário.

4. Preencha a caixa de diálogo do controle.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo. Para obter mais 
informações sobre as propriedades de cada controle, consulte a documentação no site da 
Microsoft, em http://msdn.microsoft.com/library/en-us/cpgenref/html/
cpconaspsyntaxforwebcontrols.asp.

Após ter concluído, o Dreamweaver insere o controle de formulário na sua página. Se desejar, 
clique no controle na página e altere qualquer uma das propriedades no Property inspector 
(Inspetor de propriedades).

Definir as propriedades de controles de formulário 
ASP.NET
É possível modificar as propriedades de controles de formulário ASP.NET no ambiente de 
criação.

Para modificar as propriedades de um controle de formulário ASP.NET no 
ambiente de criação:

1. Na visualização do projeto, selecione o controle de formulário na página.

O Property inspector (Inspetor de propriedades) exibe propriedades do controle.
2. Modifique as propriedades do controle nesse Property inspector.

Para obter mais informações sobre as propriedades de cada controle, consulte a 
documentação no site da Microsoft, em http://msdn.microsoft.com/library/en-us/
cpgenref/html/cpconaspsyntaxforwebcontrols.asp.

3. Para definir mais propriedades, clique no botão Tag Editor (Editor de tags) no Property 
inspector e defina as propriedades no editor de tags que for exibido.

O editor de tags permite definir um número maior de propriedades, incluindo eventos.
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Criar um menu ASP.NET dinâmico 
Você pode preencher dinamicamente um controle de menu ASP.NET, como DropDownList 
(Lista suspensa) ou ListBox (Caixa de lista) com entradas de um banco de dados.

Antes de começar, você deve definir um DataSet (Conjunto de dados) ou outra fonte de 
conteúdo dinâmico para o menu. Para obter mais informações, consulte “Definir um 
recordset” na página 765.

Para inserir um menu dinâmico em uma página ASP.NET:

1. Abra a página ASP.NET e posicione o ponto de inserção onde deseja exibir o menu.

2. Selecione Insert (Inserir) > ASP.NET Objects (Objetos ASP.NET). Em seguida, selecione 
asp:DropDownList ou asp:ListBox.

Será exibida a caixa de diálogo do controle de formulário.
3. Preencha a caixa de diálogo e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

O Dreamweaver insere o controle de formulário no ponto de inserção na página. Se você não 
tiver inserido um formulário, o Dreamweaver inserirá um formulário que contenha o atributo 
runat="server".

Tópicos relacionados
■ “Definir as propriedades de controles de formulário ASP.NET” na página 988
■ “Tornar dinâmico um menu ASP.NET existente” na página 989

Tornar dinâmico um menu ASP.NET existente
É possível tornar dinâmico um objeto de menu ASP.NET já existente. Os objetos de menu 
ASP.NET contêm os controles DropDownList (Lista suspensa) e ListBox (Caixa de lista).

Antes de começar, você deve definir um DataSet (Conjunto de dados) ou outra fonte de 
conteúdo dinâmico para o menu. Para obter mais informações, consulte “Definir um 
recordset” na página 765.

Para tornar dinâmico um objeto DropDownList ou ListBox existente: 

1. Na visualização do projeto, selecione o objeto DropDownList ou ListBox que você deseja 
tornar dinâmico.

2. No Property inspector (Inspetor de propriedades), clique no botão List Items (Itens da 
lista).

Será exibida a caixa de diálogo List Items.
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3. Selecione a opção From Database (Do banco de dados) e preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Tópicos relacionados
■ “Criar um menu ASP.NET dinâmico” na página 989
■ “Tornar dinâmicos menus de formulário HTML existentes” na página 899

Exibir conteúdo dinâmico em um controle ASP.NET 
TextBox (Caixa de texto)
É possível exibir conteúdo dinâmico em controles de formulário ASP.NET TextBox.

Antes de começar, você deve definir um DataSet (Conjunto de dados) ou outra fonte de 
conteúdo dinâmico para o controle TextBox. Para obter mais informações, consulte “Definir 
um recordset” na página 765.

Para tornar dinâmico um controle ASP.NET TextBox:

1. Na visualização do projeto, selecione o controle TextBox (Caixa de texto) na página.

2. No Property inspector (Inspetor de propriedades), clique no ícone em forma de raio ao lado 
da caixa de texto Text (Texto).

Será exibida a caixa de diálogo Dynamic Data (Dados dinâmicos).
3. Selecione a coluna do recordset que fornecerá um valor ao objeto TextBox. Em seguida, 

clique em OK.

O controle TextBox exibirá o conteúdo dinâmico quando a página for visualizada em um 
navegador.

Tópicos relacionados
■ “Exibir conteúdo dinâmico em campos de texto HTML” na página 900

Pré-selecionar dinamicamente controles ASP.NET 
CheckBox (Caixa de seleção)
É possível permitir que o servidor decida se deve selecionar determinados controles CheckBox 
(Caixa de seleção) quando a página ASP.NET for carregada em um navegador. 

Antes de começar, você deve definir um DataSet (Conjunto de dados) ou outra fonte de 
conteúdo dinâmico para as caixas de seleção. Para obter mais informações, consulte “Definir 
um recordset” na página 765. O ideal é que a fonte de conteúdo possua dados booleanos, 
como Yes/No (Sim/Não) ou true/false (verdadeiro/falso).
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Para pré-selecionar dinamicamente uma caixa de seleção ASP.NET: 

1. Selecione um controle de formulário CheckBox na página ASP.NET.

2. No Property inspector (Inspetor de propriedades), selecione a opção Dynamic (Dinâmico).

Será exibida a caixa de diálogo Dynamic CheckBox (Caixa de seleção dinâmica).
3. Preencha a caixa de diálogo e clique em OK.

Para obter instruções, clique no botão Help da caixa de diálogo.

A caixa de seleção será exibida selecionada ou não (dependendo dos dados) quando a página 
for carregada em um navegador.

Tópicos relacionados
■ “Pré-selecionar dinamicamente caixas de seleção HTML” na página 900

Pré-selecionar dinamicamente um item em um 
controle ASP.NET RadioButtonList (Lista de botão 
de opção)
É possível permitir que o servidor decida se deve selecionar um botão de opção em um 
controle RadioButtonList (Lista de botão de opção) quando a página for carregada em um 
navegador. 

Antes de começar, você deve inserir pelo menos um controle ASP.NET RadioButtonList na 
página. Também é necessário definir um DataSet (Conjunto de dados) ou outra fonte de 
conteúdo dinâmico para os botões de opção. Para obter mais informações, consulte “Definir 
um recordset” na página 765. O ideal é que a fonte de conteúdo possua dados booleanos, 
como Yes/No (Sim/Não) ou true/false (verdadeiro/falso).

Para pré-selecionar dinamicamente um botão de opção em um controle 
RadioButtonList: 

1. Na visualização do projeto, selecione o controle RadioButtonList.

2. No Property inspector (Inspetor de propriedades), clique em List Items (Itens da lista).

Será exibida a caixa de diálogo List Items.
3. Selecione a opção From Database (Do banco de dados) e preencha a caixa de diálogo.

Para obter instruções, clique no botão Help da caixa de diálogo.

Tópicos relacionados
■ “Pré-selecionar dinamicamente botões de opção HTML” na página 901
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Criar controles da WeB DataGrid e 
DataList do ASP.NET 
Os controles DataGrid e DataList do ASP.NET fornecem diversas opções para exibir 
diferentes tipos de dados (principalmente conteúdo dinâmico de um banco de dados) e 
simplificam o processo de ligação de fontes de dados aos controles. O Dreamweaver suporta 
tanto o controle DataGrid como DataList como comportamentos de servidor.

Sobre os controles DataGrid e DataList do ASP.NET
Os controles DataGrid e DataList do ASP.NET fornecem diversas opções para exibir 
diferentes tipos de dados (principalmente conteúdo dinâmico de um banco de dados) e 
simplificam o processo de ligação de fontes de dados aos controles. O Dreamweaver suporta 
tanto o controle DataGrid como DataList como comportamentos de servidor. Os controles 
oferecem os recursos a seguir:

DataGrid: cria uma grade com diversas colunas ligadas por dados. Este controle permite 
definir vários tipos de colunas, tanto para definir o layout do conteúdo da grade quanto para 
adicionar funcionalidades específicas (colunas de botão de edição, colunas de hyperlink e 
assim por diante).

DataList: exibe itens de uma fonte de dados utilizando modelos. É possível personalizar a 
aparência do controle manipulando os modelos que compõem seus diferentes componentes.

Tópicos relacionados
■ “Adicionar uma DataGrid do ASP.NET à página” na página 994
■ “Adicionar um DataList do ASP.NET a sua página” na página 995
■ “Modificar um objeto DataGrid ou DataList” na página 996
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Usar o controle da Web DataGrid do ASP.NET
O recurso DataGrid do Dreamweaver permite inserir um controle da Web DataGrid 
ASP.NET. O controle DataGrid insere tabelas como grades multi-coluna e pode incluir 
diferentes tipos de coluna (colunas heterogêneas) para definir o layout do conteúdo das 
células. Essas colunas incluem colunas ligadas, colunas de botões e colunas de modelos, entre 
outras. Além disso, o DataGrid suporta a funcionalidade interativa como comandos, edição e 
ordenação de colunas. Os tipos de colunas disponíveis no DataGrid são mostrados na tabela a 
seguir: 

Tipo de coluna 
DataGrid

Descrição

Simple Data Field 
(Campo de dados 
simples)

Denominada “coluna ligada” no ASP.NET, a coluna Simple Data 
Field permite especificar o campo de fonte de dados que deve ser 
exibido e o formato de dados que o campo utilizará com uma 
expressão de formatação .NET.

Free Form (Formulário 
livre)

Denominada “coluna de modelo” no ASP.NET, a coluna Free 
Form permite criar combinações de texto HTML e controles de 
servidor para criar um layout personalizado para a coluna. Os 
controles de uma coluna de formulário livre podem ser ligados por 
dados. As colunas Free Form oferecem maior flexibilidade na 
definição do layout e funcionalidade do conteúdo da grade, pois é 
possível ter controle total sobre a exibição dos dados e o que 
acontece quando os usuários interagem com as linhas da grade. 

Hyperlink A coluna Hyperlink exibe informações em forma de links de 
hipertexto. Um uso comum é exibir os dados (como número do 
cliente ou nome do produto) como um hyperlink no qual os 
usuários podem clicar a fim de navegar para uma página separada 
fornecendo detalhes sobre aquele item. 

Botões Edit, Update, 
Cancel

Conhecida como Edit Command Column (Coluna comando 
Editar) no ASP.NET a coluna Edit, Update, Cancel Buttons 
permite aos usuários efetuar edições das informações do 
DataGrid no local. Para isso, crie uma coluna Edit, Update, Cancel 
(Editar, Atualizar, Cancelar). Durante a execução, esta coluna 
exibe um botão denominado Edit. Quando o usuário clica no botão 
Edit , os dados da linha são exibidos em controles editáveis como 
caixas de texto e o botão Edit  é substituído pelo botões Update e 
Cancel.

Delete Button (Botão 
Excluir)

O botão Delete permite que um usuário remova uma linha 
individual clicando no botão. 
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Antes de inserir o comportamento de servidor DataGrid, é preciso definir um DataSet 
(conhecido por outros tipos de documentos como recordset) para o DataGrid. Para obter mais 
informações, consulte “Recordsets” na página 760.

Para saber mais sobre o controle DataGrid e sobre como utilizá-lo para formatar dados 
dinâmicos, visite o site da Microsoft em http://msdn.microsoft.com/library/en-us/cpgenref/
html/cpcondatagridwebservercontrol.asp.

Tópicos relacionados
■ “Sobre os controles DataGrid e DataList do ASP.NET” na página 992
■ “Adicionar uma DataGrid do ASP.NET à página” na página 994
■ “Adicionar um DataList do ASP.NET a sua página” na página 995
■ “Modificar um objeto DataGrid ou DataList” na página 996

Adicionar uma DataGrid do ASP.NET à página 
Os controles DataGrid permitem que você formate e exiba dados dinâmicos como grades 
multicolunadas que são apresentadas em tabelas. Para obter mais informações sobre 
DataGrids e os tipos de controle de formatação que eles fornecem, consulte “Sobre os 
controles DataGrid e DataList do ASP.NET” na página 992.

Para adicionar um objeto DataGrid a uma página:

1. Abra o painel Server Behaviors (Comportamentos de servidor), em Window > Server 
Behaviors, clique no botão de adição (+) e selecione DataGrid.

N
O

T
A

Antes de inserir o comportamento de servidor DataGrid, é preciso definir um DataSet 
(conhecido por outros tipos de documentos como recordset) para o DataGrid. Para 
obter mais informações, consulte “Recordsets” na página 760.
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Será exibida a caixa de diálogo DataGrid. 

2. Preencha a caixa de diálogo DataGrid e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Na janela do documento, o DataGrid será exibido com um contorno cinza com guia. Na 
janela Live Data (Dados ativos), em View  > Live Data), o contorno cinza desaparece e os 
alocadores e espaço do objeto são substituídos pelo DataGrid especificado. 

Tópicos relacionados
■ “Sobre os controles DataGrid e DataList do ASP.NET” na página 992
■ “Modificar um objeto DataGrid ou DataList” na página 996

Adicionar um DataList do ASP.NET a sua página
O comportamento de servidor DataList do Dreamweaver permite inserir o controle DataList 
do ASP.NET em uma página. 

Para adicionar um objeto DataList à página:

1. Abra o painel Server Behaviors (Window > Server Behaviors), clique no botão de adição (+) 
e selecione DataList.

N
O

T
A

Antes de inserir o comportamento de servidor DataList, você deve definir um DataSet 
(conhecido por outros tipos de documentos como recordset ) para o DataList. Para 
obter mais informações, consulte “Recordsets” na página 760.
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A caixa de diálogo DataList é exibida.

2. Preencha a caixa de diálogo DataList e clique em OK.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Na janela do documento, o DataList será exibido com um contorno cinza com guia. Na janela 
Live Data (View > Live Data), o contorno cinza desaparece e os alocador de espaço do objeto 
é substituído pelo DataList especificado. 

Modificar um objeto DataGrid ou DataList
Você poderá sempre modificar os objetos DataGrid e DataList para adequar sua página às 
necessidades do desenho.

Para modificar um objeto DataGrid e DataList:

■ Na visualização do projeto, clique no ícone localizado no canto superior esquerdo do 
DataGrid ou do DataList para alternar para o modo de edição e, em seguida, adicione ou 
modifique o conteúdo das regiões exibidas com guias.

N
O

T
A

Também é possível arrastar fontes de conteúdo dinâmico do painel Bindings 
(Ligações) para uma região com guia.
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■ Na visualização do projeto, selecione o objeto e utilize o Property inspector (Inspetor de 
propriedades) para modificar seus atributos.

■ Clique duas vezes no objeto no painel Server Behaviors (Comportamentos de servidor) e 
modifique suas propriedades na caixa de diálogo exibida.

■ Na visualização de código, selecione DataGrid ou DataList na página e utilize a caixa de 
diálogo da tag para alterar seus atributos.

Criar páginas-mestras/detalhes 
(ASP.NET)
Com o Dreamweaver, é possível criar conjuntos de páginas que apresentam informações em 
dois níveis de detalhe: uma página mestra que relaciona registros e uma página de detalhes que 
apresenta mais detalhes sobre cada registro. Esta seção descreve como criar esses tipos de 
página-mestra/detalhes. 

Tópicos relacionados
■ “Aprimorar a funcionalidade de uma página dinâmica” na página 739

Criar a página mestra (ASP.NET)
Esta seção descreve como criar uma página mestra que contenha registros de banco de dados. 
Com o ASP.NET é possível utilizar uma DataGrid (Grade de dados) para discriminar os 
registros da página.

Antes de iniciar, certifique-se de definir uma conexão de banco de dados para o site. Para obter 
mais informações, consulte Capítulo 25, “Conexões de banco de dados para desenvolvedores 
de ASP.NET”, na página 673.

Para criar uma página mestra:

1. Crie uma nova página ASP.NET.

Selecione File (Arquivo) > New (Novo) > Dynamic (Dinâmico), selecione um formato de 
página ASP.NET e clique em Create (Criar). Uma página .aspx em branco é aberta no 
Dreamweaver.

2. Defina um DataSet (Conjunto de dados) para a página.
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No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão de 
adição (+), selecione DataSet (Query) [Conjunto de dados (Consulta)] e preencha a caixa 
de diálogo. Para obter mais informações, clique no botão Help (Ajuda) da caixa de 
diálogo. Para codificar a sua própria instrução SQL, clique no botão Advanced (Avançado) 
para abrir a caixa de diálogo avançada DataSet (Conjunto de dados).
Certifique-se de que o DataSet contenha todas as colunas de tabela necessárias para criar a 
página mestra.
Ele deve incluir também a coluna de tabela que contém a chave exclusiva de cada registro 
– ou seja, a coluna de identificação do registro.
Normalmente, o DataSet da página mestra extrai algumas colunas de uma tabela de banco 
de dados, enquanto o da página de detalhes extrai mais colunas da mesma tabela para 
fornecer mais detalhes.
O DataSet pode ser definido em tempo de execução pelo usuário. Para obter mais 
informações, consulte “Criar uma página de busca do banco de dados (ASP.NET)” na 
página 1004.

3. Crie uma DataGrid na página.

No painel Server Behaviors (Comportamentos de servidor), em Window > Server 
Behaviors, clique no botão com sinal de adição (+), selecione DataGrid e preencha a caixa 
de diálogo DataGrid (Grade de dados). Para obter mais informações, clique no botão 
Help (Ajuda) da caixa de diálogo. Por enquanto, aceite o tipo de coluna padrão de Simple 
Data Field (Campo de dados simples) para cada coluna da DataGrid. Na próxima seção 
você alterará o tipo de uma coluna para Hyperlink (Hiperlink) (consulte “Abrir uma 
página de detalhes e repassar uma identificação de registro (ASP.NET)” na página 999).
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Este é o exemplo de uma caixa de diálogo DataGrid que define três colunas.

A próxima etapa na criação de páginas-mestras/detalhes é criar links que abram a página de 
detalhes e repassem a identificação do registro selecionado pelo usuário. 

Abrir uma página de detalhes e repassar uma 
identificação de registro (ASP.NET)
Depois de adicionar uma DataGrid à página mestra , será necessário criar links que abram a 
página de detalhes e repassem a identificação do registro selecionado pelo usuário. A página de 
detalhes usará essa identificação para localizar o registro solicitado no banco de dados e exibi-
lo.

A identificação de registro é repassada para a página de detalhes em um parâmetro da URL. 
Para obter mais informações, consulte “Parâmetros da URL” na página 749.

Em uma DataGrid, crie esses links transformando uma coluna da DataGrid em uma coluna 
de hiperlink e definindo seus atributos, conforme descrito nesta seção.

Para abrir a página de detalhes e repassar um parâmetro da URL que 
contenha a identificação do registro clicado pelo usuário:

1. Abra a caixa de diálogo DataGrid criada na seção anterior.

Para abri-la, clique duas vezes em DataGrid no painel Server Behaviors (Comportamentos 
de servidor), em Window (Janela) > Server Behaviors.
Será aberta a caixa de diálogo DataGrid.
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2. Na caixa Columns (Colunas), selecione a coluna à qual deseja aplicar links.

3. Clique no botão Change Column Type (Alterar tipo de coluna) e selecione Hyperlink 
(Hiperlink) no menu pop-up.

Será exibida a caixa de diálogo Hyperlink Column (Coluna de hiperlink). 

4. Na área Hyperlink Text (Texto de hiperlink), especifique o texto a ser exibido na coluna 
de hiperlink.

Para criar um link genérico – como Details (Detalhes) – para cada linha da DataGrid, 
selecione a opção Static Text (Texto estático) e digite o texto do link. Todas as linhas da 
DataGrid exibirão o mesmo texto (como Details) na coluna de hiperlink.
Para adicionar links aos dados exibidos na coluna, selecione a opção Data Field (Campo 
de dados) e um campo de dados no DataSet. O campo de dados fornece o texto para os 
links da coluna de hiperlink. No exemplo a seguir, todas as linhas da DataGrid exibirão 
um nome de local.

5. Na área Linked Page (Página vinculada), crie a URL a ser aplicada ao texto na coluna de 
hiperlink.
1000 Capítulo 41:  Criar aplicativos ASP.NET rapidamente



         
Além de abrir a página de detalhes, a URL também deve identificar de modo exclusivo o 
registro a ser exibido nessa página.
Para identificar o registro a ser exibido na página de detalhes, selecione a opção Data Field 
e um campo no DataSet que identifique cada registro de modo exclusivo. Na maioria dos 
casos, o campo consistirá em um número de identificação de registro. No exemplo a 
seguir, o campo consiste em códigos de local exclusivos.

6. Na caixa de texto Format String (Formatar a seqüência de caracteres) na área Linked Page, 
clique no botão Browse (Procurar). Depois localize e selecione a página de detalhes.

O Dreamweaver cria uma URL para a página de detalhes contendo um parâmetro da 
URL que identifica o registro a ser exibido pela página de detalhes. Anote o nome do 
parâmetro da URL, pois ele será utilizado na página de detalhes posteriormente.
Por exemplo, se locationDetail.aspx for selecionada como a página de detalhes, o 
Dreamweaver criará a seguinte URL:

Nesse caso, o Dreamweaver cria um parâmetro de URL denominado CODE. O 
Dreamweaver copia o nome do campo de dados, mas não é obrigatório usar esse nome. É 
possível alterá-lo e torná-lo mais descritivo, como recordID, como no exemplo a seguir.

O elemento {0} é um alocador de espaço que corresponde ao valor do campo de dados. 
Quando a página for executada, os valores do campo CODE (Código) do DataSet serão 
inseridos nas linhas correspondentes da DataGrid. Por exemplo, se o local de locação 
Canberra, na Austrália, apresentar o código CBR, será utilizada a seguinte URL na linha 
Canberra do DataGrid:
locationDetail.aspx?recordID=CBR
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7. Clique em OK para fechar a caixa de diálogo Hyperlink (Hiperlink). Em seguida, clique 
em OK para fechar a caixa de diálogo DataGrid.

O Dreamweaver atualizará a DataGrid na página.

A próxima etapa na criação de páginas-mestras/detalhes é modificar a página de detalhes, de 
modo que ela localize no banco de dados o registro solicitado e o exiba na página. 

Localizar e exibir o registro solicitado na página de 
detalhes (ASP.NET)
Após completar a página mestra ), será necessário localizar o registro solicitado no banco de 
dados e exibi-lo na página de detalhes. O procedimento consiste em definir um DataSet 
(Conjunto de dados) na página de detalhes para conter um único registro (o registro solicitado 
pela página mestra) e ligar as colunas do DataSet à página.

Para localizar e exibir o registro solicitado na página de detalhes:

1. Alterne para a página de detalhes.

Se não existir uma página, selecione File (Arquivo) > New (Novo) > Dynamic (Dinâmico), 
selecione um formato de página ASP.NET e clique em Create (Criar). Uma página .aspx 
em branco é aberta no Dreamweaver.

2. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 
de adição (+) e selecione DataSet (Query) [Conjunto de dados (Consulta)] no menu pop-
up.

Será exibida a caixa de diálogo simples DataSet. Se em vez dela for exibida a caixa de 
diálogo DataSet avançada, clique em Simple (Simples) para alternar para a caixa de 
diálogo DataSet simples.

3. Atribua um nome ao DataSet e selecione uma conexão e uma tabela de banco de dados que 
fornecerá dados ao DataSet.

4. Na área Columns (Colunas), selecione as colunas da tabela a serem incluídas no DataSet.

O DataSet pode ser idêntico ou diferente do DataSet da página mestra. Normalmente, o 
DataSet de uma página de detalhes possui mais colunas para exibir mais detalhes.
Se os DataSets forem diferentes, certifique-se de que o DataSet da página de detalhes 
contenha, no mínimo, uma coluna em comum com o DataSet da página mestra. 
Normalmente, a coluna em comum é a coluna de identificação do registro, mas pode ser 
também o campo de junção das tabelas relacionadas.
Para incluir apenas algumas das colunas da tabela no DataSet, clique na opção Selected 
(Selecionado) e escolha as colunas desejadas pressionando a tecla Control (no Windows) 
ou Command (no Macintosh) enquanto clica em cada uma delas na lista.
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5. Preencha a seção Filter (Filtro) para localizar e exibir o registro especificado no parâmetro 
da URL repassado pela página de resultados, do seguinte modo:

■ No primeiro menu pop-up da área Filter, selecione a coluna do DataSet que contém os 
valores correspondentes ao valor do parâmetro da URL repassado pela página mestra.
Por exemplo: se o parâmetro da URL contiver um número de identificação de registro, 
selecione a coluna que contém os números de identificação de registro. No exemplo 
apresentado na seção anterior, a coluna do DataSet denominada CODE (CÓDIGO) 
contém os valores correspondentes ao valor do parâmetro da URL repassado pela 
página mestra.

■ Selecione o sinal de igual (caso ainda não esteja selecionado) no menu pop-up ao lado 
do primeiro menu. 

■ Selecione URL Parameter (Parâmetro da URL) no terceiro menu pop-up.
A página mestra utiliza um parâmetro da URL para repassar informações para a página 
de detalhes.

■ Digite o nome do parâmetro da URL repassado pela página mestra na quarta caixa.
Por exemplo, se a URL utilizada pela página mestra para abrir a página de detalhes 
tiver incluído o sufixo locationDetail.aspx?recordID=CBR, digite recordID.

A caixa de diálogo DataSet deverá ter a seguinte aparência:

6. Clique em OK.

O DataSet é exibido no painel Bindings.
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7. Ligue as colunas do DataSet à página de detalhes selecionando-as no painel Bindings, em 
Window > Bindings e arrastando-as até a página.

Para obter mais informações, consulte “Tornar dinâmico o texto” na página 783.

A página mestra/detalhes ASP.NET definida está concluída. 

Após a criação das páginas-mestras/detalhes, é possível usar o painel Server Behaviors 
(Window > Server Behaviors) para modificar os vários blocos de criação.

Criar uma página de busca do banco de 
dados (ASP.NET)
O Dreamweaver pode ser utilizado para criar uma página para fazer buscas em um banco de 
dados e exibir os resultados em uma DataGrid.

Esta seção descreve as etapas para criar uma página de busca do banco de dados:

■ “Adicionar os controles de busca (ASP.NET)” na página 1004
■ “Fazer buscas com apenas um parâmetro de busca (ASP.NET)” na página 1005
■ “Fazer uma busca com diversos parâmetros de busca (ASP.NET)” na página 1007
■ “Exibir os resultados em uma DataGrid” na página 1008
■ “Ocultar a DataGrid (Grade de dados) na primeira vez em que a página for carregada” na 

página 1009
■ “Criar uma página de detalhes (ASP.NET)” na página 1010

Adicionar os controles de busca (ASP.NET)
Normalmente, as páginas de busca na Web contêm campos de formulário, nos quais o usuário 
digitará os parâmetros de busca. Quando o usuário clica em um botão, são exibidos os 
resultados da busca.

Para adicionar o formulário de busca à página: 

1. Abra a página de busca e selecione Insert (Inserir) > Form (Formulário) > Form.

Um formulário vazio é criado na página. Pode ser necessário ativar Invisible Elements 
(Elementos invisíveis), em View (Exibir) > Visual Aids (Auxílios visuais) > Invisible 
Elements, para exibir os limites do formulário, que são representados por linhas finas 
vermelhas.
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No Property inspector (Inspetor de propriedades) do formulário, selecione POST 
(TRANSMITIR) como atributo Method (Método) do formulário. Não é necessário 
especificar um atributo Action (Ação) para o formulário. A página ASP.NET será 
retransmitida para si mesma, e os resultados da busca serão exibidos na mesma página.

2. Adicione controles de formulário para que os usuários insiram os parâmetros de busca, em 
Insert > ASP.NET Objects (Objetos ASP.NET).

É possível inserir qualquer controle de formulário ASP.NET, como TextBox (Caixa de 
texto), CheckBox (Caixa de seleção), RadioButton (Botão de opção), ListBox (Caixa de 
lista) ou DropDownList (Lista suspensa). Você pode adicionar quantos controles desejar 
para auxiliar os usuários a aprimorarem suas buscas. Contudo, lembre-se de que quanto 
mais parâmetros de busca na página, mais complexa será a instrução SQL.
Para cada controle, especifique um atributo ID (Identificação), como txtCity (para um 
controle TextBox) ou lbxCountry (para um controle ListBox).
Para obter mais informações, consulte “Adicionar controles de formulário ASP.NET a uma 
página” na página 987.

3. Adicione um botão ASP.NET ao formulário, em Insert > ASP.NET Objects (Objetos 
ASP.NET) > asp:Button (Botão asp:).

Especifique um atributo ID para o botão, como btnSearch, e um texto para o identificador 
do botão, como Search.

O formulário de busca está pronto. A próxima etapa na criação da página de busca é definir 
um DataSet para localizar e armazenar os resultados da busca.

Fazer buscas com apenas um parâmetro de busca 
(ASP.NET)
Quando o usuário clica no botão Search (Busca) da página, o parâmetro de busca é enviado ao 
servidor. O servidor processa a solicitação, cria um DataSet (Conjunto de dados) filtrado com 
base no parâmetro, preenche uma DataGrid (Grade de dados) e reenvia a página ao 
navegador.

Antes de adicionar a DataGrid, é necessário definir um DataSet que localize e armazene todos 
os registros que atendam aos critérios de busca.

Para criar um DataSet que conterá os resultados da busca:

1. No painel Bindings (Ligações), em Window > Bindings, clique no botão com sinal de 
adição (+) e selecione DataSet (Query) [Conjunto de dados (Consulta)].

Se a caixa de diálogo avançada for exibida, clique no botão Simple (Simples) para abrir a 
caixa de diálogo simples.
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2. Atribua um nome ao DataSet. Em seguida, escolha uma conexão e uma tabela de banco de 
dados que contenha os dados que os usuários poderão buscar.

3. Na área Columns (Colunas), clique na opção Selected (Selecionado) e selecione uma 
coluna de chave (em geral, a coluna de identificação de registro) e as colunas que contêm 
os dados a serem exibidos na DataGrid.

Mantenha a caixa de diálogo DataSet aberta, por enquanto. Ela será utilizada em seguida para 
recuperar os parâmetros de busca enviados ao servidor e criar um filtro DataSet para excluir 
registros que não atendam aos parâmetros.

Para criar um filtro DataSet:

1. No primeiro menu pop-up da área Filter (Filtro), selecione uma coluna na tabela que será 
comparada com o parâmetro de busca enviado pela página de busca.

Por exemplo: se o valor enviado pela página de busca for um nome de cidade, selecione a 
coluna na tabela que contiver nomes de cidades.

2. No menu pop-up ao lado do primeiro menu, selecione o sinal de igual (que deve ser 
o padrão). 

Esta opção informa que o usuário deseja apenas os registros nos quais a coluna da tabela 
selecionada for exatamente a mesma que a especificada na página de busca. É possível 
utilizar uma opção menos restritiva, como “begins with” (começa com) ou “contains” 
(contém).

3. No terceiro menu pop-up, selecione Form Variable (Variável de formulário).

O parâmetro é enviado ao servidor por um formulário, utilizando o método POST 
(TRANSMITIR).

4. Na quarta caixa de texto, digite o nome do controle de formulário que enviou o parâmetro 
de busca ao servidor.

É possível obter o nome clicando no controle de formulário no formulário (para selecioná-
lo) e verificando a identificação do controle no Property inspector (Inspetor de 
propriedades).

5. Se desejar, clique em Test (Testar), digite um valor de teste e clique em OK para se conectar 
ao banco de dados e criar uma instância do DataSet.

O valor de teste simula o valor que teria sido retornado da página de busca. Clique em OK 
para fechar o DataSet.

6. Se estiver satisfeito com o DataSet, clique em OK.
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O Dreamweaver insere na página um código que, ao ser executado no servidor, verificará cada 
registro na tabela do banco de dados. Se o campo especificado em um registro atender à 
condição de filtragem, o registro será incluído em um DataSet. O código válido criará um 
recordset que contém apenas os resultados da busca.

A próxima etapa na criação da página de busca é exibir os resultados da busca em uma 
DataGrid. Consulte “Exibir os resultados em uma DataGrid” na página 1008.

Fazer uma busca com diversos parâmetros de busca 
(ASP.NET)
Se a página de busca enviar mais de um parâmetro de busca ao servidor, será 
necessário desenvolver uma consulta SQL e utilizar os parâmetros de busca em variáveis SQL. 

Para efetuar uma busca dos registros de um banco de dados utilizando SQL:

1. Abra a página de resultados no Dreamweaver. Em seguida, crie um novo DataSet abrindo 
o painel Bindings (Ligações), em Window (Janela) > Bindings, clicando no botão com sinal 
de adição (+) e selecionando DataSet no menu pop-up.

2. Verifique se a caixa de diálogo avançada DataSet é exibida.

Se a caixa de diálogo simples for exibida, alterne para a caixa de diálogo simples clicando 
no botão Advanced (Avançado).

3. Digite um nome para o DataSet e escolha uma conexão.

A conexão deve ocorrer com um banco de dados que contenha os dados 
a serem pesquisados pelo usuário.

4. Insira uma instrução Select na área de texto SQL.

Certifique-se de que a instrução inclua uma cláusula WHERE com os alocadores de 
espaço ponto de interrogação (?) para os parâmetros de busca. O exemplo a seguir contém 
dois alocadores de espaço:
SELECT EMPLOYEEID, FIRSTNAME, LASTNAME, DEPARTMENT, EXTENSION
FROM EMPLOYEE WHERE LASTNAME LIKE ?
AND DEPARTMENT LIKE ?

Para obter ajuda sobre a sintaxe de SQL, consulte Apêndice B, “Manual básico de SQL”, 
na página 1101.

N
O

T
A

Se houver apenas uma condição de busca, a caixa de diálogo simples DataSet 
(Conjunto de dados) poderá ser utilizada para definir o DataSet (consulte “Fazer buscas 
com apenas um parâmetro de busca (ASP.NET)” na página 1005).
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5. Atribua aos alocadores de espaço os valores dos parâmetros de busca, clicando no botão 
com sinal de adição (+) na área Parameters (Parâmetros) e digitando o nome, o tipo e o 
valor do parâmetro.

É necessário que os parâmetros sejam listados na mesma ordem em que aparecem na 
instrução SQL. 
Na caixa de texto Name (Nome), digite qualquer nome de parâmetro válido. O nome não 
pode conter espaços nem caracteres especiais.
No menu pop-up Type (Tipo), selecione um tipo de dados. Por exemplo, se o parâmetro 
for utilizado para conter texto, selecione WChar.
Na caixa de texto Value (Valor), digite a variável de servidor que conterá o valor do 
parâmetro. Por exemplo, se o nome do controle de formulário na página de busca for 
txtCity, uma variável de servidor denominada Request.Form(“txtCity”) será criada e um 
valor será armazenado nela. 
Também é possível inserir uma expressão mais completa que especifique um valor padrão 
caso não exista a variável de servidor. Por exemplo, ao fazer buscas em um banco de dados 
do Microsoft Access, você poderá utilizar % como valor padrão. A expressão a seguir 
verifica se a variável de servidor Request.Form("txtCity") existe. Se a variável existir 
(ou seja, se for diferente de 'nothing'), a expressão retornará o valor da variável. Se a 
variável não existir, a expressão retornará o valor padrão %.
(IIf((Request.Form("txtCity") <> Nothing),
Request.Form("txtCity"), "")) + "%"

Para obter mais informações, consulte uma referência de linguagem Visual Basic ou C#.
6. Se desejar, clique em Test (Testar) para criar uma instância do DataSet utilizando os valores 

padrão das variáveis.

Os valores padrão simulam os valores que seriam retornados da página de busca. Clique 
em OK para fechar o DataSet de teste.

7. Se estiver satisfeito com o DataSet, clique em OK.

O Dreamweaver inserirá uma consulta SQL na página.

A próxima etapa é exibir os resultados da busca em uma DataGrid. 

Exibir os resultados em uma DataGrid
Depois de criar um DataSet (Conjunto de dados) para conter os resultados da busca , é 
possível utilizar uma DataGrid (Grade de dados) para exibir as informações na página.
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Para exibir os resultados da busca em uma DataGrid:

1. Na página de busca, posicione o ponto de inserção no local em que deseja que a DataGrid 
seja exibida.

2. No painel Server Behaviors (Comportamentos de servidor), em Window > Server 
Behaviors, clique no botão com sinal de adição (+) e selecione DataGrid.

Será exibida a caixa de diálogo DataGrid.
3. Na caixa de texto ID (Identificação), digite um nome para a DataGrid, como dgLocation.

4. No menu pop-up DataSet, selecione o DataSet definido para conter os resultados da busca.

5. Preencha o restante da caixa de diálogo conforme desejar.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.

Este é o exemplo de uma caixa de diálogo DataGrid que criará uma DataGrid com três 
colunas e dez linhas, além de links para as páginas de resultados anterior e seguinte.

A DataGrid será exibida na primeira vez que a página de busca for carregada, mesmo que o 
usuário ainda não tenha feito nenhuma busca. É possível ocultar a DataGrid quando a página 
for carregada pela primeira vez. 

Ocultar a DataGrid (Grade de dados) na primeira vez 
em que a página for carregada
Quando a página de busca é carregada pela primeira vez, é possível ocultar a DataGrid que 
será utilizada para exibir os resultados da busca.
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Para ocultar a DataGrid na primeira vez que a página for carregada:

1. Abra a página de busca na visualização do código, em View (Exibir) > Code (Código).

2. Logo após a diretiva Register (Registro) localizada na parte superior da página, digite o 
seguinte bloco de código, caso a linguagem da página seja o Visual Basic:
<script runat="server">
Sub Page_Load()

If Not IsPostBack Then 
dgName.Visible = false

Else
dgName.Visible = true

End If
End Sub
</script>

onde dgName é o ID de sua DataGrid. 
Se a linguagem da página for C#, digite o seguinte código:
<script runat="server">
void Page_Load() {

if (!IsPostBack) { 
dgName.Visible = false;

} else {
dgName.Visible = true;

}
}
</script>

3. Salve a página.

Criar uma página de detalhes (ASP.NET)
A página de busca pode incluir uma página de detalhes para exibir mais informações sobre 
determinados registros relacionados na DataGrid (Grade de dados). Neste caso, a página de 
busca atua como a página mestra em um conjunto de páginas-mestras/detalhes. Para obter 
mais informações, consulte “Criar páginas-mestras/detalhes (ASP.NET)” na página 997.

Criar uma página de inserção de registros 
(ASP.NET)
O Dreamweaver pode ser utilizado para criar uma página em que os usuários poderão inserir 
novos registros em um banco de dados. O método utilizado é idêntico para todas as 
tecnologias de servidor suportadas pelo Dreamweaver. Para obter instruções, consulte “Criar 
uma página de inserção de registros (todos os servidores)” na página 944.
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Criar páginas para atualizar um registro 
(ASP.NET)
O aplicativo pode conter um conjunto de páginas em que os usuários poderão atualizar os 
registros existentes em uma tabela de banco de dados. Geralmente as páginas consistem em 
uma página de busca, uma página de resultados e uma página de atualização. A página de 
busca e a página de resultados permitem recuperar o registro e a página de atualização permite 
modificá-lo.

Esta seção descreve as etapas para criar páginas de atualização de um registro:

■ “Procurar o registro a ser atualizado (ASP.NET)” na página 1011
■ “Abrir a página de atualização e repassar a identificação do registro (ASP.NET)” na 

página 1012
■ “Recuperar o registro a ser atualizado (ASP.NET)” na página 1014
■ “Preencher a página de atualização em uma operação (ASP.NET)” na página 1016
■ “Preencher a página de atualização bloco a bloco (ASP.NET)” na página 1017

Tópicos relacionados
■ “Criar uma página de inserção de registros (todos os servidores)” na página 944
■ “Criar páginas para excluir um registro (ASP.NET)” na página 1020

Procurar o registro a ser atualizado (ASP.NET)
Quando os usuários desejam atualizar um registro, é necessário localizá-lo primeiro no banco 
de dados. Da mesma forma, é necessária uma página de busca para interagir com a página de 
atualização. O usuário seleciona o registro a ser atualizado na DataGrid (Grade de dados) de 
resultados gerados na página de busca. Quando o usuário clica no registro, a página de 
atualização é aberta e exibe o registro em um formulário.

Para obter instruções sobre a criação de uma página de busca do registro a ser atualizado, 
consulte “Criar uma página de busca do banco de dados (ASP.NET)” na página 1004.

Após criar a página de busca, a próxima etapa é criar links na página de resultados que, ao 
serem clicados, abrem a página de atualização. 
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Abrir a página de atualização e repassar a 
identificação do registro (ASP.NET)
Após criar a página de busca , é necessário criar links que abram a página de atualização e 
repassem a identificação do registro selecionado pelo usuário. A página de atualização utilizará 
essa identificação para localizar o registro solicitado no banco de dados e exibi-lo.

A identificação do registro é repassada para a página de atualização em um parâmetro da URL. 
Para obter mais informações, consulte “Parâmetros da URL” na página 749.

Esta seção pressupõe que as instruções contidas em “Criar uma página de busca do banco de 
dados (ASP.NET)” na página 1004 foram seguidas, de modo que a página de busca utilize 
uma DataGrid (Grade de dados) para exibir registros. 

Para criar links na página de busca utilizados para abrir a página de 
atualização e repassar a identificação do registro:

1. Abra a página de busca no Dreamweaver.

2. Clique duas vezes no objeto DataGrid listado no painel Server Behaviors 
(Window > Server Behaviors).

Será aberta a caixa de diálogo DataGrid.
3. Na caixa Columns (Colunas), selecione a coluna à qual deseja aplicar links.

4. Clique no botão Change Column Type (Alterar tipo de coluna) e selecione Hyperlink 
(Hiperlink) no menu pop-up.
1012 Capítulo 41:  Criar aplicativos ASP.NET rapidamente



         
Será exibida a caixa de diálogo Hyperlink Column (Coluna de hiperlink).

5. Na área Hyperlink Text (Texto de hiperlink), especifique o texto a ser exibido na coluna 
de hiperlink.

Se desejar criar um link genérico – como Update (Atualização) – para cada linha da 
DataGrid, selecione a opção Static Text (Texto estático) e digite o texto do link. Todas as 
linhas da DataGrid exibirão o mesmo texto (como Update) na coluna de hiperlink. 
Para adicionar links aos dados exibidos na coluna, selecione a opção Data Field (Campo 
de dados) e um campo de dados no DataSet. O campo de dados fornece o texto para os 
links da coluna de hiperlink. No exemplo a seguir, todas as linhas da DataGrid exibirão 
um nome de local. 

6. Na área Linked Page (Página vinculada), crie a URL a ser aplicada ao texto na coluna de 
hiperlink. 

Além de abrir a página de atualização, a URL também deve identificar de modo exclusivo 
o registro a ser exibido nessa página.
Para identificar o registro a ser exibido na página de atualização, selecione a opção Data 
Field (Campo de dados) e um campo no DataSet que identifique cada registro de modo 
exclusivo. Na maioria dos casos, o campo consistirá em um número de identificação de 
registro. No exemplo a seguir, o campo consiste em códigos de local exclusivos.
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7. Na caixa de texto Format String (Formatar a seqüência de caracteres) na área Linked Page, 
clique no botão Browse (Procurar). Depois localize e selecione a página de atualização. 

O Dreamweaver cria uma URL para a página de atualização contendo um parâmetro da 
URL que identifica o registro a ser exibido pela página de atualização. Anote o nome do 
parâmetro de URL, pois ele será utilizado na página de atualização posteriormente. 
Por exemplo, se locationUpdate.aspx for selecionada como a página de atualização, o 
Dreamweaver criará a seguinte URL e a exibirá na caixa de texto Format String:
locationUpdate.aspx?CODE={0}

Nesse caso, o Dreamweaver cria um parâmetro de URL denominado CODE (CÓDIGO). 
O Dreamweaver copia o nome do campo de dados, mas não é obrigatório usar esse nome. 
É possível alterá-lo na caixa de texto Format String para algo mais descritivo (como 
recordID), como no exemplo a seguir.
locationUpdate.aspx?recordID={0}

O elemento {0} é um alocador de espaço que corresponde ao valor do campo de dados. 
Quando a página for executada, os valores do campo CODE do DataSet serão inseridos 
nas linhas correspondentes da DataGrid. Por exemplo, se o local de locação Canberra, na 
Austrália, apresentar o código CBR, será utilizada a seguinte URL na linha Canberra do 
DataGrid: 
locationUpdate.aspx?recordID=CBR

8. Clique em OK para fechar a caixa de diálogo Hyperlink (Hiperlink) e, em seguida, clique 
em OK para fechar a caixa de diálogo DataGrid (Grade de dados).

O Dreamweaver atualizará a DataGrid na página.

Depois de criar links que abrem a página de atualização e repassam a identificação do registro 
selecionado pelo usuário, a página de atualização deverá recuperar o registro a ser atualizado. 

Recuperar o registro a ser atualizado (ASP.NET)
Depois que a página de busca repassar à página de atualização um parâmetro de URL , a 
página de atualização deverá ler o parâmetro, recuperar o registro da tabela de banco de dados 
e armazená-lo temporariamente em um DataSet (Conjunto de dados).

Para recuperar um registro a ser atualizado: 

1. Crie uma nova página ASP.NET no Dreamweaver e salve-a.

Essa página será a página de atualização.
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2. No painel Bindings (Ligações), em Window > Bindings, clique no botão com sinal de 
adição (+) e selecione DataSet (Query) [Conjunto de dados (Consulta)].

Se a caixa de diálogo avançada for exibida, clique no botão Simple (Simples) para abrir a 
caixa de diálogo simples.

3. Atribua um nome ao DataSet. Em seguida, escolha uma conexão e uma tabela de banco de 
dados que contenha os dados que os usuários poderão atualizar.

4. Clique na opção Selected (Selecionado) e escolha uma coluna de chave (em geral, a coluna 
de identificação de registro) e as colunas que contêm os dados a serem atualizados.

5. Configure a área Filter (Filtro) para que o valor da coluna de chave seja igual ao valor do 
parâmetro da URL correspondente repassado pela página de busca.

Esse tipo de filtro cria um DataSet que contém apenas um registro — o registro com uma 
identificação que corresponde ao valor do parâmetro de URL. Por exemplo, se a coluna-
chave contiver informações de identificação de registro e for denominada CODE, e a 
página de busca repassar as informações de identificação de registro correspondentes no 
parâmetro de URL denominado recordID, a área Filter deverá ter a seguinte aparência:

6. Clique em OK.

Quando o usuário selecionar um registro na página de busca, a página de atualização 
produzirá um DataSet que contém apenas o registro selecionado. 
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Após modificar a página de atualização para recuperar um registro do banco de dados e 
armazená-lo em um DataSet, você deve adicionar um formulário para que os usuários possam 
modificar os dados do registro. Também é necessário adicionar a lógica necessária para 
atualizar o banco de dados. Essas tarefas podem ser realizadas em uma operação ou bloco a 
bloco. Consulte “Preencher a página de atualização em uma operação (ASP.NET)” na 
página 1016 ou “Preencher a página de atualização bloco a bloco (ASP.NET)” na 
página 1017. 

Preencher a página de atualização em uma operação 
(ASP.NET)
Uma página de atualização é composta por três blocos de criação:

■ Um DataSet (Conjunto de dados) filtrado para recuperar o registro a partir de uma tabela 
de banco de dados (consulte “Recuperar o registro a ser atualizado (ASP.NET)” na 
página 1014).

■ Um formulário HTML que permite aos usuários modificar os dados do registro
■ Um comportamento de servidor Update Record (Atualizar registro) para atualizar a tabela 

de banco de dados.

Os dois blocos de criação finais de uma página de atualização podem ser adicionados em uma 
única operação utilizando o objeto de aplicativo Record Update Form (Formulário de 
atualização de registros). O objeto de aplicativo adiciona à página um formulário HTML e 
um comportamento de servidor Update Record. 

Para que o objeto de aplicativo possa ser utilizado, o aplicativo para a Web deve identificar o 
registro a ser atualizado e a página de atualização deve ser capaz de recuperá-lo. Consulte o 
“Procurar o registro a ser atualizado (ASP.NET)” na página 1011, o “Abrir a página de 
atualização e repassar a identificação do registro (ASP.NET)” na página 1012 e o “Recuperar o 
registro a ser atualizado (ASP.NET)” na página 1014.

Após o objeto de aplicativo colocar os blocos de criação na página, utilize as ferramentas de 
projeto do Dreamweaver para personalizar o formulário de acordo com suas preferências ou o 
painel Server Behaviors para editar o comportamento de servidor Update Record.

N
O

T
A

A página de atualização pode conter apenas um comportamento de servidor de edição 
de registros de cada vez. Por exemplo, não é possível adicionar um comportamento de 
servidor Insert Record ou Delete Record à página de atualização.
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Para criar a página de atualização com o objeto de aplicativo Record Update 
Form:

1. Abra a página na visualização do projeto e selecione Insert (Inserir) > Application Objects 
(Objetos de aplicativo) > Update Record (Atualizar registro) > Record Update Form 
Wizard (Assistente Formulário de atualização de registros).

Será exibida a caixa de diálogo Record Update Form (Formulário de atualização de 
registros).

2. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

O objeto de aplicativo adiciona à página um formulário HTML e um comportamento de 
servidor Update Record. Os objetos de formulário são dispostos em uma tabela básica, que 
pode ser personalizada utilizando as ferramentas de desenvolvimento de projetos de página do 
Dreamweaver Verifique se todos os objetos do formulário estão dentro dos limites do 
formulário.

Para editar o comportamento de servidor, abra o painel Server Behaviors, em Window > 
Server Behaviors, e clique duas vezes no comportamento Update Record.

Preencher a página de atualização bloco a bloco 
(ASP.NET)
Uma página de atualização é composta por três blocos de criação:

■ Um DataSet (Conjunto de dados) filtrado para recuperar o registro a partir de uma tabela 
de banco de dados (consulte “Recuperar o registro a ser atualizado (ASP.NET)” na 
página 1014).

■ Um formulário HTML que permite aos usuários modificar os dados do registro
■ Um comportamento de servidor Update Record (Atualizar registro) para atualizar a tabela 

de banco de dados.

Os dois blocos de criação básicos finais de uma página de atualização podem ser adicionados 
separadamente utilizando as ferramentas de formulário e o painel Server Behaviors 
(Comportamentos de servidor).

Antes de adicionar os blocos, o aplicativo da Web deve identificar o registro a ser atualizado e 
a página de atualização deve ser capaz de recuperá-lo. Consulte o “Procurar o registro a ser 
atualizado (ASP.NET)” na página 1011, o “Abrir a página de atualização e repassar a 
identificação do registro (ASP.NET)” na página 1012 e o “Recuperar o registro a ser 
atualizado (ASP.NET)” na página 1014.
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O preenchimento da página de atualização consiste em três etapas:

■ Adicionar um formulário HTML à página para que os usuários possam modificar os 
dados

■ Exibir o registro no formulário ligando os objetos do formulário a colunas da tabela de 
banco de dados

■ Adicionar o comportamento de servidor Update Record para atualizar a tabela de banco 
de dados depois que o usuário modificar o registro

Para adicionar um formulário HTML a uma página de atualização:

1. Crie uma nova página ASP.NET.

Essa será sua página de atualização.
2. Crie o layout da página com as ferramentas de projeto do Dreamweaver.

3. Adicione um formulário HTML posicionando o ponto de inserção no local em que deseja 
exibir o formulário e selecione Form (Formulário) no menu Insert (Inserir).

Um formulário vazio é criado na página. Pode ser necessário ativar Invisible Elements 
(Elementos invisíveis), em View (Exibir) > Visual Aids (Auxílios visuais) > Invisible 
Elements, para exibir os limites do formulário, que são representados por linhas finas 
vermelhas.

4. Atribua um nome ao formulário HTML clicando na tag <form> na parte inferior da janela 
do documento para selecionar o formulário e, em seguida, abra o Property inspector 
(Inspetor de propriedades), em Window (Janela) > Properties (Propriedades), e digite um 
nome na caixa Form Name (Nome do formulário).

Não é necessário especificar um atributo action (ação) ou method (método) para o 
formulário, para informá-lo para onde e como serão enviados os dados do registro quando 
o usuário clicar no botão Submit (Enviar). O comportamento de servidor Update Record 
define esses atributos para o usuário.

5. Adicione um objeto de formulário, como um campo de texto, em Insert > Form > Text 
Field, para cada coluna que deseja atualizar na tabela de banco de dados.

Os objetos do formulário permitem que os usuários modifiquem os dados. Os campos de 
texto servem comumente a este objetivo, mas também podem ser utilizados listas/menus, 
caixas de seleção e botões de opção. 
A cada objeto de formulário deve corresponder uma coluna no DataSet definido 
anteriormente. A única exceção é a coluna de chave exclusiva, à qual não deve 
corresponder nenhum objeto de formulário.
Para obter mais informações sobre objetos de formulário, consulte “Inserir objetos de 
formulário HTML” na página 892.
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6. Adicione ao formulário um botão Submit, a partir de Insert > Form > Button (Botão).

O identificador do botão Submit pode ser alterado do seguinte modo: selecione o botão, 
abra o Property inspector, em Window > Properties, e digite um novo valor na caixa de 
texto Label (Identificador).

Para exibir o registro no formulário:

1. Verifique se definiu um DataSet para conter o registro que o usuário deseja atualizar.

Para obter mais informações, consulte “Recuperar o registro a ser atualizado (ASP.NET)” 
na página 1014.

2. Ligue todos os objetos de formulário aos dados do recordset.

Para obter mais informações, consulte as seguintes seções:
■ “Exibir conteúdo dinâmico em campos de texto HTML” na página 900
■ “Pré-selecionar dinamicamente caixas de seleção HTML” na página 900
■ “Pré-selecionar dinamicamente botões de opção HTML” na página 901
■ “Criar um menu de formulário HTML dinâmico” na página 898
■ “Tornar dinâmicos menus de formulário HTML existentes” na página 899

Para adicionar um comportamento de servidor a fim de atualizar a tabela do 
banco de dados: 

1. No painel Server Behaviors, em Window > Server Behaviors, clique no botão com sinal de 
adição (+) e selecione Update Record no menu pop-up.

Será exibida a caixa de diálogo Update Record.
2. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

O Dreamweaver adiciona à página um comportamento de servidor que permite aos usuários 
atualizar registros em um banco de dados clicando no botão Submit no formulário.

Para editar o comportamento de servidor, abra o painel Server Behaviors, em Window > 
Server Behaviors, e clique duas vezes no comportamento Update Record.

Tópicos relacionados
■ “Preencher a página de atualização em uma operação (ASP.NET)” na página 1016
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Criar páginas para excluir um registro 
(ASP.NET)
O aplicativo pode conter um conjunto de páginas que permite que os usuários excluam 
registros de um banco de dados. Geralmente as páginas consistem em uma página de busca e 
uma página de exclusão. A página de busca permite recuperar o registro, e a página de exclusão 
permite excluí-lo.

Esta seção descreve as etapas para criar páginas ASP.NET que excluem registros: 

■ “Procurar o registro a ser excluído (ASP.NET)” na página 1020
■ “Criar links Delete (Excluir) na página de busca (ASP.NET)” na página 1020
■ “Exibir o registro na página de confirmação (ASP.NET)” na página 1023
■ “Adicionar lógica para excluir o registro (ASP.NET)” na página 1027

Procurar o registro a ser excluído (ASP.NET)
Quando os usuários planejam excluir um registro, é necessário localizá-lo primeiro no banco 
de dados. Da mesma forma, é necessária uma página de busca para interagir com a página de 
exclusão. Os critérios de busca são digitados na página de busca e o registro é selecionado nos 
resultados de busca exibidos em uma DataGrid (Grade de dados). Quando o usuário clica no 
registro, a página de exclusão é aberta e exibe o registro em um formulário HTML.

Para obter instruções sobre a criação de uma página de busca do registro a ser excluído, 
consulte “Criar uma página de busca do banco de dados (ASP.NET)” na página 1004.

Após criar a página de busca, a próxima etapa é adicionar à DataGrid existente nessa página 
hiperlinks ou botões Delete (Excluir). 

Criar links Delete (Excluir) na página de busca 
(ASP.NET)
Após criar a página de busca com uma DataGrid (Grade de dados), , é necessário criar links 
que abram a página de confirmação de exclusão e repassem a identificação do registro 
selecionado pelo usuário. A página de confirmação utilizará essa identificação para localizar o 
registro solicitado no banco de dados e exibi-lo.

A identificação de registro é repassada para a página de confirmação em um parâmetro da 
URL. Para obter mais informações, consulte “Parâmetros da URL” na página 749.

É possível criar esses links em uma DataGrid adicionando uma coluna de hiperlink e 
definindo seus atributos, conforme descrito nesta seção.
1020 Capítulo 41:  Criar aplicativos ASP.NET rapidamente



         
Para criar links de exclusão na DataGrid da página de busca:

1. Abra a caixa de diálogo DataGrid criada na seção anterior.

Para abri-la, clique duas vezes na DataGrid no painel Server Behaviors (Comportamentos 
de servidor). Clique duas vezes na DataGrid listada no painel, e não no item DataGrid que 
é exibido no menu pop-up quando você clica no botão de adição (+).
Será aberta a caixa de diálogo DataGrid.

2. Adicione uma coluna de links Delete clicando no botão com sinal de adição (+) e 
selecionando Hyperlink (Hiperlink).

3. Na caixa de texto Title (Título), digite um título de coluna como Delete.

O título será exibido no cabeçalho da coluna.
4. Selecione a opção Static Text (Texto estático) e digite o texto do link – como delete record 

(excluir registro).

Todas as linhas da DataGrid exibirão o mesmo texto na coluna de hiperlink.
A caixa de diálogo DataGrid deverá ter a seguinte aparência:

5. Na área Linked Page (Página vinculada), crie a URL a ser aplicada ao texto na coluna de 
hiperlink.

Além de abrir a página de confirmação, a URL também deve identificar de modo 
exclusivo o registro a ser exibido nessa página.
Para identificar o registro a ser exibido na página de confirmação, selecione a opção Data 
Field (Campo de dados) e um campo no DataSet (Conjunto de dados) que identifique 
cada registro de modo exclusivo. Na maioria dos casos, o campo consistirá em um número 
de identificação de registro.

6. Na caixa de texto Format String (Formatar a seqüência de caracteres) na área Linked Page, 
clique no botão Browse (Procurar). Depois localize e selecione a página de confirmação.
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O Dreamweaver cria uma URL para a página de confirmação contendo um parâmetro da 
URL que identifica o registro a ser exibido pela página de confirmação. Anote o nome do 
parâmetro de URL, pois ele será utilizado na página de confirmação posteriormente.
Por exemplo, se locationDelete.aspx for selecionada como a página de detalhes e CODE 
(CÓDIGO) for selecionado como o campo no DataSet que identifica cada registro de 
forma exclusiva, o Dreamweaver criará a URL a seguir.

Nesse caso, o Dreamweaver cria um parâmetro de URL denominado CODE. O 
Dreamweaver copia o nome do campo de dados, mas não é obrigatório usar esse nome. É 
possível alterá-lo e torná-lo mais descritivo, como recordID, como no exemplo a seguir.
locationDelete.aspx?recordID={0}

O elemento {0} é um alocador de espaço que corresponde ao valor do campo de dados. 
Quando a página for executada, os valores do campo CODE (Código) do DataSet serão 
inseridos nas linhas correspondentes da DataGrid. Por exemplo, se o local de locação 
Canberra, na Austrália, apresentar o código CBR, será utilizada a seguinte URL na linha 
Canberra do DataGrid:
locationDelete.aspx?recordID=CBR

7. Clique em OK para fechar a caixa de diálogo Hyperlink (Hiperlink). Em seguida, clique 
em OK para fechar a caixa de diálogo DataGrid.
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O Dreamweaver atualizará a DataGrid na página. A seguir é apresentada uma DataGrid 
visualizada em um navegador após ser feita uma busca de todas as cidades cujo nome 
começa com a letra c. 

Após criar os links de exclusão, a próxima etapa é exibir o registro na página de confirmação. 

Exibir o registro na página de confirmação 
(ASP.NET)
Após preencher a página que contém os registros , alterne para a página de confirmação de 
exclusão. A página de confirmação mostra o registro e solicita que o usuário confirme se deseja 
excluí-lo. Quando o usuário confirmar a operação clicando no botão Form (Formulário), o 
aplicativo para a Web excluirá o registro do banco de dados. 

A criação dessa página consiste nas seguintes tarefas:

■ Criar um formulário HTML com um botão para clicar e confirmar a exclusão.
■ Recuperar o registro a ser exibido na página.
■ Exibir o registro na página.

A recuperação e a exibição do registro consistem em definir um DataSet (Conjunto de dados) 
para conter um único registro — aquele que o usuário deseja excluir — e ligar as colunas do 
DataSet à página. As etapas estão descritas a seguir, com mais detalhes.
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Para criar um formulário HTML para confirmar a exclusão:

1. Crie uma nova página ASP.NET e salve-a como a página de confirmação especificada na 
seção anterior.

A página de confirmação foi especificada quando você criou os links Delete (Excluir) na 
seção anterior. Utilize esse nome ao salvar o arquivo pela primeira vez (por exemplo, 
locationDelete.aspx).

2. Insira um formulário HTML na página, em Insert (Inserir) > Form > Form.

3. Adicione ao formulário um campo oculto.

O campo oculto do formulário é necessário para armazenar a identificação do registro 
repassada pelo parâmetro da URL. Para adicionar um campo oculto, posicione o ponto de 
inserção no formulário e selecione Insert > Form > Hidden Field (Campo oculto).

4. Adicione um botão ao formulário.

O usuário deve clicar no botão para confirmar e excluir o registro exibido. Para adicionar 
um botão, posicione o ponto de inserção no formulário e selecione Insert > Form > 
Button (Botão).

5. Aperfeiçoe o projeto da página como desejar e salve-a.

Para recuperar o registro que o usuário deseja excluir:

1. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão de adição 
(+) e escolha DataSet (Conjunto de dados) no menu pop-up.

Será exibida a caixa de diálogo simples DataSet. Se em vez dela for exibida a caixa de 
diálogo DataSet avançada, clique em Simple (Simples) para alternar para a caixa de 
diálogo DataSet simples. 

2. Atribua um nome ao DataSet e escolha a tabela de banco de dados que contém os registros 
que podem ser exibidos.

3. Na área Columns (Colunas), selecione as colunas da tabela (campos de registro) que deseja 
exibir na página.

Para exibir apenas alguns dos campos do registro, clique em Selected (Selecionado), 
escolha os campos desejados pressionando a tecla Control (Windows) ou Command 
(Macintosh) enquanto clica em cada um deles na lista.
Você deve incluir o campo de identificação do registro, mesmo que não pretenda exibi-lo.
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4. Preencha a seção Filter (Filtro) para localizar e exibir o registro especificado no parâmetro 
da URL repassado pela página de busca, do seguinte modo:

■ No primeiro menu pop-up da área Filter, selecione a coluna do DataSet que contém os 
valores correspondentes ao valor do parâmetro da URL repassado pela página com os 
links Delete. Por exemplo: se o parâmetro da URL contiver um número de 
identificação de registro, selecione a coluna que contém os números de identificação 
de registro. No exemplo analisado na seção anterior, a coluna do DataSet denominada 
CODE (CÓDIGO) contém os valores correspondentes ao valor do parâmetro da 
URL repassado pelos links Delete.

■ No menu pop-up ao lado do primeiro menu, selecione o sinal de igual, se ainda não 
tiver sido selecionado.

■ No terceiro menu pop-up, selecione URL Parameter (Parâmetro da URL). A página 
com os links Delete utiliza um parâmetro da URL para repassar informações à página 
de confirmação.

■ Na quarta caixa, digite o nome do parâmetro da URL repassado pela página com os 
links Delete. 
Por exemplo, se a URL utilizada para abrir a página de confirmação incluir o sufixo 
locationDelete.aspx?recordID=CBR, digite recordID.
A caixa de diálogo DataSet deverá ter a seguinte aparência. 

5. Clique em OK.

O DataSet é exibido no painel Bindings. 
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Para exibir o registro que o usuário deseja excluir:

1. Selecione as colunas do DataSet (campos de registro) no painel Bindings e arraste-as até a 
página de confirmação.

Você deve inserir esse conteúdo dinâmico somente de leitura dentro dos limites do 
formulário. Para obter mais informações sobre como inserir conteúdo dinâmico nas 
páginas, consulte “Tornar dinâmico o texto” na página 783.
Em seguida, ligue a coluna de identificação do registro ao campo oculto do formulário.

2. Certifique-se de que a opção Invisible Elements (Elementos invisíveis) esteja ativada em 
View (Exibir) > Visual Aids (Auxílios visuais) > Invisible Elements. Em seguida, clique no 
ícone amarelo em forma de escudo (que representa o campo oculto do formulário).

O campo oculto do formulário será selecionado.
3. No Property inspector (Inspetor de propriedades), clique no ícone em forma de raio ao lado 

a caixa de texto Value (Valor).

Será exibida a caixa de diálogo Dynamic Data (Dados dinâmicos).
4. Na caixa de diálogo Dynamic Data, selecione a coluna de identificação de registro no 

DataSet e clique em OK.

No exemplo a seguir, a coluna de identificação de registro selecionada é CODE.

5. Salve a página.
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A página de confirmação preenchida deverá ter a aparência a seguir.

Após criar uma página de confirmação, a próxima etapa é adicionar lógica para excluir o 
registro. 

Adicionar lógica para excluir o registro (ASP.NET)
Após a criação da página de confirmação , a próxima etapa consiste em adicionar à página a 
lógica que exclui o registro do banco de dados quando o usuário clica no botão Confirm 
(Confirmar). No Dreamweaver, é possível adicionar esta lógica de modo rápido e fácil 
utilizando o comportamento de servidor Delete Record (Excluir registro).

Para adicionar lógica para exclusão do registro exibido no formulário HTML:

1. Verifique se a página de confirmação está aberta no Dreamweaver.

2. No painel Server Behaviors (Comportamentos de servidor), em Window (Janela) > Server 
Behaviors, clique no botão com sinal de adição (+) e selecione Delete Record.
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A caixa de diálogo Delete Record é exibida. 

3. Na caixa de texto First Check If Variable Is Defined (Primeiramente, verificar se a variável 
está definida), selecione a opção Primary Key Value (Valor da chave primária). 

Especifique o valor da chave primária posteriormente na caixa de diálogo. 
4. No menu pop-up Connection (Conexão), selecione uma conexão com o banco de dados, 

para que a página possa localizar o banco de dados e se conectar a ele.

5. No menu pop-up Table (Tabela), selecione a tabela de banco de dados que contém os 
registros a serem excluídos.

6. No menu pop-up Primary Key Column (Coluna de chave primária), selecione a coluna da 
tabela que contém as identificações do registro.

O comportamento de servidor Delete Record buscará uma correspondência nesta coluna. 
A coluna deve conter os mesmos dados de identificação do registro que a coluna DataSet 
(Conjunto de dados) ligada ao campo oculto do formulário na página.

7. No menu pop-up Submit Primary Key As (Enviar a chave primária como), selecione o tipo 
de dados da coluna de chave primária. 

8. No menu pop-up Primary Key, selecione a variável da página que contém a identificação 
do registro a ser excluído.

A variável é criada pelo campo oculto do formulário. Ela tem o mesmo nome que o 
atributo Name (Nome) do campo oculto e pode ser um formulário ou um parâmetro da 
URL, dependendo do atributo Method (Método) do formulário. Em nosso exemplo, a 
variável em questão é uma variável de formulário chamada hiddenID.
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9. Na caixa de texto On Success, Go To (Se tiver êxito, ir para), especifique uma página a ser 
aberta depois que o registro tiver sido excluído da tabela de banco de dados.

É possível especificar uma página que contenha uma breve mensagem de êxito para o 
usuário ou uma que contenha os registros restantes, para que o usuário possa verificar se o 
registro foi excluído.

10. Se desejar, selecione a opção Display Debugging Information on Failure (Exibir as 
informações de depuração se ocorrerem falhas).

As informações de depuração serão geradas pelo servidor. 
11. Para exibir uma mensagem de erro personalizada, desmarque a opção Display Debugging 

Information on Failure e especifique uma página a ser aberta na caixa de texto On Failure, 
Go To (Se não tiver êxito, ir para).

A caixa de diálogo Delete Record deverá ter a aparência a seguir.

12. Clique em OK e salve o trabalho.

Faça o upload das páginas para o servidor da Web (se necessário), abra um navegador e 
procure um registro a ser excluído. Ao clicar em um link Delete (Excluir) na página de 
resultados, será exibida a página de confirmação. Clique no botão Form (Formulário) para 
excluir o registro do banco de dados. Para confirmar se o registro foi excluído, faça novamente 
uma busca por ele.
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Utilizar procedimentos armazenados 
para modificar bancos de dados 
(ASP.NET)
É possível utilizar um procedimento armazenado para modificar um banco de dados. Um 
procedimento armazenado é um item de banco de dados reutilizável que executa algumas 
operações no banco de dados. 

Antes de utilizar um procedimento armazenado para modificar um banco de dados, 
certifique-se de que o procedimento armazenado contenha o SQL que modifica o banco de 
dados de algum modo. Para criar e armazenar o SQL em seu banco de dados, consulte a 
documentação do banco de dados e um bom manual sobre Transact-SQL.

Para adicionar um procedimento armazenado a uma página ASP.NET:

1. No Dreamweaver, abra a página onde o procedimento armazenado será executado.

2. No painel Bindings (Ligações), em Window > Bindings, clique no botão de adição (+) e 
selecione Stored Procedure.

Será exibida a caixa de diálogo Stored Procedure.

3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

N
O

T
A

Os bancos de dados do Microsoft Access e MySQL não oferecem suporte a 
procedimentos armazenados. 
1030 Capítulo 41:  Criar aplicativos ASP.NET rapidamente



         
Após fechar a caixa de diálogo, o Dreamweaver insere o código ASP.NET em sua página de 
modo que, ao ser executado no servidor, chama um procedimento armazenado no banco de 
dados. O procedimento armazenado, por sua vez, executa uma operação de banco de dados, 
como inserir um registro ou efetuar uma consulta.

Se o procedimento armazenado exigir parâmetros, é possível criar uma página para reunir os 
valores de parâmetros e os submeter em seguida à página com o procedimento armazenado. 
Por exemplo: é possível criar uma página que utiliza parâmetros da URL ou formulário 
HTML para coletar valores de parâmetro de usuários.

Tópicos relacionados
■ “Procedimentos armazenados” na página 913

Criar páginas que restringem o acesso ao 
site (ASP.NET)
O Dreamweaver pode ser utilizado para criar um conjunto de páginas que restringem o acesso 
ao site. Ele não possui comportamentos de servidor de autenticação para páginas ASP.NET. 
No entanto, uma vez que as páginas ASP e ASP.NET podem ser executadas no mesmo site, é 
possível utilizar os comportamentos de servidor de autenticação ASP. O método utilizado para 
criar essas páginas é idêntico ao do ColdFusion. Para obter instruções, consulte “Criar páginas 
que restrinjam o acesso ao site (ColdFusion, ASP, JSP, PHP)” na página 966.
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CAPÍTULO 42

Criar aplicativos ASP e JSP 
rapidamente
É possível utilizar as ferramentas do Macromedia Dreamweaver 8 para criar rapidamente um 
aplicativo ASP ou JSP para a Web, com pouca ou nenhuma codificação.

Tópicos relacionados
■ “Sobre o desenvolvimento rápido de aplicativos (todos os servidores)” na página 909

Criar páginas-mestras/detalhes 
(ASP e JSP)
Com o Dreamweaver, é possível criar conjuntos de páginas que apresentam informações em 
dois níveis de detalhe: uma página mestra que relaciona registros e uma página de detalhes que 
apresenta mais detalhes sobre cada registro. Esta seção descreve como criar páginas-mestras/
detalhes.

Criar páginas-mestras/detalhes em uma operação 
(ASP e JSP)
Ao desenvolver aplicativos ASP ou JSP, é possível criar rapidamente páginas-mestras/detalhes 
utilizando o objeto de aplicativo Master/Detail Page Set (Conjunto de páginas-mestras/
detalhes). Com o objeto de aplicativo é possível criar um conjunto completo de páginas 
dinâmicas simplesmente preenchendo uma ou duas caixas de diálogo.

O método é idêntico àquele utilizado para o ColdFusion. Para obter instruções, consulte 
“Criar páginas-mestras/detalhes em uma operação (ColdFusion, ASP, JSP, PHP)” na 
página 928.

Também é possível criar páginas-mestras/detalhes utilizando comportamentos de servidor 
individuais. 
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Criar páginas-mestras/detalhes bloco a bloco (ASP e 
JSP)
Esta seção descreve como criar um conjunto de páginas-mestras/detalhes sem utilizar o objeto 
de aplicativo Master/Detail Page Set (Conjunto de páginas-mestras/detalhes). Para obter 
instruções sobre como utilizar o objeto de aplicativo, consulte “Criar páginas-mestras/detalhes 
em uma operação (ASP e JSP)” na página 1033.

Esta seção descreve as etapas para a criação de um conjunto de páginas-mestras/detalhes:

■ “Criar uma página mestra e definir um recordset para ela (ASP e JSP)” na página 1034
■ “Exibir os registros na página mestra (ASP e JSP)” na página 1034
■ “Abrir a página de detalhes e repassar uma identificação de registro para ela (ASP e JSP)” 

na página 1035
■ “Localizar e exibir o registro solicitado na página de detalhes (ASP e JSP)” na página 1036

Criar uma página mestra e definir um recordset para ela (ASP 
e JSP)
A primeira etapa para a criação de páginas-mestras/detalhes é criar uma página mestra em 
branco e adicionar a ela um recordset.

Você pode definir um recordset na fase de projeto (consulte “Definir um recordset” na 
página 765), ou o usuário pode defini-la durante a execução (consulte “Criar páginas de 
busca/resultados (ASP e JSP)” na página 1038).

Assegure-se de que o recordset contenha não somente todas as colunas de que você necessitar 
na página mestra, mas também todas as colunas de que necessitar na página de detalhes.

Normalmente, o recordset na página mestra extrai algumas colunas de uma tabela de banco de 
dados, enquanto que o recordset na página detalhes extrai mais colunas da mesma tabela para 
fornecer mais detalhes.

A próxima etapa na criação de páginas-mestras/detalhes é exibir os registros na página mestra.

Exibir os registros na página mestra (ASP e JSP)
Após criar uma página mestra em branco e definir um recordset para ela , é necessário exibir os 
registros na página.
1034 Capítulo 42:  Criar aplicativos ASP e JSP rapidamente



         
Para exibir os registros na página mestra:

1. Crie um layout de página, para exibir diversos registros e ligar as colunas dos recordsets à 
página.

Um método comum consiste em criar uma tabela HTML com duas linhas na página 
mestra e arrastar um número limitado de colunas de recordsets do painel Bindings 
(Ligações), a partir de Window (Janela) > Bindings para a segunda linha da tabela (utilize 
a primeira linha para exibir os cabeçalhos das colunas da tabela).

2. Crie uma região repetida para exibir mais de um registro por vez.

A região repetida normalmente se aplica à linha da tabela que contiver conteúdo 
dinâmico. Para obter mais informações, consulte “Exibir vários resultados de recordsets” 
na página 806.

A próxima etapa na criação de páginas-mestras/detalhes é abrir a página de detalhes e repassar 
uma identificação de registro para ela. 

Abrir a página de detalhes e repassar uma identificação de 
registro para ela (ASP e JSP)
Após criar a página mestra e exibir registros nela , é necessário criar links para abrir a página de 
detalhes e repassar a identificação do registro que o usuário selecionou para a página de 
detalhes.

Para abrir a página de detalhes e repassar para ela um parâmetro de URL que 
identifique o registro a ser exibido: 

1. Na região repetida da página mestra, selecione o conteúdo dinâmico que atuará como link.

2. No painel Server Behaviors (Comportamentos de servidor), a partir de Window (Janela) > 
Server Behaviors, clique no botão com sinal de adição (+) e selecione Go to Detail Page (Ir 
para a página Detalhes) no menu pop-up.

A caixa de diálogo Go to Detail Page é exibida.
3. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

O Dreamweaver coloca um link especial ao redor do texto selecionado. Quando o usuário 
clica no link, o comportamento de servidor Go to Detail Page repassa o parâmetro da URL 
que contém a identificação do registro para a página de detalhes. Por exemplo: se o parâmetro 
da URL for denominado id e a página de detalhes for denominada detalhesdocliente.asp, 
quando o usuário clicar no link, a URL terá uma aparência semelhante à seguinte:

http://www.meusite.com/detalhesdocliente.asp?id=43
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A primeira parte da URL, http://www.meusite.com/detalhesdocliente.asp, abrirá a página de 
detalhes. A segunda parte, ?id=43, é o parâmetro da URL. Ela indica à página de detalhes qual 
registro deverá ser localizado e exibido. O termo id é o nome do parâmetro da URL e 43 é o 
seu valor. Neste exemplo, o parâmetro da URL contém o número de identificação do registro, 
43.

Para obter mais informações, consulte “Parâmetros da URL” na página 749.

A próxima etapa na criação de páginas-mestras/detalhes é localizar e exibir o registro solicitado 
na página de detalhes.

Localizar e exibir o registro solicitado na página de detalhes 
(ASP e JSP)
Depois de completar a página mestra , é necessário localizar o registro solicitado no banco de 
dados e exibi-lo na página de detalhes. O procedimento consiste em definir um recordset para 
manter um único registro (o registro solicitado pela página mestra) e ligar as colunas do 
recordset à página.

Para localizar e exibir o registro solicitado na página de detalhes: 

1. Alterne para a página de detalhes ou crie uma nova página ASP ou JSP, se ainda não existir 
uma.

2. No painel Bindings (Ligações), em Window (Janela)> Bindings, clique no botão com o 
sinal de adição (+) e selecione Recordset no menu pop-up.

Será exibida a caixa de diálogo Recordset simples. Se a caixa de diálogo avançada aparecer, 
clique em Simple (Simples) para alternar.

3. Atribua um nome ao recordset e selecione uma conexão e uma tabela de banco de dados 
que fornecerão dados ao recordset.

4. Na área Column (Coluna), selecione as colunas da tabela a serem incluídas no recordset.

O recordset pode ser idêntico ou diferente do recordset na página mestra. Normalmente, 
um recordset de uma página de detalhes possui mais colunas para exibir mais detalhes.
Se os recordsets forem diferentes, o recordset na página de detalhes deverá conter ao 
menos uma coluna em comum com a página mestra. Normalmente, a coluna em comum 
é a coluna de identificação do registro, mas pode ser também o campo de junção das 
tabelas relacionadas.
Para incluir apenas algumas das colunas da tabela no recordset, clique em Selected 
(Selecionado) e escolha as colunas desejadas clicando na lista e pressionando 
simultaneamente a tecla Control (no Windows) ou Command (no Macintosh).
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5. Preencha a seção Filter (Filtro) para localizar e exibir o registro especificado no parâmetro 
da URL, repassado pela página de resultados, do seguinte modo:

■ No primeiro menu pop-up da área Filter, selecione a coluna da tabela do banco de 
dados que contém os valores que coincidem com o valor do parâmetro da URL 
transferido da página mestra. 
Por exemplo: se o parâmetro da URL contiver um número de identificação de registro, 
selecione a coluna que contém os números de identificação de registro.

■ No menu pop-up ao lado do primeiro menu, selecione o sinal de igual (que já deve ter 
sido selecionado).

■ No terceiro menu pop-up, selecione URL Parameter (Parâmetro da URL).
A página mestra repassará as informações que identificam a seleção do usuário para a 
página de detalhes em um parâmetro da URL. 

■ Na quarta caixa de texto, digite o nome do parâmetro da URL repassado pela página 
mestra. 
Por exemplo: se a URL da página mestra utilizada para abrir a página de detalhes for 
www.meusite.com/detalhesdocliente.asp?id=43, digite id.
Também é possível obter o nome alternando para a página mestra, abrindo o painel 
Server Behaviors (Comportamentos de servidor), em Window > Server Behaviors, e 
clicando duas vezes no comportamento de servidor Go to Detail Page (Ir para a página 
Detalhes). Verifique o nome associado à opção Pass URL Parameter (Repassar o 
parâmetro da URL).

6. Clique em OK.

O recordset é exibido no painel Bindings.
7. Ligue as colunas do recordset à página de detalhes, selecionando-as no painel Bindings 

(Window > Bindings) e arrastando-as até a página.

A definição da página mestra/detalhes está concluída. 

Após a criação da página mestra/detalhes, é possível utilizar o painel Server Behaviors, em 
Window > Server Behaviors para modificar os diversos comportamentos de servidor.
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Criar páginas de busca/resultados (ASP 
e JSP)
O Dreamweaver pode ser utilizado para criar um conjunto de páginas que permitam que os 
usuários efetuem buscas no banco de dados. O método é idêntico àquele utilizado para o 
ColdFusion. Para obter instruções, consulte “Criar páginas de busca/resultados (ColdFusion, 
ASP, JSP, PHP)” na página 937.

Criar uma página de inserção de registro 
(ASP e JSP)
O Dreamweaver pode ser utilizado para criar uma página em que os usuários poderão inserir 
novos registros em um banco de dados. O método utilizado é idêntico para todas as 
tecnologias de servidor suportadas pelo Dreamweaver. Para obter instruções, consulte “Criar 
uma página de inserção de registros (todos os servidores)” na página 944.

Criar páginas para atualizar um registro 
(ASP e JSP)
O aplicativo pode conter um conjunto de páginas em que os usuários poderão atualizar os 
registros existentes em uma tabela de banco de dados. Geralmente as páginas consistem em 
uma página de busca, uma página de resultados e uma página de atualização. A página de 
busca e a página de resultados permitem recuperar o registro e a página de atualização permite 
modificá-lo.

Esta seção descreve as etapas para a criação de uma página para atualização de registros:

■ “Procurar o registro a ser atualizado (ASP e JSP)” na página 1039
■ “Abrir a página de atualização e repassar a identificação do registro (ASP e JSP)” na 

página 1039
■ “Recuperar o registro a ser atualizado (ASP e JSP)” na página 1040
■ “Preencher a página de atualização em uma única operação (ASP e JSP)” na página 1041
■ “Preencher a página de atualização bloco a bloco (ASP e JSP)” na página 1042

Tópicos relacionados
■ “Criar uma página de inserção de registros (todos os servidores)” na página 944
■ “Criar páginas para exclusão de um registro (ASP e JSP)” na página 1045
1038 Capítulo 42:  Criar aplicativos ASP e JSP rapidamente



         
Procurar o registro a ser atualizado (ASP e JSP)
Quando os usuários desejam atualizar um registro, é necessário localizá-lo primeiro no banco 
de dados. Da mesma forma, são necessárias as páginas de busca e de resultados para 
funcionarem com a página de atualização. Os critérios de busca são digitados na página de 
busca e o registro é selecionado na página de resultados. Quando o usuário clica no registro, a 
página de atualização é aberta e exibe o registro em um formulário HTML.

Para obter instruções sobre a criação de páginas de busca do registro a ser atualizado, consulte 
“Criar páginas de busca/resultados (ColdFusion, ASP, JSP, PHP)” na página 937.

Após criar as páginas de busca/resultados, a próxima etapa na criação de uma página de 
atualização de registro é criar links na página de resultados que, quando clicados, abrirão a 
página de atualização. 

Abrir a página de atualização e repassar a 
identificação do registro (ASP e JSP)
Após criar as páginas de busca/resultados, é necessário criar links na página de resultados que 
abram a página de atualização e repassem a identificação do registro selecionado pelo usuário. 
A página de atualização utilizará essa identificação para localizar o registro solicitado no banco 
de dados e exibi-lo.

A identificação do registro é repassada para a página de atualização em um parâmetro da URL. 
Para obter mais informações, consulte “Parâmetros da URL” na página 749.

Para criar links para abrir a página de atualização e transferir a identificação 
do registro:

1. Na página de resultados, selecione o alocador de espaço do conteúdo dinâmico do texto a 
ser exibido como link.

2. No painel Server Behaviors (Comportamentos de servidor), a partir de Window (Janela) > 
Server Behaviors, clique no botão com sinal de adição (+) e selecione Go to Detail Page (Ir 
para a página Detalhes) no menu pop-up.

Será exibida a caixa de diálogo Go to Detail Page.
3. Na caixa de texto Detail Page (Página Detalhes), clique em Browse (Procurar) e localize a 

página de atualização.

4. Dê um nome ao parâmetro da URL e especifique o recordset e a coluna que contêm a 
identificação do registro que deseja repassar para a página de atualização.

Anote o nome do parâmetro da URL, pois ele será utilizado na página de atualização 
posteriormente.
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5. Clique em OK.

O Dreamweaver insere um link especial à página. Quando o usuário clica no link, um 
parâmetro da URL que contém a identificação do registro é repassado para a página de 
atualização.

A próxima etapa na criação de uma página de atualização de registro é recuperar o registro a 
ser atualizado. 

Recuperar o registro a ser atualizado (ASP e JSP)
Após a página de resultados repassar para a página de atualização um parâmetro da URL que 
identifica o registro a ser atualizado , a página de atualização deverá ler o parâmetro, recuperar 
o registro a partir da tabela do banco de dados e armazená-lo temporariamente em um 
recordset.

Para recuperar um registro a ser atualizado: 

1. Crie uma nova página ASP ou JSP no Dreamweaver e salve-a.

Essa página será a página de atualização.
2. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 

de adição (+) e selecione Recordset.

Se a caixa de diálogo avançada for exibida, clique no botão Simple (Simples) para abrir a 
caixa de diálogo simples.

3. Atribua um nome ao recordset e especifique o local onde estão os dados a serem atualizados 
utilizando os menus pop-up Connection (Conexão) e Table (Tabela).

4. Clique na opção Selected (Selecionado) e escolha uma coluna de chave (em geral, a coluna 
de identificação de registro) e as colunas que contêm os dados a serem atualizados.

5. Configure a área Filter (Filtro) para que o valor da coluna de chave seja igual ao valor do 
parâmetro da URL correspondente repassado pela página de resultados.

Este tipo de filtro cria um recordset que contém apenas o registro especificado pela página 
de resultados. Por exemplo: se a coluna-chave contiver informações de identificação de 
registro e for chamada PRID e se a página de resultados repassar as informações de 
identificação de registro correspondentes no parâmetro da URL id, a área Filter terá a 
seguinte aparência:

6. Clique em OK.
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Quando o usuário seleciona um registro na página de resultados, a página de atualização 
produzirá um recordset contendo apenas o registro selecionado.

Depois de modificar a página de atualização para recuperar um registro do banco de dados e 
armazená-lo em um recordset, é necessário adicionar um formulário para que os usuários 
possam modificar os dados do registro e a lógica necessária para atualizar o banco de dados. 
Essas tarefas podem ser realizadas em uma operação ou bloco a bloco. Consulte “Preencher a 
página de atualização em uma única operação (ASP e JSP)” na página 1041 ou “Preencher a 
página de atualização bloco a bloco (ASP e JSP)” na página 1042. 

Preencher a página de atualização em uma única 
operação (ASP e JSP)
Uma página de atualização é composta por três blocos de criação:

■ Um recordset filtrado para recuperar o registro a partir de uma tabela de banco de dados 
(consulte “Recuperar o registro a ser atualizado (ASP e JSP)” na página 1040).

■ Um formulário HTML que permite aos usuários modificar os dados do registro
■ Um comportamento de servidor Update Record (Atualizar registro) para atualizar a tabela 

de banco de dados.

Os dois blocos de criação finais de uma página de atualização podem ser adicionados em uma 
única operação utilizando o objeto de aplicativo Record Update Form (Formulário de 
atualização de registros). O objeto de aplicativo adiciona à página um formulário HTML e 
um comportamento de servidor Update Record. 

Para que o objeto de aplicativo possa ser utilizado, o aplicativo para a Web deve identificar o 
registro a ser atualizado e a página de atualização deve ser capaz de recuperá-lo. Consulte o 
“Procurar o registro a ser atualizado (ASP e JSP)” na página 1039, o “Abrir a página de 
atualização e repassar a identificação do registro (ASP e JSP)” na página 1039 e o “Recuperar 
o registro a ser atualizado (ASP e JSP)” na página 1040.

Após o objeto de aplicativo colocar os blocos de criação na página, utilize as ferramentas de 
projeto do Dreamweaver para personalizar o formulário de acordo com suas preferências ou o 
painel Server Behaviors para editar o comportamento de servidor Update Record.

N
O

T
A

A página de atualização pode conter apenas um comportamento de servidor de edição 
de registros de cada vez. Por exemplo, não é possível adicionar um comportamento de 
servidor Insert Record ou Delete Record na página de atualização.
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Para criar a página de atualização com o objeto de aplicativo Record Update 
Form:

1. Abra a página de atualização na visualização do projeto e selecione Insert > Application 
Objects > Update Record > Record Update Form Wizard.

Será exibida a caixa de diálogo Record Update Form (Formulário de atualização de 
registros).

2. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

O objeto de aplicativo adiciona à página um formulário HTML e um comportamento de 
servidor Update Record. Os objetos de formulário são dispostos em uma tabela básica, que 
pode ser personalizada utilizando as ferramentas de desenvolvimento de projetos de página do 
Dreamweaver Verifique se todos os objetos do formulário estão dentro dos limites do 
formulário.

Para editar o comportamento de servidor, abra o painel Server Behaviors, em Window > 
Server Behaviors, e clique duas vezes no comportamento Update Record.

Preencher a página de atualização bloco a bloco 
(ASP e JSP)
Uma página de atualização é composta por três blocos de criação:

■ Um recordset filtrado para recuperar o registro a partir de uma tabela de banco de dados 
(consulte “Recuperar o registro a ser atualizado (ASP e JSP)” na página 1040).

■ Um formulário HTML que permite aos usuários modificar os dados do registro
■ Um comportamento de servidor Update Record (Atualizar registro) para atualizar a tabela 

de banco de dados.

Os dois blocos de criação básicos finais de uma página de atualização podem ser adicionados 
separadamente utilizando as ferramentas de formulário e o painel Server Behaviors 
(Comportamentos de servidor).

Antes de adicionar os blocos, o aplicativo da Web deve identificar o registro a ser atualizado e 
a página de atualização deve ser capaz de recuperá-lo. Consulte o “Procurar o registro a ser 
atualizado (ASP e JSP)” na página 1039, o “Abrir a página de atualização e repassar a 
identificação do registro (ASP e JSP)” na página 1039 e o “Recuperar o registro a ser 
atualizado (ASP e JSP)” na página 1040.
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O preenchimento da página de atualização consiste em três etapas:

■ Adicionar um formulário HTML à página para que os usuários possam modificar os 
dados

■ Exibir o registro no formulário ligando os objetos do formulário a colunas da tabela de 
banco de dados

■ Adicionar o comportamento de servidor Update Record para atualizar a tabela de banco 
de dados depois que o usuário modificar o registro e clicar no botão do formulário

Para adicionar um formulário HTML a uma página de atualização: 

1. Crie uma nova página ASP ou JSP, em File (Arquivo) > New (Novo).

Essa página será a página de atualização.
2. Crie o layout da página com as ferramentas de projeto do Dreamweaver.

3. Adicione um formulário HTML colocando o ponto de inserção no local em que deseja que 
o formulário seja exibido e selecione Insert (Inserir) > Form (Formulário) > Form.

Um formulário vazio é criado na página. Pode ser necessário ativar Invisible Elements 
(Elementos invisíveis), em View (Exibir) > Visual Aids (Auxílios visuais) > Invisible 
Elements, para exibir os limites do formulário, que são representados por linhas finas 
vermelhas.

4. Atribua um nome ao formulário HTML clicando na tag <form> na parte inferior da janela 
do documento para selecionar o formulário e, em seguida, abra o Property inspector 
(Inspetor de propriedades), em Window (Janela) > Properties (Propriedades), e digite um 
nome na caixa Form Name (Nome do formulário).

Não é necessário especificar um atributo action (ação) ou method (método) para o 
formulário, para informá-lo para onde e como serão enviados os dados do registro quando 
o usuário clicar no botão Submit (Enviar). O comportamento de servidor Update Record 
define esses atributos para o usuário.

5. Adicione um objeto de formulário, como um campo de texto, em Insert > Form > Text 
Field, para cada coluna que deseja atualizar na tabela de banco de dados.

Os objetos de formulário destinam-se à entrada de dados. Os campos de texto servem 
comumente a esse objetivo, mas também é possível usar menus, caixas de seleção e botões 
de opção. 
A cada objeto de formulário deve corresponder uma coluna no recordset definido 
anteriormente. A única exceção é a coluna de chave exclusiva, à qual não deve 
corresponder nenhum objeto de formulário.
Para obter mais informações, consulte “Inserir objetos de formulário HTML” na 
página 892.
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6. Adicione ao formulário um botão Submit, a partir de Insert > Form > Button (Botão).

O identificador do botão Submit pode ser alterado do seguinte modo: selecione o botão, 
abra o Property inspector, em Window > Properties, e digite um novo valor na caixa Label 
(Identificador).

Para exibir o registro no formulário:

1. Certifique-se de ter definido um recordset para conter o registro que o usuário deseja 
atualizar.

Para obter mais informações, consulte “Recuperar o registro a ser atualizado (ASP e JSP)” 
na página 1040.

2. Ligue cada objeto do formulário aos dados do recordset, conforme descrito nas seções a 
seguir:

■ “Exibir conteúdo dinâmico em campos de texto HTML” na página 900
■ “Pré-selecionar dinamicamente caixas de seleção HTML” na página 900
■ “Pré-selecionar dinamicamente botões de opção HTML” na página 901
■ “Criar um menu de formulário HTML dinâmico” na página 898
■ “Tornar dinâmicos menus de formulário HTML existentes” na página 899

Para adicionar um comportamento de servidor a fim de atualizar a tabela do 
banco de dados: 

1. No painel Server Behaviors, em Window > Server Behaviors, clique no botão com sinal de 
adição (+) e selecione Update Record no menu pop-up.

Será exibida a caixa de diálogo Update Record.
2. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

O Dreamweaver adiciona à página um comportamento de servidor que permite aos usuários 
atualizar registros em um banco de dados clicando no botão Submit no formulário.

Para editar o comportamento de servidor, abra o painel Server Behaviors, em Window > 
Server Behaviors, e clique duas vezes no comportamento Update Record.

Tópicos relacionados
■ “Preencher a página de atualização em uma única operação (ASP e JSP)” na página 1041
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Criar páginas para exclusão de um 
registro (ASP e JSP)
O aplicativo pode conter uma página que permite aos usuários excluir os registros existentes 
em uma tabela de banco de dados. Uma página de exclusão é normalmente uma página de 
detalhes que funciona em conjunto com uma página de resultados. A página de resultados 
permite que o usuário selecione um registro a ser excluído. Em seguida, repassa a seleção para 
a página de exclusão.

Uma página de exclusão é composta por quatro blocos de criação:

■ Um recordset filtrado para recuperar o registro a partir de uma tabela de banco de dados 
(consulte “Recuperar o registro a ser excluído (ASP e JSP)” na página 1046).

■ Uma exibição somente de leitura dos dados que serão excluídos (consulte “Exibir os dados 
a serem excluídos (ASP e JSP)” na página 1046)

■ Um botão Submit (Enviar), que serve para enviar o comando de exclusão ao servidor 
(consulte “Enviar o comando de exclusão ao servidor (ASP e JSP)” na página 1047)

■ Um comportamento de servidor Delete Record (Excluir registro) para atualizar a tabela do 
banco de dados (consulte “Excluir o registro da tabela de banco de dados (ASP e JSP)” na 
página 1048)

Tópicos relacionados
■ “Criar uma página de inserção de registro (ASP e JSP)” na página 1038
■ “Criar páginas para atualizar um registro (ASP e JSP)” na página 1038

Identificar o registro a ser excluído (ASP e JSP)
Quando os usuários planejam excluir um registro, é necessário localizá-lo primeiro no banco 
de dados. Da mesma forma, são necessárias as páginas de busca e de resultados para 
funcionarem com a página de exclusão. Para obter instruções sobre a criação das páginas de 
busca e de resultados, consulte “Criar páginas de busca/resultados (ASP e JSP)” na 
página 1038.

A página de resultados informa à página de exclusão qual registro será excluído repassando-lhe 
um parâmetro da URL. A próxima etapa será recuperar o registro a ser excluído. 

N
O

T
A

A página de exclusão pode conter apenas um comportamento de servidor de edição 
de registros de cada vez. Por exemplo, não é possível adicionar um comportamento 
de servidor Insert Record ou Update Record à página de exclusão.
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Recuperar o registro a ser excluído (ASP e JSP)
Após a página de resultados repassar o parâmetro da URL para a página de exclusão que 
identifica o registro a ser excluído , a página de exclusão deverá ler o parâmetro, recuperar o 
registro na tabela do banco de dados e armazená-lo temporariamente em um recordset.

Para recuperar um registro a ser excluído:

1. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 
de adição (+) e selecione Recordset.

Se a caixa de diálogo avançada for exibida, clique no botão Simple (Simples) para abrir a 
caixa de diálogo simples.

2. Atribua um nome ao recordset e especifique o local onde estão os dados a serem excluídos 
através dos menus pop-up Connection (Conexão) e Table (Tabela).

3. Na área Columns (Coluna), selecione a opção All (Todas) para selecionar todas as colunas 
da tabela de banco de dados.

4. Configure a área Filter (Filtro) para que o valor da coluna de chave seja igual ao valor do 
parâmetro da URL correspondente repassado pela página de resultados.

Este tipo de filtro cria um recordset que contém apenas o registro especificado pela página 
de resultados. Por exemplo: se a coluna-chave contiver informações de identificação de 
registro e for chamada PRID e se a página de resultados repassar as informações de 
identificação de registro correspondentes no parâmetro da URL id, a área Filter terá a 
seguinte aparência:

5. Clique em OK.

Quando o usuário selecionar um registro na página de resultados, a página de exclusão 
produzirá um recordset contendo apenas o registro selecionado. 

A próxima etapa na criação de uma página para excluir registros é exibir o registro a ser 
excluído.

Exibir os dados a serem excluídos (ASP e JSP)
Após recuperar o registro a ser excluído, é recomendável exibir o registro para que o usuário 
possa confirmar a exclusão.
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Para adicionar uma exibição somente de leitura do registro a ser excluído:

1. Certifique-se de ter definido um recordset para conter o registro que o usuário deseja 
excluir.

Para obter mais informações, consulte “Recuperar o registro a ser excluído (ASP e JSP)” na 
página 1046.

2. Arraste uma coluna do recordset do painel Bindings (Ligações), em Window > Bindings, 
até a página.

O conteúdo dinâmico é exibido na página. Este conteúdo pode ser colocado na página em 
sua forma original na página ou em uma tabela HTML. Para obter mais informações, 
consulte “Tornar dinâmico o texto” na página 783.

A próxima etapa na criação de uma página para excluir registros é enviar o comando de 
exclusão ao servidor.

Enviar o comando de exclusão ao servidor (ASP e 
JSP)
Após recuperar e exibir o registro a ser excluído, é necessário adicionar um botão para o 
usuário clicar e excluir o registro. A página de exclusão utiliza um botão de formulário Submit 
(Enviar) para enviar o comando de exclusão ao servidor. Para adicionar à página um 
botão Submit, é necessário criar um formulário HTML. O formulário pode conter apenas o 
botão Submit.

Para adicionar um botão Submit à página de exclusão: 

1. Na visualização do projeto, coloque o ponto de inserção no local em que deseja que o botão 
Submit seja exibido e selecione Insert (Inserir) > Form (Formulário) > Form.

Um formulário vazio é criado na página. Pode ser necessário ativar Invisible Elements 
(Elementos invisíveis), em View (Exibir) > Visual Aids (Auxílios visuais) > Invisible 
Elements, para exibir os limites do formulário, que são representados por linhas finas 
vermelhas.

2. Atribua um nome ao formulário HTML clicando na tag <form> na parte inferior da janela 
do documento para selecionar o formulário e, em seguida, abra o Property inspector 
(Inspetor de propriedades), em Window (Janela) > Properties (Propriedades), e digite um 
nome na caixa Form Name (Nome do formulário).

Não é necessário especificar um atributo action (ação) ou method (método) para o 
formulário, para informá-lo para onde e como serão enviados os dados do registro quando 
o usuário clicar no botão Submit (Enviar). O comportamento de servidor Delete Record 
(Excluir registro) define esses atributos para o usuário.
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3. Adicione ao formulário um botão Submit, a partir de Insert > Form > Button (Botão).

4. Se desejar, altere o identificador do botão Submit do seguinte modo: selecione o botão, abra 
o Property Inspector, em Window > Properties e digite um novo valor na caixa Label 
(Identificador).

A próxima etapa é a inclusão do comportamento de servidor Delete Record para atualizar a 
tabela de banco de dados depois que o usuário clicar no botão Submit.

Excluir o registro da tabela de banco de dados (ASP 
e JSP)
Depois de adicionar um botão para o usuário clicar e excluir o registro ), a etapa final é 
adicionar o comportamento de servidor Delete Record (Excluir registro) para atualizar a 
tabela de banco de dados depois que o usuário clicar no botão Submit (Enviar).

Para adicionar um comportamento de servidor que exclua a tabela de banco 
de dados: 

1. No painel Server Behaviors (Comportamentos de servidor), a partir de Window (Janela) > 
Server Behaviors, clique no botão com sinal de adição (+) e selecione Delete Record 
(Excluir registro) no menu pop-up.

A caixa de diálogo Delete Record é exibida.

2. Preencha a caixa de diálogo.

Para obter mais informações, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

O Dreamweaver adiciona à página um comportamento de servidor que permite aos usuários 
excluir registros em uma tabela de banco de dados clicando no botão Submit.
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Criar páginas com objetos avançados de 
manipulação de dados (ASP e JSP)
É possível utilizar o Dreamweaver para criar páginas que utilizam procedimentos 
armazenados, objetos de comando ASP e instruções preparadas JSP.

Utilizar procedimentos armazenados para modificar 
bancos de dados (ASP e JSP)
É possível utilizar um procedimento armazenado para modificar um banco de dados. Um 
procedimento armazenado é um item de banco de dados reutilizável que executa algumas 
operações no banco de dados.

Antes de utilizar um procedimento armazenado para modificar um banco de dados, 
certifique-se de que o procedimento armazenado contenha o SQL que modifica o banco de 
dados de algum modo. Para criar e armazenar o SQL em seu banco de dados, consulte a 
documentação do banco de dados e um bom manual sobre Transact-SQL.

A forma de utilização de um procedimento armazenado varia em função do modelo de 
servidor.

Tópicos relacionados
■ “Procedimentos armazenados” na página 913

Executar um procedimento armazenado (ASP)
Com as páginas ASP, é necessário adicionar um objeto de comando a uma página para 
executar um procedimento armazenado. Para obter mais informações sobre objetos de 
comando, consulte “Objetos de comando, ASP” na página 914.

Para adicionar um procedimento armazenado a uma página ASP:

1. No Dreamweaver, abra a página onde o procedimento armazenado será executado.

2. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 
de adição (+) e selecione Command (Stored Procedure) [Comando (Procedimento 
armazenado)].

A caixa de diálogo Command é exibida.

N
O

T
A

Os bancos de dados mySQL e Microsoft Access não oferecem suporte para 
procedimentos armazenados. 
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3. Digite um nome para o comando, selecione uma conexão ao banco de dados que contém 
o procedimento armazenado e selecione Stored Procedure no menu pop-up Type (Tipo).

4. Selecione o procedimento armazenado expandindo a ramificação Stored Procedures 
(Procedimentos armazenados) na caixa Database Itens (Itens de banco de dados), 
selecionando o procedimento armazenado na lista e clicando no botão Procedure 
(Procedimento).

5. Insira os parâmetros necessários na tabela Variables (Variáveis).

Não é necessário inserir parâmetros para a variável RETURN_VALUE.
6. Clique em OK.

Quando você fecha a caixa de diálogo, o Dreamweaver insere o código ASP em sua página de 
modo que, ao ser executado no servidor, cria um objeto de comando que ativa o 
procedimento armazenado no banco de dados. O procedimento armazenado, por sua vez, 
executa uma operação de banco de dados, como inserir um registro.

Por padrão, o código define a propriedade Prepared (Preparado) do objeto de comando como 
true, o que faz o servidor de aplicativos reutilizar uma única versão compilada do objeto 
sempre que o procedimento armazenado for executado. Se o comando tiver de ser executado 
diversas vezes, uma única versão compilada do objeto pode melhorar a eficiência de operações 
de banco de dados. No entanto, se o comando for executado apenas uma ou duas vezes, o uso 
de um único comando poderá tornar lento o procedimento do aplicativo para a Web, pois o 
sistema deve ser interrompido para compilar o comando. Para alterar a configuração, alterne 
para a visualização do código e modifique a propriedade Prepared para false.

Se o procedimento armazenado exigir parâmetros, é possível criar uma página para reunir os 
valores de parâmetros e os submeter em seguida à página com o procedimento armazenado. 
Por exemplo: é possível criar uma página que utiliza parâmetros da URL ou formulário 
HTML para coletar valores de parâmetro de usuários.

Executar um procedimento armazenado (JSP)
Com as páginas JSP, é necessário adicionar um comportamento de servidor Callable 
(Chamável) a uma página para executar um procedimento armazenado.

N
O

T
A

Nem todos os provedores de banco de dados oferecem suporte a comandos 
preparados. Se o banco de dados não tiver suporte para esses comandos, uma 
mensagem de erro poderá surgir quando você executar a página. Alterne para a 
visualização do código e modifique a propriedade Prepared para false.
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Para adicionar um procedimento armazenado a uma página JSP:

1. No Dreamweaver, abra a página onde o procedimento armazenado será executado.

2. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 
de adição (+) e selecione Callable (Stored Procedure) [Chamável (Procedimento 
armazenado)].

A caixa de diálogo Callable (Stored Procedure) é exibida.
3. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

Após fechar a caixa de diálogo Callable (Stored Procedure), o Dreamweaver insere o código 
JSP na página de modo que, ao ser executado no servidor, chamará um procedimento 
armazenado no banco de dados. O procedimento armazenado, por sua vez, executa uma 
operação de banco de dados, como inserir um registro.

Se o procedimento armazenado exigir parâmetros, é possível criar uma página para reunir os 
valores de parâmetros e os submeter em seguida à página com o procedimento armazenado. 
Por exemplo: é possível criar uma página que utiliza parâmetros da URL ou formulário 
HTML para coletar valores de parâmetro de usuários.

Utilizar comandos ASP para modificar um banco de 
dados
O Dreamweaver pode ser utilizado para criar objetos de comando ASP para inserir, atualizar 
ou excluir registros em um banco de dados. Um objeto de comando é um objeto de servidor 
que executa algumas operações em um banco de dados. O objeto de comando pode ser 
fornecido com a instrução SQL que executa a operação no banco de dados. Para obter mais 
informações, consulte “Objetos de comando, ASP” na página 914.

Também é possível fornecer o objeto com um procedimento armazenado que execute a 
operação. Para obter mais informações, consulte “Executar um procedimento armazenado 
(ASP)” na página 1049.

Para criar um objeto de comando que utilize SQL para editar um banco de 
dados:

1. No Dreamweaver, abra a página ASP onde que irá executar o comando.

2. Abra o painel Server Behaviors (Comportamentos de servidor), em Window (Janela) > 
Server Behaviors, clique no botão com sinal de adição (+) e selecione Command 
(Comando). 

A caixa de diálogo Command é exibida.
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3. Digite um nome para o comando, selecione uma conexão para o banco de dados contendo 
os registros que deseja editar e selecione a operação de edição que deseja efetuar: Insert 
(Inserir), Update (Atualizar) ou Delete (Excluir). 

O Dreamweaver inicia a instrução SQL com base no tipo de operação selecionada. Por 
exemplo, se você selecionar Insert, a caixa de diálogo terá a seguinte aparência: 

4. Preencha a instrução SQL. 

Para obter mais informações sobre como criar instruções SQL para modificar bancos de 
dados, consulte um manual Transact-SQL.

5. Use a área Variables (Variáveis) para definir qualquer variável de SQL. 

O exemplo a seguir exibe uma instrução Insert que contém três variáveis SQL. Os valores 
dessas variáveis são fornecidos por parâmetros da URL repassados à página, conforme 
definidos na coluna Run-time Value (Valor em tempo de execução) da área Variables 
(Variáveis). 

Após fechar a caixa de diálogo, o Dreamweaver insere o código ASP em sua página de 
modo que, ao ser executado no servidor, cria um comando que insere, atualiza ou exclui 
registros no banco de dados.
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Por padrão, o código define a propriedade Prepared (Preparado) do objeto de comando 
para true, que faz o servidor de aplicativos reutilizar uma única versão compilada do 
objeto sempre que o comando for executado. Para alterar esta configuração, alterne para a 
visualização do código e modifique a propriedade Prepared para false.

Seguindo o exemplo anterior, provavelmente uma página com um formulário HTML seria 
então criada, de modo que os usuários pudessem digitar dados de registro. O formulário 
HTML conteria três campos de texto (txtCity, txtAddress e txtPhone) e um botão de envio. O 
formulário utilizaria o método GET e enviaria os valores do campo de texto à página que 
contém o comando.

Utilizar as instruções preparadas JSP para modificar 
um banco de dados
O Dreamweaver pode ser utilizado para criar instruções preparadas JSP para inserir, atualizar 
ou excluir registros em um banco de dados. Uma instrução JSP preparada é um objeto de 
servidor reutilizável que contém uma instrução SQL. A instrução preparada pode ser 
fornecida com o SQL que executa a operação no banco de dados. Para obter mais 
informações, consulte “Instruções preparadas, JSP” na página 914.

Para criar uma instrução preparada que edita um registro de banco de dados:

1. No Dreamweaver, abra a página JSP que irá executar o comando.

2. Abra o painel Server Behaviors (Comportamentos de servidor), em Window (Janela) > 
Server Behaviors, clique no botão com o sinal de adição (+) e selecione Prepared (Insert, 
Update, Delete) [Preparado (Inserir, Atualizar, Excluir)]. 

Será exibida a caixa de diálogo Prepared (Insert, Update, Delete):
3. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
4. Clique em OK.

Após fechar a caixa de diálogo, o Dreamweaver insere o código JSP em sua página de modo 
que, ao ser executado no servidor, cria uma instrução preparada que insere, atualiza ou exclui 
registros no banco de dados. 
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Criar páginas que restrinjam o acesso ao 
site (ASP e JSP)
O Dreamweaver pode ser utilizado para criar um conjunto de páginas que restrinjam o acesso 
ao site. O método é idêntico àquele utilizado para o ColdFusion. Para obter instruções, 
consulte “Criar páginas que restrinjam o acesso ao site (ColdFusion, ASP, JSP, PHP)” na 
página 966.

Utilizar o JavaBeans (JSP) 
Os componentes JavaBeans são elementos da arquitetura de aplicativos JSP em várias 
camadas. Normalmente, esses componentes são utilizados como parte de uma camada 
intermediária de lógica de negócios, que efetua a transição da lógica de acesso de dados para a 
lógica de apresentação. Nesses aplicativos, os componentes de software reutilizáveis para Java 
(e não as páginas JSP) contêm a lógica que acessa diretamente o banco de dados.

No Dreamweaver, os componentes de software reutilizáveis para Java são tratados como fontes 
de conteúdo dinâmico das páginas JSP e são exibidos no painel Bindings (Ligações). É 
possível clicar duas vezes nos componentes de software reutilizáveis para Java, no painel 
Bindings, para exibir as suas propriedades e, em seguida, arrastá-las até a página, criando assim 
as referências aos dados dinâmicos.

Pode-se definir também um conjunto de componentes de software reutilizáveis para Java 
como uma fonte de conteúdo dinâmico. Contudo, o Dreamweaver oferece suporte apenas às 
regiões repetitivas e às ligações dinâmicas quando são utilizados os conjuntos de componentes 
de software reutilizáveis para Java.

As cópias da classe dos componentes de software reutilizáveis para Java (ou do arquivo com 
extensão .zip ou .jar, contendo a classe dos componentes) devem residir nos seguintes locais:

■ No sistema que estiver executando o Dreamweaver, uma cópia da classe dos componentes 
de software reutilizáveis para Java deve ficar residente na pasta Configuration/classes 
(Configuração/classes) do Dreamweaver ou no caminho da classe do sistema. O 
Dreamweaver utiliza essa cópia da classe em tempo de projeto.

■ No sistema que estiver executando o servidor do aplicativo JSP, a classe dos componentes 
de software reutilizáveis para Java deve residir no caminho da classe do servidor do 
aplicativo. O servidor do aplicativo utiliza essa cópia da classe em tempo de execução. O 
caminho da classe do servidor de aplicativos varia de um servidor de aplicativos para 
outro, mas geralmente leva a uma pasta WEB-INF com uma subpasta classes/bean. 
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Se o Dreamweaver e o servidor do aplicativo estiverem sendo executados no mesmo sistema e 
o servidor do aplicativo utilizar o caminho de classe do sistema (e não um caminho de classe 
interno), uma única cópia da classe dos componentes de software reutilizáveis para Java 
poderá residir no computador, no caminho da classe do sistema. Tanto o servidor 
de aplicativos como o Dreamweaver utilizarão esta cópia da classe. Caso contrário, as cópias 
da classe dos componentes de software reutilizáveis para Java deverão residir em dois caminhos 
no computador, como descrito acima.

A estrutura da pasta deve corresponder ao pacote de componentes de software reutilizáveis 
para Java. Por exemplo, se o pacote de componentes de software reutilizáveis para Java for 
denominado com.ardvark.myBean, ele deverá ser armazenado em /com/ardvark/ no 
caminho de classe ou na pasta Configuration/classes do Dreamweaver.

Para definir um componente de software reutilizável para Java de uma página 
JSP:

1. Selecione Window (Janela) > Bindings (Ligações) para exibir o painel Bindings.

2. Clique no botão com o sinal de adição (+) e selecione JavaBean (Componente de software 
reutilizável para Java) no menu pop-up.

Será exibida a caixa de diálogo JavaBean. 

3. Preencha a caixa de diálogo e clique em OK.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
4. O componente de software reutilizável para Java recém-definido é exibido no painel 

Bindings.
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Para definir um componente de software reutilizável para Java de uma página 
JSP:

1. Selecione Window (Janela) > Bindings (Ligações) para exibir o painel Bindings.

2. Clique no botão com o sinal de adição (+) e selecione JavaBean (Componente de software 
reutilizável para Java) no menu pop-up.

Será exibida a caixa de diálogo JavaBean Collection. 

3. Preencha a caixa de diálogo e clique em OK.

Para obter instruções, clique no botão Help (Ajuda).
4. O componente de software reutilizável para Java recém-definido será exibido no painel 

Bindings.
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43

CAPÍTULO 43

Criar aplicativos PHP 
rapidamente
As ferramentas do Macromedia Dreamweaver 8 podem ser utilizadas para criar rapidamente 
um aplicativo PHP para a Web, com pouca ou nenhuma codificação.

Tópicos relacionados
■ “Sobre o desenvolvimento rápido de aplicativos (todos os servidores)” na página 909

Criar páginas-mestras/detalhes (PHP)
Com o Dreamweaver, é possível criar conjuntos de páginas que apresentam informações em 
dois níveis de detalhe: uma página mestra que relaciona registros e uma página de detalhes que 
apresenta mais detalhes sobre cada registro. Esta seção descreve como criar esses tipos de 
páginas-mestras/detalhes.

Criar páginas-mestras/detalhes em uma operação 
(PHP)
Ao desenvolver aplicativos PHP, é possível criar rapidamente páginas-mestras/detalhes 
utilizando o objeto de aplicativo Master/Detail Page Set (Conjunto de páginas-mestras/
detalhes). Com o objeto de aplicativo é possível criar um conjunto completo de páginas 
dinâmicas simplesmente preenchendo uma ou duas caixas de diálogo. 

O método é idêntico àquele utilizado para o ColdFusion. Para obter instruções, consulte 
“Criar páginas-mestras/detalhes em uma operação (ColdFusion, ASP, JSP, PHP)” na 
página 928.

Também é possível criar páginas-mestras/detalhes utilizando comportamentos de servidor 
individuais. 
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Criar páginas-mestras/detalhes bloco a bloco (PHP)
É possível adicionar separadamente os blocos de criação básicos das páginas-mestras/detalhes 
utilizando o painel Server Behaviors (Comportamentos de servidor).

Os blocos de criação também podem ser adicionados simultaneamente por meio do objeto de 
aplicativo Master/Detail Page Set (Conjunto de páginas-mestras/detalhes). Para obter mais 
informações, consulte “Criar páginas-mestras/detalhes em uma operação (PHP)” na 
página 1057.

Esta seção descreve as etapas para a criação de um conjunto de páginas-mestras/detalhes:

■ “Criar a página mestra (PHP)” na página 1058
■ “Criar links para a página de detalhes (PHP)” na página 1060
■ “Criar um parâmetro da URL para os links (PHP)” na página 1061
■ “Localizar e exibir o registro solicitado na página de detalhes (PHP)” na página 1062

Criar a página mestra (PHP)
Esta seção descreve como criar uma página mestra que contenha registros de banco de dados. 
É possível utilizar uma tabela dinâmica para listar os registros em uma página PHP.

Antes de iniciar, certifique-se de definir uma conexão de banco de dados para o site. Para obter 
mais informações, consulte Capítulo 28, “Conexões de banco de dados para desenvolvedores 
PHP”, na página 705.

Para criar uma página mestra:

1. No Dreamweaver, crie uma nova página PHP.

Selecione File (Arquivo) > New (Novo) > Dynamic (Dinâmico), selecione PHP e clique 
em Create (Criar).
Será aberta no Dreamweaver uma página PHP em branco.

2. Defina um recordset para a página.

No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com 
sinal de adição (+), selecione Recordset (Query) [Recordset (Consulta)] e preencha a caixa 
de diálogo Recordset. Para obter mais informações, clique no botão Help (Ajuda) da caixa 
de diálogo. Para codificar a sua própria instrução SQL, clique no botão Advanced 
(Avançado) para abrir a caixa de diálogo avançada Recordset.
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Certifique-se de que o recordset contenha todas as colunas da tabela necessárias para criar 
a tabela dinâmica. O recordset deve incluir também a coluna da tabela que contém a chave 
exclusiva de cada registro — ou seja, a coluna de identificação do registro. No exemplo a 
seguir, a coluna CODE (CÓDIGO) contém informações que identificam cada registro de 
modo exclusivo.

Normalmente, o recordset na página mestra extrai algumas colunas de uma tabela de 
banco de dados, enquanto o recordset na página detalhes extrai mais colunas da mesma 
tabela para fornecer mais detalhes.
O recordset pode ser definido em tempo de execução pelo usuário. Para obter mais 
informações, consulte “Criar páginas de busca/resultados (PHP)” na página 1064.

3. Insira uma tabela dinâmica para exibir os registros na página.

Posicione o ponto de inserção no local em que deseja que a tabela dinâmica seja exibida na 
página e selecione Insert (Inserir) > Application Objects (Objetos de aplicativo) > 
Dynamic Data (Dados dinâmicos) > Dynamic Table (Tabela dinâmica).
Será exibida a caixa de diálogo Dynamic Table.
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4. Preencha a caixa de diálogo Dynamic Table e clique em OK.

O Dreamweaver inserirá uma tabela dinâmica na página.
Se precisar de ajuda para preencher a caixa de diálogo Dynamic Table, clique no botão 
Help na caixa de diálogo.

5. Se desejar, exclua a coluna da tabela dinâmica que contém as identificações de registro.

Se não desejar que as identificações de registro sejam exibidas aos usuários, exclua a coluna 
da tabela dinâmica. Clique em qualquer ponto da página para mover o foco para a página. 
Mova o ponteiro próximo à parte superior da coluna na tabela dinâmica até que as células 
da coluna sejam exibidas com um contorno vermelho. Em seguida, clique para selecionar a 
coluna da tabela. Pressione a tecla Delete para excluir a coluna da tabela.

A próxima etapa na criação de páginas-mestras/detalhes é criar links que abram a página de 
detalhes. 

Criar links para a página de detalhes (PHP)
Depois de criar a tabela dinâmica , será necessário criar os links que abrem a página de 
detalhes. Esta seção descreve como criar esses links. A seção a seguir descreve como modificar 
o link de modo que ele também repasse a identificação do registro selecionado pelo usuário. A 
página de detalhes usará essa identificação para localizar o registro solicitado no banco de 
dados e exibi-lo.

Para criar links para a página de detalhes:

1. Na tabela dinâmica, selecione o alocador de espaço do conteúdo dinâmico do texto que 
deseja exibir como link.

No exemplo a seguir, o alocador de espaço {rsLocations.LOCATION_NAME} está 
selecionado. Os links serão aplicados aos nomes de local na coluna.

2. No Property inspector (Inspetor de propriedades), clique no ícone da pasta ao lado do 
campo Link.
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3. Procure e selecione a página de detalhes.

A página de detalhes será exibida no campo Link.
Na tabela dinâmica, o alocador de espaço do conteúdo dinâmico é exibido como um link. 
Se a página for executada em um servidor, você verá que o link é aplicado ao texto em 
todas as linhas da tabela.

A próxima etapa na criação de páginas-mestras/detalhes é criar um parâmetro da URL para 
repassar a identificação do registro selecionado pelo usuário. 

Criar um parâmetro da URL para os links (PHP)
Além de abrir a página de detalhes, os links da tabela dinâmica na página mestra  também 
devem repassar a identificação do registro selecionado pelo usuário. A página de detalhes usará 
essa identificação para localizar o registro solicitado no banco de dados e exibi-lo.

A identificação de registro é repassada para a página de detalhes em um parâmetro da URL. 
Para obter mais informações, consulte “Parâmetros da URL” na página 749.

Esta seção descreve como criar um parâmetro da URL que repasse uma identificação do 
registro para a página de detalhes.

Para criar o parâmetro da URL:

1. Selecione o link na tabela dinâmica.

Se o Live Data (Dados ativos) estiver ativado, selecione o link na primeira linha.
2. No campo Link do Property inspector (Inspetor de propriedades), adicione a seguinte 

seqüência de caracteres ao final da URL:
?recordID=<?php echo $row_recordsetName['fieldName']; ?>

O ponto de interrogação informa o servidor de que haverá um ou mais parâmetros da 
URL. A palavra recordID é o nome do parâmetro de URL (você pode usar qualquer 
nome de sua preferência). Anote o nome do parâmetro da URL, pois ele será utilizado na 
página de detalhes posteriormente.
A expressão após o sinal de igual é o valor do parâmetro. Neste caso, o valor é gerado por 
uma expressão PHP que retorna uma identificação de registro do recordset. É gerada uma 
identificação diferente para cada linha na tabela dinâmica. Na expressão PHP, substitua 
recordsetName pelo nome do recordset e fieldName pelo nome do campo do recordset 
que identifica cada registro de modo exclusivo. Na maioria dos casos, o campo consistirá 
em um número de identificação de registro. No exemplo a seguir, o campo consiste em 
códigos de local exclusivos.
locationDetail.php?recordID=<?php echo $row_rsLocations['CODE']; ?>
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Quando a página for executada, os valores do campo CODE (CÓDIGO) do recordset 
serão inseridos nas linhas correspondentes da tabela dinâmica. Por exemplo, se o local de 
locação Canberra, na Austrália, apresentar o código CBR, será utilizada a seguinte URL na 
linha Canberra da tabela dinâmica:
locationDetail.php?recordID=CBR

3. Salve a página.

A etapa seguinte na criação de páginas-mestras/detalhes é modificar a página de detalhes para 
que ela possa localizar o registro solicitado no banco de dados e exibi-lo.

Localizar e exibir o registro solicitado na página de detalhes 
(PHP)
Depois de preencher a página mestra , alterne para a página de detalhes. É necessário localizar 
o registro solicitado no banco de dados e exibi-lo na página. O procedimento consiste em 
definir um recordset para manter um único registro (o registro solicitado pela página mestra) e 
ligar as colunas do recordset à página.

Para localizar e exibir o registro solicitado na página de detalhes:

1. Alterne para a página de detalhes ou crie uma nova página PHP, se ainda não existir.

2. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 
de adição (+) e selecione Recordset (Query) [Recordset (Consulta)] no menu pop-up.

Será exibida a caixa de diálogo Recordset simples. Se em vez dela for exibida a caixa de 
diálogo Recordset avançada, clique em Simple (Simples) para alternar para a caixa de 
diálogo Recordset simples.

3. Atribua um nome ao recordset e selecione uma conexão e a tabela de banco de dados que 
fornecerão dados ao recordset.

4. Na área Columns (Colunas), selecione as colunas da tabela a serem incluídas no recordset.

O recordset pode ser idêntico ou diferente do recordset na página mestra. Normalmente, 
um recordset de uma página de detalhes possui mais colunas para exibir mais detalhes.
Se os recordsets forem diferentes, certifique-se de que o recordset da página de detalhes 
contenha pelo menos uma coluna em comum com o recordset da página mestra. 
Normalmente, a coluna em comum é a coluna de identificação do registro, mas pode ser 
também o campo de junção das tabelas relacionadas.
Para incluir apenas algumas das colunas da tabela no recordset, clique em Selected 
(Selecionado) e escolha as colunas desejadas clicando na lista e pressionando 
simultaneamente a tecla Control (no Windows) ou Command (no Macintosh).
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5. Preencha a seção Filter (Filtro) para localizar e exibir o registro especificado no parâmetro 
da URL repassado pela página de resultados, do seguinte modo:

■ No primeiro menu pop-up da área Filter, selecione a coluna do conjunto de dados que 
contém os valores correspondentes ao valor do parâmetro da URL repassado pela 
página mestra. Por exemplo: se o parâmetro da URL contiver um número de 
identificação de registro, selecione a coluna que contém os números de identificação 
de registro. No exemplo analisado na seção anterior, a coluna do recordset chamada 
CODE (CÓDIGO) contém os valores correspondentes ao valor do parâmetro da 
URL repassado pela página mestra.

■ Selecione o sinal de igual (caso ainda não esteja selecionado) no menu pop-up ao lado 
do primeiro menu.

■ Selecione URL Parameter (Parâmetro da URL) no terceiro menu pop-up.
A página mestra utiliza um parâmetro da URL para repassar informações para a página 
de detalhes.

■ Na quarta caixa, digite o nome do parâmetro da URL repassado pela página mestra. 
Por exemplo, se a URL utilizada pela página mestra para abrir a página de detalhes 
incluir o sufixo locationDetail.php?recordID=CBR, digite recordID.

A caixa de diálogo Recordset deverá ter a seguinte aparência: 

6. Clique em OK.

O recordset é exibido no painel Bindings.
7. Ligue as colunas do recordset à página de detalhes, selecionando-as no painel Bindings 

(Window > Bindings) e arrastando-as até a página.

Para obter mais informações, consulte “Tornar dinâmico o texto” na página 783.
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A página mestra/detalhes PHP definida está concluída. 

Após a criação das páginas-mestras/detalhes, é possível usar o painel Server Behaviors 
(Window > Server Behaviors) para modificar os vários blocos de criação.

Criar páginas de busca/resultados (PHP)
O Dreamweaver pode ser utilizado para criar um conjunto de páginas que permitam que os 
usuários efetuem buscas no banco de dados. O método é idêntico àquele utilizado para o 
ColdFusion. Para obter instruções, consulte “Criar páginas de busca/resultados (ColdFusion, 
ASP, JSP, PHP)” na página 937.

Criar uma página de inserção de registros 
(PHP)
O Dreamweaver pode ser utilizado para criar uma página em que os usuários poderão inserir 
novos registros em um banco de dados. O método utilizado é idêntico para todas as 
tecnologias de servidor suportadas pelo Dreamweaver. Para obter instruções, consulte “Criar 
uma página de inserção de registros (todos os servidores)” na página 944.

Criar páginas para atualizar um registro 
(PHP)
O aplicativo pode conter um conjunto de páginas em que os usuários poderão atualizar os 
registros existentes em uma tabela de banco de dados. Geralmente as páginas consistem em 
uma página de busca, uma página de resultados e uma página de atualização. A página de 
busca e a página de resultados permitem recuperar o registro e a página de atualização permite 
modificá-lo.

Esta seção descreve as etapas para criar páginas de atualização de um registro: 

■ “Procurar o registro a ser atualizado (PHP)” na página 1065
■ “Criar links para abrir a página de atualização (PHP)” na página 1065
■ “Criar um parâmetro da URL para os links (PHP)” na página 1061
■ “Recuperar o registro a ser atualizado (PHP)” na página 1067
■ “Preencher a página de atualização em uma operação (PHP)” na página 1068
■ “Preencher a página de atualização bloco a bloco (PHP)” na página 1069
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Tópicos relacionados
■ “Criar uma página de inserção de registros (todos os servidores)” na página 944
■ “Criar páginas para excluir um registro (PHP)” na página 1072

Procurar o registro a ser atualizado (PHP)
Quando os usuários desejam atualizar um registro, é necessário localizá-lo primeiro no banco 
de dados. Da mesma forma, são necessárias as páginas de busca e de resultados para 
funcionarem com a página de atualização. Os critérios de busca são digitados na página de 
busca e o registro é selecionado na página de resultados. Quando o usuário clica no registro, a 
página de atualização é aberta e exibe o registro em um formulário HTML.

Para obter instruções sobre a criação de páginas de busca do registro a ser atualizado, consulte 
“Criar páginas de busca/resultados (PHP)” na página 1064.

Após criar as páginas de busca/resultados, a próxima etapa é criar links na página de resultados 
que, ao serem clicados, abrem a página de atualização. 

Criar links para abrir a página de atualização (PHP)
Após criar as páginas de busca/resultados , é necessário criar links na página de resultados para 
abrir a página de atualização e exibir o registro selecionado em um formulário HTML. Esta 
seção descreve como criar esses links. A seção a seguir descreve como modificar o link de 
modo que ele também repasse a identificação do registro selecionado pelo usuário. A página 
de atualização utilizará essa identificação para localizar o registro solicitado no banco de dados 
e exibi-lo.

Para criar os links para a página de atualização:

1. Na página de resultados, selecione o alocador de espaço do conteúdo dinâmico do texto a 
ser exibido como link.

No exemplo a seguir, o alocador de espaço {rsLocations.LOCATION_NAME} está 
selecionado. Os links serão aplicados aos nomes de local na coluna.

2. No Property inspector (Inspetor de propriedades), clique no ícone da pasta ao lado do 
campo Link.
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3. Procure e selecione a página de atualização.

A página de atualização será exibida no campo Link.
Na página de resultados, o alocador de espaço do conteúdo dinâmico é exibido como um 
link. Se fizer o upload das páginas no servidor e executar uma busca, você verá que o link é 
aplicado a todos os registros da página de resultados.

A próxima etapa na criação de uma página de atualização de registro é criar um parâmetro da 
URL para repassar a identificação do registro selecionado pelo usuário. 

Criar um parâmetro da URL para os links de 
atualização (PHP)
Além de abrir a página de atualização, os links da página de resultados  também devem 
repassar a identificação do registro selecionado pelo usuário. A página de atualização utilizará 
essa identificação para localizar o registro solicitado no banco de dados e exibi-lo.

A identificação do registro é repassada para a página de atualização em um parâmetro da URL. 
Para obter mais informações, consulte “Parâmetros da URL” na página 749.

Esta seção descreve como criar um parâmetro da URL que repasse uma identificação do 
registro para a página de atualização.

Para criar o parâmetro da URL:

1. Selecione o link na página de resultados.

2. No campo Link do Property inspector (Inspetor de propriedades), adicione a seguinte 
seqüência de caracteres ao final da URL:
?recordID=<?php echo $row_recordsetName['fieldName']; ?>

O ponto de interrogação informa o servidor de que haverá um ou mais parâmetros da 
URL. A palavra recordID é o nome do parâmetro da URL (você pode criar qualquer 
nome de sua preferência). Anote o nome do parâmetro da URL, pois ele será utilizado na 
página de atualização posteriormente. 
A expressão após o sinal de igual é o valor do parâmetro. Neste caso, o valor é gerado por 
uma expressão PHP que retorna uma identificação de registro do recordset. É gerada uma 
identificação diferente para cada linha na tabela dinâmica. Na expressão PHP, substitua 
recordsetName pelo nome do recordset e fieldName pelo nome do campo do recordset 
que identifica cada registro de modo exclusivo. Na maioria dos casos, o campo consistirá 
em um número de identificação de registro. No exemplo a seguir, o campo consiste em 
códigos de local exclusivos. 
locationDetail.php?recordID=<?php echo $row_rsLocations['CODE']; ?>
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Quando a página for executada, os valores do campo CODE (CÓDIGO) do recordset 
serão inseridos nas linhas correspondentes da tabela dinâmica. Por exemplo, se o local de 
locação Canberra, na Austrália, apresentar o código CBR, será utilizada a seguinte URL na 
linha Canberra da tabela dinâmica: 
locationDetail.php?recordID=CBR

3. Salve a página.

A próxima etapa é modificar a página de atualização para que ela possa localizar o registro 
solicitado no banco de dados e exibi-lo. 

Recuperar o registro a ser atualizado (PHP)
Após a página de resultados repassar para a página de atualização um parâmetro da URL que 
identifica o registro a ser atualizado , a página de atualização deverá ler o parâmetro, recuperar 
o registro a partir da tabela do banco de dados e armazená-lo temporariamente em um 
recordset.

Para recuperar um registro a ser atualizado: 

1. Crie uma nova página PHP no Dreamweaver e salve-a. 

Essa página será a página de atualização.
2. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 

de adição (+) e selecione Recordset.

Se a caixa de diálogo avançada for exibida, clique no botão Simple (Simples) para abrir a 
caixa de diálogo simples.

3. Atribua um nome ao recordset e especifique o local onde estão os dados a serem atualizados 
utilizando os menus pop-up Connection (Conexão) e Table (Tabela).

4. Clique na opção Selected (Selecionado) e escolha uma coluna de chave (em geral, a coluna 
de identificação de registro) e as colunas que contêm os dados a serem atualizados.

5. Configure a área Filter (Filtro) para que o valor da coluna de chave seja igual ao valor do 
parâmetro da URL correspondente repassado pela página de resultados.
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Este tipo de filtro cria um recordset que contém apenas o registro especificado pela página 
de resultados. Por exemplo: se a coluna-chave contiver informações de identificação de 
registro e for chamada PRID e se a página de resultados repassar as informações de 
identificação de registro correspondentes no parâmetro da URL id, a área Filter terá a 
seguinte aparência:

6. Clique em OK.

Quando o usuário selecionar um registro na página de resultados, a página de atualização 
produzirá um recordset contendo apenas o registro selecionado. 

Depois de modificar a página de atualização para recuperar um registro do banco de dados e 
armazená-lo em um recordset, é necessário adicionar um formulário para que os usuários 
possam modificar os dados do registro e a lógica necessária para atualizar o banco de dados. 
Essas tarefas podem ser realizadas em uma operação ou bloco a bloco. Consulte “Preencher a 
página de atualização em uma operação (PHP)” na página 1068 ou “Preencher a página de 
atualização bloco a bloco (PHP)” na página 1069.  

Preencher a página de atualização em uma operação 
(PHP)
Uma página de atualização é composta por três blocos de criação:

■ Um recordset filtrado para recuperar o registro a partir de uma tabela de banco de dados 
(consulte “Recuperar o registro a ser atualizado (PHP)” na página 1067).

■ Um formulário HTML que permite aos usuários modificar os dados do registro
■ Um comportamento de servidor Update Record (Atualizar registro) para atualizar a tabela 

de banco de dados.

Os dois blocos de criação finais de uma página de atualização podem ser adicionados em uma 
única operação utilizando o objeto de aplicativo Record Update Form (Formulário de 
atualização de registros). O objeto de aplicativo adiciona à página um formulário HTML e 
um comportamento de servidor Update Record. 

Para que o objeto de aplicativo possa ser utilizado, o aplicativo para a Web deve identificar o 
registro a ser atualizado e a página de atualização deve ser capaz de recuperá-lo. Consulte 
“Procurar o registro a ser atualizado (PHP)” na página 1065, “Criar links para abrir a página 
de atualização (PHP)” na página 1065, “Criar um parâmetro da URL para os links (PHP)” na 
página 1061 e “Recuperar o registro a ser atualizado (PHP)” na página 1067.
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Após o objeto de aplicativo colocar os blocos de criação na página, utilize as ferramentas de 
projeto do Dreamweaver para personalizar o formulário de acordo com suas preferências ou o 
painel Server Behaviors para editar o comportamento de servidor Update Record.

Para criar a página de atualização com o objeto de aplicativo Record Update 
Form:

1. Abra a página de atualização na visualização do projeto e selecione Insert > Application 
Objects > Update Record > Record Update Form Wizard.

Será exibida a caixa de diálogo Record Update Form (Formulário de atualização de 
registros).

2. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

O objeto de aplicativo adiciona à página um formulário HTML e um comportamento de 
servidor Update Record. Os objetos de formulário são dispostos em uma tabela básica, que 
pode ser personalizada utilizando as ferramentas de desenvolvimento de projetos de página do 
Dreamweaver Verifique se todos os objetos do formulário estão dentro dos limites do 
formulário.

Para editar o comportamento de servidor, abra o painel Server Behaviors, em Window > 
Server Behaviors, e clique duas vezes no comportamento Update Record.

Preencher a página de atualização bloco a bloco 
(PHP)
Uma página de atualização é composta por três blocos de criação:

■ Um recordset filtrado para recuperar o registro a partir de uma tabela de banco de dados 
(consulte “Recuperar o registro a ser atualizado (PHP)” na página 1067).

■ Um formulário HTML que permite aos usuários modificar os dados do registro
■ Um comportamento de servidor Update Record (Atualizar registro) para atualizar a tabela 

de banco de dados.

Os dois blocos de criação básicos finais de uma página de atualização podem ser adicionados 
separadamente utilizando as ferramentas de formulário e o painel Server Behaviors 
(Comportamentos de servidor).

N
O

T
A

A página de atualização pode conter apenas um comportamento de servidor de edição 
de registros de cada vez. Por exemplo, não é possível adicionar um comportamento de 
servidor Insert Record ou Delete Record na página de atualização.
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Antes de adicionar os blocos, o aplicativo da Web deve identificar o registro a ser atualizado e 
a página de atualização deve ser capaz de recuperá-lo. Consulte “Procurar o registro a ser 
atualizado (PHP)” na página 1065, “Criar links para abrir a página de atualização (PHP)” na 
página 1065, “Criar um parâmetro da URL para os links (PHP)” na página 1061 e 
“Recuperar o registro a ser atualizado (PHP)” na página 1067.

O preenchimento da página de atualização consiste em três etapas:

■ Adicionar um formulário HTML à página para que os usuários possam modificar os 
dados

■ Exibir o registro no formulário ligando os objetos do formulário a colunas da tabela de 
banco de dados

■ Adicionar o comportamento de servidor Update Record para atualizar a tabela de banco 
de dados depois que o usuário modificar o registro

Para adicionar um formulário HTML a uma página de atualização: 

1. Crie uma nova página PHP, em File (Arquivo) > New (Novo).

Essa página será a página de atualização.
2. Crie o layout da página com as ferramentas de projeto do Dreamweaver.

3. Adicione um formulário HTML posicionando o ponto de inserção no local em que deseja 
exibir o formulário e selecione Form (Formulário) no menu Insert (Inserir).

Um formulário vazio é criado na página. Pode ser necessário ativar Invisible Elements 
(Elementos invisíveis), em View (Exibir) > Visual Aids (Auxílios visuais) > Invisible 
Elements, para exibir os limites do formulário, que são representados por linhas finas 
vermelhas.

4. Atribua um nome ao formulário HTML clicando na tag <form> na parte inferior da janela 
do documento para selecionar o formulário e, em seguida, abra o Property inspector 
(Inspetor de propriedades), em Window (Janela) > Properties (Propriedades), e digite um 
nome na caixa Form Name (Nome do formulário).

Não é necessário especificar um atributo action (ação) ou method (método) para o 
formulário, para informá-lo para onde e como serão enviados os dados do registro quando 
o usuário clicar no botão Submit (Enviar). O comportamento de servidor Update Record 
define esses atributos para o usuário.

5. Adicione um objeto de formulário, como um campo de texto, em Insert > Form > Text 
Field, para cada coluna que deseja atualizar na tabela de banco de dados.

Os objetos de formulário destinam-se à entrada de dados. Os campos de texto servem 
comumente a esse objetivo, mas também é possível usar menus, caixas de seleção e botões 
de opção. 
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A cada objeto de formulário deve corresponder uma coluna no recordset definido 
anteriormente. A única exceção é a coluna de chave exclusiva, à qual não deve 
corresponder nenhum objeto de formulário.
Para obter mais informações, consulte “Inserir objetos de formulário HTML” na 
página 892.

6. Adicione ao formulário um botão Submit, a partir de Insert > Form > Button (Botão).

O identificador do botão Submit pode ser alterado do seguinte modo: selecione o botão, 
abra o Property inspector, em Window > Properties, e digite um novo valor na caixa Label 
(Identificador).

Para exibir o registro no formulário:

1. Certifique-se de ter definido um recordset para conter o registro que o usuário deseja 
atualizar.

Para obter mais informações, consulte “Recuperar o registro a ser atualizado (PHP)” na 
página 1067.

2. Ligue cada objeto do formulário aos dados do recordset, conforme descrito nas seções a 
seguir:

■ “Exibir conteúdo dinâmico em campos de texto HTML” na página 900
■ “Pré-selecionar dinamicamente caixas de seleção HTML” na página 900
■ “Pré-selecionar dinamicamente botões de opção HTML” na página 901
■ “Criar um menu de formulário HTML dinâmico” na página 898
■ “Tornar dinâmicos menus de formulário HTML existentes” na página 899

Para adicionar um comportamento de servidor a fim de atualizar a tabela do 
banco de dados: 

1. No painel Server Behaviors, em Window > Server Behaviors, clique no botão com sinal de 
adição (+) e selecione Update Record no menu pop-up.

Será exibida a caixa de diálogo Update Record.
2. Preencha a caixa de diálogo.

Para obter instruções, clique no botão Help (Ajuda) da caixa de diálogo.
3. Clique em OK.

O Dreamweaver adiciona à página um comportamento de servidor que permite aos 
usuários atualizar registros em um banco de dados clicando no botão Submit no 
formulário.
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Para editar o comportamento de servidor, abra o painel Server Behaviors, em Window > 
Server Behaviors, e clique duas vezes no comportamento Update Record.

Tópicos relacionados
■ “Preencher a página de atualização em uma operação (PHP)” na página 1068.

Criar páginas para excluir um registro 
(PHP)
O aplicativo pode conter um conjunto de páginas que permite que os usuários excluam 
registros de um banco de dados. As páginas normalmente consistem em uma página de busca, 
uma página de resultados e uma página de exclusão. A página de busca e a página de 
resultados permitem recuperar o registro e a página de exclusão permite excluí-lo.

Esta seção descreve as seguintes etapas da criação de páginas PHP para excluir registros: 

■ “Procurar o registro a ser excluído (PHP)” na página 1072
■ “Criar links para uma página de confirmação (PHP)” na página 1073
■ “Criar um parâmetro da URL a ser repassado para a página de confirmação (PHP)” na 

página 1074
■ “Exibir o registro na página de confirmação (PHP)” na página 1075
■ “Adicionar lógica para excluir o registro (PHP)” na página 1079

Procurar o registro a ser excluído (PHP)
Quando os usuários planejam excluir um registro, é necessário localizá-lo primeiro no banco 
de dados. Da mesma forma, são necessárias as páginas de busca e de resultados para 
funcionarem com a página de exclusão. Os critérios de busca são digitados na página de busca 
e o registro é selecionado na página de resultados. Quando o usuário clica no registro, a página 
de exclusão é aberta e exibe o registro.

Para obter instruções sobre a criação de páginas de busca do registro a ser excluído, consulte 
“Criar páginas de busca/resultados (PHP)” na página 1064.

Após a criação das páginas de busca/resultados, a próxima etapa consiste em criar links na 
página de resultados para abrir a página de confirmação de exclusão. 
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Criar links para uma página de confirmação (PHP)
Após criar a página de resultados, você deve criar links em que o usuário possa clicar para abrir 
uma página de confirmação de exclusão. Esta seção descreve como criar esses links. A seção a 
seguir descreve como modificar o link de modo que ele também repasse a identificação do 
registro que o usuário deseja excluir.

Para criar links para uma página de confirmação:

1. Na página de resultados, crie uma nova coluna na tabela utilizada para exibir registros 
clicando na última coluna da tabela e selecionando Modify (Modificar) > Table (Tabela) > 
Insert Rows or Columns (Inserir linhas ou colunas). 

 Será exibida a caixa de diálogo Insert Rows or Columns.
2. Selecione a opção Columns (Colunas) e After Current Column (Depois da coluna atual). 

Depois que você clicar em OK, o Dreamweaver adicionará uma coluna à tabela. 
3. Na coluna recém-criada da tabela, digite a seqüência de caracteres Delete (Excluir) na 

linha que contém os alocadores de espaço do conteúdo dinâmico. Certifique-se de digitar 
a seqüência de caracteres dentro da região repetida com guias.

Também é possível inserir uma imagem com uma palavra ou símbolo para exclusão.
Se o Live Data (Dados ativos) estiver ativado, digite a seqüência de caracteres na primeira 
linha dos registros e clique no ícone Refresh (Atualizar).

4. Selecione a seqüência de caracteres Delete para aplicar um link a ela.

 Se o Live Data estiver ativado, selecione a seqüência de caracteres na primeira linha de 
registros. 

5. No Property inspector (Inspetor de propriedades), digite a página de confirmação no 
campo Link. 

É possível digitar qualquer nome de arquivo desejado.

Depois que você clicar fora do campo Link, a seqüência de caracteres Delete será exibida na 
tabela como um link.

Após criar os links, a próxima etapa na criação de uma página de exclusão de registros é criar 
parâmetros da URL para os links. 
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Criar um parâmetro da URL a ser repassado para a 
página de confirmação (PHP)
Além de abrir a página de confirmação, os links da página de resultados  também devem 
repassar a identificação do registro que o usuário deseja excluir. A página de confirmação 
utilizará essa identificação para localizar o registro no banco de dados e exibi-lo.

É necessário repassar a identificação do registro para a página de confirmação com um 
parâmetro da URL. Esta seção descreve como criar um parâmetro da URL para repassar a 
identificação do registro para a página de confirmação.

Para criar o parâmetro da URL:

1. Selecione o link Delete (Excluir) na página de resultados.

 Se o Live Data (Dados ativos) estiver ativado, selecione o link na primeira linha.
2. No campo Link do Property inspector (Inspetor de propriedades), adicione a seguinte 

seqüência de caracteres ao final da URL:
?recordID=<?php echo $row_recordsetName['fieldName']; ?>

O ponto de interrogação informa o servidor de que haverá um ou mais parâmetros da 
URL. A palavra recordID é o nome do parâmetro da URL (você pode criar qualquer 
nome de sua preferência). Anote o nome do parâmetro da URL, pois ele será utilizado 
mais tarde na página de confirmação.
A expressão após o sinal de igual é o valor do parâmetro. Neste caso, o valor é gerado por 
uma expressão PHP que retorna uma identificação de registro do recordset. É gerada uma 
identificação diferente para cada linha na tabela dinâmica. Na expressão PHP, substitua 
recordsetName pelo nome do recordset e fieldName pelo nome do campo do recordset 
que identifica cada registro de modo exclusivo. Na maioria dos casos, o campo consistirá 
em um número de identificação de registro. No exemplo a seguir, o campo consiste em 
códigos de local exclusivos:
confirmDelete.php?recordID=<?php echo $row_rsLocations['CODE']; ?>

Quando a página for executada, os valores do campo CODE (CÓDIGO) do recordset 
serão inseridos nas linhas correspondentes da tabela dinâmica. Por exemplo, se o local de 
locação Canberra, na Austrália, apresentar o código CBR, será utilizada a seguinte URL na 
linha Canberra da tabela dinâmica: 
confirmDelete.php?recordID=CBR

3. Salve a página. 

Após criar um parâmetro dinâmico da URL para os links Delete (Excluir), a próxima etapa é 
exibir o registro na página de confirmação. 
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Exibir o registro na página de confirmação (PHP)
Depois de preencher a página que relaciona os registros ), alterne para a página de 
confirmação. A página de confirmação mostra o registro e solicita que o usuário confirme se 
deseja excluí-lo. Quando o usuário confirmar a operação clicando no botão Form 
(Formulário), o aplicativo para a Web excluirá o registro do banco de dados.

A exibição do registro consiste em três etapas:

■ Criar um formulário HTML
■ Recuperar o registro a ser exibido no formulário
■ Exibir o registro no formulário

A recuperação e exibição do registro consiste em definir um recordset para conter um único 
registro (aquele a ser excluído) e ligar as colunas do recordset ao formulário. As etapas estão 
descritas a seguir, com mais detalhes.

Para criar um formulário HTML para exibir o registro:

1. Crie uma nova página PHP e salve-a como a página de confirmação especificada na 
seção anterior.

A página de confirmação foi especificada quando você criou o link Delete (Excluir) na 
seção anterior. Utilize esse nome ao salvar o arquivo pela primeira vez (por exemplo, 
deleteConfirm.php).

2. Insira um formulário HTML na página, em Insert (Inserir) > Form > Form.

3. Adicione ao formulário um campo oculto.

O campo oculto do formulário é necessário para armazenar a identificação do registro 
repassada pelo parâmetro da URL. Para adicionar um campo oculto, posicione o ponto de 
inserção no formulário e selecione Insert > Form > Hidden Field (Campo oculto).

4. Adicione um botão ao formulário.

O usuário deve clicar no botão para confirmar e excluir o registro exibido. Para adicionar 
um botão, posicione o ponto de inserção no formulário e selecione Insert > Form > 
Button (Botão).

5. Aperfeiçoe o projeto da página como desejar e salve-a.

Para recuperar o registro que o usuário deseja excluir:

1. No painel Bindings (Ligações), em Window (Janela) > Bindings, clique no botão com sinal 
de adição (+) e selecione Recordset (Query) [Recordset (Consulta)] no menu pop-up.

Será exibida a caixa de diálogo Recordset simples. Se em vez dela for exibida a caixa de 
diálogo Recordset avançada, clique em Simple (Simples) para alternar para a caixa de 
diálogo Recordset simples. 
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2. Atribua um nome ao recordset e selecione uma conexão e a tabela de banco de dados que 
contém os registros que podem ser exibidos.

3. Na área Columns (Colunas), selecione as colunas da tabela (campos de registro) que deseja 
exibir na página.

Para exibir somente alguns dos campos do registro, clique em Selected (Selecionado), 
escolha os campos desejados na lista e pressione simultaneamente a tecla Control 
(Windows) ou Command (Macintosh).
Certifique-se de incluir o campo de identificação do registro, mesmo que não pretenda 
exibi-lo.

4. Preencha a seção Filter (Filtro) para localizar e exibir o registro especificado no parâmetro 
da URL, repassado pela página de resultados, do seguinte modo:

■ No primeiro menu pop-up da área Filter, selecione a coluna do conjunto de dados que 
contém os valores correspondentes ao valor do parâmetro da URL repassado pela 
página com os links Delete. Por exemplo: se o parâmetro da URL contiver um número 
de identificação de registro, selecione a coluna que contém os números de 
identificação de registro. No exemplo analisado na seção anterior, a coluna do 
recordset chamada CODE (CÓDIGO) contém os valores correspondentes ao valor do 
parâmetro da URL repassado pela página com os links Delete.

■ No menu pop-up ao lado do primeiro menu, selecione o sinal de igual, se ainda não 
tiver sido selecionado.

■ No terceiro menu pop-up, selecione URL Parameter (Parâmetro da URL). A página 
com os links Delete utiliza um parâmetro da URL para repassar informações à página 
de confirmação.

■ Na quarta caixa, digite o nome do parâmetro da URL repassado pela página com os 
links Delete. 
Por exemplo, se a URL utilizada para abrir a página de confirmação incluir o sufixo 
confirmDelete.php?recordID=CBR, digite recordID.
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A caixa de diálogo Recordset deverá ter a seguinte aparência:

5. Clique em OK.

O recordset é exibido no painel Bindings. 

Para exibir o registro que o usuário deseja excluir:

1. Selecione as colunas do recordset (campos de registro) no painel Bindings e arraste-as para 
o formulário inserido na página.

Para obter mais informações, consulte “Tornar dinâmico o texto” na página 783.
Em seguida, ligue a coluna de identificação do registro ao campo oculto do formulário.

2. Certifique-se de que a opção Invisible Elements (Elementos invisíveis) esteja ativada em 
View (Exibir) > Visual Aids (Auxílios visuais) > Invisible Elements. Em seguida, clique no 
ícone amarelo em forma de escudo (que representa o campo oculto do formulário).

O campo oculto do formulário será selecionado.
3. No Property inspector (Inspetor de propriedades), clique no ícone em forma de raio ao lado 

a caixa de texto Value (Valor).

Será exibida a caixa de diálogo Dynamic Data (Dados dinâmicos).
4. Na caixa de diálogo Dynamic Data, selecione a coluna de identificação do registro no 

recordset e clique em OK.
Criar páginas para excluir um registro (PHP) 1077



         
 No exemplo a seguir, a coluna de identificação de registro selecionada é CODE.

5. Salve a página.

A página de confirmação preenchida deverá ter a seguinte aparência:

Depois de criar uma página de confirmação, a próxima etapa na criação de uma página de 
exclusão de registros é adicionar lógica para excluir o registro. 
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Adicionar lógica para excluir o registro (PHP)
Após criar uma página de confirmação, a próxima etapa na criação de uma página de exclusão 
de registros é adicionar lógica à página de confirmação que exclui o registro do banco de dados 
quando o usuário clica no botão Confirm (Confirmar). No Dreamweaver, é possível adicionar 
esta lógica de modo rápido e fácil utilizando o comportamento de servidor Delete Record 
(Excluir registro).

Para adicionar lógica para exclusão do registro exibido no formulário HTML:

1. No painel Server Behaviors (Comportamentos de servidor), em Window (Janela) > Server 
Behaviors, clique no botão com sinal de adição (+) e selecione Delete Record.

A caixa de diálogo Delete Record é exibida.

2. Na caixa de texto First Check If Variable Is Defined (Primeiramente, verificar se a variável 
está definida), selecione a opção Primary Key Value (Valor da chave primária). 

Especifique o valor da chave primária posteriormente na caixa de diálogo. 
3. No menu pop-up Connection (Conexão), selecione uma conexão com o banco de dados, 

para que o comportamento de servidor possa conectar-se ao banco de dados em questão.

4. No menu pop-up Table (Tabela), selecione a tabela de banco de dados que contém os 
registros a serem excluídos.

5. No menu pop-up Primary Key Column (Coluna de chave primária), selecione a coluna da 
tabela que contém as identificações do registro.

O comportamento de servidor Delete Record buscará uma correspondência nesta coluna. 
A coluna deve conter os mesmos dados de identificação do registro que a coluna do 
recordset ligada ao campo oculto do formulário na página.
 Se a identificação do registro for numérica, selecione a opção Numeric (Numérico).
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6. No menu pop-up Primary Key, selecione a variável da página que contém a identificação 
do registro a ser excluído.

A variável é criada pelo campo oculto do formulário. Ela tem o mesmo nome que o 
atributo name (nome) do campo oculto e pode ser um parâmetro de URL ou de 
formulário, dependendo do atributo method (método) do formulário. Em nosso exemplo, 
a variável em questão é uma variável de formulário chamada hiddenRecID.

7. Na caixa de texto After Deleting, Go To (Após a exclusão, ir para), especifique a página a 
ser aberta depois que o registro for excluído da tabela do banco de dados.

É possível especificar uma página que contenha uma breve mensagem de êxito para o 
usuário ou uma que contenha os registros restantes, para que o usuário possa verificar se o 
registro foi excluído.
A caixa de diálogo Delete Record preenchida deverá ter a seguinte aparência:

8. Clique em OK e salve o trabalho.

Faça o upload das páginas para o servidor da Web (se necessário), abra um navegador e 
procure um registro a ser excluído. Ao clicar em um link Delete (Excluir) na página de 
resultados, será exibida a página de confirmação. Clique no botão Confirm para excluir o 
registro do banco de dados. Para verificar se o registro foi excluído, abra novamente a 
página com os links Delete. O registro não será mais exibido na lista.

N
O

T
A

Clique em Refresh (Atualizar) se o registro continuar sendo exibido na página.
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Criar páginas que restringem o acesso ao 
site (PHP)
O Dreamweaver pode ser utilizado para criar um conjunto de páginas que restringem o acesso 
ao site. Os métodos são idênticos àqueles utilizados para o ColdFusion. Para obter instruções, 
consulte “Criar páginas que restrinjam o acesso ao site (ColdFusion, ASP, JSP, PHP)” na 
página 966.
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PARTE 9

Apêndices
Obter mais ajuda para desenvolver seus aplicativos da Web.

Esta seção contém os seguintes capítulos:
Apêndice A: Guia do iniciante em bancos de dados. . . . . . . . . 1085

Apêndice B: Manual básico de SQL  . . . . . . . . . . . . . . . . . . . . . . . .1101
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Apêndice A

Guia do iniciante em 
bancos de dados
Este apêndice destina-se aos usuários do Macromedia Dreamweaver 8 que têm pouca ou 
nenhuma experiência com bancos de dados ou com conexões de banco de dados. São 
explicados os conceitos gerais, mas não os procedimentos específicos. Para saber como esses 
conceitos são aplicados na prática, consulte o restante deste guia. 

O apêndice descreve como projetar um banco de dados, mas não como criá-lo utilizando um 
aplicativo como o Microsoft Access ou SQL Server. Esse procedimento é descrito na 
documentação on-line ou impressa que acompanha o sistema de banco de dados.

Sobre os bancos de dados
O ponto de partida para a criação de um banco de dados é o registro. Um registro é uma 
coleção de dados relacionados tratada como uma entidade única. Por exemplo, a ficha de um 
jogador de futebol pode ser chamada de um registro: ela contém o nome, fotografia, time e 
estatísticas de um jogador. Empregando a terminologia de banco de dados, cada um desses 
itens relacionados seria chamado de campo: cada registro de ficha de jogador contém um 
campo de nome, um campo de fotografia, um campo de time e vários campos de estatísticas. 

Uma coleção de registros que compartilham os mesmos campos é chamada de tabela, porque 
esses tipos de informações podem ser facilmente apresentados no formato de tabela: cada 
coluna representa um campo e cada linha representa um registro. Assim, a palavra coluna é 
sinônimo de campo e linha é sinônimo de registro. 

Number LastName FirstName Position Goal

Registros
(linhas)

Campos (colunas)
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Um banco de dados pode conter mais de uma tabela, cada uma delas com um nome exclusivo. 
Essas tabelas podem ser relacionadas ou independentes.

O subconjunto de dados extraídos de uma ou mais tabelas é chamado de recordset (ou 
DataSet, no ASP.NET). Um recordset é também uma tabela, por ser uma coleção de registros 
que compartilham as mesmas colunas. Por exemplo: uma lista de escalação, que relaciona os 
nomes e as posições dos jogadores poderia ser chamada de recordset: ela consiste em um 
subconjunto de todas as informações possíveis sobre os jogadores, incluindo número de gols, 
assistências, penalidades, etc. 

Para criar um recordset, é necessário fazer uma consulta ao banco de dados. Um consulta 
consiste em um critério de pesquisa. Por exemplo: a consulta pode especificar que apenas 
algumas colunas serão inseridas no recordset ou que somente alguns registros serão incluídos. 
Para obter mais informações, consulte “Recordsets” na página 760.

Tópicos relacionados
■ “Conexões de bancos de dados” na página 1094

Conceitos básicos do projeto de um 
banco de dados
O projeto do banco de dados é a primeira etapa da criação de qualquer site da Web com base 
em banco de dados. Esta seção apresenta um estudo de caso para explicar os princípios básicos 
do projeto de um banco de dados. O estudo de caso envolve um aplicativo para a Web 
encomendado por uma empresa fictícia chamada Serviços Aéreos Seta, uma firma que 
administra uma pequena frota de jatos comerciais. 

Number

Tabela de banco de dados

LastName FirstName Position Goals

Tabela de recordset

LastName FirstName Position
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O projeto de um banco de dados consiste em uma série de etapas comuns. Em primeiro lugar, 
estude as regras e políticas comerciais a serem transpostas no aplicativo para a Web. Em 
segundo lugar, considere as consultas que os usuários farão ao banco de dados. Em terceiro 
lugar, defina a estrutura do banco de dados. Por fim, crie o banco de dados.

Análise das regras e políticas comerciais da Serviços 
Aéreos Seta
Você foi contratado temporariamente para criar um aplicativo para a Web encomendado pela 
Serviços Aéreos Seta. Antes de iniciar o projeto do banco de dados, é necessário certificar-se de 
ter compreendido todas as regras e políticas comercias da empresa relacionadas ao aplicativo. 
Esta seção descreve as regras e políticas comerciais (simplificadas) da Serviços Aéreos Seta.

A Seta administra uma frota de cinco jatos comerciais de vários tamanhos e modelos para seus 
proprietários. Cada jato possui até oito arrendatários, ou seja, empresas ou pessoas físicas que 
adquiriram parte das ações das aeronaves (“charter”). Esse tipo de acordo é comum entre 
pessoas ou empresas que não necessitam de um jato comercial durante um ano inteiro.

Esses proprietários, ou acionistas, pagam à empresa Serviços Aéreos Seta as seguintes taxas:

■ Uma taxa mensal de administração, proporcional à parte de cada proprietário da aeronave, 
para cobrir os custos de pagamento do piloto, seguro e hangar

■ Uma taxa de ocupação por hora que abrange todos os custos diretos, como manutenção, 
sobressalentes para o motor e refeições

Por sua vez, um acionista notifica a Serviços Aéreos Seta quando e para onde irá viajar e a 
empresa tomará as providências necessárias, incluindo a obtenção de equipes de terra e ar, 
além do fornecimento de refeições durante o vôo. A empresa pede que seja notifica com oito 
horas de antecedência a fim de poder preparar a aeronave para um vôo.

A Serviços Aéreos Seta garante “800 horas de ocupação” por ano para cada aeronave. As horas 
de ocupação são aquelas em que o jato está transportando um passageiro, pelo menos. As 
horas de ocupação têm início seis minutos (0,1 de uma hora) antes da decolagem da aeronave 
com os passageiros e termina seis minutos após a aterrissagem da aeronave.

Cada avião pode pertencer a oito proprietários, no máximo. Por exemplo: uma pessoa física 
ou corporação pode adquirir uma participação em sociedade de 1/5 (ou uma ação 
correspondente a um quinto) de um jato. Uma vez que a Serviços Aéreos Seta garante 800 
horas de vôo com passageiros por ano, o proprietário da ação correspondente a 1/5 do avião 
tem direito a 160 horas de ocupação (800 horas/5 = 160).
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Análise das características da solicitação da Serviços 
Aéreos Seta
A Serviços Aéreos Seta o contratou para criar um aplicativo para a Web com as seguintes 
características:

■ Permitir que qualquer acionista da aeronave solicite um jato para um vôo
■ Fornecer ao Departamento de Operações de Vôo (operadores de vôo) todas as informações 

necessárias para iniciar a preparação da aeronave, incluindo os detalhes da solicitação do 
arrendatário (itinerário, data e hora da partida, refeições necessárias, etc.), horas de 
ocupação restantes do arrendatário e a disponibilidade do avião para a viagem proposta

■ Permitir aos operadores de vôo reservar a aeronave para evitar conflitos de agendamento

Quais consultas os usuários farão ao banco de 
dados?
Após familiarizar-se com as características propostas para o aplicativo para a Web, reúna os 
usuários do banco de dados e faça a seguinte pergunta: “Quais consultas vocês farão ao banco 
de dados? 

Você ficará sabendo que alguns dos arrendatários das aeronaves desejam fazer as seguintes 
consultas ao banco de dados: 

■ De quantas horas de ocupação ainda disponho? 
■ O meu jato está disponível nesta(s) data(s)?

Depois que um arrendatário solicitar um avião, os funcionários de operações de vôo farão as 
seguintes consultas ao banco de dados: 

■ Onde o arrendatário deseja ir?
■ Qual é o itinerário: somente de ida, ida e volta, várias cidades? Os operadores de vôo 

necessitam dessas informações para iniciar o planejamento do vôo (verificar as previsões 
meteorológicas, apresentar os planos de vôo, etc.) e estimar as horas de ocupação.

■ O arrendatário dispõe de horas de ocupação suficientes para o itinerário proposto?
■ Quando o arrendatário deseja partir?
■ Qual é o jato do arrendatário?
■ O jato está disponível para o itinerário proposto?
■ Quantos passageiros acompanharão os arrendatários?
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■ Qual é a quantidade de bagagem dos passageiros: leve (bagagem de mão), normal (uma 
mala por passageiro) ou pesada (mais de uma mala)?

■ Quais são as refeições necessárias aos arrendatários?
■ Qual é a taxa de ocupação por hora do jato?
■ Onde posso contatar o arrendatário para confirmar o vôo e a taxa estimada?

Escolher as tabelas do banco de dados
Após conhecer as consultas que os usuários farão ao banco de dados, imagine a estrutura do 
banco de dados de modo a responder da melhor forma possível a essas perguntas. A primeira 
etapa é escolher as tabelas do banco de dados.

Em um banco de dados relacional, todos os dados são representados em tabelas compostas por 
linhas e colunas. Cada tabela descreve uma coleção de entidades relacionadas, como pessoas, 
objetos ou eventos. Cada linha descreve uma ocorrência da entidade e cada coluna descreve 
uma propriedade da entidade, por exemplo, o sobrenome de uma pessoa, cor de um objeto, 
data de um evento etc.

Escolha as cinco tabelas abaixo para o banco de dados da Serviços Aéreos Seta:

■ Uma tabela de aeronaves, que descreve todos os jatos comerciais administrados pela 
Serviços Aéreos Seta

■ Uma tabela de reserva das aeronaves, que enumera todas as datas em que os jatos estarão 
reservados ou indisponíveis para vôos

■ Uma tabela de arrendatários, que descreve todas as corporações e pessoas físicas que 
possuem ações dos jatos

■ Uma tabela de itinerários, que descreve todos os itinerários solicitados pelos arrendatários
■ Uma tabela de vôos, que descreve todas etapas (“vôos”) dos itinerários

Escolher as colunas em cada tabela
A próxima etapa é escolher as colunas em cada tabela. As colunas descrevem as propriedades 
de cada entidade da tabela. 

Uma boa regra prática a ser utilizada durante a escolha das colunas é evitar a duplicação de 
dados. Por exemplo: no caso do aplicativo da Serviços Aéreos Seta, você sabe que os nomes dos 
acionistas deverão estar associados às datas dos itinerários para responder à seguinte pergunta 
dos operadores de vôo: “Quais são refeições necessárias a um arrendatário em um determinado 
itinerário?”
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Um método é colocar as colunas correspondentes ao nome e ao sobrenome dos acionistas 
tanto na tabela de arrendatários quanto na tabela de itinerários. Contudo, essa estratégia 
obrigaria não só a uma duplicação dos dados relativos a nomes em duas tabelas, mas também 
de várias ocorrências nas tabelas de itinerários (seria necessário que digitar o nome do acionista 
na tabela de itinerários sempre que um arrendatário solicitasse um novo itinerário). Este 
método aumenta o trabalho gasto com a entrada de dados, induz a erros e ameaça a 
integridade dos dados (uma alteração feita em uma parte do banco de dados deverá ser 
repetida em outras partes).

Outra solução seria digitar o nome e sobrenome dos arrendatários uma única vez somente na 
tabela de acionistas. Quando se apresentar o momento de responder à pergunta acima dos 
operadores de vôo, as tabelas de arrendatários e de itinerários poderão ser unidas por meio de 
uma expressão SQL. 

Certifique-se de que as suas tabelas contêm uma coluna de chave primária. Uma coluna de 
chave primária contém valores únicos para cada linha. Este procedimento permite detectar a 
linha exata ao pesquisar no banco de dados. A maioria das colunas de chaves primárias 
consiste de números de identificação, mas é possível utilizar chaves primárias originais, como 
números de formulários do governo ou números de série de aeronaves.
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Após algumas considerações, escolha as seguintes propriedades e chaves primárias para as 
tabelas do banco de dados da Serviços Aéreos Seta:

Definir as relações entre as tabelas
Após definir as colunas básicas e as chaves primárias das tabelas, comece a definir as relações 
entre as tabelas. Ao terminar de definir as relações, você poderá escrever as instruções SQL no 
Dreamweaver para combinar os dados de duas tabelas (consulte “Unir tabelas” na 
página 1107).

Por exemplo, cada aeronave administrada pela Serviços Aéreos Seta é propriedade de vários 
arrendatários. É possível estabelecer uma relação individual para o coletivo (“one-to-many”) 
semelhante entre cada aeronave na tabela de aeronaves e os arrendatários na tabela de 
arrendatários. Esse procedimento economizaria o tempo gasto em digitação e no controle de 
dados de aeronaves redundantes na tabela de arrendatários.
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Em uma relação de banco de dados individual para o coletivo, uma única linha de uma tabela 
está relacionada a várias linhas em outra tabela. Pode-se definir esse tipo de relação incluindo 
uma chave estrangeira na tabela que fornece as diversas linhas, no exemplo acima, a tabela de 
arrendatários. A chave estrangeira é uma coluna que contém valores correspondentes aos da 
coluna de chaves primárias de outra tabela. A chave primária da tabela de aeronaves é chamada 
ac_serial. Portanto, a inclusão de uma chave estrangeira chamada ac_serial na tabela de 
acionistas definiria a relação “uma aeronave para muitos arrendatários”.

Conhecendo as características da solicitação do cliente, bem como as regras e políticas 
comercias da empresa, é mais conveniente definir as seguintes relações um para muitos no 
banco de dados:

■ A cada aeronave podem ser atribuídos muitos arrendatários
■ A cada aeronave podem ser atribuídas muitas reservas
■ A cada aeronave podem ser atribuídos muitos itinerários
■ A cada arrendatário podem ser atribuídos muitos itinerários
■ A cada itinerário podem ser atribuídos muitos vôos (ou etapas)
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Estes são os diagramas revisados das tabelas, depois da inclusão das chaves estrangeiras que 
definem essas relações: 

Eles são conhecidos como diagramas R-E, ou seja, diagramas de relações entre entidades.

Criar o banco de dados
A etapa final do projeto é a criação do banco de dados utilizando um sistema de banco de 
dados, como Microsoft Access, SQL Server, Oracle9i ou MySQL. Para obter 
mais informações, consulte a documentação do sistema de banco de dados.
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Conexões de bancos de dados 
Se for utilizado um banco de dados com o aplicativo para a Web, será necessário criar pelo 
menos uma conexão de banco de dados. Sem esta conexão, o aplicativo não saberá onde 
localizar o banco de dados ou como conectar-se a ele. A conexão de banco de dados pode ser 
criada no Dreamweaver fornecendo as informações (ou “parâmetros”) dos quais o aplicativo 
necessita para contatar o banco de dados.

Esta seção discute as conexões de banco de dados em termos gerais. Para obter informações 
específicas sobre a criação de conexões no Dreamweaver, consulte “Efetuar a conexão com um 
banco de dados” na página 668.

Comunicar-se com o banco de dados 
Os dados armazenados em um banco de dados estão normalmente em formato proprietário, 
do mesmo modo que o texto em um arquivo de processador de texto. Este é um exemplo de 
aparência dos dados no Microsoft Access:

N
O

T
A

Não é necessário criar conexões de banco de dados para páginas ColdFusion no 
Dreamweaver. Você se conecta por meio das fontes de dados do ColdFusion.
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Esta é a aparência do mesmo banco de dados no bloco de notas: 

O aplicativo para a Web tem o mesmo problema que o bloco de notas ou qualquer outro 
aplicativo ao tentar acessar os dados em um formato desconhecido: o aplicativo não pode 
decifrar os dados. É necessário uma interface de software entre o aplicativo para a Web e o 
banco de dados para permitir que eles se comuniquem. 

Três interfaces comuns permitem que os aplicativos estabeleçam comunicação com os bancos 
de dados. A primeira chama-se conectividade aberta de banco de dados, Open Database 
Connectivity (ODBC), a segunda é chamada de OLE DB (Banco de dados de vinculação e 
incorporação de objetos), e a terceira é a Java Database Connectivity, ou JDBC. 

A função dessas interfaces é atuar como intérpretes. Por exemplo: quando um discurso é feito 
em inglês nas Nações Unidas, um intérprete o traduz para os delegados que falam francês e 
outro intérprete o faz para os participantes que falam alemão. Da mesma forma, deve-se 
utilizar a interface OLE DB para os aplicativos que compreendem esta linguagem, outra 
interface, ODBC, para os aplicativos da Web que a compreendem e outra, JDBC, para 
estabelecer a interface entre os aplicativos que a compreendem. ColdFusion and JSP 
applications are JDBC speakers, ASP speak ODBC (through a built-in OLE DB/ODBC 
interpreter), and ASP.NET applications speak OLE DB.
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Usar os drivers de bancos de dados para se 
comunicar com o banco de dados
As interfaces ODBC, OLE DB e JDBC são implementadas pelos drivers de bancos de dados 
(ou “provedores de dados” no OLE DB), que são apenas partes de um software. Quando o 
aplicativo para a Web se comunica com o banco de dados, isto é feito por intermédio de um 
driver.

Os drivers de bancos de dados são específicos ao banco de dados. Por exemplo: podem ser 
utilizados os drivers do Microsoft Access, SQL Server e dBase. Da mesma forma, é possível 
usar os provedores OLE, como o OLE DB, para o SQL Server. A escolha depende do banco 
de dados que está sendo utilizado.

Os drivers são produzidos pelos fabricantes de bancos de dados, como a Microsoft e Oracle, e 
por vários outros fabricantes de software. A Microsoft oferece vários drivers ODBC e 
provedores OLE DB para os pacotes mais conhecidos de bancos de dados, como o Microsoft 
Access, Microsoft SQL Server e Oracle. Os drivers ODBC, que podem ser executados apenas 
na plataforma Windows, são automaticamente instalados com o Microsoft Office e com o 
Windows 2000 e Windows XP Professional. Eles também são instalados nos pacotes MDAC 
(Microsoft Data Access Components) 2.5, 2.6, e 2.7, que você pode obter gratuitamente no 
site da Microsoft em http://msdn.microsoft.com/data/mdac/downloads/. O MDAC 2,7 
instala vários provedores OLE DB. 

Para saber quais drivers ODBC estão instalados em um sistema Windows, consulte “Exibir os 
drivers ODBC instalados em um sistema Windows” na página 1097.

Alguns drivers JDBC conhecidos incluem o driver I-net JDBC para os bancos de dados do 
Microsoft SQL Server, o driver Oracle Thin para os bancos de dados da Oracle e o JDBC 
Driver for DB2 para os bancos de dados DB2 da IBM. Para obter mais informações sobre os 
drivers JDBC e seus fabricantes, pesquise o banco de dados de drivers JDBC no site da Sun, 
em http://developers.sun.com/product/jdbc/drivers.

N
O

T
A

Primeiro, instale o MDAC 2.5 e, em seguida, o MDAC 2,7.
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Estas são as interfaces de banco de dados para cada tipo de aplicativo para a Web e alguns dos 
seus respectivos drivers comuns de banco de dados:

Exibir os drivers ODBC instalados em um sistema 
Windows
Se necessitar de um determinado driver ODBC e o servidor da Web for executado em um 
sistema Windows, você poderá determinar com facilidade se o driver ODBC está instalado no 
sistema. 

Para exibir os drivers ODBC que estão instalados em um sistema Windows: 

1. Abra o ODBC Data Source Administrator da seguinte maneira: 

■ No Windows 2000, selecione Start > Settings > Control Panel > Administrative Tools 
(Ferramentas administrativas) > Data Sources (Fontes de dados).

■ No Windows XP, selecione Start > Control Panel > Administrative Tools > Data 
Sources (ODBC).

2. Clique na guia Drivers.

Será exibida uma lista de drivers ODBC instalados no sistema.

Aplicativo da Web Interface de banco de 
dados

Drivers comuns

ColdFusion
JSP

JDBC drivers originais ColdFusion
driver Sun JDBC-ODBC
driver Thin JDBC da Oracle

ASP ODBC ou OLE DB driver Microsoft Access
provedor SQL Server da 
Microsoft
ODBC da Microsoft para Oracle

ASP.NET OLE DB provedor Microsoft Jet
provedor SQL Server da 
Microsoft
provedor da Microsoft para 
Oracle

PHP específico ao MySQL driver MySQL
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Chamar os drivers de bancos de dados
Um aplicativo deve chamar um driver de banco de dados para estabelecer comunicações em 
dois sentidos com um banco de dados. Um aplicativo para a Web chama um driver utilizando 
uma seqüência de caracteres de conexão. Esta é composta por todas as informações (ou 
parâmetros) necessárias para estabelecer uma conexão com um banco de dados. Em sua forma 
mais simples, uma seqüência de caracteres de conexão especifica um driver e um banco de 
dados, como neste exemplo:
Driver={Microsoft Access Driver (*.mdb)};
DBQ=C:\Inetpub\wwwroot\Scaal\scaalcoffee.mdb

As seqüências de caracteres de conexão ASP podem conter um parâmetro Provider (Provedor) 
que especifique um provedor OLE DB. Se este parâmetro for omitido, o ASP utilizará como 
padrão o provedor OLE DB para os drivers ODBC. No exemplo acima, o provedor OLE DB 
se comunica com o driver ODBC e o driver do Microsoft Access que, por sua vez, estabelece 
comunicação com o banco de dados do Access, scaalcoffee.mdb.

Os parâmetros em uma seqüência de caracteres de conexão podem variar dependendo do 
driver. Veja a seguir uma seqüência de caracteres de conexão para um banco de dados do SQL 
Server chamado Cases, localizado em um servidor denominado Hoover:
Driver={SQL Server};Server=Hoover;Database=Cases;
UID=DanaS;PWD=Queequeg

O Dreamweaver simplifica o processo de inserção de seqüências de caracteres de conexão em 
suas páginas, fornecendo uma caixa de diálogo na qual são digitados os diferentes parâmetros 
de conexão. Por exemplo: esta é a aparência da definição de uma conexão em uma caixa de 
diálogo quando o usuário estiver programando um aplicativo JSP:

N
O

T
A

UID representa a identificação do usuário e PWD representa a senha.
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Após preencher a caixa de diálogo e clicar em OK, o Dreamweaver inserirá a seqüência de 
caracteres de conexão em um arquivo de inclusão no seu site. 

Usar um DSN
Os nomes das fontes dos dados (DSNs) podem ser especificados em algumas conexões. O 
DSN é um tipo de atalho que o usuário cria no Windows para representar uma seqüência de 
caracteres de conexão. 

Por exemplo: suponha que haja um banco de dados do Microsoft SQL Server denominado 
Precinct, localizado em um servidor denominado Kojak. Para ter acesso ao banco de dados, é 
necessário digitar o nome de usuário columbo e a senha savalas7. Depois de utilizar esses 
parâmetros para definir um DSN denominado ourcops, será possível criar a conexão 
digitando uma única palavra ourcops no Dreamweaver, em vez de todos os outros parâmetros.

Se o servidor de aplicativos estiver em execução em um sistema Windows e tiver sido definido 
um DNS nesse sistema, o DNS poderá ser utilizado para definir uma conexão ASP ou JSP. 

Caso você não tenha acesso físico a um servidor e, por isso, não for capaz de definir um DNS 
nesse local, será necessário utilizar uma seqüência de caracteres de conexão para comunicar-se 
com o banco de dados.

Para configurar um DSN no Windows, consulte os seguintes artigos no site da Microsoft:

■ Os usuários do Windows 2000 podem consultar o Artigo 300596 do Microsoft 
Knowledge Base em http://support.microsoft.com/default.aspx?scid=kb;en-us;300596 

■ Os usuários do Windows XP podem consultar a Microsoft Knowledge Base, Artigo 
305599, em http://support.microsoft.com/default.aspx?scid=kb;en-us;305599 

Tópicos relacionados
■ “Conexões de banco de dados para desenvolvedores de ASP” na página 681
■ “Conexões de banco de dados para desenvolvedores JSP” na página 695
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B

Apêndice B

Manual básico de SQL
Este apêndice descreve como utilizar a SQL (Structured Query Language) para 
criar recordsets para páginas dinâmicas. A SQL (pronuncia-se sequel) é uma linguagem que 
permite ler e gravar dados de um banco de dados. Esta linguagem é composta por algumas 
palavras-chaves apenas e regras simples de sintaxe, mas permite executar operações de banco 
de dados sofisticadas. 

Tópicos relacionados
■ “Sobre os bancos de dados” na página 1085
■ “Conceitos básicos do projeto de um banco de dados” na página 1086
■ “Recordsets” na página 760

Princípios básicos de sintaxe 
A instrução SQL mais comumente utilizada para criar um recordset é SELECT, que extrai 
determinadas colunas de uma ou mais tabelas de bancos de dados para criar um recordset. A 
sintaxe básica da instrução SELECT é apresentada abaixo:
SELECT ColumnName FROM TableName

É possível adicionar quebras de linha, guias e outros tipos de espaço em branco às instruções 
para tornar clara a lógica: O SQL ignora todos os tipos de espaço em branco. O exemplo a 
seguir mostra uma instrução válida:
SELECT PaidDues

FROM Members

N
O

T
A

A Macromedia não oferece suporte técnico para as tecnologias de outros 
fabricantes, como SQL.
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As seguintes palavras-chave identificam os comandos SQL utilizados com mais freqüência: 

As seguintes palavras-chave são utilizadas para refinar as instruções SQL: 

Os operadores a seguir especificam condições e executam funções numéricas e lógicas:

Se o item que estiver sendo comparado for texto, coloque-o entre aspas simples, como no 
exemplo a seguir:
...WHERE Country = 'Germany' 

Palavra-
chave

Descrição

SELECT Recupera os registros especificados no banco de dados

INSERT Inclui um novo registro em uma tabela de banco de dados

UPDATE Altera os valores nos registros de banco de dados especificados

DELETE Remove os registros de banco de dados especificados

Palavra-
chave

Descrição

FROM Denomina a fonte de dados de uma operação

WHERE Define uma ou mais condições para a operação

ORDER BY Classifica as linhas de recordsets em uma determinada ordem

GROUP BY Agrupa o recordset pelos itens especificados, selecionados em uma lista

Operador Significado

= Igual a

LIKE Como (caracteres curingas são aceitos)

<> Diferente de

NOT LIKE Não igual a (curingas são aceitos)

< Menor que

> Maior que

<= Menor ou igual a

>= Maior ou igual a

AND Ambas as condições devem ser atendidas, como Bahia AND Minas Gerais

OR Pelo menos uma das condições deve ser atendida, como Matos OR Mattos

NOT Exclui a condição seguinte, como Paris NOT França
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Se o item que estiver sendo comparado for uma data e você estiver trabalhando com um banco 
de dados do Microsoft Access, coloque-o entre sinais #:
...WHERE DateOfBirth < #01/01/1970#

Outros bancos de dados podem utilizar suas próprias convenções de datas. Consulte a 
documentação do sistema de banco de dados.

Alguns sistemas de bancos de dados podem utilizar sintaxes fora do padrão SQL em seus 
produtos. Consulte a documentação do sistema de banco de dados. 

Definir as colunas de um recordset
O SQL pode ser utilizado para definir os recordsets de uma página. Um recordset é um 
subconjunto extraído de um banco de dados. Para obter mais informações, consulte “Sobre os 
bancos de dados” na página 1085.

Esta é a sintaxe SQL básica para definir as colunas de um recordset:
SELECT ColumnName1, ColumnName2, ColumnNameX FROM TableName

Para incluir todas as colunas de uma tabela no recordset, utilize o caractere curinga (*) da 
seguinte forma:
SELECT * FROM TableName

Por exemplo, suponha que você esteja trabalhando com uma tabela denominada Customers. 
Para extrair todas as colunas, digite a seguinte instrução SELECT:
SELECT * FROM Customers

Suponha que você necessite apenas dos dados contidos em duas colunas da tabela Customers: 
nas colunas YearBorn e DateLastPurchase. Para criar um recordset que contenha apenas os 
dados destas duas colunas, digite a seguinte instrução SELECT:
SELECT YearBorn, DateLastPurchase
FROM Customers

Limitar o número de registros de um 
recordset
Utilize uma cláusula WHERE para limitar o número de registros no recordset. Por exemplo: 
apenas os clientes que ganham mais de R$ 50mil por ano serão incluídos. Suponha que uma 
coluna da tabela denominada Earnings informa os rendimentos de cada cliente. A instrução 
SELECT teria a seguinte aparência:
SELECT YearBorn, DateLastPurchase FROM Customers 
WHERE Earnings > 50000
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Para filtrar os registros do banco de dados, especifique uma ou mais condições em uma 
cláusula WHERE. As seções seguintes descrevem maneiras de filtrar registros com a cláusula 
WHERE:

■ “Filtrar registros com base na igualdade de dois valores” na página 1104
■ “Filtrar registros com base na semelhança de dois valores” na página 1105
■ “Filtrar registros com base em uma faixa de valores” na página 1106
■ “Filtrar registros com base em uma combinação de condições de busca” na página 1107

Filtrar registros com base na igualdade de dois 
valores
É possível filtrar registros em um banco de dados com base na igualdade do valor de um 
parâmetro em relação ao valor de uma coluna de registros.

Suponha que você decidiu permitir que os usuários pesquisassem o banco de dados por 
departamento. Siga a lógica abaixo para criar o recordset resultante da busca:

■ Verifique um registro na tabela do banco de dados.
■ Se o valor na coluna department (departamento) do registro for igual ao nome do 

departamento enviado pelo usuário, inclua esse registro no recordset resultante da busca.
■ Verifique o próximo registro da tabela.

A lógica pode ser expressa com a seguinte cláusula WHERE:
WHERE ColumnName = ParameterValue

ParameterValue é uma variável SQL que contém um parâmetro de busca. Em um aplicativo 
para a Web, o usuário normalmente fornece esse parâmetro utilizando um formulário HTML. 

Esta consulta ao banco de dados poderia ser expressa inteiramente na linguagem SQL, da 
seguinte forma:
SELECT FIRSTNAME, LASTNAME, DEPARTMENT, EMAIL
FROM EMPLOYEES
WHERE DEPARTMENT = 'varDept'

A instrução SQL localiza todos os registros na tabela de funcionários que contenham um valor 
DEPARTMENT igual àquele encontrado na variável varDept. Por exemplo: se o usuário 
especificar o nome do departamento em Operations (Operações), a instrução SQL deverá 
gerar o seguinte recordset: 
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Filtrar registros com base na semelhança de dois 
valores
É possível filtrar registros em um banco de dados com base na semelhança do valor de um 
parâmetro em relação ao valor de uma coluna de registros. 

A utilização da semelhança em vez da igualdade permite aos usuários uma maior flexibilidade 
ao especificar o valor desses parâmetros. Por exemplo: as palavras da busca não necessitam 
distinguir maiúsculas de minúsculas. Se o usuário digitar bahia e a coluna da tabela contiver o 
valor Bahia, a correspondência será estabelecida.

Além disso, a semelhança possibilita o uso de caracteres curinga para que os usuários possam 
fazer buscas de partes de palavras e também em ordem alfabética. Por exemplo, se o usuário 
digitar m e a coluna da tabela contiver os valores Matos, Madureira e Miranda, será possível 
utilizar um caractere curinga na instrução SQL para que as três correspondências sejam 
estabelecidas. 

O caractere curinga padrão é o sinal de percentagem (%):
...WHERE LastName LIKE 'Mc%'

Suponha que você decida permitir que os usuários pesquisem o banco de dados por 
sobrenome. Siga a lógica abaixo para criar o recordset resultante da busca:

■ Verifique um registro na tabela do banco de dados.
■ Se o valor na coluna last name (sobrenome) do registro contiver um valor semelhante ao 

que o usuário enviou, inclua esse registro no recordset resultante da busca.
■ Verifique o próximo registro da tabela.

A lógica pode ser expressa com a seguinte cláusula WHERE:
WHERE ColumnName LIKE ParameterValue

ParameterValue é uma variável SQL que contém um parâmetro de busca. Em um aplicativo 
para a Web, o usuário normalmente fornece esse parâmetro utilizando um formulário HTML. 

Esta consulta ao banco de dados poderia ser expressa inteiramente na linguagem SQL, da 
seguinte forma:
SELECT FIRSTNAME, LASTNAME, DEPARTMENT, EMAIL
FROM EMPLOYEES
WHERE DEPARTMENT LIKE 'varLastName'

Para que os usuários possam executar buscas utilizando partes de palavras, combine a variável 
com um caractere curinga. O caractere curinga da SQL utilizado nesse caso é o sinal de 
percentagem (%). Por exemplo: 
...WHERE LASTNAME LIKE 'varLastName%'
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Por exemplo, se o usuário digitar o parâmetro de busca s, todos os registros contendo 
sobrenomes iniciados com a letra s serão incluídos no recordset, conforme mostrado abaixo: 

Se o usuário especificar o parâmetro de busca si, apenas os registros que contenham 
sobrenomes iniciados com as letras si serão incluídos no recordset: 

Filtrar registros com base em uma faixa de valores
Os registros de um banco de dados podem ser filtrados estabelecendo-se que um valor da 
coluna de registros pertença a uma faixa limitada por dois valores de parâmetros. 

Suponha que você decidiu permitir que os usuários pesquisassem o banco de dados por uma 
faixa de datas. Siga a lógica abaixo para criar o recordset resultante da busca:

■ Verifique um registro na tabela do banco de dados.
■ Se o valor na coluna date (data) do registro se encontrar entre dois valores de data enviados 

pelo usuário, inclua esse registro no recordset resultante da busca.
■ Verifique o próximo registro da tabela.

A lógica pode ser expressa com a seguinte cláusula WHERE:
WHERE ColumnName BETWEEN ParameterValue1 AND ParameterValue2

ParameterValue1 e ParameterValue2 são variáveis SQL que contêm os parâmetros da 
busca. Em um aplicativo para a Web, o usuário normalmente fornece esses parâmetros 
utilizando um formulário HTML. 

Esta é a maneira de expressar em SQL esse tipo de consulta ao banco de dados:
SELECT FIRSTNAME, LASTNAME, DEPARTMENT, STARTDATE
FROM EMPLOYEES
WHERE STARTDATE BETWEEN #varStartRange# AND #varEndRange#

Por exemplo, se o usuário digitar os parâmetros 01/07/99 e 31/12/99 da faixa, todos os 
funcionários que começaram a trabalhar na segunda metade de 1999 serão incluídos no 
recordset, como mostrado abaixo: 
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Filtrar registros com base em uma combinação de 
condições de busca
Esta seção descreve como incluir registros no recordset resultante da busca com base em uma 
combinação de condições de busca. Combine as condições na linguagem SQL utilizando os 
operadores lógicos AND, OR e NOT.

Se desejar que todas as condições sejam verdadeiras (true) para um registro incluído no 
recordset, utilize o operador AND da seguinte forma:
...WHERE LASTNAME LIKE 'varLastName' AND DEPARTMENT LIKE 'varDept' 

Se desejar que qualquer uma das condições seja verdadeira (true) para que um registro seja 
incluído no recordset, utilize o operador OR, da seguinte forma:
...WHERE LASTNAME LIKE 'varLastName' OR DEPARTMENT LIKE 'varDept' 

Se desejar que uma condição seja verdadeira (true), mas não outra, utilize o operador NOT da 
seguinte forma: 
...WHERE DEPARTMENT LIKE 'varDept' AND NOT COUNTRY LIKE 'varCountry' 

Utilize os parênteses para agrupar as condições de busca:
...WHERE (DEPARTMENT LIKE 'varDept' AND STARTDATE < #varStart#)
OR STARTDATE BETWEEN #varStartRange# AND #varEndRange# 

Ordenar os registros em um recordset
Utilize a cláusula ORDER BY para ordenar os registros do recordset. Por exemplo, suponha que 
deseja ordenar os registros do recordset de acordo com a renda do cliente, na ordem da mais 
baixa para a mais alta. No SQL, ordene os registros da seguinte forma:
SELECT LastName, FirstName, Earnings FROM Customers 
ORDER BY Earnings

Por padrão, a cláusula ORDER BY ordena os registros na ordem ascendente (1, 2, 3... ou A, B, 
C...). Se desejar classificá-los na ordem descendente, da renda mais alta para a mais baixa, 
utilize a palavra-chave DESC da seguinte forma:
ORDER BY Earnings DESC

Unir tabelas
É possível utilizar uma única instrução SELECT para recuperar dados de uma ou mais tabelas 
de um banco de dados. Esta instrução une as tabelas e retorna um único recordset que contém 
dados selecionados em cada tabela.
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Por exemplo: o banco de dados de uma empresa pode conter uma tabela com os dados 
pessoais dos funcionários e uma outra tabela que acomoda os dados sobre os seus 
departamentos. Para criar um catálogo de funcionários com os respectivos nomes, números de 
telefone e departamentos, é necessário recuperar informações das duas tabelas 
simultaneamente.

Para isso, crie uma união especificando todas as tabelas a serem incluídas e como se 
relacionam. Por exemplo:
SELECT FIRSTNAME, LASTNAME, PHONE, DEPTNAME
FROM EMPLOYEES, DEPARTMENTS
WHERE EMPLOYEES.DEPT_ID = DEPARTMENTS.DEPT_ID

A primeira linha especifica as colunas a serem recuperadas. As três primeiras colunas, 
FIRSTNAME, LASTNAME, PHONE, constam da tabela EMPLOYEES, enquanto que a 
quarta coluna, DEPTNAME, está contida apenas da tabela DEPARTMENTS. 

A segunda linha especifica as duas tabelas das quais os dados serão recuperados, EMPLOYEES 
e DEPARTMENTS.

A última linha especifica os registros a serem unidos e recuperados nas duas tabelas. Cada 
tabela contém uma coluna chamada DEPT_ID (na tabela DEPARTMENTS, esta coluna é a 
chave primária). Para obter mais informações, consulte “Definir as relações entre as tabelas” na 
página 1091. A cláusula WHERE compara o valor de DEPT_ID de uma tabela com esse mesmo 
valor em outra tabela. Quando uma correspondência for encontrada, todos os campos do 
registro na tabela EMPLOYEES serão unidos a todos os campos do registro na tabela 
DEPARTMENTS. Em seguida, os dados combinados serão filtrados para criar um novo 
registro constituído das colunas FIRSTNAME, LASTNAME, PHONE e DEPTNAME. 
Finalmente, o novo registro será incluído no recordset.

A utilização de uma sintaxe de união um pouco diferente poderá ser mais conveniente em 
alguns sistemas de banco de dados. Por exemplo, a seguinte instrução SQL utiliza as palavras-
chave SQL INNER JOIN...ON para obter os mesmos resultados que o exemplo anterior: 
SELECT FIRSTNAME, LASTNAME, PHONE, DEPTNAME
FROM EMPLOYEES INNER JOIN DEPARTMENTS
ON EMPLOYEES.DEPT_ID = DEPARTMENTS.DEPT_ID

Consulte a documentação do sistema de banco de dados para determinar qual sintaxe de 
união deverá ser utilizada.

N
O

T
A

Utilize a notação de pontos para identificar com precisão as colunas. Por exemplo: 
EMPLOYEES.DEPT_ID refere-se à coluna DEPT_ID na tabela EMPLOYEES.
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área de trabalho, acessar arquivos em  119
área de visualização do painel Files, alterar  122
armazenar em cache as fontes de dados  778
arquivo web.xml  598
arquivos

abrir  107,  134

abrir na visualização do código  589
colocação  157
comparar  126
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páginas de atualização, criar  948
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permissões, alterar  710
procedimentos armazenados  965,  1030,  1049
projetar  1086
provedores  1094
Índice 1111
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SQL  1101
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barra de ferramentas do documento  46,  48
barra de ferramentas padrão  46,  49
barra de ferramentas, alterar títulos de documento  382
barra de navegação
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criar  466
estados da imagem  466
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barra de navegação de registros
criar  802
ocultar  806

barra de status
definir o texto (comportamento)  568
preferências  59
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barra Insert
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de encaixe  67
inserir código  620
mostrar categorias como guias  62
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barras de ferramentas

Coding  53,  617
documento  48
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excluir as fontes de dados  779
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tornar dinâmicos os formulários  889,  898
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escrever  874
instruções de codificação  871

marcadores de parâmetro  880
posicionar  878
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exibir  248
inserir  244
realce, preferência de  247
trabalhar com  246

Botão Code Navigation (Navegação de código)  627
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C
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caixas de seleção  888,  893
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aninhados  223,  224
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selecionar diversas  226,  227
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carregar arquivos  157
Cascade (Cascata)  57
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criar novas regras  436
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propriedades abreviadas  410
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inválidas  605
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navegação  627
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referência  631
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trechos  615
XHTML  606

código de navegação  627
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DELETE, palavra-chave do SQL  1102
depurar páginas ColdFusion  641
desativar

Design Notes  168
mascaramento de sites  163

desenhar
camadas  222
camadas aninhadas  224
células e tabelas de layout  289

desfazer a retirada do arquivo  155
design de quadros  306
Design Notes

abrir  170
adição de opções de status  170
ativação e desativação  168
configurar  168
definidos  167
excluir, sem associação  171
para arquivos Flash  117
para objetos de mídia  523
para os arquivos do Fireworks  117
salvamento das informações sobre o arquivo  169
sobre  116
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Design view
alternar para a visualização de código  57
atualizar  584
exibir com visualização de código  584
exibir modelos  328
JavaScript, inserir  650
VBScript, inserir  650
visualizar documentos baseados em modelos  330

designar links
abrir documentos em uma nova janela  469
em documentos  468

designar quadros  322
destruir arquivos temporários, permissões para  713
Detach from Original (Desanexar do original), opção  

198
Detach from Template (Desanexar do modelo), 

comando  367
detectar Flash Player para Flash Video  532
Director, criar filmes Shockwave com  534
Display Dependent Files (Exibir os arquivos 

dependentes), opção  145
Document Type Definition (Definição de tipo de 

documento)  596
documentos

abrir outros tipos  107
aplicar modelo  366
criar em branco  102
criar, a partir de um modelo  104
criar, com base em um arquivo de projeto  103
definir propriedades  381
definir um tipo padrão para novos  106
desanexar um modelo  367
Design Notes, utilização com  167
em cascata  57
exibir em guias (Macintosh)  79
lado a lado  57
limpar HTML do Word  108
pesquisar  444
salvar  105
salvar como modelo  340
tamanho do download, estimativa de tempo  402
título da página  382
verificar links  491
visualizar em navegadores  399

documentos baseados em modelos
anexar modelos  366
desanexar modelos  367
na visualização do projeto  330
modificar  368,  369,  370
na visualização de código  330

documentos do Microsoft Word
colar  418
importar  108
limpar o HTML  108

documentos vinculados, abrir  495
Drag Layer (Arrastar a camada), ação  555
Dreamweaver

conceitos básicos  24
integração do Contribute e  201
site. Consulte sites  88

Dreamweaver, integração do Fireworks com o
abrir e editar imagens do Fireworks  500,  512
abrir e otimizar imagens do Fireworks  501
atualização do código HTML do Fireworks  508
criação de álbuns de fotografias na Web  509
inserir arquivos do Fireworks  499
Open (Abrir) e Edit (Editar), preferências  506
Optimize Image in Fireworks (Otimizar imagem no 

Fireworks), comando  501
driver Oracle Thin  696
drivers ODBC  1094,  1097
drivers, não especificados  712
DropDownList (Lista suspensa), controle  989
DSN

conexões sem  688
criar uma conexão  684
solução de problemas  712
utilizar  1099

Dynamic Data (Dados dinâmicos), caixa de diálogo  
787

E
Edit Font List (Editar lista de fontes), comando  429
Edit Format List (Editar lista de formatos), caixa de 

diálogo  801
Edit NoFrames Content (Editar conteúdo NoFrames), 

comando  323
Edit Style Sheet (Editar folha de estilo), caixa de diálogo  

441
Edit with BBEdit (Editar com o BBEdit), comando  

600
Edit with HomeSite (Editar com o HomeSite), 

comando  599
editar  779

arquivos em um servidor  119,  121
arquivos em um site do Dreamweaver  118
atalhos de teclado  83
código  613
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comportamentos de servidor  883
controles de formulário ASP.NET  988
definições de sites do Dreamweaver  97
folha de estilo CSS  441
folhas de estilo externas  441
fontes de dados  778
itens de biblioteca  194
modelos  359
objetos de botão Flash  525
propriedades  185
recordsets  778
sites da Web, existentes localmente  97
sites da Web, existentes remotamente  98

editores de HTML baseados em texto. Consulte editores 
externos

editores externos
BBEdit (apenas no Macintosh), integração  599
HTML  599
imagens  458
integração para o HomeSite (apenas no Windows)  

599
mídia  521
texto  599

editores. Consulte editores externos
efetuar a conexão com um banco de dados  668
efetuar logout de usuários  976
efetuar o download

arquivos  156
comportamentos  548
tamanho, estimativa de tempo  402
tempo  50

efetuar upload de arquivos  897
elementos de mídia, inserir  518
elementos invisíveis

comentários  626
mostrar e ocultar  388
scripts  650
selecionar  386

elementos, alinhar  452
erros de sintaxe em instruções de inserção  716
erros ODBC  716
escrever código  613
espaço não-separável, inserir  432
espaços

converter para tabulações  630
inserir não-separável  432

esquema de desenho, para formatar tabelas  269
esquemas  596,  733
estilos

aplicar estilos CSS personalizados  437

CSS  436
estilos conflitantes  410
Consulte também folhas de estilos

estilos personalizados Consulte folhas de estilos
evento onBlur  578
eventos

alterar em comportamentos  546
definidos  541
desencadear ações  544
disponíveis para diversos navegadores e objetos  543

Excel. Consulte arquivos do Microsoft Excel
excluir

arquivos e pastas  135
arquivos em um site do Contribute  211
arquivos não-utilizados  162
conteúdo dinâmico  743,  789
fontes de dados  778
itens de biblioteca  196
linhas e colunas  275
recordsets  778

executar os objetos Flash  525
exibir

arquivos em um servidor  119
arquivos em um site do Dreamweaver  118
arquivos em uma unidade ou na área de trabalho  

119
camadas  229
código  583
código da seção head  654
elementos invisíveis  388
imagens de rastreamento  255
larguras de tabelas e colunas  274
modelos na visualização do código  329
modelos na visualização do projeto  328
propriedades  179
referências de código  613
regiões de modelo na visualização de código  330
regiões de modelo na visualização do projeto  330
registro de FTP  157
vários registros  806

Expanded Tables (Tabelas expandidas), modo  266
expandir o painel Files (Arquivos)  123
Export Table (Exportar tabela), comando  262
exportar

chaves de conexão para o Contribute  209
dados da tabela  261
estilos, para criar uma folha de estilos CSS  439
sites  147

expressões comuns  610
expressões de modelo  337
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extensibilidade, comportamentos de outras fontes  548
Extension Manager  84
extensões

adicionar  84
criar  862
gerenciar  84
instalar  873

F
falhas de logon, SQL Server  713
Favorites, lista; (Assets, painel)

adicionar e remover propriedades  188
adicionar uma nova cor  189
adicionar uma nova URL  189
criar um apelido para  190
criar uma pasta Favorites  191
exibir  181
sobre  179

Favorites, pasta  191
Ferramenta Zoom  389
ferramentas diff  126
"file already in use" (o arquivo já está em uso), 

mensagem de erro  712
Files (Arquivos), painel

abrir arquivos  134
abrir e fechar  122
alteração da exibição  124
alterar a visualização do site  123
alterar exibição das colunas  124
alterar tamanho da área de visualização  122
atualizar  135
busca de arquivos  136
exibir arquivos em  122
Log (Registro), botão  160
mapas de sites  137
mover arquivos e pastas  135
preferências  133
reduzir e expandir  123
trabalhar com arquivos e pastas  134,  135

filmes MPEG, como propriedades. Consulte 
propriedades

filmes QuickTime
como propriedades. Consulte propriedades
inserir  537

filmes Shockwave
como propriedades. Consulte propriedades
controlar  554
inserir  534

sobre  534
filmes, inserir  518
Fireworks

Design Notes no  117
editar menus pop-up  504
integração com o Dreamweaver  499
menus pop-up  572

Fit All (Ajustar tudo), opção  390
Fit Selection (Ajustar a seleção), opção  389
Fit Width (Ajustar a largura), opção  390
Flash Text (Texto Flash), caixa de diálogo  526
Flash Video

detectar reprodutor  532
editar e excluir  533
inserir  532
opções de apresentação  531

Flash, Design Notes em  117
Flash, tornar dinâmicos objetos  788
FlashPaper  529
fluxo de trabalho, para páginas dinâmicas  735
folhas de estilo

Edit Style Sheet (Editar folha de estilo), caixa de 
diálogo  441

editar  441
externas  439
Consulte também estilos

folhas de estilo Design-Time (Tempo de projeto), 
utilizar  442

folhas de estilos externas
criar  439
editar  441
vincular a  439

fontes
alterar combinações  429
alterar estilos  427
codificações, definir fontes para  82

fontes de dados
armazenar em cache  778
definir no Dreamweaver  670
enviados por usuários  747
excluir  779
JavaBeans  1054
parâmetros de formulário, sobre  747
parâmetros de URL, sobre  749
recordsets, criar (simples)  765
recordsets, sobre  761
sobre  760
variáveis ColdFusion  776
variáveis de aplicativo  773
variáveis de sessão  752,  772
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variáveis JSP  777
Format (Formato), coluna  800
Format Table (Formatar tabela), comando  269
formatação

código, definir preferências de  585,  587
tabelas e células  267

formatos de arquivo, imagem  445
formatos de dados

aplicar  800
criar  801
editar  801

formulários
acessibilidade  904
adicionar a um documento  890
ASP.NET  987
botões  887,  895
botões de opção  888,  893
botões de opção dinâmicos  901
caixas de seleção  888,  893
caixas de seleção dinâmicas  900
campos de arquivo  889,  897
campos de imagem  889,  895
campos de senha  892
campos de texto  887,  892
campos de texto dinâmicos  900
campos ocultos  887,  896
campos, validar  578
ColdFusion  915
controles, ColdFusion  919
criar  890
criar scripts do servidor  886
inserir objetos  892
JavaScript, usar com  903
menus  888,  894
menus de salto, criar  483
menus dinâmicos  898,  899
objetos dinâmicos  889,  898
scripts no cliente  903
sobre  886
utilizar para coletar dados  937,  1004
validação  902
validar formulários ColdFusion  927

formulários HTML. Ver formulários
fotografias  445
Frames (Quadros), painel  314
FROM, palavra-chave do SQL  1102
FTP

obtenção e colocação de arquivos  155
preferências  133
registro  156,  157

solução de problemas  95
funções, exibir  627
fundo

imagem e cor, definir  384
transparência no  384

G
Generator, tornar dinâmicos objetos  788
gerenciar

extensões  84
grupos de painéis  67
links  479
propriedades. Consulte propriedades

Get (Obter), comando  156
Get More Behaviors (Obter mais comportamentos), 

comando  548
GIF, imagens

como imagem de rastreamento  254
utilizações de  445

Go to URL (Ir para a URL), ação  559
grades

como guia  77
encaixar as camadas na  253
mostrar  253

gráficos bitmaps
Consulte também imagens
redimensionar  453

gráficos Consulte imagens
gravar código  874
gravar comandos  397
gravar permissões em servidores  205
Grayscale (Escala de cinza), paleta de cores  385
GROUP BY, palavra-chave do SQL  1102
grupo de painéis Results

Validation (Validação), painel  639
grupo de painéis Results (Resultados)

Target Browser Check (Verificação de navegador de 
destino), painel  635

guias
alterar a cor  252
bloquear  252
criar  251
desbloquear  252
encaixar elementos em  252
mostrar e ocultar  251
utilizar com modelos  253

guias visuais
imagens de rastreamento  254
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réguas  253
sobre  77

H
Hand (Mão), ferramenta  389
Hand, ferramenta  50
History (Histórico), painel

automatizar tarefas com  391
comandos, criar de etapas do histórico  396
etapas, aplicar a outros objetos  394
etapas, copiar e colar  395
etapas, repetir  392
lista de histórico, limpar  391
número máximo de etapas, definir  391
visão geral  377

home page, definir para o mapa do site  138,  143
HomeSite  599
HTML

atributos, tornar dinâmicos  786
código-fonte, estilos de tag  433
código-fonte, procurar  444
converter para XHTML  640
definir extensão de arquivo  106
espaço não-separável  432
formatar e inserir  406,  418
relatórios de atributos  173
Roundtrip  605
Consulte também código

Hyperlink, caixa de diálogo  472

I
imagens

alinhar  423
alterar arquivo de origem com linhas de tempo  240
aplicar comportamentos a  459
brilho e contraste  456
como propriedades. Consulte propriedades
cortar  454
definir a nitidez  456
editar com editor externo  458
fazer reamostragem  454
formatos suportados  445
em formulários  889
inserir  448
inserir no modo Layout  293
mapas de imagens  488
pré-carregar (comportamento)  564

redimensionamento  453
sobre  445
tornar dinâmico  785
trocar e restaurar troca (comportamento)  577
usando o Fireworks para otimizar  455

imagens cambiáveis
criar  458
sobre  457

imagens de rastreamento  254
Import Table (Importar tabela), comando  261
importar

arquivos do Microsoft Word  108
dados tabulares  261,  419
folha de estilo CSS externa  439
sites  147
tags ASP.NET  597
tags JRun  598
tags JSP  597,  598
tags personalizadas  596
texto de outros documentos  419

imprimir código  632
inclusões do servidor

alterar tipos  652
Arquivo  652
editar arquivo  652
inserir  652
inserir e editar  652
sobre  608
Virtual  652

inclusões do servidor de arquivos  608
inclusões do servidor virtual  608
inclusões, servidor  608
inserir

alocador de espaço de imagem  450
applets Java  539
arquivos Flash SWF  527
camadas aninhadas  224
caracteres especiais  431
comentários  626
controles ActiveX  539
datas  431
elementos de mídia  518
filmes Shockwave  534
FlashPaper  529
imagens  448
imagens cambiáveis  458
imagens do Fireworks  499
inclusões do servidor  652
itens de biblioteca  193
objetos de botão Flash  523
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objetos de texto Flash  526
páginas  944
propriedades  182
tags div  244

Insert E-Mail Link (Inserir link de correio eletrônico), 
caixa de diálogo  477

Insert Jump Menu (Inserir menu de salto), caixa de 
diálogo  484

Insert Named Anchor (Inserir âncora com nome), caixa 
de diálogo  475

Insert Navigation Bar (Inserir barra de navegação), 
caixa de diálogo  486

Insert Record (Inserir registro), comportamento  947
INSERT, palavra-chave do SQL  1102
inspetores

Property inspector  65
Tag inspector  644
Consulte também painéis

instruções de codificação  871
integração com o BBEdit (apenas no Macintosh)  599
integrar o Dreamweaver com outros aplicativos  33
interface do usuário, personalizar o layout do painel  67
Internet Explorer, conteúdo ativo restrito  401
ISP  689
itálico, definir texto em  427
item do menu Functions (Funções)  627
itens de biblioteca

adicionar às páginas  193
alterar a cor de realce  197
como propriedades. Consulte propriedades
criar  191
editar  194
editar os comportamentos em  199
excluir  196
preferências  197
propriedades  198
recriar  196
renomear  196
sobre  177
tornar editáveis os itens de documentos  198
trabalhar com  191

J
Jakarta Tomcat application server (JSP)  662
janela do documento

aplicar zoom  389
barra de status  50
barra de título  47

conceitos básicos  47,  56
executar os plug-ins para Navigator  537
exibir o código  57
procurar texto  444
redimensionar  58
selecionar elementos  386
seletor de tags  50
sobre  46
tamanho da página e tempo de download  50
Window Size, menu pop-up  50

janela do Live Data
arquivos ausentes  728
atualização automática  730
exibir  726
fornecer os parâmetros esperados  729
parâmetros da URL na barra de ferramentas  729,  

742
sobre  741

janela Site, procurar texto  444
Java Server Pages (Páginas do Java Server). Consulte JSP
JavaScript

ações  543
alertas  563
anexar a objetos de formulário  903
arquivos  108
comportamentos  541
executar  549
inserir código na visualização do projeto  650
menu pop-up  572
processar dados de formulários  903

JDBC
drivers  697,  1094
parâmetros de conexão  696

JPEG, imagens
como imagem de rastreamento  254
utilizações de  445

JRun  662
JSP (Java Server Pages)

Comportamento do servidor Callable  1050
conexões de banco de dados  695
conexões ODBC  699
conjunto de resultados, definição  737
drivers JDBC  697
importar tags  597
inserir páginas, criar  944
instruções preparadas  914,  1053
JavaBeans  1054
páginas de atualização  1038
páginas de busca, criar  937,  1038
páginas de exclusão, criar  1045
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páginas de login, criar  966
páginas-mestras/detalhes, criar  928,  1033
procedimentos armazenados  1050
servidores de aplicativos  662
variáveis JSP  777

JSP, callable (chamável)  1050
JSP, instruções preparadas  1053
Jump Menu (Menu de salto), ação  560
Jump Menu Go (Ir do menu de salto), ação  560

L
larguras e alturas da tabela  274
Layers, painel  227
layout de página. Veja modo Layout
Layout, modo

adicionar conteúdo a  293
alongamento automático  287
alternar de/para o modo Standard (Padrão)  288
células e tabelas de layout, trabalhar com  295
definir largura  287
desenhar células e tabelas de layout  289
espaçamento entre células  298
formatar as células e tabelas de layout  297
imagens espaçadoras, preferências  287
largura fixa  287
limpar as alturas das células  295
Make Widths Consistent (Tornar consistentes as 

larguras), opção  298
menu do cabeçalho da coluna  299
mover células e tabelas de layout  295
preferências  302
Remove All Spacers (Remover todos os espaçadores), 

opção  298
Remove Nesting (Remover aninhamento), opção  

298
sobre células e tabelas de layout  284
tabelas de layout aninhadas  292

layout, planejamento. Veja modo Layout
Left (À esquerda), opção de alinhamento  453
leitoras de tela

JAWS for Windows:  71
Window-Eyes  71

ler permissões em servidores  205
limpar as larguras das colunas  273,  274
linguagens

com suporte em Dreamweaver  604
referência  631

Linhas de tempo

adicionar e remover quadros  239
adicionar objetos a  238
alterar arquivo de origem de imagens  240
alterar propriedades de camadas  240
caminhos complexos  239
com loop  239
criar  237
dicas de animação  243
executar automaticamente  239
modificar  239
quadros-chave  237
renomear  243
várias  241

linhas de tempo com loop  239
linhas e colunas

adicionar e excluir  275
linhas e colunas, adicionar e remover  275
linhas, quebra na visualização do código  586
Link Checker (Verificador de links), caixa de diálogo  

493
Link Color (Cor do link), opção - Page Properties 

(Propriedades da página)  386
Link External Style Sheet (Vincular folha de estilo 

externa), caixa de diálogo  439
Link to Existing File (Link a um arquivo existente), 

comando  142
Link to New File (Link a um novo arquivo), comando  

142
links

abrir a origem  481
adicionar  184
alterar no site inteiro  482
alterar quadros com  321
a âncoras  475
aplicar à seleção  184
arquivo de cache  479
para arquivos de script  651
atualizar  479
corrigir, rompidos  493
criar  467
criar links nulos  477
definir caminhos relativos  473
designar  467
a folhas de estilos  439
gerenciar  479
mapa do site  481
em modelos  333
ocultar  806
Relative to Document (Relativo ao documento), 

opção  469
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Relative to Site Root (Relativo à raiz do site), opção  
469

remover  481
rompidos  491
verificar  491

links de correio eletrônico
alterar  482
criar  476

links de hipertexto  467
links de navegação para registros, definir  802
links de scripts

alterar  482
criar  477

links externos  491
links nulos

alterar  482
criar  477

links rompidos  491
ListBox (Caixa de lista), controle  989
Live Data Settings (Definições do Live Data), caixa de 

diálogo  729
localizar arquivos não-utilizados  162
localizar e substituir. Consulte  pesquisar
Log (Registro), botão  160

M
Mac OS (Mac), paleta de cores  385
Macintosh

acessibilidade  71
documentos com guias  79

Macromedia Director, criar filmes Shockwave com  534
Macromedia Exchange  84,  873
Macromedia HomeSite  599
Macromedia JRun  598,  662
macros, criar comandos  396
maiúsculas/minúsculas, alterar  587,  630
Manage Sites (Gerenciar sites), caixa de diálogo, 

remover sites da  148
manipuladores de eventos. Veja eventos
mapa de percurso, onde iniciar  24
mapas de imagens

criar no lado do cliente  489
pontos ativos  489
selecionar vários pontos ativos  490
visão geral  488

mapas de imagens do servidor  488
mapas de sites

adicionar arquivos a um site  142

alterar os links nos  481
definidos  137
definir home page para  138
exibir  138,  145
Link to New File (Link a um novo arquivo), 

comando  142
links, trabalhar com  481
modificar layout de  140
mostrar arquivos  144
mostrar os arquivos dependentes nos  145
ocultar arquivos  144
salvamento como um arquivo de imagem  146
trabalhar com  481
trabalhar com páginas em  141

marcadores para elementos invisíveis  388
Mark of the Web, código  401
markup. Ver código
mascarar, site

arquivos  164
ativação e desativação  163
revelar tudo  167

Master/Detail Page Set (Conjunto de páginas-mestras/
detalhes), objeto de aplicativo  928,  997,  
1033,  1057

Material de referência da CGI  40
MDAC (Microsoft Data Access Components)  674
mensagens de erro

file already in use (o arquivo já está em uso)  712
Microsoft, solução de problemas  711
Consulte também solução de problemas

mensagens de erro da Microsoft, solução de problemas  
711

menu do cabeçalho da coluna
Add Spacer Image (Adicionar imagem espacejadora), 

opção  300
Clear Column Width (Limpar largura da coluna), 

opção  274
exibir  274,  285
inserir colunas  275
largura da coluna, definir  299
Make Column Autostretch (Criar coluna com 

alongamento automático)  299
Remove Spacer Image (Remover imagem 

espacejadora)  301
Select Column (Selecionar coluna), comando  264
sobre  258

menu do cabeçalho da tabela
Clear All Heights (Limpar todas as alturas), 

comando  274,  295
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Clear All Widths (Limpar todas as larguras), 
comando  274

exibir  274,  285
Make Widths Consistent (Tornar consistentes as 

larguras)  273,  301
Remove All Spacer Images (Remover todas as 

imagens espacejadoras)  301
Select Table (Selecionar tabela), comando  264
sobre  258

menus  894
menus contextuais  66
menus de atalho. Consulte menus contextuais
menus de lista  888,  894
menus de referências de código  613
menus de salto

adicionar os itens de menus  483
alterar os itens de menu  484
criar um aviso de seleção para  483
editar  560
Go (Ir), botões  483,  560
sobre  888

menus pop-up
comportamento do JavaScript  572
Fireworks  504,  572
formulários HTML  888,  894

menus suspensos  894
Merge Cells (Mesclar células), comando  276
Microsoft Access, arquivos de banco de dados 

bloqueados  712
Microsoft IIS  661
Middle (Centro), opção de alinhamento]  452
Modelo de objeto de expressão (modelos)  338
modelos

alterar cores de realce de regiões  343
aninhados  334,  357
aplicar a documento existente  366
Assets (Propriedades), painel  341
atributos de tags editáveis  327,  356,  357
atualizar documentos  361
atualizar sites do Contribute  361
clicar em regiões bloqueadas  368
como criar novos documentos com  104
como propriedades. Consulte propriedades
criar  340
criar para sites do Contribute  344
desanexar documento de  367
desfazer aplicação  367
na visualização do projeto  328
editar  359
editar código em  336

editar scripts do servidor  336
excluir  363
expressões  337
links, criar em  333
localizar regiões editáveis  348
modificar propriedades em documentos baseados 

em modelos  368
parâmetros  336
preferências  342
região opcional  327,  353,  355
região repetitiva  327,  350,  370
regiões editáveis  326,  347,  348,  349
renomear  363
sintaxe da tag  331
sobre  326
tabela repetitiva  351,  352
tipos de regiões  326
tornar não-editável uma região  349
na visualização de código  329
XML  364

modificar
bancos de dados, utilizar procedimentos 

armazenados  965,  1030,  1049
propriedades da página  382

modo padrão
definidos  257

modos
Expanded Tables (Tabelas expandidas), modo  266
Layout, modo  283
modo padrão  257

mostrar elementos invisíveis  388
Move to Record (Mover para registro), comportamento  

805
mover  625
mover arquivos e pastas  135
multimídia. Consulte elementos de mídia
MySQL, banco de dados  705

N
Named Anchor (Âncora com nome), comando  475
Nav Bar Image (Definir imagem da barra de 

navegação), ação  565
navegadores

compatibilidade, com quadros  323
compatibilidade, como testar  635
cores, aceitas pela Web  378
designar  635
primário, definir  400
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versões, verificar  551
visualizar em  399

New From Template (Novo a partir de modelo), 
comando  104,  105

níveis de autorização  974
nomes de usuário

armazenar  968
permitir que os usuários escolham  968
verificar a exclusividade  970
verificar durante o login  973

novo tipo de documento padrão, definir  106
novos recursos no Dreamweaver  20
numerando linhas de código  586
números de linha  586

O
Objeto XSLT de Repeat Region  841
objeto XSLT de Repeat Region  822,  833,  836
objetos

inserir
inserir com a barra Insert (Inserir)  61

tornar dinâmico  788
objetos de botão Flash

modificar  525
visualização  525

objetos de texto Flash
inserir e visualizar  526

objetos do aplicativo
conjunto de páginas-mestras/detalhes  928,  997,  

1033,  1057
Record Insertion Form (Formulário de inserção de 

registros)  945
Record Update Form (Formulário de atualização de 

registros)  951,  1016,  1041,  1068
objetos do servidor

variáveis ColdFusion  764,  776
variáveis de aplicativo  773
variáveis de sessão  772

objetos, inserir HTML em formulários  892
obtenção e colocação de arquivos  156,  157
ocultar

elementos invisíveis  388
links  806

ocultar o menu pop-up  576
OLE DB

conexões  683
obter um provedor  674
provedores  1094

OLE DB Connection (Conexão com banco de dados 
OLE)  675

opção Auto Refresh  730
opções de exibição

fontes  82
painéis flutuantes  70

Open (Abrir) e Edit (Editar), preferências  506
Open (Abrir), comando  107
Open Attached Template (Abrir modelo anexado), 

comando  360
Open Browser Window (Abrir a janela do navegador), 

ação  561
Open Linked Page (Abrir a página vinculada), comando  

495
Optimize Image in Fireworks (Otimizar imagem no 

Fireworks), comando  501
Options, menu  68
ordem das colunas do painel Files, alterar  124
ordem de empilhamento

alterar com linhas de tempo  240
camadas  228

ortografia
dicionários  444
verificar com o comando Check Spelling (Verificar 

ortografia)  444
ortografia, verificar com o comando Check Spelling 

(Verificar ortografia)  443

P
página de registro  967
página inicial  46
páginas

alterar título  382
cores padrão do texto  386
Design Notes, utilização com  167
excluir  1045
exibir dados XML em  831
imagem ou cor de fundo, definir  384
inserir, criar  944
login, criar  971
preferências de tempo e tamanho do download, 

definir  402
redimensionar para adaptação ao monitor  58
registro de atualização, criar  948
registro do usuário  967
restringir o acesso às  974
visualizar em navegadores  399
XHTML, criar  640
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páginas de atualização, criar
ASP  1038
ASP.NET  1011
ColdFusion  948
JSP  1038
PHP  1064

páginas de busca, criar
ASP  937,  1038
ASP.NET  1004
ColdFusion  937
JSP  937,  1038
PHP  937

páginas de detalhes  928,  997,  1033,  1057
páginas de exclusão, criar

ASP  1045
ASP.NET  1020
ColdFusion  955
JSP  1045
PHP  1072

páginas de login
ColdFusion  977
criar  971

páginas de resultados  937,  1004
páginas-mestras/detalhes

ASP  928,  1033
ASP.NET  997
ColdFusion  928,  930
JSP  928,  1033
PHP  928,  1057

painéis
Assets (Propriedades), categoria Templates 

(Modelos)  341
Behaviors (Comportamentos)  543
de encaixe  67
definir as preferências de flutuação  70
Frames (Quadros)  314
gerenciar  67
grupos de painéis  47
History (Histórico)  377
salvar layout personalizado  70,  80

painéis flutuantes, combinar  67
paletas de cor  384
parágrafos

adicionar uma quebra de linha  424
formatação  423

Parameters (Parâmetros), caixa de diálogo  788
parâmetros

marcadores  880
modelos  336
too few (erro SQL)  715

parâmetros de conexão  696
parâmetros de modelo

modificar em documentos baseados em modelos  
369

visão geral  336
pasta Legacy  615
pasta local

configurar  92
estrutura  88

pasta remota
configurar  94
estrutura  88
solução de problemas  95

pastas  164
Favorites, para propriedades  191
mascarar e revelar  164
pesquisar  444
trabalhar com  134,  135

Perl, suporte a recursos  604
permissões

criar e destruir arquivos temporários  713
funções no Contribute  208
gravar permissões em servidores  205
pasta com banco de dados  714
segurança  711
em servidores  205
solução de problemas  709

personalizar
ambiente de codificação  583
Dreamweaver, princípios básicos  78

pesquisar
arquivos  444
código  628
expressões comuns  610
localizar e substituir  444
salvar padrões de busca  629
tags e atributos  628
texto nos arquivos  444

PHP
conexões de banco de dados  705
inserir páginas  944
instalar PHP  662
Mac OS X  662
páginas de atualização  1064
páginas de busca  937
páginas de exclusão  1072
páginas de login  966
páginas-mestras/detalhes  928,  1057

pixels transparentes no fundo  384
planejamento de quadros  306
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Play Sound (Executar o som), ação  563
plug-ins

executar na janela do documento  537
solução de problemas  538
tornar dinâmico  788
verificar  552

plug-ins para Netscape Navigator
executar na janela do documento  537
solução de problemas  538

PNG, imagens
como imagem de rastreamento  254
utilizações de  445

pontos ativos
aplicar comportamentos a  459
em mapas de imagens  489
redimensionar  490
selecionar vários em um mapa de imagens  490

pontos de interrogação  715
Popup Message (Mensagem pop-up), ação  563
posicionar

blocos de código  878
preferências

alterar realce  247
atualizar os links  479
barra de status  59
barra Insert  63
camadas  225
codificação por cores  589
dicionário para verificação ortográfica  443
editores externos  522
fontes/codificação  82
formatação de código  587
gerais  81
Layout, modo  302
modelo  342
New Document (Novo documento)  106
Open (Abrir) e Edit (Editar)  506
painéis  70
painéis flutuantes  70
realce, bibliotecas  197
realce, blocos de layout  247
realce, células de layout  291
realce, regiões de modelo  342
realce, tabelas  262
reescrita de código  588
referências de código  588
Site  133
tipos de arquivos e editores  600
tipos de arquivos/editores  522
Validator (Validador)  590

visão geral  78
Visualização do código  586

preferências de cores de código em modelos  342
preferências de fontes/codificação  82
preferências de New Document (Novo documento)  

106
Preferências de realce

blocos de conteúdo  247
células de layout  291
itens de biblioteca  197
regiões do modelo  342
tabelas  262

preferências de transferências de arquivo  133
preferências dos tipos de arquivos/editores  522
preferências gerais  81
Preload Images (Pré-carregar as imagens), ação  564
Prevent Layer Overlaps, comando  233
Preview in Browser (Visualizar no navegador), 

comando  399
princípios básicos do Dreamweaver  24
privilégios de acesso

adicionar às páginas  975
armazenar em um banco de dados  976
exemplo  974

procedimentos armazenados
ASP  1049
ASP.NET  1030
ColdFusion  965
definidos  913
JSP  1050
modificar bancos de dados  965,  1030,  1049

processadores de texto, arquivos criados por  108
Property inspector

editar código  644
exibir  65
expandir  65
sobre  46

Property inspector (Inspetor de propriedades)
corrigir links rompidos  494
editar recordset  743,  789
modo padrão  787
tornar dinâmicos atributos HTML  786

proporção, manter  453
propriedades

abrir o painel Assets  180
alterar com comportamentos  550
camada única  225
camadas múltiplas  226
categorias  181
células e tabelas de layout  297
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conjunto de quadros  320
copiar para um outro site  187
cores, aplicar ao texto  184
cores, criar  188
documento baseado em modelo  368
documento, definir  381
editar  185
exibir  65,  179
Favorites, lista  179,  181,  188
Favorites, pasta; criar  191
gerenciar  179
inserir  182
item de biblioteca  198
quadro  318
reutilizar em outro site  186
selecionar diversas  185
Site, lista  179,  180,  181
tabela  267
trabalhar com  179
URLs, criar  188

propriedades de página, alterar títulos  382
provedores de bancos de dados OLE da Microsoft  674
provedores de bancos de dados OLE da Oracle  674
Put (Colocar), comando  157

Q
quadros

adicionando atributos de acessibilidade  311
alterar conteúdo com links  321
alterar cor de fundo  320
aninhados  307
compatibilidade com os navegadores  323
criar  309
definidos  303
designar  322
editando atributos de acessibilidade  318
excluir  313
Frames (Quadros), painel  314
planejar conteúdo com  306
propriedades, definir  318
redimensionar  313
salvar  316
selecionar  313
sobre  304
uso com comportamentos  323

quadros-chave, criar  237
quebra automática de linha  586
quebra de linhas na visualização do código  586

Quick Tag Editor
abrir  646
menus de referências  648

R
RadioButton (Botão de opção), controle  991
RadioButtonList (Lista de botão de opção), controle  

991
Record Insertion Form (Formulário de inserção de 

registros), objeto de aplicativo  945
Record Path of Layer (Gravar caminho da camada), 

comando  239
Record Update Form (Formulário de atualização de 

registros), objeto de aplicativo  951,  1016,  
1041,  1068

Recordset Navigation Bar (Barra de navegação para 
recordset), objeto ativo  803

Recordset Navigation Status (Status de navegação do 
recordset), objeto ativo  810

Recordset, caixa de diálogo
avançada  767
simples  766

recordsets
armazenar em cache  778
colunas, definir (SQL)  1103
copiar e colar  779
Database Items (Itens de banco de dados), hierarquia  

768
definir sem utilizar SQL  765
editar ou excluir  778
filtrar registros (SQL)  1104,  1107
limitar os registros retornados (SQL)  1103
simples, criar  765
sobre  761
SQL, gravar  1101
SQL, gravar instruções personalizadas  767
união de tabelas (SQL)  1107
vazios, solução de problemas  717

recuar código  594,  625,  630
recursos para informações sobre tecnologias da Web  40
redimensionar

camadas  230
células da tabela  270
células e tabelas de layout  295
elementos, utilizar alças  453
quadros  313

redução de código  625
expandir  623
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redução inteligente  622
reduzir  623
sobre  622
visualizar sem expandir  624

redução inteligente  622
reduzir o painel Files (Arquivos)  123
reescrever código  605
Reference (Referência), painel  631
referências de código

bibliotecas de tags  591
preferências  588
Quick Tag Editor  648
sobre  613

Refresh Local (Atualizar o local), comando  143
regiões

clicar em bloqueadas  368
ocultar  806

regiões bloqueadas, clicar em  368
regiões editáveis (modelos)

alterar o nome de  349
controlar em modelos aninhados  357
criar  347
definidos  326
trabalhar com  348,  349

regiões opcionais (modelos)
definidos  327
inserir  353
modificar  355

regiões repetitivas (modelos)
alternar cores  352
em documentos baseados em modelos  370
criar  350
definidos  327
tabela repetitiva  351

registrar a atividade da rede  213
registrar transferências de arquivos  160
registro de eventos  213
registros

atualizar  948
criar contador  809
excluir  1045
exibir mais de um  806
inserir  944
links de navegação  802

réguas  253
na visualização do projeto  251
sobre  253

réguas horizontais, inserir e modificar  425
relatórios

exibir  175

salvar  175
para sites  173
validar código  639

relatórios de fluxo de trabalho  173
Remove Frame (Remover quadro), comando  237
Remove Timeline (Remover linha de tempo), comando  

241
remover quadros de uma linha de tempo  240
Rename Panel Groups (Renomear grupos de painéis), 

comando  69
renomear

arquivos e pastas  135
itens de biblioteca  196

Repeat Region (Repetir região), comportamento  806
repetir etapas  391
Replay (Executar novamente), botão  392
requisitos, aplicativos para a Web  657
Reset Origin, comando  253
Reset Position (Redefinir a posição), comando  255
restrição de tabelas  733
restringir o acesso ao site  966
reutilizar

buscas  629
código  615
itens de biblioteca  193
propriedades  186

revelar
pastas do site  164
tipos de arquivos  164
todas as pastas e arquivos  167

reverter arquivos  132
reverter para última versão salva  381
Right (À direita), opção de alinhamento, definir o 

Property inspector (Inspetor de propriedades)  
453

Roundtrip HTML  605

S
salvar

arquivos em quadros e em conjuntos de quadros  
316

buscas  629
documentos  105
documentos com outro nome  380
mapas de sites  146
relatórios  175
reverter para última versão salva  381

Save (Salvar), comando  105
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Save All (Salvar tudo), comando  380
Save All Frames (Salvar todos os quadros), comando  

317
Save Frame (Salvar quadro), comando  317
Save Frame As (Salvar quadro como), comando  317
Save Frameset (Salvar conjunto de quadros), comando  

317
Save Frameset As (Salvar conjunto de quadros como), 

comando  317
scripts

chaves ajustadas, verificar  634
como propriedades. Consulte propriedades
criar links de script  477
editar externos  650
editar na visualização do projeto  651
exibir as funções  627
inserir  650
vincular arquivos externos  651

scripts do servidor, em modelos  336
seção head, vizualizar e editar  654
segurança

definir permissões de banco de dados para  711
páginas de login para  966
proteger uma pasta por meio de senha  977

selecionar
camadas  227
células e tabelas de layout  295
elementos da tabela  262
objetos na janela do documento  386
quadros e conjuntos de quadros  313
tags  649
várias propriedades  185

Select Newer Remote (Selecionar um remoto mais 
novo), comando  161

SELECT, palavra-chave do SQL  1102
seletor de cores

Dreamweaver  384
sistema  385

seletor de cores do sistema  385
seletor de tags  46,  649
senhas

armazenar  968
campos  892
incorretas  714
permitir que os usuários escolham  968
verificar durante o login  973

seqüências de caracteres de conexão
chamar os drivers de bancos de dados  1098
OLE DB  677

Server Behavior Builder (Criador de comportamentos 
de servidor)  862

serviços da Web
adicionar a uma página  856
diretórios UDDI  850
fluxo de trabalho  849
gerador proxy AXIS  851
geradores proxy adicionais  851
geradores proxy, configurar  852
geradores proxy, instalar  851
lista de sites UDDI, editar  859
SOAP  851
sobre  847

servidor da Web,
álbuns de fotos, criação  509
definir  658
projeto, níveis de experiência no  24
serviços de hospedagem  689

servidor de aplicativos
configurar  659
escolher  659

servidor de teste
aplicativos para a Web  667
comportamentos  872
configurar  659

servidor HTTP  658
servidor SQL, solução de problemas de páginas 

dinâmicas  713
servidores

abrir uma conexão já existente  119
conectar para editar arquivos  121
efetuar upload de páginas  897
opções de acesso  94
solucionar problemas da pasta remota  95

Set as Home Page (Definir como home page), comando  
143

Set Color Scheme (Definir esquema de cores), 
comando  386

Set Text of Frame (Definir o texto do quadro), ação  
566

Set Text of Layer (Definir o texto da camada), ação  567
Set Text of Status Bar (Definir a mensagem de status), 

ação  568
Set Text of Text Field (Definir o texto do campo de 

texto), ação  569
Shockwave, tornar dinâmicos objetos  788
Show Region (Mostrar região), comportamento  806
Show-Hide Layers (Mostrar/ocultar as camadas), ação  

570
sincronização dos sites local e remoto  161
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sistema de devoluções e retiradas
desfazer a retirada de um arquivo  155
devolução e retirada de arquivos  148,  153
localizar arquivos retirados  136

sistemas multiusuário  55
sistemas operacionais, multiusuário  55
Site (painel Assets), lista

atualizar  181
exibir  180

Site [painel Assets], lista
sobre  179

Site, painel
agora painel Files  47
agora painel Files (Arquivos)  132
procurar texto e HTML em documentos  444

sites
abrir para exibir  118
arquivo de cache  480
arquivos, trabalhar com  134
cache  479
Check In/Check Out (Devolver/retirar), utilizar  

148
compatibilidade com os navegadores  635
criar novas, definições avançadas  91
criar novos, Site Definition Wizard (Assistente de 

definição do site)  90
Design Notes, utilização com  167
diretrizes de teste  172
editar definições de sites  97
editar sites da Web já existentes  97,  98
especificar um servidor de teste  667
estrutura das pastas  88
exibição do painel Files (Arquivos), alterar  124
exibir no painel Files (Arquivos)  122
grandes, propriedades em  188
importar e exportar  147
links rompidos, corrigir  493
links, alterar em todo o site  482
links, trabalhar com  461
links, verificar  491
locais e remotos  88
localização de arquivos nos  136
mapa do site, trabalhar com  137
mascaramento  116,  163
material de referência  40
pasta local, configurar  92
pasta remota, configurar  94
pasta remota, solucionar problemas da  95
procurar arquivos em  444
propriedades, reutilizar  186

relatórios  173
remoção da lista de sites  148
segurança  966
sincronizar local e remoto  161
visualizar em navegadores  399

sites locais. Consulte sites  90
Snap to Web Safe (Ajustar à cor aceita pela Web), paleta 

de cores  385
SOAP e serviços da Web  851
sobrepor tags  605
solução de problemas

arquivo em uso  712
arquivos bloqueados em sites do Contribute  213
BOF  717
campo COUNT incorreto  715
clicar em regiões bloqueadas  368
compatibilidade do Contribute, ativar  204
consultas atualizáveis  714
Contribute  213,  214
devolver e retirar dos sites Contribute  213
DSN  712
EOF  717
erro de correspondência de tipos de dados  715
erros de sintaxe  716
erros ODBC  716
estilos, não exibidos corretamente no Contribute  

442
links rompidos no Contribute  212
logon com falha  713
mensagens de erro da Microsoft  711
parâmetros, falta de  715
permissões  709
plug-ins para Netscape Navigator  538

som
adicionar a uma página  535
executar  563
incorporar  536
vincular a um arquivo de áudio  535

Split Cells (Dividir células), comando  277
Split Frame (Dividir quadro), comandos  309
SQL

ASP.NET  762
colunas, definição  1103
Database Items (Itens de banco de dados), hierarquia  

768
filtrar registros  1104,  1107
instrução SELECT  1101
limitar registros  1103
operadores  1102
ORDER BY  1102
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palavras-chave  1102
recordset, definir com SQL  767
sobre  1101
unir tabelas  1107

Strikethrough (Tachado), botão (cor padrão)  385
Style (Estilo), submenu  427
Style Rendering, barra de ferramentas  54
sublinhado  427
sublinhados em nomes de contas SQL  714
substituir um alocador de espaço de imagem  451
suporte de linguagens  604
Suporte técnico Microsoft  711
Swap Image (Trocar imagem), ação  577
Swap Image Restore (Restaurar troca de imagem), ação  

578
System Color (Cor do sistema), botão  385

T
tabelas

aninhar  281
camadas, converter de  234
células, dividir  277
células, limpar larguras e alturas  273
células, mesclar  277
células, realçar  262,  284
criar e adicionar conteúdo  260
dados tabulares, importar  419
dados, exportando  261
editar  266
elementos, selecionar  262
estilos predefinidos para  269
Expanded Tables (Tabelas expandidas), modo  266
formatação  267
importar  261
largura das colunas, ajustar  273,  274,  301
larguras e alturas  273
larguras, exibir  274
linhas e colunas, adicionar e remover  275
linhas e colunas, ajustar  270
ordenar  281
propriedades  267
realce, preferência de  262
redimensionar  270
restrição  733
sobre  258
Veja também colunas, linhas e células

tabelas de layout
aninhados  292

cor de fundo  298
desenhar  289
espaçamento entre células  298
formatação  298
Make Widths Consistent (Tornar consistentes as 

larguras), opção  298
preferências  302
Remove all Spacers (Remover todos os espaçadores), 

opção  298
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tag de link href  439
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Tag Validator (Validador de tags)  639
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editar códigos com o Quick Tag Editor  646
editar com um Tag editor  621
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Tags de fechamento  615
tags inválidas, exibir  605
tags JRun  598
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Target Browser Check, painel  635
tecla Return, adicionar um parágrafo  424
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diálogo  369
testar o site
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utilizar relatórios  173
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arquivos, abrir  108
campos  887,  892
campos, definir o texto com comportamentos  569
colar  418
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editores, arquivos criados por  108
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formatação  406,  418,  427
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importar dados tabulares  419
importar de outros documentos  419,  420
inserir  406,  418
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procurar em documentos  444
recuar  424
remoção do recuo  424
tornar dinâmico  783

texto em negrito, definir  427
TextTop (Parte superior do texto), opção de 
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Tile (Lado a lado)  57
tipográficas, convenções  40
tipos de arquivos

arquivos Flash  516
preferências de editor externo e  600

tipos de codificação  82
tipos de dados, erro de correspondência  715,  717
títulos, alterar  382
Top (Superior), opção de alinhamento  452
transferência de arquivos  155

transferências de arquivos em segundo plano  115
transferir arquivos de e para os sites do Contribute  205
transformações de XSL

editar  838
lado cliente  819,  842
lado servidor  816,  826
usar parâmetros com  839

transparentes, pixels, no fundo  384
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U
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lista de sites, editar  859
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Unmark Editable Region (Desmarcar região editável), 
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Update Current Page (Atualizar página atual), comando  

361
Update Current Page, comando  195
Update HTML (Atualizar HTML), comando  508
Update Pages (Atualizar páginas), comando  361
Update Record (Atualizar registro), comportamento  

955,  1019,  1044,  1071
UPDATE, palavra-chave do SQL  1102
URLs

aplicar à seleção  184
como propriedades. Consulte propriedades
criar propriedades de URLs  188
Consulte também caminhos

usemap, atributo  489

V
validar formulários

ColdFusion  927
HTML  902

Validate Form (Validar o formulário), ação  578
Validator (Validador)

preferências  590
utilizar  639

variáveis de aplicativo  773
variáveis de sessão

dados, armazenar  755
dados, recuperar  757
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definir  772
parâmetros de formulário e parâmetros de URL  754
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VBScript, inserir código na visualização do projeto  650
vincular

a documentos do Microsoft Word ou Excel  422
âncoras  475
a âncoras com nome utilizando o ícone Point-to-File 

(Indicador de arquivos)  476
documentos utilizando o ícone Point-to-File 

(Indicador de arquivos)  470
documentos  468
a uma folha de estilo CSS externa  439
navegação e  461

Visited Links color (Cor de links visitados), opção  386
Visualização do código

abertura de arquivos não-HTML  589
alternar para a visualização do projeto  57
escrever e editar o código  613
exibir  583
exibir modelos  329
opções  586
Visualização do projeto, especificar entre  48
visualizar documentos baseados em modelos  330

visualização padrão no Property inspector (Inspetor de 
propriedades)  787

visualizações de site no painel Files (Arquivos), alterar  
123

visualizar em navegadores  399

W
WHERE, palavra-chave do SQL  1102
Window Size, menu pop-up  50
Windows OS (Windows), paleta de cores  385

X
XHTML

código  606
converter de HTML para XHTML  640
criar páginas  640

XML (Extensible Markup Language)
arquivos DTD  596
e elementos repetidos  822
em modelos  364
exibir em páginas da Web  813
exibir em páginas dinâmicas  817
sobre  814

XSL (Extensible Stylesheet Language)
comentários, inserir  841
sobre  814
Consulte também XSLT

XSLT (Extensible Stylesheet Language 
Transformations)

criar regiões condicionais com  840
e transformações no lado cliente  816,  819,  826,  

842
fragmentos  816
fragmentos, aplicar estilos a  844
fragmentos, excluir  838
fragmentos, inserir  836
Objeto XSLT de Repeat Region  841
objeto XSLT de Repeat Region  822,  833,  836
página, vincular a arquivos XML  843
páginas  816,  819
páginas, converter para  830
páginas, criar  828
sobre  815
utilizar com páginas dinâmicas  817
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